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Finance and Supply Chain

ServiceNow®  Finance and Supply Chain (FSC) workflows help organizations automate manual 
tasks, simplify approvals, and enhance end-to-end processes, leading to increased productivity 
and lower costs.

FSC applications

Learn about the 
FSC applications

Now Assist for Finance 
and Supply Chain

Learn about Now Assist for 
Finance and Supply Chain

Source-to-Pay Operations

Automate sourcing, 
procurement, and payment 
processes for internal and 

external teams to efficiently 
manage the goods and 

services needed for 
business operations

Sourcing and 
Procurement Operations

Empower employees 
to easily purchase from 
approved suppliers and 

minimize rogue spending 
with guided workflows

Supplier Lifecycle 
Operations

Simplify supplier 
onboarding, offboarding, 

and engagement 
with a unified digital 
experience for your 
teams and suppliers

Accounts Payable 
Operations

Optimize accounts payable 
for accurate and confident 

supplier payments

Finance and Supply Chain applications
Provides information about the Finance and Supply Chain (FSC) applications.

Finance and Supply Chain common applications
Finance and Supply Chain (FSC) enhances operational efficiency by utilizing shared applications 
across multiple products and workflows.

The FSC common applications enhance process efficiency and streamline collaboration across 
these products:
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• Sourcing and Procurement Operations

• Supplier Lifecycle Operations

• Accounts Payable Operations

Finance and Supply Chain includes the following common applications:

• Finance Common Architecture [sn_fin]

• ERP Integration Framework [sn_fcms_integrations]

• Common Service Delivery [sn_spend_sdc]

• Source-to-Pay Common Architecture [snc.sn_shop]

• Source-to-Pay Integration Framework [sn_spend_intg]

• Supplier Common Architecture [snc.sn_slm]

To learn more about each application, see Exploring FSC common applications.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Exploring FSC common applications

Explore the FSC common application plugins and their dependencies.

FSC common application plugins

Plugin name Description Dependencies
Mandatory/
Optional

Finance Common 
Architecture [sn_fin] Maintains 

primary data 
such as 
Enterprise 
Resource 
Planning 
(ERP) 
sources, 
legal entities, 
accounting 
periods, and 
so on.

For more 
information 
about the 
components 
installed 
with this 
plugin, see 
Components 
installed 
with Finance 

• Finance Applications – Common 
Dependencies [com.snc.fin_dep]

• Fiscal Calendar [com.snc.fiscal_calendar]

• Scoped Application 
Restricted Caller Access 
[com.glide.scope.access.restricted_caller]

• Insert Multiple Web Service 
[com.glide.web_service_insert_multiple]

Mandatory 
for SPO, 
SLO, and 
APO
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FSC common application plugins  (continued)

Plugin name Description Dependencies
Mandatory/
Optional

Common 
Architecture.

ERP Integration 
Framework 
[sn_fcms_integrations]

Provides 
integration 
support 
between the 
Platform and 
common ERP 
systems.

For more 
information 
about the 
components 
installed 
with this 
plugin, see 
Components 
installed 
with ERP 
Integration 
Framework.

• Scoped Application 
Restricted Caller Access 
[com.glide.scope.access.restricted_caller]

• Insert Multiple Web Service 
[com.glide.web_service_insert_multiple]

Mandatory 
only if you 
want to use 
a common 
integration 
framework 
to get the 
data from 
third-party 
ERP systems 
into Source-
to-Pay 
applications: 
SPO, SLO, 
and APO

Common 
Service Delivery 
[sn_spend_sdc]

Contains 
Finance 
Case, 
Finance 
Case Line, 
Finance 
Task, and 
Playbook 
status tables, 
as well 
as other 
infrastructure 
that forms 
the basis of 
Finance and 
Supply Chain 
workflows 
products.

• Process Automation Designer Core 
[com.glide.pad.core]

• Process Automation Designer for App 
Engine [com.glide.pad.license]

• Playbook Experience 
[com.playbook_experience]

Mandatory 
for SPO, 
SLO, and 
APO

Source-to-Pay 
Common Architecture 
[snc.sn_shop]

Provides an 
architecture 
to store 
purchase 
orders, 
requisitions, 
sourcing 
requests, 
and other 

• Finance Common Architecture 
[com.sn_fin]

• Common Service Delivery 
[com.sn_spend_sdc]

Mandatory 
for SPO, 
SLO, and 
APO
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FSC common application plugins  (continued)

Plugin name Description Dependencies
Mandatory/
Optional

objects 
that are 
commonly 
used across 
the source-
to-pay 
business 
processes.

For more 
information 
about the 
components 
installed 
with this 
plugin, see 
Components 
installed with 
Source-to-
Pay Common 
Architecture.

Source-to-Pay 
Integration Framework 
[sn_spend_intg]

Provides a 
set of staging 
tables, 
transform 
maps, and 
workflows 
to integrate 
Source-
to-Pay 
Operations 
with third-
party ERP 
system. 
For more 
information, 
see Source-
to-Pay 
integration 
framework.

Source-to-Pay Common Architecture

[com.snc.sn_shop]

Mandatory 
only if you 
want to use 
a framework 
to develop 
a set of API 
integrations 
with Source-
to-Pay 
applications: 
SPO, SLO, 
and APO

Supplier Common 
Architecture 
[snc.sn_slm]

Provides a 
common 
architecture 
to track data 
objects 
related to 
a supplier 
used in both 
Supplier 

• Finance Common Architecture [sn_fin]

• External User Registration 
[snc.external_user_self_registration]

• Common Service Delivery 
[sn_spend_sdc]

Mandatory 
for SLO

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

7



FSC common application plugins  (continued)

Plugin name Description Dependencies
Mandatory/
Optional

Lifecycle 
Operations 
andSupplier 
Collaboration 
Portal.

For more 
information 
about the 
components 
installed 
with this 
plugin, see 
Components 
installed 
with Supplier 
Lifecycle 
Operations.

• Common Vendor Core 
[snc.sn_vendor_core] and 
[com.snc.vendor_core]

• Document Management 
[snc.platform_document_management]

Configuring FSC common applications

Plan and configure your implementation of the FSC common applications.

Install the Finance and Supply Chain common applications

Install Finance and Supply Chain common applications and its dependent plugins from the 
ServiceNow Store.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the application listing in the ServiceNow Store  for information on dependencies, 
licensing or subscription requirements, and release compatibility.

Role required: admin

About this task
The following items are installed with the FSC common applications:

• Roles

• Tables

For more information, see Components installed with Finance Common Architecture, 
Components installed with Source-to-Pay Common Architecture, and Components installed with 
ERP Integration Framework.

Note:  Installing the SPO, SLO, or APO  application also automatically installs the FSC 
common applications as dependent applications or plugins if they are not installed already.

Install the following applications:
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• Install Sourcing and Procurement Operations. For more information on installation, see Install 
Sourcing and Procurement Operations  and Install ShoppingHub Mobile.

For more information on the required sequence for installing application plugins, see 
Application plugin installation sequence in Sourcing and Procurement Operations.

• Install Supplier Lifecycle Operations. For more information on installation, see Install Supplier 
Lifecycle Operations  and Install Supplier Collaboration Portal.

For more information on the required sequence for installing application plugins, see 
Application plugin installation sequence in Supplier Lifecycle Operations.

• Install Accounts Payable Operations. For more information on installation, see Install Accounts 
Payable Invoice Processing, Install Invoice Case Management  and Install Accounts Payable 
Operations integration with Document Intelligence.

For more information on the required sequence for installing application plugins, see 
Application plugin installation sequence in Accounts Payable Operations.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Components installed with Finance Common Architecture

Several types of components are installed with the installation of the Finance Common 
Architecture  application, including tables and user roles.

Roles installed

Role title [name] Description Contains roles

Finance admin

[sn_fin.finance_admin]

Generate fiscal and accounting periods. sn_fin.finance_user

Finance user View and edit accounting and fiscal periods. None
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Role title [name] Description Contains roles

[sn_fin.finance_user]

Tables installed

Table Description

Account Access

[sn_fin_gl_access]

Defines the access control for general ledger (GL) accounts, 
specifying who can view or modify particular GL records.

Account Access Rule

[sn_fin_gl_access_rule]

Defines rules that govern access control to the general ledger, 
ensuring proper segregation of duties and user permissions.

Account Group Mapping

[sn_fin_gl_group_mapping]

Maps general ledger accounts to specific groups for reporting 
purposes, ensuring proper categorization and alignment with 
business functions.

Accounting Periods

[sn_fin_accounting_period]

Defines accounting periods for financial reporting, such as 
fiscal year, quarters, and months.

Balance

[sn_fin_balance]

Tracks balances for different financial entities, which could 
include balances for accounts, departments, or cost centers.

Base Invoice

[sn_fin_base_invoice]

Stores high-level details about invoices, such as invoice 
number, date, supplier, customer, and total amount.

Base Tax Line

[sn_fin_base_tax_line]

Contains detailed tax line items associated with invoices, 
including tax rates, tax amounts, and tax classifications.

Currency Conversion Setting

[sn_fin_gl_currency_setting]

Contains settings and preferences for handling multiple 
currencies in the general ledger, including conversion rates and 
currency codes.

Due Date Rule

[sn_fin_gl_due_rule]

Defines rules for determining when accounts payable or 
receivable amounts are due, including due dates, grace 
periods, and interest rates.

ERP Source

[sn_fin_erp_source]

Maps and stores information regarding source systems from 
which financial data is imported or integrated into the financial 
system.

ERP source mapping

[sn_fin_erp_source_mapping]

Maps external ERP system data to the internal financial 
schema, facilitating data integration and synchronization.

Excel Data Import

[sn_fin_excel_data_import]

Supports the asynchronous excel data import for a journal 
entry.

Period Maps external ERP system data to the internal financial 
schema, facilitating data integration and synchronization.
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Table Description

[sn_fin_period]

Finance Exchange Rates

[sn_fin_fx_rate]

Maintains foreign exchange rates used for currency 
conversions in financial transactions, tracking historical and 
current rates.

Fixed Asset

[sn_fin_fixed_asset]

Stores information about fixed assets owned by the 
organization, including asset type, value, depreciation, and 
location.

Fixed Asset to Asset

[sn_fin_m2m_fixed_asset]

Represents a many-to-many relationship between fixed assets 
and various attributes, such as locations, departments, or asset 
classifications.

GL Rule

[sn_fin_gl_rule]

Defines rules and policies for general ledger account 
management, including rules for automated journal entries and 
account mappings.

GL Support

[sn_fin_gl_support]

Provides supporting data for general ledger accounts, such 
as supplementary details or documents linked to specific 
transactions.

Import Error

[sn_fin_import_error]

Tracks errors encountered during the import process, typically 
for financial data, to aid in troubleshooting and data validation.

Industry

[sn_fin_industry]

Holds industry classifications or categories relevant to the 
suppliers, customers, or financial entities in the system.

Ledger

[sn_fin_ledger]

The main table for storing general ledger (GL) entries, 
summarizing financial transactions by account, period, and 
other dimensions.

Ledger Account

[sn_fin_gl_account]

Stores balances for subledgers, such as accounts payable or 
receivable, tracking amounts owed or due by customers and 
suppliers.

Ledger Account Group

[sn_fin_gl_group]

Organizes general ledger accounts into groups for reporting 
and analysis purposes, such as by department or business 
segment.

Ledger Balance

[sn_fin_gl_balance]

Holds the balance of general ledger accounts, tracking current 
balances, debits, credits, and running totals.

Legal Entity

[sn_fin_legal_entity]

Contains information about legal entities within the 
organization, such as corporations or limited liability 
companies, along with their legal statuses.

Office Location

[sn_fin_office_location]

Contains information about office locations, including address, 
contact details, and organizational unit associated with each 
location.

Organization

[sn_fin_organization]

Contains details about the organizations within the financial 
system, including business units, departments, and 
organizational hierarchies.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

11



Table Description

Organization Tax Details

[sn_fin_org_tax_detail]

Contains tax-related information for different organizations, 
including tax registration numbers, rates, and jurisdictions.

Purchasing Entity

[sn_fin_purchasing_entity]

Stores information about entities involved in purchasing 
transactions, such as divisions or business units within an 
organization.

Properties

[sn_fin_properties]

Stores various configuration properties related to financial 
data management, such as thresholds, settings, or flags used 
throughout the system.

Profit Center

[sn_fin_profit_center]

Defines profit centers within the organization, enabling financial 
reporting and analysis by business units or operational 
segments.

Signer

[sn_fin_signer]

Stores information about individuals or entities authorized to 
sign financial documents or approve transactions.

Supplier

[sn_fin_supplier]

Contains details about suppliers, including name, address, 
contact information, and payment terms

Supplier Legal Entity 
Mapping

[sn_fin_supplier_detail]

Contains more detailed information about individual suppliers, 
including banking details, payment methods, and credit terms.

Supplier Payment 
Information

[sn_fin_supplier_payment]

Stores records of payments made to suppliers, including 
payment dates, amounts, and methods of payment.

Subledger Balance

[sn_fin_subledger_balance]

Maps general ledger accounts to specific groups for reporting 
purposes, ensuring proper categorization and alignment with 
business functions.

Tax Code

[sn_fin_tax_code]

Stores various tax codes used for transactions, including sales 
tax, VAT, and other region-specific tax codes.

Tax Type

[sn_fin_tax_type]

Contains different tax types used in financial transactions, 
such as VAT, sales tax, and withholding tax, along with their 
applicable rules.

Threshold Rule

[sn_fin_gl_threshold_rule]

Defines rules for thresholds in the general ledger, such as 
limits for certain accounts, to ensure compliance with financial 
policies.

Unit of measure

[sn_fin_uom]

Manages the unit of measurement (UOM) standards used 
across financial transactions, including different types like 
kilograms, liters, and hours.

Components installed with Source-to-Pay Common Architecture

Several types of components are installed with the installation of the Source-to-Pay Common 
Architecture application, including tables and user roles.
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Roles installed

Role title [name] Description Contains roles

Accounts Payable Viewer

[sn_shop.accounts_payable_viewer]

Read access 
to purchase 
orders, 
invoices, 
and other 
task-related 
objects that 
arise from 
purchase 
order 
creation.

None

Acknowledgment Task Owner

[sn_shop.acknowledgment_task_owner]

Access to 
all purchase 
orders and 
purchase 
requisitions. 
Read-only 
access to 
the main 
objects, but 
can update 
assigned 
tasks.

None

Business Owner

[sn_shop.invoice_owner]

Access only 
to their own 
invoices and 
related data.

None.

Procurement Administrator

[sn_shop.procurement_administrator]

Access to 
the primary 
data and 
administration 
sections of 
the Purchase 
Automation 
module.

• Procurement Primary Data Admin 
[sn_fin.procurement_primary_data_admin]

• Procurement Specialist 
[sn_shop.procurement_specialist]

Procurement Common Administrator

[sn_shop.procurement_common_admin]

Access to 
all tables, 
including 
deletion of 
records, in 
the Source-to-
Pay Common 
Architecture 
application.

Procurement Common User 
[sn_shop.procurement_common_user]

Procurement Common Reader

[sn_shop.procurement_common_reader]

Read access 
to all tables 
available in 
the Source-to-
Pay Common 

Procurement User 
[sn_fin.procurement_user]
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Role title [name] Description Contains roles

Architecture 
application.

Procurement Common User

[sn_shop.procurement_common_user]

Access to 
perform, 
create, and 
update 
operations on 
all tables in 
the Source-to-
Pay Common 
Architecture 
application.

Procurement Common Reader 
[sn_shop.procurement_common_reader]

Procurement Specialist

[sn_shop.procurement_specialist]

Access 
to all the 
data of the 
Sourcing and 
Purchasing 
Automation 
module, 
except the 
primary data.

• Procurement User 
[sn_fin.procurement_user]

• Contract Manager [contract_manager]

Procurement Specialist_Manager

[sn_shop.procurement_specialist_manager]

Access to the 
Procurement 
Team 
Performance 
Dashboard 
to view your 
organization's 
overall 
performance. 
This role has 
the same 
access as a 
procurement 
specialist, 
except that 
they have 
access to 
the manager 
dashboards.

• Procurement Specialist 
[sn_shop.procurement_specialist]

• Procurement Team Manager 
[sn_spend_psd.manager]

Purchasing Task Owner

[sn_shop.purchasing_task_owner]

Access to 
all purchase 
orders, 
requisitions, 
negotiations, 
sourcing 
requests, and 
purchasing 
tasks.

None

Shopper
Access to 
the Shopping 
Hub  portal 

None
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Role title [name] Description Contains roles

[sn_shop.shopper] to make 
requests and 
purchases.

Shopping Hub  Administrator

[sn_shop.shopping_hub_admin]

Access to all 
modules of 
the Source-to-
Pay Common 
Architecture 
application.

• Decision Table Admin 
[decision_table_admin]

• Procurement User 
[sn_fin.procurement_user]

• Model Manager [model_manager]

• Category Manager [category_manager]

Tables installed

Table Description

Acknowledgement Task

[sn_shop_acknowledgement_task]

Extends the Finance Task table and stores 
acknowledgments such as the milestone and 
receipt task.

Approval Group

[sn_shop_approval_group]

Stores a set of approval rules.

Approval Group Plan

[sn_shop_approval_group_plan]

Stores the approval plans that determine how 
the overall approval process is run.

Approval Plan Detail

[sn_shop_approval_plan_detail]

Stores an instance of the approval record for 
a purchase line that is created based on the 
approval plan.

Approval Reminder Task

[sn_shop_approval_reminder_task]

Extends the Purchasing task table and stores 
information about the specific tasks required to 
complete the approval process.

Approval Rule

[sn_shop_approval_rule]

Stores the rule that triggers the creation of an 
approval record. It uses a condition builder to 
build the trigger condition for approvals.

Approval Rule Composition

[sn_shop_approval_rule_composition]

Stores information about the approval rule and 
its associated approval group.

Attribute

[sn_shop_attribute]

Stores specific attribute types and the values 
that are associated with a product model. For 
example, a laptop can have an attribute for the 
type of memory used, which can be SSD or Hard 
disk.

Attribute Set

[sn_shop_attribute_set]

Stores a group of attribute types that can later 
be associated with a supplier product. For 
example, Memory, Graphic card, and CPU can 
be an attribute set that can be associated with a 
product group.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

15



Table Description

Attribute Type

[sn_shop_attribute_type]

Stores the various types of attributes that are 
used when creating a product attribute.

Capitalization Policy

[sn_shop_capitalization_policy]

Stores the condition based on which an asset is 
capitalized, and a fixed asset record is created.

Cart Delivery

[sn_shop_cart_delivery]

Stores information related to the delivery 
details of items in a shopping cart or purchase 
requisition. It has various details, such as order 
type, delivery location, expected delivery date, 
estimated shipping, payment allocations, and so 
on.

Cart Header

[sn_shop_cart_header]

Stores high-level information about the purchase 
requisition. It has various details, such as 
requisition ID, shopper details, requisition date, 
shopper payable amount, status, and so on.

Cart Line

[sn_shop_cart_line]

Stores the details of a purchase line that is 
added to a cart. It has various details such as 
the supplier product selected, checkout type, 
business owner, delivery location, and so on.

Credit Allocation Rules

[sn_shop_credit_allocation_rules]

Stores the credit allocation rules that are based 
on how a credit is allocated to an individual 
shopper. The allocation can be based on the 
inventory asset or user condition.

Delivery Address Task

[sn_shop_delivery_address_task]

Extends the Purchasing Task table and stores 
the tasks that are associated with verifying and 
validating the delivery location for a purchase 
line.

Delivery Location

[sn_shop_delivery_location]

Stores the delivery location for a given shop line 
or cart line.

Employee Credit

[sn_shop_employee_credit]

Stores the credit amount that is allocated for a 
user with supporting information such as the 
responsible cost center and credit allocation 
rule.

ERP Address Mapping

[sn_shop_erp_address_map]

Stores the mapping between the ERP address 
and the location.

ERP Asset Category Mapping

[sn_shop_erp_asset_category_map]

Stores the mapping between the ERP source and 
the capitalization policy.

ERP Material Group Mapping

[sn_shop_erp_material_group_map]

Stores the mapping between the ERP source, 
model category, and material group.
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Table Description

Handling Fee

[sn_shop_handling_fee]

Stores details about handling fees, which are 
additional charges added to purchase requests 
under specific conditions.

Integration Error

[sn_shop_erp_error_task]

Single table to address all integration errors.

Invoice

[sn_shop_invoice]

Stores important data about shopping invoices 
temporarily before this data is sent to the primary 
table.

Invoice cost allocation

[sn_shop_invoice_cost_allocation]

Stores the allocated invoice line cost across 
multiple cost centers or ledger accounts.

Invoice Line

[sn_shop_invoice_line]

Stores important data about imported invoice 
line temporarily before this data is sent to the 
primary table.

Invoice Payment Detail

[sn_shop_invoice_payment_detail]

Stores important data about supplier data 
temporarily before this data is sent to the primary 
table.

Invoice Tax Line

[sn_shop_invoice_tax_line]

Extends the Base Tax Line table and stores the 
tax lines for purchases that are invoiced.

Job Code

[sn_shop_job_code]

Stores the job codes that are associated with 
business owners that primarily drive the approval 
hierarchy.

Ledger Assignment Rules

[sn_shop_ledger_assignment_rule]

Stores the rules that apply to the supplier 
products, product model or product category, 
and cost center. These rules are based on the 
accounting details, such as the capex and 
expense accounts, that are populated on a 
purchase line.

Milestone

[sn_shop_milestone]

Extends the Acknowledgment Task table and 
stores the acknowledgment of services received.

Negotiation

[sn_shop_negotiation]

Stores the negotiation object that is created for a 
supplier product in a sourcing activity.

Negotiation to Contract Relationships

[sn_shop_m2m_negotiation_contract]

Stores the mapping between the negotiation and 
contract.

Negotiation Event

[sn_shop_negotiation_event]

Stores the negotiation events that are created for 
a supplier product in a sourcing activity.

Non Catalog Intake

[sn_shop_non_catalog_intake]

Extends the Import Set Row table and acts like a 
staging table for the non-catalog intake flow.
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Table Description

Order Template

[sn_shop_order]

Stores all purchase orders. This is a base table.

Order to Contract Relationships

[sn_shop_m2m_order_contract]

Stores the mapping between the purchase order 
and contract.

Order Permission

[sn_shop_m2m_order_users_covered]

Stores the mapping between the purchasing 
permission and purchase order.

Order Line Template

[sn_shop_order_line]

Extends the Shop Line table and stores the 
purchase order line for any purchase order.

Purchase Cost Allocation

[sn_shop_cost_allocation]

Stores the type of cost allocation, associated 
cost center, and the amount that is allocated for 
a shopper that can be used to buy a supplier 
product.

Purchasing Permission

[sn_shop_covered_user]

Stores the purchasing permission for a user, 
group, cost center, or department.

PSM FX Currency

[sn_shop_fx_currency_instance]

Stores the converted Fx2 currency amount into 
legal entity local currency amount and legal 
entity reporting currency amount by using the 
conversion rate from the Finance Exchange 
Rates table.

Pricing

[sn_shop_m2m_product_contract]

Stores the mapping of a supplier product and its 
price that is based on the associated contract.

Product Purchases by Job code and 
Department

[sn_shop_user_product_purchase]

Stores the aggregation of products purchased by 
the job code.

Purchase

[sn_shop_purchase]

Stores the purchase record that is created for 
each purchasing or sourcing activity.

Purchases by Category

[sn_shop_user_category_purchase]

Stores the analytical data for purchases by 
product category.

Product Purchases by Job code and 
Department

[sn_shop_user_product_purchase]

Stores the aggregation of products purchased by 
the job code.

Purchasing Task

[sn_shop_task]

Extends the Finance Task table and stores the 
various tasks that are associated with a purchase 
such as finance and contract tasks.
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Table Description

Purchase Order History

[sn_shop_order_history]

Extends the Order Template table and stores the 
older purchase order record when an order is 
revised.

Purchase Order Line History

[sn_shop_order_line_history]

Extends the Order Line Template table and 
stores the older purchase order line record when 
a purchase order line is revised.

Purchase Order Line

[sn_shop_purchase_order_line]

Extends the Order Line Template table and 
stores the purchase order line for a purchase.

Purchase Order

[sn_shop_purchase_order]

Extends the Order Template table and stores the 
purchase order for a given purchase.

Product Visuals

[sn_shop_supplier_product_artifact]

Stores the artifacts that are used to display 
product appearances on the user interface.

Purchase Requisition

[sn_shop_purchase_requisition]

Stores the purchase requisition for a purchase or 
sourcing activity.

Purchase Line

[sn_shop_purchase_line]

Extends the Request Line table and stores 
the purchase line that is associated with a 
purchasing or sourcing activity.

Purchase

[sn_shop_purchase]

Extends the Order Template table and stores the 
purchase order for a given purchase.

PSM State Mapper

[sn_shop_psm_state_mapper]

Stores the unique states of tasks related 
to negotiation, sourcing request, purchase 
requisition, and procurement case.

Product group

[sn_shop_product_group]

Stores the name that is associated with an 
attribute set that is then referenced by the 
supplier product and product model.

Price Break

[sn_shop_price_break]

Stores the price divided based on the number 
of quantities purchased for a given supplier 
product contract.

Pre-Payment

[sn_shop_pre_payment]

Stores a record of prepayment done for a 
purchase line as per a contract.

Percent Complete Configuration

[sn_shop_percent_complete_config]

Stores the configurations to determine the 
percentage of payment that is completed for an 
order.

Payment Terms

[sn_shop_payment_term]

Stores the term in which a payment would be 
made. For example, a term could be seven days 
after the invoice date.
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Table Description

Payment Methods

[sn_shop_payment_method]

Stores the payment method that is selected 
by the shopper and the cost center or person 
responsible for the payment.

Paycheck Periods

[sn_shop_paycheck_periods]

Stores the number of paychecks through which a 
payment would be made.

Purchase Order Line History

[sn_shop_order_line_history]

Extends the Order Line Template table and 
stores the older purchase order line record when 
a purchase order line is revised.

Receipt

[sn_shop_receipt]

Stores the receipt of a supplier product received 
as part of a purchase order line.

Receipt Task

[sn_shop_receipt_task]

Extends the Acknowledgment Task table and 
stores the state of a receipt confirmation.

Request Line Template

[sn_shop_request_line]

Extends the Shop Line table and stores the 
purchase request line items.

Requisition Additional Info

[sn_shop_requisition_additional_info]

Stores additional details about a purchase 
requisition, including its creation and update 
timestamps, and the users responsible for these 
actions.

Requisition Permission

[sn_shop_m2m_purchasing_users_covered]

Stores the mapping between the purchasing 
permission and purchase requisition.

Requisition to Contract Relationships

[sn_shop_m2m_requisition_contract]

Stores the mapping between the purchase 
requisition and contract.

Revision Request

[sn_shop_revision_request]

Extends the Purchasing Task table and stores the 
state of a revision request for a purchase.

Revision Line

[sn_shop_rev_request_line]

Extends the Request Line Template table and 
stores the revision line for a purchase.

Supplier Use by Department

[sn_shop_dept_supplier_purchase]

Stores the analytics of suppliers that are used by 
departments.

Service Acknowledgment

[sn_shop_invoice_task]

Extends the Acknowledgement Task table and 
stores details about invoice tasks, which are an 
extension of acknowledgment tasks.

Shop Line

[sn_shop_line]

Stores the order line template and request line 
template. This is a base table.
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Table Description

Sourcing to Contract Relationships

[sn_shop_m2m_sourcing_contract]

Stores the mapping between the sourcing 
request and contract.

Shipment Details

[sn_shop_shipment_details]

Stores the shipment details that are associated 
with a purchase order line.

Shipment Product

[sn_shop_shipment_product]

Stores the shipment product details that are 
associated with a purchase order line.

Shipping methods

[sn_shop_shipping_method]

Stores the shipping method details that are 
associated with a purchase order line.

ShoppingHub API Cache

[sn_shop_shopnow_api_cache]

Stores the cached data for quicker access by 
APIs. An example is the CachedCagetoryMap.

ShoppingHub Configuration

[sn_shop_shopnow_content]

Stores configurations that determine certain 
aspects of the application appearance 
and behavior. An example is the terms and 
conditions page URL.

Shopping Control

[sn_shop_shopping_control]

Stores the security rules that determine the 
access of supplier products for a given user.

Sourcing Request

[sn_shop_sourcing_activity]

Stores requests to source for supplier products.

Sourcing Task

[sn_shop_sourcing_task]

Extends the Purchasing Task table and stores the 
tasks that are related to a sourcing request.

Supplier Product

[sn_shop_supplier_product]

Stores the supplier products that represent 
goods or services that can be listed on the 
portal.

Supplier Product View

[sn_shop_supplier_product_view]

Stores the analytics of the number of views for a 
supplier product.

Supplier Use by Shopper

[sn_shop_user_supplier_purchase]

Stores the analytics of suppliers that are used by 
shoppers.

Shopper's Top Suppliers

[sn_shop_usr_preferred_supplier]

Stores the mapping between the shopper and 
preferred supplier.

User Controls

[sn_shop_user_control]

Stores the mapping of a user and a shopping 
control.
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Components installed with ERP Integration Framework

Several types of components are installed with the installation of the ERP Integration Framework 
application, including tables and user roles.

Roles installed

Role title [name] Description
Contains 
roles

Integration user

[sn_fcms_intg.integration_user]
Configure integration setup for the applications 
(SPO, SLO, or APO) with ERP.

None

Scheduled jobs installed

Scheduled 
job

Description

ERP User 
Sync Fetches the list of users mapped under an ERP role in the ERP Role Mapping table. 

Assigns the ServiceNow  user role to users based on the mapping.

Tables installed

Table Description

ERP Role Mapping

[sn_fcms_intg_erp_role_map]
Stores mapping of ServiceNow  and ERP journal 
roles. The mapping helps to assign users to the 
Journal preparer and approver roles in ServiceNow 
applications (SPO, SLO, or APO) when they are granted 
the corresponding role in ERP.

ERP User Mapping

[sn_fcms_intg_erp_user_map]
Stores ServiceNow  and ERP User ID mapping that 
is required for integration to work. The mapping is 
maintained for all active users who have the journal 
preparer or approver role in ERP.

Park Post Response

[sn_fcms_intg_parkpostresponse]

Stores the park and post response from ERP.

Reverse Response

[sn_fcms_intg_reverse_response]

Stores the reverse response from ERP.

Service Element Map

[sn_fcms_intg_service_element_map]
Stores the mapping of the ERP journal Header and Line 
fields with those of the application (SPO, SLO, or APO) 
fields payload.

Service Map Stores mapping for all services to the ERP such as 
Journal Post, Journal Reverse, and Fetch Users.
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Table Description

[sn_fcms_intg_service_map]

Service Queue

[sn_fcms_intg_service_queue]

Stores the requests being sent to ERP.

ERP Source Configuration

[sn_fcms_intg_source]

Maintains ERP details such as credentials and web 
service details.

Finance Case Management
The ServiceNow®  Finance Case Management  application enables your employees and finance 
teams to raise, track, and resolve finance-related requests.

Explore

Learn about the benefits and features 
of Finance Case Management.

Configure

Plan and configure your implementation.

Use

Work on finance requests, and 
manage finance cases, tasks, 

knowledge articles, and interactions.

Reference

Get details about components, such 
as fields, tables, and properties.

Exploring Finance Case Management

Learn about the benefits and capabilities of Finance Case Management.

Benefits

Finance Case Management  offers the following benefits:

• Deflect cases by providing process guidance and knowledge articles.

• Improve case routing so that finance specialists handle only the relevant inquiries, saving time.

• Shorten response times by streamlining finance-related inquiries.
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Finance Case Management  applications

Finance Case Management  uses the following applications:

Employee Center

The Employee Center provides a self-service option for finance inquiries and 
requests. This enables employees to manage tasks related to finance requests, and 
provides visibility and transparency of finance processes.

Finance Operations Workspace

Finance Operations Workspace  provides a single system of action to manage and 
prioritize work. The application displays critical information to prioritize work, and it 
eliminates tool sprawl.

Exploring the Finance Operations Workspace

The Finance Operations Workspace  is a single system to manage and prioritize work.

Finance Operations Workspace  landing page

As a Finance Specialist (sn_fin_ops.specialist), view a summary of the important items, your 
performance, and recent activities on your cases.

The landing page has the following 

components.
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Components in the Finance Operations Workspace landing page

Component Description

Important items

Cases pending final action View the cases that need a final action. The 
pending cases are displayed with the case 
number, requested by, assignment group, 
assigned to, state, priority, and date of creation 
fields.

Tasks assigned to you View the active tasks assigned to you.

Unassigned cases View the list of unassigned cases.

My performance

My assigned cases by type A visual representation of the active cases 
assigned to you, grouped by case type. Select 
each segment to view the list of cases.

My assigned cases by priority A visual representation of the active cases 
assigned to you, grouped by priority. Select 
each segment to view the list of cases.

Recently updated cases

My active cases View up to five of your active cases. Select 
View all  to view all your active cases. The 
finance cases open in the Finance Operations 
Workspace, while the other cases and tasks 
that you have access to open in the Source-to-
Pay Workspace.

Finance Operations Workspace  list page

View a high-level information of all records in a list filter from the Finance Operations Workspace 
list page.

In the Finance Operations Workspace, select the List icon  to open the List page.

You can select each module and submodule to view the details in a list. Under Lists, you can do 
the following:

• Refresh the list to display the most updated information.

• Edit columns to adjust the list to display required columns in the order of your choice.

• Reset column widths to default.

• Copy the URL for this list.

• Apply filters to view specific information that you're interested in.

• Export the list to a file in Excel, CSV, JSON, or PDF format.

• Create a copy of the list and save it under My Lists.

Note:  The List menu component is configured by admins in UI Builder. For information on 
List menu component configurations, see List menu UIB Setup .

As a finance specialist, you have access to the following modules and submodules:
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Modules and submodules

Modules Submodules

My work • Open cases

• Open tasks

• Open interactions

Review needed • Unassigned cases

• Unassigned tasks

All work • Cases

• Closed cases

• Tasks

• Closed tasks

• Interactions

• Closed interactions

Interactions • All

• Active

• Assigned to me

Primary data Cost center

Knowledge Finance articles

View a case from Finance Operations Workspace

View a case from the Finance Operations Workspace  for further processing.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations Workspace, select the List icon ( ) to open the List page.

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. Select a case number link from the Number column.
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Result
The details of finance cases are displayed on the Details  tab of the Finance Operations 
Workspace. For more information, see Finance Operations Workspace Case Details 

page.

If you have access to the Source-to-Pay Workspace, you can see invoice, procurement, and 
supplier cases in the list. If you open any of these cases, the details of the case are displayed in 
the Source-to-Pay Workspace.

Finance Operations Workspace  Case Details page

The Finance Operations Workspace  Case Details page is displayed when you select the link of a 
finance case.

On the Finance Operations Workspace, navigate to Lists  > My work  > Open cases. Select a 
case number link from the Number column to open the Finance Case Details page.

The Finance Case Details page contains the following options:
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Finance Case Details page

Option Description

Multi-tab interface For each finance case, the details are 
displayed in tabs. For more information, see 
Finance Case form tabs

Compose • Work notes (Private): Enter information that 
must be private to the logged-in user.

• Comments: Enter details that are visible to 
everyone.

• Email: Send emails related to the finance 
case. For more information on sending 
emails, see Send emails from Finance 
Operations Workspace

Activity stream Displays processing activities, comments, and 
changes to the state of the case. You can filter 
activities by post types, field changes, and 
flagged activities.

Contextual side panel Includes options to access Agent assist and 
add attachments related to the finance case.

Send emails from Finance Operations Workspace

Send emails related to a specific finance case.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. From the Compose section, select Email.

5. Enter the recipient name in the To  field.
You can also select Cc  or Bcc  and enter the names.

6. Change the subject, if necessary.
By default, the subject is the finance case number and the short description.

7. Enter the email body, if necessary.
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By default, the email body contains the link to the finance case. You can also use the email 
templates. For more information on email templates, see Email templates .

8. Select Send 

mail.

Result
The email is sent to the recipients. You can view the details of the sent email in the Emails  tab.

Agent assist  in Finance Operations Workspace

Agent assist  displays relevant search results based on the search text. The text is defaulted with 
the short description of the finance case you’re working on.

Agent assist  is part of the contextual side panel in the Finance Operations Workspace. By 
default, it displays resolved finance cases. You can edit the search text, as required. These 
search results help you to work on the record.

For resolved finance cases, the card displays the following:

• Short description of the finance case

• Finance case number

• Current state of the finance case

• The person to whom the finance case is assigned

Select the card to view the following additional details of the case:

• Date when the case was opened

• Priority of the finance case

• Group to which the finance case is assigned

• Person to whom the finance case is assigned

• Reason for closing the finance case

You can also search for knowledge articles. Select the search resource icon ( ) and select 
Knowledge Articles  to view the articles.
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The Agent assist component is configured and customized by admins in UI Builder. For more 
information about Agent assist component configurations, see Agent assist UIB setup .

Interaction management in Finance Operations Workspace

Any finance request made through chat is logged in an auto-generated interaction record. 
Specialists can choose to create a case from the interaction record, create a request, and 
associate an interaction record with an existing finance case record.

The Details  tab of an interaction record contains details of the interaction.

For more details on the fields, see Interaction form.

Finance Operations Workspace  inbox

Use the inbox to manage your incoming work items, such as chats and cases.

To open the agent inbox, select the Inbox icon ( ) in the Finance Operations Workspace.

The inbox displays the queues that are assigned to you, the number of active chats in each 
queue, and the average wait time for chats in the queue.

When you accept a chat, an interaction record is automatically created. The record captures the 
work done in that session.
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Create a new interaction

An interaction record is automatically created when you accept a chat through the chat queue 
in the Finance Operations Workspace. You can also manually create an interaction from the list 
page of the Finance Operations Workspace.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ Interactions  > All

◦ Interactions  > Active

◦ Interactions  > Assigned to me

4. Select New.

5. On the form, fill in the fields.
For more information on the form fields and descriptions, see Interaction form

6. Select Save.

Create a finance case from an interaction

An interaction record is automatically created when you accept a chat through the chat queue in 
the Finance Operations Workspace. You can create a finance case from an interaction record for 
further investigation.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ Interactions  > All

◦ Interactions  > Active

◦ Interactions  > Assigned to me

4. From the Number column, select a link to open an interaction record.

For more information on the fields in an interaction record, see Interaction form.
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5. Select Create Finance 

Case.
For more information on the form fields and descriptions, see Create a finance case.

6. Select Save.
A new finance case is created. For information on viewing finance cases, see View a case from 
Finance Operations Workspace

Associate an interaction with a finance case

Associate an interaction record to a finance case, if the interaction is related to an existing 
finance case.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ Interactions  > All

◦ Interactions  > Active

◦ Interactions  > Assigned to me

4. From the Number column, select a link to open an interaction record.

5. Select the More actions icon ( ).
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6. Select Associate Record.

7. On the Create New Interaction Related Record form, fill in the fields.
For more information on the form fields and descriptions, see Create new interaction related 
record form.

8. Select Save.

Process Automation Designer flows for playbook

Workflow Studio Playbooks enables you, as a business playbook owner, to organize Workflow 
Studio content into unified and digitized cross-enterprise processes.

You can customize the Playbook experience with your own configurations and activity overrides. 
The automated business processes that you design guide your end users and help them focus 
on the tasks and information that matter to them.

For information on Playbooks, see Playbooks .

Configuring Finance Case Management

Plan and configure your implementation for Finance Case Management.

Install Finance Case Management

Install the Finance Case Management  application (sn_fin_ops) if you have the admin role. The 
application includes demo data and installs related ServiceNow®  Store  Store applications and 
plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Finance Case Management listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin

About this task
The following items are installed with Finance Case Management:

• Plugins

• Roles

• Tables

The Finance Case Management application (sn_fin_ops) installs the following dependent 
plugins:

• Finance Operations Workspace (sn_fin_ops_ws)

• Common Service Delivery (sn_spend_sdc)
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Procedure

1. Navigate to All  > Application Manager.

2. Find the Finance Case Management  application (sn_fin_ops) using the filter criteria and 
search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.
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4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.
Select the Installed  tab and see the installed application and dependent 

plugins.

Components installed with Finance Case Management

Several types of components are installed with the activation of the Finance Case Management 
plugin, including roles, flows, and tables.

Roles installed

The following roles are installed with Finance Case Management:

List of roles installed

Role title [name] Description Contains roles

sn_fin_ops.admin Can access all the features 
and capabilities of Finance 
Case Management, including 
Finance Operations 
workspace

• sla_admin

• sn_fin_ops.specialist

sn_fin_ops.requester Can create finance-related 
cases

sn_fin_ops.specialist Can view and update the 
finance-related cases

• sn_fin_ops.requester

• workspace_user
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List of roles installed  (continued)

Role title [name] Description Contains roles

• canvas user

• email_composer

sn_fin_ops.task_owner Can view and update the 
tasks associated with the 
finance case

Tables installed

No new tables are installed with Finance Case Management. However, the labels of the following 
tables are changed:

List of tables installed

Table New label Description

sn_spend_sdc_service_request Finance case Stores the finance cases

sn_spend_sdc_service_request_lineFinance case lines Represents individual items 
or components related to the 
finance case

sn_spend_sdc_service_task Finance task Stores the finance tasks

Application plugin installation sequence in Finance Case Management

View the consolidated list of plugins, high-level description of each plugin, and the 
dependencies that are required before installing each plugin in Finance Case Management.

Application plugin list

Plugin name Description Dependencies

Finance Common Architecture 
(sn_fin)

Maintains primary data such 
as Enterprise Resource 
Planning (ERP) sources, legal 
entities, accounting periods, 
and so on.

-

Common Service Delivery 
(sn_spend_sdc)

Contains Finance Case, 
Finance Case Line, and 
Finance Task.

Finance Common Architecture 
(sn_fin)

Finance Operations 
Workspace (sn_fin_ops_ws)

Provides a single environment 
for finance specialists to work 
on finance cases, finance 
tasks, and more.

-
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Plugin name Description Dependencies

Finance Case Management

(sn_fin_ops)

Maintains primary data to 
raise, track, and resolve 
finance-related requests.

• Finance Common 
Architecture (sn_fin)

• Common Service Delivery 
(sn_spend_sdc)

• Finance Operations 
Workspace (sn_fin_ops_ws)

Source-to-Pay Common 
Architecture (snc.sn_shop)

Maintains primary data such 
as Enterprise Resource 
Planning (ERP) sources, legal 
entities, accounting periods, 
and so on.

• Finance Common 
Architecture (sn_fin)

• Common Service Delivery 
(sn_spend_sdc)

Advanced Work Assignment 
for Source-to-Pay Operations 
(snc.sn_spend_awa)

Provides configurations to 
support automatic routing, 
queuing, and assignment of 
finance cases and emails.

Advanced Work Assignment 
(glide.awa)

Activate the Create Finance Inquiry for inbound email flow

Activate the Create Finance case on Inbound email inquiry  flow to create a finance inquiry case 
automatically based on the information in an inbound email.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and select the Create Finance case on Inbound email inquiry  flow to open it.
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3. Select the more actions icon ( ), scroll, and select Copy 

flow.
The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Finance Case Management.

6. Select Copy.
A copy of the flow opens.

7. Under TRIGGER, specify the conditions that trigger this flow.
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8. Select 

Done.

9. Save and select Activate.
The Create Finance case on Inbound email inquiry  flow is activated and a finance inquiry 
case is created automatically based on the information in an inbound email.

Configuring Finance Operations Workspace

Plan and configure your implementation for Finance Operations Workspace.

Configure the Finance Operations Workspace  landing page

Configure the landing page of the Finance Operations Workspace

Use UI Builder  to configure the landing page, define different audiences for the landing page, and 
even add, remove, or modify the different content However, it’s recommended that you create a 
duplicate of the landing page before modifying it.

For more information on how to configure using UI Builder, see Create a page in UI Builder .

Configuring knowledge bases from the Finance Operations Workspace

Configure a knowledge base so that guest users can publish the knowledge base articles from 
the Finance Operations Workspace.

Enable guest users to publish knowledge base articles from the Finance Operations 
Workspace

To enable guest users to publish a knowledge article, add them to the Can Read list of the 
corresponding knowledge base in the Finance Operations Workspace.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Select the knowledge base that you want to configure.
For example, select Finance Case Management Knowledge base.

3. On the Can Read related list, select Edit.

4. In the Collection list, search for the Finance Operations Users  role.

5. Move the Finance Operations Users  role from the Collection list to the Can Read list.

6. Select Save.
A guest user can now publish a knowledge article from the Finance Operations Workspace.

Publish a knowledge base article

After creating a knowledge base article, publish the article from the Finance Operations 
Workspace

Before you begin
Role required: admin

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Knowledge, and then select Finance articles.

4. Under the Number column, select the link to a knowledge base article to open it.
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5. Select 

Publish.
A confirmation message appears, notifying you that the article is published.

Using Finance Case Management

Finance specialists can create, track, and resolve finance requests efficiently.

Using the Employee Center

Finance requesters can use the Employee Center  to create finance inquiry, view the requests 
and tasks, and interact with the live agent.

Submit a finance request from Employee Center  catalog

Ask any general finance-related question.

Before you begin
Role required: sn_fin_ops.requester/ sn_cbs.requestor

Note:  The sn_cbs.requestor role is for you to access the finance request form in the Core 
Business Suite  application.

Procedure

1. Navigate to All  > Self-Service  > Employee Center.

2. Select Finance.

3. Select Finance request.

4. On the form, fill in the fields.
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Submit finance request form

Field Description

Briefly, what is your request about? Short description of your request.

What can we help you with? Detailed description of your request.

Add attachments Attachments related to your request.

5. Submit or save the request.

◦ To submit the request, select Submit.

◦ To save your request and modify later, select Save as Draft.

What to do next
Select My Requests  to view and track the progress of your requests.

View finance articles

View finance articles from the Employee Center.

Before you begin
Role required: sn_fin_ops.requester, sn_fin_ops.specialist

Procedure

1. Navigate to All  > Self-Service  > Employee Center.

2. Select Finance.

3. Select Finance articles.

Result
You can view the Understanding General Finance Inquiries knowledge article.

Using the Finance Operations Workspace

Finance Specialists can use the Finance Operations Workspace  to manage cases, tasks, 
knowledge articles, or interactions.

Create a finance case

Create a finance case on behalf of a requester to track the progress.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases
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4. Select New  from within a submodule.

5. From the Case type drop-down list, select Finance Inquiry.

6. Select Submit.
The Create New Finance Case form opens in a new tab in the Finance Operations Workspace. 

Note:  If you have access to Source-to-Pay Workspace and if you select a case type 
related to Source-to-Pay operations, the new form opens in a new browser tab in the 
Source-to-Pay Workspace.

7. On the Create New Finance Case form, fill in the fields.
For more information on the form fields and descriptions, see Create a finance case form.

8. Select Save.
A new finance case is created. For more information on viewing finance cases, see View a case 
from Finance Operations Workspace.

Assign a finance case to yourself

As a finance specialist, assign a finance case to yourself from the Finance Operations 
Workspace. Start resolving it.

Before you begin
Role required: sn_fin_ops.specialist
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Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations Workspace, select the List icon ( ) to open the List page.

3. From the list page, navigate to either of the following submodules:

◦ Review needed  > Unassigned cases

◦ All work  > Cases

4. Select a case number link from the Number column.

5. Select Assign to me.

Note:  The Assign to me  option is available only for unassigned cases that are in draft 
state.
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The case is assigned to you and the state is Work in Progress. 

6. Select Save.

Accept a finance case

As a finance specialist, if a finance case is assigned to you, accept the case to start resolving it.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ) to open the List page.

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. Select a case number link from the Number column.

5. Select Accept.

Note:  The Accept  option is available only if the cases assigned to you are in the draft 
state.
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Accept draft finance cases assigned to you

The state of the accepted case changes to Work in Progress.

6. Select Save.

Request additional information for a finance case

Request additional information from the requester to continue working on the finance inquiry 
case.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. From the list page, navigate to either of the following submodules:

◦ My work  > Open tasks

◦ All work  > Tasks

3. From the Number column, select a link to open the finance inquiry case.

4. Select the more actions icon ( )

5. Select Request info.
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Note:  The Request info  option for a finance case is available only if:

◦ The case is assigned to you.

◦ The requester is available.

◦ The case is in Work in Progress state.

6. In the Request Info dialog, provide the reason for requesting additional information.

7. Select Request info.

Result
You can see the reason in the activity stream. The requester receives an email requesting 
additional information.

Search for finance cases

As a finance specialist, search for finance cases from the Finance Operations Workspace.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.
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2. In the global search, enter the finance case 

number.

Note:  If you have access to the Soure-to-Pay workspace, you can also search for 
relevant cases in that workspace.

Result
The search results show the finance case, if it exists.

Initiate sidebar discussions

Start a sidebar discussion to collaborate with stakeholders while working on a finance inquiry 
case.

Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ) to open the List page.

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. Select a case number link from the Number column.

5. Select Discuss.

6. Add stakeholders to the discussion.

7. Select Start discussion.
A new side bar discussion is initiated.
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Result
The stakeholders are notified when you add them to a discussion. They can join the discussion 

by selecting the Sidebar discussions icon ( ).

What to do next
For more information on the sidebar, see Sidebar .

To learn more about using the sidebar, see Using Sidebar .

For information on the activity stream in the sidebar is, see Activity stream in Sidebar .

Create a finance task

Create a finance task and associate it to a finance case.

Before you begin
Role required: sn_fin_ops.admin, sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( )

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open tasks

◦ All work  > Tasks

4. Select New  from within a submodule.

5. From the Case task drop-down list, select Finance task.
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6. Select Submit.
The Create New Finance Task form opens in a new tab in the Finance Operations Workspace.

Note:  If you have access to Source-to-Pay Workspace and if you select a task type 
related to Source-to-Pay operations, the new form opens in a new browser tab in the 
Source-to-Pay Workspace.

7. On the Create New Finance Task form, fill in the fields.
For more information on the form fields and descriptions, see Create a finance task form.

8. Select Save.

Create a finance task from a finance case

Create a finance task from a finance case. Assign the task to a task owner or group to resolve that 
case.

Before you begin
Role required: sn_fin_ops.specialist, sn-fin-ops.admin

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. From the Number column, select a link to open the finance inquiry case.

5. Select the Tasks  tab, and then select 

New.

6. On the Create New Finance Task form, fill in the fields.
For more information on the form fields and descriptions, see Create a finance task form.

7. Select Save.

Close a finance case

Close a finance case after all the activities and tasks for resolving the case are complete.
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Before you begin
Role required: sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( ).

3. From the list page, navigate to either of the following submodules:

◦ My work  > Open cases

◦ All work  > Cases

4. In the Number column, select the link to open the case.

5. Select Close.
The Close dialog box is displayed.

6. From the Closure code, select one of the following options:

◦ Duplicate request

◦ Canceled/False inquiry

◦ Canceled by caller

◦ Information provided

7. In the Closure notes  field, enter the reason for closing the case.

8. Select Close.

Result
The case moves to the Closed complete state, the associated open tasks are closed, and the 
details in the Closure section are filled.
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Create a knowledge base article

Create knowledge base articles for finance-related topics.

Before you begin
Role required: sn_fin_ops.admin, sn_fin_ops.specialist

Procedure

1. Navigate to either of the following:

◦ All  > Finance Operations  > Finance Operations Workspace.

◦ Workspaces  > Finance Operations Workspace.

2. In the Finance Operations workspace, select the List icon ( )

3. From the list page, navigate to Knowledge  > Finance articles.

4. Select New.

Note:  In the current version, the New  button to create a knowledge base article from the 
Finance Operations Workspace  is non-functional. For information on a workaround, see 
the knowledge base article KB2097952 .

5. In the Create article dialog box, do the following:

◦ From the Knowledge Base  field, select Finance Case Management Knowledge Base

◦ From the Article Template  field, select Standard.

◦ Select Create Article.

6. On the Create New Knowledge form, fill in the fields.
For more information on the form fields and descriptions, see Create knowledge base article 
form.

7. Save the article.

What to do next
Publish the knowledge article. For information, see Publish a knowledge base article.

Finance Case Management reference

Reference topics provide additional information about the lists and forms that you use in Finance 
Case Management.

Create a finance case form

Use the Create New Finance Case form to enter finance case details and provide resolution 
information.

Create New Finance Case form

Field Description

Finance Case

Number System-generated unique identifier for the 
case.

State Status of the case:
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Create New Finance Case form  (continued)

Field Description

• Draft

• Work in Progress

• Closed complete

Priority Urgency of case.

Case type Type of case, such as Finance inquiry.

Requested by Owner of the case.

Opened Creation date of the case.

Channel source Channel used to send the inquiry.

Short description Brief description of the case.

Description Detailed description of the case.

Assignment

Assignment group Group that can fulfill the case.

Assigned to Person assigned to work on the case.

Watch list Person who is notified about the status of the 
case.

Closure

Closure code Reason for closing the case.

Closed by Person who closed the case.

Closed Date and time of closing the case.

Closure notes Details related to closing the case.

Finance Case form tabs

The Finance case form includes tabs that store finance case information that a finance specialist 
can use to perform related tasks.

Finance case form tabs

Tab Description

Details Details about the case.

Tasks Tasks that the finance specialist created for this case.

Emails Emails sent or received while resolving this case.

SLAs Service level agreements (SLAs) associated with the case.

• For assigning finance cases, SLA is 4 hours duration, between 08:00 to 
17:00 on weekdays, excluding holidays.

• For processing finance cases, SLA is 16 hours duration between 08:00 to 
17:00 on weekdays, excluding holidays.
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Finance case form tabs  (continued)

Tab Description

Finance admins can view and create SLAs by navigating to All  > Finance 
Operations  > Administration  > Finance case SLA Definitions.

Related cases Other cases related to this case.

Interactions All interactions related to this case.

Cases by same 
requester

Cases that are opened by the same requester.

Create a finance task form

Use the Create New Finance task form to provide details about the finance task.

Finance task form tabs

Tab Description

Number System-generated unique identifier for the task.

State Status of the task:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of task.

Related 
case

Case associated with the task.

Assignment 
group

Group that you want to assign this task. You can assign the task to any group. 
Members who have the Finance roles can see and work on the task.

Assigned to Person that you want to assign this task to. You can assign the task to any person. 
Persons who have the Finance roles can see and work on the task.

Short 
description

Brief description about the task.

Description Detailed description about the task.

Interaction form

For an auto-generated interaction record, the Details  tab contains details of the interaction.

Fields in the Details tab

Field Description

Number Auto-generated unique interaction number.

Opened for Name of the user.
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Fields in the Details tab  (continued)

Field Description

Type Channel through which interaction is created. 
For example, chat.

Assigned to Name of the assigned agent.

State Status of the interaction

Application Type of application. For example, Finance 
Case Management.

Short description Brief description of the interaction.

Work notes Additional notes about the interaction record.

Create new interaction related record form

Use the Create New Interaction Related Record form to provide details about the associated 
finance case.

Create New Interaction Related Record form

Field Description

Interaction System-generated interaction number.

Record Type Type of record created for a case or 
knowledge topic.

Document table Finance case name that you want to associate 
with the interaction record.

ID of related record ID of a related record. This field is auto-
populated after you select Document table.

Email notifications from Finance Case Management

Finance Case Management  sends email notifications when you perform certain actions on a 
finance case.

Finance Case Management  sends emails in a predefined template and uses email actions to 
trigger email conditions. You can use the deep links in the emails to view relevant details.

Email conditions and recipients

Email conditions Recipients

A new finance case is created. Email sender, case submitter, or requester

A new task is created for a finance case and 
assigned to a task owner.

Assigned task owner

A finance case is closed. Requester

A comment is added to the finance case. User addressed in the comment

A request for additional information is made. Requester

Create knowledge base article form

Use the Create New Knowledge form to provide details about the knowledge base article.
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Create knowledge base article form

Field Description

Number System-generated unique identifier for the knowledge base article.

Knowledge 
base

Knowledge base to which this article belongs, such as Finance Case 
Management Knowledge Base.

Category Category of the article. Use the category picker to select an existing category or 
subcategory.

Scheduled 
publish date

Future date on which the article is published automatically. If approvals are 
enabled, the approval process must be completed before this date.

Valid to Validity of the article.

Version Read-only field managed by the Knowledge Management process whenever 
changes are made to a published article.

Article type Type of article, such as HTML.

Workflow Status of the article.

Source Task Name of the article source.

Attachment 
link

Link to attachments.

Display 
attachments

Display of attachments in the article. Select this option to display attachments in 
the article.

Short 
description

Short description of the article.

Article body Detailed description of the article.

Now Assist for Finance and Supply Chain
Use the ServiceNow®  Use Now Assist for Finance and Supply Chain to help fulfillers and 
requesters quickly summarize cases, including procurement, supplier, and invoice records, 
keeping them informed of progress and next steps.

Get started

Now Assist for Finance and Supply Chain

Now Assist for Common 
Finance and Supply 

Chain features

Learn about Now Assist 
for Common Finance and 

Supply Chain features

Now Assist for 
Sourcing and 

Procurement Operations

Learn about Now 
Assist for Sourcing and 

Procurement Operations

Now Assist for Supplier 
Lifecycle Operations

Learn about Now 
Assist for Supplier 

Lifecycle Operations
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Now Assist for Finance and Supply Chain (continued)

Now Assist for Accounts 
Payable Operations

Learn about Now 
Assist for Accounts 
Payable Operations

Now Assist for Common Finance and Supply Chain features
Use Now Assist for Common Finance and Supply Chain features to summarize purchase orders 
and keep fulfillers informed of their status, progress, and required actions.

Get started

Explore

Learn more about 
Common Finance and 
Supply Chain features

Configure

Configure the Common 
Finance and Supply Chain 

features to get started

Use

Use generative AI 
capabilities offered by Now 
Assist for Common Finance 
and Supply Chain features

Important:  Some Now Assist  products/features are currently unavailable for customers 
in the FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the KB0743854
article in the Now Support  Knowledge Base. Please check for availability updates in future 
releases.

Troubleshoot and get help

• ServiceNow Community on AI and Intelligence

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support.

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-
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making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .

Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. Customers can opt out of future data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Explore Now Assist for Common Finance and Supply Chain features

Use Now Assist for Common Finance and Supply Chain features to summarize purchase orders 
and keep fulfillers informed of their status, progress, and required actions.

Overview of Now Assist for Common Finance and Supply Chain features

With Now Assist for Common Finance and Supply Chain, fulfillers can leverage generative 
AI-powered summarization to quickly gain a clear understanding of purchase orders. These 
summaries provide visibility into completed actions, current status, and upcoming steps, 
empowering fulfillers to take timely and informed actions.

The summarization capability is available in the Source-to-Pay Workspace.

Note:  You can install this application only if you're entitled to the Sourcing and 
Procurement Operations Pro Plus SKU or the Source-to-Pay Operations Pro Plus SKU.

Now Assist skills for Common Finance and Supply Chain features

Purchase order summarization for fulfillers: Summarize purchase orders and keep fulfillers 
informed about their current status, progress, and action items.

As a fulfiller (sn_fsc_genai.now_assist_fulfiller), you can use summarize purchase orders in the 
Source-to-Pay Workspace  for the following products:

• Sourcing and Procurement Operations

• Supplier Lifecycle Operations

• Accounts Payable Operations
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For more information on configuring Now Assist for Common Finance and Supply Chain features, 
see Configuring Now Assist for Common Finance and Supply Chain features.

To learn more about how to use Now Assist for Common Finance and Supply Chain features, see 
Using Now Assist for Common Finance and Supply Chain features

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

Related topics

Explore Now Assist for Sourcing and Procurement Operations (SPO)

Explore Now Assist for Supplier Lifecycle Operations (SLO)

Exploring Now Assist for Accounts Payable Operations (APO)

Supporting information for Now Assist for Common Finance and Supply Chain features

Get a quick overview of the important information that is related to the Now Assist for Sourcing 
and Procurement Operations (SPO)  application.

Supported versions

Now Assist for Common Finance and Supply Chain features is supported starting with 
Yokohama.

Supported user interfaces

The Now Assist for Common Finance and Supply Chain features application includes the skills 
that are listed in the following table.

Interface Skills

Source-to-Pay Workspace Purchase order summarization for fulfillers

Required roles

To use Now Assist for Common Finance and Supply Chain features, you need the roles listed in 
the following table.

Role Description

admin Installs the Now Assist for SPO, Now Assist for SLO, or Now 
Assist for APO  plugins, and activates the Purchase order 
summarization for fulfillers skill.

sn_fsc_genai.now_assist_fulfiller Generates summaries for purchase orders in the Source-to-
Pay Workspace  workspace.

Licensing requirements

The Now Assist for Common Finance and Supply Chain application requires the Source-to-Pay 
Operations Pro Plus SKU.
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Application information

The Now Assist for FSC Common store app (sn_fsc_genai) includes the Purchase order 
summarization for fulfillers skill.

To use Now Assist for FSC Common (sn_fsc_genai) with SPO, SLO, or APO, install the 
corresponding plugins as required:

• Now Assist for SPO  (sn_spend_gen_ai).

Now Assist for SLO  (sn_supplier_gen_ai)

• Now Assist for APO  (sn_ap_gen_ai)

For more information, see Configuring Now Assist for Common Finance and Supply Chain 
features.

Now Assist roles for Common Finance and Supply Chain features

Grant fulfiller, requester, and supplier user roles to access the Common Finance and Supply 
Chain features powered by generative AI along with the product specific Now Assist features.

Roles installed

Role title [name] Description Contains roles

Now Assist  for FSC Common

sn_fsc_genai.now_assist_fulfiller Contains 
fulfiller role to 
access Finance 
and Supply 
Chain common 
generative AI 
features

now_assist_panel_user

sn_fsc_genai.now_assist_requester Contains 
requester 
role to access 
Finance and 
Supply Chain 
common 
generative AI 
features

sn_fsc_genai.now_assist_supplier Contains 
Now Assist 
supplier role to 
access Finance 
and Supply 
Chain common 
generative AI 
features

Now Assist for Accounts Payable Operations (APO)

sn_ap_gen_ai.now_assist_fulfiller Contains 
fulfiller role 
to access 

sn_fsc_genai.now_assist_fulfiller
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Role title [name] Description Contains roles

Now Assist 
for Accounts 
Payable 
Operations

sn_ap_gen_ai.now_assist_supplier Contains 
supplier role 
to access Now 
Assist  features 
for Accounts 
Payable 
Operations

sn_fsc_genai.now_assist_supplier

Now Assist for Sourcing and Procurement Operations (SPO)

sn_spend_gen_ai.now_assist_fulfiller Contains 
fulfiller role 
to access 
generative AI 
features for 
Sourcing and 
Procurement 
Operations

sn_fsc_genai.now_assist_fulfiller

sn_spend_gen_ai.now_assist_requester Contains 
requester 
role to access 
generative AI 
features for 
Sourcing and 
Procurement 
Operations

sn_fsc_genai.now_assist_requester

Now Assist for Supplier Lifecycle Operations (SLO)

sn_supplier_gen_ai.now_assist_fulfiller Contains Now 
Assist  fulfiller 
role to access 
generative 
AI features 
for Supplier 
Lifecycle 
Operations

sn_fsc_genai.now_assist_fulfiller

sn_supplier_gen_ai.now_assist_supplier Contains Now 
Assist  supplier 
role to access 
generative 
AI features 
for Supplier 
Collaboration 
Portal

sn_fsc_genai.now_assist_supplier

Configuring Now Assist for Common Finance and Supply Chain features

If you have the admin role, you can configure the Now Assist for Common Finance and Supply 
Chain features application so that your fulfillers can use the agentic AI skills in Source-to-Pay 
Workspace  Workspace and Core UI.
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Before you begin
Role required: admin

About this task
Use the Now Assist Admin  console to configure Now Assist for Common Finance and Supply 
Chain features. This console contains everything that you need to install the plugins and 
configure the agentic AI skills. For additional information, see Now Assist Admin console .

The following table lists the Now Assist for Common Finance and Supply Chain features and 
skills that you can access from the Now Assist Admin  console.

Now Assist for Common Finance and Supply Chain features features and skills in the Now 
Assist Admin  console

Now Assist for SPO  skills Description

Purchase order summarization for fulfillers Summarize purchase orders and keep fulfillers 
informed on their status, progress, and 
required actions.

Now Assist skills for Common Finance and Supply Chain features

Procedure

1. Install the Now Assist for FSC Common (sn_fsc_genai) plugin.

◦ For information about the plugin dependencies and plugin activation order, see Supporting 
information for Now Assist for Common Finance and Supply Chain features.

◦ For information about the installation process, see Install Now Assist plugins .

2. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Skills  tab of the Now 
Assist Admin  console.

3. Expand the Finance & Supply Chain  workflow group and select Common Finance and Supply 
Chain features.

4. Activate and configure the skills for Now Assist for Common Finance and Supply Chain 
features.

Skills Action

Purchase order 
summarization for fulfillers

On the Purchase order summarization for fulfillers skill card, 
select Activate skill  to activate the skill.

5. Select General Details  and review the details about the skill and select Save and continue  to 
go to the next step in the Guided Setup.
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6. Follow the steps to configure and activate a skill using the Guided Setup.

7. Select Choose input  and review the base input table and input fields, and then select Save 
and continue  to go to the next step in the Guided Setup.

8. Optional:  Select Customize and test prompt  to test the prompt on a record.

9. Select Save and continue  to go to the next step in the Guided Setup.

10. Optional:  Select Define Availability  and choose one of the following options.

Option Description

Skill is always available Skill is always available to users.

Customize skill availability

The skill is available only when the certain 
conditions are met (Default).

(Optional) Use the condition builder to set 
your conditions.

11. Select Save and continue  to go to the next step in the Guided Setup.

12. Choose Select display  to determine where you'd like to display the skill.

Option Description

In-product desktop

The Purchase order summarization for fulfiller 
skillis displayed in the Source-to-Pay Work­
space  for Sourcing and Procurement Opera­
tions, Supplier Lifecycle Operations, and Ac­
counts Payable Operations.

Now Assist  panel

Now Assist  skills are available in the Now As­
sist  panel. Turn on multi-language support for 
user-entered text with Dynamic Translation 
in Now Assist applications. For more informa­
tion, see Configure multilingual service for 

.

Note:  If you don't see this option, you 
must activate the Now Assist  panel. For 
more information, see Activate Now As­

.

13. Select Save and continue  to go to the next step.

14. Review your choices and select Activate  to complete the configuration for the skill.

15. Select Return to Common Finance & Supply Chain features.
The skill is activated.

Customize a Now Assist for Common Finance and Supply Chain features skill

If you have the admin role, you can customize a Now Assist for Sourcing and Procurement 
Operations (SPO)  skill so that fulfillers and requesters can use the generative AI skills in Source-
to-Pay Workspace, Shopping Hub, and in Core UI.

Before you begin
Role required: admin
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About this task
From the Now Assist Admin  console, you can select the input table, related records, and fields 
for each input template of the Summarization for fulfillers skill, and then configure the prompt 
headers to include in the general summary.

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Skills  tab of the Now 
Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Common Finance and Supply Chain 
features  to view the skills for the Now Assist for Common Finance and Supply Chain features.

3. Create a copy of a skill and customize the input fields.

a. On the Purchase order summarization for fulfillers feature card, select the More actions icon 

( ).

b. Select Make a copy.
A guided setup leads you through the configuration of the general details, input, prompt, 
availability, display, review, and activation of the customized skill. If you complete the entire 
walk-through, the skill is activated.

4. In the General details step, fill in the fields.
For information about the inputs and triggers for each skill, see Skill inputs for Now Assist for 
Sourcing and Procurement Operations (SPO).

a. Enter a name and description for the skill.

b. Select Save and continue  to go to the next step.

5. View the input data for each skill, such as the base input fields and related lists for the different 
input templates.

Configure the base input table fields and related lists for the different input templates for the 
skill.

Each skill relies on a base input table and input fields with descriptions to provide context for 
the Now LLM Service  to generate a response.

Select only those related tables that are offered as the base system, as part of the input data.

a. For each input template state, select +New base input field  and configure the base input 
table fields.

Add multiple base input fields, as necessary.
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Choose input step

The following table lists the base input table fields and descriptions, including a relevant 
example.

Base input fields

Field Description

Base input field
Field in the Purchase Order table whose 
value this skill uses in its response.

For example, Order type.

Field description
Description of the base input field value.

For example, Type of the purchase 
order.

b. For each input template state, configure the rule conditions by using the condition builder to 
filter the data.

The rule conditions determine when the input template is used. By default, the record state 
determines the input template that the Now LLM Service  uses.

You can build the condition out further by selecting +New condition set  and configuring 
additional parameters.

c. For each input template state, select +New data source  to configure the additional related 
table and activity stream data, as needed.
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You can add input data sources like related tables, activity streams and relationships to 
provide more context to the Now LLM Service. You can also add rule conditions to these 
additional data sources.

You can also add the rule conditions to these additional data sources.

The selection of the related table fields may have a direct impact on the quality of the 
corresponding prompt header. For example, if a prompt header requires a specific field 
from the related table, but that field isn’t selected as input, the summary for that prompt 
header will contain missing information. For example, as a base case, you see one related 
table, such as Service level agreement (SLA), that includes all the required fields and 
filtering conditions for the prompt header. The SLA prompt header is preselected to help 
you understand how the related table, its fields, and the prompt header work together to 
produce a summary. You can use the SLA as a reference to configure the other related tables 
to determine which fields to select and which description adds the requirements of their 
respective prompt headers. Apply any additional conditions to filter the data further.

d. Select Save and continue  to go to the next step.

6. Customize the prompt.

Review and test the prompt for each input template configuration. You can edit the prompt by 
adding new predefined sections and reordering them, as needed.

a. For each input template state, select the prompt sections from the list of available sections 
to include in the generated summary.

To add a section, you must configure the relevant input data prior to this step.

The available prompt sections that you can select:

▪ Overview for PO

▪ Actions completed for PO

▪ Next steps for PO

The following table lists the mandatory prompt headers.

Mandatory prompt headers

Input template state Mandatory prompt header

Open ▪ Overview for PO

▪ Actions completed for PO

▪ Next steps for PO

Closed ▪ Overview for PO

▪ Actions completed for PO

b. Select Save  to continue to the test response.

c. Select a record in the Test response section, and test the prompt response output format by 
selecting Run Test.

d. Select Save and continue  to go to the next step.
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7. Define how the skill is available to your users.

a. Configure the skill to be always available to users, or select conditions that must be met 
before the skill is available.
Selecting Customize skill availability  displays a condition builder to filter the data further.

b. Select Save and continue  to go to the next step.

8. Configure where to display the record summarization.

a. Select either In-product, or Now Assist panel.

▪ In-product desktop: When selected, the customized Purchase order summarization for 
fulfillers skill is shown on the forms and workspaces in all Common Finance & Supply 
Chain features products.

For the skills that appear in-product, select the down arrow to identify the roles that can 
use the skill.

▪ Now Assist panel: When selected, the Now Assist  skills are available in the Now Assist 
panel.

Now Assist  skills are available in the Now Assist  panel. Turn on multi-language support 
for user-entered text with Dynamic Translation in Now Assist applications. For more 
information, see Configure multilingual service for Now Assist applications .

Note:  If you don't see this option, you must activate the Now Assist  panel. For more 
information, see Activate Now Assist panel standard chat .

For the skills that appear in the Now Assist  panel, select the down arrow to identify the 
roles that can use the skill.

b. Select Save and continue  to go to the next step.

9. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
The fulfillers having the sn_fsc_genai.now_assist_fulfiller role can now select Summarize  for 
a purchase order record in the Source-to-Pay Workspace  to generate the summary for the 
purchase order.

Skill inputs for Now Assist for Common Finance and Supply Chain features

You can configure some of the inputs for a generative AI skill. Inputs permit you to determine how 
and when a skill is used.

Overview of skills

Inputs identify the data used for a skill. Inputs include the table and fields used to generate a 
record summary.

You can modify inputs, but you can't modify a skill's data source. The data source contains the 
tables and fields that the skill relies on.
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Now Assist skills for Now Assist for Common Finance and Supply Chain 
features

The Now Assist for Common Finance and Supply Chain features includes the Purchase order 
summarization for fulfillers skill.

Purchase order summarization for fulfillers skill

Inputs for the Purchase order summarization for fulfillers skill identify the table and fields used 
when the summary is generated for a purchase order.

The following table lists the inputs for the Purchase order summarization for fulfillers skill from the 
Choose input for purchase order page in the Now Assist Admin  console.

Input Description

Base input table Purchase Order [sn_shop_purchase_order] 
table.

Base input fields • Number

• Business owner

• Order type

• Supplier

• Total amount

• Status

• Order placed

• Cancellation reason

• Order paid

• ERP number

Customize supplier summarization for fulfillers skill

If you have the admin role, you can customize the supplier summarization for fulfillers skill so that 
fulfillers can use the generative AI skills in Source-to-Pay Workspace  to view relevant supplier 
information.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .

Role required: admin

About this task
From the Now Assist Admin  console, you can select the input table, related records, and fields 
for each input template of the Summarization for fulfillers skill, and then configure the prompt 
headers to include in the general summary.
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Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Skills  tab of the Now 
Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Common Finance and Supply Chain 
features  to view the skills for the Now Assist for Common Finance and Supply Chain features.

3. Create a copy of a skill and customize the input fields.

a. On the Supplier summarization for fulfillers feature card, select the More actions icon ( ).

b. Select Make a copy.
A guided setup leads you through the configuration of the general details, input, prompt, 
availability, display, review, and activation of the customized skill. If you complete the entire 
walk-through, the skill is activated.

4. In the General details step, fill in the fields.
For information about the inputs and triggers for each skill, see Skill inputs for Supplier 
summarization for fulfillers skill.

a. Enter a name and description for the skill.

b. Select Save and continue  to go to the next step.

5. View the input data for each skill, such as the base input fields and related lists for the different 
input templates.

Configure the base input table fields and related lists for the different input templates for the 
skill.

Each skill relies on a base input table and input fields with descriptions to provide context for 
the Now LLM Service  to generate a response.

Select only those related tables that are offered as the base system, as part of the input data.

a. For each input template state, select +New base input field  and configure the base input 
table fields.

Add multiple base input fields, as necessary.
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Choose input step

The following table lists the base input table fields and descriptions, including a relevant 
example.

Base input fields

Field Description

Base input field
Field in the Supplier table whose value this 
skill uses in its response.

For example, Legal name.

Field description
Description of the base input field value.

For example, Legal name of the 
supplier.

b. For each input template state, configure the rule conditions by using the condition builder to 
filter the data.

The rule conditions determine when the input template is used. By default, the record state 
determines the input template that the Now LLM Service  uses.

You can build the condition out further by selecting +New condition set  and configuring 
additional parameters.

c. For each input template state, select +New data source  to configure the additional related 
table and activity stream data, as needed.

You can add input data sources like related tables, activity streams and relationships to 
provide more context to the Now LLM Service. You can also add rule conditions to these 
additional data sources.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

70



You can also add the rule conditions to these additional data sources.

The selection of the related table fields may have a direct impact on the quality of the 
corresponding prompt header. For example, if a prompt header requires a specific field 
from the related table, but that field isn’t selected as input, the summary for that prompt 
header will contain missing information. For example, as a base case, you see one related 
table, such as Service level agreement (SLA), that includes all the required fields and 
filtering conditions for the prompt header. The SLA prompt header is preselected to help 
you understand how the related table, its fields, and the prompt header work together to 
produce a summary. You can use the SLA as a reference to configure the other related tables 
to determine which fields to select and which description adds the requirements of their 
respective prompt headers. Apply any additional conditions to filter the data further.

d. Select Save and continue  to go to the next step.

6. Customize prompt output.

Select Active  and Save and continue.

The following prompt sections will be displayed while using the skill:

◦ Key Supplier Details

◦ Procurement Specialist specific details

◦ AP specialist specific details

◦ Supplier Manager specific details

7. Define how the skill is available to your users.

a. Configure the skill to be always available to users, or select conditions that must be met 
before the skill is available.
Selecting Customize skill availability  displays a condition builder to filter the data further.

b. Select Save and continue  to go to the next step.

8. Define who can access this skill.

a. Edit the Access control lists (ACLs) to determine who has access to this skill (optional).

b. Select Save and continue  to go to the next step.

9. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
The fulfillers having the sn_fsc_genai.now_assist_fulfiller role can now select Summarize  for a 
supplier record in the Source-to-Pay Workspace  to generate the summary of the supplier.

Skill inputs for Supplier summarization for fulfillers skill

You can configure some of the inputs for a generative AI skill. Inputs permit you to determine how 
and when a skill is used.

Overview of skills

Inputs identify the data used for a skill. Inputs include the table and fields used to generate a 
record summary.

You can modify inputs, but you can't modify a skill's data source. The data source contains the 
tables and fields that the skill relies on.
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Now Assist skills for Now Assist for Common Finance and Supply Chain 
features

The Now Assist for Common Finance and Supply Chain features includes the Supplier 
summarization for fulfillers skill.

Supplier summarization for fulfillers skill

Inputs for the Supplier summarization for fulfillers skill identify the table and fields used when the 
summary is generated for a supplier.

The following table lists the inputs for the Supplier summarization for fulfillers skill from the 
Choose input for suppliers in the Now Assist Admin  console.

Supplier summarization for fulfillers skill input

Input Description

Base input table Supplier [sn_fin_supplier] table

Base input fields • Legal name

• Onboarded

• Status

• On-boarded date

• DUNS number

Using Now Assist for Common Finance and Supply Chain features

As a fulfiller, you can use the Now Assist for FSC Common to quickly summarize purchase orders 
in the S2P workspace using the Purchase order summarization for fulfillers skill.

Summarize a purchase order by using Now Assist for Common Finance and Supply Chain 
features in Source-to-Pay Workspace

As a fulfiller, summarize purchase orders and keep fulfillers informed of their status, progress, 
and required actions by using the Purchase order summarization for fulfillers skill in the Now 
Assist for Common Finance and Supply Chain features application.

Before you begin
Role required: sn_fsc_genai.now_assist_fulfiller

About this task
You can use these record summarization skill in either Core UI  or Source-to-Pay Workspace.

• In Core UI, the summary appears in a banner in the record record.

• In Source-to-Pay Workspace, the summary is generated in the Details  tab.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Orders  > All purchase orders.

4. Select the link to the purchase order record under the Number column.
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5. On the Details tab, in the Record summary section, select Summarize.

When you opt to summarize a purchase order, you see the following message:

Now Assist is summarizing your purchase order.

Note:  Generating and displaying the summary may take several seconds.

6. Review the summary details.

A concise summary of a purchase order, including the overview, actions completed, and next 

steps.

◦ Overview: Provides information about the record.

◦ Actions completed: Lists all the actions that have been taken so far.

◦ Next steps: Lists the actions that the fulfillers need to take next.

7. Optional:  When you finish summarizing a record, you can add it to the work notes, expand or 
collapse it, provide feedback, copy it, or view information about it.
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Option Procedure

Save the summary information by adding it 
to the record work notes

a. Select Share.

b. In the Share to work notes dialog box, edit 
the summary.

c. Select Save to work 

notes.

Expand or collapse the summary
Select the expand card icon ( ) or the col­

lapse card icon ( ) to see more details or 
fewer summary details.

Provide feedback for the summary

If you think that the summary was helpful, se­

lect the helpful icon ( ). If you think that the 
summary wasn’t helpful, select the not helpful 

icon ( ).

This feedback improves the generative AI 
model and can help to improve the future ver­
sions of this skill.

Copy the record summary
Select the copy to clipboard icon ( ) to use 
the record summary information for another 
purpose, such as pasting into an email.

View the information about the record sum­
mary

If you want to check some details about the 
summary, select the more info icon ().

Refresh the record summary
If you want to refresh the summary, select the 

refresh icon ( ).

Source-to-Pay Operations
Streamline procurement for employees and enable work team efficiencies. Connect the source-
to-pay process end-to-end.
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Automate and simplify the source-to-pay process

Source-to-Pay Operations  is a powerful solution that automates and simplifies the source-to-
pay process. It enables a seamless purchasing and case management process across work 
teams, allowing procurement to focus more on strategic priorities. Built on the ServiceNow AI 
Platform, Source-to-Pay Operations  integrates seamlessly with existing ERP and procurement 
technologies to deliver faster time-to-value, while streamlining fulfillment and reducing the 
potential for errors or delays.

With Source-to-Pay Operations, you can organize and manage work across teams and systems 
with real-time governance. This enables you to:

• Refocus teams to higher value work by capturing and automating repeatable non-structured 
work in cases.

• Shorten onboarding and qualification cycle times with guided collaboration and configurable 
step-by-step playbooks.

• Improve compliance and contract utilization with centralized catalogs and automate end-to-
end order creation.

• Improve the days payable outstanding (DPO) by automating low value invoice processing 
work, thus enabling reprioritization of teams to focus on more strategic tasks.

With this solution, you can also increase engagement with collaboration, self-service, and omni-
channel access, which enables you to:

• Deflect low-focus requests from employees and suppliers with self-service interactions.

• Streamline intake to improve first-time request automation.

• Meet employees and suppliers where they work, to improve governance and spend 
management.

You can also leverage intelligence to enable continuous process improvement. This allows you 
to:

• Improve supplier compliance and spend governance through enhanced transparency.

• Enable suppliers to better help you by letting them audit, define, and update their own 
information.

• Drive better outcomes by continually improving people, processes, and behavior.

• Achieve real-time self service access to purchase orders and invoices, and redirect invoice-
related inquiries from employees and suppliers to a specialist.
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Procurement is in the scope of most enterprise transformation initiatives. As procurement 
leaders assess their priorities, organizations are looking for transformable ways to evolve their 
procurement processes, while leveraging their existing investments. Organizations can use the 
Source-to-Pay Operations  solution to address several of their use cases.

Improve procurement processing and drive compliant outcomes

Make it easy for employees and procurement to make 
procurement processes easier and trackable, with omni-channel 
guidance.

Accelerate supplier qualification and enhance accuracy

Enhance the supplier experience by enabling suppliers to 
complete onboarding tasks, raise requests, and get answers to 
questions quickly.

Transform supplier management with digital experiences

Access supplier information easily, identify key supplier 
contacts, and collaborate in real time to resolve issues that 
impact production.
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Streamline end-to-end invoice processing and expedite the payment 
process

Enable accounts payable teams to simplify and speed up 
the invoice processing cycle and ensure timely and accurate 
payment of invoices.

Improve procurement processing and drive compliant outcomes
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• Help employees self service their requests through intuitive workflows, knowledge base, and 
virtual agents. Increase spend under management and employee engagement with uniform 
guided experiences that meet employees where they work.

• Use step-by-step playbooks to make processes easier and trackable. Increase contract 
utilization and compliance by including controls in digital workflows

Accelerate supplier qualification and enhance accuracy

• Extend procurement processes to include supplier qualification and onboarding. Organize and 
manage workflows to include cross-functional teams, from legal to finance.

• Improve supplier data quality by enabling suppliers to manage their own data.

• Accelerate issue resolution by empowering suppliers to engage with cases and tasks.
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Transform supplier management with digital experiences

• Manage and collaborate with suppliers on cases, in real time. Use case management for 
diverse issues like quality resolutions, supplier shortages, engineering changes, and so on.

• Centralize all supplier demographic, performance, and Environmental, Social, and Governance 
(ESG) intelligence. Better manage supplier data by centralizing supplier information.

• Leverage third-party supplier intelligence to increase the comprehensive supplier information.

Streamline end-to-end invoice processing and expedite the payment process

• Save time and increase productivity by consolidating all Accounts Payable workstreams into a 
single experience.

• Enable Accounts Payable teams to work seamlessly with suppliers and cross-functional teams 
to resolve invoice-related inquiries and to process invoices quickly and accurately.

• Ingest invoices via different channels and capture invoice data using Document Intelligence to 
reduce manual invoice data entry.

• Perform end-to-end invoice processing using workflows to identify and resolve exceptions, 
obtain approvals, and post the invoices into ERP systems to process payments.
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Source-to-Pay Operations  integration with third-party applications

Source-to-Pay Operations  supports the following integrations:

Source-to-Pay integration framework

Install an optional third-party ERP integration application that enables primary 
data, fixed assets, purchase order, receipt, invoice, and tax integration capabilities 
between S2P and the third-party ERP application.

Source-to-Pay Operations  integration with SAP ECC and SAP S4 HANA

Send purchase orders, receipts, suppliers, and payables invoices created in 
Source-to-Pay Operations  to SAP ECC and SAP S4 HANA.

Source-to-Pay Operations  integration with 3CLogic

Enhance the end-user experience with voice and SMS capabilities.

Learn

• What is Sourcing and Procurement Operations (SPO)?

• What is Supplier Lifecycle Operations (SLO)?

• What is Accounts Payable Operations (APO)?

• What are Finance and Supply Chain (FSC) workflows?

Get started

• Log in to your ServiceNow  account and find additional information about Source-to-Pay 
Operations, at Now Create .

• Access real-time courses, self-paced training, and career resources at ServiceNow 
University .

• Work with an implementation specialist to achieve your desired business outcomes. To learn 
more, visit the Customer Success Center .

• Connect with other Source-to-Pay Operations  users at Now Community

• Explore which other tools can optimize your Source-to-Pay Operations  experience, like Virtual 
Agent , and Knowledge Management .

Products, features, and customer journeys

• Source-to-Pay Operations purchasing and sourcing workflows

• Sourcing and Procurement Operations

• Supplier Lifecycle Operations

• Accounts Payable Operations

• Source-to-Pay Workspace

• Source-to-Pay Integrations

• Improve sourcing experience when working with new suppliers

Source-to-Pay Operations  purchasing and sourcing workflows
Gain deeper insights into the complete process of sourcing, procuring, and paying for goods and 
services by exploring the Source-to-Pay purchasing and sourcing workflows.
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Get started

Source-to-Pay Operations purchasing and sourcing workflows

Understanding the end-to-end purchasing 
workflow in Source-to-Pay Operations

Learn about the end-to-end purchasing 
process and its key user personas

Understanding the end-to-end sourcing 
workflow in Source-to-Pay Operations

Learn about the end-to-end sourcing 
process and its key user personas

Understanding the end-to-end purchasing workflow in Source-to-Pay 
Operations

Gather a high-level understanding of the end-to-end purchasing workflow with the Sourcing and 
Procurement Operations  (SPO) and Accounts Payable Operations  (APO) products within the 
Source-to-Pay (S2P) suite.

The purchasing workflow is triggered when an active contractual price is available for a product 
or service the shopper intends to purchase.

Prerequisites

Install and activate the necessary plugins. For information on the respective product plugins and 
installation sequence, see:

• SPO: Application plugin installation sequence in Sourcing and Procurement Operations

• APO: Application plugin installation sequence in Accounts Payable Operations

Workflow of the purchasing process

The following figure shows how different personas use the various applications withing the SPO 
and APO products to complete the end-to-end purchasing process within the Source-to-Pay 
(S2P) suite.
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Workflow of the purchasing process

In this workflow:

1. An employee performs a quick checkout with a product or service that has a contractual 
price. A purchase requisition is created. For more information, see Order a product with quick 
checkout.

Alternatively, an employee performs a full checkout with products or services that have 
contractual prices. For more information, see Complete your checkout.

Role: sn_shop.shopper.

Application portal: Shopping Hub.

2. Approval rules route the purchase request to one or more assigned approvers.

3. An approver reviews the purchase request and approves it. A purchase order is created. For 
more information, see Approve a request from Employee Center.

Role: sn_shop.procurement_specialist.

Application portal: Employee Center.

4. A procurement specialist fulfills the purchase order from the associated supplier.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.

5. On fulfillment, the employee confirms receipt of the requested product. For more information, 
see Confirm receipt of your order from Shopping Hub Home  and Confirm receipt of your order 
from Employee Center.

Role: sn_shop.shopper.

Application portal: Shopping Hub  or Employee Center.

6. Invoices are auto-created. When invoices aren’t auto-submitted or don’t match the purchase 
orders, or when invoice exceptions must be resolved, an accounts payable specialist gets 
involved. For more information, see Accounts Payable Invoice Processing.
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Alternatively, the accounts payable specialist manually creates invoices. For more information, 
see Accounts Payable Specialist manual tasks.

Role: sn_ap_apm.accounts_payable_specialist.

Application portal: Source-to-Pay Workspace.

7. The accounts payable specialist converts invoices of purchase order type to invoice types 
such as non-purchase order, credit memo, and debit memo, based on their interactions with 
shoppers and suppliers of business services. For more information, see Accounts Payable 
Specialist manual tasks.

Role: sn_ap_apm.accounts_payable_specialist.

Application portal: Source-to-Pay Workspace.

8. An accounts payable agent manages and works on assigned invoice cases, requests more 
information from suppliers or employees if necessary, and creates and assigns tasks to the 
users. For more information, see Invoice Case Management.

Role: sn_ap_cm.agent.

Application portal: Source-to-Pay Workspace.

9. The employee, approver, procurement specialist, accounts payable specialist, and accounts 
payable agent have complete visibility into the status of the workflow through process 
completion, from their respective portals.

Understanding the end-to-end sourcing workflow in Source-to-Pay 
Operations

Gather a high-level understanding of the end-to-end sourcing workflow with the Sourcing and 
Procurement Operations  (SPO), Supplier Lifecycle Operations  (SLO), and Accounts Payable 
Operations  (APO) products within the Source-to-Pay (S2P) suite.

The sourcing workflow is triggered when there is an active contractual price for a product or 
service that the shopper intends to purchase.

Prerequisites

Install and activate the necessary plugins. For more information on the respective product 
plugins and installation sequence, see:

• SPO: Application plugin installation sequence in Sourcing and Procurement Operations

• SLO: Application plugin installation sequence in Supplier Lifecycle Operations

• APO: Application plugin installation sequence in Accounts Payable Operations

Workflow of the sourcing process

The following figure shows how different personas use the various applications withing the SPO, 
SLO, and APO products to complete the end-to-end sourcing process within the Source-to-Pay 
(S2P) suite.
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Workflow of the sourcing process

In this workflow:

1. An employee creates a sourcing request for a product or service that doesn't have a 
contractual price, or isn’t available in the catalog. For more information, see Complete sourcing 
checkout  and Requesting for products or services that you don't see on ShoppingHub, 
respectively.

Role: sn_shop.shopper.

Application portal: Shopping Hub  and Employee Center  respectively.

2. Approval rules route the sourcing request to one or more assigned approvers.

3. An approver reviews the sourcing request and approves it. For more information, see Approve 
a request from Employee Center.

Role: sn_shop.procurement_specialist.

Application portal: Employee Center.

4. Work assignment rules route the sourcing request to an assigned procurement specialist.

5. The procurement specialist, with the contained role of a sourcing manager, adds the sourcing 
request to a negotiation event. For more information, see Add a sourcing request to a sourcing 
event.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.

6. Negotiations are auto-created with qualified suppliers. For more information, see Sourcing 
intake guided experience with playbooks.

If sourcing with a new supplier, see Improve sourcing experience when working with new 
suppliers.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.
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7. Begin the qualification process to onboard the new supplier. For more information, see 
Supplier qualification.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.

8. Review the supplier onboarding case and start the supplier onboarding using playbooks. For 
more information, see Use the supplier onboarding playbook to onboard suppliers.

The playbook automatically creates supplier tasks to conduct risk assessment and to collect 
supplier information, such as banking information and location details.

Role: sn_slm.manager.

Application portal: Source-to-Pay Workspace.

9. The supplier manager assigns the supplier tasks to the supplier contact.

Role: sn_slm.manager.

Application portal: Source-to-Pay Workspace.

10. The supplier contact completes the following tasks:

◦ Assigned tasks. For more information, see Viewing supplier contact tasks from the Supplier 
Collaboration Portal.

◦ Risk assessment questionnaire. For more information, see Complete a risk assessment from 
the Supplier Collaboration Portal.

Role: sn_slm.contact.

Application portal: Supplier Collaboration Portal.

11. After the supplier manager reviews the supplier risk score and completes the different 
activities in each stage of the playbook, the supplier is successfully onboarded.

Role: sn_slm.manager.

Application portal: Source-to-Pay Workspace.

12. On reaching supplier responses close date, the sourcing manager awards one or more 
suppliers. For more information, see Award multiple suppliers from a sourcing event.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.

13. Purchase requisitions are auto-created. The procurement specialist reviews the purchase 
requisitions and its associated purchase lines, and creates purchase orders. For more 
information, see SPO list page.

Role: sn_shop.procurement_specialist.

Application portal: Source-to-Pay Workspace.

14. On fulfillment, the employee confirms receipt of the requested product. For more information, 
see Confirm receipt of your order from Shopping Hub Home  and Confirm receipt of your order 
from Employee Center.
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Role: sn_shop.shopper.

Application portal: Shopping Hub  or Employee Center.

15. Invoices are auto-created. When invoices aren’t auto-submitted or don’t match the purchase 
orders, or when invoice exceptions must be resolved, an accounts payable specialist gets 
involved. For more information, see Accounts Payable Invoice Processing.

Alternatively, the accounts payable specialist manually creates invoices. For more information, 
see Accounts Payable Specialist manual tasks.

Role: sn_ap_apm.accounts_payable_specialist.

Application portal: Source-to-Pay Workspace.

16. The accounts payable specialist converts invoices of purchase order type to invoice types 
such as non-purchase order, credit memo, and debit memo, based on their interactions with 
shoppers and suppliers of business services. For more information, see Accounts Payable 
Specialist manual tasks.

Role: sn_ap_apm.accounts_payable_specialist.

Application portal: Source-to-Pay Workspace.

17. An accounts payable agent manages and works on assigned invoice cases, requests more 
information from suppliers or employees if necessary, and creates and assigns tasks to the 
users. For more information, see Invoice Case Management.

Role: sn_ap_cm.agent.

Application portal: Source-to-Pay Workspace.

18. The employee, approver, sourcing manager, procurement specialist, supplier manager, 
accounts payable specialist, and accounts payable agent have complete visibility into the 
status of the workflow through process completion, from their respective portals.

Now Assist for Source-to-Pay Operations
Use the ServiceNow®  Now Assist for Source-to-Pay Operations  to help fulfillers and requesters 
quickly summarize cases, including procurement, supplier, and invoice records, keeping them 
informed of progress and next steps.
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Get started

Now Assist for Source-to-Pay Operations

Now Assist for 
Sourcing and 

Procurement Operations

Learn about Now 
Assist for Sourcing and 

Procurement Operations

Now Assist for Supplier 
Lifecycle Operations

Learn about Now 
Assist for Supplier 

Lifecycle Operations

Now Assist for Accounts 
Payable Operations

Learn about Now 
Assist for Accounts 
Payable Operations

Source-to-Pay Operations  common skills

Now Assist  skills support Source-to-Pay workflows (APO, SPO and SLO) with AI-powered email 
generation, sentiment analysis for case prioritization, and natural language data exploration and 
reporting.

Note:  The common Now Assist  skills are applicable to Sourcing and Procurement 
Operations, Supplier Lifecycle Operations  and Accounts Payable Operations.

The common Now Assist  skills available in the Source-to-Pay Workspace are:

• Email response generation-This skill uses generative AI to automatically draft professional, 
context-aware email responses for supplier inquiries, procurement communications, and AP 
case management across Source-to-Pay workflows, reducing manual effort and improving 
response consistency. Email generation for Source-to-Pay workflows are available as:

◦ Generate email responses  in Sourcing and Procurement Operations

◦ Generate an email response for supplier cases  in Supplier Lifecycle Operations

◦ Generate an email response for supplier tasks  in Supplier Lifecycle Operations

◦ Generate email response for invoice case  in Accounts Payable Operations

◦ Generate email response for invoice task  in Accounts Payable Operations

• Sentiment analysis-The skill uses large language models to detect emotional tone (Positive, 
Negative, or Neutral) in cases across Source-to-Pay workflows. Sentiment analysis for Source-
to-Pay workflows are available as:

◦ Analyze sentiment in procurement cases

◦ Analyze sentiments in supplier cases

◦ Analyze sentiments in invoice cases

• AI Data Explorer-The AI Data Explorer for Source-to-Pay supports AI-driven prompt 
understanding, recommended queries, and drill-down capabilities within a unified interface. 
It enables business users to generate reports, visualizations, and KPIs using natural language 
queries without relying on technical expertise or predefined dashboards. Through a 
conversational interface, users can ask questions in plain English and receive interactive 
charts and summaries in real time. Explore AI is integrated within the Source-to-Pay tables 
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and use cases, ensuring accurate, context-aware insights across procurement, supplier and 
accounts payable workflows. For more information on the data explorer, see Use AI to explore 
data with AI Data Explorer  and Using AI Data Explorer in Source-to-Pay Operations.

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

Using AI Data Explorer in Source-to-Pay Operations

Use the AI Data Explorer in Source-to-Pay Operations  to generate reports, visualizations, and 
data insights from APO, SPO and SLO workspace using natural language questions.

Before you begin
Role required: now_assist_explorer_user

About this task
The AI Data Explorer enables fulfillers and requesters to generate reports, visualizations, and 
data insights through a conversational interface from Source-to-Pay workspace using natural 
language. Users input natural language prompts to query data without needing technical 
expertise in tables, filters, or data structures.

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed. The List page displays Explore 
with AI  option. As a fulfiller or a requester you can explore data insights through 
conversational analytics. You can ask specific questions in AI Data Explorer, to which 
it responds with summary, and suggested follow-up questions as shown below: 

For more information on the extended data analysis, data visualization in AI data explorer, see 
Use AI to explore data with AI Data Explorer .
The AI-assisted, interactive exploration assists fulfillers in making data-driven decisions within 
the Source-to-Pay workspace.
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Source-to-Pay Workspace
The Source-to-Pay Workspace  provides experiences and tools that you can use to work 
on various activities, such as procuring goods, onboarding high-performing suppliers, and 
processing invoices.

The Source-to-Pay Operations  (S2P) product suite includes the following products:

Source-to-Pay Workspaces

Procurement Service 
Management Workspace

Learn about the 
Procurement Service 

Management Workspace

Supplier Lifecycle 
Management Workspace

Learn about the 
Supplier Lifecycle 

Management Workspace

Accounts Payable 
Operations Workspace

Learn about the 
Accounts Payable 

Operations Workspace

Regardless of whether you have installed the entire Source-to-Pay (S2P) product suite or any 
of the individual products that are part of the S2P suite, you use the Source-to-Pay Workspace 
to manage and work on all aspects and activities of Source-to-Pay Operations. Access to the 
landing pages and list views within the Source-to-Pay Workspace is role-based.

The Source-to-Pay Workspace  application provides experiences and tools for a Procurement 
Specialist, Supplier Manager, and Accounts Payable Specialist to view and work on cases and 
tasks related to Source-to-Pay Operations.

The Source-to-Pay Workspace  application is a dependent application and is automatically 
installed if any of the following applications are installed:

• Source-to-Pay Common Architecture

• Procurement Case Management

• Supplier Lifecycle Operations

• Invoice Case Management

However, if you wish to install just the Source-to-Pay Workspace  application, the dependent 
application Procurement Case Management  is also installed along with.

End user and roles

End user and goal Required role

Procurement Specialist: View your open 
requests and purchasing to-dos.

sn_shop.procurement_specialist

PCM Agent: View your open requests and 
purchasing to-dos.

sn_spend_psd.agent
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End user and goal Required role

Accounts Payable Specialist: View your open 
requests and purchasing to-dos.

Note:  This role contains the PCM Agent 
role, and therefore has access to the 
same home page and modules as the 
PCM Agent.

sn_shop.accounts_payable_specialist

Admin role for Canvas Core Application: 
View and make configuration changes to the 
widgets.

canvas_admin

Supplier Fulfiller:

• Create tasks

• View suppliers related to assigned cases or 
tasks

• View assigned cases and tasks, or tasks that 
are created by them

• Update assigned cases and tasks, or tasks 
that are created by them

sn_slm.fulfiller

Supplier Manager:

• Create suppliers, cases, and tasks

• View all the suppliers, cases, and tasks

• Update only the suppliers they manage

• Update the cases and tasks that they create 
or that are assigned to them

sn_slm.manager

Supplier Administrator: Create, view, update, 
and delete all the suppliers, cases, and tasks.

sn_slm.admin

Exploring Source-to-Pay Operations  Workspace

Learn about the key features and capabilities of Source-to-Pay Operations.

The Source-to-Pay Operations  (S2P) product suite includes the following products:

• Sourcing and Procurement Operations  (SPO)

• Supplier Lifecycle Operations  (SLO)

• Accounts Payable Operations  (APO)

Regardless of whether you have installed the entire Source-to-Pay (S2P) product suite or any 
of the individual products that are part of the S2P suite, you use the Source-to-Pay Workspace 
to manage and work on all aspects and activities of Source-to-Pay Operations. Access to the 
landing pages and list views within the Source-to-Pay Workspace is role-based.

Source-to-Pay Workspace  landing page

Depending on the product that you have installed and the role you're assigned, the landing page 
for each product is displayed in a separate tab under the Source-to-pay  header. The product 
tabs that appear are named after each installed product.
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When you open the Source-to-Pay Workspace, the home page is displayed by default. If you 

navigate away from the home page, you can select the home icon ( ) to return to the home 
page.

Example scenarios for role-based access in Source-to-Pay Workspace

Let's take a look at a few example scenarios to help you understand the conditions that 
determine how and when product-specific tabs containing landing pages are displayed.

Scenario 1: Only one product is installed

Let's consider a scenario where you have installed only the Supplier Lifecycle 
Operations  product and you are assigned the Supplier Fulfiller [sn_slm.fulfiller] role. 
In this scenario, the individual product-specific tabs are not shown, instead the 
landing page for Supplier Lifecycle Operations  is directly displayed.

Scenario 2: Two or more products are installed

Let's consider a scenario where:

• You have installed Sourcing and Procurement Operations, Supplier Lifecycle 
Operations, and Accounts Payable Operations.

• You have been assigned the Procurement Case Management (PCM) agent 
[sn_spend_psd.agent], Supplier Fulfiller [sn_slm.fulfiller], and Accounts Payable 
Specialist [sn_ap_apm_accounts_payable_specialist] roles.

In this scenario, the following product-specific tabs are displayed under the Source-
to-pay  header on the Source-to-Pay Workspace  landing page.

• Sourcing and procurement: Select this tab to view the landing page for Sourcing 
and Procurement Operations. For more information, see SPO list page.

• Supplier management: Select this tab to view the landing page for Supplier 
Lifecycle Operations. For more information, see SLO landing page.

• Accounts payable: Select this tab to view the landing page for Accounts Payable 
Operations.

Source-to-Pay Workspace with all the three product-specific tabs

SPO  landing page

As a fulfiller within the procurement team, you can visually launch into your day with a one-stop-
shop experience where you can view work that needs your attention, and use quick actions to 
navigate to internal and external websites.
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As a Procurement Specialist or Procurement Case Management  (PCM) Agent, you can use the 
Source-to-Pay Workspace  landing page to view all your open requests, which include purchasing 
to-dos that need your attention, along with their overdue status. You can also view requests 
that need your review, and filter them by priority and work type, such as purchase requisitions, 
sourcing requests, negotiation events, and cases. You can also filter your tasks by due date for 
better planning. The distribution of your work by work type and priority is displayed in a stacked 
bar chart format. This quick glance of your work enables you to better plan and prioritize your 
work. You can also view the recently updated records, which enables you to keep up with the 
progress when collaborating with other stakeholders.

Each record widget displays details such as the record number, short description, state, date 
opened, priority, business owner, and last updated. You can then select the widget to view more 
details pertaining to that record.

Note:  If you install Procurement Case Management  without Source-to-Pay Common 
Architecture, you can see only procurement cases in the Work to review  section, and 
procurement tasks in the Tasks  section.

Reports

For a detailed analysis on each component, select the respective widget or chart.

Title Type Description

Work to review

Needs final action Widget
View the total number of 
records assigned to the 
logged-in user that needs a 
final action. Select a widget 
to view the complete list of 
records.

Up to five records are 
displayed upfront in this 
section, with their record 
number, short description, 
priority, business owner, last 
updated date, and opened 
date. Use the carousel to view 
more records.

Filter by priority and work type 
such as purchase requisitions, 
sourcing requests, negotiation 
events, and cases, for focused 
results.

New this week Widget
View the total number of 
new records assigned to the 
logged-in user during the 
current week. Select a widget 
to view the complete list of 
records.
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Title Type Description

Up to five records are 
displayed upfront in this 
section, with their record 
number, short description, 
priority, business owner, last 
updated date, and opened 
date. Use the carousel to view 
more records.

Filter by priority and work type 
such as purchase requisitions, 
sourcing requests, negotiation 
events, and cases, for focused 
results.

Tasks

Tasks Widget
View the total number of open 
purchasing tasks assigned to 
the logged-in user. Select a 
widget to view the details of 
that record. Select View all  to 
view the complete list of tasks.

You can also view up to four 
records in this section, with 
their task number, state, short 
description, and opened date.

Filter by due dates for focused 
results.

Summary

Distribution of your work Stacked bar chart View the total number of 
requests assigned to the 
logged-in user that's not in a 
closed state, sorted by priority, 
and color coded by work type. 
Point to a bar area to view the 
number of work types that fall 
within that priority time frame. 
Select a bar area to view the 
complete list of records within 
that time frame. Select View 
all  to view the complete list of 
records.

Note:  The logged-in 
user can view only the 
work that is specific to 
their role.

Recently updated Widget View the list of records 
assigned to the logged-in 
user that was last updated by 
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Title Type Description

someone. The list displays 
the record number, short 
description, updated by, and 
state. Select a number to view 
the details of that record. 
Select View all  to view the 
complete list of records.

Quick actions

Procurement dashboard Widget Open a new tab with the 
procurement dashboards, 
where dashboards are 
filtered by the Sourcing and 
Procurement Operations 
group.

Supplier directory Widget Open the list of suppliers in 
the workspace.

Knowledge articles Widget Open a new tab with the 
Purchase and Expense 
category knowledge base 
page.

Open Employee Center Widget Open a new tab with the 
Purchase and Expense 
category in Employee Center.

Open ShoppingHub Widget Open a new tab with the 
ShoppingHub home page.

Configure your workspace landing page

You can configure the landing page using UI Builder, define different audiences for the 
landing page, and even add, remove, or modify the different content, if you want. However, it’s 
recommended that you create a duplicate of the landing page before modifying it. For detailed 
information on how to configure using UI Builder, see Create a page in UI Builder .

SLO  landing page

As a supplier manager, view a snapshot of your assigned supplier cases and tasks and take 
actions to resolve them.

As a Supplier Manager [sn_slm.manager] or Supplier Fulfiller [sn_slm.fulfiller], you can use the 
landing page to create a new case, task, and supplier. You can also manage suppliers, view 
cases and tasks that are assigned to you.

For a detailed analysis on each component, select the respective widget or chart. Select the 

Refresh icon ( ) to view the latest data. Select the Edit columns icon ( ) to add or remove 
columns in the list and to display the columns in the order you choose.
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Components in the Source-to-Pay Workspace

Components in Source-to-Pay Workspace

Title Type Description

Quick Actions

Create case Option Opens the Create New Supplier Case form that enables you to create a 
new supplier case.

Create task Option Opens the Create a new task form that enables you to create a new 
supplier task.

Create new 
supplier

Option Opens the Request new supplier form that enables you to onboard a 
new supplier.

Create KPI 
template

Option Opens the Create New KPI template form that enables you to create 
KPI templates.

Create 
segmentation 
rule

Option Opens the Create New Segmentation rule form that enables you to 
build your segmentation rule by selecting specific conditions to filter 
the data from the supplier table.

Manage my 
suppliers

Option Opens the My Suppliers form that displays a list of the suppliers 
managed by the logged-in user.

In the Number column of the My Suppliers form, select the link to the 
supplier number to view more details about the supplier.

My Work

High priority 
cases

Single 
score

Displays the count of cases marked as high priority.

Overdue 
cases

Single 
score

Displays the count of cases that are overdue.

Tasks to 
review

Single 
score

Displays the count of tasks that the logged-in user needs to review.

Tasks created 
by me

Single 
score

Displays the count of tasks that the logged-in user has created.

Overdue 
tasks

Single 
score

Displays the count of tasks that are overdue.

Cases List Displays a list of cases assigned to the logged-in user.

This list shows only five cases by default. Click View all  to view the list 
of all the cases.

Tasks List Displays a list of tasks assigned to the logged-in user.

This list shows only five tasks by default. Click View all  to view the list 
of all the tasks.

Work Summary

My cases Donut 
chart

Displays a segmented breakdown of your assigned cases. Each 
segment represents the type, state, or priority of the cases based on 
the applied filter.
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Components in Source-to-Pay Workspace  (continued)

Title Type Description

Filter: 
By 
type

Displays cases filtered by their type.

Filter: 
By 
state

Displays cases filtered by their state.

Filter: 
By 
priority

Displays cases filtered by their priority.

My tasks Donut 
chart

Displays a segmented breakdown of your assigned tasks. Each 
segment represents the type, state, or priority of the tasks based on 
the applied filter.

Filter: 
By 
type

Displays tasks filtered by their type.

Filter: 
By 
state

Displays tasks filtered by their state.

Filter: 
By 
priority

Displays tasks filtered by their priority.

Role-based access to quick actions in the Source-to-Pay Workspace

Role-based access to quick actions in Source-to-Pay Workspace

Role Available quick action

Supplier Administrator

[sn_slm.admin]
• Create case

• Create task

• Create new supplier

• Manage my suppliers

Supplier Manager

[sn_slm.manager]
• Create case

• Create task

• Create new supplier

• Manage my suppliers

Supplier Owner

[sn_slm.owner]
• Create case

• Create task

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

96



Role-based access to quick actions in Source-to-Pay Workspace   (continued)

Role Available quick action

• Create new supplier

• Manage my suppliers

Supplier Fulfiller

[sn_slm.fulfiller]

Create task

Configure your workspace landing page

You can configure the landing page using UI Builder, define different audiences for the 
landing page, and even add, remove, or modify the different content, if you want. However, it’s 
recommended that you create a duplicate of the landing page before modifying it. For detailed 
information on how to configure using UI Builder, see Create a page in UI Builder .

Source-to-Pay Workspace  Supplier page

As a supplier manager, view all the information about a supplier, view supplier locations, manage 
cases, and view procurement information.

Open the Source-to-Pay Workspace  Details page by navigating to All  > Supplier Lifecycle 
Operations  > Source-to-Pay Workspace.

Under Quick Actions, select Manage my suppliers, and then in the Legal name column of the 
My suppliers form, select the link to the legal name of the supplier to view more details about the 
supplier.

The Details page contains the following tabs that display relevant information related to the 
supplier.

• About

• Details

• Related work

• Spend

• Risk

• Performance

• KPI management

• Subsidiaries

• Documents

About tab

The About  tab displays information about the supplier, supplier relationship, similar suppliers, 
and supplier locations.

Sections on the About tab

Title Description

Sections
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Sections on the About tab  (continued)

Title Description

Supplier 
details

Displays supplier details, such as legal name, DUNS number, country of 
registration, stock symbol, number of employees. You can edit the supplier 
details, if needed.

Relationship 
summary

Displays details about whether the supplier has been onboarded, who 
onboarded the supplier and on which date, and who is the supplier relationship 
manager.

Relationship 
manager

Person responsible for managing the relationship with this supplier. Select the 

email icon ( ) to send an email to the relationship manager.

Similar 
suppliers

Displays suppliers that provide products and services similar to the one that 
you’re currently viewing.

Supplier 
news

Displays news and significant events related to the suppliers that you manage, 
so that you can take action to reduce the impact to the business. For example, 
news related to mergers and acquisitions, cybersecurity events, fines and 
sanctions, bankruptcy, negative news, and so on.

By default, Supplier Lifecycle Operations  retrieves supplier news and activities 
using the Bing News Search API.

The News Integration for Supplier Lifecycle Operations  plugin 
(com.snc.sn_supplier_news) provides you with the flexibility to dynamically fetch 
news and activities related to a supplier by using any API of your choice. For 
more information, see Configuring a custom API to dynamically fetch supplier 
news.

Related 
Links

Displays links that enable you to view additional information pertaining to 
suppliers:

• Banking information

• Product codes

• Email domains

• Contracts

• Supplier products

Supplier 
locations Displays the geographical location of the suppliers on a map.

Note:  The Map UI component for threat and alert data feeds 
(com.sn_fam_map) plugin enables you to view and manage this section. 
Verify that you have configured the FAM map properties. For more 
information, see Configure properties for Supplier Lifecycle Operations.

You can do the following:
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Sections on the About tab  (continued)

Title Description

• Select the add supplier location icon ( ) to add a supplier location. For more 
information, see Add a supplier location from the Source-to-Pay Workspace.

• Select the toggle list view icon ( ) to open the list view, which displays a list 

of all the supplier locations. Select the toggle map view icon ( ) to return to 
the map view.

• Select the toggle full screen view icon ( ) to view the map in full screen. 

Select the toggle full screen view icon ( ) to exit the full screen mode.

Stakeholders Displays internal stakeholders and supplier contacts associated with a supplier. 
Internal stakeholders are internal users with a unique relationship type such 
as Procurement manager or Category manager. To view a list of all the internal 
stakeholders, select the View stakeholders  option. For more information on 
adding and managing internal stakeholders, see Manage internal stakeholders

Supplier contacts are associated external users. Primary supplier contact 
is indicated with a Primary tag. To view a list of all the internal stakeholders, 
select the View supplier contacts  option. For more information on adding and 
managing supplier contacts, see Manage supplier contacts from the Source-to-
Pay Workspace.

Note:  The View stakeholders  and View supplier contacts  options are 
displayed only if the supplier has more than five internal stakeholders or 
supplier contacts respectively.

Option

Contextual 
side panel

This panel appears below the UI actions.

Select the supplier overview icon ( ) to open the following panels:

• Supplier overview: Displays information about the supplier.

• Supplier contacts: Displays information about the supplier contacts. An 
Admin label next to the contact's name indicates that the contact is a primary 
contact. If a supplier has more than 5 supplier contacts, the View all  option is 
displayed. Select View all  to view a list of all the contacts for the supplier.

Select the attachments icon ( ) to open the Attachments panel, which enables 
you to attach documents to the case.

Select the agent assist icon ( ) to open the Agent Assist panel, which enables 
you to search for information across multiple sources such as catalog items, 
knowledge articles, supplier cases, problems, and open incidents.

Options 
to sync 
supplier 
data with 
an external 
third-party 
application

Select Connect to external data: Enables you to synchronize the supplier data 
from an external third-party application so that you can view the latest supplier 
details in the Source-to-Pay Workspace

Select Sync with external data  to synchronize with an external third-party 
application to update the supplier details in the Source-to-Pay Workspace
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Sections on the About tab  (continued)

Title Description

Note:  The Sync with external data  option replaces the Connect to 
external data  option after you import supplier details for the first time using 
the Connect to external data  option.

For more information, see Synchronize supplier data using external third-party 
application.

Options 
to create 
supplier 
cases and 
supplier 
tasks

Select the Create  drop-down list to view these options:

• Create supplier case: Enables you to create a supplier case. For more 
information, see Create a supplier case.

• Create supplier task: Enables you to create a task for a supplier case. For 
more information, see Create a task for a supplier case from the Source-to-Pay 
Workspace

Option 
to save 
supplier 
details

If you update the supplier details, select Save  to save the data to the supplier 
record.

Option to 
delete a 
supplier

Select the see actions icon ( ) and select Delete  to delete a supplier.

Details tab

The Details  tab displays information about the supplier.

Note:  The fields on this tab are editable. You can update the supplier details and select 
Save  to save the data.

Fields on the Details tab

Field Description

Supplier

Number An auto-generated number that uniquely identifies a supplier.

Legal name Name of the supplier.

ERP supplier 
code

Company code of the supplier in the ERP system.

Parent entity Name of the parent company of the supplier.

Global 
company

Name of the global company of the supplier.

Relationship 
manager

Person responsible for managing the relationship with this supplier.

Relationship 
status

Business relationship that is designated to the supplier. The options are 
Strategic, Valued, Tactical, or Excluded.

Onboarded Whether the supplier is onboarded. The options are Yes or No.
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Fields on the Details tab  (continued)

Field Description

Preferred Whether the supplier is preferred. The options are Yes or No.

General

Street address Street where the supplier is located.

City City where the supplier is located.

State / 
Province

State or province where the supplier is located.

Country Country where the supplier is located.

Industry The type of industry the supplier belongs to.

Website Website of the supplier.

Image Option to attach an image of the supplier logo. Select Attach image  and select 
the image you want to attach.

Related work tab

The Related work  tab displays information about cases, tasks, sourcing requests, risk 
assessments, purchase requisitions, and shipments.

The Related work  tab contains the Lists section on the left, which contains the modules 
that display information about cases, tasks, sourcing requests, risk assessments, purchase 
requisitions, and shipments. The Lists section displays the count of records in each module. You 
can select a module to view a list of records in that module.

In the Number column, select the record number link to view more details pertaining to that 
record.

Modules on the Related work tab

Module Description

Cases Displays a list of cases for the supplier.

Tasks Displays a list of tasks for the supplier.

Risk 
assessments

Displays a list of risk assessments for the supplier.

Note:  This module is displayed only if you have installed the Vendor Risk 
Management (com.sn_vdr_risk_asmt) plugin.

Purchase 
requisitions

Displays a list of purchase requisitions for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) plugin.

Purchase 
orders

Displays a list of purchase orders for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) and Source-to-Pay Common 
Architecture (com.snc.sn_shop) plugins.
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Modules on the Related work tab  (continued)

Module Description

Shipments
Note:  This module is displayed only if you have installed the Supply 
Chain Exception Management (com.snc.sn_scm_core) plugin.

Invoices Displays a list of invoices for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) and Source-to-Pay Common 
Architecture (com.snc.sn_shop) plugins.

Spend tab

The Spend  tab displays information about open purchase orders, open invoices, your total 
spend, total savings, and the trend of your spend and savings over time.

Note: 

The Spend  tab becomes available in the Source-to-Pay Workspace  only if you install the 
Source-to-Pay Common Architecture  (com.snc.sn_shop) plugin. The Spend  tab displays 
information about open purchase orders, open invoices, your total spend, total savings, and 
a graphical representation of the trend of your spend and savings over time.

For detailed information about each component, select an individual widget or chart.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

102



Spend tab

Sections on the Spend tab

Title Type Description

Summary - Total Spend

All Time Widget View the total spend till date.

This Year Widget View the total spend for the 
year.

This Quarter Widget View the total spend for the 
quarter.

This Month Widget View the total spend for the 
quarter.
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Sections on the Spend tab  (continued)

Title Type Description

Summary - Total Savings

All Time Widget View the total savings till date.

This Year Widget View the total savings for the 
year.

This Quarter Widget View the total savings for the 
quarter.

This Month Widget View the total savings for the 
quarter.

Summary

Spend vs. Savings over time Graph Displays a graphical 
presentation of spend versus 
savings over a given period of 
time.

Purchase orders

Number Column An auto-generated number 
that uniquely identifies the 
purchase order.

In the Number column, select 
the link to the record number 
to view more details.

Display name Column Name of the purchase order 
for a supplier product.

Total amount Column The total cost of purchase 
requisition calculated as the 
sum from all related purchase 
lines.

Status Column State of the purchase order.

Created Column Date on which this purchase 
order is created.

Created by Column Person who created the 
purchase order.

Invoices

Number Column An auto-generated number 
that uniquely identifies the 
invoice.

In the Number column, select 
the link to the record number 
to view more details.

Purchase order Column Purchase order with which this 
invoice is associated.
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Sections on the Spend tab  (continued)

Title Type Description

State Column Status of the invoice.

Invoice date Column Date on which this invoice is 
created.

Created by Column Person who created the 
invoice.

Contracts

Number Column An auto-generated number 
that uniquely identifies the 
contract record.

In the Number column, select 
the link to the record number 
to view more details.

Name Column Short description of the 
contract.

Total cost Column Final cost of the contract.

State Column Current state of the contract.

Substate Column Current substate of the 
contract.

Start date Column Date on which the contract 
takes effect.

End date Column Date on which the contract 
expires

Risk tab

The Risk  tab displays third-party name and process information, summary reports, risk 
intelligence scores, and tracking data for issues and tasks. On most reports, you can select an 
item to view the underlying data.

The Risk  tab is displayed only if you have installed the Third-party Risk Management 
[com.sn_vdr_risk_asmt] and GRC: Vendor Risk Management Workspace 
(com.sn_vdr_risk_asmt_workspace) plugins.

To know more about the information displayed on the Risk  tab, see Viewing summarized risk 
information for a third party .

Performance

The Performance  tab displays the Dashboard which enables monitoring and managing supplier 
performance effectively and making data-driven decisions. You can view the overall supplier 
score, risk score, individual KPI scores, and domain-specific scores.

The Performance  tab is displayed only if you have installed the KPI Framework (com.snc.sn_kpi) 
and Supplier Relationship and Performance Management (com.snc.sn_slm_perf) plugins.
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To know more about the information displayed on the Performance  tab, see View supplier 
performance dashboard.

KPI Management

The KPI Management  tab provides comprehensive visibility into the performance scores of all 
KPIs. KPIs are grouped by domains (such as Inventory and Quality) and include critical details 
such as weight, frequency, and status.

The KPI Management  tab is displayed only if you have installed the KPI Framework 
(com.snc.sn_kpi) and Supplier Relationship and Performance Management 
(com.snc.sn_slm_perf) plugins.
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To know more about the information displayed on the KPI Management  tab, see Manage 
supplier KPIs from the supplier record page of the Source-to-Pay Workspace.

Subsidiaries tab

The Subsidiaries  tab displays all the subsidiaries of the supplier.

The Subsidiaries  tab contains the Add  option, which enables you to quickly add a subsidiary of 
the supplier. For more information, see Add a subsidiary for a supplier from the Source-to-Pay 
Workspace.

Stakeholders

The Stakeholders  tab helps you manage internal stakeholders and supplier contacts associated 
with a supplier. You can complete the following operations from this tab:

• View a list of internal stakeholders and supplier contacts

• Add internal stakeholders with a unique relationship type to the supplier

• Remove or update internal stakeholder details

• Add, remove, or update supplier contacts

• Manage access for primary contact role

For more information on the stakeholders tab, see Manage internal stakeholders  and Manage 
supplier contacts from the Source-to-Pay Workspace.
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Documents tab

The Documents  tab displays information about the required documents that the suppliers 
upload by either using this tab or from the Supplier Collaboration Portal.

The Documents  tab contains the Link Documents  option, which enables you to quickly add an 
already uploaded document without creating a new one. Access to the Link Documents  option 
is controlled by the user criteria you set on the Manage access  tab when creating the supplier 
document configuration. For more information, see Create a supplier document configuration.

Source-to-Pay Workspace  Case Details page

The Source-to-Pay Workspace  Case Details page is displayed when you select the link of a 
supplier case to view more details about that case.

On the Source-to-Pay Workspace  List page, navigate to Lists  > Cases  and select any of the sub-
modules to view a list of cases. Select the link to the case in the Number  column to open the 
Case Details page.

For more information about viewing cases in the Source-to-Pay Workspace, see View a supplier 
case from the Source-to-Pay Workspace.

The Case Details page contains the following options.

Case Details page options

Option Description

Multi-tab 
interface

When you select a link for a case, each case opens in a separate tab in the top-left 
corner, which enables you to easily navigate between multiple open cases.

Each case displays information in the following tabs:

• Playbook  tab: Displays either the playbook to onboard a supplier or the generic 
playbook depending on the case type. For more information, see Use the 
supplier onboarding playbook to onboard suppliers  and Case playbook for 
specific supplier case types.

• Details  tab: Contains the Supplier Case, Summary Details, and Resolution 
Information sections.

◦ Supplier Case: Displays information about the supplier case.

◦ Summary Details: Displays the parent case, related location, start and end 
dates for the case.

◦ Resolution Information: Displays the resolution information and close notes for 
the case.

• Supplier Information  tab: Displays information about the supplier. For more 
information about this tab, see Supplier Information tab.

• Supplier Tasks  tab: Lists the supplier tasks for the supplier case.

• Related Cases  tab: Lists the child supplier cases related to the parent supplier 
case.

If you've not installed Third-party Risk Management, the playbook creates 
supplier cases of types Risk assessment  and Tiering assessment. The Supplier 
Risk Assessment and Supplier Tiering Assessment cases are child cases of the 
parent Onboard a Supplier  case and are displayed on the Related Cases  tab. 
The supplier owner or supplier manager assigns these assessment cases to the 
TPR assessor.
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Case Details page options  (continued)

Option Description

• Approvals  tab: Lists the approval records, their approval status, and the persons 
who need to approve this case.

Important:  Supplier Lifecycle Operations  creates an approval record if 
the "Ask For Approval" action is a part of any SLO flow. This approval record 
can be approved by the user who belongs to the Supplier Administrators 
group (sys_user_group table). For more information, see Add a user to a 
group .

• Risk Assessments  tab: Displays the risk assessments for a supplier.

If you have installed Third-party Risk Management, the playbook creates the risk 
assessment records and displays them in this tab.

• Tiering Assessments  tab: Displays the tiering assessments for a supplier.

If you have installed Third-party Risk Management, the playbook creates the 
tiering assessment records and displays them in this tab.

Note:  The Risk Assessments  and Tiering Assessments  tabs are shown 
only for a supplier case of type Supplier onboarding.

• Draft Emails  tab: Displays a list of emails you saved as draft.

• Documents  tab: Enables you to manage supplier documents by uploading, 
updating and downloading the required documents

Compose 
section

Contains the Comments and Work notes (Private) widgets. The text that you enter 
in the Comments section are visible to everyone. However, the text that you enter 
in the Work notes (Private section) are visible only to internal users; customers 
cannot view them.

Activity 
stream

Displays all the processing activities, conversations, and changes that have 
happened since the case was opened. You can filter activities by post types, field 
changes, and flagged activities.

Contextual 
side panel

This panel appears below the UI actions.

Select the supplier overview icon ( ) to open the following panels:

• Supplier overview: Displays the following information about the supplier.

◦ Supplier: Name of the supplier.

◦ Short description: Brief description about the supplier.

◦ Risk rating: The risk rating of the supplier.

The risk rating scale helps business users better understand risk assessment 
results. For example, in the default settings, risk scores in the 20 through 39 
range indicate high risk, while scores in the 60 through 79 range indicate low 
risk.

Depending on the risk score of the supplier, the following risk ratings are 
displayed:
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Case Details page options  (continued)

Option Description

▪ 1 - Very High

▪ 2 - High

▪ 3 - Moderate

▪ 4 - Low

▪ 5 - Very Low

For more information about risk ratings and risk scores, see Set up risk rating 
scales for scoring .

◦ Onboarded: Status of whether the supplier is onboarded into the ERP system. 
The options are Yes or No.

◦ DUNS number: Unique, 9-digit identifier for a supplier.

◦ Website: Website of the supplier.

◦ Industry: Industry to which the supplier belongs.

◦ Country of Registration: The country in which the supplier is registered.

• Supplier contacts: Displays information about the supplier contacts. An Admin 
label next to the contact's name indicates that the contact is a primary contact. If 
a supplier has more than five supplier contacts, the View all  option is displayed. 
Select View all  to view a list of all the contacts for the supplier.

Select the attachments icon ( ) to open the Attachments panel, which enables 
you to attach documents to the case.

Select the agent assist icon ( ) to open the Agent Assist panel, which enables 
you to search for information across multiple sources such as catalog items, 
knowledge articles, supplier cases, problems, and open incidents.

Supplier Information tab

The Supplier Information  tab shows details about the supplier and the supplier contact, a 
summary of all the open and overdue cases, and a list of all the cases by their priority.
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Supplier Information tab

Sections

The Supplier Information  tab includes the following sections.

Sections on the Supplier Information tab

Section Description

Supplier Displays the following information about the supplier:

• Primary Contact

• Phone

• Website

• Street Address

• City/State

• Country
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Sections on the Supplier Information tab  (continued)

Section Description

Contact Displays the following information about the contact:

• Office Phone

• Mobile Phone

• Email

• Street Address

• City/State

• Country

Reports

The Supplier Information  tab includes the following reports.

Reports on the Supplier Information tab

Title Type Description

Supplier case summary

Open Single 
score

Total number of open cases for the supplier. Click the number to 
view the list of open cases.

Overdue Single 
score

Total number of overdue cases for the supplier. Click the number to 
view the list of overdue cases.

Cases Donut 
chart

Total number of supplier cases by case or type.

By Type Choice 
list

Enables you to filter and view cases by type or state in the Cases 
donut chart.

Contact case summary

Open Single 
score

Total number of open cases requested by the contact. Click the 
number to view the list of open cases.

Overdue Single 
score

Total number of overdue cases requested by the contact. Click the 
number to view the list of overdue cases.

Cases Donut 
chart

Total number of cases by type or state.

By type Choice 
list

Enables you to filter and view cases by type or state in the Cases 
donut chart.

Cases by priority

Count of cases 
by priority

Donut 
chart

Total number of cases by priority.

List of cases and 
their details

List
Displays a list of cases by their priority, including case details, such 
as case number, short description, and priority.
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Reports on the Supplier Information tab  (continued)

Title Type Description

In the Number column, select the link to the case to view more 
details.

Sidebar for supplier cases in the Source-to-Pay Workspace

Sidebar enables stakeholders to collaborate with others by getting into discussions when 
working on supplier cases.

You can start a Sidebar discussion by selecting Discuss  on a supplier case in the Source-to-Pay 
Workspace. Other stakeholders are notified when you add them to a discussion. They can join 

the discussion by selecting the Sidebar discussions icon ( ).

For more information on what Sidebar is, see Sidebar .

To learn more about how to use Sidebar, see Using Sidebar .

For information on activity stream in Sidebar is, see Activity stream in Sidebar .

APO  landing page

Use the Source-to-Pay Workspace  landing page to find all the information that you need and view 
the tasks specific to your role, all in one location.

Open the Source-to-Pay Workspace  by navigating to All  > Accounts Payable Operations  > 
Accounts Payable Workspace.

When you open the Source-to-Pay Workspace, the home page is displayed by default. If you 

navigate away from the home page, you can select the home icon ( ) to return to the home 
page.

As an agent, you can view and manage to-do tasks assigned to you, open any unassigned 
cases, and cases by priority. As an Accounts Payable Specialist, you can view and manage tasks 
assigned to you, open any unassigned cases, cases by priority, invoice exceptions, and invoices 
at risk of being paid late.

Landing page view for an Accounts Payable Specialist

The following information is displayed on the landing page when you log in to the workspace 
with the Accounts Payable Specialist [sn_ap_apm.accounts_payable_specialist] or admin 
[sn_ap_apm.admin] role.

Note:  For a detailed analysis on each component, select the respective widget or chart.

Landing page view for an Accounts Payable Specialist

Title Type Description

Quick actions

Create New 
Invoice

Widget Opens a new tab that enables you to create a new invoice case with 
the Invoice automation category.

Review your work
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Landing page view for an Accounts Payable Specialist  (continued)

Title Type Description

Supplier Filter Filter by supplier to view information for specific suppliers in the 
widgets of the Review your work section.

Legal entity Filter Filter by legal entity to view information for specific legal entities in 
the widgets of the Review your work section.

My invoices Widget Displays the invoices grouped by their state.

Top invoice 
exception types

Donut 
chart

Displays the invoice exceptions grouped by type.

Select View all  to view a list of all the exception types.

Invoices due 
soon

Bar 
chart

Displays the invoices grouped by state that are due soon.

Select View all  to view a list of all the invoices that are due soon.

My team

Backlog Widget View the list of cases that are yet to be assigned.

Landing page view for an agent

The following information is displayed on the landing page when you log in to the workspace with 
the agent [sn_ap_cm.agent] or admin [sn_ap_cm.admin] role.

Note:  For a detailed analysis on each component, select the respective widget or chart.

Landing page view for an agent

Title Type Description

Quick actions

Create New 
Inquiry

Widget Opens a new tab that enables you to create a new invoice case with 
the Inquiry category.

Review your work

Supplier Filter Filter by supplier to view information for specific suppliers in the 
widgets of the Review your work section.

Open inquiries 
by status

Widget Displays the inquiries grouped by their status.

Select View all  to view a list of all the inquiries.

Inquiries by 
category

Widget Displays the inquiries grouped by their category.

Select View all  to view a list of all the inquiries.

My team

Backlog Widget View the list of cases that are yet to be assigned.

Landing page view for task owner

The following information is displayed on the landing page when you log in to the workspace with 
the task owner role.
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Note:  For a detailed analysis on each component, select the respective widget or chart.

Landing page view for task owner

Title Type Description

Work assigned to you

Open tasks Widget Displays the number of invoice tasks in Open status.

Select View all  to view a list of all the invoices that are in open state.

Tasks by 
state

Bar 
chart

Displays the invoices grouped by state that are due soon.

Select View all  to view a list of all the invoices that are due soon.

Your tasks

Exception 
task

Filter Displays the card view of invoice tasks. Filter by due dates to view details 
of exception tasks for task owners that are due soon.

Summary

Unassigned 
tasks

Widget View the list of invoice tasks that are assigned to the assignment group 
of the current user. For more information on the fields of invoice tasks, 
see Create New Invoice task form

Source-to-Pay Workspace  list page

The Source-to-Pay Workspace  list page enables you to see high-level information for all records 
in a list filter.

The modules that are displayed on the list page vary depending on the Source-to-Pay 
Operations  product that you have installed.

For example, if you have installed only Sourcing and Procurement Operations  (SPO) and if you 
are assigned the Supplier Fulfiller [sn_slm.fulfiller] role, you can view only SPO modules on the 
list page.

If you have installed both Sourcing and Procurement Operations  (SPO) and SLO and if you are 
assigned the Procurement Specialist [sn_shop.procurement_specialist] and Supplier Fulfiller 
[sn_slm.fulfiller] roles, the list page displays a combination of modules for both the installed 
products.

In the Source-to-Pay Workspace, select the list icon ( ) to open the List page.

You can select each module and sub-module to view the details in a list. Under Lists, you can do 
the following:

• Refresh the list to display the most updated information.

• Edit columns to adjust the list to display required columns in the order of your choice.

• Reset column widths to default.

• Copy the URL for this list.

• Apply filters to view specific information that you are interested in.

• Export the list to a file in Excel, CSV, JSON, or PDF format.

• Create a copy of the list and save it under My Lists.
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SPO  list page

As a Procurement Case Management (PCM) Agent, view and work with your procurement 
cases, and view the knowledge base. When logged in as a Procurement Specialist however, 
you can also view and work with the various case types, knowledge base, orders, receipt 
acknowledgments, interactions, and primary data.

With an additional supplier role of sn_supplier.fulfiller, a Procurement Specialist can view, work 
on, and also create supplier cases from the list view of Source-to-Pay Workspace.

Note:  The app-supplier (com.snc.sn_supplier_mgmt) and app-supplier-common 
(com.snc.sn_slm) plugins must also be installed to view supplier cases.

You can select each module and submodule to view the details in a list. Here, you can adjust the 
column widths, copy the URL, apply filters, and export the list to a desired file type. You can also 
edit a selected record or create a new record as required.

You can then open the record number link to view more details pertaining to that record, 
including related lists displayed as tabs, and the activity stream for that record that contains 
comments, work notes, and emails.

Related list grouping

As a sourcing manager working on certain procurement objects, you can view all the similar 
related lists grouped at one place for your easy reference, under the Related work, Agreements, 
and Sourcing approach  tabs. The following information is usually grouped under these tabs:

• Related work

◦ Approval plans

◦ Purchasing tasks

◦ Purchasing SLAs

◦ Task SLAs

◦ Contract requests

Note:  This tab is available for sourcing requests, negotiation events, negotiations, 
purchase requisitions, and purchase lines, only if you have the Source-to-Pay 
Operations  with Contract Management Pro  plugin (com.snc.sn_spend_clm) installed.

◦ Cases

◦ Interaction-related records

Note:  This tab is typically available for cases.

• Agreements

◦ Related contracts

◦ Signed contracts

◦ Draft contracts

◦ Other legal documents

• Sourcing approach
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◦ Sourcing requests

◦ Negotiations

◦ Purchase lines

Note:  This tab is typically available for negotiation events.

• Emails

◦ Draft emails

◦ Sent emails

Note:  You can customize the related lists to be displayed in these related work item 
tabs by updating the necessary client-side variables in the standard Record page that is 
shipped with Source-to-Pay Workspace. Any conflicts arising from previous customizations 
with the record page can be handled by identifying the difference in the macroponent file 
and merging the changes as required.​

Form grouping

As sourcing and purchasing fulfillers working on sourcing requests in the Source-to-Pay 
Workspace, view the sourcing request form data in organized sections as follows, making it 
easier for you to find the information that you must focus on.

• Sourcing Request

• Requested Product

• Negotiation Event

The Purchase Lines and Contract Requests related lists also display the information that are 
most important for the sourcing and purchasing fulfillers.

Further, the purchase line (PRL) form is organized into sections, displaying relevant fields, based 
on whether you’re viewing it as part of the sourcing and negotiating processes, or the purchasing 
process.

Here are the section details of a purchase line with details of the relevant fields.

• Purchase Line

Note:  In case a purchase line is canceled as part of the sourcing process, this section 
provides details on the cancellation reason and canceled by. This information isn’t 
provided for active purchase lines.

• Supplier and Pricing

Note:  As part of a purchase requisition, pricing related information such as starting unit 
price, negotiated unit price, total line amount, and so on, are provided for the purchase 
line.

• Delivery
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Note: 

◦ For goods to be sourced, the requested delivery date is displayed.

◦ For services to be sourced, requested start and end dates are displayed.

◦ This section isn’t available for purchase lines of type handing fee.

• Accounting, Receiving, and Payment

To debug why a particular field is visible or hidden, navigate to Form Builder from the sourcing 
request form and select each field to understand which UI Policy is applicable.

Contextual information

From the contextual side panel, you can view relevant information such as Agent Assist, 
attachments, templates, and procurement cases and tasks associated with that procurement 
record via dynamic related records.

For information on Agent Assist, see Agent assist in Source-to-Pay Workspace. For information 
on procurement and supplier case creation, see Create a procurement case  and Create a 
supplier case. For information on procurement task creation, see Create a procurement task.

As sourcing managers and fulfillers, you also get a contextual view of supplier profile cards for 
procurement objects such as purchase requisitions, sourcing requests, negotiation events, 
negotiations, and procurement cases. These supplier profile cards help you with key relevant 
information such as supplier name, industry, onboarded flag, website, supplier contact, if any, 
and so on. All the relevant suppliers for each procurement object are visible in the contextual 
side panel. For example, if a sourcing request is being worked on with three suppliers, then all 
the three supplier profile cards are visible in the contextual panel. You can further drill down into 
the supplier 360-degree view by selecting the individual supplier cards, and gather details about 
them.

As administrators, you can customize the look and feel or the information to be displayed in 
these supplier profile cards, from the supplier manager workspace experience in UI Builder. You 
can also add these supplier cards to more procurement objects in Source-to-Pay Workspace 
by modifying the conditions of the object record pages. Any conflicts arising from previous 
customizations with the record page can be handled by identifying the difference in the 
macroponent file and merging the changes as required.​

Sidebar and Microsoft Teams for Source-to-Pay Workspace

Sidebar enables stakeholders to collaborate with others by getting into discussions when 
working on task-based records. You can create a Sidebar discussion by selecting Discuss 
from your procurement object details page on the Source-to-Pay Workspace  list page. Other 
stakeholders are notified when you add them to a discussion. They can join the discussion from 
the Sidebar discussions icon. For more information, see Sidebar and Microsoft Teams .

For more information on Sidebar, see Sidebar .

To learn more about how to use Sidebar, see Using Sidebar .

For information on activity stream in Sidebar, see Activity stream in Sidebar .

For detailed information on integrating and enabling Sidebar with Microsoft Teams, see Integrate 
Sidebar and Microsoft Teams  and Enable or configure the Microsoft Teams integration .
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SLO  list page

As a supplier manager, use the list page to work on the various supplier case types, view the 
cases and tasks assigned to you, all the cases and tasks, all the unassigned tasks, Knowledge 
Base  articles, and active suppliers.

Open the Source-to-Pay Workspace  by navigating to All  > Supplier Lifecycle Operations  > 
Source-to-Pay Workspace.

As a supplier manager, you have access to the following modules and sub-modules.

Note:  You can create a new case, task, knowledge article, or interaction by selecting the 
New  option on the top right corner within a sub-module. When you navigate to and open a 
sub-module, click the link under the Number column to view more details about that sub-
module.

Modules and sub-modules on the List page

Module Sub-module

My work • Open cases: Displays a list of all the open cases assigned to you.

• Open tasks: Displays a list of all the open tasks assigned to you.

• Open interactions: Displays the interactions that are assigned to you.

For more information, see Create a supplier case.

Review 
needed

• Unassigned cases: Displays a list of all the unassigned cases.

• Unassigned tasks: Displays a list of all the unassigned tasks.

For more information, see Create a task for a supplier case from the Source-to-Pay 
Workspace.

All work • Cases: Displays a list of all the cases.

• Closed cases: Displays a list of all the closed cases.

• Supplier tasks: Displays a list of all the supplier tasks.

• Employee tasks: Displays a list of all the employee tasks. These are internal 
tasks that are assigned to individuals within the same organization.

• Interactions: Displays a list of all the interactions.

• Closed interactions: Displays a list of all the closed interactions.

For more information, see Interaction Management in Supplier Lifecycle 
Operations.

Knowledge Supplier articles: Displays a list of knowledge articles for suppliers.

Primary 
Data

Suppliers: Displays a list of active suppliers.

APO  list page

As an agent, view and work with the primary data, all the invoice inquiry cases, including the 
cases that are assigned to you. As an Account Payable Specialist, you can view and work with 
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the primary data, all the invoice processing cases, your assigned cases and tasks, invoices, and 
invoice exceptions.

Select the list icon ( ) to open the List page in the Source-to-Pay Workspace.

You can select each module and sub-module to view the details in a list. Under Lists, you can do 
the following:

• Refresh the list to display the most updated information.

• Edit columns to adjust the list to display required columns in the order of your choice.

• Reset column widths to default.

• Copy the URL for this list.

• Apply filters to view specific information that you're interested in.

• Export the list to a file in Excel, CSV, JSON, or PDF format.

• Create a copy of the list and save it under My Lists.

• Edit a selected supplier case or create a new supplier case.

As an Accounts Payable Specialist, you have access to the following modules and sub-modules:

• My Work

◦ My open invoice processing cases

◦ My open invoice exceptions

◦ My open tasks

◦ Unassigned cases

◦ Unassigned tasks

• All Work

◦ All open invoice processing cases

◦ All open invoice exceptions

◦ All open tasks

◦ All closed cases

◦ All closed tasks

• Primary Data

◦ Suppliers

◦ Purchase orders

◦ Goods receipts

◦ Invoices

◦ Payment terms

◦ Ledger accounts

As an agent, you have access to the following modules and sub-modules:

• My work in progress: Cases

• All team work: Cases

• My Work
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◦ My open invoice inquiry cases

◦ My open tasks

◦ Unassigned cases

◦ Unassigned tasks

• All Work

◦ All open invoice inquiry cases

◦ All open tasks

◦ All closed cases

◦ All closed tasks

• Primary Data

◦ Suppliers

◦ Purchase orders

◦ Invoices

◦ Payment terms

Configuring Source-to-Pay Workspace

Plan and configure your implementation for Source-to-Pay Workspace.

• For more information on configuring Sourcing and Procurement Operations, see Configuring 
Sourcing and Procurement Operations.

• For more information on configuring Supplier Lifecycle Operations, see Configuring Supplier 
Lifecycle Operations.

• For more information on configuring Source-to-Pay Workspace, see Configuring Accounts 
Payable Operations.

Configuring knowledge bases to enable guest users to read knowledge articles from the 
Source-to-Pay Workspace

Configure knowledge bases so that guest users can read the created knowledge articles from 
the Source-to-Pay Workspace.

Publish knowledge articles to enable guest users to read them from the Source-to-Pay 
Workspace

To enable guest users to read a knowledge article, add them to the Can Read list of the 
corresponding knowledge base in the Source-to-Pay Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > Knowledge Bases.

2. Select the knowledge base that you want to configure.
For example, select Purchase and Expense  or Supplier Knowledge.

3. On the Can Read related list, select Edit.

4. In the Collection list, search for the Guest User  role.

5. Move the Guest User  role from the Collection list to the Can Read list.
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6. Select Save.
A guest user can now read the knowledge article from the Source-to-Pay Workspace.

Publish a knowledge article from the Source-to-Pay Workspace

You can publish a knowledge article from the from the Source-to-Pay Workspace.

Before you begin
Role required: sn_slm.manager, sn_shop.procurement_specialist_manager, or admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and

3. Navigate to Lists  > Knowledge, and then select one of the following:

◦ Supplier articles

◦ Procurement articles

4. Under the Number column, select the link to a knowledge article to open it.

5. Select Publish.
A confirmation message appears, informing you that the knowledge article may be published 
and be visible to unauthenticated users.

6. Select Publish.

Using Source-to-Pay Workspace

Procurement specialists, sourcing managers, supplier managers, supplier contacts, accounts 
payable specialists use the Source-to-Pay Workspace  to work on various requests, cases, 
negotiations, accelerate supplier onboarding, minimize supplier risk, validate invoice processing 
cases, and maximize productivity.

• For more information on using Sourcing and Procurement Operations, see Using Sourcing and 
Procurement Operations.

• For more information on using Supplier Lifecycle Operations, see Using Supplier Lifecycle 
Operations.

• For more information on using Source-to-Pay Workspace, see Using Accounts Payable 
Operations.

Create a known error article from the Source-to-Pay Workspace

Create known error articles to document the root cause and the workaround of a problem to help 
with resolving incidents.

Before you begin
Role required: sn_slm.manager, sn_shop.procurement_specialist_manager, or admin

Procedure

1. Navigate to All  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Knowledge, and then select one of the following:
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◦ Supplier articles

◦ Procurement articles

4. Select New.

5. In the Create article dialog box, do the following:

◦ In the Knowledge Base  field, select Purchase and Expense  or Supplier Knowledge.

◦ In the Article Template  field, select Known Error article.

◦ Select Create Article.

6. On the Create New Known Error article form, fill in the fields.

Field Description

Number Read-only field. Unique number to identify 
the known error article.

Knowledge base Knowledge base to which this article belongs.

Category Category of the article. Use the category 
picker to select an existing category or 
subcategory.

Valid to Date after which the known error article is 
deleted from the database. After this date, 
the article does not appear in the search 
result.

Version Read-only field. Managed by the Knowledge 
Management process when changes are 
made to a published article.

Workflow Status of the article.

Source Task Read-only field. The Problem record on which 
you are creating the article.

Attachment link Select the check box so that the article 
appears as an attachment in the Problem 
record. If you do not select the check box, 
the content of the article appears in the work 
note of the Problem.

Display attachments Display of attachments in the article. When 
you do not select this option, the article does 
not display the attachments.

Short description Short description of the known error.

Description Detailed explanation of the known error.

Workaround Method that you have used to overcome the 
problem. It can be a way of dealing with a 
problem or making something work despite 
the problem not being resolved.

Cause Information about what had caused the 
problem.

7. Select Save.
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Create a knowledge base article from the Source-to-Pay Workspace

Create knowledge base articles within a knowledge base to share information across your 
organization.

Before you begin
Role required: sn_slm.manager, sn_shop.procurement_specialist_manager, or admin

Procedure

1. Navigate to All  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Knowledge, and then select one of the following:

◦ Supplier articles

◦ Procurement articles

4. Select New.

5. In the Create Article dialog box, do the following:

◦ In the Knowledge Base  field, select Purchase and Expense  or Supplier Knowledge.

◦ In the Article Template  field, select Standard.

◦ Select Create Article.

6. On the Create New Knowledge form, fill in the fields.

Field Description

Number System-generated unique identifier for the 
request.

Knowledge base Knowledge base to which this article belongs.

Category Category of the article. Use the category 
picker to select an existing category or 
subcategory. You can create a category or 
subcategory to suit your requirements.

Schedule publish date Date in future when the article is published 
automatically. If approvals are enabled, the 
approval process must be completed before 
this date.

Valid to Validity of the article.

Version Read-only field. Managed by the Knowledge 
Management process when changes are 
made to a published article.

Article type Type of article, such as HTML.

Workflow Status of the article.

Source Task Name of the article source.

Attachment link Link to attachments.

Display attachments Display of attachments in the article. When 
you do not select this option, the article does 
not display the attachments.
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Field Description

Short description Short description of the article.

Article body Detailed description of the article.

7. Select Save.

Source-to-Pay Workspace  reference

Reference topics provide additional information about articles, lists and forms that you use in 
Source-to-Pay Workspace.

• For more information on Sourcing and Procurement Operations, see SPO landing page.

• For more information on Supplier Lifecycle Operations, see SLO landing page.

• For more information on Source-to-Pay Workspace, see APO landing page.

Source-to-Pay Workspace  Analytics Center

With Source-to-Pay Workspace  Analytics Center, you can ask a question about your data, and 
see how things are performing now and trends over time.

This Analytics Center is modeled using Natural Language Query (NLQ) which is helpful in 
converting natural language into database queries, thus fetching relevant data from the 
respective database tables. In this case, NLQ is developed with the help of configurable 
synonyms and semantic shortcuts. In synonyms, for example, to fetch data from the Supplier 
column in the Purchase Line table, a synonym "vendor" is added. Similarly, multiple synonyms 
can be configured to further improve search results. In semantics, conditions can be configured 
for the synonym such that search results can be further optimized. For example, to render 
appropriate search results for closed contracts, a condition "active=false" is configured against 
the synonym "closed" for the Contract Task table.

Source-to-Pay Workspace  Analytics Center

Based on these synonyms and semantic conditions, some of the predefined supported 
questions are listed here.

• Purchase requisition

◦ Order type

▪ Show me purchase requisitions of type standard

▪ Show me purchase requisitions of type blanket

▪ Show me standard purchase requisitions

▪ Show me blanket purchase requisitions

◦ Requisition type

▪ Show me net new purchase requisitions

▪ Show me revised purchase requisitions
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◦ Active

▪ Show me all open purchase requisitions

▪ Show me all closed purchase requisitions

• Sourcing request: Active

◦ Show me all open sourcing requests

◦ Show me all closed sourcing requests

• Negotiation: Active

◦ Show me all open negotiations

◦ Show me all closed negotiations

• Purchase line: Product type

◦ Show me all purchase lines of type good

◦ Show me all purchase lines of type goods

◦ Show me all purchase lines of type service

• Purchasing tasks and all extensions of purchasing tasks: Active

◦ Show me all open <task type>

◦ Show me all closed <task type>

• Purchase order: Order type

◦ Show me purchase orders of type standard

◦ Show me purchase orders of type blanket

• Purchase order line: Product type

◦ Show me all purchase order lines of type good

◦ Show me all purchase order lines of type goods

◦ Show me all purchase order lines of type service

• Milestones

◦ Completion date

▪ Show me upcoming milestones

▪ Show me today's milestones

▪ Show me past milestones

▪ Show me historical milestones

◦ Active

▪ Show me all open milestones

▪ Show me all closed milestones

• Receipt tasks: Active

◦ Show me all open receipt tasks

◦ Show me all closed receipt tasks

• Procurement cases: Active

◦ Show me all open procurement cases

◦ Show me all closed procurement cases
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Note:  For any questions that you may want to ask about your data, ensure that you specify 
the table name as it appears in the database, along with other keywords as required, such 
as the state or type, for example. Search results are sometimes displayed graphically, 
based on the search criteria used.

If you do not get the desired search results, select How can I improve my results?  to view tips 
and suggestions on improving your search.

Source-to-Pay Integrations
You can find all the Source-to-Pay third-party integrations on the ServiceNow Store, and this 
section helps you understand these integrations.

Source-to-Pay integration applications

Integrating with third-
party applications

Extend the capabilities of 
Source-to-Pay Operations 

by integrating with 
third-party applications

Integrating Sourcing 
and Procurement 

Operations (SPO) with 
other applications

Extend the capabilities of 
Sourcing and Procurement 

Operations and connect 
with other departments 

by integrating with 
other applications

Integrating Supplier 
Lifecycle Operations 

(SLO) with other 
applications

Extend the capabilities 
of Supplier Lifecycle 

Operations by integrating 
with other applications

Integrating Accounts 
Payable Operations (APO) 

with other applications

Extend the capabilities 
of Accounts Payable 

Operations by integrating 
with other applications

Source-to-Pay integration with third-party applications

Extend the capabilities of Source-to-Pay Operations  by integrating with third-party applications.
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Source-to-Pay integration framework

As part of the Source-to-Pay (S2P) integration framework, customers can install an optional third-
party ERP integration application that enables primary data, fixed assets, purchase order, receipt, 
invoice, and tax integration capabilities between S2P and the third-party ERP application. For 
more information, see Source-to-Pay integration framework.

Source-to-Pay Operations  integration with SAP

Source-to-Pay Operations  integration with SAP provides integration workflows for integrating the 
Sourcing and Procurement Operations, Supplier Lifecycle Operations, and Accounts Payable 
Operations. For more information, see Source-to-Pay integration with SAP.

Source-to-Pay integration with 3CLogic

Integrate Source-to-Pay Operations  with 3CLogic Cloud Contact Center solution to enhance 
the end-user experience with voice and SMS capabilities. 3CLogic is a ServiceNow  partner 
that provides native voice and SMS capabilities to complement ServiceNow’s existing digital 
channels. For more information, see About 3CLogic .

Source-to-Pay integration with Oracle EBS

Integrate Source-to-Pay Operations with Oracle EBS to handle sales orders, procurement, 
finance, and so on, in Oracle EBS from your ServiceNow instance. For more information, see 
Source-to-Pay integration with Oracle EBS.

Source-to-Pay integration with SAP Ariba

Integrate Source-to-Pay Operations with SAP Ariba  to handle sales orders, procurement, finance, 
and so on, in Coupa from your ServiceNow  instance. For more information, see Source-to-Pay 
integration with SAP Ariba.

Source-to-Pay integration with Coupa

Integrate Source-to-Pay Operations with Coupa to handle sales orders, procurement, finance, 
and so on, in Coupa from your ServiceNow  instance. For more information, see Source-to-Pay 
integration with Coupa.

Integrations

• Source-to-Pay integration framework

• Source-to-Pay integration with SAP

• Source-to-Pay Integration with 3CLogic

• Source-to-Pay integration with Oracle EBS

• Source-to-Pay integration with SAP Ariba

• Source-to-Pay integration with Coupa

Source-to-Pay integration framework

As part of the Source-to-Pay (S2P) integration framework, customers can install an optional third-
party ERP integration application that enables primary data, fixed assets, purchase order, receipt, 
invoice, and tax integration capabilities between S2P and the third-party ERP application.

Primary data entities include:
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• Supplier

• Profit center

• Cost center

• Ledger accounts

• Purchase organizations

• Asset category

• Material mapping

• Unit of measure

While the third-party application is the system of record for primary data, S2P is the system of 
record for purchase orders and receipts. Invoices are either created manually in S2P or through 
an external supplier portal (for example, Ariba). For tax calculation and integration, see Tax 
calculations.

The integration between S2P and the third-party application requires settings on both sides so 
that these applications function properly together.

• Integration settings on Source-to-Pay side

• Integration setting on the third-party side.

Applications required for third-party integration

The integration requires the Finance – ERP Integration store application.

Permissions and roles for third-party integration

The following ServiceNow  roles are required for integration:

• System administrator (admin) for installation of the integration application.

• Procurement Specialist (sn_shop.procurement_specialist) for defining the ERP source.

• FCA Integration user (sn_fcms_intg.integration_user) for ERP source configurations such 
as web service authorization, web services for Park and Post, Reverse, and User and Role 
mapping.

Add the following roles to the FCA Integration user:

◦ Import_transformer

◦ Soap

MID Server required for third-party integration

This integration requires an installed and configured MID Server  in your ServiceNow  instance to 
connect to the ERP system server. See Installing the MID Server  for details.

Note:  The MID Server  integration is required only for an ERP integration using SOAP 
services.

Inbound staging tables for Source-to-Pay Operations

The inbound staging tables for Source-to-Pay Operations  temporarily store source-to-pay data 
before it is sent to the Source-to-Pay primary data tables.
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Inbound staging tables for Sourcing and Procurement Operations

The inbound staging tables for Sourcing and Procurement Operations  temporarily store sourcing 
and procurement data before it is sent to the SPO  primary data tables.

CMDB Model Category Stage inbound staging table

The CMDB Model Category Stage inbound [sn_fcms_intg_cmdb_model_category_stage] staging 
table temporarily stores important data about product model categories before this data is sent 
to the primary table.

The following table lists the mandatory fields for the CMDB Model Category Stage inbound 
[sn_fcms_intg_cmdb_model_category_stage] staging table.

CMDB Model Category Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Name String Name of the CMDB model category.

CMDB Service Model Stage inbound staging table

The CMDB Service Model Stage inbound [sn_fcms_intg_cmdb_service_model_stage] staging 
table temporarily stores important data about service models before this data is sent to the 
primary table.

The following table lists the mandatory fields for the CMDB Service Model Stage inbound 
[sn_fcms_intg_cmdb_service_model_stage] staging table.

CMDB Service Model Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Model 
number

String Unique identifier for the service model.

CMN Location Stage inbound staging table

The CMN Location Stage inbound [sn_fcms_intg_cmn_location_stage] staging table temporarily 
stores important data about locations before this data is sent to the primary table.

The following table lists the mandatory fields for the CMN Location Stage inbound 
[sn_fcms_intg_cmn_location_stage] staging table.

CMN Location Stage inbound staging table

Field Data type Description

City String Name of the city where the CMN 
location belongs.
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CMN Location Stage inbound staging table  (continued)

Field Data type Description

Country String Name of the country where the 
CMN location belongs.

Country key String Country key of the CMN location.

Default String Indicates whether the CMN 
location is default or not.

ERP source String ERP source from which data is 
imported. For purchase order, 
receipt, and invoice integrations, 
the ERP source is determined 
through the legal entity associated 
with these records.

Legal entity String Name of the legal entity

Location String Coordinates or details of the CMN 
location.

Name String Name of the CMN location.

Plant String Name of the plant at the CMN 
location.

Postal code String Postal code of the CMN location.

Region String Region name of the CMN location.

State String State / province of the CMN 
location.

Street String Street of the CMN location.

Street and house number String Street and house number of the 
CMN location.

Zip String Zip code of the CMN location.

Catalog Import staging table

The Catalog Import [sn_spend_intg_imp_catalog] staging table temporarily stores important data 
about catalog imports before this data is sent to the primary table.

Catalog Import

Fields Data type Description

Available for countries String Countries where the product 
is available.

Available Units String Number of units of a product 
that are available.

Bundle Boolean Indicates whether the Product 
Model is of type bundle.

Bundled Components String Bundle model components as 
a json array.
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Catalog Import  (continued)

Fields Data type Description

Catalog id String Unique identifier for each 
catalog of the purchase order.

Category UNSPSC code String

Contract end date String Date on which the contract 
term ends.

Contract number String

Contract start date String Date on which the contract 
term starts.

Customer id String Unique identifier for the 
customer.

Delivery time String Estimated number of days it 
takes to ship a product to the 
customer.

Images String List of strings that specify the 
image URLs for the supplier 
product.

Manufacturer/publisher name String Name of the manufacturer or 
publisher.

Manufacturer/publisher part 
number (MPN)

String Manufacturer or publisher’s 
unique identifier for the 
product.

Negotiated currency String Currency used in price 
negotiation.

Negotiated price String Unit price of a product as 
negotiated through a contract 
with the supplier .

Parent Bundle Part Number 
(MPN/SKU)

String Manufacturer/publisher/
supplier part number of the 
parent bundle.

Product attributes String Attributes of the product.

Product category Reference Reference to the Product 
category.

Product category name String Category of the product.

Product description String Description of the product.

Product name String Name of the product or 
service purchased from a 
supplier.

Provider Reference

Sales end date String Date when a product is 
discontinued or removed from 
the catalog.
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Catalog Import  (continued)

Fields Data type Description

Sales start date String Date when a product is 
published in the catalog.

Supplier id String Supplier ID for which the 
purchase order is generated.

Supplier part number String Supplier part number of the 
supplier product.

Third party import ID String Unique identifier for external 
data imports.

Third-party category Reference Reference to the Third Party 
category.

Unit String Unit or rate at which the 
product is sold by the supplier.

Catalog Error staging table

The Catalog Error [sn_spend_intg_catalog_error] staging table temporarily stores important data 
about any catalog errors before this data is sent to the primary table.

Catalog Error

Field Data type Description

Manufacturer/publisher part 
number (MPN)

String Manufacturer or publisher’s 
unique identifier for the 
product.

Supplier part number String Unique identifier assigned 
by a supplier to a specific 
product or part that they 
provide.

Cost Center Stage inbound staging table

The Cost Center Stage inbound [sn_fcms_intg_imp_cost_center] staging table temporarily stores 
important data about cost centers before this data is sent to the primary table. You can use this 
table to lookup all the cost center details.

The following table lists the mandatory fields for the Cost Center Stage inbound 
[sn_fcms_intg_imp_cost_center] staging table.

Cost Center Stage inbound staging table

Field
Data 
type

Description

Account 
number

String Account number of the cost center

Available 
for user

String Users that are applicable to the cost center

Code String Code of the cost center
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Cost Center Stage inbound staging table  (continued)

Field
Data 
type

Description

Cost 
center 
type

String Type of cost center

Controlling 
area

String Controlling area of the cost center

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Legal 
entity

String Detailed information about individual suppliers, including banking details, 
payment methods, and credit terms.

Manager String Name of the manager of the cost center

Name String Name of the cost center

Profit 
center

String Profit centers within the organization, enabling financial reporting and 
analysis by business units or operational segments.

Valid from String Date the cost center is valid from

Valid to String Date the cost center is valid to

Department Stage inbound staging table

The Department Stage inbound [sn_fcms_intg_department_stage] staging table temporarily 
stores important data about departments before this data is sent to the primary table.

The following table lists the mandatory fields for the Department Stage inbound 
[sn_fcms_intg_department_stage] staging table.

Department Stage inbound staging table

Field
Data 
type

Description

Category 
ID/ERP 
Department 
ID

String Unique ID of the Category or ERP department.

Department 
name

String Name of the department.

Department 
head

String Name of the head of the department.

Description String Description of the department.

ERP source String ERP source from which data is imported. For purchase order, receipt, 
and invoice integrations, the ERP source is determined through the legal 
entity associated with these records.

Primary 
contact

String Primary contact details of the department.
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ERP Plant Address Mapping Stage inbound staging table

The ERP Plant Address Mapping Stage inbound 
[sn_fcms_intg_erp_plant_address_mapping_stage] staging table temporarily stores important 
data about ERP plant address before this data is sent to the primary table.

The following table lists the key fields for the ERP Plant Address Mapping Stage inbound 
[sn_fcms_intg_erp_plant_address_mapping_stage] staging table.

Note:  There are no mandatory fields for this table.

ERP Plant Address Mapping Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Name String Name of the ERP plant.

FX Currency Stage inbound staging table

The FX Currency Stage inbound [sn_fcms_intg_fx_currency_stage] staging table temporarily 
stores important data about FX currencies before this data is sent to the primary table.

The following table lists the mandatory fields for the FX Currency Stage inbound 
[sn_fcms_intg_fx_currency_stage] staging table.

FX Currency Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

ISO 
currency 
code

String Unique three-letter currency code as defined by the International 
Organization for Standardization (ISO).

Name String Name of the currency.

FX Rate Stage inbound staging table

The FX Rate Stage inbound [sn_fcms_intg_fx_rate_stage] staging table temporarily stores 
important data about FX rates before this data is sent to the primary table.

The following table lists fields for the FX Rate Stage inbound [sn_fcms_intg_fx_rate_stage] 
staging table.

FX Rate Stage inbound staging table

Field
Data 
type

Description

Conversion 
date

String Date of currency conversion.
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FX Rate Stage inbound staging table  (continued)

Field
Data 
type

Description

ERP source String ERP source from which data is imported. For purchase order, receipt, 
and invoice integrations, the ERP source is determined through the legal 
entity associated with these records.

This is a mandatory field.

Exchange 
rate

Floating 
point 
number

Rate of exchange for currency conversion.

This is a mandatory field.

From 
currency

String Currency that is imported from.

This is a mandatory field.

Rate type String Specifies the type of exchange rate used for currency conversion.

Span end String End date for the FX rate schedule.

Span start String Start date for the FX rate schedule.

To 
currency

String Currency that is imported to.

This is a mandatory field.

Fixed asset details stage inbound table

The Fixed asset details inbound [sn_fcms_intg_imp_fixed_asset_details] staging table 
temporarily stores important data about imported invoice line before this data is sent to the 
primary table.

Fixed asset details inbound staging table

The following table lists the fields for the Fixed asset details inbound 
[sn_fcms_intg_imp_fixed_asset_details] staging table.

Fixed asset details stage

Field Data type Description

Asset id String Unique identifier for the fixed 
asset.

Asset number String Unique identifier generated 
within the ERP system for the 
fixed asset.

Capitalize on String Date on which the requester 
assumes the liability of the 
fixed asset, depending on the 
supplier incoterm.

Currency String Currency associated with the 
purchase of the fixed asset.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

136



Fixed asset details stage  (continued)

Field Data type Description

Depreciated amount String Amount that the fixed asset 
has depreciated by over time.

Depreciation life-cycle String Length of time in which 
the fixed asset is fully 
depreciated.

Depreciation start date String Start date of depreciation 
cycle.

Depreciation term String Frequency of depreciation 
throughout the life-cycle of the 
fixed asset.

ERP Asset number String Unique identifier generated 
within the ERP system for the 
fixed asset.

ERP Asset sub number String Unique identifier number that, 
when paired with the Asset 
number, identifies an asset.

ERP source String ERP source from which the 
fixed asset is imported.

Original value String Amount originally paid for the 
fixed asset.

Remaining value String Amount that the fixed asset 
is worth the current day, after 
factoring in depreciation.

Salvage value String Amount that the fixed asset is 
worth after it has come to the 
end of its life.

GL Account Stage inbound staging table

The GL Account Stage inbound [sn_fcms_intg_gl_account_stage] staging table temporarily 
stores important data about General Ledger (GL) accounts before this data is sent to the primary 
table.

The following table lists the mandatory fields for the GL Account Stage inbound 
[sn_fcms_intg_gl_account_stage] staging table.

GL Account Stage inbound staging table

Field
Data 
type

Description

Account 
currency

String Currency name of the GL account.

Account 
name

String Name of the GL account.

Alternate 
currency

String Alternate currency name of the GL account.
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GL Account Stage inbound staging table  (continued)

Field
Data 
type

Description

Category String Category of the GL account.

Entity String Name of the entity.

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

GL 
Account

String Name of the general ledger account.

Inactive String Status of the GL account. By default the checkbox is inactive.

Ledger 
type

String Type of ledger account.

Local 
currency

String Local currency that corresponds to the entity's operating location.

Number String General ledger account number.

Short 
description

String Description of the GL account.

Sub-ledger 
account

String Sub-ledger account number.

Type String Type of GL account.

Import Availability Updates inbound staging table

The Import Availability Updates inbound [sn_spend_intg_imp_availability] staging table 
temporarily stores important data about cost allocations before this data is sent to the primary 
table.

The following table lists the mandatory and optional fields for the Import Availability Updates 
inbound [sn_spend_intg_imp_availability] staging table.

Import Availability Updates inbound staging table

Field Data type Description

Available Units String Units that are available to be 
sold.

Customer ID String Unique identifier for each 
customer of the purchase 
order.

Catalog ID String Unique identifier for each 
catalog of the purchase order.

Supplier ID String Supplier ID for which the 
purchase order is generated.

Supplier part number String Supplier part number of the 
supplier product.
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Import Availability Updates inbound staging table  (continued)

Field Data type Description

Third party import ID String Unique identifier for external 
data imports.

Unit String Unit or rate in which this 
product is sold by the supplier.

Availability Error staging table

The Availability Error [sn_spend_intg_availability_error] staging table stores important data about 
availability error so that an ERP integrator can export this data to a third-party ERP system.

Availability Error staging table

The following table lists fields for the Availability Error [sn_spend_intg_availability_error] staging 
table.

Availability Error staging table

Field Data type Description

Supplier part number String Unique number that is used 
by the supplier to identify this 
product.

Inbound Cost Allocation staging table

The Inbound Cost Allocation [sn_spend_intg_imp_cost_allocation] staging table temporarily 
stores important data about cost allocations before this data is sent to the primary table.

The following table lists the fields for the Inbound Cost Allocation 
[sn_spend_intg_imp_cost_allocation] staging table.

Inbound Cost Allocation staging table

Field
Data 
type

Description

Allocate by String Determines whether the cost allocation is based on amount or percentage.

Allocation 
amount

String Amount that is allocated.

Allocation 
percentage

String Percentage of cost allocation.

Cost 
center

String Cost center associated with the cost allocation.

Cost owner String User who incurs the cost of the allocated transaction amount.

ERP CA 
number

String CA number from the ERP system.

ERP line 
number

String Purchase order line number from the ERP system.

This is a mandatory field.
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Inbound Cost Allocation staging table  (continued)

Field
Data 
type

Description

ERP PO 
number

String Purchase order number from the ERP system.

This is a mandatory field.

ERP source String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

This is a mandatory field.

Order line String Order line associated with the cost allocation.

Inbound Invoice staging table

The Inbound Invoice [sn_shop_invoice] staging table temporarily stores important data about 
shopping invoices before this data is sent to the primary table.

Inbound Invoice staging table

The following table lists fields for Inbound Invoice [sn_shop_invoice] staging table.

Inbound Invoice staging table

Field Data type Description

External invoice 
number

String Invoice number originated from a third party application.

This is a mandatory field.

Inbound source String Individual or group who owns the invoice.

Currency String Currency format associated with this invoice.

Discounts String Discounts applied on the invoice.

ERP number String Unique number generated within the ERP system for the 
purchase order.

ERP source String The available ERP.

This is a mandatory field.

External invoice 
number

String Invoice number originated from a third party application.

This is a mandatory field.

External invoice 
source

String Name of the third party application associated with the 
invoice.

This is a mandatory field.

Final tax String Total amount of tax to be paid.

Inbound source String External source system from where the invoice is received.
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Inbound Invoice staging table  (continued)

Field Data type Description

Invoice date String (yyyy-
mm-dd)

Date on which the invoice is created.

This is a mandatory field.

Invoice date String Date on which the invoice was created.

Invoice line count String Total number of invoice lines in an invoice.

Invoice type String Type of the invoice for processing.

Legal entity String Name of the legal entity of the supplier.

Original invoice String Unique invoice number created by the Supplier.

Other charges String Other additional charges associated with the invoice.

This is a mandatory field.

Payment terms String The agreed upon time and conditions under which a 
payment to a supplier is made.

Purchase order String The purchase order against which the invoice is created.

Remit to city String City to which the payment is made.

Remit to country String Country to which the payment is made.

Remit to state/
province

String State to which the payment is made.

Remit to street String Street to which the payment is made.

Remit to zip/
postal code

String Zip code to which the payment is made.

Ship from city String City from which the items on the purchase order are 
shipped.

Ship from country String Country from which the items on the purchase order are 
shipped.

Ship from state/
province

String State from which the items on the purchase order are 
shipped.

Ship from street String Street from which the items on the purchase order are 
shipped.

Ship from zip/
postal code

String Zip code from which the items on the purchase order are 
shipped.

Shipping amount String Shipping charges incurred for the invoice.

Ship to city String City to which the items on the purchase order should be 
shipped.

Ship to country String Country to which the items on the purchase order should be 
shipped.

Ship to state/
province

String State to which the items on the purchase order should be 
shipped.
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Inbound Invoice staging table  (continued)

Field Data type Description

Ship to street String Street to which the items on the purchase order should be 
shipped.

Ship to zip/postal 
code

String Zip code to which the items on the purchase order is 
shipped.

Status String Current status of the inbound invoice.

Subtotal String Total amount of money to be paid to the supplier excluding 
tax and shipping charges.

This is a mandatory field.

Supplier String Name of the supplier from whom the good or service is 
procured.

This is a mandatory field.

Supplier invoice 
number

String Unique invoice number created by the Supplier.

Supplier tax id String Tax ID associated to the third party reseller.

Supplier tax rate String Supplier tax rate.

Target ERP String Target ERP where the invoice is posted.

Tax amount String Tax amount levied on the total invoice amount.

Third party import 
ID

String A unique identifier for external data imports.

Inbound Purchase Order staging table

The Inbound Purchase Order [sn_fcms_intg_imp_order] staging table temporarily stores 
important data about purchase orders before this data is sent to the primary table.

The following table lists fields for the Inbound Purchase Order [sn_fcms_intg_imp_order] staging 
table.

Inbound Purchase Order staging table

Field
Data 
type

Description

Blanket 
order end 
date

String Date on which the blanket order is expected to end.

If you're unsure of the delivery date of the product, you can provide an 
estimated time frame, which then creates a blanket order.

Blanket 
order start 
date

String Date on which the blanket order is expected to start.

If you're unsure of the delivery date of the product, you can provide an 
estimated time frame, which then creates a blanket order.

Business 
owner

String The user who placed the order.
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Inbound Purchase Order staging table  (continued)

Field
Data 
type

Description

Cost center String Cost center that incurs the expense of the order.

ERP PO 
number

String Purchase order number from the ERP system.

This is a mandatory field.

ERP source String ERP source from which data is imported. For purchase order, receipt, 
and invoice integrations, the ERP source is determined through the legal 
entity associated with these records.

This is a mandatory field.

Legal entity String Legal entity corresponding to a purchase.

Order type String Type of the purchase order- Standard or Blanket.

Payment 
term

String The agreed upon time and conditions under which a payment to a 
supplier is made.

PO amount String Total amount of the purchase order.

PO amount 
currency

String Currency of the purchase order.

PO status String Status of the purchase order.

Purchasing 
organization

String The organization making the purchase order.

Supplier 
company 
name

String Supplier company name for which the purchase order is generated.

Inbound Purchase Order Line staging table

The Inbound Purchase Order Line [sn_fcms_intg_imp_order_line] staging table temporarily 
stores important data about purchase order lines before this data is sent to the primary table.

The following table lists the mandatory fields for the Inbound Purchase Order Line 
[sn_fcms_intg_imp_order_line] staging table.

Inbound Purchase Order Line staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

ERP PO 
number

String Purchase order number from the ERP system.

ERP 
PO line 
number

String Purchase order line number from the ERP system.
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Inbound Receipt staging table

The Inbound Receipt [sn_fcms_intg_imp_receipt] staging table temporarily stores important data 
about receipts before this data is sent to the primary table.

The following table lists the mandatory fields for the Inbound Receipt 
[sn_fcms_intg_imp_receipt] staging table.

Inbound Receipt staging table

Field
Data 
type

Description

ERP 
PO line 
number

String Purchase order line number from the ERP system.

ERP PO 
number

String Purchase order number from the ERP system.

ERP 
receipt 
number

String Unique number generated within the ERP system for the receipt.

ERP source String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Milestone String Milestone associated with the receipt.

Percentage 
received

String Percentage of the service received.

This field is visible only for a service receipt.

PO line 
number

String Purchase order line number against which the receipt of the product is 
acknowledged.

Quantity 
received

String Quantity of product received as part of the receipt.

State String Current state of the receipt.

Supplier 
product

String Supplier product for which the receipt is generated.

Type String Type of the receipt based on the product type. For example, Goods 
Receipt or Services Receipt.

Legal Entity Stage inbound staging table

The Legal entity stage inbound [sn_fcms_intg_legal_entity_stage] staging table temporarily 
stores important data about legal entities before this data is sent to the primary table.

The following table lists the fields for the Legal Entity Stage inbound 
[sn_fcms_intg_legal_entity_stage] staging table.

Legal Entity Stage inbound staging table

Field
Data 
type

Description

City String City where the legal entity is located.
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Legal Entity Stage inbound staging table  (continued)

Field
Data 
type

Description

Country String Country where the legal entity is located.

ERP 
company 
code

String Company code of the supplier in the ERP system.

This is a mandatory field.

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

This is a mandatory field.

Global 
company

String Global company that the entity is linked to.

Industry String Industry type of the legal entity.

Legal 
name

String Legal name of the entity that corresponds to its operating location.

Local 
currency

String Local currency that corresponds to the entity's operating location.

Street String Street where the legal entity is located.

Office Location Stage inbound staging table

The Office Location Stage inbound [sn_fcms_intg_office_location_stage] staging table 
temporarily stores important data about office locations before this data is sent to the primary 
table.

The following table lists the mandatory fields for the Office Location Stage inbound 
[sn_fcms_intg_office_location_stage] staging table.

Office Location Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Country String Name of the country where the office location belongs.

Order Acknowledgement staging table

The Order Acknowledgment [sn_spend_intg_imp_purchase_order_ack] staging table temporarily 
stores important data about order acknowledgements before this data is sent to the primary 
table.
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Order Acknowledgment staging table

Field Data type Description

Customer id String Unique identifier for a 
customer.

Estimated arrival date String Date on which the order is 
expected to arrive.

Purchase order line number String Line number against which 
the receipt of the product is 
acknowledged.

Purchase order number String Unique number for the 
purchase order.

Sales order line number String Unique identifier for each item 
on a sales order.

Sales order number String Unique identifier for a 
customer's purchase.

Status code String Code indicating the current 
status.

Status message String A message that indicates the 
current status.

Supplier id String Unique identifier for the 
supplier.

Third party import ID String Unique identifier for external 
data imports.

Order Acknowledgement Error staging table

The Order Acknowledgement Error [sn_spend_intg_order_ack_error] staging table temporarily 
stores important data about any errors in the order price imports before this data is sent to the 
primary table.

Order Acknowledgement Error

Field Data type Description

Sales order line number String Unique identifier for each item 
on a sales order.

Sales order number String Unique identifier for a 
customer's purchase.

Payment Terms Stage inbound staging table

The Payment Terms Stage inbound [sn_fcms_intg_payment_term_stage] staging table 
temporarily stores important data about payment terms before this data is sent to the primary 
table.

The following table lists the mandatory fields for the Payment Terms Stage inbound 
[sn_fcms_intg_payment_term_stage] staging table.
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Payment Terms Stage inbound staging table

Field
Data 
type

Description

Discount 
days

Integer Specific days or periods during which you receive discounts on 
products.

Discount 
percentage

Decimal Cash discount percentage rate.

ERP source String ERP source from which data is imported. For purchase order, receipt, 
and invoice integrations, the ERP source is determined through the legal 
entity associated with these records.

Name String The name or code of the payment term. Example: Net 060.

Net days to 
pay

Integer Number of days within which payment is due after receiving an invoice.

Payment 
term

String Term for making the payment.

Short 
description

String A short explanation of the payment term. Example: 2%14, Net 60.

Type String Type of the payment term.

Price Import staging table

The Price Import [sn_spend_intg_imp_price] staging table temporarily stores important data 
about price imports before this data is sent to the primary table.

Price Import staging table

Field Data type Description

Catalog id String Unique identifier for each 
catalog of the purchase order.

Contract end date String Date on which the contract 
term ends.

Contract number String Unique number of the 
contract.

Contract start date String Date on which the contract 
term starts.

Customer id String Unique identifier for a 
customer.

Negotiated currency String Currency used in price 
negotiation.

Negotiated price String Unit price of a product as 
negotiated through a contract 
with the supplier.

Supplier id String Unique identifier for the 
supplier.

Supplier part number String Unique identifier assigned 
by a supplier to a specific 
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Price Import staging table  (continued)

Field Data type Description

product or part that they 
provide.

Third party import ID String Unique identifier for external 
data imports.

Price Error outbound staging table

The Price Error [sn_spend_intg_price_error] staging table stores important data about pricing 
error so that an ERP integrator can export this data to a third-party ERP system.

Price Error staging table

The following table lists fields for the Price Error [sn_spend_intg_price_error] staging table.

Price Error staging table

Field Data type Description

Supplier part number String Unique number that is used 
by the supplier to identify this 
product.

Product Model Stage inbound staging table

The Product Model Stage inbound [sn_fcms_intg_cmdb_model_stage] staging table temporarily 
stores important data about product models before this data is sent to the primary table.

The following table lists the mandatory fields for the Product Model Stage inbound 
[sn_fcms_intg_cmdb_model_stage] staging table.

Product Model Stage inbound staging table

Field
Data 
type

Description

Asset 
tracking

String Process by which the model can be tracked.Select one of these options:

• Leave to Category: Model is transparent and the category defines the 
asset class.

• Create Consumable Asset: Model forces the asset class to be 
consumable, regardless of what the category defines as the asset class.

• Don't create assets: Model blocks asset instantiation, regardless of what 
the category defines as the asset class.

Description String Description of the product model for the buyer.

ERP source String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Model 
category

String Category to which the model belongs to.
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Product Model Stage inbound staging table  (continued)

Field
Data 
type

Description

Model 
number

String Specific model number that is assigned to the item by the manufacturer.

Name String Name of the product model.

Product 
category

String Category to which the product belongs to.

Short 
description

String Brief description of the product model.

Purchase Entity Stage inbound staging table

The Purchase Entity Stage inbound [sn_fcms_intg_imp_purchase_entity] staging table 
temporarily stores important data about purchase entities before this data is sent to the primary 
table.

The following table lists the mandatory fields for the Purchase Entity Stage inbound 
[sn_fcms_intg_imp_purchase_entity] staging table.

Purchase Entity Stage inbound staging table

Field
Data 
type

Description

ERP 
source

String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

ERP 
number

String Unique identifier for the ERP system from which data is imported.

Legal 
entity

String Detailed information about individual suppliers, including banking details, 
payment methods, and credit terms.

Name String Name of the purchase entity.

Purchase Line Stage inbound staging table

The Purchase Entity Stage inbound [sn_spend_intg_purchase_line] staging table temporarily 
stores important data about purchase entities before this data is sent to the primary table.

Purchase Line Stage inbound staging table

The following table lists both the mandatory and optional fields for the Purchase Line Stage 
inbound [sn_spend_intg_purchase_line] staging table.

Purchase Line Stage inbound staging table

Field Data type Description

Account assignment category String Account assignment category 
of the purchase line.

Acknowledgement type String Acknowledgment type of the 
purchase line. Applicable only 
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

if product type is Service or 
Handling fee. The values are:

• Milestones

• Service acknowledgement

• Two way match

Active String Indicates if the purchase line 
is active or not.

Additional comments String Additional notes about the 
purchase line, if any.

Address String Address of the purchase line.

After the fact String Indicates if the purchase 
requisition is after the fact or 
not.

Asset category String Asset category of the 
purchase line.

Awarded String Indicates who is the awarded 
supplier for the purchase line.

Awarded in third party String Indicates who is the third-
party awarded supplier for the 
purchase line.

Business owner String An individual or group who 
owns the purchase line.

Capex account String Ledger account to post the 
capital expenses of this 
product after the purchase 
completion.

Cart line id String Shopping cart line ID of the 
purchase line.

City String City of the purchase line.

Contract price String Contract price of the purchase 
line.

Cost center String Cost center that incurs the 
cost of the purchase line.

Cost plan String Cost plan for the purchase 
line.

Country String Name of the country of the 
purchase line.

Country code String Country code of the purchase 
line.
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

Estimated shipping String Shipping cost estimate for the 
product based on the delivery 
location.

Estimated tax String Tax estimate for the product 
based on the price and 
delivery location.

Expense account String Expense account associated 
with the purchase line.

General ledger account String General Ledger (GL) account 
associated with the purchase 
line.

Goods receipt required String Indicates if a receipt is 
required in addition to the 
invoice.

Individual unit cost String Cost of the individual unit.

Internal order number String Internal order number of the 
purchase line.

Legal entity String Internal legal entity that incurs 
the cost of this purchase line.

Line source String Line source associated with 
the purchase line.

Manual handling fee String Manual charges added for 
a specific supplier when a 
rule is triggered as a result 
of certain configurable 
conditions for a purchase 
requisition being met.

Maximum budget String Maximum budget that the 
shopper provides for this 
purchase.

Milestone payout type String Indicates the type of 
milestone payout. The options 
available are Amount and 
Percentage.

Negotiated by String Indicates who is responsible 
for negotiation.

Negotiated savings String Total savings through 
negotiation. This is calculated 
as: (Starting unit cost - 
Negotiated unit cost) x 
Supplier's quantity.

Negotiated unit cost String Cost per unit of the product 
after negotiation.
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

Negotiation String Negotiation associated with 
this purchase line.

Net amount String Amount included as a cost 
allocation on the purchase 
order. This doesn’t include 
any estimates.

Non catalog purchase? String Indicates if the purchase is 
non catalog or not.

Number String System-generated unique 
identifier of the purchase line.

Parent line String Parent line of the purchase 
line.

Part requirement String Part requirement associated 
with the purchase line.

Payment allocations String Payment allocations of the 
purchase line.

Payment method String Indicates the payment method 
to the supplier.

Payment schedule String Indicates the schedule of 
payments to the supplier.

Preferred currency String Payment method preferred by 
the supplier legal entity.

Pre-paid account String General ledger account where 
purchases of this product are 
posted when they are prepaid.

Pre-payments required String Option to mark if pre-
payments is required for this 
product.

Pricing obtained on String Date on which the pricing is 
obtained for the purchase line.

Product category String Product category that is 
sourced through this purchase 
line.

Product example String Reference URL that the 
shopper provides.

Product name String Name of the supplier product.

Product type String Type of the product 
associated with the purchase 
line.

Project String Project associated with the 
purchase line.
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

Purchase String Parent purchase associated 
with this purchase line.

Purchase order String Purchase order associated 
with the purchase line.

Purchase order line String Purchase order line 
associated with the purchase 
line.

Purchase reason String Reason for purchasing the 
product.

Purchase requisition String Purchase requisition 
associated with this purchase 
line.

Purchased quantity String Quantity that has been 
purchased by the shopper.

Recipient String Recipient of the purchase line.

Requested delivery date String Requested delivery date of 
the purchased product.

Requested end date String Requested end date of the 
purchase line order.

Requested start date String Requested start date of the 
purchase line order.

Shipping method String Details of the carrier, the 
applicable suppliers, and 
the valid delivery location 
countries for those suppliers.

Shopper's original choice String Original or first choice of the 
shopper.

Short description String Brief description about the 
purchase line.

Sourcing request String Sourcing request associated 
with this purchase line.

Specific requirements String Requirements that the 
shopper specifies.

Spend categorization String Indicates whether negotiation 
with the supplier is 
addressable or not.

Starting unit cost String Cost per unit of the product 
prior to negotiation.

State String State of the purchase line.

State or province String State or province of the 
purchase line.
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

Street String Street address of the 
purchase line.

Supplier String Supplier for which the 
shopper places the order.

Supplier case String Indicates if a supplier case is 
created for the supplier or not.

Supplier contact String Name of the supplier contact 
of the purchase line.

Supplier contact email String Registered email ID for this 
supplier contact.

Supplier contact first name String First name of the supplier 
contact.

Supplier contact job title String Job title of the supplier 
contact.

Supplier contact last name String Last name of the supplier 
contact.

Supplier contacted? String Indicates if the supplier has 
been contacted or not.

Supplier notes String Additional notes about the 
supplier, if any.

Supplier part auxiliary ID String Auxiliary ID associated with 
the supplier part.

Supplier product String Supplier product for which the 
purchase line is created.

Supplier's lead time (days) String Number of days that the 
supplier takes to deliver the 
goods or provide the service. 
Based on this, the delivery 
date for goods and the start 
and end dates for services 
vary.

Supplier's quantity String Quantity that the supplier can 
provide.

Tags String Tag names for the purchase 
line.

Term length String Duration of the term.

Term value String Type of the term. The options 
are Days, Weeks, Months, and 
Years.

Third party Category String Third-party category of the 
purchase line.
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Purchase Line Stage inbound staging table  (continued)

Field Data type Description

Total bid amount String Supplier's quantity multiplied 
by negotiated unit cost. It 
reflects the total bid amount 
from that particular supplier 
for that purchase line.

Total individual units String Number of fixed assets that 
are created depends on this 
value.

Total line amount String Total price of the purchased 
goods and services, including 
estimated tax and shipping.

Type String Type of the purchase line.

Unit String Unit of rate at which the 
customer purchases the 
product.

Upcoming date String Upcoming date for the 
purchase line.

WBS element String WBS element associated with 
the purchase line.

Zip or postal code String Zip code of the purchase line.

Purchase Requisition staging table

The Purchase requisition [sn_spend_intg_purchase_requisition] staging table temporarily stores 
important data about purchase requests before this data is sent to the primary table.

Purchase Requisition stage

Field Data type Description

Accounting period String Financial period during 
which expenses related to 
the purchase requisition are 
recorded.

Actual end String End date of a purchase 
requisition (PR) process.

Actual start String Start date or initiation date of 
a purchase requisition (PR) 
process.

Additional comments String Supplementary information 
or notes added to a purchase 
requisition (PR).

After the fact String Actions or processes related 
to a purchase requisition 
(PR) that are handled 
or documented after a 
requisition is approved.
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Purchase Requisition stage  (continued)

Field Data type Description

Assigned to String Individual or department 
responsible for reviewing, 
approving, and processing the 
purchase requisition (PR).

Assignment group String Team responsible for 
managing a Purchase 
Requisition (PR) within an 
organization.

Business owner String Individual or entity that has 
legal ownership and control 
over a business.

Cost center String Department, unit, or segment 
within an organization 
that is responsible for 
managing its own budget and 
expenses related to purchase 
requisitions.

Description String Description of the purchase 
requisition.

ERP Source String It is a field or attribute 
associated with a purchase 
requisition that indicates the 
specific ERP module, system, 
or process from which the 
requisition was generated.

Group Id String Unique identifier assigned 
to a group of purchase 
requisitions. This identifier 
groups together related 
requisitions for easier 
management, tracking, and 
processing.

Handling fee String Additional charge associated 
with the processing of a 
Purchase Requisition (PR).

Legal entity String Legal entity within an 
organization that is 
responsible for the purchase 
requisition.

Location String Location of the legal entity.

Number String Unique identifier assigned 
to a purchase requisition 
document within the 
procurement system.
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Purchase Requisition stage  (continued)

Field Data type Description

Order type String Classification of orders based 
on their nature, purpose, or 
processing requirements.

Payment term String Specific terms and conditions 
under which payment is 
to be made for the goods 
or services requested in a 
Purchase Requisition (PR).

Preferred currency String Currency that is preferred 
or required for processing a 
Purchase Requisition (PR).

Primary contact String Individual responsible for 
managing the Purchase 
Requisition (PR) process.

Priority String Level of urgency assigned 
to a Purchase Requisition 
(PR) within an organization's 
procurement process.

Purchase String Purchase order associated 
with the purchase requisition.

Purchase order String Official purchase order issued 
to the supplier.

Purchasing entity String Organization or department 
that is responsible for 
procurement of goods or 
services within a company.

Requested delivery String Date by which the requester 
of a purchase requisition (PR) 
expects the goods or services 
to be delivered.

Requisition type String Classification of a purchase 
requisition based on the 
nature or purpose of the 
requested goods or services.

Short description String Brief description of the 
purchase order.

State String Current state of the purchase 
requisition.

Submitted by String Individual or entity that 
created the purchase 
requisition request.

Supplier String Vendor or supplier from 
whom the requested goods 
or services are intended to be 
purchased.
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Purchase Requisition stage  (continued)

Field Data type Description

Total amount String Total cost or value of all items 
or services requested in a 
requisition.

Total estimated shipping String Estimated cost associated 
with the shipping of goods or 
services.

Total estimated tax String Estimated amount of tax 
applicable to the goods 
or services requested in a 
Purchase Requisition (PR).

Spend Shipment Import inbound staging table

The Spend Shipment Import inbound [sn_spend_intg_imp_shipment] staging table temporarily 
stores important data about spend shipment imports before this data is sent to the primary table.

The following table lists both the mandatory and optional fields for the Spend Shipment Import 
inbound [sn_spend_intg_imp_shipment] staging table.

Spend Shipment Import inbound staging table

Field Data type Description

Actual shipment date String Date at which the product was shipped.

City String Name of the city of the shipment.

Country String Name of the country of the shipment.

Customer ID String Unique identifier for each customer of the shipment.

Estimated shipment date String Date at which the product is estimated to be shipped.

Line number String Line number of the shipment.

Name String Name of the shipment.

Order number String Unique order number of the shipment.

Planned shipment date String Date at which the product is planned to be shipped.

Product details String Details of the product to be shipped.

Punchout String Punch out details of the shipment.

Sales order line number String Sales order line number of the shipment.

Sales order number String Sales order number associated with the shipment.

Ship to String Shipping location of the product.

Shipment Import String Number of shipments to be imported.

Shipment quantity String Number of shipments to be shipped.

Shipment type String Type of shipment.

Shipping carrier String Name of the shipping carrier.

State String Name of the state of the shipment.
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Spend Shipment Import inbound staging table  (continued)

Field Data type Description

Street String Street of the shipment.

Supplier ID String ID of the supplier.

Supplier shipment number String Shipment number of the supplier.

Third party import ID String Third party import ID of the shipment.

Tracking number String Tracking number of the shipment.

Zip code String ZIP code of the shipment.

Shipment Error staging table

The Shipment Error [sn_spend_intg_shipment_error] staging table temporarily stores important 
data on any shipment errors before this data is sent to the primary table.

Shipment Error

Field Data type Description

Sales order line number String Unique identifier for each item 
on a sales order.

Sales order number String Unique identifier for a 
customer's purchase.

Supplier shipment number String Shipment number of the 
supplier.

Supplier Product Stage inbound staging table

The Supplier Product Stage inbound [sn_spend_intg_supplier_product_stage] staging table 
temporarily stores important data about supplier products before this data is sent to the primary 
table.

The following table lists the mandatory fields for the Supplier Product Stage inbound 
[sn_spend_intg_supplier_product_stage] staging table.

Supplier Product Stage inbound staging table

Field
Data 
type

Description

Capex account String General ledger account where capital expenses are posted on 
purchase.

Currency String Currency format associated with the supplier

Description String Detailed description of the product for the buyer.

ERP source String ERP source used by the organization.

Expense account String General ledger account where operational expenses are posted 
on purchases.

Goods receipt 
required

String Indicates if a receipt is required in addition to the invoice.
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Supplier Product Stage inbound staging table  (continued)

Field
Data 
type

Description

Name String Name of the company that the supplier is linked to.

Prepaid account String General ledger account where purchases of this product are 
posted when they are prepaid.

Product category String Category to which this product belongs.

Product model String Standardized definition for this product across suppliers.

Note:  For creating a product bundle, enter the name of 
the product model of type bundle in this field.

Product type String Type of product. The options are Good or Service.

Published String Option for specifying if the product is to be listed on the 
ShoppingHub portal.

Services 
acknowledgement

String All the service acknowledgments associated with the supplier.

Short description String Brief description of the product for the buyer.

Sourcing required Boolean Option to mark if sourcing is required for this product. This is 
determined based on if there is an active contractual price for 
this supplier product or not.

Sourcing time in 
days

String Estimated number of days to process the sourcing request.

Spend 
categorization

String Product that is addressable for negotiation. You can select one of 
these options:

• Addressable: Can be considered for negotiation.

• Not Addressable: Cannot be considered for negotiation.

Supplier String Name of the supplier.

Supplier delivers 
to

String Countries where the suppliers can deliver the product.

Supplier part 
number

String Unique number that is used by the supplier to identify this 
product.

Units String Unit or rate in which the product is sold by the supplier.

Third Party Sourcing Registration staging table

The Third Party Sourcing Registration [sn_spend_intg_sourcing_vendor] table temporarily stores 
important data on third party sourcing registrations before this data is sent to the primary table.
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Third-Party Sourcing Registration

Field Data type Description

Third-party sourcing 
registration name

String Name of the third-party 
sourcing registration to be 
integrated with ServiceNow.

Third-party sourcing 
registration code

String User defined code to be 
associated to the third-party 
sourcing registration.

Third Party Unit Mapping staging table

The Third Party Unit Mapping [sn_spend_intg_third_party_uom_map] staging table temporarily 
stores important data on third party mapping before this data is sent to the primary table.

Third Party Unit Mapping

Field Data type Description

Supplier Product Reference Reference to the Supplier 
Product.

Third-party unit Reference Reference to the Third Party 
Unit.

Third Party Unit staging table

The Third Party Unit [sn_spend_intg_third_party_uom] staging table temporarily stores important 
data on third party units before this data is sent to the primary table.

Third Party Unit

Field Data type Description

Provider Reference Reference to the Third Party 
Registration table.

Third party unit String Name of the third-party unit.

Unit Reference Reference to the Unit table.

Unit of Measure inbound staging table

The Third Party Unit [sn_fcms_intg_imp_uom] staging table temporarily stores important data on 
third party units before this data is sent to the primary table.

Unit of Measure

Field Data type Description

ERP Unit String Name of the base ERP unit.

ERP Unit Description String Description of the base ERP 
unit.

ERP Source String ERP source used by the 
organization.
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Unit of Measure  (continued)

Field Data type Description

Set Reference Reference to an external data 
source for importing data.

Inbound staging tables for Supplier Lifecycle Operations

The inbound staging tables for Supplier Lifecycle Operations  temporarily store supplier data 
before it is sent to the SLO primary data tables.

Supplier contact inbound staging table

The Supplier contact inbound [sn_fcms_intg_supplier_contact_inbound] staging table 
temporarily stores important data about a supplier contact before this data is sent to the Supplier 
Contact [vm_vdr_contact] primary table.

Supplier contact inbound staging table

The following table lists the mandatory fields for the Supplier contact inbound 
[sn_fcms_intg_supplier_contact_inbound] staging table.

Supplier contact inbound staging table

Field Data type Description

First name String First name of the supplier contact.

Last name String Last name of the supplier contact.

Email Email Email address of the supplier contact.

Supplier inbound staging table

The Supplier inbound [sn_fcms_intg_imp_supplier] staging table temporarily stores important 
data about the supplier before this data is sent to the Supplier [sn_fin_supplier] primary table.

Supplier inbound staging table

The following table lists fields for the Supplier inbound [sn_fcms_intg_imp_supplier] staging 
table.

Supplier inbound staging table

Field
Data 
type

Description

Accepted 
purchasing 
currency

String Currency value in which purchase orders for this supplier must be 
created.

City String City where the supplier is located.

Company 
overall rating

String Overall rating of the company.

Company 
type

String Industry type of the supplier.

Country String Country where the supplier is located.
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Supplier inbound staging table  (continued)

Field
Data 
type

Description

Country of 
registration

String Country where the supplier is registered.

County / 
District

String County or district where the supplier is located.

Customer 
number

String Unique identifier for the organization to the supplier.

Domain String Domain name of the supplier.

Duns String Unique 9-digit identifier for a supplier.

Employee 
number

String Employee number of the supplier contact.

ERP 
company 
code

String Company code of the supplier in the ERP system.

ERP 
company 
code

String Company code of the supplier in the ERP system.

ERP source String ERP source used by the organization.

Fax number String Number to which documents can be faxed to the supplier.

Founded 
year

String Year the organization was founded.

General 
ledger 
account

String Accounts payable reconciliation account for the supplier.

Goods 
shipped from

String Location from where the supplier ships out the products.

Incoterm String Set of 11 internationally recognized rules that define the responsibilities 
of sellers and buyers.

It specifies who is responsible for paying for and managing the 
shipment, insurance, documentation, customs clearance, and other 
logistical activities. Select one of these options:

• Carriage and Insurance Paid to (CIP)

• Carriage Paid to (CPT)

• Cost and Freight (CFR)

• Cost, Insurance, and Freight (CIF)

• Delivered at Place (DAP)

• Delivered at Terminal (DAT)

• Delivered Duty Paid (DDP)

• Ex Works (EXW)

• Free Alongside Ship (FAS)
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Supplier inbound staging table  (continued)

Field
Data 
type

Description

• Free Carrier (FCA)

• Free on Board (FOB)

Industry String Industry type of the supplier.

Legal entities String Name of the legal entity.

Legal name String Legal name of the supplier that corresponds to its operating location.

Locations 
count

String Number of places where the supplier operates.

Logo URL String Image URL of the supplier’s logo.

Long 
description

String Detailed description of the supplier.

Off-boarded 
date

String Date of the supplier's termination from the organization.

Onboarded String Indicates whether the supplier is onboarded into the ERP system.

On-boarded 
by

String Employee responsible for onboarding the supplier.

On-boarded 
date

String Onboarding date of the supplier.

Parent 
company

String Parent company of the supplier.

Payment 
term

String Agreed upon time and conditions for payment to the supplier.

PO box 
number

String Post office box number where the supplier correspondence and 
payments are made.

Posting 
Block

String Postal block where the supplier is located.

Primary 
phone 
number

String Primary phone number.

Purchasing 
entities

String Purchasing entities that are allowed to purchase from the supplier.

Short 
description

String Brief description about the supplier.

State / 
Province

String State or province where the supplier is located.

Status String

Street 
address

String Street where the supplier is located.

Sustainability 
rating

String The business relationship designated to the entity.
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Supplier inbound staging table  (continued)

Field
Data 
type

Description

Tax id String Tax ID of the organization.

Tax 
jurisdiction

String Taxation authority that imposes the taxes.

Twitter String Twitter account of the supplier.

URL String URL of the supplier.

Wikipedia String Wikipedia page of the supplier.

YouTube String Youtube channel of the supplier.

Zip / Postal 
code

String Zip code or postal code where the supplier is located.

Supplier legal entity mapping inbound staging table

The Supplier legal entity mapping inbound [sn_fcms_intg_supplier_legal_entity_inbound] 
staging table temporarily stores important data about the legal entities of a supplier before this 
data is sent to the Supplier Legal Entity Mapping (sn_fin_supplier_detail) primary table.

Supplier legal entity mapping inbound staging table

The following table lists the mandatory fields for the Supplier legal entity mapping inbound 
[sn_fcms_intg_supplier_legal_entity_inbound] staging table.

Supplier legal entity mapping inbound staging table

Field Data type Description

Legal entity String Name of the legal entity of the supplier.

Supplier String Name of the supplier.

Supplier location inbound staging table

The Supplier location inbound [sn_fcms_intg_supplier_location_inbound] staging table 
temporarily stores important data about the geographical location of a supplier before this data 
is sent to the Supplier Location [sn_slm_m2m_location] and Location [cmn_location] primary 
tables.

Supplier location inbound staging table

The following table lists the mandatory fields for the Supplier location inbound 
[sn_fcms_intg_supplier_location_inbound] staging table.

Supplier location inbound staging table

Field Data type Description

Category String The category that the supplier location 
belongs to. The choices are:

• Contracting address

• Delivery address
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Supplier location inbound staging table  (continued)

Field Data type Description

• Facility (default)

• Headquarters

• Invoice address

• Service center

City String City of the supplier location.

Company String Name of the company that the supplier 
location is linked to.

Contact String Contact details of the supplier location.

Coordinates retrieved on String Coordinates of the supplier location that 
was retrieved on a specific date.

Country  String Country of the supplier location.

Duplicate  String Indicates whether the supplier location 
is a duplicate or not.

ERP source String ERP source from which data is imported.

Fax phone String Fax phone details of the supplier 
location.

Full name String Full name of the supplier location.

Integration status String Latitude coordinates of the supplier 
location.

Latitude String Latitude coordinates of the supplier 
location.

Location source String Source of the supplier location.

Location type String Type of the supplier location.

Longitude String Longitude coordinates of the supplier 
location.

Managed by group String Name of the group that manages the 
supplier location.

Name String Name of the supplier.

Primary String Indicates whether the supplier is 
primary or not.

Primary location String Primary location of the supplier.

Phone String Phone number of the supplier.

Phone territory String Phone territory of the supplier.

Processing message String A message that describes the current 
processing status.

State / Province String State of the supplier location.
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Supplier location inbound staging table  (continued)

Field Data type Description

Stock room String Stock room details of the supplier 
location.

Street address String Street address of the supplier location.

Time zone  String Timezone of the supplier location.

Zip/Postal code String Zip code of the supplier location.

Supplier payment inbound staging table

The Supplier payment inbound [sn_fcms_intg_supplier_payment_inbound_stage] staging table 
temporarily stores important data about the payment information of a supplier before this data is 
sent to the Supplier Payment Information [sn_fin_supplier_payment] primary table.

Supplier payment inbound staging table

The following table lists the mandatory fields for the Supplier payment inbound 
[sn_fcms_intg_supplier_payment_inbound_stage] staging table.

Supplier payment inbound staging table

Field Data type Description

Supplier Reference The supplier that the payment information is for.

Bank name String Name of the bank.

Account number Password2 Account number of the beneficiary.

Inbound staging tables for Accounts Payable Operations

The inbound staging tables for Accounts Payable Operations  temporarily stores invoice data 
before it is sent to the APO primary data tables.

Invoice import inbound staging table

The invoice import inbound [sn_spend_intg_imp_invoice] staging table temporarily stores 
important data about the imported invoice before this data is sent to the [sn_shop_invoice] 
primary table.

Invoice Import inbound staging table

The following table lists fields for the invoice import inbound [sn_spend_intg_imp_invoice] 
staging table.

Invoice import inbound staging table

Field Data type Description

Amount invoiced String Total amount a supplier is expected to be paid.

Business owner String Individual or group who owns the invoice.

Currency String Currency format associated with this invoice.

Discounts String Discounts applied on the invoice.
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Invoice import inbound staging table  (continued)

Field Data type Description

ERP number String Unique number generated within the ERP system for the 
purchase order.

ERP source String The available ERP.

This is a mandatory field.

External invoice 
number

String Invoice number originated from a third party application.

This is a mandatory field.

External invoice 
source

String Name of the third party application associated with the 
invoice.

This is a mandatory field.

Final tax String Total amount of tax to be paid.

Inbound source String External source system from where the invoice is received.

Invoice date String (yyyy-
mm-dd)

Date on which the invoice is created.

This is a mandatory field.

Invoice date String Date on which the invoice was created.

Invoice line count String Total number of invoice lines in an invoice.

Invoice type String Type of the invoice for processing.

Legal entity String Name of the legal entity of the supplier.

Original invoice String Unique invoice number created by the Supplier.

Other charges String Other additional charges associated with the invoice.

This is a mandatory field.

Payment terms String The agreed upon time and conditions under which a 
payment to a supplier is made.

Purchase order String The purchase order against which the invoice is created.

Remit to city String City to which the payment is made.

Remit to country String Country to which the payment is made.

Remit to state/
province

String State to which the payment is made.

Remit to street String Street to which the payment is made.

Remit to zip/
postal code

String Zip code to which the payment is made.

Ship from city String City from which the items on the purchase order are 
shipped.

Ship from country String Country from which the items on the purchase order are 
shipped.
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Invoice import inbound staging table  (continued)

Field Data type Description

Ship from state/
province

String State from which the items on the purchase order are 
shipped.

Ship from street String Street from which the items on the purchase order are 
shipped.

Ship from zip/
postal code

String Zip code from which the items on the purchase order are 
shipped.

Shipping amount String Shipping charges incurred for the invoice.

Ship to city String City to which the items on the purchase order should be 
shipped.

Ship to country String Country to which the items on the purchase order should be 
shipped.

Ship to state/
province

String State to which the items on the purchase order should be 
shipped.

Ship to street String Street to which the items on the purchase order should be 
shipped.

Ship to zip/postal 
code

String Zip code to which the items on the purchase order is 
shipped.

Status String Current status of the inbound invoice.

Subtotal String Total amount of money to be paid to the supplier excluding 
tax and shipping charges.

This is a mandatory field.

Supplier String Name of the supplier from whom the good or service is 
procured.

This is a mandatory field.

Supplier invoice 
number

String Unique invoice number created by the Supplier.

Supplier tax id String Tax ID associated to the third party reseller.

Supplier tax rate String Supplier tax rate.

Target ERP String Target ERP where the invoice is posted.

Tax amount String Tax amount levied on the total invoice amount.

Third party import 
ID

String A unique identifier for external data imports.

Import error staging table

The Import error [sn_spend_intg_import_error] staging table temporarily stores important data on 
errors before this data is sent to the primary table.
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Import error staging table

Field Data type Description

Error message String A message that describes the 
error encountered.

Outbound status Reference Indicates the status of 
outgoing transactions.

Invoice line import inbound staging table

The Invoice line import inbound [sn_spend_intg_imp_invoice_line] staging table 
temporarily stores important data about imported invoice line before this data is sent to the 
[sn_shop_invoice_line] primary table.

Invoice line import inbound staging table

The following table lists the mandatory fields for the Invoice line import inbound 
[sn_spend_intg_imp_invoice_line] staging table.

Invoice line import inbound staging table

Field Data type Description

Cost center String Cost center for which the invoice is generated.

Currency String Currency format associated with the invoice.

ERP line 
number

String ERP line number.

ERP source String Available ERP source.

This is a mandatory field.

External 
invoice 
number

String Invoice number from external invoice.

External 
invoice 
source

String Name of the third party application associated with the 
invoice. Derive logic from external invoice number.

This is a mandatory field.

Final tax String Final tax.

GL account String Account used to generate the invoice.

Inbound 
source

String External invoice source.

Line amount 
invoiced

String The total cost which is being billed for this good or service.

Line 
description

String Description of the invoice line.

This is a mandatory field.

Line quantity Decimal number Number of items that have been invoiced.
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Invoice line import inbound staging table  (continued)

Field Data type Description

This is a mandatory field.

Line unit 
price

Decimal number Unit price of the line item in the invoice.

This is a mandatory field.

Purchase 
order line

String Purchase line related to the invoiced amount.

Ship to city String City to which the items on the purchase order should be 
shipped.

Ship to 
country

String Country to which the items on the purchase order should 
be shipped.

Ship to 
state/
province

String State to which the items on the purchase order should be 
shipped.

Ship to 
street

String Address to which the items on the purchase order should 
be shipped.

Ship to zip/
postal code

String Zip code to which the items on the purchase order should 
be shipped.

Status String Current status of this invoice line.

Subtotal Decimal number 
Example (12345.65)

Total amount of money to be paid to the supplier excluding 
tax and shipping charges.

This is a mandatory field.

Supplier part 
number

String Supplier part number of the supplier product.

Supplier tax 
rate

String Supplier tax rate.

Target ERP String ERP number of inbound source.

Tax amount String Tax for the invoice amount.

Tax code String Tax code of the invoice.

Third party 
import ID

String Unique identifier for external data imports.

Unit String The unit or rate in which this product is sold by the 
supplier.

Invoice payment detail import inbound table

The Invoice Payment detail import inbound [sn_spend_intg_imp_invoice_payment_detail] 
staging table temporarily stores important data about supplier before this data is sent to the 
[sn_shop_invoice_payment_detail] primary table.
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Invoice payment detail import inbound staging table

The following table lists the fields for the Invoice payment detail import inbound 
[sn_spend_intg_imp_invoice_payment_detail] staging table.

Invoice payment detail import inbound staging table

Field Data type Description

Currency String Currency used in the invoice.

This is a mandatory field.

ERP 
invoice 
number

String Unique identifier for invoices in the ERP system.

This is a mandatory field.

ERP 
Source

String Specifies the original source of ERP.

This is a mandatory field.

ERP 
supplier 
code

String ERP supplier code from the external supplier.

This is a mandatory field.

Payment 
amount

Decimal 
number

Total amount to be paid.

This is a mandatory field.

Payment 
date

String Date (yyy-mm-dd) by which payment is to be completed.

This is a mandatory field.

Payment 
method

String Mode through which the payment is done. Choice Example: 
bank_transfer/ cash_payment/ cheque /credit_card /debit_card /
wire_transfer

This is a mandatory field.

Payment 
reference 
ID

Alphanumeric A unique ID to track the payment details.

This is a mandatory field.

Remit to 
city

String City to which the payment is made.

This is a mandatory field.

Remit to 
country

String Country to which the payment is made in ISO 3166 format. 
Example:US

This is a mandatory field.

Remit to 
state/
province

String State or province to which the payment is made.

This is a mandatory field.

Remit to 
street

String Street address to which the payment is made.

This is a mandatory field.
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Invoice payment detail import inbound staging table  (continued)

Field Data type Description

Remit to 
ZIP/postal 
code

String Zip or postal code address to which the payment is made.

This is a mandatory field.

Scheduled 
payment 
date

String Date (yyyy-mm-dd) at which the payment will be made.

This is a mandatory field.

Third party 
import ID

String Unique identifier for imported data set.

Organization tax details inbound staging table

The Organization tax details inbound [sn_fcms_intg_org_tax_detail_inbound] staging table 
temporarily stores important data about an organization's tax information before this data is sent 
to the Organization Tax Details [sn_fin_org_tax_detail] primary table.

Organization tax details inbound staging table

The following table lists the mandatory fields for the Organization tax details inbound 
[sn_fcms_intg_org_tax_detail_inbound] staging table.

Organization tax details inbound staging table

Field Data type Description

Organization String Name of the organization.

Tax ID String Tax ID of the organization.

Invoice tax line staging table

The invoice tax line inbound [sn_spend_intg_imp_invoice_tax_line] staging table 
temporarily stores important data about the invoice tax line before this data is sent to the 
[sn_shop_invoice_tax_line] primary table.

Invoice tax line inbound staging table

The following table lists the fields for the invoice tax line inbound [sn_shop_invoice_tax_line] 
staging table.

Invoice tax line inbound staging table

Field Data type Description

Tax Type String Type of the tax applicable on the invoice.

Taxable Amount FX 
Currency

The amount of tax applicable on an invoice.

Supplier Tax String The amount charged by the supplier.

Supplier Tax 
Rate

Decimal The tax rate calculated by the third-party tax calculation 
engine.
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Outbound staging tables for Source-to-Pay Operations

The outbound staging tables for Source-to-Pay Operations  store source-to-pay data before it is 
exported to a third-party ERP system.

Outbound staging tables for Sourcing and Procurement Operations

The outbound staging tables for Sourcing and Procurement Operations  store sourcing and 
procurement data before it is exported to a third-party ERP system.

Outbound Cost Allocation staging table

The Outbound Cost Allocation [sn_spend_intg_outbound_cost_allocation] staging table stores 
important data about the cost allocations created so that an ERP integrator can export this data 
to a third-party ERP system.

The following table lists the key fields for the Outbound Cost Allocation 
[sn_spend_intg_outbound_cost_allocation] staging table.

Note:  There are no mandatory fields for this table.

Outbound Cost Allocation staging table

Field
Data 
type

Description

Allocation 
amount

String Amount of cost that is allocated for expenditure.

Allocate by String Determines if the cost allocation is made by amount or percentage.

Allocation 
percentage

String Percentage of the cost allocated.

This field is visible only if the allocation type is set to Percentage.

Allocation 
type

String Specifies how the cost is allocated. For example, Cost center, Employee 
credit, or Payroll.

Cost center String Cost center that incurs the cost of this allocated transaction amount.

Cost owner String User who incurs the cost of this allocated transaction amount.

Employee 
credit

String Reference to the employee credit to which this cost allocation is made.

This field is visible only if the allocation type is set to Employee Credit.

ERP 
integration 
status

String Current status of the ERP integration.

ERP line 
number

String Purchase order line number from the ERP system.

ERP source String ERP source from which data is imported. For purchase order, receipt, and 
invoice integrations, the ERP source is determined through the legal entity 
associated with these records.

Number of 
payments 
selected

String Number of payments that the cost owner selected to pay back for a 
subsidized purchase.

This field is visible only if the allocation type is set to Payroll.

Order line String Order line associated with the cost allocation.
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Outbound Cost Allocation staging table  (continued)

Field
Data 
type

Description

Processing 
message

String A message that describes the current processing status.

Purchase 
line

String Purchase line associated with the cost allocation.

Terms 
accepted 
on

String Date and time at which the cost owner has accepted the terms and 
conditions of the organization to withhold the payroll.

This field is visible only if the allocation type is set to Payroll.

Outbound Order staging table

The Outbound Order [sn_spend_intg_outbound_purchase_order] staging table stores important 
data about the purchase orders created so that an ERP integrator can export this data to a third-
party ERP system.

The following table lists the key fields for the Outbound Order 
[sn_spend_intg_outbound_purchase_order] staging table.

Note:  There are no mandatory fields for this table.

Outbound Order staging table

Field
Data 
type

Description

Blanket order 
end date

Date Date on which the blanket order is expected to end.

If you're unsure of the delivery date of the product, you can provide an 
estimated time frame, which then creates a blanket order.

Blanket order 
start date

Date Date on which the blanket order is expected to start.

If you're unsure of the delivery date of the product, you can provide an 
estimated time frame, which then creates a blanket order.

Business 
owner

String The user who placed the order.

Catalog ID String Unique identifier for each catalog of the purchase order.

Customer ID Unique identifier for each customer of the purchase order.

ERP number String Unique number generated within the ERP system for the purchase order.

ERP source String ERP source from which the purchase order is imported.

Integration 
status

String Current status of the purchase order integration.

Legal entity String Name of the legal entity making this purchase.

Order date String Date and time of the order placed in YYYY-MM-DD HH: MM: SS format.

Order type String Type of the purchase order, which can be Standard or Blanket.
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Outbound Order staging table  (continued)

Field
Data 
type

Description

Payment 
term

String The agreed time and conditions of payment for the purchase order.

PO amount String Total amount of the purchase order.

PO amount 
currency

String Currency of the purchase order.

Processing 
message

String A message that describes the current processing status of the purchase 
order.

Purchase 
order 
number

String Unique number for the purchase order.

Purchase 
order status

String Current status of the purchase order.

Purchasing 
group

String The group of employees making the purchase order.

Purchasing 
organization

String The organization making the purchase order.

Supplier 
company 
name

String Supplier company name for which the purchase order is generated.

Supplier ID String Supplier ID for which the purchase order is generated.

Outbound Order Line staging table

The Outbound Order Line [sn_spend_intg_outbound_purchase_order_line] staging table stores 
important data about the purchase order lines created so that an ERP integrator can export this 
data to a third-party ERP system.

The following table lists the key fields for the Outbound Order Line 
[sn_spend_intg_outbound_purchase_order_line] staging table.

Note:  There are no mandatory fields for this table.

Outbound Order Line staging table

Field
Data 
type

Description

Account assignment 
category

String Account assignment category of the purchase order line.

Asset category String Asset category of the purchase order line.

City String City of the purchase order line.

Contract number String Contract number of the purchase order line.

Cost center String Cost center that incurs the cost of the purchase order line.

Country String Name of the country of the purchase order line.
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Outbound Order Line staging table  (continued)

Field
Data 
type

Description

Enroll in ABM String Option to enroll the purchase order line for an Apple Business 
Manager (ABM) account.

ERP line number String Purchase order line number from the ERP system.

Expected delivery 
date

String Expected delivery date of the purchased product.

GL account String General Ledger (GL) account associated with the purchase order 
line.

Integration status String Current status of the purchase order line integration.

Location name String Location of the purchase order line.

Manufacturer part 
number (MPN)

String Manufacturer or publisher’s unique identifier for the product, 
which the customer desires to purchase.

Model number String Unique model number of the product.

Organization ID String Organization ID of the purchase order line.

Processing message String A message that describes the current processing status of the 
purchase order line.

Product category String Product category that the purchase order line belongs to.

Product name String Name of the product associated with the purchase order line.

Product type String Type of the product associated with the purchase order line.

Purchase order String Purchase order associated with the purchase order line.

Purchase order line 
number

String Line number of the purchase order line.

Purchase order line 
status

String Current status of the purchase order line.

Purchased quantity String Quantity purchased as part of the purchase order line.

Recipient String Recipient of the purchase order line.

Service end date String Date on which service is expected to end.

This is applicable only if the Product type is Service.

Service start date String Date on which service is expected to be rendered.

This is applicable only if the Product type is Service.

Ship to String Shipping location of the purchase order line.

Short text String Brief description about the purchase order line.

State String State or province of the purchase order line.

Street String Street address of the purchase order line.

Supplier part 
number

String The supplier’s unique identifier for the product, which the 
customer desires to purchase.
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Outbound Order Line staging table  (continued)

Field
Data 
type

Description

Unit String Unit of rate at which the customer purchases the product.

Unit price String The price of each individual unit is purchased.

Unit price currency String The currency in which the order is placed.

Zip code String Zip code of the purchase order line.

Outbound Receipt staging table

The Outbound Receipt [sn_spend_intg_outbound_receipt] staging table stores important data 
about the receipts created so that an ERP integrator can export this data to a third-party ERP 
system.

The following table lists the key fields for the Outbound Receipt 
[sn_spend_intg_outbound_receipt] staging table.

Note:  There are no mandatory fields for this table.

Outbound Receipt staging table

Field
Data 
type

Description

ERP number String Unique number generated within the ERP system for the receipt.

ERP source String ERP source from which the receipt is imported. The ERP source is 
determined through the legal entity associated with these records.

Integration 
status

String Current status of the receipt integration.

Milestone String Milestone associated with the receipt.

Percentage 
received

String Percentage of the service received.

This field is visible only for a service receipt.

Processing 
message

String A message that describes the current processing status of the receipt.

Purchase 
order line 
number

String Purchase order line number against which the receipt of the product is 
acknowledged.

Purchase 
order line sys 
ID

String Purchase order line Sys_id  of the receipt.

Quantity 
received

String Quantity of product received as part of the receipt.

Receipt 
number

String Unique number for the receipt.

Receipt status String Current status of the receipt.
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Outbound Receipt staging table  (continued)

Field
Data 
type

Description

The status field is visible only when the ERP integration plugin is 
installed.

Receipt type String Type of the receipt based on the product type. For example, Goods 
Receipt or Services Receipt.

Supplier 
product

String Supplier product for which the receipt is generated.

Third-party Registration outbound staging table

The Third-party Registration [sn_spend_intg_third_party_registration] outbound staging table 
stores important data about the third-party registrations created so that an ERP integrator can 
export this data to a third-party ERP system.

Third-party Registration outbound staging table

The following table lists the key fields for the Third-party Registration 
[sn_spend_intg_third_party_registration] outbound staging table.

Third-party Registration outbound staging table

Field Data type Description

Allow multi 
location 
order

Boolean Supplier allows orders to be split for multi-location shipping.

Allow 
purchase 
order 
revision

Boolean Supplier allows purchase orders to be revised after confirmation.

Customer id String Unique identifier for the customer.

Import 
availability 
update

Boolean Supplier is allowed to import availability updates.

Import 
catalog

Boolean Supplier is allowed to import catalog, which includes price and 
availability.

Import 
invoice

Boolean Supplier is allowed to import invoices.

Import price 
update

Boolean Supplier is allowed to import price updates.

Import 
shipment

Boolean Supplier is allowed to import shipments.

Post order Boolean Supplier is allowed to post orders.

Provider 
name

String Unique identifier for the supplier.
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Third-party Registration outbound staging table  (continued)

Field Data type Description

Punchout 
connection 
type

String Punchout connection type:

• Start URL: Outbound URL to start punchout purchases.

• Order request URL: Outbound URL to request orders.

• Order confirmation URL: Inbound URL for order confirmation data 
from the third-party site.

• Shipping confirmation URL: Inbound URL for shipping 
confirmation data from the third-party site.

Punchout 
connection 
url

URL Unique URLs for the punchout group members with punchout 
credentials, specifically for Start URL and Order request URL 
connection types.

Punchout 
credentials

Reference Unique set of credentials for punchout group members.

Punchout 
group

Reference Users or members involved with this punchout supplier group, 
including shoppers, procurement specialists, and approvers.

Supplier Reference Name of the supplier in the ServiceNow records.

Third-party Model Mapping outbound staging table

The Third-party Model Mapping [sn_spend_intg_third_party_category_map] outbound staging 
table stores important data about the Third-party Model Mapping created so that an ERP 
integrator can export this data to a third-party ERP system.

Third-party Model Mapping outbound staging table

The following table lists the key fields for the Third-party Model Mapping 
[sn_spend_intg_third_party_category_map] outbound staging table.

Third-party Model Mapping outbound staging table

Field Data type Description

Product model Reference Name of the product model. This is required for catalog items.

Third-party category Reference Name of the category that the third-party belongs to.

Outbound staging tables for Supplier Lifecycle Operations

The outbound staging tables for Supplier Lifecycle Operations  store supplier data before it is 
exported to a third-party ERP system.

Supplier contact outbound staging table

The Supplier contact outbound [sn_spend_intg_supplier_contact_outbound] staging table 
temporarily stores important data about a supplier contact so that an ERP integrator can export 
this data to a third-party ERP system.

Supplier contact outbound staging table

The following table lists the mandatory fields for the Supplier contact outbound 
[sn_spend_intg_supplier_contact_outbound] staging table.
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Supplier contact outbound staging table

Field Data type Description

Active String Indicates if the supplier contact is active or not.

Avatar String Display avatar of the supplier contact.

Building String Name of the building of the supplier contact.

Business phone String Business phone number of the supplier contact.

City String Name of the city of the supplier contact.

Company String Name of the company that the supplier contact is linked to.

Cost center String Cost center that incurs the cost of the supplier contact.

Country String Name of the country of the supplier contact.

Country code String Country code of the supplier contact.

Date format String Date format of the supplier contact, which is YYYY-MM-DD.

Department String Department of the supplier contact.

Division String Division of the supplier contact.

Email String Email address of the supplier contact.

Employee number String Employee number of the supplier contact.

Fax String Fax number of the supplier contact.

First name String First name of the supplier contact.

Gender String Gender of the supplier contact.

Home phone String Home phone number of the supplier contact

Integration status String Current status of the supplier contact integration.

Job code String Job code of the supplier contact.

Last name String Last name of the supplier contact.

Location String Location of the supplier contact.

Manager String Name of the Manager of the supplier contact.

Middle name String Middle name of the supplier contact.

Mobile phone String Mobile phone number of the supplier contact.

Name String Name of the supplier contact.

Notes String Notes about the supplier contact.

Organization String Name of the organization of the supplier contact.

Other phone String Other phone number of the supplier contact.

Photo String Photo of the supplier contact.

Prefix String Prefix of the supplier contact.

Primary contact String Primary contact person of the supplier contact.

Registration status String Current registration status of the supplier contact.

Time format String Time format of the supplier contact, which is HH: MM: SS.
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Supplier contact outbound staging table  (continued)

Field Data type Description

Time zone String Time zone of the supplier contact.

Title String Designated title of the supplier contact.

User ID String User ID to identify the supplier contact.

Zip/Postal Code String ZIP code of the supplier contact.

Supplier legal entity mapping outbound staging table

The Supplier legal entity mapping outbound [sn_fcms_intg_supplier_legal_entity_outbound] 
staging table temporarily stores important data about the legal entities of a supplier so that an 
ERP integrator can export this data to a third-party ERP system.

Supplier legal entity mapping outbound staging table

The following table lists the mandatory fields for the Supplier legal entity mapping outbound 
[sn_fcms_intg_supplier_legal_entity_outbound] staging table.

Supplier legal entity mapping outbound staging table

Field
Data 
type

Description

Active String Indicates if the supplier legal entity is active or not.

Bank details String Bank details of the supplier legal entity.

Domain String Domain name of the supplier legal entity.

ERP company code String Company code of the entity in the ERP system.

ERP source String ERP source used by the organization.

General ledger 
account

String The account to which capital or operational expenses will be 
posted.

Hold payment String Indicates that the invoice payment is put on hold for the 
supplier.

Hold posting String Indicates that the invoice posting is put on hold for the 
supplier.

Integration status String Current status of the supplier legal entity integration.

Legal entity String Name of the legal entity of the supplier.

Onboarded String Indicates if a user has completed the onboarding process.

Payment method String Payment method preferred by the supplier legal entity.

Payment term String Agreed time and conditions for payment to the supplier legal 
entity.

Processing message String A message that describes the current processing status.

Remit to city String City to which the payment is made.

Remit to country String Country to which the payment is made.

Remit to state String State to which the payment is made.
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Supplier legal entity mapping outbound staging table  (continued)

Field
Data 
type

Description

Remit to street 
address

String Street address to which the payment is made.

Remit to zipcode String Zip code to which the payment is made.

Supplier String Name of the supplier.

Supplier location outbound staging table

The Supplier location outbound [sn_spend_intg_supplier_location_outbound] staging table 
stores important data about the geographical location of a supplier so that an ERP integrator can 
export this data to a third-party ERP system.

Supplier location outbound staging table

The following table lists the mandatory fields for the Supplier location outbound 
[sn_spend_intg_supplier_location_outbound] staging table.

Supplier location outbound staging table

Field
Data 
type

Description

Category String Category of the supplier location.

City String Name of the city of the supplier.

Company String Name of the company that the supplier is linked to.

Contact String Contact details of the supplier location.

Coordinates retrieved 
on

String Coordinates of the supplier location.

Country String Name of the country of the supplier.

Duplicate String Indicates if the supplier location is a duplicate.

ERP company code String Company code of the supplier location in the ERP system.

ERP source String ERP source from which data is imported.

External unique ID String Unique external ID number generated for the supplier 
location.

Fax phone String Fax number of the supplier location.

Full name String Full name of the supplier location.

Integration status String Current status of the supplier location integration.

Lat long error String Indicates if there’s a latitude or longitude error in the supplier 
location.

Latitude String Latitude of the supplier location.

Location source String Source of the supplier location.

Location type String Type of supplier location.
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Supplier location outbound staging table  (continued)

Field
Data 
type

Description

Longitude String Longitude of the supplier location.

Managed by group String The name of the group that manages the supplier location.

Name String Name of the supplier location.

Parent String Parent organization of the supplier location.

Phone String Phone number of the supplier location.

Phone territory String Name of the phone territory of the location.

Primary String Name of the primary contact of the supplier location.

Primary location String Name of the supplier's primary location.

Processing message String A message that describes the current processing status.

State/Province String Name of the State/Province of the supplier location.

Stock room String Stock room details of the supplier location.

Street address String Street address of the supplier location.

Time zone String Time zone of the supplier location.

Zip/Postal code String ZIP or postal code of the supplier location.

Supplier outbound staging table

The Supplier outbound [sn_spend_intg_outbound_supplier] staging table stores important data 
about the supplier so that an ERP integrator can export this data to a third-party ERP system.

Supplier outbound staging table

The following table lists the fields for the Supplier outbound [sn_spend_intg_outbound_supplier] 
staging table.

Supplier outbound staging table

Field Data type Description

ABA routing 
number

string Unique, nine-digit number used to identify banks and financial 
institutions.

Account 
number

string Account number of the supplier.

Active string Indicates whether the supplier payment record is active.

Beneficiary 
name on 
account

string Name of the beneficiary on the supplier's account.

BSB code string Bank State Branch is a six-digit number that is used to identify a 
bank code and its associated branch in Australia.

City string City where the supplier is located.

Country string Country where the supplier is located.
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Supplier outbound staging table  (continued)

Field Data type Description

ERP company 
code

string Company code of the supplier in the ERP system.

ERP Source string ERP source used by the organization.

Fax number ph_number Fax number of the supplier that can be used for sending 
documents.

General ledger 
account

string Accounts payable reconciliation account for the supplier.

IFSC code string IFSC code of supplier's account number.

Integration 
status

String Status of the integration process.

The outbound integration is considered successful only when 
the integrating status is New.

This is a mandatory field.

Legal entity string Name of the legal entity of the supplier.

Legal Name String Legal name of the supplier.

This is a mandatory field.

Off-boarded 
date

glide_date Date of the supplier's termination from the organization.

On-boarded string Indicates whether the supplier is on-boarded into the ERP 
system.

Payment term string Agreed time and conditions for payment to the supplier.

Phone number String Phone number of the supplier.

This is a mandatory field.

Primary phone 
number

ph_number Phone number of the primary contact at the supplier 
organization.

Processing 
message

string A message that describes the current processing status.

State / Province string State or province where the supplier is located.

Street address string Street where the supplier is located.

Zip / Postal 
code

string Zip code or postal code where the supplier is located.

Supplier payment outbound staging table

The Supplier payment outbound [sn_spend_intg_supplier_payment_outbound_stage] staging 
table temporarily stores important data about the payment information of a supplier so that an 
ERP integrator can export this data to a third-party ERP system.
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Supplier payment outbound staging table

The following table lists the mandatory fields for the Supplier payment outbound 
[sn_spend_intg_supplier_payment_outbound_stage] staging table.

Supplier payment outbound staging table

Field
Data 
type

Description

ABA routing 
number

String Unique, nine-digit number used to identify banks and financial 
institutions.

Account 
number

String Account number of the beneficiary for the supplier payment.

Active String Indicates whether the supplier is active or not.

Bank 
identification 
number

String Bank identification number for the supplier payment.

Bank name String Name of the bank for the supplier payment.

Beneficiary 
name on 
account

String Beneficiary name on the account for the supplier payment.

Branch code String Branch code for the supplier payment.

BSB code String Bank State Branch is a six-digit number that is used to identify a bank 
code and its associated branch in Australia.

Country String Name of the country of the supplier.

Currency String Three-digit ISO currency code used for a given country.

Domain String Domain name of the supplier.

ERP company 
code

String Company code of the entity in the ERP system.

ERP source String ERP source used by the organization.

IBAN String International Bank Account Number used for international payments.

IFSC code String Indian Financial System Code (IFSC) is a unique 11-digit alphanumeric 
code that is used for online fund transfer transactions in India.

Integration 
status

String Current status of the supplier payment integration.

Primary String Indicates whether this account is the primary account.

Processing 
message

String A message that describes the current processing status.

Sort code or 
transit code

String Sort code or transit code of the supplier's bank.

Supplier String Name of the supplier that the payment information is for.

SWIFT code String Bank Identifier Code (also known as SWIFT code) of the bank of the 
supplier.
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Outbound staging tables for Accounts Payable Operations

The outbound staging tables for Accounts Payable Operations  stores invoice data before it is 
exported to a third-party ERP system.

Organization tax details outbound staging table

The Organization tax details outbound [sn_spend_intg_outbound_tax_detail] staging table 
stores important data about an organization's tax information so that an ERP integrator can 
export this data to a third-party ERP system.

Organization tax details outbound staging table

The following table lists fields for the Organization tax details outbound 
[sn_spend_intg_outbound_tax_detail] staging table.

Organization tax details outbound staging table

Field
Data 
type

Description

Active String Tax registration status of the organization or supplier.

Country String Name of the country.

Integration 
status

String Status of the integration process.

Organization String Name of the organization.

This is a mandatory field.

Process 
message

String Describes fields that stores information related to a specific process.

State/
Province

String Name of the state or province where the supplier or organization 
details are registered.

Tax ID String Tax ID of the organization.

This is a mandatory field.

Outbound invoice staging table

The outbound invoice [sn_spend_intg_outbound_invoice] staging table stores important data 
about invoices so that an ERP integrator can export this data to a third-party ERP system.

Outbound invoice staging table

The following table lists both the mandatory and optional fields for the outbound invoice 
[sn_spend_intg_outbound_invoice] staging table.

Outbound invoice staging table

Field Data type Description

Amount invoiced String Total amount for the invoice.

Business owner String An individual or group who owns the invoice.

Currency String Currency format associated with the invoice.
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Outbound invoice staging table  (continued)

Field Data type Description

Default tax code Reference Default tax code levied on the total invoice amount.

Default tax code - 
deprecated

String Indicates whether the Tax code on the invoice is deprecated or 
not.

Default tax 
jurisdiction code

String Tax code jurisdiction to which the tax must be paid.

Discounts String Discounts applied on the invoice amount.

ERP number String Unique number generated within the ERP system for the 
purchase order.

ERP posting date String Date on which the invoice is posted in the ERP system.

ERP source String Target ERP where the invoice will be posted.

Final tax String Final tax on the invoice amount.

Integration status String Current status of the outbound invoice integration process.

Invoice date String Date on which this invoice is created.

Invoice status String Current status of this invoice.

Invoice type String Type of invoice for processing.

Note:  Accounts Payable Operations supports invoices 
of type PO invoice  and Non-PO invoice.

Legal entity Reference Internal legal entity which incurs the cost of this invoice.

Number String An auto-generated number that uniquely identifies the invoice.

Original invoice String A unique invoice number created by the Supplier.

Other charges String Other charges applied on the invoice amount.

Payment terms Reference How and when to make payment for the products and services.

Processing 
message

String A message that describes the current processing status.

Purchase order Reference Purchase order associated with this invoice.

Remit to city String City to which the payment is made.

Remit to country Reference Country to which the payment is made.

Remit to state/
province

String State or province to which the payment is made.

Remit to street String Street address to which the payment is made.

Remit to zip/
postal code

String ZIP or postal code to which the payment is made.

Ship from city String City from which the items on the purchase order is shipped.

Ship from country Reference Country from which the items on the purchase order is 
shipped.
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Outbound invoice staging table  (continued)

Field Data type Description

Ship from state/
province

String State or province from which the items on the purchase order is 
shipped.

Ship from street String Street address from which the items on the purchase order is 
shipped.

Ship from zip/
postal code

String ZIP or postal code from which the items on the purchase order 
is shipped.

Ship to city String City to which the items on the purchase order should be 
shipped.

Ship to country String Country to which the items on the purchase order should be 
shipped.

Ship to state/
province

String State or province to which the items on the purchase order 
should be shipped.

Ship to street String Street address to which the items on the purchase order 
should be shipped.

Ship to zip/postal 
code

String ZIP or postal code to which the items on the purchase order 
should be shipped.

Shipping amount String Shipping charges incurred for the invoice.

Subtotal String Total amount of money to be paid to the supplier excluding tax 
and shipping charges.

Supplier Reference Supplier who delivers the product or service.

Supplier invoice 
number

String Invoice number of the supplier invoice.

Tax amount String Tax rate applied on the invoice amount.

Invoice error staging table

The Invoice error [sn_spend_intg_import_error] staging table temporarily stores important data 
on errors before this data is sent to the primary table.

Invoice error staging table

Field Data type Description

Supplier invoice number String Unique invoice number 
created by the supplier.

Supplier invoice line number String Unique identifier for each line 
item on a supplier invoice.

Sales order number String Unique identifier for a 
customer's purchase.

Sales order line number String Unique identifier for each item 
on a sales order.
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Outbound invoice line staging table

The Outbound invoice line [sn_spend_intg_outbound_invoice_line] staging table stores 
important invoice line data so that an ERP integrator can export this data to a third-party ERP 
system.

Outbound invoice line staging table

The following table lists both the mandatory and optional fields for the Outbound invoice line 
[sn_spend_intg_outbound_invoice_line] staging table.

Outbound invoice line staging table

Field Data type Description

Cost center Reference Cost center for which the invoice is generated.

ERP line number String A unique identifier generated within an ERP system for the 
purchase order line.

ERP source String Target ERP where the invoice will be posted.

Final tax String Final tax on the invoice amount.

GL account Reference Account used to generate the invoice.

Integration 
status

String Current status of the outbound invoice line integration process.

Invoice Reference Transaction record used to track purchase between shopper 
and supplier.

Invoice line 
status

String Current status of this invoice line.

Line amount 
invoiced

String Total amount for the invoice line.

Line description String Description of the line item in the invoice.

Line quantity String Number of items that have been invoiced.

Line unit price String Unit price of the line item in the invoice.

Number String An auto-generated number that uniquely identifies the invoice.

Processing 
message

String A message that describes the current processing status.

Purchase order 
line

Reference Purchase line related to this invoiced amount.

Ship to city String City to which the items on the purchase order should be 
shipped.

Ship to country Reference Country to which the items on the purchase order should be 
shipped.

Ship to state/
province

String State or province to which the items on the purchase order 
should be shipped.

Ship to street String Street address to which the items on the purchase order should 
be shipped.
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Outbound invoice line staging table  (continued)

Field Data type Description

Ship to zip/
postal code

String ZIP or postal code to which the items on the purchase order 
should be shipped.

Subtotal String Total amount of money to be paid to the supplier excluding tax 
and shipping charges.

Supplier part 
number

String Supplier part number of the supplier product.

Tax amount String Tax rate applied on the invoice amount.

Tax code Reference Tax code of the invoice.

Tax code - 
deprecated

String Indicates whether the Tax code on the invoice is deprecated or 
not.

Tax jurisdiction 
code

String Tax code jurisdiction to which the tax must be paid.

Unit Reference Unit or rate in which this product is sold by the supplier.

Outbound invoice tax line staging table

The Outbound invoice tax line [sn_spend_intg_outbound_invoice_tax_line] staging table stores 
important invoice line data so that an ERP integrator can export this data to a third-party ERP 
system.

Outbound invoice tax line staging table

The following table lists both the mandatory and optional fields for the outbound invoice tax line 
[sn_spend_intg_outbound_invoice_tax_line] staging table.

Outbound invoice tax line staging table

Field Data type Description

Final tax String Final tax amount paid for this 
invoice.

Integration status String Current status of the 
outbound invoice tax line 
integration process.

Invoice Reference Invoice for which this tax is 
applicable.

Invoice line Reference Invoice line for which the tax is 
applicable.

Number String A unique system-generated 
number, which identifies the 
tax line.

Processing message String A message that describes the 
current processing status.

Supplier tax String Amount of tax charged by the 
supplier.
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Outbound invoice tax line staging table  (continued)

Field Data type Description

Supplier tax rate String Tax rate charged by the 
supplier.

Tax type Reference Type of the tax applicable on 
the invoice.

Taxable amount String Amount of tax applicable on 
an invoice.

Source-to-Pay integration framework transform maps and subflows

The transform maps transform the source-to-pay data from the inbound staging tables to the 
Source-to-Pay primary data tables. The subflows move the source-to-pay data from the outbound 
staging tables to a third-party ERP system.

Transform maps

The following transform maps transform the source-to-pay data from the inbound staging tables 
to the Source-to-Pay primary data tables.

Transform map details

Transform map Description

Load product model Transforms product model data from the 
sn_fcms_intg_cmdb_model_stage staging table to the 
cmdb_model primary table.

Load service model Transforms service model data from the 
sn_fcms_intg_cmdb_service_model_stage staging table to 
the cmdb_service_product_model primary table.

CMN location Transforms CMN location data from the 
sn_fcms_intg_cmn_location_stage staging table to the 
cmn_location primary table.

Master data cost center Transforms cost center data from the 
sn_fcms_intg_imp_cost_center staging table to the 
cmn_cost_center primary table.

Load department Transforms department data from the 
sn_fcms_intg_department_stage staging table to the 
cmn_department primary table.

ERP Plant Address Transforms ERP plant address data from the 
sn_fcms_intg_erp_plant_address_mapping_stage staging 
table to the sn_fcms_intg_erp_plant_address_mapping 
primary table.

Load FX currency Transforms FX currency data from the 
sn_fcms_intg_fx_currency_stage staging table to the 
sn_fin_fx_currency primary table.

Load FX rate Transforms FX rate data from the sn_fcms_intg_fx_rate_stage 
staging table to the sn_fin_fx_rate primary table.
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Transform map details  (continued)

Transform map Description

GL account load data Transforms GL account data from the 
sn_fcms_intg_gl_account_stage staging table to the 
sn_fin_gl_account primary table.

Cost allocation stage Transforms cost allocation data from the 
sn_spend_intg_imp_cost_allocation staging table to the 
sn_shop_cost_allocation primary table.

Order stage Transforms purchase order data from the 
sn_fcms_intg_imp_order staging table to the 
sn_shop_purchase_order primary table.

Order line stage Transforms purchase order line data from the 
sn_fcms_intg_imp_order_line staging table to the 
sn_shop_purchase_order_line primary table.

Receipt stage Transforms receipts data from the sn_fcms_intg_imp_receipt 
staging table to the sn_shop_receipt primary table. 
Transform legal entities:

Transform legal entities Transforms legal entity data from the 
sn_fcms_intg_legal_entity_stage staging table to the 
sn_fin_legal_entity primary table.

Load payment terms Transforms payment terms data from the 
sn_fcms_intg_payment_term_stage staging table to the 
sn_shop_payment_term primary table.

Transform office location Transforms office location data from the 
sn_fcms_intg_office_location_stage staging table to the 
sn_shop_office_location primary table.

Load product category Transforms product category data from the 
sn_fcms_intg_cmdb_model_category_stage staging table to 
the cmdb_model_category primary table.

Master data purchase entity Transforms purchase entity data from the 
sn_fcms_intg_imp_purchase_entity staging table to the 
sn_fin_purchasing_entity primary table.

Load supplier product Transforms supplier product data from the 
sn_spend_intg_supplier_product_stage staging table to the 
sn_shop_supplier_product primary table.

Transform supplier contact 
details

Transforms supplier contact details data from the 
sn_fcms_intg_supplier_contact_inbound staging table to the 
vm_vdr_contact primary table.

Master data supplier Transforms supplier data from the 
sn_fcms_intg_imp_supplier staging table to the 
sn_fin_supplier primary table.

Load legal entity-mapping data Transforms supplier legal entity data from the 
sn_fcms_intg_supplier_legal_entity_inbound staging table to 
the sn_fin_supplier_detail primary table.
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Transform map details  (continued)

Transform map Description

Load supplier address 
information

Transforms supplier location data from the 
sn_fcms_intg_supplier_location_inbound staging table to 
the sn_slm_m2m_location primary table.

Transform supplier payment Transforms supplier payment data from the 
sn_fcms_intg_supplier_payment_inbound_stage staging 
table to the sn_fin_supplier_payment primary table.

Invoice import Transforms invoice details from the 
sn_spend_intg_imp_invoice staging table to the 
sn_shop_invoice primary table.

Invoice line import Transforms invoice line details from the 
sn_spend_intg_imp_invoice_line staging table to the 
sn_shop_invoice_line primary table.

Invoice payment detail import Transforms invoice payment details from the 
sn_spend_intg_imp_invoice_payment_detail staging table to 
the sn_shop_invoice_payment_detail primary table.

Transform organization tax 
details

Transforms organization tax details data from the 
sn_fcms_intg_org_tax_detail_inbound staging table to the 
sn_fin_org_tax_detail primary table.

Subflows

The following subflows move the source-to-pay data from the outbound staging tables to a third-
party ERP system.

Subflow details

Subflows Description

Create cost allocation on 
outbound table

Moves cost allocation data from the 
sn_shop_cost_allocation primary table to the 
sn_spend_intg_outbound_cost_allocation staging table.

Create purchase order on 
outbound order table

Moves purchase order data from the 
sn_shop_purchase_order primary table to the 
sn_spend_intg_outbound_purchase_order staging table.

Create purchase order line on 
outbound order line table

Moves purchase order line data from the 
sn_shop_purchase_order_line primary table to the 
sn_spend_intg_outbound_purchase_order_line staging 
table.

Create/update receipt on 
outbound table

Moves receipt data from the sn_shop_receipt primary 
table to the sn_spend_intg_outbound_receipt staging 
table.

Update Supplier Contact 
Outbound from trigger Supplier 
Contact

Moves supplier contact details data from 
the vm_vdr_contact primary table to the 
sn_spend_intg_supplier_contact_outbound staging table.

Update Supplier Legal entity 
details from Legal entity mapping

Moves supplier legal entity data from the 
sn_fin_supplier_detail primary table to the 
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Subflow details  (continued)

Subflows Description

sn_fcms_intg_supplier_legal_entity_outbound staging 
table.

Update Supplier Location 
outbound from M2M location

Moves supplier location data from the 
sn_slm_m2m_location primary table to the 
sn_spend_intg_supplier_location_outbound staging table.

Update Supplier Outbound from 
trigger Supplier

Moves supplier data from the sn_fin_supplier primary table 
to the sn_spend_intg_outbound_supplier staging table.

Update Supplier Payment 
Outbound from trigger Payment

Moves supplier payment data from the 
sn_fin_supplier_payment primary table to the 
sn_spend_intg_supplier_payment_outbound_stage 
staging table.

Update tax details outbound from 
trigger tax details

Moves organization tax details data from the 
sn_fin_org_tax_detail primary table to the 
sn_spend_intg_outbound_tax_detail staging table.

Integration errors in staging tables

Integration errors caused by the target ERP sources are recorded in the form of system-
generated integration error tasks (outbound integration error). You can view the integration 
tasks associated with Procurement and Sourcing Operations, Supplier Lifecycle Operations and 
Accounts Payable Operations in the Tasks  area of the Source-to-Pay workspace.

The integration errors are categorized as:

• Outbound integration Error-occurs when the outbound staging record is run and the sub flows 
in the target ERP source fails due to an error. Example: Connection error. The sub flow auto-
updates the error message in the Processing message  field of the outbound staging table and 
sets the Integration status  to error. The system auto-creates error task for erroneous record 
and auto-assigns to a specialist.

• Inbound integration error- Occurs when the inbound flow fails to fetch the primary data from 
the target ERP sources due to error in the master flow or ERP subflow. The Error  field in the 
inbound staging table is auto-updated with the appropriate error message.

A specialist can reinitiate the integration activity after fixing the integration errors. Bulk records 
are integrated through scheduled jobs.

Scheduled jobs to fetch primary data

You can schedule on-demand jobs to be run at specific intervals of time to fetch primary data 
from different ERP sources into ServiceNow.

Before you start the ERP integration, you must configure the integration services record for target 
ERP source using the sn_fcms_intg_service table. The sn_fcms_intg_service table is a mapping 
table between sub flows and target ERP source. For more information on creating a integration 
service record, see Create Integration Service record.

Scheduled jobs are configured for entities using scripts. Example: Fetch cost center from ERP 
systems. For more information on configuring scheduled jobs using scripts, see Automatically 
run a script of your choosing . The script invokes subflow which is associated with an entity as 
shown in the figure below. The subflow queries the active entities or ERP source configuration 
(optional) listed in the integration service table.
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The scheduled jobs are run for the following entities:

• Cost center

• Payment terms

• Legal entity

• Plant/address

• GL account

• Purchasing org

• Product category/Product model (Material group/Material number)

• Currency

• Department

• Supplier

• FX currency rate

Create Integration Service record

Create Integration Service records for entities using the sn_fcms_intg_service table.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to Integration Services.

2. Select New.

3. On the integration service record, fill in the fields.

Integration service record

Field Description

Entity The type of entity for which you want to 
configure scheduled job.

ERP Source configuration The ERP source mapped to the entity.

Subflow The subflow used to fetch primary data.

Properties The filter condition used to fetch data from 
ERP sub flows. Example: Full-pull creates 
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Field Description

JSON in the integration service record which 
is passed to the ERP sub flows to fetch data.

Active The status of the interaction service. By 
default, the check box is inactive.

4. Select Submit.

What to do next
In the ERP Source configuration, Run jobs for active entities.

Run scheduled jobs

Run adhoc scheduled jobs to fetch entity primary data from the target ERP source.

Before you begin
Role required: sn_fcms_intg.integration_user

About this task
Executes on-demand scheduled jobs on true entities of an ERP source target and fetches 
primary data. Auto-populates the entity inbound tables.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Select the ERP source for which you would like to run scheduled jobs.

3. Select Integration Services  >Run job.
The fetch services run automatically as scheduled.
Entity inbound tables are populated with primary data.

Primary data integration

All primary data are synchronized based on the configurable scheduled job Fetch Spend Primary 
Data. For supplier primary data, if an update is made in the ERP, it is synchronized with Source-to-
Pay (S2P) even if the scheduled job has not been triggered.

The asset category and material group mapping tables are also populated by the same 
scheduled job. However, the address mapping table has to be populated manually. A 
procurement administrator must manually populate the S2P model categories and capitalization 
policy in the respective mapping tables on initial load.

Fixed asset integration

Fixed assets are created automatically in Source-to-Pay (S2P) on creation of a purchase 
order, when capitalization policy criteria are satisfied, and synchronized to the ERP system 
asynchronously.

The following fields are added in the Fixed Asset table to integrate with the ERP systems:

• Depreciation lifecycle

• Depreciation term

• Salvage value

Whenever the Depreciated amount, Remaining value, and Salvage value  fields are updated in 
the ERP system, depending on the depreciation term defined in the ERP, the values are synced 
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back to S2P for the corresponding fixed asset. A configurable scheduled job Fetch Fixed Asset 
Details defined in S2P determines the frequency to retrieve this data from the ERP system.

For more information on automatic fixed asset creation, see Fixed asset creation.

Purchase order integration

Purchase orders are created in Source-to-Pay (S2P) and synchronized to the ERP system 
asynchronously.

As there are several key concepts that are specific to the ERP system but are not captured in 
S2P, the following configurations in S2P are prerequisites to ensure successful execution of the 
integration:

• ERP Address Mapping: This table stores the mapping between a delivery location in S2P and 
a plant in the ERP system. Additional address identifier columns are available in this table to 
allow customers map an address in S2P to other entities in the ERP system.

• ERP Asset Category Mapping: This table stores the mapping between a capitalization policy 
in S2P and an asset class in the ERP system. The asset class is populated based on the value 
that was mapped to the corresponding capitalization policy that triggered the creation of the 
fixed asset in S2P.

• ERP Material Group Mapping: This table stores the mapping between a model category in 
S2P and a material group in the ERP system. Depending on the model category associated 
to the supplier product in a purchase order line within S2P, the appropriate model category is 
populated in the ERP system.

• Account assignment category configuration: To accommodate prepayments and the ability 
to store multiple general ledger accounts on a purchase order line in the ERP system, 
configuration has to be done to either introduce a net new Account Assignment Category in 
the ERP system that has this feature enabled, or update an existing one.

Note:  The ERP integration mapping tables can be accessed through the primary data by a 
procurement administrator alone.

Process flow

• On final review of a purchase requisition, a purchase order and fixed assets, if applicable, are 
created in S2P, triggering the integration with the ERP system.

• Attachments, if any, with valid sys-ids, are copied from the Inbound Purchase Order staging 
table record to the Purchase Order primary table record. This is done through a transform 
script, which is part of the Order stage transform map, triggered onAfter.

• If there is an integration error, an integration error purchasing task is created on the purchase 
requisition. This contains the error message from the ERP system to inform the procurement 
specialist what must be updated.

• If a purchase order line is being inserted by the ERP system with no corresponding purchase 
order in S2P, your administrator gets an error message. They can run the 'Retrigger failed order 
line import set records' scheduled job to re-trigger the error purchase order line records that 
have not been imported due to the absence of the purchase order. For more information on 
integration error handling, see Integration errors in staging tables.

• Purchase orders are not created in the ERP system until the integration error is resolved in 
S2P. At this juncture, the status of the purchase order and purchase requisition in S2P is set to 
Pending Submission.

• Additional form sections, fields, and mapping tables are created in S2P for integration 
purposes.
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• On successful purchase order creation in the ERP system, a purchase order ERP number and 
purchase order line ERP number are returned and synchronized back to the appropriate record 
in S2P.

• If a capitalization policy is satisfied, fixed assets are created in the ERP system and the ERP 
number is synchronized back to S2P.

• Purchase order revisions in S2P do not result in a new purchase order creation in the ERP 
system. The existing purchase order is updated to reflect the revised information. The buttons 
to update a purchase order are turned off when the integration status in the Outbound Order 
[sn_spend_intg_outbound_purchase_order] staging table is New or In Process.

• Cancellation of a purchase order in S2P moves the status of the purchase order to Pending 
Submission. When the integration is successful in the ERP system, the purchase order is 
canceled.

• Blanket purchase orders are not created in the ERP system as it is a pre-approved list of users 
who do not have to go through the approval process when they purchase against the blanket 
purchase. Also, there are no financial documents associated with blanket purchase orders in 
S2P.

• Purchase order releases are created in the ERP system.

• Invoices and receipts are created against the standard purchase order releases in S2P, and as 
such, created as standard purchase orders in the ERP system as well.

Purchase order line split scenario

Multiple purchase order lines are created from a single purchase line if the following conditions 
are met:

• Purchase is integrated with the ERP system

• Purchased quantity is 100 or more

• Purchase is capitalized, for example, fixed assets created for the purchase

If multiple purchase order lines must be created, the first purchase order line can have a 
maximum purchased quantity of 99, and the remainder should go into the next purchase order 
line(s), none exceeding 99. You can create as many purchase order lines as required to cover the 
quantity of products purchased.

For example, if a purchase line purchased quantity is 250, which is capitalized and integrated 
with the ERP system, the purchase order lines are split as follows:

• POL1001: Purchased quantity = 99

• POL1002: Purchased quantity = 99

• POL1003: Purchased quantity = 52

Note:  Each purchase order line created here must reference the same purchase line, and 
the fixed assets created must reference the appropriate purchase order line.

Receipt integration

Receipts are created in Source-to-Pay (S2P) and synchronized to the ERP system 
asynchronously.
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Process flow

• When a receipt record is created in S2P, integration with the ERP system is triggered. This 
creates a goods receipt (GR) in the ERP system.

• If there is an integration error, an integration error purchasing task is created on the purchase 
order. This contains the error message from the ERP system to inform the procurement 
specialist what must be updated.

• Similar to purchase order integration, a goods receipt is not created in the ERP system until 
the integration error is resolved in S2P. At this juncture, the status of the receipt in S2P is set to 
Pending Review.

• On successful goods receipt creation in the ERP system, an ERP number is returned and 
synchronized back to the appropriate record in S2P.

Note:  No additional configurations are required for receipt integration to function.

Invoice integration

Invoices are created either manually in Source-to-Pay (S2P) or through an external supplier 
portal. Generic API synchronizes invoices created from a supplier portal into S2P.

Process flow

• When the matching and invoice approvals process, if applicable, is complete, an 
asynchronous call to the ERP system is triggered.

• If there is an integration error, an integration error purchasing task is created on the purchase 
order. This contains the error message from the ERP system to inform the procurement 
specialist what must be updated.

• Similar to purchase order integration, an invoice is not created in the ERP system until the 
integration error is resolved in S2P. At this juncture, the status of the invoice and invoice line in 
S2P is set to Pending Review.

• On successful invoice creation in the ERP system, an ERP number and ERP line number are 
returned and synchronized back to the appropriate record in S2P.

• In case of manual invoice creation, the user has to manually confirm the invoice to trigger the 
ERP system integration.

Note:  No additional configurations are required for invoice integration to function.

ERP source

An ERP Source [sn_fin_erp_source] table is available in Source-to-Pay (S2P) as part of the 
Finance Common Architecture  application.

You can use the ERP Source  field available in tables to directly identify the correct ERP source if 
you have integrations with multiple ERP systems.
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Note: 

• In some scenarios, for purchase orders, receipts, and invoice integration, the ERP source 
for records is still determined through the legal entity on those records. This is achieved 
by adding an ERP Source  reference field on the Legal Entity [sn_fin_legal_entity] table. 
Also, Legal Entity is added as a related list for the ERP Source table.

• The ERP source column in the global table should be deprecated and migrated to local 
tables. Run the data migration script manually to move data from the impacted tables to 
the new mapping table. For more information, see Migrate ERP source data from global 
tables to the mapping table [KB1733450] .

The Multi-ERP data will continue to function without migrating the ERP source column (for 
up to the next two family releases from Yokohama), but ensure migration to local tables is 
completed.

Tables containing the ERP Source column

The following tables contain the ERP Source column.

Tables containing the ERP Source column

Application Table

Global CMDB Categories [cmdb_categories]

Product Model [cmdb_model]

Service Model [cmdb_service_product_model]

Cost Center [cmn_cost_center]

Department [cmn_department]

Location [cmn_location]

Source-to-Pay Common Architecture Negotiation [sn_shop_negotiation]

Negotiation Event [sn_shop_negotiation_event]

Office Location [sn_shop_office_location]

Purchase Requisition [sn_shop_purchase_requisition]

Sourcing Request [sn_shop_sourcing_activity]

Supplier Product [sn_shop_supplier_product]

Finance Common Architecture Fixed Asset [sn_fin_fixed_asset]

Office Location [sn_fin_office_location]

ERP source configuration

ERP source configuration allows specific customer logic to be implemented to populate values 
specific to third-party ERP systems. It contains all the service mappings defined between 
Source-to-Pay (S2P) and the third-party ERP system.

If there are multiple ERP sources, these are stored as separate ERP source entries with their 
respective service mappings. You can update the service mapping logic to fulfill specific 
requirements by updating the appropriate service element map entry within the service map 
record.
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For organizations with multiple ERP systems, an ERP Source  field has been added in the tables 
to enable proper identification of the ERP system it is integrated with. For more information, see 
ERP source.

Integration settings on Source-to-Pay side

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to automatically post purchase 
order, receipt, invoice, and download primary data from the ERP.

Before you start the integration configuration, you must complete the following tasks.

• Add the following roles to the Integration user:

◦ Import_transformer

◦ Soap

• Get the following information from the ERP team:

◦ ERP integration user credentials.

◦ SOAP or REST API details based on your ERP system and the type of web services you are 
using for the integration.

Note:  If the application needs to support multiple ERP instances, configure S2P to 
integrate with each ERP instance separately.

1. Define an ERP source.

Define the ERP source that you want to integrate with Procurement Service Management. This 
information is required for any primary data. For more information, see ERP source  and Primary 
data integration.

2. Set up the authentication profile.

Create a basic authentication profile that can be used for web service integration with ERP. 
Register the ERP integration username and password to create the authentication profile and 
associate it to service maps. For more information, see Set up the authentication profile.

3. Define source configuration for ERP.

ERP source configuration determines the ERP source to which your ERP system connects. 
For more information, see ERP source configuration  and Define ERP source configuration for 
Source-to-Pay.

4. Configure service maps for the following entities:

◦ Post purchase order.

Set up web services for the source configuration to post purchase orders to ERP.

◦ Post receipt.

Set up web services for the source configuration to post receipts to ERP.

◦ Post invoice.

Set up web services for the source configuration to post invoices to ERP.

◦ Fetch supplier.

Set up web services for the source configuration to fetch supplier updates from ERP.
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◦ Fetch cost center.

Set up web services for the source configuration to fetch cost center updates from ERP.

◦ Fetch purchasing entity.

Set up web services for the source configuration to fetch purchasing entity updates from 
ERP.

◦ Fetch general ledger account.

Set up web services for the source configuration to fetch general ledger account updates 
from ERP.

◦ Fetch asset category.

Set up web services for the source configuration to fetch asset category updates from ERP.

◦ Fetch material group.

Set up web services for the source configuration to fetch material group updates from ERP.

Note:  For configuring each of these service maps, provide the connection end point 
and the ERP credentials that you set up for your authentication profile. Also, create a 
separate web service record for each service request that you want to customize.

For more information, see Configure service maps for Source-to-Pay.

5. Configure scheduled job to synchronize primary data updates from ERP.

Set up the interval in the Fetch Spend Primary Data scheduled job to periodically synchronize 
primary data updates from the ERP, for posting services to work.

6. Load data to ERP user mapping table.

Set up S2P and ERP User ID mapping for the integration to work. The mapping is maintained 
for all active users who have the procurement buyer role in ERP. These users should be used 
in the requisition assignment rule. For more information, see Load data to ERP user mapping 
table for Source-to-Pay.

7. Map the following entities:

◦ Purchasing entity.

Map legal entity to the downloaded purchasing entity in the purchasing entity table.

◦ Asset category.

Map capitalization policy to the downloaded asset category in the asset category mapping 
table.

◦ Material group.

Map model category to the downloaded material group in the material group mapping table.

◦ Delivery address.

Map location reference in the delivery location table to ERP address code in the address 
mapping table.
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◦ ERP plant.

Map ERP plant id to the corresponding ERP location in the address mapping table. Use the 
ERP address identifier 1  field for this mapping.

Set up the authentication profile

Create a basic authentication profile that can be used for web service integration with ERP. 
Register the ERP integration user name and password to create the authentication profile and 
associate it to service maps.

Before you begin

• Verify that the application scope is set to Finance – ERP Integration.

• Credentials required: ERP integration user credentials provided by ERP.

Role required: sn_fcms_intg.integration_user

About this task
If the application needs to support multiple ERP instances, create a separate credential alias and 
authentication profile for each instance.

Procedure

1. Navigate to Connections & Credentials  > Connection & Credential Aliases.

2. Click New.

3. Enter a unique name for the alias and set the Type  value to Credential.

4. Click Submit.
A new credential alias with a unique ID is created.

5. In the Credentials related list, click New  and then select Basic Auth Credentials.

6. On the form, fill in the fields.

Basic Auth Configuration form

Field Description

Name Name of the authentication configuration.

Username User name as provided by ERP.

Password Password as provided by ERP. This username 
and password is used to authenticate the 
HTTP request when this basic authentication 
profile is enabled.

Credential alias Credential alias created for the ERP 
configuration. This alias is auto-populated 
when you create an authentication profile 
from a credential alias.

7. Click Submit.

What to do next
Configure service maps for the source configuration and associate the basic authentication 
profile to these service maps.
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Define ERP source configuration for Source-to-Pay

ERP source configuration determines the ERP source to which your ERP system connects. Map 
the integration payload with the Source-to-Pay (S2P) tables.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Click New.

3. On the form, fill in the fields.

ERP Source Configuration form

Field Description

ERP Name of the ERP system.

ERP Source ERP source for which the integration is 
required.

Name Name of the ERP.

4. Click Submit.

What to do next
For the defined source configuration:

• Define service mappings for each integration service by accessing the Service Mappings 
related list. You can define element level mapping between S2P table fields and payload 
elements.

• Map S2P users and corresponding ERP user ids by accessing the ERP User Mappings related 
list.

Configure service maps for Source-to-Pay

For configuring service maps, provide the connection end point and the ERP credentials that you 
set up for your authentication profile. Also, create a separate web service record for each service 
request that you want to customize.

Before you begin

• Verify that the application scope is set to Finance – ERP Integration.

• Ensure that the MID Server  is installed and configured in your ServiceNow  instance to connect 
to the ERP server. See Installing the MID Server  for details.

Note:  The MID Server integration is required only for an ERP integration using SOAP 
services.

• For SOAP type service, SOAP API details (WSDL information – soap action and endpoint 
details), provided by ERP.

• For REST type service, REST API details, as provided by ERP.

Role required: sn_fcms_intg.integration_user
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About this task
If the application needs to support multiple ERP instances, create separate web services for 
each ERP instance.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you need to configure service maps.

3. In the Service Mappings related list, click New.

4. On the form, fill in the fields.

Service Map form

Field Description

Name Name of the service map.

Service Service to process the selected request.

Source Name of the ERP source.

Type Type of web service to connect with ERP. 
Select a type based on your ERP system.

◦ SOAP: Select if you are using SOAP 
services with your integration.

◦ REST: Select if you are using REST 
services with your integration.

Use MID Option to use MID Server  to connect with 
ERP.

The field is required only when you select 
SOAP in the Type  field.

Credential alias Basic authentication profile associated with 
the service.

SOAP action SOAP action provided by ERP.

This field appears when SOAP is selected in 
the Type  field.

SOAP endpoint SOAP endpoint provided by ERP.

This field appears when SOAP is selected in 
the Type  field.

Envelope Reference to generate the service element 
maps.

This field appears when SOAP is selected in 
the Type  field.

HTTP Method Method for the web service.

This field appears when REST is selected in 
the Type  field.
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Field Description

Base URL Base URL of endpoint provided by ERP.

This field appears when REST is selected in 
the Type  field.

Resource Path Path of the resource provided by ERP.

This field appears when REST is selected in 
the Type  field.

5. Click Submit.

Load data to ERP user mapping table for Source-to-Pay

Set up Source-to-Pay (S2P) and ERP User ID mapping for the integration to work. The mapping is 
maintained for all active users who have the procurement buyer role in ERP. These users should 
be used in the requisition assignment rule.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. Select Create table  and enter a label for the new table in the Label  field.

3. In the Source of the import  field, select File, and then click Choose File  to select the source 
Excel spreadsheet.

4. Optional:  If appropriate, specify the Work sheet and Header row number.

5. Click Submit.
The imported data is now available in the new Import Set table.

6. Create a transform map  to define the field mapping between columns of the import set and 
columns of the target ERP User Mapping [sn_fcms_intg_erp_user_map] table.
The ERP User Mapping table maintains mapping between ERP user IDs and ServiceNow  user 
IDs.

7. Transform the data from the import set table to the target table.
For more information, see Run an import .

Result
The data is imported into the ERP User Mapping table.

What to do next
Verify that the data records are imported into the target table. You can view the ERP user 
mappings by navigating to Finance - ERP Integration  > ERP Users.

Note:  If an ERP user mapping is not required, you can deactivate it. To deactivate a 
mapping, in the ERP User Mapping form, select the Inactive  check box.

ERP Integration Framework

The Source-to-Pay (S2P) ERP Integration Framework enables seamless data exchange between 
ServiceNow and third-party Enterprise Resource Planning (ERP) systems. This framework 
supports comprehensive integration of primary data, transactional data (purchase orders, 
receipts, invoices), fixed assets, and tax information across multiple ERP instances.
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Key Features

• User-defined primary data that can be customized to organizational needs.

• Mapped to organizational legal entities for clear data governance.

• Associated with target ERP systems for bidirectional data flow.

• Flexible configuration enabling multiple sources for an organization.

ERP Sources

An ERP Source represents a specific ERP instance from which data is imported and to which 
data is exported. Organizations typically maintain multiple ERP instances as systems of record, 
with each ERP source mapped to a legal entity within the organization.

ERP Integration Requirements

• At least one ERP source must be configured for each legal entity within every target instance.

• Each ERP source should be associated with a specific target ERP system.

• Organizations can create as many ERP sources as needed to support their structure.

The integration framework clearly defines the system of record responsibilities:

• Third-party ERP: System of record for primary data entities

• Source-to-Pay: System of record for purchase orders and receipts

• Either system: Invoices can be created manually in Source-to-Pay or through external supplier 
portals

Integration Architecture

The ERP Integration Framework application loads primary data into Source-to-Pay Operations, 
enabling various ServiceNow workflows. It also imports selected inbound transactional data 
objects such as purchase order data that are shared across all Source-to-Pay Operations 
products.

Both the ERP Integration Framework and Source-to-Pay Integration Framework applications 
provide an abstraction layer between the Source-to-Pay application and backend systems. This 
design shields Source-to-Pay workflows and data models from backend-specific integration 
components and data structures.
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Source-to-Pay Operations Integration Architecture

Required Applications

The integration requires the Finance – ERP Integration store application to be installed.

MID Server Requirement

A MID Server is required for ERP integrations using SOAP services. The MID Server must be 
installed and configured to connect to the ERP system server. See Installing the MID Server  for 
details.

Note:  MID Server integration is only required for SOAP-based integrations, not for REST-
based integrations.

User Roles and Permissions

The ERP Integration Framework supports the following roles and permissions:

Role name Capabilities

Administrator (sn_fcms_intg.admin) • Install integration applications

• Configure system-wide settings

• Manage all aspects of the integration 
infrastructure

Procurement Specialist 
(sn_shop.procurement_specialist)

• Define and manage ERP sources

• Configure ERP source parameters

• Manage integration workflows
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Role name Capabilities

FCA Integration user 
(sn_fcms_intg.integration_user)

• Configure ERP source settings including web 
service authorization

• Set up web services for Park and Post, Reverse 
operations

• Manage user and role mappings

• Access inbound and outbound staging tables

• Configure and execute integration processes

Additional roles for the FCA Integration user (sn_fcms_intg.integration_user):

• Import_transformer: For data transformation operations

• SOAP: For SOAP-based web service integrations

Granular roles

Users assigned the integration admin role (sn_fcms_intg.admin) are granted read 
and write permissions for these system properties. This access aligns with the granular role 
modifications as per the new directives.

Property Name Read role Write role

sn_fcms_intg.status_for_purchase_ordersn_shop.shopper, 
sn_shop.procurement_common_reader, 
sn_fcms_intg.admin

sn_fcms_intg.admin

sn_fcms_intg.status_for_invoice_creationsn_fcms_intg.admin, 
sn_ap_apm.accounts_payable_specialist

sn_fcms_intg.admin

sn_fcms_intg.status_for_goods_receiptsn_shop.shopper, 
sn_shop.procurement_common_reader, 
sn_fcms_intg.admin

sn_fcms_intg.admin

Source-to-Pay integration with SAP

The Source-to-Pay integration with SAP enables you to send purchase orders, receipts, and 
invoices created on the SAP from your ServiceNow instance. This integration helps in looking up 
or extracting primary data objects from SAP into ServiceNow.

Key features

With this application, you can perform the following:

• Integration hub actions for purchase requisition, purchase order, receipt, and invoices.

• Create or update purchase orders in SAP.

• Cancel purchase orders in SAP.

• Create good receipts in SAP.

• Create invoices in SAP.
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Overview of the Source-to-Pay integration with SAP

Prerequisites

First, you must activate the Source-to-Pay integration with the SAP application from the 
ServiceNow Store. This automatically activates the SAP ECC, SAP S4 Public, and SAP S4 HANA 
OData Spoke. Next you must set up the following SAP ECC or SAP S4 HANA based on your 
requirement:

• SAP ECC RFC Spoke

• SAP S4 HANA Public Cloud Spoke

• SAP S4 HANA OData Spoke

The following are the ServiceNow Store app plugins:

• sn_sap_ecc_rfc_spo.SAP_ECC

• sn_s4_hana_cld_spk.SAP_S4_HANA_Cloud

• sn_hana_odata_spk.SAP_S4_HANA_OData

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

How it works

The subflows enable a plug-and-play experience for the integration scenarios. Integration Hub 
Actions provide the building blocks for Source-to-Pay subflows and connects to the SAP system 
through REST APIs.

Explore Source-to-Pay integration with SAP

Learn more about the Source-to-Pay integration with SAP.

Establishing communication between the SAP and ServiceNow instances

The Source-to-Pay integration with SAP supports the following APIs:
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• REST APIs: REST relies on a client/server approach that separates front and back ends of 
the API and provides considerable flexibility in development and implementation. REST is 
stateless, which means the API stores no data or status between requests.

• SOAP APIs: The simple object access protocol (SOAP) is a messaging standard defined by the 
World Wide Web Consortium and broadly used to create web APIs, usually with XML. SOAP 
supports a wide range of communication protocols found across the internet, such as HTTP, 
SMTP and TCP/IP.

You can establish a connection with an SAP system from the ServiceNow instance using the 
following methods:

• SAP Java Connector  (SAP JCo): It is a middleware that allows Java applications to 
communicate with SAP systems using RFC/BAPI protocols. It supports both inbound and 
outbound Remote Function Calls. For more information, see SAP Documentation.

• OData  (Open Data Protocol): It is used in web technologies by SAP to make data accessible 
across different platforms, enabling the development of web applications, websites, and 
mobile apps.

SAP supports the following protocols for transferring data:

• RFC/BAPI (sync typically)

• REST/OData (sync)

• SOAP (async typically)

SAP Implementations

• On-premises implementation:

Everything is managed and maintained by the customer in their physical locations. Both SAP 
ECC and SAP S4 HANA can be implemented in this model.

• On-premises implementation on Azure or AWS:

The SAP instance could be on a cloud instance like Azure or AWS, but it’s still a type on-
premises implementation as it is within a firewall, with the only difference being that the 
instance is hosted on a cloud server. Both SAP ECC and SAP S4 HANA can be implemented in 
this model.

• Cloud implementation:

The SAP instance is on a true cloud system. Only SAP S4 HANA can be implemented in this 
model, and SAP ECC can’t be implemented in this category.

The current default SAP integration workflows offered by ServiceNow cater to the implementation 
of the first two types. However, it doesn’t exclude customers from implementing on cloud, which 
can easily be achieved by converting the wrapper function modules into web service WSDLs. 
However, this requires customizations at SAP and ServiceNow.

Execute RFC in the Source-to-Pay with SAP integration

Execute RFC from the available list.

Process flow:

Step 1 - Create a record for the SAP system in the Connection and Credential alias table.

Step 2 - Create Credential for connecting to the SAP system.
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Step 3 - Add MID Server and credentials to the connection.

Step 4 - Create ERP Source is an ERP source configuration table.

Step 5 - Create a Service, add flow and give the necessary inputs in the fields.
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Name: ZSN_BAPI_GET_DATA

Query parameters to execute RFC

Title Type Description

Input

1 Connection 
Alias -

Connection Alias for SAP ECC – RFC

2 RFC The Reference to records (SAP RFC Name and Application component) in 
SAP RFC Table

3 Input Input fields for the selected RFC, represented in a flat structure

Output

1 Response
The response for the execution of selected RFC at SAP

2 Action 
Status

If the request is executed successfully, Status is set to “Success”. If there’s a 
failure in SAP ECC - RFC, Status is set to “Error"

3 Error 
Message

Reason for error. Populated only when an error occurs. Error returned from 
SAP in the RETURN parameter.

No or empty response received from SAP
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• Function Builder Initial Screen

• Enter the IMPORT, CHANGING, and TABLES parameters
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• Results data
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• Results data

Results data

Configure the Source-to-Pay integration with SAP

Integrate the ServiceNow instance with SAP by creating a custom OAuth application in SAP ECC 
and SAP S4 HANA to authenticate ServiceNow requests.

Application set up

Verify that you have performed the following:

• Activated the Source-to-Pay integration with the SAP application from ServiceNow Store. This 
automatically activates the SAP ECC, SAP S4 HANA, and SAP S4 HANA OData Spoke.

• Set up the Spoke:

◦ Set up the SAP ECC RFC spoke

◦ Setup the SAP S4 HANA Public Cloud spoke

◦ Set up SAP S4 HANA OData spoke

• Activated the Source-to-Pay integration framework from ServiceNow Store. The Source-to-Pay 
integration with SAP uses the Source-to-Pay integration framework to pull tasks from SAP into 
ServiceNow. For more information on the Source-to-Pay integration framework, see Source-to-
Pay integration framework.
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Primary Data Integration Dependencies with SAP Dependencies

Install the following dependencies of Primary Data integration with SAP. When you install the 
plugin, all the dependencies get installed automatically. All primary data are synchronized based 
on the configurable scheduled job Fetch Spend Primary Data.

Run the Trigger SAP Integration that pulls tasks into ServiceNow. For more information, see Use 
schedule flows in SAP.

Primary Data Integration Dependencies with SAP

App name Plugin ID

SAP ECC IDOC Spoke sn_sap_ecc_idoc_sp

Source-to-pay Common Architecture sn_shop

ERP Integration Framework sn_fcms_intg

Utility Spoke sn_utility_spoke

SAP ECC RFC Spoke sn_sap_ecc_rfc_spo

Supplier Common Architecture sn_slm

SAP S4 HANA Spoke sn_hana_odata_spk

Supplier Lifecycle Operations Integration Dependencies with SAP

Install the following dependencies of Supplier Lifecycle Operations integration with SAP. When 
you install the plugin, all the dependencies get installed automatically.

Supplier Lifecycle Operations Integration Dependencies with SAP

App name Plugin ID

Primary Data Integration with SAP sn_sap_data_int

ERP Integration Framework sn_fcms_intg

Finance Common Architecture sn_fin

Supplier Operations sn_so

Sourcing and Procurement Operations Integration Dependencies with SAP

Install the following dependencies of Sourcing and Procurement Operations integration with 
SAP. When you install the plugin, all the dependencies get installed automatically.

Sourcing and Procurement Operations Integration Dependencies with SAP

App name Plugin ID

Primary Data Integration with SAP sn_sap_data_int

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

SAP S4 HANA RFC Spoke sn_sap_s4_hana_rfc

SAP ECC IDOC Spoke sn_sap_ecc_idoc_sp
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Accounts Payable Operations Integration Dependencies with SAP

Install the following dependencies of Accounts Payable Operations integration with SAP. When 
you install the plugin, all the dependencies get installed automatically.

Accounts Payable Operations Integration Dependencies with SAP

App name Plugin ID

Primary Data Integration with SAP sn_sap_data_int

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

SAP S4 HANA RFC Spoke sn_sap_s4_hana_rfc

SAP ECC IDOC Spoke sn_sap_ecc_idoc_sp

ERP Source Configuration for SAP

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to automatically post purchase 
order, receipt, invoice, and download primary data from the ERP.

ERP source configuration enables the implementation of specific logic to populate values 
pertinent to third-party ERP systems. It includes all integration services defined between Source-
to-Pay (S2P) and the third-party ERP system. In cases where multiple ERP sources exist, they’re 
stored as distinct ERP source entries with their corresponding integration services.

To meet specific requirements, you can modify the service-mapping logic by updating the 
relevant service element map entry within the integration service record. For organizations using 
multiple ERP systems, an ERP Source field has been incorporated into the tables to ensure 
accurate identification of the respective integrated ERP system.

Prerequisites

Before you start the integration configuration, you must complete the following tasks.

• Add the following roles to the Integration user:

◦ Import_transformer

◦ SOAP

• Get the following details from the ERP team:

◦ ERP integration user credentials.

◦ SOAP or REST API details based on your ERP system and the type of web services you are 
using for the integration.

Note:  If the application needs to support multiple ERP instances, configure Source-to-Pay 
to integrate with each ERP instance separately.

ERP Source Configuration

To perform the ERP Source configuration for SAP, follow these steps:

1. Define the ERP source that you want to integrate with SAP integration.

2. Create a basic authentication profile that can be used for web service integration with SAP.
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3. Define source configuration for ERP source. The ERP source configuration determines the 
ERP source to which your ERP system connects. For more information, see Define ERP source 
configuration for SAP.

4. The integration services are preconfigured with the base system for the following entities:

◦ Currencies

Set up subflows for the source configuration to lookup currencies from SAP.

◦ Legal Entities

Set up subflows for the source configuration to lookup legal entities or company code details 
from SAP.

◦ FX Currency Rates

Set up subflows for the source configuration to lookup FX rates from SAP.

◦ Cost Centers

Set up subflows for the source configuration to lookup cost centers from SAP.

◦ Departments

Set up subflows for the source configuration to lookup departments from SAP.

◦ Payment Terms

Set up subflows for the source configuration to lookup payment terms from SAP.

◦ Purchasing Orgs

Set up subflows for the source configuration to lookup purchasing orgs from SAP.

◦ GL Accounts

Set up subflows for the source configuration to lookup GL accounts from SAP.

◦ Plant Addresses

Set up subflows for the source configuration to lookup plant addresses from SAP.

◦ Suppliers

Set up subflows for the source configuration to lookup suppliers from SAP.

◦ Product Models

Set up subflows for the source configuration to lookup product models from SAP.

◦ Invoices

Set up subflows for the source configuration to lookup invoices from SAP.

◦ Unit of Measure

Set up subflows for the source configuration to lookup the base unit of measure details from 
SAP.
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◦ Product Categories

Set up subflows for the source configuration to lookup material group details from SAP.

ERP Source Configuration of S4 HANA

Note:  Similarly, you can select SAP ECC configuration to view the list of services.

5. Configure a scheduled job to synchronize primary data updates from SAP.

6. Set the time interval in the lookup Cost Center scheduled job to periodically synchronize 
primary data updates from the ERP, for posting services to work.

Note:  Similarly, you can configure schedule jobs for the other integrations services.

You have configured the ERP source for SAP.

Define ERP source configuration for SAP

ERP source configuration determines the ERP source to which your ERP system connects. Map 
the integration payload with the SAP tables.

https://player.vimeo.com/video/1092942658?
h=96dd37817f&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin
Role required: sn_fcms_intg.admin

About this task
By default, the base system includes one ERP source named SAP, which refers to the parent 
connection for SAP. If there are multiple SAP instances, multiple ERP sources must be 
configured, and the child connections for these SAP instances should be referenced.

Each ERP instance requires a unique ERP source configuration. Therefore, 10 ERP instances 
need 10 configurations.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select one of the following ERP source configurations based on 
your requirement:
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◦ SAP ECC ERP

◦ SAP S4 HANA Cloud

◦ SAP S4 HANA OData

This configuration is available as a part of the base system.

3. To edit the ERP source, select here.

4. Select the required ERP source for the SAP ECC or SAP S4 HANA using the search option.

5. To create a new ERP source, perform the following steps:

a. Select New.

b. On the form, fill the fields.

Define a new ERP source configuration

Field Description

ERP Source ERP source for which the integration is 
required. For example, SAP ECC or SAP S4 
HANA.

Short Description Summary of the ERP source.

Active Option to activate the ERP source.

Amount Precisions Amount precision of the ERP source. For 
example, 2.

Define a new ERP source configuration for S4 HANA OData

c. Select Submit.
A new ERP source is created. Verify that the connection alias is also unique for each ERP 
source.

Note:  SAP integration can have multiple ERP sources. The Staging table displays the 
ERP source column, which you can use to distinguish which ERP the data belongs to.
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What to do next
By default, the SAP base system provides 14 integration services. For other SAP instances, you 
must perform the following:

• To modify each integration service, you can open the integration service and select here  to. 
You can define element level mapping between SAP table fields and payload elements.

• Map the users and corresponding ERP User IDs by accessing the ERP User Mappings related 
list.

Configure integration services for SAP

For configuring integration services, provide the connection end point and the SAP ERP 
credentials that you set up for your authentication profile. Also, create a separate integration 
service record for each service request that you want to customize.

https://player.vimeo.com/video/1121974947?
h=c47e0a87be&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin

• Verify that the application scope is set to SAP ECC and SAP S4 HANA spoke.

• Verify that the MID Server  is installed and configured in your ServiceNow  instance to connect 
to the ERP server. For more details, see Installing the MID Server .

• For REST type service, REST API details, as provided by ERP.

Role required: sn_fcms_intg.admin

About this task
If the application requires multiple SAP instances, create separate integration services 
for each ERP instance. You can create integration service records for entities using the 
sn_fcms_intg_service  table.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you need to configure integration services.
For example, SAP ECC or SAP S4 HANA.

3. In the Integration Services list, select the service that you want to configure.

Look up Legal Entities from SAP S4 HANA OData

4. To modify the Integration service record, select here.
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5. On the Integration service record, fill in the fields.

Integration service record

Field Description

Entity The type of entity for which you want to configure the 
integration service.

Application Name of the application. For example, SAP ECC or 
SAP S4 HANA.

ERP Source configuration The ERP source mapped to the entity. For example, 
SAP ECC or SAP S4 HANA.

Active The status of the interaction service. By default, the 
check box is inactive.

Subflow The subflow used to fetch primary data.

Properties
Creates a JSON record in the integration service, 
which is then passed to the ERP subflows to retrieve 
complete data.

You can define the value for the properties based on 
your requirements. Here’s an example:

◦ filter: currency eq 'USD'

◦ order_by: currencies

◦ select: currency

◦ page_size: 100

◦ Enabling Full Pull:

Use this property to fetch the complete data.

▪ Create a property named "full_pull" and set 
its value to true.

▪ Additionally, you can create another property like, 
"initial_load_start_date_time" and 
set its value to 2025-04-15T04:10:34.

◦ Enabling Delta Pull:

Use this property to fetch the incremental data.

Set the value of the "full_pull" property to 
false.

Order Option to choose the order in which the entity should 
be displayed.

6. Select Update  to save the configuration changes.
The integration service is configured for the selected entity.
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Look up primary data in SAP

You can run a job to look up primary data (for example, Currencies) from different ERP sources 
into ServiceNow.

Before you start the ERP integration, you must configure the integration services 
record for the target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating an integration service record, see Create Integration Service 
record.

Look up currencies in SAP

You can manually run jobs for the following entities:

Integration services available as a part of the base system for SAP

Entity Table name

Currencies FX Currency Stage inbound staging table

Legal entities Legal Entity Stage inbound staging table

FX Currency rates FX Rate Stage inbound staging table

Cost Centers Cost Center Stage inbound staging table

Departments Department Stage inbound staging table

Payment Terms Payment Terms Stage inbound staging table

Purchasing Organizations Purchase Entity Stage inbound staging table

GL Accounts GL Account Stage inbound staging table

Plant Addresses CMN Location Stage inbound staging table

Suppliers Supplier location inbound staging table

Product Models Product Model Stage inbound staging table

Invoices Invoice import inbound staging table

Unit of Measure Unit of Measure inbound staging table

Product Categories Product Model Stage inbound staging table
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Transformation maps and subflows

To learn more about the Transformation maps and subflows, see Source-to-Pay integration 
framework transform maps and subflows.

Manually execute flows or subflows in SAP (Inbound)

You can manually trigger flows or subflows in SAP on demand. Follow these steps to manually 
trigger a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select the SAP  ERP source to manually trigger the flows or 
subflows.
For example, SAP ECC, or SAP S4 HANA Cloud, or SAP HANA OData

3. In the Integration Services list, select the subflows that you want to manually trigger.

Manually trigger flows or subflows in SAP

4. Select Run job  to trigger the flow or subflow.

5. Navigate to All  > Process Automation  > Workflow Studio.

6. From the Workflow Studio home page, select the Operations  tab and then select Flows  tab.
The list of flow executions appear. You can look up the status of the flows or subflows that you 
triggered. If there were any errors during execution, you can view them under the processing 
message column.

7. Navigate back to the Homepage  tab, and select Flows  or Subflows.

8. Look up the Flow  or Subflow  name or SAP ECC  or SAP S4 HANA  application name using the 
filter icon, and select Apply.
You can view the flows or subflows that you triggered.
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Flows or subflows in Workflow Studio

9. You can use the trigger condition as a part of the base system to execute the flow or subflow.

Note:  Don’t modify the trigger condition.

The flow or subflow gets executed.

Scheduled jobs to look up primary data in SAP

You can schedule on-demand jobs to be run at specific intervals of time to fetch primary data 
from different SAP ERP sources into ServiceNow.

Before you start the SAP ERP integration, you must configure the integration services 
record for target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating a integration service record, see Configure integration services 
for SAP.

Run scheduled jobs in SAP

Run adhoc scheduled jobs to look up entity primary data from the target SAP ERP source.

Before you begin
Role required: sn_fcms_intg.admin
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About this task
Executes on-demand scheduled jobs on true entities of an ERP source target and fetches 
primary data. Auto-populates the entity inbound tables.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Select the ERP source for which you would like to run scheduled jobs.

3. Select Integration Services  >Run job.
The fetch services run automatically as scheduled.
Entity inbound tables are populated with primary data.

Use Source-to-Pay integration with SAP

Understand how you can use Source-to-Pay integration with SAP to handle sales orders, 
procurement, finance, and so on, in SAP from your ServiceNow instance.

Use schedule flows in SAP

Use the schedule flows that interact with SAP to pull information on purchase requisition, 
purchase order, receipt, invoice, and sourcing.

You can either use the subflows to perform the required tasks or you can create a copy of the 
subflows and then customize it according to your requirements.

Important: 

These subflows are read-only. To modify a flow or subflow, create a copy and then apply the 
required changes.

The Source-to-Pay with SAP integration supports the following subflows.

Primary Data Integration with SAP

The Primary Data Integration with SAP supports the following subflows and system properties:

Subflows for Primary Data Integration with SAP ECC

Scheduled subflow details for Primary Data Integration with SAP ECC

Subflow Description

Fetch Currencies Use this subflow to fetch and synchronize all 
currencies from SAP ECC system.

Fetch Legal Entities Use this subflow to fetch and synchronize all 
legal entities from SAP ECC system.

Fetch FX Currency Rates Use this subflow to fetch and synchronize all 
FX currency rates from SAP ECC system.

Fetch Cost Centers Use this subflow to fetch and synchronize all 
cost centers from SAP ECC system.

Fetch Departments Use this subflow to fetch and synchronize all 
departments from SAP ECC.

Fetch Payment Terms Use this subflow to fetch and synchronize all 
payment terms from SAP ECC system.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

228



Scheduled subflow details for Primary Data Integration with SAP ECC  (continued)

Subflow Description

Fetch Purchasing Orgs Use this subflow to fetch and synchronize 
all purchasing organizations from SAP ECC 
system.

Fetch GL Accounts Use this subflow to fetch and synchronize all 
GL accounts from SAP ECC system.

Fetch Product Models Use this subflow to fetch and synchronize all 
product models from SAP ECC system.

Fetch ServiceNow Product Models Use this subflow to fetch and synchronize all 
ServiceNow product models from SAP ECC 
system.

Fetch Plant Addresses Use this subflow to fetch plant addresses from 
SAP ECC system.

Fetch Suppliers Use this subflow to fetch and synchronize all 
suppliers from SAP ECC system.

System Properties for Primary Data Integration with SAP ECC

Use these system properties to configure settings for the Primary Data Integration with SAP ECC 
from the System Properties page. For more information, see Source-to-Pay integrations with SAP 
reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Primary Data Integration with SAP ECC

Property Name Description

sn_sap_data_int.cloud_base_unit_of_measure_service_subflowUse this subflow for fetching the base units of 
measure from SAP ECC system.

sn_sap_data_int.cloud_company_codes_service_subflowUse this subflow for fetching company codes 
from SAP ECC system.

sn_sap_data_int.cloud_cost_centers_service_subflowUse this subflow for fetching cost center data 
from SAP ECC system.

sn_sap_data_int.cloud_fetch_suppliers_service_subflowUse this subflow for fetching supplier details 
from SAP ECC system.

sn_sap_data_int.cloud_materials_service_subflowUse this subflow for fetching material data 
from SAP ECC system.

sn_sap_data_int.cloud_material_group_service_subflowUse this subflow for fetching material group 
information from SAP ECC system.

sn_sap_data_int.full_load_time_range_default Defines the default time range for full data 
loads.

sn_sap_data_int.odata_base_unit_of_measure_service_subflowUse this subflow for fetching base unit of 
measure data using OData service.
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System Properties for Primary Data Integration with SAP ECC  (continued)

Property Name Description

sn_sap_data_int.odata_cost_centers_service_subflowUse this subflow for fetching cost center 
details using OData service.

sn_sap_data_int.odata_currencies_service_subflowUse this subflow for syncing currency 
information using OData service.

sn_sap_data_int.odata_fx_rate_service_subflow Use this subflow for fetching foreign exchange 
rates using OData service.

sn_sap_data_int.odata_gl_account_service_subflowUse this subflow for fetching general ledger 
account data using OData service.

sn_sap_data_int.odata_legal_entities_service_subflowUse this subflow for fetching legal entity 
details using OData service.

sn_sap_data_int.odata_materials_service_subflowUse this subflow for fetching materials data 
using OData service.

sn_sap_data_int.odata_material_group_service_subflowUse this subflow for fetching material group 
details using OData service.

sn_sap_data_int.odata_payment_terms_service_subflowUse this subflow for fetching payment terms 
information using OData service.

sn_sap_data_int.odata_plant_addresses_service_subflowUse this subflow for retrieving plant address 
details using OData service.

sn_sap_data_int.odata_purchasing_group_service_subflowUse this subflow for fetching purchasing group 
data using OData service.

sn_sap_data_int.odata_purchasing_organizations_service_subflowUse this subflow for fetching purchasing 
organization details using OData service.

sn_sap_data_int.odata_suppliers_service_subflowUse this subflow for fetching supplier 
information through OData service.

sn_sap_data_int.Subflow.Resume.Count Track the number of times a subflow resumes 
execution.

Default value: 30

sn_sap_data_int.subflow_timeout_value Maximum timeout duration (in milliseconds) 
for subflow execution.

Default value: 10000000

Subflows for Primary Data Integration with SAP S4 HANA Cloud

Scheduled subflow details for Primary Data Integration with SAP S4 HANA Cloud

Subflow Description

Fetch Legal Entities Use this subflow to fetch and synchronize 
all legal entities from SAP S4 HANA Cloud 
system.
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Scheduled subflow details for Primary Data Integration with SAP S4 HANA Cloud 
(continued)

Subflow Description

Fetch Cost Centers Use this subflow to fetch and synchronize all 
cost centers from SAP S4 HANA Cloud system.

Fetch GL Accounts Use this subflow to fetch and synchronize 
all GL accounts from SAP S4 HANA Cloud 
system.

Fetch Suppliers Use this subflow to fetch and synchronize all 
supplier details from SAP S4 HANA Cloud 
system.

Fetch Product Models Use this subflow to fetch and synchronize all 
product models from SAP S4 HANA Cloud 
system.

Fetch Units of Measure Use this subflow to fetch base unit of measure 
from SAP S4 HANA Cloud system.

Fetch Product Categories Use this subflow to fetch and synchronize all 
product categories from SAP S4 HANA Cloud 
system.

System Properties for Primary Data Integration with SAP S4 HANA Cloud

Use these system properties to configure settings for the Primary Data Integration with SAP 
S4 HANA Cloud from the System Properties page. For more information, see Source-to-Pay 
integrations with SAP reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Primary Data Integration with SAP S4 HANA Cloud

Property Name Description

sn_sap_data_int.cloud_base_unit_of_measure_service_subflowUse this subflow for fetching the base units of 
measure from SAP S4 HANA Cloud system.

sn_sap_data_int.cloud_company_codes_service_subflowUse this subflow for fetching company codes 
from SAP S4 HANA Cloud system.

sn_sap_data_int.cloud_cost_centers_service_subflowUse this subflow for fetching cost center data 
from SAP S4 HANA Cloud system.

sn_sap_data_int.cloud_fetch_suppliers_service_subflowUse this subflow for fetching supplier details 
from SAP S4 HANA Cloud system.

sn_sap_data_int.cloud_materials_service_subflowUse this subflow for fetching material data 
from SAP S4 HANA Cloud system.

sn_sap_data_int.cloud_material_group_service_subflowUse this subflow for fetching material group 
information from SAP S4 HANA Cloud system.
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System Properties for Primary Data Integration with SAP S4 HANA Cloud  (continued)

Property Name Description

sn_sap_data_int.full_load_time_range_default Defines the default time range for full data 
loads.

sn_sap_data_int.odata_base_unit_of_measure_service_subflowUse this subflow for fetching base unit of 
measure data using OData service.

sn_sap_data_int.odata_cost_centers_service_subflowUse this subflow for fetching cost center 
details using OData service.

sn_sap_data_int.odata_currencies_service_subflowUse this subflow for syncing currency 
information using OData service.

sn_sap_data_int.odata_fx_rate_service_subflow Use this subflow for fetching foreign exchange 
rates using OData service.

sn_sap_data_int.odata_gl_account_service_subflowUse this subflow for fetching general ledger 
account data using OData service.

sn_sap_data_int.odata_legal_entities_service_subflowUse this subflow for fetching legal entity 
details using OData service.

sn_sap_data_int.odata_materials_service_subflowUse this subflow for fetching materials data 
using OData service.

sn_sap_data_int.odata_material_group_service_subflowUse this subflow for fetching material group 
details using OData service.

sn_sap_data_int.odata_payment_terms_service_subflowUse this subflow for fetching payment terms 
information using OData service.

sn_sap_data_int.odata_plant_addresses_service_subflowUse this subflow for retrieving plant address 
details using OData service.

sn_sap_data_int.odata_purchasing_group_service_subflowUse this subflow for fetching purchasing group 
data using OData service.

sn_sap_data_int.odata_purchasing_organizations_service_subflowUse this subflow for fetching purchasing 
organization details using OData service.

sn_sap_data_int.odata_suppliers_service_subflowUse this subflow for fetching supplier 
information through OData service.

sn_sap_data_int.Subflow.Resume.Count Track the number of times a subflow resumes 
execution.

Default value: 30

sn_sap_data_int.subflow_timeout_value Maximum timeout duration (in milliseconds) 
for subflow execution.

Default value: 10000000

Subflows for Primary Data Integration with SAP S4 HANA OData
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Scheduled subflow details for Primary Data Integration with SAP S4 HANA OData

Subflow Description

Fetch Currencies Use this subflow to fetch and synchronize all 
Currencies from SAP S4 HANA OData system.

Fetch Legal Entities Use this subflow to fetch and synchronize 
all legal entities from SAP S4 HANA OData 
system.

Fetch FX Currency Rates Use this subflow to fetch and synchronize all 
FX rates from SAP S4 HANA OData system.

Fetch Cost Centers Use this subflow to fetch and synchronize 
all cost centers from SAP S4 HANA OData 
system.

Fetch Departments Use this subflow to fetch and synchronize 
all departments from SAP S4 HANA OData 
system.

Fetch Payment Terms Use this subflow to fetch and synchronize all 
payment terms from SAP S4 HANA OData 
system.

Fetch Purchasing Orgs Use this subflow to fetch and synchronize all 
Purchasing Organizations from SAP S4 HANA 
OData system.

Fetch GL Accounts Use this subflow to fetch and synchronize 
all GL accounts from SAP S4 HANA OData 
system.

Fetch Plant Addresses Use this subflow to Fetch Plant Addresses 
from SAP S4 HANA OData system.

Fetch Suppliers Use this subflow to fetch and synchronize all 
supplier details from SAP S4 HANA OData 
system.

Fetch Product Models Use this subflow to fetch and synchronize all 
product models from SAP S4 HANA Cloud 
system.

Fetch Units of Measure Use this subflow to fetch base unit of measure 
from SAP S4 HANA Cloud system.

Fetch Product Categories Use this subflow to fetch and synchronize all 
product categories from SAP S4 HANA Cloud 
system.

System Properties for Primary Data Integration with SAP S4 HANA OData

Use these system properties to configure settings for the Primary Data Integration with SAP 
S4 HANA OData from the System Properties page. For more information, see Source-to-Pay 
integrations with SAP reference.

Role required:
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• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Primary Data Integration with SAP S4 HANA OData

Property Name Description

sn_sap_data_int.cloud_base_unit_of_measure_service_subflowUse this subflow for fetching the base units of 
measure from SAP S4 HANA OData system.

sn_sap_data_int.cloud_company_codes_service_subflowUse this subflow for fetching company codes 
from SAP S4 HANA OData system.

sn_sap_data_int.cloud_cost_centers_service_subflowUse this subflow for fetching cost center data 
from SAP S4 HANA OData system.

sn_sap_data_int.cloud_fetch_suppliers_service_subflowUse this subflow for fetching supplier details 
from SAP S4 HANA OData system.

sn_sap_data_int.cloud_materials_service_subflowUse this subflow for fetching material data 
from SAP S4 HANA OData system.

sn_sap_data_int.cloud_material_group_service_subflowUse this subflow for fetching material group 
information from SAP S4 HANA OData system.

sn_sap_data_int.full_load_time_range_default Defines the default time range for full data 
loads.

sn_sap_data_int.odata_base_unit_of_measure_service_subflowUse this subflow for fetching base unit of 
measure data using OData service.

sn_sap_data_int.odata_cost_centers_service_subflowUse this subflow for fetching cost center 
details using OData service.

sn_sap_data_int.odata_currencies_service_subflowUse this subflow for syncing currency 
information using OData service.

sn_sap_data_int.odata_fx_rate_service_subflow Use this subflow for fetching foreign exchange 
rates using OData service.

sn_sap_data_int.odata_gl_account_service_subflowUse this subflow for fetching general ledger 
account data using OData service.

sn_sap_data_int.odata_legal_entities_service_subflowUse this subflow for fetching legal entity 
details using OData service.

sn_sap_data_int.odata_materials_service_subflowUse this subflow for fetching materials data 
using OData service.

sn_sap_data_int.odata_material_group_service_subflowUse this subflow for fetching material group 
details using OData service.

sn_sap_data_int.odata_payment_terms_service_subflowUse this subflow for fetching payment terms 
information using OData service.

sn_sap_data_int.odata_plant_addresses_service_subflowUse this subflow for retrieving plant address 
details using OData service.

sn_sap_data_int.odata_purchasing_group_service_subflowUse this subflow for fetching purchasing group 
data using OData service.

sn_sap_data_int.odata_purchasing_organizations_service_subflowUse this subflow for fetching purchasing 
organization details using OData service.
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System Properties for Primary Data Integration with SAP S4 HANA OData  (continued)

Property Name Description

sn_sap_data_int.odata_suppliers_service_subflowUse this subflow for fetching supplier 
information through OData service.

sn_sap_data_int.Subflow.Resume.Count Track the number of times a subflow resumes 
execution.

Default value: 30

sn_sap_data_int.subflow_timeout_value Maximum timeout duration (in milliseconds) 
for subflow execution.

Default value: 10000000

Supplier Lifecycle Operations Integration with SAP

The Supplier Lifecycle Operations Integration with SAP supports the following subflows:

Subflows for Supplier Lifecycle Operations Integration with SAP ECC

Scheduled subflow details for Supplier Lifecycle Operations Integration with SAP ECC

Flow Description

Create or update supplier Creates or updates or deactivates suppliers in 
SAP ECC.

Deactivate supplier bank details Deactivates the supplier bank details in SAP 
ECC.

Create or update supplier payment 
information

Creates or updates supplier payment 
information in SAP ECC.

Subflows for Supplier Lifecycle Operations Integration with SAP S4 HANA OData

Scheduled subflow details for Supplier Lifecycle Operations Integration with SAP S4 HANA 
OData

Flow Description

Create or update supplier Creates or updates or deactivates suppliers in 
SAP S4 HANA OData.

Deactivate supplier bank details Deactivates the supplier bank details in SAP 
S4 HANA OData.

Create or update supplier payment 
information

Creates or updates supplier payment 
information in SAP S4 HANA OData.

Sourcing and Procurement Operations Integration with SAP

The Sourcing and Procurement Operations Integration with SAP supports the following subflows:

Subflows for Sourcing and Procurement Operations Integration with SAP ECC
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Scheduled subflow details for Sourcing and Procurement Operations integration with SAP 
ECC

Flow Description

Create or update Purchase Order Creates or updates purchase orders in SAP 
ECC.

Create Goods Receipts Creates goods receipts in SAP ECC.

Cancel Goods Receipts Cancels goods receipts in SAP ECC.

Fetch Purchase Order Fetches and synchronize all purchase orders 
from SAP ECC.

Fetch Goods Receipts Fetches and synchronize all goods receipts 
from SAP ECC.

Subflows for Sourcing and Procurement Operations Integration with SAP S4 HANA OData

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

Scheduled subflow details for Sourcing and Procurement Operations integration with SAP 
S4 HANA OData

Flow Description

Create or update Purchase Order Creates or updates purchase orders in SAP S4 
HANA OData.

Create Goods Receipts Creates goods receipts in SAP S4 HANA 
OData.

Cancel Goods Receipts Cancels goods receipts in SAP S4 HANA 
OData.

Fetch Purchase Order Fetches and synchronize all purchase orders 
from SAP S4 HANA OData system.

Fetch Goods Receipts Fetches and synchronize all goods receipts 
from SAP S4 HANA OData system.

System Properties for Sourcing and Procurement Operations Integration with SAP

Use these system properties to configure settings for the Sourcing and Procurement Operations 
Integration with SAP from the System Properties page. For more information, see Source-to-Pay 
integrations with SAP reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin
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System Properties for Sourcing and Procurement Operations Integration with SAP

Property Name Description

sn_psm_sap_int.should_transactions_flow_through_idocIndicates whether procurement transactions 
should be processed through SAP IDoc 
integration.

sn_psm_sap_int.status_for_goods_receipt Current status of goods receipt in the 
procurement process.

sn_psm_sap_int.status_for_purchase_order Current status of a purchase order within the 
SAP-integrated procurement workflow

Accounts Payable Operations Integration with SAP

The Accounts Payable Operations Integration with SAP supports the following subflows:

Accounts Payable Operations Integration with SAP ECC

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

Scheduled subflow details for Accounts Payable Operations Integration with SAP ECC

Flow Description

Create Invoice Creates invoices in SAP ECC.

Create Non-Purchase Order Invoice Create non-purchase order Invoices in SAP 
ECC.

Authorize Payment Authorizes and releases payment for supplier 
invoice in SAP ECC.

Fetch Invoice Fetches and synchronize all invoices from the 
SAP ECC system.

Accounts Payable Operations Integration with SAP S4 HANA OData

Scheduled subflow details for Accounts Payable Operations Integration with SAP S4 HANA 
OData

Flow Description

Create Invoice Creates invoices in SAP S4 HANA OData.

Create Non-Purchase Order Invoice Create non-purchase order Invoices in SAP S4 
HANA OData.

Authorize Payment Authorizes and releases payment for supplier 
invoice in SAP S4 HANA OData.

Fetch Invoice Fetches and synchronize all invoices from the 
SAP S4 HANA OData system.
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System Properties for Accounts Payable Operations Integration with SAP

Use these system properties to configure settings for the Accounts Payable Operations 
Integration with SAP from the System Properties page. For more information, see Source-to-Pay 
integrations with SAP reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Accounts Payable Operations Integration with SAP

Property Name Description

sn_apm_sap_int.cloud_invoices_service_subflowSpecifies the subflow used to fetch invoice 
data from the Cloud-based SAP service.

sn_apm_sap_int.odata_invoices_service_subflowDefines the subflow responsible for fetching 
invoices via SAP OData services.

Use a flow or subflow in SAP (Outbound)

A flow or subflow can be executed in SAP using the Workflow Studio. Follow these steps to run a 
flow or subflow.

Before you begin
Role required:

• sn_fcms_intg.admin - Write role

• sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin - Read role

About this task

https://player.vimeo.com/video/1121974926?
h=1751b72860&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Look up the Flow  name or SAP  application name using the filter icon, and select Apply.
For example, SAP ECC, or SAP S4 HANA Cloud, or SAP HANA OData

4. Select the required flow from the list.

For example, select Create non-purchase order invoice  flow.
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Create non-purchase order invoice flow

5. In the Trigger field, specify the time and interval at which you want to run the scheduled flow 
automatically.

This flow subsequently triggers subflows to automate tasks. To customize the sample flow, 
copy it to the desired application scope.

Note:  Don’t modify the trigger condition.

The flow or subflow gets executed.

Copy a flow or subflow in SAP

You can create a copy of the flow or subflow and make the necessary modifications. Use the 
following steps to activate a flow or subflow.

Before you begin
Role required:

• sn_fcms_intg.admin - Write role

• sn_fcms_intg.admin - Read role

• sn_shop.procurement_specialist, sn_shop.shopper - Users

About this task

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Open the flow that you want to copy.

4. Select the  more actions icon, and select Copy flow.

Important:  Perform this step only if you plan to customize or make specific changes to 
the flow.
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Copy of a Create non-purchase order flow

5. Activate the flow or subflow.

◦ Make sure that the flow or subflow is available and activated on the base system.

◦ Activate the copied flow after making the required changes.

6. Use the Trigger Condition  for the flow or subflow.

This flow or subflow is triggered and associated with the purchase order when the following 
conditions are met:

◦ Legal entity . ERP source . Active  is true.

◦ Legal entity . ERP source . ERP Source  is not empty.

◦ Status  is Pending Submission

Note:  Don’t modify the trigger condition.

Trigger conditions for Creating a non-purchase order invoice flow
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Note: 

Once data is pulled into staging tables, transform maps move data into target tables. For 
more details, refer to Source-to-Pay integration framework transform maps and subflows.

You have successfully copied and executed the flow.

Source-to-Pay integrations with SAP reference

Reference topics provide additional information on integrating Source-to-Pay Operations  with 
SAP integrations, including primary data, fixed assets, purchase orders, receipts, invoices, and 
tax integration between Source-to-Pay and ERP systems.

Set system properties for SAP Integrations

Use these system properties to configure settings for the SAP ECC, S4 HANA Cloud, and S4 
HANA OData integrations from the System Properties page.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

To access the system properties list, perform the following steps:

1. Navigate to All.

2. Search for sys_properties_list.do  and open the system properties list.

3. Look up Primary Data Integration with SAP using the filter option.

4. The following system properties are available as a part of the base system.

Note:  You can modify these values only if necessary.

Source-to-Pay Integration with 3CLogic

Integrating Source-to-Pay Operations with 3CLogic provides omnichannel experience and self-
service features.

The Source-to-Pay Integration with 3CLogic Cloud Contact Center solution provides the following 
benefits:

• Enhance the end-user experience with voice and SMS capabilities

• Provide an omnichannel experience for end users to request and receive help

• Personalize end-user interactions while resolving inquiries quickly

For more information, see 3CLogic Cloud Call Center for ServiceNow Voice .

Source-to-Pay integration with Oracle EBS

The Source-to-Pay integration with Oracle EBS enables you to handle sales orders, procurement, 
finance, and so on, in Oracle EBS from your ServiceNow instance.

Key features

With this application, you can perform the following:
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• Integration hub actions for invoices, cost centers, product models, payment terms, purchasing 
organizations, departments, GL accounts, currencies, FX rates, invoice payment details, 
suppliers, plant addresses, and legal entities.

• Create or update purchase orders in Oracle EBS.

• Cancel purchase orders in Oracle EBS.

• Create good receipts in Oracle EBS.

• Create invoices in Oracle EBS.

Overview of the Source-to-Pay integration with Oracle EBS

Prerequisites

First, you must activate the Source-to-Pay integration with the Oracle EBS application from the 
ServiceNow Store. This automatically activates the Oracle EBS Spoke. Next you must set up 
Oracle EBS Spoke .

ServiceNow Store app plugins: sn_Oracle EBS_spoke.

Note:  The Source-to-Pay integration with Oracle EBS depends on the Oracle EBS Spoke .

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

How it works

The subflows enable a plug-and-play experience for the integration scenarios. Integration Hub 
Actions provide the building blocks for Source-to-Pay subflows and connects to the Oracle EBS 
system through REST APIs.

Configure the Source-to-Pay integration with Oracle EBS

Integrate the ServiceNow instance and Oracle EBS by creating a custom OAuth application in 
Oracle EBS to authenticate ServiceNow requests.

Application set up

Verify that you have performed the following:
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• Activated the Source-to-Pay integration with the Oracle EBS application from ServiceNow 
Store. This automatically activates the Oracle EBS Spoke.

• Set up Oracle EBS Spoke .

• Activated the Source-to-Pay integration framework from ServiceNow Store. Source-to-Pay 
integration with Oracle EBS uses the Source-to-Pay integration framework to pull tasks from 
Oracle EBS into ServiceNow. For more information on the Source-to-Pay integration framework, 
see Source-to-Pay integration framework.

Primary Data Integration with Oracle EBS's Dependencies

Install the following dependencies of Primary Data integration with Oracle EBS. When you install 
the plugin, all the dependencies get installed automatically. All primary data are synchronized 
based on the configurable scheduled job Fetch Spend Primary Data.

Run the Trigger Oracle EBS Integration that pulls tasks into ServiceNow. For more information, 
see Use schedule flows in Oracle EBS.

Primary Data Integration with Oracle EBS

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

Supplier Common Architecture sn_slm

EBS Spoke sn_oracle_ebs_spk

Supplier Lifecycle Operations Integration Dependencies with Oracle EBS

Install the following dependencies of Supplier Lifecycle Operations integration with Oracle EBS. 
When you install the plugin, all the dependencies get installed automatically.

Supplier Lifecycle Operations Integration with Oracle EBS

App name Plugin ID

Primary Data Integration with Oracle EBS sn_orcl_data_int

Source-to-Pay Integration Framework sn_spend_intg

Sourcing and Procurement Operations Integration Dependencies with Oracle 
EBS

Install the following dependencies of Sourcing and Procurement Operations integration with 
Oracle EBS. When you install the plugin, all the dependencies get installed automatically.

Sourcing and Procurement Operations Integration with Oracle EBS

App name Plugin ID

Primary Data Integration with Oracle EBS sn_orcl_data_int

Sourcing and Purchasing Automation sn_pr
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Sourcing and Procurement Operations Integration with Oracle EBS  (continued)

App name Plugin ID

Source-to-Pay Integration Framework sn_spend_intg

Accounts Payable Operations Integration Dependencies with Oracle EBS

Install the following dependencies of Accounts Payable Operations integration with Oracle EBS. 
When you install the plugin, all the dependencies get installed automatically.

Accounts Payable Operations Integration with Oracle EBS

App name Plugin ID

Primary Data Integration with Oracle EBS sn_orcl_data_int

Accounts Payable Invoice Processing sn_ap_apm

Source-to-Pay Integration Framework sn_spend_intg

ERP source configuration for Oracle EBS

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to automatically post purchase 
order, receipt, invoice, and download primary data from the ERP.

ERP source configuration enables the implementation of specific logic to populate values 
pertinent to third-party ERP systems. It includes all service mappings defined between Source-
to-Pay (S2P) and the third-party ERP system. In cases where multiple ERP sources exist, they’re 
stored as distinct ERP source entries with their corresponding service mappings.

To meet specific requirements, you can modify the service-mapping logic by updating the 
relevant service element map entry within the service map record. For organizations using 
multiple ERP systems, an ERP Source field has been incorporated into the tables to ensure 
accurate identification of the respective integrated ERP system.

The ERP source configuration for Oracle EBS enables customers to establish multiple Oracle 
instances. Each instance is identified by a distinct source, and the connection alias for each 
instance must be unique.

Prerequisites

Before you start the integration configuration, you must complete the following tasks.

• Add the following roles to the Integration user:

◦ Import_transformer

◦ SOAP

• Get the following details from the ERP team:

◦ ERP integration user credentials.

◦ SOAP or REST API details based on your ERP system and the type of web services you’re 
using for the integration.

Note:  If the application must support multiple ERP instances, configure Source-to-Pay to 
integrate with each ERP instance separately.
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ERP Source Configuration

To perform the ERP Source configuration for Oracle EBS, follow these steps:

1. Define the ERP source that you want to integrate with Oracle EBS integration.

2. Create a basic authentication profile that can be used for web service integration with Oracle 
EBS.

3. Register the Oracle EBS integration username and password to create the authentication 
profile and associate it to service maps.

4. Define source configuration for ERP source. The ERP source configuration determines the 
ERP source to which your ERP system connects. For more information, see Define ERP source 
configuration for Oracle EBS.

5. Configure service maps for the following entities:

◦ Cost Centers

Set up subflows for the source configuration to lookup cost centers from Oracle EBS.

◦ Product Models

Set up subflows for the source configuration to lookup product models from Oracle EBS.

◦ Payment Terms

Set up subflows for the source configuration to lookup payment terms from Oracle EBS.

◦ Purchasing Orgs

Set up subflows for the source configuration to lookup purchasing orgs from Oracle EBS.

◦ Departments

Set up subflows for the source configuration to lookup departments from Oracle EBS.

◦ GL Accounts

Set up subflows for the source configuration to lookup GL accounts from Oracle EBS.

◦ Currencies

Set up subflows for the source configuration to lookup currencies from Oracle EBS.

◦ FX Currency Rates

Set up subflows for the source configuration to lookup FX rates from Oracle EBS.

◦ Invoice Payment Details

Set up subflows for the source configuration to lookup invoice payment details from Oracle 
EBS.

◦ Suppliers

Set up subflows for the source configuration to lookup suppliers from Oracle EBS.

◦ Plant Addresses

Set up subflows for the source configuration to lookup plant addresses from Oracle EBS.

◦ Legal Entities
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Set up subflows for the source configuration to lookup legal entities or company code details 
from Oracle EBS.

◦ Invoices

Set up subflows for the source configuration to lookup invoices from Oracle EBS.

ERP Source Configuration of Oracle EBS

6. Configure a scheduled job to synchronize primary data updates from Oracle EBS.

7. Set up the interval in the lookup Cost Center scheduled job to periodically synchronize primary 
data updates from the ERP, for posting services to work.

Note:  Similarly, you can configure schedule jobs for the other integrations services.

8. Load data to the Oracle EBS user-mapping table.

9. Set up Source-to-Pay and ERP User ID mapping (sn_fcms_intg_erp_user_map)  for the 
integration to work.

The mapping is maintained for all active users who have the procurement buyer role in ERP. 
These users should be used in the requisition assignment rule.

You have configured the ERP source for Oracle EBS.

Define ERP source configuration for Oracle EBS

ERP source configuration determines the ERP source to which your ERP system connects. Map 
the integration payload with the Oracle EBS tables.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
By default, the base system includes one ERP source named Oracle EBS, which refers to the 
parent connection for Oracle EBS. If there are multiple Oracle EBS instances, multiple ERP 
sources must be configured, and the child connections for these Oracle EBS instances should 
be referenced.
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Each ERP instance requires a unique ERP source configuration. Therefore, 10 ERP instances 
need 10 configurations.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select Oracle EBS.

This configuration is available as a part of the base system.

3. To edit the ERP source, select here.

4. Select the required ERP source for the Oracle EBS using the search option.

5. To create a new ERP source, perform the following steps:

a. Select New.

b. On the form, fill the fields.

Define a new ERP source configuration

Field Description

ERP Source ERP source for which the integration is 
required. For example, Oracle EBS.

Short Description Summary of the ERP source.

Active Option to activate the ERP source.

Amount Precisions Amount precision of the ERP source. For 
example, 2.

Define a new ERP source configuration for Oracle EBS

c. Select Submit.
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A new ERP source is created. Verify that the connection alias is also unique for each ERP 
source.

Note:  Oracle EBS integration can have multiple ERP sources. The Staging table 
displays the ERP source column, which you can use to distinguish which ERP the data 
belongs to.

What to do next
By default, the Oracle EBS base system provides 13 service mappings. For other Oracle EBS 
instances, you need to perform the following:

• Define service mappings manually for each integration service by accessing the Service 
Mappings related list. You can define element level mapping between Oracle EBS table fields 
and payload elements.

• Map the users and corresponding ERP User IDs by accessing the ERP User Mappings related 
list.

Configure integration services for Oracle EBS

For configuring integration services, provide the connection end point and the Oracle EBS ERP 
credentials that you set up for your authentication profile. Also, create a separate web service 
record for each service request that you want to customize.

https://player.vimeo.com/video/1100184497?
h=f5b16fc19b&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin

• Verify that the application scope is set to Oracle EBS spoke.

• Verify that the MID Server  is installed and configured in your ServiceNow  instance to connect 
to the ERP server. For more details, see Installing the MID Server .

Note:  The MID Server integration is required only for an Oracle EBS ERP integration 
using SOAP services.

• For REST type service, REST API details, as provided by ERP.

Role required: sn_fcms_intg.integration_user

About this task
If the application requires multiple Oracle EBS ERP instances, create separate web services 
for each ERP instance. You can create Integration Service records for entities using the 
sn_fcms_intg_service  table.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you need to configure integration services.
For example, Oracle EBS.

3. In the Integration Services list, select the service that you want to configure.
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Look up Legal Entities from Oracle EBS

4. On the integration service record, fill in the fields.

Integration service record

Field Description

Entity The type of entity for which you want to configure the 
integration services.

Application Name of the application. For example, Oracle EBS.

ERP Source configuration The ERP source mapped to the entity. For example, 
Oracle EBS.

Active The status of the interaction service. By default, the 
check box is inactive.

Subflow The subflow used to fetch primary data.

Properties
Creates a JSON record in the integration service, 
which is then passed to the ERP subflows to retrieve 
complete data.

To pass JSON into the subflow, create a property 
named "query" and assign it a JSON query as its 
value, like this:

[
  {
    "parameter": 
 "LEGAL_ENTITY_NAME",
    "operator": "=",
    "value": "Vision ADB",
    "operand": "NONE"
  }
]

◦ Enabling Full Pull:

Use this property to fetch the complete data.
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Field Description

▪ Create a property named "full_pull" and set 
its value to true.

▪ Additionally, you can create another property like, 
"initial_load_start_date_time" and 
set its value to 2025-02-15T04:10:34.

◦ Enabling Delta Pull:

Use this property to fetch the incremental data.

Set the value of the "full_pull" property to 
false.

Order Option to choose the order in which the entity should 
be displayed.

5. Select Update.
The integration service is configured for the selected entity.

Load data to ERP user-mapping table for Oracle EBS

Set up Oracle EBS and ERP User ID mapping for the integration to work. The mapping is 
maintained for all active users who have the procurement buyer role in ERP. These users should 
be used in the requisition assignment rule.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. Select Create table  and enter a label for the new table in the Label  field.

3. In the Source of the import  field, select the File  option.

4. Select Choose File  to import the source Excel spreadsheet.

Load data to ERP user-mapping table for Oracle EBS

5. Optional:  If appropriate, specify the Work sheet and Header row number.

6. Select Submit.
The imported data is now available in the new Import Set table.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

250



7. Create a transform map  to define the field mapping between columns of the import set and 
columns of the target ERP User Mapping [sn_fcms_intg_erp_user_map] table.
The ERP User Mapping table maintains mapping between ERP user IDs and ServiceNow  user 
IDs.

8. Transform the data from the import set table to the target table.
For more information, see Run an import .
The data is imported into the Oracle EBS ERP User Mapping 
(sn_fcms_intg_erp_user_map)  table.

What to do next
Verify that the data records are imported into the target table. You can view the Oracle EBS ERP 
user mappings by navigating to Finance - ERP Integration  > ERP Users.

Note:  If an ERP user mapping isn’t required, you can deactivate it. To deactivate a 
mapping, in the ERP User Mapping form, select the Inactive  check box.

Look up primary data in Oracle EBS

You can run a job to look up primary data from different ERP sources into ServiceNow.

Before you start the ERP integration, you must configure the integration services 
record for the target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating an integration service record, see Create Integration Service 
record.

Look up primary data in Oracle EBS

You can manually run jobs for the following entities:

Look up primary data in Oracle EBS

Entity Description Table name

Cost Centers Lookup cost centers from 
Oracle EBS

Cost Center Stage inbound 
staging table

Product Models Lookup product models from 
Oracle EBS.

Product Model Stage inbound 
staging table

Payment Terms Lookup payment terms from 
Oracle EBS.

Payment Terms Stage 
inbound staging table
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Look up primary data in Oracle EBS  (continued)

Entity Description Table name

Purchasing Orgs Lookup purchasing orgs from 
Oracle EBS.

Purchase Entity Stage 
inbound staging table

Departments Lookup departments from 
Oracle EBS.

Department Stage inbound 
staging table

GL Accounts Lookup GL accounts from 
Oracle EBS.

GL Account Stage inbound 
staging table

Currencies Lookup currencies from Oracle 
EBS.

FX Currency Stage inbound 
staging table

FX Currency rates Lookup FX rates from Oracle 
EBS.

FX Rate Stage inbound 
staging table

Invoice Payment Details Lookup invoice payment details 
from Oracle EBS.

Invoice payment detail import 
inbound table

Suppliers Lookup suppliers from Oracle 
EBS.

Supplier location inbound 
staging table

Plant addresses Lookup plant addresses from 
Oracle EBS.

CMN Location Stage inbound 
staging table

Legal entities Lookup legal entities from 
Oracle EBS.

Legal Entity Stage inbound 
staging table

Invoices Lookup invoices from Oracle 
EBS.

Invoice import inbound 
staging table

Transformation maps and subflows

To learn more about the Transformation maps and subflows, see Source-to-Pay integration 
framework transform maps and subflows.

Scheduled jobs to look up primary data in Oracle EBS

You can schedule on-demand jobs to be run at specific intervals of time to fetch primary data 
from different Oracle EBS ERP sources into ServiceNow.

Before you start the Oracle EBS ERP integration, you must configure the integration 
services record for target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating an integration service record, see Create Integration Service 
record.

Scheduled jobs are configured for entities using scripts. Example: Fetch cost center from ERP 
systems. For more information on configuring scheduled jobs using scripts, see Automatically 
run a script of your choosing . The script invokes a subflow, which is associated with an entity as 
shown in the following figure. The subflow queries the active entities or ERP source configuration 
(optional) listed in the integration service table.
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Run scheduled jobs in Oracle EBS

Run adhoc scheduled jobs to look up entity primary data from the target Oracle EBS ERP source.

Before you begin
Role required: sn_fcms_intg.integration_user

About this task
Executes on-demand scheduled jobs on true entities of an ERP source target and fetches 
primary data. Auto-populates the entity inbound tables.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Select the ERP source for which you would like to run scheduled jobs.

3. Select Integration Services  >Run job.
The fetch services run automatically as scheduled.
Entity inbound tables are populated with primary data.

Use Source-to-Pay integration with Oracle EBS

Learn how you can use Source-to-Pay integration with Oracle EBS to handle sales orders, 
procurement, finance, and so on, in Oracle EBS from your ServiceNow instance.

Use schedule flows in Oracle EBS

Use the schedule flows to retrieve information from Oracle EBS, including invoices, cost 
centers, product models, payment terms, purchasing organizations, departments, GL accounts, 
currencies, FX rates, invoice payment details, suppliers, plant addresses, and legal entities.

You can either use the subflows to perform the required tasks or you can create a copy of the 
subflows and then customize it according to your requirements.

Important: 

These subflows are read-only. To modify a flow or subflow, create a copy and then apply the 
required changes.

The Source-to-Pay with Oracle EBS integration supports the following subflows.

Primary Data Integration with Oracle

The Primary Data Integration with Oracle supports the following subflows and system properties:

Subflows for Primary Data Integration with Oracle
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Scheduled subflow details for Primary Data Integration with Oracle

Subflow Description

Fetch Cost Centers Use this subflow to lookup cost centers from 
Oracle EBS.

Fetch Product Models Use this subflow to lookup product models 
from Oracle EBS.

Fetch Payment Terms Use this subflow to lookup payment terms from 
Oracle EBS.

Fetch Purchasing Orgs Use this subflow to lookup purchasing orgs 
from Oracle EBS.

Fetch Departments Use this subflow to lookup departments from 
Oracle EBS.

Fetch GL Accounts Use this subflow to lookup GL accounts from 
Oracle EBS.

Fetch Currencies Use this subflow to lookup currencies from 
Oracle EBS.

Fetch FX Currency Rates Use this subflow to lookup FX rates from 
Oracle EBS.

Fetch Invoice Payment Details Use this subflow to lookup invoice payment 
details from Oracle EBS.

Fetch Suppliers Use this subflow to lookup suppliers from 
Oracle EBS.

Fetch Plant Addresses Use this subflow to lookup plant addresses 
from Oracle EBS.

Fetch Legal Entities Use this subflow to lookup legal entities or 
company code details from Oracle EBS.

Fetch Invoices Use this subflow to lookup invoices from 
Oracle EBS.

System Properties for Primary Data Integration with Oracle

Use these system properties to configure settings for the Primary Data Integration with Oracle 
from the System Properties page. For more information, see Source-to-Pay integrations with 
Oracle reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Primary Data Integration with Oracle

Property Name Description

sn_orcl_data_int.action_default_page_size Oracle EBS action's default page size.

sn_orcl_data_int.common_object_details_service_flow_nameUse this subflow to look up common object 
details in Oracle.
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System Properties for Primary Data Integration with Oracle  (continued)

Property Name Description

sn_orcl_data_int.cost_centers_service_flow_nameUse this subflow for fetching cost centers from 
the Oracle system.

sn_orcl_data_int.currencies_service_flow_name Use this subflow for fetching currencies from 
Oracle EBS system.

sn_orcl_data_int.fetch_purchasing_organizations_service_flow_nameUse this subflow for fetching purchasing 
organizations from the Oracle system.

sn_orcl_data_int.full_load_time_range_default Defines the default time range for full data 
loads.

sn_orcl_data_int.fx_rates_service_flow_name Use this subflow for fetching FX rates from the 
Oracle system.

sn_orcl_data_int.glide.rest.max_content_length Defines the maximum content length allowed 
for REST API payloads.

sn_orcl_data_int.gl_account_service_flow_nameUse this subflow for fetching GL accounts from 
the Oracle system.

sn_orcl_data_int.inventory_items_flow_name Use this subflow for fetching inventory items 
from the Oracle system.

sn_orcl_data_int.legal_entities_service_flow_nameUse this subflow for fetching legal entities from 
the Oracle system.

sn_orcl_data_int.payment_terms_service_flow_nameUse this subflow for fetching payment terms 
from the Oracle system.

sn_orcl_data_int.plant_address_flow_name Use this subflow for fetching plant address 
from the Oracle system.

sn_orcl_data_int.purchase_groups_service_flow_nameUse this subflow for fetching purchase groups 
from the Oracle system.

sn_orcl_data_int.supplier_service_flow_name Use this subflow for fetching suppliers from 
the Oracle system.

sn_orcl_data_int.timeout_value Maximum timeout duration (in milliseconds) 
for subflow execution.

Default value: 10000000

Supplier Lifecycle Operations Integration with Oracle

The Supplier Lifecycle Operations Integration with Oracle supports the following subflows:

Scheduled subflow details for Supplier Lifecycle Operations Integration with Oracle

Flow Description

Create or update or deactivate supplier Creates or updates or deactivates supplier in 
Oracle EBS.

Create or update supplier location Creates or updates supplier location in Oracle 
EBS.
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Scheduled subflow details for Supplier Lifecycle Operations Integration with Oracle 
(continued)

Flow Description

Create or update supplier payment 
information

Creates or updates supplier payment 
information in Oracle EBS.

Important: 

These subflows are read-only. To modify a flow or subflow, create a copy and then apply the 
required changes.

System Properties for Supplier Lifecycle Operations Integration with Oracle

Use these system properties to configure settings for the Supplier Lifecycle Operations 
Integration with Oracle from the System Properties page. For more information, see Source-to-
Pay integrations with Oracle reference.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

System Properties for Supplier Lifecycle Operations Integration with Oracle

Property Name Description

sn_slo_orcl_int.supplier_location_service_flow_nameUse this subflow to fetch supplier location data 
from the Oracle system.

sn_slo_orcl_int.supplier_payment_service_flow_nameUse this subflow to fetch supplier payment 
information from the Oracle system.

sn_slo_orcl_int.supplier_service_flow_name Use this subflow to fetch supplier data from 
the Oracle system.

Sourcing and Procurement Operations Integration with Oracle EBS

The Sourcing and Procurement Operations Integration with Oracle EBS supports the following 
subflows:

Scheduled subflow details for Sourcing and Procurement Operations integration with Oracle 
EBS

Flow Description

Create or updates or cancels purchase order Creates or updates or cancels purchase order 
in Oracle EBS.

Accounts Payable Operations Integration with Oracle EBS

The Accounts Payable Operations Integration with Oracle EBS supports the following subflows:
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Scheduled subflow details for Accounts Payable Operations Integration with Oracle EBS

Flow Description

Create AP invoice Creates AP invoice in Oracle EBS.

Manually trigger flows or subflows in Oracle EBS (Inbound)

You can manually trigger flows or subflows in Oracle EBS on demand. Follow these steps to 
manually trigger a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

About this task

https://player.vimeo.com/video/1104414703?
h=6b62c2639f&badge=0&autopause=0&player_id=0&app_id=58479

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select the Oracle EBS  ERP source to manually trigger the flows 
or subflows.

3. In the Integration Services list, select the subflows that you want to manually trigger.

Manually trigger flows or subflows in Oracle EBS

4. Select Run job  to trigger the flow or subflow.

5. Navigate to All  > Process Automation  > Workflow Studio.

6. From the Workflow Studio home page, select the Operations  tab and then select Flows  tab.
The list of flow executions appear. You can look up the status of the flows or subflows that you 
triggered. If there were any errors during execution, you can view them under the processing 
message column.

7. Navigate back to the Homepage  tab, and select Flows  or Subflows.

8. Look up the Flow  or Subflow  name or Oracle EBS  application name using the filter icon, and 
select Apply.
You can view the flows or subflows that you triggered.
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Flows or subflows in Workflow Studio

9. You can use the trigger condition as a part of the base system to execute the flow or subflow.

Note:  Don’t modify the trigger condition.

The flow or subflow gets executed.

Use a flow or subflow in Oracle EBS (Outbound)

A flow or subflow can be executed in Oracle EBS using the Workflow Studio. Follow these steps 
to run a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

About this task

https://player.vimeo.com/video/1121974905?
h=c7e9d2124e&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Look up the Flow  name or Oracle EBS  application name using the filter icon, and select Apply.

4. Select the required flow from the list.

For example, select Create or update or cancel purchase order  flow.
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Create or update or cancel purchase order flow

5. In the Trigger field, specify the time and interval at which you want to run the scheduled flow 
automatically.

This flow subsequently triggers subflows to automate tasks. To customize the sample flow, 
copy it to the desired application scope.

Note:  Don’t modify the trigger condition.

The flow or subflow gets executed.

Copy a flow or subflow in Oracle EBS

You can create a copy of the a flow or subflow and make the necessary modifications. Use the 
following steps to activate a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio homepage, select Flows.

3. Open the flow that you want to copy.

4. Click the  more actions icon, and select Copy flow.

Important:  Perform this step only if you plan to customize or make specific changes to 
the flow.

Create or update purchase order flow

5. Activate the flow or subflow.
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◦ Make sure that the flow or subflow is available and activated on the base system.

◦ Activate the copied flow after making the required changes.

6. Use the Trigger Condition  for the flow or subflow.

This flow or subflow is triggered and associated with the purchase order when the following 
conditions are met:

◦ Legal entity . ERP source . Active  is true.

◦ Legal entity . ERP source . ERP Source  is not empty.

◦ Status  is Pending Submission

Note:  Do not modify the trigger condition.

Note:  Once data is pulled into staging tables, transform maps move data into target 
tables. For more details, refer to Source-to-Pay integration framework transform maps and 
subflows

You have successfully copied and executed the flow.

Source-to-Pay integrations with Oracle reference

Reference topics provide additional information on integrating Source-to-Pay Operations  with 
Oracle, including sales orders, procurement, finance, and so on, between Source-to-Pay and 
ERP systems.

Set system properties for Oracle Integration

Use these system properties to configure settings for the Oracle integration from the System 
Properties page.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

To access the system properties list, perform the following steps:

1. Navigate to All.

2. Search for sys_properties_list.do  and open the system properties list.

3. Look up Primary Data Integration with Oracle using the filter option.
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4. The following system properties are available as a part of the base system.

Note:  You can modify these values only if necessary.

Source-to-Pay integration with SAP Ariba

The Source-to-Pay integration with SAP Ariba  enables you to handle sales orders, procurement, 
finance, and so on, in SAP Ariba  from your ServiceNow instance.

Key features

With this application, you can perform the following:

• Integration hub actions for invoices, cost centers, payment terms, purchasing organizations, 
departments, GL accounts, currencies, FX rates, invoice payment details, suppliers, and legal 
entities.

• Create goods receipts in SAP Ariba.

Prerequisites

• Activate the Source-to-Pay integration with the SAP Ariba  application from the ServiceNow 
Store. This automatically activates the SAP Ariba  Spoke.

• Set up SAP Ariba Spoke .

Overview of the Source-to-Pay integration with SAP Ariba

ServiceNow Store app plugins: sn_sap_ariba_spoke.

Note:  The Source-to-Pay integration with SAP Ariba  depends on the SAP Ariba Spoke .

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

How it works

The subflows enable a plug-and-play experience for the integration scenarios. Integration Hub 
Actions provide the building blocks for Source-to-Pay subflows and connects to the SAP Ariba 
system through REST APIs.
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Configuring the Source-to-Pay integration with SAP Ariba

Integrate the ServiceNow instance and SAP Ariba  using the SSH, Basic Auth, OAuth 2.0, and API 
Key credentials SAP Ariba  to authenticate ServiceNow requests.

Application set up

• Activate the Source-to-Pay integration with the SAP Ariba  application from the ServiceNow 
Store. This automatically activates the SAP Ariba Spoke.

• Set up SAP Ariba Spoke .

• Activate the Source-to-Pay integration framework from the ServiceNow Store. Source-to-Pay 
integration with SAP Ariba  uses the Source-to-Pay integration framework to pull tasks from SAP 
Ariba  into ServiceNow. For more information on the Source-to-Pay integration framework, see 
Source-to-Pay integration framework.

Primary Data Integration with SAP Ariba  Dependencies

Install the following dependencies of Primary Data integration with SAP Ariba. When you install 
the plugin (sn_ariba_data_int), the dependencies are installed automatically.

Primary Data Integration with SAP Ariba

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

Supplier Common Architecture sn_slm

SAP Ariba Spoke sn_sap_ariba_spoke

Sourcing and Procurement Operations Integration Dependencies with SAP 
Ariba

Install the following dependencies of Sourcing and Procurement Operations integration with SAP 
Ariba. When you install the plugin, all the dependencies get installed automatically.

Sourcing and Procurement Operations Integration with SAP Ariba

App name Plugin ID

Primary Data Integration with SAP Ariba sn_ariba_data_int

Sourcing and Purchasing Automation sn_pr

Source-to-Pay Integration Framework sn_spend_intg

Accounts Payable Operations Integration Dependencies with SAP Ariba

Install the following dependencies of Accounts Payable Operations integration with SAP Ariba. 
When you install the plugin, all the dependencies get installed automatically.
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Accounts Payable Operations Integration with SAP Ariba

App name Plugin ID

Primary Data Integration with SAP Ariba sn_ariba_data_int

Accounts Payable Invoice Processing sn_ap_apm

Source-to-Pay Integration Framework sn_spend_intg

ERP source configuration for SAP Ariba

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to post purchase order, receipt, 
invoice, and download primary data automatically from the ERP system.

ERP source configuration enables the implementation of specific logic to populate values 
pertinent to third-party ERP systems. It includes all service mappings defined between Source-
to-Pay (S2P) and the third-party ERP system. If multiple ERP sources exist, they’re stored as 
distinct ERP source entries with their corresponding service mappings.

To meet specific requirements, you can customize the service-mapping logic by modifying 
the relevant service element map entry within the service map record. For organizations using 
multiple ERP systems, an ERP Source field has been incorporated into the tables to accurately 
identify the respective integrated ERP system.

The ERP source configuration for SAP Ariba  enables customers to establish multiple SAP Ariba 
instances. Each instance is identified by a distinct source, and the connection alias for each 
instance must be unique.

Prerequisites

Before you start the integration configuration, complete the following tasks.

• Add the following roles to the Integration user:

◦ sn_fcms_intg.admin

◦ sn_spend_intg.admin

• Get the following details from the ERP team:

◦ ERP integration user credentials.

◦ REST API details based on your ERP system you're using for the integration.

Note:  If the application must support multiple ERP instances, configure Source-to-Pay to 
integrate with each ERP instance separately.

ERP Source Configuration

To configure the ERP Source for SAP Ariba, perform the following steps:

1. Define the ERP source that you want to integrate with the SAP Ariba  integration.

2. Create a basic authentication profile that can be used for the web service integration with SAP 
Ariba

3. Register the SAP Ariba  integration username and password to create the authentication profile 
and associate it to service maps.

4. Define the source configuration for ERP source. The ERP source configuration determines the 
ERP source to which your ERP system connects. For more information, see Define ERP source 
configuration for SAP Ariba.
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5. Configure service maps for the following entities:

◦ Legal Entities

Set up subflows for the source configuration to lookup legal entities or company code details 
from SAP Ariba.

◦ FX Currency Rates

Set up subflows for the source configuration to lookup FX rates from SAP Ariba.

◦ Purchasing Orgs

Set up subflows for the source configuration to lookup purchasing organizations from SAP 
Ariba.

◦ Currencies

Set up subflows for the source configuration to lookup currencies from SAP Ariba.

◦ Payment Terms

Set up subflows for the source configuration to lookup payment terms from SAP Ariba.

◦ GL Accounts

Set up subflows for the source configuration to lookup GL accounts from SAP Ariba.

◦ Cost Centers

Set up subflows for the source configuration to lookup cost centers from SAP Ariba.

◦ Departments

Set up subflows for the source configuration to lookup departments from SAP Ariba.

◦ Suppliers

Set up subflows for the source configuration to lookup suppliers from SAP Ariba

◦ Invoices

Set up subflows for the source configuration to lookup invoices from SAP Ariba.
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ERP Source Configuration for SAP Ariba

You have configured the ERP source for SAP Ariba.

Define ERP source configuration for SAP Ariba

ERP source configuration determines the ERP source to which your ERP system connects. Map 
the integration payload with the SAP Ariba  tables.

Before you begin
Role required: sn_fcms_intg.admin

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select SAP Ariba REST.

This configuration is available as a part of the base system.

3. To edit the ERP source, select here  from the label To edit this record click here.

Edit the ERP Source for SAP Ariba
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a. Select the list search icon ( ) to look up the required ERP source for SAP Ariba.

b. In the ERP Sources dialog, use the search option to select the ERP Source for SAP Ariba.

c. Select Update.

4. To create an ERP source, do the following:

a. Select here.

b. Select the list search icon ( ) to look up the required ERP source for SAP Ariba.

c. In the ERP Source dialog, select New.

Create an ERP Source for SAP Ariba

d. On the form, fill the fields.

Define a new ERP source configuration

Field Description

ERP Source ERP source for which the integration is 
required. For example, SAP Ariba.

Short Description Summary of the ERP source.

Active Option to activate the ERP source.

Amount Precisions Amount precision of the ERP source. For 
example, 2.

e. Select Submit.
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A new ERP source is created. Verify whether the connection alias is unique for each ERP 
source.

Note:  SAP Ariba  integration can have multiple ERP sources. The Staging table 
displays the ERP source column, which helps identify the ERP system associated with 
the data.

Configure integration services for SAP Ariba

For configuring integration services, provide the connection end point and the SAP Ariba 
credentials that you set up for your authentication profile. Also, create a integration service 
record for each entity you want to customize.

Before you begin
Role required: sn_fcms_intg.admin

About this task
If the application requires multiple SAP Ariba  instances, create separate entities for 
each ERP instance. You can create integration service records for entities using the 
sn_fcms_intg_service  table.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you must configure integration services.
For example, select SAP Ariba  REST.

3. In the Integration Services list, select the service that you want to configure.
For example, select Invoices.

4. To edit the ERP source, select here  from the label To edit this record click here.

5. On the integration service record, update the fields to modify the configurations.

Integration service record fields

Field Description

Entity The type of entity for which you want to configure the 
integration service.

Application Name of the application. For example, Primary Data 
Integration with SAP Ariba.

ERP Source configuration The ERP source mapped to the entity. For example, 
SAP Ariba.

Active The status of the interaction service. By default, the 
check box is inactive.

Subflow The subflow used to fetch primary data.

Properties
Creates a JSON record in the integration service, 
which is then passed to the ERP subflows to retrieve 
complete data.

To pass JSON into the subflow, create a property 
named "query" and assign it a JSON query as its 
value, like this:
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Field Description

[
  {
    "page_size”: “5”,
    "supplier_network_id": 
 "AN01000000001",
    "system_Id": "ServiceNow3",
    "source_system": "SAP Ariba 
 Network"
  }
]

Order The order in which the entity should be displayed.

6. Select Submit.
The integration service is configured for the selected entity.

Look up primary data in SAP Ariba

You can run a job to look up primary data from different ERP sources into ServiceNow.

Before the ERP integration, configure the integration services record for the target ERP source 
using the sn_fcms_intg_service  table. The sn_fcms_intg_service  table is a 
mapping table between the subflows and targets the ERP source. For more information on 
creating an integration service record, see Create Integration Service record.

Look up primary data in SAP Ariba

You can manually run jobs for the following entities:
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Look up primary data in SAP Ariba

Entity Description Table name

Legal entities Lookup legal entities from SAP 
Ariba.

Legal Entity Stage inbound 
staging table

FX Currency rates Lookup FX rates from SAP Ariba. FX Rate Stage inbound 
staging table

Purchasing Orgs Lookup purchasing orgs from 
SAP Ariba.

Purchase Entity Stage 
inbound staging table

Currencies Lookup currencies from SAP 
Ariba.

FX Currency Stage inbound 
staging table

Payment Terms Lookup payment terms from 
SAP Ariba.

Payment Terms Stage 
inbound staging table

GL Accounts Lookup GL accounts from SAP 
Ariba.

GL Account Stage inbound 
staging table

Cost Centers Lookup cost centers from SAP 
Ariba.

Cost Center Stage inbound 
staging table

Departments Lookup departments from SAP 
Ariba.

Department Stage inbound 
staging table

Suppliers Lookup suppliers from SAP 
Ariba.

Supplier location inbound 
staging table

Invoices Lookup invoices from SAP Ariba. Invoice import inbound 
staging table

Use Source-to-Pay integration with SAP Ariba

Use Source-to-Pay integration with SAP Ariba  to handle sales orders, procurement, finance, and 
so on in SAP Ariba  from your ServiceNow instance.

Use flows in SAP Ariba

Use flows to retrieve information from SAP Ariba, including invoices, cost centers, product 
models, payment terms, purchasing organizations, departments, GL accounts, currencies, FX 
rates, invoice payment details, suppliers, supplier bids, and legal entities.

You can either use the subflows to perform the required tasks or you can create a copy of the 
subflows and then customize it according to your requirements. The Source-to-Pay with SAP 
Ariba  integration supports the following subflows.

Sourcing and Procurement Operations Integration with SAP Ariba

The Sourcing and Procurement Operations Integration with SAP Ariba  supports the following 
subflows:

Flow and subflow details for Sourcing and Procurement Operations integration with SAP 
Ariba

Flow/Subflow Description

Flow

Award Sourcing Event in SAP Ariba  REST Awards sourcing events in SAP Ariba REST
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Flow and subflow details for Sourcing and Procurement Operations integration with SAP 
Ariba  (continued)

Flow/Subflow Description

Create or Update Sourcing Event in SAP Ariba Creates or updates sourcing event in SAP 
Ariba

Create Receipt in ERP Creates receipts in ERP

Fetch Supplier Bids for Sourcing Event from 
SAP Ariba  REST

Fetches supplier bids for sourcing event from 
SAP Ariba  REST

Subflow

Award Sourcing Event in SAP Ariba REST Awards sourcing events in SAP Ariba REST

Create Receipt in SAP Ariba Creates receipts in SAP Ariba

Creating or Updating of Sourcing Event in SAP 
Ariba

Creates or updates sourcing event in SAP 
Ariba

Fetch Supplier Bids for Sourcing Event for SAP 
Ariba

Fetches supplier bids for sourcing event from 
SAP Ariba

Fetch Supplier Bids for Sourcing Event Service 
Ariba

Fetches supplier bids for sourcing event 
service

Accounts Payable Operations Integration with SAP Ariba

The Accounts Payable Operations Integration with SAP Ariba  supports the following subflows:

Subflow details for Accounts Payable Operations Integration with SAP Ariba

Flow Description

Fetches invoices from SAP Ariba  REST Fetches accounts payable invoices inSAP 
Ariba.

Update invoice statuses as Rejected in SAP 
Ariba  REST

Updates invoice statuses as rejected in SAP 
Ariba

Fetch invoices from SAP Ariba  REST service Fetches invoices from SAP Ariba  REST service

Manually trigger flows or subflows in SAP Ariba (Inbound)

You can manually trigger flows or subflows in SAP Ariba  on demand.

Before you begin
Role required: sn_fcms_intg.admin

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select the SAP Ariba REST  ERP source to manually trigger the 
flows or subflows.

3. In the Integration Services list, select the subflows that you want to manually trigger.

4. Select Run job  to trigger the flow or subflow.
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Run subflows in SAP Ariba

5. Navigate to All  > Process Automation  > Workflow Studio.

6. From the Workflow Studio home page, select the Operations  tab and then select Flows  tab.

Flow execution in SAP Ariba

The list of flow executions appear. You can look up the status of the flows or subflows that you 
triggered. If there were any errors during execution, you can view them under the processing 
message column.

7. Navigate back to the Homepage  tab, and select Flows  or Subflows.

8. Select the More icon  corresponding to the flow, subflow, or application name, use the filter 
condition, and select Apply.
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Filter flow, subflow, or application

You can view the flows or subflows that you triggered.

9. Use the trigger condition defined in the base system, to execute the flow or subflow.

Note:  Don’t modify the trigger condition.

Use a flow or subflow in SAP Ariba  (Outbound)

Execute a flow or subflow in SAP Ariba  using the Workflow Studio.

Before you begin
Role required: sn_fcms_intg.admin, sn_shop.procurement_specialist, connection_admin

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Select the More icon  corresponding to the flow, subflow, or application name, use the filter 
condition, and select Apply.

4. Select the required flow from the list.

For example, select the Create or Update Sourcing Event in SAP Ariba  flow.
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Create or Update Sourcing Event in SAP Ariba

5. In the Trigger field, specify the condition for the flow to run.

This flow subsequently triggers subflows. To customize the sample flow, copy it to the desired 
application scope.

Note:  Don’t modify the trigger condition.

Copy a flow or subflow in SAP Ariba

You can create a copy of the a flow or subflow, and modify based on your requirements.

Before you begin
Role required: sn_fcms_intg.admin, sn_shop.procurement_specialist, connection_admin

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio homepage, select Flows.

3. Open the flow that you want to copy.
For example, Update or Create Sourcing Event in SAP Ariba.

4. Select the More actions icon  and select Copy flow.

Important:  Perform this step only if you plan to customize or make specific changes to 
the flow.

a. In the Create a copy of this flow dialog, provide a name for the new flow.
The Application is SAP Ariba Spoke, by default.

5. Activate the flow or subflow.

◦ Make sure that the flow or subflow is available and activated in the base system.

◦ Activate the copied flow after making the required changes.

6. Use the Trigger Condition  for the flow or subflow.
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This flow or subflow is triggered when the condition Integration status  is New  is met.

Note:  Do not modify the trigger condition.

Trigger condition to create or update sourcing even in SAP Ariba

Note: 

Once data is pulled into staging tables, transform maps move data into target tables. For 
more details, refer to Source-to-Pay integration framework transform maps and subflows.

You have successfully copied and executed the flow.

Source-to-Pay integration with Coupa

The Source-to-Pay integration with Coupa enables you to handle business spend and automate 
approvals, contracts, inventory, purchase orders, requisitions, suppliers, and user management 
in Coupa from your instance.

Key Features

With this application, you can perform the following:

• Perform Integration hub actions for loading primary data, supplier management, PR, PO, 
receipt, invoice, and sourcing.

• Look up Legal Entity details from Coupa to Source-to-Pay integration framework

• Look up Currency details from Coupa to Source-to-Pay integration framework

• Look up Supplier details from Coupa to Source-to-Pay integration framework
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Overview of the Source-to-Pay integration with Coupa

Prerequisites

Activate the Source-to-Pay integration with the Coupa application from the ServiceNow Store to 
activate the Coupa Spoke automatically. Next you must set up Coupa Spoke .

ServiceNow Store app plugins: sn_coupa_spoke.

Note:  The Source-to-Pay integration with Coupa depends on the Coupa Spoke .

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

How it works

The subflows enable a plug-and-play experience for the integration scenarios. Integration Hub 
Actions provide the building blocks for Source-to-Pay subflows and connects to the Coupa 
system through REST APIs.

Configure Source-to-Pay integration with Coupa

Integrate your ServiceNow  instance and Coupa by creating a custom OAuth application in Coupa 
to authenticate ServiceNow  requests.

Application set up

• Activate the Source-to-Pay integration with Coupa application from the ServiceNow Store  to 
activate the Coupa Spoke automatically.

• Set up Coupa Spoke .

• Activate the Source-to-Pay integration framework from ServiceNow Store. Source-to-Pay 
integration with Coupa uses the Source-to-Pay integration framework to pull tasks from Coupa 
into your ServiceNow  instance.For more information on Source-to-Pay integration framework, 
see Source-to-Pay integration framework.

Primary Data Integration Dependencies with Coupa

Install the following dependencies of Primary Data integration with Coupa. When you install the 
plugin, all the dependencies get installed automatically. All primary data are synchronized based 
on the configurable scheduled job Fetch Spend Primary Data.
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Run the Trigger Coupa Integration that pulls tasks into your ServiceNow  instance. For more 
information, see Use schedule flows in Oracle EBS.

Primary Data Integration with Coupa

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Coupa Spoke sn_coupa_spoke

Supplier lifecycle Operations Integration Dependencies with Coupa

Install the following dependencies of Supplier Lifecycle Operations integration with Coupa. 
When you install the plugin, all the dependencies get installed automatically.

Supplier Lifecycle Operations Integration with Coupa

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Source-to-Pay Integration Framework sn_spend_intg

Source-to-pay Common Architecture sn_shop

Supplier Common Architecture sn_slm

Coupa Spoke sn_coupa_spoke

Sourcing and Procurement Operations Integration Dependencies with Coupa

Install the following dependencies of Sourcing and Procurement Operations integration with 
Coupa. When you install the plugin, all the dependencies get installed automatically.

Sourcing and Procurement Operations Integration with Coupa

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

Sourcing and Purchasing Automation sn_pr

Source-to-Pay Integration Framework sn_spend_intg

Coupa Spoke sn_coupa_spoke

Accounts Payable Operations Integration Dependencies with Coupa

Install the following dependencies of Accounts Payable Operations integration with Coupa. 
When you install the plugin, all the dependencies get installed automatically.

Accounts Payable Operations Integration with Coupa

App name Plugin ID

ERP Integration Framework sn_fcms_intg
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Accounts Payable Operations Integration with Coupa  (continued)

App name Plugin ID

Coupa Spoke sn_coupa_spoke

Accounts Payable Invoice Processing sn_ap_apm

Source-to-Pay Integration Framework sn_spend_intg

Schedule flow activation

Activate and run the Trigger Coupa Integration that pulls tasks into your ServiceNow  instance. For 
more information, see Activate the schedule flows.

ERP Source Configuration for Coupa

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to post purchase order, receipt, 
invoice, and download primary data from the ERP automatically.

ERP source configuration includes all service mappings defined between Source-to-Pay (S2P) 
and the third-party ERP system. In cases where multiple ERP sources exist, they’re stored as 
distinct ERP source entries with their corresponding service mappings.

To meet specific requirements, you can modify the service-mapping logic by updating the 
relevant service element map entry within the service map record. For organizations using 
multiple ERP systems, an ERP Source field has been incorporated into the tables to ensure 
accurate identification of the respective integrated ERP system.

The ERP source configuration for Coupa enables customers to establish multiple Coupa 
instances. Each instance is identified by a distinct source, and the connection alias for each 
instance must be unique.

Prerequisites

Before you start the integration configuration, you must get the following details from the ERP 
team:

• ERP integration user credentials.

• SOAP or REST API details based on your ERP system and the type of web services you’re 
using for the integration.

• Roles to be added for the Integration users.

ERP Source Configuration

To perform the ERP Source configuration for Coupa, perform the following steps:

1. Define the ERP source that you want to integrate with Coupa integration. For more information, 
see Define an ERP source configuration for Coupa.

2. Create a basic authentication profile that can be used for web service integration with Coupa.

3. Register the Coupa integration username and password to create the authentication profile 
and associate it to service maps.

4. Define source configuration for ERP source.

The ERP source configuration determines the ERP source to which your ERP system connects. 
For more information, see Define an ERP source configuration for Coupa.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

277



5. Configure service maps for the required entities. For more information, see Configure 
integration services for Coupa.

ERP Source Configuration of Coupa

You have configured the ERP source for Coupa.

Define an ERP source configuration for Coupa

Define an ERP source configuration that specifies the Coupa ERP source to which the ERP 
system connects. Map the integration payload with the Coupa tables.

Before you begin
Role required: admin

About this task
By default, the base system includes one ERP source named Coupa, which refers to the parent 
connection for Coupa. If there are multiple Coupa instances, multiple ERP sources must be 
configured, and the child connections for these Coupa instances should be referenced.

Each ERP instance requires a unique ERP source configuration. For example, 10 ERP instances 
need 10 configurations.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select Coupa.

This configuration is available as a part of the base system.

3. To edit the ERP source, select here.

4. Select the required ERP source for Coupa using the search option.

5. To create a new ERP source, perform the following steps:

a. Select here.

b. Select the list search icon ( ).
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c. Look up the required ERP source for Coupa.

d. In the ERP Source dialog, select New.

e. On the form, fill the fields.

Define a new ERP source configuration form

Field Description

ERP Source ERP source for which the integration is 
required. For example, Coupa.

Short Description Summary of the ERP source.

Active Option to activate the ERP source.

Amount Precisions Amount precision of the ERP source. For 
example, 2.

Define a new ERP source configuration for Coupa

f. Select Submit.

A new ERP source is created. Verify that the connection alias is also unique for each ERP 
source.

Note:  Coupa integration can have multiple ERP sources. The Staging table displays the 
ERP source column, which you can use to distinguish which ERP the data belongs to.

What to do next
By default, services mapping are provided for the Coupa base system. For other Coupa 
instances, you must perform the following steps:

• Define service mappings manually for each integration service by accessing the Service 
Mappings related list. You can define element level mapping between Coupa table fields and 
payload elements.

• Map the users and corresponding ERP User IDs by accessing the ERP User Mappings related 
list.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

279



Configure integration services for Coupa

Configure integration services for Coupa. Provide the connection end point and the Coupa ERP 
credentials that you set up for your authentication profile. Also, create a separate web service 
record for each service request that you want to customize.

Before you begin

• Verify that the application scope is set to Coupa spoke.

• Verify that the MID Server  is installed and configured in your ServiceNow  instance to connect 
to the ERP server. For more details, see Installing the MID Server .

Note:  The MID Server integration is required only for a Coupa integration using SOAP 
services.

• For REST type service, REST API details, as provided by ERP.

Role required: admin

About this task
If the application requires multiple Coupa ERP instances, create separate web services 
for each ERP instance. You can create Integration Service records for entities using the 
sn_fcms_intg_service  table.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you need to configure integration services.
For example, Coupa.

3. In the Integration Services list, select the service that you want to configure.

Look up Legal Entities from Coupa

4. On the integration service record, fill in the fields.

Integration service record

Field Description

Entity Type of entity for which you want to configure the 
service mapping.

Application Name of the application. For example, Coupa.
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Field Description

ERP Source configuration The ERP source mapped to the entity. For example, 
Coupa.

Active Option to activate the interaction service. By default, 
the service is inactive.

Subflow Subflow used to fetch primary data.

Properties
Properties of the service.

The property creates a JSON record in the integration 
service, which is then passed to the ERP subflows to 
retrieve complete data.

To pass JSON into the subflow, create a property 
named "query" and assign it a JSON query as its 
value, like this:

[
  {
    "parameter": 
 "LEGAL_ENTITY_NAME",
    "operator": "=",
    "value": "Vision ADB",
    "operand": "NONE"
  }
]

◦ Enabling Full Pull:

Create a property named "full_pull" and set its 
value to true

◦ Enabling Delta Pull:

Use this property to fetch the incremental data.

Set the value of the "full_pull" property to 
false.

Order Order in which the entity should be displayed.

5. Select Update.

Activate the schedule flows

Activate the schedule flow that interacts with Coupa to pull information into your ServiceNow 
instance. You can pull information on primary data, supplier management, sourcing, invoice, and 
so on.

Before you begin
Role required: sn_coupa_spoke.Coupa Admin

Procedure

1. Open Run Trigger Coupa Integration.

2. Navigate to Flow Designer  > Flow.
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3. Select Activate.

4. In the Trigger  field, specify the time and interval at which you want to automatically run the 
scheduled flow.

This flow in turn triggers the subflows to automate tasks. To customize the sample flow, copy it 
to the required application scope.

The available subflows include:

Activate scheduled flow details

Subflow Description

Look up legal entities from Coupa Retrieves details of the legal entities in 
Coupa.

Look up currencies from Coupa Retrieves details of the currencies in Coupa.

Look up conversion rates from Coupa Retrieves details of the conversion rates in 
Coupa.

Look up shipment notice using PO line id in 
Coupa

Retrieves details of the shipment notice using 
PO line ID in Coupa.

Look up advance shipment notice after 
updated date in Coupa

Retrieves details of the advance shipment 
notice after updated date in Coupa.

Create, update, and deactivate supplier in 
Coupa

Manage suppliers by creating, updating, and 
deactivating supplier in Coupa.

Look up suppliers from Coupa Retrieves details of the suppliers in Coupa.

Create, update, and cancel purchase order in 
Coupa

Manage purchase orders by creating, 
updating, and canceling purchase order in 
Coupa.

Look up purchase orders from Coupa Retrieves details of the purchase orders in 
Coupa.

Create and void goods receipt in Coupa Manage goods receipt by creating and 
voiding goods receipt in Coupa.

Look up receipts from Coupa Retrieves details of the receipts in Coupa.

Look up product catalogs from Coupa Retrieves details of the product catalogs in 
Coupa.

Create, update, and cancel invoice in Coupa Manage invoices by creating, updating, and 
canceling invoice in Coupa.

Look up invoices details from Coupa Retrieves details of the invoices in Coupa.

Look up Invoice payment details Retrieves details of the Invoice payment in 
Coupa.

Create sourcing event Manage sourcing event by creating sourcing 
events in Coupa.

Look up sourcing events from Coupa Retrieves details of the sourcing events in 
Coupa.

Award purchase Retrieves details of the Award purchase in 
Coupa.
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Note: 

If you want to change the configurations that are shipped along with Source-to-Pay 
Integration with Coupa, you can edit the subflows.

Once data is pulled into staging tables, the transform maps move data into target tables. For 
more details, refer to Source-to-Pay integration framework transform maps and subflows.

Looking up primary data in Coupa

You can run a job to look up primary data from different ERP sources into ServiceNow

Before you start the ERP integration, you must configure the integration services record for the 
target ERP source using the [sn_fcms_intg_service] table. The [sn_fcms_intg_service] table is a 
mapping table between sub flows and target ERP source. For more information on creating an 
integration service record, see Create Integration Service record.

Look up primary data in Coupa

You can manually run jobs for the following entities:

Look up primary data in Coupa

Entity Description Table name

Currencies Look up currencies from Coupa. FX Currency Stage inbound 
staging table

FX Currency rates Look up FX rates from Coupa. FX Rate Stage inbound 
staging table

Legal entities Look up legal entities from 
Coupa.

Legal Entity Stage inbound 
staging table

Purchase Line Shipment 
Details

Look up purchase line shipment 
details from Coupa.

Purchase Requisition staging 
table

Shipment Notices Look up shipment notices from 
Coupa

-

Suppliers Look up suppliers from Coupa. Supplier location inbound 
staging table

Cost Centers Look up cost centers from 
Coupa.

Cost Center Stage inbound 
staging table

Supplier Payment 
Information

Look up supplier payment 
information from Coupa.

Supplier payment inbound 
staging table

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

283



Look up primary data in Coupa  (continued)

Entity Description Table name

Invoices Look up invoices from Coupa. Invoice import inbound 
staging table

Purchase Orders Look up purchase orders from 
Coupa

Inbound Purchase Order 
staging table

Invoice Payment Details Look up invoice payment details 
from Coupa.

Invoice payment detail import 
inbound table

Receipts Look up receipts from Coupa. Inbound Receipt staging table

Product Models Look up product models from 
Coupa.

Product Model Stage inbound 
staging table

Use Source-to-Pay integration with Coupa

Use the Source-to-Pay integration with Coupa to process employee information at ServiceNow.

Trigger a flow or subflow in Coupa

Manually trigger a flow or subflow in Coupa.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select the Coupa  ERP source to trigger the flows or subflows 
manually.

3. In the Integration Services list, select the subflows that you want to trigger manually.

Manually trigger flows or subflows in Coupa

4. Trigger the flow or subflow by selecting Run job.
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What to do next
To view the status of the executed flow and a list of errors (if any), see View the execution status 
of a flow

View the execution status of a flow

View the status of a flow that has been triggered. If there were any errors during execution, you 
can view them under the processing message column.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio

2. From the Workflow Studio home page, select the Operations  tab and then select Flows  tab.

Result
The list of flow executions appear. You can look up the status of the flows or subflows that you 
triggered. If there were any errors during execution, you can view them under the processing 
message column.

Use a flow or subflow in Coupa (outbound)

A flow or subflow can be executed in Coupa using the Workflow Studio.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Look up the Flow  name or Coupa  application name using the filter icon, and select Apply.

4. Select the required flow from the list.

Award Purchase flow
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5. In the Trigger  field, specify the time and interval at which you want to run the scheduled flow 
automatically.

This flow subsequently triggers subflows to automate tasks. To customize the sample flow, 
copy it to the desired application scope.

Note:  Don’t modify the trigger condition.

Result
The flow or subflow gets executed.

Copy a flow or subflow in Coupa

Create a copy of a flow or subflow, make the necessary modifications, and then activate it.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Open the flow that you want to copy.

4. Select the more actions icon ( ).

5. Select Copy flow.

Important:  Perform this step only if you plan to customize or make specific changes to 
the flow.

Copy of a Award Purchase flow

6. Activate the flow or subflow.

◦ Make sure that the flow or subflow is available and activated on the base system.

◦ Activate the copied flow after making the required changes.

7. Use the Trigger Condition  for the flow or subflow.
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Note:  After data is pulled into staging tables, the transform maps move data into target 
tables. For more details, refer to Source-to-Pay integration framework transform maps and 
subflows.

You have successfully copied and executed the flow.

Source-to-Pay integration with Oracle Financial Cloud

The Source-to-Pay integration with Oracle Financial Cloud enables you to manage sales orders, 
procurement, finance, and so on, in Oracle Financial Cloud from your ServiceNow instance.

Key features

With this application, you can perform the following:

• Look up Currencies, General Ledger (GL) accounts, Legal entities, Payment terms details, Plant 
Address, Cost Center, Purchasing Orgs, and Purchasing Groups from Oracle Financial Cloud.

• Create or update Supplier locations in Oracle Financial Cloud

• Create or update Supplier payment details in Oracle Financial Cloud

• Create, update, or deactivate Suppliers in Oracle Financial Cloud

Overview of the Source-to-Pay integration with Oracle Financial Cloud

Prerequisites

First, you must activate the Source-to-Pay integration with the Oracle Financial Cloud application 
from the ServiceNow Store. This automatically activates the Oracle Financial Cloud Spoke. Next 
you must set up Oracle Financial Cloud Spoke .

ServiceNow Store app plugins: sn_Oracle Financial Cloud_spoke.

Note:  The Source-to-Pay integration with Oracle Financial Cloud depends on the Oracle 
Financial Cloud Spoke .

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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How it works

The subflows enable a plug-and-play experience for the integration scenarios. Integration Hub 
Actions provide the building blocks for Source-to-Pay subflows and connects to the Oracle 
Financial Cloud system through REST APIs.

Configure the Source-to-Pay integration with Oracle Financial Cloud

Integrate the ServiceNow instance and Oracle Financial Cloud by creating a custom OAuth 
application in Oracle Financial Cloud to authenticate ServiceNow requests.

Application set up

Verify that you have performed the following:

• Activated the Source-to-Pay integration with the Oracle Financial Cloud application from 
ServiceNow Store. This automatically activates the Oracle Financial Cloud Spoke.

• Set up Oracle EBS Spoke .

• Activated the Source-to-Pay integration framework from ServiceNow Store. Source-to-Pay 
integration with Oracle Financial Cloud uses the Source-to-Pay integration framework to pull 
tasks from Oracle Financial Cloud into ServiceNow. For more information on the Source-to-Pay 
integration framework, see Source-to-Pay integration framework.

Primary Data Integration with Oracle Financial Cloud's Dependencies

Install the following dependencies of Primary Data integration with Oracle Financial Cloud. 
When you install the plugin, all the dependencies get installed automatically. All primary data are 
synchronized based on the configurable scheduled job Fetch Spend Primary Data.

Run the Trigger Oracle Financial Cloud Integration that pulls tasks into ServiceNow. For more 
information, see Run scheduled jobs in Oracle Financial Cloud.

Primary Data Integration with Oracle Financial Cloud

App name Plugin ID

ERP Integration Framework sn_fcms_intg

Source-to-pay Common Architecture sn_shop

Supplier Common Architecture sn_slm

Oracle Financial Cloud Spoke sn_ofc_spoke.OracleCloudFinancials

Supplier Lifecycle Operations Integration Dependencies with Oracle Financial 
Cloud

Install the following dependencies of Supplier Lifecycle Operations integration with Oracle 
Financial Cloud. When you install the plugin, all the dependencies get installed automatically.

Supplier Lifecycle Operations Integration with Oracle Financial Cloud

App name Plugin ID

Primary Data Integration with Oracle Financial 
Cloud

sn_orcl_data_int
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Supplier Lifecycle Operations Integration with Oracle Financial Cloud  (continued)

App name Plugin ID

Source-to-Pay Integration Framework sn_spend_intg

ERP source configuration for Oracle Financial Cloud

Configure your Source-to-Pay (S2P) instance to support inbound and outbound integration with 
your ERP system. This integration configuration enables you to automatically post purchase 
order, receipt, invoice, and download primary data from the ERP.

ERP source configuration enables the implementation of specific logic to populate values 
pertinent to third-party ERP systems. It includes all service mappings defined between Source-
to-Pay (S2P) and the third-party ERP system. In cases where multiple ERP sources exist, they’re 
stored as distinct ERP source entries with their corresponding service mappings.

To meet specific requirements, you can modify the service-mapping logic by updating the 
relevant service element map entry within the service map record. For organizations using 
multiple ERP systems, an ERP Source field has been incorporated into the tables to ensure 
accurate identification of the respective integrated ERP system.

The ERP source configuration for Oracle Financial Cloud enables customers to establish multiple 
Oracle instances. Each instance is identified by a distinct source, and the connection alias for 
each instance must be unique.

Prerequisites

Before you start the integration configuration, you must complete the following tasks.

• Add the following roles to the Integration user:

◦ Import_transformer

◦ SOAP

• Get the following details from the ERP team:

◦ ERP integration user credentials.

◦ SOAP or REST API details based on your ERP system and the type of web services you’re 
using for the integration.

Note:  If the application must support multiple ERP instances, configure Source-to-Pay to 
integrate with each ERP instance separately.

ERP Source Configuration

To perform the ERP Source configuration for Oracle Financial Cloud, follow these steps:

1. Define the ERP source that you want to integrate with Oracle Financial Cloud integration.

2. Create a basic authentication profile that can be used for web service integration with Oracle 
Financial Cloud.

3. Register the Oracle Financial Cloud integration username and password to create the 
authentication profile and associate it to service maps.

4. Define source configuration for ERP source. The ERP source configuration determines the 
ERP source to which your ERP system connects. For more information, see Define ERP source 
configuration for Oracle Financial Cloud.

5. Configure service maps for the following entities:
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◦ Suppliers

Set up subflows for the source configuration to lookup suppliers from Oracle Financial 
Cloud.

◦ Payment Terms

Set up subflows for the source configuration to lookup payment terms from Oracle Financial 
Cloud.

◦ Legal Entities

Set up subflows for the source configuration to lookup legal entities or company code details 
from Oracle Financial Cloud.

◦ Currencies

Set up subflows for the source configuration to lookup currencies from Oracle Financial 
Cloud.

◦ GL Accounts

Set up subflows for the source configuration to lookup GL accounts from Oracle Financial 
Cloud.

◦ Purchase Groups

Set up subflows for the source configuration to lookup purchase groups from Oracle 
Financial Cloud.

◦ Purchasing Orgs

Set up subflows for the source configuration to lookup purchasing orgs from Oracle Financial 
Cloud.

◦ Cost Center

Set up subflows for the source configuration to lookup purchasing cost center from Oracle 
Financial Cloud.

◦ Plant Addresses

Set up subflows for the source configuration to lookup plant addresses from Oracle Financial 
Cloud.

6. Configure a scheduled job to synchronize primary data updates from Oracle Financial Cloud.

7. Set up the interval in the lookup Cost Center scheduled job to periodically synchronize primary 
data updates from the ERP, for posting services to work.

Note:  Similarly, you can configure schedule jobs for the other integrations services.

8. Load data to the Oracle Financial Cloud user-mapping table.

9. Set up Source-to-Pay and ERP User ID mapping (sn_fcms_intg_erp_user_map)  for the 
integration to work.
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The mapping is maintained for all active users who have the procurement buyer role in ERP. 
These users should be used in the requisition assignment rule.

You have configured the ERP source for Oracle Financial Cloud.

Define ERP source configuration for Oracle Financial Cloud

ERP source configuration determines the ERP source to which your ERP system connects. Map 
the integration payload with the Oracle Financial Cloud tables.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
By default, the base system includes one ERP source named Oracle Financial Cloud, which 
refers to the parent connection for Oracle Financial Cloud. If there are multiple Oracle Financial 
Cloud instances, multiple ERP sources must be configured, and the child connections for these 
Oracle Financial Cloud instances should be referenced.

Each ERP instance requires a unique ERP source configuration. Therefore, 10 ERP instances 
need 10 configurations.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select Oracle Financial Cloud.

This configuration is available as a part of the base system.

3. To edit the ERP source, select here.

4. Select the required ERP source for the Oracle Financial Cloud using the search option.

5. To create a new ERP source, perform the following steps:

a. Select New.

b. On the form, fill the fields.

Define a new ERP source configuration

Field Description

ERP Source ERP source for which the integration is 
required. For example, Oracle Financial 
Cloud.

Short Description Summary of the ERP source.

Active Option to activate the ERP source.

Amount Precisions Amount precision of the ERP source. For 
example, 2.

c. Select Submit.
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A new ERP source is created. Verify that the connection alias is also unique for each ERP 
source.

Note:  Oracle Financial Cloud integration can have multiple ERP sources. The Staging 
table displays the ERP source column, which you can use to distinguish which ERP the 
data belongs to.

What to do next
By default, the Oracle Financial Cloud base system provides five service mappings. For other 
Oracle Financial Cloud instances, you need to perform the following:

• Define service mappings manually for each integration service by accessing the Service 
Mappings related list. You can define element level mapping between Oracle Financial Cloud 
table fields and payload elements.

• Map the users and corresponding ERP User IDs by accessing the ERP User Mappings related 
list.

Configure integration services for Oracle Financial Cloud

For configuring integration services, provide the connection end point and the Oracle Financial 
Cloud ERP credentials that you set up for your authentication profile. Also, create a separate web 
service record for each service request that you want to customize.

Before you begin

• Verify that the application scope is set to Oracle Financial Cloud spoke.

• Verify that the MID Server  is installed and configured in your ServiceNow  instance to connect 
to the ERP server. For more details, see Installing the MID Server .

Note:  The MID Server integration is required only for an Oracle Financial Cloud ERP 
integration using SOAP services.

• For REST type service, REST API details, as provided by ERP.

Role required: sn_fcms_intg.integration_user

About this task
If the application requires multiple Oracle Financial Cloud ERP instances, create separate web 
services for each ERP instance. You can create Integration Service records for entities using the 
sn_fcms_intg_service  table.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Open the ERP source for which you need to configure integration services.
For example, Oracle Financial Cloud.

3. In the Integration Services list, select the service that you want to configure.

4. On the integration service record, fill in the fields.

Integration service record

Field Description

Entity The type of entity for which you want to configure the 
integration services.
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Field Description

Application Name of the application. For example, Oracle 
Financial Cloud.

ERP Source configuration The ERP source mapped to the entity. For example, 
Oracle Financial Cloud.

Active The status of the interaction service. By default, the 
check box is inactive.

Subflow The subflow used to fetch primary data.

Properties
Creates a JSON record in the integration service, 
which is then passed to the ERP subflows to retrieve 
complete data.

To pass JSON into the subflow, create a property 
named "query" and assign it a JSON query as its 
value, like this:

[
  {
    "parameter": 
 "LEGAL_ENTITY_NAME",
    "operator": "=",
    "value": "Vision ADB",
    "operand": "NONE"
  }
]

◦ Enabling Full Pull:

Use this property to fetch the complete data.

▪ Create a property named "full_pull" and set 
its value to true.

▪ Additionally, you can create another property like, 
"initial_load_start_date_time" and 
set its value to 2025-02-15T04:10:34.

◦ Enabling Delta Pull:

Use this property to fetch the incremental data.

Set the value of the "full_pull" property to 
false.

Order Option to choose the order in which the entity should 
be displayed.

5. Select Update.
The integration service is configured for the selected entity.

Load data to ERP user-mapping table for Oracle Financial Cloud

Set up Oracle Financial Cloud and ERP User ID mapping for the integration to work. The mapping 
is maintained for all active users who have the procurement buyer role in ERP. These users 
should be used in the requisition assignment rule.
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Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. Select Create table  and enter a label for the new table in the Label  field.

3. In the Source of the import  field, select the File  option.

4. Select Choose File  to import the source Excel spreadsheet.

5. Optional:  If appropriate, specify the Work sheet and Header row number.

6. Select Submit.
The imported data is now available in the new Import Set table.

7. Create a transform map  to define the field mapping between columns of the import set and 
columns of the target ERP User Mapping [sn_fcms_intg_erp_user_map] table.
The ERP User Mapping table maintains mapping between ERP user IDs and ServiceNow  user 
IDs.

8. Transform the data from the import set table to the target table.
For more information, see Run an import .
The data is imported into the Oracle Financial Cloud ERP User Mapping 
(sn_fcms_intg_erp_user_map)  table.

What to do next
Verify that the data records are imported into the target table. You can view the Oracle Financial 
Cloud ERP user mappings by navigating to Finance - ERP Integration  > ERP Users.

Note:  If an ERP user mapping isn’t required, you can deactivate it. To deactivate a 
mapping, in the ERP User Mapping form, select the Inactive  check box.

Look up primary data in Oracle Financial Cloud

You can run a job to look up primary data from different ERP sources into ServiceNow.

Before you start the ERP integration, you must configure the integration services 
record for the target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating an integration service record, see Create Integration Service 
record.

You can manually run jobs for the following entities:

Look up primary data in Oracle Financial Cloud

Entity Table name

Suppliers Supplier location inbound staging table

Payment Terms Payment Terms Stage inbound staging table

Legal entities Legal Entity Stage inbound staging table

Currencies FX Currency Stage inbound staging table

GL Accounts GL Account Stage inbound staging table

Purchasing Organizations Purchase Entity Stage inbound staging table

Plant Addresses CMN Location Stage inbound staging table
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Look up primary data in Oracle Financial Cloud  (continued)

Entity Table name

Cost Centers Cost Center Stage inbound staging table

Transformation maps and subflows

To learn more about the Transformation maps and subflows, see Source-to-Pay integration 
framework transform maps and subflows.

Scheduled jobs to look up primary data in Oracle Financial Cloud

You can schedule on-demand jobs to be run at specific intervals of time to fetch primary data 
from different Oracle Financial Cloud ERP sources into ServiceNow.

Before you start the Oracle Financial Cloud ERP integration, you must configure the integration 
services record for target ERP source using the sn_fcms_intg_service  table. The 
sn_fcms_intg_service  table is a mapping table between sub flows and target ERP source. 
For more information on creating an integration service record, see Create Integration Service 
record.

Scheduled jobs are configured for entities using scripts. Example: Fetch cost center from ERP 
systems. For more information on configuring scheduled jobs using scripts, see Automatically 
run a script of your choosing . The script invokes a subflow, which is associated with an entity as 
shown in the following figure. The subflow queries the active entities or ERP source configuration 
(optional) listed in the integration service table.

Run scheduled jobs in Oracle Financial Cloud

Run adhoc scheduled jobs to look up entity primary data from the target Oracle Financial Cloud 
ERP source.

Before you begin
Role required: sn_fcms_intg.integration_user

About this task
Executes on-demand scheduled jobs on true entities of an ERP source target and fetches 
primary data. Auto-populates the entity inbound tables.

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. Select the ERP source for which you would like to run scheduled jobs.

3. Select Integration Services  >Run job.
The fetch services run automatically as scheduled.
Entity inbound tables are populated with primary data.

Use the Source-to-Pay integration with Oracle Financial Cloud

Learn how you can use Source-to-Pay integration with Oracle Financial Cloud to handle sales 
orders, procurement, finance, and so on, in Oracle Financial Cloud from your ServiceNow 
instance.

Use schedule flows in Oracle Financial Cloud

Use the schedule flows to retrieve information from Oracle Financial Cloud, including Currencies, 
General Ledger (GL) accounts, Legal entities, Payment terms details from Oracle Financial Cloud.
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You can either use the subflows to perform the required tasks or you can create a copy of the 
subflows and then customize it according to your requirements. The Source-to-Pay with Oracle 
Financial Cloud integration supports the following subflows:

Primary Data Integration with Oracle Financial Cloud

The Primary Data Integration with Oracle Financial Cloud integration supports the following 
subflows or actions:

Scheduled subflow details for Primary Data Integration with Oracle Financial Cloud

Subflow Description

Fetch Payment Terms Use this subflow to fetch and synchronize all 
payment terms from Oracle Financial Cloud 
system.

Fetch Legal Entities Use this subflow to fetch and synchronize 
all legal entities from Oracle Financial Cloud 
system.

Fetch Currencies Use this subflow to fetch and synchronize 
all currencies from Oracle Financial Cloud 
system.

Fetch GL Accounts Use this subflow to fetch and synchronize 
all GL Accounts from Oracle Financial Cloud 
system.

Fetch Purchase Groups Use this subflow to fetch and synchronize 
all purchasing groups from Oracle Financial 
Cloud system.

Fetch Cost Center Use this subflow to fetch and synchronize 
all cost centers from Oracle Financial Cloud 
system.

Fetch Purchasing Orgs Use this subflow to fetch and synchronize 
all purchasing organizations from Oracle 
Financial Cloud system.

Fetch Plant Address Use this subflow to fetch plant addresses from 
Oracle Financial Cloud system.

Important: 

These subflows are read only. To modify a flow or subflow, create a copy and then apply the 
required changes.

Supplier Lifecycle Operations Integration with Oracle Financial Cloud

The Supplier Lifecycle Operations Integration with Oracle Financial Cloud supports the following 
subflows:
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Scheduled subflow details for Supplier Lifecycle Operations Integration with Oracle 
Financial Cloud

Flow Description

Create or update supplier location Creates or updates supplier location in Oracle 
Financial Cloud.

Create or update supplier payment 
information

Creates or updates supplier payment 
information in Oracle Financial Cloud.

Create, update or deactivate supplier Creates or updates or deactivates supplier 
details in Oracle Financial Cloud.

Important: 

These subflows are read-only. To modify a flow or subflow, create a copy and then apply the 
required changes.

Manually trigger flows or subflows in Oracle Financial Cloud (Inbound)

You can manually trigger flows or subflows in Oracle Financial Cloud on demand. Follow these 
steps to manually trigger a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Finance – ERP Integration  > ERP Source Configuration.

2. In the ERP Configurations view, select the Oracle Financial Cloud  ERP source to manually 
trigger the flows or subflows.

3. In the Integration Services list, select the subflows that you want to manually trigger.

4. Select Run job  to trigger the flow or subflow.

5. Navigate to All  > Process Automation  > Workflow Studio.

6. From the Workflow Studio home page, select the Operations  tab and then select Flows  tab.
The list of flow executions appear. You can look up the status of the flows or subflows that you 
triggered. If there were any errors during execution, you can view them under the processing 
message column.

7. Navigate back to the Homepage  tab, and select Flows  or Subflows.

8. Look up the Flow  or Subflow  name or Oracle Financial Cloud  application name using the filter 
icon, and select Apply.
You can view the flows or subflows that you triggered.

9. You can use the trigger condition as a part of the base system to execute the flow or subflow.

Note:  Don’t modify the trigger condition.

The flow or subflow is executed.

Use a flow or subflow in Oracle Financial Cloud (Outbound)

A flow or subflow can be executed in Oracle Financial Cloud using the Workflow Studio. Follow 
these steps to run a flow or subflow.
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Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio home page, select Flows.

3. Look up the Flow  name or Oracle Financial Cloud  application name using the filter icon, and 
select Apply.

4. Select the required flow from the list.

For example, select Create or update supplier location  flow.

5. In the Trigger field, specify the time and interval at which you want to run the scheduled flow 
automatically.

This flow subsequently triggers subflows to automate tasks. To customize the sample flow, 
copy it to the desired application scope.

Note:  Don’t modify the trigger condition.

The flow or subflow is executed.

Copy a flow or subflow in Oracle Financial Cloud

You can create a copy of the a flow or subflow and make the necessary modifications. Use the 
following steps to activate a flow or subflow.

Before you begin
Role required: sn_fcms_intg.integration_user

Procedure

1. Navigate to All  > Process Automation  > Workflow Studio.

2. From the Workflow Studio homepage, select Flows.

3. Open the flow that you want to copy.

4. Click the  more actions icon, and select Copy flow.

Important:  Perform this step only if you plan to customize or make specific changes to 
the flow.

5. Activate the flow or subflow.

◦ Make sure that the flow or subflow is available and activated on the base system.

◦ Activate the copied flow after making the required changes.

6. Use the Trigger Condition  for the flow or subflow.

This flow or subflow is triggered and associated with the purchase order when the following 
conditions are met:

◦ Legal entity . ERP source . Active  is true.

◦ Legal entity . ERP source . ERP Source  is not empty.

◦ Status  is Pending Submission
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Note:  Do not modify the trigger condition.

Note:  Once data is pulled into staging tables, transform maps move data into target 
tables. For more details, refer to Source-to-Pay integration framework transform maps and 
subflows

You have successfully copied and executed the flow.

Source-to-Pay integrations reference

Reference topics provide additional information on integrating Source-to-Pay Operations  with 
third-party applications, including primary data, fixed assets, purchase orders, receipts, invoices, 
and tax integration between Source-to-Pay and ERP systems.

Source-to-Pay Integrations glossary

Learn about the terms and concepts used in Source-to-Pay (S2P) integrations.

Glossary terms are grouped alphabetically.

A  | C  | D  | E  | I  | M  | P  | R  | S  | T  | W

A

API (Application Programming Interface)

A set of rules that allows different software entities to communicate with each other.

Asynchronous Integration

A type of integration where the systems involved communicate without waiting for an 
immediate response.

C

Catalog Management

The process of managing product and service information in a structured way.

Cloud Contact Center

A cloud-based customer service solution that handles inbound and outbound 
communications.

Contract Management

The process of managing contract creation, execution, and analysis to maximize 
operational and financial performance.

D

Data Synchronization

The process of ensuring that data in two or more locations is updated consistently.

E

EDI (Electronic Data Interchange)

The electronic interchange of business information using a standardized format.
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I

integration

The ability to connect ServiceNow’s legal tools with other apps so they work together.

Invoice

A document issued by a seller to a buyer, indicating the products, quantities, and agreed 
prices for products or services provided.

M

middleware

The software that acts as a bridge between different applications or services.

P

Procurement

The process of finding, acquiring, and buying goods, services, or works from an external 
source.

R

receipt

A document acknowledging that a specified amount of money, goods, or services has been 
received.

Return

The process of sending back goods to the supplier due to various reasons such as defects 
or incorrect orders.

S

SAP ECC

An enterprise resource planning software developed by SAP SE, used for business process 
management.

SAP S/4HANA

A next-generation enterprise resource planning suite from SAP, designed to run on the SAP 
HANA database.

Source-to-Pay (S2P)

A process that encompasses all activities from sourcing goods and services to paying 
suppliers.

Supplier Lifecycle Management

The end-to-end process of managing a supplier's performance and relationship with the 
organization.

Supplier Portal

An online platform where suppliers can interact with the buying organization.
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synchronous integration

A type of integration where the systems involved communicate in real time.

T

third-party application

An external software system that can be integrated with ServiceNow to extend its 
capabilities.

3CLogic

A ServiceNow partner that provides native voice and SMS capabilities to complement 
ServiceNow’s digital channels.

W

Workflow

A sequence of activities to automate processes in applications.

Source-to-Pay integrations with Oracle reference

Reference topics provide additional information on integrating Source-to-Pay Operations  with 
Oracle, including sales orders, procurement, finance, and so on, between Source-to-Pay and 
ERP systems.

Set system properties for Oracle Integration

Use these system properties to configure settings for the Oracle integration from the System 
Properties page.

Role required:

• Read Role: sn_shop.procurement_specialist, sn_shop.shopper, sn_fcms_intg.admin

• Write Role: sn_fcms_intg.admin

To access the system properties list, perform the following steps:

1. Navigate to All.

2. Search for sys_properties_list.do  and open the system properties list.

3. Look up Primary Data Integration with Oracle using the filter option.

4. The following system properties are available as a part of the base system.

Note:  You can modify these values only if necessary.

Improve sourcing experience when working with new suppliers
With Sourcing and Procurement Operations  and Supplier Lifecycle Operations  together, provide 
complete visibility to all the stakeholders involved in the sourcing process, along with improved 
supplier onboarding experience.

Workflow of the sourcing experience

The following figure shows how an employee, procurement specialist, supplier manager, and 
supplier use the SPO and SLO applications together to get complete visibility into the sourcing 
process and simultaneously enjoy improved supplier onboarding experience.
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Workflow of the sourcing experience

In this workflow:

1. An employee visits Shopping Hub  (or Employee Center) and creates a sourcing request with a 
new supplier to be onboarded.

2. Work assignment rules route the request to a procurement specialist's workspace.

3. The procurement specialist initiates automated supplier qualification, which creates required 
cases, including a new supplier onboarding case that is assigned to a supplier manager.

4. The supplier manager reviews the supplier onboarding case and uses the onboarding 
playbook in the supplier workspace to onboard suppliers.

5. The playbook generates tasks and assigns them to the supplier being onboarded.

6. The supplier contact views the assigned tasks in the Supplier Collaboration Portal.

7. The supplier contact completes the assigned tasks and submits the required questionnaire in 
the Supplier Collaboration Portal.

8. The supplier manager reviews the collected supplier data and completes the onboarding 
playbook in the supplier workspace.

9. The employee, procurement specialist, and supplier manager have complete visibility into 
the status of work, including supplier onboarding, through process completion, from their 
respective portals.

Requirements for sourcing with a new supplier

Install and activate these plugins.

• Shopping Hub [com.snc.sn_spend_uib]

• Sourcing and Purchasing Automation [com.snc.sn_pr]

• Procurement Case Management [com.sn_spend_psd]

• Source-to-Pay Workspace [com.sn_spend_workspace]

• Playbooks for Sourcing and Procurement Operations [com.sn_spend_cp]

• Advanced Work Assignment for Sourcing and Procurement Operations 
[com.snc.sn_spend_awa]
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• Supplier Common Architecture [com.snc.sn_slm]

• Supplier Lifecycle Operations [com.snc.sn_supplier_mgmt]

• Supplier Collaboration Portal [com.snc.sn_supplier_sp]

• Advanced Work Assignment for Supplier Lifecycle Operations [com.snc.sn_slm_awa]

• Source-to-Pay Common Architecture [com.snc.sn_shop]

• Finance Common Architecture [com.sn_fin]

• Common Service Delivery [com.sn_spend_sdc]

• Risk Assessments Integration for Sourcing and Procurement Operations [com.sn_spend_vrm]

For information on the installation sequence, see Application plugin installation sequence in 
Sourcing and Procurement Operations.

Get started with sourcing with a new supplier

To get started with sourcing with a new supplier, follow these steps:

1. Request for a product or service that you don't see on Shopping Hub, and add a new supplier 
that you prefer to source it from. For more information, see Requesting for products or services 
that you don't see on ShoppingHub.

Role: sn_shop.shopper.

2. Review the sourcing request and its associated purchase lines on the Source-to-Pay 
Workspace. For more information, see SPO list page.

Role: sn_shop.procurement_specialist.

3. Begin the qualification process to onboard the new supplier. For more information, see 
Supplier qualification.

Role: sn_shop.procurement_specialist.

4. Review the supplier onboarding case and start the supplier onboarding using playbooks. For 
more information, see Use the supplier onboarding playbook to onboard suppliers.

Role: sn_slm.manager.

5. The playbook automatically creates supplier tasks to conduct risk assessment and to collect 
supplier information, such as banking information and location details.

6. Log in to the Supplier Collaboration Portal  and complete the following:

◦ Assigned tasks. For more information, see Viewing supplier contact tasks from the Supplier 
Collaboration Portal.

◦ Risk assessment questionnaire. For more information, see Complete a risk assessment from 
the Supplier Collaboration Portal.

Role: sn_slm.contact.

7. Review the collected supplier information and determine whether to continue or cancel the 
onboarding process.

Role: sn_slm.manager.
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8. Complete the different activities in each stage of the playbook to successfully onboard the 
new supplier.

Role: sn_slm.manager.

Sourcing and Procurement Operations
With ServiceNow  Sourcing and Procurement Operations  (SPO), you can provide your employees 
with a simple automated AI-assisted tool that they can use to shop for goods and services that 
they need at work.

SPO value proposition

Provide a seamless procurement experience with:

Explore

Learn how SPO can 
help you with its key 

features and benefits.

Configure

Plan and configure SPO to 
meet your specific needs.

Integrate

Extend SPO capabilities 
by integrating with 
other applications.
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Get started

Explore

Learn more about 
Now Assist for SPO

Configure

Configure the Now 
Assist for SPO

application to get started

Use

Use generative AI 
capabilities offered by 

Now Assist for SPO

Use Sourcing and 
Procurement Operations

AI agent collection

Use agentic workflows 
in Now Assist for SPO

Important: 

• Not all model providers are available for customers with in-country SKUs, and some Now 
Assist  products/features are currently unavailable for in-country customers. For more 
information, see the KB1584492  article in the Now Support Knowledge Base. Be sure to 
check for model provider availability updates in future releases.

• Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the 
KB0743854  article in the Now Support  Knowledge Base . Be sure to check for availability 
updates in future releases.

• Some Now Assist  products/features are currently available only for customers in some 
regions. Be sure to check for availability updates in future releases.

• Some AI products and skills are not available in Regulated Markets. For more information, 
see KB2593939: Regulated Markets AI Products/Skills Not Available . Be sure to check 
for availability updates in future releases.

Supported LLMs for Now Assist for Sourcing and Procurement Operations 
(SPO)

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .
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Troubleshoot and get help

• ServiceNow Community on AI and Intelligence

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support.

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-

making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .

Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. Customers can opt out of future data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Explore Now Assist for Sourcing and Procurement Operations (SPO)

Now Assist for Sourcing and Procurement Operations (SPO)  is an application that adds 
generative AI capabilities to the Source-to-Pay Workspace  to help requesters and procurement 
teams work more efficiently.

Overview of Now Assist for Sourcing and Procurement Operations (SPO)

Now Assist for Sourcing and Procurement Operations (SPO)  uses generative AI to handle 
procurement requests and understand records, which helps procurement teams improve 
visibility, reduce manual effort, and make faster, smarter decisions throughout the procurement 
process.

Now Assist for Sourcing and Procurement Operations (SPO)  includes the following capabilities:

• Provides AI-assisted conversational intake, enabling requesters to submit procurement 
requests in natural language. Now Assist for SPO  uses procurement-related topics to route 
requests to the appropriate intake process and helps requesters submit accurate requests 
without relying on fulfillers.

• Produces generative AI-powered record summaries that help requesters and fulfillers quickly 
interpret completed actions, status, and next steps.

• Embeds summary access across procurement experiences, including Source-to-Pay 
Workspace, Shopping Hub, and the Now Assist  panel.

• Monitors requester sentiment across active procurement cases, enabling procurement 
specialists to identify, prioritize, and manage sensitive requests proactively

• Assists procurement specialists and buyers in composing clear, professional, and accurate 
email responses using Now Assist.
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Now Assist skills for Sourcing and Procurement Operations

The following skills are available in Now Assist for Sourcing and Procurement Operations (SPO).

• Skills available for requesters:

◦ Document extraction

◦ Purchase requisition summarization for requesters

◦ Purchase order summarization for requesters

◦ Sourcing request summarization for requesters

Note:  A requester with the sn_spend_gen_ai.now_assist_requester role can use these 
summarization skills in Shopping Hub.

• Skills available for fulfillers:

◦ Email response for acknowledgement task

◦ Email response for negotiation

◦ Email response for procurement case

◦ Email response for procurement task

◦ Email response for purchase requisition

◦ Email response for sourcing event

◦ Email response for sourcing request

◦ Email response for sourcing task

◦ Negotiation summarization for fulfillers

◦ Procurement case summarization for fulfillers

◦ Product category predictor

◦ Purchase requisition summarization for fulfillers

◦ Sentiment analysis for procurement case

◦ Sourcing request summarization for fulfillers
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◦ Sourcing event summarization for fulfillers

◦ Spend category predictor

Note:  A fulfiller with the sn_spend_gen_ai.now_assist_fulfiller role can use these 
summarization skills in Source-to-Pay Workspace.

For more information about setting up Now Assist for SPO, see Configure Now Assist for Sourcing 
and Procurement Operations (SPO).

As a requester, you can use Now Assist for SPO  to:

• Submit purchase requisitions

• Sourcing requests

• Request for products or services that aren't available in the catalog

For guidance on using these capabilities in Now Assist for SPO, see Using Now Assist for 
Sourcing and Procurement Operations (SPO).

Now Assist for SPO  is also available in Virtual Agent, where it uses large language models (LLMs) 
and generative AI skills to enhance conversational experiences. These capabilities help improve 
deflection rates and reduce the manual effort required for Natural Language Understanding (NLU) 
topic discovery.

For detailed information about Now Assist  in Virtual Agent  and how to use generative AI skills in 
your conversations, see Now Assist in Virtual Agent .

To understand how you can interact with the Virtual Agent  when Now Assist  capabilities are 
enabled in your instance, see Exploring Now Assist in Virtual Agent .

During the Conversational Interfaces Assistants guided setup, a Now Assist  assistant for Virtual 
Agent  is created automatically. For more information about this assistant, see LLM assistants .

Domain separation is supported for Now Assist  in Virtual Agent. For more information, see Now 
Assist in Virtual Agent domain separation .

Supporting information for Now Assist for Sourcing and Procurement Operations (SPO)

Get a quick overview of the important information that is related to the Now Assist for Sourcing 
and Procurement Operations (SPO)  application.

Supported versions

Now Assist for SPO  is supported starting with Xanadu.

Supported user interfaces

The Now Assist for SPO  application includes the skills that are listed in the following table.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

309

https://www.servicenow.com/docs/access?context=now-assist-in-va-landing&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=now-assist-in-va-landing&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=now-assist-in-va-landing&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-now-assist-va&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-now-assist-va&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-now-assist-va&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=llm-assistants&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=llm-assistants&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=llm-assistants&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=na-in-va-domain-separation&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=na-in-va-domain-separation&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=na-in-va-domain-separation&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US
https://www.servicenow.com/docs/access?context=na-in-va-domain-separation&version=yokohama&pubname=yokohama-conversational-interfaces&ft:locale=en-US


Now Assist for SPO supported interfaces

Interface Skill

Virtual Agent • Conversational catalog shopping 
experience in Now Assist  in Virtual Agent.

• Document extraction

• Track request status

Source-to-Pay Workspace • Email response for acknowledgement task

• Email response for negotiation

• Email response for procurement case

• Email response for procurement task

• Email response for purchase requisition

• Email response for sourcing event

• Email response for sourcing request

• Email response for sourcing task

• Negotiation summarization for fulfillers

• Procurement case summarization for 
fulfillers

• Product category prediction

• Purchase requisition summarization for 
fulfillers

• Sentiment analysis for procurement case

• Sourcing request summarization for fulfillers

• Sourcing event summarization for fulfillers

• Spend categories prediction

Shopping Hub • Purchase order summarization for 
requesters

• Purchase requisition summarization for 
requesters

• Sourcing request summarization for 
requesters

Core UI • Negotiation summarization for fulfillers

• Procurement case summarization for 
fulfillers

• Product category predictor

• Purchase requisition summarization for 
fulfillers

• Sentiment analysis for procurement case

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

310



Now Assist for SPO supported interfaces  (continued)

Interface Skill

• Sourcing event summarization for fulfillers

• Sourcing request summarization for fulfillers

• Spend category predictor

Application information

Activate the Now Assist for SPO  store app (sn_spend_gen_ai) to use the Conversational intake 
experience and Record summarization skills.

This store app has the following dependencies:

• Now Assist for Platform (com.sn.now.platform)

• Sourcing and Purchasing Automation(com.snc.sn_pr)

• Now Assist for FSC Common (sn_fsc_genai)

Activate the applications in the following order:

1. Now Assist for Platform (sn_genai_platform)

2. Sourcing and Purchasing Automation (com.snc.sn_pr)

3. Now Assist for FSC Common (sn_fsc_genai)

4. Now Assist for Sourcing and Procurement Operations (SPO)  (sn_spend_gen_ai)

For more information, see Configure Now Assist for Sourcing and Procurement Operations (SPO).

Configure Now Assist for Sourcing and Procurement Operations (SPO)

If you have the admin role, you can configure the Now Assist for Sourcing and Procurement 
Operations (SPO)  application so that your requesters, procurement specialists, and sourcing 
managers can use the generative AI skills in Source-to-Pay Workspace, Shopping Hub, and Core 
UI.

Before you begin
Role required: admin

About this task
The following Now Assist for Sourcing and Procurement Operations (SPO)  fulfillers skills are 
activated by default:

• Email response for acknowledgement task

• Email response for negotiation

• Email response for procurement case

• Email response for procurement task

• Email response for purchase requisition

• Email response for sourcing event

• Email response for sourcing request

• Email response for sourcing task
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• Sentiment analysis for procurement case

• Sourcing request summarization for fulfillers

• Sourcing event summarization for fulfillers

• Negotiation summarization for fulfillers

• Purchase requisition summarization for fulfillers

• Procurement case summarization for fulfillers

If the Now Assist for Sourcing and Procurement Operations (SPO)  fulfillers skills are turned off, 
you can reactivate them or configure them using the Now Assist Admin  console. The console 
contains everything that you need to install the plugins and configure the generative AI skills. For 
more information, see Now Assist Admin console .

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

The following table lists the features and skills that you can access from the Now Assist Admin 
console.

Now Assist for SPO  features and skills in the Now Assist Admin  console

Now Assist for SPO  skills Description

Document extraction Enables requesters to define and customize 
the fields that Now Assist extracts from 
uploaded Statements of Work (SOWs), quotes, 
and other supporting attachments.

Email response for acknowledgement task Generate email responses and suggest 
templates for acknowledgement tasks based 
on conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for negotiation Generate email responses and suggest 
templates for negotiations based on 
conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for procurement case Generate email responses and suggest 
templates for procurement cases based 
on conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for procurement task Generate email responses and suggest 
templates for procurement tasks based 
on conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for purchase requisition Generate email responses and suggest 
templates for purchase requisitions based 
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Now Assist for SPO  features and skills in the Now Assist Admin  console  (continued)

Now Assist for SPO  skills Description

on conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for sourcing event Generate email responses and suggest 
templates for sourcing events based on 
conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for sourcing request Generate email responses and suggest 
templates for sourcing requests based 
on conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Email response for sourcing task Generate email responses and suggest 
templates for sourcing tasks based on 
conversation context to help fulfillers 
draft emails quickly and maintain clear 
communication.

Negotiation summarization for fulfillers Summarize negotiations to keep fulfillers 
informed on their status, progress, and action 
items.

Procurement case summarization for fulfillers Summarize procurement cases and keep 
fulfillers informed about their status, progress, 
and action items.

Purchase requisition summarization for 
fulfillers

Summarize purchase requisitions and keep 
fulfillers informed about their status, progress, 
and action items.

Purchase requisition summarization for 
requesters

Summarize purchase requisitions to keep 
requesters informed about their status, 
progress, and action items.

Product category predictor Suggests the most likely product category for 
a fulfiller when the primary ML-based category 
prediction doesn’t meet the confidence 
threshold.

Purchase order summarization for requesters Summarize purchase orders to keep 
requesters informed about their status, 
progress, and action items.

Sentiment analysis for procurement case Analyze requester sentiment across 
procurement case to help fulfillers prioritize 
urgent issues and make informed decisions. 
This skill provides sentiment evaluations, 
trend analysis, and AI-generated summaries 
that explain the reasoning behind each 
sentiment.
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Now Assist for SPO  features and skills in the Now Assist Admin  console  (continued)

Now Assist for SPO  skills Description

Sourcing event summarization for fulfillers Summarize sourcing events to keep fulfillers 
informed on their status, progress, and action 
items.

Sourcing request summarization for fulfillers Summarize sourcing requests and keep 
fulfillers informed about their status, progress, 
and action items.

Sourcing request summarization for 
requesters

Summarize sourcing requests to keep 
requesters informed about their status, 
progress, and action items.

Spend category predictor Suggests the appropriate spend category for 
a fulfiller when primary ML-based category 
prediction doesn’t meet the confidence 
threshold.

Now Assist skills for SPO

Procedure

1. Install the Now Assist for Sourcing and Procurement Operations (SPO)  plugin 
(sn_spend_gen_ai).

◦ For information about the plugin dependencies and plugin activation order, see Supporting 
information for Now Assist for Sourcing and Procurement Operations (SPO).

◦ For information about the installation process, see Install Now Assist plugins .

2. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Features  tab of the Now 
Assist Admin  console.

3. Expand the Finance and Supply Chain  workflow group and select Sourcing and Procurement 
Operations.

The Sourcing and Procurement Operations features are grouped under the Finance and 
Supply Chain workflow group. Each feature has its associated skills.
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4. Activate and configure the skills for Now Assist for Sourcing and Procurement Operations 
(SPO).

Now Assist for Sourcing and Procurement Operations (SPO)  skills

Skills Action

◦ Document extraction

◦ Sourcing request summarization for 
requesters

◦ Purchase requisition summarization for 
requesters

◦ Purchase order summarization for 
requesters

On the skill card that you want to activate, select 
Activate skill.

◦ Email response for acknowledgement 
task

◦ Email response for negotiation

◦ Email response for procurement case

◦ Email response for procurement task

◦ Email response for purchase 
requisition

◦ Email response for sourcing event

◦ Email response for sourcing request

◦ Email response for sourcing task

◦ Sentiment analysis for procurement 
case

◦ Sourcing request summarization for 
fulfillers

◦ Purchase requisition summarization for 
fulfillers

◦ Procurement case summarization for 
fulfillers

◦ Negotiation summarization for fulfillers

◦ Sourcing event summarization for 
fulfillers

On the skill card that you want to activate, select 
Activate skill.

5. Select General details  and review the details about the skill and select Save and continue  to 
go to the next step in the Guided Setup.

6. Follow the steps to configure and activate a skill using the Guided Setup.

7. Select Choose input  for the skill and review the base input table and input fields, and then 
select Save and continue  to go to the next step in the Guided Setup.

8. Optional:  Select Customize and test prompt  to test the prompt on a record.

9. Select Save and continue  to go to the next step in the Guided Setup.

10. Optional:  Select Define availability  and choose one of the following options.
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Option Description

Skill is always available Skill is continuously available to users.

Customize skill availability

The skill is available only when the certain 
conditions are met (Default).

(Optional) Use the condition builder to set 
your conditions.

11. Select Save and continue  to go to the next step in the Guided Setup.

12. Choose Select display  to determine where you'd like to display the skill.

Option Description

In-product desktop
Now Assist  skills are displayed on forms and 
workspaces.

Now Assist  panel

Now Assist  skills are available in the Now As­
sist  panel.

Now Assist  skills are available in the Now As­
sist  panel. Turn on multi-language support for 
user-entered text with Dynamic Translation 
in Now Assist applications. For more informa­
tion, see Configure multilingual service for 

.

Note:  If you don't see this option, you 
must activate the Now Assist  panel. For 
more information, see Activate Now As­

.

13. Select Save and continue  to go to the next step.

14. Review your choices and select Activate  to complete the configuration for the skill.

15. Select Return to Sourcing and Procurement Operations..
The skill is activated.

Customize a Now Assist for Sourcing and Procurement Operations (SPO)  skill

If you have the admin role, you can customize a Now Assist for Sourcing and Procurement 
Operations (SPO)  skill so that fulfillers and requesters can use the generative AI skills in Source-
to-Pay Workspace, Shopping Hub, and in Core UI.

Before you begin
Role required: admin

About this task
From the Now Assist Admin  console, you can select the input table, related records, and fields 
for each input template of the Summarization for fulfillers skill, and then configure the prompt 
headers to include in the general summary.
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Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Skills  tab of the Now 
Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Sourcing and Procurement 
Operations  to view the skills for the Now Assist for SPO  features.

3. Create a copy of a skill and customize the input fields.

a. On the skills card that you want to copy, select the More actions icon ( )..

b. In the Active skills section, locate the skill that you'd like to copy and select the More actions 

icon ( ), and then select Make copy.
The copied skill opens and a guided setup leads you through the configuration of the 
general details, input, prompt, availability, display, review, and activation of the customized 
skill. If you complete the entire walk-through, the skill is activated.

4. In the General details step, fill in the fields.
For information about the inputs and triggers for each skill, see Skill inputs for Now Assist for 
Sourcing and Procurement Operations (SPO).

a. Enter a name and description for the skill.

b. Select Save and continue  to go to the next step.

5. View the input data for each skill, such as the base input fields and related lists for the different 
input templates.

Configure the base input table fields and related lists for the different input templates for the 
skill.

Each skill relies on a base input table and input fields with descriptions to provide context for 
the Now LLM Service  to generate a response.

Select only those related tables that are offered as the base system, as part of the input data.

a. For each input template state, select +New base input field  and configure the base input 
table fields.

Add multiple base input fields, as necessary.
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Choose input step

The following table lists the base input table fields and descriptions, including a relevant 
example.

Base input fields

Field Description

Base input field
Field in the case table whose value this skill 
uses in its response.

For example, Product category.

Field description
Description of the base input field value.

For example, The category of the 
product purchased.

b. For each input template state, configure the rule conditions by using the condition builder to 
filter the data.

The rule conditions determine when the input template is used. By default, the record state 
determines the input template that the Now LLM Service  uses.

You can build the condition out further by selecting +New condition set  and configuring 
additional parameters.

c. For each input template state, select +New data source  to configure the additional related 
table and activity stream data, as needed.

You can add input data sources like related tables, activity streams and relationships to 
provide more context to the Now LLM Service. You can also add rule conditions to these 
additional data sources.

You can also add the rule conditions to these additional data sources.

The selection of the related table fields may have a direct impact on the quality of the 
corresponding prompt header. For example, if a prompt header requires a specific field 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

318



from the related table, but that field isn’t selected as input, the summary for that prompt 
header will contain missing information. For example, as a base case, you see one related 
table, such as Service level agreement (SLA), that includes all the required fields and 
filtering conditions for the prompt header. The SLA prompt header is preselected to help 
you understand how the related table, its fields, and the prompt header work together to 
produce a summary. You can use the SLA as a reference to configure the other related tables 
to determine which fields to select and which description adds the requirements of their 
respective prompt headers. Apply any additional conditions to filter the data further.

d. Select Save and continue  to go to the next step.

6. Customize the prompt.

Review and test the prompt for each input template configuration. You can edit the prompt by 
adding new predefined sections and reordering them, as needed.

a. For each input template state, select the prompt sections from the list of available sections 
to include in the generated summary.

To add a section, you must configure the relevant input data prior to this step.

For example, for the Sourcing request summarization for requesters skill, you can select the 
following available prompt sections:

▪ Requester overview for SR

▪ Requester next steps for SR

▪ Requester SR closed

The following table lists the mandatory prompt headers for the Sourcing request 
summarization for requesters skill.

Mandatory prompt headers

Input template state Mandatory prompt header

Open ▪ Requester overview for SR

▪ Requester next steps for SR

Closed Requester SR closed

b. Select Save  to continue to the test response.

c. Select a record in the Test response section, and test the prompt response output format by 
selecting Run Test.

d. Select Save and continue  to go to the next step.

7. Define how the skill is available to your users.

a. Configure the skill to be always available to users, or select conditions that must be met 
before the skill is available.
Selecting Customize skill availability  displays a condition builder to filter the data further.

b. Select Save and continue  to go to the next step.
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8. Configure where to display the record summarization.

a. Select either In-product, or Now Assist panel.

▪ In-product: When selected, the Now Assist  skills are displayed on the forms and 
workspaces.

For the skills that appear in-product, select the down arrow to identify the roles that can 
use the skill.

▪ Now Assist panel: When selected, the Now Assist  skills are available in the Now Assist 
panel.

Now Assist  skills are available in the Now Assist  panel. Turn on multi-language support 
for user-entered text with Dynamic Translation in Now Assist applications. For more 
information, see Configure multilingual service for Now Assist applications .

Note:  If you don't see this option, you must activate the Now Assist  panel. For more 
information, see Activate Now Assist panel standard chat .

For the skills that appear in the Now Assist  panel, select the down arrow to identify the 
roles that can use the skill.

b. Select Save and continue  to go to the next step.

9. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
You can now select Summarize  in a record to generate the summary for the following records:

◦ Sourcing request

◦ Purchase requisition

◦ Procurement case

◦ Negotiation

◦ Sourcing event

◦ Purchase order

Skill inputs for Now Assist for Sourcing and Procurement Operations (SPO)

You can configure some of the inputs for a generative AI skill. Inputs permit you to determine how 
and when a skill is used.

Overview of skills

Inputs identify the data used for a skill. Inputs include the table and fields used to generate a 
record summary.

You can modify inputs, but you can't modify a skill's data source. The data source contains the 
tables and fields that the skill relies on.

Now Assist skills for Now Assist for SPO

The Now Assist for SPO  includes the following skills:

• Email response for acknowledgement task

• Email response for negotiation
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• Email response for procurement case

• Email response for procurement task

• Email response for purchase requisition

• Email response for sourcing event

• Email response for sourcing request

• Email response for sourcing task

• Negotiation summarization for fulfillers

• Procurement case summarization for fulfillers

• Purchase order summarization for requesters

• Purchase requisition summarization for fulfillers

• Purchase requisition summarization for requesters

• Sentiment analysis for procurement case

• Sourcing event summarization for fulfillers

• Sourcing request summarization for fulfillers

• Sourcing request summarization for requesters

Email response for acknowledgement task skill

Generates clear, context-aware email responses and ready-to-use acknowledgement templates 
that help fulfillers draft emails quickly while maintaining concise and effective communication.

The following table lists the inputs for Email response for acknowledgement task from Choose 
input for email response page in the Now Assist Admin  console.

Email response for acknowledgement task skill input

Input Description

Base input table sn_shop_acknowledgement_task

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for negotiation skill

Generates context-aware email responses and provides ready-to-use negotiation templates to 
help fulfillers draft emails quickly while maintaining clear, professional communication.

The following table lists the inputs for Email response for negotiation skill from Choose input for 
email response page in the Now Assist Admin  console.
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Email response for negotiation skill skill input

Input Description

Base input table sn_shop_negotiation

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for procurement case skill

Generates context-aware email responses and provides ready-to-use templates for procurement 
scenarios, enabling fulfillers to draft emails quickly while ensuring clear and professional 
communication.

The following table lists the inputs for Email response for procurement case from Choose input 
for email response page in the Now Assist Admin  console.

Email response for procurement case skill input

Input Description

Base input table sn_spend_psd_procurement_request

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for procurement task skill

Generates context-aware email responses and provides ready-to-use templates for procurement 
tasks, helping fulfillers draft emails quickly while maintaining clear and professional 
communication.

The following table lists the inputs for Email response for procurement task from Choose input for 
email response page in the Now Assist Admin  console.

Email response for procurement task skill input

Input Description

Base input table sn_spend_psd_procurement_task
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Email response for procurement task skill input  (continued)

Input Description

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for purchase requisition skill

Generates context-aware email responses and provides ready-to-use templates for purchase 
requisitions, enabling fulfillers to draft emails quickly while ensuring clear and professional 
communication.

The following table lists the inputs for Email response for purchase requisition from Choose input 
for email response page in the Now Assist Admin  console.

Email response for purchase requisition skill input

Input Description

Base input table Purchase Requisition 
[sn_shop_purchase_requisition] table.

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for sourcing event skill

Generates context-aware email responses and provides ready-to-use templates for sourcing 
events, enabling fulfillers to draft emails quickly while ensuring clear and professional 
communication.

The following table lists the inputs for Email response for sourcing event from Choose input for 
email response page in the Now Assist Admin  console.

Email response for sourcing event skill input

Input Description

Base input table sn_shop_negotiation_event
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Email response for sourcing event skill input  (continued)

Input Description

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for sourcing request skill

Generates context-aware email responses and provides ready-to-use templates for sourcing 
requests, helping fulfillers draft emails quickly while maintaining clear and professional 
communication.

The following table lists the inputs for Email response for sourcing request from Choose input for 
email response page in the Now Assist Admin  console.

Email response for sourcing request skill input

Input Description

Base input table sn_shop_sourcing_activity

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Email response for sourcing task skill

Generates context-aware email responses and provides ready-to-use templates for sourcing 
tasks, enabling fulfillers to draft emails quickly while ensuring clear and professional 
communication.

The following table lists the inputs for Email response for sourcing task from Choose input for 
email response page in the Now Assist Admin  console.

Email response for sourcing task skill input

Input Description

Base input table sn_shop_sourcing_task
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Email response for sourcing task skill input  (continued)

Input Description

Base input fields • Short description

• Description

• Emails

• Additional comments

• Work notes

• Activity

Negotiation summarization for fulfillers skill

Inputs for the Negotiation summarization for fulfillers skill identify the table and fields that are 
used when the summary is generated for a negotiation.

The following table lists the inputs for the Negotiation summarization for fulfillers from the 
Choose input for negotiation page in the Now Assist Admin  console.

Negotiation summarization for fulfillers skill input

Input Description

Base input table Negotiation [sn_shop_negotiation]

Base input fields • Short description

• Description

• Supplier

• Negotiation type

• Negotiation objectives

• Third party sourcing tool integration

• Third party sourcing record

• State

• Work notes

• Additional comments

Procurement case summarization for fulfillers skill

Inputs for the Procurement case summarization for fulfillers skill identify the table and fields that 
are used when the summary is generated for a procurement case.

The following table lists the inputs for the Procurement case summarization for fulfillers from the 
Choose input for procurement case page in the Now Assist Admin  console.
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Procurement case summarization for fulfillers skill input

Input Description

Base input table Procurement Case 
[sn_spend_psd_procurement_request]

Base input fields • State

• Short description

• Description

• Due date

• Case type

• Related case

• Requested by

• Supplier

• Assigned to

• Work notes

• Additional comments

Purchase order summarization for requesters skill

Inputs for the Purchase order summarization for requesters skill identify the table and fields used 
when the summary is generated for a purchase order.

The following table lists the inputs for the Purchase order summarization skill for requesters from 
the Choose input for purchase order page in the Now Assist Admin  console.

Purchase order summarization skill input

Input Description

Base input table Purchase Order [sn_shop_purchase_order]

Base input fields • Supplier

• Total amount

• Status

• ERP number

Purchase requisition summarization for fulfillers skill

Inputs for the Purchase requisition summarization for fulfillers skill identify the table and fields 
that are used when the summary is generated for a purchase requisition.

The following table lists the inputs for the Purchase requisition summarization for fulfillers from 
the Choose input for purchase requisition page in the Now Assist Admin  console.
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Purchase requisition summarization fulfillers skill input

Input Description

Base input table Purchase Requisition 
[sn_shop_purchase_requisition]

Base input fields • Number

• Short description

• Description

• State

• Business owner

• Order type

• Requisition type

• Supplier

Purchase requisition summarization for requesters skill

Inputs for the Purchase requisition summarization for requesters skill identify the table and fields 
used when the summary is generated for a purchase requisition.

The following table lists the inputs for the Purchase requisition summarization skill for requesters 
from the Choose input for purchase requisition page in the Now Assist Admin  console.

Purchase requisition summarization skill input

Input Description

Base input table Purchase Requisition 
[sn_shop_purchase_requisition]

Base input fields • Number

• State

• Short description

• Business owner

• Order type

• Requisition type

• Supplier

• Total amount

• Due date

Sentiment analysis for procurement case skill

Analyzes requester sentiment across procurement cases to help fulfillers prioritize urgent issues 
and make informed decisions. This capability delivers sentiment assessments, trend analysis, 
and AI-generated summaries that clearly explain the rationale behind each evaluation based on 
the scheduler frequency.
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The following table lists the inputs for Sentiment analysis for procurement case from Choose 
input for sentiment analysis page in the Now Assist Admin  console.

Sentiment analysis for procurement case skill input

Input Description

Base input table Procurement Case 
[sn_spend_psd_procurement_request]

Base input fields • Short description

• Description

• Priority

• State

• Additional comments

• Work notes

• Activity

Sourcing event summarization for fulfillers skill

Inputs for the Sourcing event summarization for fulfillers skill identify the table and fields that are 
used when the summary is generated for a sourcing event.

The following table lists the inputs for the Sourcing event summarization for fulfillers from the 
Choose input for sourcing event page in the Now Assist Admin  console.

Sourcing event summarization for fulfillers skill input

Input Description

Base input table Sourcing event [sn_shop_negotiation_event]

Base input fields • Short description

• Negotiation type

• Description

• Negotiation objectives

• Third party sourcing record

• Third party sourcing tool integration

• Supplier responses close

• State

Sourcing request summarization for fulfillers skill

Inputs for the Sourcing request summarization for fulfillers skill identify the table and fields used 
when the summary is generated for a sourcing request.

The following table lists the inputs for the Sourcing request summarization for fulfillers skill from 
the Choose input for sourcing request page in the Now Assist Admin  console.
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Summarization for fulfillers skill input

Input Description

Base input table Sourcing Request [sn_shop_sourcing_activity]

Base input fields • Business owner

• Short description

• Request type

• Product category

• Product name

• Max budget

• Purchased quantity

• Product type

• Status

Sourcing request summarization for requesters skill

Inputs for the Sourcing request summarization for requesters skill identify the table and fields 
used when the summary is generated for a sourcing request.

The following table lists the inputs for the Sourcing request summarization skill for requesters 
from the Choose input for sourcing request page in the Now Assist Admin  console.

Sourcing request summarization skill input

Input Description

Base input table Sourcing Request [sn_shop_sourcing_activity]

Base input fields • Assigned to

• Product category

• Status

• Supplier responses close

• Short description

• Max budget

• Purchased quantity

• Request type

• Product type

• Product name

• Business owner

Approve restricted caller access privileges manually

Approve restricted caller access (RCA) privileges to enable cross-scope access to any errors 
generated when using the Negotiation event summarization for fulfillers skill.
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Before you begin
Role required: Admin

About this task
RCA privileges define cross-scope access to an application, an event, or an application 
resource.

Procedure

1. Navigate to All  > System Applications  > Application Restricted Caller Access.

2. In the Source Scope  column search field, enter Now Assist for Sourcing and 
Procurement Operations (SPO).

3. For source scopes with the status Requested, select the source scope record and update the 
Status  field to Allowed.

Using Now Assist for Sourcing and Procurement Operations (SPO)

For your requesters' purchasing needs, the Now Assist for SPO  Virtual Agent  searches against 
the existing products in the product catalog and displays the available products.

If a product is found with or without a price in the catalog, the requester can then fill out the 
intake questions through a simple conversation, and then submit the purchase request after 
reviewing the summary of responses. They can also edit a response before submitting.

If a product or service isn’t found in the catalog, the chatbot gathers more information, such 
as checking for availability of quotes, and routes the requester to the corresponding off-
catalog intake form. It also provides the requester with the option to submit a question to the 
procurement team about the required product or service, with relevant attachments, if any, all 
through a conversation.

Note:  You can ask a question to the procurement team, and create a corresponding 
procurement case, only if you have the sn_spend_psd.requestor role. Ensure that you 
admin has assigned that role to you.

As a requester, you can start with viewing all the topics, and then selecting Buy a product.
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You could also directly start typing what you need, in which case the utterance detection 
mechanism uses Genius Results to retrieve Virtual Agent  topics, catalog items, and Q&A results, 
and displays them to the requester within a card carousel. For details, see Using Now Assist in 
Virtual Agent .
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The Virtual Agent  engages you in a guided conversation, asking you relevant questions along 
the way to help you submit your purchase, sourcing, and off-catalog requests, as well as 
procurement cases, independently, without the need to reach out to fulfillers. You can then 
review and track these request records from Shopping Hub, Employee Center, or Platform.

To learn more about quick checkout and sourcing checkout processes, see Order a product 
with quick checkout  and Complete sourcing checkout  respectively. For more information 
on off-catalog intake forms, see Requesting for products or services that you don't see on 
ShoppingHub.

Now Assist  in Virtual Agent  provides your users with an interactive generative Artificial 
Intelligence (AI) experience. A friendly, natural language conversation is easier to understand 
and makes requesters more comfortable with talking to a bot. To learn how a conversation 
powered by generative AI might look in Virtual Agent, see Using Now Assist in Virtual Agent .

As an administrator, you can use the Now Assist  in Virtual Agent  Analytics dashboard to monitor 
the performance of Now Assist  in Virtual Agent  as a self-service deflection tool. To learn more, 
see . Now Assist  in Virtual Agent  Analytics calculates the conversation deflection rate based on 
the resolution status associated with Now Assist  query responses. For more information, see .

For detailed information on Now Assist  in Virtual Agent  in general, and Now Assist for SPO  in 
particular, see Explore Now Assist for Sourcing and Procurement Operations (SPO).

For information on configuring Now Assist for SPO, see Configure Now Assist for Sourcing and 
Procurement Operations (SPO).

Summarize a record by using Now Assist for Sourcing and Procurement Operations (SPO)  in 
Source-to-Pay Workspace

As a fulfiller, summarize procurement-related records to know about their status, progress, 
and action items by using the record summarization skills in the Now Assist for Sourcing and 
Procurement Operations (SPO)  application.

Before you begin
Role required: sn_spend_gen_ai.now_assist_fulfiller

About this task
You can use these record summarization skill in either Core UI  or Source-to-Pay Workspace.

• In Core UI, the summary appears in a banner in the record record.

• In Source-to-Pay Workspace, the summary is generated in the Details  tab.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

To Do this

To generate a summary for the 
following records:

◦ Procurement case

◦ Sourcing request

◦ Purchase requisition

a. Navigate to Lists  > All work.

b. Select any of the following modules and select the link to 
the record under the Number column.

▪ Cases

▪ Sourcing requests
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To Do this

◦ Negotiation

◦ Sourcing event

▪ Requisitions

▪ Negotiations

▪ Sourcing events

4. On the Details tab, in the Record summary section, select Summarize.

When you opt to summarize a purchase requisition, you see the following message:

Now Assist is summarizing your purchase requisition.

Note:  Generating and displaying the summary may take several seconds.

5. Review the summary details.

A concise summary of a record, including the overview, actions completed, 
and next steps. The information that is displayed is based on the type of the 

record:

◦ Overview: Provides information about the record.

◦ Actions completed: Lists all the actions that have been taken so far.

◦ Next steps: Lists the actions that the fulfillers need to take next.

6. Optional:  When you finish summarizing a record, you can add it to the work notes, expand or 
collapse it, provide feedback, copy it, or view information about it.
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Option Procedure

Save the summary information by adding it 
to the record work notes

a. Select Share.

b. In the Share to work notes dialog box, edit 
the summary.

c. Select Save to work 

notes.

Expand or collapse the summary
Select the expand card icon ( ) or the col­

lapse card icon ( ) to see more details or 
fewer summary details.

Provide feedback for the summary

If you think that the summary was helpful, se­

lect the helpful icon ( ). If you think that the 
summary wasn’t helpful, select the not helpful 

icon ( ).

This feedback improves the generative AI 
model and can help to improve the future ver­
sions of this skill.

Copy the record summary
Select the copy to clipboard icon ( ) to use 
the record summary information for another 
purpose, such as pasting into an email.

View the information about the record sum­
mary

If you want to check some details about the 
summary, select the more info icon ().

Refresh the record summary
If you want to refresh the summary, select the 

refresh icon ( ).

Summarize a record by using Now Assist for Sourcing and Procurement Operations (SPO)  in 
Shopping Hub

As a shopper, summarize sourcing request, purchase requisition, and purchase order records to 
know about their status, progress, and action items by using the record summarization skills in 
the Now Assist for Sourcing and Procurement Operations (SPO)  application.

Before you begin
Role required: sn_spend_gen_ai.now_assist_requester

About this task
You can use these record summarization skill in either Core UI  or Shopping Hub.
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• In Core UI, the summary appears in a banner in the record.

• In Shopping Hub, the summary is generated in a widget in the record.

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select My purchases  from your Shopping Hub profile.

3. Do one of the following:

To Do this

To generate a summary for a sourcing request 
records. Select a sourcing request record to view 

it.

To generate a summary for purchase requisition 
record. Select a purchase requisition record to 

view it.

To generate a summary for purchase order 
record. Select a purchase order record to view it.

On the sourcing request or purchase requisition record, a widget is displayed with the 
Summarize option.

4. Select Summarize.

Note:  Generating and displaying the summary may take several seconds.

5. Review the summary details.
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A concise summary of a record, including its overview and next steps you 
need to take. The information that is displayed is based on the type of the 

record.

◦ Overview: Provides information about the record.

◦ Your next steps: Lists the actions that the shoppers need to take next.

6. Optional:  When you finish summarizing a record, you can add it to the activity, expand or 
collapse it, provide feedback, copy it, or view information about it.

Option Procedure

Expand or collapse the summary
Select the expand card icon ( ) or the col­

lapse card icon ( ) to see more details or 
fewer summary details.

Provide feedback for the summary

If you think that the summary was helpful, se­

lect the helpful icon ( ). If you think that the 
summary wasn’t helpful, select the not helpful 

icon ( ).

This feedback improves the generative AI 
model and can help to improve the future ver­
sions of this skill.

Copy the record summary
Select the copy to clipboard icon ( ) to use 
the record summary information for another 
purpose, such as pasting into an email.

View the information about the record sum­
mary

If you want to check some details about the 
summary, select the more info icon ().

Request the generative AI capabilites in Now Assist for Sourcing and Procurement Operations 
(SPO)  by using Now Assist  panel

Request the contextual generative AI capabilities to summarize procurement-related records 
in the Now Assist for Sourcing and Procurement Operations (SPO)  application by using the 
conversational interface in the Now Assist  panel.
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Before you begin
Make sure that Next Experience  is enabled in the instance. For more information, see Next 
Experience UI .

Make sure that AI search  and Now Assist  panel are enabled in the instance.

Role required: sn_spend_gen_ai.now_assist_fulfiller

About this task
You can use the Now Assist  panel in Source-to-Pay Workspace to summarize procurement-
related records.

For more information about the Now Assist  panel, see Now Assist panel . For information about 
activating the Now Assist  panel, see Activate Now Assist panel standard chat .

Procedure

1. Log in to an instance where the Now Assist for SPO  application is installed.

2. Navigate to Workspaces  > Source-to-Pay Workspace.

3. Request the generative AI capabilities in SPO for procurement-related records for the following 

skills by selecting the Now Assist  icon :

◦ Sourcing request summarization for fulfillers

◦ Purchase requisition summarization for fulfillers

◦ Procurement case summarization for fulfillers

◦ Negotiation summarization for fulfillers

◦ Sourcing event summarization for fulfillers

4. After you request the generative AI capabilities, you can summarize procurement-related 
records.

Option Description

Summarize a record

a. Open a record.

b. From the header menu, select the Now As­

sist  icon .

c. In the Now Assist  panel, select Summarize 
a record.

Use the Now Assist for Sourcing and Procurement Operations (SPO)  skills in a Virtual Agent 
chat

Request the contextual generative AI capabilities by using the conversational interface in the 
Now Assist for Sourcing and Procurement Operations (SPO)  in a Virtual Agent  chat.

As a requester, you can use the predefined topics (chatbot conversations) that are designed to 
help you complete common self-service tasks, such as buying a product or knowing the status of 
a purchase requisition, sourcing request, or procurement case.

As a requester, you can use the Now Assist for SPO  skills in a Virtual Agent  chat to search against 
the existing products in the product catalog or to display the available products. You can also 
inquire about the status of the procurement records, such as sourcing requests, purchase 
requisitions, procurement cases, and purchase orders.
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To start a conversation, navigate to All  > Self-Service  > Employee Center  and select the Virtual 

Agent chat icon ( ).

Using a predefined topic to buy a product

As a requester, you can start by selecting Show all my options  as shown in the following 
example.

Starting screen for the Now Assist for SPO  in a Virtual Agent  chat

Then, select the Request to buy something  topic as shown in the following example.
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All topics in the Now Assist for SPO  in a Virtual Agent  chat

You could also directly start entering the instructions. The utterance detection mechanism uses 
Genius Results to retrieve Virtual Agent  topics, catalog items, and Q&A results, and displays 
them to the requester within a card carousel. The following example shows the available 
products in the search results.
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Products available based on search results

For details, see Using Now Assist in Virtual Agent .

Virtual Agent  engages you in a guided conversation, asking you relevant questions to help you 
submit your purchase, sourcing, and off-catalog requests, as well as procurement cases, without 
the need to reach out to fulfillers. You can then review and track these request records from 
Shopping Hub, Employee Center, or Platform.

If a product is found with or without a price in the catalog, the requester can then fill out the 
intake questions through a simple conversation and then submit the purchase request after 
reviewing the summary of responses. They can also edit a response before submitting. The 
following example shows a catalog conversation.
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Catalog conversation

If a product or service isn’t found in the catalog, the chatbot gathers more information, such as 
checking for availability of quotes, and routes the requester to the corresponding off-catalog 
intake form as shown in the following example.
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Off-catalog conversation

It also provides the requester with the option to submit a question to the procurement 
team about the required product or service, with relevant attachments, if any, all through a 
conversation.

Note:  You can ask a question to the procurement team, and create a corresponding 
procurement case, only if you have the sn_spend_psd.requestor role. Verify that your 
administrator has assigned that role to you.

To learn more about quick checkout and sourcing checkout processes, see Order a product with 
quick checkout  and Complete sourcing checkout. For more information on off-catalog intake 
forms, see Requesting for products or services that you don't see on ShoppingHub.

Using a predefined topic to track requests

As a requester, you can inquire about the status of your recent purchase or request by selecting 
the Track purchases or procurement requests  topic as shown in the following example.
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You can inquire about the following records to the virtual agents:

• Purchase requisition (PR)

• Sourcing request (SR)

• Procurement Case (PC)

For example, let's say that you ask whether the purchase requisition PR0001002 has already 
been approved as shown in the following example.
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Purchase requisition status inquiry

The following example shows that the chatbot has provided you with the current status of the 
purchase requisition that you inquired about.
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Purchase requisition inquiry response

You can choose either to close the conversation or check the status of another record.

Searching for requests by specifying a time period

The Now Assist for SPO  in a Virtual Agent  chat also enables you to search for requests by 
specifying the time period when the request was opened. Here are a few examples:

• What's the status of the purchase I made last month

• Just send me the status of my purchases made 3 weeks ago

• Can I get an update on the purchase I requested in August 2024

When Virtual Agent  requires more information about your request

If the Virtual Agent  requires more information to search for your specific request, the following 
event occurs:
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• The Now Assist for SPO  in a Virtual Agent  chat provides you options to understand your 
requirement.

For example, let's say you want to buy something as shown in the following example.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

346



• The Now Assist for SPO  in a Virtual Agent  chat displays the results based on your request:

When Virtual Agent  has no results for your request

If the Virtual Agent  is unable to search for your specific request, the following event occurs:

• The Now Assist for SPO  in a Virtual Agent  chat instructs you to provide more context if the 
results don't meet your needs.

I'm sorry, I couldn't find what you needed. Could you rephrase 
your request or provide more context?

• The Now Assist for SPO  in a Virtual Agent  chat instructs users up to two times to rephrase their 
request before displaying the following message:
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• If there’s no chat activity for 900 seconds, the Now Assist for SPO  in a Virtual Agent  chat ends 
as shown in the following example.

Additional Information

Now Assist  in Virtual Agent  provides your users with an interactive generative AI experience. 
A friendly, natural language conversation is easier to understand and makes requesters more 
comfortable with talking to a bot. To learn how a conversation that is powered by generative AI 
might look in Virtual Agent, see Using Now Assist in Virtual Agent .

As an administrator, you can use the Now Assist  in Virtual Agent  Analytics dashboard to monitor 
the performance of Now Assist  in Virtual Agent  as a self-service deflection tool. To learn more, 
see . Now Assist  in Virtual Agent  Analytics calculates the conversation deflection rate that 
is based on the resolution status associated with Now Assist  query responses. For more 
information, see .
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For detailed information on Now Assist  in Virtual Agent  in general, and Now Assist for SPO  in 
particular, see Explore Now Assist for Sourcing and Procurement Operations (SPO).

For information on configuring Now Assist for SPO, see Configure Now Assist for Sourcing and 
Procurement Operations (SPO).

Generate email responses

Enables procurement specialists and buyers to generate professional, accurate email responses 
using Now Assist. By minimizing manual drafting and review, it helps procurement specialists and 
buyers respond to requester inquiries more efficiently and focus on higher-value procurement 
tasks.

Before you begin
Role required: sn_spend_gen_ai.now_assist_fulfiller

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

List actions

To Do this action

To generate an email response for 
the following records:

◦ Negotiation

◦ Procurement case

◦ Procurement task

◦ Purchase requisition

◦ Sourcing event

◦ Sourcing request

◦ Sourcing task

a. Navigate to Lists  > All work.

b. Select one of the following modules and select the 
record link in the Number  column.

▪ Cases

▪ Negotiations

▪ Requisitions

▪ Sourcing events

▪ Sourcing requests

▪ Tasks

4. On the Details  tab, select Email.

5. Select anywhere within the email message window to see the Now Assist icon .

6. To generate a context-based email response, select the Now Assist icon .

7. To refine an email draft, select the Now Assist icon  and then select any of the available 
options:

◦ Elaborate

◦ Shorten

◦ Change tone

8. Select Insert  to add the AI-generated email response to the email message window.

9. Optional:  Apply templates by selecting the template icon .

10. Select Send email  to send the email.
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Result
An AI-generated email response is sent to the requester.

Analyze sentiment in procurement cases

Analyze requester sentiments on active procurement cases to help procurement specialists 
quickly identify, prioritize, and track sensitive requests.

Before you begin
Role required: sn_spend_gen_ai.now_assist_fulfiller

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > All work  > Cases.

4. Select any active procurement case.
The procurement case form view appears.

5. To see why the sentiment was generated, select the information icon .

6. Optional:  To refresh the sentiment and trend manually, select the information icon  and then 

select the refresh icon .
A red dot indicates that the sentiment was updated due to recent activity. Sentiment updates 
automatically every 30 minutes.

Use agentic workflows in Now Assist  for Sourcing and Procurement 
Operations

Use agentic workflows in Now Assist for Sourcing and Procurement Operations (SPO)  to 
streamline procurement through intelligent product recommendations, guided checkout, off-
catalog purchasing, and access to detailed product information. These workflows also assist with 
procurement-related inquiries and help you track associated records efficiently.

Available agentic workflows for Sourcing and Procurement Operations  AI Agent Collection

Agentic workflow name Description Available AI agents

Conversational intake for 
sourcing and procurement Addresses your procurement 

needs by offering product 
recommendations, guided 
checkout, off-catalog request 
support, and detailed product 
information. It also responds 
to inquiries and tracks related 
records.

• Procurement request 
tracking AI agent

• Procurement product 
recommendation AI agent

• Procurement inquiry 
analysis AI agent
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Available agentic workflows for Sourcing and Procurement Operations  AI Agent Collection 
(continued)

Agentic workflow name Description Available AI agents

Savings Opportunity 
Discovery Scans contracts, spend, and 

supplier data on a recurring 
schedule to surface ranked 
savings opportunities for 
category managers to review, 
act on, or dismiss.

• Contract Optimization 
Opportunity Finder Agent

• Spend Optimization 
Opportunity Finder Agent

• Supplier Optimization 
Opportunity Finder Agent

To run the AI agents autonomously, you must activate the agentic workflow. For more information, 
see Enable AI agents for the Help fulfill procurement requests agentic workflow in the Now Assist 
panel.

For more information about savings opportunities and how the Opportunity Finder agents work, 
see Savings opportunity identification.

For more information about the AI agents, see  Now Assist AI agents .

Important:  By default, all agentic workflows and AI agent records are read-only.

Looking for an AI agent?

• There might be AI agents installed with the Now Assist application that are not used in agentic 
workflows. To learn how to see all agents that are available on your instance, see Find AI 
agents .

• To find agents that might not be installed on your instance, visit the AI Agent Marketplace  on 
the ServiceNow Store.

Help fulfill procurement requests agentic workflow

The Help fulfill procurement requests agentic workflow addresses your procurement needs by 
providing product recommendations, guided checkout, off-catalog processes, and detailed 
product information. It also answers questions and tracks related records.

Help fulfill procurement requests agentic workflow overview

The Help fulfill procurement requests agentic workflow handles and resolves procurement-
related inquiries, which include the product information, purchase intent, sourcing new items, or 
tracking purchasing records.

Accessing the Help fulfill procurement requests agentic workflow

To access the agentic workflow:

1. Navigate to All  > AI Agent Studio  > Create and manage.

2. Select Help fulfill procurement requests.

Available AI agents in the Help fulfill procurement requests agentic workflow

The following table lists the agents that are used in the Help fulfill procurement requests agentic 
workflow.
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Important:  In the Define availability screen for the AI agent, make sure that the Status 
toggle is enabled to activate the AI agent.

AI agents used in the Help fulfill procurement requests agentic workflow

AI agent AI agent role

Procurement 
inquiry analysis 
AI agent

Retrieves and displays relevant knowledge articles to address sourcing and 
procurement queries. If no relevant articles are found, or if intent is unclear, 
redirects you to a live agent.

Track request 
agent

Provides a summary of either a sourcing request or purchase requisition by 
using a record number. This agent can also answer any questions that are 
related to a record or tracking a request as well.

Product 
recommendation 
and 
procurement 
agent

Assists a user to discover products to procure or purchase. After a product 
is selected, a user can proceed with procurement by initiating the checkout 
and raising a purchase request. The agent also supports scenarios where a 
user is looking only for information about a specific product.

The AI agent decision log displays the AI agents that are working on a request. You can watch 
their interactions, decisions, and thought processes as they happen in real time.

Enable AI agents for the Help fulfill procurement requests agentic workflow in the Now Assist 
panel

Enable AI agents in the Now Assist  panel to help you manage procurement requests more 
efficiently, with faster response times and smarter support.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > AI Agent Studio  > Overview.

2. Under Agentic workflows, select Help fulfill procurement requests.

If you want to modify this agentic workflow, you can duplicate  it, adjust the settings to suit 
your specific needs, and activate the duplicated version of the agentic workflow.

3. On the Describe and connect page, select Continue.
The Describe and connect page is read-only.

4. On the Defined trigger page, select Continue.
The Define trigger page is read-only.

5. On the Select display page, switch the Display toggle to the open position so that the AI agents 
are enabled in the Now Assist  panel.

6. In the Who can access from the Now Assist panel?  field, enter 
now_assist_panel_user.

In addition to the now_assist_panel_user role, you can assign any role to access the Now 
Assist  panel.
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7. Activate the agentic workflow by selecting Save and test.
The AI agents are enabled in the Now Assist  panel.

Enable AI agents for the Help fulfill procurement requests agentic workflow in Virtual Agent

Enable AI agents in Virtual Agent  to streamline procurement requests, providing quicker support 
and a more efficient experience for requesters through intelligent assistance.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > AI Agent Studio  > Overview.

2. Under Agentic workflows, select Help fulfill procurement requests.

3. Under Connect AI agents, select any of the AI agents that you want to make available in Virtual 
Agent.
The agents that you can select:

◦ Track request agent

◦ Product recommendation and procurement agent

◦ Guided checkout agent

◦ Off catalog agent

◦ Procurement inquiry analysis AI agent

For example, let's assume that you select the Product recommendation and procurement 
agent.
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4. On the Describe and instruct page, select Continue.
The Describe and instruct page is read-only.

5. On the Add tools and information page, select Continue.
The Add tools and information page is read-only.

6. On the Describe and instruct page, select Continue.
The Describe and instruct page is read-only.

7. On the Define trigger page, select Continue.
The Describe trigger page is read-only.

8. On the Define availability page, in the Select display section, switch the Display toggle to the 
open position so that the AI agent is enabled in the Virtual Agent.

9. To activate the agentic workflow, select Save and test.
The selected AI agent is enabled in Virtual Agent.

Submit a purchase request using the Now Assist AI agent

Use the Now Assist AI‑powered  chat experience in the Employee Center to submit a purchase 
request. The AI agent analyzes your requirements, displays suitable products or services, and 
guides you through confirming and submitting the request.

Before you begin
Role required: sn_spend_gen_ai.now_assist_requester
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Procedure

1. In your ServiceNow instance, navigate to All  > Self-Service  > Employee Center.

2. In the Employee Center interface, select the Now Assist chat icon ( ).

3. In the chat window, describe the product or service that you want to purchase.
You can request more than one product or service in the same purchase request.

4. When prompted, enter No  to proceed without a quote or Statement of Work.
Now Assist analyzes your input using the Procurement product recommendation AI agent and 
displays up to three products or services.

5. Select Show  to view the products.

A side panel opens displaying the top three products or services categorized as an excellent 
match or good match.

6. Select the product or service that you want to purchase.

7. Select Submit  to confirm details, such as quantity, supplier, total price, and delivery period.

8. Optional:  Select Edit  to make changes and then enter Submit.

9. Optional:  When prompted to add attachments, select Yes  to upload supporting files.
You can add multiple attachments in PDF, PNG, JPEG, Word, XLSX, or ZIP format, with each file 
up to 10 GB.

10. Select No  to submit the purchase request without attachments.

Result
The purchase request is successfully submitted through Employee Center using the Now Assist 
AI agent.

Upload a Statement of Work (SOW) to request a purchase

Use Now Assist’s AI-powered chat interface to upload a Statement of Work (SOW) and submit 
your purchase request through Employee Center.

Before you begin
Role required: sn_spend_gen_ai.now_assist_requester

Procedure

1. Navigate to All  > Self-Service  > Employee Center  in your ServiceNow instance.

2. Select the Now Assist chat icon ( ) in the Employee Center interface.
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3. Provide details about the product that you want to purchase in the chat interface.

4. When prompted, enter Yes  to proceed with uploading a Statement of Work (SOW).

5. Select Click here to upload a file  and select a Statement of Work (SOW) from your device.

Note:  Verify that the file is in PDF, PNG, or JPEG format and doesn’t exceed 1 MB.
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Now Assist analyzes your document using the Procurement product recommendation AI agent.

6. Enter additional details requested, such as the reason for purchase, expected delivery date, 
and service period.
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7. Optional:  Select Show  to view the request.

8. Optional:  Select Make changes  to edit the request.

a. Select the document link.
The Statement of Work (SOW) document opens in a new tab.

b. Select Edit Answers  to make changes.
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c. Select Submit  > Confirm and submit  to save your changes.

d. Return to the Employee Center and select Yes  to proceed.

Your purchase requisition has been created and submitted for approval.

9. Select Submit  to submit the request.

Result
Your purchase requisition has been created and submitted for approval.

Update the product category or spend category in the Now Assist panel

Use the Now Assist panel to update the product category or spend category for purchase 
requisitions, sourcing requests, or purchase orders directly from the Source-to-Pay Workspace.

Before you begin
Role required: sn_shop_procurement_specialist

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to List  > All work  and locate the required record.

a. Select from the following modules:

▪ Sourcing requests

▪ Requisitions

b. In the Number  column, select the record link to open the details page.

4. To open the Now Assist panel, select the Now Assist icon .

5. In the Now Assist panel, enter a request to update either the product category or spend 
category.
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6. Select Product Category  or Spend Category, based on your requirement.

7. When prompted, enter the reason for the update or enter Skip  to continue without providing a 
reason.

8. Enter your suggested category.
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Now Assist analyzes your input and provides AI-generated suggestions.

9. Review the suggested options and select the one you want to apply.

Result
The product category or spend category for the selected purchase line is successfully updated.

Exploring Sourcing and Procurement Operations
Use ServiceNow®  Sourcing and Procurement Operations  to provide your employees, shoppers, 
or requesters with a simple automated tool that they can use to shop for goods and services that 
they need at work.
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Sourcing and Procurement Operations  applications

Sourcing and Procurement Operations  (SPO) comprises the following applications:

Application Description

Shopping Hub With this application, provide a streamlined, e-commerce like experience 
for your employees to self-service requests, and source or purchase 
products and services through the procurement organization. This is an 
add-on experience to Employee Center.

Shopping Hub  enables you to do the following:

• Manage a catalog of goods and services that your employees can use 
to order items that they need for their jobs.

• Simplify and streamline the way employees request help in sourcing or 
procuring goods and services.

• Suggest and guide employees to the correct suppliers.

• Provide transparency into the procurement process with regular 
updates.

For more information on these, see Using Shopping Hub.

Source-to-
Pay Common 
Architecture

With this application, provide an architecture to store purchase orders, 
requisitions, sourcing requests, and other objects that are commonly 
used across the source-to-pay business processes.

For more information on these, see Components installed with Sourcing 
and Procurement Operations.

Sourcing and 
Purchasing 
Automation

With this application, provide workflows and automation for sourcing 
requests, negotiations, and purchase requisitions.

For more information on these, see Sourcing and Purchasing Automation.

Procurement Case 
Management

With this application, enable all your employees to request services from 
the procurement team, and allow the procurement team to manage those 
requests.

For more information on these, see Procurement Case Management.

Playbooks for 
Sourcing and 
Procurement 
Operations

With this application, provide a set of pre-built playbooks, workflows, and 
experiences for your employees, sourcing, and procurement to automate 
work that is typically managed through emails and spreadsheets.

For more information on these, see Purchase revision flows.

Source-to-Pay 
Workspace

With this application, provide a single environment for your Procurement 
Specialists to work on purchase requisitions, sourcing requests, 
negotiations, procurement requests, and more.

For more information on these, see Source-to-Pay Workspace.

Advanced Work 
Assignment for 
Source-to-Pay 
Operations

With this application, provide configurations to support automatic routing, 
queuing, and assignment of procurement cases, emails, and live agent 
chat conversations.
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Application Description

For more information on these, see Advanced Work Assignment for 
Source-to-Pay Operations.

Performance 
Analytics for 
Sourcing and 
Procurement 
Operations

With this application, provide a set of pre-configured metrics and 
dashboards to assess spend, operational efficiency, and team 
performance across the Sourcing and Procurement Operations  product.

Visually analyze how you are placed with your work and achievements 
over a given period of time, with the Procurement Buyer Dashboard. For 
more information on these, see Procurement Buyer Dashboard.

Visually analyze how your organization is placed strategically and 
operationally, over a given period of time, with the Procurement Strategy 
& Ops Dashboard. For more information on these, see Procurement 
Strategy & Ops Dashboard.

Visually analyze how your team is performing on sourcing requests, 
purchase requisitions, negotiated savings, and negotiation outcomes, 
over a given period of time, with the Procurement Team Performance 
Dashboard. For more information on these, see Procurement Team 
Performance Dashboard.

Note:  Activation of this application on your production instance 
may require a separate Performance Analytics license.

Shopping Hub 
Mobile

With this application, enable Shopping Hub  and other employee 
experiences for procurement within the Now Mobile  application.

For more information on these, see Shopping Hub Mobile.

Virtual Agent for 
Sourcing and 
Procurement 
Operations

With this application, provide pre-configured topics for sourcing and 
procurement within a conversational interface, for employees to raise 
requests, find knowledge, and complete tasks.

For more information on this, see Virtual Agent for Sourcing and 
Procurement Operations.

Natural Language 
Understanding 
Models for 
Sourcing and 
Procurement 
Operations

With this application, provide Natural Language Understanding  (NLU) 
models to enhance the virtual agent conversation interface, using natural 
human utterances to detect the correct conversations intended by 
employees.

For more information on this, see NLU support for Sourcing and 
Procurement Operations Virtual Agent.

Common Service 
Delivery

With this back-end application, store Finance Case, Finance Case Line, 
Finance Task, and Playbook status tables, as well as other infrastructure 
that forms the basis of Finance and Supply Chain workflows products.

Finance Common 
Architecture

With this application, maintain primary data such as Enterprise Resource 
Planning (ERP) sources, legal entities, accounting periods, and so on.

For more information on these, see Components installed with Finance 
Common Architecture.
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https://www.servicenow.com/docs/access?context=process-mining&version=yokohama&pubname=yokohama-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-mining&version=yokohama&pubname=yokohama-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-mining&version=yokohama&pubname=yokohama-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=sourcing-procurement-operations-rn&version=yokohama&pubname=yokohama-release-notes&ft:locale=en-US
https://www.servicenow.com/docs/access?context=sourcing-procurement-operations-rn&version=yokohama&pubname=yokohama-release-notes&ft:locale=en-US
https://www.servicenow.com/docs/access?context=sourcing-procurement-operations-rn&version=yokohama&pubname=yokohama-release-notes&ft:locale=en-US
https://www.servicenow.com/docs/access?context=sourcing-procurement-operations-rn&version=yokohama&pubname=yokohama-release-notes&ft:locale=en-US
https://learning.servicenow.com/lxp/en/source-to-pay-operations/sourcing-and-procurement-operations-spo?id=learning_course_prev&course_id=e9eb688747714e105cbdaf44846d432c
https://learning.servicenow.com/lxp/en/source-to-pay-operations/sourcing-and-procurement-operations-spo?id=learning_course_prev&course_id=e9eb688747714e105cbdaf44846d432c
https://learning.servicenow.com/lxp/en/source-to-pay-operations/sourcing-and-procurement-operations-spo?id=learning_course_prev&course_id=e9eb688747714e105cbdaf44846d432c
https://learning.servicenow.com/lxp/en/source-to-pay-operations/sourcing-and-procurement-operations-spo?id=learning_course_prev&course_id=e9eb688747714e105cbdaf44846d432c
https://learning.servicenow.com/lxp/en/pages/servicenow
https://learning.servicenow.com/lxp/en/pages/servicenow
https://learning.servicenow.com/lxp/en/pages/servicenow
https://learning.servicenow.com/nowcreate
https://learning.servicenow.com/nowcreate
https://learning.servicenow.com/nowcreate
https://learning.servicenow.com/nowcreate


https://www.youtube.com/watch?v=crQtfrCR6DY
https://www.youtube.com/watch?v=crQtfrCR6DY
https://www.youtube.com/watch?v=crQtfrCR6DY
https://www.youtube.com/watch?v=crQtfrCR6DY
https://www.servicenow.com/community/source-to-pay-operations/ct-p/source-2-pay-operations
https://www.servicenow.com/community/source-to-pay-operations/ct-p/source-2-pay-operations
https://www.servicenow.com/community/source-to-pay-operations/ct-p/source-2-pay-operations
https://www.servicenow.com/community/source-to-pay-operations/ct-p/source-2-pay-operations


Purchase requisitions, purchase orders, and sourcing requests detail view

In the detail view, you can track the step dependencies and progress of the sequential and 
concurrent steps.
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Process visibility configuration requirements

As a procurement administrator, you can use the configuration framework to modify and edit your 
own content to your business process. With this framework, you can easily define and modify 
steps and work items within each step, including sequencing and label changes.

For more information on how to configure process steps, work items, and link them together, see 
Shopping Hub process visibility configuration.

Process visibility customer adoption

For existing customers using sourcing requests, purchase requisitions, and purchase orders 
records, the default content is available in the new user experience. Use the configuration 
framework to modify your steps and processes and populate them on Shopping Hub.

For existing customers using custom tables (and not sourcing requests, purchase requisitions, 
and purchase orders records), the default content is not available in the new user experience. 
Use the configuration framework to build your steps and processes and populate them on 
Shopping Hub.

For new customers, use the configuration framework to modify your steps and processes and 
populate them on Shopping Hub.

Purchase refinement options

You can refine your purchases through filtering, sorting, searching, and perform actions from the 
My purchases landing page.
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Filter

You can filter your orders by:

• Open: All purchase lines that are not in the state Closed Rejected, Closed Canceled, Closed 
Complete, or Closed No Decision, and the parent sourcing request, negotiation, purchase 
requisition not in any of the respective closed states. This option is default.

• Supplier Evaluation: All active purchase lines associated to an active sourcing request.

Note:  Active purchase lines refer to those that are not in the state Closed No Decision, 
Closed Rejected, or Closed Canceled. Whereas active sourcing requests refer to those 
not in the state Closed No Decision or Closed Complete.

• Processing Purchase: All active purchase lines associated to a purchase requisition that are in 
the state Pending Review, Pending Approval, Awaiting Task Completion, or Final Review.

• Purchased: All purchase order lines that are not in the state Closed Complete, Closed Paid, or 
Closed Canceled.

• Pre-approved Purchases: All lines associated with a purchase requisition or purchase order 
that has an order type of blanket, and is not in the state Closed Canceled or Closed Rejected. 
Where a purchase order line exists, the corresponding purchase line is not visible.

• Closed:

◦ All purchase order lines that are in the state Closed Complete, Closed Paid, or Closed 
Canceled.

◦ All purchase lines that are in the state Closed Rejected, Closed Canceled, Closed Complete, 
or Closed No Decision.

◦ Where a purchase order line exists, the corresponding purchase line is not visible.

• All: All the orders, irrespective of their state. Where a purchase order line exists, the 
corresponding purchase line is not visible.

Sort

You can sort your orders by:

• Recently Updated: Sort by the last updated date of the purchase line or purchase order line, 
whichever is the primary record. This option is default.

• Date Submitted: Sort by the created date of the purchase line or purchase order line, 
whichever is the primary record.

• Upcoming deliveries:

◦ When a purchase line is related to a purchase requisition or sourcing request, sort by the 
earliest to the latest date based on the following criteria:

▪ The expected delivery date of a line with product type as good or the start date of a line 
with product type as service.

▪ The start date for a blanket line.

◦ For purchase orders, sort by the earliest to the latest date based on the following criteria:

▪ The expected delivery date of a line with product type as good or the start date of a line 
with product type as service.

▪ The start date for a blanket line.
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Search

To search for a specific purchase, enter relevant keywords or purchase numbers. Keyword search 
is performed on top of the existing filter criteria that you have selected.

The following fields are searchable:

• Number

• Short description

• Supplier

• Supplier product

• Delivery location

• Expected delivery date

• Start date

• End date

• State

Tabs

As a shopper, you can organize the purchases info into tabs for better visibility and operational 
ease. You can track the progress of all your purchases, service requests, purchase orders, 
supplier info, status, and other associated fields from a unified location at the header or line level 
information:

• View by purchase:View your purchasing activity at the purchase level — a multi item order 
from a supplier, an entire requisition, and sourcing requests.

• View by item:View your purchasing activity at the item level — each individual item ordered is 
displayed separately.

You can select the associated cards, view the details, and perform available actions.

User actions

You can perform the following actions from my purchase list page. Select the more options icon 
to see the available actions based on the state of the purchase.

• Edit: Revise the quantity or location for your purchases.

Note:  This option is not available for bundled products.

• Cancel: Cancel the purchases.

• Add to cart: Add all the products and line items again to your cart.

• View your purchase: View product summary, delivery date and location, and other details.

• View product details: See the details of the product.

• Purchase details: See the purchase order number. You can cancel the purchase or reorder 
from the purchase details page.

This list of actions changes based on the state of the order.

Related topics

Shopper to-dos
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Purchase highlights

Your purchases, which include purchase requisitions, purchase requisition lines, purchase 
orders, purchase order lines, and sourcing requests, are highlighted with color coding to help 
you quickly understand their state and due date. The progress bar on these purchases follows a 
similar color coding.

A red state badge is displayed if a purchase is closed canceled or closed rejected. A yellow state 
badge indicates that a purchase requires decision or needs information. For all other states, a 
grey badge is displayed.

A red due date badge is displayed for a purchase if:

• Any of the purchasing tasks associated with the purchase requisition line or purchase order 
line are overdue.

• Any of the milestones associated with the purchase order line are overdue.

• Any of the receipt tasks associated to the parent purchase order are overdue.

Similarly, a yellow due date badge is displayed for a purchase if any of the above conditions have 
a due date approaching in three days. A green due date badge indicates that everything is on 
schedule.

A procurement administrator can use the sn_shop.spend.sla.due.days purchasing property to 
configure the number of days for displaying the yellow highlight. By default, this is set to three 
days of the task due date.

Note:  The total line amount that you see for each purchase includes the updated shipping 
and tax estimates.

Your purchases are also highlighted with colored information banners when approvers request 
for clarification, or reject your purchase requisitions, purchase orders, or sourcing requests, in 
whole or in part. The reason for rejection is also displayed.

Activity stream

Track the updates on a selected purchase by navigating to the Activity  tab. The activity stream 
shows the progress that your order has made since the time you placed it.

The activity stream on the purchase line or purchase order line displays updates for the 
parent sourcing request, negotiation, purchase requisition, purchase order, purchasing tasks 
associated with the parent, and purchasing tasks associated with the purchase line.

For each activity stream update, the following text is displayed before showing the update from 
the old value to the new value: “<Object name> <Number>  has been updated with the 
following changes". For example, if the purchase line is within the context of a sourcing request, it 
displays: “Sourcing Request SRC0001001 has been updated with the following changes”.

You can also perform the following actions in the Activity  tab.

• Compose:

You can compose a message and post it as a comment in the activity stream. You can also tag 
a person you want to address, with "@<primary contact name>", in the Comments  field. 
An instructional message is displayed above the Compose section which dynamically shows 
who the primary contact is for the associated purchasing task. An email notification is sent 
to the user who is tagged such that they know when they have been mentioned in an activity 
stream post.

• Watchlist:
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Business owners can view and edit the watchlist users from the purchase requisition in My 
purchases  while the purchase requisition is still in open state (not in complete, cancelled 
or rejected state). Alternatively, you can view and edit the Watchlist  from the Reason for 
purchase  page. For more information, see Add users to the watchlist of the purchase. By 
default, you can add up to 20 users in the watchlist. You can modify this value by configuring 
the system properties.

Updates to the following fields on the respective parent objects are displayed in the activity 
stream of the purchase line or purchase order line:

• Sourcing request

◦ Status

◦ Assigned to

◦ Product name

◦ Employee requirements

◦ Sourcing request details

• Negotiation

◦ State

◦ Assigned to

◦ Negotiation type

◦ Negotiation outcome

◦ Negotiation objectives

◦ Close notes

• Purchase requisition

◦ State

◦ Assigned to

◦ Cost center

◦ Total amount

• Purchase order

◦ Status

◦ Cost center

◦ Total amount

• Purchasing tasks

◦ Assigned to

◦ Assignment group

◦ State

My to-dos and purchasing to-dos

As a shopper, you can review to-dos from the To-dos  tab.

You can select the individual to-dos from the My to-dos  tab and work with them as required. For 
more information on the various types of to-dos and how to work with them, see Shopper to-dos.
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On the Purchasing to-dos  tab, however, you can only view the non-shopper responsible 
purchasing to-dos that are associated with this purchase. For each of these to-dos, the State, 
Due date, Primary contact, Number, and Last updated  fields are displayed.

In the Purchase detail view, you can also view all approval requests, including those that have 
not been requested. For example, if there is a sequential rule that has three approvers, all three 
purchase request approvals are displayed. Approvals are not triggered for the subsequent 
approvers though, and email notifications are sent only when approval is required for purchase 
request. If the approval is no longer required or complete, it is no longer displayed.

Light view of purchasing to-dos

You can select View activity  on a purchasing to-do item to display a light view of the to-do, 
where you can view its activity stream, and compose a message and post it as a comment in the 
activity stream. You can also tag a person you want to address, with "@<primary contact name>", 
in the Comments  field. An instructional message is displayed above the Compose section, 
which dynamically shows who the primary contact is for the associated purchasing task. An 
email notification is sent to the user who is tagged such that they know when they have been 
mentioned in an activity stream post.

My requests

As a shopper, you can view all the order revisions from your shopping account anytime by 
selecting My requests from your profile in Shopping Hub.

You can also track the progress of your request such as edit or cancel requests from your 
account or the Shopping Hub footer. Track the progress of the purchase modification requests, 
view its activity stream, review to-dos, view, and upload attachments associated with the 
purchase line or purchase order line.

Multi-currency support in Shopping Hub

Shoppers can view and select their local currency during shopping in Shopping Hub, providing a 
seamless multi-currency experience.

Key benefits

The multi-currency functionality provides the following benefits:

• Enables shoppers to view prices in their familiar local currency, helping them make more 
informed purchasing decisions.

• Enables shoppers operating across multiple geographies to toggle between currencies, 
providing better context for purchase decisions.

• Enables approvers to view product prices in their local currency alongside the original supplier 
currency across email notifications and To-dos.

How to configure

Role required: sn_shop.procurement_administrator

Plugin required: Shopping Hub (sn_spend_uib)

Ensure that you complete the following configurations for the multi-currency functionality to work 
correctly in Shopping Hub.
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• Set the sn_spend_uib.local_currency.enable.menuoption  system property 
to enable shoppers to view product prices in local currency in Shopping Hub. For more 
information, see Components installed with Sourcing and Procurement Operations.

Note:  Property is set to True by default. If you do not want prices to be displayed in the 
local currency, set this property to False.

• Ensure that each sys_user record is associated with an organization.

This allows the organization’s local currency to become the user’s default currency upon login.

Note:  This is the Legal Entity record. On this record, you can view the local currency 
associated with the legal entity.
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• To display a currency in the View prices in  drop-down list on the Shopping Hub home page, a 
corresponding Currency record must exist in the fx_rate table and be active.

How it works

The following points describe how the multi-currency feature works:

• Shoppers can select the currency they want to view during 

shopping.

When a shopper selects a currency, the following banner message appears.

• For delegated shopping, the default currency is derived from the delegator’s legal entity.

• Estimated prices are displayed consistently across supplier cards, product details, cart, 
checkout, and purchase tracking pages.
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• As an approver, you can view the product price in your local currency alongside the original 
supplier currency. This information appears in email notifications and To-dos in Employee 
Center and Shopping Hub.

• The product price is also displayed in both your local currency and the original supplier 
currency on the product bundle page.

Purchase requisition line-level questions in Shopping Hub

Line-level questions let procurement admins capture product-specific information during 
checkout, improving data accuracy and enabling flexible purchase requisition workflows.

Key benefits

Capture essential information during request intake to minimize back-and-forth communication 
between the requester, fulfiller, and supplier.

How to configure

Role required: sn_shop.procurement_administrator

Plugin required: Shopping Hub (sn_spend_uib)

For more information about creating configurable, line-level questions for shoppers, see 
Configure purchase requisition line-level questions in ShoppingHub.

How it works

Learn how shoppers can access and enter additional product information at the line level when 
creating or reviewing purchase requisitions.

The additional information or questions added in the record producer for a specific product, 
product model, or product category appear during checkout in Shopping Hub.

If the questions are configured as mandatory, selectingAdd to cart  or Request to buy  expands 
the Additional information section, where you must provide your responses. You can submit the 
purchase only after answering all mandatory purchase requisition line-level questions for the 
selected product.
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Additional Information section in Shopping Hub

Note:  Edits to additional questions require shoppers to create a case for a fulfiller to 
update the responses. Shoppers can also request updates by posting a message in the 
purchase’s activity stream.

If you select Add to cart  or Request to buy  without completing mandatory fields in the Additional 
Information section, a message prompts you to fill them first.

Fill mandatory fields message in Additional Information section

After a purchase requisition is created for your request, the fulfiller can view the additional 
information in the Variables section of the purchase requisition line record in the ServiceNow AI 
Platform.

Note:  The Variables  input field is not available by default in the Outbound Order 
[sn_spend_intg_outbound_purchase_order] staging table. To integrate with an ERP system, 
you must add the Variables  field.
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Variables section of a PRL record in ServiceNow AI Platform

Additionally, the fulfiller can view this information on the Details  tab of the purchase requisition 
line record in the Source-to-Pay Workspace.

Note:  Fulfillers can update the response in the Variables section on the PRL record. The 
fulfiller can modify responses until the POL moves to the Ordered state. When the POL is in 
Revision state, the Variables section becomes editable again.

Details tab of a PRL record in Source-to-Pay Workspace

Note:  Fulfillers can update the response in the Variables section on the PRL record’s 
Details  tab in the Source-to-Pay Workspace. The fulfiller can modify responses until the 
POL moves to the Ordered state. When the POL is in Revision state, the Variables section 
becomes editable again.

The additional information also appears on the Purchase details page under My purchases in 
Shopping Hub.
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Purchase details page in My purchases

Purchase on behalf of another user in Shopping Hub

Shoppers can purchase products and services on behalf of another user in Shopping Hub. 
When purchasing on behalf of another user, shoppers can also view the carts and purchases 
associated with that user. A shopper who is authorized to purchase on behalf of other users is 
referred to as a super shopper.

Key benefits

This functionality provides the following benefits:

• Shopping controls allow administrators to define purchasing eligibility, ensuring that restricted 
products cannot be purchased.

• Checkout is allowed only if the product can be shipped to the delivery location of the user on 
whose behalf the purchase is made. If shipping is not supported, Shopping Hub prevents the 
purchase from being submitted.

• Shoppers purchasing on behalf of other users can easily view those users’ carts and 
purchases by selecting the user name from the filter list.
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System properties for purchasing on behalf of another user

System property Description

sn_shop.skip_shopping_controls_for_purchase_on_behalf_of_users Controls how Shopping 
Hub enforces shopping 
control restrictions 
when a super shopper 
purchases on behalf of 
another user.

• Default value: false

• When set to false, 
shopping control 
restrictions for 
the selected user 
are enforced and 
restricted products 
cannot be purchased.

• When set to true, 
restricted products 
for the selected user 
display a warning, 
but the purchase on 
behalf of another 
user is allowed to 
proceed.

sn_shop.skip_delivery_restrictions_for_purchase_on_behalf_of_users Controls how Shopping 
Hub enforces delivery 
address restrictions 
when a super shopper 
purchases on behalf 
of another user and 
the product cannot 
be delivered to the 
selected user’s default 
delivery address.

• Default value: false

• When set to false, 
products that cannot 
be delivered to the 
selected user’s 
delivery address 
cannot be purchased.

• When set to true, a 
warning is displayed 
for non-deliverable 
products, and the 
super shopper is 
allowed to proceed 
with the purchase.
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System property Description

sn_spend_uib.purchased_bahealf.enable.card.actions Controls the availability 
of purchase card 
actions for purchases 
made on behalf of other 
users in My purchases.

• Default value: true

• When set to true, 
all supported card 
options are available 
for purchases made 
on behalf of other 
users.

• When set to false, 
only the View 
purchase  option is 
available.

How to configure

Role required: sn_shop.shopping_hub_admin

Plugin required: Shopping Hub (sn_spend_uib)

Ensure that you configure the super shopper to purchase on behalf of other users. For more 
information, see Enable a shopper to purchase on behalf of another user.

How it works

The following points describe how this capability works:

To make a purchase on behalf of another user, select a product and then select the Purchase on 
behalf of  check box. From the On behalf of  list, select the user for whom the purchase is being 
made (for example, Andrew Griffin).
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After Request to buy  is selected, the system displays the relevant details configured for the 
selected user, such as cost center and delivery location. These details can be modified before 
the request is submitted.

After the request is submitted, the purchase is available in My purchases. By default, the page 
displays purchases made by you. You can use the filter to view purchases made on behalf of 
other users.

Tasks are not automatically assigned to the person the item was purchased for. To ensure 
they can confirm receipt of the item, make sure the selected address includes the business 
owner’s name in the Recipient  field. For all other tasks, the procurement specialist can reassign 
ownership to the business owner.

If the sn_spend_uib.purchased_bahealf.enable.card.actions  system property is set to true, all 
available card options are displayed for purchases made on behalf of other users. If the property 
is set to false, only the View purchase option is available.
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You can also view the carts of users on whose behalf you are making purchases.

If a user is selected from the Shopping for  list (for example, Warren Summers), the Purchase on 
behalf of  check box is disabled. In this case, Shopping Hub automatically sets the purchasing 
capability to the selected user only.
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Decimal quantity support for service-based purchases in Shopping Hub

As a shopper, you can now specify decimal quantity values for service-based products when you 
create or edit a purchase requisition (PR) or purchase order (PO) in Shopping Hub.

Key benefits

This functionality provides the following benefits:

• You can specify decimal quantities for selected service-based products.

• You can enable or disable decimal support for a service product by configuring its UOM.

Note:  Starting with Yokohama Patch 12 and Zurich Patch 6, Shopping Hub  supports 
decimal quantities for service-based products. If you upgraded to Yokohama Patch 12 or 
Zurich Patch 6 and cannot specify decimal quantities for services, you must run a script 
from the Scripts - Background module. For more information, see Run the fix script to 
enable decimal quantities for services.

How to configure

Role required: sn_shop.shopping_hub_admin

Plugin required: Shopping Hub (sn_spend_uib)
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• To enable this capability for a service product, you must configure a unit of measure (UOM) 
that supports decimal values.

• You control decimal quantity support at the UOM level. In the Unit of Measure Decimal Support 
decision table, set the decimalSupported attribute to true for the required UOM, as shown in 
the following image.

Note:  You can use decimal quantities only for products of type Service. You cannot 
specify decimal quantities for products of type Good, even if the UOM is configured to 
support decimal values.

How it works

The following points describe how this capability works:
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• When you purchase a product of type Service, you can enter a decimal value in the Quantity 
field.

• When you purchase a product of type Good, Shopping Hub prevents you from entering a 
decimal value in the Quantity field and displays an error message.

• When you edit a PR or PO for a product of type Service, you can enter a decimal value in the 
New quantity field.
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• When you edit a PR or PO for a product of type Good, Shopping Hub prevents you from 
entering a decimal value in the New quantity field and displays an error message.

Run the fix script to enable decimal quantities for services

After upgrading to Yokohama Patch 12 or Zurich Patch 6, if you are unable to specify decimal 
quantities for services, you must run a background fix script to enable support for decimal 
quantities.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
If you upgraded to Yokohama Patch 12 or Zurich Patch 6 and cannot specify decimal quantities 
for services, run this script from the Scripts - Background module. The script converts the 
quantity field type from integer to decimal and updates the field scale to four decimal places.
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Procedure

1. Navigate to All  > System Definition  > Scripts - Background.

2. In the Run script (JavaScript executed on server)  section, paste the following code:

(function() {
   var tableName = 'sn_spend_sdc_service_request_line';
   var columnName = 'new_purchased_quantity';
   if (pm.isZboot()) {
       return;
   }
   try {
       var updated = 
 GlideFixStuff.fixTypeFromIntegerToDecimalCaseLineQuantityItem(
tableName, columnName);
       if (!updated) {
           gs.info('Cannot update type from integer to decimal 
 for field ' + columnName);
           return;
       }
       updateScale();
   } catch (ex) {
       gs.info('Cannot update type from integer to decimal with 
 error ' + JSON.stringify(ex));
       return;
   }
   function updateScale() {
       var desiredScale = 4;
       var dictGR = new GlideRecord('sys_dictionary');
       var query = 'name=' + tableName + '^elementIN' + 
 columnName;
       var fieldName;
       dictGR.addEncodedQuery(query);
       dictGR.query();
       if (dictGR.next()) {
           try {
               var attrbiuteArray = [];
               var currentAttributes = dictGR.attributes;
               if (currentAttributes != '') {
                   attrbiuteArray = 
 currentAttributes.split(',');
               }
               var currentMaxLength = dictGR.max_length;
               fieldName = dictGR.element;
               var newMaxLength = currentMaxLength + 
 desiredScale;
               dictGR.max_length = newMaxLength;
               attrbiuteArray.push("scale=" + desiredScale);
               dictGR.attributes = attrbiuteArray.join(',');
               dictGR.update();
               dictGR.max_length = newMaxLength + 1;
               dictGR.update();
               gs.info('Updated max length twice for field ' + 
 fieldName);
           } catch (ex) {
               gs.info('Cannot update scale attribute due to 
 error : ' + JSON.stringify(ex));
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               gs.error('Error updating max length attribute 
 for field {0}. No update performed.', fieldName);
           }
       }
   }
})();

3. Deselect the Record for rollback?  check box.

4. Select Run Script.

Shopping Hub Mobile

The ServiceNow Shopping Hub Mobile  app enables you to engage with procurement 
organizations from a mobile device. Shopping Hub Mobile  is available on the Now Mobile app 
and is supported on iOS and Android devices.

To access Shopping Hub Mobile  from your mobile device, you must first download the Now 
Mobile application on an iOS platform from the Apple App Store or on an Android platform from 
the Google Play Store.

For more information on installing Shopping Hub Mobile, see Install ShoppingHub Mobile.

Shoppers can use Shopping Hub Mobile  to complete to-dos assigned to them, view, track, 
and revise their purchases, request for products or services that they don't see listed on the 
ShoppingHub portal, and submit quotes from vendors for review by the procurement team.

For more information on using Shopping Hub Mobile, see Using Shopping Hub Mobile.

Related topics

Application plugin installation sequence in Sourcing and Procurement Operations

My purchases on your mobile

As a shopper, you can view all the purchases you made from your shopping account, view their 
statuses, and revise your purchases.

As a ShoppingHub Administrator, you can configure your mobile instance to display My 
Purchases on your landing page. For details, see Display My Purchases on your mobile instance.

The fulfilment status of your individual purchases are flagged for your quick reference.

Your purchases are also highlighted with color coding to help you quickly understand their due 
dates, if any. A red badge is displayed on a purchase if:

• Any of the purchasing tasks associated with the purchase requisition line or purchase order 
line are overdue.

• Any of the milestones associated with the purchase order line are overdue.

• Any of the receipt tasks associated to the parent purchase order are overdue.

Similarly, a yellow badge is displayed if any of the above conditions have a due date approaching 
in seven days. A grey badge is displayed if any of the above conditions have a due date more 
than seven days.

You can open any purchase to view the details of the purchase and more information associated 
to your purchase, as applicable, such as additional quotes, receipts, prepayments, and other 
related lists.
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You can track the updates on a selected order from Activity  > Activity and Attachments 
> Activity. You can also compose a message and tag a person you want to address, with 
"@<primary contact name>", in the Add Comment  field.

You also have the option to view and upload attachments associated with a purchase from 
Activity  > Activity and Attachments  > Attachments.

Filter

You can filter your orders by:

• Open:

◦ All purchase lines that are not in the state Closed Rejected, Closed Canceled, Closed 
Complete, or Closed No Decision, and the parent sourcing request, negotiation, or purchase 
requisition not in any of the respective closed states.

◦ This is the default option.

• Closed:

◦ All purchase order lines that are in the state Closed Complete, Closed Paid, or Closed 
Canceled.

◦ All purchase lines that are in the state Closed Rejected, Closed Canceled, Closed Complete, 
or Closed No Decision.

◦ Where a purchase order line exists, the corresponding purchase line is not visible.

• All: All the orders, irrespective of their state. Where a purchase order line exists, the 
corresponding purchase line is not visible.

Related topics

View and revise your purchase from your mobile device

Performance Analytics for Sourcing and Procurement Operations

With this application, you can use a set of pre-configured metrics and dashboards to assess 
spend, operational efficiency, and team performance across the Sourcing and Procurement 
Operations  product.

Visually analyze how you’re placed with your work and achievements over a given period of time, 
with the Procurement Buyer Dashboard. For more information on these, see Procurement Buyer 
Dashboard.

Visually analyze how your organization is placed strategically and operationally, over a given 
period of time, with the Procurement Strategy & Ops Dashboard. For more information on these, 
see Procurement Strategy & Ops Dashboard.

Visually analyze how your team is performing on sourcing requests, purchase requisitions, 
negotiated savings, and negotiation outcomes, over a given period of time, with the Procurement 
Team Performance Dashboard. For more information on these, see Procurement Team 
Performance Dashboard.

You can access these dashboards by navigating to All  > Platform Analytics Workspace  > 
Analytics Center  > Dashboards.

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations
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Procurement Buyer Dashboard

Visually analyze how you’re placed with your work and achievements over a given period of time.

Note:  This dashboard is available only if you install the Performance Analytics for 
Sourcing and Procurement Operations  application.

You can use the Procurement Buyer Dashboard to view all your open sourcing requests, 
negotiations, purchasing tasks, purchase requisitions, and expiring contracts, in widgets that 
distinguish these by due dates. You can also view your achievements, which include your year-
to-date total spend, further broken down by spend categorization, total savings, negotiation 
outcomes, and the average cycle time of your assigned sourcing requests and purchase 
requisitions.

End user and roles

End user and goal Required role

Procurement Specialist: View your work and 
achievements.

sn_shop.procurement_specialist

Procurement Specialist Manager: View your 
work and achievements. This role contains the 
specialist role, and hence has access to the 
buyer dashboard.

sn_shop.procurement_specialist_manager

Procurement Administrator: View and make 
configuration changes to the widgets.

sn_shop.procurement_administrator

Indicators

• Number of Open Purchasing Task

• Number of Open Purchase Requisition

• Number of Closed Purchase Requisitions - Monthly

• Purchase Requisition - Avg Cycle Time (Days) - Monthly

• Number of Closed Sourcing Requests - Monthly

• Number of Open Sourcing Request

• Number of Open Negotiations

• Sourcing Request - Avg Cycle Time (Days) - Monthly

• Number of Expiring Contracts

Breakdowns

• Cost center

• Department

• Negotiation - AssignedTo

• PurchaseRequisition - AssignedTo

• PurchaseTask - AssignedTo

• SourcingRequest - AssignedTo
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• (PSM) Contract End Date Breakdown

• (PSM) Due Date Breakdown

Reports

The Procurement Buyer Dashboard is segregated into the following tabs:

• My Work: View all your open sourcing requests, negotiations, purchasing tasks, purchase 
requisitions, and expiring contracts.

• My Achievements: View your achievements, which include your year-to-date total spend, 
spend categorization, total savings, negotiation outcomes, and average cycle times for 
sourcing request and purchase requisition.

Note:  All the reports pertain to tasks that the logged-in user is assigned to.

For a detailed analysis on each component, select the respective widget or chart.

Title Type Description

My Work

My Open Sourcing Requests Widget View your total number of 
sourcing requests that aren’t 
in a closed state.

My Open Negotiations Widget View your total number of 
negotiations that aren’t in a 
closed state.

My Expiring Contracts Widget View your total number of 
contracts, associated to 
purchase requisitions in any 
state, that have an end date of 
90 days out.

My Open Sourcing Requests 
by Due Date

Pie chart View the breakdown of the 
count of your open sourcing 
requests by due date range.

My Open Negotiations by Due 
Date

Pie chart View the breakdown of 
the count of your open 
negotiations by due date 
range.

My Expiring Contracts by Due 
Date

Pie chart View the breakdown of 
the count of your expiring 
contracts by end date range.

My Open Purchasing Tasks Widget View your total number of 
purchasing tasks that aren’t in 
a closed state.

My Open Purchasing Tasks by 
Due Date

Pie chart View the breakdown of the 
count of your open purchasing 
tasks by due date range.

All Open Task Types Stacked bar chart View the count of the open 
purchasing tasks that aren’t 
assigned to the logged-
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Title Type Description

in user, by task type and 
due date range. The parent 
purchase requisition however 
is assigned to the logged-in 
user.

My Open Purchase 
Requisitions

Widget View your total number of 
purchase requisitions that 
aren’t in a closed state.

My Aging Purchase 
Requisitions

Stacked bar chart View the breakdown of the 
count of your purchase 
requisitions by age (that is the 
number of days since opened) 
and state.

My Achievements

My YTD Total Spend Widget View the year-to-date sum of 
all the spend for purchase 
lines managed by the buyer, 
excluding blanket purchase 
orders.

My YTD Spend Categorization Pie chart
View the breakdown of your 
total year-to-date spend 
by addressable and non-
addressable categories.

The total spend is the sum of 
the total line amount on the 
purchase order line, excluding 
blanket purchase orders, 
where the logged-in user is 
also the one assigned, the 
state of the purchase order 
isn’t closed canceled, and 
the spend categorization is 
either addressable or non-
addressable.

My YTD Total Savings Widget View the year-to-date sum of 
the negotiated savings across 
all closed complete purchase 
requisition lines assigned to 
the buyer.

My YTD Negotiation 
Outcomes

Stacked bar chart
View your year-to-date 
negotiation outcomes against 
the negotiation count, 
grouped by negotiation type.

Some of the possible 
negotiation outcomes are 
contract renewal, quote, 
RFx, and so on. Negotiation 
types can be cost avoidance, 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

393



Title Type Description

standard savings, contract 
terms negotiations, or 
unsuccessful negotiations.

This report shows negotiation 
outcomes where the 
corresponding negotiation 
state is either Closed 
Complete or Closed 
Canceled.

My Average Sourcing Request 
Cycle Time

Bar with line
View the average time from 
when a sourcing request is 
created to when its state is 
Closed Complete or Closed 
No Decision.

The report pulls all the 
sourcing requests that went 
into Closed Complete or 
Closed No Decision state for 
the month, and takes the cycle 
time from when they were 
opened. This data is retrieved 
from the Duration  field on the 
sourcing request.

My Average Purchase 
Requisition Cycle Time

Bar with line
View the average purchase 
requisition cycle time from 
when a purchase requisition 
is created to when its state 
is Closed Complete, Closed 
Rejected, or Closed Canceled.

The report pulls all the 
purchase requisitions that 
went into Closed Complete, 
Closed Rejected, or Closed 
Canceled status for the 
month, and takes the cycle 
time from when they were 
opened. This data is retrieved 
from the Duration  field on the 
purchase requisition.

For information on how to work with dashboards in configurable workspaces, see Dashboards in 
Platform Analytics .

For information on how to work with widgets and data visualizations in configurable workspaces, 
see Data visualizations in Platform Analytics .

Procurement Strategy & Ops Dashboard

Visually analyze how your organization is placed strategically and operationally, over a given 
period of time.
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Note:  This dashboard is available only if you install the Performance Analytics for 
Sourcing and Procurement Operations  application.

You can use the Procurement Strategy & Ops Dashboard to view your organization's strategic 
performance, which includes year-to-date total spend, spend categorization, total savings, 
negotiation outcomes, spend by category and supplier, and utilization of active blanket purchase 
orders. On the operations side, you can view your organization's open sourcing requests, 
negotiations, expiring contracts, and purchase requisitions and their details. You can filter by 
cost center or department and select specific elements to view relevant details.

On the SLA side, you can view the basic cycle times for different record types, time taken for 
each state, comparison of breached versus unbreached records, breached time in comparison 
with standard SLA time, and team performance in terms of processing records and also the 
excess time taken for breached records. You can filter the records by task type.

Note:  The widgets plot metrics or data from the day the upgrade is taken, as the triggers 
for collecting metrics are enabled only after the upgrade. So, historical data isn’t available 
automatically after the upgrade but is accumulated thereafter. Also, if any new case types 
are introduced in the system and you want to add its metrics to the SLA dashboard, ensure 
that you update the indicator source.

End user and roles

End user and goal Required role

Procurement Specialist Manager: View your 
organization's strategic and operational 
performance. You can view your organization's 
SLA-related details. This role has the same 
access as a procurement specialist, except 
that they have access to the manager 
dashboards.

sn_shop.procurement_specialist_manager

Procurement Administrator: View and make 
configuration changes to the widgets.

sn_shop.procurement_administrator

Indicators

• Number of Expiring Contracts

• Number of Open Negotiations

• Number of Open Purchase Requisition

• Number of Open Sourcing Request

• Number of Total (ATF) Purchase Requisition

• Order Line Revisioned Line Amount

• Order Line Total Line Amount(History Line)

• PSM - Average cycle time for record types

• PSM - Average cycle time in each state for record types

• PSM - Breached SLA by record type

• PSM - Number of closed record types

• PSM - Procurement Team Performance.Count
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• PSM - ProcurementSLA.duration of records

• PSM - ProcurementSLA.standard time

• Purchase Order - Total Line Amount

• (ATF) Purchase Line - Total Line Amount

Breakdowns

• Cost center

• Department

• Negotiation - AssignedTo

• ProcurementSLA - HasBreached

• ProcurementUsers - AssignedTo

• Product Category

• PurchaseRequisition - AssignedTo

• PurchaseTask - AssignedTo

• SourcingRequest - AssignedTo

• State

• Supplier

• Task type

• (PSM) Contract End Date Breakdown

• (PSM) Due Date Breakdown

Reports

The Procurement Strategy & Ops Dashboard is segregated into the following tabs:

• Strategic: View your organization's strategic performance, which includes year-to-date total 
spend, spend categorization, total savings, negotiation outcomes, spend by category and 
supplier, and utilization of active blanket purchase orders.

• Operations: View your organization's open sourcing requests, negotiations, expiring contracts, 
and purchase requisitions and their details.

• SLA: View your organization's average time to complete records, breached SLA by record type, 
and a comparison between average time and SLA time of breached records.

Note:  By default, YTD is configured to start from January. However, this can be configured 
to start from any month if need be.

For a detailed analysis on each component, select the respective widget or chart.

Title Type Description

Strategic

Total Spend - YTD Widget View the total year-to-
date amount across the 
organization for all standard 
purchase orders, excluding 
blanket and closed canceled 
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Title Type Description

purchase orders. Only 
standard purchase orders and 
purchase order releases are 
considered.

Spend Categorization - YTD Pie chart
View the breakdown of the 
total year-to-date spend 
across the organization 
by addressable and non-
addressable categories.

The total spend is the sum 
of the total line amount on 
the purchase order line, 
excluding blanket purchase 
orders, where the state of 
the purchase order isn’t 
closed canceled, and the 
spend categorization is 
either addressable or non-
addressable.

Total Savings - YTD Widget View the year-to-date sum 
of the negotiated savings 
across the organization for 
all standard purchase orders, 
excluding blanket and closed 
canceled purchase orders. 
Only standard purchase 
orders and purchase order 
releases are considered.

Negotiation Outcomes - YTD Stacked bar chart
View the year-to-date 
negotiation outcomes across 
the organization against the 
negotiation count, grouped by 
negotiation type.

Some of the possible 
negotiation outcomes are 
contract renewal, quote, 
RFx, and so on. Negotiation 
types can be cost avoidance, 
standard savings, contract 
terms negotiations, or 
unsuccessful negotiations.

This report shows negotiation 
outcomes where the 
corresponding negotiation 
state is either Closed 
Complete or Closed 
Canceled.
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Title Type Description

Spend by Category - YTD List View the year-to-date 
committed spend, that is 
purchase order created, 
across the organization, 
grouped by the category 
associated to the supplier 
product on the purchase order 
line.

Total Spend by Supplier - YTD List View the total year-to-
date amount across the 
organization for all standard 
purchase orders, excluding 
blanket and closed canceled 
purchase orders, grouped 
by supplier. Only standard 
purchase orders and 
purchase order releases are 
considered.

Utilization of Active Blanket 
Purchase Orders

List View the released or subtotal 
percentage of the active 
blanket purchase orders 
across the organization that 
are within the end date.

Operations

Open Sourcing Requests Widget View the total number of 
sourcing requests across the 
organization that aren’t in a 
closed state.

Open Negotiations Widget View the total number of 
negotiations across the 
organization that aren’t in a 
closed state.

Expiring Contracts Widget View the total number of 
contracts, associated to 
purchase requisitions in any 
state, across the organization, 
that has an end date of 90 
days out.

Open Sourcing Requests by 
Due Date

Pie chart View the breakdown 
of the count of open 
sourcing requests across 
the organization by due date 
range.

Open Negotiations by Due 
Date

Pie chart View the breakdown of the 
count of open negotiations 
across the organization by 
due date range.

Expiring Contracts by End 
Date

Pie chart View the breakdown of the 
count of expiring contracts 
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Title Type Description

across the organization by 
end date range.

Open Purchase Requisitions Widget View the total number of 
purchase requisitions across 
the organization that aren’t in 
a closed state.

Aging Purchase Requisitions Stacked bar chart View the breakdown of the 
count of purchase requisitions 
across the organization by age 
(that is the number of days 
since opened) and state.

After-the-Fact (ATF) Purchase 
Requisitions

Bar with line View the count and $ value of 
After-the-Fact (ATF) purchase 
requisitions.

$ value is the value of 
purchase lines that satisfy 
the ATF criteria. For example, 
if there’s one ATF purchase 
requisition with two lines 
(purchase requisition line 1 
is ATF with line amount $10, 
and purchase requisition line 
2 isn’t ATF with line amount 
$5), the count of ATF purchase 
requisitions is 1 and the $ 
value is $10.

Revised ATF purchase 
requisitions and their values 
aren’t considered.

SLA

Average time to complete 
record

Bar with line View the average cycle 
time and count for record 
types such as sourcing 
request, purchase requisition, 
negotiation, and cases. While 
the count is shown on the Y-
axis and is represented by the 
bar, the line represents the 
time.

Fact data for this widget is 
derived from database views 
created from metric definitions 
that track psm_unique_state 
and active fields of PSM 
record types.

Average time to complete by 
state

Stacked bar chart View the breakup of the time 
taken in each state of the 
record.
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Title Type Description

For example, if a sourcing 
request took three days to 
complete, then the time 
taken in each state of the 
sourcing request like pending 
review, requires decision, 
awaiting response, and so on, 
is displayed here.

This widget should be read 
in conjunction with the 
previous widget to get an 
understanding of the average 
time, and the breakup of this 
average time into various 
states.

Data for this widget is derived 
from database views created 
from metric definitions that 
track psm_unique_state and 
active fields of PSM record 
types.

Breached SLA by record type Stacked bar chart View a comparison between 
the records that were 
processed within the SLA time 
versus those that weren't. 
This gives an idea of the 
percentage work done that 
is within the SLA and the 
percentage that is breaching 
it.

For example, if 100 records 
were processed in a week and 
70 records were processed 
within the SLA time, then 70% 
of the work is done within the 
SLA and 30% is breaching it.

Data for this widget is derived 
from the Task SLA table that is 
fed by SLA definitions created 
on the active fields of PSM 
record types.

Average time vs SLA time of 
breached records

Time series column View the actual time taken 
versus the allotted SLA time. 
This gives an understanding 
of the extra time that is taken 
when compared to the SLA 
time.
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Title Type Description

Data for this widget is derived 
from the Task SLA table that is 
fed by SLA definitions created 
on the active fields of PSM 
record types.

Employee performance by 
record type

Stacked bar chart View the count of records 
of types sourcing request, 
purchase requisition, 
negotiation, and cases that 
have been processed by your 
team.

Data for this widget is derived 
from database views created 
from metric definitions that 
track active fields of PSM 
record types.

Employee performance 
breaches in durations

Stacked bar chart View the time taken for the 
breached records of the team.

The Procurement Specialist 
Manager can not only see the 
time taken for the breached 
records, but can also drill 
down to get the exact duration 
and the SLA time to get the 
details of time exceeded by 
SLA.

Data for this widget is derived 
from the Task SLA table that is 
fed by SLA definitions created 
on the active fields of PSM 
record types.

For information on how to work with dashboards in configurable workspaces, see Dashboards in 
Platform Analytics .

For information on how to work with widgets and data visualizations in configurable workspaces, 
see Data visualizations in Platform Analytics .

Procurement Team Performance Dashboard

Visually analyze how your team is performing on sourcing requests, purchase requisitions, 
negotiated savings, and negotiation outcomes, over a given period of time, with the help of the 
Procurement Team Performance Dashboard.

Note:  This dashboard is available only if you install the Performance Analytics for 
Sourcing and Procurement Operations  application.
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End user and roles

End user and goal Required role

Procurement Specialist Manager: View your 
organization's overall performance. This 
role has the same access as a procurement 
specialist, except that they have access to the 
manager dashboards.

sn_shop.procurement_specialist_manager

Procurement Administrator: View and make 
configuration changes to the widgets.

sn_shop.procurement_administrator

Indicators

• Number of Total Cost Avoidance Negotiations

• Number of Total Negotiations

• Number of Closed Purchase Requisitions - Monthly

• Number of All Purchase Requisition - Monthly

• Purchase Line Total Negotiated Savings

• Purchase Requisition - Avg Cycle Time (Days) - Monthly

• Number of Closed Sourcing Requests - Monthly

• Purchase Line Negotiated Savings

• Number of Total Contract Terms Negotiations

• Number of Total Negotiation Unsuccessful

• Sourcing Request - Avg Cycle Time (Days) - Monthly

• Number of All Sourcing Request - Monthly

• Parent Line Negotiated Savings

• Number of Total Standard Savings Negotiations

Breakdowns

• Negotiation - AssignedTo

• PurchaseRequisition - AssignedTo

• SourcingRequest - AssignedTo

Reports

Note:  By default, YTD is configured to start from January. However, this can be configured 
to start from any month if need be.

For a detailed analysis on each component, select the respective widget or chart.

Title Type Description

Average Sourcing Request 
Cycle Time

Bar with line
View the average time from 
when a sourcing request is 
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Title Type Description

created to when its state is 
Closed Complete or Closed 
No Decision.

The report pulls all the 
sourcing requests across the 
organization that went into 
Closed Complete or Closed 
No Decision state for the last 
five months, and takes the 
cycle time from when they 
were opened. This data is 
retrieved from the Duration 
field on the sourcing request.

You can set a target cycle time 
that serves as a benchmark 
for the organization, and easily 
visualize how current cycle 
times compare against it.

Sourcing Request Cycle Time 
- Last Month

List
View the average cycle time 
for sourcing requests by buyer 
across the organization.

You can also view the number 
of open sourcing requests that 
were assigned to the buyer 
as of last month, which were 
either closed last month or 
open throughout the duration 
of the month.

Average Purchase Requisition 
Cycle Time

Bar with line
View the average purchase 
requisition cycle time from 
when a purchase requisition 
is created to when its state 
is Closed Complete, Closed 
Rejected, or Closed Canceled.

The report pulls all the 
purchase requisitions across 
the organization that went 
into Closed Complete, Closed 
Rejected, or Closed Canceled 
status for the last four months, 
and takes the cycle time from 
when they were opened. 
This data is retrieved from 
the Duration  field on the 
purchase requisition.

You can set a target cycle time 
that serves as a benchmark 
for the organization, and easily 
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Title Type Description

visualize how current cycle 
times compare against it.

Purchase Requisition Cycle 
Time - Last Month

List
View the average cycle time 
for purchase requisitions by 
buyer across the organization.

You can also view the number 
of open purchase requisitions 
that were assigned to the 
buyer as of last month, which 
were either closed last month 
or open throughout the 
duration of the month.

Negotiated Savings by Buyer - 
YTD

List View the sum of the year-
to-date negotiated savings 
across all closed complete 
purchase lines across the 
organization.

Negotiation Outcomes by 
Buyer - YTD

List
View the list of buyers across 
the organization along with 
their corresponding year-to-
date negotiation outcomes, 
where the corresponding 
negotiation state is either 
Closed Complete or Closed 
Canceled.

Some of the possible 
negotiation outcomes are 
contract renewal, quote, 
RFx, and so on. Negotiation 
types can be cost avoidance, 
standard savings, contract 
terms negotiations, or 
unsuccessful negotiations.

For information on how to work with dashboards in configurable workspaces, see Dashboards in 
Platform Analytics .

For information on how to work with widgets and data visualizations in configurable workspaces, 
see Data visualizations in Platform Analytics .

Sourcing and Purchasing Automation

Sourcing and Purchasing Automation  for ShoppingHub includes workflows that help support 
the user interface purchasing experience for the shopper. These workflows consist of sourcing 
requests, negotiations, purchase requisitions, contracts, purchase orders, receipts, and invoices.

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations
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Sourcing request

A sourcing request is created for when an item that a shopper, employee, or requester needs, 
must be sourced. This record is created when an active contractual price for the product that the 
shopper intends to purchase doesn’t exist. This includes items in both the product catalog and 
off-catalog.

A purchase line is created, which is then grouped into a sourcing request. Sourcing requests are 
grouped by product models.

As a procurement specialist or sourcing manager:

• To view all sourcing requests from the Source-to-Pay Workspace, navigate to All  > 

Procurement Case Management  > Source-to-Pay Workspace, and select the List icon ( ), 
followed by All team work  > Sourcing Requests.

• To view all sourcing requests from the Platform, navigate to Sourcing and Purchasing 
Automation  > All Work, and select All Sourcing Requests.

• To view sourcing requests assigned to you from the Platform, navigate to Sourcing and 
Purchasing Automation  > My Work, and select My Sourcing Requests.

After the shopper places a request for a catalog or non-catalog item from ShoppingHub, the 
information that the shopper provides is mapped to the fields of a sourcing request as follows:

Sourcing request fields

Field Description

Number System-generated unique identifier of the 
sourcing request.

Assigned to User who is responsible for the purchase. 
Determined using purchasing assignment 
rules.

For details, see Create a purchasing 
assignment rule.

Business owner User who owns the sourcing request.

Submitted by User who has shopped and submitted the 
purchase.

Status Status of the sourcing request.

Note:  This is a read-only field.

Purchase Related purchase, if any.

Sourcing event Represents the type of sourcing activity 
needed to negotiate with each supplier, and 
tracks the individual negotiations with each 
supplier.

Short description Brief description of the sourcing request.

Summary Details

Product category Product category that is sourced through this 
sourcing request.
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Sourcing request fields  (continued)

Field Description

Product model Product model that is sourced through this 
sourcing request.

Product name Product that is requested for.

Product type Indicates if the type of the product is a good or 
service.

Supplier responses close Date by which the suppliers must submit their 
responses to the sourcing activity.

Benchmark price Price point from which all starting unit costs for 
all the purchase lines of this sourcing requests 
are derived.

Request type Type of request that the shopper, employee, 
or requester is asking for. The options are 
request for quote, request for information, 
request for proposal, and proof of concept.

Sourcing request details Details of the sourcing request.

The following are the related lists of a sourcing request record:

Sourcing request related lists

Related list Description

Purchase Lines Provides information of the individual lines 
under a sourcing request for the referenced 
supplier.

The number of purchase lines for a sourcing 
request depends on the number of products 
or services with the same product model.

For more details, see Purchase lines.

Purchasing Tasks Provides information of all purchasing tasks 
that are related to the sourcing request. The 
tasks on the associated negotiation aren’t 
displayed.

For more details, see Purchasing tasks and 
procurement cases.

Cases Displays all the cases associated with this 
sourcing request.

Purchasing SLAs Displays the SLAs associated to purchasing 
tasks against the sourcing request, along with 
tasks associated to the underlying purchase 
requisition line.

Negotiations Represents the task of obtaining the pricing 
of or negotiating the terms for the product or 
service requested by the shopper.
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Sourcing request related lists  (continued)

Related list Description

For more details, see Negotiations.

Draft Contracts Displays all the draft contracts associated with 
this sourcing request.

For more details, see Contracts.

Signed Contracts Displays all the signed contracts associated 
with this sourcing request.

Other Legal Documents Displays all the other legal documents 
associated with this sourcing request.

Contract Requests Displays all the associated contract requests 
against this sourcing request.

Note:  This field is displayed only if 
you have the Source-to-Pay Operations 
with Contract Management Pro  plugin 
(com.snc.sn_spend_clm) installed.

Approval Plans Displays all the approval plans created against 
this sourcing request.

Draft Emails Associated email communication that is saved 
as drafts.

Sent Emails Associated email communication that has 
been sent.

Sourcing and negotiation workflow

After a sourcing request is created, the procurement specialist can create a purchasing task of 
the subtype Ask a question  if more details are needed from the shopper.

The procurement specialist can decide if a negotiation for this purchase can be created or 
not. If time doesn’t permit for a negotiation, the supplier can be contacted directly for pricing 
details. After the suppliers respond with their quotes, a purchasing task is systematically created 
requesting the shopper to select a supplier to award. This is a sourcing task of the subtype 
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Select a supplier. For an awarded supplier, the Awarded column value of a purchase line is 
automatically set to Yes, and this creates an associated purchase requisition.

A shopper can select Cancel  to update the status of the sourcing request and its associated 
purchase lines to Closed Canceled.

Sourcing request state flows

Let's consider a simple scenario where qualification is needed. If a price is entered on a 
purchase line (PRL), the PRL indicates that the price has been added or updated, and moves to 
the Pricing Obtained state, where it remains in that state. All the other PRLs without price and the 
sourcing request (SR) continue to remain in the Qualification Needed state. Once qualified, the 
SR and other PRLs that are in the Qualification Needed state move to the Qualified state, while 
the PRL that had price remain in the Pricing Obtained state.

Manually creating a new PRL re-triggers the qualification flow. If pricing has been added to this 
PRL, the PRL remains in the Pricing Obtained state while qualification work is being done. The SR 
also remains in the Qualification Needed state, as needed.

When sourcing events (NEs) and negotiations (NEGs) are considered in the sourcing flow, 
consider the following scenarios:

• Qualification is needed, where NE is in the Planned state, and NEG, SR, and PRL are all in the 
Qualification Needed state:

If a price is entered on a PRL, the PRL indicates that the price has been added or updated, and 
moves to the Pricing Obtained state, where it remains in that state. All the other PRLs without 
price and the SR continue to remain in the Qualification Needed state. Once qualified, the SR 
and other PRLs that are in the Qualification Needed state move to the Qualified state, while the 
PRL that had price remain in the Pricing Obtained state.

• NEG is in progress, where NE is in WIP, and NEG, SR, and PRL are all in the Negotiation in 
Progress state:

If a price is entered on a PRL when NEG is in progress, the PRL indicates that the price has 
been added or updated, and moves to the Pricing Obtained state, where it remains in that 
state. All the other PRLs without price and the NEG and SR remain in the Negotiation in 
Progress state, while the NE remains in WIP.

• New SRs or suppliers are added after Start negotiating  is selected on the NE, where NE is in 
WIP, and NEG, SR, and PRL are all in the Negotiation in Progress state:

This triggers qualification cases to be evaluated on the affected PRLs and move the NEG to 
Qualification Needed. If qualification isn’t needed, both the NEGs and the newly created PRLs 
remain in the Negotiation in Progress state.

If qualification is needed, NEs remain in WIP even when new SRs or existing suppliers are 
added. Once qualification cases are complete, Individual NEGs automatically move from 
Qualified to Negotiation in Progress, without the need to re-select Start negotiating  on the NE. 
The newly evaluated PRLs also move to Negotiation in Progress.

However, at any point, if a price is entered on any of the newly created PRLs, the PRL indicates 
that the price has been added or updated, and moves to the Pricing Obtained state, where it 
remains in that state.

The default states that are available for a sourcing request are listed.

• Pending Approval

• Pending Review
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• Information Needed

• Qualification Needed

• Qualified

• Pending Negotiation

• Negotiation in Progress

• Pending Resubmission

• Awaiting Supplier Response

• Awaiting Task Completion

• Requires Decision

• Closed Complete

• Closed No Decision

• Closed Canceled

• Closed Rejected

For more information on NEGs and NEs, see Negotiations  and Sourcing events  respectively.

For information on how a supplier tiering assessment task influences SR states, see Sourcing 
and Procurement Operations integration with Third-party Risk Management.

Negotiations

A negotiation represents individual supplier negotiations and tracks the items and activities 
according to supplier. These activities involve obtaining the price for the products or services 
requested by the shopper, or negotiating the terms.

The type and outcome of a negotiation record can be used for reporting purposes.

Here’s a list of key fields of a negotiation:

Negotiation fields

Field Description

Number System-generated unique identifier of the 
negotiation.

Assigned to User who is responsible for the negotiation.

State Current status of the negotiation.

Note:  This is a read-only field.

Due date Date when this negotiation is scheduled to be 
completed.

Short description Brief of the negotiation.

Summary

Sourcing event Sourcing event associated with this 
negotiation.

Supplier Supplier with whom you are negotiating.

Negotiation type Type of negotiation with the supplier.
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Negotiation fields  (continued)

Field Description

For example, you can initiate a contract 
renewal or ask for a quote.

Negotiation outcome Result of the negotiation.

For example, you can negotiate contract terms 
or savings on a purchase.

Expected start Expected start date of the negotiation.

Actual start Actual start date of the negotiation.

Actual end Actual end date of the negotiation.

Duration Duration of the negotiation.

Negotiation objectives Objectives or goals for the negotiation.

Close notes Notes on closure of the negotiation, if any.

The following are the related lists of a negotiation:

Negotiation related lists

Related list Description

Sourcing Requests View and track all the sourcing requests 
associated with the purchase lines in the 
negotiation.

For details, see Sourcing request.

Purchase Lines View and track all the purchase line records 
within the parent purchase for the supplier 
referenced on the negotiation.

For details, see Purchase lines.

Purchasing Tasks View information on all the purchasing tasks 
that are related to the negotiation.

For details, see Purchasing tasks and 
procurement cases.

Cases View information on all the cases that are 
related to the sourcing event.

Draft Contracts View and track all the draft contracts for the 
supplier referenced on the negotiation.

For more details, see Contracts.

Signed Contracts View and track all the signed contracts for the 
supplier referenced on the negotiation.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

410



Negotiation related lists  (continued)

Related list Description

Other Legal Documents View and track all the other legal documents 
for the supplier referenced on the negotiation.

Contract Requests Displays all the associated contract requests 
against this negotiation.

Note:  This field is displayed only if 
you have the Source-to-Pay Operations 
with Contract Management Pro  plugin 
(com.snc.sn_spend_clm) installed.

Purchasing SLAs View all the purchasing SLAs associated to 
the purchasing tasks against the negotiation, 
along with tasks associated to the underlying 
purchase requisition line.

Draft Emails Associated email communication that is saved 
as drafts.

Sent Emails Associated email communication that has 
been sent.

Sourcing and negotiation workflow

Negotiation state flows

The status of the purchase line and the sourcing request updates automatically depending on 
the status of the negotiation. Negotiations are grouped by supplier.

• When the state of the negotiation is updated to Awaiting Supplier Response, all applicable 
purchase requisition lines, for the same supplier, of sourcing requests associated to the 
negotiation are also updated to Awaiting Supplier Response. The purchase requisition lines 
not belonging to sourcing requests associated to the negotiation aren’t updated.

• When all applicable purchase requisition lines, for the same supplier, of sourcing requests 
associated to the negotiation are updated to Pricing Obtained, the state of the negotiation 
should be Closed Complete. If one purchase requisition line is in Pricing Obtained state, 
while another is still in Awaiting Supplier Response, the state of the negotiation remains in the 
Awaiting Supplier Response state.
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• When the state of the negotiation is updated to Negotiation in Progress, all applicable 
purchase requisition lines, for the same supplier, of sourcing requests associated to the 
negotiation are updated to Negotiation in Progress. The purchase requisition lines not 
belonging to sourcing requests associated to the negotiation aren’t updated.

• When the state of the negotiation is updated to Closed Complete or Closed Canceled, no state 
updates are affected on the purchase requisition lines.

The default states that are available for a negotiation are listed.

• Planned

• Qualification Needed

• Qualified

• Negotiation in Progress

• Awaiting Supplier Response

• Pricing Obtained

• Awaiting Task Completion

• Requires Decision

• Closed Decided

• Closed No Decision

• Closed Rejected

• Closed Canceled

Sourcing events

Sourcing events represent the type of sourcing activity needed to negotiate with each supplier, 
and track the individual negotiations with each supplier. They help sourcing managers manage 
multi-supplier and multi-product negotiations.

Instead of individually managing negotiations of similar item requests from various suppliers 
who provide that item, sourcing managers can create a sourcing event for a negotiation intent 
or objective to manage multi-supplier and multi-product negotiations. Multiple negotiations and 
sourcing requests can be mapped to a single sourcing event as child entities.

Through this sourcing event, the sourcing managers can view and effectively manage the 
progress of the negotiations created for each supplier. They can also discuss, follow, update, 
or cancel the event, as required. Further, they can award a single supplier or multiple suppliers, 
or even reject bids by selecting Award, Award multiple suppliers, or Reject bids  respectively. 
Selecting Award multiple suppliers  redirects them to the Source-to-Pay Workspace, where they 
can complete the process. For more information on this, see Award multiple suppliers from a 
sourcing event.

Sourcing events can be best viewed from the Source-to-Pay Workspace  list page.

Here’s a list of key fields of a sourcing event:

Sourcing event fields

Field Description

Number System-generated unique identifier of the 
sourcing event.

Assigned to User who is responsible for the sourcing event.
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Sourcing event fields  (continued)

Field Description

State Current state of the sourcing event.

Note:  This is a read-only field.

Supplier responses close Date by which the suppliers must submit their 
responses to the sourcing activity.

Short description Brief of the sourcing event.

Description Details of the sourcing event.

Summary

Negotiation type Type of sourcing event or the method used to 
engage with the supplier.

For example, you can initiate a contract 
renewal or ask for a quote.

Negotiation outcome Anticipated outcome or end results of the 
sourcing event.

For example, you can negotiate contract terms 
or standard savings on a purchase.

Expected start Expected start date of the sourcing event.

Actual start Actual start date of the sourcing event.

Actual end Actual end date of the sourcing event.

Duration Duration of the sourcing event.

Negotiation objectives Objectives or goals for the sourcing event.

Close notes Notes on closure of the sourcing event, if any.

The following are the related lists of a sourcing event:

Sourcing event related lists

Related list Description

Sourcing Requests View all the sourcing requests that are 
mapped to this sourcing event.

For details, see Sourcing request.

Negotiations View all the negotiations with each supplier 
that are mapped to this sourcing event.

For details, see Negotiations.

Purchase Lines View and track all the purchase line records 
within the parent purchase for the suppliers 
referenced on the sourcing event.
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Sourcing event related lists  (continued)

Related list Description

For details, see Purchase lines.

Purchasing Tasks View information on all the purchasing tasks 
that are related to the sourcing event.

For details, see Purchasing tasks and 
procurement cases.

Cases View information on all the cases that are 
related to the negotiation event.

Draft Contracts View and track all the draft contracts for the 
suppliers referenced on the sourcing event.

For more details, see Contracts.

Signed Contracts View and track all the signed contracts for the 
suppliers referenced on the sourcing event.

Other Legal Documents View and track all the other legal documents 
for the suppliers referenced on the sourcing 
event.

Contract Requests Displays all the associated contract requests 
against this sourcing event.

Note:  This field is displayed only if 
you have the Source-to-Pay Operations 
with Contract Management Pro  plugin 
(com.snc.sn_spend_clm) installed.

Purchase SLAs View all the purchase SLAs associated to 
purchasing tasks against the sourcing event, 
along with tasks associated to the underlying 
purchase requisition lines.

Purchase Requisitions View information on all the purchase 
requisitions that are related to the sourcing 
event.

For more details, see Purchase requisition.

Draft Emails Associated email communication that is saved 
as drafts.

Sent Emails Associated email communication that has 
been sent.
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Sourcing event workflow

The default states that are available for a sourcing event are listed.

• Draft

• Planned

• Work in Progress

• Pricing Obtained

• Awaiting Task Completion

• Requires Decision

• Closed Complete

• Closed No Decision

• Closed Canceled

Purchase requisition

A purchase requisition represents a request that is sent internally within an organization to 
obtain purchased goods or services. It consists of items that need to be ordered, and may need 
to go through approvals for a purchase order to be created.

A purchase requisition is created in either of the following scenarios:

• When a shopper selects Request to buy  from a product details page on ShoppingHub.

• When a supplier is selected after providing quotes in a sourcing request.

Through a purchase requisition, the purchasing department understands details of the items that 
are requested, the quantity, supplier, cost, and reason for purchase.

Purchase requisition fields

Field Description

Number System-generated unique identifier of the 
purchase requisition.

Requisition type Indicates if this requisition is net new or a 
revision.

The shopper can revise the quantity of the 
product or delivery location for on order from 
ShoppingHub or the buyer can submit a 
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Purchase requisition fields  (continued)

Field Description

revision from the Sourcing and Purchasing 
Automation  module.

To understand how revisions are handled, see 
Purchase revisions.

Assigned to User who is responsible for the purchase. 
Determined using purchasing assignment 
rules.

Primary contact Person within the procurement team working 
on the purchase who can be contacted with 
questions. This field is populated or updated 
with the same user in the Assigned to  field on 
the purchase requisition.

Business owner User who submitted the purchase request.

Submitted by User who has shopped and submitted the 
purchase.

State Status of the purchase requisition.

Note:  This is a read-only field.

Purchase Unique ID of the purchase.

Negotiation Negotiation associated with this purchase 
requisition.

Purchase order Purchase order associated with this purchase 
requisition.

Short description Brief description of the purchase requisition.

Summary Details

Supplier Indicates the supplier who provides the 
product.

Order type Indicates whether the resulting order is a 
standard or blanket order.

During the checkout of a product or service, 
if the shopper selects a time frame for the 
delivery based on date range or term, the 
order type is considered as Blanket.

Otherwise, the order type is considered as 
Standard.

After the fact Indicates if the purchase requisition is after 
the fact or not.

After a purchase line is created and grouped 
into a purchase requisition, if the created on 
date is either within or after x number of days 
of the expected delivery date or start date, 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

416



Purchase requisition fields  (continued)

Field Description

then the entire purchase requisition would be 
considered as after the fact. For a purchase 
requisition that has multiple purchase lines, 
if at least one line is after the fact, the entire 
purchase requisition is considered after the 
fact.

Requested delivery Requested delivery date.

Note:  This can be a date or date range 
that is in the past, present, or future. For 
the date to be in the past, the After the 
fact  field must be set to Yes.

Shipping method Details of the carrier, the applicable suppliers, 
and the valid delivery location countries for 
those suppliers.

For more information on shipping methods 
and handling fees, see Handling fees.

Total estimated tax The estimated sum of all taxes related to 
purchase lines within a purchase requisition.

Total estimated shipping Estimated sum of all shipping costs related to 
purchase lines within a purchase requisition.

Discount percentage Discount provided if the minimum spend 
requirement is met.

This field isn’t displayed for a blanket order 
type.

Minimum spend Minimum amount that must be spent to avail a 
discount.

This field isn’t displayed for a blanket order 
type.

Total amount Total cost of purchase requisition calculated 
as the sum from all purchase lines.

Accounting Details

Payment term Payment term as agreed with the supplier.

This value defaults from the referenced 
supplier record.

Legal entity This value defaults from the associated 
business owner.

Purchasing entity This value defaults from the associated 
business owner.
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Purchase requisition fields  (continued)

Field Description

Cost center This value defaults from the associated 
business owner.

Note:  This value must be filled on 
the Business Owner record for it to be 
populated on the purchase requisition.

The following are the related lists of a purchase requisition:

Purchase requisition related lists

Related list Description

Purchase Lines Provides information of the individual 
lines under a purchase requisition for 
the referenced supplier. Handling fees, if 
applicable, are added as a purchase line for 
this purchase requisition. For more details, see 
Purchase lines.

For information on shipping methods and 
handling fees, see Handling fees.

Purchasing Tasks Provides information of all purchasing tasks 
that must be completed prior to creation of a 
purchase order.

For more details, see Purchasing tasks and 
procurement cases.

Purchasing SLAs Provides SLA information for tasks and 
approvals. The underlying SLA definitions are 
defined through purchasing SLA definitions, 
which is an administration module.

Cases Displays all the cases associated with this 
purchase requisition.

Related Contracts Provides information of all active and draft 
contracts for the referenced supplier.

Purchasing Permissions This related list is conditionally displayed for 
purchase requisitions whose order type is 
Blanket.

Purchasing permissions enable a user to 
define a list of pre-approved users, groups, 
departments, or cost centers. Any purchases 
made by these users against the blanket 
purchase order don’t require an approval 
process.

By default, the business owner on the 
originating purchase requisition of order type 
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Purchase requisition related lists  (continued)

Related list Description

Blanket  is added as a user that can create a 
standard release against a blanket purchase 
order.

Related Purchase Requisition This related list is conditionally displayed for 
revised requisitions. It shows the relationship 
between the original and revised purchase 
requisitions.

Approval Plans Displays all the approval plans created against 
this purchase requisition.

Approvals Displays the list of approvers that must 
approve the purchase requisition.

Contract Requests Displays all the associated contract requests 
against this purchase requisition.

Note:  This field is displayed only if 
you have the Source-to-Pay Operations 
with Contract Management Pro  plugin 
(com.snc.sn_spend_clm) installed.

Draft Emails Associated email communication that is saved 
as drafts.

Sent Emails Associated email communication that has 
been sent.

The key purchasing properties relevant to a purchase requisition are:

• sn_shop.atf.threshold.days

• sn_shop.spend.requisition.autoorder

• sn_shop.spend.requisition.autoorder.threshold

• sn_shop.approval.reassessment.resend

For the list of all purchasing properties, see Purchasing properties. If you have the role of a 
procurement administrator, you can access the Purchasing Properties module by navigating to 
Sourcing and Purchasing Automation  > Administration.

The default states that are available for a purchase requisition are listed.

• Pending Review

• Pending Approval

• Awaiting Task Completion

• Final Review

• Pending Submission

• Closed Complete

• Closed Canceled

• Closed Rejected

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

419



• Pending Cancellation

• Pending Revision

• Pending Supplier Confirmation

Handling fees

As an administrator, you can configure the conditions of a purchase request, which when met, 
adds a handling fee to that purchase request. Any field on the Purchase Request table can be 
used as part of the conditions to determine if a handling fee is to be applied for a purchase.

If multiple handling fees are generated based on the configurable conditions, the handling fee 
with the lowest rank is applied. A Procurement Administrator can leverage the Pricing table to 
apply handling fee pricing. In the Pricing table, handling fees can be set as a fixed price or as a 
percentage-based price. When percentage-based pricing is not applied, the handling fee line 
amount is a percentage of the total amount of all the lines on the purchase request.

If there is a handling fee rule associated with a purchase requisition, a new purchase line 
is created with product type as handling fee. You can also view the details of this view-only 
handling fee purchase line from the My purchases  tab.

Shipping method

As an administrator, you can create shipping methods and associate them with various suppliers 
and delivery locations. If a shipping method is defined by the admin for a specific supplier and a 
specific delivery location, it is prompted to the shopper during checkout. When multiple shipping 
methods are available, the user can select any one for the purchase. Shipping method is only 
applicable for product type goods. Shipping method records store the details of the carrier, the 
applicable suppliers, and the valid delivery location countries for those suppliers. If no countries 
are defined for a supplier to deliver, the shipper delivers to all countries.

The shopper is required to select the shipping method, if applicable, during both quick and full 
checkout to proceed. In full checkout, it is a mandatory field on the Delivery date page. During 
checkout, a shipping method is available for selection if both these conditions are met:

• If the supplier in a given shipping method is listed in that shipping method's Supplier  field.

• If the delivery location country in a given shipping method is listed in the Supplier delivers to 
field.

Shipping method is stored in each cart line and purchase line. It is also stored on each purchase 
requisition generated during full checkout, and is referenced in the purchase order and purchase 
order lines.

Shipping method is one of the criteria for grouping purchase requisitions, along with supplier, 
business owner, and blanket requisition. All purchase lines with the same shipping method are 
grouped together.

Purchase lines

Purchase lines provide information of the individual lines under a purchase requisition or a 
sourcing request for the referenced supplier.

A procurement specialist or procurement administrator can manually create a purchase line, in 
Pending Review state. Populate the following fields on the purchase line:

• Legal entity and cost center, based on the specified business owner

• General ledger account fields, based on the ledger assignment rules
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• Starting unit cost and Negotiated unit cost, based on the supplier product's underlying 
contractual price

• Unit, based on the underlying product model of the supplier product

If an ineligible supplier product is selected based on existing shopping controls and the 
“supplier delivers to” criteria, an error is displayed to the shopper when trying to save the 
purchase line.

A purchase line can also be created from the intake process. It captures the employee request 
details for the item that needs to be sourced or purchased.

If sourcing is required for the selected supplier product, a sourcing request is created on saving 
the purchase line. Updating the status of the sourcing request to Closed Canceled or Closed 
No Decision corresponds to an update in the status of the associated purchase lines. Credit 
purchases aren’t enabled in this scenario. The grouping logic determines if the line can be 
automatically merged with an existing purchase requisition.

The key fields of a purchase line are as follows:

Purchase line fields

Field Description

Number System-generated unique identifier of the 
purchase line.

Supplier Supplier for which the shopper places the 
order.

For a non-catalog intake, if the shopper 
provides a supplier name for which a supplier 
record doesn’t exist, a new supplier record is 
manually created with some of these details:

• Legal name, according to the name provided 
by the shopper.

• Onboarding status of the supplier. An 
onboarding playbook is triggered for new 
suppliers as part of Supplier Lifecycle 
Operations, to guide the registration 
process for the new supplier contact.

• Relationship status of the supplier

• Preferred status of the supplier

The contact details provided by the shopper 
for the supplier is also displayed as a record 
in the Vendor Contacts  related list. This 
record is created with the help of the vendor 
contact creation API from Supplier Lifecycle 
Operations. For more information, see Create 
New Supplier Case form.

Product category Product category that is sourced through this 
purchase line.

Supplier product Supplier product for which the purchase line is 
created.
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Purchase line fields  (continued)

Field Description

This field isn’t displayed if the product type is 
handling fees.

Product name Name of the supplier product.

For a non-catalog purchase, the information 
is taken from the Describe the product  or 
Describe the service  fields.

This field isn’t displayed if the product type is 
handling fees.

Product example Reference URL that the shopper provides.

For a non-catalog purchase, this information 
is obtained from the Do you have an 
example of what you're looking for?  field on 
ShoppingHub.

This field isn’t displayed if the product type is 
handling fees.

Supplier contacted? Indicates if the shopper has already contacted 
the supplier.

For a non-catalog purchase, this field is set 
to true if the shopper selects I've contacted 
them already.

This field isn’t displayed if the product type is 
handling fees.

Supplier contact Name of the supplier contact for this supplier.

Supplier contact email Registered email ID for this supplier contact.

Non-catalog purchase? Indicates if a non-catalog intake workflow is 
initiated.

The value is true when a shopper uses 
the Don't see what you need?  option on 
ShoppingHub.

This field isn’t displayed if the product type is 
handling fees.

State Current status of the purchase line.

Note:  This is a read-only field.

Purchase Parent purchase associated with this 
purchase line.
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Purchase line fields  (continued)

Field Description

Sourcing request Sourcing request associated with this 
purchase line.

Sourcing event Sourcing event associated with this purchase 
line.

Negotiation Negotiation associated with this purchase line.

Purchase requisition Purchase requisition associated with this 
purchase line.

Short description Brief description that is visible to the shopper 
on ShoppingHub.

This field isn’t displayed if the product type is 
handling fees.

Purchase reason Reason for the purchase that the shopper 
provides before checkout.

For a non-catalog purchase, this information is 
obtained from the Why do you need this?  field 
on ShoppingHub.

This field isn’t displayed if the product type is 
handling fees.

Handling fee Charges added for a specific supplier when 
a rule is triggered as a result of certain 
configurable conditions for a purchase 
requisition being met. For more information on 
handling fees, see Handling fees.

This field is displayed only if the product type 
is handling fees.

Specific requirements Requirements that the shopper specifies.

For a non-catalog purchase, this information is 
given in the Any specific requirements  field 
on ShoppingHub.

Purchasing Details

Spend categorization Indicates whether negotiation with the 
supplier is addressable or not.

Negotiated by Indicates who is responsible for negotiation.

Product type Indicates whether the ordered product type is 
a good, service, or handling fee.

Goods receipt required Indicates if a receipt is required in addition to 
the invoice.

This field is visible only if the product type is 
Good.
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Purchase line fields  (continued)

Field Description

One-time pricing Indicates if the pricing created for a service 
can be reusable in subsequent purchase 
requests. When created in the context of a 
sourcing request or negotiation for a service, 
the default value is Yes.

This field is visible only if the product type is 
Service.

Expected delivery date Expected date for the delivery that the 
shopper requests.

Note:  This date can be in the past, 
present, or future. For the date to be in 
the past, the After the fact  field in the 
associated purchase requisition table 
must be set to Yes.

Acknowledgment type Indicates if receipt of confirmation is 
necessary and the type of receipt. The 
available options are Milestones, Service 
Acknowledgment, and Two Way Match.

This field is displayed as Invoice  if the product 
type is handling fees.

Note:  If you’re an existing customer 
continuing with the Source-to-Pay 
Common Architecture  (sn_shop) 
plugin, and skipping the Shopping 
Hub (sn_spend_uib) plugin, service 
acknowledgment is replaced with invoice 
acknowledgment for you.

Milestone payout type Indicates the type of milestone payout. 
The options available are Amount  and 
Percentage.

This field is visible only if the acknowledgment 
type is set to Milestones.

Start date Expected start date of the service that the 
shopper provides.

Note:  This date can be in the past, 
present, or future. For the date to be in 
the past, the After the fact  field in the 
associated purchase requisition table 
must be set to Yes.

End date Expected date to end providing the service to 
the shopper.
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Purchase line fields  (continued)

Field Description

End date  is calculated as: Start date+[Term 
length*Term value].

Note:  This date can be in the past, 
present, or future. For the date to be in 
the past, the After the fact  field in the 
associated purchase requisition table 
must be set to Yes.

Term length Duration of the term.

When the shopper selects a time frame, the 
order is considered a blanket type order.

Term value Type of the term. The options are Days, 
Weeks, Months, and Years.

Maximum budget Maximum budget that the shopper provides 
for this purchase.

Purchased quantity Quantity of the product that the shopper 
wants to purchase.

Estimated tax Tax estimate for the product based on the 
price and delivery location.

Estimated shipping Shipping cost estimate for the product based 
on the delivery location.

Total line amount Total price of the purchased goods and 
services, including estimated tax and 
shipping.

Net amount Amount included as a cost allocation on the 
purchase order. This doesn’t include any 
estimates.

Total individual units Number of fixed assets that are created 
depends on this value.

Individual unit cost Cost of the individual unit.

Supplier Bid Details

Supplier's lead time (days) Number of days that the supplier takes to 
deliver the goods or provide the service. 
Based on this, the delivery date for goods and 
the start and end dates for services vary.

Unit Unit in which the product is provided by the 
supplier.

Supplier's quantity Quantity that the supplier can provide.

Starting unit cost Cost per unit of the product prior to 
negotiation.

Negotiated unit cost Cost per unit of the product after negotiation.
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Purchase line fields  (continued)

Field Description

Total bid amount Supplier's quantity multiplied by negotiated 
unit cost. It reflects the total bid amount from 
that particular supplier for that purchase line.

Negotiated savings Total savings through negotiation. This is 
calculated as: (Starting unit cost - Negotiated 
unit cost) x Supplier's quantity

Supplier notes Additional notes about the supplier, if any.

Delivery Details

Fields in the Delivery Details section map to the information from delivery location details that 
the shopper provides. Shipping method is displayed as a read-only field here. However, this 
section isn’t displayed if the product type is handling fees.

Accounting Details

Product category Category to which the supplier product 
belongs.

Capex account Ledger account to post the capital expenses 
of this product after the purchase completion.

Expense account Ledger account to post the operational 
expenses of this product after the purchase 
completion.

Payment schedule Indicates the schedule of payments to the 
supplier.

Pre-payments required Indicates if pre-payments can be credited to 
the supplier against this purchase.

Legal entity Internal legal entity that incurs the cost of this 
purchase.

Cost center Cost center that incurs the cost of this 
transaction.

The capex account, expense account, and pre-payment details are populated from ledger 
assignment rules.

The following are the related lists of a purchase line:

Purchase line related lists

Related list Description

Cases Displays all the cases associated with this 
purchase line.

Purchasing Tasks Provides information of tasks such as 
obtaining more information from the requester, 
or awarding a supplier after quotes are 
received.
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Purchase line related lists  (continued)

Related list Description

For details, see Purchasing tasks and 
procurement cases.

Purchasing SLAs Provides SLA information for tasks and 
approvals. The underlying SLA definitions are 
defined through purchasing SLA definitions, 
which is an administration module.

Pricing Stores the relationship between supplier 
product, contracts, and price of a product.

For more details, see Pricing.

Milestones Provides information of all the milestones for 
this purchase.

This related list is visible only if the 
acknowledgment type is set to Milestones.

For details, see Milestones.

Cost Allocations Provides the information on cost allocation 
type and the cost center for this purchase line.

For details, see Cost allocations.

Pre-payments Provides information of the pre-payment 
details such as the amount and the payment 
date for this purchase.

This related list is visible only if the Pre-
payments required  field is checked.

For details, see Pre-payments.

Contract Requests Displays all the associated contract requests 
against this purchase line.

Note:  This field is displayed only if 
you have the Source-to-Pay Operations 
with Contract Management Pro  plugin 
(com.snc.sn_spend_clm) installed.

Related topics

Purchase revision flows

Milestones

Milestones represent an acknowledgment that a certain deliverable is achieved for a service. You 
can create a milestone against the purchase line and purchase order line for a service product 
type, when the acknowledgment type is set to Milestones.

The key fields of a milestone are:
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Milestone fields

Field Description

Deliverable Name Name of the milestone

Number System-generated unique identifier of the 
milestone.

Assigned to User primarily responsible for confirming the 
completion of this milestone.

Primary contact Person within the procurement team who can 
be contacted with questions about receipts, 
milestones, invoices, or other activities related 
to acknowledgment. This field is populated or 
updated with the same user in the Assigned to 
field of the parent task record, as follows: For 
a milestone or acknowledgment task, from the 
referenced purchase order.

Purchase line Purchase line associated with the milestone.

Purchase order line Purchase order line associated with the 
milestone.

State Status of the milestone.

Due date Expected completion date from the user this 
milestone is assigned to.

Summary Details

Completion date Scheduled completion date for the milestone.

Payout type The type of the payout associated with this 
milestone. For example, Percentage  or 
Amount.

Payout amount Amount associated with this milestone.

This field is displayed if the payout type is set 
to Amount.

Sum of the amount across all milestones can’t 
exceed the total amount on the purchase 
requisition.

Payout percentage Percentage of the payout amount associated 
with this milestone.

This field is displayed if the payout type is set 
to Percentage.

Sum of the percentages across all milestones 
can’t exceed 100%.

Cancellation reason Reason for the cancellation of the milestone.

This field is required when the recipient 
cancels the milestone.
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Milestone fields  (continued)

Field Description

Deferral reason Reason for the deferral of the delivery date of 
the milestone.

Milestones are assigned to the recipient of the purchase line. A recipient can either confirm, 
cancel, or defer milestones using Confirm completion, Cancel, or Defer Completion  options.

• Confirming a milestone updates the state to Closed Complete.

• Canceling a milestone requires a cancellation reason.

• Deferring the completion of a milestone requires a completion date and the state is updated to 
Pending Completion Date.

When the status of a milestone task is Closed Complete, a receipt is created and the Amount 
received  or Percentage received  fields are populated accordingly on the receipt. The receipt 
triggers the update of the states on the purchase order line and purchase order similar to the 
workflow of a good receipt.

The [PSM] Monitor Milestone Tasks scheduled job monitors the completion date of each active 
milestone on a daily basis. On the specified date of completion, the job updates the state of the 
milestone from Pending Completion Date  to Confirmation Required.

The UI action to confirm or defer the milestone is displayed when the state of the milestone is 
Confirmation Required.

Cost allocations

Cost allocation defines how to allocate the payment for a particular purchase line. Costs can be 
allocated towards a cost center, employee credit, or payroll payments.

Note:  Shipping and tax costs are excluded from cost allocation calculations.

The key fields for a cost allocation are as follows:

Cost allocation fields

Field Description

Purchase line Purchase line associated with this allocation.

Allocation type Specifies how the cost is allocated. For 
example, Cost center, Employee credit, or 
Payroll.

Cost owner User who incurs the cost of this allocated 
transaction amount.

Cost center Cost center that incurs the cost of this 
allocated transaction amount.

Employee credit Reference to the employee credit to which this 
cost allocation is made.

This field is visible only if the allocation type is 
set to Employee Credit.
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Cost allocation fields  (continued)

Field Description

Terms accepted on Date and time at which the cost owner has 
accepted the terms and conditions of the 
organization to withhold the payroll.

This field is visible only if the allocation type is 
set to Payroll.

Number of payments selected Number of payments that the cost owner 
selected to pay back for a subsidized 
purchase.

This field is visible only if the allocation type is 
set to Payroll.

Allocate by Determines if the cost allocation is made by 
amount or percentage.

Allocation amount Amount of the cost allocated.

Allocation percentage Percentage of the cost allocated.

This field is visible only if the allocation type is 
set to Percentage.

If a purchase line is created:

• From the ShoppingHub catalog, the cost allocation is created from the payment method that 
the employee selects during checkout. The employee can define the cost center to allocate to, 
and can split the allocation amongst multiple cost centers, as required. Employee credits and 
paycheck payments also result in the creation of a cost allocation.

• When an employee submits an off-catalog request from the I need to submit a quote flow, 
and selects a cost center that is not their default cost center, the selected cost center gets 
populated in the Cost Allocation table associated to the purchase requisition line. The 
employee can define the cost center to allocate to, but the allocation is 100% to that cost 
center, and can't be split.

Pre-payments

A prepayment is the amount paid for services before their receipt or invoiced due date. When 
an invoice is issued for a pre-payment, it is against the pre-paid account. During the defined pre-
paid period, the amount is amortized accordingly against the capex or expense account.

The Pre-payments required  field on the purchase line indicates if pre-payments can be credited 
to the supplier against a purchase. Selecting this field also results in the display of the Pre-
payments related list on the purchase line. The pre-payment information is carried over to a 
purchase order line whenever a purchase order is created.

The following are the key fields of a prepayment:
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Pre-payment fields

Field Description

Number System-generated unique identifier of the pre-
payment.

Contract Contract to which this pre-payment is 
associated.

Purchase line The purchase line associated with this pre-
payment. This field is auto-populated when 
created from the pre-payments related list on 
purchase line.

Purchase requisition The purchase requisition associated with this 
pre-payment. This field is referenced from the 
purchase line.

Purchase order line The purchase order for which pre-payments 
are authorized up to the specified amount.

This field is auto-populated when a purchase 
order line is created from the purchase line.

Purchase order The purchase order associated with this pre-
payment. This field is referenced from the 
purchase order line.

Authorized by The user who authorizes this pre-payment. 
This field is populated based on the user who 
creates the pre-payment.

Authorized on The date on which the pre-payment is 
authorized.

Accounting Details

Amount Total purchase line amount.

Currency code Currency code of the total line amount.

Pre-pay on Date on which the specified amount is pre-
paid.

Pre-pay by The type of pre-payment. For example, 
Amount  or Percentage.

Pre-payment percentage The percentage of the total line amount for the 
pre-payment.

This field is visible only if the pre-payment 
type is set to Percentage.

Pre-payment amount The portion of the total line amount for the pre-
payment.

Pre-paid period start The start date of the pre-payment period, from 
which the pre-payments start.

Pre-paid period end The end date of the pre-payment period, after 
which no pre-payments are made.
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Multiple pre-payments related to one line can be made. For example, you can pre-pay 50% of the 
total line amount on X date and another 50% on Y date. The total of the pre-payment amounts 
must not exceed the line amount.

Purchase requisition merging

Purchase requisitions can be merged if certain criteria are met. This avoids multiple purchase 
orders from being created unnecessarily and also helps enforce approval rule limits.

Consider these various scenarios for purchase requisition grouping.

Scenarios for merging purchase requisitions

A procurement buyer can group new products by the same supplier into an existing requisition 
so that multiple orders are not sent to the supplier. Consider the following scenarios:

Scenario 1: A Purchase Requisition (PR1) for Supplier A exists, in state Pending Approval. 
Purchase Order (PO) has not been created.

• Sourcing not required:

If the shopper adds a supplier product from the same Supplier A in ShoppingHub, and it has 
the same submitted by, supplier, cost center, and business owner as PR1, then the lines are 
automatically grouped with PR1 with the state Pending Approval. PR1 remains in Pending 
Approval state. Approvals are re-assessed similar to revisions. If the line was created more 
than 24 hours after PR1, it is not grouped automatically and is created under a new purchase 
requisition.

• Sourcing required:

If the shopper adds a supplier product from the same Supplier A in ShoppingHub that does 
not have an active contractual price, a sourcing request is created. In the sourcing request, 
assuming that the line was awarded to the same Supplier A, and there is an existing purchase 
requisition with the same submitted by, supplier, cost center, and business owner, and the 
newly sourced line was created not more than 24 hours after PR1, the purchase line references 
PR1 when the supplier is awarded, and a purchase requisition is created. The line is added into 
PR1 with the state Pending Approval. PR1 remains in Pending Approval state. Approvals are re-
assessed similar to revisions.

Scenario 2: PR1 for Supplier A exists, in state Awaiting Task Completion. PO does not exist yet.

• A procurement specialist has to manually merge the purchase requisitions.

• Sourcing not required:

◦ An annotation is displayed on the header of PR2 indicating that this purchase requisition 
can be merged with another existing requisition <purchase requisition number>, where 
<purchase requisition number> is a link to PR1 that has the same submitted by, supplier, 
cost center, and business owner as PR2. This annotation is cleared once an order is created 
against PR1.

◦ The user can select Merge  on the PR2 header to move the lines from PR2 to PR1. If there 
are no other requisitions or sourcing requests belonging to the purchase request that PR2 
belongs to, then the purchase request and PR2 are deleted. The merged lines are in the 
state Pending Approval, and the purchase requisition is also reverted to Pending Approval. 
However, the original lines remain in their original state. Approvals are re-assessed similar to 
revisions.
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◦ If there were other requisitions or sourcing requests under purchase request 2, then the 
purchase request is not deleted. Only purchase requisition 2 is deleted.

◦ The Merge  UI action is only available if PR2 and the corresponding lines were created not 
more than 24 hours after PR1.

• Sourcing required: Upon awarding the sourcing request, a similar annotation is displayed 
on the header of the sourcing request indicating that this line can be merged with another 
existing requisition <Purchase requisition number>. The user can select Merge with Existing 
Requisition  or Create Requisition. If merged, PR1's state reverts to Pending Approval.

Scenario 3: PR1 for Supplier A exists, in state Final Review. PO does not exist yet. Same as 
Scenario 2.

Scenario 4: PR1 in state Awaiting Task Completion, PR2 not merged with PR1 and in state Pending 
Approval. Another purchase is created. If the procurement specialist decides not to merge PR2 
with PR1, and PR2’s state is still Pending Approval, then the new purchase lines automatically 
merge with PR2 according to the criteria in Scenario 1.

Scenario 5: Multiple PRs in state Awaiting Task Completion or Final Review. New PR created 
within 24 hours with the same requested by, supplier, cost center, and business owner.

• When the user selects Merge  on the new purchase requisition, display a list of all the 
purchase requisitions in the state Awaiting Task Completion or Final Review, and allow the user 
to select which one to merge with.

• In this scenario, an annotation is displayed on the most recent purchase requisition indicating 
that this purchase requisition can be merged with several other requisitions.

Scenario 6: Revisions

• Purchase requisitions of type Revision, created as a result of PO revision, are not eligible for 
merging.

• Purchase requisition revisions, where no PO is created, can be considered for merging using 
similar criteria documented in the previous scenarios.

Note:  For all merge scenarios, Merge  is only displayed on the UI on the most recently 
created purchase requisition.

Scenario 7: PR1 for Supplier A exists, in state Closed Canceled, Closed Rejected, or Closed 
Complete. A line is not grouped into a PR that has the state Closed Canceled, Closed Rejected, 
or Closed Complete. Instead, a new PR is created.

Scenario 8: PO already created, and supplier product(s) from the same supplier is added. Create 
a new purchase request and purchase requisition (PR2).

Purchase line merge

Purchase lines within a purchase requisition can also be merged under the following conditions:

• If the supplier product, business owner, cost center, submitted by, delivery date or start date/
end date, delivery location, payment method, and purchase reason are identical, except the 
quantity, the purchase lines can be grouped into a single line instead of separate lines.

• If the delivery date, start date/end date, or delivery location is different, a new line must be 
created.

• If only the payment method is different, the cost allocation entries should be updated 
accordingly, based on the combined ratio.

• If only the purchase reason is different, append the purchasing reasons as follows:
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◦ Purchasing reason 1 - qty 1 (example: New hire orientation - qty 10)

◦ Purchasing reason 2 - qty 2 (example: IT hardware refresh - qty 2)

Note:  Purchase requisition merging and purchase line merging are not applicable for 
bundled products.

Purchasing tasks and procurement cases

All automated purchasing tasks and procurement cases are created using flow designer from the 
Service Delivery Common (SDC) application. Flow designer uses the underlying task and case 
generation decision tables, and purchasing tasks and procurement cases are created based on 
the conditions defined in the decision tables.

Conditions and triggers for task and case creation

While the Sourcing decision dependent on case  and Order dependent on case  fields in the 
Finance Case table determine the need for a procurement case  to be created, the Sourcing 
decision dependent on task  and Order dependent on task  fields in the Finance Task table 
determine the need for a procurement task  to be created.

Tasks and cases are generated when the following rules are triggered, with the decision tables 
supporting this generation via decision inputs.

• Purchase Requisition Task and Case Generation Rule

• Sourcing Request Task and Case Generation Rule

• Negotiation Task and Case Generation Rule

• Negotiation Event Task and Case Generation Rule

Procurement case types

Here’s a list of the types and subtypes of procurement cases:

• Edit a purchase

• Edit a receipt

• GL Coding Review

• Budget Review

• Contract Review

• Send NDA for Signature

• Return a purchase

• Replace a purchase

• Request a Corporate Card

• Inquiry

• Delivery Address Review

• Request a copy of contract

• Due Diligence

For procurement cases, you can also create child cases or associate child cases to parent cases. 
However, remember that you must close all child cases and associated child cases before you 
can close any parent case. Similarly, you can reopen a child case or associated child case only 
when the parent case is still open.
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Procurement case states

The states that are available for a procurement case are listed.

• Draft

• Processing Case

• In Review

• On Hold

• Work in Progress

• Closed Canceled

• Closed Rejected

• Closed Completed

Purchasing task types

A list of the types and subtypes of purchasing tasks are listed.

• Purchasing task

◦ Select a Supplier: Ask the shopper to compare pricing from multiple suppliers and select a 
supplier.

◦ Sourcing task

◦ Ask a question: Ask the shopper for more information about the purchase.

• Procurement/Supplier task: Create a procurement task for a supplier.

You can also create child tasks or associate child tasks to parent tasks. However, remember that 
you must close all child tasks and associated child tasks before you can close any parent task. 
Similarly, you can reopen a child task or associated child task only when the parent task is still 
open.

The following are the key fields of a purchasing task:

Purchasing task fields

Field Description

Number System-generated unique identifier of the 
purchasing task.

Assignment group Group to which this purchasing task belongs.

Assigned to User to which this purchasing task is assigned.

Primary contact Person within the procurement team working 
on the purchase who can be contacted with 
questions. This field is populated or updated 
with the same user in the Assigned to  field of 
the parent task record, as follows:

• For a sourcing task, from the referenced 
sourcing request

• For a purchasing task, from the purchasing 
task itself

• For a contract task, from the contract task 
itself
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Purchasing task fields  (continued)

Field Description

• For a supplier task, from the supplier task 
itself

• For a finance task, from the finance task 
itself

State Status of the purchasing task.

Substate Progress of obtaining the shopper’s 
responses to the procurement specialist’s 
questions.

Due date Expected date of completing the task.

Short description Short description of the task.

Description Detailed description of the task.

Detailed description Detailed description of the Custom Task for 
Employee task subtype. You can enter your 
instructions in html or rich text format, and 
even add hyperlinks or images as required.

Summary Details

Supplier Supplier reference for this task.

Sourcing request Sourcing request associated with this task.

Purchase requisition Purchase requisition associated with this task.

Purchase order Purchase order for which the revision request 
task is raised.

Sourcing decision dependent on task Specifies whether this task must be completed 
before a sourcing request can be created.

Note:  This field is displayed only if a 
related sourcing request is entered.​

Qualification dependent on task Specifies whether this task must be completed 
before a qualification request can be created.

Note:  This field is displayed only if a 
related sourcing request is entered.​

Order dependent on task Determines if completion of this task is 
required prior to a purchase order being 
created.

Note:  This field is displayed only if a 
related purchase requisition is entered.​

Expected start Expected date of starting work on the task.

Actual start Actual date of starting work on the task.
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Purchasing task fields  (continued)

Field Description

Actual end Actual date of completing the task.

Duration Actual time taken to complete the task.

Question & Answer

This section contains the information of the questions posed to the shopper and the 
responses that the shopper provides.

Purchasing task and procurement case creation

Create purchasing tasks and procurement cases in sourcing requests and purchase requisitions.

Sourcing request

If a negotiation does not exist, the supplier risk assessment and send NDA for signature cases 
are triggered when the state of the sourcing request is Awaiting Supplier Response. The 
procurement cases are created on the cases related list of the sourcing request.

• Conduct a supplier risk assessment: If risk assessment on the referenced supplier record is 
not valid, create a supplier risk assessment case for each supplier on the sourcing request.

• Send NDA for signature: If the NDA on the referenced supplier record is not valid, create an 
NDA case for each supplier on the sourcing request. This requires adding a supplier reference 
field on the case template.

• If the user skips updating the state of the sourcing request to Awaiting Supplier Response, 
these cases are created when the state of the sourcing request is Requires Decision.

• If the user decides to manually create contracts against the sourcing request, trigger the 
contract review case once a contract is created.

If a new supplier is added to the sourcing request, the risk assessment and send NDA for 
signature cases for that supplier are triggered when the state of the sourcing request is Awaiting 
Supplier Response or Requires Decision (if the user skipped the Awaiting Supplier Response 
state).

Purchasing tasks and procurement cases for the awarded supplier that are created on a sourcing 
request are also shown on the purchase requisition.

For information on how a supplier tiering assessment case influences sourcing request states, 
see Sourcing and Procurement Operations integration with Third-party Risk Management.

Purchase requisition

The following procurement cases and purchasing tasks are created in flow designer when 
the state of the purchase requisition is Pending Review or Pending Approval (if approvals are 
triggered):

• Cases:

◦ GL coding review

◦ Budget review

◦ Conduct a supplier risk assessment

◦ Onboard a supplier

◦ Send NDA for signature
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◦ Delivery address verification (not applicable for blanket order type scenario)

◦ Delivery address approval (not applicable for blanket order type scenario)

• Tasks: Follow up required: Approval duration breached

The integration error purchasing task is created in flow designer when integration with ERP fails 
and the state of the purchase requisition is updated to Awaiting Task Completion.

If a purchase requisition is created directly without a sourcing request, all purchasing tasks 
and procurement cases are created in flow designer when the state of the purchase requisition 
is Pending Review or Pending Approval (if approvals are triggered), with the exception of 
contract review case and integration error task. These are created when the state is Awaiting 
Task Completion. If the tasks and cases triggered during the Pending Review or Pending 
Approval state are still open after approvals are complete, the state of the purchase requisition 
is in Awaiting Task Completion. Only when all the Order dependent on task  tasks and Order 
dependent on case  cases are closed, the state of the purchase requisition is updated to Final 
Review or PO Created, based on the purchasing property.

Purchase order

A purchase order is a binding contract between a buyer and a supplier that authorizes a 
purchasing transaction. It contains the descriptions, quantities, prices, applicable discounts, 
payment terms, delivery dates, and other associated terms and conditions with the supplier.

In a purchase order, the key fields are the following:

Purchase order fields

Field Description

Display name Name of the purchase order for a supplier 
product.

Number System-generated unique identifier of the 
purchase order.

ERP number The purchase order number that is synced 
from ERP systems.

Version The version of the purchase order. A revised 
purchase order has a higher version number.

Business owner The user who placed the order.

Status Status of the purchase order.

Purchase requisition The purchase requisition associated with this 
order.

Primary contact Person within the procurement team who 
can be contacted with questions about the 
order. This field is populated or updated with 
the same user in the Assigned to  field on the 
purchase requisition.

Summary Details

Supplier Supplier who provides the product of this 
order.

Order type Indicates if the purchase order is of the type 
Standard  or Blanket.
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Purchase order fields  (continued)

Field Description

Minimum spend Minimum amount that must be spent to avail a 
discount.

This field isn’t displayed for a blanket order 
type.

Discount percentage Discount provided if the minimum spend 
requirement is met.

This field isn’t displayed for a blanket order 
type.

Total amount The total cost of purchase requisition 
calculated as the sum from all related 
purchase lines.

Released amount The budget that is consumed so far.

This field is visible for blanket order type.

Shipping method Details of the carrier, the applicable suppliers, 
and the valid delivery location countries for 
those suppliers.

For more information on shipping methods 
and handling fees, see Handling fees.

Accounting Details

Cost center The cost center incurring the expense of this 
order.

This field is carried over from the related 
purchase requisition.

Legal entity Internal legal entity making this purchase.

This field is carried over from the related 
purchase requisition.

Purchasing entity The organizational entity associated with the 
business owner making this purchase.

This field is carried over from the related 
purchase requisition.

Payment term The agreed time and conditions of payment to 
the supplier.

Received amount Indicates if the order is partially or fully 
delivered. This value is the sum of the receipt 
values in the child purchase order lines.

This field is visible for standard order type.
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Purchase order fields  (continued)

Field Description

Received percent Indicates if the order is partially or fully 
delivered. This value is the sum of the receipt 
values in the child purchase order lines.

This field is visible for standard order type.

Invoiced amount Amount invoiced for the product ordered. 
While other charges are added to the amount 
invoiced, discount amount is subtracted from 
it.

This field is visible for standard order type.

Amount paid Amount paid for the product ordered.

This field is visible for standard order type.

Remaining balance Amount due to the supplier for the order.

This field is visible for standard order type.

During purchase order integration, any attachments with valid sys-ids are copied from the 
Inbound Purchase Order staging table record to this Purchase Order primary table record. This 
is done through a transform script, which is part of the Order stage transform map, triggered 
onAfter. Go to the purchase order record on the Purchase Order table based on the ERP number 
and purchase order number, and verify that your attachments are present on the target record. 
You can delete or rename attachments as needed, without creating duplicates.

The receipt fields (Received amount  and Received percent) on the Accounting Details section 
of a purchase order are summations of the receipt fields on the child purchase order lines, which 
are populated based on the following conditions:

• For purchase order line of goods:

◦ When goods have been received: The received quantity is populated when a receipt is 
created. The received amount and received percent are calculated based on the received 
quantity.

◦ When goods haven’t been received: The received amount is populated with the line amount 
invoiced (editable field) when the status of the invoice line associated with the purchase 
order line is Invoice Confirmed. The received quantity and received percent are calculated 
based on the received amount.

• For purchase order line of services:

Note:  Business rules pertaining to handling state changes, handling tax and charges, 
default invoice fields, populating invoice line amounts, handling line total changes, and 
populating supplier products are available only if you haven't installed the Shopping Hub 
plugin and are still using the Source-to-Pay Common Architecture  plugin.​
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◦ When the acknowledgment type is milestones:

▪ If the milestone payout is amount, the received amount is populated accordingly. The 
received quantity and received percent are calculated based on the received amount.

▪ If the milestone payout is a percentage, the received percent is populated accordingly. 
The received quantity and received amount are calculated based on the received percent.

◦ When the acknowledgment type is service acknowledgment: The received amount is 
populated based on the approved invoice line amount. The received quantity and received 
percent are calculated based on the received amount.

◦ When the acknowledgment type is a two-way match: The received amount is populated with 
the line amount invoiced (editable field) when the status of the invoice line associated with 
the purchase order line is Invoice Confirmed. The received quantity and received percent 
are calculated based on the received amount.

For more information on purchase order lines, see Purchase order lines.

The following are the key related lists of a purchase order record:

Purchase order related lists

Related list Description

Purchase Order Lines Lists the standard purchase order releases for 
a blanket purchase order.​

Approval Plans Displays all the approval plans created against 
this purchase order.

Receipts Provides details of the receipts created for this 
purchase order. For details, see Receipts.

This related list is visible for standard order 
type.

Milestones Provides details of the milestones for this 
purchase order. For details, see Milestones.

This related list is visible for standard order 
type.

Invoices Provides details of the invoices generated for 
this purchase order. For details, see Invoices.

This related list is visible for standard order 
type.

Related Contracts Provides details of related contracts 
associated for this purchase order. For details, 
see Contracts.

This related list is visible for standard order 
type.

Purchasing Permission Carried over from the related purchase 
requisition.
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Purchase order related lists  (continued)

Related list Description

This related list is visible for blanket order 
type.

Purchase Order Releases
This related list is visible for blanket order 
type.

Purchasing Tasks Provides information of tasks for this purchase 
order.

Purchase Order History List of purchase orders before the current 
revision. This related list is visible if the 
purchase order has revisions.

Blanket purchase order workflow

During checkout, when a shopper selects I am not sure  in the delivery date option, it creates 
a purchase requisition with a blanket order type, which results in the creation of a blanket 
purchase order.

Purchasing permissions define the list of users, groups, cost centers, or departments that are 
allowed to purchase against the blanket purchase order without requiring any approvals. As 
receipts and invoices are not applicable for blanket purchase orders, these related lists are not 
displayed on the purchase order form view.

For details on the various fields and related lists that are populated for a blanket purchase order, 
see Purchase order.

Standard purchases against a blanket purchase order

A standard purchase order release is created when the following conditions are satisfied:

• User who requested the purchase is defined under the associated purchasing permission of 
the blanket purchase order.

The business owner who requested the original blanket purchase order can always release 
against the blanket purchase order even if they are not explicitly defined under the purchasing 
permission.

• Creation date of the standard purchase line falls within the range of the blanket line’s start and 
end date.

• Supplier product purchased is defined as a supplier product on the blanket purchase order.

• Funds must be available on the blanket purchase order. The value of the Released amount 
field on the blanket purchase order must be less than the value in the Total amount  field.

The standard purchase order release has a reference to the blanket purchase order and will be 
displayed under the Purchase Order Releases related list on the blanket purchase order.

On the blanket purchase order, the sum of the total amount of all released purchase orders is 
updated in the Released amount  field of the Summary Details section. When the value of the 
Released amount  field matches with the value of the Total amount  field, the status of the blanket 
purchase order changes to Closed Complete.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

442



If a purchase order release amount results in the blanket purchase order amount being 
exceeded, an approval is triggered for the delta amount to the business owner of the applicable 
standard purchase order release.

For example, if a blanket purchase order exists with an associated purchasing agreement 
contract with validity from January 1, 2019 to December 31, 2019. The amount limit on the blanket 
purchase order is $1000, and the current released amount is $800. The next standard purchase 
order release against the blanket is for $500. So, an approval for the delta of $300 is required.

To check if a request should be considered as a release against an existing blanket purchase 
order:

• For goods, check the creation date of the purchase request against the start and end date of 
the corresponding line on the blanket purchase order.

• For services, check the start and end date of the request against the start and end date of the 
corresponding line on the blanket purchase order.

Purchase revisions

Revisions for the quantity of the product, budget, or delivery location can be made to orders 
placed from ShoppingHub.

The shopper can revise an order from ShoppingHub or the procurement specialist can submit 
revision from the Sourcing and Purchasing Automation  module.

When a shopper updates the Pricing  reference field on the purchase requisition line, a revision 
is triggered for both standard and blanket purchase requests.

• For standard purchase requests, the quantity is left as-is. The total line amount is updated, 
which in turn updates the total amount of the purchase request and triggers reassessment of 
approvals, if applicable. Budget, even if populated, is not considered as a revision attribute.

• For blanket purchase requests, the quantity is left as-is. The total line amount is updated, 
which in turn updates the total amount of the purchase request and triggers reassessment of 
approvals, if applicable. In this scenario, the revision line captures the change in the pricing 
reference as well as the budget.

When a purchase order is created, the pricing reference on the purchase requisition line cannot 
be revised.

Revisions with no purchase order

If no purchase order is created, and state of the purchase requisition is not Closed Rejected, 
Closed Complete, or Closed Canceled, you can manually revise the purchase requisition. In 
this case, neither a revision request nor a new purchase requisition is created. You can view the 
updates in the Revision Lines related list of the purchase requisition line.

The addition of a new purchase requisition or purchase order line is restricted to the same 
supplier and business owner for a revision process.

Purchase order revisions

• Shopper-initiated purchase order revision:

◦ When the status of a purchase order is not Closed Complete  or Closed Canceled, a 
shopper can revise the lines from ShoppingHub. A revision request is created and assigned 
to the procurement specialist, and the state is updated to Closed Complete. A procurement 
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specialist does not have to confirm the revision request prior to creation of the revised 
purchase requisition.

◦ A new purchase requisition of type Revision  is created and the revision request is attached 
to the revised purchase requisition.

• Procurement specialist-initiated purchase order revision:

◦ To initiate a revision of the purchase order, select Revise  in the Sourcing and Purchasing 
Automation  module.

◦ On confirmation of the revision, a new purchase requisition of type Revision  is created and 
the revision request is attached to the revised purchase requisition.

• Shopper-initiated blanket purchase order revision:

◦ When the status of a blanket purchase order is not Closed Released, a shopper can initiate 
a revision from ShoppingHub. Only the quantity and budget can be revised on a blanket 
purchase order.

◦ When a budget revision is made, the quantity and total line amount of the corresponding 
blanket line is calculated to the nearest value using the negotiated unit cost of the supplier 
product. Revisions cannot be below the current released amount against the blanket 
purchase order. Revising either quantity or budget results in the other being back-calculated 
accordingly.

◦ On confirmation of the revision, a new purchase requisition of type Revision  is created and 
the revision request is attached to the revised purchase requisition.

For both the shopper-initiated and procurement specialist-initiated purchase order and blanket 
purchase order revisions, the status of the purchase requisition is updated to Pending Revision 
and delegation of authority is reassessed.

The state of the purchase order and the purchase order lines that were revised are updated to 
Pending Revision. The state of the purchase order lines which are not revised does not change.

When the state of the purchase requisition is Final Review  and the purchase requisition is of the 
type Revision, you can select Update Purchase Order  to update the existing purchase order and 
purchase order lines with the revised information.

State of the purchase requisition is then updated to Closed Complete.

Note: 

Revision requests must be in a closed state for a purchase order to be created. For more 
information on purchase orders, see Purchase order.

Revisions are not allowed in ShoppingHub for lines that have been fully received. Revisions 
can only be triggered for an amount that exceeds the received amount.

Impact of rejecting an increase in funds revision

If a purchase requisition or purchase order is revised, and the re-approval is rejected, the 
behavior is as follows:

• If a purchase order doesn't exist, the purchase requisition is reverted to the pre-revision state 
and value, for both single and multiple lines.

• If a purchase order exists, and the good or service has either been partially delivered or not 
delivered at all:
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◦ For a single line, the original purchase order remains as-is. The purchase order reverts to 
its state prior to revision. The resulting purchase requisition of type Revision will be in the 
Closed Rejected state, with no option to update the purchase order.

◦ For multiple lines, if every line within the revision purchase requisition is rejected, the impact 
is the same as above.

◦ For multiple lines, if some of the lines within the revision purchase requisition are rejected, 
only those rejected lines revert to their state prior to revision, upon updating the purchase 
order.

Purchase revision impact on cost allocations and milestones

Cost allocation behavior

• Cost allocations from the original purchase requisition are updated in the revised 
purchase requisition.

• If an increase or decrease in funds happens, a new cost allocation is created 
for the primary cost center (cost center of the business owner on the purchase 
requisition) on the revised purchase requisition.

This amount reflects either as an increase (positive amount) or decrease 
(negative amount) in funds.

• Once the purchase order is updated, the revised purchase order contains 
separate entries for the primary cost center, that is, the one from the original 
purchase requisition and another as a result of the revision, along with any 
additional user-defined allocations from the original purchase requisition.

• Cost allocations cannot be updated after the creation of a purchase order.

For more details on cost allocations, see Cost allocations.

Milestone behavior

• Milestone details are copied from the original purchase requisition to the revised 
purchase requisition.

• User can create any additional milestones, as needed, on completion of the 
revision.

• Once the purchase order is updated, the original milestone on the purchase order 
is updated to the Closed Canceled  state, as a copy is already created during the 
revision process.

For more details on milestones, see Milestones.

Related topics

Purchase revision flows

Contracts

A contract defines the terms and conditions along with pricing agreed for a product with the 
supplier. An active contractual price determines if the pricing of a product or service is displayed 
on ShoppingHub.

Use the purchasing view to view contract details in the Sourcing and Purchasing Automation 
module. You can also create a new contract with the contract_manager role.
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In addition to purchase requisitions, systematic creation of a contract occurs during a sourcing 
request or negotiation. This is configured accordingly in flow designer. The various scenarios for 
pre-purchase contract creation are:

• Negotiation exists, created manually: Trigger contract creation, including NDA if required, 
against the negotiation when the state of the negotiation is Planned.

• Negotiation exists, created systematically through third-party sourcing integration: Trigger 
contract creation, including NDA if required, against the negotiation when the state of the 
negotiation is Negotiation in Progress.

• Negotiation does not exist: Trigger NDA contract creation, if required, against the sourcing 
request when the state of the sourcing request is Awaiting Supplier Response. A procurement 
specialist or contract team can manually create other contracts against the sourcing request 
before creating a purchase requisition. If contracts are not manually created against the 
sourcing request, they are systematically created against the awarded purchase requisition 
after approvals are complete.

• New supplier created from manual sourcing or third-party sourcing integration: For third-party 
sourcing integration, trigger contract creation when a new purchase line is created for a new 
supplier. For manual sourcing, contract creation follows the manual negotiation creation or 
negotiation does not exist scenarios.

When a supplier is awarded, contracts that were created for the other suppliers are canceled, 
except NDAs. Contract metadata population remain as is.

In a contract, the following are the key fields:

Contract form

Field Description

Contract model Type of the contract.

Supplier Supplier that is billed for this contract.

Contract number Unique identifier for the contract that the 
vendor assigns.

Name Short description of the contract.

Parent contract Parent contract or agreement, if any.

Start date Date from which this contract is effective.

End date Date on which the contract ceases to be 
effective.

State Status of the contract. For example, Draft, 
Active, Expired, or Canceled.

Substate Substate of the contract. For example, 
Awaiting Review, Under Review, Approved, 
or Rejected.

License quantity entitled Number of licenses included in the contract. 
This field is available for Maintenance and 
Software License contracts.

Contract administrator Person responsible for managing the contract 
and interacting with the vendor.

Approver User who approves or rejects the contract.
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Contract form  (continued)

Field Description

Business owner Internal user responsible for the product in the 
contract.

Agreement type License classification of the contract.

Description Detailed description of the contract.

Purchasing

Purchasing entity The purchasing entity associated with the 
contract.

Payment term The agreed to time and conditions under 
which a payment to a supplier is made.

Incoterm Determines who assumes the liability and 
when a fixed asset must be capitalized.

Financial

Invoice payment terms Terms that explain how to pay the contract. For 
example, Net Monthly Account  or Net 30.

Payment schedule Schedule that defines when to make 
payments. For example, Monthly  or Annually.

Payment amount Amount paid for this contract so far.

Applicable taxes Tax applicable for this contract. Select from 
Exempt  or Sales.

Effective tax rate Tax rate applicable to the total cost.

This field is visible only if the applicable taxes 
is selected as Sales.

Tax cost Total tax on the contract.

This field is visible only if the applicable taxes 
is selected as Sales.

Total cost Final cost of the contract after adjustments 
have been applied. If a contract has one or 
more rate cards, this field shows the combined 
value of all rate cards.

Vendor account Account of the vendor with which the contract 
is associated.

PO Number Purchase order associated with this contract.

Cost center Cost center that is financially responsible for 
the asset.

Has rate card Determines if the contract has an associated 
rate card.

Renewal

Automatically renew Indicates if the contract can be renewed at the 
end of its term.
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Contract form  (continued)

Field Description

Options Duration of the contract renewal or extension. 
For example, 1 year.

Renewal start date Date on which the contract renewal or 
extension takes effect.

Renewal end date Date on which the contract renewal or 
extension ends.

Cost adjustment type Type of cost adjustment applied to the 
contract: Fixed, Manual, or CPI  (consumer 
price index).

Cost adjustment amount Numerical increase or decrease in price of 
contract. To indicate a decrease in price, enter 
a negative number. Either a Cost adjustment 
or Cost adjustment percentage  can be 
specified, but not both.

Cost adjustment percentage Percentage increase or decrease in price 
of contract. To indicate a decrease in price, 
enter a negative percentage. Either a Cost 
adjustment  or Cost adjustment percentage 
can be specified, but not both.

Terms and conditions

Specific legal information in the contract.

The following are the related lists of a contract:

Contract related lists

Related list Description

Child Contracts Lists any child contracts that exist for this 
contract.

Expense Lines Lists all expense lines for this contract.

Assets Covered Lists all assets covered by this contract.

CIs Covered Lists all configuration items (CI) used in this 
contract.

Service Offerings Lists all service offerings from this vendor. 
Activate Service Portfolio Management to see 
this related list.

Approval History Lists all approvals for this contract.

Contract History Displays the changes to the start and end 
dates of this contract and changes to the 
terms and conditions.

Purchase Requisitions Lists all the purchase requisitions associated 
with this contract.
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Contract related lists  (continued)

Related list Description

Purchase Orders Lists all the purchase orders associated with 
this contract.

Supplier Products Covered Lists all the supplier products covered under 
this contract.

Pre-payments Provides information of the pre-payment 
details such as the amount and the payment 
date for this contract.

Contract exception rules

Contract exception rules specify conditions in which a contract record is not created even 
if there is a corresponding contract type mapped to a model category. A procurement 
administrator can configure these rules from decision tables which are in the administration 
section of the Sourcing and Purchasing Automation  module.

Pricing

Pricing stores the relationship between supplier product, contracts, and price of a product.

You can store pricing as a single price or with a price break. Supplier quotes are stored in the 
Pricing table and are used to display in Shopping Hub  to help with the decision of awarding a 
supplier.

A pricing record is created when the Negotiated unit cost  field is populated on the purchase line 
within a sourcing request.

Several scenarios are documented here for clarity.

• One-time single price, no negotiations:

◦ Sourcing request is automatically created.

◦ Procurement specialist directly enters price into the Negotiated unit cost  field on the 
purchase line.

◦ Pricing record is automatically created when the Negotiated unit cost  field is populated. 
Price value on the Pricing table is populated with the negotiated unit cost.

◦ The state changes based on the existence of a price value in the Pricing table.

• One-time single price, with negotiations:

◦ Sourcing request is automatically created.

◦ Procurement specialist creates a negotiation.

◦ Pricing record is automatically created when the negotiation is created, with no price value.

◦ Procurement specialist directly enters price into the Negotiated unit cost  field on the 
purchase line.

◦ Price value on the Pricing table is populated with the negotiated unit cost.

◦ The state changes based on the existence of a price value in the Pricing table.

◦ Systematic contract creation on negotiation remains as-is and is linked to the pricing record.

• One-time price break, no negotiations:
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◦ Similar to the one-time single price, no negotiations scenario.

◦ Procurement specialist confirms the quantity with the shopper, if not indicated by the 
shopper already, and enters the appropriate negotiated unit cost on the purchase line.

Note:  When quantity is revised on a line that has an underlying price break, the 
negotiated unit cost on the purchase line and purchase order line must be updated to 
reflect the corresponding pricing for that quantity tier.

◦ Pricing record is systematically created for a single price.

◦ Creating a price break entry in the Pricing table is optional.

◦ User manually changes the price type from single price to price break in the Pricing table, 
and enters the pricing tiers.

• One-time price break, with negotiations:

◦ Similar to the one-time single price, with negotiations scenario.

◦ Procurement specialist confirms the quantity with the shopper, if not indicated by the 
shopper already, and enters the appropriate negotiated unit cost on the purchase line.

Note:  When quantity is revised on a line that has an underlying price break, the 
negotiated unit cost on the purchase line and purchase order line must be updated to 
reflect the corresponding pricing for that quantity tier.

◦ Pricing record is systematically created for a single price.

◦ Creating a price break entry in the Pricing table is optional.

◦ User manually changes the price type from single price to price break in the Pricing table, 
and enters the pricing tiers.

• Term single price, no negotiations: Similar to the one-time single price, no negotiations 
scenario.

• Term single price, with negotiations: Similar to the one-time single price, with negotiations 
scenario.

• Term price break, no negotiations: Similar to the one-time price break, no negotiations 
scenario.

• Term price break, with negotiations: Similar to the one-time price break, with negotiations 
scenario.

Note:  For third party sourcing integration, the flow does not get impacted since both the 
Negotiated unit cost  field and the Pricing table are populated systematically.

The Original unit cost  field in the Pricing table populates the Starting unit cost  field on a 
purchase line for any subsequent purchases using this active contractual price record.

Contractual Price

A price for a supplier product is considered as an active contractual price when there is a 
contract reference to the pricing and the contract is active. Subsequent purchases of a product 
with contractual pricing uses the active contractual price, and the price is displayed in Shopping 
Hub  accordingly.

The Price Duration Type  field determines if the price is for a one-time purchase or a term 
purchase. This is a read-only field, whose values are populated based on the One-time pricing 
field on the purchase line.
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Note:  For a good, the value of this field on the Pricing table is always Term. This field 
is editable within the purchase line only when it is for a service, and the line is within 
the context of a sourcing request. Once a purchase requisition is created, the field 
becomes read-only. Any updates made to this field value on the purchase line is reflected 
accordingly on the Pricing table.

If there are multiple overlapping active contracts for a specific supplier product, and they are 
mapped to the same or different contract models, the contract with the lowest price is used to 
display pricing in Shopping Hub.

If there are overlapping active contracts in a blanket or release scenario, any subsequent release 
uses the lower price. For blanket purchase orders (not releases), the original contract associated 
to the blanket purchase order is not updated. The blanket line amount and quantity remain the 
same. Releases (after the lower contractual price is active) are associated to the contract with 
the lower contractual price. Contract association for releases that are complete shouldn't be 
changed.

If the overlapping contracts have a price break structure, use the minimum price to determine 
which contract to use during the overlapping period.

A reference to the pricing record is added on the purchase line to allow procurement specialists 
to select a different pricing record, if required. If the pricing reference is updated, the starting 
unit cost and negotiated unit cost are updated on the purchase line, and so is the requisition to 
contract association.

Receipt tasks

Receipt tasks are created when goods receipt is required for the purchase line.

A receipt task references a purchase order and is grouped by the recipient and the calendar 
month of the product's expected delivery date. A receipt task is created only during the month of 
the expected delivery date, irrespective of the purchase order creation date, and remains open 
until all the expected deliveries for the recipient in a calendar month are confirmed. This is done 
using the [PSM] Create Receiving Task scheduled job.

Consider the following example:

The current month is September 2020, and for a purchase order, there are five purchase order 
lines:

Purchase order line Expected delivery date Recipient

1 September 10, 2020 John

2 September 20, 2020 John

3 October 22, 2020 John

4 September 12, 2020 Peter

5 October 5, 2020 John

On the purchase order, three receipt tasks are created as follows:
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• Receipt task 1, associated to purchase order line 1 and 2, is created on September 1, 2020, with 
the state Open.

• Receipt task 2, associated to purchase order line 3 and 5, is created on October 1, 2020, with 
the state Open.

• Receipt task 3, associated to purchase order line 4, is created on September 1, 2020, with the 
state Open.

You can view all receipt tasks from the Receipt Acknowledgment  sub-module under the 
Sourcing and Purchasing Automation  module. The following are the key fields of a receipt task:

Receipt task fields

Field Description

Number System-generated unique identifier of the 
receipt task.

Assigned to Person primarily responsible for this receipt 
task.

Primary contact Person within the procurement team who can 
be contacted with questions about receipts, 
milestones, invoices, or other activities related 
to acknowledgment. This field is populated or 
updated with the same user in the Assigned to 
field of the parent task record, as follows: For 
a receipt or acknowledgment task, from the 
referenced purchase order.

Short description Brief description of the receipt task.

This description is dynamically populated 
based on whether there are one or multiple 
products to be received from the supplier.

Description Detailed description of the receipt task.

State Status of the receipt task. For example, Open, 
Shipped, Partially Complete, and so on.

Due date Expected due date from the person to whom 
this task is assigned.

Summary Details

Expected start Expected start date of the receipt task.

Actual start Actual start date of the receipt task.

Actual end Actual end date of the receipt task.

Duration Duration to complete this receipt task.

The following are the related lists of a receipt task:
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Receipt task related lists

Related list Description

Purchase order lines List of all the related purchase order lines for 
this receipt task.

Receipts List of all the receipts for this task.

This list is populated when the shipment of the 
product is partially or fully complete.

For more details, see Receipts

Shipment details List of all the shipment tracking numbers for 
this receipt task.

For more details, see Shipment details.

Receipts

Receipts reference a purchase order line. Depending on the product type of the purchase, a 
goods receipt or services receipt is generated.

If the product type of the purchase order is a good, then a goods receipt is generated. If the 
product type is services, then a services acknowledgment receipt is generated.

Note:  If you’re an existing customer continuing with the Source-to-Pay Common 
Architecture  (sn_shop) plugin, and skipping the Shopping Hub (sn_spend_uib) plugin, 
service acknowledgment is replaced with invoice acknowledgment for you.

For a product of the type service, if the acknowledgment type is Milestones, then confirming a 
milestone also results in receipt generation. However, if the acknowledgment type is Two way 
match, receipt creation is disabled for this purchase order line.

Receipts can either be a partial or full receipt, and are used determine the status of the 
associated purchase order line and purchase order.

You can view all receipts from the Receipt Acknowledgment  sub-module under the Sourcing 
and Purchasing Automation  module. The following are the key fields of a receipt:

Receipt fields

Field Description

Number System-generated unique identifier of the 
receipt.

ERP number ERP number generated for the receipt.

Received by The recipient of the product.

Status Status of the receipt.

The status field is visible only when the ERP 
integration plugin is installed.

Supplier product The product for which the receipt is generated.
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Receipt fields  (continued)

Field Description

Type Type of the receipt based on the product type. 
For example, Goods Receipt  or Services 
Receipt.

Summary Details

Purchase order line The purchase order against which the receipt 
of the product is acknowledged.

Milestone Milestone associated for this receipt.

This field is visible only for a services receipt 
and if the acknowledgment type is milestones.

Quantity received The quantity of the product received.

This field is visible only for a good receipt.

Percentage received Percentage of the service received.

This field is visible only for a services receipt.

Amount received Receipt amount for the service received.

This field is visible only for a services receipt.

Shipment details

Shipment details display tracking information of a product that is shipped to the employee 
shopper.

Shipments can be tracked for USPS, FedEx, UPS, or other carrier services. The tracking 
information from shipping details is displayed to the employee shopper on the ShoppingHub 
portal. Shipment details are referenced to a receipt task and a purchase order line.

You can view all shipment details from the Receipt Acknowledgment  sub-module under the 
Sourcing and Purchasing Automation  module. The following are the key fields for a shipment:

Shipment details fields

Field Description

Tracking number Tracking number associated with the 
shipment.

Quantity shipped Quantity of the product shipped.

Status Status of the shipment.

For example, Pending Shipment, Shipped, 
Out for Delivery, Delivered.

Updated The date and time the status is last updated.

Summary

Carrier Shipment carrier used for the delivery.
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Shipment details fields  (continued)

Field Description

For example, USPS, FedEx, UPS, or Other.

Other carrier Name of any other shipment carrier used for 
the delivery.

This field is visible only if carrier is selected as 
Other.

Receipt task Receipt task associated with the shipment.

Receipt Receipt associated with the shipment.

Purchase order line Purchase order line associated with the 
shipment.

When the status of the shipment is updated to Delivered, a receipt is created for the quantity 
mentioned in the shipment.

Invoice tasks

Invoice tasks, an extension of acknowledgment tasks, lists invoice tasks in the Open, Work in 
Progress, and Closed Rejected status.

Note:  If you are a new customer, or an existing customer who has upgraded and installed 
the Shopping Hub (sn_spend_uib) plugin, these tasks aren't applicable for you. However, 
if you choose to continue with the existing Source-to-Pay Common Architecture  (sn_shop) 
plugin and skip the Shopping Hub plugin, these tasks are available for you to work on.

When an invoice acknowledgment is triggered, a task is created against the invoice and 
displayed as an Invoice Task related list on the Invoice form view.

You can view these invoice tasks from the Receipt Acknowledgment  sub-module under the 
Sourcing and Purchasing Automation  module. The following are the key fields of an invoice task:

Invoice task fields

Field Description

Number System-generated unique identifier of the 
invoice task.

Assigned to Person primarily responsible for this invoice 
task.

Primary contact Person within the procurement team who can 
be contacted with questions about receipts, 
milestones, invoices, or other activities related 
to acknowledgment. This field is populated or 
updated with the same user in the Assigned to 
field of the parent task record, as follows: For 
an invoice or acknowledgment task, from the 
referenced purchase order.

Short description Brief description of the invoice task.

Description Detailed description of the invoice task.
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Invoice task fields  (continued)

Field Description

State Status of the invoice task. The options are 
Open, Work in Progress, Closed Complete, 
Closed Rejected, and Closed Canceled.

If a line is acknowledged in ShoppingHub, 
the state of the invoice line will be Invoice 
Confirmed. If rejected, the state of the invoice 
line will be Rejected.

Due date Expected due date from the person to whom 
this task is assigned.

Summary Details

Invoice Invoice for which this invoice task is created.

Expected start Expected start date of the invoice task.

Actual start Actual start date of the invoice task.

Actual end Actual end date of the invoice task.

Duration Duration to complete this invoice task.

The following are the related lists of an invoice task:

Invoice task related lists

Related list Description

Invoice lines List of all the related invoice lines 
with acknowledgment type as service 
acknowledgment, for this invoice task.

Invoices

Invoices are generated for a payment against a purchase order. A purchase order can have 
multiple invoices depending on the payment schedule.

You can manually create invoices in the ServiceNow  platform or generate invoices through 
integration with an external supplier portal.

Note:  Invoice matching is either done externally in the supplier portal or manually in 
ServiceNow. There’s currently no logic to perform invoice matching systematically in the 
ServiceNow  platform.

The following are the key fields of an invoice:

Invoice fields

Field Description

Number System-generated unique identifier for the 
invoice.

ERP number Unique identifier generated within an ERP 
system for the invoice.
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Invoice fields  (continued)

Field Description

This field is applicable when there’s an ERP 
integration. The value is populated after the 
invoice is posted in the ERP system through 
the integration.

Status Current status of the invoice.

Supplier invoice number Invoice number of the supplier.

Note:  This is a mandatory field except 
when the invoice is in the Draft state.

Supplier tax id Tax ID associated with the supplier.

Invoice date Date on which this invoice is created.

Note:  This is a mandatory field except 
when the invoice is in the Draft state.

Summary Details

Supplier Supplier from whom the product or service is 
procured.

Purchase order Purchase order to which this invoice has been 
matched.

Invoice date Date on which this invoice is created.

Note:  This is a mandatory field except 
when the invoice is in the Draft state.

Subtotal Total amount of money to be paid to the 
supplier excluding tax and shipping charges.

Note:  This is an editable field.

Tax rate Tax rate percentage applied for the order.

Sales tax Sales tax charges incurred for the invoice.

Shipping Shipping charges incurred for the invoice.

Other charges Other additional charges associated to the 
invoice.

Discounts Discounts applied to the invoice.

Amount invoiced (Transaction currency) Total amount of money to be paid to the 
supplier including tax and shipping charges.

Note:  This is a mandatory field except 
when the invoice is in the Draft state. This 
is also an editable field.
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Invoice fields  (continued)

Field Description

Accounting Details

Legal entity The internal legal entity which incurs the cost 
of this invoice.

Remit to address The location to which this payment is made.

The following are the related lists of an invoice:

Invoice related lists

Related list Description

Invoice Lines Captures the line amount and rolls up to the 
subtotal on the invoice.

Service Acknowledgments Displays all the service acknowledgments 
associated with this invoice.

Approval Plans Displays all the approval plans created against 
this invoice.

Approvals When the services acknowledgment is set to 
Invoice approval, invoice approvals act as a 
form of receipt before issuing the payment to a 
supplier.

In the absence of a receipt and three-way 
matching, invoice approvals are used to avoid 
an automatic two-way match.

Invoice approvals are sent to the recipient of 
the line and the shopper can act on them as a 
to-do in ShoppingHub.

For details, see Shopper to-dos.

Invoice Tasks When a service acknowledgment is triggered, 
a task is created against the invoice and listed 
here.

Note:  If you are a new customer, or an 
existing customer who has upgraded 
and installed the Shopping Hub plugin, 
these tasks aren't applicable for you. 
However, if you choose to continue with 
the existing Source-to-Pay Common 
Architecture  plugin and skip the 
Shopping Hub plugin, these tasks are 
available for you to work on.

To create an invoice from a supplier for a received product or service, edit the Subtotal  field in 
the Invoice form to the actually received amount, add an invoice line to capture the specifics of 
that purchase order line, and update the Line amount invoiced  field in that Invoice Line form to 
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reflect the same received amount. When the invoice line and the invoice are both updated to 
the Paid state, an expense line in auto-generated in the Project form of Project Management  for 
which the purchase was originally made.

For more information on Sourcing and Procurement Operations's integration with Project 
Management, see Sourcing and Procurement Operations integration with Project Management.

Invoice calculations and state flows

Note:  Business rules pertaining to handling state changes, handling tax and charges, 
default invoice fields, populating invoice line amounts, handling line total changes, and 
populating supplier products are available only if you haven't installed the Shopping 
Hub (sn_spend_uib) plugin and are still using the Source-to-Pay Common Architecture 
(sn_shop) plugin.​

A field named Amount requiring approval  on the invoice approval record distinguishes the 
actual invoice amount that needs to be approved, as the invoice lines within an invoice could 
consist of different services acknowledgment types and/or goods receipt required conditions.

When an invoice line that is sent for approval is approved, the status of the invoice line is 
updated to Invoice Confirmed. If any line within the invoice is rejected, the entire invoice is 
rejected.

The status of the invoice is updated to Invoice Confirmed only when the status of all the 
corresponding invoice lines are Invoice Confirmed. If the status of the invoice is updated to 
Invoice Confirmed, then the status of all the associated invoice lines are also updated to Invoice 
Confirmed. This applies to the scenario when matching is done manually in the ServiceNow AI 
Platform  and the user updates the invoice header instead of updating line by line. This update is 
done by selecting Confirm  on the invoice header. When the invoice state is Invoice Confirmed, 
the Confirm  button isn’t displayed for any subsequent state as well.

The invoice state on the invoice header is read-only as the state change is driven by the lines. 
In case of a multi-line invoice, if one line is in a Requires Review state, the invoice header is 
updated to Requires Review as well.

Create an approval rule

Approve a purchase requisition, purchase order, sourcing request, or invoice, by defining an 
approval strategy and creating approval rules. This is a one-place configuration that can drive 
any kind of approval process that your organization may need.

Before you begin
To create an approval rule, you must have set up your product catalog (with the necessary 
product categories, product models, and supplier products) and should be able to raise a 
purchase requisition or sourcing request. For more information on how to set up your product 
catalog, see Create a product category, Create a product model, and Add a supplier product. You 
should have also set up the sys_user record appropriately to include relevant details such as job 
codes, managers.

Role required: sn_shop.procurement_administrator

About this task
You can create an approval rule to determine how approval plans are generated and routed when 
conditions are met, from the Sourcing and Purchasing Automation  module.

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Administration  > Approval Rule.

2. Select New.
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3. On the form, fill in the fields.

Approval Rule form

Field Description

Number System-generated unique identifier for the approval rule.

Name Name you assign to the approval rule.

Active Option to decide if this rule is used to generate approvals during the purchase 
requisition process.

Approving 
object

Object you’re seeking approval for. The following options are available:

◦ Invoice

◦ Purchase Order

◦ Purchase Requisition

◦ Sourcing Request

It's defaulted based on the approving object selected. For sourcing request 
and purchase requisition it’s purchase requisition line, for purchase order it’s 
purchase order line, and for invoice it’s invoice line.

Note:  While full approval workflows, including approval engine, state 
flows, and email notifications, are provided for purchase requisitions and 
sourcing requests, additional implementation is required in defining state 
flows and email notifications for purchase order and invoice approval rules.

Approving 
line

Approving object line you're seeking approval for.

Approval 
rule type Type of approval rule that determines how approval plans are generated and 

routed when conditions are met. The following options are available:

◦ Dynamic Users or Groups

◦ Managerial Job Code Hierarchy

◦ Managerial Hierarchy

◦ Specified Users or Groups

◦ Cost Center Managers

Note:  This option is available only when the approving object is a 
purchase requisition.

Depending on the rule type you select, the associated fields appear. For more 
information on these rules, see Approval rule types.

Base 
approvals 
on

Business owner who the approval rule is based on.

Users Specified users who should receive the approval based on the approval trigger.

Groups Users in the specified groups who should receive the approval based on the 
approval trigger.
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Field Description

Approval 
sequence

Sequence in which the approval rules should be triggered. For more information 
on this, see Approval rule grouping and sequencing.

Approval 
required 
from

Determines the managers who should receive the approval request during the 
purchase requisition process.

Allow 
automatic 
approval

Determines if self-approval is to be enabled. By default, this flag is checked or 
set to true, enabling the self-approval functionality, where the requester has the 
approving authority. However, if the flag is cleared or set to false, the requester is 
included to be an active approver in the approval engine’s generated approval 
list, thus overriding the default self-approval functionality. The requester now 
needs to provide an explicit approval decision by completing an approval task.

Purchasing 
user

User for whom approvals are triggered.

Send 
approval to 
purchasing 
users

Options to send an approval dynamically to a user or group related to the 
purchasing user.

Authorized 
job codes

One or more job codes that can automatically approve purchases up to the 
specified limit.

Approved 
purchasing 
limit

Reference currency threshold within which users with the specified job codes 
can approve purchase requisitions.

Approval 
routing 
method

Method of routing the approvals. The options are sequentially and in parallel.

Approval 
decision 
method

Method of approving the rule. You can select if all approvers must approve the 
rule or any approver can approve it.

Approval 
trigger 
conditions

Conditions based on the approving object that determine the conditions under 
which an approval plan is created.

The trigger conditions are based on the Approving Object table and enable the 
user to dot-walk. For example, if the user wants to create trigger conditions from 
the maximum budget of a sourcing request, they should walk from maximum 
budget to amount, and then create the conditions.

Note:  Approvals are individually evaluated for each approving object. 
For example, creating the same approval for a sourcing request and a 
purchase requisition results in approvals getting triggered twice. To prevent 
this, the admin can configure approvals from not getting created in a 
purchase requisition if it's backed by a sourcing request that isn't empty. 
This is done from the approval trigger conditions.

4. Select Submit.

Approval rule types

Approval rule types determine the methods by which approvals are created during the purchase 
requisition process.
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As a procurement administrator, you can define an approval strategy and create approval 
rules to approve a purchase internally before it’s converted to a purchase order and sent to a 
supplier. This is a one-place configuration that can drive any kind of approval process that your 
organization may need.

You can create these approval rule types that go on to determine the conditions under which 
approval plans are generated and routed:

Approval rule types

Approval rule type Description Example Scenario

Dynamic Users or Groups Approvals are dynamically 
created and sent to the 
specified user or group. 
Approvals are triggered based 
on the purchasing user's 
attributes. The approval 
routing method is restricted 
to just sending approvals in 
parallel.

If approval is required from the 
purchasing user's cost center 
manager, then at the time 
when the purchase requisition 
is sent to pending approval, 
the rule looks at the record 
for the user in the Business 
Owner  field, dot-walks to the 
referenced cost center, and 
sends an approval to whoever 
is the referenced user in the 
Manager  field on the cost 
center.

Managerial Job Code 
Hierarchy

Approvals are triggered based 
on the purchasing user's job 
code and manager's job code. 
The approval routing method 
can be parallel or sequential, 
and the approval decision 
method can be all approvers 
or any approver.

If approval is required from 
all users up to the user with 
an authorized code, then 
an approval is sent to all 
users within a management 
hierarchy up to the user with 
an authorized job code for the 
approved purchasing limit that 
covers the total amount of the 
purchase requisition.

If approval is required from 
the most junior user with 
an authorized code, then 
an approval is sent to the 
most junior user within a 
management hierarchy up to 
the user with an authorized 
job code for the approved 
purchasing limit that covers 
the total amount of the 
purchase requisition.

Managerial Hierarchy Approvals are triggered based 
on the purchasing user's 
manager's hierarchy. The 
approval routing method can 
be parallel or sequential, and 
the approval decision method 
can be all approvers or any 
approver.

If approval is required from 
all managers in hierarchy, 
then an approval is sent to 
all users in the purchasing 
user's (business owner) 
management hierarchy up to 
the job code specified, when 
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Approval rule types  (continued)

Approval rule type Description Example Scenario

the approval trigger conditions 
are met.

If approval is required from the 
direct manager alone, then an 
approval is sent to the user's 
manager in the purchasing 
user's (business owner) 
management hierarchy.

If approval is required from 
the most senior manager, 
then an approval is sent to the 
most senior manager in the 
purchasing user's (business 
owner) management hierarchy 
up to the job code specified.

Specified Users or Groups Approvals are triggered based 
on the specified users or 
groups. The approval routing 
method is restricted to just 
sending approvals in parallel.

Cost Center Managers Approvals are triggered only 
for purchase requisitions, 
from multiple cost center 
managers. The approval 
routing method is restricted 
to just sending approvals in 
parallel.

If the cost of a purchase 
requisition is allocated 
across many cost centers, 
approvals are sent to each 
cost center manager for 
the cost allocation amount 
needing approval.

If an individual item in the 
purchase requisition has cost 
allocated across multiple cost 
centers, all the cost center 
managers must provide their 
approval for the amount of 
that item to be approved.​
 The purchase requisition 
can be partially or completely 
approved depending on the 
approval decision for each 
individual item or purchase 
line.

Cost center managers receive 
email notifications for their 
approval with details of the 
purchase and the allocated 
amount needing approval. 
They can provide their 
approval directly from the 
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Approval rule types  (continued)

Approval rule type Description Example Scenario

email, or complete their 
approval in Shopping Hub, 
Employee Center, Virtual 
Agent, or Shopping Hub 
Mobile.

Self-approved purchases

For requesters who possess the right purchasing authority, job code, or belong to designations 
that meet a defined purchasing approval matrix, their purchases are self-approved. An audit trail 
is made available, where an approval plan is created with the approval type as Self Approved, 
and in the Closed Complete state, though no actual approval tasks are created.

Such requesters can also complete approval tasks, if configured, and provide approvals for 
invoices from suppliers to be routed for payment. In the Approval Rules form, an admin can 
configure the need for a requester to provide an explicit approval decision, through the Allow 
automatic approval  flag. By default, this flag is checked or set to true, enabling the self-approval 
functionality, where the requester has the approving authority. However, if the flag is cleared 
or set to false, the requester is included to be an active approver in the approval engine’s 
generated approval list, thus overriding the default self-approval functionality. The requester now 
must provide an explicit approval decision by completing an approval task.

Note:  In case of any issues related to approvals not getting created as expected, ensure 
that the flag on the rule is in the correct state and the rule conditions are met.

Approval rule considerations

Factors like currency, which includes foreign exchange, reference, and transactional, decide the 
approval rules to be triggered. Some of the other factors are purchasing limit, line amount, and 
received lines, among others.

Foreign exchange and reference currency considerations in approval rules

If an approval rule has a defined approved purchasing limit, the foreign exchange currency is 
defaulted to the system reference currency.

To determine the approval rule to be triggered, compare the transactional currency on the Total 
amount  field on the purchase requisition against the reference currency approval rule bucket 
that it belongs to.

If an approval rule has an approval trigger defined using the total line amount, it should be 
defined by dot-walking to the reference amount. The transactional currency on the purchase 
line's total line amount is compared against the reference currency, to determine the approval 
rule to be triggered.

Fully received lines consideration in approval rules

For a fully received line, the line amount is taken into consideration to determine the approval 
rule that needs to be triggered.

Approval rule grouping and sequencing

As a Procurement Administrator, you can associate approval rules with approval groups and 
define the sequence to determine when these rules should be triggered. With this association, 
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a set of approval rules within a rule group is triggered in sequence, instead of all of them being 
evaluated simultaneously.

For example, when purchasing an IT-related product, a manager can first approve the purchase 
before sending it to the IT department for approval.

Rules within an approval group are evaluated only if all the rules within it are satisfied. If there 
are multiple approval groups, all groups are evaluated simultaneously. For approval rules that 
do not have an associated approval group, evaluation is done as-is at the same time with 
rules that are associated to approval groups. By default, all rules in an approval group are also 
evaluated independently. If a rule group is satisfied, then the individual rules do not need to be 
evaluated. This prevents a Procurement Administrator from creating duplicate rules that need to 
be evaluated independently and also within the context of an approval group.

Consider the following scenarios:

Scenario 1

• Purchase requisition amount is $8,000

• Business owner’s job code is IC3, cost center is Engineering

• Business owner’s managerial job code hierarchy is IC3 => M3 => M4 => CFO

Approval rules A and B

• Without rule group and group sequencing, approval rules A and B are triggered 
simultaneously.

• With rule group and group sequencing, approval rule A is triggered first, followed by approval 
rule B when A is complete.

Scenario 2

• Purchase requisition amount is $8,000, supplier product belongs to the XYZ product category

• Business owner’s job code is IC3, cost center is Engineering

• Business owner’s managerial job code hierarchy is IC3 => M3 => M4 => CFO
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Approval rules A, B, and C

• Without rule group and group sequencing, approval rules A, B, and C are triggered 
simultaneously.

• With rule group and group sequencing, approval rules A and C are triggered first, followed by 
approval rule B when A is complete.

Scenario 3

• One purchase made for $120k

• Another purchase made for $95k

Approval rules A, B, C, and D

• Without rule group and group sequencing, approval rules A, B, C, and D are triggered 
simultaneously.

• With rule group and group sequencing, approval rules A and D are triggered first, followed by 
approval rules B and C when A is complete.

Approval group details are stored in the Approval Group table. Within each approval group, there 
is an approval rule composition related list to define the order of approval rule evaluation within 
that specific group.
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Impact of rule groups and sequencing on the resend approval for reassessment 
property

If approval rules that belong to a rule group are triggered, the resend approval for reassessment 
property is only applicable if the same rules within that rule group are satisfied as a result of a 
merge or revision.

In the scenario where there are rules that belong to a group, and are also evaluated 
independently, the resend approval for reassessment property is only applicable if the same 
rules within the group are triggered. For rules that do not belong to a group, the property behaves 
as-is.

For example, in scenario 2:

• If the resend approval for reassessment property is set to No, and as a result of a revision, 
approval rule A is satisfied, rule B is not satisfied, and rule C is satisfied, then approvals are 
resent to the approver for rule A.

• If the property is set to No, and rules A, B, and C are satisfied as a result of a revision, then the 
approvals are not resent.

• If the property is set to Yes, and rules A, B, and C are satisfied as a result of a revision, then all 
approvals are resent.

• If the property is set to Yes, and rules A, C, and a new rule D are satisfied as a result of a 
revision, then approvals A and C are resent, and a new approval D is sent.

Monitor an approval plan

During evaluation, the approval engine converts each approval rule into one or multiple approval 
plans. You can monitor approval plans to understand how the overall approval process is being 
executed, the routing and decision methods, the list of approvers involved, the status on the 
approvals, the list of purchase lines the approval is planned for, and so on.

Before you begin
To monitor an approval plan, you must have already defined an approval rule. For more 
information on how to create approval rules, see Create an approval rule. You can review and 
update the plans if required. Approval plans are not created manually.

Role required: sn_shop.procurement_administrator

About this task
You can monitor approval plans to understand how the overall approval process is being 
executed, from the Sourcing and Purchasing Automation  module.

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Administration  > Approval Plan.

2. Select a record.

3. On the form, review these fields.

Approval Plan form

Field Description

Number System-generated unique identifier for the approval plan.

Approval 
Rule

The approval rule you want to reference for this plan.
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Field Description

Purchase 
requisition 
number

The unique identifier for the record on which this approval plan is applied.

Approver 
list

User or users responsible for approving the plan.

Approver 
group list

List of groups containing the users responsible for approving the plan.

Approval 
routing 
method

Method of routing the approvals. The options are sequentially and in parallel.

Approval 
decision 
method

Method of approving the rule. You can select if all approvers must approve the 
rule or any approval can approve it.

Approval Status of the approval plan request. The options are Not Yet Requested, 
Requested, Approved, and Rejected.

State Work status on the requested approval plan. The options are Pending, Open, 
Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped.

Purchase 
requisition 
line(s)

List of the purchase lines that the approval is planned for.

Primary 
contact

Business owner of the purchase who can be contacted with questions about the 
purchase. This field is automatically populated on creation of an approval plan 
with the referenced business owner of the purchase order.

Short 
description

Short description of the approval plan. This is a calculated value, in the format: 
Approve <total amount> purchase for <supplier name>.

What to do next
Use the related lists of the approval plan form to view the approval plan details and approvers 
associated with this approval plan.

Approvals reassessment

Review the conditions for approvals reassessment and their impact on purchase automation.

Resend approvals for reassessment property

The sn_shop.approval.reassessment.resend purchasing property determines if an approval 
needs to be reassessed as a result of a revision or a merge. The revision could be that of a 
purchase order or a purchase requisition. This property is only applicable if the same approval 
rule is triggered. If a new rule is triggered, this property is not applicable and a new approval plan 
is generated.

For information on approval rule groups and sequencing, and how these impact the property, 
see Approval rule grouping and sequencing.

A reduction in funds revision is not allowed if the amount is below what has already been 
shipped or delivered. Revisions are not allowed on rejected lines, and therefore reassessment of 
approvals is not applicable.

For information on approval rules, see Approval rule types  and Create an approval rule.
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When an approval reassessment is sent to approvers, the approval amount to be considered 
must include the revised line's original amount and the increase in funds. For example, if the 
original line amount is $1000 and an increase in funds revision results in the line amount to be 
$1500, the amount to be considered for reassessment and approval is $1500.

When the resend approvals for assessment property is set to Yes, if there is an existing approval 
plan record that is in progress, and a revision or merge occurs before the plan is completed, its 
status is updated to No longer required, and a new plan is created. If the property is set to No, 
and if the existing approval plan is in progress, it is reused.

During an approval reassessment, rejection of a fully received line is not allowed. In 
ShoppingHub, the fully received line is displayed under the Approved  tab.

Population of due date on approvals

When a new approval record is generated and the state of the approval record is Requested, the 
due date for the record is calculated and populated using the following properties:

• sn_shop.pr.approval.duration: Duration, in hours, allocated for an approver to complete the 
approval request. By default, it is set to 9 hours.

• sn_shop.pr.approval.duration.schedule: The type of schedule associated to the approval 
duration. By default, it is set to 8-5 weekdays, excluding holidays.

Note:  The sys_id of the schedule is used as the value for this property.

Parallel approval records have the same due date. For sequential approvals, the first approver's 
due date is populated based on the property value defined, the second approver's due date is 
calculated after the first approval is complete, and so on.

Creation of breached approvals review task

If a due date for an approval is breached, a new task is automatically created using the [PSM] 
Approval Due Date Breached scheduled job, which runs once a day. This task is a purchasing 
task, with subtype Approval, and is assigned to the same person to whom the purchase 
requisition is assigned.

For sequential approval, this purchasing task is created for each approver record that is overdue. 
For parallel approvals, a single task is created with a related list displaying all the relevant 
approver records that have breached.

The due date of this task is populated with the breach time on the SLA instance record 
associated to the SLA definition for the breached approvals review.

For approvals that are no longer required or are canceled, the breached approvals review task 
creation is not triggered. Breached approvals review SLAs are deleted as they are no longer 
required.

Create a purchasing assignment rule

Automatically assign a sourcing request, negotiation, or purchase requisition to a procurement 
specialist user or a task fulfiller’s group based on pre-defined conditions by using a purchasing 
assignment rule.

Before you begin
To create a purchasing assignment rule, you must have set up your product catalog (with the 
necessary product categories, product models, and supplier products) and should be able 
to raise a purchase request. For more information on how to set up your product catalog, see 
Create a product category, Create a product model, and Add a supplier product. You should have 
also set up user attributes on the sys_user record appropriately.
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Role required: sn_shop.procurement_administrator

About this task
You can create a purchasing assignment rule to route sourcing requests, negotiations, or 
purchase requisitions to an individual or group, from the Sourcing and Purchasing Automation 
module.

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Administration  > Purchasing 
Assignment Rules.

2. Select New.

3. On the form, fill in the fields.

Assignment Rule form

Field Description

Name The name you assign to the assignment rule.

Application The application containing this record. In this case, it displays the default 
application, which is Sourcing and Procurement Operations.

Active Option to decide if this rule is in use.

4. Select the Applies To  tab and fill in the fields.

Applies To form

Field Description

Table Name of the table for which conditions must be set.

Conditions
Combination of conditions that must be met before the task is assigned to a 
user or group. You must add at least one filter condition, select a field type, and 
specify a value, for the condition to be set.

Note:  The rule is applied only if the task is not already assigned to 
another user or group.

5. Select the Assign To  tab and fill in the fields.

Assign To form

Field Description

User The user to whom the task is assigned.

Group The group to which the task is assigned.

6. Select the Script  tab and fill in the fields.
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Script form

Field Description

Script A script to further customize the assignment rule. Scripts provide access to the 
current pool of variables.

7. Select Submit.

Define a capitalization policy

Create fixed asset shells automatically during purchase order creation, by defining a 
capitalization policy.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
You can define a capitalization policy from the Sourcing and Purchasing Automation  module.

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Administration  > Capitalization 
Policies.

2. Select New.

3. On the form, fill in the fields.

Capitalization Policy form

Field Description

Name The display name of the capitalization policy.

Owned 
by

The user responsible for managing this fixed asset policy.

Rank Determines the order in which a capitalization policy is processed if multiple 
policies are satisfied. Policies with lower ranks are honored and processed first.

Created The date when this fixed asset policy is created.

Active Option to decide if this policy can be used to create fixed assets.

Capitalize 
assets if

Conditions that determine the creation of a fixed asset.

4. Select Submit.

Fixed asset creation

As a procurement administrator, you can create fixed assets for products that are purchased for 
long-term use and are not likely to be converted quickly into cash.

Fixed asset creation is automated when capitalization policy criteria are satisfied. To ensure that 
fixed assets are created automatically on creation of a purchase order, you must first define an 
applicable capitalization policy. For more information on how to define a capitalization policy, see 
Define a capitalization policy.

Note:  Blanket purchase orders cannot result in the creation of a fixed asset.
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You can navigate to Sourcing and Purchasing Automation  > Primary Data  > Fixed Assets, and 
review these fields.

Fixed Asset form

Field Description

Number System-generated unique identifier for the fixed asset.

ERP asset 
number

Unique identifier generated within the ERP system for the fixed asset.

Display 
name

System-generated unique display name for the fixed asset. This is an auto-
generated value derived from concatenating the ERP number and the product 
name into <ERP number - Product name>, where the values are taken from the 
ERP asset number  and Product name  fields respectively. If either of these fields 
are null or empty, then the corresponding value is left empty.

Supplier Supplier from whom this fixed asset was purchased.

Product 
name

Name of the purchased product.

Purchase 
order line

The purchase associated with this fixed asset.

Status Current status of the creation of the fixed asset. The options are Submitted, 
Success, and Pending Deletion. This field is used in the back end for SAP 
integration purposes.

Capitalize 
on

The date on which the requester assumes the liability of the fixed asset, 
depending on the supplier incoterm.

Original 
value

The amount originally paid for the fixed asset.

Depreciation 
lifecycle

The length of time in which the fixed asset is fully depreciated.

Depreciation 
term

The frequency of depreciation throughout the lifecycle of the fixed asset.

Depreciated 
amount

The amount that the fixed asset has depreciated by, over time.

Remaining 
value

The amount that the fixed asset is worth today, after factoring in depreciation.

Salvage 
value

The amount that the fixed asset is worth after it has come to the end of its useful 
life.

Inventory asset creation

Inventory assets are not created upfront when fixed assets are created.

They are created only when the following conditions are satisfied:

• Asset tracking strategy on the product model is set to create assets.

• Product category referenced on the product model has an asset class defined.

• Product has been partially or fully delivered. In case of partial delivery, only the corresponding 
partial quantity of inventory assets are created.
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Inventory assets are not created if goods receipt required is specified as no for a good, or if the 
acknowledgment type is a two-way match for a service.

If you have defined an asset class, the corresponding asset records are created and associated 
to the relevant contract model on the purchase order, which are then displayed on the assets 
covered related list. The applicable contract models that should have the assets covered related 
list are insurance, lease, maintenance, purchase order, software license, subscription, and 
warranty.

To view the asset related list, navigate to Asset  > Portfolios  > All Assets. A Purchasing  tab has 
been added to the asset form view to capture procurement specific fields that are populated 
from the purchase order line of the corresponding asset.

Purchasing form

Field Description

Purchase order Purchase order associated with this asset.

ERP number Unique number generated within the ERP system for the purchase order.

Purchase order line Purchase order line associated with the asset.

Supplier Supplier associated with the asset.

Unit Unit used to purchase this asset.

Unit price Unit price of this asset.

Recipient Recipient of the asset.

Received Date when the asset was received.

For more information on asset creation, see Create assets .

A fixed asset related list has also been added. It displays the fixed asset that is associated with 
this inventory asset if a capitalization policy was satisfied.

Shipping cost calculations

A framework to integrate shipping cost calculations into Sourcing and Purchasing Automation  is 
implemented such that approvals can be done on the full value of purchases.

Shipping estimates can be provided by both the ShoppingHub administrator and the buyer.

Shipping estimates from ShoppingHub administrator

A ShoppingHub administrator can set a default system-wide shipping estimate 
as a percentage. This can then be applied to all purchases that require shipping, 
when no other shipping estimates or data exist. This is enabled through a system 
property sn_shop.default.shipping.estimate. Organizations that have a policy around 
an acceptable threshold shipping cost might want to enter the threshold in the 
sn_shop.default.shipping.estimate.

A ShoppingHub administrator can also configure shipping estimates to be included in 
purchase requests for the approval process. This is enabled through a system property 
sn_shop.shipping.estimate.inclusion, which is included in purchase request approvals. If this 
inclusion is marked as true, the shipping estimate from the cart line or checkout is included as 
a field in the purchase line and in the total amount in the purchase request, while the estimate 
in cost allocation is not considered. However, if this inclusion is marked as false, not only would 
shipping be excluded in the purchase request approval process, but also not calculated at 
checkout, even if data is included at the product, supplier, or system levels.
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Note:  When a purchase request becomes a purchase order, the shipping estimate is not 
included in the total amount.

Shipping estimates from buyer

A buyer can set shipping estimates at the following levels:

• Supplier:

Set a standard percentage estimate for shipping costs from a specific supplier. This estimate 
is then applied to all the orders that require shipping from that supplier, which do not have any 
estimate at the product level. In the Purchasing Automation  tab of the supplier record, enter 
a shipping estimate value in decimal in the Default shipping estimate for products from this 
supplier (calculated as percentage of negotiated unit price)  field.

• Product:

Set a default shipping estimate for a supplier product record. This is then prioritized in 
estimating the shipping cost of a purchase over any supplier level estimate or default 
shipping estimate. In the Purchasing Automation  tab of the supplier product record, enter a 
shipping estimate value in decimal in the Default shipping estimate for this supplier product 
(calculated as percentage of negotiated unit price)  field.

Note:  The entered decimal values are stored in percentage. For example, a shipping 
estimate value of 10.5 is stored as 10.5%.

Shipping cost calculation in cart line table

If the item in your cart is a good, a cart line shipping estimate prioritization logic is used to 
calculate the estimated shipping cost. If the item in your cart is a service, the estimated shipping 
cost shows as 0.0 in your currency.

The cart line for each item is updated with the shipping estimate.

1. Use the product level shipping estimate percentage to calculate shipping, provided the 
sn_shop.shipping.estimate.inclusion property is set to true:

◦ Pull the estimated shipping as percentage value from the supplier product record.

◦ Calculate shipping as [Estimated Shipping as Percentage] * [Quantity] * [Negotiated Unit 
Price].

2. If 1 is null, use the supplier level shipping estimate percentage to calculate shipping, provided 
the sn_shop.shipping.estimate.inclusion property is set to true:

◦ Pull the estimated shipping as percentage value from the supplier record.

◦ Calculate shipping as [Estimated Shipping as Percentage] * [Quantity] * [Negotiated Unit 
Price].

3. If both 1 and 2 are null, use the default shipping estimate percentage to calculate shipping, 
provided the sn_shop.shipping.estimate.inclusion property is set to true:

◦ Pull the estimated shipping as percentage value from the system properties.

◦ Calculate shipping as [Estimated Shipping as Percentage] * [Quantity] * [Negotiated Unit 
Price].

4. If 1, 2, and 3 are all null, or the sn_shop.shipping.estimate.inclusion property is set to false, 
shipping estimate is shown as Undetermined.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

474



Tax calculations

A framework to integrate tax calculations into Sourcing and Purchasing Automation  is 
implemented such that approvals can be done on the full value of purchases.

Tax estimates from ShoppingHub administrator

A ShoppingHub administrator can configure tax estimates to be included in purchase 
requests for the approval process. This is enabled through a system property 
sn_shop.tax.estimate.inclusion, which is included in purchase request approvals. If this inclusion 
is marked as true, the tax estimate from the cart line or checkout is included as a field in the 
purchase line and in the total line amount. However, if this inclusion is marked as false, not only 
would tax be excluded in the purchase request approval process, but also not calculated at 
checkout. This applies even when a customer has made the effort to set up the tax calculation 
API, but has not marked the purchasing property to true.

Note:  When a purchase request becomes a purchase order, the tax estimate is not 
included in the total amount.

Tax calculation integration process

• Tax integration is triggered when a shopper adds a product to the cart, and the 
sn_shop.tax.estimate.inclusion property to include tax in the purchase request approval 
process is marked as true.

• A flow designer tax estimate responsible for making the API call, is triggered.

• The flow designer evaluates if the SAP integration in configured or not.

• If the SAP integration is configured, the flow designer sends the relevant parameter 
information to the SAP tax engine API, and receives the retrieved tax information to the calling 
function.

• The received tax estimate is updated in the cart line as well as on the final checkout page.

• If the SAP integration is not configured or there are integration errors, the flow designer 
does not receive any information from the SAP API, and the estimated tax is reflected as 
undetermined.

Note:  Here, the customer is open to integrate with any other tax engine, as desired.

Tax calculation API

A tax calculation API is created to provide specific parameters to a tax calculator engine, SAP in 
this case.

The following parameters are to be used in a tax calculation generic API:

• Cart line:

◦ Delivery location (from the checkout cart line)

◦ System date

◦ Purchase quantity (from the checkout cart line)

◦ Total line amount (from the checkout cart line)

◦ Currency (from the Fx Currency  field in the cart line)

• Supplier record:

◦ Street address, City, State, County, Zip, Country, Region (from the vendor's supplier record)

◦ Legal name (from the vendor's supplier record)

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

475



• Supplier product record: Model category (from the product model)

• Product model: Unit (from the cart line)

A staging table is also created that includes the following output parameters for the API:

• Tax amount

• Tax jurisdiction

• Tax type/description

• Tax percentage

Tax calculation integration with SAP

SAP's tax engine API consumes necessary parameters from the tax calculation generic API to 
provide tax estimates.

Parameter and field mapping between ServiceNow and SAP

Parameter ServiceNow Field SAP Field

Ship to Delivery Location Delivery Address Number

Date System Date Tax Posting Date

Quantity Purchase Quantity Quantity

Net price Total Line Amount Net Amount

Ship from Street Address, City, State, 
County, Zip, Country, Region

Shipping Address

Vendor name Legal Name Vendor Code

Material/Material group Model Category Material/Material Group

Unit of measure Unit Base Unit of Measure

Entity Entity Company Code

The tax estimates are consumed by ServiceNow and updated in the Estimated Tax  field on the 
cart line.

Procurement Case Management

With the Procurement Case Management  application, you can enable your employees to submit 
procurement cases and access your organization's knowledge base. You can also enable your 
procurement teams to automate their fulfillment processes so that they can manage and monitor 
the progress of their tasks.

The Procurement Case Management  (PCM) application enables you to manage the complete life 
cycle of the procurement process.

By using the PCM application, your organization gets the following benefits:

• Procurement process optimization for task routing and tracking the progress of your tasks.

• Knowledge article publish and performance workflows.

• Visibility into the processes, progress, and overall efficiency of the procurement process.

• Integration with IT Asset Management, Software Asset Management, and Contract 
Management.
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Installed plugins

Install Procurement Case Management  from the ServiceNow  Store.

The Procurement Case Management (sn_spend_psd) application installs the following 
dependent plugins:

• Common Service Delivery (sn_spend_sdc)

• Source-to-Pay Workspace (sn_spend_workspace)

Required roles

You can configure the following roles and tasks:

• sn_spend_psd.psd_admin: Configure and make changes to the system properties, such as 
creating request types and categories.

Note:  An application-specific admin role enables a user to manage application-level 
configurations, roles, and access controls. Your system-level admin on the production 
instance must grant the application-specific admin role to the appropriate users, and 
then remove the application-specific admin role from all users with the system-level 
admin role to help prevent system-level admins from viewing sensitive application data 
via forms, lists, and the UI. For more information, see Application administration .

• sn_spend_psd.manager: View, create, and update procurement cases and tasks.

• sn_spend_psd.agent: Manage the workflows for fulfilling requests and knowledge articles.

• sn_spend_psd.procurement_task_owner: Access and complete task assignments to fulfill the 
requests.

• sn_spend_psd.requestor: Create procurement cases.

Related topics

Procurement Case Management Dashboard

Using Procurement Case Management

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Work prioritization

Priority is automatically assigned to purchase requisitions, sourcing requests, and procurement 
cases that your procurement specialists must work on, based on decisions configured by your 
administrators through decision tables.

This enables your procurement specialists to view their work, sorted by priority, and get started 
with the highest priority records first, followed by the ones that have lower priority. Procurement 
specialists can view this from the Procurement Specialist list page as well as from the transaction 
records on Platform.

This automatic assignment of priority is governed by these three decision tables:

• Priority defaulting for Purchase Requisition: Defines the priority on purchase requisitions.​

• Priority defaulting for Sourcing Request: Defines the priority on sourcing requests.​

• Priority defaulting for Procurement Cases: Defines the priority on procurement cases.​
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Your administrators can define the logic for defaulting priority in the above decision tables 
based on your organization's standardized policy of classifying requisitions, sourcing requests, 
and procurement cases as high, medium, and low priority. Some examples are dollar value of 
purchases, executive or leadership purchases, type of spend, and so on. This can be achieved 
by using any of the attributes available in the transaction header, lines, or even related records. 
They can configure the decision labels and answers on these decision tables based on your 
organizational requirements, which will in turn decide the priority of the purchase requisitions, 
sourcing requests, and procurement cases. By default, the priority is set to 5 - Planning.

The priority logic is retriggered and priority is automatically reevaluated if any subsequent 
updates are made to the respective records.

For information on how to work with decision tables, see Decision Tables .

Supplier qualification

As a procurement specialist or Procurement Case Management  (PCM) agent, you would want to 
engage with suppliers who are qualified to fulfill your organization's purchasing needs.

The supplier qualification process can be very involved with multiple teams wanting to engage 
with a supplier on different levels. Based on your process, you can define qualification cases to 
reflect the work that needs to be done to ready the engagement with a supplier. This is achieved 
through decision tables for your sourcing and negotiation work streams. For information on the 
relevant decision tables, see Purchasing tasks and procurement cases.

Qualification cases include:

• Supplier cases:

◦ Conduct a Supplier Risk Assessment: Conduct a risk assessment for a supplier.

◦ Onboard a Supplier: Onboard a supplier for a purchase.

◦ Conduct a Supplier Tiering Assessment: Conduct a tiering assessment for a supplier.

Note:  For these supplier cases, the decision templates are available only when you 
have the Supplier Lifecycle Operations  application installed. You must also enable the 
Risk Assessments Integration for Sourcing and Procurement Operations  application 
and have the GRC  Vendor Risk Management  license if you want the Conduct a Supplier 
Tiering Assessment case to be generated. For information on how a supplier tiering 
assessment task influences sourcing request states, see Sourcing and Procurement 
Operations integration with Third-party Risk Management.

• Contract cases:

◦ Contract Review: Review contracts for a purchase.

◦ Send NDA for Signature: Send an NDA for signature to the supplier for a purchase.

• Finance cases:

◦ GL Coding Review: Review accounting details for a purchase line.

◦ Budget Review: Review budget details for a purchase requisition.

For a case to be considered as a qualification case, the Qualification dependent on case  field in 
that case template must be set to Yes.

To enable you be compliant with fair competition laws, when engaging with multiple suppliers, 
qualification cases that you’ve defined in the decision tables need to be completed before 
continuing your sourcing and negotiation work streams. You can define qualification cases to be 
initiated on a sourcing request, negotiation, or a negotiation event.
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To initiate the supplier qualification flow on a sourcing request, select the sourcing request 
you want to work with from the Source-to-Pay Workspace  list page, All team work  > Sourcing 
Requests, and select Begin qualification. This automatically creates the qualification cases that 
you’ve defined within the decision tables to be associated with this sourcing request, and also 
moves the sourcing request and its associated purchase lines to the Qualification Needed state. 
Alternatively, updating the negotiated unit cost on any of the purchase lines within the sourcing 
request automatically triggers the qualification flow on the sourcing request. Closing the cases 
moves them to the Qualified state, and readies the sourcing request for awarding.

Note:  If a sourcing request is raised with qualified suppliers, qualification cases aren't 
created and the sourcing request is directly moved to the Qualified state.

When working within a negotiation or sourcing event that has an associated sourcing request, 
the supplier qualification flow is automatically initiated, and qualification cases are created for 
the negotiation or sourcing event respectively. Closing these cases moves the sourcing event 
and all its associated sourcing requests, negotiations, and purchase lines to the Qualified state, 
and readies the sourcing requests for awarding. All state changes are displayed in the activity 
streams of the respective records. You can use the activity stream to track your negotiations with 
your suppliers, from start to end.

Note:  If the qualification event had been started for a sourcing request, and cases had 
been created on the sourcing request before it was mapped to a negotiation or negotiation 
event, and there’s an overlap in cases, then previously created cases on the sourcing 
request are automatically closed and the new cases created for the negotiation or sourcing 
event are retained.

Process Automation Designer flows for playbook

The Source-to-Pay Workspace  helps you automate the entire process, right from tracking the 
requests, fulfillment, and to order revision flows.

As a process owner or administrator, you can use Playbooks  to enable cross-enterprise 
workflows and create a task-oriented view:

• Optimize the processes and improve the productivity with the help of the procurement 
workspace playbook.

• Manage easy tracking of the requests and use the guided approval and resolution flows.

• Perform complex activities and tasks from a simplified unified playbook.

Source-to-Pay Workspace  playbook

This playbook comes with a Global Playbook Experience record that defines a default playbook 
configuration. You can use the following record without any additional configurations. By default, 
this record defines a set of rules for managing how individual activities appear within the 
playbook.
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Playbooks  playbook flows for procurement

You can customize this behavior by customizing the Playbook experience with your own 
configurations and activity overrides.

Related topics

Playbooks  

Email notifications from Playbook

Several email notifications are triggered from Playbook. This may be a result of your action, an 
assignment for you, or to keep you updated on the status of your purchases, including purchase 
revisions.

Playbook sends out emails in a predefined template and uses flow designer to trigger the 
different email conditions. You can use the deep links that are provided in the emails to view 
relevant details. You’re notified through email when:

• Your request to edit a purchase order or purchase requisition has been confirmed.

• Your request to edit a purchase order or purchase requisition has been rejected.

• Your request to cancel a service request, purchase order, purchase requisition, purchase order 
line, or purchase requisition line has been confirmed.

Note:  You receive one email notification if you cancel from the header level. However, 
cancellation at line levels triggers respective email notifications.

• Your request to cancel a service request, purchase order, purchase requisition, purchase order 
line, or purchase requisition line has been rejected.

• Your request to return a product has been confirmed.

• Your request to return a product has been rejected.

Note:  You can adjust the email trigger conditions and content in flow designer or email 
scripts, if necessary. You can also choose to fetch and use other details that aren’t 
displayed in the email by default, such as order type for purchase requisitions, product 
type or request type for sourcing requests, and so on. For detailed information on email 
templates and how to work with them, see Email templates . You can also configure the 
email layout, and change the background color or font color, for example. The html field in 
the email layout record must be modified to achieve this. For detailed information on email 
layouts and how to work with them, see Email layouts .
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Email composer with quick messages and response templates in Source-to-Pay Workspace

Insert predefined content into the message body of emails that you send from the email client in 
Source-to-Pay Workspace.

You can use this feature to send emails for all procurement objects, which include purchase 
requisitions, sourcing requests, negotiations, sourcing events, procurement cases, and tasks. 
To open the email client, select Compose Email  from the More Actions icon on the procurement 
object. A draft email appears with pre-populated data in the To, Subject, and email body fields.

Using quick messages

In the email client, you can select a quick message to fill the email body with the content that 
is specified in the quick message. After you define one or more quick messages, the Quick 
Messages contextual pane appears in the email client so that you can draft an email with a 
quick message of your choice. For Sourcing and Procurement Operations, Disclaimer is the only 
default quick message provided.

On selecting Insert, the quick message content is inserted at the place of the cursor. It doesn't 
replace the content that you created before selecting the quick message. To replace existing 
content with a quick message, highlight the text to replace and then select a quick message.

Creating quick message content

Define quick messages by creating records in the Email Client Canned Messages 
[sys_email_canned_message] table.

When you define a quick message, you can add any of the following types of content into the 
message body:

• Icons

• Logos

• Images

• Rich-text HTML

• Hyperlinks

• Variables

• Any other HTML constructs

Assign the email_client_quick_message_author role to business managers so that they can 
create quick messages for users in their group.

For more information on how to create a quick message, see Define a quick message .

Using response templates

Resolve cases faster and more efficiently with response templates. Response templates are 
reusable messages that can be copied to draft emails to provide quick and consistent messages 
to users. Each template is associated with a table that is an extension of the Task [task] or 
Interaction [interaction] table. Response templates include a short name for specifying a shortcut 
that can be used to identify the message.

Open the response template that you want to use for your email and select Copy to clipboard. 
You can now paste the contents of this template at the place of the cursor. It doesn't replace the 
content that you created before selecting the response template. To replace existing content with 
a response template content, highlight the text to replace and then select a response template.
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By default, the following response templates are provided for these standard procurement 
objects:

• Procurement case: Standard closure response, procurement contacts, policy instructions, and 
additional information.

• Purchase requisition: Placing of purchase order is in process, procurement contacts, and 
policy instructions.

• Sourcing request: Placing of purchase order is in process, procurement contacts, and policy 
instructions.

• Negotiation: Procurement contacts, and policy instructions.

• Sourcing event: Procurement contacts, and policy instructions.

• Task: Procurement contacts, and policy instructions.

While users with the response template reader [sn_templated_snip.template_snippet_reader] 
role can only read response template content, those with the response template writer 
[sn_templated_snip.template_snippet_writer] role can read, create, update, and delete response 
template content.

For more information on how to work with response templates, see Create or modify a response 
template .

Emailed message in activity log

After your email is composed, sent, and most importantly received by the intended recipient, 
you can see the email message in the Activity  section of the procurement object record. You 
can continue to work with this email from the activity log by replying to or forwarding the email as 
required.

Email composer setup configurations

To view email composer and all its associated features, which include viewing your emailed 
message in the activity log, verify that you have the following configurations in place:

• Sent email should be in Received state, for the email log to show up in the activity stream of 
the procurement object.

• The formatter update of the activity stream of the procurement objects should have the Emails 
- autogenerated  and Emails - correspondence  formats applied.

• The Email client attribute should be updated to the procurement object type, for the email 
composer feature to be enabled for that object.

• The email_composer role should be added as a contained role for the base fulfiller or agent 
[sn_spend_sdc.agent] role, for the user to view the email composer feature.

• The response template reader [sn_templated_snip.template_snippet_reader] role should be 
added for the user to view the response template feature.

Agent assist  in Source-to-Pay Workspace

Agent assist  in Source-to-Pay Workspace  automatically displays relevant search results based 
on the search text, which is defaulted with the short description of the procurement case you’re 
working on. You can edit the search text as required. These search results help you to work on 
the record.

Agent assist  is part of the contextual side panel in Source-to-Pay Workspace. By default, it 
displays knowledge articles as a resource, but can also display associated suppliers for a record 
if you select the resource as Suppliers.
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For Sourcing and Procurement Operations, Agent assist  is configured for the following 
procurement objects:

• Purchase requisition

• Sourcing request

• Negotiation

• Sourcing event

For information on how Agent assist  is set up and configured on the ServiceNow AI Platform, see 
Configure a record page for a workspace in Workspace Builder .

Interaction Management  in Source-to-Pay Workspace

Interactions are a centralized location for all communication channels available in Source-to-
Pay Workspace. Interaction Management  involves managing procurement related queries from 
different sources such as an email, chat, message, or SMS.

Interaction Management  overview

Any procurement related assistance that a procurement specialist or a live agent provides to a 
shopper in the form of a call, chat, email, or SMS is recorded in an interaction record.

Also, any supplier-related assistance that a supplier manager or a live agent provides to a 
supplier contact in the form of a call, chat, email, or SMS is recorded in an interaction record.

For more information about Interaction Management, see .

Interaction Management  activities in Source-to-Pay Workspace  include:

• View interaction details in Source-to-Pay Workspace

• Create a procurement case

• Associate a record with an interaction

View interaction details in Source-to-Pay Workspace

View the details of an interaction record to analyze interactions and take immediate actions. 
Viewing an interaction record provides a comprehensive view of the customer journey. You can 
link an interaction record to an existing procurement case or can assign a task, which needs a 
procurement specialist involvement for investigation.

Before you begin
Role required: Procurement specialist, agent

Procedure

1. Navigate to All  > Procurement Case Management.

2. Select the List icon ( ) and select Interactions  >All.

3. View interactions in the desired category to associate a record with a procurement case or a 
task.

• Assigned to me- Interactions assigned to a user

• Active-Interactions ready to be investigated

• All- All interactions
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4. Select an interaction record to view its details.

Details form

Field Description

Number System-generated unique interaction number

Type Mode of interaction

State Status of the record

Opened for The virtual agent name

Assigned to The virtual agent assigned to the interaction 
record

Transcript Text record of the conversation between an 
agent and the customer

5. Optional:  View the procurement cases assigned to an interaction record by accessing the 
Related tasks  tab.

6. Optional:  View information about the assigned virtual agent, attachments added to the 
interaction, and templates for use in the contextual side panel.

Associate an interaction record with a related procurement case in Source-to-Pay Workspace

Associate an interaction record to a procurement case if your interaction is related to an existing 
procurement case. You can also associate a task to an interaction record to track your actions 
related to the interaction.

Before you begin
Role required: Live agent, Procurement specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select Interactions  >All.

3. Search for an interaction record using the interaction ID from the list of records.

4. Associate a record with an existing procurement case.

a. Select More Actions option and then select Associate record.

b. On the form, fill in the fields.

Associate record form

Field Description

Interaction System-generated interaction number.

Record Type Type of record created for a task or 
knowledge topic. By default, this task is 
auto-populated.

Document table Unique table name of the procurement case.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

484



Field Description

Task Procurement task that you want to associate 
to an interaction record.

Note:  The ID of the related record 
auto-populates when the table name is 
provided in the Document table  field.

5. Select Save.

Result
The interaction record is updated with its associated procurement case.

Procurement Case Management  Dashboard

The Procurement Case Management  Dashboard helps you to track, analyze, and manage your 
procurement services.

View and track your open requests, by type, department, or knowledge article views.

You can access this dashboard by navigating to All  > Platform Analytics Workspace  > Analytics 
Center  > Dashboards.

For a detailed analysis on each component, select the respective widget or chart.

Title Type Description

Open Procurement Cases by 
Type

Bar chart Track the total requests 
open for each type and plan 
fulfillment.

Procurement Cases Cycle 
Time - Last 3 Months

Stacked bar chart Use the metrics to determine 
the cycle time of your open 
procurement cases, grouped 
by case type or assigned to, 
within the last three months.

Open Procurement Cases by 
Department

Bar chart View the requests from each 
department.

Open Procurement Cases List Sort, open, and manage the 
open requests from a central 
place.

Procurement Knowledge 
Article Views - Last 3 Months

Stacked bar chart Use the metrics to determine 
the usefulness of your topics 
and identify the articles that 
need improvement, within the 
last three months.

For information on how to work with dashboards in configurable workspaces, see Dashboards in 
Platform Analytics .

For information on how to work with widgets and data visualizations in configurable workspaces, 
see Data visualizations in Platform Analytics .
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Record producers and catalogs in the procurement workflow

Record producers and catalogs ensure the accuracy and availability of the required items in the 
procurement workflow and standardize the request fulfillment.

Record producers

As a procurement administrator or procurement manager, you can create a record producer 
for tables and database views that are in the same scope and define the procurement-specific 
records and standardize the procurement workflows. To set up record producers, perform the 
following steps:

• Create a new record producer for the Procurement Case Management  application.

• Assign a table name as a procurement case.

• Select Procurement  as the target catalog under Accessibility  > Catalogs.

• Select Procurement  under Accessibility  > Category.

Catalogs and catalog items

Catalog and catalog items ensure the accuracy and availability of the required items in the 
procurement workflow and standardize the request fulfillment. To set up catalogs, perform the 
following steps:

• Create procurement-related catalog and catalog items.

• View the existing catalog items.

• Manage your category hierarchy.

• Associate the categories within your catalog.

Related topics

Service catalog categories

Record Producer

Source-to-Pay Workspace

As a Procurement Specialist, you can easily complete your actionable tasks within the premises 
of an enhanced user experience with Source-to-Pay Workspace.

The Source-to-Pay Workspace  application provides experiences and tools for a Procurement 
Specialist to source, negotiate, and procure the goods and services that an organization 
requires. It also enables them to address and work on tasks related to procurement.

The Source-to-Pay Workspace  application is a dependent application and is automatically 
installed if any of the following applications are installed:

• Source-to-Pay Common Architecture

• Procurement Case Management

However, if you wish to install just the Source-to-Pay Workspace  application, the dependent 
application Procurement Case Management  is also installed along with.
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End user and roles

End user and goal Required role

Procurement Specialist: View your open 
requests and purchasing to-dos.

sn_shop.procurement_specialist

PCM Agent: View your open requests and 
purchasing to-dos.

sn_spend_psd.agent

Accounts Payable Specialist: View your open 
requests and purchasing to-dos.

Note:  This role contains the PCM Agent 
role, and therefore has access to the 
same home page and modules as the 
PCM Agent.

sn_shop.accounts_payable_specialist

Admin role for Canvas Core Application: 
View and make configuration changes to the 
widgets.

canvas_admin

Spend and Savings Management

Category management is a strategic procurement approach that involves managing a group 
of related products or services to maximize value, optimize costs, and enhance supplier 
relationships. Essentially, it’s the structured management of category taxonomy, ensuring that 
goods and services are categorized, sourced, and managed efficiently to drive better decision-
making and operational efficiency.

The Spend and Savings Management (sn_spend_mgmt) feature enables category managers 
to import and manage their organization's category taxonomy. By incorporating this taxonomy 
into the ServiceNow system, category managers can streamline procurement processes, track 
spending, and evaluate savings more effectively at the category level.

Important:  Check your entitlements to determine whether you have access to Spend 
and Savings Management.

The Spend and Savings Management application offers the following key benefits:

• Cost optimization: Analyze spending across categories to identify areas for cost reduction 
through better supplier negotiations, volume discounts, and contract optimization.

• Improved visibility: Categorize spend to gain insights into where money is being spent, 
enabling better decision-making and control over expenses.

• Strategic sourcing: Consolidate spend within specific categories to achieve better pricing and 
terms with suppliers.

• Risk management: Identify potential supplier risks early on by closely monitoring spend within 
categories and ensuring compliance with regulatory requirements.

• Enhanced procurement efficiency: Streamline the procurement process by focusing on key 
categories, reducing unnecessary administrative tasks.
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• Data-driven decision making: Use data analytics to identify trends and make informed 
procurement decisions based on category performance.

• AI-driven savings discovery: Use AI agents to automatically scan contracts, spend, and 
supplier data on a recurring schedule to surface ranked savings opportunities for category 
managers to review and act on.

For more information about using Spend and Savings Management, see Using Spend and 
Savings Management.

For more information about how AI agents identify savings opportunities across contracts, 
spend, and supplier data, see Savings opportunity identification.

Required role

Category manager admin (sn_spend_mgmt.category_manager_admin): Can import the category 
taxonomy and update the Spend Category and Spend Category Stage tables.

Tables installed

Spend category stage tables

Table Description

Spend Category

(sn_spend_mgmt_category)

Stores data about spend categories.

Spend Category Stage

(sn_spend_mgmt_category_stage)
Temporarily stores important data about spend 
categories before this data is sent to the Spend 
Category (sn_spend_mgmt_category) primary table.

Spend to Product Category Mapping

(sn_spend_mgmt_m2m_spend_product)

Stores the mapping of spend categories to product 
categories.

Components installed with Spend and Savings Management

Several types of components are installed with activation of the Spend and Savings 
Management  (sn_spend_mgmt) plugin, including user roles and tables.

Roles installed

Role title [name] Description Contains roles

sn_spend_mgmt.category_manager_admin Can import 
the category 
taxonomy, 
update 
the Spend 
Category 
and Spend 
Category 
Stage tables 
and update 
the Spend 

None
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Role title [name] Description Contains roles

category 
to Product 
category 
mappings.

sn_spend_mgmt.sourcing_category_manager Can view 
and access 
the Category 
Management 
workspace 
tab and the 
Savings 
dashboard 
in Spend 
and Savings 
Management.

sn_shop.procurement_specialist

Tables installed

Table Description

Spend Category

(sn_spend_mgmt_category)

Stores data about spend categories.

Spend Category Stage

(sn_spend_mgmt_category_stage)

Temporarily stores important data about spend 
categories before this data is sent to the Spend 
Category (sn_spend_mgmt_category) primary table.

Extends the Import Set Row (sys_import_set_row) 
table.

Spend to Product Category Mapping

(sn_spend_mgmt_m2m_spend_product)

Stores the mapping of spend categories to product 
categories.

Category management tab

The Category management tab provides a unified, filter-driven view of category performance 
across spend, savings, pipeline projects, contracts, purchase orders, and suppliers.

To view the Category Management tab in the Source-to-Pay Workspace, you must have the 
sn_spend_mgmt.sourcing_category_manager role and have the following applications installed:

• Spend and Savings Management  (sn_spend_mgmt)

• Sourcing Pipeline Management  (sn_spend_pipeline)

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

489



Category management tab

Components in the Category management tab

Components in Category management tab

Title Type Description

Global filters

Global filters Filter You can filter the data using the following filter 
types and sources:

• Date: Supports predefined ranges (for 
example, Last 3 months, Last 6 months, Last 
month, Last year, This year, YTD) and custom 
date ranges.

• Category: Multi-select drop-down list 
populated from the Spend category table.

• Supplier: Multi-select drop-down populated 
from the 'Supplier' table.

To apply a filter, select a filter type (for 
example, Supplier), and choose one or more 
filter values (such as Adobe Systems or Apple, 
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Components in Category management tab  (continued)

Title Type Description

Inc.), and then move the selected filter value 
from the Available list to the Applied list.

Overview

Total spend Single Score with Line 
graph

Displays total spend from all settled invoices 
for the selected time period, along with a trend 
line showing spend progression over time.

Note:  The spend data covers only the 
last 750 days. You can run the fix script 
and modify the period to retrieve spend 
data for their preferred date range.

Savings Bar graph Displays the savings amount (planned, 
realized, active) for all pipeline projects for the 
selected time period.

Note:  Displays the savings score based 
on the annualized data provided on the 
pipeline object. When calculating each 
pipeline project’s savings, the dashboard 
considers the overlap between the 
selected date-range filter and the 
project’s start and end dates.

Pipeline projects by 
type

Ring chart Displays the pipeline projects by the following 
type for the selected time period:

• Supplier optimization

• Contract optimization

• Savings potential

• Spend optimization

• Risk reduction

Contracts

Expiring within 180 
days

Single score Contracts with end dates within the next 180 
days.

Auto-renewing within 
90 days

Single score Contracts with auto-renew flag set to true and 
renewal due in 90 days.

Unconsolidated 
spend

Single score Contracts with the same suppliers for different 
business owners or purchasing entity.

Contracts List All contracts for the selected category.

When you create a pipeline project from the 
Contracts list by selecting Pipeline project 
> Create new  or Add to existing, the Project 
type  field in the Create New Pipeline Project 
form is automatically populated with Contract 
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Components in Category management tab  (continued)

Title Type Description

Optimization. You can view the contract details 
in the Associated Records section.

Note:  A contract record can be 
associated with only one active pipeline 
project record at a time.

Purchase order lines

Off-contract spend Single score POLs of POs where the contract field is null 
(no linked contract).

Non-preferred 
supplier spend

Single score POLs of POs with suppliers where Preferred 
flag is set to No.

Spend fragmentation Single score Same product procured from different 
suppliers.

Purchase order lines List POLs in the selected category.

When you create a pipeline project from the 
Purchase Orders list by selecting Pipeline 
project  > Create new  or Add to existing, the 
Project type  field in the Create New Pipeline 
Project form is automatically populated 
with Spend Optimization. You can view the 
purchase order details in the Associated 
Records section.

Note:  A purchase order line record 
can be associated with only one active 
pipeline project record at a time.

Suppliers

Total suppliers in this 
category

Single score Suppliers with performance score less than 
95%.

Note:  The widgets in the Suppliers 
section vary based on whether Third-
party Risk Management  or Supplier 
Lifecycle Operations  is installed.

Non-preferred 
suppliers

Single score Suppliers where Preferred flag is set to No.

New Suppliers Added Single score New suppliers added in the selected time 
period.

Suppliers List List of active suppliers.

When you create a pipeline project from the 
Suppliers list by selecting Pipeline project  > 
Create new  or Add to existing, the Project 
type  field in the Create New Pipeline Project 
form is automatically populated with Supplier 
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Components in Category management tab  (continued)

Title Type Description

Optimization. You can view the supplier details 
in the Associated Records section.

Note:  A supplier record can be 
associated with only one active pipeline 
project record at a time.

Category analytics

Within the Source-to-Pay Workspace, the Category analytics module includes the Savings 
dashboard that offers procurement teams a unified view of savings opportunities across the 
sourcing pipeline.

Open the Source-to-Pay Workspace  and select the Category Analytics icon ( ). The Category 
analytics module opens, displaying the Savings dashboard.

Users with th sn_spend_mgmt.sourcing_category_manager role can view and access the 
Savings dashboard in the Category analytics module.

Savings dashboard

The Savings dashboard provides procurement teams with a consolidated view of savings 
opportunities across all pipeline project data.

The Savings dashboard helps users analyze category performance, track potential and realized 
savings, and monitor project progress from opportunity identification through to savings 
realization.
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Savings dashboard

Components in the Savings dashboard

Components in Savings dashboard

Title Type Description

Filter by Filter You can filter the data using the following filter 
types and sources:

• Time: Supports predefined ranges (for 
example, Last month, Last year, This year, 
YTD) and custom date ranges.

Note:  The time filter considers all 
pipeline projects whose savings start 
date and savings end date overlap with 
the selected date range.

• Category: Multi-select drop-down list 
populated from the Spend category table.
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Components in Savings dashboard  (continued)

Title Type Description

Note:  If you do not select a category 
in the Category filter, the dashboard 
displays all data associated with 
the root categories. If you select a 
category, the dashboard displays 
data for that category and its child 
categories. In both cases, this data is 
displayed in the Hard savings, Cost 
avoidance, and Savings by year bar 
graphs.

• Business Unit: Multi-select drop-down list 
populated from the Business unit table.

• Supplier: Multi-select drop-down populated 
from the 'Supplier' table.

• Team member: Searchable multi-select 
drop-down list based on the spend category 
manager column in the Spend category 
table.

To apply a filter, select a filter type (for 
example, Supplier), and choose one or more 
filter values (such as Adobe Systems or Apple, 
Inc.), and then move the selected filter value 
from the Available list to the Applied list.

Realized savings Single score Total realized savings (hard savings, cost 
avoidance, and other savings) from all 
completed pipeline projects.

Hard savings Single score Total hard savings from all the completed 
pipeline projects.

Cost avoidance Single score Total cost avoidance from all the completed 
pipeline projects.

Planned savings Single score
Total estimated savings (estimated hard 
savings + estimated cost avoidance) from all 
planned pipeline projects.

Active savings Single score
Total estimated savings (estimated hard 
savings + estimated cost avoidance) from all 
pipeline projects that are in progress.

Pipeline savings Bar graph Displays planned, realized, and active savings 
for the date range selected in the filter.

Hard savings Bar graph Displays hard savings for closed projects, 
grouped by category.
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Components in Savings dashboard  (continued)

Title Type Description

Cost avoidance Bar graph Displays cost avoidance savings for closed 
projects, grouped by category.

Savings by year Bar graph Displays year-over-year realized savings, 
grouped by category.

Pipeline projects in 
progress

Ring chart Displays count of in-progress pipeline 
projects, segmented by spend category.

Pipeline projects by 
state

Ring chart Displays count of projects segmented by state 
(Draft, Planned, Work in Progress, Closed 
Complete).

Savings opportunity identification

The Savings Opportunity Discovery agentic workflow automatically scans contracts, spend, 
and supplier data to surface ranked savings opportunities, helping category managers focus on 
review and action rather than manual discovery.

The Savings Opportunity Discovery agentic workflow scans contracts, spend, and supplier data 
on a recurring schedule and writes ranked savings opportunities to the Savings Opportunities 
(sn_spend_gen_ai_savings_opportunities) table. An AI orchestrator triggers 
three optimization sub-agents in parallel, normalizes the results, and surfaces findings for 
category managers to review. Each opportunity carries an estimated savings value, a complexity 
assessment, and supporting insights. Category managers see only the opportunities tied to 
spend categories they own.

Potential savings opportunities

Plugin dependencies

The following plugins are required to use the Savings Opportunity Discovery agentic workflow:
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• Now Assist for Sourcing and Procurement Operations (SPO) (sn_spend_gen_ai)

• Sourcing Pipeline Management (sn_spend_pipeline)

• Spend and Savings Management (sn_spend_mgmt)

Business value

Category managers have historically relied on manual reviews of contracts, spend, and supplier 
data to identify sourcing opportunities. The process is inconsistent across categories and time-
consuming, so opportunities are missed or surfaced too late to act on. Scheduled, agent-based 
identification produces consistent output for every spend category and lets the team focus 
attention on review, simulation, and action rather than discovery.

Savings lever framework

Each opportunity is associated with a savings lever that describes the specific source of savings. 
Levers currently supported include renewal caps, price escalations, payment terms, off-contract 
spend, unconsolidated spend, supplier consolidation, and non-preferred supplier spend. The 
framework supports additional levers without changes to the user-facing review surface.

Savings Opportunity Discovery agentic workflow

Savings Opportunity Discovery agentic workflow contains three Opportunity Finder agents.

Opportunity Finder agents

Agent Analyzes Savings levers covered

Contract 
Optimization 
Opportunity 
Finder Agent

Extracts contract clauses, including 
escalation percentages, renewal caps, and 
payment terms, and forecasts future spend 
under the existing terms.

Price Escalations & Renewal 
Caps; Payment Terms 
Optimization

Supplier 
Optimization 
Opportunity 
Finder Agent

Analyzes supplier spend for fragmentation 
across suppliers and for spend with non-
preferred suppliers.

Non-preferred Supplier Spend; 
Unconsolidated Spend; Spend 
Fragmentation; supplier 
performance and risk

Spend 
Optimization 
Opportunity 
Finder Agent

Analyzes purchase order activity for off-
contract spend, unconsolidated spend, and 
other spend-side levers.

Off-Contract Spend; Contract 
Leakage

The Savings Opportunity Finder Agents Scheduled Job runs the agents weekly. You can also run 
this scheduled job on-demand by entering sysauto.list  in the navigation filter. Search for 
and open the Savings Opportunity Finder Agents Scheduled Job, and then select Execute Now.

When the Savings Opportunity Finder Agents Scheduled Job runs, the Savings Opportunity 
Discovery agentic workflow uses all three agents and scans procurement data across contracts, 
suppliers, and purchase order lines and creates records on the Savings Opportunities table 
(sn_spend_gen_ai_savings_opportunities).

Each opportunity record contains an estimated opportunity value, a savings lever, a confidence 
score, supporting data, and links to the suppliers, spend categories, and contracts the analysis 
drew from. Category managers review the opportunities, accept or dismiss them, and convert 
accepted opportunities into pipeline projects for tracking.
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For more information about the fields on a savings opportunity record, see Savings opportunity 
fields.

Opportunity lifecycle

Each run generates new opportunities and reconciles existing ones according to the current 
state of the record:

• An open opportunity that has not yet been acted upon is updated in place when its underlying 
data changes. For example, when new closed purchase order lines change the estimated 
savings.

• A dismissed opportunity can reappear if fresh data changes the estimate enough to invalidate 
the original dismissal.

• A closed opportunity for which a pipeline project has been created is not re-created. For 
spend and supplier optimization, the next run can create a delta opportunity that reflects only 
the new data since the original was actioned.

Decision and action flow

Opportunities appear in two places in the Source-to-Pay Workspace: a unified Potential 
savings opportunities  page that lists every opportunity accessible to the signed-in user, and a 
Category Management  tab scoped to the spend category in context. From either entry point, 
the user opens the Now Assist  Panel by selecting Learn more  for a single opportunity to review 
supporting insights, ask clarifying questions, run simulations, and either action or dismiss the 
opportunity.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

498



Category Management tab showing Potential savings opportunities section

When an opportunity is presented, the category manager can:

• Open the opportunity in the Now Assist  Panel to review details, ask follow-up questions, and 
simulate alternative values.

• Act on the opportunity by creating a pipeline project with key fields prefilled from the 
opportunity.

• Dismiss the opportunity with one or more reasons selected from a checklist.

Acted and dismissed decisions are captured as feedback to improve future opportunity 
generation.

For more information about actioning or dismissing a savings opportunity, see Action or dismiss 
a savings opportunity.

Roles and access

Access to savings opportunity records is governed by the following roles:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

499



• sn_spend_mgmt.sourcing_category_manager: Read access to the Savings Opportunities 
(sn_spend_gen_ai_savings_opportunities) table and records.

• sn_spend_mgmt.category_manager_admin: Write access to opportunity records, and read and 
write access to the sn_spend_gen_ai.savings_opportunity.cost_of_capital 
system property.

Supplier optimization savings opportunities

The Supplier Optimization Opportunity Finder Agent identifies spend placed with non-preferred 
suppliers and fragmented across multiple suppliers for similar products. Addressing these 
opportunities helps redirect spend to preferred sources and consolidate supplier relationships.

The Supplier Optimization Opportunity Finder Agent analyzes supplier spend patterns to detect 
two types of savings opportunity: spend placed with non-preferred suppliers when a preferred 
alternative exists, and spend fragmented across multiple suppliers for similar products within 
the same spend category. Both levers use product similarity matching to identify consolidation 
opportunities.

Non-preferred supplier spend opportunities

A non-preferred supplier is a supplier that has not been designated as preferred for its spend 
category. Spend placed with non-preferred suppliers can reduce negotiated savings and weaken 
supplier governance. The agent identifies cases where the same or a closely related product is 
being purchased from a non-preferred supplier when a preferred alternative exists.

The agent processes purchase order lines where the supplier is not marked as preferred for the 
relevant spend category. The agent groups activity by supplier, spend category, and product, 
then attempts to match each non-preferred grouping to a preferred supplier that offers the same 
or a closely related product. Product similarity is determined by comparing product attributes 
and descriptions, including both direct matches and semantically related items in the same 
spend category.

To avoid reprocessing every purchase order on each run, the agent tracks the date of the last run 
and processes only purchase order lines updated after that date. Deduplication based on spend 
category, supplier, and savings lever prevents the agent from generating a duplicate opportunity 
for the same finding on subsequent runs.

A non-preferred supplier opportunity captures the following information:

• The non-preferred supplier and the spend category where the activity was detected.

• The identified preferred supplier for the same or related products.

• The purchase order lines that contributed to the finding.

• The estimated savings from redirecting future purchases to the preferred supplier.

Spend fragmentation opportunities

Spend fragmentation occurs when an organization buys similar products or services from 
multiple suppliers within the same spend category. The agent detects these patterns and 
identifies opportunities to consolidate purchases to fewer suppliers to negotiate better pricing 
and reduce supplier management overhead.

The agent groups historical spend by spend category and checks for cases where similar goods 
or services are being purchased from multiple suppliers in the same category. Product similarity 
is determined by comparing product attributes and descriptions. For each fragmented group, the 
agent calculates the potential savings if the spend is consolidated under the supplier offering 
the most favorable terms in the category.
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The agent applies deduplication so that repeated weekly runs do not create a separate 
opportunity for the same fragmentation pattern. If new purchase activity changes the savings 
estimate, the existing open opportunity is updated rather than duplicated.

A spend fragmentation opportunity captures the following information:

• The spend category and the suppliers identified in the fragmented spend pattern.

• The amount of spend distributed across the multiple suppliers.

• The estimated savings from consolidating spend to the identified supplier.

• The currency used in the calculation, which reflects the session currency at the time the agent 
runs, with USD used when no session currency is available.

When you create a pipeline project from a spend fragmentation opportunity, the linked suppliers 
are attached to the project so that the sourcing team can reference the source evidence during 
supplier consolidation discussions.

Spend optimization savings opportunities

Spend Optimization Opportunity Finder Agent identifies opportunities where purchase activity 
is outside negotiated contracts or fragmented across multiple contracts. Addressing these 
opportunities helps redirect spend to contracted pricing and increase purchasing volume for 
negotiation.

Spend Optimization Opportunity Finder Agent analyzes purchase order activity from the 
preceding 12 months to detect patterns where spend is either outside contracted sources or 
spread across multiple contracts for the same supplier and product. The agent supports two 
savings levers: off-contract spend and unconsolidated spend.

Off-contract spend opportunities

Off-contract spend refers to purchases made without using a negotiated contract, often at prices 
higher than the contracted rate. The agent identifies categories and products where off-contract 
spend exists alongside on-contract spend so that sourcing teams can redirect future purchases 
to the contracted source.

The agent examines closed-paid and closed-released purchase order lines and determines 
whether each purchase was on-contract by matching against contract-to-purchase-order 
relationships and date ranges. The agent groups activity by supplier, spend category, and 
product, then separates on-contract activity from off-contract activity. For each grouping that 
contains both, the agent calculates the discount missed by buying off-contract and the potential 
savings from redirecting that spend to the contracted price.

For services, the agent normalizes the contract value over the duration of the service to derive a 
daily rate, which is then used when comparing on-contract and off-contract pricing. Rebates are 
not included in the savings estimate.

An off-contract spend opportunity captures the following information:

• The supplier and the spend category where off-contract activity was detected.

• The on-contract and off-contract purchase order lines that contributed to the finding.

• The estimated savings from moving the off-contract spend to the contracted price.

If a category, supplier, or product has only off-contract activity and no comparable on-contract 
activity, the agent does not generate an opportunity. A reference price is required to calculate the 
potential savings.
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Unconsolidated spend opportunities

Unconsolidated spend refers to purchases of the same or similar products or services placed 
across multiple contracts or business units with the same supplier. When these purchases are 
aggregated, the resulting volume can support negotiating a lower per-unit price or improved 
contract terms.

The agent examines purchase order lines from the preceding 12 months and groups activity by 
supplier, business unit, and product. The agent identifies cases where the same supplier delivers 
similar products across different contracts at different prices, then compares the actual prices 
paid against the lowest contracted price for the same or closely related product. The difference 
represents the potential savings from consolidating future purchases under the lower-priced 
contract.

An unconsolidated spend opportunity captures the following information:

• The supplier and the spend categories where the fragmentation was detected.

• The contracts and purchase order lines that contributed to the finding.

• The baseline spend and the estimated savings from consolidation.

• A complexity rating that reflects the number of source records involved.

When you act on an unconsolidated spend opportunity, the linked purchase orders are attached 
to the draft pipeline project under the Previous purchase orders related list so that sourcing 
teams can include the source evidence into the next negotiation.

If a grouping does not include enough recent activity, if the products cannot be matched as 
similar, or if there is no lower-priced contract available for comparison, the agent does not create 
an opportunity for that grouping. No administrator-configurable spend or volume thresholds 
apply.

Contract optimization savings opportunities

The Contract Optimization Opportunity Finder Agent identifies opportunities to reduce costs by 
renegotiating price escalations, renewal caps, and payment terms on supplier contracts.

The Contract Optimization Opportunity Finder Agent analyzes supplier contracts that have 
an attached document to extract clause-level data and identify opportunities to reduce future 
spend. Two savings levers are currently supported: price escalation and renewal caps, and 
payment terms. For each lever, the agent calculates the savings available from renegotiating the 
existing terms and displays the finding as a savings opportunity .

Price escalation and renewal cap opportunities

Many supplier contracts include clauses that allow the supplier to increase prices each year or 
at each renewal. Over multi-year terms, even small escalation percentages can compound into 
significant additional spend. The agent identifies contracts where renegotiating the escalation or 
renewal cap can produce measurable savings.

For each in-scope contract, the agent forecasts contracted spend under the current escalation 
clause and models an alternative scenario where the escalation is reduced. The default 
alternative scenario applies a 25 percent reduction relative to the original escalation percentage. 
This reduction is fixed and is not configurable.

The forecast period is derived from the contract validity or payment terms. If the contract 
document does not provide a duration, the agent defaults the forecast period to one year.

The agent calculates the cumulative difference between the baseline forecast and the 
negotiated forecast over the forecast period. For example, a contract with a $20M annual 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

502



baseline and a 7 percent annual escalation produces a 3-year forecast of $64.3M. Reducing the 
escalation to 3 percent produces a forecast of $61.8M. The cumulative savings of $2.5M is the 
value shown on the opportunity.

A price escalation or renewal cap opportunity captures the following information:

• The contract analyzed and the supplier on the contract.

• The current escalation percentage extracted from the contract document.

• The proposed renegotiated escalation or renewal cap.

• The cumulative estimated savings over the forecast period.

• The contracts linked as source records for the eventual pipeline project.

When you act on the opportunity, the linked contract is attached to the draft pipeline project as a 
previous contract so that the sourcing team can carry the source evidence into renegotiation.

Payment terms opportunities

Payment terms set the timing of supplier invoice payments, such as Net 30 or Net 60. Extending 
payment windows or capturing early payment discounts can improve working capital. The agent 
analyzes contract clauses and historical payment data to identify contracts where these levers 
can produce financial benefit.

For contracts that have an attached document, the agent extracts the existing payment terms 
and any early payment discount clauses. The agent compares the current payment window 
against an extended window (typically 30 days longer) and calculates the working capital benefit 
using a configurable treasury rate. Where an early payment discount clause exists, the agent also 
models the savings from taking the discount.

The agent uses a configurable treasury rate, also called cost of capital, to estimate 
the value of extending payment windows. The rate is stored in the system property 
sn_spend_gen_ai.savings_opportunity.cost_of_capital 
(default value: 9 , expressed as a percentage). An administrator with the 
sn_spend_mgmt.category_manager_admin role can read and update this property.

If the remaining contract validity is less than one year, the agent prorates the savings estimate to 
reflect the actual time remaining on the contract.

A payment terms opportunity captures the following information:

• The contract analyzed and the supplier on the contract.

• The existing payment terms and the proposed extended payment terms.

• The early payment discount terms when present in the contract clauses.

• The estimated annual savings from the proposed change, calculated using the configured 
treasury rate.

Sourcing Pipeline Management

Sourcing Pipeline Management  (sn_spend_pipeline) provides a centralized framework for 
creating, tracking, and executing sourcing initiatives through pipeline projects. It enhances 
efficiency through automated workflows, improves visibility into project progress, and simplifies 
savings tracking and forecasting.

Sourcing Managers gain access to a unified pipeline project workspace that consolidates 
sourcing events, negotiations, and contract management. Each pipeline project includes 
dedicated tabs for these components, along with UI actions to initiate them directly. All related 
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work, including sourcing requests, is consolidated within the pipeline, providing complete, end-
to-end visibility into sourcing activities.

Important:  Check your entitlements to determine whether you have access to Sourcing 
Pipeline Management.

With the pipeline_management_admin role, you can configure the Pipeline project creation 
rule decision table to automate the creation of pipeline projects. The default pipeline project 
creation rule automatically creates a pipeline project when the total price of the products being 
sourced exceeds $250,000. When a sourcing intake request is submitted, a pipeline project is 
automatically created in the Draft state when the rule conditions are met. The pipeline project is 
associated with the sourcing request.

For more information about using Sourcing Pipeline Management, see Using Sourcing Pipeline 
Management.

Plugin requirements

Required plugin and dependency:

• Required plugin: Sourcing Pipeline Management  (sn_spend_pipeline)

• Plugin dependency: Spend and Savings Management  (sn_spend_mgmt)

Installing Sourcing Pipeline Management

Install the Sourcing Pipeline Management  application from the ServiceNow Store. For more 
information about installing an application from the ServiceNow Store, Install a ServiceNow Store 
application .

Viewing pipeline projects in the Source-to-Pay Workspace

You can view pipeline projects by navigating to the Lists  tab in the Source-to-Pay Workspace. 
Within this tab, pipeline projects are accessible through the Pipeline projects  sub-module under 
both the My work and All work modules. Additionally, you can access them via the Sourcing 
pipeline: new request  submodule under the Review needed module.

Fulfillers can view their assigned pipeline projects directly in the Work to review panel on the 
Source-to-Pay Workspace  landing page. Each pipeline project appears in a dedicated tile.

To filter and locate specific pipeline projects, fulfillers can use the All work types filter and select 
Pipeline project  from the drop-down list.

Fulfillers can view tasks related to pipeline projects in the Distribution of Work section of the 
Summary panel on the Source-to-Pay Workspace  workspace landing page. Pipeline projects also 
appear in the Recently updated section.

Components installed with Sourcing Pipeline Management

Several types of components are installed with activation of the Sourcing Pipeline Management 
(sn_spend_pipeline) plugin, including user roles and tables.

Roles installed

Role title [name] Description Contains roles

sn_spend_pipeline.pipeline_management_admin
Can configure the 
Pipeline project 

decision_table_admin
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Role title [name] Description Contains roles

creation rule 
decision table 
to automate the 
creation of pipeline 
projects.

sn_spend_pipeline.sourcing_pipeline_user
Can view and 
access the Pipeline 
Management 
workspace.

None

Tables installed

Table Description

Contract to Pipeline project Relationships

(sn_spend_pipeline_m2m_contract)

Stores the many-to-many relationships between 
contracts and pipeline projects.

Purchase order to Pipeline project 
Relationships

(sn_spend_pipeline_m2m_order)

Stores the many-to-many relationships between 
purchase orders and pipeline projects.

Purchase requisition to Pipeline project 
Relationships

(sn_spend_pipeline_m2m_requisition)

Stores the many-to-many relationships between 
purchase requisitions and pipeline projects.

Sourcing Request to Pipeline project 
Relationships

(sn_spend_pipeline_m2m_sourcing_request)

Stores the many-to-many relationships between 
sourcing requests and pipeline projects.

Supplier to Pipeline project Relationships

(sn_spend_pipeline_m2m_supplier)

Stores the many-to-many relationships between 
suppliers and pipeline projects.

Pipeline Project

(sn_spend_pipeline_project)

Stores the pipeline projects.

Extends the Task (task) table.

Pipeline project creation rule for high-value sourcing requests

By default, the Pipeline project creation rule decision table is used to create pipeline projects 
automatically in Sourcing Pipeline Management.

Note:  You must have the sn_spend_pipeline.pipeline_management_admin 
role to update the Pipeline project creation rule decision table configuration.

The sn_spend_pipeline.pipeline_management_admin  role contains the 
decision_table_admin  role, which enables you to create, read, edit, and delete 
decision table inputs, columns, and values. For more information about configuring 
decision tables, see Configuring decision tables .
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When a shopper requests pricing for items over $250,000 through Shopping Hub or via 
Employee Center  using the default "I need a product" record producer, specific decision inputs 
are triggered. If the shopper enters a budget greater than $250,000, the system automatically 
evaluates these decision inputs to apply the rule conditions:

• Sourcing request [sn_shop_sourcing_activity]

• Purchase line [sn_shop_purchase_line]

The Pipeline project creation rule is applied to the Budget  field in the Sourcing Request (SR). 
This rule determines whether a pipeline project should be created for the SR based on the 
following conditions:

• If the amount exceeds $250,000 USD, a pipeline project is created.

• If the amount is $250,000 USD or less, a pipeline project isn’t created.

Note:  The Budget  field controls the creation of pipeline projects based on the entered 
amount. If the currency is different from the USD, it's converted to USD before the rule 
conditions are applied.

Automatic pipeline project creation via Shopping Hub  or Employee Center  intake requests

When a shopper submits sourcing requests for products, pipeline projects are automatically 
created, provided the product price meets the budget conditions defined in the decision table.

By default, the budget threshold is set to $250,000. However, you can configure the budget 
conditions in the decision table to suit your business requirements. For more information, see 
Pipeline project creation rule for high-value sourcing requests.

If multiple sourcing requests are submitted for products that belong to the same spend category 
or the same sourcing manager, only a single pipeline project is created to group all those 
products.

Pipeline projects created automatically through sourcing intake requests are set to the Draft 
state.

Fields automatically populated in the pipeline project record

The following fields are automatically populated for pipeline project records created through an 
intake request:
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Field Description

Short 
description

• If the intake request results in a single sourcing request (SR), the short 
description follows this format:

PIPE00001 for <Product Name>

• If multiple SRs are created from the same intake request, the format is:

PIPE00001 Multiple requests for <Requestor Name>

Requestor Populated based on the value provided in the Who is this request for  field.

Number An auto-generated number that uniquely identifies the pipeline project.

Estimated 
end date

If multiple SRs have different delivery dates, the earliest delivery date is used as 
the estimated end date.

Spend 
category

Derived from the Product Category field using predefined spend category to 
product category mappings.

Note:  If the sourcing requests in a pipeline project have different spend 
categories, the Spend category  field is left blank. If the sourcing manager is 
the same across different spend categories, the requests are grouped into 
one pipeline project. In such cases, the Spend category  field is left blank.

Sourcing requests grouping logic

The following conditions determine how sourcing requests (SR) are grouped into pipeline 
projects.

Grouping logic Condition

Group SRs by spend 
category (if available)

• If an SR includes multiple products with different product categories, 
and category taxonomy is configured, then separate pipeline projects 
are created for each spend category.

• However, if the sourcing manager is the same for those spend 
categories, they’re grouped into one pipeline project. In this case, the 
Spend Category  field is left blank in the grouped pipeline project.

Group SRs without 
spend categories

• SRs that do not have a spend category are grouped into a single 
pipeline project.

• If four SRs are created from the same intake request, and three have 
spend categories while one doesn't, the one without is grouped with 
the others.

Spend category 
restrictions for adding 
SRs to a pipeline 
project

SRs can be added to an existing pipeline project in the following 
scenarios:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

507



Grouping logic Condition

• The spend category of the SRs matches with that of the pipeline 
project.

• The spend category is blank and not defined for the SRs.

• The SRs must be in either the Pending Review or Pending Approval 
state.

How pipeline project creation affects cancellation

The way a pipeline project is created determines when and how it can be canceled.

Pipe creation method Cancellation behavior

Auto-created pipeline 
projects from sourcing 
requests

If a pipeline project is auto-created from a sourcing request (SR), and 
that SR is later canceled, the pipeline project is also canceled but 
only in Draft state.

If the pipeline project has progressed to the Work in Progress (WIP) 
state, it isn’t canceled, even if the associated SR is canceled.

Manually created 
pipeline projects

For pipeline projects created manually from the List view, the project 
isn’t canceled even if the associated sourcing request is canceled.

For both auto-created 
and manually created 
pipeline projects

If all sourcing requests under a pipeline project are in Closed – 
Cancelled or Closed – Rejected state, the pipeline project also 
moves to the Closed – Cancelled state.

Email notifications for pipeline projects

Sourcing managers receive email notifications when a pipeline project is created automatically, 
and before its estimated start and end dates.

The email notification includes the View pipeline project  option that navigates the sourcing 
manager to the Source-to-Pay Workspace View, where they can access the pipeline project's 
Overview  tab.

System properties for Sourcing Pipeline Management

The following system properties are used by Sourcing Pipeline Management  to notify sourcing 
managers about upcoming pipeline project deadlines.

System property Description

sn_spend_pipeline.days_before_start.notification
Number of days before the estimated start 
date to trigger an email to the sourcing 
manager if the project is not in Work in 
Progress, Closed Complete, or Closed 
Canceled state.

sn_spend_pipeline.days_before_end.notification
Number of days before the estimated end 
date to trigger an email to the sourcing 
manager if the project is not in Closed 
Complete or Closed Canceled state.
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Note:  You must have the sn_spend_pipeline.pipeline_management_admin role to update 
the Value  field in the system properties. The Value  field defines the number of days before 
sending a notification email to the sourcing manager.

To access these properties, navigate to All  and enter sys_properties_list.do  in the 
application navigator. In the Name  search field, enter the property name to locate it.

Scheduled jobs

Sourcing and Pipeline Management includes the following scheduled jobs for 
sending email notifications:

• Trigger Pipeline Start Notification

• Trigger Pipeline End Notification

Business rules

Sourcing and Pipeline Management includes the Trigger pipe end or 
start notification  business rule, which runs in the following scenarios:

• When a pipeline project's estimated start date exceeds the value specified in 
the system property, the Trigger pipe end or start notification business rule runs. 
This business rule immediately sends email notifications to sourcing managers to 
keep them informed about project timelines. Email notifications are sent only for 
pipeline projects in the Draft or Planned state.

• When a pipeline project's estimated end date exceeds the value specified in the 
system property, the Trigger pipe end or start notification business rule runs. It 
immediately notifies sourcing managers via email. Email notifications are sent 
only for pipeline projects that are not in the Closed Complete or Closed Canceled 
state.

Pipeline management tab

The Pipeline management tab enables you to get insights into savings and pipeline projects, 
improving visibility, tracking, and collaboration across teams.

To view the Pipeline management tab in the Source-to-Pay Worksapce, you must have the 
pipeline_management_admin role and have the following applications installed:

• Spend and Savings Management  (sn_spend_mgmt)

• Sourcing Pipeline Management  (sn_spend_pipeline)
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Pipeline management tab

Components in the Pipeline management tab

Components in Pipeline management tab

Title Type Description

My work

New pipeline projects 
this week

Single score Displays the projects that are new this week 
and assigned to the logged-in user.

Pipeline projects 
starting withing 30 
days

Single score Displays the pipeline projects assigned to the 
logged-in user with an estimated start date 
due in 30 days or less.

Contracts expiring 
within 180 days

Single score Displays the contracts with an expiration date 
in 180 days or less, where the logged-in user is 
the contract administrator.

Active projects Ring chart Displays the active projects assigned to the 
logged-in user, excluding projects in the 
Closed completed or Closed cancelled states.

Active projects by 
priority

Bar graph Displays the projects by priority assigned to 
the logged-in user, excluding projects in the 
Closed completed or Closed cancelled states.

My pipeline projects List Displays a list of all active pipeline projects 
assigned to the logged-in user, sorted by 
priority and excluding projects in the Closed 
completed or Closed cancelled states.

My savings

Hard savings YTD Single score Displays the total hard savings from closed 
and completed pipeline projects assigned 
to the logged-in user, where the savings end 
date is greater than or equal to the current 
year.
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Components in Pipeline management tab  (continued)

Title Type Description

Note:  The My Savings section displays 
the savings scores calculated from the 
annualized data entered on the pipeline 
object.

Cost avoidance YTD Single score Sum of all the Cost avoidance on the Closed 
Completed pipeline projects assigned to the 
logged in user, where the savings end date is 
greater than or equal to the current year.

Planned savings - 
Current year

Single score Total estimated savings (estimated hard 
savings + estimated cost avoidance) from 
planned pipeline projects assigned to the 
logged-in user, where the estimated end date 
falls within the current year.

Active savings - 
Current year

Single score Displays the total estimated savings 
(estimated hard savings + estimated cost 
avoidance) from in-progress pipeline projects 
assigned to the logged-in user, where the 
estimated end date falls within the current 
year.

Understanding punchout

Punchout is a technology that connects a buyer’s eProcurement application directly to a 
supplier’s eCommerce site, enabling the buyer to browse products, build a cart, and then have 
the cart redirected into the buyer's procurement system for checkout.

Punchout enables an organization’s employees to shop on a supplier’s third-party eCommerce 
site. Purchases are completed in the organization’s eProcurement application, where approval 
workflows and spending controls are applied.

In a Level 1 punchout, shoppers can browse the supplier’s catalog within Shopping Hub but with 
limited functionality, such as viewing products without real-time pricing or availability. When they 
select items, they are redirected to the supplier’s punchout site to add products to their cart. The 
cart is then redirected back to Shopping Hub, where the shopper completes the checkout.

With a Level 2 punchout, shoppers search for products within Shopping Hub. When they select 
items, they are redirected to the supplier’s punchout site to view real-time product details 
and pricing. After finalizing selections, the cart is redirected back to Shopping Hub, where the 
shopper completes the checkout.

Punchout configuration in SPO

You must configure punchout for third-party suppliers.

The following configuration is required in SPO to enable punchout:
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• Enable suppliers for Punchout: Ensure that suppliers are enabled for Punchout. For each 
punchout supplier, a supplier record must be created, and the Punchout checkbox should be 
selected.

• Configure the Third Party Registration table (sn_spend_intg_third_party_registration): 
Depending on the type of integration, configure one the following configuration options:

◦ cXML Punchout: If the record is marked for cXML Punchout support, the cXML Punchout 
Setup related list allows you to configure various connection details.

◦ API Exchange: If the record is marked for API Exchange, the API Configuration related list 
provides options for setting up API-based integration with Punchout systems.

◦ SpendInt API: If the record is marked for SpendInt API, configuration options for data load 
are available. This supports pre-Punchout configuration for integrations.

For more information, see Configure punchout for third-party site purchases.

How L1 punchout works

In the Level 1 (L1) punchout, SPO and the punchout supplier communicate using the cXML 
protocol.
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L2 punchout flow

The following figure illustrates the L1 Punchout 

flow.

Communication between SPO and punchout supplier for Level 1 punchout

The following figure illustrates the interaction between SPO and the punchout supplier for a Level 
1 Punchout.

Note:  This flow is also applicable to other Punchout systems; however, the content of the 
cXML payloads may vary depending on the provider.
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Cart checkout from the punchout supplier site

The cart checkout flow involves the following:

• When a user checks out the cart on the punchout supplier site, the punchout supplier (or other 
Punchout systems) sends a PunchoutOrderMessage cXML payload to the REST endpoint 
exposed by SPO.

• The details of this endpoint are included in the PunchoutSetupRequest payload, enabling the 
punchout supplier to know where to send the order request.

• After SPO receives the PunchoutOrderMessage payload, it processes the information and 
creates the corresponding SPO cart lines.

• The user then reviews the cart in SPO and proceeds to checkout. Upon successful checkout, a 
purchase requisition (PR) is created.
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The following figure illustrates this flow:

Sending purchase order to punchout system

Sending purchase order information to the punchout supplier system involves the following:

• When a PR is approved and a PO is created, SPO needs to send OrderRequest cXML payload 
to the punchout supplier system.

• The flow action Send Punchout Order Request sends the PO to the punchout system.

• The punchout supplier creates the order and sends confirmation.

The following figure illustrates this flow:
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Processing order confirmation and shipping confirmation from punchout 
supplier system

The punchout supplier sends the order confirmation payload to the Order Confirmation URL, 
which is configured in the punchout supplier's system. Similarly, for each order line, the punchout 
supplier may optionally send a shipping confirmation payload to the Shipping Confirmation 
URL. For more information, see Providing Order and Shipping Confirmation URLs to Punchout 
Suppliers.

The following figure illustrates this flow:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

516



Processing order confirmation from punchout system

The following figure illustrates this flow:
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Processing shipping confirmation from punchout system

Establishing connection between SPO and the supplier punchout system

SPO and the supplier punchout system use PunchoutRequest and PunchoutResponse payloads 
to establish the connection.

The Punchout system returns a PunchoutResponse, which contains the start URL for the 
Punchout session. The SPO endpoint parses this response and opens the URL in a new tab. This 
parsing can be implemented using the XML Parser action step.

Note:  The PunchoutRequest and PunchoutResponse payloads are expected to follow the 
same structure across all Punchout systems.

The following figure illustrates the connection flow:
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How SPO communicates with the supplier punchout system

How L2 punchout works

Level 2 (L2) Punchout enables buying organizations to search for and discover Punchout items 
directly within their procurement application, eliminating the need to search each supplier’s site 
individually.

Key APIs used in L2 punchout

• Search API: Enables SPO to query multiple Punchout systems and display product listings 
within the application.

• Product API: If supported by the Punchout system, this API allows SPO to retrieve detailed 
product information.

• Order API: If supported by the Punchout system, this API enables users to complete the 
checkout process within SPO itself.

Multi-supplier support

You can configure SPO with multiple Punchout endpoints. For more information, see Punchout 
configuration in SPO.

When a search is initiated, SPO queries all configured systems and presents a consolidated set 
of results to the user.
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Search and checkout flow

• Users can search for items and view a consolidated list of products returned from all 
configured Punchout systems.

• Selected products are added to the cart, and checkout is completed within SPO. Upon 
checkout, a Purchase Requisition (PR) is created. Once approved, a Purchase Order (PO) is 
generated and synced to the corresponding Punchout system.

L2 punchOut flow

The Level 2 Punchout flow includes the following steps:

• When a search term is entered, SPO’s backend queries all configured search endpoints, and 
the resulting product list is displayed in ShoppingHub.

• If any of the returned payloads lack required mandatory fields, the corresponding results are 
excluded from further processing.

• If the Punchout system supports the Product API, detailed product information can be 
retrieved from the supplier.

• After products are added to the cart and the user checks out, SPO creates a Purchase 
Requisition and, upon approval, a Purchase Order.

• The PO is then synced with the Punchout system using either of the following:
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◦ cXML payloads, if the supplier supports a cXML order endpoint.

◦ Order API, if the supplier supports API-based order submission.

• The target Punchout system is determined based on the supplier information in the PO. SPO 
retrieves the relevant third-party configuration from the Third-Party Registration table.

• An extension point, sn_spend_intg.ThirdPartySystemApiExtension, is available to support 
integration with various Punchout systems:

◦ Users must configure Punchout system details in the Third-Party Registration table.

◦ Users must also implement the above extension point to enable integration with specific 
Punchout systems.

The following figure illustrates the L2 Punchout 

flow.

AI Search for Sourcing and Procurement Operations

The AI Search application provides a modern consumer-grade search engine for the Service 
Portal, Employee Center  (EC), Mobile, and Virtual Agent.

New customers automatically have the AI Search application configured with their base system 
for Sourcing and Procurement Operations. Existing customers can configure the PSM-specific 
Shopping Hub  search application to use the AI Search application by following the configuration 
steps.
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For more information, see AI Search .

Configuration

For detailed information on configuring the AI Search application, see Configuring 
AI Search .

Navigate to AI Search  > Search Applications  > Search Application Configurations 
to associate the AI Search engine with your Shopping Hub  search application.

Note:  For more information, see Create a search application configuration for 
AI Search .

In the Search Application Configuration  form of your application, select a Search 
Profile  to get started. A search profile determines the search sources, conditions, 
and criteria that power your search.

Under each search profile, there are a series of tabs that enhance the AI search. 
The base system provides the following that you can also modify:

• Search Sources: Along with the default search sources, Supplier  and Purchasing 
are provided on EC and Service Portal for Sourcing and Procurement Operations, 
so that the applications are capable of searching through suppliers and supplier 
products for purchasing as well. For the PSM-specific Shopping Hub  search 
application however, only the Purchasing  search source is available, allowing 
you to search only for supplier products. These search sources are rendered 
as separate tabs when you search on these applications, and are listed under 
Navigation Tabs.

Note:  You can find more information on reviewing and updating your 
search sources here.

• Synonyms

• Stop Words

• Typo Handling

• Genius Results

• Result Improvement Rules

Note: 

For more information, see Defining search profiles .

You cannot configure the UI of search results or change the available facets 
and filters from Shopping Hub. AI Search faceting is supported in Shopping 
Hub  results in Employee Center  and Service Portal.

Integration

AI Search is automatically integrated with Shopping Hub. For detailed information 
on integrating AI Search with other applications, see Integrating AI Search into your 
application .

Administration

To learn how the AI Search features and behavior affect indexing and search, see 
Administering AI Search .

Using
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For information on how AI Search displays results, refinement filter options, and 
Genius Result answers, see Using AI Search .

ServiceNow®  Mobile

To configure AI Search for the ServiceNow®  Mobile, see Advanced text search in 
mobile .

Service Portal or Employee Center

To configure AI Search for the Service Portal or EC so that your users can take 
advantage of this powerful search tool, see AI Search in Service Portal .

Virtual Agent

Virtual Agent uses AI Search to return search results in bot conversations when 
there are no relevant topics to display. For more information, see Virtual Agent 
integration with AI Search .

Configuring Sourcing and Procurement Operations
Plan and configure your implementation for Sourcing and Procurement Operations.

Install Sourcing and Procurement Operations

Install Sourcing and Procurement Operations  and its dependent applications from the 
ServiceNow  Store.

Before you begin
Role required: admin

About this task
Install the following applications in the suggested sequence to get started with Sourcing and 
Procurement Operations:

1. Finance Common Architecture  [sn_fin]

2. ERP Integration Framework  [sn_fcms_intg]

3. Common Service Delivery  [sn_spend_sdc]

4. Procurement Case Management  [sn_spend_psd]

Note:  You must use the November 2023 version of the Document Template plugin 
[sn_doc] for using the November 2023 versions of the Procurement Case Management 
and Playbooks for Sourcing and Procurement Operations  plugins.

5. Source-to-Pay Workspace  [sn_spend_workspace]

6. Source-to-Pay Common Architecture  [snc.sn_shop]

7. Sourcing and Purchasing Automation  [snc.sn_pr]

Note:  If you want to leverage the demo data, you must repair the Sourcing and 
Purchasing Automation  plugin. You can repair it now or after you have completed 
installing all the plugins.

8. Shopping Hub  [snc.sn_spend_uib]

9. Shopping Hub Mobile  [sn_shop_mobile]

10. Playbooks for Sourcing and Procurement Operations  [sn_spend_cp]

11. Virtual Agent for Sourcing and Procurement Operations  [sn_shop_va]
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12. Natural Language Understanding Models for Sourcing and Procurement Operations 
[sn_spend_nlu]

13. Source-to-Pay Integration Framework  [sn_spend_intg]

14. Procurement File Transfer Framework  [sn_spend_ftp_intg]

15. Performance Analytics for Sourcing and Procurement Operations  [sn_spend_pa]

16. Risk Assessments Integration for Sourcing and Procurement Operations  [sn_spend_vrm]

17. Project Costing for Sourcing and Procurement Operations  [sn_spend_ppm]

18. Source-to-Pay Operations  with Contract Management Pro  [snc.sn_spend_clm]

19. Now Assist for Sourcing and Procurement Operations (SPO)  [sn_spend_gen_ai]

20. Advanced Work Assignment for Source-to-Pay Operations  [snc.sn_spend_awa]

21. Process Mining for Source-to-Pay Operations [sn_s2p_mining]

22. Primary Data Integration with SAP [sn_sap_data_int]

23. Sourcing and Procurement Operations  Integration with SAP [sn_psm_sap_int]

24. Procurement for Field Service Management

Note:  This application is owned by the Field Service Management  team.

For more information on these applications and their dependencies, see Application plugin 
installation sequence in Sourcing and Procurement Operations.

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. In the search bar, use the filter criteria to find the application.
You can search for the application by its name or ID. If you can't find an application, you can 
request it from the ServiceNow  Store. Visit the ServiceNow Store  website to view all the 
available apps and for information about submitting requests to the store. For cumulative 
release notes information for all released apps, see the ServiceNow Store  version history 
release notes .

3. Select Install.

4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, you must install them first if they are not already 
installed.

If the dependent applications or plugins are not installed already, installing your application 
automatically installs them.

5. Select Load demo data  if demo data is available and you want to install it.
Some applications include demo data, which are sample records that describe application 
features for common use cases. Load demo data when you first install the application on a 
development or test instance.

6. Select Install.

What to do next
Review the various components installed with these installations. For details, see:

• Components installed with Sourcing and Procurement Operations

• Components installed with ERP Integration Framework
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• Components installed with Finance Common Architecture

• Properties installed with Finance Common Architecture

Components installed with Sourcing and Procurement Operations

Several types of components are installed with the activation of Sourcing and Procurement 
Operations, including tables, user roles, and scheduled jobs.

Demo data is available for this feature.

Roles installed

Role title [name] Description Contains roles

Shopping Hub  Administrator

[sn_shop.shopping_hub_admin]

Access to all 
modules of 
the Source-to-
Pay Common 
Architecture 
application.

• decision_table_admin

• sn_fin.procurement_user

• model_manager

• category_manager

Shopper

[sn_shop.shopper]

Access to 
the Shopping 
Hub  portal 
to make 
requests and 
purchases.

None

Procurement Administrator

[sn_shop.procurement_administrator]

Access to 
the primary 
data and 
administration 
sections of 
the Purchase 
Automation 
module.

• sn_fin.procurement_primary_data_admin

• sn_shop.procurement_specialist

Procurement Specialist

[sn_shop.procurement_specialist]

Access 
to all the 
data of the 
Sourcing and 
Purchasing 
Automation 
module, 
except the 
primary data.

• sn_fin.procurement_user

• contract_manager

Accounts Payable Viewer

[sn_shop.accounts_payable_viewer]

Read access 
to purchase 
orders, 
invoices, 
and other 
task-related 
objects that 
arise from 
purchase 

None
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Role title [name] Description Contains roles

order 
creation.

Purchasing Task Owner

[sn_shop.purchasing_task_owner]

Access to 
all purchase 
orders, 
requisitions, 
negotiations, 
sourcing 
requests, and 
purchasing 
tasks.

None

Acknowledgment Task Owner

[sn_shop.acknowledgment_task_owner]

Access to 
all purchase 
orders and 
purchase 
requisitions. 
Read-only 
access to 
the main 
objects, but 
can update 
assigned 
tasks.

None

Procurement Common Administrator

[sn_shop.procurement_common_admin]

Access to 
all tables, 
including 
deletion of 
records, in 
the Source-to-
Pay Common 
Architecture 
application.

sn_shop.procurement_common_user

Procurement Common Reader

[sn_shop.procurement_common_reader]

Read access 
to all tables 
available in 
the Source-to-
Pay Common 
Architecture 
application.

sn_fin.procurement_user

Procurement Common User

[sn_shop.procurement_common_user]

Access to 
perform, 
create, and 
update 
operations on 
all tables in 
the Source-to-
Pay Common 
Architecture 
application.

sn_shop.procurement_common_reader

sn_spend_mgmt.category_manager_admin Can import 
the category 
taxonomy, 

None
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Role title [name] Description Contains roles

update 
the Spend 
Category 
and Spend 
Category 
Stage tables 
and update 
the Spend 
category 
to Product 
category 
mappings.

sn_spend_mgmt.sourcing_category_manager Can view 
and access 
the Category 
management 
tab and the 
Savings 
dashboard 
in Spend 
and Savings 
Management.

sn_shop.procurement_specialist

sn_spend_pipeline.pipeline_management_admin
Can configure 
the Pipeline 
project 
creation rule 
decision table 
to automate 
the creation 
of pipeline 
projects.

decision_table_admin

sn_spend_pipeline.sourcing_pipeline_user
Can view 
and access 
the Pipeline 
management 
tab.

None

Note:  An application-specific admin role enables a user to manage application-level 
configurations, roles, and access controls. Your system-level admin on the production 
instance must grant the application-specific admin role to the appropriate users, and then 
remove the application-specific admin role from all users with the system-level admin role 
to help prevent system-level admins from viewing sensitive application data via forms, lists, 
and the UI. For more information, see Application administration .

Roles installed with Procurement Case Management  (sn_spend_psd)

Role title [name] Contains roles

Procurement Team Agent

[sn_spend_psd.agent]

• sn_spend_sdc.agent

• sn_slm.fulfiller
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Role title [name] Contains roles

• sn_shop.shopper

• canvas_user

Procurement Team Manager

[sn_spend_psd.manager]

• sn_spend_sdc.manager

• sn_spend_psd.agent

Procurement Task Owner

[sn_spend_psd.procurement_task_owner]

sn_slm.fulfiller

Procurement Service Delivery Admin

[sn_spend_psd.psd_admin]

• sla_admin

• sn_spend_sdc.admin

Employee Requestor

[sn_spend_psd.requestor]

sn_spend_sdc.requestor

Scheduled jobs installed

Scheduled job Description

[PSM] Approval 
Due Date 
Breached

Creates a breached approvals review task if a due date for an approval is 
breached.

[PSM] Clear 
Recently Viewed 
Data

Clears the recently viewed data in ShoppingHub. This data comprises 
entries that were created more than 90 days ago by the logged-in user.

[PSM] Create 
Receiving Task

Creates receipt tasks against the purchase order, grouped by calendar 
month and recipient, on the first of every month.

[PSM] Create 
Service 
Acknowledgment 
Task

Creates service acknowledgment tasks on a monthly basis. This job 
automatically picks all purchase order lines that have started and are yet to 
reach their end dates, and have some remaining amount or percentage or 
quantity to be delivered.

[PSM] Execute 
Credit Allocation 
Rules

Runs the credit allocation rules that are set up. Employee credit records are 
created as per this rule.

[PSM] Execute 
Shopping 
Controls

Runs the shopping controls that are set up. User control records are created 
as per the shopping controls, and the respective supplier products are 
updated as well.

[PSM] Monitor 
Milestone Tasks

Fetches any active milestone whose completion date is today and updates 
the state of the milestone to Confirmation Required.

[PSM] Populate 
Spend Task – 
Due Date Bucket

Calculates the due date bucket of purchasing tasks to determine the 
category to which they belong to. The categories are Others, Due within 7 
Days, and Overdue.
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Scheduled job Description

[PSM] 
Purchasing Data 
Aggregation

Populates the following aggregate tables: Product Purchases by Job Code, 
Supplier Use by Shopper, and Supplier Use by Department.

[PSM] Retiring 
Supplier 
Products

Updates the Published flag on the supplier product to False when the 
current date is the same as the sales end date on the supplier product.

[PSM] Revoke 
Expired Credits

Sets the credit status to Credit Expired after the expiration date on the credit 
is reached.

Tables installed

Note:  The following tables are commonly available, within the Source-to-Pay Common 
Architecture  application.

Table Description

Attribute

[sn_shop_attribute]

Stores specific attribute types and the values that are 
associated with a product model. For example, a laptop 
can have an attribute for the type of memory used, which 
can be SSD or Hard disk.

Attribute Set

[sn_shop_attribute_set]

Stores a group of attribute types that can later be 
associated with a supplier product. For example, Memory, 
Graphic card, and CPU can be an attribute set that can be 
associated with a product group.

Attribute Type

[sn_shop_attribute_type]

Stores the various types of attributes that are used when 
creating a product attribute.

Delivery Location

[sn_shop_delivery_location]

Stores the delivery location for a given shop line or cart 
line.

ERP Address Mapping

[sn_shop_erp_address_map]

Stores the mapping between the ERP address and the 
location.

ERP Asset Category Mapping

[sn_shop_erp_asset_category_map]

Stores the mapping between the ERP source and the 
capitalization policy.

ERP Material Group Mapping

[sn_shop_erp_material_group_map]

Stores the mapping between the ERP source, model 
category, and material group.

Integration Error

[sn_shop_erp_error_task]

Stores integration errors that might occur when 
communicating or processing a request with ERP.
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Table Description

Invoice

[sn_shop_invoice]

Stores the invoice that is associated with a purchase 
order.

Invoice Line

[sn_shop_invoice_line]

Stores the invoice lines for each corresponding purchase 
order line.

Job Code

[sn_shop_job_code]

Stores the job codes that are associated with business 
owners that primarily drive the approval hierarchy.

Milestone

[sn_shop_milestone]

Extends the Acknowledgment Task table and stores the 
acknowledgment of services received.

Office Location

[sn_shop_office_location]

Stores delivery locations marked as office.

Order Line Template

[sn_shop_order_line]

Extends the Shop Line table and stores the purchase 
order line for any purchase order.

Order Template

[sn_shop_order]

Stores all purchase orders. This is a base table.

Order to Contract Relationships

[sn_shop_m2m_order_contract]

Stores the mapping between the purchase order and 
contract.

Payment Terms

[sn_shop_payment_term]

Stores the term in which a payment would be made. For 
example, a term could be seven days after the invoice 
date.

Price Break

[sn_shop_price_break]

Stores the price divided based on the number of 
quantities purchased for a given supplier product 
contract.

Pricing

[sn_shop_m2m_product_contract]

Stores the mapping of a supplier product and its price 
that is based on the associated contract.

Product Group

[sn_shop_product_group]

Stores the name that is associated with an attribute 
set that is then referenced by the supplier product and 
product model.
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Table Description

Product Visuals

[sn_shop_supplier_product_artifact]

Stores the artifacts that are used to display product 
appearances on the user interface.

Purchase Order

[sn_shop_purchase_order]

Extends the Order Template table and stores the 
purchase order for a given purchase.

Purchase Order Line

[sn_shop_purchase_order_line]

Extends the Order Line Template table and stores the 
purchase order line for a purchase.

Receipt

[sn_shop_receipt]

Stores the receipt of a supplier product received as part 
of a purchase order line.

Shipment Details

[sn_shop_shipment_details]

Stores the shipment details that are associated with a 
purchase order line.

Shipment Product

[sn_shop_shipment_product]

Stores the shipment product details that are associated 
with a purchase order line.

Shipping Method

[sn_shop_shipping_method]

Stores the shipping method details that are associated 
with a purchase order line.

Note:  The following tables are installed as part of the Sourcing and Purchasing 
Automation  application.

Table Description

Acknowledgment Task

[sn_shop_acknowledgment_task]

Stores acknowledgments such as the milestone 
and receipt task. This is a parent table within the 
Common Service Delivery  (SDC) application.

Approval Plan

[sn_shop_approval_plan]

Stores the approval plan details for a purchase 
requisition such as the approval routing method 
and approval decision method.

Approval Plan Detail

[sn_shop_approval_plan_detail]

Stores an instance of the approval record for 
a purchase line that is created based on the 
approval plan.

Approval Rule
Stores the rule that triggers the creation of an 
approval record. It uses a condition builder to 
build the trigger condition for approvals.
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Table Description

[sn_shop_approval_rule]

Capitalization Policy

[sn_shop_capitalization_policy]

Stores the condition based on which an asset is 
capitalized, and a fixed asset record is created.

Cart Line

[sn_shop_cart_line]

Stores the details of a purchase line that is 
added to a cart. It has various details such as 
the supplier product selected, checkout type, 
business owner, delivery location, and so on.

Contract Task

[sn_shop_contract_task]

Extends the Purchasing Task table and stores 
instances of various types of contract tasks that 
are associated with a purchase line.

Purchase Cost Allocation

[sn_shop_cost_allocation]

Stores the type of cost allocation, associated 
cost center, and the amount that is allocated for 
a shopper that can be used to buy a supplier 
product.

Credit Allocation Rules

[sn_shop_credit_allocation_rules]

Stores the credit allocation rules that are based 
on how a credit is allocated to an individual 
shopper. The allocation can be based on the 
inventory asset or user condition.

Delivery Address Task

[sn_shop_delivery_address_task]

Extends the Purchasing Task table and stores 
the tasks that are associated with verifying and 
validating the delivery location for a purchase 
line.

Employee Credit

[sn_shop_employee_credit]

Stores the credit amount that is allocated for a 
user with supporting information such as the 
responsible cost center and credit allocation rule.

Ledger Assignment Rules

[sn_shop_ledger_assignment_rule]

Stores the rules that apply to the supplier 
products, product model or product category, 
and cost center. These rules are based on the 
accounting details, such as the capex and 
expense accounts, that are populated on a 
purchase line.

Model Map

[sn_shop_m2m_model_map]

Stores the mapping between a CMDB model and 
a third-party category.

Negotiation

[sn_shop_negotiation]

Stores the negotiation object that is created for a 
supplier product in a sourcing activity.

Negotiation Event

[sn_shop_negotiation_event]

Stores the sourcing events that are created for a 
supplier product in a sourcing activity.
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Table Description

Non Catalog Intake

[sn_shop_non_catalog_intake]

Extends the Import Set Row table and acts like a 
staging table for the non-catalog intake flow.

Order Permission

[sn_shop_m2m_order_users_covered]

Stores the mapping between the purchasing 
permission and purchase order.

Paycheck Periods

[sn_shop_paycheck_periods]

Stores the number of paychecks through which a 
payment would be made.

Payment Methods

[sn_shop_payment_method]

Stores the payment method that is selected 
by the shopper and the cost center or person 
responsible for the payment.

Percent Complete Configuration

[sn_shop_percent_complete_config]

Stores the configurations to determine the 
percentage of payment that is completed for an 
order.

Pre-Payment

[sn_shop_pre_payment]

Stores a record of prepayment done for a 
purchase line as per a contract.

Product Purchases by Job Code

[sn_shop_user_product_purchase]

Stores the aggregation of products purchased by 
the job code.

Product Stage

[sn_shop_imp_product]

Extends the Import Set Row table. This staging 
table is used to import supplier products.

Properties

[sn_shop_properties]

Stores the Shopping Hub  specific properties 
such as the requisition auto order.

Purchase

[sn_shop_purchase]

Stores the purchase record that is created for 
each purchasing or sourcing activity.

Purchase Line

[sn_shop_purchase_line]

Extends the Request Line table and stores 
the purchase line that is associated with a 
purchasing or sourcing activity.

Purchase Order History

[sn_shop_order_history]

Extends the Order Template table and stores the 
older purchase order record when an order is 
revised.
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Table Description

Purchase Order Line History

[sn_shop_order_line_history]

Extends the Order Line Template table and stores 
the older purchase order line record when a 
purchase order line is revised.

Purchase Requisition

[sn_shop_purchase_requisition]

Stores the purchase requisition for a purchase or 
sourcing activity.

Purchases by Category

[sn_shop_user_category_purchase]

Stores the analytical data for purchases by 
product category.

Purchasing Permission

[sn_shop_covered_user]

Stores the purchasing permission for a user, 
group, cost center, or department.

Purchasing Task

[sn_shop_task]

Stores the various tasks that are associated with 
a purchase such as finance and contract tasks. 
This is a base table within the Common Service 
Delivery  (SDC) application.

Receipt Task

[sn_shop_receipt_task]

Extends the Acknowledgment Task table and 
stores the state of a receipt confirmation.

Request Line Template

[sn_shop_request_line]

Extends the Shop Line table and stores the 
purchase request line items.

Requisition Permission

[sn_shop_m2m_purchasing_users_covered]

Stores the mapping between the purchasing 
permission and purchase requisition.

Requisition to Contract Relationships

[sn_shop_m2m_requisition_contract]

Stores the mapping between the requisition and 
contract.

Revision Line

[sn_shop_rev_request_line]

Extends the Request Line Template table and 
stores the revision line for a purchase.

Revision Request

[sn_shop_revision_request]

Extends the Purchasing Task table and stores the 
state of a revision request for a purchase.

Service Acknowledgment

[sn_shop_service_acknowledgment]

Stores the acknowledgment tasks of services 
received.
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Table Description

Shop Line

[sn_shop_line]

Stores the order line template and request line 
template. This is a base table.

Shopper's Top Suppliers

[sn_shop_usr_preferred_supplier]

Stores the mapping between the shopper and 
preferred supplier.

Shopping Control

[sn_shop_shopping_control]

Stores the security rules that determine the 
access of supplier products for a given user.

ShoppingHub API Cache

[sn_shop_shopnow_api_cache]

Stores the cached data for quicker access by 
APIs. An example is the CachedCagetoryMap.

ShoppingHub Configuration

[sn_shop_shopnow_content]

Stores configurations that determine certain 
aspects of the application appearance and 
behavior. An example is the terms and conditions 
page URL.

Sourcing Bid Stage

[sn_shop_imp_sourcing_bid]

Stores the bids that are received for a supplier 
product by the third-party providers. This is a 
staging table.

Sourcing Line Outbound Queue

[sn_shop_sourcing_line_out_queue]

Stages the sourcing line for the third-party 
providers.

Sourcing Outbound Queue

[sn_shop_sourcing_out_queue]

Stages the sourcing request for the third-party 
providers.

Sourcing Request

[sn_shop_sourcing_activity]

Stores requests to source for supplier products.

Sourcing Task

[sn_shop_sourcing_task]

Extends the Purchasing Task table and stores the 
tasks that are related to a sourcing request.

Sourcing Vendor

[sn_shop_sourcing_vendor]

Stores the mapping between the sourcing vendor 
code and sourcing vendor name.

Supplier Product

[sn_shop_supplier_product]

Stores the supplier products that represent 
goods or services that can be listed on the portal.
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Table Description

Supplier Product View

[sn_shop_supplier_product_view]

Stores the analytics of the number of views for a 
supplier product.

Supplier Use by Department

[sn_shop_dept_supplier_purchase]

Stores the analytics of suppliers that are used by 
departments.

Supplier Use by Shopper

[sn_shop_user_supplier_purchase]

Stores the analytics of suppliers that are used by 
shoppers.

Third-Party Category

[sn_shop_third_party_category]

Stores an external category that is provided by a 
supplier that maps to an existing model.

User Controls

[sn_shop_user_control]

Stores the mapping of a user and a shopping 
control.

Purchasing properties

The following list contains the purchasing properties that are used by Sourcing and Procurement 
Operations.

Property Description

sn_shop.atf.threshold.days Number of days before an expected delivery 
date for goods, or a start date for services and 
blankets, in which time a purchase requisition 
would be considered after the fact.

sn_shop.credit.allocation.batchsize Total number of employee records that are 
processed in a batch, during credit allocation.

sn_shop.default.contract.model.type Default contract model when creating 
contracts.

sn_shop.default.purchasing.time Initial value of the purchasing time in days.

sn_shop.default.shipping.estimate Default shipping estimate, in percentage.

sn_shop.default.sourcing.time Initial sourcing time in days.

sn_shop.default.supplier.onboard.time Initial supplier onboarding time in days.

sn_shop.non.pricing.contract List of non-pricing contracts. The default is 
NDA.

sn_shop.shipping.estimate.inclusion Shipping estimate included in purchase 
request approvals.

sn_shop.approval.reassessment.resend Approvals that must be reassessed during a 
revision if the same approval rule is triggered. 
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Property Description

It applies to both purchase requisition and 
purchase order revisions.

sn_shop.log.property Logging level for Sourcing and Purchasing 
Automation.

sn_shop.spend.requisition.autoorder Purchase order that can be automatically 
created on completion of purchasing tasks 
without having to undergo a manual final 
review.

sn_shop.spend.requisition.autoorder.threshold Dollar amount threshold above which a final 
review is required before a purchase order is 
created even when the automatic creation of 
purchase orders property is set to Yes.

sn_shop.spend.sla.due.days Minimum due date for SLA calculation.

sn_shop.supported.artifact.formats Formats that are supported for supplier 
product artifacts.

sn_shop.tax.estimate.inclusion Includes generated tax estimate in purchase 
requests for the approval process.

Watchlist properties

Set the sn_shop.watchlist.user.limit  system property to restrict the maximum 
number of users in the watchlist to 20.

Role required:

• sn_shop.procurement_administrator, sn_shop.shopping_hub_admin - Edit and view.

• sn_shop.procurement_administrator, sn_shop.shopping_hub_admin, sn_shop.shopper, 
sn_shop.procurement_specialist, sn_spend_psd.agent - View (read-only).

To modify the user limit, do the following:

1. Navigate to All.

2. On the left navigation pane, enter sys_properties_list.do.

The entire list of properties in the System Properties [sys_properties] table appears.

3. In the Name search field, look for sn_shop.watchlist.user.limit  and open the system property.

The system property sn_shop.watchlist.user.limit  opens as a record. The Value  field displays 
the default value as 20. You can edit the record in editing mode.

4. In the Value  field, you can modify the value as per your requirement.

For example, 5.

5. Select Update.

Property to automate the edit receipt flow

Enable the sn_spend_cp.enable_automated_edit_receipt_flow  system property 
to automate the approval and processing of edit receipt requests without manual intervention. 
The automated process updates the purchase order (PO) and purchase order line (POL) 
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quantities, while also automatically closing the associated procurement case in the Source-to-
Pay Workspace.

Role required: admin

This property is enabled by default. However, if this property is disabled, do the following to 
enable it:

1. Navigate to All.

2. On the left navigation pane, enter sys_properties_list.do.

The entire list of properties in the System Properties [sys_properties] table appears.

3. In the Name search field, look for sn_spend_cp.enable_automated_edit_receipt_flow  and 
open the system property.

The system property is enabled by default. The Value  field displays the default value as ON.

4. If the Value  field shows OFF, change it to ON  to enable this property.

5. Select Update.

Properties installed with Finance Common Architecture

Use these properties to configure various settings in the Sourcing and Procurement Operations 
application.

For more information on how to configure these properties, see Configure properties in Finance 
Common Architecture.

Properties for Finance Common Architecture

Property Description

default_je_sheet_name Default sheet name of a Microsoft Excel file 
used to import journal entries.

number_of_future_periods Number of future periods that are available in 
the Period filter list on the Finance Workspace.

number_of_prior_periods Number of prior periods that are available in 
the Period filter list on the Finance Workspace.

Configure properties in Finance Common Architecture

Configure properties for various settings used in Sourcing and Procurement Operations 
application.

Before you begin
Role required: sn_fin.finance_admin

Procedure

1. Navigate to Finance Common  > Properties.

2. Open a property to edit or select New  to create one.

3. On the form, fill in the fields.
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Properties form

Field Description

Name Unique name of the property.

Description Short description of the property.

Application Name of the application to which the property 
applies.

Value Value for the property.

4. Select Submit.

Application plugin installation sequence in Sourcing and Procurement Operations

The following table lists the Sourcing and Procurement Operations  (SPO) plugins, their 
installation sequence, high-level descriptions, and dependencies.

Important:  Before installing a plugin listed in the Plugin name column, ensure that you 
install all corresponding dependencies listed in the Plugin dependencies column from the 
ServiceNow Store .

Application plugin installation sequence

SequencePlugin name Description Plugin dependencies

1 Finance Common 
Architecture

[com.sn_fin]

Maintains primary data 
such as Enterprise 
Resource Planning (ERP) 
sources, legal entities, 
accounting periods, and so 
on.

• Finance Applications – 
Common Dependencies

• Fiscal Calendar

• Scoped Application 
Restricted Caller Access

• Scoped Application 
Restricted Caller Access

• Insert Multiple web 
service

• Document Templates

2 ERP Integration Framework

[com.sn_fcms_intg]

Provides integration 
support between the 
Platform and common ERP 
systems.

• Scope Application 
Restricted Caller Access

• Insert Multiple Web 
Service

3 Common Service Delivery

[com.sn_spend_sdc]

Contains Finance Case, 
Finance Case Line, Finance 
Task, and Playbook status 
tables, as well as other 
infrastructure that forms 
the basis of Finance and 
Supply Chain workflows 
products.

• Process Automation 
Designer Core

• Process Automation 
Designer for App Engine

• Playbook Experience
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Application plugin installation sequence  (continued)

SequencePlugin name Description Plugin dependencies

4 Procurement Case 
Management

[com.sn_spend_psd]

Enables all employees to 
request services from the 
procurement team, and 
the procurement team to 
manage those requests.

• Common Service Delivery

• Source-to-Pay Workspace

5 Source-to-Pay Workspace

[com.sn_spend_workspace]

Provides a single 
environment for 
Procurement Specialists 
to work on purchase 
requisitions, sourcing 
requests, negotiations, 
procurement requests, and 
more.

None

6 Source-to-Pay Common 
Architecture

[com.snc.sn_shop]

Provides an architecture 
to store purchase orders, 
requisitions, sourcing 
requests, and other objects 
that are commonly used 
across the source-to-pay 
business processes.

• Procurement Case 
Management

• Common Service Delivery

• GraphQL Plugin

• Finance Common 
Architecture

• User Criteria Scoped API

• Source-to-Pay Workspace

• Employee Center

7 Sourcing and Purchasing 
Automation

[com.snc.sn_pr]

Provides workflows and 
automation for sourcing 
requests, negotiations, and 
purchase requisitions.

Note:  If you want 
to leverage the 
demo data, you must 
repair the Sourcing 
and Purchasing 
Automation  plugin. 
You can repair it now 
or after you have 
completed installing 
all the plugins.

• Source-to-Pay Common 
Architecture

• Supplier Common 
Architecture

8 Shopping Hub

[com.snc.sn_spend_uib]

Provides a streamlined, e-
commerce like experience 
for employees to self-
service requests, and 
source or purchase 
products and services 
through the procurement 
organization. This is an add-

• Sourcing and Purchasing 
Automation

• Common UIB Wrapper 
Components
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Application plugin installation sequence  (continued)

SequencePlugin name Description Plugin dependencies

on experience to Employee 
Center.

9 Shopping Hub Mobile

[com.sn_shop_mobile]

Enables Shopping Hub 
and other employee 
experiences for 
procurement within the Now 
Mobile  application.

• Sourcing and Purchasing 
Automation

• Mobile Plugin

• Mobile Agent Native 
Client

10 Playbooks for Sourcing and 
Procurement Operations

[com.sn_spend_cp]

Provides a set of prebuilt 
playbooks, workflows, and 
experiences for employees, 
sourcing, and procurement 
to automate work that is 
typically managed through 
emails and spreadsheets.

• Source-to-Pay Common 
Architecture

• Sourcing and Purchasing 
Automation

11 Virtual Agent for Sourcing 
and Procurement 
Operations

[com.sn_shop_va]

Provides preconfigured 
topics for sourcing and 
procurement within a 
conversational interface, 
for employees to raise 
requests, find knowledge, 
and complete tasks.

• Source-to-Pay Common 
Architecture

• Glide Virtual Agent

12 Natural Language 
Understanding Models for 
Sourcing and Procurement 
Operations

[com.sn_spend_nlu]

Provides Natural Language 
Understanding  (NLU) 
models to enhance the 
virtual agent conversation 
interface, using natural 
human utterances to detect 
the correct conversations 
intended by employees.

• Source-to-Pay Common 
Architecture

• Glide Virtual Agent

• Virtual Agent for Sourcing 
and Procurement 
Operations

13 Source-to-Pay Integration 
Framework

[com.sn_spend_intg]

Provides a set of staging 
tables, transform maps, 
and workflows to integrate 
sourcing, third-party 
catalogs, ordering, 
shipments, and invoicing 
with Sourcing and 
Procurement Operations.

Source-to-Pay Common 
Architecture

14 Procurement File Transfer 
Framework

[com.sn_spend_ftp_intg]

Extends the Source-to-
Pay Integration Framework 
with Secure File Transfer 
Protocol (SFTP) and File 
Transfer Protocol (FTP) 
functionality, designed 
for integrating with 
systems that don’t support 
Representational State 

• Source-to-Pay Integration 
Framework

• ServiceNow 
IntegrationHub Action 
Step – SSH
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Application plugin installation sequence  (continued)

SequencePlugin name Description Plugin dependencies

Transfer (REST) or Simple 
Object Access Protocol 
(SOAP) based integration 
methods.

• ServiceNow 
IntegrationHub Action 
Step - SFTP

• ServiceNow 
IntegrationHub Flow 
Trigger - REST

15 Performance Analytics for 
Sourcing and Procurement 
Operations

[com.sn_spend_pa]

Provides a set of 
preconfigured metrics 
and dashboards to 
assess spend, operational 
efficiency, and team 
performance across the 
Sourcing and Procurement 
Operations  product.

• Source-to-Pay Common 
Architecture

• Sourcing and Purchasing 
Automation

16 Risk Assessments 
Integration for Sourcing and 
Procurement Operations

[com.sn_spend_vrm]

Provides a set of 
capabilities to trigger 
risk assessments on a 
supplier during the sourcing 
or purchase requisition 
workflow using Third-party 
Risk Management.

• Source-to-Pay Common 
Architecture

• Vendor Risk Management

17 Project Costing for 
Sourcing and Procurement 
Operations

[com.sn_spend_ppm]

Provides a set of 
capabilities to automate 
the calculation of planned 
versus actual cost by 
linking purchase orders to 
cost plans within Project 
Portfolio Management.

• Source-to-Pay Common 
Architecture

• Project Portfolio Suite 
with Financials

18 Source-to-Pay Operations 
with Contract Management 
Pro

[com.snc.sn_spend_clm]

Provides streamlined cross-
team collaboration and 
enables legal professionals 
to run their contracting 
work within the sourcing 
and purchasing process.​
 With this integration, 
procurement specialists 
can initiate contract 
requests manually 
throughout the sourcing 
and purchasing process.

• com.snc.sn_pr

• com.sn_cm_word_addin

19 Now Assist for Sourcing and 
Procurement Operations 
(SPO)

[com.sn_spend_gen_ai]

Uses procurement-related 
topics to route requesters 
to the appropriate intake 
channels, and then through 
conversation, helps to 
submit their requests.

• Now Assist for Platform

• Sourcing and Purchasing 
Automation

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

542



Application plugin installation sequence  (continued)

SequencePlugin name Description Plugin dependencies

20 Advanced Work 
Assignment for Source-to-
Pay Operations

[com.snc.sn_spend_awa]

Provides configurations to 
support automatic routing, 
queuing, and assignment 
of procurement cases, 
emails, and live agent chat 
conversations.

• Procurement Case 
Management

• Advanced Work 
Assignment

• Agent Chat

21 Process Mining for Source-
to-Pay Operations

[com.sn_s2p_mining]

Provides the ability to use 
Platform's Process Mining 
capabilities on the Source-
to-Pay workflows to which 
customers are entitled 
to analyze and improve 
source-to-pay processes.

Source-to-Pay Common 
Architecture

22 Primary Data Integration 
with SAP

[com.sn_sap_data_int]

Provides the ability to 
fetch entity data like legal 
entity, cost center, material, 
supplier, and so on, from 
SAP ECC and SAP HANA 
into ServiceNow.

• ServiceNow 
IntegrationHub Enterprise 
Pack Installer

• ERP Integration 
Framework

• SAP ECC IDoc Spoke

• SAP S4 HANA RFC Spoke

• Source-to-Pay Common 
Architecture

• Utility Actions Spoke

• SAP S4 HANA OData 
Spoke

• SAP S4 HANA Cloud 
Spoke

23 Sourcing and Procurement 
Operations  Integration with 
SAP

[com.sn_psm_sap_int]

Provides the ability to send 
purchase orders, receipts, 
and returns created in 
Sourcing and Procurement 
Operations  to SAP ECC and 
SAP S4 HANA.

• ERP Integration 
Framework

• Source-to-Pay Common 
Architecture

• SAP ECC IDoc Spoke

• SAP S4 HANA RFC Spoke

• Primary Data Integration 
with SAP
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Application plugin installation sequence  (continued)

SequencePlugin name Description Plugin dependencies

24 Procurement for Field 
Service Management

com.snc.fsm_psm_mobile

Provides an integration 
with the Field Service 
Management application. 
With this integration, a field 
service agent can engage 
with procurement and place 
an order to purchase a 
required part from a vendor 
or supplier.

Note:  This 
application is owned 
by the Field Service 
Management  team.

• Field Service 
Management

• Field Service Mobile

• Shopping Hub Mobile

Related topics

Install Sourcing and Procurement Operations

Components installed with Sourcing and Procurement Operations

Components installed with ERP Integration Framework

Components installed with Finance Common Architecture

Properties installed with Finance Common Architecture

Setting up primary data for ShoppingHub

Create primary data of your suppliers and office locations that your suppliers deliver to. Define 
your product catalog with data of your product categories, product models, and supplier 
products. Define shopping controls to control the supplier product visibility to your employees.

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Service portal configuration for ShoppingHub

Configure punchout for third-party site purchases

Customize your top suppliers on Shopping Hub

Using Shopping Hub

My purchases on Shopping Hub

Add a supplier

Add suppliers and their products to populate your primary data.

Before you begin
Role required: sn_shop.shopping_hub_admin or sn_shop.procurement_administrator

About this task
You can add a supplier to the primary data and add products under that supplier. The suppliers 
that you add, appear on the Shopping Hub  portal under Suppliers.
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Procedure

1. Navigate to All  > ShoppingHub  > Primary Data  > Suppliers.
You can also navigate to Sourcing and Purchasing Automation  > Primary Data  > Supplier.

2. Select New.

3. On the form, fill in the fields.

Supplier form

Field Description

Number System-generated unique identifier for the supplier.

Legal name Legal name of the supplier that corresponds to its operating location.

ERP supplier 
code

Company code of the supplier in the ERP system.

Parent entity Parent organization of the supplier.

Global 
company

Global company that the supplier is linked to.

Punchout Whether the supplier is a third-party punchout.

Note:  This option is only available for Procurement Specialists using 
the Purchasing view.

Industry Industry to which the supplier belongs.

Image Image of the supplier’s logo.

Description Detailed description of the supplier.

4. To add an image of the supplier’s logo, select Select to add….

5. Select the Relationship Summary  tab and fill in the fields.

Relationship Summary form

Field Description

Onboarded Status of whether the supplier is onboarded into the ERP system. The 
options are Yes  or No.

Valid NDA Status of whether the supplier has a valid non-disclosure agreement. The 
options are Yes  or No.

Valid risk 
assessment

Status of whether a valid risk assessment has been performed for the 
supplier. The options are Yes  or No.

Tiering 
assessment 
needed?

Whether a tiering assessment is required for the supplier.

Customer number Unique identifier for the organization to the supplier.

On-boarded by The person responsible for onboarding the supplier.

On-boarded date Onboarding date of the supplier.

Off-boarded date Termination date of the supplier from the organization.
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Field Description

Relationship 
manager

Person responsible for managing the relationship with this supplier.

Relationship 
status

Business relationship that is designated to the supplier. The options are 
Strategic, Valued, Tactical, or Excluded.

Preferred Whether the supplier is preferred. The options are Yes  or No.

6. Select the Contact Information  tab and fill in the fields.

Contact Information form

Field Description

Street address Street where the supplier is located.

PO box number Post office box number where the supplier correspondence and 
payments are made.

City City where the supplier is located.

State/Province State or province where the supplier is located.

County/District County or district where the supplier is located.

Zip/Postal code Zip code or postal code where the supplier is located.

Country Country where the supplier is located.

Region Region where the supplier is operating. Options are AMS, APAC, 
EMEA, or LATAM.

Primary phone 
number

Phone number of the primary contact from the supplier side.

Fax number Number to which documents can be faxed to the supplier.

Website Website of the supplier.

7. Select the Purchasing Automation  tab and fill in the fields.

Purchasing Automation form

Field Description

Shipping time in 
days

Estimated number of days to ship products to the delivery location. For 
more information, see Lead time calculations.

Shipping estimates 
for products from 
this supplier 
(percent of 
negotiated price)

Default shipping estimate from the supplier.

Incoterm
Set of 11 internationally recognized rules that define the responsibilities 
of sellers and buyers. It specifies who is responsible for paying for and 
managing the shipment, insurance, documentation, customs clearance, 
and other logistical activities. Select one of these options:
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Field Description

◦ Carriage and Insurance Paid to (CIP)

◦ Carriage Paid to (CPT)

◦ Cost and Freight (CFR)

◦ Cost, Insurance, and Freight (CIF)

◦ Delivered at Place (DAP)

◦ Delivered at Terminal (DAT)

◦ Delivered Duty Paid (DDP)

◦ Ex Works (EXW)

◦ Free Alongside Ship (FAS)

◦ Free Carrier (FCA)

◦ Free on Board (FOB)

Goods shipped 
from

Location from where the supplier ships out the products.

Supplier delivers to Approved shipping countries for the supplier.

Purchasing entities Purchasing entities that are allowed to purchase from this supplier.

Legal entities Legal entities that are allowed to buy from this supplier.

8. Select the Accounting Details  tab and fill in the fields.

Accounting Details form

Field Description

Payment term Agreed time and conditions for paying the supplier.

Tax jurisdiction Taxation authority that imposes the taxes.

Accepted purchasing 
currency

Currency value in which purchase orders for this supplier must 
be created.

General ledger account Accounts payable reconciliation account for this supplier.

9. Select Submit.

What to do next

• Use the related lists of the supplier form to view the supplier products and contracts that are 
associated with this supplier.

• Add a supplier product. For more information, see Add a supplier product.

Add office locations

Add all the office locations that your suppliers deliver to in your primary data. That way, your 
employees using Shopping Hub  can select any of these pre-approved office locations for 
delivery while placing an order for a product.

About this task
https://player.vimeo.com/video/1143155462?
h=59e51ab483&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Before you begin
Role required: sn_shop.shopping_hub_admin

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Primary Data.

2. Select Office Locations.

3. Select New.

4. On the form, fill in the fields.

Office Location form

Field Description

Name Name of the office.

Country Country of the office location.

Location Address of the office location.

Default Option to make this office location default.

If you select this option, this office location 
appears as the default delivery address for a 
new user of Shopping Hub.

Legal Entity Legal entity that is responsible for this office 
location.

5. Select Submit.

Manage delivery to valid address

As an administrator, you can define one or multiple valid countries where a supplier can deliver 
the products.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Primary Data  > Suppliers.

2. Alternatively, navigate to All  > Sourcing and Purchasing Automation  > Primary Data  > 
Supplier Product.

Valid values defined at the supplier product take precedence over the values defined at the 
supplier level.

3. Select countries by unlocking the Supplier delivers to  field.

4. Select Save.
The products are now available for delivery only for the selected countries. When you leave the 
field blank, the products are eligible for delivery in all countries.
Once you select valid countries, employees can view and select the list of delivery locations 
associated with the valid countries in ShoppingHub.
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Related topics

Valid countries for delivery

Delivery location options

Select a delivery location

Add delivery locations

Add the address that can be selected by the user to have the product delivered. You can add 
multiple delivery locations.

About this task
https://player.vimeo.com/video/1143155425?
h=a0ea47fcb2&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: sn_shop.shopper, sn_shop.procurement_common_user, 
sn_shop.procurement_specialist, or sn_shop.shopping_hub_admin

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Primary Data.

2. Select Delivery Locations.

3. Select New.

4. On the form, fill in the fields.

Delivery Location form

Field Description

Address Displays the value of the combination of 
recipients name and location details.

Shopper The logged-in user who saved this address.

Recipient The user who is the recipient of this address.

User default location Determines whether this is user's default 
location or not.

User saved location Indicates that the user saved the address to 
be used for future purchases.

Address verification Indicates that this delivery address is a valid 
shippable location.

Address approval Indicates that this delivery address can be 
used for user purchases.

Location Details

Location The common location used for integration 
with third-party systems.

Work address The address of the office location.

Street The street address of the delivery location.

City The city of the delivery location.

State / Province The state of the delivery location.
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Field Description

Zip / Postal code The zip code of the delivery location.

Country The country of the delivery location.

5. Select Submit.

Setting up your product catalog

You can set up your product catalog by grouping the supplier products that you want to appear 
on the Shopping Hub  portal into product categories and product models.

Create product categories to group product models

Create categories for your product models to group your product models.

Before you begin
Role required: sn_shop.shopping_hub_admin

Procedure

1. Navigate to All  > Product Catalog  > Model Categories.

2. Select New.

3. On the form, fill in the fields.

Model Category form

Field Description

Name
Display name of your product category on the 
Shopping Hub  portal.

Parent category Existing category that you select as the 
parent of this category.

UNSPSC code United Nations Standard Products and 
Services Code of the product category.

Picture or icon Visual representation of the product category.

Purchasing Automation

Spend categorization Products of this category that can be sourced 
or not sourced.

Select Addressable  or Not Addressable.

Product type Product that is of the type Good or Service. 
Based on the product type, appropriate 
workflow options are initiated.

Goods receipt required Goods receipt that is required or not required.

This field appears only if the product type is 
set to Good.

Acknowledgment type Receipt of confirmation and the type of 
receipt. The options are Milestones, Service 
Acknowledgment, or Two Way Match.
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Field Description

This field appears only if the product type is 
set to Service.

Goods sourcing checkout References the record producer used 
for sourcing requests of goods from this 
category.

Services sourcing checkout References the record producer used for 
sourcing requests of services from this 
category.

Contract type Contract types that are applicable to this 
product category.

Related contracts, based on the specified 
contract models, are created for any 
purchase requisition of a product of this 
category.

Display pricing?
Determines if pricing is to be displayed 
in Shopping Hub  for supplier products 
associated to this category.

Sourcing time in days Number of days that are required to source a 
product of this category from the supplier.

For details, see Lead time calculations.

Supplier onboarding time in days Number of days that are required for a new 
supplier of a product in this category to 
onboard.

For details, see Lead time calculations.

Purchasing time in days Number of days that are required to complete 
a purchase order for products in this 
category.

Enterprise Asset Configuration

CI class Configuration item (CI) class that represents 
any product of this category.

You can't add the CI class to the model 
category later.

Asset class
Asset that represents any product of this 
category. Setting the asset class triggers the 
creation of assets depending on the model 
category selected.

If you select Consumable  or Software 
License, the CI class  field becomes read-
only because consumables and software 
licenses don’t create CIs. If you specify 
a CI class and then select Consumable 
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Field Description

or Software License, the CI class  field is 
changed to None  automatically.

If you don’t select an asset class, the product 
category doesn’t create any asset.

You can select an asset class from these 
options:

◦ Asset: An item that can be tracked 
individually.

◦ Consumable: An asset not tracked 
individually, such as keyboards.

◦ Hardware: A physical piece of computer 
equipment, such as a laptop or server.

◦ Software License: A legal statement that 
defines the uses of software, such as the 
number of installations that are allowed or 
the terms of distribution.

Allow pre-allocation Option to determine if you want to track items 
in this category as pre-allocated assets.

Allow as primary Option to determine if assets of this product 
category can be primary components of a 
bundle.

Allow in bundle Option to determine if assets of this product 
category can be components of a bundle.

4. Select Submit.

Result
The product category is created and the form reopens with its related lists.

What to do next
Use the related lists of the model category form to view the product models, supplier products, 
and ledger assignment rules that are associated with this category.

Related lists of a product category

Name Description

Product Models Product models that are associated with this product category.

Supplier Products Supplier products that come under this product category.

Select New  to create a supplier product.

Ledger Assignment Rules Ledger assignment rules for this product category.

Select New  to add a ledger assignment rule.

Create product models to group supplier products

Create product models to group your supplier products.
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Before you begin
Role required: sn_shop.shopping_hub_admin

Procedure

1. Navigate to All  > ShoppingHub  > Model Management  > All Models.

2. Select New.

3. Select a model type that you want to create from the following options:

◦ Application

◦ Bundle

◦ Consumable

◦ Contract

◦ Facility

◦ Hardware

◦ Service Model

◦ Software Model

◦ Other Product Model

4. On the form, fill in the fields.

The following table describes the fields that appear on all models, regardless of the type of 
model.

Field Description

Display name Name of the model.

Note:  The Display name  field is auto-populated with the values of 
the Manufacturer  and Name  fields.

Manufacturer Name of the manufacturer of the model.

Name Manufacturer-assigned name of the model or abstract name that is 
specified by the model manager, such as Field Agent Laptop.

Short description Brief description of the model.

Model categories Categories to which the model is assigned.

Asset tracking 
strategy

Process by which the model can be tracked. Select one of these options:

◦ Leave to Category: Model is transparent and the category defines the 
asset class.

◦ Create Consumable Asset: Model forces the asset class to be 
consumable, regardless of what the category defines as the asset 
class.

◦ Don't create assets: Model blocks asset instantiation, regardless of 
what the category defines as the asset class.

Acquisition 
method

Method for purchasing the model. Select Both, Buy, or Lease.

Cost Cost of a single unit of the model.

Depreciation Depreciation scheme for the model.
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Field Description

Salvage value Estimated value that an asset realizes after its sale at the end of its useful 
life. This value must be less than or equal to the cost of the asset.

Model number Specific model number that is assigned to the item by the manufacturer.

Barcode Barcode number that is assigned to the model by the manufacturer.

Owner Person responsible for the model.

Status Status of the model. Select In Production, Retired, or Sold.

Expenditure type Type of expenditure. Select one of these options:

◦ Capex: Capital expenditure is a one-time expenditure, where the value 
is realized over the years. For example, a photocopier.

◦ Opex: Operational expenditure is an on-going expenditure. For 
example, toners for the photocopier.

Picture Picture or icon to represent this product model.

Certified Model that has an approval for its use.

Comments Additional information about the model that is good to know.

Assets Assets that are created from this model.

You can have any combination of assets and configuration items. 
For example, with a single hardware model, you can have assets and 
no configuration items, configuration items and no assets, or both 
configuration items and assets.

Configuration 
Items Configuration items that are created from this model. You can have any 

combination of assets and configuration items.

Purchasing Automation

Product category Category to which this product belongs.

Spend 
categorization

Products of this category that can be sourced or not.

The default value is based on the selected product category.

Product type Type Good or Service.

The default value is based on the selected product category.

Good receipt 
required Goods receipt that is required or not. This field appears only if the product 

type selected is Good.

The default value is based on the selected product category.

Acknowledgment 
type

Receipt of confirmation and the type of receipt. The options available are 
Milestones, Service Acknowledgment, and Two Way Match.

The default value is based on the selected product category but the value 
provided here can override it.

This field appears only if the product type selected is Service.
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Field Description

Sourcing time in 
days

Number of days that are required to source a product of this category from 
the supplier.

This field is auto-populated based on the selected product category.

For details, see Lead time calculations.

Purchasing time 
in days

Number of days that are required to complete a purchase order for 
products in this category.

This field is auto-populated based on the selected product category.

For details, see Lead time calculations.

5. Select Submit.

What to do next

• Use the related lists of the model category form to view the product models, supplier products, 
and ledger assignment rules that are associated with this category.

• Create ledger assignment rules for this product model. See add a ledger assignment rule.

Add a supplier product

Add supplier products to populate the primary data.

Before you begin
To add a supplier product, you must have already added a supplier, product category or model 
category, and product model to the primary data. For more information on how to add them, see 
Add a supplier, Create product categories, and Create product models.

Role required: sn_shop.shopping_hub_admin or sn_shop.procurement_administrator

About this task
https://player.vimeo.com/video/1143155478?
h=a380c18a04&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

You can add a supplier product and choose to publish it on the Shopping Hub  portal. The 
products that you add, appear on the portal under various categories. You can add multiple 
products that are available with the suppliers.

Procedure

1. Navigate to All  > ShoppingHub  > Supplier Products  > Published Products.
You can also navigate to Sourcing and Purchasing Automation  > Primary Data  > Supplier 
Product.

2. Select New.

3. On the form, fill in the fields.

Supplier product form

Field Description

Name Name of the product at the supplier’s end.

Supplier Supplier for this product.
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Field Description

Supplier part 
number

Unique number that is used by the supplier to identify this product.

Product 
model

Standardized definition for this product across suppliers.

Note:  For creating a product bundle, enter the name of the product 
model of type bundle in this field.

Product 
category

Category to which this product belongs.

Sales start 
date

Date when the supplier product is active and available for purchase in the 
catalog. This is a read-only field.

Sales end 
date

Date when the supplier product is discontinued and no longer published in 
the catalog. This is a read-only field.

Published Option for specifying if the product is to be listed on the Shopping Hub  portal.

Note:  The Sales start date  and Sales end date  fields are populated through third-party 
integration from the Catalog API using Source-to-Pay Integration Framework  (PIF).

4. Select the Details  tab and fill in the fields.

Details form

Field Description

Units available Number of units of the product in stock with the supplier.

Unit Unit or rate in which the product is sold by the supplier.

Short description Brief description of the product for the buyer.

Description Detailed description of the product for the buyer.

5. Select the Purchasing Automation  tab and fill in the fields.

Note:  These cascade down from the model category to the product model, to the 
supplier product, but can be overridden at the leaf level.

Purchasing Automation form

Field Description

Spend 
categorization Product that is addressable for negotiation. You can select one of these 

options:

◦ Addressable: Can be considered for negotiation.

◦ Not Addressable: Cannot be considered for negotiation.

Product type Type of product. The options are Good  or Service.

Goods receipt 
required

Purchase and receipt of goods that are automated. The options are Yes  or 
No.
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Field Description

Acknowledgment 
type Type of receipt confirmation, if any, required for services. You can select 

one of these options:

◦ None

◦ Milestones

◦ Service Acknowledgment

◦ Two Way Match

Capex account General ledger account where capital expenses are posted on purchase.

Expense account General ledger account where operational expenses are posted on 
purchases.

Pre-paid account General ledger account where purchases of this product are posted when 
they are prepaid.

Sourcing 
required?

Option to mark if sourcing is required for this product. This is determined 
based on if there is an active contractual price for this supplier product or 
not.

Supplier delivers 
to

Countries where the suppliers can deliver the product.

For more information, see Manage delivery to valid address.

6. Select the Lead Time  tab and review the fields.

Lead Time form

Field Description

Total lead time in 
days

Estimated number of days to process the purchase order and deliver the 
product.

Sourcing time in 
days

Estimated number of days to process the sourcing request.

Purchasing time in 
days

Estimated number of days to complete the purchase requisition and 
create a purchase order.

Shipping time in 
days

Estimated number of days to ship the product to the delivery location.

For more information, see Lead time calculations.

7. Select Submit.

What to do next
Use the related lists of the supplier product form to view the pricing, purchase order lines, 
product visuals, and ledger assignment rules that are associated with this supplier product.

Add a supplier product bundle

Add a supplier product bundle, which may include several products or services from the same 
supplier. You can also add sub-bundles to the main bundle.
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Before you begin
A bundled model is a single model comprised of individual models. For example, a laptop, 
printer, keyboard, and mouse can be combined into a single bundled model. For this bundled 
model to appear in the Shopping Hub  portal, you have to create a supplier product for the same. 
Once the supplier product is created and published, it will be available for purchase in Shopping 
Hub. For more information on how to create bundled models, see Bundled models .

Role required: sn_shop.shopping_hub_admin or sn_shop.procurement_administrator

About this task
A supplier product bundle is a supplier product created under any product model of type bundle.

You can add a supplier product bundle and choose to publish it on the Shopping Hub  portal. 
The product bundles that you add appear on the portal under various categories. To a product 
bundle you can add multiple products, services, or sub-bundles that are available with the same 
supplier.

Procedure

1. Navigate to All  > ShoppingHub  > Supplier Products  > Published Products.
You can also navigate to Sourcing and Purchasing Automation  > Primary Data  > Supplier 
Product.

2. Select New.

3. On the form, fill in the fields.
For more information, see Add a supplier product.

Note:  For creating a product bundle, enter the product model of type bundle in the 
Product model  field.

4. Select Check bundle setup  to check if the configurations for all the products and services 
included in the bundle are complete.
For all missing configurations, a list of validation messages are displayed. You can select each 
message to correct the respective configuration. The following conditions must be fulfilled for 
publishing a bundle:

◦ All model components must be associated with supplier products from the same supplier.

◦ All supplier products must be published.

◦ All supplier products other than type bundle must have a contract price associated with 
them.

◦ All supplier products of type bundle must not have a contract price associated with them.

◦ All supplier products must have a contract price listed in the same currency.

Note:  If Check bundle setup  option is selected for an already published bundle and 
any of its configurations are found incomplete, the bundle gets unpublished.

5. Select Submit.

What to do next
Use the related lists of the supplier product form to view the pricing, purchase order lines, 
product visuals, and ledger assignment rules that are associated with this supplier product 
bundle.

Lead time calculations

Lead time (in days) of a supplier product consist of the time for sourcing, supplier onboarding, 
purchasing, and shipping for a supplier product, product model, or a product category. Each of 
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these durations are used to calculate the total lead time which determines the number of days to 
execute a purchase order.

Supplier onboarding time

Supplier onboarding time indicated the average number of days to onboard a new 
supplier for a product of a category. The initial default value is 15 days, as defined in the 
sn_shop.default.supplier.onboard.time property of the purchasing properties table.

When a purchase requisition is created for a supplier product, it can have a purchasing task of 
type supplier onboarding. Over time, as purchase requisitions are completed, the onboarding 
time for a supplier is updated automatically as follows:

For a product category: Supplier onboarding time = Sum [Actual Duration of supplier tasks for 
purchase requisitions with purchase lines in a category]/Number of Supplier onboarding tasks.

Example calculation of supplier onboarding time:

Purchase Requisition A for 
Supplier A

Purchase Requisition B for 
Supplier B

Purchase Requisition C for 
Supplier C

• Supplier Task = Onboarding; 
Actual duration = 13 days

• Purchase line 1: Product 
Category = Hardware

• Purchase line 2: Product 
Category = Software

• Supplier Task = Onboarding; 
Actual duration = 15 days

• Purchase line 3: Product 
Category = Hardware

• Supplier Task = Onboarding; 
Actual duration = 21 days

• Purchase line 4: Product 
Category = Software

Calculated supplier onboarding time in days

• Hardware product category = (13+15)/2 = 14

• Software product category = (13 + 21)/2 = 17

Note:  If the calculation produces a decimal, always round up regardless of the value.

Sourcing time

Sourcing time indicates the average number of days taken to source a product from a supplier, if 
sourcing is required for products of a category.

The initial default value is three days, as defined in the sn_shop.default.sourcing.time property 
of the purchasing properties table. This value is updated over time, as sourcing requests for a 
supplier product are completed.

The sourcing time for a product category, product model, or supplier product is updated as 
follows:
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1. The actual duration values of all sourcing requests for supplier products are considered. An 
average of these values is calculated. This average is the new default sourcing time for this 
supplier product.

2. When the sourcing time is updated for a supplier product, it is recalculated for the related 
product model as an average of the sourcing times of all its supplier products.

3. When the sourcing time is updated for a product model, it is recalculated for the related 
product category as an average of the sourcing times of all its product models.

For any new product model, the sourcing time is the same as its referenced model category. For 
any new supplier product, the sourcing time is the same as its referenced product model.

Note: 

• If Spend categorization  of a product category is Not Addressable, the sourcing time is 
always 0.

• If the Purchase Line is of the state Closed Canceled, it indicates that sourcing did not 
occur for that purchase line. In this case, the average sourcing time of the supplier 
product is not updated.

Example calculation of sourcing time:

Sourcing Request A for MacBooks

Actual duration = 16 days

Purchase line 1 – Reseller A 
MacBook

• Purchase requisition 
line (PRL) State = Closed 
Rejected

• Product Model = MacBook

• Product Category = 
Hardware

Purchase Line 2 – Reseller B 
MacBook

• PRL State = Pending 
Approval

• Product Model = MacBook

• Product Category = 
Hardware

Purchase Line 3 – Apple 
MacBook (assume current 
sourcing time is 11 days)

• PRL State = Closed 
Canceled

• Product Model = MacBook

• Product Category = 
Hardware

Sourcing Request B for Lenovo Think Pads

Actual duration = 22 days

Purchase line 4 – Reseller A 
Lenovo Think Pad

• PRL State = Closed 
Rejected

• Product Model = MacBook

• Product Category = 
Hardware

Purchase Line 5 – Reseller B Think Pad

• PRL State = Pending Approval

• Product Model = MacBook

• Product Category = Hardware

Calculated sourcing time in days

• Reseller A MacBook = 16

• Reseller B MacBook = 16

• Apple MacBook = 11
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• MacBook Product Model = (16 + 16 + 11)/3 = 15

• Reseller A Lenovo ThinkPad = 22

• Reseller B Lenovo ThinkPad = 22

• Lenovo ThinkPad Product Model = (22 + 22)/2 = 22

• Hardware Product Category = (15 + 22)/2 = 19

Note:  If the calculation produces a decimal, always round up regardless of the value.

Purchasing time

Purchasing time indicates the average number of days taken to complete the purchase 
requisition workflow and create purchase orders for products in a category.

The initial default value is five days, as defined in the sn_shop.default.purchasing.time property 
of the purchasing properties table. This value is updated over time, as purchase requisitions for a 
supplier product are completed.

The purchasing time for a product category, product model, or supplier product is updated as 
follows:

1. The actual duration values to complete all purchase requisitions for supplier products 
are considered. An average of these values is calculated. This average is the new default 
purchasing time for this supplier product.

2. When the purchasing time is updated for a supplier product, it is recalculated for the related 
product model as an average of the purchasing times of all its supplier products.

3. When the purchasing time is updated for a product model, it is recalculated for the related 
product category as an average of the purchasing times of all its product models.

If the purchase requisition is of the Blanket order type, the purchase time for its purchase lines is 
not updated. Example calculation of purchasing time:

Purchase Requisition 
A for Reseller A

Purchase Requisition 
B for Reseller B

Purchase Requisition 
C for Reseller B

Purchase Requisition 
D for Reseller A

• Actual duration = 16 
days

• Purchase line 1

◦ Supplier product 
= Reseller A 
Apple MacBook

◦ Product Model = 
MacBook

◦ Product Category 
= Hardware

• Purchase line 2

• Actual duration = 13 
days

• Purchase line 3

◦ Supplier Product 
= Reseller B 
MacBook

◦ Product Model = 
MacBook

◦ Product Category 
= Hardware

• Actual duration 21 
days

• Purchase line 4

◦ Supplier Product 
= Reseller B 
Office 365

◦ Product Model = 
Office 365

◦ Product Category 
= Software

• Actual duration = 7 
days

• Purchase line 5

◦ Supplier Product 
= Reseller A 
Lenovo ThinkPad

◦ Product Model = 
Lenovo ThinkPad

◦ Product Category 
= Hardware
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◦ Supplier Product 
= Reseller A 
Office 365

◦ Product Model = 
Office 365

◦ Product Category 
= Software

Calculated purchasing time in days

• Reseller A MacBook = 16

• Reseller B MacBook = 13

• MacBook Product Model = (16+13)/2 = 15

• Reseller A Lenovo Think Pad = 7

• Lenovo Think Pad Product Model = 7

• Hardware Product Category = (15+7)/2 = 11

• Reseller A Office365 = 16

• Reseller B Office365 = 21

• Office 365 Product Model = (21+16)/2 = 19

• Software product category = 19

Note:  If the calculation produces a decimal, always round up regardless of the value.

Shipping time

Shipping time indicates the estimated number of days taken to ship a supplier product to a 
delivery location. This value is retrieved from the shipping time of a supplier.

Whenever the shipping time for a supplier is updated, the shipping times of all the supplier 
products belonging to that supplier reflect the same.

If the supplier product is created through a third-party integration, then the shipping time is 
updated from the values of the integration, and not from the supplier record.

Note:  If the product type of the supplier product is Service, then the value of shipping 
time is always 0.

Total lead time

Total lead time indicates the numbers of days taken to execute the purchase order of a supplier 
product and deliver it to the employee.

For a supplier product, the total lead time is calculated as:

• If sourcing and supplier onboarding are required,

Total lead time = [Supplier onboarding time from the referenced product category] + [Sourcing 
time of the supplier product] + [Purchasing time for the supplier product] + [Shipping time of 
the supplier product].

• If sourcing is required but supplier onboarding is not required,
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Total lead time = [Sourcing time of the supplier product] + [Purchasing time for the supplier 
product] + [Shipping time of the supplier product].

• If sourcing is not required and supplier onboarding is required,

Total lead time = [Supplier onboarding time from the referenced product category] + 
[Purchasing time for the supplier product] + [Shipping time of the supplier product].

• If sourcing and supplier onboarding are not required,

Total lead time = [Purchasing time for the supplier product] + [Shipping time of the supplier 
product].

The total lead time of a supplier product is recalculated every time the values of the above fields 
on the supplier product form are updated.

Note:  All the lead times are recalculated and refreshed after completion of each purchase 
requisition. For these calculations, only the purchase requisition data of the recent 12 
months is considered.

Ledger assignment rules

When a purchase line is created for a purchase requisition on the ShoppingHub portal, the 
details of capex account, expense account, and pre-paid account are auto-populated based on 
applicable ledger assignment rules.

The legal entity from a purchase requisition or a sourcing request determines its ERP source. 
This ERP source determines the appropriate ledger assignment rule for a product category, 
product model, supplier product, and a cost center.

For a purchase line, if rules are found for the supplier product, the related product model, and its 
product category, then the priority of in which those rules are triggered is in this order:

1. Supplier product with cost center

2. Product model with cost center

3. Product category with cost center
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4. Spend category with cost center

5. Supplier product

6. Product model

7. Product category

8. Spend category

Note:  If you have multiple ERP sources, you can create multiple rules but each rule can 
correspond to only one ERP source.

Create ledger assignment rules

Automate ledger account assignment for a purchase line by relating ledger accounts to a 
supplier product, product model, product category, spend category, and cost center.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Open the record of a product category, product model, or supplier product to which you want 
to add the ledger assignment rules.

2. From the Ledger Assignment Rules related list, select New.

3. On the form, fill in the fields.

Ledger Assignment Rules form

Field Description

Product category Product category that the ledger assignment 
rules apply to.

Spend category Spend category that the ledger assignment 
rules apply to.

Product model Product model that the ledger assignment 
rules apply to.

Supplier product Supplier category that the ledger assignment 
rules apply to.

Applies to specific cost center Controls if general ledger accounts are used 
for one or more specific cost centers.

Cost center Add cost centers.

This field is visible only if the Applies to 
specific cost center  check box is selected.

Applies to child product categories Controls if general ledger accounts are used 
for one or more child product categories.

Child product categories Add child product categories.

This field is visible only if the Applies to child 
product categories  check box is selected.
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Field Description

Applies to child spend categories Controls if general ledger accounts are used 
for one or more child spend categories.

Child spend categories Add child spend categories.

This field is visible only if the Applies to child 
spend categories  check box is selected.

Capex account Ledger account to post the capital expenses 
of this product after the purchase completion.

Expense account Ledger account to post the operational 
expenses of this product after the purchase 
completion.

Pre-paid account Ledger account to post the purchase 
expenses of this product after the purchase 
completion.

4. Select Submit.

Create shopping controls

Set conditions to control the visibility of supplier products for an employee or a department who 
visits the Shopping Hub  portal. Shopping Hub  administrators can manage access to products 
based on categories, suppliers, or any attribute related to a supplier product.​

Before you begin
Role required: sn_shop.shopping_hub_admin

About this task
Employees who meet these conditions cannot see products from specified suppliers or product 
categories while browsing or searching on the Shopping Hub  portal.

For example, you define a shopping control for an employee, Jane Doe, to exclude visibility for 
all products of the Apparel and Bags category. So, Jane Doe cannot see any products of this 
category on the Shopping Hub  portal.

Also, these supplier products are not visible on the Shopping Hub  portal when another employee 
shops as a delegate on behalf of Jane Doe.

Shopping controls can be overridden with employee credits. For details, see Shopping controls 
overridden by credits.

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > Shopping Controls.

2. Select New.

3. On the form, fill in the fields.

Shopping Control form

Field Description

Short description Description of the shopping control
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Field Description

For example, Shopping Control for Jane Doe.

Active Check box to determine if this shopping 
control is active.

Employee Exclusion Criteria section

User criteria Select from existing user criteria to whom the 
controls must apply.

User conditions Define conditions to identify the user to 
whom the shopping controls must apply.

For example, User ID  is  jane.doe.

Supplier Product Criteria section

Exclude supplier products if Define conditions to identify products that 
must not be visible to the employees who 
meet the defined user conditions.

For example,

Product Category  is  Computer Displays  OR

Max known price  is  1000 USD.

Note: 

If the shopping control is set to Active, a scheduled job is run once per day to find 
and update any new users or supplier products with the appropriate controls. This job 
considers:

◦ Users created after the last scheduled job run time.

◦ Supplier products created after the last scheduled job run time

4. Select Submit.

What to do next

• Apply the shopping control to your users and product catalog:

1. Open the shopping control record you created.

2. Select Implement control.

3. Reload the form:

▪ The User Control related list is populated with the records of users as defined in Employee 
Exclusion Criteria.

▪ The Supplier Products related list is populated with the records of supplier products that 
meet the conditions in Supplier Product Criteria.

• You can choose to deactivate any active shopping control.
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1. Deselect the Active  check box.

2. select Update

Any user which references to this shopping control is then updated so that this control is 
no longer applied to that user. On reloading the form, you can see that the User Control and 
Supplier Products related lists are empty.

Configure delegate for a shopper

Configure your employees as delegates to shop on behalf of someone else. For these 
employees, the Shopping as  option is available on the Shopping Hub  homepage to shop as a 
delegate.

Before you begin
Role required: admin

About this task
https://player.vimeo.com/video/1143155500?
h=f805eed3b4&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

When shopping as a delegate, the user can see the previous purchases and top supplier 
preferences of the delegate. The user can place orders and request pricing for the catalog and 
non-catalog items on Shopping Hub  on the behalf of the delegate.

For example, if Jo Sparks is shopping on behalf of a business owner Alan Edwards, Jo selects 
Alan Edwards from the Shopping as  option. The scope of products available for purchase on 
Shopping Hub  is then based on Alan Edwards' permissions and not Jo's. For all purchases that 
Jo submits on behalf of Alan, Alan Edwards is listed in the Business Owner  field and Jo is listed 
in the Submitted by  field.

With appropriate delegate properties, Jo can also view and act on the to-dos and approvals on 
behalf of Richard.

Note:  You can configure delegates to shop on your behalf only from Shopping Hub, and 
not from Employee Center.

Procedure

1. Navigate to All  > User Administration  > Delegates.

2. Select New.

3. On the form, fill in the fields.

Delegate form

Field Description

User The employee who the shopper can delegate 
as. For example, Alan Edwards.

Delegate The employee who can shop on behalf of the 
user. For example, Jo Sparks.

Starts The date from which the shopper can 
delegate.

Ends The date at which the shopper stops being 
the delegate.
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Field Description

Shopping as Indicates if the user can shop as the selected 
delegate on Shopping Hub. Ensure to select 
this check box.

This field is visible only in the purchasing 
view.

Approvals Indicates if the user can have the delegate 
authority for approvals.

Configure an approval rule for a delegate to 
ensure that the business owner has better 
visibility into the request before approval. For 
more information, see Configure approval 
rule for a delegate.

Assignments Indicates if the user can delegate task 
assignments.

CC notifications Indicates if the user can receive notifications.

Meeting invitations Indicates if the user can receive meeting 
invitations.

Configure approval rule for a delegate

Configure an approval rule for a delegate to ensure that the business owner has better visibility 
into the request before approval.

Before you begin
Role required: admin

About this task
https://player.vimeo.com/video/1143155520?
h=454a7a3524&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

In Shopping Hub, when a delegate checks out on behalf of the delegator, the default workflow 
assumes the delegate has full permissions to submit purchase requests (PRs). However, you can 
configure an approval rule to ensure that the first approval request is sent to the business owner 
(delegator). This configuration enables the delegator to review the approval request and decide 
whether to approve or reject it.

Procedure

1. Navigate to All  > Sourcing and Purchasing Automation  > Administration  > Approval Rules.

2. In the form, fill in the fields.

Approval Rule form

Field Description

Number System-generated unique identifier for the approval rule.

Name The name you assign to the approval rule.

Active Option to enable the approval rule.
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Field Description

Approving 
object

Object you’re seeking approval for. Select Purchase Requisition.

Approving 
line

Approving object line that you're seeking approval for. For the Purchase 
Requisition object, the approving line is defaulted to Purchase Line.

Approval rule 
type

The type of approval rule that determines how approval plans are generated 
and routed when conditions are met.

The following options are available:

◦ Dynamic Users or Groups

◦ Managerial Job Code Hierarchy

◦ Managerial Hierarchy

◦ Specified Users or Groups

Base 
approvals on

Purchase requisition fields that you want to base your approvals on. Select 
the Business owner  field and move it from Available to Selected.

Allow 
automatic 
approval

Option to allow automatic approval.

Note:  Ensure that you deselect this option.

Approval 
trigger 
conditions

Conditions based on the approving object that determine the conditions 
under which an approval plan is created.

See the following image to understand the approval trigger conditions you 
need to configure.

3. Select Submit.

ShoppingHub configuration

As an admin, you can create and modify ShoppingHub configurations to offer a standardized 
experience.

To provide a better end-user experience, use the ShoppingHub configuration to create the 
records. You can standardize the shopper experience procurement workflows such as request 
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modifications and sourcing checkouts. These records provide you more control and flexibility in 
your business process.

When you enable Edit or Cancel configuration options, your shoppers can raise revision 
requests in a self-service way from Service Catalog or ShoppingHub.

Related topics

Configure sourcing checkout details

Enable user actions

Enable a shopper to purchase on behalf of another user

Configure the Shopping Hub to enable a shopper to purchase on behalf of another user.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > ShoppingHub Configuration.

2. Select New.

3. On the form, fill in the fields.

ShoppingHub Configuration

Field Description

Name Name of the configuration

Configuration type Select Purchase on behalf of  from the list to 
enable purchasing on behalf of another user.

Active Check box that indicates whether the 
configuration is active.

Group of shoppers The group of shoppers who are authorized to 
purchase on behalf of other users.

Group(s) to be shopped on behalf of The group of users for whom purchases can 
be made on their behalf.

Individual shoppers Individual users who are authorized to 
purchase on behalf of other users.

Individual(s) to be shopped on behalf of The individual users for whom purchases can 
be made on their behalf.

4. Select Submit.
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Purchase modification configuration

As an admin, you can configure the conditions that must be met for the purchase modification 
records to be available to the shopper for editing or canceling.

The Appearance conditions  condition builder for each purchase modification record allows 
you to define these conditions based on your requirements and business needs. You can 
add conditions pertaining to credit purchase, purchase requisition or purchase order states, 
purchase requisition line or purchase order line states, product type, and much more.

Configure purchase modification record producers

Configure the conditions to make the purchase modification records available for the shopper 
to edit or cancel. You can leverage the condition builder to set specific conditions from the 
ShoppingHub Configuration table.

Before you begin
Role required: sn_shop.shopping_hub_admin or sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > ShoppingHub Configuration.

2. Open the user interface configuration record you want to set conditions for.

3. In the Appearance conditions  section, add or remove the desired conditions with values that 
must be met for the record to be available to the shopper to edit or cancel.

4. Select Update.

Configure sourcing checkout details

Manage the Shopping Hub  configuration to standardize the request fulfillment at the checkout. 
You can ensure the accuracy and availability of the required items in the procurement catalogs.

Before you begin
Role required: sn_spend_psd.admin, sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > ShoppingHub Configuration.

2. Select New.

3. On the form, fill in the fields.

ShoppingHub Configuration

Field Description

Name Name of the configuration

Configuration type Select the type from the available list. For 
example, user interface.

Display label Display label of the ShoppingHub 
configuration

Active Check box to determine the active status of 
this configuration

Page Page information for ShoppingHub 
configuration
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Field Description

Section Section information for ShoppingHub 
configuration

Record producer used for checkout Select the record producer.

The following record producers are used for 
sourcing checkout:

◦ ShoppingHub: sourcing a good checkout

◦ ShoppingHub: sourcing a service 
checkout

4. Select Edit sourcing checkout  to modify the details.

5. Select Submit.

Related topics

Sourcing checkout

Configure sourcing checkout

Enable user actions

Configure the edit and cancel options to enable modifications to the purchases.

Before you begin
Role required: sn_spend_psd.admin, sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > ShoppingHub Configuration.

2. Select purchase modification type, for example, Cancel purchase order  to modify the details.

3. On the form, fill in the fields.

ShoppingHub Configuration

Field Description

Name Name of the configuration

Configuration type Select the type from the available list. For 
example, user interface

Active Check box to determine the active status of 
this configuration

Page Page information for Shopping Hub 
configuration

Section Section information for Shopping Hub 
configuration, for example, User actions

Object Details of the object name, for example, 
Purchase order

Purchase modification type Details of the modification, for example, 
Cancel

Content type Details of the content type, for example, Label
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Field Description

Display label Name of the configuration label, for example, 
cancel purchase order

Buttons Details of the available options

Record producer Select the record producer. For example, 
Cancel purchase order

4. Select Update  or select Save  from the additional actions menu.

What to do next
Use the same steps to modify the following user action configurations:

• Edit purchase order

• Cancel purchase order line

• Edit purchase order line

• Edit purchase request

• Cancel purchase request

• Edit purchase request line

• Cancel purchase request line

You may add additional configurations to suit your business requirements.

Sourcing checkout

As a ShoppingHub or Procurement administrator, you can configure checkouts for sourcing 
requests to collect information that is relevant to the product, product model, or category. Your 
teams can automate the sourcing processes, share more information, and improve operational 
efficiency.

Using the catalog builder, you can create the record producer for mapping the Sourcing 
Checkout  during the checkout on ShoppingHub.

You can use the following capabilities:

• Configure the sourcing checkout when initiating a sourcing event.

• Enable the sourcing checkout flow by Supplier Product, Product model, Product Category.

• Provide better visibility into the procurement processes and checkout experience.

You can use the default or add a new sourcing checkout and customize the questions in an 
existing sourcing checkout based on your sourcing and procurement policies.

Related topics

Configure sourcing checkout

Complete sourcing checkout

Create sourcing checkout record

Create a custom checkout to use for sourcing requests for a specific product, product model, or 
product category.

Before you begin
Role required: sn_shop.procurement_administrator
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About this task
Utilize record producers to create a custom set of questions to ask Shoppers during checkout 
while initiating a sourcing request.

• You can use a sourcing checkout for all the goods or services using the default checkout from 
ShoppingHub Configuration.

• You can use a sourcing checkout for a specific supplier product, or a product model, or a 
product category from the Sourcing and Purchasing Automation  tab on each record.

Procedure

1. Navigate to a supplier product, a product model, or a category section.
For supplier model, All  > Sourcing and Purchasing Automation  > Primary Data  > Supplier 
Product  > Create new sourcing checkout.
Catalog builder opens.

2. Select Details  to update basic information about the record producer such as the name and 
description.

3. On the form, fill in the fields.

4. Select the Destination  tab and fill in the fields.

5. Select the Location  tab and select a catalog and category where requesters can find the item.
Fill in the fields or use the available information.

6. Select the Questions  tab and create custom or select from the preconfigured questions.
The following questions are available in the default sourcing checkouts.

Question set Description

ShoppingHub: Product & Other data for 
Checkout

Collects data about the product that is 
sourced from the Shopping Hub  product de­
tails page. Includes multiple variables that 
map to the cart line and purchase line. This 
is included in every Shopping Hub  checkout 
which cannot be removed when using the cat­
alog builder template.

ShoppingHub Checkout Delivery Date for 
Goods Selector

Select a delivery date or create a blanket PR 
for a good. Includes multiple variables that 
map to the cart line and purchase line.

ShoppingHub Checkout Delivery Date for 
Services Selector

Select a start date and end date or create a 
blanket PR for a service. Includes multiple 
variables that map to the cart line and pur­
chase line.

ShoppingHub Delivery Location Selector

Select an office location or add a new loca­
tion for a product or service to be delivered 
to. Includes multiple variables that map to the 
cart line and purchase line.

ShoppingHub More Info Request
Provide additional info while sourcing a prod­
uct. Maps to the sourcing request details field 
in the cart line and sourcing.

ShoppingHub Other Request

Provide details about “something else” when 
sourcing a product. Maps to the sourcing re­
quest details field in the cart line and sourc­
ing request.
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Question set Description

ShoppingHub Purchase Reason
Provide a reason for purchase. Maps to the 
purchase reason field in the cart line and 
sourcing request.

ShoppingHub Sourcing Intent

Select whether they want to receive a quote, 
a POC, more info, or something else about a 
good or service being sourced. Maps to the re­
quest type field in the cart line and sourcing 
request.

ShoppingHub: Good Delivery Date (only)
Select a delivery date for a good. Maps to the 
estimated delivery date field in the purchase 
line.

ShoppingHub: Service End Date (only)
Select an end date to a service. Maps to the 
end date field in the purchase line.

ShoppingHub: Service State Date (only)
Select a start date to a service. Maps to the 
start date field in the purchase line.

7. Select the Settings  tab and fill in the fields.

8. Select Review and Submit.

Related topics

Configure sourcing checkout

Record Producer

Create a record producer

Edit sourcing checkout record

Edit the default sourcing checkout used for all sourcing requests or create a custom checkout for 
sourcing requests for a specific product, product model, or product category.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
Use record producers to create a custom set of questions to ask shoppers during checkout while 
initiating a sourcing request.

• You can use a sourcing checkout for all the goods or services using the default checkout from 
ShoppingHub Configuration.

• You can use a sourcing checkout for a specific supplier product, or a product model, or a 
product category from the Sourcing and Purchasing Automation  tab on each record.

Procedure

1. Navigate to the default sourcing when sourcing a goods or product from All  > ShoppingHub  > 
Administration  > ShoppingHub Configuration  > Edit sourcing checkout.
The default source checkout opens on the catalog builder.

2. Select Details  to review and update fields about the record producer.

3. Review the Destination and Location  tabs.

4. Select the Questions  tab and add from the pre-configured questions.
See Create sourcing checkout record  for more information.
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5. Select the Settings  tab and fill in the fields.

6. Select Review and Submit  for a final review and submit the record producer.

Result
Edits to an existing sourcing checkout are now complete.

Related topics

Record Producer

Create sourcing checkout record

Create a record producer

Configure sourcing checkout

As an administrator, you can configure the sourcing checkout to collect information that is 
relevant to a specific product, product model, or product category. You can also change the 
default sourcing checkout used universally. The additional information at the sourcing checkout 
helps understand the requirement better and enable quicker processing.

Before you begin
Role required: sn_shop.shopping_hub_admin

Configure sourcing checkouts in Shopping Hub  to change all sourcing requests for a product or 
service throughout the system. Or you can configure for specific products and categories.

To configure a sourcing checkout for a product or service, you must first create the sourcing 
checkout from the purchasing automation tab of product, product model, or category. Simply 
select Create new sourcing checkout, for more information, see Create sourcing checkout 
record.

• Supplier Product: Create or change the sourcing checkout for a specific product from a 
specific supplier. For example, MacBook Pros 15 inch sold by a specific supplier, for example, 
Apple.

• Product Model: Create or change the sourcing checkout for a product model. For example, 
MacBook Pros 15 inch sold by any supplier.

• Product Categories: Create or change the sourcing checkout for a product category. For 
example, Laptops.

• Default Sourcing Checkout: Change the sourcing checkout for all sourcing requests of goods 
or services in ShoppingHub Configuration. From Catalog builder, edit the default checkout 
and submit.

Note:  Values defined at the supplier product take priority over the values defined at 
other levels.

About this task
Configure the relevant questions in this manner.
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Procedure

1. Select a sourcing checkout to use in one of the following locations:

◦ Supplier Product: Navigate to Sourcing and Purchasing Automation  > Primary Data  > 
Supplier Product.

◦ Product Model: Configure the details from ShoppingHub  > Model Management  > All 
Models.

◦ Product Category  Configure the details from ShoppingHub  > Category Management  > 
Product Categories.

2. From the Purchasing automation  tab, select the Sourcing checkout  field.

3. Select one from the available list and select Save.
The questions are now configured. When you leave the field blank, the default sourcing 
checkout questions appear at the time of checkout. When you have multiple sourcing 
checkouts defined, the following priority is applicable:

◦ Values defined at the supplier product take precedence over the values defined at the 
model or product level.

◦ Values defined at the product model take precedence over the product category.

◦ Values defined at the product category take precedence over default.

Note:  If you do not configure the sourcing checkout value, the default sourcing 
checkout is applicable.

Once you select sourcing checkout, shoppers can view, select, and provide relevant 
information associated with the procurement of the product or service.

Related topics

Record Producer

Create a record producer

Create sourcing checkout record

Shopping Hub process visibility configuration

As a procurement administrator, you can create and modify purchase process steps, work items 
involved in the process steps, and link the process steps and work items.

You can track your purchase requisitions, purchase orders, and sourcing requests using the 
process visibility tracker in the purchase detail view.

To configure the visibility tracker, you can define the process steps and work items involved in 
the purchase procedure. You can then link the work items to their respective process steps. 
You can also update the sequence and labels to ensure flexibility and alignment with business 
processes.

Add process steps

Create process steps involved in the product purchase cycle.

Before you begin
Role required: sn_shop.procurement_administrator
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Procedure

1. Navigate to All  > ShoppingHub  > Process visibility configurations  > Configure process steps.

2. Select New.

3. On the form, fill in the fields.

Step configuration

Field Description

Name Name of the process step.

Active Option to mark the process step as available 
for use.

Application Application for which the process step is 
being created.

Order Order in which this step is displayed.

Table Table that the process step belongs to.

Display conditions Conditions that must be met for the step to 
be visible on the form.

Start conditions Conditions that must be met for the step to 
start.

Empty state text Text that is displayed if there are no work 
items in the selected step.

4. Select Submit.

Add work items

Create work items to be added to the process steps involved in the product purchase cycle.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Process visibility configurations  > Configure work items.

2. Select New.

3. On the form, fill in the fields.

Purchase work item

Field Description

Name Name of the work item.

Application Application for which the work item is being 
created.

Table Table to which the work item belongs to.
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Field Description

Filter conditions Conditions to filter work items to be shown 
against the step.

4. Select Submit.

Link work items with process steps

Establish the relationship between the process steps and their work items.

Before you begin
Role required: sn_shop.procurement_administrator

Procedure

1. Navigate to All  > ShoppingHub  > Process visibility configurations  > Configure step and work 
item relationships.

2. Select New.

3. On the form, fill in the fields.

Step to Work item Relationships

Field Description

Step Name of the process step.

Work item Name of the work item.

Order Order in which the work item is displayed.

Work item's table Table that the work item belongs to.

Work item to procurement record path Dot-walk path from the work item’s table to 
the procurement record.

Application Application for which the work item is being 
created.

Active Option to mark the work item relation as 
available for use.

4. Select Submit.

Configure punchout for third-party site purchases

Set up punchout configuration to allow shoppers or employees to make third-party site 
purchases.

Before you begin
Role required: admin or procurement administrator

Procedure

1. Navigate to All  > ShoppingHub  > Primary Data  > Suppliers.
You can also navigate to Sourcing and Purchasing Automation  > Primary Data  > Supplier.

2. Ensure that the Punchout  check box is selected for the designated third-party supplier.
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Note:  This Punchout  option is only available in the Purchasing view. For more 
information on adding suppliers, see Add a supplier.

3. Navigate to All  > Procurement Integrations  > Catalog  > Third-Party Categories.

4. Do the following:

◦ Add the required mapping records between SPO's model category and the punchout 
supplier's product category.

◦ Add the required mapping records between SPO's predefined units and the punchout 
supplier's units of measure.

For more information, see Mapping Product Categories and Units of Measure for seamless 
checkout in Shopping Hub

5. Navigate to All  > Procurement Integrations  > Setup  > Third-Party Registration.

6. From the Supplier  list, search for and select a supplier.

7. Do either or both of the following depending on your implementation requirements.

◦ Select the cXML punchout support  check box and fill in the fields in the cXML punchout 
setup  tab.

The suppliers that do not have Search API and Order API or do not want to use them can 
upload catalog index files containing product catalog data. The uploaded data is stored in 
the Third-party Catalog (sn_spend_intg_third_party_catalog) table. For more information, 
see Add third-party catalog data in an Excel file.

Field Description

Require catalog 
index file upload?

Option that enables you to upload the catalog index CSV file. For more 
information, see Add third-party catalog data in an Excel file.

cXML domain The domain name associated with your organization for the punchout 
transaction.

cXML identity A unique identifier used to represent your organization in the punchout 
transaction.

Third-party cXML - connections

Order request 
URL

The URL endpoint where the cXML order request is sent to the supplier.

Punchout group The specific group for which this punchout configuration applies.

Punchout 
inbound 
credentials

The credentials that the supplier uses to authenticate when connecting 
to your system for punchout transactions.

Punchout 
outbound 
credentials

The credentials that you use to authenticate when connecting to the 
supplier system for punchout transactions.

Punchout start 
URL

The URL used to initiate the punchout session to the supplier system.

◦ Select the APIs exchange  check box and fill in the fields in the APIs configuration  tab.
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This option is designed for punchout suppliers using the Search API, Order API, and Product 
Details API, enabling shoppers to search for products, place orders, and view product details 
seamlessly within the Shopping Hub experience.

Field Description

Access 
token API

The URL/API used to authenticate and obtain an access token for API 
requests.

API Key/
Client ID

The unique identifier or key provided by the supplier to authenticate API 
requests.

Order 
detail API

The endpoint URL for retrieving detailed information about a specific product.

Place order 
request API

The endpoint URL for placing orders with the supplier.

Product 
details APO

The endpoint URL for retrieving detailed information about a specific product.

Product 
search API

The endpoint URL for searching products within the supplier's catalog. For 
more information, see Configure extension point for Product search API.

Punchout 
group

The specific group for which this punchout configuration applies.

Important:  If a supplier uses the Search API for product searches and cXML for order 
placement, you should select both the cXML punchout support  and APIs exchange 
check boxes and fill in the required fields in each corresponding section.

8. Select Submit.

What to do next
When integrating with a punchout supplier, customers are required to provide specific URLs for 
Order Confirmation and Shipping Confirmation. For more information, see Providing Order and 
Shipping Confirmation URLs to Punchout Suppliers.

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Setting up primary data for ShoppingHub

Service portal configuration for ShoppingHub

Customize your top suppliers on Shopping Hub

Using Shopping Hub

My purchases on Shopping Hub

Providing Order and Shipping Confirmation URLs to Punchout Suppliers

When integrating with a punchout supplier, customers are required to provide specific URLs for 
Order Confirmation and Shipping Confirmation.

These URLs must be configured correctly to confirm seamless communication between the 
customer's instance and the punchout supplier’s system.
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URLs to punch out supplier's system

URL name URL format

Order Confirmation 
URL instance-name/api/sn_spend_intg/punchout/

orderconfirmation/sys_id

Shipping Confirmation 
URL instance-name/api/sn_spend_intg/punchout/

shippingconfirmation/sys_id

Where:

• instance-name  is the customer’s instance name.

• sys_id  is the unique system ID of the punchout supplier record stored in the Supplier 
(sn_fin_supplier) table.

Configure extension point for Product search API

The sn_spend_intg.ThirdPartySystemApiExtension scripted extension point provides the 
configuration that punchout suppliers can use to ensure that all details about their product, 
such as product's name, brand, manufacturer, price, availability, SKU, and so on, is displayed in 
Shopping Hub.

View the third-party system API extension point format

View the format of the sn_spend_intg.ThirdPartySystemApiExtension extension point.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Extension Points  > Scripted Extension Points.

2. In the API Name  field, search for sn_spend_intg.ThirdPartySystemApiExtension 
and then select the link to open the extension point.
View the format of the extension point script.

Create script include for punchout supplier products

Create script include that enables you to display all the products details for the punchout 
supplier in Shopping Hub.

Before you begin
Role required: admin

About this task
Ensure that the application scope is set to Shopping Hub.

Procedure

1. Navigate to All  > System Definitions  > Script Includes.

2. Select New.

3. On the Script Include form, fill in the fields.
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Field Description

Name The name of the script include.

API Name Read-only and auto-populated API name.

Application The application where this script include resides. For example, Shopping Hub.

Accessible 
from

Sets which applications can access this script include.

Glide AJAX 
callable

Makes the script include available to client scripts, list/report filters, reference 
qualifiers, or if specified as part of the URL.

Mobile 
callable

Option to make the script include available on the mobile device.

Sandbox 
enabled

Option to let a client make changes to their script include without causing 
global affecting.

Active Enables the script include when selected. Deselect the active field to disable 
the script include.

Description Provides descriptive content regarding the script include.

Script The server-side script to run when called from other scripts.

The script must define a single JavaScript class or a global function. The class 
or function name must match the Name field.

Protection 
policy

Protection policy for script includes published as part of a custom application.

4. Select Submit.

Create extension instance for the scripted extension point

Create an extension instance to associate the punchout supplier's script include with the 
sn_spend_intg.ThirdPartySystemApiExtension scripted extension point.

Before you begin
Role required: admin

About this task
An extension instance is a registered instance of a scripted extension point that links a script 
include with a scripted extension point.

Note:  Ensure that the application scope is set to Shopping Hub.

About this task

Procedure

1. Select All and in the search filter, enter sys_extension_instance.LIST, and then press enter or 
return on your keyboard.

2. Select New.

3. In the Point  field, enter sn_spend_intg.ThirdPartySystemApiExtension.

4. In the Class  field, select the script include that you created.
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For more information, see Create script include for punchout supplier products.

5. In the Order  field, enter a number.
When multiple extension instances are available, the one with the least order value takes 
precedence.

6. Select the Active  check box.

7. Select Submit.

Mapping Product Categories and Units of Measure for seamless checkout in Shopping Hub

You can map the product categories and units of measure for third-party products to the 
corresponding model categories. This ensures that during checkout, Shopping Hub  accurately 
considers and displays the product category for the purchase order lines (POL) and purchase 
requisition lines (PRL) based on your predefined mappings.

Note:  You can configure the product category and unit of measure mappings for 
the products either before or after uploading the catalog index CSV file. However, it's 
recommended to define these mappings in advance whenever possible and reupload the 
CSV file if new mappings are added.

Create third-party unit mapping

Create a third-party unit mapping to align the punchout supplier's unit of measure with the 
predefined units of measure.

Before you begin
Role required: admin

About this task
The Unit of Measure (UOM) in a product catalog and category refers to the standard 
measurement used to quantify products or services. It ensures consistency in how items are 
presented, sold, and tracked, maintaining uniformity across transactions and processes. By 
standardizing measurements, UOM allows for the proper categorization and comparability 
of products with similar attributes, even if they come from different suppliers or have varying 
specifications."

Procedure

1. Navigate to All  > Procurement integrations  > Catalog  > Third-Party Units.

2. Select New.

3. On the form, fill in the fields.

Field Description

Third 
party 
unit

Standard of measurement defined by an external supplier for the products or 
services they provide.

Unit Units defined within ServiceNow  to which the third-party unit should be mapped.

A unit defines specific ways the products or services are quantified, billed, or 
packaged.

The available standard units are:

◦ Individual Unit

◦ Fixed Fee
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Field Description

Any custom unit created will behave like an Individual Unit in the purchasing 
workflow. For example, if a unit called Box is created and a user purchases 10 
Boxes, the system will treat it as a quantity of 10, even if each Box contains 5 
Individual Units.

Note:  Define a unit of measure conversion if you want to convert the 
purchased quantity into a different number of assets. For example, if a user 
purchases 10 Boxes, and each Box contains 5 Individual Units, the system will 
generate 50 assets.

Provider Supplier selling the product or service.

Note:  The supplier name must match the one provided in the third-party 
registration record.

Default
Option to set a third-party unit mapping as default. The default mapping is used 
when a third-party unit does not match with any of the existing predefined units.

4. Select Submit.

5. Navigate to All  > Procurement integrations  > Catalog  > Third-Party Catalog.

6. Ensure that all unit of measure mappings are accurate, and make any necessary updates.

Create third-party category mapping

Create a third-party product category mapping to map the punchout supplier's product category 
to SPO's model category.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Procurement integrations  > Catalog  > Third-Party Categories.

2. Select New.

3. On the form, fill in the fields.

Field Description

Name Category defined by an external supplier for the products or services they provide.

Model 
category

Shopping Hub category that the third-party category should be mapped.

Provider Supplier selling the product or service.

Note:  The supplier name must match the one provided in the third-party 
registration record.

Default
Option to set a third-party product category mapping as default. The default 
mapping is used when a third-party product does not match with any of the 
existing predefined model categories.
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4. Select Submit.

5. Navigate to All  > Procurement integrations  > Catalog  > Third-Party Catalog.

6. Ensure that all product category mappings are accurate, and make any necessary updates.

Add third-party catalog data in an Excel file

You can download and add third-party catalog data in an Excel file template.

Before you begin
Role required: admin

Procedure

1. Select All.

2. In the navigation filter, enter sn_spend_intg_third_party_catalog_list.do..

3. Right-click any column heading and select Export  > .xlsx.

4. Select Download  to save the spreadsheet on your local system.

Result
An Excel template is created with the required columns for adding the third-party catalog data. 
Use this Excel spreadsheet to enter the data that you want to upload and store into the Third-
party Catalog (sn_spend_intg_third_party_catalog) table.

What to do next
After adding the required data to the Excel file, upload it to store the data in the Third-party 
Catalog (sn_spend_intg_third_party_catalog) table. For more information, see Configure 
punchout for third-party site purchases.

Customize your top suppliers on Shopping Hub

Personalize the list of suppliers to see on your Shopping Hub  homepage. Update your list with 
the change in your preferences anytime.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.
You can see the Shopping Hub  homepage.

2. Scroll down on the homepage where you can see the list of suggested suppliers based on your 
role.

3. Select the more options icon and select Personalize.

4. From the list of suppliers, select those that you want to see on your Shopping Hub  homepage.
You can select up to 10 suppliers.

5. Select Save.

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Setting up primary data for ShoppingHub

Service portal configuration for ShoppingHub
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

586



Configure punchout for third-party site purchases

Using Shopping Hub

My purchases on Shopping Hub

Configure conditions for merging purchase requisitions

Configure the conditions under which the purchase requisitions (PR) should be merged.

Before you begin
Role required: sn_shop.shopping_hub_admin or sn_shop.procurement_administrator

About this task
The conditions that you set determine when to merge the purchase requisitions.

Note:  The existing default scenarios for merging purchase requisitions and purchase 
lines remain valid and function as they did previously. For more information, see Purchase 
requisition merging.

You cannot merge the PRs that are in any of the following states:

• Closed Complete

• Closed Canceled

• Closed Rejected

• Pending Submission

• Pending Cancellation

• Pending Revision

• Pending Supplier Confirmation

Procedure

1. Navigate to All  > ShoppingHub  > Administration  > ShoppingHub Configuration.

2. In the Configuration type column, select Merge configuration.
The Configuration type  field is set to Merge configuration  by default.
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3. The Active  check box is selected by default.
Deselect the Active  check box if you want to deactivate the merge configuration.

4. On the Merge conditions  tab, fill in the fields.

Field Description

Purchase 
table

Read-only field that shows the Purchase Requisition 
[sn_shop_purchase_requisition] table.

Merge 
type

The type of merge that you want to allow. The options are:

◦ Allow both: Enables you to configure both auto merge and manual conditions.

Displays both the Auto merge conditions and Manual merge conditions 
sections.

◦ Allow only auto merge: Enables you to configure only the auto-merge 
conditions.

Displays the Auto merge conditions section.

◦ Allow only manual merge: Enables you to configure only the manual-merge 
conditions.

Displays the Manual merge conditions section.

Matching 
conditions

Include custom fields that you want as part of the condition builder.

Move the required fields from the Available list to the Selected list.

Let’s consider a scenario with two PRs, PR1 and PR2. For these PRs to be 
merged, the values in the fields defined in the matching conditions must be 
identical in both PRs. For example, if the matching conditions contain the Cost 
center and Legal entity fields, PR1's cost center must match PR2's cost center, 
and the same goes for their legal entity values.
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Field Description

Auto 
merge 
conditions

Allows you to define conditions to automatically merge PRs, based on any of the 
fields available for a PR.

This section becomes available after you select the Allow only auto merge 
option in the Merge type  field.

Manual 
merge 
conditions

Allows you to define conditions to manually merge PRs, based on any of the 
fields available for a PR.

This section becomes available after you select the Allow only manual merge 
option in the Merge type  field.

5. Select Update.

Service portal configuration for ShoppingHub

As an admin, you can configure your service portal such that shoppers who are on the portal can 
quickly access ShoppingHub and even view purchasing and approval to-dos assigned to them.

You can perform these configurations:

• Add a ShoppingHub Navbar link

• Add a ShoppingHub icon link

• Add a ShoppingHub widget

• Verify and update search sources

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Setting up primary data for ShoppingHub

Configure punchout for third-party site purchases

Customize your top suppliers on Shopping Hub

Using Shopping Hub

My purchases on Shopping Hub

Add a Shopping Hub  Navbar link to your service portal

You can add a Shopping Hub  Navbar link to your service portal header menu so that shoppers 
can navigate from the service portal to the Shopping Hub  portal with a single select.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. From the Service Portals list, select the active service portal.

Note:  A green dot to the left of the list item indicates that it is active.

3. On the Main menu  field, select the Preview this record  icon.
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4. Select Open Record.

5. Select New.

6. On the Menu Item form, fill in these fields:

a. In the Label  field, enter ShoppingHub.

b. In the Type  field, select URL.

c. In the Order  field, enter 300.

d. In the HREF / URL  field, enter /now/shopnow?ref=sp_navbar.

e. In the URL target  field, enter blank  so that it opens in a new tab.

Note:  It is recommended that you use these settings. However, you can configure this 
otherwise as well.

7. Select Submit.

Add a Shopping Hub  icon link to your service portal

You can add a Shopping Hub  icon link to your service portal icons menu so that shoppers can 
navigate from the service portal to the Shopping Hub  portal with a single select.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  > Designer.

2. From the Service Portal Designer, select the Service Portal home page.

3. From Layouts, select Container  and drag it onto the page.

Note:  You must add a 4-column container here.

4. From Widgets, drag Icon Link  and drop it in the container.

5. On the Icon Link  container, select the Edit  icon.

6. On the Instance with Link form, fill in these fields:

a. On the Type  field, select URL.

b. In the HREF / URL  field, enter /now/shopnow?ref=sp_icon.

c. In the Title  field, enter Buy something.

d. In the Short description  field, enter Visit our procurement portal to purchase goods or 
services from any supplier.

e. On the Glyph  field, select the Basket  icon.

f. On the Template  field, select Circle icon.

Note:  It is recommended that you use these settings. However, you can configure this 
otherwise as well.

7. Select Save.
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Add a Shopping Hub  widget to your service portal

You can add a Shopping Hub  widget to your service portal so that shoppers can view the 
purchasing to-dos assigned to them from the service portal before getting redirected to work on 
them in the Shopping Hub  portal.

Before you begin
Role required: admin or sp_admin

Procedure

1. Navigate to All  > Service Portal  > Service Portal Configuration  > Designer.

2. From the Service Portal Designer, select the Service Portal home page.

3. From Widgets, drag My Purchasing To-Dos  and drop it in the page.

What to do next
You can select the individual to-dos or select View all  to view and work on them in Shopping 
Hub.

Verify and update search sources on your service portal

You can verify the search sources on your service portal and update them, as required, so that 
the required data is queried seamlessly from the respective instance tables.

Before you begin
Role required: admin or sp_admin

About this task
Verify that the appropriate search sources, including Suppliers and Purchasing, are listed for 
your service portal. These should be available by default. If for some reason they aren't, you can 
add them manually. For more information on search sources, see AI Search for Sourcing and 
Procurement Operations.

Procedure

1. Navigate to All  > Service Portal  > Portals.

2. From the Service Portals list, select the active service portal.

Note:  A green dot to the left of the list item indicates that it is active.

3. Verify that the Search Sources related list includes Suppliers and Purchasing.

Note:  If they aren't listed, here's how you can add them manually.

4. Navigate to Service Portal  > Search Sources.

5. From the Search Sources list, select Suppliers.

6. On the Portals related list, select Edit.

7. On the Edit Members page, move Service Portal  to your Portals List for Suppliers.

8. Select Save.

9. Repeat steps 5-8 for the Purchasing search source.

Install ShoppingHub Mobile

Install the Shopping Hub Mobile  application from the ServiceNow Store.
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Before you begin
Role required: admin

Role required: admin

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from the ServiceNow store.

3. Select Install.

4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, you need to install them first if they are not 
already installed.

Installing your application also automatically installs dependent applications or plugins if they 
are not installed already.

5. If demo data is available and you want to install it, select Load demo data.
Some applications include demo data, which are sample records that describe application 
features for common use cases. Load demo data when you first install the application on a 
development or test instance.

6. Select Install.

Related topics

Application plugin installation sequence in Sourcing and Procurement Operations

Shopping Hub Mobile

My purchases on your mobile

Using Shopping Hub Mobile

Enable the mobile experience for ShoppingHub Mobile

Enable the mobile experience for Shopping Hub Mobile  so that users can complete to-dos 
assigned to them and view and track their purchases from their mobile device.

Before you begin
Role required: admin

Procedure

1. Install the Shopping Hub Mobile  application plugin on your instance.

2. Download the Now mobile application on an iOS platform from the Apple App Store or on an 
Android platform from the Google Play Store.

For more information on using this mobile app, see Now Mobile app  topic.

3. Add the instance that has Shopping Hub Mobile  installed to the Now Mobile application and 
log in to access the application data on your mobile device.

What to do next
Log in to an instance with a mobile app
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Advanced Work Assignment for Source-to-Pay Operations

Use the Advanced Work Assignment for Source-to-Pay Operations  feature to automatically 
assign work items to agents based on availability and capacity.

Advanced Work Assignment for Source-to-Pay Operations  pushes work to qualified agents 
using work item queues, routing conditions, and assignment criteria that you define. For more 
information, see Exploring Advanced Work Assignment .

Prerequisites for installing Advanced Work Assignment for Source-to-Pay 
Operations

Before you install Advanced Work Assignment for Source-to-Pay Operations, ensure that 
you activate the Agent Chat  application and load the demo data during installation. For more 
information, see Activate Agent Chat and load demo data.

Required plugins

Install the Advanced Work Assignment for Source-to-Pay Operations  (com.snc.sn_spend_awa) 
plugin if you have the admin role. Installing this plugin also installs the following dependent 
plugins:

• Advanced Work Assignment  (com.glide.awa)

• Agent Chat  (com.glide.interaction.awa)

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Setting up Advanced Work Assignment for Source-to-Pay Operations

Plan and configure your implementation of Advanced Work Assignment for Source-to-Pay 
Operations.

Setting up Advanced Work Assignment for Source-to-Pay Operations  involves configuring the 
following components:

• Service channels: A means of providing optimum service to employees, shoppers, and 
requesters. Advanced Work Assignment  (AWA) offers base system channels for chats, cases, 
incidents, and walk-up centers. You can assign the work to an appropriate skilled group. The 
quantum of work can also be assigned more equitably among the group. For each channel, 
you can set attributes such as agent capacity and utilization conditions to control the work 
handled in the channel.

• Work item: A single piece of work handled by an agent from start to completion.

• Work item queue: A queue that stores a specific type of work item for a service channel.

• Assignment groups: Agents belong to specific groups organized by the type of work assigned 
to them.

• Assignment rules: Criteria that determine how work items are pushed to the appropriate agent 
within a qualified assignment group.

• Agent capacity: The maximum number of work items on a particular service channel that an 
agent may actively work on at a time. If you want to set a maximum capacity for an agent across 
all service channels, define the maximum universal capacity for that agent.
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• Agent availability: States that indicate agent presence, and whether the agent is available for 
work, busy, or offline. AWA  uses the agent availability state to determine if an agent is able to 
receive work.

• Inbox layout: A configuration tied to a service channel that defines which fields of a record 
representing a work item are shown in agent inboxes. A layout defines what the agent sees in 
the Source-to-Pay Workspace.

For more information, see Exploring Advanced Work Assignment .

Configure Advanced Work Assignment for Source-to-Pay Operations

Configure various components, such as service channels, work item queues, and assignment 
rules that determine how emails and chat interactions should be routed to agents.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment.

2. Create a service channel to automatically route incoming work to agents.

For more information, see Create or configure a service channel .

The following service channels are specific to Advanced Work Assignment for Source-to-Pay 
Operations.

◦ Procurement Cases: For more information,see Automatic case creation from emails.

◦ Chat. For more information,see Using Advanced Work Assignment for Source-to-Pay 
Operations.

Note:  Procurement administrators can also configure custom service channels for any 
work that may come through modes other than emails and chat, like SMS, or phone, for 
example.

After you’ve created a service channel, do the following:

a. Configure the agent capacity to determine the number of work items that can be 
automatically assigned to agents supporting a service channel. For more information, see 
Override agent capacity for selected agents .

b. Create or change an inbox layout to determine the information shown on work item cards 
displayed in an agent's inbox. For more information, see Create or change an inbox layout .

c. Create a work item size override if you want to calculate an agent's workload using a work 
item size other than the default. For more information, see Create or change a work item size 
override .

3. Define or modify a queue so that you can determine which work items are routed automatically 
to agents through a given service channel.
For more information, see Create a work item queue .

4. Set the Advanced Work Assignment  criteria for assigning work items to agents.
For more information, see Configure agent assignment rules .

5. Optional:  Configure the following parameters to improve your Advanced Work Assignment 
functionality:
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a. Create or modify the availability states that agents use to indicate whether they can receive 
work, or are offline or away. Agents set these states in their Workspace Inbox. For more 
information, see Configure agent presence states .

b. Define the reasons that agents can use to decline work assignments that they receive in 
their Workspace inbox. For more information, see Configure reasons for rejecting work 
items .

c. Prevent an agent from being assigned too many work items by configuring the agent's 
maximum universal capacity. For more information, see Configure an agent's maximum 
universal capacity .

d. Create or manage groups that have associated Advanced Work Assignment  queues. For 
more information, see Create or change groups for Advanced Work Assignment queues .

For detailed instructions on how to configure Advanced Work Assignment, see Configuring 
Advanced Work Assignment .

Configure the Sourcing and Procurement Operations  queues

Configure the Advanced Work Assignment for Source-to-Pay Operations  queues to ensure that 
email and chat requests are routed and assigned to specific agents belonging to defined groups.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Queues.

2. Select one of these queues specific to Advanced Work Assignment for Source-to-Pay 
Operations.

◦ General Ledger Accounting Queue

◦ Legal Review for Procurement Queue

◦ Strategy Sourcing Queue

◦ Service Desk & Others Queue

3. In the Assignment Eligibility related list, select New.

a. In the Agent assignment rule  field, select Chat - Most Capacity.

b. Select the lock icon ( ) next to the Groups  field.

c. Select the look-up icon ( ) to view the list of groups.

d. Select New.

e. In the Name  field, enter a name for the group.

f. Fill in the remaining fields, as appropriate.

g. Select Submit.

h. Select the lock icon ( ) to lock the Groups  field.

i. Right-select and select Save.

4. Next to the Groups  field, select the link to the group, which opens the group record.

a. In the Group Members related list, select Edit  to add members to the group.

b. Select one or more users in the Collection list and move them to the Group Members List.
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c. Select Save.

Note:  The users that you add to this assignment group are automatically granted the 
awa_agent role.

5. Repeat steps 3 and 4 for the remaining Advanced Work Assignment for Source-to-Pay 
Operations  queues.

Configure Agent Chat  for Source-to-Pay Workspace

Use Agent Chat Settings to configure Agent Chat  for Source-to-Pay Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Agent Chat.

2. In the User Experience section, swipe the Agent names and avatars  toggle switch to the right 
to enable this option.

3. In the Configurable Toolbar Controls section, select View All.
The Quick Action Toolbar Controls is displayed.

Add or update the quick action shortcuts for live agents in Agent Chat. For more information 
about configuring the toolbar controls, see Setting up quick action toolbar controls .

4. Select Save.

Using Advanced Work Assignment for Source-to-Pay Operations

Enables shoppers or requesters to interact with agents to resolve their issues and get answers to 
their questions.

The Advanced Work Assignment for Source-to-Pay Operations  application enables the following:

• Shoppers or requesters can start chat sessions using Virtual Agent  from Employee Center  to 
interact with live agents. For more information, see Virtual Agent for Sourcing and Procurement 
Operations.

• Agents, when online, get notified of incoming requests on new work items. By default, no more 
than five work items are assigned to an agent at a time. They can accept chat requests from 
the Source-to-Pay Workspace  Inbox page to interact with shoppers or requesters. They also 
have the option to reject the chat requests, or transfer them to other queues or agents with 
more expertise on that topic, if needed.

• Agents can use various features like response templates, knowledge base articles, Agent 
assist, and so on, to complete their work and resolve the queries or questions from the 
shoppers. For more information on these features, see Email composer with quick messages 
and response templates in Source-to-Pay Workspace  and Agent assist in Source-to-Pay 
Workspace.

• Agents can also create cases out of these interactions if any work item needs more analysis 
and help from the fulfiller. For more information on interactions, see Create a procurement 
case.

Automatic case creation from emails

Cases are automatically created from incoming emails from shoppers based on the keywords 
used by them in the subject lines and bodies of the emails.
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As an admin, you can set an email ID where all emails from shoppers are to be received. You can 
do this by navigating to All  > Procurement Case Management  > Administration  > Procurement 
Properties.

Note:  The following are some examples of cases created from emails with specific 
keywords.

• GL coding review cases are created from the keyword "accounting"

• Contract review cases are created from the keyword "contract"

• Sourcing related cases are created from the keyword "sourcing"

• General inquiry cases are created from the keyword "information"

Automatically create supplier case or procurement case from an inbound email

If you use the automatic case creation functionality in both Supplier Lifecycle Operations  (SLO) 
and Sourcing and Procurement Operations  (SPO), ensure that each instance is configured with 
a unique email address in the Automatic creation of cases from email property. This ensures 
the instance can correctly match incoming emails to the appropriate user and create the 
corresponding case.

For example:

• In SLO, set the email address to supplierhelp@acme.com for creating supplier cases. For more 
information, see Enable automatic creation of supplier cases from incoming emails.

• In Sourcing and Procurement Operations, set the email address to 
procurementhelp@acme.com for creating procurement cases.

This approach enables seamless case creation and accurate email-to-user mapping.

Integrating Sourcing and Procurement Operations  with other 
applications
Extend the capabilities of Sourcing and Procurement Operations  and connect with other 
departments by integrating with other applications.

Sourcing and Procurement Operations  integrations

Sourcing and Procurement Operations  (SPO) supports the following integrations:

Now Assist for Sourcing and Procurement Operations (SPO)

Use the Now Assist for Sourcing and Procurement Operations (SPO)  application to 
guide your requesters through a conversation-like experience for their procurement 
needs. The application uses procurement-related topics to route requesters to the 
appropriate intake channels, and then through conversation, helps to submit their 
requests.

For more information on this, see Now Assist for Sourcing and Procurement 
Operations (SPO).

Source-to-Pay Operations  with Contract Management Pro

With this application, provide streamlined cross-team collaboration and enable 
legal professionals to run their contracting work within the sourcing and purchasing 
process. With this integration, procurement specialists can initiate contract requests 
manually throughout the sourcing and purchasing process.
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For more information on this, see Source-to-Pay Operations integration with 
Contract Management Pro.

Project Costing for Sourcing and Procurement Operations

With this application, provide a set of capabilities to automate the calculation of 
planned versus actual cost by linking purchase orders to cost plans within Project 
Portfolio Management.

For more information on this, see Sourcing and Procurement Operations integration 
with Project Management.

Risk Assessments Integration for Sourcing and Procurement Operations

With this application, provide a set of capabilities to trigger risk assessments on a 
supplier during the sourcing or purchase requisition workflow using Third-party Risk 
Management.

For more information on this, see Sourcing and Procurement Operations integration 
with Third-party Risk Management.

ERP Integration Framework

With this application, provide integration support between the Platform and 
common ERP systems.

Source-to-Pay Integration Framework

With this application, provide a set of staging tables, transform maps, and workflows 
to integrate sourcing, third-party catalogs, ordering, shipments, and invoicing with 
Sourcing and Procurement Operations.

For more information on this, see Spendint API.

Procurement File Transfer Framework

With this application, extend the Source-to-Pay Integration Framework  with Secure 
File Transfer Protocol (SFTP) and File Transfer Protocol (FTP) functionality, designed 
for integrating with systems that do not support Representational State Transfer 
(REST) or Simple Object Access Protocol (SOAP) based integration methods.

For more information on this, see Procurement File Transfer Framework.

Primary Data Integration with SAP

With this application, provide your customers with the ability to fetch entity data like 
legal entity, cost center, material, supplier, and so on, from SAP ECC and SAP HANA 
into ServiceNow.

For more information on this, see Source-to-Pay integration with SAP.

Sourcing and Procurement Operations  Integration with SAP

With this application, provide your customers with the ability to send purchase 
orders, receipts, and returns created in Sourcing and Procurement Operations  to 
SAP ECC and SAP S4 HANA.

For more information on this, see Source-to-Pay integration with SAP.

Procurement for Field Service Management

With this integration application between Shopping Hub Mobile  and Field Service 
Management, help your field service agents to order a part or item that isn’t 
available on inventory, from a vendor or supplier.

For more information on this, see Sourcing and Procurement Operations integration 
with Field Service Management.
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Note:  This application is owned by the Field Service Management  team.

Sourcing and Procurement Operations  integration with IT Asset Management

The Asset Management Integration for Sourcing and Procurement Operations plugin 
(com.snc.sn_spend_asset) provides an integration between IT Asset Management  (ITAM) and 
Sourcing and Procurement Operations  (SPO) applications, enhancing operational efficiency.

This integration enables asset managers to access Shopping Hub catalog items, including 
the catalog items without assigned prices, directly within the ITAM workspace. By enabling 
procurement actions without switching platforms, it streamlines workflows and improves the user 
experience for asset managers and end users.

ITAM-SPO better together workflow

The procurement journey begins through an automated inventory stock order or when an end 
user submits a request for items from the service catalog. The asset manager then evaluates 
whether the request can be fulfilled by using available local stock, generating transfer orders, or 
creating purchase orders. After the asset manager identifies the appropriate purchase action, 
the better together experience begins.

The following figure illustrates the ITAM-SPO workflow.

1. Select this box to learn about stock rules.

2. Select this box to learn how to create an inventory stock order request.

3. Select this box to learn how to track a request.

4. Select this box to learn how to source requests from local stockrooms.

5. Select this box to learn how to create a transfer order from a request.

6. Select this box to learn how to create SR or PR via ITAM Workspace.

7. Select this box to learn how to receive assets in ITAM.

8. Select this box to understand the asset creation process in ITAM.

Roles required for the SPO-ITAM better together feature

Note:  Additional roles may be required based on the specific asset management product 
installed.
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Roles required for SPO-ITAM better together

Role Description

Asset Manager

[sn_spend_asset.spo_shopper]

Can work on assigned requests from the ITAM 
workspace by creating sourcing requests or purchase 
requisitions in SPO.

Software Asset Management 
administrator

[sam_admin]

Has full access to the Software Asset Management 
application.

Enterprise Asset Manager

[sn_eam.enterprise_asset_manager]

Has access to all Enterprise Asset Management  features 
except administrative functions.

Procurement User

[procurement_user]

Can do the following:

• Create purchase orders without a request.

• View requests and requested items.

• View transfer orders.

• Create a purchase order or transfer order when 
sourcing items for a request.

• View the vendor catalog.

Plugin dependencies for the SPO-ITAM better together feature

The following are the plugin dependencies that are required to use Asset Management 
Integration for Sourcing and Procurement Operations (com.snc.sn_spend_asset):

• Sourcing and Purchasing Automation (com.snc.sn_pr)

• Procurement (com.snc.procurement)

• Shopping Hub (com.snc.uib.sn_spend_uib)

Additional plugins may be required based on the specific asset management product installed:

• Base Asset (no additional plugins required)

• Enterprise Asset Management (com.sn_eam)

• Hardware Asset Management (com.sn_hamp)

• Software Asset Management (com.snc.samp)

Inventory stock orders

Typically, inventory stock orders are automatically submitted based on the stock rules 
configuration. Stock rules define the conditions under which a specified quantity of an asset is 
transferred from another stockroom or ordered from a supplier when the inventory in a particular 
stockroom falls below a defined threshold. For more information, see Stock rules .

The following are the prerequisites for creating a stock order via stock rules:
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• Application: Hardware Asset Management or Enterprise Asset Management

• Catalog Item: Hardware Inventory Stock Order

• Category: Asset Lifecycle

Note:  For an inventory stock order, the delivery address and quantity of items are 
predefined and can’t be modified.

End user requests via Service Catalog for IT assets

An asset manager or end user can manually submit a request. If a user has the Inventory user 
role, they can purchase more than 10 items. For more information, see Create an inventory stock 
order request . If the user is purchasing 10 items or fewer, a general service catalog request 
works.

Requesters can only make requests via service catalog for published and approved models. If 
an approved model is not available, contact Procurement or IT to request the items, based on 
your business process. For more information, see Publish models to the hardware or software 
catalog .

The following are the prerequisites for creating a request for more than 10 items:

• Application: Hardware Asset Management or Enterprise Asset Management

• Catalog Item: Hardware or Enterprise Inventory Stock Order

• Category: Asset Lifecycle

Note:  For requests of more than 10 items, the delivery address and item quantities are 
predefined and cannot be modified.

The following are the prerequisites for creating a standard end-user request for fewer than 10 
items:

• Application: Software Asset Management, Hardware Asset Management, Enterprise Asset 
Management, or Base Asset

• Catalog Item: Standard Hardware, Software, or Enterprise Request

• Category: Asset Lifecycle

Supported applications and flows in the ITAM-SPO better together feature

The ITAM-SPO better together feature supports the following applications and flows:

ITAM applications

• Software Asset Management (SAM)

• Hardware Asset Management (HAM)

• Enterprise Asset Management (EAM)

• Base Asset

ITAM flows covered as part of this better together solution include the following:

• Hardware, Software, and Enterprise Asset Standard Flows

• Hardware and Enterprise Inventory Stock Orders
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Create Sourcing Request or Purchase Requisition in SPO  via ITAM Workspace

As an Asset Manager, you can create an SR or PR in SPO  from the ITAM Workspace to fulfill IT 
and asset requests submitted through Employee Center.

Before you begin
Role required: sn_spend_asset.spo_shopper

About this task
After an employee submits a request through the Employee Center or an automated stock rule is 
triggered, the Asset Manager can view the request in the Service Catalog application and start 
sourcing and procuring the requested items from the appropriate ITAM Workspace.

The ITAM workspace used depends on the type of items being requested, such as hardware, 
software, or enterprise assets.

• Asset Workspace

• Hardware Asset Workspace

• Software Asset Workspace

• Enterprise Asset Workspace

To ensure a seamless integration between ITAM and SPO, the following updates have been 
implemented:

• SPO's Purchase Requisition (PR), Sourcing Request (SR), and Purchase Order (PO) tables are 
mapped to their corresponding tables in ITAM to enable smooth data flow between the two 
products.

• When a PR, SR, or PO is created in SPO, the associated data and states are synchronized with 
the corresponding PO in ITAM.

• The ITAM Purchase Order (PO), generated during the creation of a sourcing request or 
purchase requisition, provides visibility to both the employee and the asset manager.

• ITAM Purchase Order Lines (POLs) are generated after a supplier has been awarded in the 
sourcing request flow.

• The ITAM PO includes references to SPO’s SR, PR, and PO records.

• The ITAM POL includes references to SPO’s purchase requisition line (PRL) or POL records.

Procedure

1. Navigate to All  > Open Records  > Requests.

2. Open the request.

3. On the Catalog tasks  tab, select and open the sourcing task for the request.

4. Select Source Request.
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A confirmation message is displayed informing you that you're being redirected to the 
appropriate Asset Management workspace.

5. Select OK.

6. On the Sourcing page, select Purchase.

You' are guided through stages that enhance the better together experience using SPO’s 
Shopping Hub workflows, helping you efficiently source the products you need.

7. On the Select the requested items you want to purchase page, select the items that you 
requested.

8. Select Select Supplier.

9. On the Select suppliers for requested items page, select the suppliers from whom you want to 
buy the requested items.
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Note:  The purchase quantity you specify should not exceed the quantity specified on 
the original request in the Service Catalog application. In the Purchase quantity  field, if 
you specify a quantity that exceeds the original quantity, you see a message that informs 
you that the total quantity selected exceeds the quantity to be sourced.

10. Select Request items and checkout.
One of the following occurs depending on whether the requested items have a price 
associated with them.

◦ For products that do not have an associated price, the sourcing flow is triggered. For more 
information, see Create sourcing request from the ITAM Workspace.

◦ For products, that have an associated price, the purchasing flow is triggered. For more 
information, see Create purchase requisition from the ITAM Workspace.

11. Select Checkout.

Create sourcing request from the ITAM Workspace

As an asset manager, use SPO’s sourcing flow from the ITAM Workspace to complete checkout 
when the requested item doesn’t have contractual pricing.

Before you begin
Role required: sn_spend_asset.spo_shopper

About this task
This task describes the options you need to select and the information you need to provide after 
you select Request items and checkout  when the requested item does not have an associated 
price.

During checkout, asset managers interact with a user interface that is similar to Shopping Hub’s "I 
need a product" record producer to provide key details about the product to be sourced.

Procedure

1. Complete steps 1 through 10 as described in Create Sourcing Request or Purchase Requisition 
in SPO via ITAM Workspace.

2. On the Select the preferred supplier for the following items page, select Request items and 
checkout.
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3. On the form, fill in the fields in these sections.

Request items and checkout form

Section Option

Request 
details

From the What do you need for this request? list, select any of the following 
options:

◦ I need a quote

◦ I need a proposal

◦ I need a proof of concept

◦ I need more information about the products or suppliers

Delivery 
information

◦ From the Select delivery address  list, select a delivery address.

Note:  For an inventory stock order, the delivery address is predefined 
and cannot be modified.

◦ From the Default delivery date list, select one of the following options:

▪ As soon as possible

▪ A specific date

▪ I am not sure
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Section Option

Products

◦ Add the products you would like to request. Select the Open Preview  option 
to see a preview of the product and make any changes to the metric group, 
license metric, quantity, and so on. Select Update to save your changes.

Note:  You can select Add  to add additional products; however, the 
quantity that you specify must not exceed the number specified in the 
original request. However, for an inventory stock order, the quantity of 
items is predefined and cannot be modified.

◦ In the Why do you need these products?  field, enter a reason for buying 
these products.

Additional 
details

Enter any details or questions you want to mention.

Attachments Select +Add file  to add any attachments you would like to upload.

Note:  You cannot modify quantities through this record producer. To make quantity 
changes, go to the Supplier selection page.

4. Select Checkout.

A sourcing request (SR) is created.

What to do next
The Procurement Specialist accesses the SR in the Source-to-Pay Workspace  and initiates the 
sourcing process.

Create purchase requisition from the ITAM Workspace

As an asset manager, use SPO’s purchasing flow from the ITAM Workspace to complete 
checkout when the requested item has contractual pricing.

Before you begin
Role required: sn_spend_asset.spo_shopper

About this task
This task describes the options you need to select and the information you need to provide after 
you select Request items and checkout  when the requested item has an associated price.

Procedure

1. Complete steps 1 through 10 as described in Create Sourcing Request or Purchase Requisition 
in SPO via ITAM Workspace.

2. Optional:  Submit sourcing request for items without price.

3. On the Delivery location page, select a delivery location from the Delivery location  list.
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4. Optional:  Select Deliver to additional locations  to add additional delivery locations and 
specify the purchase quantity.

5. Select Continue to delivery date.

6. On the Delivery date page, select any of the following options:

◦ Get as soon as  (an estimated date auto-populates based on the current date)

◦ On a specific date

7. Optional:  Select Add another delivery date  to add another delivery date.

8. Select Continue to Payment method.

9. On the Payment method page, you can retain the selected cost center or select any of the 
following options:

◦ Use another cost center

◦ Pay with multiple cost centers
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10. Select Continue to purchase reason.

11. On the Reason for purchase page, do the following:

◦ In the Reason for purchase  field, enter a reason for making this purchase.

◦ Select +Add file  to add any attachments to this purchase.

◦ In the Watchlist  field, ad individuals who you want notified if any updates are made to this 
purchase.

12. Select Complete checkout.
A purchase requisition is created for the requested items in SPO.

What to do next
The Procurement Specialist reviews the requisition in the Source-to-Pay Workspace and 
converts it into a purchase order.
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Note:  The PO created in SPO (sn_shop_purchase_order table) references the 
corresponding PO generated in ITAM (procure_po table). The Asset Manager can monitor 
the progress of the SR, PR, and PO by closely tracking the PO within ITAM.

If the asset manager has the Shopping Hub shopper role (sn_shop.shopper), they can also 
view the status of their request directly in Shopping Hub.

The end user who submitted the original RITM continues to track and monitor the request 
status on the RITM record. Statuses between SPO and ITAM objects are synchronized so 
that updates appear in real time.

Receiving assets in IT Asset Management

As part of the Better Together integration, all asset receiving is handled within IT Asset 
Management (ITAM). When an item is initially received in ITAM, a receipt is automatically 
generated in SPO in the Pending Submission state.

After the buyer confirms receipt against the purchase order in ITAM, a corresponding receipt 
is automatically created for the associated purchase order in Sourcing and Procurement 
Operations. For more information about receiving assets in ITAM, see Receive an asset .

After the receipt is posted to the ERP system, the status of the SPO receipt changes to Posted.

Note:  The SPO receipt is read-only and cannot be modified.

To support seamless integration between SPO and ITAM, both the receipt and shipment tables in 
each application are retained. The required field mappings have been configured to enable data 
flow between both the applications.

As part of the receiving process, the ITAM receipt passes relevant data to the SPO receipt, which 
is read-only. ITAM also creates the associated assets.

As part of the shipment process, the ITAM shipment record passes shipment details to the SPO 
shipment record, which is also read-only.

After receiving the requested items, the asset manager or an employee can acknowledge receipt 
using the following ITAM receiving experiences:
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• Mobile barcode scanning. For more information, see Acknowledge receipt of an asset on a 
mobile device .

• From the Employee Center portal. For more information, see Acknowledge receipt of assets on 
the Employee Center portal .
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• From the ITAM purchase order. For more information, see Receive an asset .

.

Asset creation process in IT Asset Management

In IT Asset Management (ITAM), assets are created when you acknowledge the receipt of the 
requested items.

After receiving is completed, receiving slips are generated in ITAM, the associated assets are 
created, and the status of the PO is updated to Received. You can view the created assets in the 
Assets  tab of the ITAM purchase order. For more information, see Receiving assets in IT Asset 

Management.

Additionally, when receiving slips are generated in ITAM, corresponding read-only receipts are 
created in SPO.

The following occurs during the asset creation process in ITAM:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

611

https://www.servicenow.com/docs/access?context=t_ReceiveAnAsset&version=yokohama&pubname=yokohama-it-asset-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ReceiveAnAsset&version=yokohama&pubname=yokohama-it-asset-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ReceiveAnAsset&version=yokohama&pubname=yokohama-it-asset-management&ft:locale=en-US


• When a Hardware Asset Management (HAM) or Enterprise Asset Management (EAM) asset is 
received, ITAM creates a corresponding record in the alm_asset table.

• When a Software Asset Management (SAM) item is received, ITAM creates a corresponding 
entitlement in the alm_license table.

• When a consumable is received, ITAM creates a corresponding entitlement in the 
alm_consumable table.

Considerations for implementing the ITAM-SPO better together flow

This section provides information on considerations for implementing the ITAM-SPO better 
together solution.

Functional detail Description

PO and PR 
transaction 
behavior

To enable seamless integration:

• The Cancel  and Order  options are disabled for POs in ITAM.

• Edit and return flows for Purchase Requisitions (PR) and Purchase Orders 
(PO) in SPO are not supported in this integration. Therefore, the Confirm 
Revision  option is disabled when the PR is in the Pending Review state.

Acknowledging 
asset receipt in 
ITAM

• After asset delivery, the purchaser acknowledges receipt via the PO in 
ITAM. Assets are then created and can be viewed under the Assets  tab of 
the ITAM PO.

• In this workflow, no assets or receipts are created from the SPO PO.

• A read-only receipt is generated on the SPO POL only after the ITAM receipt 
slip is created.

Shopping Hub 
and IT Asset 
Management

As part of this flow, all IT asset, consumable, and enterprise purchases should 
go through the service catalog. Services purchases should continue to flow 
through Shopping Hub.

Shopping Hub controls should prevent IT asset purchases directly from the 
Shopping Hub catalog.

Supplier 
Product 
and Vendor 
Catalog Item 
table usage

When a purchase is initiated using the ITAM-SPO flow, the system doesn't use 
the Vendor Catalog Item (pc_vendor_cat_item) table. Instead, it uses SPO's 
Supplier Product (sn_shop_supplier_product) table to process the purchase.

How ITAM-SPO 
better together 
flow affects 
SAM-Coupa 
integration

The ITAM-SPO integration flow does not support the Software Asset 
Management (SAM) and Coupa integration. If you are currently using the 
SAM-Coupa integration and wish to continue doing so, do not install the 
Asset Management Integration for Sourcing and Procurement Operations 
(com.snc.sn_spend_asset) plugin.

If you choose to install the better together application, complete the following 
steps to successfully implement the SPO-Coupa integration:
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Functional detail Description

• Stop the “Create a Requisition” business rule from triggering on the ITAM 
Purchase Order table (proc_po) when the status changes to Ordered.

• Restrict the creation of new itam_procurement_integration_job scheduled 
jobs. Retire any existing daily jobs to avoid potential conflicts.

• Delete all business rules associated with the app-itam-procurement-
integration application to prevent integration conflicts.

• Ensure that Purchase Requests (PRs), Purchase Orders (POs), and Receipts 
in SPO are properly mapped to corresponding entities in Coupa for 
seamless integration.

Creation of 
assets for 
services

The creation of inventory assets for services in the alm_asset table is 
disabled in the Sourcing and Purchasing Automation and Asset Management 
Integration for Sourcing and Procurement Operations plugins. The previously 
created inventory assets for services are not affected. For fixed assets, ITAM 
continues to create corresponding records in the alm_asset table for services. 
Inventory asset creation for goods continues to function as before.

Sourcing and Procurement Operations  integration with Employee Center

As an employee, shopper, or requester, you can view all procurement case types available to 
you, knowledge articles, open to-dos and purchasing tasks assigned to you, track your requests, 
and even access your purchases on the Employee Center  (EC) portal by integrating Sourcing 
and Procurement Operations  with Employee Center.

Ensure that your admin has installed Employee Center, which is available as a zBoot plugin, 
for you to enjoy the seamless unified employee portal experience. Further, they may choose to 
install the employee content taxonomy plugin to access a prebuilt taxonomy for your service 
catalog, including the Purchases and Expenses topic.

Note:  To know more about EC and how to set it up as an admin, visit the Employee 
Center  home page.

Purchase and expense

You can view the following subtopics from the Purchase and Expense  tab:

• Invoices

• Supplier Services

• Corporate Cards

• Purchase Requests

• Travel and Expenses

Each subtopic includes both catalog items and knowledge articles. Procurement Service 
Management’s applications pre-populate some of these subtopics with content.

Select Browse all  to view all the above subtopics across categories. These include invoices, 
supplier services, third-party supplier sites, catalog and off-catalog products and services, 
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knowledge base articles, travel and expenses, and so on. You can set filters and avail the sorting 
options to refine your search results.

Note:  These subtopics are configured by the admin from the Employee taxonomy, where 
the search items are mapped to relevant connected content.

From Purchase Requests  in particular, you can do a bunch of things that include editing, 
canceling, or returning a purchase, buying something, requesting for a product or service, 
submitting a quote, requesting a copy of a contract, asking any queries to the procurement team, 
understanding what a sourcing request or purchase order is, and so on.

From Quick links, you can directly go to the list of third-party supplier sites, or visit ShoppingHub.

My tasks

As an approver, you can view your open and completed approval tasks, and also work on your 
open items, from My tasks. If you’re logged in as an employee or shopper instead, you can work 
on completing your procurement tasks.

Note:  Admins can create new to-do widgets to show up in Employee Center, or configure 
existing widgets from Employee Center  > Activity Configurations. For more information, 
see Employee tasks page .

In My tasks, you can filter your search by the following:

• Task type

◦ Approval

◦ Invoice

◦ Milestone

◦ Receipt

◦ Sourcing

• Due date

◦ Overdue

◦ Due soon: Tasks that are due in the next seven days.

• Priority

◦ Critical

◦ High

◦ Medium

◦ Low

• Created: Tasks that are created within the last four hours.

Note:  These filters are inactive by default. You can enable them by navigating to All  > 
Employee Center  > Administration  > To-do filter categories.

For detailed information on how to work with configurable task filters, see Configurable task 
filters .

My active items

As a shopper, you can view specific items from the widgets under the My active items  section. 
Some of these are:
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• Tasks: List of open tasks assigned to you, along with reminders on their statuses. You can 
update the fields to be displayed in the task cards by adding them to the to-dos configuration 
record.

• Purchases: Number of purchases made by you.

• Requests: Number of requests raised by you.

Others include surveys, invoices, purchase orders, risk assessments, issues, shipments, and so 
on. Selecting these takes you to their details page on ShoppingHub, where you can work with 
them as required.

Note:  Admins can also configure these active items widgets in Employee Center. For more 
information, see My active items widget configuration .

Search for punchout products in Employee Center

You can search for punchout products directly in Employee Center  using the AI search bar.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > Self-Service  > Employee Center.

2. In the search bar, search for any punchout product that you want to buy.

3. The punchout products that match your search criteria are listed in the Supplier site catalog 
tab.

Important:  Only cXML punchout products are displayed in the Supplier site catalog 
tab. The punchout products uploaded via API are not listed.
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4. Select a product to purchase.

You are redirected to the supplier site to add items to the cart. Depending on your setup, the 
following occurs:

◦ If you've installed Shopping Hub, you are redirected back to Shopping Hub  from the supplier 
site to complete the checkout process.

◦ If you haven't installed Shopping Hub, you must complete the checkout process and place 
the order on the supplier site.

For more information about the checkout experiences for shoppers based on whether they 
have installed Employee Center, Shopping Hub, or both, see Shopper checkout experiences 
based on installed applications.

Tracking your procurement requests in Employee Center

As a shopper, you can enjoy complete visibility into the progress of your requests by tracking 
your procurement cases in Employee Center.

As a shopper or employee, you can view the current status and track the progress of your 
procurement requests or cases in Employee Center. Not only can you view the complete list of 
steps involved in closing a case, but also those that have been passed or skipped on the way to 
closure.

You can navigate to your cases from All  > Self-Service  > Employee Center  > My Requests. 
Alternatively, you can go to All  > ShoppingHub  > ShoppingHub Home, and select My purchases 
from your profile list. Here, you can view all the procurement cases created against your 
purchases in the corresponding Cases  tab. Select View details  on a specific case to view the 
current state of the case, details on when it was created and last updated, progress, and so on. In 
both cases, you’re directed to your request details page in Employee Center.

Note:  You can track the progress for only those cases that have playbooks associated 
with them, such as edit or cancel a purchase, return goods to a supplier, and so on.

For your shoppers to view the complete list of steps on procurement cases or requests, relevant 
activities are provided with the Playbook status (sn_spend_sdc_playbook_status) table by 
default, with steps to be displayed to the shoppers mapped against the playbook steps that 
are displayed to the procurement specialists. Your administrators can add new activities and 
mappings, or edit these existing configurations, if required.

Note:  To view the progress bar on the case details page in Employee Center, ensure that 
a playbook is associated to that case, and that playbook status configuration records are 
created for the steps to be displayed in the Playbook status table.​

For more information on these playbooks available on Source-to-Pay Workspace, see:

• Process a purchase order edit in playbook

• Process a purchase requisition edit request in playbook

• Process a return request in playbook

Approve a request from Employee Center

Approve, reject, or request clarification on open purchase requisition lines and sourcing 
requests that are assigned to you, directly from Employee Center.
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Before you begin
Approval workflows are provided for purchase requisitions and sourcing requests by default. 
However, you can create approval workflows for other objects from Employee Center  to-do 
configurations.

Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the approval task that you want to work with.

3. View details of the approval request, such as requester name, total amount or budget requiring 
approval, and request ID at the header level.
At the line level, you can view the details of the requested items, such as product, approval 
amount, approval status, unit, price, quantity, total line amount, line number, reason for 
purchase, product type, delivery location, expected delivery date, and so on. You can also 
filter the purchase requisition lines by their approval status, and view associated activities and 
attachments in separate tabs therein.

4. Do one of these actions.

Action Description

Request clarification

Opens a confirmation dialog box, where you 
can enter your questions regarding the select­
ed purchase requestion lines or sourcing re­
quest. An email notification is sent to the re­
quester that some clarification is sought for 
the purchase, and a provide clarification to-
do is created for their action.

Note:  This correspondence is tracked 
through the activity stream of the ap­
proval plan here in Employee Center. 
The same is also tracked through the ac­
tivity stream of the corresponding pur­
chase requisition or sourcing request in 
Shopping Hub.

Reject

Opens a confirmation dialog box, where you 
can enter your reason for rejecting only the 
selected purchase requestion lines. An email 
notification is sent to the requester with this 
information.

Reject all

Opens a confirmation dialog box, where you 
can enter your reason for rejecting all the pur­
chase requestion lines or sourcing request. 
An email notification is sent to the requester 
with this information.

Note:  You’re redirected here if you se­
lect Reject  on the approval email notifi­
cation.

Approve
Opens a confirmation dialog box, where you 
can approve only the selected purchase re­
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Action Description

question lines. An email notification is sent to 
the requester with this information.

Approve all

Opens a confirmation dialog box, where you 
can approve all the purchase requestion lines 
or sourcing request. An email notification is 
sent to the requester with this information.

Note:  You can review the details and 
approve the purchase request directly 
from the email notification.

You can now view the approved and rejected approval tasks on the Completed  tab. Shoppers 
can view the same from their requests in Shopping Hub.

Note:  You can configure the above email notification based on your requirements. For 
details, see Approval email notification templates.

Approval email notification templates

Email notifications are triggered for new, due soon, and overdue approval to-dos in configurable 
templates. As an approver, you can review the details and approve the purchase requests 
directly from the email notifications.

When a purchase request that triggers an approval rule, is submitted, and you’re assigned as an 
approver for that purchase, a record is created in the sysapproval_approver table, and an email 
notification is sent to you. You can review the details of the purchase request therein, view the 
attachments if needed, and provide your approval directly from the email notification. This makes 
the approval task experience seamless for you, and at the same time expedites the purchase 
experience of the requester or shopper who immediately receives the approval notification.

Note:  When providing your approval from the email notification, ensure that the subject 
line of the response email has "approve" in it. Also ensure that there’s no mismatch in the 
approver's email address.

You may also reject the request, which redirects you to Employee Center  to complete the action. 
Here, you can also request clarification on the purchase request from the requester, if need be. 
For more information on this, see Approve a request from Employee Center.

These email notifications are triggered for new, due soon, and overdue approval to-dos in 
templates that customers can easily configure to meet their specific business requirements.

• Customers can modify the email content in flow designer or email scripts, according to their 
requirements.

• They can also choose to fetch and use other details that aren’t displayed in the email by 
default, such as order type for purchase requisitions, product type or request type for sourcing 
requests, and so on. For detailed information on email templates and how to work with them, 
see Email templates .

• Customers can also configure the email layout, and change the background color or font color, 
for example. The html field in the email layout record must be modified to achieve this. For 
detailed information on email layouts and how to work with them, see Email layouts .

Provide more details on your purchase from Employee Center

Provide additional information on your purchase from Employee Center  by answering the follow-
up questions that the procurement specialist has posted regarding your order. Your response to 
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these to-dos ensures that the procurement specialist understands your exact requirements and 
has all the necessary information before proceeding with the sourcing request.

Before you begin
To provide more details on your purchase, you should have received such requests from the 
procurement specialist. Only then, this to-do is displayed to you on Employee Center.

Role required: sn_shop.shopper

About this task
You can provide more information on the queries that the procurement buyer has posted for 
them to proceed with the sourcing request.

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as task number, due date, state, primary contact, requested 
supplier, requested product, quantity, total line amount, and so on.
You can track the updates on the selected task from the Activity  tab. You can also view and 
upload attachments associated with the task from the Attachments  tab.

4. In the What is the purpose of this purchase?  field, provide the necessary information to 
address the procurement buyer’s queries.

5. Select Submit.

What to do next
You can view the completed task in the Completed  tab.

Confirm meeting a milestone for your service from Employee Center

Provide confirmation from Employee Center  on whether the supplier has met a milestone for a 
service you had ordered, so that payment can be processed to the supplier for that milestone. If 
a milestone hasn’t been met by the due date, you can raise a cancel request or propose a new 
completion date.

Before you begin
To provide confirmation on meeting the milestone for a service you had ordered, you should 
have received the service by the due date or milestone that you had defined when placing the 
order. The milestone is displayed on the completion date defined on the milestone.

Role required: sn_shop.shopper

About this task
This confirm milestone completion task is automatically created by the system on the target 
completion date. This task is active for a day, after which it becomes overdue.

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as task number, due date, state, primary contact, milestone, 
expected completion date, payout amount, and so on.
You can track the updates on the selected task from the Activity  tab. You can also view and 
upload attachments associated with the task from the Attachments  tab.

4. Do one of these actions.
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Action Description

Comments
Provide your response, if any, and select Con­
firm.

Request to cancel

Request to cancel the milestone altogether.

On the Request to cancel milestone  window, 
provide your reason for canceling the mile­
stone, and select Submit.

Propose new completion date

Push the milestone to a later date.

On the Propose a new expected completion 
date  window, pick a new completion date, pro­
vide your reason for changing the date, and 
select Submit.

Note:  Milestones can be received in 
percentage and amount, but can only 
be deferred if not complete until they’re 
processed for the full milestone. This 
is because milestones are parts of the 
whole, and partials aren’t supported.

What to do next
You can view the completed task in the Completed  tab after the fulfiller has also reviewed and 
confirmed that the task is complete.

Review your service acknowledgment task from Employee Center

Review and acknowledge the receipt status of your ordered service from your supplier from 
Employee Center.

Before you begin
Service acknowledgment tasks are auto-created the first time on purchase order creation, and 
are triggered on a monthly basis by the Create Service Acknowledgment Task scheduled job. 
This scheduled job automatically picks all purchase order lines that have started and are yet 
to reach their end dates, and have some remaining amount or percentage or quantity to be 
delivered.

To review your service acknowledgments, your service request should have been reviewed and 
approved by a Procurement Specialist and converted to a purchase order. Only then, this task is 
displayed to you on Employee Center.

Role required: sn_shop.shopper

About this task
The due date of your service acknowledgment task is set based on the due date defined by you 
when placing the order.

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Pending confirmation  tab, select the task that you want to work with.

3. View details of the task, such as task number, due date, state, primary contact, purchase order 
number, supplier, order created, total amount, remaining amount, and so on.
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You can track the updates on the selected task from the Activity  tab. You can also view and 
upload attachments associated with the task from the Attachments  tab.

4. Do one of these actions.

Action Description

I didn't receive any services

Displays the Confirm you didn't receive any 
services  dialog box to record your confirma­
tion for that particular month. On confirma­
tion, the task is marked as Closed Complete 
and moved to the Completed  tab. The sched­
uled job will run to create a new task for you 
the following month.

Mark as received

Displays the Specify the quantity you re­
ceived  dialog box, where you can enter the 
received quantity for the selected purchase 
line for that particular month (if the unit of the 
supplier product is individual unit), or the re­
ceived percentage (if the unit of the supplier 
product is fixed fee). This information is now 
displayed in the Confirmed  tab.

Note:  If you select multiple purchase 
lines, you can't specify individual 
amounts or percentages for them, and 
the entire lines must be marked as re­
ceived. Also, if the purchase order line 
has fixed fee as the unit, then it’s auto­
matically set up for percentage.

Mark this task as complete

Displays the Confirm you didn't receive all 
services  dialog box to record your confirma­
tion for that particular month. On confirma­
tion, the task is marked as Closed Complete 
and moved to the Completed  tab.

Note:  Every time you confirm receiving a percentage of your order, a receipt of type 
Services is automatically created. This receipt can be viewed by a Procurement Specialist 
against your purchase order on Source-to-Pay Workspace.

What to do next
You can view the completed task in the Completed  tab.

Confirm receipt of your order from Employee Center

Provide confirmation of receipt of the items that you ordered that are in pending receipt state 
from Employee Center, so that payment is processed to the supplier accordingly. If you have not 
received the complete order, you can confirm receipt of a part of your order as well with the date 
when you received them.

Before you begin
To provide confirmation of receipt of your orders, you should have received a part of your order 
at least, if not the complete order. Only then, this to-do is displayed to you on the Pending 
confirmation  tab.

Role required: sn_shop.shopper
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Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Pending confirmation  tab, select the task that you want to work with.

3. View details of the task, such as task number, due date, state, primary contact, purchase order 
number, and so on.
You can view the current status of your ordered items, along with the tracking number and 
carrier name, from the Shipment details  tab. You can also track the updates on the selected 
task from the Activity  tab. Further, you can view and upload attachments associated with the 
task from the Attachments  tab.

4. Select the purchase line that you received and select Mark as received.
Displays the Specify the quantity and date you received this product  dialog box, where you 
can enter the received quantity and date when you received the selected purchase line. This 
information is now displayed in the Confirmed  tab.

Note:  If you select multiple purchase lines, you can't specify individual quantities or 
dates for them, and the entire lines must be marked as received with a single date.

What to do next
You can view the completed task in the Completed  tab.

View a link or video from Employee Center

Complete your task by viewing a link or video that your procurement specialist has assigned to 
you, directly from Employee Center. This action is listed as a task under My Tasks.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as the task number, due date, if any.

4. View the link or video in the task.
In case of CORS error in the network tab of your web page, ensure that your procurement 
specialist has provided the correct URL. For example, when rendering a YouTube video, ensure 
that the video source link or embedded link is provided while creating the task.​

5. Select Complete.

What to do next
You can view the completed task in the Completed  tab.

Upload a document from Employee Center

Complete the task that your procurement specialist has assigned to you by uploading a 
document, directly from Employee Center. This action is listed as a task under My Tasks.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.
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3. View details of the task, such as the task number, due date, if any.

4. Select the attachment icon to select one or more documents from your local drives, as 
required.
Alternatively, you can drag and drop documents from your local drives to attach them.

5. In the Upload a file  dialog box, select Upload  to attach the documents.
Once attached, you have the option to download, remove, or rename the documents, if 
required.

6. Select Mark as complete.

What to do next
You can view the completed task in the Completed  tab.

Sign a document using DocuSign from Employee Center

Provide your consent by signing a document using DocuSign, directly from Employee Center. 
This action is listed as a task under My Tasks.

Before you begin
Role required: sn_shop.shopper, supplier

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as the task number, due date, if any, and so on.

4. On the displayed document, select Continue.

5. Select Start.

6. Follow the arrowhead and select Sign.

7. Select Finish.

What to do next
You can view the completed task in the Completed  tab.

Sign a document from Employee Center

Provide your consent by signing a document, directly from Employee Center. This action is listed 
as a task under My Tasks.

Before you begin
Role required: sn_shop.shopper, supplier

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as the task number, due date, if any, and so on.

4. On the displayed document, you can choose to type your signature or draw it.
Based on what you select, you can either write your full name in the Full name  field, or draw a 
digital signature in the box provided.
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Note:  If you aren’t happy with what you see in the document, you can select I don't 
want to sign this document. You must enter your reason for declining, followed by 
Decline and complete  to complete the task.

5. Select Accept and complete.

What to do next
You can view the completed task in the Completed  tab.

Complete a form from Employee Center

Fill in a form that your procurement specialist has sent to you, and submit it directly from 
Employee Center. This action is listed as a task under My Tasks.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. Select the task that you want to work with.

3. View details of the task, such as the task number, due date, if any, and so on.

4. On the displayed form, fill in the details as required.

5. Optional:  Select Save as  if you want to save a draft in your requests and plan to complete it 
later.

6. Select Submit.

What to do next
You can view the completed task in the Completed  tab.

Raise a general inquiry for procurement

As a shopper, raise an inquiry for any pre-existing purchase or for any other queries that you may 
have regarding any procurement function.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > Employee Center  > Purchase and Expense  > Purchase Requests.

2. Select the Ask Procurement  card.

3. On the form, fill in the details of the query.

Field Description

Is this about a 
specific purchase?

Based on your requirement, select one of these.
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Field Description

◦ If your inquiry is about a pre-existing purchase, select Yes.

Note:  You can also raise this inquiry from All  > ShoppingHub 
Home  > My purchases, by selecting Inquire  from the more 
actions icon on a purchase.

◦ If your inquiry is about something else, select No.

Which purchase is 
this about?

If you have selected Yes  above, select the purchase request number 
from the list.

Note:  This number is automatically populated if you raise this 
inquiry from All  > ShoppingHub Home  > My purchases.

How can the 
procurement team 
help?

Describe your query. Based on your input here, related search results 
are displayed with relevant knowledge base articles.

Note:  Customers can configure the questions in the Ask Procurement form, introduce 
new questions, or enable additional validations, if required, from the respective record 
producer records.

4. Select Submit  to submit your inquiry, if none of the related search results have answered your 
query.

What to do next
A procurement case of type Inquiry is created under Procurement Cases  in Source-to-Pay 
Workspace, which is assigned to a fulfiller. The fulfiller can then help you with your inquiry.

Virtual Agent  for Sourcing and Procurement Operations

ServiceNow®  Virtual Agent  for Sourcing and Procurement Operations  enables shoppers to 
quickly find and purchase products that they're looking for from a vendor on ShoppingHub, by 
interacting with a virtual agent from Employee Center. It also allows shoppers to view purchases, 
procurement tasks, procurement cases, and even work on their to-dos. They can also get help 
from the procurement team using Virtual Agent.

For more information on Virtual Agent  in general, its components, benefits, and basic user 
interface, see Virtual Agent .

Sourcing and Procurement Operations  Virtual Agent  conversations and topic blocks

A topic conversation defines the dialog between the Virtual Agent  (chat support bot) and the 
user, which enables you to gather information for a specific business need.

You can create and reuse topic blocks to simplify the topic authoring and maintenance process. 
Topic blocks enable you to reuse standard procedures across conversation topics.

As part of the Sourcing and Procurement Operations  product, the following Virtual Agent  topic 
conversation and reusable topic blocks are provided:

• Request to purchase from a vendor

◦ ShoppingHub: Product Search

◦ ShoppingHub: Checkout - Delivery Location

◦ ShoppingHub: Checkout - Quantity
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◦ ShoppingHub: Checkout - Shipping Method

◦ ShoppingHub: Checkout - Delivery Date

◦ ShoppingHub: Checkout - Purchase Reason

◦ ShoppingHub: Checkout - Payment Method

• See my purchases

◦ View PR or PO

◦ View Purchase Details

• See my procurement tasks

◦ More Info

◦ PSM Select Supplier Task

◦ PSM Purchase Approval

◦ PSM Invoice Review Task

◦ PSM Confirm Receipt Task

◦ PSM Confirm Milestone Task

• See my procurement cases: View Procurement Case

• Get help from procurement: Browse PSM Content

To view just the reusable topic functions, navigate to the Topics page in Virtual Agent Designer 
and select the Topic Blocks  tab. For detailed information, see Reusable topic blocks .

Install Virtual Agent for Sourcing and Procurement Operations

Install Virtual Agent for Sourcing and Procurement Operations  from the ServiceNow Store.

Before you begin
Role required: admin, virtual_agent_admin

About this task
Activate the following plugins:

Name Description

Glide Virtual Agent (com.glide.cs.chatbot) Activates the Virtual Agent framework and 
other necessary plugins. This is a prerequisite 
for the Shopping Virtual Agent plugin to work.

Virtual Agent Experience Pack for 
Sourcing and Procurement Operations 
(com.sn_shop_va)

Activates a conversational bot platform 
for providing user assistance through 
conversations for Sourcing and Procurement 
Operations.

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from ServiceNow  store.
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Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select Install.

4. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed.

5. Optional:  If demo data is available and you want to install it, select Load demo data.

(Optional) Demo data comprises sample records that describe application features for 
common use cases. Load demo data when you first install the application on a development or 
test instance.

Important:  If you don't load the demo data during installation, it's unavailable to load 
later.

6. Select Install.

Enable Virtual Agent for Sourcing and Procurement Operations

Enable Virtual Agent for Sourcing and Procurement Operations  to start chatting with the Virtual 
Agent.

Before you begin
Role required: admin, virtual_agent_admin
The base system provides predefined Virtual Agent  topics (chatbot conversations). To customize, 
duplicate, and edit a topic, see Virtual Agent Designer

Procedure

1. Navigate to All  > Conversational Interfaces > Virtual Agent > Designer.

2. In the Category  field, select PSM Virtual Agent Topics.

3. In the Type  field, select Topics.

4. Select any topic to open it and view the conversation flow.

◦ To use the topic in a conversation with no changes, select Publish.

◦ To test the active, published conversation topic, select Test.

◦ To duplicate the topic so you can customize it, select Duplicate. Enter a name for the 
duplicate topic and select Save.

Note:  It is recommended that you use the conversation flow as delivered for optimum 
results.

NLU  support for Sourcing and Procurement Operations  Virtual Agent

You can set up Sourcing and Procurement Operations  Virtual Agent  to use Natural Language 
Understanding  (NLU) to understand word meanings and word contexts to infer user intent.

NLU  provides information that your virtual agent uses to determine what users want to do and 
to extract relevant values from their input. With NLU, your virtual agent offers a more natural and 
engaging conversational experience.

For more information, see Natural Language Understanding in Virtual Agent .
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The following intents are provided as part of the Sourcing and Procurement Operations  Model:

• ‑Browse Shoppinghub

• ‑ViewPurchase

• ‑Purchasing task

• ‑ViewProcurementCase

• ‑Get help from procurement

Set up NLU  for Sourcing and Procurement Operations  Virtual Agent

Set up Natural Language Understanding  (NLU) for Sourcing and Procurement Operations  Virtual 
Agent  before chatting with the Virtual Agent  to optimize the search experience.

Before you begin
Role required: admin, virtual_agent_admin
You must have the following plugin installed on your instance: Natural Language Understanding 
Models for Sourcing and Procurement Operations. For information on how to install the plugin, 
follow this procedure.

Procedure

1. Train and publish the NLU  model.

a. Navigate to NLU Workbench > Models.

b. Select Sourcing and Procurement Operations Model.

c. Select Train  to train your prediction server for the first time before you get started.

d. Select Publish  to publish the NLU  model.

2. Enable NLU  for Sourcing and Procurement Operations  Virtual Agent.

Note:  This is a one-time activity that you must perform to ensure that NLU  is enabled for 
Virtual Agent  in your instance.

a. Navigate to Conversational Interfaces > Virtual Agent > General Settings.

b. Select the Enable NLU in Virtual Agent  radio button to enable NLU.

c. In the NLU service provider  field, select ServiceNow NLU.

d. Select Save.

3. Integrate NLU  with Sourcing and Procurement Operations  Virtual Agent.

a. Navigate to Conversational Interfaces > Virtual Agent > Designer.

b. In the Category  field, select PSM Virtual Agent Topics.

c. In the Type  field, select Topics.

d. Select any topic to open it.

e. Select the Properties  tab.

f. In the Set up Natural Language Understanding (NLU)  section, NLU Model  field, select 
Sourcing and Procurement Operations Model.

g. In the Associated Intent  field, select the relevant intent.

h. Select the Flow  tab.

i. Select the first input entity.

j. In the User Input Properties  section, Name  field, enter Product service term.
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k. In the Associated Entity  field, select SupplierProduct.

l. Select the Enable NLU at Input Node  radio button.

m. Select the Skip confirmation for recognized entity  radio button.

n. Save and publish the topic.

Sourcing and Procurement Operations  integration with third-party sourcing 
solutions

ServiceNow  can integrate with third-party sourcing solutions to automate the sourcing process 
within the Sourcing and Procurement Operations  product. A generic, easily configurable 
sourcing integration framework is provided within Source-to-Pay Integration Framework  to enable 
you to specify the business criteria for triggering an integration. This integration framework can 
also integrate with multiple third-party sourcing solutions based on different criteria.

Customers can either build the connector to that third-party tool or find one in the ServiceNow 
store.

For example, Fairmarkit, a third-party solution, built and certified its own ServiceNow  application 
to the store, which leverages the integration framework to connect with the Fairmarkit system. For 
more information on this integration, visit store .

For information on decision configuration, see Decision configuration for third-party sourcing.

To learn about the integration tables, see Integration tables for third-party sourcing.

Third-party sourcing integration process

• If an integration is triggered, considering that applicable business criteria are defined in the 
decision table, and a request for pricing initiated by a shopper in ShoppingHub meets the 
criteria, one or more sourcing requests within a single purchase are automatically grouped 
into a single sourcing event. These are systematically created in the Sourcing and Purchasing 
Automation  application.

• When the negotiation setup playbook is complete, and the sourcing event is in the Work in 
Progress state, with the associated negotiations, sourcing requests, purchase lines, cases, and 
tasks in the Negotiation in Progress state, relevant data is populated in the Sourcing Outbound 
Queue, Sourcing Line Outbound Queue, and Negotiation Event Outbound Queue tables. This 
data can then be processed by the third-party solution accordingly, to initiate an RFx in their 
platform. Sourcing event is also created for the integrated sourcing request.

Note:  After a sourcing request is created and posted to the Sourcing Outbound Queue 
table, the third-party tool that is responsible for processing that sourcing request is 
identified and stored in the Third party tool name  field.

• A system property for the supplier responses close date (sn_spend_intg.u_bids.end.date) sets 
the Supplier responses close  field value on the sourcing event and sourcing requests to after 
the sourcing event has been created, plus the number of days defined. The default value is 
three days. The sourcing manager can override this value manually when updating this field on 
the sourcing event record.
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Note:  A schedule job can be set up in the ServiceNow  instance to check if the supplier 
responses close date has been reached (aka today). When done, ServiceNow  stops 
receiving bids from suppliers and moves all individual supplier negotiations within the 
sourcing event to the Pricing Obtained state, and then to Requires Decision. The sourcing 
manager or fulfiller can then award a supplier with the business. The timestamp of the 
supplier responses close date is 23:59:59 of the day the bids close, in UTC date/time 
format. As the sourcing manager, you can also decide to close the bids now, with the date 
and timestamp of now, and proceed with the awarding flow without any wait time.

• If the supplier responses close date changes on the sourcing request, then this update is sent 
to the Sourcing Outbound Queue table. The Supplier responses close  field is updated. Also, 
if a sourcing request or purchase line is canceled, this status is also sent back to the sourcing 
request or purchase line outbound tables respectively.

Note:  The supplier responses close date is read-only on the sourcing request, but 
any change of the supplier responses close date on the sourcing event rolls up to the 
sourcing requests.

• If there’s an error inserting new or updated records to this table, then the integration status 
is updated to Failed. The sourcing request at this point is in the Pending Resubmission state. 
The error details are captured in the Processing Message  field and the integration error task 
is displayed. The procurement specialist must address the error and then resubmit both the 
sourcing requests and sourcing event by selecting the Resubmit  button.

Note:  Currently, errors are logged only on the Sourcing Outbound Queue table.

• Suppliers are invited to participate in a bid and engage through the third-party application 
platform.

• When quotes are returned, the Sourcing Bid Stage table is populated by the third-party 
solution and the information is processed internally within ServiceNow  using a transform map 
to populate the purchase lines on the sourcing request.

Note:  When an RFx is created or awarded in the third-party tool, shoppers and sourcing 
managers are notified through emails and alerts from Shopping Hub  and Source-to-
Pay Workspace  respectively. Shoppers and sourcing managers are also notified about 
rejected bids, irrespective of the integration.

• If additional supplier bids are returned from the third-party solution, an existing logic in 
ServiceNow  determines if a new supplier, supplier product record, or both must be created.

• After awarding is done in ServiceNow, that information is sent back to the third party using the 
Awarded Supplier Outbound Queue table. Awarding can also be done in the third-party tool, in 
which case the data is received by ServiceNow.

For information on sourcing request, negotiation, and sourcing event flows, see Sourcing 
request, Negotiations  and Sourcing events, respectively. For more information, see Compare 
quotes and select a supplier.

Decision configuration for third-party sourcing

The Sourcing Event Generation Rule decision table in Sourcing and Procurement Operations 
helps the sourcing managers and procurement teams to configure the business criteria on 
demand, which provides them with flexibility to decide on the types of requests that should be 
integrated with a third-party sourcing solution.

If no decisions are configured, then sourcing requests aren’t sent to any external applications.
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When a shopper requests pricing for an item that must be sourced in ShoppingHub, the following 
decision inputs are automatically evaluated in ServiceNow:

• Sourcing request

• Purchase line

To configure a decision:

1. Navigate to Sourcing and Purchasing Automation  > Administration  > Decision Tables.

2. Select the Sourcing Event Generation Rule decision table.

3. On the Decisions related list, select New.

4. In the Label  field, enter a name for the label.

5. In the Answer  field, select an answer record for the given external application from the Third-
Party Sourcing Registration table.

Note:  If there are no existing external application records in the Third-Party Sourcing 
Registration table, create one with the following:

◦ Third-Party Sourcing Registration Code: User-defined code to be associated with the 
third-party sourcing registration.

◦ Third-Party Sourcing Registration Name: Name of the third-party sourcing registration to 
be integrated with ServiceNow.

6. In the Condition  field, configure the conditions using the sourcing request and purchase line 
decision inputs.

Note:  To send sourcing requests successfully to the applicable external third-party 
application, these conditions must be evaluated to be true.

Integration tables for third-party sourcing

Integration tables are used to interact with the third-party sourcing application. Relevant 
information that is required to conduct a Request for anything (RFx) in the third-party application 
is staged within ServiceNow  and transferred through APIs to the third-party application.

The following integration tables are used:

• Sourcing Outbound Queue, which stores the sourcing requests. It captures the items that 
must be sourced along with the shopper, employee, or requester's requirements from sourcing 
intake.

• Sourcing Line Outbound Queue, which stores the purchase lines associated with the sourcing 
requests. It captures the supplier details that the shopper, employee, or requester wanted to 
source from. Additionally, ServiceNow  sends any other suppliers that supply the same product 
model as the item that must be sourced.

• Negotiation Event Outbound Queue, which stores the negotiation type, objectives, third party 
sourcing event record, sourcing event number, and supplier response close associated with 
the sourcing requests.

• Sourcing Bid Stage, which is an inbound table used as part of the RFx process. It’s used 
to get the supplier responses to the RFx in real time from the third-party tool, back into the 
ServiceNow  instance.

• Awarded Supplier Outbound Queue, which stores the awarded suppliers. It captures the 
supplier details that are awarded in ServiceNow, and shares this data with the third-party tool 
for them to share the award business wins or losses with the suppliers.
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Sourcing Outbound Queue

Field Field type Description

City String Delivery city

Country String Delivery country

End date Other Date End date of the service

Expected delivery date Other Date Expected delivery date of the 
good

Grouped sourcing request 
number

String ServiceNow's sourcing event 
record number

Integration status String Integration processing status

Manufacturer String Name of the manufacturer

Manufacturer part number String Part number of the 
manufacturer

Maximum budget Decimal Internal budget provided by 
the requester

Preferred currency String Preferred currency of 
transaction

Processing message String Integration processing 
message

Product category String

Product model String Product model name. 
Required for catalog items.

Product model short 
description

String Short description of the 
product model

Product name String Product name. Required for 
off-catalog items.

Product type String Good or service

Purchase reason String Internal reason to purchase 
this item

Quantity Integer Quantity provided by the 
requester

Start date Other Date Start date of the service

State String Delivery state

Street String Delivery street

Sourcing request number String ServiceNow's sourcing 
request record number

Sourcing request short 
description

String ServiceNow's sourcing 
request short description

Sourcing request status String Status of the requester's 
intake record (sourcing 
request)
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Sourcing Outbound Queue  (continued)

Field Field type Description

Supplier responses close Other Date Formerly named Bids end 
date. This is the due date 
for all suppliers to provide a 
response to an RFx.

Third party tool name String Name of the third-party tool

Third party tool RFx ID String Event number of the third-
party tool

Third party tool RFx ID status String Event status of the third-party 
tool

Third party tool RFx URL String Event URL of the third-party 
tool

Unit String Unit populated on the product 
details

UNSPSC String UNSPSC code

Zip code String Delivery zip code

Sourcing Line Outbound Queue

Field Field type Description

Integration status String Integration processing status

Processing message String Integration processing 
message

Purchase line number String ServiceNow's purchase line 
record number

Sourcing out queue header Reference Reference to the sourcing 
outbound table

Sourcing request number String ServiceNow's sourcing 
request record number

Supplier company name String Supplier name. This can be 
requested by the requester or 
existing supplier providing a 
catalog item

Supplier email address String Email address of the supplier

Supplier ERP number String Identification number for the 
supplier in the ERP system

Supplier number String ServiceNow's supplier record

Supplier part number String Part number of the supplier
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Negotiation Event Outbound Queue

Field Field type Description

Integration status String Integration processing status

Negotiation objectives String Objectives or outcome of the 
negotiation

Negotiation type String Type of negotiation, such as 
quote for example.

Number String ServiceNow's sourcing event 
record number

Processing message String Integration processing 
message

Supplier response close Other Date Formerly named Bids end 
date. This is the due date 
for all suppliers to provide a 
response to an RFx.

Third party sourcing event 
record

String Third party's sourcing event 
record number

Sourcing Bid Stage

Field Field type Description

Grouped sourcing request 
number

String ServiceNow's sourcing event 
record number

Integration status String Integration processing status

Manufacturer String Name of the manufacturer

Manufacturer part number String Part number of the 
manufacturer

Preferred currency String Preferred currency of 
transaction

Processing message String Integration processing 
message

Product category String

Product model String Product model name. 
Required for catalog items.

Product model short 
description

String Short description of the 
product model

Product name String Product name. Required for 
off-catalog items. This is a 
required field.

Product type String Good or service

Purchase line number String ServiceNow's purchase line 
record number
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Sourcing Bid Stage  (continued)

Field Field type Description

Quote number String Quote number back from 
Request for Quote (RFQ)

Quote price String Quote unit price back from 
RFQ

Shipping amount String Quote shipping amount from 
RFQ

Sourcing out queue ID String Reference to the sourcing 
outbound table

Sourcing request number String ServiceNow's sourcing 
request record number. This is 
a required field.

Sourcing request short 
description

String ServiceNow's sourcing 
request short description

Supplier address String Supplier location: Address

Supplier city String Supplier city found on the 
quote

Supplier company name String Supplier name. This is a 
required field.

Supplier country String Supplier country found on the 
quote

Supplier County/District String Supplier location: County or 
district

Supplier delivery date Date/Time Supplier delivery date of the 
good

Supplier email address String Email address of the supplier 
found on the quote

Supplier end date Date/Time Supplier end date of the 
service

Supplier ERP number String Identification number for the 
supplier in the ERP system

Supplier fax number String Supplier fax number found on 
the quote

Supplier lead time (days) String Supplier lead time

Supplier notes String Notes from the supplier, if any

Supplier number String ServiceNow's supplier record

Supplier part number String Part number of the supplier

Supplier PO box number String Supplier PO box number 
found on the quote

Supplier primary phone 
number

String Supplier primary phone 
number found on the quote
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Sourcing Bid Stage  (continued)

Field Field type Description

Supplier quantity String Supplier quantity found on the 
quote. This is a required field.

Supplier region String Supplier location: Region

Supplier start date Date/Time Supplier start date of the 
service

Supplier State/Province String Supplier state found on the 
quote

Supplier street address String Supplier location: Street 
address

Supplier website String Supplier website, if provided 
on the quote

Supplier Zip / Postal code String Supplier zip code found on 
the quote

Third party tool name String

Third party tool RFx ID String Event number of the third-
party tool

Third party tool RFx ID status String Event status of the third-party 
tool

Third party tool RFx URL String Event URL of the third-party 
tool

Unit String Unit populated on the product 
details. This is a required field.

UNSPSC String UNSPSC code

Awarded Supplier Outbound Queue

Field Field type Description

Integration status String Status of the integration 
process.

Processing message String Describes the current 
processing status.

Purchase line number String ServiceNow's purchase line 
record number.

Purchase requisition number String ServiceNow's purchase 
requisition record number 
created after awarding

Quantity Integer Quantity of the goods or 
service awarded to the 
supplier.
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Awarded Supplier Outbound Queue  (continued)

Field Field type Description

Sourcing request number String Unique identifier of the 
sourcing request created 
inServiceNow's.

Supplier company name String Name of the supplier company 
that is awarded the quote.

Supplier ERP number String Identification number for the 
supplier in the ERP system.

Supplier number String ServiceNow's supplier record.

Third party tool name String Name of the third-party tool.

Third party tool RFx URL String Event URL of the third-party 
tool.

Sourcing and Procurement Operations  integration with Third-party Risk 
Management

Leverage relevant supplier risk assessment capabilities by integrating Sourcing and 
Procurement Operations  with Third-party Risk Management.

The following capabilities can be leveraged by customers if they have both the Sourcing and 
Procurement Operations  and Third-party Risk Management  applications installed:

• Connection between the Company and Supplier tables through the Related company  field. 
Also, leverage properties in the tables to synchronize other fields between the two tables at 
your own discretion.

• Viewing tiering assessments and risk assessments for a vendor in the Supplier table.

• Vendor Risk Reviewer role as a procurement specialist.

• Adding members to the Governance, Risk, and Compliance  (GRC) group, containing the new 
Purchasing Task Owner role.

• Automation of the Valid risk assessment  field in the Supplier table.

• Enhancements to the existing Conduct a Supplier Risk Assessment case.

• Creating a new Conduct a Supplier Tiering Assessment case. This is automatically triggered 
based on its requirement specified in the Tiering assessment needed?  field in the Supplier 
table.

Note:  This is unique to the Risk Assessments Integration for Sourcing and Procurement 
Operations  application and is not available if the customer has Sourcing and 
Procurement Operations  alone.

Risk Assessments Integration for Sourcing and Procurement Operations 
application

Customers can use the Risk Assessments Integration for Sourcing and Procurement Operations 
application for leveraging certain capabilities if they have both the Sourcing and Procurement 
Operations  and Third-party Risk Management  applications installed.

With this application, the Related company  field is defaulted from the current application. This 
new reference field displays under the Global company  field as a reference to the Company 
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table. This field is only available when the Third-party Risk Management  and Sourcing and 
Procurement Operations  applications are installed. Also, the Tiering Assessments and Risk 
Assessments related lists in the Supplier table are only available when the Third-party Risk 
Management  and Sourcing and Procurement Operations  applications are installed.

Company table connection

Two new fields are added, one in the Supplier table named Related company, and another in the 
Company table named Supplier  that references the Supplier table.

When you open any existing supplier record in the Supplier table, you can link it to an existing 
record in the Company table with the Related company  field. If that record does not exist, the 
procurement administrator creates a record in the Company table to establish the connection.

When you create a new supplier record in the Supplier table, a new vendor record is 
automatically created in the Company table with read-only reference to the Supplier table.

Valid risk assessment visibility in the Supplier table

Tiering and risk assessments on a vendor can be created on the vendor record in the Third-
party Risk Management  application. These assessments are made visible in the Supplier 
table as related lists, to validate any supplier in Sourcing and Procurement Operations. A 
procurement specialist, containing the Vendor Assessment Reviewer role can read any vendor 
risk assessment data.

For information on tiering and risk assessments on a vendor, see Manage vendor tiering 
assessments  and Manage vendor risk assessments .

Valid supplier risk assessment

To determine if a supplier has a valid risk assessment, a scheduled job is run, and the customer’s 
system administrator can configure its frequency. This job keeps the Valid risk assessment  field 
in the Supplier table up-to-date, based on the Risk rating valid to  field on risk assessments in 
the Vendor Risk Assessments table.

A risk assessment is considered valid when:

• Today's date is on or before the date defined in the Risk rating valid to  field.

• The value in the Valid risk assessment  field in the Supplier table is Yes.

A Conduct a Supplier Risk Assessment case is created if a risk assessment is invalid. Risk 
assessments can be triggered manually by the Vendor Risk Manager, or automatically from any 
change in vendor tier rating.

Enhancing the Conduct a Supplier Risk Assessment case

A Vendor Risk Manager can be assigned the Conduct a Supplier Risk Assessment case to 
validate a supplier's risks and to ensure that the supplier does not pose risks to the company.

The existing Conduct a Supplier Risk Assessment case is enhanced such that:

• The GRC group contains the Purchasing Task Owner role, with visibility and access to the case.

• The case has a related list of the risk assessments, both valid and expired, for better visibility.

Creating a new Conduct a Supplier Tiering Assessment case

A new Conduct a Supplier Tiering Assessment case can be created in either of these methods, 
and assigned to the manager of the GRC group:
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• Automatically, triggered based on its requirement specified in the Tiering assessment 
needed?  field in the Supplier table. If the risk rating of the related supplier is critical, high, or 
empty, a Conduct a Supplier Tiering Assessment case is auto-triggered.

Note:  This is unique to the Risk Assessments Integration for Sourcing and Procurement 
Operations  application and is not available if the customer has Sourcing and 
Procurement Operations  alone.

• Manually, by a customer.

You can customize this case through the Supplier Tiering Assessment case templates, by 
defining the Sourcing decision dependent on case  field to decide if this case should stop the 
sourcing request from moving into the Requires Decision state. The default value of this field is 
Yes. In this scenario, if all purchase requisition lines are in the Pricing Obtained state, and there 
are other cases still open, the sourcing request moves to the Awaiting Task Completion state. 
When the open cases are closed, the sourcing request moves to the Requires decision state. 
When the Sourcing decision dependent on case  field is set to No, and if all purchase requisition 
lines are in the Pricing Obtained state, then the sourcing request will be in the same Pricing 
Obtained state even if other cases are open.

If the sourcing request gets converted to a purchase request, the case is available to be 
completed in the purchase requisition.

Note:  All tiering assessments for a supplier are displayed in related lists.

For more information on sourcing requests, purchasing tasks, and procurement cases, see 
Sourcing request  and Purchasing tasks and procurement cases.

Sourcing and Procurement Operations  integration with Project Management

Eliminate manual efforts of linking purchase orders to projects by integrating Sourcing and 
Procurement Operations  with Strategic Portfolio Management's Project Management.

The Project Costing for Sourcing and Procurement Operations  plugin (sn_spend_ppm) provides 
this integration. This plugin has dependency on the following applications that can be purchased 
separately:

• Sourcing and Purchasing Automation

• Source-to-Pay Common Architecture

• Finance Common Architecture

• Common Service Delivery

• Procurement Case Management

• Source-to-Pay Workspace

• Supplier Common Architecture

• Playbook Experience

• Document Templates

• Common Vendor Core

The plugin also has dependency on the following system plugins that need to be installed 
separately:

• External User Self-Registration

• Finance Applications - Common Dependencies
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• Fiscal Calendar

• GraphQL Plugin

• Insert Multiple Web Service

• PPM Standard

• Process Automation Designer Core

• Process Automation Designer for App Engine

• Scoped Application Restricted Caller Access

• Signature Pad

• User Criteria Scoped API

• Vendor Core

Important:  Your administrator must manually assign the IT Project User, which is a 
licensed role, to your shopper for them to view project details during checkout. Also, as part 
of the Source-to-Pay pricing initiative, your administrator must manually assign the PPM 
user role to your procurement specialist.

With this integration, project managers or shoppers can associate a purchase with a project, 
which provides the reason for making the purchase, but also automatically creates cost plans 
and expense lines for that project. This enables project managers, shoppers, and procurement 
specialists to easily track planned costs each time a purchase is made for a Project Management 
project, and realize actual costs each time an invoice is paid for a Project Management  project 
purchase.

Impact on checkout and purchase details

When this application is installed, you must answer the additional question Is this a purchase 
for an existing project?  during checkout. If your answer is in the affirmative, you must select your 
project from the list to proceed with the checkout.

Each project name is associated with a demand number, both of which are then auto-populated 
in the Purchase Reason  field. You can add more information in the Purchase Reason  field if you 
want to. On completing your checkout, these details are displayed on the purchase details page.

Note: 

• If this purchase isn’t made for an existing project, you must mention the reason for 
purchase in the Purchase Reason  field to proceed with the checkout.

• During full checkout, you can select a project for the entire purchase or individually at the 
product level.

• You can’t select a project for a credit purchase.

Impact on purchase request line and purchase order line tables

When a purchase request is created, you can configure the Purchasing Details form layout on 
the purchase request line table to display the Project  field. This field references the selected 
demand record. Similarly, when a purchase request line is converted to a purchase order line, 
you can configure the Summary Details form layout on the purchase order line table to display 
the same Project  field.

As part of this integration, whenever a purchase is ordered as part of a demand or project, a cost 
plan is automatically created in association with that purchase order line. You can configure the 
Summary Details form layout on the purchase order line to display the new Cost plan  field. A 
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Purchase Order Lines related list is also added to the corresponding cost plan record. On the 
Cost Plan form, the Total planned cost  field is auto-populated based on when the purchase 
order had been generated. The Total actual cost  field is populated based on invoice and 
expense line creation.

For information on how to configure a form layout, see Configuring the form layout .

Impact on invoice line and expense line tables

When an invoice is created, and both the invoice and the invoice line are in the Paid state, an 
expense line is automatically created for the project. This expense line has an Invoice Lines 
related list reference.

For more information on invoice creation, see Invoices.

Impact of demand and project lifecycle on Sourcing and Procurement 
Operations  flows

When a demand is converted to a project as part of demand and project lifecycle:

• The demand number isn’t available for selection during checkout.

• When a purchase request line using that demand number is converted to a purchase order 
line, the latter references the project and not the demand number.

• The cost plan references the newly created project and not the one initially selected by the 
shopper.

• When an invoice is created, the associated expense line references the project and not the 
demand number.

When a demand or project is in a closed state:

• The demand or project number isn’t available for selection during checkout.

• Cost plans and expense lines aren’t created for closed demands and projects. However, if a 
cost plan is already created for a closed demand or project, expense lines continue to be auto-
generated until all the invoices are paid out.

Impact on sourcing request

When requesting pricing for a product that doesn’t have pricing available, you must answer the 
additional question Is this a purchase for an existing project?. If your answer is in the affirmative, 
you must select your project from the list to proceed with submitting the request. On successful 
submission, the project and demand details are displayed on the sourcing request record.

As a shopper, you can compare the pricing for your purchase, select a supplier, and proceed to 
checkout.

Impact on off-catalog purchase request

When requesting a quote for a product that is not available on the ShoppingHub catalog, you 
must answer the additional question Is this a purchase for an existing project?. If your answer 
is in the affirmative, you must select your project from the list to proceed with submitting the 
request.
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Email notifications

When a purchase order associated to a demand or project is created, updated, or canceled, the 
assigned demand manager or project manager gets an email notification about its impacts on 
the cost plans of the demand or project.

Sourcing and Procurement Operations  integration with Celonis

Identify inefficiencies in your customer business process, understand their business impact, 
and gain insights into the root causes, by integrating Sourcing and Procurement Operations  with 
Celonis.

Some insights provided by Celonis are listed here.

• Inconsistent payment terms: Where the payment terms agreed with the supplier is Net 45 on 
the supplier primary record, but invoices have an earlier payment term like Net 15 or Net 30. 
Such inconsistent payment terms, if not recognized, may lead to an inefficient usage of the 
working capital and the days payable outstanding of the customer may get reduced.

• Duplicate suppliers: Where a same supplier is wrongly created twice, for example, “California 
Academy of Sciences” and “The California Academy of Sciences.” Such duplicate records may 
confuse end users, with some invoices getting created for the first supplier and some for the 
second. This makes supplier account reconciliation difficult and prone to frauds, where the 
same invoice may be recorded for both the suppliers.

• Duplicate invoices: Where the same supplier invoice gets recorded twice. This could be 
because it has been entered once based on the invoice that was emailed, and reentered by 
another payables specialist later when the physical copy of the invoice was received from 
the inward mail department. Such invoices, if not identified, may result in overbooking of an 
invoice and double payment to the supplier.

• Invoices for late payment risk: Where some invoices are on hold as the price billed is 
marginally greater than the tolerance defined, for example, 0.5% above tolerance. In such 
cases, the has to be released so that the payment can be made on time.

• Supplier bank account missing: Where the payment method setup on the supplier is 
electronic, but the bank account is missing. Payments for such suppliers are identified during 
the payment batch run that happens around the due date. This eventually delays the payment 
to the supplier and impacts the relationship with the supplier. Ideally, such issues must be 
identified beforehand so that the missing information can be gathered from the supplier well 
before the due date.

These insights are valuable and have a direct impact on business, in terms of inefficient usage of 
money, overspending, or having an adverse impact on supplier relationship. With this integration, 
these insights provided by Celonis are easily consumed by the Now platform’s intuitive low-
code workflow to create playbook experiences that guide users through the processes on how to 
resolve these issues.

Workflow and playbook experience for Celonis integration

Workflows for the various insights provided by Celonis are built with the help of the Playbooks 
component provided by the Now platform. For more information on this component, see Process 
Automation Designer .

Here's an example of an inconsistent payment term insight provided by Celonis, and an end-to-
end system built to automate the work for the users.

Create a flow in Playbooks:
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• Ingest the data from the Celonis API, create a procurement case, and assign it to a user or 
group. These cases are displayed in the assigned user's Source-to-Pay Workspace  landing 
page.

• Customers can configure various options like updating the ERP directly from the case 
playbook, or manually logging in to the ERP to update the data.

• Customers can configure the closure steps like sending an email to the supplier with the 
information that the payment terms have been updated to the original agreed term recorded 
in the primary record. Customers can also mark a copy of this email to their manager with the 
case closure information.

Configure your playbook experience to include the following relevant information:

• Steps to resolve the case.

• Displaying the relevant information in the playbook so that users can take appropriate 
decisions.

• Ability to perform searches so that the case owner can search for knowledge articles on similar 
cases and learn how they were resolved.

• Embedded tasks in the playbook like directly updating the ERP, which ensures that all the work 
that must be done can be done from the playbook itself without the need to log in to any other 
ERP system.

For more information, see About Playbook Experience .

Celonis triggers for Sourcing and Procurement Operations

A sample payload from Celonis for payment term mismatch is provided.

{
    "Supplier": "PolyTec",
    "Supplier City": "Munich",
    "Supplier Country": "DE",
    "Purchase Order": "PO10008760",
    "Invoice Number": 9350035113,
    "Payment Block Reason": "Payment Term Mismatch",
    "Due Date": "5/15/21",
    "Priority Vendor": "Yes",
    "Invoice Amount": 160725.03,
    "Payment Term (Invoice)": "NET 30",
    "Payment Term (Master Data)": "NET 60"
  }

The incoming payload from Celonis is stored in a custom staging table, from where it is 
processed via a business rule or flow designer to create a case and corresponding case lines. 
You can leverage existing case types or create a new case type as need be, which you can then 
assign to users or groups. Create a new case type by adding a new choice to the Case type 
column. A corresponding playbook can be triggered for this case type to assist in case fulfilment, 
as explained above.

Sourcing and Procurement Operations  integration with Field Service 
Management

The Procurement for Field Service Management  plugin (com.snc.fsm_psm_mobile) provides an 
integration between the Field Service Management  and Sourcing and Procurement Operations 
applications.
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A field service agent working on completing a particular work order task could view the asset 
inventory, locate the parts that are available in stockrooms in real time, and source them as per 
requirement. With this integration, a field service agent can engage with procurement and place 
an order to purchase a required part from a vendor or supplier.

This functionality is available only on your mobile device through the Agent mobile application.

Note:  This integration application is owned by the Field Service Management  team. To 
use this application, a license is required for both Field Service Management  and Sourcing 
and Procurement Operations.

Changes to the Field Service Management  application

In the Field Service Management  application, this integration adds a Purchase Orders related 
list to the part requirement form on your mobile device. This list shows the order details of the 
purchase made with a vendor or supplier.

Also, the Order Part  button has been added, which enables a field service agent to purchase the 
part if it is not available in the inventory or any physical stockroom.

On the Inventory  tab, My Purchases  and My Purchasing To-dos  applets have been added 
from the Shopping Hub Mobile  application to provide field service agents visibility into their 
purchases and purchasing to-dos. However, these lists are available only if the better together 
application is installed.

On the Inventory  tab, the My Inventory  applet displays the assets that are created when 
creating transfer order lines from Field Service Management, as well as assets that are created 
when acknowledging the delivery of products from a vendor or supplier from Sourcing and 
Procurement Operations. Assets that are created in the Asset Usage table are also displayed 
here.

Integrate with Field Service Management

Field Service Management  provides an integration with the Sourcing and Procurement 
Operations  application. With this integration, a field service agent can engage with procurement 
and place an order to purchase a required part from a vendor or supplier.

Before you begin
Role required: admin

Note:  This integration application is owned by the Field Service Management  team. To 
use this application, a license is required for both Field Service Management  and Sourcing 
and Procurement Operations.

Procedure

1. Navigate to All  > System Definition  > Plugins.

2. Search for the Procurement for Field Service Management  plugin (snc.fsm_psm_mobile).

Note:  To activate this plugin, there is a dependency on the Shopping Hub Mobile 
application. For more information on activating and setting up Field Service Management 
and additional plugins, see Activate Field Service Management .

3. Select Activate.
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Order parts you need using the Agent mobile application

Place an order for a part that you require to complete a particular work order task, from the 
Sourcing and Procurement Operations  flow, using the Agent mobile application.

Before you begin
To successfully order a part, verify that the product models used by Field Service Management 
are aligned to the supplier products.

Role required: wm_agent, wm_dispatcher, fsm_agent, or sn_shop.shopper

Procedure

1. Log in to your instance in the Agent mobile application.

2. From the My Tasks  section, select the work order task you want to work with.

3. Tap the Parts  tab.

4. From the Part Requirements  section, select the part you need to complete your work order 
task.

5. Tap Order Part.

6. From the Available to purchase  section, select the product you want to place an order for.

This section displays all the supplier products that are associated with the product model of 
the part requirement.

Note:  Only products that have pricing available are displayed here. Also, all the criteria 
for products to be visible on Shopping Hub, such as shopping controls, are applied here 
as well.

The quick checkout flow is triggered from Shopping Hub  and the checkout details are auto-
populated.

Note:  The Quantity  and Delivery date  fields are auto-populated from the part 
requirement, but are editable.

7. Edit the checkout fields as required.

8. Enter your reason for purchase in the Purchase Reason  field.

9. Tap Complete Checkout.
A confirmation message stating that your purchase is successfully routed for approval, is 
displayed, along with the purchase requisition line number.

Note:  As an FSM agent, if you're unable to check out products in the PSM and FSM 
mobile experience Agent app, install the fix script after installing the fms-psm-mobile 
and spend-uib-portal applications. The fix script updates the quick checkout link to the 
correct MESP page.

What to do next
On the order confirmation screen, tap Return to work order task  if you want to go back to the 
work order task details screen.

Source-to-Pay Operations  integration with Contract Management Pro

The Source-to-Pay Operations  with Contract Management Pro  plugin (com.snc.sn_spend_clm) 
provides an integration between the Contract Management Pro  and Sourcing and Procurement 
Operations  applications.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

645



Contract Management Pro (CM Pro) is a contract life-cycle management solution used to set up 
contract document templates, clauses, clause variations, and initiate contract requests. It also 
supports e-signatures and external storage systems.

The integration of Sourcing and Procurement Operations  with  Contract Management Pro  aims to 
streamline cross-team collaboration and enable legal professionals to run their contracting work 
within the sourcing and purchasing process. With this integration, procurement specialists can 
initiate contract requests (CRs) manually throughout the sourcing and purchasing process.

Note:  To use this application, a license is required for both Contract Management Pro  and 
Sourcing and Procurement Operations.

Using this integration, procurement specialists can create contract requests for the following:

• Purchase lines

• Purchase requisitions

• Sourcing requests

• Negotiations

• Sourcing events

User roles required for the SPO-CM Pro better together feature

The following roles are required to initiate, view, and manage contract execution:

• Sourcing and purchasing viewer: This is a new role provided within the Contract 
specialist  assignment group. This role can be assigned to the contracting and procurement 
professionals to have read-only access into the purchase lines, sourcing requests, 
negotiations, and purchase requisitions.

• Contract fulfiller: This is a licensed role for CM Pro. This role has to be explicitly assigned 
to the contracting and procurement professionals if they have to work on contract requests. 
Once assigned, they can work on the contract requests, leveraging all capabilities from CM 
Pro – obtaining contract signatures, authoring contracts, tracking revisions, and creating the 
contract documents to be stored in the contract repository.​

• Contract user: This role is also provided within the Contract specialist  assignment group and 
is required to initiate and track contract execution.

You can assign your procurement and contracting professionals to these roles as required.

Integrate with Contract Management Pro

Contract Management Pro  provides an integration with the Sourcing and Procurement 
Operations  application. With this integration, procurement specialists can initiate contract 
requests (CRs) manually throughout the sourcing and purchasing process.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Plugins.

2. Search for the Source-to-Pay Operations  with Contract Management Pro  plugin 
(com.snc.sn_spend_clm).
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Note:  To activate this plugin, there is a dependency on the Sourcing and Purchasing 
Automation plugin (com.snc.sn_pr) and the Microsoft Word add-in for ServiceNow 
Contracts plugin (com.sn_cm_word_addin). These plugins must be installed to utilize the 
new better together feature for the contracting workflow.

3. Select Activate.

4. Complete the initial configuration steps to set up CM Pro.
For more information on setting up Contract Management Pro, see Add and configure contract 
request functionality into your workspace .

Initiate a contract request

Initiate a contract request from the Source-to-Pay workspace.

Before you begin
Role required: admin or fulfiller

To initiate a contract request, you must have already added a contract template and created 
template rules. For more information on how to add a contract template, see Configure templates 
for a contract and amendment request in Contract Management Pro . For more information on 
how to create template rules, see Configure contract template rules .

You can initiate contract requests from the related work section, the Dynamic Related Records 
(DRR) contextual side panel, and the playbook.

Procedure

1. Navigate to the Source-to-Pay Workspace.

2. Open the entity for which you have to initiate a contract request.

Note:  Contract requests can be initiated for purchase lines, purchase requisitions, 
sourcing requests, negotiations, and sourcing events.

3. Initiate a contract request from the related work section, the DRR, or the playbook.

◦ From Related work: Contract requests can be initiated for all types of entities. For more 
information on how to initiate a contract request from the related work section, see Initiate a 
contract request from the related work section.

◦ From DRR: Contract requests can be initiated for all types of entities, except purchase 
lines. For more information on how to initiate a contract request from the DRR, see Initiate a 
contract request from Dynamic Related Records (DRR).

◦ From Playbook: Contract requests can be initiated only for sourcing events and sourcing 
requests. For more information on how to initiate a contract request from the playbook, see 
Initiate a contract request from the playbook.

Note:  You can manually create a contract request for a given supplier throughout the 
S2P workflow, so that a signed contract can be created with that supplier.

Initiate a contract request from the related work section

Initiate a contract request for purchase lines, purchase requisitions, sourcing requests, 
negotiations, or sourcing events from the related work section.

Before you begin
Role required: admin
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Procedure

1. Navigate to the Source-to-Pay Workspace.

2. Open the entity for which you have to initiate a contract request.

Note:  From the related work section, contract requests can be initiated for purchase 
lines, purchase requisitions, sourcing requests, negotiations, and sourcing events.

3. Navigate to Related work  > Contract Requests.

4. Select New.

5. Provide the details about the contract that you have to initiate.

6. Select Initiate.

Initiate a contract request from Dynamic Related Records (DRR)

Initiate a contract request for purchase requisitions, sourcing requests, negotiations, or sourcing 
events from the Dynamic Related Records (DRR) section.

Before you begin
Role required: admin

Procedure

1. Navigate to the Source-to-Pay Workspace.

2. Open the entity for which you have to initiate a contract request.

Note:  From DRR, contract requests can be initiated for purchase requisitions, sourcing 
requests, negotiations, and sourcing events.

3. Select the Related cases and tasks icon from the DRR.

4. Select the Add button to create a task.

5. Select Contract request  from the list of available options.

6. Provide the details about the contract that you have to initiate.

Note:  Sourcing events and sourcing requests can be associated with multiple suppliers. 
Therefore, you must select a supplier to create a contract request for sourcing events and 
sourcing requests.

7. Select Initiate.

Initiate a contract request from the playbook

Initiate a contract request for sourcing requests or sourcing event from the playbook.

Before you begin
Role required: admin

Procedure

1. Navigate to the Source-to-Pay Workspace.

2. Open the sourcing request or sourcing event for which you have to initiate a contract request.
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Note:  From the playbook, you can initiate contract requests for sourcing requests and 
sourcing events only.

3. Select Playbook  and navigate to the Request details  step.

4. Select Create a type of work  in the Assign work to others  section.

5. Select Contract request  from the list of available options.

6. Select a supplier from the list of available suppliers.

7. Select Next.

8. Provide the details about the contract that you have to initiate.

9. Select Initiate.

Using Now Assist  for Contract Management  in Sourcing and Procurement Operations

With the sn_cm_gen_ai.ai_contract_fulfiller role, you can review non-standard or missing clauses 
in procurement contracts and extract key details to update the contract repository using Now 
Assist for Contract Management  within the Source-to-Pay Workspace.

Enable Now Assist  in Contract Management

Install the Now Assist  in Contract Management  plugin (sn_cm_gen_ai) and activate the 
generative AI skills to use Now Assist  skills in Contract Management.

About this task
Use the Now Assist  console to enable Now Assist  in Contract Management. This console 
contains everything that you need to install the plugin and activate the generative AI skills. For 
additional information, see Now Assist Admin console .

The following skills are available for Contract Management  in the Now Assist Admin  console.

• Contract metadata extraction

• Contract analysis

Before you begin
Role required: sn_cm_gen_ai.ai_contract_admin

Procedure

1. Install the Now Assist  in Contract Management  plugin (sn_cm_gen_ai).

◦ For information about the plugin installation process, see Install Now Assist plugins .

◦ For information about the plugin dependencies and plugin activation order, see Application 
information .

2. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist Skills  tab of the Now 
Assist Admin  console.

3. Navigate to Employee  > CM Pro.

4. On the tile for your skill, select Activate skill.
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Now Assist skills for Contract Management Pro

5. In the skill guided setup, configure the use cases and other mappings for the skill.
For more information on configuring contract metadata extraction, see Configuring contract 
metadata extraction .

For more information on configuring contract analysis, see Configuring contract analysis .

6. In the Review and activate page, select Activate.

Start a metadata extraction for a contract from Source-to-Pay Workspace

Extract metadata from a signed contract attached in a contract repository record.

Before you begin
Role required: sn_cm_gen_ai.ai_contract_fulfiller

About this task
By default, the following use cases are available for Sourcing and Procurement Operations, 
which are mapped to the purchase requisition, purchase line item, and negotiation tables.

• CM Pro - Contract Analysis

• CM Pro - Contract Metadata Extraction

For more information, see Metadata extraction using Now Assist in Contract Management .

Procedure

1. Open the Source-to-Pay Workspace.

2. Navigate to Lists  > My work  > Open contract requests

3. Select a contract request that is in Closed complete or Contract signed state.

4. Select Initiate metadata extraction.
A message appears stating that the metadata extraction process has been initiated. You 
receive an email notification when the process is completed.

The Review extracted metadata  button appears on initiating the metadata extraction. You can 
select the button after the metadata extraction is completed.
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What to do next
Review the metadata extracted from a contract and add it to the contract repository. For more 
information, see Work with extracted metadata .

The Extraction results tab in the contract repository record displays the processed metadata and 
their statuses, indicating whether the metadata have been successfully added to the mapped 
fields in the contract repository. For more information, see Metadata extraction results .

Analyze a contract document from Source-to-Pay Workspace

As a contract fulfiller, analyze a contract document with generative AI to identify non-standard 
and missing clauses.

Before you begin
Role required: sn_cm_gen_ai.ai_contract_fulfiller or sn_cm_core.contract_fulfiller

About this task
You can analyze an entire document and identify any non-standard or missing clauses by using 
generative AI with the Now Assist in Contract Management application. With generative AI, your 
organization can save time and effort by reducing the need for manual review.

For more information, see Contract analysis using Now Assist in Contract Management .

Procedure

1. Open the Source-to-Pay Workspace.

2. Navigate to Lists  > My work  > Open contract requests

3. Select a contract request that is in Work in progress state.

Note:  You can analyze only the contracts that are in Work in progress state.

4. If the contextual side panel isn’t open, select the Now Assist  Contract Review by Now Assist 

icon ( ).
You can analyze contracts in the Now Assist  contextual side panel as shown in the following 
example.

5. On the contract request page, select Contract documents.

6. Submit contract documents for Now Assist  analysis.
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The latest versions of the documents are automatically selected for analysis.

Method Steps

Run Now Assist  analysis on a single con­
tract document

a. On the Contract documents  tab, select a 
contract document.

b. From the contextual side panel, select Ana­
lyze with Now Assist.

Run Now Assist  analysis on multiple con­
tract documents

a. After opening a contract request, from the 
contextual side panel select Analyze with 
Now Assist.

Note:  A list of contract documents 
that were submitted for the Now As­
sist  analysis is displayed. Information 
about the documents and any errors 
that were found are also included.

b. Select Analyze contract.

After you select Analyze with Now Assist, you might encounter Restricted Caller Access 
(RCA) approval messages as shown in the image.

For more information about approving restricted caller access (RCA) privileges to allow cross-
scope access to Now Assist  in Contract Management, see RCA approvals for Now Assist in 
Contract Management.

7. Select Analyze contract.

a. The Now Assist  application creates a copy of the documents and starts analysis on the new 
documents. The status is now Analysis in progress.

b. A card is created for each document in Analyzed contracts with the Now Assist  contextual 
panel. The contract status updates to the Awaiting review status.

c. When the analysis of the documents is complete, the status changes to Ready for review 
with the following details:
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Status of action taken on the contract analysis suggestions

Section Description

Pending reviews Displays the number of deviations reported 
and pending for review.

Completed Displays the number of reviewed deviations 
that have been reviewed and any actions 
taken.

8. Select the document card to view the details of the analysis.
The details of the contract analysis are displayed with the Now Assist  comments. The 
comments explain the reasons for marking a clause non-standard.

9. View the analysis and select Back  to go to the analyzed contracts in the Now Assist  contextual 
side panel.
You can only view the suggestions in the contextual side panel. To act on a suggestion, 
open a .docx Microsoft Word  document and use the Microsoft Word  add-in for ServiceNow 
Contracts. For more information, see Contract analysis states in Now Assist in Contract 
Management

RCA approvals for Now Assist  in Contract Management

Approve restricted caller access (RCA) privileges to allow cross-scope access to Now Assist  in 
Contract Management.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > Application Restricted Caller Access.

2. In the search field of the Source Scope column, enter Now Assist in Contract 
Management.

3. Select and open the record highlighted in the image.

4. Set the Status  field to Allowed.

5. Select Update.

ERP source validation on Sourcing and Procurement Operations  objects

Sourcing and Procurement Operations  supports multi-ERP integration that enables you to use 
different ERP systems for different regions or lines of business, as required.

Whenever Sourcing and Procurement Operations  integrates with multiple ERPs, it validates 
the ERP from where the primary data is being fetched. It also ensures that the transaction 
data is routed to the right ERP with the right set of attributes. To validate ERP source to select 
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correct attributes for Sourcing and Procurement Operations  objects, and to support multi-ERP 
integration, these updates are enabled.

Fx currency and conversion rates

Conversion rates from the Finance Exchange Rates (sn_fin_fx_rate) table are used. This table 
has an ERP Source column, and records like purchase requisition and purchase order are also 
tied to the ERP Source column. By taking the legal entity and getting an ERP source from the legal 
entity, the right conversion rate is derived.

Fx2 currency amount is converted into your legal entity local currency amount and legal entity 
reporting currency amount by using the conversion rate from the Finance Exchange Rates table. 
All these converted values are stored in the PSM FX Currencies (sn_shop_fx_currency_instance)​
 table.

Shopping Hub

Foreign currency transactions are supported. A foreign currency transaction is one where the 
contract currency, also known as the transaction currency, is different from the local currency 
of the legal entity. For example, if an employee whose legal entity has a local currency of USD, 
purchases something which is in the contract currency of EUR, then it becomes a foreign 
currency transaction. In such cases,the contract amount is converted into the legal entity local 
currency in the shopping cart by using the exchange rate from the Finance Exchange Rates 
(sn_fin_fx_rate) table, where the ERP source in the Finance Exchange Rates table matches with 
the ERP source or legal entity of the employee.

Also, purchase requisitions are split based on currency of the purchase requisition lines. Legal 
entity local currency is used to do the conversions during checkout.

Cost center and GL account

Cost center and GL account values are restricted by the ERP source on the object. The legal 
entity from the object is considered, and the ERP source is fetched. When a user updates the 
record, only those cost centers that have matching ERP sources are displayed in the Source-to-
Pay Workspace.

Note:  These validations are enforced only when a legal entity has been set up for 
integration with ERPs. If you've set up integration with an ERP, then you’ll see the data 
having the same ERP source, thereby preventing downstream errors during integration.

If there’s any record with different ERP sources, then an integration error task is raised. This is an 
indicator for your fulfiller to correct the record before processing it further.

Spendint API

The Spendint  API provides endpoints that push the catalog, price, availability, order, shipment, 
and invoice information from a third party to the ServiceNow  instance. This API is part of the 
Source-to-Pay Integration Framework  application.

This API requires the Procurement Integration Framework (com.glide.sn_spend_intg) store 
application and is provided within the sn_spend_intg  namespace. For information, see 
Procurement File Transfer Framework.

To access this API, you must have the sn_spend_intg.procurement_integrator role.

Third-party registration for PIF and PFTF

Onboard a supplier through the third-party registration process before you get started with 
Source-to-Pay Integration Framework  (PIF) or Procurement File Transfer Framework  (PFTF).
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Navigate to All  > Procurement Integrations  > Setup  > Third-Party Registration. For third-party 
registration, following are the fields:

Third-Party Registration form

Field Description

Provider name Unique identifier for the supplier.

Supplier Name of the supplier in the ServiceNow 
records.

Customer id Unique identifier for the customer.

Import catalog Supplier is allowed to import catalog, which 
includes price and availability.

Post order Supplier is allowed to post orders.

Import invoice Supplier is allowed to import invoices.

Allow purchase order revision Supplier allows purchase orders to be revised 
after confirmation.

Import shipment Supplier is allowed to import shipments.

Allow multi location order Supplier allows orders to be split for multi-
location shipping.

Spendint API - POST /sn_spend_intg/spendint/catalog

Allows suppliers to post multiple catalogs for creating supplier products, model products, 
contracts, and pricing records.

In the catalog  API integration, when you receive data from a third-party catalog, you can:

1. Create any new third-party categories and map these categories to model categories.

◦ If available, use the United Nations Standard Products and Services Code (UNSPSC) and 
then the category name.

◦ If UNSPSC is not available, use just the category name.

2. After you map a third-party category to a model category, use the Manufacturer Part Number 
(MPN) to find an existing product model, if one is available.

a. If a product model is found for the MPN, update the product model with any changes, and 
then create or update any supplier products that are related to the product model.

b. If a product model does not exist for the MPN, do the following:

i. A product model class is usually available on the model category that is referenced by the 
third-party category for the product. Use this product model class to get the product model 
table in which the product model should be created, for example, hardware, software, 
consumable, and so on. If no product model class is available, create the product model in 
the base product model table.

ii. After the correct product model class is identified, create a new product model in the 
correct class as follows:

▪ Manufacturer, publisher, or provider should map to the manufacturer on the product 
model.

▪ Product name from the API should map to the name on the product model.

▪ MPN from the API should update the model number.
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▪ Product description from the API should update the description on the product model.

▪ Model category should be updated with the product category referenced on the third-
party category record.

▪ Product category should be updated with the product category referenced on the third-
party category record.

▪ If there are values in the substitute products in the API, create the substitute product 
records between the current product model and the other product models.

▪ If there are values in the compatible products in the API, create the compatible product 
records between the current product model and the other product models.

▪ Product attributes from the API should be created or updated in the product attribute 
related list for the product model.

3. If a product model is available, use the supplier part number to create or update the supplier 
products that are related to the product model.

Third-party mapping

Use the following tables to perform the third-party category, model, and unit mappings:

• Third-Party Categories: Stores all the third-party category records for the ShoppingHub 
administrator to map with internal existing model categories.

• Third-Party Model Mappings: Stores all the mapping information between product models and 
third-party model categories.

• Third-Party Units: Stores all the third-party unit records for the ShoppingHub administrator to 
map with supplier product units.

• Third-Party Unit Mappings: Stores all the mapping information between product models and 
third-party units.

Note:  A third-party integration product is auto-published when both the third-party 
category and third-party unit are mapped appropriately.

Supplier product sales dates

A supplier product is discontinued and no longer published in the catalog when it has reached 
its sales end date. The Sales start date  and Sales end date  fields on the Supplier product form 
are populated through third-party integration from theCatalog  API.

Status tables

To know the status of the bulk product import request, make a REST call into the ServiceNow 
database using the Table  REST API. The response from the API lists the records where the bulk 
import request failed. For bulk product import response, query the Catalog Error table with the 
following parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

Details on the customer id, supplier id, error type, unique import set id, and state can be found in 
the Outbound Status table, which is the parent error table.

URL format

/api/sn_spend_intg/spendint/catalog

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

656



Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

customer_id Identifier for the customer.

Data type: String

Maximum length: 100

catalog_id Identifier for the catalog content that can 
be purchased by a customer.

Data type: String

Maximum length: 100

products List of objects that define products to 
create or update. Each transaction has a 
limit of 1000 products.

Data type: Array

"products": [
  {
    "available_units": 
 "String",
   
 "available_for_country": 
 [Array],
    "bundled_components": 
 [Array],
    "contract_agreement": 
 {Object},
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Request body parameters (XML or JSON)  (continued)

Name Description

    "delivery_time": 
 "String",
    "images": [Array],
    "manufacturer": 
 "String",
    "mpn": "String",
    "parent_bundle": 
 "String",
    "product_attributes": 
 {Object},
   
 "product_category_name": 
 "String",
    "product_description": 
 "String",
    "product_name": 
 "String",
    "sku": "String",
    "unit": "String",
    "unspsc": "String",
  }
]

products.available_units Required for products that are kept in 
stock. This value indicates the quantity of 
units that are available for this product.

Data type: String

Maximum length: 40

products.available_for_country List of country codes where the supplier 
product can be purchased. If no country 
is provided, a user from any country can 
purchase the product.

Data type: Array

"available_for_country": 
 ["US","IN","GB"]

products.bundled_components Valid only for scenarios when sending 
a product bundle as part of the catalog 
payload, and applicable only for the 
parent bundle payloads. This value 
contains the reference to the child 
bundle components. The list of the 
MPN and quantities for the child bundle 
components are maintained here.
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Request body parameters (XML or JSON)  (continued)

Name Description

Note:  Since the same child bundle 
component can be added more 
than once within a bundle, the 
entered quantity is the differentiator 
between the same children bundle 
components.

The child bundle components and their 
details (MPN and quantities) should be 
mapped to the same supplier.

Data type: Array

"bundled_components": [
  {
    "mpn": "String",
    "quantity": "String"
  }
]

products.contract_agreement Details of the contract for a product.

Note:  This is not required for child 
bundle components.

Data type: Object

"contract_agreement": {
  "contract_end_date": 
 "String",
  "contract_number": 
 "String",
  "contract_start_date": 
 "String",
  "negotiated_currency ": 
 "String",
  "negotiated_price": 
 "String"
}

products.contract_agreement.contract_end_date Date on which the contract term ends.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

products.contract_agreement.contract_number Required. Number of the active contract 
that is associated with the product.

Data type: String
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Request body parameters (XML or JSON)  (continued)

Name Description

Maximum length: 100

products.contract_agreement.contract_start_date Date on which the contract term starts.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

products.contract_agreement.negotiated_currency Required. Currency of the negotiated 
price.

Data type: String

Maximum length: 40

products.contract_agreement.negotiated_price Required. Unit price of a product as 
negotiated through a contract with the 
supplier or reseller.

Data type: String

Maximum length: 40

products.delivery_time Estimated number of days it takes to ship 
a product to the customer. This value must 
represent the number of days and be a 
whole integer.

Data type: String

Maximum length: 40

products.images List of strings that specify the image URLs 
for the supplier product.

Data type: Array

products.manufacturer Required. Company that manufactures, 
publishes, or provides the product. This is 
not the supplier or reseller of the product.

Data type: String

Maximum length: 100

products.mpn Required. Identifier for a product that is 
provided by the manufacturer, publisher, 
or provider.

Note:  This is not required for 
reseller parent bundles if the SKU 
value is available.

Data type: String
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

660



Request body parameters (XML or JSON)  (continued)

Name Description

Maximum length: 100

products.parent_bundle Valid only for scenarios when sending 
a product bundle as part of the catalog 
payload, and applicable only for the 
child bundle component payloads. In the 
case of a child bundle component, the 
reference to the parent is maintained here. 
The parent MPN and SKU values are also 
set here.

Data type: String

Maximum length: 100

products.product_attributes List of key-value pairs that define product 
attributes, for example, "Color": 
"Space Grey". Multiple attributes for a 
product are allowed. However, only those 
attributes that impact pricing or stock 
availability should be provided through 
the API.

Data type: Object

products.product_category_name Required. Name that you enter if you are 
not setting the unspsc  property. This 
name is the category to which a product 
belongs. This category name can be 
used in a commerce scenario to shop 
for the product. For example, a power 
strip product could belong to an Office 
Equipment category.

Data type: String

Maximum length: 100

products.product_description Full description of the product that 
appears to a shopper within a commerce 
experience.

Note:  It is recommended that 
the supplier be as descriptive as 
possible here, especially for product 
bundle catalog items where there are 
child bundle components.

Data type: String

Maximum length: 65000

products.product_name Required. Name of the product.

Data type: String
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Request body parameters (XML or JSON)  (continued)

Name Description

Maximum length: 1000

products.sku Required. Number that is generated by a 
supplier that uniquely identifies a product 
that is sold by that supplier.

Data type: String

Maximum length: 100

products.unit Required. Unit or rate at which the product 
is sold by the supplier. For example, 
pieces, hours, and so on.

Data type: String

Maximum length: 40

products.unspsc Required. Identifier that you 
enter if you are not setting the 
product_category_name  property. 
This identifier is the UNSPSC for the 
category to which a product belongs. 
For example, UNSPSC code 43210000 
is the identifier for the product category 
Computers.

Data type: String

Maximum length: 100

supplier_id Required. Identifier for the reseller or 
supplier with whom the customer can 
place orders.

Data type: String

Maximum length: 100

third_party_import_id Identifier that enables a third party to pass 
a string value to uniquely identify a set of 
imported data.

Data type: String

Maximum length: 100

Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.
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Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.

Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.

Name Description

error_response_body Description of the errors, listed by sku, mpn, and the 
error message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String

Example: cURL request

curl 
 "https://instance.service-now.com/api/sn_spend_intg/spendint/ca
talog" \
--request POST \
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--header "Accept:application/json" \
--user 'username':'password'
{"root": [{
  "customer_id": "AB-1234323",
  "catalog_id": "ACME CORP-12347898",
  "supplier_id": "SUP-123456",
  "third_party_import_id": "DELL1234567",
  "products": [
    {
      "product_name": "Apple MacBook Pro 13 Core i7",
      "mpn": "Z0WQ-20004301931",
      "sku": "55788741",
      "manufacturer": "Apple",
      "product_category_name": "Computer",
      "parent_bundle": "920-0045362002",
      "bundled_components": {
        "mpn": "Z0WQ-20004301931",
        "quantity": "4",
       },
      "unspsc": "43211500",
      "product_description": "Apple MacBook Pro 13 Core i7 
 2.8GHz 16GB 512GB - Touch Bar - Space Gray",
      "product_attributes": {
        "Color": "Space Grey",
        "RAM": "16GB",
        "Screen Size": "13inch"
      },
      "images": ["http://test123.image1.png", 
 "http://test123.image2.jpeg"],
      "unit": "Each",
      "available_units": "4",
      "available_for_country": ["US","IN","GB"],
      "delivery_time": "4",
      "contract_agreement": {
        "contract_number": "34567892",
        "contract_start_date": "YYYY-MM-DD",
        "contract_end_date": "YYYY-MM-DD",
        "negotiated_price": "456",
        "negotiated_currency ": "USD"
      }
    }
  ]
}
]}

Possible responses:

// Success response:
{
    "result": {
        "response": "success"
    }
}
 
// Error response:
{
    "result": {
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        "response": [
            {
                "customer_id": "AB-1234323",
                "supplier_id": "SUP-123456",
                "third_party_import_id": "DELL1234567",
                "status_code": "failure",
                "error_response_body": [
                    {
                        "sku": "55788741",
                        "mpn": "Z0WQ-20004301931",
                        "error_message": "Field Value 
 empty/Formatting issue Negotiated currency \n"
                    }
                ]
            }
        ]
    }
}

Spendint API - POST /sn_spend_intg/spendint/price

Updates any pricing for supplier product records.

When pricing is available for supplier product records, the API uses the product SKU to find an 
existing supplier product. If a matching supplier product exists, the corresponding contract price 
is updated. If no matching supplier product is found, an error message is generated, stating that 
the product for which you are trying to update pricing for does not exist.

Status tables

To know the status of the price import request, make a REST call into the ServiceNow  database 
using the Table  REST API. The response from the API lists the records where the price import 
request failed. For a price import response, query the Price Error table with the following 
parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

You can find the details on the customer ID, supplier ID, error type, unique import set ID, and 
state can in the Outbound Status table, which is the parent error table.

URL format

/api/sn_spend_intg/spendint/price

Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.
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Query parameters  (continued)

Name Description

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

catalog_id Required. Identifier for the catalog content 
that can be purchased by a customer.

Data type: String

Maximum length: 100

customer_id Required. Identifier for the customer.

Data type: String

Maximum length: 100

products List of objects that define products to 
create or update. Each transaction has a 
limit of 1000 products.

Data type: Array

"products": [
  {
    "contract_agreement": 
 {Array},
    "sku": "String"
  }
]

products.contract_agreement Details of the contract for a product.

Data type: Object

"contract_agreement": {
  "contract_end_date": 
 "String",
  "contract_number": 
 "String",
  "contract_start_date": 
 "String",
  "negotiated_currency ": 
 "String",

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

666



Request body parameters (XML or JSON)  (continued)

Name Description

  "negotiated_price": 
 "String"
}

products.contract_agreement.contract_end_date Date on which the contract term ends.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

products.contract_agreement.contract_number Required. Number of the active contract 
that is associated with the product.

Data type: String

Maximum length: 100

products.contract_agreement.contract_start_date Date on which the contract term starts.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

products.contract_agreement.negotiated_currency Required. Currency of the negotiated 
price.

Data type: String

Maximum length: 40

products.contract_agreement.negotiated_price Required. Unit price of a product as 
negotiated through a contract with the 
supplier or reseller.

Data type: String

Maximum length: 40

products.sku Required. Number that is generated by a 
supplier that uniquely identifies a product 
that is sold by that supplier.

Data type: String

Maximum length: 100

supplier_id Required. Identifier for the reseller or 
supplier that the customer can place 
orders with.

Data type: String
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Request body parameters (XML or JSON)  (continued)

Name Description

Maximum length: 100

third_party_import_id Identifier that enables a third party to pass 
a string value to uniquely identify a set of 
imported data.

Data type: String

Maximum length: 100

Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.

Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.

Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.
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Name Description

error_response_body Description of the errors, listed by sku and the error 
message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String

Example: cURL request

curl 
 "https://instance.service-now.com/api/sn_spend_intg/spendint/pr
ice" \
--request POST \
--header "Accept:application/json" \
--user 'username':'password'
{"root": [{
  "customer_id": "ACME CORP",
  "catalog_id": "AB-1234323",
  "supplier_id": "SUP-123456",
  “third_party_import_id”: “DEL789876",
  "products": [
    {
      "sku": "5578874",
      "contract_agreement": {
        "contract_number": "34567892",
        "contract_start_date": "YYYY-MM-DD",
        "contract_end_date": "YYYY-MM-DD",
        "negotiated_price": "456",
        "negotiated_currency ": "USD"
      }
    }
  ]
}
]}

Possible responses:

// Success response:
{
    “result”: {
        “response”: “success”
    }
}
 
// Error response:
{
    “result”: {
        “response”: [
            {
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                “customer_id”: “ACME CORP”,
                “supplier_id”: “SUP-123456”,
                “third_party_import_id”: “DEL789876",
                “status_code”: “failure”,
                “error_response_body”: [
                    {
                        “sku”: “5578874”,
                        “error_message”: “The product for 
 which you are trying to update pricing does not exist\nField 
 Value empty/Formatting issue Negotiated currency\nField 
 Value empty/Formatting issue Contract start date\nField Value 
 empty/Formatting issue Contract end date\n”
                    }
                ]
            }
        ]
    }
}

Spendint API - POST /sn_spend_intg/spendint/availability

Updates the availability for supplier product records.

When supplier product records are available, the API uses the product SKU to find an existing 
supplier product. If a matching supplier product exists, the corresponding available_units  field 
is updated. If no matching supplier product is found, an error message generates stating that the 
product for which you are trying to update availability for does not exist.

Status tables

To know the status of the update availability request, make a REST call into the ServiceNow 
database using the Table  REST API. The response from the API lists the records where the 
update availability request failed. For update availability response, query the Availability Error 
table with the following parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

The details on the customer ID, supplier ID, error type, unique import set ID, and state can be 
found in the Outbound Status table, which is the parent error table.

URL format

/api/sn_spend_intg/spendint/availability

Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.
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Query parameters  (continued)

Name Description

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

catalog_id Required. Identifier for the catalog content that can be purchased by 
a customer.

Data type: String

Maximum length: 100

customer_id Required. Identifier for the customer.

Data type: String

Maximum length: 100

products List of objects that define the products to update. Each transaction 
has a limit of 1000 products.

Data type: Array

"products": [
  {
    "available_units": "String",
    "sku": "String",
    "unit": "String"
  }
]

products.available_units Required for products that are kept in stock. Number of units 
available for this product.

Data type: String

Maximum length: 40

products.sku Required. Number that is generated by a supplier that uniquely 
identifies a product sold by that supplier.

Data type: String

Maximum length: 100
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Request body parameters (XML or JSON)  (continued)

Name Description

products.unit Required. Unit or rate at which the product is sold by the supplier. For 
example, pieces, hours, and so on.

Data type: String

Maximum length: 100

supplier_id Identifier for the reseller or supplier that the customer can place 
orders with.

Data type: String

Maximum length: 100

third_party_import_id Allows a third-party to pass a string value to uniquely identify a set of 
imported data.

Data type: String

Maximum length: 100

Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.

Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.
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Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.

Name Description

error_response_body Description of the errors, listed by sku and the error 
message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String

Example: cURL request

curl 
 "https://instance.servicenow.com/api/sn_spend_intg/spendint/ava
ilability" \
--request POST \
--header "Accept:application/json" \
--user 'username':'password'
{"root": [{
  "customer_id": "AB-1234323",
  "catalog_id": "ACME CORP",
  "supplier_id": "SUP-123456",
  "third_party_import_id": "DEL6789876",
  "products": [
    {
      "sku": "5578874",
      "unit": "Each",
      "available_units": "20"
    }
  ]
}
]}

Possible responses:

// Success response:
{
    "result": {
        "response": "success"
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    }
}
 
Error response:
{
    "result": {
        "response": [
            {
                "customer_id": "AB-1234323",
                "supplier_id": "SUP-123456",
                "third_party_import_id": "DEL6789876",
                "status_code": "failure",
                "error_response_body": [
                    {
                        "sku": "5578874",
                        "error_message": "The product for which 
 you are trying to update availability does not exist\nField 
 Value empty/Formatting issue Unit\n"
                    }
                ]
            }
        ]
    }
}

Spendint API - POST /sn_spend_intg/spendint/orderack

Updates order information for when a user shops for a product from a third-party catalog. When 
the user checks out, a purchase line is created so that approvals or other tasks for the purchase 
can be completed.

When a purchase order is generated in the ServiceNow  database, the order is pushed into the 
following tables:

• Outbound Order: Contains the order header.

• Outbound Order Line: Contains the order lines.

Suppliers need to query these tables and fetch the orders that are pending against them. 
Suppliers should create a scoped app for Workflow Studio  actions for integrating with the 
ServiceNow  database.

Query the tables with the following parameters:

• sysparm_query=supplier_id=<supplier_id>^purchase_order.status=20 
for header

• sysparm_query=purchase_order.supplier_id=<supplier_id>^purchase_order.status=20 
for header

When a purchase line is converted to a purchase order line, the following processes are run:

1. The purchase order and purchase order line are submitted to the Enterprise Resource 
Planning (ERP), if applicable.

2. The purchase order and purchase order line are transferred through integration to the third 
party with the customer ID, supplier ID, purchase order number, order date, purchase order 
amount, purchase order amount currency, and purchase order lines.
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3. The purchase order and purchase order line remain in the Pending Submission state until 
confirmation messages are received by both the third-party catalog integration and the ERP. 
After confirmation is received, the state is updated to Ordered. If there is no ERP integration 
involved, a confirmation message is required only from the third-party integration.

Status tables

To know the status of the order acknowledgment request, make a REST call into the ServiceNow 
database using the Table  REST API. The response from the API lists the records where the 
order acknowledgment request failed. For an order acknowledgment response, query the Order 
Acknowledgment Error table with the following parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

The details on the customer ID, supplier ID, error type, unique import set ID, and state can be 
found in the Outbound Status table, which is the parent error table.

URL format

/api/sn_spend_intg/spendint/orderack

Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

customer_id Required. Identifier for the customer.

Data type: String

Maximum length: 100

order_number Required. Purchase order number provided by the 
customer for this order.
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Request body parameters (XML or JSON)  (continued)

Name Description

Data type: String

Maximum length: 40

sales_order_lines List of objects that define the sales order lines 
with unique updates for the purchases in this 
order.

Data type: Array

"sales_order_lines":[
  {
    "estimated_arrival_date": 
 "String",
    "line_number": "String",
    "sales_order_line_number": 
 "String"
  }
]

sales_order_lines.estimated_arrival_date Estimated arrival date of the order.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

sales_order_lines.line_number Required. Purchase order line number that 
was generated by the customer for a particular 
purchase.

Data type: String

Maximum length: 40

sales_order_lines.sales_order_line_number Sales order line number that was generated by 
the supplier. This number is required only for 
revisions to this purchase.

Data type: String

Maximum length: 40

sales_order_number Number or value that is generated by the supplier 
for this order.

Data type: String

Maximum length: 40

status_code Required. Status of the submitted order that 
confirms if the order was successfully placed.

Data type: String
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Request body parameters (XML or JSON)  (continued)

Name Description

Valid values:

• confirmed: Order placed successfully.

• rejected: Order not placed.

status_message Message that is attached to a status code. For 
example, the message could be that the order 
was successfully placed and is on back order.

Data type: String

Maximum length: 1000

supplier_id Required. Identifier for the reseller or supplier that 
the customer can place orders with.

Data type: String

Maximum length: 100

third_party_import_id Identifier that enables a third party to pass a string 
value to uniquely identify a set of imported data.

Data type: String

Maximum length: 100

Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.

Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.
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Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.

Name Description

error_response_body Description of the errors, listed by the sales order 
number, sales order line number, and the error message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String

Example: cURL request

curl 
 "https://instance.service-now.com/api/sn_spend_intg/spendint/or
derack" \
--request POST \
--header "Accept:application/json" \
--user 'username':'password'
{"root":[{
  "customer_id": "ACME CORP",
  "supplier_id": "SUP-123456",
  "third_party_import_id": "undefined",
  "order_number": "PO08903323",
  "sales_order_number": "SO03323212",
  "status_code": "CONFIRMED",
  "status_message": "BACKORDERED",
  "sales_order_lines":[
    {
      "line_number": "POL6789876",
      "sales_order_line_number": "SOL5678909",
      "estimated_arrival_date": "YYYY-MM-DD"
    }
  ]
}
]}

Possible responses:
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// Success response:
{
    "result": {
        "response": "success"
    }
}
 
// Error response:
{
    "result": {
        "response": [
            {
                "customer_id": "ACME CORP",
                "supplier_id": "SUP-123456",
                "third_party_import_id": "undefined",
                "status_code": "failure",
                "error_response_body": [
                    {
                        "sales_order_number": "SO03323212",
                        "sales_order_line_number": "SOL5678909",
                        "error_message": "Field Value 
 empty/Formatting issue Purchase order number\nField Value 
 empty/Formatting issue Purchase order line number\n"
                    }
                ]
            }
        ]
    }
}

Spendint API - POST /sn_spend_intg/spendint/shipment

Use this endpoint to accept updates on purchases from third parties.

When you receive data, you must match the shipment data to a purchase order line by using 
the sales order line number. You can use the tracking number to find an existing shipment 
detail record that is related to the purchase order line. If no such record is found, create a new 
shipment detail record. If no purchase order or purchase order line exists for the shipment data, 
you see an error message that states that the purchase order for this shipment does not exist.

Note:  If the purchase order and purchase order lines are in the Pending Submission 
status, and the sales order and sales order lines are not populated, then the shipment and 
invoice posting from the third-party reseller is not allowed. It is only allowed when the status 
of the purchase order and purchase order lines are Ordered. Also, there is no sequential 
restriction on shipment and invoice posting.

Status tables

To know the status of the shipping request, make a REST call into the ServiceNow  database using 
the Table  REST API. The response from the API lists the records where the shipping update 
failed. To get a shipping response, query the Shipment Error table with the following parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

The details on the customer ID, supplier ID, error type, unique import set ID, and state can be 
found in the Outbound Status table, which is the parent error table.
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URL format

/api/sn_spend_intg/spendint/shipment

Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

customer_id Identifier for the customer.

Data type: String

Maximum length: 100

order_number Required. Purchase order number that is 
provided by the customer for this order.

Data type: String

Maximum length: 40

sales_order_number Required. Number or value that is generated 
by the supplier for this order.

Data type: String

Maximum length: 40

shipment_lines List of shipment lines that can contain the 
serial number, IMEI number, and asset tag 
details of the assets.

Data type: Array
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Request body parameters (XML or JSON)  (continued)

Name Description

"shipment_lines": [
  {
    "actual_shipment_date": 
 "String",
    "estimated_arrival_date": 
 "String",
    "line_number": "String",
    "planned_shipment_date": 
 "String",
    "product_details": 
 [Array],
    "sales_order_line_number": 
 "String",
    "shipping_address": 
 {Object},
    "shipping_carrier": 
 "String",
    "shipment_quantity": 
 "String",
    "ship_to": "String",
    "tracking_number": 
 "String"
  }
]

shipment_lines.actual_shipment_date Date on which the shipment leaves the 
supplier’s location.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

shipment_lines.estimated_arrival_date Date on which the shipment is expected to 
arrive at the specified location.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

shipment_lines.line_number Required. Purchase order line number that 
is generated by the customer for a particular 
purchase.

Data type: String

Maximum length: 40

shipment_lines.planned_shipment_date Date on which the shipment is planned to 
leave the supplier’s location.
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Request body parameters (XML or JSON)  (continued)

Name Description

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

shipment_lines.product_details List of objects that define the details about 
the products being shipped. Options include 
the serial number, IMEI number, and asset tag 
details.

Data type: Array

"product_details": [
  {
    "asset_tag": "String",
    "imei": "String",
    "serial_number": "String"
  }
]

shipment_lines.product_details.asset_tag Asset tag of the shipped product.

Data type: String

Maximum length: 100

shipment_lines.product_details.imei IMEI number of the shipped product.

Data type: String

Maximum length: 100

shipment_lines.product_details.serial_number Required. Serial number of the shipped 
product.

Data type: String

Maximum length: 100

shipment_lines.sales_order_line_number Sales order line number that is generated by 
the supplier. This number is required only for 
revisions to this purchase.

Data type: String

Maximum length: 40

shipment_lines.shipping_address Address where the products are being 
shipped to.

Data type: Object

"shipping_address":
  {
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Request body parameters (XML or JSON)  (continued)

Name Description

    "city": "String",
    "country": "String",
    "name": "String",
    "state": "String",
    "street": "String",
    "zip_code": "String"
  }

shipment_lines.shipping_address.city Name of the city where the products are 
shipped to.

Data type: String

Maximum length: 1000

shipment_lines.shipping_address.country Country where the products are shipped to.

Data type: String

Maximum length: 40

shipment_lines.shipping_address.name Name of the customer that the products are 
being shipped to.

Data type: String

Maximum length: 1000

shipment_lines.shipping_address.state State where the products are shipped to.

Data type: String

Maximum length: 1000

shipment_lines.shipping_address.street Name of the street where the products are 
shipped to.

Data type: String

Maximum length: 1000

shipment_lines.shipping_address.zip_code Zip code or pin code where the products are 
shipped to.

Data type: String

Maximum length: 40

shipment_lines.shipment_quantity Required. Number of the products being 
shipped as physical goods. The number 
should contain the quantity of the products 
that are in the shipment.

Data type: String
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Request body parameters (XML or JSON)  (continued)

Name Description

Maximum length: 40

shipment_lines.shipping_carrier Shipping carrier that is delivering the product 
to the specified location such as FedEx, UPS, 
USPS, and so on.

Data type: String

Maximum length: 100

shipment_lines.ship_to Name of the recipient that the products are 
shipped to.

Data type: String

Maximum length: 100

shipment_lines.tracking_number Tracking number that is provided by the 
shipping carrier for the whole or a portion of 
the purchase.

Data type: String

Maximum length: 100

supplier_id Required. Identifier for the reseller or supplier 
that the customer can place orders with.

Data type: String

Maximum length: 100

supplier_shipment_number Required. Identification number that is 
generated for this shipment. Typically, 
this number is generated by an Enterprise 
Resource Planning (ERP) or order tracking 
system.

Data type: String

Maximum length: 100

third_party_import_id Identifier that enables a third party to pass 
a string value to uniquely identify a set of 
imported data.

Data type: String

Maximum length: 100

Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.
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Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.

Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.

Name Description

error_response_body Description of the errors, listed by the sales order line 
number, sales order number, supplier shipment number, 
and the error message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String

Example: cURL request

curl 
 "https://instance.service-now.com/api/sn_spend_intg/spendint/sh
ipment" \
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--request POST \
--header "Accept:application/json" \
--user 'username':'password'
{"root":[{
  "customer_id" : "ACME CORP",
  "supplier_id" : "SUP-123456",
  "third_party_import_id": "DEL2134324",
  "supplier_shipment_number" : "TN-YU67898723",
  "order_number": "PO0001002",
  "sales_order_number": "SO00223002",
  "shipment_lines": [
    {
      "line_number": "POL0001005",
      "sales_order_line_number": "SOL0231325",
      "shipment_quantity": "4",
      "shipping_carrier": "FedEx",
      "tracking_number": "E-901290092",
      "shipping_address":
        {
          "name" : "1640 Camino Del Rio North #202, San 
 Diego,CA",
          "street" : "1640 Camino Del Rio North",
          "city" : "San Diego",
          "state" : "CA",
          "zip_code" : "92108-1512",
          "country" : "US"
        },
      "ship_to": "John doe",
      "planned_shipment_date": "YYYY-MM-DD",
      "actual_shipment_date": "YYYY-MM-DD",
      "estimated_arrival_date": "YYYY-MM-DD",
      "product_details": [
        {
          "serial_number": "FL1234-23242319001",
          "imei": "2134890294",
          "asset_tag": ""
        },{
          "serial_number": "FL1234-23242319110",
          "imei": "245499003",
          "asset_tag": ""
        }
      ]
    }
  ]
}
]}

Possible responses:

// Success response:
{
    "result": {
        "response": "success"
    }
}
 
// Error response:
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{
    "result": {
        "response": [
            {
                "customer_id": "ACME CORP",
                "supplier_id": "SUP-123456",
                "third_party_import_id": "DEL2134324",
                "status_code": "failure",
                "error_response_body": [
                    {
                        "sales_order_line_number": "SOL0231325",
                        "sales_order_number": "SO00223002",
                        "supplier_shipment_number": 
 "TN-YU67898723",
                        "error_message": "The purchase order for 
 this shipment does not exist\nThe purchase order line for this 
 shipment does not exist\n"
                    }
                ]
            }
        ]
    }
}

Spendint API - POST /sn_spend_intg/spendint/invoice

Accepts invoices from third-party providers.

If the purchase order and purchase order lines are in the Pending Submission status, and the 
sales order and sales order lines are not populated, then the shipment and invoice posting from 
the third-party reseller is not allowed. It is only allowed when the status of the purchase order 
and purchase order lines are Ordered. Also, there is no sequential restriction on shipment and 
invoice posting.

After an invoice is submitted, the invoice and invoice lines are mapped to a purchase order. On a 
successful mapping, the state of the invoice is set as follows:

• Awaiting Delivery: When no receipts exist, the order is partially delivered, or the invoice 
requires approval.

• Invoice Confirmed: When the purchase order is delivered and the amount invoiced matches 
the purchase order total amount.

• Requires Review: When the purchase order is delivered and the amount invoiced does not 
match the purchase order total amount.

When a valid invoice is posted for a line item, the same invoice cannot be updated.

If the provided invoice does not have a purchase order number, the invoice is rejected and 
you see an error message that states that one or more of the provided invoices does not have 
a purchase order number. If the provided invoice has a purchase order number, but it doesn't 
match the purchase order or no purchase order exists, you see an error message. The message 
states that one or more invoices do not have a corresponding purchase order that matches the 
purchase order number of the invoice. Also, if the amount invoiced sent from the third-party 
reseller does not match with the invoiced amount, the invoice is rejected.
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Status tables

To know the status of the invoice request, make a REST call into the ServiceNow  database using 
the Table  REST API. The response from the API lists the records where the invoice creation 
failed. For invoice response, query the Invoice Error table with the following parameter:

sysparm_query=outbound_error.supplier_id=<supplier_id>^outbound_error.state=20

The details on the customer ID, supplier ID, error type, unique import set ID, and state can be 
found in the Outbound Status table, which is the parent error table.

URL format

/api/sn_spend_intg/spendint/invoice

Supported request parameters

Path parameters

Name Description

None

Query parameters

Name Description

mode Support for asynchronous and synchronous modes for third-party integration.

Data type: String

Valid values:

• async: Asynchronous mode.

• sync: Synchronous mode.

Default: async

Request body parameters (XML or JSON)

Name Description

currency Required. Currency for subtotal, tax, and 
shipping. The subtotal, tax, and shipping should 
be in the same currency.

Data type: String

Maximum length: 40

customer_id Identifier for the customer.

Data type: String

Maximum length: 100
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Request body parameters (XML or JSON)  (continued)

Name Description

discounts Discounts that are applied toward the invoice. 
This is an editable field.

Data type: String

Maximum length: 100

invoice_date Required. Date on which the customer was 
invoiced.

Data type: String

Maximum length: 40

Format: YYYY-MM-DD

invoice_lines List of objects that define the lines that are being 
invoiced for purchases within this order.

Data type: Array

"invoice_lines": [
  {
    "invoiced_line_amount": 
 "String",
    "invoiced_quantity": 
 "String",
    "line_number": "String",
   
 "supplier_invoice_line_number": 
 "String",
    "sales_order_line_number": 
 "String"
  }
]

invoice_lines.invoiced_line_amount Required. Total cost, excluding taxes and 
shipping, that a customer is being invoiced for a 
given purchase order line.

Data type: String

Maximum length: 40

invoice_lines.invoiced_quantity Required. Quantity of goods or services that a 
customer is being invoiced for.

Data type: String

Maximum length: 40

invoice_lines.line_number Required. Purchase order line number that 
is generated by the customer for a particular 
purchase.
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Request body parameters (XML or JSON)  (continued)

Name Description

Data type: String

Maximum length: 40

invoice_lines.sales_order_line_number Required. Sales order line number that is 
generated by the supplier.

Data type: String

Maximum length: 40

invoice_lines.supplier_invoice_line_number Required. Identification number that is generated 
by a supplier for this invoice line.

Data type: String

Maximum length: 100

other_charges Other additional charges associated to the 
invoice. This is an editable field.

Data type: String

Maximum length: 100

order_number Required. Purchase order number that is 
provided by the customer for this order.

Data type: String

Maximum length: 40

remit_to_address Required. Location to which a payment is made.

Data type: String

Maximum length: 1000

sales_order_number Required. Number or value that is generated by 
the supplier for this order.

Data type: String

Maximum length: 40

shipping Required. Total shipping cost for the entire 
purchase.

Data type: String

Maximum length: 40

subtotal Required. Total amount of money to be paid to the 
supplier excluding tax and shipping charges.
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Request body parameters (XML or JSON)  (continued)

Name Description

Data type: String

Maximum length: 40

supplier_id Required. Identifier for the reseller or supplier that 
the customer can place orders with.

Data type: String

Maximum length: 100

supplier_invoice_number Required. Identification number that is generated 
by a supplier for this invoice.

Data type: String

Maximum length: 100

supplier_tax_id Tax identifier that is associated to the third party 
reseller. This is an editable field.

Data type: String

Maximum length: 100

tax Required. Total amount of taxes that are billed for 
the purchase.

Data type: String

Maximum length: 40

tax_rate Tax rate percentage that is applied for the order. 
This is an editable field.

Data type: String

Maximum length: 100

third_party_import_id Identifier that enables a third party to pass a 
string value to uniquely identify a set of imported 
data.

Data type: String

Maximum length: 100

total_amount_invoiced Required. Total amount of money to be paid to the 
supplier including tax and shipping charges.

Data type: String

Maximum length: 40
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Headers

The following request and response headers apply to this HTTP action only or apply to this 
action in a distinct way.

Request headers

Header Description

Accept Data format of the response body. Supported types: application/json  or 
application/xml.

Default: application/json

Note:  Only the application/json  data format is supported for Procurement 
Integration Framework.

Response headers

Header Description

None

Status codes

The following status codes apply to this HTTP action.

Status codes

Status code Description

success Successful. The request was successfully 
processed.

failure Unsuccessful. The request was processed 
with errors.

Response body parameters (JSON)
These response body parameters are received when queried in synchronous mode.

Name Description

error_response_body Description of the errors, listed by the sales order line 
number, sales order number, supplier invoice number, 
supplier invoice line number, and the error message.

Data type: Array

error_response_body.error_message Detailed error message.

Data type: String

status_code Response status such as "success" or "failure."

Data type: String
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Example: cURL request

curl 
 "https://instance.service-now.com/api/sn_spend_intg/spendint/in
voice" \
--request POST \
--header "Accept:application/json" \
--user 'username':'password'
{"root":[{
  "customer_id": "Customer - A",
  "supplier_id": "SUP-123456",
  "third_party_import_id": "undefined",
  "supplier_invoice_number": "QAAP89873220071",
  "supplier_tax_id": "TIN000000",
  "order_number": "POL7987633",
  "sales_order_number": "SO0000000081",
  "invoice_date": "YYYY-MM-DD",
  "subtotal": "6000",
  "tax_rate": "10%",
  "tax": "600",
  "shipping": "120",
  "other_charges": "100",
  "discounts": "200",
  "total_amount_invoiced": "6620",
  "remit_to_address": "1640 Camino Del Rio North #202, San 
 Diego,CA",
  "currency": "USD",
  "invoice_lines": [
    {
      "supplier_invoice_line_number": "QA789A867877ABN32251",
      "line_number": "POL587667",
      "sales_order_line_number": "SOL00000081",
      "invoiced_quantity": "45",
      "invoiced_line_amount": "4000"
    },
    {
      "line_number": "POL587668",
      "supplier_invoice_line_number": "78987323",
      "sales_order_line_number": "SOL98769",
      "invoiced_quantity": "12",
      "invoiced_line_amount": "2000"
    }
  ]
}
]}

Possible responses:

// Success response:
{
    "result": {
        "response": "success"
    }
}
 
// Error response:
{
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    "result": {
        "response": [
            {
                "customer_id": "Customer - A",
                "supplier_id": "SUP-123456",
                "third_party_import_id": "undefined",
                "status_code": "failure",
                "error_response_body": [
                    {
                        "sales_order_line_number": 
 "SOL00000081",
                        "sales_order_number": "SO0000000081",
                        "supplier_invoice_number": 
 "QAAP89873220071",
                        "supplier_invoice_line_number": 
 "QA789A867877ABN32251",
                        "error_message": "The invoice do not 
 have a corresponding purchase order which matches the purchase 
 order number of the invoice provided\n"
                    }
                ]
            }
        ]
    }
}

Procurement File Transfer Framework

Procurement File Transfer Framework  (PFTF) helps you transfer information between the 
ServiceNow  database and a third-party reseller through a File Transfer Protocol  (FTP). You can 
set up an FTP server for access and transfer of reseller data without any spoke development by 
the third-party reseller.

When the PFTF application is installed, the following applications from the ServiceNow 
IntegrationHub Professional Pack Installer must be auto-installed. This is a prerequisite.

• ServiceNow IntegrationHub Action Step - SSH

• ServiceNow IntegrationHub Action Step - SFTP

• ServiceNow IntegrationHub Flow Trigger - REST

FTP integration helps when you intend to transfer files between ServiceNow and your resellers.

Use Procurement File Transfer Framework  for the following activities:

• Support the FTP-based integration for suppliers.

• Standardize the file structure, formats, and naming conventions for each supplier.

• Manage large-scale data through FTP import and export.

• Simplify the import and export operations with mid server and flow designer.

• Use the file transfer workflows to control the data operations.

Currently, the following integrations are supported:

Imports:

• Catalog import

• Order acknowledgment import
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• Shipment import

• Invoice import

Exports: Order export

Your suppliers can upload the files with the recommended folder  structure and format on the 
server. ServiceNow imports and exports all the details automatically through scheduled data 
imports and exports.

Import data using FTP server

Import a file from a local source, a remote network server, or another instance by providing a path 
and authentication information. Transfer and manage procurement data in a principled structure 
that administrators can use for various data management operations.

Before you begin

• Understand the data import workflows and FTP functionality.

• Ensure that you install and configure an FTP client.

• Ensure that you install and configure MID Server  in your ServiceNow  instance to connect to the 
ERP server. See Installing the MID Server  for details.

Note:  The MID Server integration is required only for an ERP integration using SOAP 
services.

• Ensure you have permissions to access and pull data from FTP.

Role required: import_admin or admin

Procedure

1. Navigate to All.

2. On the left navigation pane, enter sys_data_source_list.do.
The entire list of available data sources is displayed.

3. In the Name  search field, enter spend  to find and select the spend data sources you want to 
configure.

4. On the form, fill in the fields:

File

Field Description

Name Enter a unique name for this data source.

Import set table label Specify a label for the import set staging 
table to use.

Import set table name ServiceNow uses the label to construct a 
unique table name to prevent namespace 
collision with an existing table. This table 
stores the data from any third-party sources.

Type Select File  as the type of data that you are 
importing from.

Format Select JSON  as format.
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Field Description

File retrieval method Select SFTP  as format for data transfer.

File path Specify the file path for querying.

5. Set additional fields based on the selected Type.
See the documentation for each data source type for additional field information. The Table 
transform map is associated with the table to transform the File Based Catalog 
Import [sn_spend_ftp_intg_catalog_stage]  data into Catalog Import 
[sn_spend_intg_imp_catalog]. For more information on the table transform map, see 
the Data source table information.

What to do next

• Manage the data integration by scheduled import and export jobs on a daily, weekly, or 
monthly basis. Perform the Scheduled Imports  based on your business needs. See Schedule 
a data import .

• Verify the accuracy of the data import and share the errors on the FTP server. The reseller can 
fix the posted errors using Perform export steps.

Run scheduled imports

A scheduled import allows administrators to import data on a regular schedule. Run import 
operations on a daily, weekly, or monthly basis based on your business requirements. Scheduled 
import runs a datasource similar to how a scheduler job runs the script.

Before you begin
Role required: import_scheduler, import_admin, or admin

Procedure

1. Navigate to All  > System Import Sets  > Administration  >  > Scheduled Imports.
A list of available scheduled imports appears with Run, Data source, Active, and Updated 
information.

2. Select Example File Based Catalog Import

3. Follow the steps for data import .

What to do next

• You can verify the data transfer records from Procurement Integrations  > Catalog  > FTP 
Catalog Imports. You can see all the data as one single payload content. See Payloads for 
more information.

• The same record is then transformed and available from Procurement Integrations  > Catalog 
> Catalog Imports.

Perform export steps

Export a file from a local source, a remote network server, or another instance by providing a path 
and authentication information.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Procurement Integrations  > File Transfer Setup  > FTP Integration 
Configurations.

2. Select New.

3. Select one of the following operations:

◦ Post Purchase Order

◦ Post Catalog Error

◦ Post Shipment Error

◦ Post Invoice Error

◦ Post Price Error

◦ Post Availability Error

4. Provide Mid server  connection and path details.
The MID Server facilitates communication and the movement of data between a ServiceNow 
instance and external applications, data sources, and services. For more information on the 
MID server, see the related topics.

5. Provide FTP server  connection and path details.

For more information on connection, path, and HTTP connection, see the related topics.

Verify the accuracy of the data, identify any discrepancies, and share the errors with the 
reseller on the same FTP server. You may use flow designer to move the data from your 
instance to external applications.

Related topics

MID Server

Introduction to credentials, connections, and aliases

Export data to the FTP server

Export a file from a local source, a remote network server, or another instance by providing a path 
and authentication information.

Before you begin
You can use Data Source to pull the data from an FTP server. However, you can't use Data Source 
to post the data to the FTP server.

Role required: admin

About this task
Integrate your FTP Server to export all the confirmed orders using Flow Designer.

Procedure

Navigate to All  > Procurement Integration  > Ordering  > Outbound Orders.
A list of outbound orders appears.

Use the Flow Designer to automate processes of data movement from ServiceNow to third-party 
applications. Flow Designer lets you move the procurement data between a ServiceNow instance 
and external applications, data sources, and services.
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Example:
You can use Flow Designer subflows to move the data into a mid server and then to external 
resources. Here is a quick example for processing the Purchase Order Queue.

• Look up for FTP integration record with the supplier ID. For example, Process Purchase Order 
Outbound Queue.

• Generate Purchase Order payload.

• Push to Mid server.

• Wait for duration of time.

• Push to FTP server.

• Assign subflow outputs.

• Add an action, flow logic, or subflow as required.

Note:  Based on your business requirements, add additional actions, triggers, or 
subflows.

Related topics

MID Server

Introduction to credentials, connections, and aliases

Data source table information

The following information can help you with the FTP import and export data.

Data source types

Data sources are used to create an import set so that data can be processed, if necessary, prior 
to being mapped onto a production table.

Label Name

File Data is in a recognized file format, accessible 
locally or remotely through several file retrieval 
methods.

JDBC Data is in a database, accessible using JDBC. 
ServiceNow Technical Support supports 
Oracle, MySQL, Sybase, DB2 Universal, and 
MS SQL Server drivers.

LDAP Data is in an LDAP server, accessible through 
the LDAP or LDAPS ports, 389 and 636 
respectively.

OIDC Data is accessible via OIDC.

REST (IntegrationHub) Data is in a REST API, accessible through 
IntegrationHub.

Data Stream IntegrationHub Data is loaded from a Data Stream Action, 
accessible through IntegrationHub.

Custom (Load by Script) Data is obtained using a custom script.
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Folder structure

See the following folder structure. You can use the <type>.request  for taking the data and 
<type>.response  for posting the data back to the FTP server:

catalog.request
catalog.response
 
invoice.request
invoice.response
 
orders.request
orders.response
 
shipment.request
shipment.response

Associated Table Transform Map

To import data, define a data source and transform map, and schedule or run an import at some 
regular interval.

Table transform map is associated with the table to transform the File Based Catalog 
Import [sn_spend_ftp_intg_catalog_stage]  data into Catalog Import 
[sn_spend_intg_imp_catalog]. See the following table transform labels and associated 
table information.

Label Name

Invoice Import sn_spend_intg_imp_invoice

Catalog Import sn_spend_intg_imp_catalog

Availability Import sn_spend_intg_imp_availability

Shipment Import sn_spend_intg_imp_shipment

Order Acknowledgment sn_spend_intg_imp_purchase_order_ack

Price Import sn_spend_intg_imp_price

Payloads samples and errors

Use the following sample payloads to enable procurement data import and export.

Payloads

See the following sample payload for importing and exporting procurement records.

Name Sample payload

Invoice Import See Spendint API - POST /sn_spend_intg/
spendint/invoice

Catalog Import See Spendint API - POST /sn_spend_intg/
spendint/catalog

Availability Import See Spendint API - POST /sn_spend_intg/
spendint/availability
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Name Sample payload

Shipment Import See Spendint API - POST /sn_spend_intg/
spendint/shipment

Order Acknowledgment See Spendint API - POST /sn_spend_intg/
spendint/orderack

Price Import See Spendint API - POST /sn_spend_intg/
spendint/price

Errors

This section describes the following procurement errors:

Catalog Error (Outbound)

{
  "root": {
    "status_message": "",
    "status_code": "Failure",
    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "error_response_body": [
      {
        "error_message": "Field Value empty/Formatting issue 
 Negotiated currency \n",
        "mpn": "Z0WQ-20004301931",
        "sku": "55788741"
      }
    ]
  }
}

Price Error (Outbound)

 
{
  "root": {
    "status_message": "",
    "status_code": "Failure",
    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "error_response_body": [
      {
        "error_message": "Field Value empty/Formatting issue 
 Negotiated currency \n",
        "mpn": "Z0WQ-20004301931"
      }
    ]
  }
}

Availability Error (Outbound)

{
  "root": {
    "status_message": "",
    "status_code": "Failure",
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    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "error_response_body": [
      {
        "error_message": "Field Value empty/Formatting issue 
 Negotiated currency \n",
        "mpn": "Z0WQ-20004301931"
      }
    ]
  }
}

Shipment Error (Outbound)

{
  "root": {
    "status_message": "",
    "status_code": "Failure",
    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "error_response_body": [
      {
        "supplier_shipment_number": "SHIPSUP00001 \n",
        "sales_order_number": "SOL0010001 \n",
        "sales_order_line_number": "SOL0010001 \n",
        "error_message": "The purchase order for this shipment 
 does not exist \n"
      }
    ]
  }
}

Invoice Error (Outbound)

{
  "root": {
    "status_message": "",
    "status_code": "Failure",
    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "error_response_body": [
      {
        "supplier_invoice_number": "SUPINV000001 \n",
        "supplier_invoice_line_number": "SUPINVL0000001 \n",
        "sales_order_number": "SOL0010001 \n",
        "sales_order_line_number": "SOL0010001 \n",
        "error_message": "The provided invoices does not have a 
 purchase order line number \n"
      }
    ]
  }
}

Outbound Order

 
{
  "root": {
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    "order_amount": "200",
    "order_number": "PO0010001",
    "currency": "USD",
    "order_date": "01-01-2021",
    "customer_id": "AB-1234323",
    "supplier_id": "SUP-123456",
    "catalog_id": "ABC780987",
    "order_lines": [
      {
        "sku": "A20002 \n",
        "line_number":"POL0010001 \n",
        "mpn": "09876789 \n",
        "purchased_quantity": "2 \n",
        "unit": "Each \n",
        "unit_price": "USD \n",
        "ship_to": "John A \n",
        "contract_number": "VEN09000002 \n",
        "organization_id": "868979 \n",
        "enroll_in_abm": "yes",
        "shipping_address": {
          "name": "2225 Lawson Ln, Santa Clara, CA 95054, United 
 States\n",
          "street": "2225 Lawson Ln \n",
          "city": "Santa Clara \n",
          "state": "CA \n",
          "zip_code": "95054 \n",
          "country": "Unites States of America \n"
        }
      }
    ]
  }
}

Using Sourcing and Procurement Operations
Employees, shoppers, or requesters can use Sourcing and Procurement Operations  to self-
service requests, and source or purchase products and services through the procurement 
organization. Procurement specialists and sourcing managers can use Sourcing and 
Procurement Operations  to work on various procurement objects such as purchase requisitions, 
sourcing requests, negotiations, procurement requests, cases, and more.

Using Shopping Hub

Use the Shopping Hub  module to request pricing or place an order for products and services. 
You can also request for products or services that you don’t see in the catalog, revise, replace, 
or return your ordered products and services, customize your top suppliers, work on your to-dos, 
and much more.

This video shows the shopper journey, from searching for products in Employee Center  to 
purchasing in Shopping Hub, fulfillment in Source-to-Pay Workspace, and receipt completion in 
Shopping Hub.

https://player.vimeo.com/video/1073634788?
h=44cc0708f7&badge=0&autopause=0&player_id=0&app_id=58479
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Benefits of the UIB experience

The Shopping Hub (sn_spend_uib) application provides configurable experiences using the Now 
Experience UI Builder (UIB). This allows you greater flexibility to provide streamlined employee 
experiences to meet your specific business needs. Some of the things that you can do here 
include, but isn’t limited to:

• Customize your portals by adding new filters and badges, renaming labels, branding, and so 
on.

• Expose additional fields or hide fields as required, to meet your business needs.

• Streamline the quick checkout flow using record producer.

• Add pages to provide new experiences.

For detailed information on how to configure your experience with UIB, see Working in UI 
Builder .

Related topics

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Setting up primary data for ShoppingHub

Service portal configuration for ShoppingHub

Configure punchout for third-party site purchases

Customize your top suppliers on Shopping Hub

My purchases on Shopping Hub

Log in to Shopping Hub for the first time

Shoppers who log in to Shopping Hub for the very first time must set up a default delivery 
location before they can browse products and access the other pages.

If the shopper navigates to a different page other than the Shopping Hub home page without 
setting up default delivery address, they are redirected to the home page to set the default 
delivery location.

Set work address as your delivery location

Set your work address as the default location when you log in to Shopping Hub for the first time.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. In the Welcome to Shopping Hub dialog box, select Set a delivery location.

3. In the Address type section, select Work address (already approved).

4. Select Next.

5. In the Select a Work address dialog box, fill in the fields:

Field Description

Recipient The user who is the recipient of this address.
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Field Description

Work address The address of the office location.

6. Select Use this location.

Select a delivery location other than the work address

Set your default location to an address other than your work address when you log in to 
Shopping Hub for the first time.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. In the Welcome to Shopping Hub dialog box, select Set a delivery location.

3. In the Address type section, select Somewhere else.

4. Select Next.

5. In the Add a delivery address dialog box, fill in the fields.

Field Description

Recipient The user who is the recipient of this address.

Country The country of the delivery location.

Street The street address of the delivery location.

Floor, unit, etc. The floor number of the delivery location.

City The city of the delivery location.

State / Province The state of the delivery location.

Zip / Postal code The zip code of the delivery location.

6. Select Submit for approval.

Browse punchout and native catalog items from the Categories and Suppliers lists in 
Shopping Hub  (SH)

In Shopping Hub, you can view both the punchout (third-party) and the native catalog items from 
the Categories or the Suppliers list on the Shopping Hub home page.

Before you begin
Role required: admin

About this task
Only cXML punchout products are displayed in both the Categories  and Suppliers  lists. The 
punchout products uploaded via API are not listed.

Important:  Enabling shopping controls may affect the page load time.

For more information about the checkout experiences for shoppers based on whether they have 
installed Employee Center, Shopping Hub, or both, see Shopper checkout experiences based on 
installed applications.
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Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the Categories  list, and select a category; for example, Office Equipment.

3. Select Browse Office Equipment.

The Office Equipment page displays both the punchout and native catalog items that belong to 
this category.

4. Navigate to All  > ShoppingHub  > ShoppingHub Home.

5. From the Suppliers list, select the letter corresponding to the first letter of the supplier's name.
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6. Select a supplier.
The supplier page displays both the punchout and native catalog items that are sold by this 
supplier.
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7. On the product tile you want to purchase, select one of the following options:
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◦ Select Product  to open the product page and add it to your cart or request to purchase.

◦ Select Supplier site  to open the supplier's website.

Order a product with quick checkout

Order a product or service that you want to purchase from the product catalog available on 
Shopping Hub  Home.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.
If you’re shopping for someone else as a delegate, select the appropriate shopper from the 
Shopping as  list.

Note:  This option is visible only if you’re configured to delegate for another employee 
shopper.

2. Browse for the required product or service using the Categories  or the Suppliers  list on the 
Shopping Hub  homepage, or search for it.
If you’re a returning shopper, you can also find your recently viewed items on the homepage.
On the product details page, you can see the price of the product and the probable date of its 
delivery.

If the pricing isn’t available and you need to contact the supplier for it, you can check the 
expected date by which the pricing details will likely be provided. For more information, see 
Complete sourcing checkout.

3. To place an order for a product or service that has pricing:
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a. Select Quantity  or Budget  as appropriate.

b. Enter the quantity that you need or the budget at your disposal.

Note:  The budget you provide automatically calculates the quantity for the product 
and the corresponding price. While entering the price, you can change your currency 
type from the list.

c. Do one of the following actions:

▪ Select Request to buy  to perform a quick checkout with your selected product.

▪ Select Add to cart  to save your product to your cart and continue shopping.

Note:  For more information on how to use your shopping cart, see Shopping cart.

Order a product with quick checkout

d. On the quick checkout form, fill in the fields.

Field Description

Where 
do you 
want this 
delivered?

Location where you want your product to be delivered. The options are:

▪ To a saved location

Note:  The recipient is the logged-in user or the delegated user.

▪ To a work address (already approved)

▪ To somewhere else

When 
do you 
need this 
product?

Date range when you want your product to be delivered. The options are:

▪ As soon as possible: For the quickest delivery slot possible for the product. 
This is calculated based on the product category of the selected product.

▪ A specific date

▪ I have a time frame in mind (a blanket order)
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Field Description

Note:  You can select a date or date range that is in the past, present, 
or future. If you select a date range, you must enter your requested start 
and end dates to proceed.

Payment 
method

Method of making the payment. Select a cost center from the list, which is 
defaulted with your assigned cost center. You can also add multiple cost 
centers, if necessary, and save them for future use.

Note:  Verify that the total percentage of all the cost centers doesn’t 
exceed 100%.

You can view the cost center and allocation breakup from the purchase 
requisition that is created, by navigating to the Cost Allocations related list of 
the associated purchase requisition line.

If you have available credits, the same is displayed here as a mode of 
payment. For details, see Shop with employee credits.

Note:  If you change the quantity or delivery location during checkout, the shipping 
and tax estimates are recalculated and updated accordingly. The cart line is also 
updated with the new estimates.

e. Based on whether the purchase is for an existing project, select one of these options.

Field Description

No Purchase isn’t for an existing project.

Yes Purchase is for an existing project. Enter the project details as required.

Note:  You must have the Procurement with Project Management 
(sn_spend_ppm) application installed, and also have the IT Project User role. 
For more information, see Sourcing and Procurement Operations integration 
with Project Management.

f. In the Purchase reason  field, provide your reason for making the purchase.
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Purchase reason and watchlist for the purchase request

g. In the Watchlist  field, select one or more users to be added to the watchlist of the purchase 
request.

The users on the Watchlist receive email notifications when specific conditions are fulfilled 
and the purchase request status is updated. By default, you can add up to 20 users in 
the watchlist. You can modify this value by configuring the system properties. For more 
information, see Components installed with Sourcing and Procurement Operations.

Note:  This limit for the number of users on the watchlist is applicable only while 
making the purchase request. You can add more users to the watchlist after the 
purchase request is created. However, you can add more users only at the purchase 
requisitions page.

h. Add any supporting documents for this purchase as attachments, if applicable.

Note:  You can download, remove, or rename the attachments, as required. These 
attachments are also appended to the associated purchase requisition for reference.

i. Select Submit request.

What to do next

• Review your purchase. After you complete your checkout, select Review your purchase  to 
view the details or your order.

• To review your orders anytime later, you can select My purchases  from your profile on 
ShoppingHub.

◦ View the list of all purchases placed from your shopping account.

◦ Track the progress of an order, review to-dos, and so on.

Note:  For more information, see My purchases.
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Complete sourcing checkout

As a shopper, you can request pricing or more information about a product or service in the 
Shopping Hub  catalog that doesn’t have contractual pricing.

Before you begin
Role required: sn_shop.shopper

About this task
During checkout, you can provide information that the procurement team needs about the 
selected product, product model, or category. Your responses can improve the sourcing 
processes and overall operational efficiency in procurement.
Share additional sourcing request info such as pricing details, budget, quotation, delivery 
address, and timeframe. Follow these steps to provide the sourcing team with the necessary 
information required to collect quotes or more info for your product or service:

Procedure

1. Browse or search for the required product or service from ShoppingHub  > ShoppingHub 
Home.

2. At Request pricing, specify the quantity or budget.
Here, you can enter the quantity or the price. While entering the price, you can change your 
currency type from the list. You can also see the date by which you can get the pricing details 
on the product details page. This is the sourcing time for the displayed product.

3. Select Request pricing or info.
Your administrator may have configured this button to read differently.
Information relevant to the product or service is displayed in the contextual side panel.

4. Follow the on-screen workflow and specify the required information:

◦ I need a quote

◦ I need a proposal

◦ I need a proof of concept

◦ I need more information about the products or suppliers

For example, when you select I need a quote, provide the following information based on 
whether you're looking for products or services:

◦ What project is this request for?

Note:  This field is available only when you have the Procurement with Project 
Management (sn_spend_ppm) application installed, and also have the IT Project User 
role. For more information, see Sourcing and Procurement Operations integration with 
Project Management.

◦ Why do you need these products?

◦ Why do you need these services?

◦ Supplier information

Note:  If you’ve already contacted the supplier regarding your request, select the 
appropriate option, and enter details of the supplier contact such as first and last 
names, job title, and registered email ID. Before you save the supplier contact details, 
ensure that your admin has set up the email domains for the supplier contacts, and the 
corresponding records are available in the Supplier Email Domain table.

For more information on adding suppliers, see:
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▪ From Platform: Add a supplier.

▪ From the supplier catalog: Add a supplier contact using the supplier catalog.

▪ From Source-to-Pay Workspace: Add a supplier contact from the Source-to-Pay 
Workspace.

◦ How much do you potentially need?

◦ When would you like this delivered? For products, select from these options.

▪ As soon as possible  for the quickest delivery slot possible. This is calculated based on the 
product category of each selected product.

▪ A specific date  if you have a specific delivery date in mind.

▪ I am not sure (estimated timeframe)  to select a time frame for the product based on date 
range or term.

◦ When do you need this service? For services, select from these options.

▪ Within a specific timeframe  to provide the start date and end dates of the service.

▪ I am not sure (estimated timeframe)  to select a time frame for the service based on date 
range or term.

Note:  You can select a date or date range that is in the past, present, or future. If you 
select a date range, you must enter your requested start and end dates to proceed. You 
can specify the term length of the product or service and the term value in days, weeks, 
months, quarters, or years. Also, when you select a time frame, the order becomes a 
blanket type order, and you don’t need to specify a payment method during checkout.

◦ Where do you want this delivered? Select from these options.

▪ To a saved location: In this case, the primary saved address of the logged-in user is 
displayed.

▪ To a work address (already approved): In this case, you must select who is receiving the 
item, or the business owner.

▪ To somewhere else

Note:  Based on your configuration, you may see additional information, such as details 
and attachments. This additional information can help source the service or product 
quickly.

5. Select Submit Request.

Related topics

Order a product with quick checkout

Shopping cart

As a shopper, you can use the shopping cart to store all your shortlisted products, both goods 
and services, so that you can continue shopping and place your purchase request for all 
products at one go, when done.

In your shopping cart, services are tagged for easy identification. The tags help you differentiate 
them from goods.

If you have credits allocated to you for a product or category, you can use them during final 
checkout. Products that can be bought with credits are tagged as well.
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If you want to switch to shopping as a delegate, the items in your cart are saved and an alert 
message stating the same is displayed.

Add products to your shopping cart

Use your shopping cart to add multiple products that you have shortlisted and want to purchase 
when you are done shopping on Shopping Hub.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Browse for the required goods or services from the Categories  or the Suppliers  list on the 
Shopping Hub  homepage.

3. Select Add to cart.

What to do next
When you are done adding products to your cart, you can review your shopping cart and 
proceed to final checkout. For more information, see Review your shopping cart.

Review your shopping cart

When you are done with your shopping, review your shopping cart to ensure that you have the 
right products from the right suppliers in the right quantities in your cart.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the shopping cart icon.

3. Do one of the following actions:
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◦ Select +  or –  to edit the purchase quantity for the products you shortlisted.

◦ Select Remove  to remove products from your cart.

Note:  You can select Undo  if you wish to add the product back to your cart. This 
option is not available for bundled products.

◦ Select Purchase later  if you want to buy a product at a later date or time.

◦ Select Remove all items from cart  to clear your cart.

Note:  Purchase later  option is not available for bundled products. Also, if the purchase 
quantity of a bundled product is updated, the quantities of the products within the bundle 
get updated automatically.

What to do next
When you’re done reviewing your cart, you can proceed with the final checkout. For more 
information on how to proceed, see Complete your checkout.

Cart line update scenarios

Cart lines are created, updated, or deleted based on the updates that you make to the products 
in your shopping cart.

• A new cart line is created for every new product that you add to your shopping cart.

• If an existing cart line is created through one method, and you go back to the same product 
details page and add more through another method, first by quantity and then by budget 
for example, the existing cart line is updated accordingly without creating a new cart line. 
In this scenario, when you add by budget, quantity is back-calculated. Similarly, when you 
add by quantity, the corresponding budget is calculated by multiplying the quantity with the 
contractual price.
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Note:  Cart line updates by budget are not supported for bundled products.

• If you set a new delivery location in the secondary navigation bar or switch users while 
shopping, and add the same supplier product to your shopping cart, a new cart line is created.

• If the individual cart lines contain different currencies, the values are displayed in the 
reference currency in the Summary section. If a single currency exists for all the cart lines, the 
same is displayed in the Summary section. The price in the cart line continues to be in the 
contractual price currency.

• When you remove a product from your cart, the cart line is updated to reflect the status of the 
product, which is now Pending Deletion. If you wish to add the removed product back to your 
cart, and select Undo, the cart line status is updated to Visible in Cart.

• If you wish to buy a product at a later date or time, and select Purchase later, the cart line 
status is updated to Purchasing Later.

• If you move a product, some quantity of which already exists in your cart, from your Purchase 
later  section to your shopping cart, the cart lines merge and the purchase quantity is updated 
accordingly.

Product selection overrides

Certain scenarios such as excluded suppliers and shopping control restrictions can override 
your product selection capability.

Excluded suppliers

If a supplier is marked as excluded in the Relationship status  field under the Relationship 
Summary  tab on the Supplier form view, the information is displayed under the respective 
purchase requisitions and purchase orders.

In your shopping cart, if you have any product from a excluded supplier, a message is displayed 
stating that the product has been removed and is no longer available for purchase. You can 
select the link in the message to view similar products from other suppliers, if they exist. An email 
with this information is also sent to your registered email. The visibility status of the removed 
product is updated to Supplier Excluded on the cart line.
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Shopping controls

A ShoppingHub administrator can set shopping controls to restrict your access to specific 
products.

In your shopping cart, if you have any such product that has restricted access, a message is 
displayed stating that the product has been removed and is no longer available for purchase. 
You can select the link in the message to view similar products from other suppliers, if they exist. 
The visibility status of such a product is updated to Product Access Denied on the cart line.

Complete your checkout

Proceed to checkout when you’ve completed your shopping and have reviewed your shopping 
cart.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Select a delivery location.

2. Select a delivery date.

3. Select a payment method.

4. Provide a reason for your purchase.

5. Add users to the watchlist of the purchase

6. Add relevant attachments, if applicable.

Note:  You can add attachments at the entire purchase level and also at the individual 
product level. The purchase requisitions display the attachments added at both the 
levels. If approvals are required for this purchase, these attachments are available for 
all the approvers in both Shopping Hub and Employee Center. The automatic approval 
emails that are triggered also contain the attachments for reference, as needed.

7. Provide any additional information, if applicable.

Note: 

◦ If you decide to go back and update any of your previously selected parameters, be 
it delivery location, delivery date, payment method, or purchase reason, a warning 
message is displayed stating that this update shall undo all your selections up to 
checkout.

◦ The data you enter during checkout are lost in an incomplete checkout process. For 
more information, see Checkout data loss scenarios.

8. Select Complete checkout.

Your purchase is requested, and a confirmation page is displayed with the following 
information:
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◦ Message stating that your requested amount, if approved, shall be processed and sent to 
the supplier, and that you’ll be notified of the same.

◦ Link to view all your purchases. This takes you to the My purchases  landing page.

◦ What to expect, listing the next steps.

Note:  On completing your checkout, an appropriate number of cart lines are created, 
which then result in the creation of purchase lines. For more information, see Purchase 
line creation scenarios.

Select a delivery location

You can select either a single delivery location or multiple delivery locations for the various 
products in your cart.

Before you begin
Role required: sn_shop.shopper.

Procedure

1. From your shopping cart, select Proceed to checkout.
The Checkout page appears.

2. In the Delivery location section, select your preferred delivery location.

Note: 

◦ You can go with your default delivery location, which is based on what you selected 
from the Deliver to  list on the primary navigation bar. You can also choose to deliver 
to an office location, another address, or multiple locations, if need be. For more 
information on these, see Delivery location options.

◦ You can view your order details such as negotiated unit cost, purchase quantity, 
estimated tax, and estimated shipping on the Delivery location page as well as in the 
Summary section.

◦ If you update the quantities, the amount (including shipping) is recalculated in real 
time and reflected accordingly in the product header card as well as in the Summary 
section.
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What to do next
When you are done selecting delivery locations for the products in your cart, you can select 
delivery dates for them. For more information, see Select a delivery date.

To prevent products from being shipped to invalid locations, see Manage delivery to valid 
address

Delivery location options

As a shopper, you can select either a single delivery location or multiple delivery locations for the 
various products in your cart.

You can use the toggle feature between entire purchase  and product  to specify if the delivery 
location applies to the entire purchase or to individual products. This toggle is conditionally 
displayed based on predefined criteria. For example, if there is only a single item in your cart, the 
toggle feature does not apply and is therefore not displayed.

Toggle between entire purchase and product

For each existing delivery location, its code and full address are displayed. While you can go with 
your default delivery location that is preselected for faster checkout, the following options are 
also available:

• Deliver to work address: Allows you to create a new delivery location by adding a recipient 
and selecting a registered office address. Select the Save this address for future use  check 
box if you want to view it in your preferred delivery locations list.

• Deliver to somewhere else: Allows you to create a new delivery location by adding a recipient 
and filling out the Deliver to somewhere else form. Select the Save this address for future use 
check box if you want to view it in your preferred delivery locations list. For information on type-
ahead and auto-fill suggestions, see Delivery address suggestions.
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• Deliver to multiple locations: Allows you to assign multiple delivery locations for the various 
products in your cart. You can also assign multiple delivery locations to just a single product in 
your cart and update the quantity for each defined delivery location from this page.

Related topics

Manage delivery to valid address

Valid country location

Delivery address suggestions

Improve your shopper experience with filling in a new address location through type-ahead and 
auto-fill, in the Deliver to somewhere else form. You can further use the StreetService script to 
integrate with an Address Verification Service (AVS) of your choice to get enhanced address 
suggestions.
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This reduces the manual effort in entering each data point in an address, prevents user entered 
data errors, and allows you to store cleaner delivery address location records. It also helps your 
Procurement Specialists to easily view and complete delivery address validation-related tasks.

You can also enable your admins to easily implement their own address validation services to 
render address suggestions when shoppers are filling out a new address location. You can either 
import an XML file or select Insert and stay  on the StreetService script to integrate with a third-
party AVS in your instance. Ensure that you are in the Source-to-Pay Common Architecture  scope 
when importing the XML file or making changes to the StreetService script. You can also import 
the XML file by selecting any table, right-selecting the table header, and selecting Import XML. 
Provide your own API keys and endpoints for the AVS of your choice within the StreetService 
script.

Note:  If you do not have an AVS set up at your end, this feature prompts you with address 
suggestions from your saved and office locations.

Valid countries for delivery

As a shopper, you can view, add, and select the delivery locations and office locations while 
placing an order on ShoppingHub.

When an administrator configures valid countries for shipping on the Supplier  or Supplier 
product  using the Supplier delivers to  field, you can see the product availability at valid 
locations and complete the order.

On configuration, shoppers can gain the following insights:

• Display supported delivery countries and availability for each product.

• View, add, edit, and select valid delivery locations.

• Prevent products from being shipped to invalid locations.

Add, modify, and select valid delivery locations and office locations from the following flows:

• Address from Deliver to  at primary navigation

• Address at Request to buy

• Address at Add to cart

For more information on how to configure valid countries, see Manage delivery to valid address.

Related topics

Valid country location

Valid country location

As a shopper, you can select a valid delivery location based on the preconfigured countries.

Validate addresses

Based on the countries configured, you can prevent products from being shipped to invalid 
locations. Perform the address validation at various stages.

• See the valid countries for delivery from the product and purchase pages.

• See the product availability and unavailability when a shopper changes delivery location from 
the Deliver to  list to an unsupported country on the product details page.

• Add, edit, and select the available delivery addresses and office addresses.

• See the product availability based on the office address or delivery location in the primary 
navigation bar.
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• Add valid Deliver to work address  and Deliver to somewhere else  from the primary navigation 
bar, contextual side panel, quick checkout, and entire purchase.

• Based on your configuration, filter the list of countries and the product catalog and display the 
addresses and offices where delivery is available.

• Validate the saved address list, deliver to work address, and deliver to somewhere else during 
quick checkout and full checkout.

• Select valid addresses for each product based on the countries or office locations where the 
delivery is available.

• During full cart checkout, toggle between entire purchase and product to see and select 
available addresses.

• See the following address validation message on product and purchase pages: This item 
does not deliver to <countryname>.

• See the address validation message Delivery is only available for certain 
countries.

The following example shows how a shopper can add or select valid addresses during various 
stages of checkout:

Address validation flows

• Select the primary address for delivery from the primary navigation bar.

• See the product availability based on the location address on the primary navigation bar.

• Select the number of countries to see the list of valid countries.

• When your administrator configures the valid countries, you see only certain countries where 
delivery is available.

• You can change your location from Deliver to  and complete the order.

• When you add a new address, the country list displays only the valid list of countries.

• When your product is available for delivery to the location you selected, you can place the 
order using the Add to cart  or Request to buy  buttons.

• When you select Request to buy, you can select the delivery location from a list of saved 
addresses.

◦ When you select Deliver to work address  to add a new address, you can add addresses 
from only certain countries that are preconfigured for delivery.

◦ When you select Deliver to somewhere else  to add a new address, you can add addresses 
from only certain countries that are preconfigured for delivery.

See the product availability on the products page. When the product is unavailable for delivery, 
these buttons are disabled with the following error message:This item does not 
deliver to <countryname>  or This item does not deliver to this 
address.

• You can add or select the delivery location for the valid countries and complete the shopping.

• From your shopping cart, when you select Proceed to checkout, select valid addresses for 
each product based on the countries or office locations where the delivery is available.

Related topics

Manage delivery to valid address

Valid countries for delivery

Delivery location options
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Select a delivery date

You can select a single delivery date or multiple delivery dates for the various products in your 
cart. If you're unsure of a delivery date, you can provide an estimated time frame which then 
creates a blanket order.

Before you begin
To select delivery dates for the products in your cart, you should have first selected appropriate 
delivery locations for them.

Role required: sn_shop.shopper

Procedure

1. On the Checkout page, select Continue to delivery date.

You can also select Delivery date  from the stepper pages to directly go to the page.
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2. In the Delivery date section, select your preferred delivery date.

Note: 

◦ Depending on whether the product is a good or service, different delivery date options 
are available. For more information on this, see Order a product.

◦ When adding a delivery date, the quantity of the product is updated accordingly. You 
can also specify different delivery dates for each supplier product and delivery location 
combination. For more information on these, see Delivery date options.

◦ For a bundled product, depending on whether the products within the bundle are 
goods or services, different delivery date options are displayed.

What to do next
When you are done selecting delivery dates for the products in your cart, you can select 
payment methods for them. For more information, see Select a payment method.

Delivery date options

As a shopper, you have the option to select either a single delivery date or multiple delivery 
dates for the various products in your cart.

If you’re unsure of a delivery date, you can specify an estimated time frame for delivery. This time 
frame can be a term or date range. You can specify the term length and the term value in days, 
weeks, months, quarters, or years.

Date range for delivery

Note:  You can select a date or date range that is in the past, present, or future. If you 
select a date range, you must enter your requested start and end dates to proceed. Also, 
when you select a time frame, the order becomes a blanket type order, and you don’t need 
to specify a payment method during checkout.
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If you have a product in your cart that has an eligible credit to be used, the option to provide a 
time frame is not available.

You can use the toggle feature between entire purchase and product to specify if the delivery 
date applies to the entire purchase or to individual products. This toggle is conditionally 
displayed based on predefined criteria. For example, if there’s only a single item in your cart, the 
toggle feature doesn’t apply and is therefore not displayed.

While you can always go with the default delivery date for the products for faster checkout, the 
following options are also available:

• Add another delivery date: Allows you to add a new delivery date for a product in your cart. If 
you have just one quantity of a product in your cart, adding new delivery dates automatically 
adds corresponding quantities of the same product to your cart. The quantity is recalculated 
in real time and reflected accordingly in the product header card as well as in the Summary 
section.

• Request single delivery date: Allows you to revert to a single delivery date after you have 
specified multiple delivery dates for the products in your cart. A warning message is displayed 
stating that this update shall undo all the delivery date selections that you’ve done so far.

Select a payment method

You can pay using one of your preferred payment methods or use another cost center to make 
the payment. You can even pay using multiple cost centers for the various products in your cart.

Before you begin
To select a payment method for the products in your cart, you should have first selected 
appropriate delivery dates for them.

Role required: sn_shop.shopper.
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Procedure

1. On the Checkout page, select Continue to payment method.

You can also select Payment method  from the stepper pages to directly go to the page.

2. In the Payment method section, select your preferred payment method.

Note: 

◦ Your preferred payment methods are displayed. These are stored in the backend in the 
sn_shop_payment_method table with the preferred tags against these records. You 
can go with your default payment method, or choose to pay using another cost center, 
multiple cost centers, available credits, or paychecks, if need be. For more information 
on these, see Payment method options.

◦ For blanket order purchases, an information banner is displayed stating that payment 
methods will be determined when individual purchases are made against the blanket 
order.

What to do next
When you are done selecting the payment method for the products in your cart, you must 
provide a reason for making this purchase. For more information, see Provide a reason for your 
purchase.

Payment method options

As a shopper, you have the option to pay using one of your preferred payment methods or use 
another cost center. You even have the option to pay using multiple cost centers for the various 
products in your cart.
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If you have credits allocated to you for a particular good or service, those credits are applied 
here. You can pay the remaining balance, if applicable, from your future paychecks.

You can use the toggle feature between entire purchase and product to specify if the payment 
method applies to the entire purchase or to individual products. This toggle is conditionally 
displayed based on predefined criteria. For example, if there is only a single item in your cart, the 
toggle feature does not apply and is therefore not displayed.

While you can always go with your default payment method that is preselected at the backend 
for faster checkout, the following options are also available:

• Use another cost center: Allows you to create a new payment method by searching for and 
selecting another cost center. Select the Save this cost center for future use  check box if you 
want to view it in your preferred payment methods list for any subsequent purchases. A new 
record is created in the backend in the sn_shop_payment_method table with the preferred tag 
against this record.

• Pay with multiple cost centers: Allows you to add another cost center for making your 
payment. Adding a new cost center automatically sets the payment percentage to 99% for 
the first cost center and 1% for the newly added one. You can update the percentage for both, 
but the total needs to add up to 100% for you to proceed to the next step. To revert to a single 
cost center for payment, you can either select Pay with one cost center  or manually delete the 
newly added cost center rows and update the percentage.

• Pay using credits: Allows you to use your allocated credits for specified products and services. 
The credits available for purchase towards the individual products are displayed accordingly. 
The estimated total and the amount you pay are automatically calculated by the system and 
displayed in the Summary section. Shipping and tax costs are excluded for both you pay and 
credit purchase calculations. For more information on employee credits and how to use them, 
see Shop with employee credits.

• Pay using paychecks: Allows you to pay the remaining amount, after optimum credit 
consumption, through equal deductions from your future paychecks. You can choose from the 
list of available paycheck options and accept the terms and conditions for paycheck payments 
to proceed to the next step.

Provide a reason for your purchase

You must provide a reason for making your purchase. This is mandatory and allows you to 
complete your checkout.

Before you begin
To provide a purchase reason, you should have first selected your desired payment method.

Role required: sn_shop.shopper

Procedure

1. On the Checkout page, select Continue to purchase reason.
You can also select Reason for purchase  from the stepper pages to directly go to the page.

2. In the Reason for purchase  field, enter your purchase reason.
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Note:  For purchases that have credits applied to them, the reason for purchase is 
defaulted with “Used employee credit”. You can update this reason if desired. Also, the 
shipping and tax estimates are recalculated as per your quantity and delivery location 
updates, and reflected in the Summary section on this page.

What to do next
When you are done providing your purchase reason, you can provide any additional information 
in the next screen, if applicable, or proceed to complete your checkout.

Add users to the watchlist of the purchase

You can add one or more users to the watchlist of the purchase request. The users on the 
Watchlist receive email notifications when specific conditions are fulfilled and the purchase 
request status is updated.

Before you begin
Role required: sn_shop.shopper

About this task
You can view and edit the Watchlist  either from the Reason for purchase  page or on the 
Purchase requisition under My Purchases  in the Shopping hub. For more information, see 
Activity stream. By default, you can add up to 20 users in the watchlist. You can modify this value 
by configuring the system properties. For more information, see Components installed with 
Sourcing and Procurement Operations.

Note:  This limit for the number of users on the watchlist is applicable only while making 
the purchase request. You can add more users to the watchlist after the purchase request is 
created. However, you can add more users only at the purchase requisitions page.
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Procedure

1. In the Reason for purchase page, if you're on the Apply to Entire purchase  view, perform the 
following steps:

a. On the Watchlist  field, select one or more users to the watchlist of the purchase request 
using the search option.

b. Select Save Watchlist.
This watchlist applies to the Entire purchase, and therefore the watchlist is also applicable 
to the entire purchase request.

Add users to the watchlist of the entire purchase

2. In the Reason for purchase page, if you're on the Apply to Product  view, perform the following 
steps:

a. On the Watchlist  field of each product or item, select one or more users to the watchlist of 
the purchase request using the search option.

b. Select Save Watchlist.
The users on the watchlist for each product or item will be combined into one purchase 
request and then cascaded to the header level. You can verify this by checking the My 
purchases page.
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Add users to the watchlist of the products

c. Similarly, you can add users to the watchlist of the purchase request of other products/items.

Configure additional questions for checkout

As an administrator, you can configure additional questions for full checkout to collect more 
information from a shopper specific to a purchase. This information is first stored in the 
Requisition Additional Info staging table against the purchase requisition ID that is created on 
checkout, and then mapped to the Purchase Requisitions table for back-end consumption.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
Use a record producer to create a custom set of questions to ask shoppers during full checkout. 
Build this record producer in Catalog Builder using the ShoppingHub additional questions for a 
PR  template.
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A record producer can contain the following question types:

• Text - Single-line

• Text - Multi-line

• Choice - Record references

• Option - Check box

• Choice - Dropdown (fixed values)

• Date

Procedure

1. Create and add the necessary columns in the Requisition Additional Info staging table.

2. Create and add the same columns in the Purchase Requisitions table.

3. In Catalog Builder, configure a record producer titled Shopping Hub Additional Questions 
using the ShoppingHub additional questions for a PR  template.
This record producer is used to store more information from a shopper specific to a purchase.

Note:  For information on how to create a record producer, see Create a catalog item 
using a template .

4. Navigate to ShoppingHub  > Administration  > ShoppingHub Configuration.

5. Select the Additional Information for a Purchase Request  configuration name associated with 
the Checkout configuration  type.

6. Select the Content details  tab.

7. On the Record producer  field, search for and select the Shopping Hub Additional Questions 
record producer.
You must first create this record producer using the ShoppingHub additional questions for a 
PR  template.

8. Select Update.
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9. In Workflow Studio, map the fields from the Requisition Additional Info staging table to the 
Purchase Requisitions table.

Note:  This flow is automatically triggered when a purchase requisition ID is created as a 
result of a checkout.

Configure purchase requisition line-level questions in ShoppingHub

As a procurement administrator, you can create configurable, line-level questions for shoppers 
to provide the information needed to complete the purchase during the checkout process in 
Shopping Hub. These questions are defined in Catalog Builder and specific to certain products 
or product categories.

Before you begin
Role required: sn_shop.procurement_administrator

About this task
Plugin required: Shopping Hub (sn_spend_uib)

Use a record producer to create a custom set of questions to ask shoppers during the quick and 
full checkout for specific products or product categories. Build this record producer in Catalog 
Builder using the ShoppingHub: Additional information on supplier products or product 
models or product categories  template. For information on how to create a record producer, see 
Create a catalog item using a template .

Shopping Hub checks for the existence of the record producer used for the additional 
information configuration in the specified order:

• Supplier product

• Product model

• Product category

• Parent category
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Procedure

1. Navigate to Supplier Products, Product Models, or Model Categories.

2. Select and open a record for a supplier product, product model, or a model category.

3. In the Related Links section, select Add additional information.

The Create record producer page opens in Catalog Builder.

4. In Catalog Builder, configure a record producer using the ShoppingHub: Additional 
information on supplier products or product models or product categories  template.
This record producer is used to store additional information from a shopper specific to a 
purchase.

Note:  For information on how to create a record producer, see Create a catalog item 
using a template .

5. Navigate to ShoppingHub  > Administration  > ShoppingHub Configuration.

6. In the Name  field, enter a name for the configuration.

7. In the Configuration type  field, select the Additional Information.

8. In the Content details  tab, do one or more of the following as needed.

◦ In the Supplier product  field, search for and add a supplier product that you want to display 
additional information at checkout.

◦ In the Product model  field, search for and add a product model that you want to display 
additional information at checkout.

◦ In the Product category  field, search for and add a product category that you want to display 
additional information at checkout.
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Note:  Shopping Hub checks for the existence of the record producer used for the 
additional information configuration in the specified order:

◦ Supplier product

◦ Product model

◦ Product category

◦ Parent category

9. In the Record producer  field, search for and select the record producer you created.
You must first create this record producer using the ShoppingHub: Additional information on 
supplier products or product models or product categories  template.

10. Select Submit.
The questions added in the record producer for a specific product, product model, or product 
category appear during checkout in Shopping Hub.

Checkout data loss scenarios

The data you enter during checkout are lost in an incomplete checkout process.

This happens if you perform any of the following actions:

• Log out.

• Return to your shopping cart page.

• Navigate to any other page on ShoppingHub.

• Close the browser window.

However, if you refresh the page, values on the current and previous steps are retained.

Purchase line creation scenarios

On completing your checkout, an appropriate number of cart lines are created, which then result 
in the creation of purchase lines.

For a supplier product:

• Every new delivery location creates a separate purchase line.

• Different delivery dates create separate purchase lines.

• Different payment methods result in an appropriate number of cost allocations being created 
against the purchase line.

• Different purchase lines are created for each product listed in a bundled product.

Purchasing from punchout or third-party suppliers

Shoppers who are part of the punchout group can navigate to punchout or external third-party 
supplier sites from ShoppingHub or Employee Center  and make purchases. They can view the 
third-party purchases in the My purchases page on ShoppingHub, and also view the shipment 
records received from the third-party sites.

External suppliers on ShoppingHub

Shoppers who are part of the punchout group can view punchout or external third-party 
supplier sites from the following tabs or widgets in ShoppingHub Home after navigating to All  > 
ShoppingHub  > ShoppingHub Home.
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• Suppliers  > Supplier sites: Shoppers can select the Supplier site  check box to filter their 
search for external or punchout suppliers.

• Purchase directly from the supplier site  widget: Shoppers can view up to four external 
supplier cards here. If there are more than four external suppliers, they can view all by going to 
the complete list.

For more information about the checkout experiences for shoppers based on whether they have 
installed Employee Center, Shopping Hub, or both, see Shopper checkout experiences based on 
installed applications.

For more information on punchout groups and how to configure them as an admin, see Configure 
punchout for third-party site purchases.

External suppliers on Employee Center

Shoppers who are part of the punchout group can also view punchout or external third-party 
supplier sites from the following tabs in Employee Center  after navigating to All  > Employee 
Center.

• Purchase and Expense  > Quick links  > Purchase directly from supplier sites.

• Purchase and Expense  > Browse all  > Quick links  > Purchase directly from supplier sites.

Shoppers are redirected to the Supplier sites page, with all the punchout suppliers listed there. 
They can sort and search the list for specific suppliers. Selecting a supplier tile takes them to the 
external site for making the purchase. For more information about the checkout experiences for 
shoppers based on whether they have installed Employee Center, Shopping Hub, or both, see 
Shopper checkout experiences based on installed applications.

For more information on Employee Center, see Sourcing and Procurement Operations 
integration with Employee Center.

Post checkout from external supplier sites

After successfully completing a checkout at an external third-party supplier site, a shopper can 
view the third-party purchase requisition in the My purchases page from ShoppingHub Home. 
The purchase requisition record contains details of the third-party supplier, purchase lines with 
product names, and the associated approvals, contracts, and cases.

Once the necessary approvals are received and the associated cases are completed, a 
purchase order is created by the procurement specialist. The same purchase order can also be 
viewed by the procurement admin in the external site in their order logs. The order confirmation 
and shipment confirmation details are received from the external supplier site as and when the 
order is processed. Shipment details are captured in the Shipment Details table by purchase 
lines.

In case of an update to the order quantity or price at the external supplier end, the same is 
sent as a revision during order confirmation to SPO, which is then updated in SPO  as a revision 
purchase requisition. For more information on purchase revision scenarios, see Purchase 
revision flows.

For information on emails triggered by the system, see Alerts and email notifications from 
ShoppingHub.

Troubleshooting errors

In case of any failures in creating purchase requisitions, check the import logs or transform 
history records. Check the flow actions 'Send Punchout Setup request' and 'Send punchout 
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order request' context executions for connection setup failures and order confirmation failures. 
Check the 'Punchout Edit/Cancel flow' context executions for punchout revision flow failures.

An error code of 500 would indicate an invalid credential record or a missing punchout 
configuration in the third-party registration for supplier.

Shopper checkout experiences based on installed applications

The following figure illustrates the checkout experiences for shoppers based on whether they 
have installed Employee Center, Shopping Hub, or both.

Shopper checkout experiences

Unified request tracking in Shopping Hub

You can search for purchased products and services by entering the original purchase record 
ID or its associated record IDs in Shopping Hub. This includes tracking details from the ordering 
stage to the fulfillment stage of the procurement process.

Additionally, you can use keywords or the first three letters of a record to find products. For 
instance, searching for "Laptop" will display a list of laptops purchased. Similarly, typing "SRC" 
shows all sourcing requests, typing "PRL" displays purchase requisition lines, and so on.

Note:  The search results include all records, regardless of their current status. Even 
closed records are shown in the search results.

For example, suppose you created a sourcing request (SRC0000007) to purchase a product. As 
the product progressed through the procurement process, the sourcing request converted into a 
purchase requisition (PR0000002), which then became a purchase order (PO0001026).
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Shopping Hub  showing the progression of your purchases

Navigate to ShoppingHub  > ShoppingHub Home  > My purchases. In the search field, search for 
any of the records, SRC0000007, PR0000002, or PO0001026, to access complete details about 
your purchase.

Note:  The purchase card displays the timeline of all previously closed procurement 
records, providing the shopper with the necessary context to understand the purchase 
history.

Hide supplier pricing from ShoppingHub

When creating model categories for grouping your product models, you can decide if pricing is to 
be displayed in ShoppingHub for supplier products associated to a particular category.

The pricing that is displayed for supplier products on ShoppingHub is an agreed-upon 
contractual price between you and the supplier. As an administrator, based on your business 
requirement, you can decide if this pricing needs to be displayed or hidden in your ShoppingHub 
catalog for supplier products associated to a particular category. If you decide to hide the pricing, 
the shipping and taxes involved are also hidden. If there are parent and child categories, the 
display pricing choice made on the child category overrides its parent.

If pricing is hidden in the model category form for a product category, pricing details aren’t 
displayed in the following instances:

• Product information card on the ShoppingHub catalog

• Product details or categories or suggestions based on your role landing page

• Supplier product card, on both ShoppingHub and Virtual Agent

• Product header card in your shopping cart

• Summary section during full checkout and also on Virtual Agent

• Quick checkout overlay

• Purchase confirmation page after quick and full checkouts

• Total line amount  and Budget  fields in the My purchases list view, on both desktop and mobile

• Total line amount  in the header, and price fields Subtotal, Tax, Shipping, and Total line 
amount  in the purchase section in the Purchase details page, on both desktop and mobile

• Activity stream in My purchases

• Pre-payment amount  field in the Pre-payments  tab on the purchase details page

• Negotiated unit cost  field in the Additional quotes  tab on the purchase details page

• Total line amount  field in the Submitted purchases  tab on the purchase details page

• Approval to-do in the To-dos  tab on the purchase details page

• Total line amount  and Remaining amount  fields in the blanket purchase list view, on mobile
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• Total line amount  and Remaining amount  in the blanket purchase form view header, on 
mobile

• Total line amount  field in the Submitted purchases related list of a blanket purchase order, on 
mobile

• Negotiated unit cost  and Total line amount  fields in the Additional quotes related list of a 
blanket purchase order, on mobile

• Confirmation page after completing a select a supplier to-do

• Line amount invoiced in invoice acknowledgment

Note:  This applies only if you haven't installed the Shopping Hub plugin and are still 
using the Source-to-Pay Common Architecture  plugin.

• Invoice amount to review in invoice acknowledgment, on mobile

• Price fields Total amount, Amount paid, and Remaining balance  in the purchase section in 
invoice acknowledgment, on mobile

• Price fields Total estimated tax, Total estimated shipping, and Total amount  in the purchase 
section in receipt acknowledgment, on mobile

• Price fields Subtotal, Estimated tax, Estimated shipping, and Total line amount  in the 
purchase section in milestones, on mobile

• Payout amount  field in the to-do section in milestones, on mobile

• Activity stream and purchase summary in My to-dos

• Standard search results on Employee Center  (EC) and Virtual Agent

• AI Search results on ShoppingHub, Service Portal, and EC

Note:  Even if supplier pricing is hidden, sort by price and filter by price range display 
search results in ShoppingHub. For sort by price low to high, for example, request pricing 
products are displayed first, followed by pricing hidden products, and products with 
price. For filter by price range, if the minimum price range is greater than zero, pricing 
hidden products are hidden along with request pricing products.

However, when an approval to-do is created, the pricing is visible to the approver so that an 
informed decision can be taken on the approval request. If display pricing is set to No, then the 
select a supplier to-do is assigned to the buyer instead of the person who submitted it. But, if the 
buyer reassigns it to the submitter, the latter can view the price in the to-do in ShoppingHub. This 
is applicable to both desktop and mobile versions.

Also, if you’re a shopper with store credits allocated to you, you can view the pricing details even 
though the pricing is otherwise hidden.

Note:  This hide pricing feature doesn’t impact the checkout flows, sourcing flows, or any 
other flows that are run in the back-end.

Requesting for products or services that you don't see on ShoppingHub

As an employee, shopper, or business owner, you can place requests for one or more products 
or services that are currently not listed on the ShoppingHub portal. You can do this from 
ShoppingHub Home or directly from Employee Center.

Request for products that you don't see on Shopping Hub

Place a request for one or more products that are currently not listed on the Shopping Hub  portal. 
You can do this from Shopping Hub  Home or directly from Employee Center.
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Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select Don't see what you need?.

The Purchase requests page is displayed from the Employee Center  catalogs.

Note:  To directly access from Employee Center, navigate to Purchases and expenses  > 
Purchase requests.

3. Select I need a product.

4. On the form, fill in the details of the products that you’re looking for.
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Field Description

Who is this 
request for?

Name of the employee, shopper, or business owner who needs this 
product.
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Field Description

Note:  If you’re logged in as a fulfiller, you can raise this request for a 
shopper as well. Also, shoppers can select their delegates here.

What project 
is this request 
for?

Project for which this request is being raised.

Note:  This field is available only when you have the Procurement 
with Project Management (sn_spend_ppm) application installed, and 
also have the IT Project User role. For more information, see Sourcing 
and Procurement Operations integration with Project Management.

What do you 
need for this 
request?

Type of request. The options are:

◦ I need a quote

◦ I need a proposal

◦ I need a proof of concept

◦ I need more information about the products or suppliers

What suppliers 
do you want to 
request from?

Details of the suppliers you want to request from. The options are:

◦ Existing suppliers in the system: Add one or many suppliers from the 
list of existing suppliers. If you’ve already contacted them, select the 
appropriate option, and enter details of the supplier contact such as first 
and last names, job title, and registered email ID.

Note:  Before you save the supplier contact details, ensure that 
your admin has set up the email domains for the supplier contacts, 
and the corresponding records are available in the Supplier Email 
Domain table.

◦ External suppliers: Add one or many suppliers, and enter details of the 
supplier contact such as first and last names, job title, and registered 
email ID.

Note:  It is recommended that you search from the existing 
suppliers first, and if the supplier you’re looking for doesn’t exist, 
enter one you want to work with.

◦ I don't have any suppliers in mind.

For more information on adding suppliers, see:

◦ From Platform: Add a supplier.

◦ From the supplier catalog: Add a supplier contact using the supplier 
catalog.

◦ From Source-to-Pay Workspace: Add a supplier contact from the Source-
to-Pay Workspace.

Default delivery 
address

Address for delivery. The options are:
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Field Description

◦ A saved address: In this case, the primary saved address of the logged-in 
user is displayed.

◦ A work address: In this case, you must select who is receiving the item, or 
the business owner.

◦ Somewhere else

Default delivery 
date

Estimated date range for delivery. The options are:

◦ As soon as possible: For the quickest delivery slot possible for the 
product. This is calculated based on the product category of each 
selected product.

◦ A specific date: If you have a specific date in mind for the delivery of the 
product.

◦ I am not sure: A time frame for the delivery of the product.

Note:  You can select a date or date range that is in the past, present, 
or future. If you select a date range, you must enter your requested 
start and end dates to proceed.

Add the 
products you’d 
like to request

Add one or more products that you’re looking for, along with details such as 
product category, name of the product, specific requirements, if any, link to 
an example of what you’re looking for, quantity or budget amount, currency, 
delivery address, delivery date, and so on.

Note:  Here, you have the option to select different delivery 
addresses and dates for the individual products, as required, or go 
with the same options from the parent purchase.

Why do you 
need these 
products?

Reason behind this product requirement.

Are there 
additional 
details or 
questions you'd 
like to include?

Additional details, if any.

Note:  You must answer this question if you have selected I need 
more information about the products or suppliers  in the What do you 
need for this request?  field.

5. Optional:  Select Save as Draft  if you want to save a draft in your requests and plan to 
complete it later.

6. Select Submit.
Individual sourcing requests are created for each product that you’ve requested for, with 
individual lines for the selected suppliers.

What to do next
View your sourcing request details from the Requested items  tab, where a complete summary 
of your request lines is displayed. You can also view the details from the My Purchases page in 
Shopping Hub.

In case of errors, check your system logs to detect any issues with the record producer 
submission. However, if you were able to submit successfully, check your event logs to verify 
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whether the asynchronous event sn_shop.process_non_catalog_sourcing was triggered to 
initiate creation of the sourcing requests.

Request for services that you don't see on Shopping Hub

Place a request for one or more services that are currently not listed on the Shopping Hub  portal. 
You can do this from Shopping Hub  Home or directly from Employee Center.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select Don't see what you need?.

The Purchase requests page is displayed from the Employee Center  catalogs.

Note:  To directly access from Employee Center, navigate to Purchases and expenses  > 
Purchase requests.
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3. Select I need a service.

4. On the form, fill in the details of the services that you’re looking for.
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Field Description

Who is this 
request for?

Name of the employee, shopper, or business owner who needs this service.

Note:  If you’re logged in as a fulfiller, you can raise this request for a 
shopper as well. Also, shoppers can select their delegates here.

What project 
is this request 
for?

Project for which this request is being raised.

Note:  This field is available only when you have the Procurement 
with Project Management (sn_spend_ppm) application installed, and 
also have the IT Project User role. For more information, see Sourcing 
and Procurement Operations integration with Project Management.

What do you 
need for this 
request?

Type of request. The options are:

◦ I need a quote

◦ I need a proposal

◦ I need a proof of concept

◦ I need more information about the services or suppliers

What suppliers 
do you want to 
request from?

Details of the suppliers you want to request from. The options are:

◦ Existing suppliers in the system: Add one or many suppliers from the 
list of existing suppliers. If you’ve contacted them already, select the 
appropriate option, and enter details of the supplier contact such as first 
and last names, job title, and registered email ID.

Note:  Before you save the supplier contact details, ensure that 
your admin has set up the email domains for the supplier contacts, 
and the corresponding records are available in the Supplier Email 
Domain table.

◦ External suppliers: Add one or many suppliers, and enter details of the 
supplier contact such as first and last names, job title, and registered 
email ID.

Note:  It is recommended that you search from the existing 
suppliers first, and if the supplier you’re looking for doesn’t exist, 
enter one you want to work with.

◦ I don't have any suppliers in mind

For more information on adding suppliers, see:

◦ From Platform: Add a supplier.

◦ From the supplier catalog: Add a supplier contact using the supplier 
catalog.

◦ From Source-to-Pay Workspace: Add a supplier contact from the Source-
to-Pay Workspace.

Default address 
of service

Address where the service is required. The options are:
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Field Description

◦ A saved address: In this case, the primary saved address of the logged-in 
user is displayed.

◦ A work address: In this case, you must select who is receiving the item, or 
the business owner.

◦ Somewhere else

Default service 
dates

Estimated date range for the service. The options are:

◦ Within a specific time frame: If you have a specific date range in mind for 
the delivery of the service.

◦ I am not sure: A time frame for the delivery of the service.

Note:  You can select a date range that is in the past, present, or 
future. If you select a date range, you must enter your requested start 
and end dates to proceed.

Add the service 
you'd like to 
request

Add one or more services that you’re looking for, along with details such 
as service category, name of the service, specific requirements, if any, link 
to an example of what you’re looking for, currency type, maximum budget 
amount, address of service, service date, and so on.

Note:  Here, you have the option to select different service addresses 
and dates for the individual services, as required, or go with the same 
options from the parent purchase.

Why do you 
need these 
services?

Reason behind this service requirement.

Are there 
additional 
details or 
questions you'd 
like to include?

Additional details, if any.

Note:  You must answer this question if you have selected I need 
more information about the services or suppliers  in the What do you 
need for this request?  field.

5. Optional:  Select Save as Draft  if you want to save a draft in your requests and plan to 
complete it later.

6. Select Submit.
Individual sourcing requests are created for each service that you've requested for, with 
individual lines for the selected suppliers.

What to do next
View your sourcing request details from the Requested items  tab, where a complete summary 
of your request lines is displayed. You can also view the details from the My Purchases page in 
Shopping Hub.

In case of errors, check your system logs to detect any issues with the record producer 
submission. However, if you were able to submit successfully, check your event logs to verify 
whether the asynchronous event sn_shop.process_non_catalog_sourcing was triggered to 
initiate creation of the sourcing requests.
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Configure additional attributes for I need a product or service

You can configure additional attributes on the intake for variable sets configured on the I need 
a product  and I need a service  record producers. Any new fields that are added to the variable 
set must be mapped in the record producer script to ensure that the information is saved in the 
backend.

Before you begin
Role required: admin

Procedure

1. Navigate to the I need a product  or I need a service  record producer, as required.

2. Go to the script section of the record producer and ensure that the intake details fields are 
mapped to the payload appropriately.

Note:  If any of the fields aren’t mapped, then mapping logic must be added.

3. Go to the script include: NonCataloglntakeService, function: createSourcingRequest.
This function creates and appends the information passed from the record producer to the 
sourcing request record. Ensure that the sourcing request has the appropriate field in its table.

4. To save the information on the purchase request line, go to the script include: 
NonCataloglntakeService.
This creates an import set record in the non-catalog import set table, 
sn_shop_non_catalog_intake.

5. Go to the Table Transform Map: Non catalog intake, and check if the field mapping between the 
source and target is correct.

Submit a quote

As a shopper or requester, when an existing quotation for a product or service that you're looking 
for doesn’t meet your expectation, you can get your own quote and submit it so that a requisition 
can be processed by the procurement team accordingly. You can submit a quote from Shopping 
Hub  Home or directly from Employee Center.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select Don't see what you need?.
The Purchase requests page is displayed from the Employee Center  catalogs.

Note:  To directly access from Employee Center, navigate to Purchases and expenses  > 
Purchase requests.

3. Select I need to submit a quote.

4. On the form, fill in the details.

Field Description

First, search and add the 
supplier from the existing 
supplier list

List of all the available suppliers.
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Field Description

Can't find the supplier 
above? Add them here

Allows you to add a new supplier, who is then verified in the back-
end before being added to the list of available suppliers.

Have you contacted 
this supplier about 
the products you're 
requesting?

If you’ve contacted the supplier already, select the appropriate 
option, and enter details of the supplier contact such as first and 
last names, job title, and registered email ID.

For more information on adding suppliers, see:

◦ From Platform: Add a supplier.

◦ From the supplier catalog: Add a supplier contact using the 
supplier catalog.

◦ From Source-to-Pay Workspace: Add a supplier contact from 
the Source-to-Pay Workspace.

5. From What are you buying?  select Add  to add one or more goods, services, or both, by filling 
in the Add Row form.

Field Description

Supplier part number (ex: SKU, product ID) Unique product or service identifier, such as 
SKU.

Product/Service name Details of the product or service.

Unit (ex: box, each, ounces)/Unit (ex: fixed 
fee, per hour)

Unit of measure of the product or service that 
you must buy.

Select the currency type for the quoted price Currency type.

Unit price Amount per unit of the product or service.

Quantity Number of units of the product or service.

Tax Estimated tax amount.

Shipping Estimated shipping cost.

Total amount Total amount to be paid, including tax and 
shipping.

When will this product be delivered?/When is 
the delivery?

Date when the product or service is needed 
by. Choose a delivery date or delivery period:

◦ Specify a delivery date  if you have a 
specific date in mind for the delivery of the 
product.

◦ I am not sure  to select a time frame for the 
delivery of the product or service.

Note:  You can select a date or date 
range that is in the past, present, or 
future. If you select a date range, you 
must enter some estimated start and 
end dates to proceed.

Where do you think you will have this 
delivered?

Delivery location of the product or service. 
You can use one of your saved addresses, in 
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Field Description

which case the primary saved address of the 
logged-in user is displayed. You can choose 
to deliver to a work address, in which case 
you must select who is receiving the item. 
You can also choose to deliver to somewhere 
else.

Cost center for payment Payment method, which is defaulted to your 
cost center.

Additional comments Any additional information that you may want 
to add.

6. Select Add.

7. In the What project is this request for?  field, select the project for which this request is being 
raised.

Note:  This field is available only when you have the Procurement with Project 
Management (sn_spend_ppm) application installed, and also have the IT Project User 
role. For more information, see Sourcing and Procurement Operations integration with 
Project Management.

8. Provide the reason behind making the purchase.

9. In the Watchlist  field, select one or more users to be added to the watchlist of the purchase 
request.

The users on the Watchlist receive email notifications when specific conditions are fulfilled and 
the purchase request status is updated. By default, you can add up to 20 users in the watchlist. 
You can modify this value by configuring the system properties. For more information, see Add 
users to the watchlist of the purchase.

10. Add attachments of your quote for verification.

11. Optional:  Select Save as Draft  if you want to save a draft in your requests and plan to 
complete it later.

12. Select Submit.

What to do next
You can view the newly created purchase requisition details on the My Purchases page in 
ShoppingHub. Purchase lines are grouped based on whether the order type is standard or 
blanket. For more information on purchase line grouping, see Purchase requisition merging.

Purchase revision flows

As a procurement administrator, you can leverage or modify the existing workflows to process the 
purchase modification requests raised by shoppers.

When you install the Playbooks for Sourcing and Procurement Operations  application, you 
can automate the overall purchase revision flows. The following workflow shows how the 
admin facilitates the purchase modification process to create requests, resolve request, and 
communicate with stakeholders:
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Related topics

Purchase revision roles and responsibilities

Purchase revision roles and responsibilities

As a procurement administrator, you can create workflows that blend automation, integration, 
and human review to process the purchase modification requests raised by shoppers.

Purchase revision workflow involves the steps to route the request through various stakeholders. 
The following workflow shows how the admin facilitates the purchase modification process to 
create requests, resolve request, and communicate with stakeholders:

Administrator

As an admin or process owner, you can facilitate shoppers with a process to raise edit or 
cancel requests from Service Catalog and ShoppingHub. Define a unified task-view playbook 
experience for agents to process the approval workflows:

Shopper
As a shopper, you can raise the edit or cancel requests for the following objects from 
ShoppingHub or Service Catalog:

• Purchase requisition: A purchase request that tracks all tasks and approvals, and associates 
the purchase to a contract and supplier. Purchase requisitions contain one or more purchase 
line items. A purchase order is created from a purchase requisition task.​

• Purchase line: An individual line item that includes all the details of the goods or services for 
procurement. Purchase requisitions contain multiple purchase line items.

• Purchase order: A purchase order includes one or more purchase order lines. Once the 
business unit approves the purchase requisition, a purchase order is issued to the supplier 
with the requested goods or services.

• Purchase order line: An individual line item that includes all the details of the goods or 
services for procurement. Purchase orders contain multiple purchase order line items.

Agent
As an agent or fulfiller or buyer, you can process these requests from the Source-to-Pay 
Workspace  playbook:
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• Approve or reject an Edit  order with the revised quantity or delivery location of the purchase 
requisitions.

• Reject or approve a Cancel  request of the entire order or line items.

Edit flows

You can use these steps to raise an edit request for purchase line item. The following image 
explains the process of request creation by shopper and request resolution by buyer or agent.

Edit request overview

Cancel flows

You can use these steps to raise a cancel request for purchase line items or an entire purchase. 
Here's an overview of the process from request creation and request resolution.

Cancel request overview

Add a line to an existing purchase requisition or order

You can add a new purchase line to an existing purchase requisition or order.

Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to All  > ShoppingHub Home  > My purchases.

2. Select a purchase requisition or order and select Edit  from the More options  icon.
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The Edit a purchase page is displayed with the available purchase lines.

3. Select Add  to add a new line.

4. On the form, fill in the fields.
When adding a new line, you can select a supplier product from the existing system catalog or 
request for a new supplier product from the Would you like to:  field. The fields displayed are 
based on the selection of one of the following options:
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◦ Browse catalog

Field Description

Would you like to: Select Browse catalog  to select from a pre-
existent supplier and catalog.

Supplier Displays the supplier name.

Supplier Product Select a relevant product to purchase from 
the list.

Quantity Enter the numerical quantity of the product 
to purchase.

Expected delivery date
Important:  This field is applicable 
only for product.

Select the date by when you want the 
product to be delivered.

Requested start date
Important:  This field is applicable 
only for services.

Select the date by when you want the 
service to start.
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Field Description

Requested end date
Important:  This field is applicable 
only for services.

Select the date by when you want the 
service to end.

Where do you think you will have this 
delivered?

Select one of the following delivery options:

▪ To a saved location

▪ To a work address (already approved)

▪ To somewhere else

The delivery location available for selection 
is filtered based on the countries supplier 
can deliver to.

Address Based on the delivery option selected, the 
address is displayed here.

Add a payment method Select your preferred payment method.

Purchase reason Enter your comments on the purchase.

◦ Submit a quote
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Field Description

Would you like to: Select Submit a quote  to add a new supplier 
and product that you want to purchase.

Supplier Displays the supplier name.

Is this a quote for a goods or service? Select if the quote is for a goods or a 
service.
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Field Description

Supplier Part Number Enter the number to identify the supplier or 
product. For example, SKU, Product ID, and 
so on.

Product Name Enter the name of the product that you 
would like to order.

Unit Select from Fixed Fee  orIndividual unit 
to quantify the product. For example, box, 
each, ounces, and so on.

Select the currency type for the quoted 
price

Select the currency type in which you want 
to trade.

Unit Price Enter the price per unit.

Quantity Enter the numerical quantity of the product 
to purchase.

Tax Enter the tax value.

Shipping Enter the shipping mode.

Total Amount Displays the calculated total value of the 
purchased.

Expected delivery date
Important:  This field is applicable 
only for product.

Select the date by when you want the 
product to be delivered.

Requested start date
Important:  This field is applicable 
only for services.

Select the date by when you want the 
service to start.

Requested end date
Important:  This field is applicable 
only for services.

Select the date by when you want the 
service to end.

Where do you think you will have this 
delivered?

Select one of the following delivery options:

▪ To a saved location

▪ To a work address (already approved)

▪ To somewhere else

Address Based on the delivery option selected, the 
address is displayed here.

Add a payment method Select your preferred payment method.

Purchase reason Enter your comments on the purchase.

Additional comments Enter additional comments if any.
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5. Select Add  to complete the add request.
A new purchase line is added to the purchase requisition or order. Note that for Submit a quote 
option, the PRL/POL number isn’t displayed.

6. Select Submit request.
A confirmation message screen appears.

Edit a purchase line from a purchase requisition or order

You can edit and revise the quantity of a product or delivery location of a purchase line directly 
from a purchase requisition or order. You can also view the existing or current quantity or delivery 
date of the purchase requisition or order.

Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to ShoppingHub Home  > My purchases.
Alternatively, you can edit a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Edit a purchase. For more information, see Edit a purchase line from a 
purchase requisition or order from Employee Central (EC).

2. Select a purchase requisition or order and select Edit.

You can also select the More options  icon on the line and select Edit  to modify the details of 
the purchase requisition or order.
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Note:  Remember that the Edit  option isn’t available for purchases in the Closed state.

The Edit a purchase page is displayed with the available purchase lines.
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3. Select the Open Preview icon to edit the quantity or delivery location of the purchase line.
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The delivery location available for selection is filtered based on the countries supplier can 
deliver to.

4. You can update the following details.
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Note:  If it's a product, you will see Current delivery date and New delivery date fields, 
and if it's a service, you will see Current start date, New start date, Current end date, and 
New end date.

For goods, we will show the fields related to delivery dates, for service lines, we show the 
fields related to service dates.

Field Description

Current Quantity

Displays the existing or current numerical 
quantity of the product to purchase.

The current quantity can be viewed but not 
edited.

New Quantity

Update the new numerical quantity of the 
product to purchase.

You can view existing quantity by referring to 
the Current Quantity field.

Current delivery date

Important:  This field is applicable on­
ly for products.

Displays the existing or current delivery date 
of the product.

The current delivery date can be viewed but 
not edited.

New delivery date

Important:  This field is applicable on­
ly for products.

Update the delivery date of the product ac­
cording to your preference.

Current start date

Important:  This field is applicable on­
ly for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New start date
Important:  This field is applicable on­
ly for services.

Update the new start date of the service.

Current end date
Important:  This field is applicable on­
ly for services.

Displays the current start date of the service.
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Field Description

The current start date can be viewed but not 
edited.

New end date
Important:  This field is applicable on­
ly for services.

Update the new end date of the service.

Would you like to edit something else?

◦ Select Yes  if you want to edit something on 
the purchase order.

◦ Select No  if you don't have anything to up­
date on the purchase order.

Why are you editing this purchase?
Enter the reason for editing the purchase req­
uisition or order.

Add attachments
Browse and select the related attachments 
for updating the purchase requisition or or­
der.

5. Select Submit.
The purchase line is updated with the changes.

Edit a purchase requisition line

You can edit and revise the quantity of the product, budget, or delivery location of a purchase 
requisition line in a purchase requisition based on your requirements.

Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to ShoppingHub Home  > My purchases.
Alternatively, you can edit a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Edit a purchase. For more information, see Edit a purchase line from a 
purchase requisition or order from Employee Central (EC).

2. Select a purchase requisition and a purchase requisition line in it.

Note:  Remember that the Edit  option is not available for purchases in the Closed state.

3. Select Edit  on the purchase requisition line.
You can also select the More options  icon on the requisition line and select Edit  to modify the 
details of the line.
The Edit a purchase  page displays the Purchase summary  with the price and quantity 
information.

4. On the form, edit the fields:
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Note:  If it's a product, you will see Current delivery date and New delivery date fields, 
and if it's a service, you will see Current start date, New start date, Current end date, and 
New end date.

For goods, we will show the fields related to delivery dates, for service lines, we show the 
fields related to service dates.

Field Description

Current Quantity Displays the existing or current numerical 
quantity of the product to purchase.

The current quantity can be viewed but not 
edited.

New Quantity Update the new numerical quantity of the 
product to purchase.

You can view existing quantity by referring to 
the Current Quantity field.

Current delivery date
Important:  This field is applicable 
only for products.

Displays the existing or current delivery date 
of the product.

The current delivery date can be viewed but 
not edited.

New delivery date
Important:  This field is applicable 
only for products.

Update the delivery date of the product 
according to your preference.

Current start date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New start date
Important:  This field is applicable 
only for services.

Update the new start date of the service.

Current end date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.
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Field Description

The current start date can be viewed but not 
edited.

New end date
Important:  This field is applicable 
only for services.

Update the new end date of the service.

Where do you want this delivered? The options are:

◦ To one of my saved locations

◦ To an office location

◦ To a new address
For example, you can select an office 
location.

The delivery location available for selection is 
filtered based on the countries supplier can 
deliver to.

Would you like to edit something else? ◦ Select Yes  if you want to edit something on 
the purchase order.

◦ Select No  if you don't have anything to 
update on the purchase order.

Address Select an address from the dropdown list.

Purchase Reason Enter the reason for the purchase.

5. In the Why are you editing this purchase? field, provide the reason for editing the request.

6. Add an attachment to support your edit request, if applicable.
This file is attached to the procurement case record initially, and then to the purchase 
requisition associated to that procurement case when the case is closed.

7. Select Submit Request  to complete the edit request.

Result
The step creates a procurement case with the details of the revised quantity, location, and other 
information. Associated request lines and tasks are created using this information.

What to do next

• Shoppers can review and edit the request details from ShoppingHub  > My requests  or My 
requests  from the footer.

• Buyers can track the progress of the procurement case and procurement case line edit 
requests from Source-to-Pay Workspace.

Related topics

Purchase revision flows

Process Automation Designer flows for playbook
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Edit a purchase order line

You can edit and revise the quantity of the product, budget, or delivery location of a purchase 
order line in a purchase order based on your requirements.

Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to ShoppingHub Home  > My purchases.
Alternatively, you can edit a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Edit a purchase. For more information, see Edit a purchase line from a 
purchase requisition or order from Employee Central (EC).

2. Select a purchase order and a purchase order line in it.

Note:  Remember that the Edit  option isn’t available for purchases in the Close state.

3. Select Edit  on the purchase order line.
You can also select the More options  icon on the order line and select Edit  to modify the 
details of the line.
The Edit a purchase  page displays the Purchase summary  with the price and quantity 
information.

4. On the form, fill in the fields:

Note:  If it's a product, you see Current delivery date and New delivery date fields. If it's a 
service, you see Current start date, New start date, Current end date, and New end date.

For goods, you see the fields related to delivery dates, for service lines, you see the fields 
related to service dates.

Field Description

Current Quantity Displays the existing or current numerical 
quantity of the product to purchase.

The current quantity can be viewed but not 
edited.

New Quantity Update the new numerical quantity of the 
product to purchase.

You can view existing quantity by referring to 
the Current Quantity field.

Current delivery date
Important:  This field is applicable 
only for products.

Displays the existing or current delivery date 
of the product.

The current delivery date can be viewed but 
not edited.
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Field Description

New delivery date
Important:  This field is applicable 
only for products.

Update the delivery date of the product 
according to your preference.

Current start date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New start date
Important:  This field is applicable 
only for services.

Update the new start date of the service.

Current end date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New end date
Important:  This field is applicable 
only for services.

Update the new end date of the service.

Where do you want this delivered? The options are:

◦ To one of my saved locations

◦ To an office location

◦ To a new address
For example, you can select an office 
location.

The delivery location available for selection is 
filtered based on the countries supplier can 
deliver to.

Would you like to edit something else? ◦ Select Yes  if you want to edit something on 
the purchase order.

◦ Select No  if you don't have anything to 
update on the purchase order.

Address Select an address from the drop-down list.

Purchase Reason Enter the reason for the purchase.
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5. In the Why are you editing this purchase? field, provide the reason for editing the request.

6. Add an attachment to support your edit request, if applicable.
This file is attached to the procurement case record initially. When the case is closed, the file is 
attached to the purchase order associated with that procurement case.

7. Select Submit Request.

Result
The step creates a procurement case with the details of the revised quantity, location, and other 
information. Associated request lines and tasks are created using this information.

What to do next

• Shoppers can review and edit the request details from ShoppingHub  > My requests  or My 
requests  from the footer.

• Buyers can track the progress of the procurement case and procurement case line edit 
requests from Source-to-Pay Workspace.

Related topics

Purchase revision flows

Process Automation Designer flows for playbook

Edit a purchase line from a purchase requisition or order from Employee Central (EC)

You can edit and revise the quantity of a product or delivery location of a purchase line from 
Employee Center. You can also view the existing or current quantity or delivery date of the 
purchase requisition or order.

Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to Employee Center  > Purchase and Expense  > Purchase Requests  > Edit a 
purchase.
Alternatively, from ShoppingHub Home, select Don't see what you need?  > Edit a purchase.

2. Look up the required purchase requisition or order using the search option.
You can find the required purchase requisition or order using the purchase requisition number, 
short description, purchase order (PO) number, or ERP number.

3. Select a purchase requisition or order and select one of the following options:

◦ Edit one item

◦ Edit entire purchase

4. If you selected Edit one item  of the purchase request, perform the following steps:

a. Look up the required item using the search option.
You can find the required purchase requisition or order using the purchase requisition 
number, short description, purchase order (PO) number, or ERP number.

b. You can edit the following details depending on whether it's a product or service.
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Edit details of one item of the purchase request or order

Field Description

Current Quantity Displays the existing or current numerical 
quantity of the product or service to 
purchase.

The current quantity can be viewed but not 
edited.

New Quantity Update the new numerical quantity of the 
product or service to purchase.

Current delivery date
Important:  This field is applicable 
only for products.

Displays the existing or current delivery date 
of the product.

The current delivery date can be viewed but 
not edited.

New delivery date
Important:  This field is applicable 
only for products.
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Field Description

Update the delivery date of the product 
according to your preference.

Current start date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New start date
Important:  This field is applicable 
only for services.

Update the new start date of the service.

Current end date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New end date
Important:  This field is applicable 
only for services.

Update the new end date of the service.

Would you like to edit something else? ▪ Select Yes  if you want to edit something 
on the purchase order.

▪ Select No  if you don't have anything to 
update on the purchase order.

Why are you editing this purchase? Enter the reason for editing the purchase 
requisition or order.

5. If you selected Edit entire purchase  request, perform the following steps:

a. Look up the required purchase request using the search option.
You can find the required purchase requisition or order using the purchase requisition 
number, short description, purchase order (PO) number, or ERP number.

b. Select the Edit  icon next to the required purchase request line.

c. You can update the following details.
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Edit entire purchase request

Field Description

Current Quantity Displays the existing or current numerical 
quantity of the product or service to 
purchase.

The current quantity can be viewed but not 
edited.

New Quantity Update the new numerical quantity of the 
product or service to purchase.

You can view existing quantity by referring to 
the Current Quantity field.

Current delivery date
Important:  This field is applicable 
only for products.

Displays the existing or current delivery date 
of the product.

The current delivery date can be viewed but 
not edited.

New delivery date
Important:  This field is applicable 
only for products.
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Field Description

Update the delivery date of the product 
according to your preference.

Current start date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New start date
Important:  This field is applicable 
only for services.

Update the new start date of the service.

Current end date
Important:  This field is applicable 
only for services.

Displays the current start date of the service.

The current start date can be viewed but not 
edited.

New end date
Important:  This field is applicable 
only for services.

Update the new end date of the service.

Would you like to edit something else? ▪ Select Yes  if you want to edit something 
on the purchase order.

▪ Select No  if you don't have anything to 
update on the purchase order.

Why are you editing this purchase? Enter the reason for editing the purchase 
requisition or order.

6. Select Save.

7. Add an attachment to support your edit request, if applicable.

8. Select Submit.
The purchase line is updated with the changes.

9. To save the modified details of the purchase requisition or order as a draft, select Save as 
Draft  option.

Editing purchase requisitions and orders with cost allocation adjustments

As a shopper, you can modify purchase requisitions (PRs) and purchase orders (POs) while 
maintaining cost allocation across multiple cost centers.
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Example use case for editing a purchase with multiple cost centers

In this example, a shopper creates a PR with cost allocation distributed between two cost 
centers, Customer Success and Engineering. The costs are assigned based on predefined 
percentages.

Suppose 20% is allocated to Customer Success and 80% to Engineering.

If you purchase 6 quantities of the energy monitoring device priced at $230 each. The total cost 
amounts to $1380.

The cost for this purchase is allocated as follows:
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• Customer Success Cost Center: $276 (20% of $1380)

• Engineering Cost Center: $1104 (80% of $1380)

Now suppose you edit the PR or PO to increase the quantity from 6 to 10 pencils. The total cost 
amounts to $2300.
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In this case, the total cost is proportionally distributed between both the cost centers based on 
the original allocation:

• Customer Success Cost Center: $460 (20% of $2300)

• Engineering Cost Center: $1840 (80% of $2300)

The cost allocation remains consistent when modifying purchase quantities in a PR or PO.

For more information, see Cost allocations.

Related topics

Edit a purchase line from a purchase requisition or order

Edit a purchase line from a purchase requisition or order from Employee Central (EC)

Raise a cancel request

As a shopper, you can cancel an entire purchase request, purchase order, or individual line 
items.
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Before you begin
Role required: sn_spend_psd.requestor or shopper

Procedure

1. Navigate to ShoppingHub  > My purchases.
Alternatively, you can cancel a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Cancel a purchase.

2. Select a purchase requisition, purchase order, or purchase line.

3. Select Cancel this purchase  from the Edit  menu or the More options  menu.

You can also select the More options  icon on the requisition line and select Cancel this 
purchase  to cancel a purchase.

You can also cancel a purchase requisition line using the Remove  button in the Edit a 
purchase  page. It will internally create a new procurement case for the buyer to confirm or 
reject.

4. Specify a reason for the cancellation.

5. Select Submit request.
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Result
The step creates a procurement case with the details of the product for cancellation. Associated 
request lines and tasks are created using this information.

What to do next

• Shoppers can review and edit the request details from ShoppingHub  > My requests  or My 
requests  from the footer.

• Buyers can review, edit, and process your request details from Procurement Case 
Management  > Source-to-Pay Workspace  > Procurement Cases, if required.

Related topics

Purchase revision flows

Process Automation Designer flows for playbook

Return a product

You can request a return for a product that has been fully or partially delivered to you.

Before you begin
Role required: sn_spend_psd.requestor or shopper

About this task
You can raise a return request for multiple products belonging to the same purchase order or 
purchase requisition that has been fully or partially delivered to you.

Procedure

1. Navigate to ShoppingHub Home  > My purchases.
Alternatively, you can return a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Return a purchase.

2. Select a purchase requisition, purchase order, or purchase line that has been delivered or 
partially delivered.

3. Select Return  from the More options  or Edit  menu, as applicable.

4. On the form, fill in the fields:

Field Description

Return type Type of return you want to request. The 
options are:

◦ Return for a refund

◦ Return for a replacement

Business owner Name of the business owner. This field is 
auto-populated.

Return scope Select whether you want to return teh 
entire purchase or individual items from the 
purchase. The options are:

◦ Entire purchase

◦ Individual items

Purchase order lines This section is displayed if you select 
Individual items  from the Return scope  field.
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Field Description

◦ Purchase order line: Purchase order line 
that you want to modify.

◦ Product name: Product associated with the 
purchase order lines.

◦ Quantity received: Quantity of items that 
you have received.

◦ Quantity returned: Quantity of items 
already returned before, if any, is auto-
populated.

◦ Quantity to be returned: Quantity of items 
to return. This field is displayed only if you 
selected Return for a refund  in the Return 
type  field.

◦ Quantity to be replaced: Quantity of items 
to replace. This field is displayed only if you 
selected Return for a replacement  in the 
Return type  field.

How many would you like to return? Quantity of items to return. Remember that 
the quantity must always be lesser than or 
equal to the delivered quantity.

Note:  This field is displayed only for 
line-level returns.

Reason for return Reason for returning this purchase.

Note:  You can introduce new question variables to the form and enable additional 
validations, if required, from the respective record producer record.

5. Select Submit Request.
A confirmation message screen appears.

Result
Depending on the type of return request, this procedure creates a procurement case of type 
Return a purchase or Replace a purchase, with the relevant details. Associated request lines and 
tasks are created using this information.

The fulfiller can approve or reject the return or replacement request. For more information, see 
the following topics:

• Process a return request in playbook

• Process a replacement request in playbook

What to do next

• Shoppers can review the request details from Employee Center  > My Requests.

• Shoppers can review the request details from ShoppingHub  >  > My purchases, accessed 
from the profile image or from the footer.

• Buyers can track the progress of the procurement case and procurement case line requests 
from Source-to-Pay Workspace.
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Submit an edit receipt request from Shopping Hub

As a shopper, you can revise previously accepted receipts to address any discrepancies, 
ensuring accurate updates to purchase orders, purchase order lines, and received quantities.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home  > My purchases.
Alternatively, you can return a purchase from Employee Center  > Purchase and Expense  > 
Purchase Requests  > Edit a receipt.

2. Search for and open the purchase order or Purchase order line you want to edit.

3. Select the kebab menu, and then select Edit a receipt.

4. On the Edit a request form, fill in the fields.

Field Description

Business owner User who submitted the purchase request.

Purchase order line Purchase order line that you want to modify.

Receipt Receipt that you want to edit.

Quantity received Number of items you received from that order.

Date received Date when you received the items.

Reason for edit Reason for editing the receipt.

5. Select Submit request.
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A procurement case of type Edit a receipt is created.

What to do next

• Shoppers can review the request details from Employee Center  > My Requests.

• Shoppers can review the request details from ShoppingHub  >  > My purchases, accessed 
from the profile image or from the footer.

• Buyers can track the progress of the procurement case and procurement case line requests 
from Source-to-Pay Workspace.

Shopper to-dos

As a shopper, you can have to-dos assigned to you, related to your purchases, for you to act on. 
You can view your to-dos by selecting the user icon on ShoppingHub Home.

To-dos are specific to the logged-in user, so you can view them when logged in and Shopping 
as Myself. When shopping as another user, you can’t see any to-dos unless you’re set up as a 
delegate for that user. If assignments and approvals are selected for the delegate, you can view 
and work on the to-dos and approvals accordingly.

This section includes purchase request approval tasks, purchasing tasks, procurement tasks, 
receipt tasks, and acknowledgment tasks. Selecting assignments also means that the delegate 
can view the to-dos on the purchase details page.

You can select a to-do to view the details of the task, and view and upload attachments 
associated with the to-do. You can also track the updates on a selected to-do by selecting the 
Activity  tab. You can also compose a message and tag a person you want to address, with 
"@<primary contact name>", in the Comments  field. An instructional message is displayed above 
the Compose section that dynamically shows who the primary contact is for the associated 
purchasing task. The specified user receives an email notification.

Here's a look at the types of shopper responsible to-dos that can be listed under My to-dos:
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• Approvals  tab: Approval tasks: Approve your purchase requisition

• Other to-dos  tab

◦ Purchasing tasks

▪ Provide more details on your purchase

▪ Request clarification on a purchase request (approver task)

▪ Provide clarification on your purchase

▪ Compare quotes and select a supplier

◦ Procurement tasks

▪ View a link or video

▪ Upload a document

▪ Sign a document

▪ Submit a form

◦ Receipt tasks

▪ Confirm receipt of your order and quantity

▪ View shipment details of your order

▪ Confirm meeting a milestone for your service

◦ Review your invoice acknowledgment

◦ Review your service acknowledgment

Each of these to-dos displays specific information and have a specific action for the shopper to 
complete.

As a shopper, you can have visibility into to-dos, attachments, and activity stream views of 
purchase requests and orders. You can perform similar actions from the purchase order or order 
line section.

To-do refinement options

You can refine your to-dos through filtering, sorting, and searching options on the My to-dos 
landing page.

Filter

You can filter your to-dos by:

• Open: This option is Default. All tasks with the following conditions:

◦ Purchasing tasks that are in the Open state.

◦ Sourcing tasks with subtype Ask a question, that are in the Work in Progress state, with sub-
state as Answer Pending.

◦ Sourcing tasks with subtype Select a Supplier, that are in the Work in Progress state.

◦ Approval tasks, for purchase requests or approvals for invoices, that are in the Requested 
state.

◦ Receipt tasks that are in the Open, Shipped, or Partially Complete state.

◦ Milestones that are in the Confirmation Required state.

• Due this week: All tasks that are due in the next seven days.

• Overdue: All tasks that are past their due date.
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Sort

You can sort your to-dos by:

• First due:

◦ Sort your to-dos by due dates. Those with earlier due dates are displayed first.

◦ This is the default option.

• Last due: Sort your to-dos by due dates. Those with later due dates are displayed first.

• Last updated: Sort your to-dos by the last updated date. Those updated recently are displayed 
first.

Search

To search for a specific to-do, enter relevant keywords or to-do numbers. Keyword search is 
performed on top of the existing filter criteria that you have selected.

The following fields are searchable:

• Number

• Short description

• Due date

You can select the associated cards, view the details, and perform available actions.

To-do highlights

Your to-dos are highlighted with color coding to help you quickly understand the due dates.

A red vertical line is displayed to the left of the task card, and a badge with the same color is 
displayed with the number of days, if the due date of the to-do has passed.

Similarly, a yellow vertical line is displayed to the left of the task card, and a badge with the same 
color is displayed with the number of days, if the to-do has a due date approaching in three days.

A procurement administrator can use the sn_shop.spend.sla.due.days purchasing property to 
configure the number of days for displaying the yellow highlight. By default, this is set to three 
days of the task due date.

Approve your purchase requisition from Shopping Hub  Home

Provide approvals for your purchase requisitions and invoice requests that are in pending 
approval state. Purchase requisition approvals are generated when an approval rule is triggered 
on meeting certain criteria. Invoice approvals are sent to the recipient of the line.

Before you begin
Role required: sn_shop.shopper
To provide approvals for your purchase requisitions and invoice requests, you should have 
received such requests. Only then, this to-do is displayed to you on Shopping Hub  Home.

You can choose to reject them along with your reasons for rejection. Your action on these to-dos 
moves the purchase requisitions and invoices to their respective workflows.

An approver can also access the purchase details page on Shopping Hub  to gather more 
information on a purchase request before approving it. Select the card that shows the purchase 
line in the approval details page to view the purchase details. Approvers are however, not 
allowed to revise purchase lines.
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About this task
You can approve or reject your purchase requisitions and invoice requests from the Approvals 
tab.

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Approvals  tab.

4. On the Pending approval  tab, view details of the approval requests, such as requester name, 
total amount or budget requiring approval, and request ID at the header level.
At the line level, you can view the details of the requested items, such as product, approval 
amount, approval status, unit, price, quantity, total line amount, line number, reason for 
purchase, product type, delivery location, expected delivery date, and so on. You can also 
filter the purchase requisition lines by their approval status, and view associated activities and 
attachments in separate tabs therein.

5. Do any of these actions.

Action Description

Approve selected Approves all the to-dos you selected.

Approve all Approves all the to-dos.

Reject selected Rejects all the to-dos you selected.

Reject all Rejects all the to-dos.

You can now view the approved and rejected to-dos on the Approved  and Rejected  tabs 
respectively.

Note:  When rejecting a purchase requisition, you must provide your justification for 
rejection on the Reason for rejection  window.

6. Select Submit.

Provide more details on your purchase from Shopping Hub  Home

Provide additional information on your purchase from Shopping Hub  Home by answering the 
follow-up questions that the procurement specialist has posted regarding your order. Your 
response to these to-dos ensures that the procurement specialist understands your exact 
requirements and has all the necessary information before proceeding with the sourcing 
request.

Before you begin
To provide more details on your purchase, you should have received such requests from the 
procurement specialist. Only then, this to-do is displayed to you on Shopping Hub  Home.

Role required: sn_shop.shopper

About this task
You can provide more information on the queries that the procurement buyer has posted for 
them to proceed with the sourcing request.
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Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the to-do you want to work with.

5. In the Write a response  field, provide the necessary information to address the procurement 
buyer’s queries.

6. Select Submit.

Request clarification on a purchase request from Shopping Hub  Home

As an approver, request clarification from the shopper on a purchase requisition if you have 
questions that you need answers to before approving or rejecting the purchase requisition. 
Purchase requisition approvals are generated when an approval rule is triggered on meeting 
certain criteria.

Before you begin
To request clarification on a purchase requisition, you should be assigned as an approver for the 
shopper requesting the purchase. Also, specific approval rules must be triggered on meeting 
certain criteria. Only then, this approval to-do is displayed to you on Shopping Hub  Home.

An approver can also access the purchase details page on Shopping Hub  to gather more 
information on a purchase request before approving or rejecting it. Select the card that shows 
the purchase line in the approval details page to view the purchase details. Approvers are 
however, not allowed to revise purchase lines.

Note:  You can also request clarification from your mobile device, virtual agent, or by 
selecting Ask for Clarification  from the purchase requisition approval record in Sourcing 
and Purchasing Automation  or from Requisition Approvals  in Source-to-Pay Workspace.

Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the to-do you want to work with.

4. Select Request clarification  from the list.

5. In the Ask <Shopper Name> for clarification  window, enter the questions that you require 
clarification for.

6. Select Submit.

What to do next
View the clarifications requested by you and other approvers, or ask for more clarifications if 
required, from the activity stream of that to-do.

Provide clarification on your purchase from Shopping Hub  Home

Provide clarification on your purchase by answering the question that the approver has posted 
regarding your order. Your response to this clarification ensures that the approver understands 
your exact requirements and has all the necessary information before proceeding with approving 
or rejecting your purchase request.
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Before you begin
To provide clarification on your purchase, you should have received a clarification request from 
the approver. Only then, this task is displayed to you on your My purchases page on Shopping 
Hub  Home.

Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My purchases.

3. On the View by purchase  tab, select View question  on the purchase you want to provide 
clarification for.

4. In the Answer question  dialog box, enter your clarification for the approver.

5. Select Post comment.

This correspondence is tracked through the activity stream of the corresponding purchase 
requisition or sourcing request here in Shopping Hub. The same is also tracked through the 
activity stream of the approval plan in Employee Center.

An email notification is sent to the approver that clarification is provided for the purchase. You 
can configure this email notification based on your requirements. For details, see Approval 
email notification templates.

Compare quotes and select a supplier from Shopping Hub  Home

Review the quotes that you have received from the various suppliers for the product you had 
requested sourcing for. These quotes are displayed after the sourcing requests have listed 
similar suppliers for the product model you requested for. You can choose to award the supplier 
with the quote that best fulfills your requirements.

Before you begin
To review the quotes that you have received from suppliers, you should have received at least 
one quote from a supplier for your product. Only then, this to-do is displayed to you on Shopping 
Hub  Home.

Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Do one of these actions.

Action Description

Checkout now

Select the quote that works best for you and 
proceed to checkout. The quick checkout 
pane is displayed, with the details for your pur­
chase already filled in. For more information 
on how to proceed, see Order a product.

Reject all quotes
Reject all the quotes if none of them serve 
your purpose.
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Action Description

Note:  When rejecting all quotes, you 
must provide your justification for rejec­
tion on the Reason for rejection  win­
dow.

5. Select Submit.

Confirm receipt of your order from Shopping Hub  Home

Provide confirmation of receipt of the items you ordered that are in pending receipt state from 
Shopping Hub  Home, so that payment is processed to the supplier accordingly. If you have not 
received the complete order, you can confirm receipt of a part of your order as well with the date 
when you received them.

Before you begin
To provide confirmation of receipt of your orders, you should have received a part of your order 
at least, if not the complete order. Only then, this to-do is displayed to you on the Pending 
confirmation  tab.

Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. On the Pending confirmation  tab, select the to-do you want to work with.

5. Do one of these actions.

Action Description

Received selected

Confirms receipt of the selected orders.

On the Confirm receipt  window, fill in the fol­
lowing fields:

◦ Quantity received: Number of items you re­
ceived from that order.

◦ Date received: Date when you received the 
items.

Received all

Confirms receipt of all the orders.

On the Confirm you received everything  win­
dow, select the date when you received your 
ordered items.

6. Select Submit.

View shipment details of your order from Shopping Hub  Home

View the current status of your ordered items, along with the tracking number and carrier name, 
from the Shipment details  tab under your receipt to-dos.
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Before you begin
To view the status of your ordered items, you should have received dispatch notice regarding 
your orders from the supplier. Only then, this Shipment details  tab is displayed to you on 
Shopping Hub  Home.

Role required: sn_shop.shopper

About this task
You can view the status, tracking number, and carrier name for your ordered items that the 
supplier has dispatched from their end.

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the to-do you want to work with.

5. Select the Shipment details  tab.
Details of the dispatched items, including tracking number, carrier name, and status, are 
displayed.

Confirm meeting a milestone for your service from Shopping Hub  Home

Provide confirmation from Shopping Hub  Home on whether the supplier has met a milestone for 
a service you had ordered, so that payment can be processed to the supplier for that milestone. 
If a milestone hasn’t been met by the due date, you can raise a cancel request or propose a new 
completion date.

Before you begin
To provide confirmation on meeting the milestone for a service you had ordered, you should 
have received the service by the due date or milestone that you had defined when placing the 
order. The milestone is displayed on the completion date defined on the milestone.

Role required: sn_shop.shopper

About this task
You can provide confirmation on whether the supplier has met a milestone for a service you 
had ordered, from the Other to-dos  tab. This confirm milestone completion task is automatically 
created by the system on the target completion date. This task is active for a day, after which it 
becomes overdue.

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the to-do you want to work with.

5. Do one of these actions.

Action Description

Additional comments
Provide your response, if any, and select Com­
plete.

Defer completion Push the milestone to a later date.
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Action Description

On the Defer completion  window, provide 
your reason for changing the due date, pick a 
new due date, and select Submit.

Note:  Milestones can be received in 
percentage and amount, but can only 
be deferred if not complete until they’re 
processed for the full milestone. This 
is because milestones are parts of the 
whole, and partials aren’t supported.

Cancel milestone

Cancel the milestone altogether.

On the Cancel milestone  window, provide 
your reason for canceling the milestone, and 
select Submit.

View a link or video from Shopping Hub  Home

Complete your task by viewing a link or video that your procurement specialist has assigned to 
you, directly from Shopping Hub  Home. This action is listed as a task under My to-dos.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the task that you want to work with.

5. View details of the task, such as the task number, due date, if any.

6. View the link or video in the task.
In case of CORS error in the network tab of your web page, ensure that your procurement 
specialist has provided the correct URL. For example, when rendering a YouTube video, ensure 
that the video source link or embedded link is provided while creating the task.​

7. Select Complete.

Upload a document from Shopping Hub  Home

Complete the task that your procurement specialist has assigned to you by uploading a 
document, directly from Shopping Hub  Home. This action is listed as a task under My to-dos.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.
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4. Select the task that you want to work with.

5. View details of the task, such as the task number, due date, if any.

6. Select Select  to select one or more documents from your local drives, as required.
Alternatively, you can drag and drop documents from your local drives to attach them.

7. In the Upload a file  dialog box, select Upload  to attach the documents.
Once attached, you have the option to download, remove, or rename the documents, if 
required.

8. Select Mark as complete.

Sign a document using DocuSign from Shopping Hub  Home

Provide your consent by signing a document using DocuSign, directly from Shopping Hub  Home. 
This action is listed as a task under My to-dos.

Before you begin
Role required: sn_shop.shopper, supplier

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the task that you want to work with.

5. View details of the task, such as the task number, due date, if any.

6. On the displayed document, select Continue.

7. Select Start.

8. Follow the arrowhead and select Sign.

9. Select Finish.

Sign a document from Shopping Hub  Home

Provide your consent by signing a document, directly from Shopping Hub  Home. This action is 
listed as a task under My to-dos.

Before you begin
Role required: sn_shop.shopper, supplier

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the task that you want to work with.

5. View details of the task, such as the task number, due date, if any.

6. On the displayed document, you can choose to type your signature or draw it.
Based on what you select, you can either write your full name in the Full name  field, or draw a 
digital signature in the box provided.
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Note:  If you aren’t happy with what you see in the document, you can select I don't 
want to sign this document. You must enter your reason for declining, followed by 
Decline and complete  to complete the task.

7. Select Accept and complete.

Complete a form from Shopping Hub  Home

Fill in a form that your procurement specialist has sent to you, and submit it directly from 
Shopping Hub  Home. This action is listed as a task under My to-dos.

Before you begin
Role required: sn_shop.shopper

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the user icon and select My to-dos.

3. Select the Other to-dos  tab.

4. Select the task that you want to work with.

5. View details of the task, such as the task number, due date, if any.

6. On the displayed form, fill in the details as required.

7. Optional:  Select Save as  if you want to save a draft in your requests and plan to complete it 
later.

8. Select Submit.

Create an employee credit

Manage and track credits that an employee shopper is allocated to in Shopping Hub, by creating 
an employee credit. If a credit already exists, allocated to an employee, it shows up as a payment 
option in Shopping Hub, and is created as a cost allocation entry at the backend.

Before you begin
Role required: sn_shop.shopping_hub_admin

About this task
You can create a credit for an employee shopper from Shopping Hub.

Procedure

1. Navigate to All  > ShoppingHub  > Manage Employee Credits  > Allocated Credits.

2. Select New.

3. On the form, fill in the fields.

Employee Credit form

Field Description

Credit name The name you assign to an employee credit. This is visible to the shopper who 
is assigned the credit.

Number Unique identifier for this credit.
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Field Description

Description Additional information about the credit. This is visible to the shopper who is 
assigned the credit.

Allocated to Search for and select the user who this authorized to shop with this allocated 
credit.

Responsible 
cost center

The cost center responsible for the user you selected in the Allocated to  field. 
This is auto-populated and read-only.

Amount 
allocated

The amount of credit a shopper is allocated to spend.

Expiration 
date

The date after which a credit allocated to a shopper is no longer valid.

Payback 
options

The number of paycheck periods an employee is allowed to pay back costs in 
excess of the allocated credit amount.

Restrict 
Use to 
Categories

Search for and select the categories for which employee credits can be used 
to purchase products in the category. You must select a value for either the 
Restrict Use to Categories  or Restrict Use to Products  fields to create the 
record.

Restrict Use 
to Products

Search for and select the products for which employee credits can be used 
to purchase products related to the product model. You must select a value 
for either the Restrict Use to Categories  or Restrict Use to Products  fields to 
create the record.

Status Specify the current status of a credit. The options are Pending Purchase, Credit 
Consumed, and Credit Expired. If you save the status as Credit Consumed or 
Credit Expired, the form becomes read-only.

Allocated Specifies how the employee credit was allocated. The options are Manually 
and By Credit Allocation Rule.

Allocated by The employee who created and allocated the credit to another employee. This 
field is required if credit allocation is done manually.

Credit 
allocation 
rule

The rule that generated this employee credit. This field is visible only if 
allocation is done through a credit allocation rule.

4. Select Submit.

Create a credit allocation rule

Assign an amount of credit that an employee shopper can use in Shopping Hub, by creating a 
condition-based allocation rule.

Before you begin
Role required: sn_shop.shopping_hub_admin

To create a credit allocation rule, you must have already created some credits to be assigned to 
employee shoppers. For more information, see Create an employee credit.

About this task
You can create a condition-based credit allocation rule for an employee shopper from Shopping 
Hub.
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Procedure

1. Navigate to All  > ShoppingHub  > Manage Employee Credits  > Credit Allocation Rules.

2. Select New.

3. On the form, fill in the fields.

Credit Allocation Rules form

Field Description

Credit 
name

The name you assign to an employee credit. This is visible to the shopper who is 
assigned the credit.

Active Option to decide if employee credits are to be created for this rule.

Description Additional information about the credit. This is visible to the shopper who is 
assigned the credit.

One time 
credit

Option to decide if credits are to be assigned just once to employees that meet 
the conditions of this rule.

Amount 
allocated

The amount of credit a shopper is allocated to spend.

Credit 
expires 
after

The amount of time a credit remains active for a shopper to use.

Allocation 
based on

Specify the conditions that determine if credits are to be assigned automatically. 
The options are Inventory Asset and User.

Specify 
asset 
conditions

Specify the conditions that must be met for a credit to be created. This field is 
visible only if you select Inventory Asset in the Allocation based on  field.

Specify 
user 
conditions

Specify the conditions that must be met for a credit to be created. This field is 
visible only if you select User in the Allocation based on  field.

Payback 
options

The number of paycheck periods an employee is allowed to pay back costs in 
excess of the allocated credit amount.

Restrict 
use to 
spend 
categories

Search for and select the spend categories for which employee credits can be 
used to purchase products in the category. You must select a value for either 
the Restrict use to spend categories, Restrict use to product categories, or 
Restrict use to products  fields to create the record.

Restrict 
use to 
product 
categories

Search for and select the product categories for which employee credits can 
be used to purchase products in the category. You must select a value for either 
the Restrict use to spend categories, Restrict use to product categories, or 
Restrict use to products  fields to create the record.

Restrict 
use to 
products

Search for and select the products for which employee credits can be used to 
purchase products related to the product model. You must select a value for 
either the Restrict use to spend categories, Restrict use to product categories, 
or Restrict use to products  fields to create the record.

4. Select Submit.
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What to do next
Use the related list of the credit allocation rule form to view the employee credits associated with 
this rule.

Create a paycheck period

Assign a time period for an employee shopper to pay back costs in excess of the allocated credit 
amount in Shopping Hub  Home, by creating a paycheck period.

Before you begin
To create a paycheck period, you must have already created some credits to be assigned to 
employee shoppers. For more information, see Create an employee credit.

Role required: sn_shop.shopping_hub_admin

About this task
You can create a paycheck period for an employee shopper from Shopping Hub.

Procedure

1. Navigate to All  > ShoppingHub  > Manage Employee Credits  > Paycheck Periods.

2. Select New.

3. In the Number of paychecks  field, enter a number to create a record for a paycheck period.

4. Select Submit.

Shopping controls overridden by credits

As a shopper, you can use employee credits to purchase a restricted set of supplier products 
based on the category or product model. At the same time, you could be restricted, via Shopping 
Control, from viewing those supplier products.

In this case, the employee credits allocated to you override the shopping control settings and 
temporarily allow you to view and shop those specific supplier products which are tied to these 
employee credits. Once this credit is consumed or reaches expiry, the shopping control settings 
resume precedence.

Consider these scenarios:

Scenario 1: A shopping control exists, according to which you, from the marketing department, 
cannot view and shop any supplier product in the IT hardware category. An employee credit for 
hardware refresh is created for you. This allows you to search, browse, and shop from the laptop 
category, which is a child of the IT Hardware category. You can also view any child category of the 
laptop category, as well as any supplier product within these categories.

Scenario 2: A shopping control exists, according to which you, from the marketing department, 
cannot view and shop any supplier product in the IT hardware category. An employee credit 
for hardware refresh is created for you. This allows you to search, browse, and shop MacBook 
product models, which comes under the laptop category, whose parent category is IT hardware. 
However, you are not able to view any other products within the laptop or IT hardware categories 
because the credit does not allow you access to the other products in this category.

Shop with employee credits

Shop products from the various categories in Shopping Hub  Home with employee credits that 
are allocated to you. You can search, browse, and shop from all open categories as well as from 
those restricted categories for which credits have been assigned to you.
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Before you begin
To shop using employee credits, you must have some employee credits allocated to you by the 
Shopping Hub  administrator. For more information on how employee credits allow you access to 
restricted categories, see Shopping controls overridden by credits.

Role required: sn_shop.shopper

About this task
You can search, browse, and shop products from the various categories in Shopping Hub  Home 
with employee credits that are allocated to you for those categories.

Procedure

1. Navigate to All  > ShoppingHub  > ShoppingHub Home.

2. Select the Available Credits  tab.
The available credits and their product categories are displayed.

Note:  You don’t see the Available Credits  tab if:

◦ You don’t have any credits allocated to you.

◦ You’ve fully or partially consumed your credits.

◦ Your credits have expired.

3. Navigate to the credit that you want to shop with, and select Shop this credit.

4. On the Filters  form, fill in the fields.

Filters form

Field Description

Get it by Date by which you want the product.

Supplier Option to filter by the type of the supplier. The options are Onboarded and 
Preferred. Select one or more suppliers from the list to refine your search.

Price Price range of the product. Select a minimum and maximum price to refine your 
search.

5. From the search results, select the product you want to shop.
The product details page is displayed.

6. In the Purchase by  field, select one of these options.

Option Description

Quantity
Number of units of the product you want to 
shop.

Budget Budget you have at your disposal.

7. Select Request to buy.

8. On the quick checkout form, fill in the fields.
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Field Description

Where 
do you 
want this 
delivered?

Location where you want your product to be delivered. The options are:

◦ To a saved location

◦ To a work address (already approved)

◦ To somewhere else

When 
do you 
need this 
product?

Date range when you want your product to be delivered. The options are:

◦ As soon as possible

◦ On a specific date

◦ I have a time frame in mind (a blanket order)

Payment 
method

Method of making the payment. The available credits are displayed here. If the 
price of the product exceeds the available credit, the remaining balance amount 
is scheduled for deduction from future paychecks based on the configured 
payback options.

9. Accept the terms and conditions for credit purchases for paycheck payments.

10. Based on whether the purchase is for an existing project, select one of these options.

Option Description

No Purchase isn’t for an existing project.

Yes
Purchase is for an existing project. Enter the 
project details as required.

11. Add any supporting documents for this purchase as attachments, if applicable.

12. Select Submit request.

Note:  You don’t have the option to shop with partial credits. Any unused credit 
automatically expires when you successfully place an order.

What to do next
You can view the allocation type and allocation amount breakup from the purchase requisition 
that is created, by navigating to the Cost Allocations related list of the associated purchase 
requisition line.

Alerts and email notifications from ShoppingHub

Several alerts and email notifications are triggered from ShoppingHub. This may be a result of 
your action, an assignment for you, or to keep you updated on the status of your purchases, 
including blanket contracts.

Alerts

You receive an alert triggered from ShoppingHub when:

• You switch the user that you’re shopping as in ShoppingHub

• You switch to shop as someone else's delegate

• You submit a revision

• You complete a to-do that isn't an approval
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• You approve a purchase

• You reject an approval

• ShoppingHub has a global fail or fails to complete an action, due to server issue

Email notifications

ShoppingHub sends out emails in a predefined template and uses flow designer to trigger the 
different email conditions. You can use the deep links that are provided in the emails to view 
relevant details. You’re notified through email when:

• You submit a purchase request, irrespective of approval requirement (for one or multiple 
purchase lines)

• You submit a new purchase request from a third-party site.

• Your delegate submits a purchase request, irrespective of approval requirement (for one or 
multiple purchase lines)

• You submit a purchase request, irrespective of approval requirement that is automatically 
merged with an existing purchase request (for one or multiple purchase lines)

• A purchase request that triggers an approval rule, is submitted, and you’re assigned as an 
approver for that purchase.

Note:  As an approver, you can approve the purchase from the email itself. For details, 
see Approval email notification templates.

• An approver requests clarifications on your purchase request

• An approver requests clarifications on your sourcing request

• You respond to clarification requests on your purchase request

• You respond to clarification requests on your sourcing request

• A purchase is manually merged with an existing purchase, irrespective of approval 
requirement

• A merged purchase is approved, partially approved, or rejected

• You submit a sourcing request

• Your delegate submits a sourcing request

• Your purchase is approved, partially approved, or rejected and canceled

• Your sourcing request is approved, partially approved, or rejected

• You initiate or submit a purchase revision, irrespective of approval requirement

• Your purchase revision is confirmed, approved, rejected, or canceled

• There are any price or quantity changes during purchase order confirmation

• There are any rejections for any purchase order lines that could not be fulfilled during 
purchase order confirmation

• Your purchase is ordered from a supplier

• Purchasing permissions are added for you on a blanket purchase order (for one or multiple 
purchase lines)

• A blanket purchase order, for which you have purchasing permissions, is created or open (for 
one or multiple purchase lines)

• Seven days are left for a blanket purchase order contract to expire (for one or multiple 
purchase lines)
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• 20% budget is left on a blanket purchase order (for one or multiple purchase lines)

• No budget is left on a blanket purchase order (for one or multiple purchase lines)

• A blanket purchase order is closed (for one or multiple purchase lines)

• You’re assigned as a delegate

• You’re no longer assigned as a delegate

• An item is removed from your cart or Purchase later section

• You receive a delivery

• A purchasing task is assigned to you

• A breached approval review task is assigned to you

• You’re mentioned in an activity stream

• A new to-do is created and assigned to you

• A to-do assigned to you is due today or overdue

• A confirm receipt to-do is assigned to you

• A confirm milestone to-do is assigned to you

• A to-do requesting you to provide more information is assigned to you

• A select supplier to-do is assigned to you

• An invoice approval to-do is assigned to you

• A purchase approval to-do is assigned to you

• A purchase approval to-do is updated or canceled

• An approval to-do is assigned to you as a result of a revision or merge reassessment

You can adjust the email trigger conditions and content in flow designer or email scripts, if 
necessary. You can also choose to fetch and use other details that aren’t displayed in the 
email by default, such as order type for purchase requisitions, product type or request type 
for sourcing requests, and so on. For detailed information on email templates and how to work 
with them, see Email templates . You can also configure the email layout, and change the 
background color or font color, for example. The html field in the email layout record must be 
modified to achieve this. For detailed information on email layouts and how to work with them, 
see Email layouts .

Prioritize Shopping Hub  email notifications

To ensure that your customers receive the focused Shopping Hub  email notifications, over the 
global notifications that are sent by default from the platform team, you can manually add a 
condition to suppress them.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Notification  > Notifications.

2. Search for and open the Activity Stream @Mention Email  record.

3. Select the hyperlink on the information message to edit it.

4. On the When to send  tab, add the condition: "Table does not contain sn_shop_"

5. Save the record.
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Using Shopping Hub Mobile

The ServiceNow Shopping Hub Mobile  app enables you to engage with procurement 
organizations from a mobile device.

The Shopping Hub Mobile  app provides the following capabilities to shoppers:

• View and complete your to-dos: Each of these to-dos displays specific information and have 
specific actions for the shopper to complete.

◦ Review and approve purchase requisitions

◦ Provide more details on your purchase

◦ Request clarification on a purchase request (approver task)

◦ Provide clarification on your purchase

◦ Compare quotes and select a supplier

◦ Confirm receipt of your order

◦ View shipment details of your order

◦ Confirm meeting a milestone for your service

◦ Review invoices associated with your purchase

• View, track, and revise your purchases

• Requesting for products or services that you don't see on ShoppingHub

• Submit quotes from vendors

Related topics

Install ShoppingHub Mobile

Application plugin installation sequence in Sourcing and Procurement Operations

Shopping Hub Mobile

My purchases on your mobile

Shopper to-dos on your mobile

As a shopper, you can complete actions on to-dos related to your purchases.

To-dos are specific to the logged in user.

Your to-dos are highlighted with color coding to help you quickly understand their due dates, 
if any. A red badge with the number of days is displayed on the to-do that is overdue. Similarly, 
a yellow badge with the number of days is displayed if a to-do has a due date approaching in 
seven days. A grey badge with the number of days is displayed if a to-do has a due date more 
than seven days.

You can open any to-do to view the details of the task and the purchase that led to the creation of 
the to-do. You can also view the entire purchase for specific to-dos.

Approve your purchase requisition from your mobile device

As a manager, provide approvals for purchase requisitions that are in pending approval state 
from your mobile application. Purchase requisition approvals are generated when an approval 
rule is triggered on meeting certain criteria. You can choose to reject them along with your 
reasons for rejection. Your action on these to-dos moves them to their respective workflows.
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Before you begin
When a purchase approval to-do is assigned to you, it is displayed on the Now Mobile My Tasks 
tab, in addition to the Shopping Hub  desktop to-dos page.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the approval to-do you want to work with.

4. View details of the approval request, such as requester name, total amount or budget requiring 
approval, and request ID at the header level.
At the line level, you can view the details of the requested items, such as product, approval 
amount, approval status, unit, price, quantity, total line amount, line number, reason for 
purchase, product type, delivery location, expected delivery date, and so on. You can also 
filter the purchase requisition lines by their approval status, and view associated activities and 
attachments in separate tabs therein.

5. On the To-do  tab, select Pending approval.

6. Do any of the following actions.

Action Description

Approve
Swipe left on the line item, and select Ap­
prove  to approve it.

Reject
Swipe left on the line item, and select Reject 
to reject it.

Approve all
Tap on the Actions icon, and select Approve 
all  to approve the entire purchase.

Reject all
Tap on the Actions icon, and select Reject all 
to reject the entire purchase.

You can view your approved and rejected to-dos in the To-do  tab, listed after your pending 
approvals. You can also view the details of the purchase that led to the creation of this to-do in 
the Purchase  tab.

Note:  When rejecting a line item or an entire purchase, you must provide your 
justification for rejection in the Response  field.

7. Tap the Next icon.

Provide more details on your purchase from your mobile device

Provide additional information on your purchase by answering the follow-up questions that 
the procurement specialist has posted regarding your order from your mobile application. 
Your response to these to-dos ensures that the procurement specialist understands your 
exact requirements and has all the necessary information before proceeding with the sourcing 
request.

Before you begin
A procurement specialist can request for more information about a sourcing request by 
assigning a to-do. When this more information needed request is assigned to you, it is displayed 
on the Now Mobile My Tasks  tab, in addition to the Shopping Hub  desktop to-dos page.

Role required: sn_shop.shopper
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About this task
You can provide more information on the queries that the procurement buyer has posted for 
them to proceed with the sourcing request.

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the to-do you want to work with.

4. Select Provide more information.

5. Provide the necessary information in the Response  field to address the procurement buyer’s 
queries.

6. Tap the Next icon.
You can view the details of the purchase that led to the creation of this to-do in the Purchase 
tab. Here, you also have the option to view the entire purchase if you so desire.

Request clarification on a purchase request from your mobile device

As an approver, request clarification from the shopper on a purchase requisition if you have 
questions that you need answers to before approving or rejecting the purchase requisition, from 
your mobile application. Purchase requisition approvals are generated when an approval rule is 
triggered on meeting certain criteria.

Before you begin
To request clarification on a purchase requisition, you should be assigned as an approver for the 
shopper requesting the purchase. Also, specific approval rules must be triggered on meeting 
certain criteria. Only then, this approval to-do is displayed to you on the Now Mobile My Tasks 
tab.

Note:  You can also request clarification from your Shopping Hub  desktop, virtual agent, 
or by selecting Ask for Clarification  from the purchase requisition approval record in 
Sourcing and Purchasing Automation  or from Requisition Approvals  in Source-to-Pay 
Workspace.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the to-do you want to work with.

4. On the To-do  tab, select Pending approval.

Note:  You can view the clarification provided by the shopper by selecting Requests for 
clarification.

5. Tap on the Actions icon, and select Request clarification.

6. Enter the clarification you require in the Question  field.

7. Tap the Next icon.

Provide clarification on your purchase from your mobile device

Provide clarification on your purchase by answering the question that the approver has posted 
regarding your order, from your mobile application. Your response to this clarification ensures 
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that the approver understands your exact requirements and has all the necessary information 
before proceeding with approving or rejecting your purchase request.

Before you begin
To provide clarification on your purchase, you should have received a clarification request from 
the approver. Only then, this task is displayed to you on the Now Mobile My Purchases  tab.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Purchases.

3. Open the purchase you want to provide clarification for.

4. On the More Info  tab, select Requests for clarification.

5. Select the question you want to provide clarification for.

6. Tap on the Actions icon, and select Provide clarification.

7. Provide your clarification in the Clarification answer  field.

8. Tap Submit.

Compare quotes and select a supplier from your mobile device

When you raise a sourcing request, the procurement team works with suppliers to get quotes 
for the good or service you are looking for. When you receive these quotes, you can review them 
from your mobile application. You can choose to award the supplier with the quote that best 
fulfills your requirements.

Before you begin
To review the quotes that you have received from suppliers, you should have received at least 
one quote from a supplier for your product or service, and then have a compare quote task 
assigned to you. Then, the to-do is displayed on the Now Mobile My Tasks  tab, in addition to the 
Shopping Hub  desktop to-dos page.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the approval to-do you want to work with.

4. On the To-do  tab, select Quotes to review.

5. Do any of the following actions.

Action Description

Reject
Swipe left on the line item, and select Reject 
to reject the purchase line.

Request to buy
Swipe left on the line item, and select Re­
quest to buy  to proceed with the supplier and 
perform a quick checkout.
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Note:  When rejecting a quote, you must provide your justification in the Reason for 
rejection  field.

6. Tap the Next icon.

Confirm receipt of your order from your mobile device

Provide confirmation of receipt of the items you ordered that are in pending receipt state, from 
your mobile application, so that payment is processed to the supplier accordingly. If you have not 
received the complete order, you can confirm receipt of a part of your order as well with the date 
when you received them.

Before you begin
To provide confirmation of receipt of your orders, you should have received a part of your order at 
least, if not the complete order.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the receipt to-do you want to work with.

4. On the To-do  tab, select Pending confirmation.

5. Do one of these actions.

Action Description

Received

Swipe left on the line item, and select Re­
ceived  to confirm receipt of the selected or­
ders.

On the Confirm receipt  screen, fill in the fol­
lowing fields:

◦ Quantity received: Number of items you re­
ceived from that order.

◦ Date received: Date when you received the 
items.

Received (Details screen)

Tap on the line item to view the Details screen 
with the list of all the items pending deliver­
ies. Select Received  to confirm receipt of all 
the orders.

On the Confirm receipt  screen, fill in the fol­
lowing fields:

◦ Quantity received: Number of items you re­
ceived from that order.

◦ Date received: Date when you received the 
items.
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You can view your received deliveries in the To-do  tab, listed after your pending confirmation 
tasks. You can also view the details of the purchase that led to the creation of this to-do in the 
Purchase  tab.

6. Tap the Next icon.

View shipment details of your order from your mobile device

View the current status of your ordered items, along with the tracking number and carrier name, 
in your receipt to-dos, from your mobile application.

Before you begin
To view the status of your ordered items, you should have received dispatch notice regarding 
your orders from the supplier.

Role required: sn_shop.shopper

About this task
You can view the status, tracking number, and carrier name for your ordered items that the 
supplier has dispatched from their end.

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the receipt to-do you want to work with.

4. On the To-do  tab, select Shipment details.
Details of the dispatched items, including tracking number, carrier name, and status, are 
displayed.

Confirm meeting a milestone for your service from your mobile device

Provide confirmation on whether the supplier has met a milestone for a service you had 
ordered, from your mobile application, so that payment can be processed to the supplier for that 
milestone. If a milestone has not been met by the due date, you can choose to push the due date 
to a later date.

Before you begin
To provide confirmation on meeting the milestone for a service you had ordered, you should 
have received the service by the due date or milestone that you had defined when placing the 
order. The milestone is displayed on the completion date defined on the milestone.

Role required: sn_shop.shopper

About this task
You can provide confirmation on whether the supplier has met a milestone for a service you had 
ordered. This confirm milestone completion task is automatically created by the system on the 
target completion date. This task is active for a day, after which it becomes overdue.

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the to-do you want to work with.

4. On the To-do  tab, do one of these actions.
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Action Description

Confirm milestone
Select Confirm milestone  and provide your 
response, if any, in the Additional comments 
field.

Defer completion

Tap on the Actions icon, and select Defer 
completion  to push the milestone to a later 
date.

On the Defer completion  screen, pick a new 
completion date and provide your reason for 
changing the date.

Cancel milestone

Tap on the Actions icon, and select Cancel 
milestone  to cancel the milestone altogether.

On the Cancel milestone  screen, provide 
your reason for canceling the milestone.

You can also view the details of the purchase that led to the creation of this to-do in the 
Purchase  tab. Here, you also have the option to view the entire purchase if you so desire.

5. Tap the Next icon.

Review invoice acknowledgment task from your mobile device

Review invoices that require acknowledgment from your mobile application. Invoice 
acknowledgments are sent to the recipients of the purchases, and each line associated with an 
invoice can be marked as correct or incorrect. Your action on these to-dos moves the invoices to 
their respective workflows.

Before you begin
When you are assigned as the recipient of an order that requires invoice acknowledgment, 
and that invoice is sent to you for acknowledgment by the procurement team, an invoice 
acknowledgment task is displayed on your Now Mobile My Tasks  tab, in addition to the 
Shopping Hub  desktop to-dos page.

Note:  This only applies to orders where the underlying services acknowledgment is 
defined as invoice acknowledgment.

Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Tasks.

3. Open the to-do you want to work with.

4. On the To-do  tab, select Pending approval.

5. Do any of these actions.

Action Description

Mark all lines correct
Marks all the invoice lines as correct and 
moves them to the Invoice Confirmed state.
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Action Description

Review invoice lines
Displays the details of all the invoice lines for 
your review.

Mark as correct
Swipe left on an invoice line and select Mark 
as correct  to move it to the Confirmed state.

Mark as incorrect
Swipe left on an invoice line and select Mark 
as incorrect  to move it to the Rejected state.

Mark all lines correct
Tap on the Actions icon and select Mark all 
lines correct  to move all the invoice lines to 
the Invoice Confirmed state.

Mark all lines incorrect
Tap on the Actions icon and select Mark all 
lines incorrect  to move all the invoice lines to 
the Rejected state.

Approve
Tap on the invoice line and select Approve  to 
move it to the Confirmed state.

Mark incorrect
Tap on the invoice line and select Mark incor­
rect  to move it to the Rejected state.

Display My Purchases on your mobile instance

As a Shopping Hub  Administrator, you can configure your mobile instance to display My 
Purchases on your landing page. This is a one-time activity.

Before you begin
Role required: sn_shop.shopping_hub_admin

About this task
You can perform this activity only from your desktop.

Procedure

1. Navigate to All  > System Mobile  > Applet Launchers.

2. Select the Homepage  record.

3. Select the Body  tab.

4. Select the My Items  section.

5. Select the hyperlink on the information message to edit it.

6. In the Applets  field, search for and add My Purchases.

7. Select Update.

Related topics

Shopping Hub Mobile

My purchases on your mobile

View and revise your purchase from your mobile device

View and revise your purchase from your mobile device

View all the purchases you made from your shopping account, view their status, and revise your 
purchases from your mobile application.
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Before you begin
Role required: sn_shop.shopper

Procedure

1. Log in to your instance in the Now Mobile application.

2. Select My Purchases.

3. Open the purchase you want to work with.

4. Do one of these actions.

Action Description

View your purchase details

On the Purchase  tab, view the details of your 
purchase, such as quantity, recipient, deliv­
ery location, start date, end date, subtotal, 
tax, purchase reason, and so on.

View more information on your purchase

Select the More Info  tab to view more informa­
tion associated to your purchase, such as ad­
ditional quotes, receipts, prepayments, and 
other related lists.

Revise purchase

Tap the Actions icon to revise your purchase. 
On the Revise purchase  screen, enter the re­
vised quantity and delivery location, and tap 
the Next icon.

Related topics

Shopping Hub Mobile

My purchases on Shopping Hub

Display My Purchases on your mobile instance

Using Procurement Case Management

With the Procurement Case Management  application, you can enable your employees to submit 
procurement cases and access your organization's knowledge base.

Related topics

Procurement Case Management

Procurement Case Management Dashboard

Install Sourcing and Procurement Operations

Application plugin installation sequence in Sourcing and Procurement Operations

Create a procurement case

As a procurement specialist, create a procurement case from the list view of Source-to-Pay 
Workspace  to address your procurement-related business needs.

https://player.vimeo.com/video/1038250055?
h=9e71316df9&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist
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Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the list page, navigate to All work  > Cases.

3. Select New.

4. On the Create a new case  dialog box, select the case type from the What would you like to 
create?  list.
A procurement specialist can also create a case or task by navigating to Related cases and 
tasks  in the contextual panel of a procurement object details page, and selecting the + icon.

5. Select Create Case.

6. On the form, fill in the fields.

Procurement Case

Field Description

Number System-generated unique identifier for the 
case.

Created Date and time when the case was opened.

Case type Type of case based on the requirement. 
Available options:

◦ Budget review

◦ Contract review

◦ Delivery address review

◦ Due Diligence Case

◦ General procurement case

◦ GL coding review

◦ Send NDA for signature

Due date Expected date and time by when the case is 
expected to be resolved.

Requested by Person who requested for the case.

Priority Urgency of the case.

State Current state the case is in.

Assignment group Group to which the case is assigned to.

Assigned to Person within the assignment group to whom 
the case is assigned to.

Short description Brief description of the case.

Description Detailed description of the case.

Summary Details

Supplier Supplier associated with the case.

Related PO Purchase order associated with the case.

Related PR Purchase requisition associated with the 
case.
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Field Description

Related SR Sourcing request associated with the case.

Related NEG Negotiation associated with the case.

Related NE Sourcing event associated with the case.

Related case Any other case associated with the case.

Sourcing decision dependent on case Whether any sourcing decision is dependent 
on the case.

Note:  This field is displayed only if a 
related sourcing request, negotiation, or 
sourcing event is entered.​

Qualification dependent on case Whether any qualification is dependent on 
the case.

Note:  This field is displayed only if a 
related sourcing request, negotiation, or 
sourcing event is entered.​

Order dependent on case Whether the order is dependent on the case.

Note:  This field is displayed only if a 
related purchase requisition is entered.​

Expected start Date and time by when work is expected to 
start on the case.

Actual start Date and time when work actually starts on 
the case.

Actual end Date and time when work actually completes 
on the case.

Duration Time taken to resolve the case, in days, 
hours, minutes, and seconds.

Reason Reason why the case was created.

7. Select Save.

Create a procurement case for a service

Create a procurement case for a service that you wish to procure. The procurement organization 
receives your details from the request and works toward its fulfillment.

Before you begin
Role required: sn_spend_psd.requestor

Procedure

1. Navigate to All  > Procurement Case Management.

2. Select Create New.

3. On the form, fill in the fields.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

808



Field Description

Number System-generated unique identifier for the 
request.

Created Creation date of the request.

Request type Type of the request, such as Corporate Card 
Request.

Request by Owner of the request.

State Status of the request.

Priority Urgency of the request.

Assignment group Group that can fulfill the request.

Assignment to Person assigned to fulfill the request.

Short description Short description of the request.

Purchase modification reason Reason for purchase modification.

Description Detailed description of the request.

4. Select Submit.

Note:  You can also submit procurement cases from the Service Catalog.

What to do next

• Review and edit your request details.

• Track the progress of your request by monitoring the request fulfillment with the procurement 
organization.

Create a quick case

As a procurement specialist, quickly create a procurement case from the plus icon on Source-to-
Pay Workspace. With an additional supplier role of sn_supplier.fulfiller, you can similarly create a 
supplier case.

https://player.vimeo.com/video/1025480397?
h=4f7094fce3&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the landing or list page, select the + icon at the tab level.

3. On the Create new case  dialog box, select the case type from the Case type  list.

4. Select Submit.
A case form is displayed with pre-filled data based on the templates that you have configured.
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5. On the form, fill in the required fields.

6. Select Save.

Create a supplier case

As a procurement specialist, with an additional supplier role of sn_slm.manager, create a supplier 
case from the list view of Source-to-Pay Workspace  to address your supplier-related business 
needs.

https://player.vimeo.com/video/1056096764?
h=c4bc92591c&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist and sn_slm.manager

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the list page, navigate to All work  > Cases.

3. Select New.

4. On the Create a new case  dialog box, select the case type from the Case type  list.
A procurement specialist can also create a case or task by navigating to Related cases and 
tasks  in the contextual panel of a procurement object details page, and selecting the + icon.

5. Select Create Case.

6. On the form, fill in the fields.

Supplier Case

Field Description

Number System-generated unique identifier for the 
case.

Requested by Person who requested for the case.

Case type Type of case based on the requirement. 
The case type options are different for 
procurement cases and supplier cases.

Supplier Supplier associated with the case.

Opened by Person who opened the case.

Opened Date and time when the case was opened.

State Current state the case is in.

Stage Not applicable.

Priority Urgency of the case.

Assignment group Group to which the case is assigned to.

Assigned to Person within the assignment group to whom 
the case is assigned to.

Parent Parent, if any, from which this case has been 
created, typically for reference purposes.
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Field Description

Due date Date and time by when the case is expected 
to be resolved.

Short description Brief description of the case.

Description Detailed description of the case.

7. Select Save.

Create a task from a procurement case

Create a task directly from a procurement case. You can also create associated tasks and assign 
these tasks to fulfill the request.

Before you begin
Role required: sn_spend_psd.psd_admin, sn_spend_psd.agent

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.
A Source-to-Pay Workspace  agent page is displayed.

2. Select the List  button on the left pane.
The List pane expands to displays all related lists.

3. Select Requisitions.

4. Select the requisition number for which you want to add a task.

5. Select the Purchasing Tasks  tab.

6. Select New  on the associated Procurement Tasks list.
The Create a new task pop-up is displayed.

7. In the What task would you like to create?  field, select a task type.
For information on the task types, see Purchasing tasks and procurement cases.

8. Select Create task.

9. On the form, fill in the fields.

Field Description

Number System-generated unique identifier for the 
task.

Created Creation date of the task.

Task type Type of the task to fulfill the request.

Sub type Subtype of the task to fulfill the request.

Request Associated request for the task.

State Status of the task.

Assignment group Group that can fulfill the task.

Assignment to Person assigned to complete the task.

Due date Expected date of completion for the task.

Short description Short description of the task.
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Field Description

Description Detailed description of the tasks.

10. Select Submit.
You can create multiple tasks to fulfill the procurement case. All tasks in Open state are 
displayed on the Open tasks  pane of the task tab. You can access the tasks directly from this 
pane and perform the necessary actions.

Create a procurement task

As a procurement specialist, create a procurement task for the shopper or employer from the 
contextual panel of a procurement object details page in Source-to-Pay Workspace, to address 
your procurement-related business needs.

https://player.vimeo.com/video/1049740852?
h=d0fc28e838&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Procurement Workspace.

2. On the list page, navigate to All work.

3. Do one of the following:

To Do this

To create a procurement task for a 
procurement case.

a. Select Cases.

b. Select the link to the procurement case record under 
the Number column.

c. On the Purchasing Tasks  tab, select New.

To create a procurement task for the 
other procurement objects.

a. Select any of the following modules and select the 
link to the record under the Number column.

▪ Sourcing request

▪ Sourcing event

▪ Negotiation

▪ Purchase requisition

b. Select the link to the record under the Number 
column to open it.

c. Select Related work  > Purchasing Tasks.

d. Select New.

4. On the Create new task dialog box, select Procurement task  from the Task type  list.

5. Select Submit.

6. On the form, fill in the fields.
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Procurement Task

Field Description

Number System-generated unique identifier for the 
task.

Task type Type of task based on the requirement.

Action type for task Type of action that the shopper must 
complete for this task to progress. The 
options are:

◦ Mark complete

◦ View link

◦ Play video

◦ Upload documents

◦ Complete a form

◦ Sign document

Note: 

◦ For View link or Play video action 
types, the required URL  field must be 
populated with the desired link.

◦ For the Complete a form action type, 
the required Catalog item  field must 
be populated with the desired form or 
catalog item that is to be completed.

◦ For the Sign document action type, 
the required Document template  field 
must be populated with the desired 
preconfigured template that is to be 
sent for signing.

Assignment group Group to which the task is assigned to.

Assigned to Person within the assignment group to whom 
the task is assigned to.

Note:  You must assign the action type 
to the concerned shopper or employee 
for them to find it in their tasks list.

State Current state the task is in.

Note:  The assigned to shopper 
or employee can view this task in 
Employee Center  or Shopping Hub  only 
when the status of the task is updated 
to Work in Progress.

Due date Expected date and time by when the task is 
expected to be resolved.
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Field Description

Sourcing decision dependent on task Whether any sourcing decision is dependent 
on the task.

Note:  This field is displayed only if a 
related sourcing request is entered.​

Qualification dependent on task Whether any qualification is dependent on 
the task.

Note:  This field is displayed only if a 
related sourcing request is entered.​

Order dependent on task Whether the order is dependent on the task.

Note:  This field is displayed only if a 
related purchase requisition is entered.​

Short description Brief description of the task.

Description Detailed description of the task.

Summary Details

Related case Case associated with the task.

Sourcing request Sourcing request associated with the task.

Purchase requisition Purchase requisition associated with the task.

Purchase order Purchase order associated with the task.

Expected start Date and time by when work is expected to 
start on the task.

Actual start Date and time when work actually starts on 
the task.

Actual end Date and time when work actually completes 
on the task.

Duration Time taken to resolve the task, in days, hours, 
minutes, and seconds.

7. Select Save.

8. Select Send to assignee  to send the task to the assigned shopper or employee's queue.
If you have created a procurement task with action type as Sign document, a document task is 
automatically created and assigned to the selected shopper or employee.

Add a sourcing request to a sourcing event

You can manage multi-supplier and multi-product negotiations by mapping similar sourcing 
requests and related negotiations to a sourcing event.

Before you begin
Role required: sn_shop.procurement_specialist
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Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the list page, navigate to All work  > Sourcing Requests.

3. Select the sourcing request that you plan to add to a sourcing event.

4. Select Add to sourcing event.

5. In the Add to sourcing event dialog box, select whether you would like to add the sourcing 
request to an existing or new sourcing event.

◦ If adding to an existing sourcing event, select the sourcing event from the Sourcing events 
list. The Supplier response close  field is auto-populated with the supplier response close 
date specified in the existing sourcing event that you're adding the sourcing request to.

◦ If adding to a new sourcing event:

a. Enter a short description for the sourcing event in the Short description  field.

b. Select the method used to engage with the supplier from the Negotiation type  field. The 
options are Quote, RFx, Contract Renewal, and Other.

c. Select the anticipated outcome or end results of the negotiation event from the 
Negotiation outcome  field. The options are Standard Savings, Contract Terms Negotiated, 
Cost Avoidance, and Negotiation Unsuccessful.

d. The Expected start  field gets auto-populated with the current date. However, you can 
select your expected start date from the calendar icon if necessary.

e. The supplier response close date specified in the sourcing request is auto-populated in 
the Supplier response close  field. If the sourcing manager changes the supplier response 
deadline for a new sourcing event, the sourcing request also reflects this updated date.

Note:  When adding multiple sourcing requests to a new sourcing event, the 
furthest date among those requests is used to populate the Supplier response close 
field.

6. Select Add.

Result
A new sourcing event is created, which is attached to the selected sourcing request.

What to do next
View an overview of the sourcing event in the Overview  tab, and other associated information 
in relevant tabs such as Details, Negotiations, Sourcing Requests, Purchase Lines, Cases, 
Purchasing Tasks, and Contracts.

You can add more sourcing requests to this sourcing event by selecting Add sourcing request. 
Negotiation records are automatically created for each supplier in the sourcing request. You can 
add more suppliers to this sourcing event as well. For more information, see Work on a sourcing 
event.

In compliance with fair competition laws, qualify all your suppliers in that sourcing event before 
you start negotiating with any of them. For more information, see Supplier qualification.

Work on a sourcing event

You can work on a sourcing event and complete an entire workflow, right from starting 
negotiations with multiple suppliers, to awarding one or multiple suppliers, or rejecting bids. 
Awarding suppliers create purchase requisitions for the selected suppliers and items.
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Before you begin
Ensure that you’ve qualified all the suppliers involved in the sourcing event before you start 
negotiating with them. You can add additional relevant sourcing requests and qualified suppliers 
to the ongoing sourcing event, as and when required, when working on the event. This allows you 
to manage complex negotiation activities. Adding a sourcing request or supplier auto-creates 
purchase lines and creates a new negotiation record to manage negotiation activities for that 
specific supplier.

Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the list page, navigate to Review Needed  > Sourcing event: ready to negotiate.

3. Select and open the sourcing event that you plan to work on.

4. Select Start negotiating.
The sourcing event moves to the Work in Progress state.

5. Optional:  Select Add sourcing requests  if you want to add more similar sourcing requests to 
this sourcing event.

6. Optional:  Select Add suppliers  if you want to add more suppliers to this sourcing event.

7. On the Purchase Lines  tab, update the Negotiated unit cost  field for each purchase line.
This moves the purchase request lines to the Pricing Obtained state.

8. On the Negotiations  tab, select Finish negotiating  for each negotiation.
This moves the sourcing event and all its associated negotiations, sourcing requests, and 
purchase lines to the Requires Decision state.

9. Do one of these actions.

Action Description

Save
Saves the details of the sourcing event for fur­
ther action.

Cancel

Cancels the sourcing event and moves all 
its negotiations and associated sourcing re­
quests and purchase lines to the Closed Can­
celled state. This sourcing event is no longer 
considered for the awarding process.

Award single supplier

Opens the Select a supplier to award  dialog 
box, where you can select one of the suppli­
ers from the list and select OK  to award the 
supplier. The awarded negotiation moves to 
the Closed Decided state while all the others 
move to Closed Rejected. The purchase lines 
for the awarded negotiation are automatically 
converted to purchase requisitions.

Award multiple suppliers

Opens the Award suppliers  tab, where you 
can select one or more suppliers from the list 
and select Review selection  to award the sup­
pliers. The awarded negotiations move to the 
Closed Decided state while the others move 
to Closed Rejected. The purchase lines for 
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Action Description

the awarded negotiation are automatically 
converted to purchase requisitions.

For information on more options that are avail­
able to you on this tab, see Award multiple 
suppliers from a sourcing event.

Reject bids

Opens the Reject all bids?  dialog box, where 
you must enter your reason for rejection to 
reject all the bids. The sourcing event and 
all its negotiations and associated sourcing 
requests and purchase lines move to the 
Closed Rejected state.

10. Select View purchase requisitions  from the sourcing event or the awarded negotiation to view 
the details of the newly created purchase requisitions.

Award multiple suppliers from a sourcing event

When negotiations are complete for a sourcing event, you can award one or multiple suppliers 
from the sourcing event, or reject all bids, as required. Awarding suppliers create purchase 
requisitions for the selected suppliers and items.

Before you begin
Ensure that you’ve qualified all the relevant suppliers, and have received all the bids and 
responses from them, before you begin the awarding process. At this point, the sourcing event 
that you plan to work on, and all its associated negotiations, sourcing requests, and purchase 
lines must be in the Requires Decision state.

Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. On the list page, navigate to All work  > Sourcing events.

3. Select and open the sourcing event that you plan to work on.
The Details  page is displayed with a list of all the negotiations, suppliers, state, and negotiation 
outcome.

4. From the Award single supplier  list, select Award multiple suppliers.
The Award suppliers  tab is displayed with all the supplier bids and responses grouped by 
products, with details of the requester’s intake.

5. Do one of the following.

◦ Select Review selection  without making any selection for any product. A dialog box is 
displayed with a message alerting you that you haven't made any selection. Selecting 
Continue  rejects all the bids.

◦ Select Review selection  without making at least one selection for all the products. A dialog 
box is displayed with a message alerting you that you haven't made a selection for all the 
products. Selecting Continue  awards the selected suppliers and rejects all the unselected 
bids.

◦ Select None, reject bids  for all the products, and then select Review selection. The Reject 
all bids?  dialog box is displayed where you must enter your reason for rejection. Selecting 
Reject all bids  rejects all the bids.
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◦ Select at least one supplier for all the products, except one whose bids you reject, and 
then select Review selection. The Here's what you selected  dialog box is displayed with a 
summary of your selection. Selecting Submit  awards the selected suppliers and rejects all 
the unselected bids.

Note:  The sourcing event is moved to Closed Complete, with the individual negotiations 
under it moved to Closed Decided or Closed Rejected based on your selection. The 
awarded sourcing requests are moved to Closed Complete, with purchase requisitions 
automatically created for the purchase lines. All the other sourcing requests are moved to 
the Closed Rejected state.

Create a knowledge base article about procurement

Create a knowledge base article about procurement so that you can share procurement 
information and policies with your employees and procurement team.

Before you begin
Role required: sn_spend_psd.agent, sn_spend_psd.admin

Procedure

1. Navigate to All  > Procurement Case Management  > Knowledge.

2. Select Create New Article.

3. On the form, fill in the fields.

Field Description

Number System-generated unique identifier for the 
request.

Knowledge base Knowledge base to which this article belongs.

Category Category of the article such as procurement 
policy. Use the category picker to select an 
existing category or subcategory. You can 
create a category or subcategory to suit your 
requirements.

Valid to Validity of the article.

Article type Type of article such as HTML.

Workflow Status of the article.

Source Task Name of the article source.

Attachment link Link to attachments.

Display attachments Display of attachments in the article. When 
you do not select this option, the article does 
not display the attachments.

Short description Short description of the article.

Article body Detailed description of the article.

4. Optional:  To check if any duplicate articles are available with similar short descriptions, select 
Search for Duplicates.

5. Do one of these actions.
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Action Description

Submit To submit an article for review, select Submit.

Save
To save an article, from the Additional actions 
menu, select Save.

What to do next

• View your submitted articles by navigating to Knowledge  > My Knowledge Articles

• Track the progress of your article from My Knowledge Articles.

• Manage the article workflows, such as reviewing, publishing, updating, or retiring the article.

• Monitor the performance metrics of your article by navigating to Procurement Case 
Management  > PSM Dashboards.

Working with Sourcing and Procurement Operations  playbooks in the Source-
to-Pay Workspace

Playbooks provide a streamlined and consistent way of accomplishing various tasks, such as 
editing a purchase order, editing a purchase requisition, approving or rejecting cancellation 
requests, and so on.

Process a purchase order edit in playbook

You can edit and revise the quantity of the product or delivery location of the purchase orders 
based on your requirements.

Before you begin
Role required: sn_spend_psd.requestor, administrator

About this task
As an agent, you can view the requests, complete tasks across multiple workflow activities, 
and manage complex operations from a unified playbook. The playbook  provides agents an 
automated way to visualize the overall process in a task-oriented format.

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select the case of type Edit a purchase order.

Note:  With the revision request raised, the state has been changed to Pending Revision 
for both the purchase order and purchase order line. Remember that the Edit  option is 
unavailable for purchases in the Close state.

4. Complete the steps in the various stages and activities of the Edit a purchase order playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep the 
case assigned to you.

You can do the following:
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Stage Activity Activity Details

◦ In the Assigned to  search field, search for and select the person 
that you want to assign the case to.

◦ In the Short description  field, update the description for the 
case.

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Lookup 
procurement 
case line

This activity provides more information on the service request, 
purchase request, and purchase request line items.

Select Details about changes to this purchase  to review the 
changes.

Intake 
and 
Assess

Buyer confirm 
or reject 
request to 
edit PO

Review this request to edit the purchase order and confirm or reject 
whether it can be processed.

Select one of the following actions.

◦ Confirm: When you confirm, you can check the revised the 
purchase order or purchase order line. On successful update, the 
request is automatically closed.

◦ Reject: When you reject, you must contact the supplier and 
confirm whether the order can be rejected. When the supplier 
allows cancellation, the request changes to Closed Rejected 
state.

Update POLs 
to pending 
revision state

Updates the POLs state to pending revision until the PR of type 
revision is approved and the PO is updated.

Process 
PO Edit

Create PR of 
type Revision

Creates a PR of type revision with the Shopper's changes to the PO.

Send 
business 
owner 
confirmation 
email

Sends the business owner confirmation that lines from their 
purchase order have been successfully edited using Shopping Hub 
email template.

Complete 
case Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Close 
case

Update case 
to complete

After the PO has been updated, the request to edit the purchase 
order is automatically closed.
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Result
The request updates the purchase order or line item with revised quantity, location, delivery 
dates, or service dates. A new card of revision type is also created for the shopper and approvers 
to communicate on, which can be viewed by the shopper from My purchases.

What to do next
Review and confirm your purchase request details from Procurement Case Management  > 
Procurement Cases  > Purchase Requisitions  > Purchase lines, if required.

Related topics

Purchase revision flows

Purchase revision roles and responsibilities

Playbooks  

Process a purchase requisition edit request in playbook

Use the procurement playbook to approve or reject the revision requests for the quantity of the 
product or delivery location.

Before you begin
Role required: sn_spend_psd.admin, agents, fulfillers

About this task
As an agent, you can view the requests, complete tasks across multiple workflow activities, 
and manage complex operations from a unified playbook. The playbook provides agents an 
automated way to visualize the overall process in a task-oriented format.

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select a case of type Edit a purchase.

Note:  With the revision request raised, the state has been changed to Pending Revision 
for both the purchase requisition and purchase line. Remember that the Edit  option is 
unavailable for purchases in the Close state. You can view all the associated information 
in the Details  tab, and information on the procurement case lines, tasks, and original 
purchase in the Procurement Case Lines, Purchasing Tasks, Related work, and 
Original purchase  tabs.

The Playbook  tab opens with the Edit a purchase requisition  section.

4. Complete the steps in the various stages and activities of the Edit a purchase requisition 
playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep the 
case assigned to you.

You can do the following:

◦ In the Assigned to  search field, search for and select the person 
that you want to assign the case to.

◦ In the Short description  field, update the description for the case.
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Stage Activity Activity Details

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Modifications 
requested by 
shopper

This activity completes automatically.Intake 
and 
Assess

Confirm 
or reject 
request to 
edit PR

This activity enables you to review the initial request, confirm or 
reject the request to edit the PR. The available options are:

◦ Confirm: When you confirm, you can check the revised the 
purchase request or purchase request line with updated quantity 
and location. On successful update, the request to edit a 
purchase request is automatically closed.

◦ Reject: When you reject, you must contact the supplier and 
confirm whether the order can be rejected. When a supplier 
allows cancellation, the request changes to Closed Rejected 
state.

Process 
PR Edit

Update PR 
with new 
details

This activity updates the PR with new details and completes 
automatically.

Notify the 
requestor Use this activity to email the business owner confirming that lines 

from their purchase requisition have been successfully edited.

A draft email appears with pre-populated data in the Subject  field. 
The email body is pre-populated with the relevant text.

Select Send Email  to send the email.

Complete 
case Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Close 
case

Update case 
to complete

After the PR has been updated, the request to edit a PR is 
automatically closed.

Result
The request updates the purchase requisition or line item with revised quantity or location. A new 
card of revision type is also created for the shopper and approvers to communicate on, which 
can be viewed by the shopper from My purchases.

Related topics

Purchase revision flows

Purchase revision roles and responsibilities

Playbooks  
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Process a return request in playbook

Use the procurement playbook to approve or reject return requests.

Before you begin
Role required: sn_spend_psd.admin, agents, fulfillers

About this task
As an agent, you can view the requests, complete tasks across multiple workflow activities, 
and manage complex operations from a unified playbook. The playbook provides agents an 
automated way to visualize the overall process in a task-oriented format.
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Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select the request number from the list for further processing.

4. Complete the steps in the various stages and activities of the Return a purchase playbook.
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Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep 
the case assigned to you.

In the Assigned to  search field, select a procurement specialist to 
work on this case.

Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Lookup 
procurement 
case lines

Look up procurement case line associated with this return 
request for use later in the process.

Intake and 
Assess

Assign 
return 
request

Return request is automatically assigned to the buyer assigned to 
the original purchase.

Confirm 
return and 
collect 
information

Contact the supplier, confirm the return, and collect the 
necessary information.

Select to verify and process the information about the request.

◦ Confirm: After you verify that return is feasible, confirm the 
request. When confirmed, the request moves to the Work in 
progress state. You can now send an email to the business 
owner confirming that the return request has been initiated.

◦ Reject: When you reject the return request, the request moves 
to the Closed Rejected state. You can now close the case by 
sending an email to the business owner confirming that the 
return request has been rejected.

Get POLs 
from Service 
Case

Updates state of Purchase Order Lines to pending return.

Coordinate 
with 
Supplier

Send 
business 
owner email 
confirming 
return

Sends the business owner confirmation that after reviewing the 
return and coordinating with supplier, the return is feasible.

Reverse 
goods 
receipt

Creates a receipt type for the goods that are to be shipped back 
to the supplier. This receipt is recorded on the purchase order 
record. If you skip this step, the request moves to the Closed 
Rejected state. You can then close the case by sending an email 
to the business owner confirming that the return request has 
been rejected.

Create 
return

Creates a receipt of type return.

Reverse 
Goods 
Receipt

Set POL 
status after 
return

Updates the POL status to appropriate state based on the 
Returned and Accepted quantities.
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Stage Activity Activity Details

Create Debit 
Memo / Skip

Creates a debit memo invoice for this return. This debit memo is 
recorded on the purchase order record. If the invoice for these 
returned goods is yet to be paid, a debit memo isn’t required. You 
may choose to skip this step, if required.

Create 
invoice of 
type debit 
memo

Creates a debit memo.

Create 
Debit 
Memo

Create 
invoice line 
for debit 
memo

Creates an invoice line associated with debit memo in Shopping 
Hub.

Retire 
Assets

Any associated assets or fixed assets created during purchase 
order creation are revised based on the quantity of the returned 
products. The states of these assets and fixed assets are updated 
to Retired and Pending Deletion respectively.

Send 
business 
owner email 
confirming 
successful 
return

Sends the business owner confirmation that their return has been 
processed successfully.

Complete 
case Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.

Close case

Update case 
to complete

Updates the case to Closed Completed.

Process a replacement request in playbook

Use the procurement playbook to approve or reject replacement requests.

Before you begin
Role required: sn_spend_psd.admin, agents, fulfillers

About this task
As an agent, you can view the requests, complete tasks across multiple workflow activities, 
and manage complex operations from a unified playbook. The playbook provides agents an 
automated way to visualize the overall process in a task-oriented format.
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Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.
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3. Select the Replace a purchase case from the list for further processing.

4. Complete the steps in the various stages and activities of the Replace a purchase playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep 
the case assigned to you.

In the Assigned to  search field, select a procurement specialist 
to work on this case.

Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Lookup 
procurement 
case lines

Look up procurement case line associated with this 
replacement request for use later in the process.

Intake and 
Assess

Assign 
replacement 
request

Replacement request is automatically assigned to the buyer 
assigned to the original purchase.

Confirm 
replacement 
and collect 
information

Contact the supplier, confirm the replacement, and collect the 
necessary information.

Select to verify and process the information about the request.

◦ Confirm: After you verify that replacement is feasible, 
confirm the request. When confirmed, the request moves to 
the Work in progress state. You can now send an email to the 
business owner confirming that the replacement request has 
been initiated.

◦ Reject: When you reject the replacement request, the 
request moves to the Closed Rejected state. You can now 
close the case by sending an email to the business owner 
confirming that the replacement request has been rejected.

Coordinate 
with 
Supplier

Send business 
owner email 
confirming 
replacement 
acceptance

Sends the business owner confirmation that after reviewing 
the replacement request and coordinating with supplier, the 
replacement is feasible.

Notify the 
requestor

Sends the business owner confirmation that their replacement 
has been processed successfully.

Complete case
Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.

Close case

Update case to 
complete

Updates the case to Closed Completed.
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Process an edit receipt request in playbook

You can revise previously approved receipts to correct any discrepancies, ensuring the delivery 
receipt accurately reflects the quantities received for a specific purchase order.

Before you begin
Role required: Fulfiller, agent, or admin

About this task
As a fulfiller, you can review the details of the Edit Receipt request and choose to either confirm 
or reject it.

Note:  This task is not required if the 
sn_spend_cp.enable_automated_edit_receipt_flow  system property is 
enabled. For more information, see Components installed with Sourcing and Procurement 
Operations.

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select the case of type Edit a receipt.

4. Complete the steps in the various stages and activities of the Edit a receipt playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep 
the case assigned to you.

You can do the following:

◦ In the Assigned to  search field, search for and select the 
person that you want to assign the case to.

◦ In the Case type:  field, leave the default value as-is.

◦ In the Short description  field, add a brief description for the 
case.

◦ In the Description  field, add a detailed description for the 
case.
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Stage Activity Activity Details

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Intake 
and 
Assess

Modifications 
requested by 
shopper

Review the changes requested by the shopper on the delivery 
receipt.

Confirm edit Review this request to edit the delivery receipt and confirm or 
reject whether it can be processed.

Select one of the following actions.

◦ Confirm: When you confirm, the procurement case moves to 
Work in progress state.

◦ Reject: When you reject, the procurement case moves to 
Closed Rejected state.

Edit delivery 
receipt

Updates the delivery receipt with the changes requested by 
the shopper

Review 
and 
confirm

Update purchase 
order line

Updates the purchase order line with the quantity of items 
received, as specified by the shopper.

Notify the 
requester Use this activity to email the business owner confirming that 

lines from their purchase requisition have been successfully 
edited.

A draft email appears with pre-populated data in the Subject 
field. The email body is pre-populated with the relevant text.

Select Send Email  to send the email.

Close 
case

Complete case
Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Fulfilling request for copy of contract in playbook

Reduce manual effort by providing your procurement specialist with a playbook for attaching the 
contract from and sending it as an email to the employee who requested for it.

If an employee requires a copy of a contract they have access to, they can submit a request for 
the same from Employee Center  by navigating to Purchase and expense  > Purchase Requests 
> Request a copy of contract. A procurement case of type Request a copy of contract is created 
for the procurement specialist to work on, in Source-to-Pay Workspace. The procurement 
specialist can attach a copy of the contract from a playbook and send it as an email to the 
employee who requested for it. This reduces a lot of manual effort and provides the procurement 
specialist a single place to perform all the necessary actions.​
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Fulfill request for copy of contract in playbook

Attach a copy of the contract from a playbook and send it as an email to the employee who 
requested for it.

Before you begin
Role required: Procurement specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select the applicable Request a copy of contract case from the list for further processing.

4. Complete the steps in the various stages and activities of the Verify and approve delivery 
address playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or 
keep the case assigned to you.

In the Assigned to  search field, select a procurement 
specialist to work on this case.

Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.
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Stage Activity Activity Details

Collect contract 
details properties

This is an automated step to get the contract details from 
submitted case.

Review/attach 
contract properties

Find and review the contract as specified in request.

If a contract is already attached to this case, it’s displayed 
here. The procurement specialist can open and view the 
contract and verify the details, if necessary.

Send a 
copy of 
contract

Find and attach 
contract when 
contract number is 
not specified

Find and attach contract when contract number is not 
specified.

Select Compose email  to draft the email for the employee.

Select Add File  to browse and attach the contract file to the 
email.

Consider these scenarios:

◦ If a contract number is specified in the request, and an 
attachment exists for that contract in the contract record, 
attach the requested contract number to the email.

◦ If a contract number is specified in the request, but an 
attachment doesn't exist for that contract in the contract 
record, find the file for the contract number and attach it to 
the email.

◦ If a contract number isn't specified in the request, and only 
details are mentioned, find the contract as described by 
the requester and attach it to the email.

Select Send Email  to send the email for the employee.

Select Done.

Complete case
Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the 
case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Close 
case

Update case to 
complete

The request is now fulfilled and the procurement case moves 
to the Closed Completed state.

Routing NDAs to suppliers

Reduce manual effort by providing your procurement specialist with a single place to perform 
all the necessary actions when creating and routing Non-Disclosure Agreements (NDAs) to 
suppliers and third parties.

As a procurement specialist, you can easily define your NDA content and update signer 
details with the help of a document template that is provided by default with the Document 
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Template plugin [sn_doc], which is added as a dependency on Procurement Case Management 
[com.sn_spend_psd]. The signer details are stored in the Signers table.​

Note:  You must use the November 2023 version of the Document Template plugin 
[sn_doc] for using the November 2023 versions of the Procurement Case Management  and 
Playbooks for Sourcing and Procurement Operations  plugins.

Further, procurement specialists can easily route the NDAs to suppliers and third parties for 
signing via DocuSign integration, review the signed documents, and close the procurement case 
of type Send NDA for Signature, from a designated playbook in Source-to-Pay Workspace.

Details of the workflow are provided here.

1. Define your NDA content and update the list of participants for signature. See Define NDA 
content and update the list of signers.

2. Set up DocuSign.

For more information, see Docusign eSignature Spoke .

3. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

4. Select the list icon and select All team work  > Cases.

5. Select New.

6. In the Create a new case dialog box, select Send NDA for Signature.

7. Select Create Case.

Note:  During a procurement request, when a valid NDA isn’t available for the selected 
supplier, a procurement case of type Send NDA for Signature is automatically created.

8. Open the case in Source-to-Pay Workspace, prepare the NDA, and send it for signing to the 
suppliers and third parties from a playbook. See Send NDA to suppliers for signature.

Note:  If the Playbook  tab isn’t visible in Source-to-Pay Workspace, verify that the 
Document Template Integration with DocuSign application is installed correctly.

9. Sign the NDA.

◦ For external third-party suppliers, directly sign from the email notification  or from Supplier 
Collaboration Portal. For more information, see Using Supplier Collaboration Portal.

◦ For internal supplier representatives, from Employee Center. For more information, see Sign 
a document using DocuSign from Employee Center.

10. Review the signatures from the playbook in Source-to-Pay Workspace, notify the user, and 
close the case. See Send NDA to suppliers for signature.

Additional configurations

You can make changes to the Send NDA for signature playbook, if you must, from Playbooks.

For adding new participants, create a new column on the procurement case and update the 
logic to populate in Playbooks. For more information, refer to the implementation of the signer_1 
column.

You can also update the subflows to incorporate any new logic. Flow details can be found in 
different steps in Playbooks.
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Define NDA content and update the list of signers

As a procurement specialist, you can easily define your Non-Disclosure Agreement (NDA) 
content and update the list of participants for whose signature is required.

Before you begin
Procurement specialists can do this with the help of a document template that is provided 
by default with the Document Template plugin [sn_doc], which is added as a dependency on 
Procurement Case Management  [com.sn_spend_psd]. The signer details are stored in the 
Signers table.​

Note:  You must use the November 2023 version of the Document Template plugin 
[sn_doc] for using the November 2023 versions of the Procurement Case Management  and 
Playbooks for Sourcing and Procurement Operations  plugins.

Role required: Procurement specialist

Procedure

1. Navigate to All  > Document Templates  > All Document Templates.

2. Select and open the Supplier NDA draft template.
A sample NDA template that is provided by default is displayed.

3. In the Table  field, select the required table.

Note:  Depending on the table you select, the variables that you can use in the body of 
your NDA content are displayed.

4. In the Signing type  field, select DocuSign.

5. In the Participants  related list, provide these details.

◦ Internal Signer: Select the user.

◦ External Signer 1: Select the signer 1 authorized signatory name and email.

6. Select Update.

Send NDA to suppliers for signature

As a procurement specialist, you can use playbooks to prepare a Non-Disclosure Agreement 
(NDA) and send it for signing to the suppliers and third parties and review the signed and 
completed NDA.

Before you begin
Role required: Procurement specialist

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the list icon and select All work  > Cases.

3. Select the applicable Send NDA for Signature case from the list for further processing.

4. Complete the steps in the various stages and activities of the Send NDA for signature 
playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or 
keep the case assigned to you.
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Stage Activity Activity Details

You can do the following:

◦ In the Assigned to  search field, search for and select the 
person that you want to assign the case to.

◦ In the Short description  field, update the description for the 
case.

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Update case 
to Work in 
progress

Updates the case state to Work in progress

Select 
document 
tamplte

In the Document template  field, select Supplier NDA draft.

Select Continue.

Identify internal 
signer

In the Internal Signer  field, select the name of the signer.

Select Continue.

Identify 
supplier's signer

Do the following:

◦ In the Supplier contact  field, enter the name of the supplier 
contact.

◦ In the Signatory email  field, enter a valid email ID of the 
supplier or third-party signer.

◦ In the Signatory title  field, enter a title for the supplier or 
third-party signer.

◦ In the Authorized signatory name  field, enter the name of 
the supplier or third-party signer.

Select Save.

Signer details 
are updated on 
procurement 
case

The details are added to the procurement case.

Get signer 
details

The signer details are displayed.

Review signers Review the signer details and select Save and create NDA.

An NDA is created with the document template that was 
defined in Define NDA content and update the list of signers. 
A contract is also created in parallel and displayed here.

Create contract 
and update 
case

Creates a contract and updates the procurement case.

Prepare 
NDA

Review 
document

Review the NDA and check that all details are correct before 
sending it for signing.
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Stage Activity Activity Details

Send document 
for signature Select Send NDA  to send the NDA for signing to the suppliers 

and third parties.

The NDA is sent to the signers and corresponding document 
tasks are automatically created for them.

Note:  If document tasks are not getting created, verify 
that the integration with DocuSign is set up correctly.​

Review 
completed 
NDA

Wait for the NDS 
to be signed 
and completed

Check if you have received the signed document. Open and 
verify the signed NDA attachment for completion and select 
Continue.

Notify the 
requestor Email the requestor that the NDA has been signed.

A draft email appears with pre-populated data in the Subject 
field. The email body is pre-populated with the relevant text.

Select Send Email  to send the email.

Complete case
Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.

Close 
case

Update case to 
complete

Updates the case to Closed Completed.

Verifying delivery addresses in playbook

Procurement specialists can verify delivery addresses and notify shoppers through email for 
delivery address-related updates using playbook.

As a procurement specialist or an agent, you can check and approve delivery addresses 
provided by shoppers. With playbook, you can visualize the end-to-end address verification 
process in a task-oriented format. First, you manually verify the address provided by the shopper 
against the supplier company's addresses available in the delivery locations table. If the 
shopper's address is invalid or missing, you can request that the shopper provide the correct 
address through an email. The shopper then updates the address details in the purchase order 
line. For more information about editing a purchase line, see Edit a purchase order line.

The activity stream, which tracks the interactions between a shopper and an agent, notifies you 
when the shopper updates the address in the purchase order line.

Review delivery address in playbook

Verify a delivery address presented through the playbook by evaluating the address against 
supplier addresses and indicating whether it’s valid.

Before you begin
Role required: Fulfiller, agent
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Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Open a procurement case with filter criteria set to Delivery Address Review  and the State  set 
to In review.

4. Complete the steps in the various stages and activities of the Verify and approve delivery 
address playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person 
or keep the case assigned to you.

You can do the following:

◦ In the Assigned to  search field, search for and select 
the person that you want to assign the case to.

◦ In the Short description  field, update the description 
for the case.

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.
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Stage Activity Activity Details

Verify and 
approve 
address

Check that the 
address is verified and 
company approved

This activity enables you to review the delivery address 
and indicate if it is verified and company approved.

The options are:

◦ Not verified:Select this option if the address provided 
by the shopper is invalid and can’t be verified.

◦ Verified but not approved: Select this option if the 
address provided by the shopper is valid but isn't 
approved by the supplier company.

◦ Verified and approved: Select this option if the 
address provided by the shopper is valid and 
approved by the supplier company.

Notify the requestor
Use this activity to email the requestor about the status 
of the delivery address verification and approval.

A draft email appears with pre-populated data in the 
Subject  field. The email body is pre-populated with the 
relevant text.

Select one of the following actions:

◦ Send Email: Sends the email instantly.

◦ Skip: Skips this activity and moves to the next activity.

Close 
case

Complete case
Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the 
case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Result
The procurement case is updated with valid address and its state updates to Closed Completed.

Reviewing and updating general ledger details in playbook

As a fulfiller working in the procurement team, you can review and update missing General 
Ledger (GL) account details using playbook.

If a shopper checks out multiple products from a single supplier, multiple purchase requisition 
lines are generated that can contain missing GL accounting details. The purchase requisition 
lines with missing GL accounting details are auto-populated in a playbook associated with the 
purchase requisition in the procurement case.

Review and update missing general ledger details in playbook

Review and update missing General Ledger (GL) accounting details through the procurement 
playbook. If a shopper checks out multiple products from a single supplier, multiple Purchase 
Requisition Lines (PRLs) are generated, some of which could potentially contain missing GL 
accounting details.
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Before you begin
Role required: Fulfiller, agent

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select

3. All work  > Cases.

4. Open a procurement case with filter criteria set to GL Coding Review  and the State  set to In 
review.

5. Complete the steps in the various stages and activities of the Verify and approve accounting 
fields on PRL playbook.

Stage Activity Activity Details

Review case Assign case Use this activity to assign the case to a different person or 
keep the case assigned to you.

You can do the following:

◦ In the Assigned to  search field, search for and select the 
person that you want to assign the case to.

◦ In the Short description  field, update the description for 
the case.

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Verify and 
approve 
accounting 
fields on PRL

Review PRLs 
with missing 
GL account 
informaiton

This activity enables you to review and update the PRLs.

Select a PRL, review the missing GL accounting details, 
update them, and then select Save. Some examples of 
possible missing information include Capex, expense and 
pre-payment accounts.

The PRL is updated with GL accounting details.

The options are:
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Stage Activity Activity Details

◦ Continue: Select this option to move to the next stage and 
activity.

◦ Open List: Select this option to view a list of PRLs.

Notify the 
requestor Use this activity to email the requestor that the accounting 

fields on PRL have been verified and approved.

A draft email appears with pre-populated data in the Subject 
field. The email body is pre-populated with the relevant text.

Select one of the following actions:

◦ Send Email: Sends the email instantly.

◦ Skip: Skips this activity and moves to the next activity.

Close case

Complete 
case Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.
Updates the case to Closed Completed.

Result
The procurement case is updated with valid GL account details and the playbook is closed.

Sourcing intake guided experience with playbooks

As sourcing managers, you can use the sourcing intake and negotiation setup playbooks 
to guide you through the complex request intake process so that you can focus on actual 
productive work such as negotiating savings from suppliers.

The sourcing intake playbook and the negotiation setup playbook embedded in the sourcing 
intake playbook as a flow, guide you through these actions with clear steps to view your progress.

Here's a quick breakdown of the playbooks and their associated tasks.
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Sourcing intake playbook

The sourcing request playbook, also known as the sourcing intake playbook, enables you to:

• Review an employee or requester’s requirements, which include details of the sourcing intake, 
purchase lines, and approvals.

• Request clarifications or more information from the requester, if necessary.

• Collaborate with cross-functional teams and create other work such as tasks and cases for 
them, if necessary.​
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For more information on how to perform these actions on the sourcing intake playbook, see 
Review details and request clarification on a sourcing request in playbook.

• Decide if you should negotiate in a sourcing event or not.

Here, as the sourcing manager, you can select a sourcing approach to source with similar 
employee requests. You can decide whether to work on negotiations with suppliers right away 
or at a later stage. In case of the former, you must add the sourcing request to a new or existing 
sourcing event to proceed.

For more information on how to perform these actions on the sourcing intake playbook, see 
Select a sourcing approach in playbook.

Note:  If you have skipped negotiations at this stage, you have the option to work on 
negotiations after the qualification is complete. You can add the sourcing request to an 
exiting sourcing event or create a new sourcing event as required, before working with 
the sourcing event.

Negotiation setup playbook

The sourcing event playbook, also known as the negotiation setup playbook, enables you to:

• Review and add sourcing requests and purchase lines, if necessary.

• Review and add suppliers, if necessary.

• Manage qualification work.

For more information on this, see Set up negotiations with suppliers and manage qualifications 
in playbook.

Note:  This action in available in both the playbooks, depending on when you want to 
get started with managing qualification work.

Configurations

The playbook stages and activities of sourcing requests and sourcing events can be modified by 
the customer from Playbooks. The Declarative Actions can be edited or newly created, and their 
mappings modified in the Activity Definition section. The look and feel of the activities can also 
be configured from Activity Experience in the Activity Definition section.​

For details on how administrators, agents, and fulfillers can configure playbooks, see Running 
playbooks . For more information on Playbooks  stages and activities, see Stages and 
activities .
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Troubleshooting

If your playbook activities aren’t working as expected, perform these actions.

1. Navigate to the respective process in Playbooks. For sourcing requests and sourcing events, 
the processes are Sourcing Intake and Negotiation Setup respectively.​

2. Within the process, go to the corresponding activity that is not working as expected. For 
example, in the Sourcing approach section, which is the second stage of the playbook:

◦ If stage 2.1 is skipped, it should go to the Qualification workflow.​

◦ If stage 2.1 is completed, it should go to the Add to an existing negotiation workflow.​

◦ If stage 2.1 is canceled, it should go to the Create new sourcing event workflow.​

3. Under the Automation  tab, navigate to the corresponding subflow in Workflow Studio.​

4. Open the executions of the subflow and check further.​

5. To check the activity experiences, go to the sys_pd_process_definition table and check the 
process configurations. This table contains all the activity definition configurations and action 
mappings for Declarative Actions.​

Review details and request clarification on a sourcing request in playbook

Get complete clarity on a sourcing request by reviewing the intake details, purchase lines, and 
approvals, and requesting clarification on the request, if necessary. You can perform these 
actions from the Request details section of the sourcing intake playbook.

Before you begin
Role required: Sourcing manager

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Sourcing Requests.

3. Open the sourcing request that you want to work with.

You can also pick the sourcing request that you want to work with from the workspace landing 
page.

Note:  To work on the sourcing intake playbook, the sourcing request must be in the 
Pending Review state.

4. Review the sourcing request details and update them, if necessary.

5. Select Continue.

6. Review the details of the purchase lines within the sourcing request.

7. Select Continue.

8. Review whether the requester has all the required approvals for this sourcing request.

9. Select Continue.

10. Review all the cases and tasks related to this sourcing request.

11. Optional:  To reach out to the appropriate teams for additional clarification on this sourcing 
request:

a. Select Create a type of work.

b. On the Create a type of work pop-up window, select the required case or task.
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c. Select Create.

d. Select Save  to save the case or task and add it to the sourcing request.

12. Select Continue.

What to do next
Decide if you want to negotiate with suppliers right away, or skip this step and start qualifying the 
sourcing request instead. You can perform these actions from the Sourcing approach section of 
the sourcing intake playbook. For details, see Select a sourcing approach in playbook. For more 
information about the qualification process, see Supplier qualification.

Select a sourcing approach in playbook

Decide if you want to negotiate with suppliers right away, or skip this step and start qualifying the 
sourcing request instead. You can perform these actions from the Sourcing approach section of 
the sourcing intake playbook.

Before you begin
Role required: Sourcing manager

Ensure that you have complete clarity on the sourcing request by reviewing the intake details, 
purchase lines, and approvals, and requesting clarification on the request, if necessary. For 
details, see Review details and request clarification on a sourcing request in playbook.

Procedure

1. Perform steps 1 through 11, as documented in Review details and request clarification on a 
sourcing request in playbook.

2. In the Sourcing approach section, choose to negotiate with suppliers right away, or skip this 
step and start qualifying the sourcing request instead.

In case of the former, you can add the sourcing request to an exiting or new sourcing event as 
required, before working with the sourcing event, as documented in Set up negotiations with 
suppliers and manage qualifications in playbook.

In case of the latter, you have the option to work on negotiations after the qualification is 
complete.

3. Do one of these actions.

Decision Action

Add to an existing sourcing event

To source with an existing group of requests, 
select an existing sourcing event from the list.

The Supplier response close  field is au­
to-populated with the supplier response 
close date specified in the existing sourcing 
event that you're adding the sourcing request 
to.

Add to a new sourcing event

To source the request by itself or with a new 
group of similar requests, add to a new sourc­
ing event and update the details of this sourc­
ing event.

The supplier response close date specified 
in the sourcing request is auto-populated in 
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Decision Action

the Supplier response close  field. If the sourc­
ing manager changes the supplier response 
deadline for a new sourcing event, the sourc­
ing request also reflects this updated date.

Continue

Skip negotiating and start qualifying the sourc­
ing request.

For more information about the qualification 
process, see Supplier qualification.

What to do next
Work on a negotiation setup playbook to manage qualification work, and review the sourcing 
requests, suppliers, and purchase lines, all within the premises of a sourcing event. For details, 
see Set up negotiations with suppliers and manage qualifications in playbook.

Set up negotiations with suppliers and manage qualifications in playbook

Work on a negotiation setup playbook to manage qualification work, and review the sourcing 
requests, suppliers, and purchase lines, all within the premises of a sourcing event.

Before you begin
Role required: Sourcing manager

Ensure that you’ve selected the appropriate sourcing approach. For details, see Select a 
sourcing approach in playbook.

Procedure

1. Under Manage qualification work, review all the cases and tasks related to this sourcing event.

2. Do one of these actions.

Decision Action

Create a type of work
On the Create a type of work pop-up window, 
select the required case or task, and add it to 
the sourcing event.

Complete qualification

Completes the qualification.

Note:  The procurement cases must be 
in the Closed Completed state for you to 
complete the qualification.

3. After qualification is complete, do one of these actions.
You can continue sourcing this request by adding pricing to this record. If you want pricing for 
additional items or suppliers, use a sourcing event instead.

Decision Action

Add to a new sourcing event

To source the request by itself or with a new 
group of similar requests, add to a new sourc­
ing event and update the details of this sourc­
ing event.
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Decision Action

Add to an existing sourcing event
To source with an existing group of requests, 
select an existing sourcing event from the list.

Add pricing to this record
Continue sourcing this request by adding pric­
ing to this record.

4. If you’ve added the sourcing request to a new or existing sourcing event, select Go to sourcing 
event.

5. Review the details of the sourcing requests within this sourcing event.

6. Optional:  Select Add sourcing requests  if you want to add more similar sourcing requests to 
this sourcing event.

7. Select Continue.

8. Review the details of the suppliers within this sourcing event.

9. Optional:  Select Add suppliers  if you want to add more suppliers to this sourcing event.

10. Select Continue.
Adding a sourcing request or supplier auto-creates purchase lines and creates a new 
negotiation record to manage negotiation activities for that specific supplier.

11. Review the details of the purchase lines within this sourcing event.

12. Select Continue.

13. Manage qualification work, as described in steps 1 and 2.

Streamlining the supplier risk assessment workflow

As procurement specialists, track activity on the Third-Party Risk Management (TPRM) records, 
and update and make changes to the sourcing requests and purchase requests based on the 
final risk rating.

With the due diligence playbook for due diligence case types, procurement specialists no 
longer need multiple clicks to manually update any tasks that they need to complete during 
the different stages of the supplier risk assessment workflow. They no longer need to open the 
supplier tiering assessment and risk assessment cases that get auto-triggered whenever there’s 
a need for supplier qualification. With the TRPM capabilities, when a sourcing request is added 
to a sourcing event, in the Qualification needed state, a supplier case of type due diligence is 
triggered to address risk assessments. The risk team is responsible for the workflow after the due 
diligence is triggered.

With this due diligence playbook, procurement specialists, sourcing managers, and procurement 
managers no longer need to handle these activities outside the system through emails, phone 
calls, or weekly zoom meetings with the risk team. There’s no need to check for any updates from 
the tiering assessor and update them back to their own working records. They’re also relieved 
from remembering or finding the appropriate records to update when the risk assessment is 
complete.

The tiering assessor must complete the tiering questionnaire after the supply manager submits 
the tiering questionnaire. The state of the tiering assessment questionnaire changes to Awaiting 
response.

The supplier contact completes the risk assessment from the supplier collaboration portal. For 
more information on this, see Complete a risk assessment from the Supplier Collaboration Portal.

Note the following scenarios:
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• When Supplier Lifecycle Operations  is installed, and the supplier is new, the Due Diligence 
Request (DDR) is created in Supplier Lifecycle Operations  as a supplier case, and the due 
diligence case is taken care of through the onboard a supplier case.

• When Supplier Lifecycle Operations  is installed, but the supplier is old and already onboarded, 
the DDR is created as a procurement case.

• When Supplier Lifecycle Operations  is not installed, irrespective of whether the supplier is old 
or new, the DDR is created in Sourcing and Procurement Operations  as a procurement case.

For information on how Supplier Lifecycle Operations  similarly assesses suppliers during the 
onboarding process, see Minimize risk by assessing suppliers during the onboarding process . 
For detailed information on the supplier onboarding playbook, see Use the supplier onboarding 
playbook to onboard suppliers.

For information on how to configure TPRM, see Configuring Third-party Risk Management . For 
detailed information on the due diligence workflow, see Due diligence workflow .

Track risk assessments from the due diligence playbook

As procurement specialists, use the due diligence playbook to track supplier risk assessments 
and complete the associated tasks.

Before you begin
Role required: Procurement specialist

About this task
When a sourcing request is added to a sourcing event, in the Qualification needed state, a 
supplier case of type due diligence is triggered to address risk assessments. You can choose 
to close the case through the playbook if there are duplicate requests. In case of no duplicates, 
a new due diligence is initiated through the playbook. The same Third-Party Risk Management 
(TPRM) record producer is used here. You are notified at each step in the TPRM workflow, such 
as inherent risk assessment, third-party risk assessment, and so on. You can review the risk 
rating after the due diligence is complete. Now, you can either accept or reject the risk rating, and 
take necessary actions based on this decision. Select Mark Complete  to close the due diligence 
case.

Procedure

1. Navigate to All  > Procurement Case Management  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select All work  > Cases.

3. Select the Due Diligence procurement case from the list for further processing.
The Playbook  tab opens with the Assign case  section.

4. Complete the steps in the various stages and activities of the Create a Due Diligence Request 
playbook.

Stage Activity Activity Details

Review 
case

Assign case Use this activity to assign the case to a different person or keep the 
case assigned to you.

You can do the following:

◦ In the Assigned to  search field, search for and select the person 
that you want to assign the case to.

◦ In the Short description  field, update the description for the case.
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Stage Activity Activity Details

◦ Select one of the following actions:

▪ Select Save  to save your changes.

▪ Select Start work  to start working on the case.

Update case 
to work in 
progress

This activity updates the case to Work in progress and completes 
automatically.

Review the 
Supplier 
details

Review the supplier details and select Continue.

Check for 
duplicate 
Due 
Diligence 
Requests

Checks for duplicate due diligence requests. If there aren't any 
duplicate requests, select Create new request.

Create Due 
Diligence 
Request

Request third-party risk due diligence by selecting one of the 
following options:

◦ Onboard a new engagement

◦ Reassess an existing engagement

◦ Reassess an existing engagement for contract renewal

◦ Offboard an engagement with due diligence

◦ Offboard an engagement with NO due diligence

Add any relevant attachments, if required, and select Submit.

The relevant third party, if available, is automatically populated.

If the third party is not listed here or incomplete information is 
provided, enter the following details:

◦ Third-party information

◦ Engagement information

◦ Third-party address

◦ Engagement address

◦ Third-party primary contact

◦ Engagement primary contact

Update PC 
Record with 
the DDR case

Updates the procurement case record with the due diligence 
request case.

A due diligence case is created for the supplier. After that, the 
created case record ID gets populated in the Related DDR  field 
under the Details  tab.

Create 
Request

Wait for risk 
process to 
start

Wait for the inherent risk assessment to complete.

At this point, the TPRM team starts onboarding the supplier 
associated with the created DDR.
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Stage Activity Activity Details

Wait for the 
Inherent Risk 
Assessment

Wait for the inherent risk assessment to complete.

Here, the assigned respondent completes and submits the inherent 
risk questionnaire, and the TPRM team updates the INA record and 
sets it to Closed state. Details of the INA record are provided in 
parallel in the playbook.

Notify 
requestor 
on the 
Inherent Risk 
Assessment

A notification is sent to you with the information that the inherent 
risk assessment is now complete.

Wait for 
the Third-
Party Risk 
Assessments

Wait for the third-party risk assessments to complete.

Here, the TPRM team starts the due diligence for the supplier 
associated with the created DDR. Details of the third-party risk 
assessments for the third party and the engagement are provided 
in parallel in the playbook.

Notify 
requestor 
on the Third-
Party Risk 
Assessment

A notification is sent to the requester when both these risk 
assessments are completed and in the Closed state.

Check for 
the status 
of the Due 
Diligence 
approval 
process

Review the status of the entire due diligence approval process.

At this point, the TPRM team moves the DDR to the TPRM approved 
state. A notification is sent to you with the information that the due 
diligence request has been approved by the TPRM team. The risk 
ratings from all the above assessments are now displayed in the 
playbook.

Note:  At any point during the above TPRM activities, if 
the record gets rejected, then a notification is sent to you 
regarding this rejection, and the case is moved to Closed 
rejected.

Assess 
Risk

Notify 
requester 
that the 
request 
has been 
approved.

The requester is notified when the DD Request is approved by 
TPRM team.

Review 
Risk 
Rating

Accept or 
reject risk 
rating

Do one of the following:

◦ Select Reject Risk Rating, notify the requester that the request 
has been rejected, and mark the case as Rejected.

◦ Select Accept Risk Rating, notify the supplier, and mark the case 
as Complete.

Close 
case

Get Supplier 
contact email 
from DDR 
record

Gets the email ID of the supplier contact from the due diligence 
request record.
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Stage Activity Activity Details

Notify 
Supplier Use this activity to email the supplier about the status of the due 

diligence request.

A draft email appears with pre-populated data in the Subject  field. 
The email body is pre-populated with the relevant text.

Select one of the following actions:

◦ Send Email: Sends the email instantly.

◦ Skip: Skips this activity and moves to the next activity.

Complete 
case Use this activity to add work notes and close the case.

Do the following:

◦ In the Work notes  field, add any comments about the case.

◦ In the Close notes  field, add any closing comments.

◦ Select Complete case.

Update case 
to complete

Updates the case to Closed Completed.

Using Spend and Savings Management

Use Spend and Savings Management to import and manage your organization's category 
taxonomy.

Map spend categories to product categories using an Excel file

You can map spend categories to product categories using an Excel file to better organize 
and manage your organization’s expenses by grouping similar goods or services into logical 
categories.

The process for mapping spend categories to product categories using an Excel file includes the 
following tasks:

1. Add spend category data in an Excel file.

2. Load and map spend categories to existing product categories.

3. Run transform to import spend category data into the Spend Category primary table.

Add spend category data in an Excel file

You can download and add spend category data in an Excel file template.

Before you begin
Role required: admin

Procedure

1. Select All.

2. In the navigation filter, enter sn_spend_mgmt_category_stage_list.do.

3. Right-click any column heading and select Export  > .xlsx.

4. Select Download  to save the spreadsheet on your local system.
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Result
An Excel template is created with the required columns for adding the spend category data. 
Use this Excel spreadsheet to enter the supplier data that you want to import and store into the 
Spend Category Stage (sn_spend_mgmt_category_stage) staging table.

What to do next
Load the spend category data from the excel template into the Spend Category Stage 
(sn_spend_mgmt_category_stage) staging table. For more information, see Load and map spend 
categories to existing product categories.

Load and map spend categories to existing product categories

As a Spend category admin, you can use spend category management to import your 
organization's spend categories and map them to ServiceNow product categories.

Before you begin
Role required: sn_spend_mgmt.category_manager_admin

Procedure

1. Navigate to All  > Load Data.
The Load Data page appears.

2. In Import set table, select Existing table.

3. From the Import set table  list, select the Spend Category Stage 
(sn_spend_mgmt_category_stage) table.

4. In Source of the Import, choose File.

5. Browse to the excel template that was created in Add spend category data in an Excel file.

6. Enter the Sheet number  of the excel template that needs to be loaded into the staging table.

7. Enter the Header row  of the excel template that needs to be loaded into the staging table.

8. Click Submit.

Result
The Excel template with spend category data is uploaded.

What to do next
Run the transform to import the data from the Spend Category Stage table to the Spend Category 
primary table. For more information, see Run transform to import spend category data into the 
Spend Category primary table.

Run transform to import spend category data into the Spend Category primary table

Run transform to import the data records from the Spend Category Stage 
(sn_spend_mgmt_category_stage) staging table into the Spend Category 
(sn_spend_mgmt_category) primary table.

Before you begin
Role required: admin

About this task
Here’s how the transform map works:

• In the Spend Category table, only the Category name field is mandatory and must be unique; 
all other fields are optional.

• During transformation, if either the Spend category manager or Sourcing manager is not found, 
the Spend category record is skipped and an error is logged.
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• If the Parent spend category does not already exist, it is created automatically.

• If a matching Product category cannot be found using either the UNSPSC or Category name, 
the corresponding many-to-many (m2m) record is not created, and the issue is logged 
accordingly.

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. Select Existing table.

3. In the Import set table  field, select Spend Category Stage 
(sn_spend_mgmt_category_stage).

4. In the Source of the import  field, select File.

5. Select Choose File  and select the source Excel spreadsheet.

6. Optional:  Specify the worksheet number in the Sheet number  field and header row number in 
the Header row  field.

7. Select Submit.
The imported data is now available in the new Import Set table.

8. Select Run Transform.

Important:  Ensure that the Import set  field shows sn_spend_mgmt_category_stage 
and the Selected maps, run in order  field shows Load spend categories and map to 
product categories - sn_spend_mgmt_category.

9. Select Transform.

10. Optional:  Verify that the data records were imported into the Spend Category 
(sn_spend_mgmt_category) primary table.

Map spend categories to product categories manually

You can manually map spend categories to product categories to better organize and manage 
your organization’s expenses by grouping similar goods or services into logical categories.

Before you begin
Role required: sn_spend_mgmt.category_manager_admin

Procedure

1. Navigate to All  > Spend and Savings Management  > Spend Categories.

2. Select New.

3. On the form, fill in the fields.

Field Description

Category name Name of the spend category.

Category code Code of the spend category.

Spend category 
manager

Name of the spend category manager.

Parent spend 
category

Category that contains more specific child categories or 
subcategories of spend.
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Field Description

Sourcing manager Name of the sourcing manager.

4. Select Submit.
The Child Spend Categories, Product Categories, and Ledger Assignment Rules related lists 

appear.

5. Do the following:

To Do this

Create 
child spend 
categories

a. Select the Child Spend Categories  related list, and select New.

b. On the form, fill in the fields.

The Parent spend category  field is auto-populated.

See step 3  for a description of the field values on the Spend category 
form.

Create product 
categories

a. Select the Product Categories  related list and select Edit.

b. In the collection list pop up window, do one of the following to move the 
categories to the Product Categories List

▪ Select a category and then click the right arrow icon ( ) icon.

▪ Double-click a category.

Note:  In the Collection list, you can search for product categories 
by entering the category name or by using wild cards (*).

c. Select Save.

Create ledger 
assignment rules

Select the Ledger Assignment Rules  related list and select New. For 
more information, see Create ledger assignment rules.

Action or dismiss a savings opportunity

Convert a savings opportunity into a pipeline project, or dismiss it with a reason.

When a savings opportunity is created, it has an Open  status by default. After reviewing the 
opportunity in the Now Assist  Panel, the opportunity moves to one of two outcomes:
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• Closed: The user accepts the opportunity. A pipeline project is created from the opportunity 
and linked to it, moving it into the sourcing pipeline for execution.

• Dismissed: The user rejects the opportunity and provides a reason. The card is removed from 
the Potential savings opportunities page and the dismissal reason is saved on the opportunity 
record.

Note:  After an opportunity is closed or dismissed, the action is not reversible.

Review a savings opportunity and create a pipeline project

Open a savings opportunity discovered by the Savings Opportunity Discovery agentic workflow 
and create a pipeline project that tracks the savings.

Before you begin
The Now Assist Panel deployment for the relevant Opportunity Finder agent must be active. The 
weekly Savings Opportunity Finder Agents Scheduled Job uses the same check before running 
each agent.

Role required: sn_spend_mgmt.sourcing_category_manager to read opportunity records, or 
sn_spend_mgmt.category_manager_admin to update them. To create a pipeline project, the 
sourcing_pipeline_user role and category manager access to the opportunity's spend category 
are also required.

About this task
Three agents create opportunity records: the Contract Optimization Opportunity Finder Agent, 
the Supplier Optimization Opportunity Finder Agent, and the Spend Optimization Opportunity 
Finder Agent. The Learn more  action on an open opportunity card launches the Savings 
Opportunity Discovery use case, which routes to the correct agent based on the opportunity's 
lever.

While pipeline project creation is in progress, the opportunity status moves to In progress  and 
the record is locked from changes by other users until the flow completes or is cancelled.

Procedure

1. From the Workspaces  tab, select Source-to-Pay Workspace.

2. Select the Category management  tab.

3. Do one of the following:

◦ In the Potential savings opportunities section, in the opportunity card you want to work on, 
select the three dots menu, and then select Learn more.
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◦ In the Potential savings opportunities section, select View all. Then, in the Potential Savings 
Opportunities page, select Learn more  for the opportunity you want to act on.

4. Review the content in each section of the Now Assist Panel.

◦ Opportunity Summary: A narrative paragraph summarizing the total estimated savings, the 
supplier, the spend categories covered, the baseline contract spend, and the savings levers 
that produced the opportunity.

◦ Key Insights: A list of specific findings that support the opportunity, such as the current and 
proposed values for each savings lever and the cumulative savings attributable to each. The 
insights also include observations about contract utilization or spend patterns relevant to the 
finding.

◦ Recommended Next Steps: A list of suggested actions to progress the opportunity, such as 
reviewing the relevant contract clauses, engaging the supplier to confirm negotiated rates, or 
validating the savings calculation against actual spend.

◦ What would you like to do next?: Predefined options such as Create pipeline project, How 
are savings calculated, and Ask anything  appear . The predefined options vary according 
to the opportunity type. Select an option or type directly in the chat input to continue the 
conversation.
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5. Optional:  Ask follow-up questions about the opportunity in the chat.
For example, ask How were the savings calculated? , Show the 
related contracts , or List the pipeline projects linked to 
this opportunity . The agent calls the results appear in the chat without ending the 
conversation .

6. Select Create pipeline project.
The following pre-filled project details appear: State  (Draft), Short description, Estimated 
spend, Estimated savings, Start date  (today), End date  (contract end date for Contract 
Optimization; otherwise empty), and Project type  (Supplier, Contract, or Spend Optimization). 

7. Review the pre-filled values and reply Yes  to make changes or No  to proceed.
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If you reply Yes, enter the field to change in the chat . The revised summary appears for 
confirmation before proceeding.

8. Select a priority when prompted: 1 - Critical, 2 - High, 3 - Moderate, 4 - Low, or 5 - Planning.
Only values 1 through 5 are accepted; the agent re-prompts for an invalid value.

9. Wait for the agent to create the pipeline project.
The agent calls the pipeline project creation flow .
On success, the agent returns the pipeline project number as a hyperlink along with the state, 
priority, and project type.

Trouble? 
If the pipeline project creation fails, an error message appears with an option to retry .

10. Choose whether to generate a chat summary when prompted with Yes  or No.
If you select Yes, the agent generates a 3–5 sentence work note covering the project 
description, estimated savings, start date, and recommended next steps.

11. Review the draft summary and reply Yes  to make changes or No  to confirm.
If you reply Yes, provide the revisions in chat and confirm the updated summary before 
proceeding.

12. Select Post to work notes  to attach the summary to the new pipeline project, or End chat  to 
close the conversation.

Result
A pipeline project record is created and linked to the opportunity, contracts, suppliers, and 
purchase orders referenced by the opportunity. The opportunity record is updated to reflect the 
action.

What to do next
The following fields on the draft pipeline project are prefilled from the opportunity. Review and 
update any values before progressing the project.

Pipeline project draft fields prefilled from the opportunity

Field Description

Short 
description

Opportunity type and the related spend categories.

Estimated 
spend

Baseline or consolidated spend captured for the opportunity.

Estimated 
savings

Savings value calculated for the opportunity.

Estimated 
start date

Current date.

Estimated 
end date

Renewal start date when the opportunity is based on a contract. The contract end 
date is used as a fallback.

Project 
type

Determined by the opportunity type.

Previous 
records

Source records linked by opportunity type: contracts for contract optimization, 
purchase orders for spend optimization, and suppliers for supplier optimization.

Dismiss a savings opportunity

Reject a savings opportunity that you do not intend to pursue, recording who dismissed it, when, 
and why so it stays on record for auditing.
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Before you begin
The Dismiss  option is available only to the user assigned as Spend category manager on the 
Spend categories table for the opportunity's spend category. A manager assigned to a parent 
spend category can dismiss opportunities for any of its child categories. The option is hidden for 
users who do not meet this condition.

Role required: sn_spend_mgmt.category_manager_admin

Procedure

1. From the Workspaces  tab, select Source-to-Pay Workspace.

2. Select the Category management  tab.

3. Do one of the following:

◦ In the Potential savings opportunities section, in the opportunity card you want to dismiss, 
select the three dots menu, and then select Dismiss.

◦ In the Potential savings opportunities section, select View all. Then, in the Potential Savings 
Opportunities page, select Dismiss  for the opportunity you want to dismiss.

4. In the Share feedback  modal, select one or more reasons from the checklist.

At least one reason is required. The available options are:

◦ Not relevant to my role

◦ Already completed

◦ Timing isn't right
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◦ Incorrect analysis

◦ Other

Optionally, add a comment in the Add a comment  field to provide more context. You can also 
chat with Now Assist  from this modal to propose changes to the opportunity before dismissing 
it.

5. Select Submit.
The opportunity Status  moves to Dismissed. The Dismissed reason, Dismissed by, and 
Dismissed date  fields are populated. The card is removed from the Potential Savings 
Opportunities  page and the Category Management  tab.

Note:  If the dismissal does not process, verify that the 
sn_spend_mgmt.category_manager_admin role is assigned and that the opportunity is 
not in progress.

Result
The opportunity remains on the Savings Opportunities table with Status  of Dismissed  and the 
dismissal audit fields filled in. The record is not deleted. The dismissal reason is captured as 
structured agent feedback; subsequent discovery runs consume that feedback to deprioritize 
patterns that have been rejected and to refine the scoring of future opportunities. When new 
data materially changes the savings estimate on a dismissed opportunity, the agentic workflow 
can regenerate it for re-evaluation.
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What to do next
Note:  If the opportunity still appears on the Potential Savings Opportunities  page after 
dismissal, refresh the page. If the issue persists, verify that the Status  field on the record is 
set to Dismissed.

To reopen a dismissed opportunity, set Status  back to Open  in the Savings Opportunities table. 
The UI policy reverses and hides the dismissal fields, but the previously entered values are 
retained on the record.

The Learn more  Now Assist  trigger remains available on dismissed records because the trigger's 
condition only suppresses it for status = closed.

Using Sourcing Pipeline Management

Use Pipeline Sourcing Management to create pipeline projects that capture key financial and 
opportunity data while providing end-to-end visibility into all sourcing activities.

Add a sourcing request to a pipeline project

Add a sourcing request to a pipeline project to link project details, reduce manual data entry, and 
track sourcing progress against project timelines.

https://player.vimeo.com/video/1127148219?
h=7e205803a9&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist or admin

About this task
You can add sourcing requests that are in either the Pending Review or Pending Approval state 
to pipeline projects.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ) and do one of the following:

◦ Navigate to Lists  > My work  > Sourcing requests.

◦ Navigate to Lists  > All work  > Sourcing requests.

3. Select the link to the sourcing request under the Number column.

4. Select Add to pipeline project.

5. In the Add to pipeline project dialog box, do one of the following:
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To Do this

Add the sourcing 
request to an existing 
pipeline project.

◦ Select Add to an existing pipeline project.

◦ Search for and select a project from the Pipeline project  list.

Note:  The list displays only those pipeline projects that 
are in either the Draft or Planned state and share spend 
category as the sourcing request.

Add the sourcing 
request to a new 
pipeline project.

◦ Select Add to a new pipeline project.

◦ In the Short description  field, enter a brief summary of the 
pipeline project.

◦ In the Description  field, enter detailed project information.

◦ From the Project type  list, select one of the following options:

▪ Supplier Optimization

▪ Contract Optimization

▪ Savings Potential

▪ Spend Optimization

▪ Risk Reduction

◦ In the Estimated Start Date  field, enter the target start date for 
the pipeline project.

◦ In the Spend Category  field, select the spend category that 
matches that of the sourcing request.

6. Select Add.
The sourcing request is associated with either an existing or a new pipeline project. It’s 
displayed in the Sourcing Requests  tab of the pipeline project.
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Related topics

Sourcing request

Create a pipeline project manually

Create a pipeline project manually to record project details that aren’t automatically generated 
through an intake request.

https://player.vimeo.com/video/1127146794?
h=2555be6a73&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin
Role required: sn_shop.procurement_specialist or admin

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ) and do one of the following:

◦ Navigate to Lists  > My work  > Pipeline projects.

◦ Navigate to Lists  > All work  > Pipeline projects.

3. Select New.
The Create New Pipeline Project form is displayed. For a description of the field values, see 
Create New Pipeline Project form.

4. Select Save.
The pipeline project is created in the Planned state.

For more information about the tabs and UI actions available in the pipeline project record, see 
Pipeline project record tabs and UI actions.

Report savings when awarding a supplier

When awarding a supplier, enter the spend and savings data for the sourcing event associated 
with the pipeline project.

Before you begin
Role required: sn_shop.procurement_specialist
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About this task
The sourcing event that you plan to work on, and all its associated negotiations, sourcing 
requests, and purchase lines must be in the Requires Decision state. When negotiations are 
complete for a sourcing event, you can award one or more suppliers. Awarding suppliers creates 
purchase requisitions for the selected suppliers and items.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ) and do one of the following:

◦ Navigate to Lists  > My work  > Sourcing events.

◦ Navigate to Lists  > All work  > Sourcing events.

3. Open the sourcing event that is in the Requires Decision state.

4. Select Award.
The Award to supplier dialog box is displayed.

5. In the Supplier  field, select a supplier, and then select Next.

6. Enter the spend and savings data in the Final spend, Cost avoidance, Lost savings, and 
Other savings  fields.
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Note:  The Review financials modal is displayed only if the sourcing event is associated 
with a pipeline project.

The Hard savings  field is auto-populated and displays the cumulative savings from all 
sourcing events associated with the pipeline project. This value is calculated by summing 
the Negotiated savings from all closed purchase requisition lines (PRLs) within the sourcing 
events.

You can edit the Hard savings  field if you’d like. If you edit the Hard savings  field, a warning 
message appears indicating that the entered value differs from the cumulative negotiated 
savings on PRLs. This warning is shown only if there are negotiated savings on any PRL.

7. Select Submit.

Result
The sourcing event is moved to Closed Complete, with the individual negotiations under it 
moved to Closed Decided or Closed Rejected based on your selection. The awarded sourcing 
request is moved to Closed Complete, with purchase requisitions automatically created for the 
purchase lines. In addition, the spend and savings data is updated in the associated pipeline 
project.

Report savings when awarding multiple suppliers

When awarding multiple suppliers, enter the spend and savings data for the sourcing event 
associated with the pipeline project.

Before you begin
Role required: sn_shop.procurement_specialist

About this task
The sourcing event that you plan to work on, and all its associated negotiations, sourcing 
requests, and purchase lines must be in the Requires Decision state. When negotiations are 
complete for a sourcing event, you can award one or more suppliers. Awarding suppliers creates 
purchase requisitions for the selected suppliers and items.
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Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ) and do one of the following:

◦ Navigate to Lists  > My work  > Sourcing events.

◦ Navigate to Lists  > All work  > Sourcing events.

3. Open the sourcing event that is in the Requires Decision state.

4. Select Award multiple suppliers.
The Award suppliers for sourcing event page is displayed.

5. Select the supplier for each product you want to purchase.

6. Select Review selection.

The Review selection dialog box is displayed.
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7. Select Next.

8. Enter the spend and savings data in the Final spend, Annual cost avoidance, Lost savings, 
and Other savings  fields.

Note:  The Review financials modal is displayed only if the sourcing event is associated 
with a pipeline project.

The Annual hard savings  field is auto-populated and displays the cumulative savings from all 
sourcing events associated with the pipeline project. This value is calculated by summing the 
Negotiated savings from all the selected purchase lines on the Award suppliers page.

You can edit the Annual hard savings  field if you’d like. If you edit the Annual hard savings 
field, a warning message appears indicating that the entered value differs from the cumulative 
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negotiated savings on PRLs. This warning is shown only if there are negotiated savings on any 
PRL.

9. Select Submit.

Result
The sourcing event is moved to Closed Complete, with the individual negotiations under it 
moved to Closed Decided or Closed Rejected based on your selection. The awarded sourcing 
requests are moved to Closed Complete, with purchase requisitions automatically created for 
the purchase lines. In addition, the spend and savings data is updated in the associated pipeline 
project.

Close a pipeline project

As a sourcing manager, you can close the pipeline project when all the activities related to the 
sourcing pipeline project have been completed.

Before you begin
Ensure that you’ve qualified all the relevant suppliers, and have received all the bids and 
responses from them, before you begin the awarding process. At this point, the sourcing event 
that you plan to work on, and all its associated negotiations, sourcing requests, and purchase 
lines must be in the Requires Decision state.

Role required: sn_shop.procurement_specialist

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ) and do one of the following:

◦ Navigate to Lists  > My work  > Pipeline projects.

◦ Navigate to Lists  > All work  > Pipeline projects.

3. Open the pipeline project that is in the Work in progress state.

4. Select Close.

The system checks that all related objects, such as sourcing requests and sourcing events, are 
closed. If any of the related objects are open, an error message prompts you to close them.

The Close pipeline project dialog box is displayed.
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The Hard savings  field is auto-populated and displays the cumulative savings from all 
sourcing events associated with the pipeline project. This value is calculated by summing 
the Negotiated savings from all closed purchase requisition lines (PRLs) within the sourcing 
events.

If needed, you can edit the Hard savings  field. If you edit the Hard savings  field, a warning 
message appears indicating that the entered value differs from the cumulative negotiated 
savings on PRLs. This warning is shown only if there are negotiated savings on any PRL.

5. Enter the project's financial data in the Estimated spend, Hard savings, Targeted savings, 
Cost avoidance, Final spend, Other savings, and Lost savings  fields.

6. In the Closing notes  field, enter a brief summary of the pipeline project that provides context 
for future reference, auditing, or reporting.

7. Select Close.
The pipeline project moves to the Closed Complete state.

Create a pipeline project from an expiring contract

As a sourcing manager, you can create a pipeline project directly from an expiring contract using 
a guided, decision-based workflow.

Before you begin
Role required: admin

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the Category management  tab.

3. Under the Contracts section, select the Expiring within 90 days  widget.
The list of expiring contracts is displayed.
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4. Select and open a contract for which you want to create a pipeline project.

5. From the Pipeline project  drop-down list, select one of the following options:

◦ Create new

A pipeline project is automatically created for the expiring contract. The contract is displayed 
in the Associated Records section of the pipeline project.

◦ Add to existing

From the Add to pipeline project  list, select an existing pipeline project. The contract is 
added to the pipeline project.

The Contract renewal sourcing task is automatically created and appears in the Related work 
tab of the contract record. This task is assigned to the business owner who was originally 
assigned to the sourcing request. The shopper or business owner can view the sourcing task 
in Employee Center and choose whether to renew the contract or not. For more information, 
see Confirm contract renewal in Employee Center.

Confirm contract renewal in Employee Center

As a business owner or shopper, confirm whether the expiring contract needs to be renewed.

Before you begin
Role required: sn_shop.shopper

About this task
After a pipeline project is created from an expiring contract, a sourcing task is automatically 
assigned to the business owner or shopper. This task prompts them to confirm whether the 
expiring product or service is still needed. Based on their selection, the system either cancels 
the project or duplicates a sourcing request.

Procedure

1. Navigate to All  > Employee Center.

2. Select My Tasks.
The form displays the Open  and Completed  tabs.

The Open  tab lists all to-dos that have not been completed.

3. On the Open  tab, select the contract renewal task.
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4. In the Do you want to renew this contract section, select one of the following options:

◦ Renew this contract: The following occurs when you select this option:

▪ The pipeline project is canceled.

▪ A mandatory Close notes text box is displayed to the user.

▪ The shopper/business owner's input is stored in the Close notes  field on the pipeline 
project record and in the Work notes section.

◦ Do not renew: The following occurs when you select this option:
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▪ Task completion is recorded in the Work notes of the pipeline project.

▪ A new sourcing request is created by duplicating the original request linked to the expiring 
contract.

▪ Details from the previous request are displayed, with an option to update delivery 
information.

▪ The new request is linked to the active pipeline project and appears under the Overview 
tab and in the Sourcing related list on the pipeline project record.

5. Select Submit.

Sourcing and Procurement Operations  reference
Reference topics provide additional information about Sourcing and Procurement Operations, 
including lists, forms, rules, components, parameters, roles, and personas.

Create New Pipeline Project form

Use the Create New Pipeline Project form to provide details about the pipe project.

Create New Pipeline Project form

Field Description

Pipeline Project

Number An auto-generated number that uniquely 
identifies the pipeline project.

State The current state of the pipeline project. 
Available values:

• Draft

• Planned

• Work in Progress

• Closed Complete

• Closed Canceled

Priority Indicates how quickly you must complete the 
pipeline project.

Project type Specifies the type of project based on the 
sourcing objective. Available values:

• Supplier Optimization – Consolidating 
suppliers to reduce spend

• Contract Optimization - Renegotiating an 
existing contract

• Savings Potential – Using market 
intelligence to potentially lower spend
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Create New Pipeline Project form  (continued)

Field Description

• Spend Optimization – Use sourcing events 
(RFI, RFQ, RFP) to lower spend

• Risk Reduction – Supplier issues or backup 
for an existing supplier

Assigned to Person assigned to the pipeline project.

Short description Name of the pipeline project.

Description Description of the pipeline project.

Project summary

Opportunity source The source of the pipeline project.

This field takes its value based on where the 
pipeline is created.

• Intake Request: When the pipeline project 
is created from the Employee Center intake 
request.

• Adhoc: When the Sourcing Manager or 
Procurement Specialist manually create 
the from the list view in Source-to-Pay 
Workspace.

• System-generated: When the pipeline 
project is created by AI.

Business owner The person who initiates the pipeline project 
and provides key input and approvals.

Spend category Spend category used to report on savings.

Business unit The business unit associated with the pipeline 
project, such as IT, Finance, HR, or Sales.

Estimated start date The projected date when the project is 
expected to begin.

Estimated end date The projected completion date for the pipeline 
project.

This field reflects the due date specified in 
the sourcing request. If the pipeline project is 
associated with multiple sourcing requests, 
the earliest due date among them is used.

Actual start date Actual start date of the pipeline project.

Note:  This field is automatically 
populated when the pipeline project 
moves to the Work in Progress state.
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Create New Pipeline Project form  (continued)

Field Description

Actual end date Actual end date of the pipeline project.

Note:  This field is automatically 
populated when the pipeline project 
moves to the Close Complete state.

Savings start date The date from which savings are expected to 
begin.

Note:  This field becomes mandatory 
when the pipeline project moves to the 
Planned state.

Savings end date The date until which savings are expected to 
be captured.

Note:  This field becomes mandatory 
when the pipeline project moves to the 
Planned state.

Financials

Estimated spend The anticipated expenditure for the goods or 
services covered by the pipeline project.

Annual hard savings The measurable, recurring cost reductions 
achieved each year as a result of sourcing 
activities, contract negotiations, or process 
improvements.

Annual cost avoidance The estimated yearly savings realized by 
preventing future costs or price increases 
through proactive sourcing strategies or 
negotiations.

Estimated hard savings The projected, quantifiable cost reduction 
expected from the pipeline project, typically 
derived from direct price decreases or 
efficiency gains.

Estimated cost avoidance The projected financial benefit resulting from 
mitigating potential cost increases, avoiding 
additional expenses, or improving purchasing 
efficiency.

Other savings Any additional savings achieved that don't 
fall under hard savings or cost avoidance 
categories.

Final spend The actual amount spent at the completion of 
the pipeline project.

Lost savings Forecasted savings that were not realized 
due to delays, project cancellations, or scope 
changes.
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Create New Pipeline Project form  (continued)

Field Description

Associated records

Previous record type The classification of the preceding project 
record.

Previous record ID The unique identifier of the previous related 
project or sourcing record, used for reference.

Pipeline project record tabs and UI actions

View project financial details, add existing procurement objects to pipeline projects, or create 
new procurement objects from the Pipeline project record form.

Pipeline project record form

Pipeline project record form

The following table provides descriptions of the available tabs and UI actions in the Pipeline 
project record form.

Form 
component

Description

State and 
progress bar

Shows the current state of the pipeline project.

Tabs

Overview The Overview tab includes the following sections:
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Form 
component

Description

• Project savings: Displays savings related tiles for:

◦ Estimated spend: Populated from the corresponding field on the pipeline 
project.

◦ Targeted savings: Populated from the corresponding field on the pipeline 
project.

◦ Realized savings: Sum of Hard savings, Cost avoidance, and Other savings 
on the pipeline project.

• Sourcing summary: Displays list views of sourcing requests, sourcing events, 
and contracts associated with the pipeline project.

Details Displays all the information that you provided when creating a pipeline project.

Sourcing Contains separate subtabs, each listing sourcing requests, sourcing events, 
and negotiations associated with the pipeline.

Purchase 
Lines

Lists the purchase lines belonging to all the associated sourcing requests.

Contracts Contains separate subtabs, each listing draft contracts, signed contracts, and 
other legal documents associated with the pipeline.

Related Work Contains separate subtabs, each listing purchasing tasks, cases, and 
purchasing SLAs associated with the pipeline.

Note:  If the SPO and Contract Management Pro integration is enabled, 
this tab also includes contract requests.

Emails Displays a list of emails in both Draft and Sent status.

UI actions

Add Use this drop-down list to add existing objects to the pipeline project. Available 
options:

• Existing sourcing request

• Existing sourcing event

• Existing contract

Create Use this drop-down list to create new objects for the pipeline project. Available 
options:

• New sourcing request

• New sourcing event

• New contract

Savings opportunity fields

Reference for the fields on the savings opportunity record in the Savings Opportunities 
(sn_spend_gen_ai_savings_opportunities) table.
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Savings opportunity record fields

Field Description Type

Header fields

Number Automatically generated unique identifier for the savings opportunity 
record, prefixed with OPP.

String

Status Current state of the opportunity. Choice

Opportunity 
Value

Total estimated savings calculated by the agent, displayed with the 
currency code inline. For contract optimization, this is the cumulative 
savings over the forecast period. For renewal-and-escalation 
findings, this value combines both savings components.

Currency

Opportunity 
Type

Category of opportunity produced by the source agent: Contract 
Optimization, Spend Optimization, or Supplier Optimization.

Choice

Short 
description

One-line summary of the opportunity generated by the agent, 
describing the spend category, the product or service involved, and 
the estimated savings. Used on opportunity cards in the Source-to-
Pay Workspace .

String

Description Rich text field containing the full AI-generated analysis for the 
opportunity. The content is structured as: Opportunity Summary 
(narrative overview of the finding), Supplier Breakdown or equivalent 
spend analysis, Why This Matters (business rationale), and 
Recommended Actions (suggested next steps) .

HTML

Opportunity Details tab

Savings 
Lever Specific lever that produced the savings finding. The available 

values are:

• Price Escalations & Renewal Caps

• Payment Terms Optimization

• Non-preferred Supplier Spend

• Unconsolidated Spend (Single Supplier, Multiple BU Contracts)

• Spend Fragmentation (Multi-Supplier in a Category)

• Off-Contract Spend

Choice

Savings 
Category

Classification of the savings type, for example Hard Savings  and 
Cost Avoidance . Used to categorize the financial impact of the 
opportunity.

Choice

Confidence 
Score

Numeric confidence value assigned by the AI model to indicate how 
strongly the recommendation is supported by the underlying data.

Integer

Complexity Effort estimate to action the opportunity, calculated based on factors 
such as the number of suppliers or purchase orders involved, for 
example Low, Medium, or High.

Choice

Spend 
Categories

One or more spend categories associated with the opportunity. 
Access control on the table uses this field to scope opportunities to 
category managers who own the relevant category.

Glide list
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Savings opportunity record fields  (continued)

Field Description Type

Suppliers One or more suppliers associated with the opportunity. For supplier 
optimization opportunities, this includes all suppliers identified in the 
fragmented or non-preferred spend pattern.

Glide list

Contracts One or more contracts associated with the opportunity. Populated 
for contract optimization opportunities where the finding is derived 
from contract clause analysis.

Glide list

Activity & History tab

Created Timestamp when the opportunity was generated by the AI agent . Date/
Time

Updated Timestamp of the most recent update to the record, such as when 
the scheduled run refreshed the savings estimate.

Date/
Time

Actioned By User who created a pipeline project from the opportunity. Populated 
when the opportunity status moves to Actioned.

Reference 
(sys_user)

Actioned 
Date

Timestamp when the pipeline project was created from the 
opportunity.

Date/
Time

Pipeline 
Project

Reference to the pipeline project created when the opportunity is 
actioned.

Reference

Dismissed 
reason

One or more reasons selected from the dismissal checklist. Visible 
and populated when the opportunity status is Dismissed.

String

Dismissed 
by

User who dismissed the opportunity. Visible and populated when the 
opportunity status is Dismissed.

Reference 
(sys_user)

Dismissed 
date

Timestamp of the dismissal. Visible and populated when the 
opportunity status is Dismissed.

Date/
Time

Domain separation and Sourcing and Procurement Operations

Domain separation is unsupported for Sourcing and Procurement Operations. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Sourcing and Procurement Operations  glossary

Learn about the terms and concepts used in Sourcing and Procurement Operations  (SPO).

Glossary terms are grouped alphabetically.
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C  | N  | P  | R  | S  | V

C

child case

A case that is linked to and is a part of a parent case, inheriting its context and contributing 
to its resolution or management.

N

negotiation

Individual discussions with a supplier to track activities like pricing, product requests, or 
agreement terms.

sourcing event

A collective sourcing activity managing multi-supplier and multi-product negotiations, 
enabling streamlined tracking, supplier management, and decision-making.

Natural Language Understanding for SPO

AI models enhancing the Virtual Agent's ability to understand and respond to user queries 
naturally.

Now Assist for SPO

An application that uses generative AI to summarize procurement-related records and 
facilitate conversational procurement tasks.

P

parent case

A case that contains multiple related child cases. This hierarchical case structure is useful 
for managing complex scenarios that involve multiple stages and processes.

playbooks for SPO

Pre-built workflows and templates for automating common procurement tasks.

procurement case

A record used to track and manage procurement-related queries or issues.

procurement task

A specific action or step that contributes to the completion of a procurement case.

purchase requisition

A request sent by a requester to procure specific goods or services, requiring approval.

performance analytics for SPO

Dashboards and metrics to evaluate spend, efficiency, and team performance in Sourcing 
and Procurement Operations.

Procurement Buyer Dashboard

A visualization tool showing individual buyer performance over a specified period.
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Procurement Team Performance Dashboard

A dashboard that provides visual insights into team performance on procurement-related 
tasks.

Procurement Strategy & Ops Dashboard

A dashboard that shows the year-to-date total spend, spend categorization, total savings, 
negotiation outcomes, spend by category and supplier, and active blanket purchase 
orders.

purchase order

A binding contract between a buyer and supplier that outlines item details, quantities, 
prices, discounts, payment terms, delivery dates, and other conditions.

R

record summarization

A feature of Now Assist for SPO  that provides a concise overview, the actions completed, 
and the next steps for procurement records.

related case

A case that is associated with another case due to shared characteristics, dependencies, 
or interactions.

S

Source-to-Pay Workspace

A workspace that centralizes the management of suppliers, from sourcing to payment, 
enhancing productivity and collaboration.

Shopping Hub

An e-commerce-style interface for employees to submit self-service requests for goods 
and services, integrated with the organization's procurement processes.

Sourcing and Purchasing Automation

A workflow and automation for sourcing requests, negotiations, and purchase requisitions.

Shopping Hub  catalog

A curated list of goods and services available for employees to order through Shopping 
Hub.

Shopping Hub Mobile

A mobile application version of the Shopping Hub, integrated with the Now Mobile app.

sourcing request

A request that is created when an item that the shopper intends to buy needs to be 
sourced due to the lack of an active contractual price.

V
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Virtual Agent

An AI-powered conversational chatbot that helps shoppers quickly find and purchase 
products from vendors via the Shopping Hub application, accessible through Employee 
Center.

Supplier Lifecycle Operations
With ServiceNow®  Supplier Lifecycle Operations  (SLO), you can effectively collaborate with 
suppliers, manage supplier relationships, monitor risk, compliance, and performance across the 
supplier life cycle.

Supplier Lifecycle Operations value proposition

Explore

Learn about how supplier 
managers and supplier 
contacts use Supplier 
Lifecycle Operations.

Configure

Plan and configure 
your implementation.

Integrate

Extend the capabilities 
of Supplier Lifecycle 

Operations by integrating 
with other applications.
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Get started

Explore

Learn more about 
Now Assist for SLO

Configure

Configure the Now 
Assist for SLO

application to get started

Use

Use generative AI 
capabilities that are offered 

by Now Assist for SLO

Important: 

• Not all model providers are available for customers with in-country SKUs, and some Now 
Assist  products/features are currently unavailable for in-country customers. For more 
information, see the KB1584492  article in the Now Support Knowledge Base. Be sure to 
check for model provider availability updates in future releases.

• Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the 
KB0743854  article in the Now Support  Knowledge Base . Be sure to check for availability 
updates in future releases.

• Some Now Assist  products/features are currently available only for customers in some 
regions. Be sure to check for availability updates in future releases.

• Some AI products and skills are not available in Regulated Markets. For more information, 
see KB2593939: Regulated Markets AI Products/Skills Not Available . Be sure to check 
for availability updates in future releases.

Supported LLMs for Now Assist for Supplier Lifecycle Operations (SLO)

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

Troubleshoot and get help

• ServiceNow Community on AI and Intelligence

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support.

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

882

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1584492
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1584492
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1584492
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0743854
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0743854
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0743854
https://support.servicenow.com/kb?id=kb_article_view&sys_kb_id=e8d7cc82475aba90b7832920326d4362
https://support.servicenow.com/kb?id=kb_article_view&sys_kb_id=e8d7cc82475aba90b7832920326d4362
https://support.servicenow.com/kb?id=kb_article_view&sys_kb_id=e8d7cc82475aba90b7832920326d4362
https://www.servicenow.com/docs/access?context=ai-model-providers&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=ai-model-providers&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=ai-model-providers&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=manage-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=manage-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=manage-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=manage-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=exploring-large-language-models&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/community/ai-intelligence-articles/tkb-p/ai-platform-kb
https://www.servicenow.com/community/ai-intelligence-articles/tkb-p/ai-platform-kb
https://www.servicenow.com/community/ai-intelligence-articles/tkb-p/ai-platform-kb
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0597477
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0597477
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0597477
https://support.servicenow.com/now?draw=case
https://support.servicenow.com/now?draw=case
https://support.servicenow.com/now?draw=case
https://support.servicenow.com/now?draw=case
https://support.servicenow.com/now?draw=case


making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .

Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. Customers can opt out of future data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Explore Now Assist for Supplier Lifecycle Operations (SLO)

With the Now Assist for Supplier Lifecycle Operations (SLO)  application, supplier managers can 
summarize the details of supplier-related cases to keep them informed about their progress and 
action items.

Overview of Now Assist for SLO

With Now Assist for Supplier Lifecycle Operations (SLO)  skills, supplier managers can generate 
summary of supplier cases and supplier's KPI performance. The Supplier case summarization 
skill provides supplier managers a concise overview of the case, actions completed so far, and 
the next steps that need to be taken. The Supplier performance summarization skill helps the 
supplier managers know the overall supplier performance score, trend, performance details, 
historical context, and next steps.

Now Assist for Supplier Lifecycle Operations (SLO)  includes the following capabilities:

• Supplier case summarization provides supplier managers a summary of the supplier-related 
cases, enabling them to quickly assess the status of any case in the supply process and take 
the necessary actions.

• Supplier performance summarization provides supplier managers a complete KPI performance 
summary, including overall performance scores, and trends.

• Sentiment Analysis helps reduce escalated cases by providing agents with the current 
sentiment on a case, based on interactions and the latest trends. It also offers insights into why 
the sentiment is what it is today.

• Email response generation generates contextually relevant email responses by analyzing case 
and task details.
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Now Assist skills for SLO

Note: 

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI, 
Google Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist 
skills and AI agents. Use the Configuration Controls in AI Control Tower  to define 
which options are available, then set the skill-level preferences in the Now Assist Admin 
console . For more information, see Large language models on the ServiceNow AI 

Platform® .

Skills
The Now Assist for SLO  application includes generative AI skills and features that enable 
supplier managers to summarize the supplier-related cases within the Source-to-Pay Workspace.

Supplier case summarization

Provides supplier managers a summary of the supplier-related cases. Supplier 
managers can see the status of any case in the supply process and take the 
necessary actions quickly. Supplier managers can also refresh and post the 
summary to the work notes or activity stream.

Fulfillers can customize prompt configuration and prompt optimization using the 
preprocessor in the Now Assist Skill kit (NASK). The skill supports multiple models 
such as OpenAI, Claude, Gemini, Now LLM. To customize the prompt instructions, 
sn_skill_builder_admin role is mandatory.

For more information about how to summarize a case, see Summarize a case 
by using Now Assist for Supplier Lifecycle Operations (SLO) in Source-to-Pay 
Workspace.

Supplier performance summarization

Provides supplier managers the complete KPI performance summary including 
overall performance scores, trends, and action items.

For more information about how to summarize a supplier's performance, see 
Summarize supplier performance in Source-to-Pay Workspace.

Sentiment Analysis for supplier case
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The Sentiment Analysis skill analyzes requester's responses and determines the 
overall sentiment associated with a supplier case. The sentiment and sentiment 
trend generated helps you gauge the urgency of a supplier case by indicating 
whether the requester's tone is improving, worsening, or remaining consistent over 
time. For more information, see Analyze sentiments in supplier cases.

Email response for supplier case

The Email response for supplier case skill generates contextually relevant email 
responses by analyzing case details such as case type, short description, 
description, work notes, activity stream, additional comments, related records, and 
relevant knowledge base articles. Use this skill to draft, adjust the tone, shorten, or 
elaborate email responses, reducing the time spent on manual email composition. 
You can also use predefined templates to maintain consistency in your email 
responses. For more information, see Generate an email response for supplier 
cases.

Email response for supplier task

The Email response for supplier task skill generates contextually relevant email 
responses by analyzing task details such as case type, short description, 
description, work notes, activity stream, additional comments, related records, and 
relevant knowledge base articles. Use this skill to draft, adjust the tone, shorten, or 
elaborate email responses, reducing the time spent on manual email composition. 
You can also use predefined templates to maintain consistency in your email 
responses. For more information, see Generate an email response for supplier 
tasks.

To learn how to configure Now Assist for SLO, see Configure Now Assist for Supplier Lifecycle 
Operations (SLO).

To learn more about how to use Now Assist for SLO, see Use Now Assist for Supplier Lifecycle 
Operations (SLO).

Related topics

Supporting information for Now Assist for Supplier Lifecycle Operations (SLO)

Configure Now Assist for Supplier Lifecycle Operations (SLO)

Use Now Assist for Supplier Lifecycle Operations (SLO)

Supporting information for Now Assist for Supplier Lifecycle Operations (SLO)

Get a quick overview of the important information that is related to the Now Assist for Supplier 
Lifecycle Operations (SLO)  application.

Supported versions

Now Assist for SLO  is supported starting with the Xanadu  release.

Supported user interfaces

The Now Assist for SLO  application includes the skills that are listed in the following table.

Now Assist for SLO  supported interfaces

Interface Skill

Virtual Agent Conversational intake for suppliers

Source-to-Pay Workspace Supplier case summarization
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Now Assist for SLO  supported interfaces  (continued)

Interface Skill

Core UI Supplier case summarization

Application information

Activate the Now Assist for SLO  store app (com.snc.sn_supplier_gen_ai) to use the Case 
summarization skill.

This store app has the following dependencies:

• Now Assist for Platform (com.sn.now.platform)

• Supplier Lifecycle Operations (com.snc.sn_supplier_mgmt)

Activate the applications in the following order:

1. Now Assist for Platform (sn_genai_platform)

2. Supplier Lifecycle Operations (com.snc.sn_supplier_mgmt)

3. Now Assist for Supplier Lifecycle Operations (SLO)  (com.snc.sn_supplier_gen_ai)

For more information, see Configure Now Assist for Supplier Lifecycle Operations (SLO).

Configure Now Assist for Supplier Lifecycle Operations (SLO)

If you have the admin role, you can configure the Now Assist for Supplier Lifecycle Operations 
(SLO)  application so that your supplier managers can use the generative AI skills in Source-to-
Pay Workspace  and in Core UI.

Before you begin
Role required: admin

About this task
Use the Now Assist Admin  console to configure Now Assist for SLO. This console contains 
everything that you need to install the plugins and configure the generative AI skills. For 
additional information, see Now Assist Admin console .

The following table lists the feature and skill that you can access from the Now Assist Admin 
console.

Now Assist for SLO  feature and skill in the Now Assist Admin  console

Now Assist for SLO  feature Skill

Case summarization Supplier case summarization
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Now Assist skills for SLO

Procedure

1. Install the Now Assist for Supplier Lifecycle Operations (SLO)  plugin 
(com.snc.sn_supplier_gen_ai).

◦ For information about the plugin dependencies and plugin activation order, see Supporting 
information for Now Assist for Supplier Lifecycle Operations (SLO).

◦ For information about the installation process, see Install Now Assist plugins .

2. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

3. Expand the Finance and Supply Chain  workflow group and select Supplier Lifecycle 
Operations.

The Supplier Lifecycle Operations feature is located under the Finance and Supply Chain 
workflow group. Each feature has its associated skill.

4. Activate and configure the Supplier case summarization skill for Now Assist for Supplier 
Lifecycle Operations (SLO).

Skill Action

Supplier case 
summarization

a. On the Case summarization skill card, select View details.

b. In the All available Case summarization skills section, activate the 
Supplier case summarization skill by selecting Activate skill.

5. Select General Details, review the details about the skill, and select Save and continue  to go 
to the next step in the Guided Setup.

6. Configure and active a skill by using the Guided Setup.
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7. Select View Case Input  and review the base input table and input fields, and then select Save 
and continue  to go to the next step in the Guided Setup.

8. Optional:  Test the prompt on a case by selecting Customize & Test Prompt  and then 
selecting Save and continue  to go to the next step in the Guided Setup.

9. Optional:  Define the availability of the skill by selecting Define Availability, and then selecting 
one of the following options.

Option Description

Skill is always available The skill is available to users at all times.

Customize skill availability

The skill is available only when certain condi­
tions are met (default).

(Optional) Use the condition builder to set 
your conditions.

10. Select Save and continue  to go to the next step in the Guided Setup.

11. Display the Now Assist  skills on forms and workspaces by selecting Select display  and then 
In-product desktop.

12. Select Save and continue  to go to the next step.

13. Review your choices and complete the configuration of the skill by selecting Activate.

14. Select Return to Case summarization.
The skill is displayed in the Active skills section.

Customize a Now Assist for Supplier Lifecycle Operations (SLO)  skill for Case summarization

If you have the admin role, you can customize a Now Assist for Supplier Lifecycle Operations 
(SLO)  skill. By customizing a skill, supplier managers can use the generative AI skills in Source-to-
Pay Workspace  and in Core UI.

Before you begin
Role required: admin

About this task
From the Now Assist Admin  console, you can select the input table, related records, and fields for 
each input template of the Case summarization skill. You can then configure the prompt headers 
to include them in the general summary.

Procedure

1. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Supplier Lifecycle Operations  to 
view the skill for the Now Assist for SLO  feature.

3. Create a copy of the skill and customize the input fields.

a. On the Case summarization feature card, select View details.

b. In the Active skills section, locate the skill that you'd like to copy and select the More actions 

icon ( ).
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c. Select Make copy.

The copy that you make is listed in the Active skills section.

d. Select the copied skill from the Active skills section to open it.
A guided setup leads you through the configuration of the general details, input, prompt, 
availability, display, review, and activation of the customized skill. If you complete the entire 
walk-through, the skill is activated.

4. In the General details step, fill in the fields.
For information about the inputs for each skill, see Skill input for Now Assist for Supplier 
Lifecycle Operations (SLO).

a. Enter a name and description for the skill.

b. Select Save and continue  to go to the next step.

5. View the input data for each skill, such as the base input fields and related lists for the different 
input templates.

Configure the base input table fields and related lists for the different input templates for the 
skill.

Each skill relies on a base input table and input fields with descriptions to provide context for 
the Now LLM Service  to generate a response.

Select only those related tables that are offered as the base system, as part of the input data.

a. For each input template state, select +New base input field  and configure the base input 
table fields.

Add multiple base input fields, as necessary.

The following table lists the base input table fields and descriptions, including a relevant 
example.

Base input fields

Field Description

Base input field
Field in the case table whose value this skill 
uses in its response.

For example, Short description.

Field description
Description of the base input field value.

For example, Short description 
of case, provides quick info 
about the case.

b. For each input template state, configure the rule conditions by using the condition builder to 
filter the data.

The rule conditions determine when the input template is used. By default, the record state 
determines the input template that the Now LLM Service  uses.
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You can build the condition out further by selecting +New condition set  and configuring 
additional parameters.

c. For each input template state, select +New data source  to configure the additional related 
table and activity stream data, as needed.

You can add input data sources like related tables, activity streams, and relationships to 
provide more context to the Now LLM Service. You can also add rule conditions to these 
additional data sources.

The selection of the related table fields can have a direct impact on the quality of the 
corresponding prompt header. If a prompt header requires a specific field from a related 
table, but that field isn’t selected as input, the summary for that prompt header contains 
missing information.

d. Select Save and continue  to go to the next step.

6. Customize the prompt.

Review and test the prompt for each input template configuration. You can edit the prompt by 
adding new predefined sections and reordering them, as needed.

a. For each input template state, select the prompt sections from the list of available sections 
to include in the generated summary.

To add a section, you must configure the relevant input data prior to this step.

The available prompt sections that you can select:

▪ Overview

▪ Actions completed

▪ Next steps

The following table lists the required prompt headers.

Required prompt headers

Input template state Required prompt header

Open ▪ Overview

▪ Actions completed

▪ Next steps

Closed ▪ Overview

▪ Actions completed

b. Select Save  to continue to the test response.

c. Select a record in the Test response section, and test the prompt response output format by 
selecting Run Test.

d. Select Save and continue  to go to the next step.
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7. Define how the skill is available to your users.

a. Configure the skill to be always available to users, or select conditions that must be met 
before the skill is available.
Selecting Customize skill availability  displays a condition builder to filter the data further.

b. Select Save and continue  to go to the next step.

8. Configure where to display the supplier case summarization.

a. Select In-product desktop  to display the Now Assist  skills on forms and workspaces.
For the skills that appear in the in-product desktop, select the down arrow to identify the 
roles that can use the skill.

b. Select Save and continue  to go to the next step.

9. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
You can select Summarize  in a record to generate the summary for the supplier case.

Customize Now Assist for Supplier Lifecycle Operations (SLO)  to use the Virtual Agent  chat

If you have the admin role, you can configure the Now Assist for Supplier Lifecycle Operations 
(SLO)  application so that suppliers can use the generative AI skills in Source-to-Pay Workspace 
and in Core UI.

Before you begin
Role required: admin

About this task
Use the Now Assist Admin  console to configure Now Assist for SLO. This console contains 
everything that you need to install the plugins and configure the generative AI skills. For 
additional information, see Now Assist Admin console .

Procedure

1. Install the Now Assist for Supplier Lifecycle Operations (SLO)  plugin 
(com.snc.sn_supplier_gen_ai).

◦ For information about the plugin dependencies and plugin activation order, see Supporting 
information for Now Assist for Supplier Lifecycle Operations (SLO).

◦ For information about the installation process, see Install Now Assist plugins .

2. Navigate to All  > Conversational Interfaces  > Assistants.

3. From the list of existing LLM Virtual Agents, select Now Assist in Virtual Agent - Supplier.

4. Review the details about Virtual Agent  by selecting Overview  and then selecting Save and 
continue  to go to the next step in Guided Setup.

5. Review the selected conversational skills by selecting Now Assist skills  and then selecting 
Save and continue  to go to the next step in Guided Setup.

6. Review the selected portal by selecting Display experience  and then selecting Save and 
continue  to go to the next step in Guided Setup.

7. Review the search sources by selecting Information Sources  and then selecting Save and 
continue  to go to the next step in Guided Setup.
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8. Review the branding information by selecting Branding  and then selecting Save and continue 
to go to the next step in Guided Setup.

9. Review the structure of the chat experience by selecting Chat experience  and then selecting 
Save and continue  to go to the next step in Guided Setup.

10. Review all the details by selecting Review  and then selecting Turn on.

Skill input for Now Assist for Supplier Lifecycle Operations (SLO)

You can configure some of the inputs for a generative AI skill. Inputs permit you to determine how 
and when a skill is used.

Overview of skills

Inputs identify the data used for a skill. Inputs include the table and fields used to generate a 
case summary.

You can modify inputs, but you can't modify a skill's data source. The data source contains the 
tables and fields that the skill relies on.

Now Assist skill for Now Assist for SLO

The Now Assist for SLO  includes the Supplier case summarization skill.

Supplier case summarization skill

Inputs for the Supplier case summarization skill identify the table and fields that are used when 
the summary is generated for a supplier request.

The following table lists the inputs for the Supplier case summarization skill from the Choose 
input for supplier request page in the Now Assist Admin  console.

Input Description

Base input table Supplier case [sn_slm_case] table.

Base input fields • Short description

• Description

• State

• Work notes

• Additional comments

• Assigned to

• Created

• Created by

• Due date

• Case type

• Supplier

• Priority

• Close notes
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Use Now Assist for Supplier Lifecycle Operations (SLO)

If you have the sn_slm.fulfiller or admin role, you can generate supplier-related case summaries 
to get a quick overview of the cases, completed actions, or pending tasks by using the Now 
Assist for Supplier Lifecycle Operations (SLO)  application.

For more information on how to use Now Assist for SLO  to summarize a case, see Summarize a 
case by using Now Assist for Supplier Lifecycle Operations (SLO) in Source-to-Pay Workspace.

For more information on how to use Now Assist for SLO  in a Virtual Agent chat, see Use Now 
Assist for Supplier Lifecycle Operations (SLO) in a Virtual Agent chat.

Related topics

Summarize a case by using Now Assist for Supplier Lifecycle Operations (SLO) in Source-to-
Pay Workspace

Use Now Assist for Supplier Lifecycle Operations (SLO) in a Virtual Agent chat

Explore Now Assist for Supplier Lifecycle Operations (SLO)

Configure Now Assist for Supplier Lifecycle Operations (SLO)

AI driven supplier onboarding using Now Assist for SLO

Use the AI driven supplier onboarding playbook to automate onboarding tasks such as supplier 
registration, information validation, and task list generation.

Accessing the AI driven supplier onboarding playbook

To access the AI driven supplier onboarding playbook:

1. In the decision builder, open the Supplier case playbook.

a. Change the existing playbook case type from Onboard new supplier  to AI driven supplier 
onboarding.

b. Select Save.

2. Set the default model for the One Extend capabilities.

a. Navigate to Sys_One_Extend_Capability.

b. Open the Generic Prompt record.

i. Go to the OneExtend Definition Configs related list.

ii. In the default column, ensure that at least one model is marked to True.

c. Open the Summarize record.

i. Go to the OneExtend Definition Configs related list.

ii. In the default column, ensure that at least one model is marked to True.

Available AI agents in AI driven supplier onboarding

The following table lists the agents that are used in the workflow.

Important:  In the Define availability screen for the AI agent, make sure that the Status 
toggle is enabled to activate the AI agent.
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AI agents used in AI driven supplier onboarding

AI agent AI agent role

Supplier data steward AI agent • Ensures that the supplier data is accurate, compliant, 
and continuously maintained across systems. During 
onboarding, this agent also checks for duplicate supplier 
records.

Note:  Duplicate supplier onboarding 
requests can be resolved from the 
Now Assist  panel by updating the 
legal name or the email domain 
of the primary contact's email 
address.

• Handles supplier onboarding by creating an invitation 
case for the supplier contact and assigning the 
necessary supplier tasks. Additionally, it ensures that 
the supplier case status is updated appropriately in the 
system.

Supplier data validator AI agent Validates supplier-provided data and documents in real 
time during onboarding, profile updates, or transactional 
interactions. This agent extracts details from the attached 
banking proof document and compares it with the 
submitted information to validate its accuracy.

Supplier approval AI agent
On approval, confirms supplier activation, activates 
supplier record and updates supplier company 
information, sends welcome email to the supplier, notifies 
the requester on onboarding status, and updates the case 
status to Closed complete.

On rejection, provides a reason for rejection, sends an 
email to the supplier, notifies the requester and supplier 
about onboarding status, and updates the case to Closed 
rejected.

Supplier document strategy 
generator AI agent • Generates dynamic onboarding flows that are 

customized to meet the supplier's compliance and 
regulatory documentation requirements. Flows are 
customized based on the following two factors:

◦ The region in which the supplier is based.

◦ The industry in which the supplier operates.

• Automatically creates tasks for the onboarding flow by 
referencing all published Knowledge Base (KB) articles.

Note:  In the approval stage, supplier managers can also approve or reject supplier 
onboarding using the Yes and No buttons.
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Activities in the AI driven supplier onboarding playbook

Activities in the AI driven supplier onboarding playbook

Activity Description

AI suggested similar suppliers This activity is triggered when an onboarding 
request originates from a sourcing request. 
When a shopper selects an external supplier 
to fulfill a purchase request, an onboarding 
request is created automatically to onboard 
the external supplier.

The AI suggested similar suppliers activity 
analyzes the sourcing request and suggests 
similar suppliers. You can select either of the 
following options to proceed:

• Cancel the current onboarding request by 
selecting the reject button.

• Continue with the current onboarding 
request by selecting the continue button.

AI driven primary data validation This activity is triggered during the registration 
stage to validate banking details submitted 
by the supplier contact. It cross-references 
the banking details against the information 
in the attached proof and highlights any 
discrepancies, enabling the supplier 
relationship manager to resolve them.

A supplier task is first created for the supplier 
contact to submit banking details through 
the Supplier Collaboration Portal. Once 
the supplier contact submits the banking 
details, the AI driven primary data validation 
activity is triggered. The supplier relationship 
manager can then choose to update either 
the record or the attached proof to resolve the 
discrepancies.

Note:  Supplier contacts must select 
the Extract values from the attachment 
to auto-populate form fields.  checkbox 
while completing the supplier banking 
information task to auto-populate 
bank name, account holder name, and 
account number.

The AI agent decision log displays the AI agents that are working to resolve the case, and you 
can watch their interactions, decisions, and thought processes as they happen in real time.

Activate AI agents individually

Activate all the AI agents individually that you want to make available for the Coordinate supplier 
onboarding agentic workflow.
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Before you begin
Role required: aia-admin

Procedure

1. Navigate to All  > AI Agent Studio  > Overview.

2. Under AI agents, select and activate all the AI agents one by one to make them available in the 
Now Assist  panel.

◦ Data steward AI agent

◦ Supplier response handler AI agent

◦ Supplier collaborator AI agent

For example, let's assume that you select the Data steward AI agent.

3. In the Describe and instruct page, select Continue.
The Describe and instruct page is read-only.

4. In the Add tools and information page, select Continue.
The Add tools and information page is read-only.

5. In the Describe and instruct page, select Continue.
The Describe and instruct page is read-only.

6. In the Define trigger page, select Continue.
The Describe trigger page is read-only.

7. In the Define availability page, switch the Display  toggle to the open position so that the AI 
agents are enabled in the Now Assist  panel.

8. To activate the agentic workflow, select Save and test.

Supplier document strategy generator AI agent

Generate a customized onboarding task list that meets the supplier's compliance and regulatory 
requirements using the Supplier document strategy generator AI agent.

The Supplier document strategy generator AI agent analyzes all published knowledge base 
articles using the RAG (Retrieval-Augmented Generation) framework to gather information 
on compliance and regulation-related tasks. Based on the analysis, the AI agent generates a 
contextualized list of tasks specific to the supplier's region and industry.

Note:  The Supplier document strategy generator AI agent includes a default knowledge 
base article in the Supplier Knowledge section. This article contains a comprehensive list 
of compliance and regulatory requirements that suppliers must meet during onboarding 
based on their industry and region. You can access the knowledge base article from the 
Supplier Knowledge section.

Automated task list

In the AI driven supplier onboarding workflow, supplier managers are prompted to provide the 
supplier's location and industry type as inputs on the Now Assist panel. The AI agent cross-
references these inputs with all the published knowledge base articles and identifies the 
required compliance and regulatory tasks.

Supplier Managers can view the list of tasks identified by the AI agent on the Playbook  tab. They 
can remove tasks from this list by clearing the respective check boxes. Supplier Managers can 
also add new tasks by selecting the Add item  option. The tasks created are of the type document 
upload.
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Note:  Mandatory tasks are grayed out and cannot be edited.

After the tasks are generated, Supplier Managers can update the details of the tasks by adding 
notes and comments. They can also create tasks manually.

Automate supplier case creation from emails

Emails received from supplier contacts can be automatically converted to supplier cases using 
the Email Intent to Action Agentic workflow.

The Email Intent to Action Agentic workflow analyzes incoming supplier emails, identifies the 
email intent, and executes associated actions using the Intent Identification and Intent Executor 
agents. For more information on the Email Intent to Action Agentic workflow, see Email Intent to 
Action Agentic Workflow .

Prerequisites for automated creation of supplier cases

To use this functionality, verify that the following steps are completed:

• Configure the [sn_supplier.slm_email] system property and edit the Value field to contain 
supplier email address. For more information, see Configure properties for Supplier Lifecycle 
Operations.

• Deactivate the Create Supplier case for email inbound action. For more information, see 
Deactivate Create supplier case from email inbound action.

• Activate the Trigger Intent to Action inbound action. For more information, see Enable intent to 
action workflow from inbound actions .

Automatic creation of supplier cases workflow

1. When an email arrives in a supplier’s inbox, the sender details are verified. If the sender is not 
a registered supplier contact, an automated reply is sent for registration.

2. If the sender is a registered supplier contact but is mapped to several suppliers, an automated 
reply is sent to request clarification.

3. The Intent Identification Agent analyzes the inbound email and identifies its intent. Once 
identified, this intent is mapped to a preconfigured and customized intent within the system. 
For more information, see Create and associate actions for intent .

4. The Intent Executor Agent creates cases based on the following criteria:

◦ If the email contains SLO  related queries, a supplier case is created for each of the queries. 
The cases are assigned automatically to the supplier relationship manager.

◦ If the email contains vague information or queries unrelated to SLO, a universal request is 
created.

◦ If the email contains multiple queries, supplier cases are created to resolve SLO  related 
queries and a single universal request is created for other queries.

Related topics

Deactivate Create supplier case from email inbound action

Deactivate Create supplier case from email inbound action

The Create Supplier case for email inbound action must be inactive for automatic creation of 
supplier cases from emails using Now Assist.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Policy  > Email  > Inbound Actions.

2. Select the Create supplier case from email  inbound action.

3. On the inbound action form, clear the Active  check box.

Result
The Create supplier case from email inbound action is deactivated.

Summarize a case by using Now Assist for Supplier Lifecycle Operations (SLO)  in Source-to-
Pay Workspace

Summarize supplier-related cases to learn more about their status, progress, and action items by 
using the supplier case summarization skill in the Now Assist for Supplier Lifecycle Operations 
(SLO)  application.

Before you begin
Role required: sn_supplier_gen_ai.now_assist_fulfiller

Note:  This role must be provided to the sn_slm.fulfiller user.

About this task
You can use the supplier case summarization skill in either Core UI  or Source-to-Pay Workspace.

• In Core UI, the summary appears in a banner in the record.

• In Source-to-Pay Workspace, the summary is generated in the Details  tab.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > All work  and select either of the following records:

◦ Cases

◦ Closed cases

4. Under the Number column, select the link to the supplier case.

5. In the Record summary section, select Summarize.
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6. Review the summary details.

A concise summary of a case includes the overview, actions completed, and next steps. The 
information that is displayed is based on the type of the case:

◦ Overview: Provides information about the case.

◦ Actions Completed: Lists all the actions that have been taken so far.

◦ Next steps: Lists the actions that the supplier managers must take next.

7. Optional:  When you finish summarizing a case, you can add it to the work notes, expand or 
collapse it, provide feedback, copy it, or view information about it.

Option Procedure

Save the summary information by adding it 
to the record work notes

a. Select Share to work notes.

b. In the Share to work notes dialog box, edit 
the summary.

c. Select Save to work notes.

Expand or collapse the summary
Select the expand card icon ( ) or the col­

lapse card icon ( ) to see more details or 
fewer summary details.

Provide feedback for the summary

If you think that the summary was helpful, se­

lect the helpful icon ( ). If you think that the 
summary wasn’t helpful, select the not helpful 

icon ( ).

This feedback improves the generative AI 
model and can help to improve the future ver­
sions of this skill.

Copy the record summary
Select the copy to clipboard icon ( ) to use 
the record summary information for another 
purpose, such as pasting into an email.

View the information about the record sum­
mary

If you want to check some details about the 
summary, select the more info icon ().

Refresh the record summary
If you want to refresh the summary, select the 

refresh icon ( ).

Summarize supplier performance in Source-to-Pay Workspace

Generate comprehensive performance summary including overall performance scores, trends, 
and action items by using the supplier performance summarization skill in the Now Assist for 
Supplier Lifecycle Operations (SLO)  application.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .

Role required: admin, slm manager
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About this task

• This skill is available from the March 26 Yokohama  release onwards.

• You can use the supplier performance summarization skill in the Source-to-Pay Workspace  in 
the KPI Management  tab.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Suppliers  and select the legal name of the supplier for which you want to 
generate the performance summary.
The supplier details page is displayed.

4. Under the KPI management  tab, select Summarize  to generate the performance summary 
with Now Assist.

5. Review the summary details.

A concise summary includes the overall supplier performance score, trend, performance 
details, historical context, and next steps. The information that is displayed is based on the 
KPIs available for the selected supplier.

◦ Supplier performance score: Latest overall supplier performance score calculated from the 
weighted average scores of all KPIs.

◦ Trend: KPI failure patterns over time, performance trends, and recurring areas of concern.

◦ Performance details: Lists all the failing KPIs, failing KPIs in action plans, and at-risk KPIs.

◦ Historical context: Lists the number of action plans created, targets achieved, and previous 
focus areas.

◦ Steps ahead: Lists the actions that the supplier managers must take next.

Analyze sentiments in supplier cases

Use the Sentiment Analysis skill in Now Assist for Supplier Lifecycle Operations (SLO)  to analyze 
a requester's response and determine the sentiment and sentiment trend associated with a 
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supplier case. You can gauge the urgency of a supplier case and prioritize your responses based 
on the sentiment analysis.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .

Role required: sn_supplier_gen_ai.now_assist_fulfiller and sn_slm.fulfiller

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon .

3. Go to Cases  > Open.

4. Select a supplier case.
The case detailed view appears.

5. Select the information icon  to view the reasoning behind the generated sentiment.

6. Optional:  Manually refresh the sentiment analysis.

a. Selecting the information icon .

b. View the updated sentiment analysis by selecting the refresh icon .

Generate an email response for supplier cases

Generate an email response for supplier cases.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .

Role required: sn_supplier_gen_ai.now_assist_fulfiller and sn_slm.fulfiller

About this task
The Email response for supplier case skill uses supplier case details such as case type, short 
description, description, work notes, activity stream, additional comments, related records, and 
relevant knowledge base articles to compose an email response. You can also use this skill to 
elaborate, shorten, or change the tone of your email draft.
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon.

3. Go to All work  > Cases.

4. Select a supplier case.
The case detail view appears.

5. Go to the Email  tab.

6. Click anywhere within the email body textbox.

7. Generate an email draft by selecting the Now Assist icon .

8. Select Insert.

9. Optional:  Elaborate, shorten, or change the tone of an email body.

a. Select the required content.

b. Select the Now Assist icon .

10. Optional:  Apply templates by selecting the template icon .

Result
An AI generated email draft is created.

Related topics

Generate an email response for supplier tasks

Automate supplier case creation from emails

Analyze sentiments in supplier cases

Generate an email response for supplier tasks

Generate an email response for supplier tasks.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .
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Role required: sn_supplier_gen_ai.now_assist_fulfiller and sn_slm.fulfiller

About this task
The Email response skill uses supplier task details such as task type, short description, 
description, work notes, activity stream, additional comments, related records, and relevant 
knowledge base articles to compose an email response. You can also use this skill to elaborate, 
shorten, or change the tone of your email draft.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon.

3. Go to Tasks  > Open.

4. Select a supplier task.
The task detail view appears.

5. Go to the Email  tab.

6. Click anywhere within the email body textbox.

7. Generate an email draft by selecting the Now Assist  icon.

8. Select Insert.

9. Optional:  Elaborate, shorten, or change the tone of an email body.

a. Selecting the required content.

b. Select the Now Assist icon .

10. Optional:  Apply templates by selecting the template icon .

Result
An AI generated email draft is created.

Use Now Assist for Supplier Lifecycle Operations (SLO)  in a Virtual Agent  chat

Use the conversational interface of Now Assist for Supplier Lifecycle Operations (SLO)  to request 
contextually relevant generative AI capabilities through a Virtual Agent  chat.

Role required: sn_supplier_gen_ai.now_assist_supplier
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Note:  This role must be provided to the sn_slm.contact user.

As a supplier, you can use the predefined topics (chatbot conversations) that are designed to 
help you complete self-service tasks. You can manage a profile, manage users, submit a request, 
track request status, or connect to a live agent by using contextual generative AI capabilities.

To start a conversation, navigate to All  > Supplier Lifecycle Operations  > Supplier Collaboration 

Portal  and select the Virtual Agent chat icon ( ).

Starting screen for the Now Assist for SLO  in a Virtual Agent  chat

The following example shows the starting screen for the Now Assist for SLO  in a 
Virtual Agent  chat.

Then, you select Show all my options  as shown in the following example.
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All topics in the Now Assist for SLO  in a Virtual Agent  chat

Using a predefined topic to update the bank details

As a supplier contact, you can update your existing bank details or submit a new one by 
selecting Show all my options  > Update banking details. You could also directly start entering 
the instructions.

You must enter the email address that is associated with your organization's account to update 
your bank details. Follow the instructions in the chat to complete the procedure as shown in the 
following example.
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Update the bank details

You must upload proof of the beneficiary's bank account to edit the request.

Select Yes, submit  to create a supplier case.

Using a predefined topic to update the location details

As a supplier contact, you can add a new location or remove an existing one by selecting Show 
all my options  > Update location details. You could also directly start entering the instructions.

For example, enter Add new location details  in the chat to add a new location. Select 
a country from the list and follow the prompts in the chat to complete the procedure as shown in 
the following example.
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Update the location details

Select Yes, submit  to create a supplier case.

Using a predefined topic to update the profile details

As a supplier contact, you can update the profile details by selecting Show all my options  > 
Update profile details. You could also directly start entering the instructions.

Select Edit request  to update the profile details and enter the profile details that you want to 
update. Follow the prompts in the chat to complete the procedure.

Select Yes, submit  to create a supplier case as shown in the following example.
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Supplier case for the profile update

Using a predefined topic to submit a request

As a supplier contact, you can submit a request by selecting Show all my options  > Submit a 
request. You could also directly start entering the instructions.

Enter Supplier inquiry  in the chat, describe the case, and select a supplier contact from 
the list to create a request as shown in the following example.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

908



Submit a request

Select Yes, submit  to create a supplier case.

Using a predefined topic to track a request status

As a supplier contact, you can track a request status by selecting Show all my options  > Track 
request status. You could also directly start entering the instructions.

For example, enter I want to know the status of SCASE0001156  in the chat to 
view the status of the request as shown in the following example.
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Track a request status

Using a predefined topic to enroll a new user

As a supplier contact, you can enroll a new user by selecting Show all my options  > Enroll a new 
user. You could also directly start entering the instructions.

Enter the work email address of the new user and select if you want this new user as the primary 
contact as shown in the following example.
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Enroll a new user

Select Yes, submit  to create a supplier case.

Using a predefined topic to remove a user account

As a supplier contact, you can remove a user account by selecting Show all my options  > 
Remove user account. You could also directly start entering the instructions.

Enter the name of the user or the email address of the user account that you want to remove. 
Enter the email address of the user who will take over the tasks that were delegated to the 
removed user. You must also provide a reason for offboarding this user. The following example 
shows how to remove a user account.
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Remove a user account

Select Yes, submit  to create a supplier case.

Using a predefined topic to request an access change

As a supplier contact, you can request an access change by selecting Show all my options  > 
Request access change. You could also directly start entering the instructions.

Note:  Only a secondary contact can request an access change.

Select the urgency of the access change, such as low, moderate, or high. Enter the reason for 
requesting the access change from secondary to primary as shown in the following example.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

912



Request an access change

Select Yes, submit  to create a supplier case.

Using a predefined topic to connect to a live agent

As a supplier contact, you can connect to a live agent by selecting Show all my options  > 
Connect to a live agent.

Select Supplier management team  to connect to a live agent as shown in the following example.
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Connect to a live agent

Additional Information

Now Assist  in Virtual Agent  provides your users with an interactive generative AI experience. 
A friendly, natural language conversation is easier to understand and makes supplier contacts 
more comfortable with talking to a bot. To learn how a conversation that is powered by generative 
AI might look in Virtual Agent, see Using Now Assist in Virtual Agent .

As an administrator, you can use the Now Assist  in Virtual Agent  Analytics dashboard to monitor 
the performance of Now Assist  in Virtual Agent  as a self-service deflection tool. To learn more, 
see . Now Assist  in Virtual Agent  Analytics calculates the conversation deflection rate that 
is based on the resolution status associated with Now Assist  query responses. For more 
information, see .

For detailed information on Now Assist  in Virtual Agent  in general, and Now Assist for SLO  in 
particular, see Explore Now Assist for Supplier Lifecycle Operations (SLO).

For information on configuring Now Assist for SLO, see Configure Now Assist for Supplier 
Lifecycle Operations (SLO).

Exploring Supplier Lifecycle Operations
Use ServiceNow®  Supplier Lifecycle Operations  to empower suppliers with self-service to 
simplify operations and improve productivity.
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Overview of Supplier Lifecycle Operations

Supplier Lifecycle Operations  enables you to onboard suppliers quickly, effortlessly manage 
supplier data, add key supplier contacts, monitor supplier performance, and enhance the 
productivity of the teams that engage with suppliers.

Benefits of Supplier Lifecycle Operations

Supplier Lifecycle Operations  provides the following benefits:

• Faster supplier onboarding: View details about new suppliers and onboard suppliers quickly 
using onboarding workflows and start purchasing goods and services.

• Automatically import supplier information: Supplier Lifecycle Operations  integrates with the 
supplier Intelligence platform, Craft, which enables you to import and view all the important 
supplier details.

• Supplier self-service: Enhance the supplier experience by enabling suppliers to complete 
onboarding tasks, get their questioned answered, and fulfill requests, such as viewing open 
purchase orders and submitting invoices.

• Supplier data management: Provide flexibility to suppliers to manage and update their own 
data, ensuring that the supplier data is current and up to date.

• Supplier case and contact management: Create and manage supplier cases, add, and manage 
supplier contacts.

• Minimize risk during supplier onboarding: Identify and assess potential supplier risks when 
onboarding new suppliers.

• Manage supplier relationship and performance: Monitor and assess supplier performance by 
setting up criteria for measuring supplier performance though KPIs and thresholds.

• Many-to-many (M2M) mapping between supplier contact and suppliers: A single supplier 
contact can be the contact for multiple suppliers, if those suppliers share a parent-subsidiary 
relationship.

Important:  M2M mapping between supplier contact and suppliers is available from 
the Xanadu  December 2024 release onwards. To enable M2M mapping, see Enable M2M 
mapping between supplier contact and suppliers.

• Supplier payment optimization: Supplier managers can view the potential returns or savings 
when a supplier accepts commercial credit card payments. They can convert high-potential 
suppliers, and capture value through card-based payments.

For more information about installing and configuring Supplier Lifecycle Operations, see 
Configuring Supplier Lifecycle Operations.

Supplier Lifecycle Operations  applications

Supplier Lifecycle Operations  includes the following applications.

Supplier Lifecycle Operations  applications

Application Description

Supplier Case 
Management

The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.
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Supplier Lifecycle Operations  applications  (continued)

Application Description

Supplier 
Common 
Architecture

Provides a common architecture to track data objects related to a supplier 
used in both Supplier Lifecycle Operations  and Supplier Collaboration Portal.

Source-to-Pay 
Workspace

Enables you to centralize supplier information and collaborate with suppliers to 
improve performance.

Important:  Starting with the Washington D.C. release, Supplier 
Manager Workspace  is being prepared for future deprecation. It’s hidden 
from the navigation and no longer is activated on new instances but will 
continue to be supported. Source-to-Pay Workspace  provides the latest 
experience for this functionality.

Supplier 
Collaboration 
Portal

Provides a single, one-stop experience for suppliers to get self-service, 
complete tasks and make requests into an organization.

Supplier 
Operations

Provides advanced case management capabilities to handle key supplier 
lifecycle events such as onboarding, offboarding, and ongoing operations.

Supplier 
Relationship 
and 
Performance 
Management

Enables you to establish clear expectations and criteria for measuring supplier 
performance, monitor, and assess their performance against those criteria.

Supplier 
Payment 
Optimization

Enables supplier managers to view the potential returns or savings when 
suppliers accept commercial credit card payments. They can convert high-
potential suppliers, and capture value through card-based payments.

Advanced 
Work 
Assignment 
for Supplier 
Lifecycle 
Operations

Automatically assign supplier cases to agents based on availability and 
capacity.

Risk 
Assessments 
Integration 
for Supplier 
Lifecycle 
Operations

Provides an integration with the Third-party Risk Management (TPRM) 
application to conduct due diligence when onboarding new suppliers.

News 
Integration 
for Supplier 
Lifecycle 
Operations

Retrieve recent news and other articles from preferred news channels. There’s 
a preconfigured integration with Microsoft  Bing available with this application.

Craft.co 
Integration 
for Supplier 
Lifecycle 
Operations

Provides a preconfigured integration with Craft.co. Craft.co is a supplier 
intelligence platform that offers validated and comprehensive information 
about suppliers with which a company engages.
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Supplier Case Management

The Supplier Case Management  application (com.snc.sn_supplier_mgmt) logs and tracks all 
supplier-related cases and tasks. It also provides support for Advanced Work Assignments and 
the ability to resolve cases via playbooks.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

The Supplier Case Management  application (com.snc.sn_supplier_mgmt) provides basic case 
management capabilities for supplier-related cases. The supplier cases can be created through 
various channels such as Workspace, email, and other supported methods. The application also 
supports task creation and tracking, enabling users to manage and resolve supplier issues more 
efficiently.

Supplier Case Management  has the following plugin dependencies:

• Supplier Common Architecture  (com.snc.sn_slm)

• Source-to-Pay Workspace (com.sn_spend_workspace)

For more information about installing and configuring Supplier Case Management, see Install 
Supplier Lifecycle Operations.

Related topics

Supplier Common Architecture

Source-to-Pay Workspace

Advanced Work Assignment for Supplier Lifecycle Operations

Using Source-to-Pay Workspace

Supplier Collaboration Portal

The ServiceNow®  Supplier Collaboration Portal  application provides a seamless unified 
employee portal experience for supplier contacts.

Supplier Collaboration Portal  enables you to do the following:

• Resolve supplier inquiries using self-service and Knowledge  articles

• Improve supplier data quality by enabling suppliers to manage their own data

• Accelerate case resolution by enabling suppliers to complete tasks and upload required 
prerequisite documents

As a supplier contact, you must first self-register to access the Supplier Collaboration Portal. For 
more information, see Self-register to the Supplier Collaboration Portal.

In the Supplier Collaboration Portal, you can view the requests assigned to you, open to-dos, and 
Knowledge  articles.

Note:  The Supplier Collaboration Portal  is supported on mobile devices. To access the 
Supplier Collaboration Portal  on a mobile device, open a mobile browser, and then navigate 
to your instance URL and append the /supplier suffix to the end of the URL. For example, 
https://example.com/supplier.

For more information about installing the Supplier Collaboration Portal, see Install Supplier 
Collaboration Portal.
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Supplier Collaboration Portal  header

The portal header contains the following options:

Options on the Supplier Collaboration Portal  header

Option Description

My 
Company

Opens the Supplier Profile page, which shows the supplier details. You can submit a 
request to update the details by selecting Request Change.

For more information, see Update company profile using the supplier catalog.

Important:  From Xanadu  December 2024 release onwards, after enabling 
M2M mapping between supplier contact and suppliers, the list of suppliers 
linked with the contact are displayed on selecting My Company. You can 
select a supplier from the list which opens the company-specific Supplier 
Profile page.

Tasks Contains the following submenus.

Note:  Only the primary contact can see the Tasks menu and its submenus in 
the portal header.

• My Tasks: Opens the My To-dos page, which lists all the tasks that are assigned to 
the logged-in user.

Note:  The secondary contact can view only the My Tasks option in the 
portal header.

• All Tasks: Opens the Supplier Task List page, which lists all the tasks that are 
assigned to the supplier.

For more information, see Viewing supplier contact tasks from the Supplier 
Collaboration Portal.

My 
Requests

Opens the My Requests page, which lists all the requests assigned to you.

For more information, see View all your requests from the Supplier Collaboration 
Portal.

Raise a 
request

Option that enables you to raise a request by navigating to the General category in 
the Supplier catalog.

For more information, see Raising requests from the Supplier Collaboration Portal.

Supplier Collaboration Portal  widgets

The Supplier Collaboration Portal  contains the following widgets.
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Supplier Collaboration Portal  widgets

Widget Description

How can 
we help?

Lets you search for any information that you're looking for.

My 
active 
items

As a supplier contact, you can view and work on specific items. The information that 
is displayed in the tiles depends on the plugins that you have installed. Selecting a 
tile in the widget opens the page that provides more information about it.

• Tasks

• Requests

• Surveys

• Issues

• Risk Assessments

• Contracts

• Supplier Products

• Purchase Orders

• Shipments

• Invoices

The Risk Assessments tile is displayed if you have installed the Third-party Risk 
Management  plugin.

The Contracts, Supplier Products, Purchase Orders, Shipments, and Invoices 
tiles are displayed if you have installed the Sourcing and Purchasing Automation 
(com.snc.sn_pr) and Source-to-Pay Common Architecture (com.snc.sn_shop) 
plugins.

Important: 

The data for My active items  is sourced from the Activity Configurations 
table. For all the new custom records added to Activity Configurations 
that need to be shown in My active items, the corresponding ACLs for 
sn_slm_contact must also be explicitly added.

Also, for restricting the data appearing in My active items, you can configure 
the user criteria by updating the Activity Access  list of the Activity 
Configurations  table.

My tasks Displays a list of supplier tasks assigned to you. Selecting a task directly opens it on 
the My To-dos page so that you can work on that task. Select View All  to view a list 
of all the tasks assigned to you.

Important:  The data for My tasks  is sourced from the To-dos 
Configurations  table. For all the new custom records added to To-dos 
Configurations  that need to be shown in My tasks, the corresponding ACLs 
for sn_slm_contact must also be explicitly added.
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Supplier Collaboration Portal  widgets  (continued)

Widget Description

My 
requests

Displays a list of cases that you have submitted. Selecting a case directly opens the 
My Cases page so that you can work on that case. Select View All  to view a list of all 
the cases that you have submitted.

Quick 
links

Enables the supplier to access internal and external resources related to specific 
departments within your organization.

My 
company

This section has the following fields:

• Number of employees: The number of people employed by the company.

• Founded: The year the company was founded.

• Industry: The type of industry the company belongs to.

• Relationship manager: The name of the relationship manager for your company.

• Onboarded date: The date your company was onboarded.

Select Details  to view details, contact information, payment information, and 
locations of your company.

My 
contacts

Displays a list of members on your team. You can call a member directly or send 

an email to a member by selecting the phone icon ( ) or the email icon ( ) 
respectively, next to that team member's name. You can also invite new members to 
register to by selecting Invite.

Note:  The Invite  option is available only to the primary supplier contact and 
the supplier administrator. Only the primary supplier contact and the supplier 
administrator can invite new members to access the Supplier Collaboration 
Portal. For more information, see Invite a member to access the Supplier 
Collaboration Portal.

Most 
viewed 
articles

Displays a list of the most viewed articles.

For more information about using the Supplier Collaboration Portal, see Using Supplier 
Collaboration Portal.

Supplier Operations

Supplier Operations provides advanced case management capabilities to handle key supplier 
lifecycle events such as onboarding, offboarding, and ongoing operations.

Important: 

• Check your entitlements to determine whether you have access to Supplier Operations.

• The new plugin Supplier Operations  (com.snc.sn_so) (v 1.2.0 ) must be installed after 
upgrading to the Supplier Case Management Yokohama  December 2025 (v 5.2.0) 
release. For more information, see Install Supplier Operations.

The Supplier Operations  application (com.snc.sn_so) provides the following capabilities:
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• Case management for:

◦ Handling supplier onboarding and offboarding, and ongoing operations.

◦ Handling supplier lifecycle ongoing operations.

◦ Resolving cases via Playbooks for a structured and consistent approach.

• Integrations with third-party solutions such as Craft and Relish.

• Access to Document Management and Segmentation Rules.

To install Supplier Operations, the following plugins have to be installed:

• Required plugin: Supplier Operations (com.snc.sn_so)

• Dependent plugins:

◦ Supplier Case Management (com.snc.sn_supplier_mgmt)

◦ Document Management (com.snc.platform_document_management)

For more information about installing Supplier Operations, see Install Supplier Operations.

Related topics

Supplier Case Management

Source-to-Pay Workspace

Use the supplier onboarding playbook to onboard suppliers

Manage supplier cases from the Source-to-Pay Workspace

Supplier Relationship and Performance Management

Managing supplier relationship and performance is a key aspect of supplier management that 
aims to optimize the value and quality of the products and services delivered by suppliers.

The Supplier Relationship and Performance Management (com.snc.sn_slm_perf) application 
enables you to establish clear expectations and criteria for measuring supplier performance, 
monitor, and assess their performance against those criteria, provide feedback and recognition, 
and implement corrective actions and improvement plans when needed.

The Supplier Relationship and Performance Management (SRPM) application offers the following 
key benefits:

• Reduced costs and risks: By ensuring that suppliers meet the standards and specifications 
of the organization, SRPM can help reduce the costs of poor quality, defects, rework, delays, 
and non-compliance. SRPM can also help mitigate the risks of supply disruptions, fraud, 
corruption, and reputational damage.

• Increased efficiency and innovation: By fostering collaboration and communication with 
suppliers, SRPM can help improve the efficiency and effectiveness of the procurement 
process.

• Enhanced customer satisfaction and loyalty: By delivering high-quality products and services 
that meet or exceed customer expectations, SRPM can help enhance customer satisfaction 
and create a competitive advantage in the market.

• Improved supplier relationships: By providing constructive feedback and recognition to 
suppliers, SRPM can help build trust and mutual respect, including encouraging suppliers to 
invest in long-term partnerships and continuous improvement.

• Automated KPI data collection: By providing a comprehensive, automated KPI system 
integrated into action plans to meet user expectations for performance monitoring.
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To install Supplier Relationship and Performance Management, the following plugins have to be 
installed:

• Required plugin: Supplier Relationship and Performance Management (com.snc.sn_slm_perf)

• Dependent plugins:

◦ KPI Framework (com.snc.sn_kpi)

◦ Supplier Common Architecture (com.snc.sn_slm)

◦ Supplier Operations (com.snc.sn_so)

◦ Gantt Component for ServiceNow (com.servicenow_now_gantt)

To enable the Automated KPIs feature after an upgrade, run the fix scripts KPI - Dec 25 records 
script  and KPI - Dec 25 data records script. For more information, see Run fix scripts to enable 
Automated KPI collection.

For more information about configuring Supplier Relationship and Performance Management, 
see Configure Supplier Relationship and Performance Management.

For more information about using Supplier Relationship and Performance Management, see 
Using Supplier Relationship and Performance Management.

For more information about Supplier Relationship and Performance Management data model 
and primary tables, see Supplier Relationship and Performance Management reference.

Related topics

Configure Supplier Relationship and Performance Management

Using Supplier Relationship and Performance Management

Supplier Relationship and Performance Management reference

Supplier Payment Optimization

Supplier managers can view the potential returns or savings when suppliers accept credit card 
payments. They can convert high-potential suppliers, and capture value through card-based 
payments.

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization. This feature is available from the Yokohama December 2025 release 
onwards.

The Supplier Payment Optimization (com.snc.sn_slm_opt) application enables suppliers 
managers to estimate potential savings from credit card payments, which can result in significant 
cost savings for the company. It provides a Supplier Payment Optimization dashboard that 
provides an overview of the total potential savings for all suppliers.

Supplier Payment Optimization offers the following key benefits:

• Estimate savings: Estimate savings and returns associated with card acceptance by the 
suppliers.

• Effective expense tracking: Compare actual expenses with the data available on the 
dashboard on monthly, quarterly, yearly, and all-time spend.

• Drive conversion of high-potential suppliers: Identify, prioritize, and track suppliers with high 
acceptance potential.

• Stronger supplier relationships: With more suppliers accepting credit card payments, timely 
and reliable payments help build trust and may lead to better pricing or priority service.
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Supplier Payment Optimization offers the following capabilities:

• Saving estimator tool: The saving estimation tool can be used to calculate potential savings 
from credit card payments. The tool uses default values and enables users to modify billing 
cycles and other parameters to create new estimates. For more information, see Estimate 
savings using the saving estimator tool.

• Propensity score: Supplier managers can check the propensity score (currently requires 
manual updates) before proceeding with raising the new supplier credit card enablement 
journey. For more information, see Add propensity score for a supplier.

• Credit card enablement: Supplier Managers can initiate credit card enablement cases, 
enabling suppliers to use a credit card as their preferred payment method. For more 
information, see Create a case for supplier credit card enablement.

• Payment optimization dashboard: The dashboard includes data on the all-time spend and 
total spend for the current month, current quarter, and current year. It also lists the top 10 
supplier opportunities based on the saving estimates generated using the saving estimation 
tool. For more information, see View the Payment Optimization dashboard.

To install Supplier Payment Optimization, the following plugins have to be installed:

• Required plugin: Supplier Payment Optimization (com.snc.sn_slm_opt)

• Dependent plugins:

◦ Supplier Operations (com.snc.sn_so)

◦ Source-to-Pay Workspace (com.sn_spend_workspace)

◦ Source-to-Pay Common Architecture (com.snc.sn_shop)

For more information, see Install Supplier Payment Optimization.

For more information about using Supplier Payment Optimization, see Using Supplier Payment 
Optimization.

For more information about Supplier Payment Optimization data model and primary tables, see 
Supplier Payment Optimization reference.

Related topics

Supplier Common Architecture

Source-to-Pay Workspace

Smart Assessments

Supplier managers can configure smart assessments in bulk for internal and external users.

Important:  Check your entitlements to determine whether you have access to Smart 
Assessments. This feature is available from the March 26 Yokohama  release onwards.

Supplier managers use the segmentation rules and assessment templates to create smart 
assessments in bulk for users. Smart assessments provide a survey-like experience with 
enhanced UI capabilities. This feature utilizes the capabilities of the Smart Assessment Engine 
application. Assessments can be created for internal and external users:

• Internal users (supplier owners/managers) respond to the assessment through the Source-to-
Pay Workspace.

• External users (supplier contacts) receive emails with a link to the assessment and respond 
through the Supplier Collaboration Portal.
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Note:  Users can reassign the assessments based on the reassignment configuration. For 
more information, see Configure user criteria for reassigning assessments.

For more information about how to configure smart assessments, see Configure smart 
assessments.

Universal Request

The Universal Request  feature enables supplier contacts to raise issues that do not fit into 
predefined case types or involve multiple departments. It provides a structured workflow for 
routing and resolution of queries.

Important:  Check your entitlements to determine whether you have access to the 
Universal Request feature. This feature is available from the Yokohama December 2025 
release onwards.

You must install the Universal Request for Source-to-Pay Operations plugin [sn_fsc_ur_common] 
to enable the Universal Request  feature in SLO. For more information on installing the plugin, see 
Install Universal Request for SLO.

Key Stakeholders

The Universal Request  workflow involves the following stakeholders:

• Supplier contacts: Supplier contacts submit their queries by raising Universal requests.

• Routing agents: Routing agents are tier-1 agents who manage both Universal requests and 
supplier cases. These agents have both the Universal Request role and the [sn_slm.agent] 
role. Routing agents can perform the following operations:

◦ View, update, transfer, and close Universal requests

◦ Create supplier cases from Universal requests

Note:  You can create Routing agents by adding users to the Source Operations Universal 
Request Group. This group is a default assignment group that contains Universal request 
roles and supplier agent roles. For more information on assigning roles, see Assign roles to 
UR users .

For more information on roles in Universal requests, see Universal Request roles and groups .

Universal Request  workflow

1. Submission of a Universal request

The supplier contact submits a Universal request from the Supplier Collaboration portal. For 
more information on raising a Universal request, see Create a Universal Request from the 
Supplier Collaboration Portal.

2. Assignment of the Universal request
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◦ For requests that are marked as sensitive, suppliers select the department at the time of 
request submission. The request is assigned automatically to the corresponding assignment 
group.

Note:  Suppliers can mark a Universal request as sensitive by selecting the Issue 
contains sensitive or confidential information  check box while submitting the 
request form. For more information, see Create a Universal Request from the Supplier 
Collaboration Portal.

◦ For requests that aren’t marked as sensitive, routing agents review the request and route 
them to an appropriate assignment group based on the information provided in the 
description and short description by the supplier.

3. Primary ticket creation

◦ For requests that are marked as sensitive, a primary ticket of the type supplier case is 
created automatically.

◦ For requests that aren’t marked as sensitive, routing agents must create a supplier case for 
resolution. For more information, see Create a supplier case.

Note:  Routing agents can also create an invoice case instead of a supplier case from 
a Universal request if they have the required permissions.

4. Resolution of the Universal request

◦ If the routing agent accepts the resolution provided in the primary ticket, the Universal 
request is marked as complete and closed.

◦ If the resolution is rejected, the supplier case is dissociated from the Universal request. The 
routing agent then creates a new primary ticket from the Universal request for resolution.

Primary tickets can also be transferred to other departments when resolving a Universal request 
requires cross-departmental support or must be reassigned to a different department. For more 
information on transferring primary tickets, see Transfer a primary ticket .

When a Universal request needs support from multiple departments, you can create Associated 
tickets in addition to the primary ticket. Associated tickets enable multiple departments to work 
on the resolution of the Universal request simultaneously. For more information see, Create 
associated ticket for primary ticket of UR .

Configuring Supplier Lifecycle Operations
Plan and configure your implementation for Supplier Lifecycle Operations.

Related topics

Install Supplier Lifecycle Operations

Install Supplier Collaboration Portal

Supplier Document Management

Advanced Work Assignment for Supplier Lifecycle Operations

Install Supplier Lifecycle Operations

You can install the Supplier Lifecycle Operations  application (com.snc.sn_supplier_mgmt) if you 
have the admin role. The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.
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Before you begin
Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Supplier Lifecycle Operations  application listing in the ServiceNow Store 
for information on dependencies, licensing or subscription requirements, and release 
compatibility.

• The Supplier Lifecycle Operations  application (com.snc.sn_supplier_mgmt) installs the 
following dependent plugins.

◦ Supplier Common Architecture  (com.snc.sn_slm)

◦ Playbook Experience (sn_playbook_exp)

◦ Employee Experience Foundation (sn_ex_emp_fd)

◦ News Integration for Supplier Lifecycle Operations  (sn_supplier_news)

◦ Source-to-Pay Workspace (com.sn_spend_workspace)

◦ Geo Map component (sn_geo_map)

Note:  For the Geo Map component (sn_geo_map) plugin, ensure that you configure 
the Geo map properties. For more information, see Configure properties for Supplier 
Lifecycle Operations.

• Craft.co Integration for Supplier Lifecycle Operations  (com.snc.sn_supplier_craft)

Note:  This plugin is optional. If you have installed this plugin, ensure that you configure 
the Craft Integration properties. For more information, see Configure properties for 
Supplier Lifecycle Operations.

Role required: admin

About this task
The following items are installed with Supplier Lifecycle Operations:

• Plugins

• Store applications

• Roles

• Tables

For more information, see Components installed with Supplier Lifecycle Operations.

For more information about using Supplier Lifecycle Operations, see Using Supplier Lifecycle 
Operations.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Supplier Lifecycle Operations  application (sn_supplier_mgmt) using the filter criteria 
and search bar.
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You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Components installed with Supplier Lifecycle Operations

Several types of components are installed with activation of Supplier Lifecycle Operations, 
including tables and user roles.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

The user roles and tables, even though installed along with Supplier Lifecycle Operations, reside 
in the Supplier Common Architecture  application. For more information, see Supplier Common 
Architecture.

Note:  The following roles are installed with Finance Common Architecture  (com.sn_fin), 
which is installed as a dependent plugin:

• sn_fin.supplier_payment_info_read: Provides read access to supplier details and 
supplier payment information tables

• sn_fin.supplier_payment_info_write: Provides write access to supplier details and 
supplier payment information tables

Roles installed

Note:  Users with the Supplier Manager [sn_slm.manager], Supplier Fulfiller 
[sn_slm.fulfiller], and Supplier Owner [sn_slm.owner] roles cannot access the Supplier 
Collaboration Portal.

Role title [name] Description Contains roles

Supplier 
Administrator

[sn_slm.admin]

The supplier admin 
can create, view, 
update, and delete all 
the suppliers, cases, 
and tasks.

• decision_table_admin

• sn_shop.shopper

• awa_admin

• sn_vdr_risk_asmt.vendor_assessor

• sn_fin.supplier_payment_info_write
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Role title [name] Description Contains roles

• sn_slm.manager

• sn_kpi.admin

Supplier Fulfiller

[sn_slm.fulfiller]

Users with this role 
can do the following:

• Create tasks

• View suppliers 
related to assigned 
cases or tasks

• View assigned 
cases and tasks, 
or tasks that are 
created by them

• Update assigned 
cases and tasks, 
or tasks that are 
created by them

• task_editor

• template_read_global

• sn_shop.shopper

• workspace_user

• vendor_reader

• canvas_user

• sn_fin.finance_user

• awa_agent

• survey_reader

• sn_fin.procurement_user

• email_composer

Supplier Owner

[sn_slm.owner]

The supplier owner 
can do everything the 
supplier fulfiller can 
do, plus users with 
this role can:

• Create suppliers 
using the playbook

• Create cases and 
tasks for suppliers 
they own

• View the suppliers 
they own

• View cases and 
tasks for the 
suppliers they own

• Update the 
suppliers they own

• Update the cases 
and tasks that are 
created by them or 
assigned to them

• personalize_responses

• workspace_user

• canvas_user

• sn_slm.fulfiller

• sn_fin.finance_user

• sn_fin.procurement_user

• sn_vdr_risk_asmt.vendor_assessment_reviewer
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Role title [name] Description Contains roles

Note:  The 
Supplier Owner 
[sn_slm.owner] 
role can create, 
manage, and 
edit records 
for only the 
suppliers that 
they own.

Supplier Manager

[sn_slm.manager]

The supplier manager 
can do everything the 
supplier owner can 
do, plus users with 
this role can:

• Create suppliers 
using the playbook

• Create cases and 
tasks

• View all the 
suppliers, cases, 
and tasks

• Update the 
suppliers they 
manage and also 
other suppliers

• Update the cases 
and tasks that they 
create or that are 
assigned to them

• sn_slm.owner

• dm_user_criteria_read

Supplier Agent

sn_slm.agent

The supplier agent 
can do everything the 
supplier fulfiller can 
do, plus users with 
this role can:

• Create cases and 
tasks

• View all the 
suppliers, cases, 
and tasks

• Update all the 
tasks and assigned 
cases

sn_slm.fulfiller

Supplier Contact

[sn_slm.contact]

A user with this role 
can do the following:

• sn_fin.supplier_payment_info_read

• snc_external
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Role title [name] Description Contains roles

• Submit requests 
using the supplier 
catalog from 
the Supplier 
Collaboration 
Portal

• Complete assigned 
tasks using 
the Supplier 
Collaboration 
Portal

Note:  A 
contact can 
be a primary 
contact or 
secondary 
contact. A 
primary contact 
is a user that 
has the Primary 
contact column 
set to true  on 
the Vendor 
Contacts page.

KPI Administrator

[sn_kpi.admin]

The KPI admin can 
define, manage, and 
analyze KPIs.

sn_kpi.user

Note:  Added after the Xanadu December 
2024 upgrade.

KPI User

[sn_kpi.user]

The KPI user can only 
read all the records in 
KPI framework.

Note:  Added after the Xanadu December 
2024 upgrade.

KPI Data Owner

[sn_kpi.data_owner]

The KPI data owner 
can access only 
specific tables and 
fields which are 
necessary to collect 
data for KPIs from an 
internal user.​

Note:  Added after the Xanadu December 
2024 upgrade.

Tables installed

Note:  The Supplier Payment Information [sn_fin_supplier_payment] table, which 
stores the bank account records of the suppliers, is installed with the Finance Common 
Architecture (com.sn_fin) application.
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Table Description

Supplier Case [sn_slm_case] Stores the supplier case records. Extends the Service Case 
[sn_spend_sdc_service_request] table.

Supplier Product Code 
[sn_slm_code_m2m_supplier]

Stores the relationships between suppliers in the Supplier 
[sn_fin_supplier] table and product codes in the Product 
Code [sn_supplier_product_code] table.

Supplier Email Domain 
[sn_slm_email_domain]

Stores the email domains of the suppliers.

Supplier Location 
[sn_slm_m2m_location]

Stores the relationships between suppliers stored in the 
Supplier [sn_fin_supplier] table and locations stored in the 
Location [cmn_location] table.

Supplier Contact 
[sn_slm_supplier_m2m_contact]

Stores the supplier contact and supplier records. It is used 
for the M2M mapping of one contact with many suppliers.

Product Code 
[sn_slm_product_code]

Stores the product and service records with universal 
product codes (UPC). These records do not have any relation 
to the supplier.

Supplier Task [sn_slm_task] Stores the tasks of the suppliers. Extends the Service Task 
(sn_spend_sdc_service_task) table.

Supplier Document 
Configuration 
[sn_slm_document_config]

Stores the supplier document configurations. Extends the 
Application File [sys_metadata] table.

Supplier Document Type 
[sn_slm_document_type]

Stores the supplier document types. Extends the Application 
File [sys_metadata] table.

Supplier Document References 
[sn_slm_document_references]

Stores the supplier document references. Extends the 
Document References [ds_document_references] table.

Organization Tax Details

[sn_fin_org_tax_detail]

Stores the tax registration details of the supplier.

Note:  This table has been added in the Finance 
Common Architecture (com.sn_fin) plugin.

Explicit Roles in Supplier Lifecycle Operations

You can grant access to your instance to both internal and external users. However, it is 
important to differentiate their access levels for added security. To achieve this, every user must 
have at least one role, allowing the instance to distinguish between internal and external users.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

As of the Paris release, no user can simultaneously have the explicit roles snc_internal and 
snc_external. The ServiceNow AI Platform  applies this mutual exclusion everywhere in the 
system and writes error messages to the logs for each conflict.

Groups and role containment structures also cannot include both roles, as this would result in 
any group member or user assigned to such a group or role automatically holding both roles. The 
ServiceNow AI Platform  aborts any operation that would create such a scenario.

You must install the Explicit Roles [com.glide.explicit_roles] plugin while installing Supplier 
Lifecycle Operations. Supplier Lifecycle Operations  is dependent on the Explicit Roles 
[com.glide.explicit_roles] plugin.
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For more information about ServiceNow AI Platform  explicit roles, see Explicit Roles .

Application plugin installation sequence in Supplier Lifecycle Operations

The following table provides the list of plugins for Supplier Lifecycle Operations, a high-level 
description of each plugin, and the dependencies that are required before installing each plugin.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

Supplier Lifecycle Operations  application plugin list

Plugin Description Dependencies

Supplier Common 
Architecture

[com.snc.sn_slm]

Provides a common 
architecture to track data 
objects related to a supplier 
used in both Supplier 
Lifecycle Operations  and 
Supplier Collaboration Portal.

• Finance Common 
Architecture  (com.sn_fin)

• Service Delivery Common 
(com.sn_spend_sdc)

• Document Management 
(com.snc.platform_document_management)

• External User Registration 
(com.snc.external_user_self_registration)

• Common Vendor Core 
(com.snc.sn_vendor_core) 
and (com.snc.vendor_core)

Supplier Lifecycle Operations

[com.snc.sn_supplier_mgmt]

Onboard suppliers, manage 
supplier relationships, 
monitor risk, compliance, 
and performance across the 
supplier life cycle.

• Supplier Common 
Architecture 
(com.snc.sn_slm)

• Playbook Experience 
(com.playbook_experience)

• Employee Experience 
Foundation 
(com.snc.sn_ex_emp_fd)

• News Integration 
for Supplier 
Lifecycle Operations 
(com.snc.sn_supplier_news)

• Map UI Component for 
threat and alert data feeds 
(com.sn_fam_map)

Supplier Collaboration Portal

[com.snc.sn_supplier_sp]

Provides a single, one-stop 
experience for suppliers to get 
self-service, complete tasks 
and make requests into an 
organization.

• Supplier Common 
Architecture 
(com.snc.sn_slm)

• Service Portal 
(com.glide.service-portal)
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Supplier Lifecycle Operations  application plugin list  (continued)

Plugin Description Dependencies

• E-signature (com.snc.esign)

• Employee Center 
(com.snc.employee_center)

Craft.co Integration for 
Supplier Lifecycle Operations

[com.snc.sn_supplier_craft]

Provides a pre-configured 
integration with Craft.co. 
Craft.co is a supplier 
intelligence platform 
that offers validated and 
comprehensive information 
about suppliers with which a 
company engages.

Supplier Lifecycle Operations 
(com.snc.sn_supplier_mgmt)

News Integration for Supplier 
Lifecycle Operations

[com.snc.sn_supplier_news]

Retrieve recent news and 
other articles from preferred 
news channels. There is a pre-
configured integration with 
Microsoft  Bing available with 
this application.

None

Advanced Work Assignment 
for Supplier Lifecycle 
Operations

[com.snc.sn_slm_awa]

Automatically assign supplier 
cases to agents based on 
availability and capacity.

• Advanced Work Assignment 
(com.glide.awa)

• Agent Chat 
(com.glide.interaction.awa)

• Glide Virtual Agent 
(com.glide.cs.chatbot)

• Supplier Lifecycle 
Operations 
(com.snc.sn_supplier_mgmt)

Supplier Lifecycle Operations  plugin installation sequence

To avoid incomplete demo data and other installation issues, you should install the plugins in the 
following sequence:

1. Supplier Common Architecture  (com.snc.sn_slm)

2. News Integration for Supplier Lifecycle Operations  (com.snc.sn_supplier_news)

3. Supplier Lifecycle Operations  (com.snc.sn_supplier_mgmt)

4. (Optional) Craft.co Integration for Supplier Lifecycle Operations  (com.snc.sn_supplier_craft)

5. (Optional) Advanced Work Assignment for Supplier Lifecycle Operations 
(com.snc.sn_slm_awa)

Supplier Collaboration Portal  plugin installation sequence

To avoid incomplete demo data and other installation issues, you should install the plugins in the 
following sequence:
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1. Supplier Common Architecture  (com.snc.sn_slm)

2. Supplier Collaboration Portal  (com.snc.sn_supplier_sp)

Prerequisites for upgrading Supplier Lifecycle Operations  to Washington DC  or later releases

Starting with the Washington DC  release, Supplier Manager Workspace  is being prepared for 
future deprecation. It will be hidden from the navigation and no longer be activated on new 
instances but will continue to be supported. Source-to-Pay Workspace  provides the latest 
experience for this functionality.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

Supplier managers are often part of procurement, which involves sourcing products and 
selecting the supplier that best fits the needs. As a result, the supplier manager had to switch 
between two different workspaces, which affected the user experience.

The Source-to-Pay (S2P) product suite utilizes the Source-to-Pay Workspace  for various activities 
such as procuring goods, onboarding suppliers, and processing invoices. This unified workspace 
is designed to streamline tasks for Procurement Specialists, Supplier Managers, and Accounts 
Payable Specialists by providing a consistent interface for Source-to-Pay Operations. For more 
information, see Source-to-Pay Workspace.

Before upgrading to Washington DC  or later releases, ensure that you have installed the 
Vancouver version 2.4.2 of both Supplier Common Architecture and Supplier Lifecycle 
Operations. This step is mandatory if you plan to continue using the deprecated Supplier 
Manager Workspace. For more information, see the KB article KB1651502 .

If you have upgraded to Washington DC  or later releases and want to use the Supplier Manager 
Workspace, ensure that you run the fixscript_migrate_workspace_to_smw.xml fix script. For more 
information, see Run fix script to migrate existing data from the deprecated Action type column 
after upgrade.

Configure properties for Supplier Lifecycle Operations

Use these properties to configure settings for the Supplier Lifecycle Operations application from 
the Properties page.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

Navigate to All  > Supplier Lifecycle Operations  > Properties.

Note:  The Properties page displays the properties for Craft only if you have installed the 
Craft.co integration for Supplier Lifecycle Operations  (com.snc.sn_supplier_craft) plugin. 

Click the question mark icon ( ) beside each property field to see the property name 
corresponding to that field.

Supplier Lifecyle Management properties

Property Action

Supplier lifecycle properties

Sys Id of the External User Registration Configuration for 
Onboarding a contact for a supplier.

sn_supplier.external_registration_profile_id

Auto-populated with the sys ID of the 
user registration configuration you 
specified in the Value  field of the 
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Supplier Lifecyle Management properties  (continued)

Property Action

sn_supplier.external_registration_profile_id 
system property.

Note:  Sys ID (sys_id) is a 32-character 
GUID (Globally Unique ID) that uniquely 
identifies each record in an instance.

For more information, see Configure system 
property to send registration emails to 
external users.

Automatic creation of cases from email

[sn_supplier.slm_email]

Automatically creates a supplier case if the 
incoming email address matches with the 
email address specified in this property.

For more information, see Enable automatic 
creation of supplier cases from incoming 
emails.

Decide whether or not to enable google maps API functionality 
on Supplier manager workspace. Enablement of Geo Map 
method and Geo Map key/client will still be required.

[sn_supplier.geo_map_enabled]

Type: Yes | No

Select the check box to enable this property.

Craft Integration Properties

API key for craft.

sn_supplier_craft.craft_api_query

Enter the API key that you received with your 
enterprise account from Craft.

Geo map properties

Defines which method of authentication should be used for 
Google Maps API used in Geo map component.

sn_supplier.geo_map.google.method

Select one of the following options from this 
list:

• client-id

• key

Map key from Google for Geo map component, tied to the URL 
of the server. To obtain a new key, visit http://www.google.com/
apis/maps/signup.html  for details.

sn_supplier.geo_map.google.key

If you select key  from the Defines which 
method of authentication should be used 
for Google Maps  drop-down list, enter the 
map key.

Client ID for Google Maps API for Business used in Geo 
map component. To obtain your own key, visit http://
www.google.com/enterprise/earthmaps/maps.html  for details.

sn_supplier.geo_map.google.client

If you select client-id  from the Defines which 
method of authentication should be used 
for Google Maps  drop-down list, enter the 
client ID.

Defines whether to use places API from Google for Geo map 
component (Enable when same Google key has active places lib 
subscription).

Type: Yes | No
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Supplier Lifecyle Management properties  (continued)

Property Action

sn_supplier.geo_map.google.use_places_lib Select the check box to enable this property.

Supplier collaboration portal properties

Allow "Activity Configurations" and "Filters" to be picked from all 
application scopes.

sn_supplier_sp.allow_all_apps_configuration

Type: Yes | No

Select the check box to enable this property.

For more information, see Set the property to 
configure activity configurations.

Enable automatic creation of supplier cases from incoming emails

The supplier administrator can set this property to create a supplier case automatically from an 
incoming email.

Before you begin
Role required: admin

About this task
Supplier Lifecycle Operations  automatically creates a supplier case if the incoming email 
address matches with the email address specified in this property. For more information, see 
Configure properties for Supplier Lifecycle Operations.

If you use the automatic case creation functionality in both Supplier Lifecycle Operations  (SLO) 
and Sourcing and Procurement Operations  (SPO), ensure that each instance is configured with 
a unique email address in the Automatic creation of cases from email  property. This ensures 
that the instance can correctly match incoming emails to the appropriate user and create the 
corresponding case.

For example:

• In SLO, set the email address to supplierhelp@acme.com  for creating supplier cases.

• In SPO, set the email address to procurementhelp@acme.com  for creating procurement 
cases. For more information, see Automatic case creation from emails.

This approach enables seamless case creation and accurate email-to-user mapping.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Administration  > Properties.

2. In the Automatic creation of cases from email  field, enter the email address of the incoming 
email.

3. Select Save.

Note:  After M2M mapping between supplier contact and suppliers is enabled, the 
contacts linked with multiple suppliers have to include the supplier's legal name while 
sending emails for automatic creation of cases. For more information, see Email format for 
contacts linked with multiple suppliers.
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Email format for contacts linked with multiple suppliers

Contacts linked with multiple suppliers have to include the supplier's legal name while sending 
emails for automatic creation of cases.

When a supplier contact is mapped to only one supplier and sends an email, a case is created 
with that supplier. However, when the supplier contact is mapped to multiple suppliers, the 
supplier's legal name is retrieved from the email body.

Important:  The valid supplier's legal name must be included in the email body in the 
following format:

Supplier: <supplier legal name>

When a supplier contact mapped to multiple suppliers sends an email for case creation, the 
following scenarios can occur:

Supplier's legal name is correctly mentioned in the email

When the supplier's legal name is included in the email in the given format, the supplier case is 
created with the supplier name provided in the email.

Supplier's legal name is not correctly mentioned in the email

When the supplier's name is not the exact legal name, a case is still created with the Supplier 
field set as empty. An auto-email is sent to the supplier contact requesting for the valid supplier's 
legal name. Once the supplier contact shares the supplier's legal name, it has to be added 
manually by the assigned person. The case is then assigned and the Supplier field is updated to 
mandatory.

Post-upgrade tasks for Supplier Case Management

After you upgrade to Washington DC, you must review all the post-upgrade tasks and complete 
them as needed.

Important:  The Supplier Lifecycle Operations plugin (com.snc.sn_supplier_mgmt) is 
renamed to Supplier Case Management in the Yokohama  December 2025 (v 5.2.0) release.

Run fix script to update the KPI weighted score field in the KPI score table

Run this fix script to update the KPI weighted score field values (from integer to decimal type) in 
the KPI score table (sn_kpi_score) after the March 2026 Yokohama  release.

Before you begin
Role required: admin

After the upgrade, the old field Weighted score  is replaced by KPI weighted score  field in the KPI 
score (sn_kpi_score) table.

With the updated decimal type KPI weighted score  field, all performance scores are calculated 
in decimal up to three decimal places.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Search for the Backfill KPI Weighted Score  script.

3. Open the fix script record.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

939



Note:  In the Script  field, the batch size variable is set to 10000. If there are more than 
10000 KPI records, you can do one of the following:

◦ Run the fix script repeatedly until all active records are checked and copied.

◦ In the Script  field, set the batch size variable to a number equal to the number of KPI 
records in your instance and select Update.

4. Select Run Fix Script.

Run fix script to update the Aggregation method field in the KPI table

Run this fix script to update the new fields added in the KPI table (sn_kpi_kpi) after the May 2025 
Yokohama  release.

Before you begin
Role required: admin

After the upgrade, the new fields Aggregation method, Collection level, and Current threshold 
value  are added in the KPI table (sn_kpi_kpi).

It is mandatory to run the script to be able to use new features for the existing KPI records. 
Without the aggregation method and current threshold values, the calculated KPI behavior and 
KPI performance calculations might get impacted.

Note: 

For new KPI templates and KPIs, there’s no impact even if the script is not run.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Search for the KPI - May 2025 data upgrade script  script.

3. Open the fix script record.

Note:  In the Script  field, the batch size variable is set to 9500. If there are more than 
9500 KPI records, you can do one of the following:

◦ Run the fix script repeatedly until all active records are checked and copied.

◦ In the Script  field, set the LIMIT variable to a number equal to the number of KPI 
records in your instance and select Update.

4. Select Run Fix Script.

Run fix script to update the KPI Instruction field in the Supplier Task table

Run this fix script to update the new field KPI Instruction  added in the Supplier Task 
(sn_slm_task) table in the Yokohama  release.

Before you begin
Role required: admin

After the upgrade, a new field KPI Instruction  is added in the Supplier Task (sn_slm_task) table.

The new field KPI Instruction  is derived from the KPI table (sn_kpi_kpi) Instructions  field. Run 
this fix script to transfer data from the dot-walked kpi_data.kpi.instructions  field to the KPI 
Instruction  field in the Supplier Task table.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

940



Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Search for the SLO - Feb 25 data script  script.

3. Open the fix script record.

Note:  In the Script  field, the batch size variable is set to 1000. If there are more than 
1000 supplier task records, you can do one of the following:

◦ Run the fix script repeatedly until all active records are checked and copied.

◦ In the Script  field, set the TASK_PROCESSING_LIMIT variable to a number equal to the 
number of supplier task records in your instance and select Update.

4. Select Run Fix Script.
The script updates the KPI Instruction  field value for the records where all the following 
conditions are met:

◦ The supplier task is active

◦ The supplier task is created to collect KPI data

◦ The KPI Instruction  field is empty

Run fix scripts to enable Automated KPI collection

Run the fix scripts to enable the Automated KPIs feature that automatically calculates KPI data 
from database tables instead of manually entering values.

Before you begin
Role required: admin

Note:  This feature is available from the Yokohama December 2025 release onwards.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Search for KPI - Dec 25 records script.

3. Open the fix script record.

4. Select Run Fix Script.

5. Repeat steps 2-4 to run the KPI - Dec 25 data records script.

Result
After running the fix script, a new field Data collection type  is added in the KPI Template 
[sn_kpi_template] table.

Related topics

Run fix script to update the Aggregation method field in the KPI table

Run fix script to update the KPI Instruction field in the Supplier Task table

Run fix script to migrate existing data from the deprecated Action type column after upgrade

In the May Store 2024 release, the Action type  column in the Supplier Task (sn_slm_task) table 
has been deprecated.

Before you begin
Role required: admin
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About this task
In the May Store 2024 release, the Supplier Task (sn_slm_task) table uses the Action type for 
task  column from its parent Service Task [sn_spend_sdc_service_task] table. After you upgrade 
to the May Store 2024 release, ensure that you run the fix script to migrate existing data from the 
deprecated Action type  column to the newly added Action type for task  column in the Supplier 
Task table.

Important:  Before you run the fix script, ensure that you restructure the Supplier Task 
table to extend the Service Task table.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Search for the SLO - upgrade scripts for may 2024  script.

3. Open the fix script record.

4. In the Script  field, set the batch size variable to a number equal to the number of supplier task 
records in your instance.
For example, if your instance has 10000 supplier task records, set the batch size variable as 
follows:

var batchSize = 10000;

5. Select Update.

6. Select Run Fix Script.

Run fix script to use the Supplier Manager Workspace  after upgrading to the Yokohama 
release

After upgrading to the Yokohama  release, you can see only the Source-to-Pay Workspace  on the 
All  navigation tab. You don't have to do anything if you choose to continue to use the Source-to-
Pay Workspace.

Before you begin
Role required: admin

About this task

Important:  To use the Supplier Manager Workspace  without any issues, ensure that you 
are on the latest version of the Vancouver  release (2.4.4) before upgrading to Washington 
DC  or later releases. For more information, see the KB article KB1651502 .

After upgrading to the Yokohama  release, you can see both the Source-to-Pay Workspace 
and Supplier Manager Workspace  on the Workspaces  tab. If you want to use the 
Supplier Manager Workspace  instead of the default Source-to-Pay Workspace, run the 
fixscript_migrate_workspace_to_smw.xml  fix script.

At any time, you can revert to using the Source-to-Pay Workspace  by running the 
fixscript_migrate_workspace_to_s2p.xml  fix script.
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You can download the fix script XML files from the ServiceNow 

Store .

Procedure

1. Download the fix script XML file from the Supporting Links and Docs section.

2. Navigate to All  > System Definition  > Fix Scripts.

3. Right-click the Name column and choose Import XML.

4. Select Choose file  and then select the fix script XML file that you downloaded.

5. Select Upload.

6. Search for and select the fix script record to open it.

7. Select Run Fix Script.

Enable deprecated case types after upgrade

After you upgrade to Yokohama, you can enable deprecated case types if you have the admin 
role.

Before you begin
Role required: admin

About this task
In the yokohama  release, the Conduct a risk assessment  and Conduct a tiering risk 
assessment  case types have been deprecated. However, you can perform this task to enable 
and use these case types after upgrade.

Procedure

1. Select All.

2. In the navigation filter, enter sn_slm_case_list.do.
The Supplier Cases page opens listing all the supplier cases.

3. Select New.

4. Right-click the Case type  field label and select Configure Choices.
The Configuring Case type Choices page opens.

5. In the Available list, double-click the Conduct a risk assessment (Deprecated)  and Conduct a 
tiering risk assessment (Deprecated)  case types to move them to the Selected list.
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6. Select Save.
The deprecated case types now appear in the Case type  field on the Create New Supplier 
Case form.

Processing the skipped supplier catalog item records after upgrade

After you upgrade to Yokohama, the latest supplier catalog items may get skipped and therefore 
may not be available after the upgrade.

For example, when onboarding a new supplier, the supplier onboarding flow includes a supplier 
task that creates a new record for supplier location and payment information using catalog items. 
Because the latest catalog items may not be available after the upgrade, the onboarding flow 
may get affected.

If you notice that the supplier catalog item records have been skipped during the upgrade, you 
must review the list of skipped records, evaluate how you want to resolve the conflict for these 
records, and take appropriate action.

Related topics

Enable deprecated case types after upgrade

Restructured Supplier Task table

Install Supplier Collaboration Portal

You can install the Supplier Collaboration Portal  application (com.snc.sn_supplier_sp) if you 
have the admin role. The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the application listing in the ServiceNow Store  for information on dependencies, 
licensing or subscription requirements, and release compatibility.

• The Supplier Collaboration Portal  application (com.snc.sn_supplier_sp) installs the following 
dependent plugins.

◦ Supplier Common Architecture  (sn_slm)

◦ Service Portal  (com.glide.service-portal)

◦ E-signature (com.snc.esign)

◦ Employee Center  (sn_ex_sp)

Note:  You can activate additional plugins to enable other features in Supplier 
Collaboration Portal. For more information, see Additional plugins for Supplier Collaboration 
Portal.

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Supplier Collaboration Portal  application (com.snc.sn_supplier_sp) using the filter 
criteria and search bar.
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You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

What to do next
Ensure that you complete the post installation mandatory steps. For more information, see Post 
installation troubleshooting .

Post installation mandatory step for Supplier Collaboration Portal

After you install the Supplier Collaboration Portal, ensure that you enable access to Supplier 
Collaboration Portal.

Related topics

Run the fix script to enable access to Supplier Collaboration Portal

Enable access to Supplier Collaboration Portal

Enable users to access the Supplier Collaboration Portal  either by configuring the user criteria or 
by running the fix script.

Before you begin
Role required: admin

Procedure

To enable users to access the Supplier Collaboration Portal, do one of the following:

Option Instruction

Configure the user criteria for 
the Service Portal.

Complete these steps:

1. Activate the user criteria for Service Portal plugin .

2. Set the user criteria for Service Portal system property .

Run the fix script. Complete the steps listed in Run the fix script to enable 
access to Supplier Collaboration Portal.

Run the fix script to enable access to Supplier Collaboration Portal

After you install the Supplier Collaboration Portal, you must run the fix script to enable access to 
the portal.
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Before you begin
Role required: admin

About this task
Download the SCP_Contact_User_Access.xml  file from the ServiceNow 

Store.

After you download the script file, perform the following steps.

Procedure

1. Navigate to System Definition  > Fix Scripts.

Ensure that the application scope is set to Global.

2. Right-click the Name column and select Import XML.

3. Select Choose file  and select the XML file that you downloaded.

4. Select Upload.

5. Search for and select the Add Supplier Roles  script record to open it.

6. Select Run Fix Script.
You can now access the Supplier Collaboration Portal.

Configure self-registration for external users

Configure self-registration for external users.

Before you begin

Note:  You must do this task after installing the Supplier Collaboration Portal.

Role required: admin

About this task
Ensure that you have activated the com.snc.external_user_self_registration plugin. For more 
information, see Activate External User Self-Registration .

Procedure

1. Navigate to External User Self-Registration  > User Registration Configurations  and select 
New.

2. On the User Registration Configuration form, fill in the fields.
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For more information about the form fields and descriptions, see Create a user registration 
configuration for external users .

3. From the form context menu, select Save.

4. Select the Registration  tab, and do the following:

a. In the Mandatory column for the First name  and Last name  fields, double-click and select 
true  to make these fields mandatory.

b. Select the green check mark icon ( ) to save your changes.

5. Configure the Verification  tab to verify the identity of the registered users.
When the user verification flow triggers, an activation link is sent to the user's registered email 
address.

6. Select the Transformation  tab, select and open the u_reg_xmap_[number]  transformation 
map that maps the registered users from the User Acti Req [number] source table to the User 
[sys_user] target table.

7. In the Target table  field, search and select Vendor Contact [vm_vdr_contact].

8. From the form header, right-click the header bar and select Save.

9. Scroll down and select the Field Maps  tab, and then select New.

10. Select the Use source script  check box.
The Source script box is displayed.

11. In the return string, enter supplier_registration in lowercase letters exactly as shown.

answer = (function transformEntry(source) {
 
 // Add your code here
 return "supplier_registration"; // return the value to be put 
 into the target field
 
})(source);

12. From the Target field  list, select Source.

13. Select Submit.

14. Select the Onboarding  tab and in the User onboarding flow  field, search for and select 
Supplier Contact Onboarding.

15. Select the Advanced  tab.

16. In Registration form field configuration  section, in the Account signup  form, add 
the form fields Supplier name  (u_supplier_name) and Relationship contact email 
(u_relationship_contact_email).
Then select the preview this record icon to open the record.

Note: 

◦ The Supplier name  field has been added in the Xanadu  December 2024 upgrade. 
To enable and register this field, customize the registration form by adding 
the new supplier field with field label: Supplier name  and column name: 
u_supplier_name. For more information, see Configuring a user registration 
configuration for external users .

◦ If you need to add a supplier contact whose email domain differs from the supplier's 
domain, you must also Enable M2M mapping between supplier contact and suppliers.

17. In the Variables related list, select and open the First name, Last name, Email, and Supplier 
name  (if configured in the previous step) records individually.
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18. In the First name variable record, select the Mandatory  check box and select Save.
Repeat this step for the Last name, Email, and Supplier name variable records.

Note:  The Supplier name  field has been added in the Xanadu  December 2024 
upgrade. This field is available only after M2M mapping between supplier contact and 
suppliers  is enabled.

19. Select Save.

20. For sending personalized emails to contacts who want to self-register, select the Catalog 
Client Scripts  tab.

21. Select New.

22. In the Name  field, enter a name.

23. From the Type  list, select onLoad.

24. In the Script  box, copy and paste the code.

function onLoad() {
    function getParameterValue(name) {
        var url = top.location.href;
        var value = new URLSearchParams(url).get(name);
        if (value) {
            return value;
        }
        return false;
    }
 
    if (this && this.location && this.location.pathname) {
        if (getParameterValue("email")) {
            g_form.setValue("email", 
 getParameterValue("email"));
            g_form.setReadOnly("email", true);
        }
        if (getParameterValue("supplier_name") && 
 (getParameterValue("supplier_name") != "null")) {
            g_form.setValue("u_supplier_name", 
 getParameterValue("supplier_name"));
            g_form.setReadOnly("u_supplier_name", true);
            g_form.setValue("supplier_name", 
 getParameterValue("supplier_name"));
            g_form.setReadOnly("supplier_name", true);
 
        }
        if (getParameterValue("relationship_contact_email") && 
 (getParameterValue("relationship_contact_email") != "null")) {
            g_form.setValue("u_relationship_contact_email", 
 getParameterValue("relationship_contact_email"));
            g_form.setReadOnly("u_relationship_contact_email", 
 true);
            g_form.setValue("relationship_contact_email", 
 getParameterValue("relationship_contact_email"));
            g_form.setReadOnly("relationship_contact_email", 
 true);
 
        }
    }
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}

25. Select Save.

What to do next
Do the following:

• Configure the sn_supplier.external_registration_profile_id system property to ensure that 
registration emails are sent to external users. For more information, see Configure system 
property to send registration emails to external users.

• Configure the Vendor Contact table to send emails to contacts during self-registration. For 
more information, see Configure the Vendor Contact table to send invitation emails during self-
registration.

• If you do this task after installing the Supplier Collaboration Portal, map the external user 
registration configuration that you just created to the Supplier Collaboration Portal. For more 
information, see Map the self-registration configuration to Supplier Collaboration Portal.

Configure the flow to create approval records for all supplier contact invite requests

Typically, an approval record is created only when a supplier contact self-registers to get access 
to the Supplier Collaboration Portal. However, a supplier admin can configure the Supplier 
Contact Onboarding flow to create approval records even when a supplier manager adds or 
invites a new supplier contact.

Before you begin
Role required: sn_slm.admin

About this task
After you perform this task, an approval record is created for the Enroll a new supplier user case 
type, regardless of whether a supplier contact self-registers or a supplier manager invites a new 
supplier contact.

Important:  Supplier Lifecycle Operations  creates an approval record if the "Ask For 
Approval" action is a part of any SLO flow. This approval record can be approved by the 
user who belongs to the Supplier Administrators group (sys_user_group table). For more 
information, see Add a user to a group .

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Select the Subflows  tab, search for and select the Supplier Contact Onboarding  flow.

3. Search for the If the onboarding request is created by Relationship Manager or Contact is 
invited  condition label and select it, which expands the condition label.

4. Delete the Condition 2 by selecting the remove condition icon ( ) next to the condition.
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5. Select Save.

Map the self-registration configuration to Supplier Collaboration Portal

Map the external user self-registration configuration to the Supplier Collaboration Portal.

Before you begin
Configure self-registration for external users.

Role required: admin

Procedure

1. Navigate to Service Portals  > Portals.

The Service Portals module displays the list of all the available portals.

2. Select Supplier Collaboration Portal.

3. In the External user registration configuration  field, search for and select the external user 
configuration that you created for Supplier Lifecycle Operations.

4. Select Save.

What to do next
Supplier contacts can self-register to the Supplier Collaboration Portal. For more information, see 
Self-register to the Supplier Collaboration Portal.

Configure system property to send registration emails to external users

Configure the sn_supplier.external_registration_profile_id system property to ensure that 
registration emails are sent to external users for accessing the Supplier Collaboration Portal.

Before you begin
Configure self-registration for external users.

Role required: admin

Procedure

1. Navigate to External User Self-Registration  > User Registration Configurations.

2. Open the record for the user registration configuration.
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3. Select the context menu icon ( ), and then select Copy sys_id.

4. In the navigation filter, enter sys_properties.list.

The entire list of properties in the System Properties [sys_properties] table appears.

5. In the Name  search field, enter 
sn_supplier.external_registration_profile_id.

6. Select the sn_supplier.external_registration_profile_id  system property.

7. In the Value  field, paste the sys ID of the user registration configuration.

8. Select Update.

On the Supplier Lifecycle Operations  Properties page, the Sys Id of the External User 
Registration Configuration for Onboarding a contact for a supplier  field is auto-populated 
with the sys ID of the user registration configuration you specified in the Value  field of the 
sn_supplier.external_registration_profile_id  system property.

Configure the Vendor Contact table to send invitation emails during self-registration

Configure the Vendor Contact [vm_vdr_contact] table to send invitation emails to supplier 
contacts during the self-registration process.

Before you begin
Role required: admin

Procedure

1. Navigate to All.

2. In the left navigation pane, enter vm_vdr_contact_list.do.

3. On the Vendor Contacts page, right-click any column header and select Configure  > 
Notifications.

4. In the Name column, select Vendor Contact Invited.

5. On the When to send  tab, add the condition: "Source is not supplier_registration".

6. From the form header, right-click and select Save.

Enable notifications about self-registration errors

Add the sn_slm.admin role to the groups to enable supplier admins to receive an email if a 
supplier contact encounters an error during self-registration.

Before you begin
Role required: sn_slm.admin

Procedure

1. Navigate to All  > System Security  > Users and Groups  > Groups.

2. Search for and select the Supplier Administrators  group.

3. On the Roles  tab, select Edit.

4. In the Collection list, search for and double-click the sn_slm.admin  role to move it to the Role 
list.

5. Select Save.
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Restricted caller access approvals for Supplier Collaboration Portal

After you install the Supplier Collaboration Portal  application from ServiceNow Store, you might 
encounter Restricted Caller Access (RCA) approval messages requesting for an update in the 
access request. You can approve the RCA privileges either manually or by running the fix script.

Approve restricted caller access privileges manually

Approve restricted caller access (RCA) privileges to allow cross-scope access to the Supplier 
Collaboration Portal.

Before you begin
Log in to the Supplier Collaboration Portal  as an admin.

Role required: admin

About this task
RCA privileges define cross-scope access to an application, an event, or an application 
resource.

Procedure

1. Navigate to All  > System Applications  > Application Restricted Caller Access.

2. In the search field of the Source Scope column, enter Supplier Collaboration 
Portal.

Note:  The source scope records for the Supplier Collaboration Portal  are displayed on 
the Application Restricted Caller Access form in the Platform UI only after you log in to the 
Supplier Collaboration Portal  as an admin.

3. Right-click the Source Scope column header and select Group By Source Scope.

4. Expand the Supplier Collaboration Portal  source scope.

5. Select and open each source scope record and set the Status  field to Allowed.

6. Select Update.

Run the fix script for RCA approvals

After you install the Supplier Collaboration Portal  application from ServiceNow Store, you might 
encounter Restricted Caller Access (RCA) approval messages requesting for an update in the 
access request.

Before you begin
Role required: admin

About this task
The RCAs that are generated after the installation are in the Requested  state and you must 
manually mark the RCAs as Allowed, which can be time-consuming.

To automate the RCA approvals for any record, you can run the SCP_BULK_RCAs_Approval.xml 
script where the source scope is Supplier Collaboration Portal.
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Download the SCP_BULK_RCAs_Approval.xml  file from the ServiceNow 

Store .

Note:  This file is a standalone script to reduce the manual effort involved.

After you download the script file, perform the following steps.

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Right-click the Name column and choose Import XML.

3. Select Choose file  and select the SCP_BULK_RCAs_Approval.xml  file that you downloaded.

4. Select Upload.

5. Search for and select the SCP_BULK_RCAs_Approval  script record to open it.

6. Select Run Fix Script  to approve all the requested RCAs.

RCA fix script can approve the RCAs which exist at the time of execution. After running the 
RCA script, if you install any new plugins, rerun the RCA script to approve the new RCAs.

Set the property to configure activity configurations

Set the sn_supplier_sp.allow_all_apps_configuration  property to make activity 
configurations and filters accessible from all application scopes.

Before you begin
Role required: admin

About this task
If you set this system property to true, you can create or modify an activity configuration to 
display relevant activities in My active items widget of the Supplier Collaboration Portal. For more 
information, see Configure properties for Supplier Lifecycle Operations.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Administration  > Properties.

2. Select the check box for the Allow "Activity Configurations" and "Filters" to be picked from 
all application scopes (sn_supplier_sp.allow_all_apps_configuration)  property.
By default, the check box for this property is deselected (set to No).

3. Select Save.
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Additional plugins for Supplier Collaboration Portal

After installing the Supplier Collaboration Portal  application, you can activate additional plugins 
to enable additional features.

You must have the admin role to activate these additional plugins. For details, see Activate a 
plugin .

Plugin Description

GRC: Vendor Risk 
Management 
[sn_vdr_risk_asmt]

The ServiceNow®  Vendor Risk Management  (VRM) application 
enables you to assess vendors to understand the risk that they pose 
to your organization, and reduce the manual burden and cost of 
assessment through automation.

GRC: Vendor Portal 
[sn_grc_vendor_portal]

Enables Supplier Contacts to view a list of open and closed risk 
assessments on the Vendor Risk page in the Vendor Assessment 
Portal (Governance, Risk, and Compliance  (GRC): Vendor Portal).

Note:  The GRC: Vendor Portal is installed as a dependent 
plugin with GRC: Vendor Risk Management.

Related topics

Install Supplier Collaboration Portal

Install Supplier Operations

You can install the Supplier Operations application (com.snc.sn_so) to access advanced case 
management capabilities to handle key supplier lifecycle events.

Before you begin
Important: 

• Check your entitlements to determine whether you have access to Supplier Operations.

• The new plugin Supplier Operations  (com.snc.sn_so) (v 1.2.0 ) must be installed after 
upgrading to the Supplier Case Management Yokohama  December 2025 (v 5.2.0) 
release.

Role required: admin

To install Supplier Operations, the following plugins have to be installed:

• Required plugin: Supplier Operations (com.snc.sn_so)

• Dependent plugins:

◦ Supplier Case Management (com.snc.sn_supplier_mgmt)

◦ Document Management (com.snc.platform_document_management)

Note:  The application installs required ServiceNow®  Store  applications and plugins if they 
are not already installed.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Supplier Operations application (com.snc.sn_so) using the filter criteria and search 
bar.
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You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Related topics

Install Supplier Lifecycle Operations

Install Supplier Payment Optimization

You can install the Supplier Payment Optimization application to identify, prioritize, and track high 
potential suppliers and estimate potential savings from credit card payments.

Before you begin
Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization.

Role required: admin

To install Supplier Payment Optimization, the following plugins have to be installed:

• Required plugin: Supplier Payment Optimization (com.snc.sn_slm_opt)

• Dependent plugins:

◦ Supplier Operations (com.snc.sn_so)

◦ Source-to-Pay Workspace (com.sn_spend_workspace)

◦ Source-to-Pay Common Architecture (com.snc.sn_shop)

Note:  The application installs required ServiceNow®  Store  applications and plugins if they 
are not already installed.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Supplier Payment Optimization application (com.snc.sn_slm_opt) using the filter 
criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.
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4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Related topics

Install Supplier Lifecycle Operations

Supplier Document Management

Supplier Lifecycle Operations  uses the ServiceNow®  Document Management  functionality to 
enable supplier managers, supplier owners, supplier administrators, and supplier contacts to 
manage supplier documents.

Supplier Lifecycle Operations  extends the Document Management  plugin 
(com.snc.platform_document_management), which is installed along with the Supplier Lifecycle 
Operations  application. For more information, see Document Management .

You can create a supplier document configuration to configure various aspects of the document 
upload process. The document configuration determines when this configuration is run, who can 
view, update, and upload a document, and whether to send notifications when a document is 
uploaded or has expired. You can set run conditions to determine when the configuration should 
be run or you can run the configuration manually.

Create a supplier document configuration

Create a supplier document configuration to define when to run the configuration, who can 
view the upload request and upload the documents, and whether to send notifications when 
documents are uploaded or have expired.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Do one of the following.

To Do This

Create a document configuration from the 
Platform UI

Navigate to All  > Supplier Lifecycle Opera­
tions  > Administration  > Document Configu­
ration

Create a document configuration from the 
Source-to-Pay Workspace

a. Navigate to All  > Supplier Lifecycle Opera­
tions  > Source-to-Pay Workspace.

b. Select the list icon ( ) and navigate to 
Lists  > Administration  > Document Config­
uration.

2. Select New.

3. On the form, fill in the fields.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

956

https://www.servicenow.com/docs/access?context=doc-management-landing&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=doc-management-landing&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=doc-management-landing&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US


Supplier Document Configuration form

Field Description

Name The name you assign to the configuration.

Application The application containing this record. In this case, it displays the default 
application, which is Supplier Collaboration Portal.

Order The order that you want the configuration to be displayed. Assign a numeric 
value in multiples of 100.

Active Option to decide if this configuration is in use.

Description A brief description of the configuration.

4. Select the Run condition  tab and fill in the fields.

Run condition form

Field Description

When to 
run

When you want the configuration to run. The choices are:

◦ On demand: The configuration runs when you select Execute Now  on the 
Supplier Document Configuration form.

You can use this option to run the configuration immediately without waiting for 
the other run conditions to be met. For more information, see Manually run a 
supplier document configuration.

◦ When supplier record inserted: The configuration runs when a new supplier 
record is created.

◦ When supplier record updated: The configuration runs when an existing 
supplier record is updated.

◦ When supplier record inserted/updated: The configuration runs when a new 
record is created or an existing supplier record is updated.

Supplier 
condition

Specify when the configuration must run when specific conditions are met.

Advanced Option to use a script to specify when the configuration is run.

5. Select the Upload preferences  tab and fill in the fields.

Upload preferences form

Field Description

Required 
from

Specify who must upload the document. The choices are:

◦ Anyone: Requires any one of the supplier contacts to upload the required 
document. With this option, the supplier contact can upload a document from 
the Document widget on the My Company page of the Supplier Collaboration 
Portal.

For more information, see Manage documents from the Supplier Collaboration 
Portal.
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Field Description

◦ Everyone: Requires each supplier contact to upload the required document.

The Generate task for  field becomes available if you select Everyone  in the 
Required from  field. Select Yes  in the Generate task for  field to generate the 
Upload Document task for each supplier contact.

With this option, the supplier contact can upload the document from either of 
these locations in the Supplier Collaboration Portal:

▪ Documents widget on the My Company page

▪ Upload Document task on the My To-dos page

For more information, see Manage documents from the Supplier 
Collaboration Portal.

6. Select the Manage access  tab and fill in the fields.

Manage access form

Field Description

View access Users with this access can only read the document.

Upload/Update access Users with this access can update and upload the document.

Admin access Users with this access can read, update, and upload the document.

Note:  On the Manage access  tab, assign access to users or user groups based on the 
user criteria permissions.

7. Select the Notification  tab and fill in the fields.

Notification form

Field Description

Notify on upload Controls whether a notification is sent when a document is 
uploaded. The options are:

◦ Yes

◦ No

Whom to notify on 
upload

The user that you want to notify when the document is uploaded.

This field becomes available only if you select Yes  in the Notify on 
upload  field.

Notify on expiry Controls whether a notification is sent when a document expires. 
The options are:

◦ Yes

◦ No

Whom to notify on 
expiration

The user that you want to notify when the document expires.

This field becomes available only if you select Yes  in the Notify on 
expiry  field.
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8. Select Save  to remain on the Supplier Document Configuration form.

Note:  The Suppliers related list displays all the suppliers for whom the supplier 
document configuration is applicable.

9. In the Supplier Document Types related list, select New.

Note:  If you want to create a supplier document type from the Source-to-Pay 
Workspace, do the following:

a. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

b. Select the list icon ( ) and navigate to Lists  > Administration  > Document 
Configuration.

c. Open a supplier document configuration, select the Supplier Document Types  tab, 
and then select New.

10. On the form, fill in the fields.

Supplier Document Type form

Field Description

Name The name for the document type.

Type The type of the document. The choices are:

◦ Policy

◦ Guideline

◦ Procedure

◦ Contract

Document 
Configuration

The document configuration that you want to associate the document type 
with.

Order The order that you want the configuration to be displayed. Assign a numeric 
value in multiples of 100.

Days to 
expiry

Number of days before the document expires.

Note:  After a document expires, a notification is sent to the users 
stating that the document has expired and a new version of the 
document must be uploaded.

The notification is sent only if the Notify on expiry  field is set to Yes. The 
notification is sent to the users you specify in the Whom to notify on 
expiration  field.

After a document expires, it is marked as Expired in the Documents 
widget in the Supplier Collaboration Portal. The Expired marking is 
removed when you upload an updated version of that document.

Template Option that enables you to attach a template that specifies the expected 
format of the document to upload.

Select the Manage Attachments icon ( ) to attach a template.
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Field Description

Description A brief description of the document type.

11. On the Upload preferences, Manage access, and Notification  tabs, specify the values that 
you want the document type to use.

Note:  The field values that you set in these tabs override the field values that you set in 
the corresponding tabs for the document configuration you associate this document type 
with.

12. Select Submit.

Manually run a supplier document configuration

Run a supplier document configuration to enable supplier managers, supplier owners, and 
supplier contacts to immediately upload the required documents.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, sn_slm.contact or sn_slm.admin

About this task
The supplier document configuration is configured to run based on the run conditions that you 
set. However, you can run them manually when needed. Running the document configuration 
creates either or both of the following in the Supplier Collaboration Portal, based on the run 
conditions:

• A tile in the Documents widget on the My Company page. The supplier contact can upload a 
document using this tile in the Documents widget.

Note:  The Documents widget is created if you select Anyone  from the Required from 
field in the Upload preferences form. The tile in the Documents widget is named after the 
supplier document type name that you provided when creating the supplier document 
configuration.

• The Upload Document task on the My To-dos page. The supplier contact can upload a 
document using this task. The Upload Document task is created if you select Everyone 
from the Required from  field and also set the Generate task for  field to Yes  in the Upload 
preferences form.

Procedure

1. Do one of the following.

To Do This

Run a document configuration from the Plat­
form UI

Navigate to All  > Supplier Lifecycle Opera­
tions  > Administration  > Document Configu­
ration

Run a document configuration from the 
Source-to-Pay Workspace

a. Navigate to All  > Supplier Lifecycle Opera­
tions  > Source-to-Pay Workspace.

b. Select the list icon ( ) and navigate to 
Lists  > Administration  > Document Config­
uration.
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2. Select the document configuration that you want to run.

3. Select Execute Now.

Uploading supplier documents

After you create and run a supplier document configuration, you can upload the required 
prerequisite documents.

The supplier document configuration enables the following:

• Supplier managers and supplier owners can upload the required documents from the Source-
to-Pay Workspace. For more information, see Manage documents from the Source-to-Pay 
Workspace.

• Supplier contacts can upload the required documents from the Supplier Collaboration Portal. 
For more information see Manage documents from the Supplier Collaboration Portal.

Related topics

Create a supplier document configuration

Manually run a supplier document configuration

Configure the document template for the Sign document action type for 
supplier task

Create and configure the document template that enables you to collect e-signatures from 
multiple participants and generate a filled PDF document.

Before you begin
Role required: admin

About this task
Ensure that you've installed the Document Templates [com.snc.document_templates] plugin.

Important:  When you create the supplier task of action type Sign document for the 
very first time, the supplier task is created; however, the document task is not created. 
Therefore, you cannot use the first Sign document task to upload PDF or HTML documents 
to get signatures. When you create the Sign document task for the first time, a set of 
restricted caller access (RCA) records are created that you must approve. Approving RCAs 
is a one-time activity. After you approve the RCAs, you can create and use subsequent 
Sign document supplier tasks except the first Sign document task. For more information 
about the approving the required RCAs, see Approve application restricted caller access 
privileges for Sign document supplier task type.

Important:  Starting from the May Store 2024 release, the supplier task of action type 
Sign document uses the document template (PDF or HTML). The E-signature template is 
used only for KB articles.

Procedure

1. Navigate to All  > Document Templates  > All Document Templates.

2. Select New.

3. The What kind of document template would you like to create?  page is displayed.

The following options are available on this page:
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◦ HTML Document Template

◦ PDF Document Template

4. Do one of the following:

To Do this

Configure an 
HTML document 
template

To configure an HTML document template:

a. Select HTML Document Template.

b. In the Table  field, select Supplier Task [sn_slm_task].

c. On the form, fill in the fields.

For a description of the field values, see Configure an HTML document 
template .

d. Select Submit  or Save.

e. Select the Participants related list to create participants for the PDF 
document template. For more information, see Create participants for an 
HTML document template .

f. Insert signatures in an HTML document template by selecting 
participants from the list. For more information, see Insert signatures .

g. Select Publish.

Configure a 
PDF document 
template

To configure a PDF document template:

a. Select PDF Document Template.

b. In the Table  field, select Supplier Task [sn_slm_task].

c. On the form, fill in the fields.

For a description of the field values, see Configure a PDF document 
template .

d. Select Submit  or Save.

e. Select the Parse PDF  related link to automatically parse information on 
the PDF and store that information in the PDF Mapping table for reuse.

f. Select the Participants related list to create participants for the PDF 
document template. For more information, see Create participants for a 
PDF document template .

g. Select the Template Mappings related list to define the PDF field 
mappings. For more information, see Define a PDF field mapping .

h. Select the Mark signatures related list to choose participants and 
specify the area in the PDF document where you want to collect the 
signatures of those participants.

Note:  You can mark signatures only if you have defined 
participants and mapped users to those participants.
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To Do this

For more information, see Mark a signature block .

i. Select Publish.

Approve application restricted caller access privileges for Sign document supplier task type

Approve restricted caller access (RCA) privileges after you create a supplier task of action type 
Sign document for the very first time so that you can create and use subsequent Sign document 
supplier tasks.

Before you begin
Role required: admin

About this task
Approving RCAs is a one-time activity.

Procedure

1. Navigate to All  > System Applications  > Application Restricted Caller Access.

2. Open each RCA record that matches the following filter criteria:

Column Value

Status Requested

Target 
Scope

Document Templates

Source 
Scope

Supplier Common Architecture, Supplier Collaboration Portal, and Source-to-
Pay Workspace

3. From the Status  list, select Allowed.

4. Select Update.

Advanced Work Assignment for Supplier Lifecycle Operations

Use the Advanced Work Assignment for Supplier Lifecycle Operations  feature to automatically 
assign work items to agents based on availability and capacity.

Advanced Work Assignment for Supplier Lifecycle Operations  pushes work to qualified agents 
using work item queues, routing conditions, and assignment criteria that you define. For more 
information, see Exploring Advanced Work Assignment .

Prerequisites for installing Advanced Work Assignment for Supplier Lifecycle 
Operations

Before you install Advanced Work Assignment for Supplier Lifecycle Operations, ensure that 
you activate the Agent Chat  application and load the demo data during installation. For more 
information, see Activate Agent Chat and load demo data.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

963

https://www.servicenow.com/docs/access?context=mark-signature-doctemp&version=yokohama&pubname=yokohama-employee-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=mark-signature-doctemp&version=yokohama&pubname=yokohama-employee-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=mark-signature-doctemp&version=yokohama&pubname=yokohama-employee-service-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=awa-overview&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=awa-overview&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=awa-overview&version=yokohama&pubname=yokohama-servicenow-platform&ft:locale=en-US


Required plugins

Install the Advanced Work Assignment for Supplier Lifecycle Operations  (com.snc.sn_slm_awa) 
plugin if you have the admin role. Installing this plugin also installs the following dependent 
plugins:

• Advanced Work Assignment (com.glide.awa)

• Agent Chat (com.glide.interaction.awa)

• Glide Virtual Agent (com.glide.cs.chatbot)

• Supplier Lifecycle Operations (com.snc.sn_supplier_mgmt)

Source-to-Pay Workspace  agent inbox

Use the agent inbox to manage your incoming work items, such as chats, cases, incidents, and 
more.

To open the agent inbox, select the Inbox icon ( ) in the Source-to-Pay Workspace.

The agent inbox displays the queues that are assigned to you, the number of active chats in 
each queue, and the average wait time for chats in the queue. For more information, see Inbox 
layout .

When you accept a chat, an interaction record is automatically created and captures the work 
done in that session.

Activate Agent Chat  and load demo data

Activate Agent Chat  and load demo data.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the Agent Chat  plugin using the filter criteria and search bar.

3. Select Install.

4. In the Activate Plugin dialog box, select the Load demo data  check box, and then select 
Activate.

Setting up Advanced Work Assignment for Supplier Lifecycle Operations

Plan and configure your implementation of Advanced Work Assignment for Supplier Lifecycle 
Operations.

Setting up Advanced Work Assignment for Supplier Lifecycle Operations  involves configuring 
the following components:

• Service channels: A means of providing customer service. Advanced Work Assignment  offers 
base system channels for chats, cases, incidents, and walk-up centers. For each channel, you 
can set attributes such as agent capacity and utilization conditions to control the work handled 
in the channel.

• Work item: A single piece of work handled by an agent from start to completion.

• Work item queue: A queue that stores a specific type of work item for a service channel.

• Assignment groups: Agents belong to specific groups organized by the type of work assigned 
to them.
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• Assignment rules: Criteria that determine how work items are pushed to the appropriate agent 
within a qualified assignment group.

• Agent capacity: The maximum number of work items on a particular service channel that an 
agent may actively work on at one time. If you want to set a maximum capacity for an agent 
across all service channels, define the maximum universal capacity for that agent.

• Agent availability: States that indicate agent presence and whether the agent is available 
for work or is busy or offline. Advanced Work Assignment  uses the agent availability state to 
determine if an agent is able to receive work.

• Inbox layout: A configuration tied to a service channel that defines which fields of a record 
representing a work item are shown in agent inboxes. A layout defines what the agent sees in 
the Source-to-Pay Workspace.

For more information, see Exploring Advanced Work Assignment .

Configure Advanced Work Assignment for Supplier Lifecycle Operations

Configure various components, such as service channels, work item queues, and assignment 
rules that determine how a chat interaction should be routed to an agent.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment.

2. Create a service channel to automatically route incoming work to agents.

For more information, see Create or configure a service channel .

The following service channels are specific to Advanced Work Assignment  for Supplier 
Lifecycle Operations.

◦ Supplier Cases

◦ Chat

After you have created a service channel, do the following:

a. Configure the agent capacity to determine the number of work items that can be 
automatically assigned to agents supporting a service channel. For more information, see 
Override agent capacity for selected agents .

b. Create or change an inbox layout to determine the information shown on work item cards 
displayed in an agent's inbox. For more information, see Create or change an inbox layout .

c. Create a work item size override if you want to calculate an agent's workload using a work 
item size other than the default. For more information, see Create or change a work item size 
override .

3. Define or change a queue so that you can determine which work items are routed 
automatically to agents through a given service channel.
For more information, see Create a work item queue .

4. Set the Advanced Work Assignment criteria for assigning work items to agents.
For more information, see Configure agent assignment rules .

5. Optional:  Configure the following parameters to improve your Advanced Work Assignment 
functionality:
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a. Create or modify the availability states that agents use to indicate whether they can receive 
work or are offline or away. Agents set these states in their Workspace Inbox. For more 
information, see Configure agent presence states .

b. Define the reasons that agents can use to decline work assignments that they receive in 
their Agent Workspace inbox. For more information, see Configure reasons for rejecting work 
items .

c. Prevent an agent from being assigned too many work items by configuring the agent's 
maximum universal capacity. For more information, see Configure an agent's maximum 
universal capacity .

d. Create or manage groups that have associated Advanced Work Assignment queues. For 
more information, see Create or change groups for Advanced Work Assignment queues .

For detailed instructions on how to configure Advanced Work Assignment, see Configuring 
Advanced Work Assignment .

Configure the Supplier Collaboration Queue

Configure the Supplier Collaboration Queue chat queue to ensure that the chat requests are 
routed and assigned to specific agents that belong to a defined group.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Advanced Work Assignment  > Queues.

2. Select Supplier Collaboration Queue.

For more information about the fields on the Supplier Collaboration Queue form, see Create a 
work item queue .

3. In the Initial agent response  field, enter the message that you want the users to see when an 
agent accepts a chat.
For example: Thank you for contacting support. I am looking into 
your question now and will be with you shortly.

4. In the Max wait time message  field, enter the message that you want the users to see when a 
chat ends after the Max Wait Time has elapsed.
This field is required if the Max Wait Time  is greater than 0.

5. In the Target wait time  field, enter the estimated time (Days or Hours, minutes, seconds) you 
want allotted for an agent to accept an item in the queue.

6. In the Max Wait Time field, enter the maximum amount of time within which all available agents 
have to accept or reject a chat request.
After time runs out, the requester receives the value in either the Max wait time message  field 
or the No Agents Available Message  field defined in Agent Chat settings .

Note:  The Max Wait Time  field is available after you associate the queue to the chat 
service channel.

7. In the Assignment Eligibility related list, select New.

a. In the Agent assignment rule  field, select Chat - Most Capacity.

b. Click the lock icon ( ) next to the Groups  field.
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c. Click the look-up icon ( ) to view the list of groups.

d. Select New.

e. In the Name  field, enter a name for the group.

f. Fill in the remaining fields, as appropriate.

g. Select Submit.

h. Click the lock icon ( ) to lock the Groups  field.

i. Right-click and select Save.

8. Next to the Groups  field, select the link to the group, which opens the group record.

a. In the Group Members related list, select Edit  to add members to the group.

b. Select one or more users in the Collection list and move them to the Group Members List.

c. Select Save.

Note:  The users that you add to this assignment group are automatically granted the 
awa_agent role.

Configure Agent Chat  for Source-to-Pay Workspace

Use Agent Chat Settings to configure Agent Chat  for Source-to-Pay Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Conversational Interfaces  > Settings  > Agent Chat.

2. In the User Experience - Chat settings section, do the following:

a. Swipe the Agent names and avatars  toggle switch to the right to enable this option.

b. Swipe the Transcripts  toggle switch to the right to enable the requesters to download 
a transcript of the conversation they had with an agent. For more information, see Chat 
transcript downloads for requesters .

3. In the User Experience - Statuses section, from the Live chat wait status drop-down list, select 
Wait Time.

4. In the Configurable Toolbar Controls section, select View All.
The Quick Action Toolbar Controls is displayed.

Add or update the quick action shortcuts for live agents in the Agent Chat. For more 
information about configuring the toolbar controls, see Setting up quick action toolbar 
controls .

5. Select Save.

Using Advanced Work Assignment for Supplier Lifecycle Operations

Enables supplier contacts to interact with supplier owners and resolve their issues and get 
answers to questions.

The Advanced Work Assignment for Supplier Lifecycle Operations  application enables the 
following:
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• Supplier fulfillers can accept a chat request from the Supplier Lifecycle Operations  to interact 
with supplier contacts. For more information, see Accept an incoming chat request from the 
Source-to-Pay Workspace.

• Supplier contacts can start a chat session from the Supplier Collaboration Portal  to interact 
with supplier fulfillers. For more information see Start a chat session from the Supplier 
Collaboration Portal.

Related topics

Configure Advanced Work Assignment for Supplier Lifecycle Operations

Setting up Advanced Work Assignment for Supplier Lifecycle Operations

Enable M2M mapping between supplier contact and suppliers

Many-to-many (M2M) mapping between supplier contact and suppliers enables one supplier 
contact to be the contact for multiple suppliers, provided the suppliers share a parent-subsidiary 
relationship.

Before you begin
Role required: admin

Important:  M2M mapping between supplier contact and suppliers is available from the 
Xanadu  December 2024 release onwards. The following steps are required to enable M2M 
mapping.

Procedure

1. Create and run a fix script to enable M2M mapping.
For detailed steps, see Run the fix script to enable M2M mapping.

2. Verify that the version record is created for the script include 
M2MSupplierSupportUtil.
For detailed steps, see Verify version record.

3. Configure the Supplier Email Domain [sn_slm_email_domain] table to remove the unique 
constraint from the Email Domains  column.
For detailed steps, see Remove the unique constraint from Email Domain.

Note:  This step is required only for the upgrade scenarios (for all earlier versions 
upgrading to the Xanadu  December 2024 release).

Run the fix script to enable M2M mapping

Run the fix script to enable M2M mapping between supplier contact and suppliers.

Before you begin
Verify that the application scope is set to Supplier Common Architecture.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

Verify that the application scope is set to Supplier Common Architecture.

2. Select New.

3. Fill in the following fields to create the fix script:
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Field Description

Name Unique, descriptive name for the fix script.

Description Include the disclaimer: This script is intended 
for a one-time execution in an instance and 
must remain unaltered.

Script Enter the following code for the fix script:

var m2mEnableUtil = new 
 sn_slm.M2MSupplierSupportUti
l();
gs.info("Current status of 
 M2M Supplier support: " + 
 m2mEnableUtil.isM2MSupplierS
upported());
gs.info("Enabled M2M 
 supplier support: " + 
 m2mEnableUtil.enableM2MSuppl
ierSupport());

4. Save and select Run Fix Script.
A version record is created after the script is executed.

What to do next
Verify if the version record is created for M2MSupplierSupportUtil script include.

Verify version record

After the fix script is created and run to enable M2M mapping between supplier contact and 
suppliers, a version record must be created.

Before you begin
Verify that the application scope is set to Supplier Common Architecture.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Include.

2. Search for M2MSupplierSupportUtil script include  and open it.
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3. Check in the Versions  related list if the version record is created.
If the version record is not created, select Update  to manually save the script and check again 
for the version record.

What to do next
Remove the unique constraint from Email Domain.

Remove the unique constraint from Email Domain

Multiple supplier records can have the same email domain after removing the unique  constraint 
from the Email Domain  column of the Supplier Email Domain [sn_slm_email_domain] table.

Before you begin
Role required: admin

Important:  This procedure is required only for the upgrade scenarios (for all earlier 
versions upgrading to the Xanadu  December 2024 release).

Procedure

1. In the navigation filter, enter sn_slm_email_domain_list.do.

2. Hover and right-click Email Domain  field to open the Dictionary Entry of 
sn_slm_email_domain  table.

3. Select the form context menu icon ( ) and select Configure  > Form Layout.

4. From the Available  list of fields, select the Unique  field and move it to the Selected  column.

5. Select Save.
The Unique  field is now available in the Dictionary of the sn_slm_email_domain  table.

6. Navigate to the Dictionary of sn_slm_email_domain  table, clear the Unique  check box 
and save the form.

Note:  If you are still unable to invite a supplier contact with duplicate domain, or if the 
onboarding playbook is stuck while waiting to send out an email to the supplier contact, 
follow the troubleshooting steps in the KB article KB1709872 .

Configure Supplier Relationship and Performance Management

Define key performance indicators (KPIs) and segmentation criteria to measure supplier 
performance effectively.

Important:  Check your entitlements to determine whether you have access to Supplier 
Relationship and Performance Management.

Configuring Supplier Relationship and Performance Management (SRPM) involves the following:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

970

https://support.servicenow.com/kb?sys_kb_id=43cccf6483ca9a10cdbbc430feaad3d4&id=kb_article_view
https://support.servicenow.com/kb?sys_kb_id=43cccf6483ca9a10cdbbc430feaad3d4&id=kb_article_view
https://support.servicenow.com/kb?sys_kb_id=43cccf6483ca9a10cdbbc430feaad3d4&id=kb_article_view


• Create KPI template and its thresholds: Define KPI template and thresholds to collect the 
metrics systematically by creating data collection tasks for evaluating supplier performance.

• Create automated KPI template and KPIs: Define automated KPI template and KPIs to collect 
the metrics automatically from the specified data source and calculation method.

• Create supplier-level KPIs: Add suppliers to a KPI template or vice versa to generate 
corresponding supplier-level KPI records and KPI collection tasks for the suppliers.

• Create contract-level KPIs: Add KPI template to a supplier to generate corresponding 
contract-level KPI records and KPI collection tasks for the suppliers.

• Configure Segmentation Rules: Configure segmentation rules to ensure consistent 
measurement and comparison of supplier performance, categorize suppliers into distinct 
groups based on specific criteria or characteristics.

Related topics

Create KPI units

Create KPI performance domains

Create manual KPI templates

Create KPI units

Create KPI units to be used as measurement units for the quantitative performance of the 
supplier KPIs.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. In the navigation filter, enter sn_kpi_unit.LIST.
The list of existing units are displayed.

3. Select New.

4. On the form, fill in the fields.

Create New KPI unit form

Field Description

Active Indicates whether the KPI unit record is active. This option is enabled by default.

Label Symbol or label of the KPI unit.

Unit family Category under which the unit is listed. For example, the unit US Dollars  is 
listed under the Currency  Unit family.

Note:  You can see the list of existing Unit families by selecting the look-

up ( ) icon. If none is listed, you can create one by selecting New.

Description Brief description of the KPI unit.

Name Name of the KPI unit.

Format Format in which the value is displayed.

For example:
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Field Description

◦ If Format is ${0}, $<value> is displayed.

◦ If Format is {0}%, <value>% is displayed.

Domain Domain category under which the unit is listed. By default, the Domain is set as 
Global.

Note:  You can see the list of existing domains by selecting the look-up 

( ) icon. If none is listed, you can create one by selecting New.

5. Select Submit.
A record is created for the new KPI unit.

Related topics

Create KPI performance domains

Create manual KPI templates

Create KPIs by adding suppliers to a KPI template

Create KPI performance domains

Create KPI performance domains to classify various KPIs into categories. The KPIs under 
different performance domains can be viewed in the KPI management tab and the Performance 
dashboard to measure the supplier performance.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. In the navigation filter, enter sn_kpi_domain.LIST.
The list of existing performance domains are displayed.

3. Select New.

4. On the form, fill in the fields.

Create New KPI domain form

Field Description

Domain Name of the KPI performance domain.

Description Brief description of the KPI performance domain.

Active Indicates whether the KPI performance domain record is active. This option is 
enabled by default.

5. Select Submit.
A record is created for the new performance domain.
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Related topics

Create KPI units

Create manual KPI templates

Create KPIs by adding suppliers to a KPI template

KPI templates

KPI templates are created to define KPIs that can be used to measure supplier performance.

You can define KPI templates and thresholds to collect the metrics systematically for evaluating 
supplier performance. KPI templates can be of the following types:

• Manual KPI templates: KPIs created from the manual KPI templates requires users (internal 
or external) to manually input KPI data based on the frequency schedules. This option is 
available both for quantitative and qualitative KPIs. For more information, see Create manual 
KPI templates.

• Automated KPI templates: KPIs created from the automated KPI templates extract and 
calculate data directly from the specified table using a specified method (count, sum, average, 
max, min, or latest value) based on the frequency schedules. This option is only available for 
quantitative KPIs. For more information, see Create automated KPI templates.

Note: 

To enable the Automated KPIs feature after an upgrade, run the fix scripts KPI - Dec 25 
records script  and KPI - Dec 25 data records script. For more information, see Run fix 
scripts to enable Automated KPI collection.

Create manual KPI templates

Create manual KPI templates to define KPIs that require users to manually input KPI data based 
on the frequency schedules.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Manual KPI templates can be created for both Qualitative  and Quantitative  KPI types.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following:
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◦ Under Quick actions, select Create KPI 

template.

◦ Select the list icon ( ), navigate to Lists  > Performance management  > KPI Templates, 
and then select New.

3. On the form, fill in the fields.

Select Manual  for creating a manual KPI template.

Create New KPI template form

Field Description

Basic details

Name Name of the KPI template.

Description Brief description of the KPI template.

Template 
owner

The person who owns the KPI template.

Type Indicates the type of the KPI template. The available options are:

◦ Quantitative

◦ Qualitative

Note:  Manual KPI templates can be created for both Qualitative  and 
Quantitative  KPI types.

Active This option is turned off by default. The KPI is automatically set to active 
after you have added at least two thresholds for the KPI and one of those 
thresholds is marked as target.

KPI properties

Performance 
domain

Indicates the group that the KPI belongs to.

Recommended 
weight

Determines the importance of the KPI in the overall performance score 
when multiple KPIs are collected.
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Field Description

Direction Indicates whether the KPI should be minimized or maximised to show the 
ideal trend of the values. The available options are:

◦ Maximize

◦ Minimize

◦ Milestone

Nature Indicates whether the KPI is leading (predicts future), lagging (measures 
past performance), or current (monitors ongoing activities). The available 
options are:

◦ Leading

◦ Lagging

◦ Current

Precision Specifies the number of decimal points to be used for data collection to 
ensure accuracy and consistency.

This field is displayed only if you select Quantitative  in the Type  field.

Unit Measurement used to quantify the performance indicator.

This field is displayed only if you select Quantitative  in the Type  field.

Data collection

Data collection 
type

Select Manual  for creating a manual KPI template.

Note:  For Qualitative  KPI type, only manual KPI template can be 
created.

Collection 
source

The user persona that provides the data. The available options are:

◦ User

◦ Supplier Manager

◦ Supplier Contact

Collected from 
user

The person who provides the data.

This field is displayed only if you select User  in the Collection source type 
field.

Instructions Populated in KPI collection tasks to give more context to the user providing 
the KPI data.

Collection 
frequency

The frequency for collecting the KPI data. The available options are:

◦ Daily

◦ Weekly

◦ Monthly

◦ Quarterly

◦ Semi-annually

◦ Annually
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Field Description

Contract data 
aggregation 
method

The method used to calculate the aggregated KPI value when the given KPI 
consists of contract-level sub-KPIs:

◦ Average

◦ Sum

◦ Minimum

◦ Maximum

4. Select Save.

Result
A KPI is created for the selected supplier. This KPI is activated only when the following conditions 
are met:

• At least two active thresholds are added to the KPI

• One of those thresholds is marked as target

Related topics

Create KPI thresholds

Create KPI units

Create KPI performance domains

Create automated KPI templates

Automated KPI templates can be used to create KPIs that eliminate the dependency on manual 
input from users. When creating a template for automated KPIs, you can configure the data 
source and the calculation method.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

• Automated KPI templates can be created for Quantitative  KPI template type only.

• You must have access to data tables for extracting information for automated KPI templates.

• If the automated KPI collection fails to extract data, manual KPI data collection tasks are 
created and assigned to the supplier manager.

Important:  Check your entitlements to determine whether you have access to 
Automated KPIs. This feature is available from the Yokohama December 2025 release 
onwards.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following:
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◦ Under Quick actions, select Create KPI 

template.

◦ Select the list icon ( ), navigate to Lists  > Performance management  > KPI Templates, 
and then select New.

3. On the form, fill in the fields.

Select Automated  for creating an automated KPI template.

Create New KPI template form

Field Description

Basic details

Name Name of the KPI template.

Description Brief description of the KPI template.

Template 
owner

The person who owns the KPI template.

Type Indicates the type of the KPI template. Select Quantitative.

Note:  Automated KPI templates can be created for Quantitative  KPI 
template type only.

Active This option is turned off by default. The KPI is automatically set to active 
after you have added at least two thresholds for the KPI and one of those 
thresholds is marked as target.

KPI properties

Performance 
domain

Indicates the group that the KPI belongs to.

Recommended 
weight

Determines the importance of the KPI in the overall performance score 
when multiple KPIs are collected.

Direction Indicates whether the KPI should be minimized or maximised to show the 
ideal trend of the values. The available options are:
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Field Description

◦ Maximize

◦ Minimize

◦ Milestone

Nature Indicates whether the KPI is leading (predicts future), lagging (measures 
past performance), or current (monitors ongoing activities). The available 
options are:

◦ Leading

◦ Lagging

◦ Current

Precision Specifies the number of decimal points to be used for data collection to 
ensure accuracy and consistency.

This field is displayed only if you select Quantitative  in the Type  field.

Unit Measurement used to quantify the performance indicator.

This field is displayed only if you select Quantitative  in the Type  field.

Data collection

Data collection 
type

Select Automated  for creating a automated KPI template.

Note:  Automated KPI template can be created only for Quantitative 
KPI type.

Collection 
table

Table from where KPI data is to be collected.

Note:  You must have access to the data tables for extracting data for 
automated KPIs.

Entity table 
column

Column of the collection table which refers to the supplier or contract name.

KPI data table 
column

Column of the collection table which contains the KPI data to be extracted.

Automated 
data 
aggregation 
method

The aggregation method used to calculate the data extracted from the 
tables mentioned according to the condition:

◦ Count

◦ Sum

◦ Average

◦ Min

◦ Max

◦ Latest

Collection 
frequency

The frequency for collecting the KPI data. The available options are:

◦ Daily

◦ Weekly

◦ Monthly
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Field Description

◦ Quarterly

◦ Semi-annually

◦ Annually

Contract data 
aggregation 
method

The method used to calculate the aggregated KPI value when the given KPI 
consists of contract-level sub-KPIs:

◦ Average

◦ Sum

◦ Minimum

◦ Maximum

Criteria Build a filter criteria by adding conditions that contain a field, operator, and 
value(s).

Instructions Populated in KPI collection tasks to give more context to the user providing 
the KPI data.

4. Select Save.

Result
An automated KPI template is created. This KPI is activated only when the following conditions 
are met:

• At least two active thresholds are added

• One of those thresholds is marked as target

Related topics

Create KPI thresholds

Create KPI units

Create KPI performance domains

Create KPI thresholds

Create KPI thresholds that consist of predefined values that serve as benchmarks or limits for 
evaluating performance against specific objectives.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

About this task
Ensure that you add at least two active thresholds to activate a KPI template. You can add a 
maximum of five thresholds to a KPI template.

Note:  Thresholds help determine what score the supplier receives in the KPI 
management  tab and in the scorecard. For more information, see Manage supplier KPIs 
from the supplier record page of the Source-to-Pay Workspace.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ), and navigate to Lists  > Performance management  > KPI Templates.
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3. In the Name column, select the link to the KPI template.

4. Select the Thresholds  tab and select New.

5. On the form, fill in the fields.

Create New KPI Threshold form

Field Description

Name Name of the KPI threshold.

Label Label for the KPI threshold.

Note:  The Label field is displayed only for the Qualitative KPI templates.

Description Brief description of the KPI threshold.

Target 
threshold

Option indicating that the threshold represents the target value for the KPI.

Active Option indicating that the threshold is active for use.

Low Value Represents the low value in the KPI threshold value range.

◦ This field is displayed only for Quantitative KPI templates.

◦ This value is included  in the threshold range.

◦ If left empty, the Low Value  defaults to negative infinity.

High Value Represents the high value in the KPI threshold value range.

◦ This field is displayed only for Quantitative KPI templates.

◦ This value is excluded  from the threshold range.

◦ If left empty, the High Value  defaults to positive infinity.

Normalized 
value

Indicates a value that has been calculated from its original figure to fit a specific 
scale for easy comparison with other values. For example, a scale of 1–5.

Color The color you select for each threshold is inherited by the Status column 
(showing highlighted value) in the KPI management tab on the Supplier page. 
For more information, see Manage supplier KPIs from the supplier record page 
of the Source-to-Pay Workspace.

6. Select Save.

Note:  A KPI is activated only when at least two active thresholds are added to it and one 
of those thresholds is marked as Target threshold.

Create KPIs by adding suppliers to a KPI template

You can add a new supplier whose performance you want to measure using the KPI template. 
Adding a supplier to a KPI template generates corresponding KPI records and KPI collection 
tasks for this supplier.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

About this task
The Supplier  related tab for a KPI template displays the following information:
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• Automatically displays suppliers that match a segmentation rule that is linked to this KPI 
template.

• Displays suppliers that you add manually by selecting Add.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > KPI Templates.

3. In the Name column, select the link to the KPI template.

4. Select the Suppliers  tab and select Add.
The Add supplier dialog box is displayed which shows the list of existing suppliers. You can 
select suppliers from this list to generate template-corresponding KPIS for the selected 
suppliers.

5. Select Add.
Template-corresponding KPIs are created for the added suppliers and the newly added 
supplier is shown in the Suppliers  related tab for the KPI template. Also, corresponding KPI 
collection tasks are created for the suppliers.

Note:  The same result can be achieved by adding a template to a supplier record.

What to do next
Run segmentation rule.

Create supplier-level KPIs from KPI management

You can add supplier-level for a supplier from the KPI management  tab of the supplier page. You 
can also define contract-level KPIs under their respective supplier-level KPIs.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier.

4. Select the KPI management  tab.

5. Select Add.

6. Select the collection level as Supplier level.
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7. Select a KPI template from the list of available KPI templates.

8. Select Add.

The corresponding KPI records and KPI collection tasks are created.

Create contract-level KPIs from KPI management

You can add contract-level KPIs for a supplier from the KPI management  tab of the supplier page. 
Contract-level KPIs are defined under their respective supplier-level KPIs.

Before you begin
Role required: admin

You can add contract-level KPIs only if you have installed the Sourcing and Purchasing 
Automation (com.snc.sn_pr) and Source-to-Pay Common Architecture (com.snc.sn_shop) 
plugins.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier.

4. Select the KPI management  tab.

5. Select Add.

6. Select the collection level as Contract level.
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7. Select the applicable contracts from the list of available contracts.

8. Select a KPI template from the list of available KPI templates.

9. Select Add.

The corresponding KPI records and KPI collection tasks are created.

Note: 

◦ All contract-level KPIs are defined under their respective supplier-level KPIs. If a 
supplier-level KPI doesn’t exist for a newly created contract-level KPI, a corresponding 
parent supplier-level KPI is also created.

◦ Aggregated values from contract-level KPIs must fall in the threshold ranges of their 
respective supplier-level KPIs. Therefore, supplier-level KPI thresholds must be defined 
for all possible aggregated values of contract-level KPIs, otherwise the KPI data won’t 
be generated.

Create KPIs without using KPI template

You can add new KPIs for a supplier without using the existing KPI templates. Adding new KPIs 
directly generates the corresponding KPI templates.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > KPIs.

3. Select New.

4. On the Create New KPI form, fill in the fields.

Create New KPI form

Field Description

Basic details

Name Name of the KPI.
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Field Description

Supplier Name of the supplier.

Description Brief description of the KPI template.

Type Indicates the type of the KPI. The available options are:

◦ Quantitative

◦ Qualitative

Active This option is turned off by default. The KPI is automatically set to active 
after you have added at least two thresholds for the KPI and one of those 
thresholds is marked as target.

KPI properties

Performance 
domain

Indicates the group that the KPI belongs to.

Weight Determines the importance of the KPI in the overall performance score when 
multiple KPIs are collected.

Direction Indicates whether the KPI should be minimized or maximized to show the ideal 
trend of the values. The available options are:

◦ Maximize

◦ Minimize

◦ Milestone

Nature Indicates whether the KPI is leading (predicts future), lagging (measures past 
performance), or current (monitors ongoing activities). The available options 
are:

◦ Leading

◦ Lagging

◦ Current

Precision Specifies the number of decimal points to be used for data collection to 
ensure accuracy and consistency.

This field is displayed only if you select Quantitative  in the Type  field.

Unit Measurement used to quantify the performance indicator.

This field is displayed only if you select Quantitative  in the Type  field.

Data collection

Collection 
source type

The user persona that provides the data. The available options are:

◦ User

◦ Supplier Manager

◦ Supplier Contact

Collected 
from user

The person who provides the data.

This field is displayed only if you select User  in the Collection source type 
field.
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Field Description

Instructions Populated in KPI collection tasks to give more context to the user providing the 
KPI data.

Next run 
date

The next scheduled run date in yyyy-mm-dd format.

Collection 
frequency

The frequency for collecting the KPI data. The available options are:

◦ Daily

◦ Weekly

◦ Monthly

◦ Quarterly

◦ Semi-annually

◦ Annually

Aggregation 
method

The method used to calculate the aggregated KPI value when the given KPI 
consists of contract-level sub-KPIs:

◦ Average

◦ Sum

◦ Minimum

◦ Maximum

5. Select Save.

Result
A KPI is created for the selected supplier. Also, a corresponding KPI template is created.
This KPI is activated only when the following conditions are met:

• At least two active thresholds are added

• One of those thresholds is marked as target

Create segmentation rule

Create a segmentation rule that defines criteria for categorizing suppliers into different segments 
based on various attributes or performance factors.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following:

◦ Under Quick actions, select Create segmentation rule..

◦ Select the list icon ( ), navigate to Lists  > Performance management  > Segmentation 
rules, and then select New.

3. On the form, fill in the fields.
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Create New Segmentation rule form

Field Description

Basic details

Name Name of the segmentation rule.

Description Brief description of the segmentation rule.

Active Option that indicates the segmentation rule is active for use.

Owner The person who owns the segmentation rule.

Frequency The frequency at which the segmentation rule automatically runs. The 
available options are:

◦ Ad-hoc

◦ Weekly

◦ Monthly

◦ Quarterly

◦ Yearly

Conditions

Segmentation 
table

Extracts data from the specified table.

Condition Option that enables you to build a filter by adding conditions with fields, 
operators, and values.

Select Edit conditions  to open the condition builder.

4. Select Save.

Add KPI templates to a segmentation rule

You can add new KPI templates to a segmentation rule if the existing templates used for 
suppliers don’t meet your needs.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > Segmentation 
rules.

3. In the Name column, select the link to the segmentation rule.

4. Select the KPI Template  tab and select Add.

5. On the Add KPI template form, select the check box next to the KPI template and select Add.
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The newly added supplier is shown in the KPI Template  related tab for the segmentation rule.

Note:  The weight of the new KPI template doesn’t affect the original KPI template weight 
or the weight of the KPI that was previously created from this template. However, this 
change will affect any newly created KPIs that are part of this segmentation rule after you 
run it by selecting Execute. For more information, see Run segmentation rule.

Add suppliers to a segmentation rule

You can add a new supplier to a segmentation rule if the existing suppliers don’t meet your 
needs.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

About this task
The Supplier  related tab displays the list of suppliers that fall under this segmentation rule. The 
Supplier  related tab shows the following information:

• Automatically displays suppliers that match this segmentation rule or other set condition after 
you run the segmentation rule by selecting Execute.

• Displays suppliers that you add manually by selecting New.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > Segmentation 
rules.

3. In the Name column, select the link to the segmentation rule.

4. Select the Suppliers  tab and select Add.
The Add supplier dialog box is displayed.

5. From the list of suppliers, select one or more suppliers and then select Add.
The newly added supplier is shown in the Suppliers  related tab for the segmentation rule.

What to do next
Select Execute  to run the segmentation rule. For more information, see Run segmentation rule.

Install Universal Request  for SLO

Install the Universal Request  for Source-to-Pay Operations  [sn_fsc_ur_common] plugin to use the 
Universal Request  feature in SLO.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you can’t find the plugin, request it from a 
ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note:  When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for Universal 
Request for Source-to-Pay Operations.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Components installed with Universal Request .

Configure smart assessments

Supplier managers can configure and create assessments in bulk for internal and external users 
by adding instructions, questions, and reference information from the Assessment Workspace.

Important:  Check your entitlements to determine whether you have access to Smart 
Assessments. This feature is available from the March 26 Yokohama  release onwards.

Prerequisites for creating smart assessments

To use this functionality, verify that the following plugins are installed:

• Smart Assessment Core plugin (com.sn_smart_asmt)

• Smart Assessment Designer plugin (com.sn_smart_asmt_desg)

• Smart Assessment Connected plugin (com.sn_smart_asmt_conn)

Smart assessment creation workflow

From the Assessment Workspace:

1. An assessment template is created from the Assessment Workspace, setting the following:

Field Value

Purpose This field is set to Supplier management 
surveys.

Note:  Only templates tagged with this 
purpose appear in the segmentation 
tool in the Assessment templates  tab.

Assessment targets This field is set to include the Supplier  and 
Segmentation rule assessment template 
relationship  tables.

Assessment questions are added from the Questions  tab of the new template.

For more information, see Create assessment template from Assessment Workspace.

2. Optional: Scoring  option is enabled to initiate the calculation of the assessment-level scores, 
which can be grouped by sections or questions. For more information, see Configure scoring 
for an assessment .

Note:  The smart assessment scoring plugin [com.sn_smart_scoring] must be installed 
for configuring scoring options.
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3. User criteria for reassignment are configured and enabled, restricting contacts to delegate the 
assessment to another contact from their organization. If no user criteria are configured, the 
reassign option is available to all users without restriction. For more information, see Configure 
user criteria for reassigning assessments.

4. The assessment template is published after completing the preceding configurations.

From the Source-to-Pay Workspace:

1. A segmentation rule is created from the Source-to-Pay Workspace. An assessment template 
is mapped with the new segmentation rule from the Assessment templates  tab. The new 
segmentation rule can be created for the following audience types:

◦ Manager(s)

◦ All supplier managers

◦ Only primary supplier contact(s)

◦ All supplier contacts
For more information, see Map assessment template with segmentation rule.

2. Final assessments are triggered from the Segmentation rule assessment template mapping. 
For more information, see Create assessments from assessment templates.

Users respond to the assessments

From the Source-to-Pay Workspace:

Supplier managers and owners see the assessments assigned to them under My work  > Open 
assessments  and respond to them in the workspace.

From the Supplier Collaboration Portal:

Supplier contacts see the assessments assigned to them under My active items  and respond to 
them in the portal.

Related topics

Smart Assessment Engine

Create an assessment template

Create assessment template from Assessment Workspace

You can create smart assessment templates and add instructions, questions, and reference 
information by using the template designer in the Smart Assessment Engine application.

Before you begin
Smart assessments are built using the ServiceNow®  Smart Assessment Engine (SAE) 
application. Familiarize yourself with the Smart Assessment Engine .

Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Select the Workspaces  tab and then select the Assessment workspace.

For more information on creating the smart assessment template, see Create an assessment 
template .

2. In the Purpose  field on the Smart assessment template  form, select Supplier management 
surveys.
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3. In the Assessment target  field, select the following target tables:

◦ Supplier [sn_fin_supplier] table

◦ Segmentation rule assessment template relationship 
[sn_slm_segmentation_rule_m2m_asmt_template] table

4. Select Create.

5. In the template designer, add instructions and questions.
For more information, see Add instructions and questions to an assessment template .

What to do next
Configure the user criteria to restrict the reassignment of assessments from one contact to 
another within the organization.

Configure user criteria for reassigning assessments

You can configure the user criteria for reassigning assessments to restrict reassignment within 
the organization.

Before you begin
The reassignment user criteria are configured based on the Audience type  of the assessments.

Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to Workspaces  > Assessment workspace.

2. Open the assessment template for which you have to configure the user criteria for 
reassigning assessments.

3. Open the related lists  for the assessment template by right clicking the assessment name and 
selecting Configure  > Related Lists.

4. Add User criteria  to the selected related list and Save  the form.
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5. In the User criteria  section of the assessment template, select Edit  to update the user criteria 
list.

6. Add the required roles or configurations to the User criteria based on the Audience type and 
save the template.

Audience type User criteria

Only primary supplier contact(s) Supplier: Primary Contact  (predefined)

All supplier contacts Supplier: Any Contact  (predefined)

Manager(s) Set the custom criteria for primary supplier 
managers. For more information, see Create 
custom user criteria for primary managers.

All supplier managers Set the custom criteria for all supplier 
managers. For more information, see Create 
custom user criteria for all managers.

For example: For the audience type All supplier contacts, add Supplier: Any Contact  to the 
user criteria list and save the template.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

991



7. Set the status of the user criteria to active.

8. Publish the assessment template.

What to do next
Create segmentation rule, map it to the assessment template, and create assessments from the 
Source-to-Pay workspace.

Create custom user criteria for primary managers

You can create custom user criteria for primary relationship managers for configuring the 
assessment reassignment criteria.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > User Criteria.

2. Select New.

3. On the User Criteria form, fill in the fields.

User Criteria form

Field Description

Name Unique name of the user criteria. For example, Supplier managers

Users Users that must match the user criteria.

Groups Groups that must match the user criteria.

Roles Roles to match the user criteria.

Note: 

◦ Because the evaluation of a role is cached in the session, any change 
in the role requires you to log in again.

◦ User criteria are not applicable for elevated privilege roles.
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Field Description

Advanced Option to display or hide the advanced option that includes the Script  field on 
the User Criteria form.

Script Add the script to define the list of all primary supplier managers (with role 
sn_slm.manager). This field is available when the Advanced  option is selected 
on the User Criteria form.

<?xml version="1.0" encoding="UTF-8"?>
<unload unload_date="2026-02-24 08:42:21">
<user_criteria action="INSERT_OR_UPDATE">
<active>true</active>
<advanced>true</advanced>
<company/>
<department/>
<group/>
<location/>
<match_all>false</match_all>
<name>Supplier managers</name>
<role 
 name="sn_slm.manager">da72c74043942110bb9e89e90db8
f2ef</role>
<script><![CDATA[(function isAllowed() {
    var stakeHolderGr = new 
 GlideRecord('sn_slm_supplier_m2m_internal_stakehol
ders');
 stakeHolderGr.addQuery("user",user_id);
   
 stakeHolderGr.addQuery("relationship_type","relati
onship_type_1");
 stakeHolderGr.query();
 return stakeHolderGr.next()
 
})();]]></script>
<short_description/>
<sys_class_name>user_criteria</sys_class_name>
<sys_created_by>maint</sys_created_by>
<sys_created_on>2026-02-24 
 08:38:06</sys_created_on>
<sys_domain>global</sys_domain>
<sys_domain_path>/</sys_domain_path>
<sys_id>902bb3bc50977250f8776d5de5c06973</sys_id>
<sys_mod_count>6</sys_mod_count>
<sys_name>Supplier managers</sys_name>
<sys_package display_value="Global" 
 source="global">global</sys_package>
<sys_policy/>
<sys_scope 
 display_value="Global">global</sys_scope>
<sys_update_name>user_criteria_902bb3bc50977250f877
6d5de5c06973</sys_update_name>
<sys_updated_by>maint</sys_updated_by>
<sys_updated_on>2026-02-24 
 08:42:16</sys_updated_on>
<user/>
</user_criteria>
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Field Description

</unload>

Active Option to activate or deactivate the user criteria.

Companies Companies that the user record must match.

Locations Locations that the user record must match.

Departments Departments that the user record must match.

Match All Option to determine whether all elements from each populated user criteria 
field must match. If selected, only users who match all user criteria are given 
access. If cleared, the user must meet one or more of the set user criteria to be 
given access.

By default, this check box is cleared so that any condition met provides a 
match.

For example, consider a user criteria record for the following:

◦ Locations A or B

◦ Company C or D
With Match All  selected, only users that meet all of these conditions are 
matched. For example, a user with a location A and a company C.

If Match All  isn’t selected, users meeting any of these conditions are 
matched. For example, a user with a location B.

Note:  If you select Match All, verify that you don't create contradictory 
conditions that can never be met. For example, if all users in location A 
work for company G, the conditions in this example can never be met.

4. Select Submit.

Create custom user criteria for all managers

You can create custom user criteria for all managers for configuring the assessment 
reassignment criteria.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Knowledge  > Administration  > User Criteria.

2. Select New.

3. On the User Criteria form, fill in the fields.

User Criteria form

Field Description

Name Unique name of the user criteria. For example, All supplier managers

Users Users that must match the user criteria.

Groups Groups that must match the user criteria.

Roles Roles to match the user criteria.
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Field Description

Note: 

◦ Because the evaluation of a role is cached in the session, any change 
in the role requires you to log in again.

◦ User criteria are not applicable for elevated privilege roles.

Advanced Option to display or hide the advanced option that includes the Script  field on 
the User Criteria form.

Script Add the script to define the list of all supplier managers. This field is available 
when the Advanced  option is selected on the User Criteria form.

<?xml version="1.0" encoding="UTF-8"?>
<unload unload_date="2026-02-24 08:43:14">
<user_criteria action="INSERT_OR_UPDATE">
<active>true</active>
<advanced>false</advanced>
<company/>
<department/>
<group/>
<location/>
<match_all>false</match_all>
<name>All supplier managers</name>
<role 
 name="sn_slm.manager">da72c74043942110bb9e89e90db8
f2ef</role>
<script><![CDATA[/** Scripted User Criteria is not 
 cached, and evaluated everytime, so performance is 
 dependent on the script.
* Populate `answer` with true/false or evaluate to 
 true/false
* The script is evaluated in the scope the user 
 criteria is defined
* Don't use `current` in the script or populate the 
 variable
* Don't use `gs.getUser()` or  `gs.getUserID()`,
* instead use `user_id` which contains the user 
 sys_id against whom the evaluation is happening.
*/]]></script>
<short_description/>
<sys_class_name>user_criteria</sys_class_name>
<sys_created_by>maint</sys_created_by>
<sys_created_on>2026-02-24 
 08:43:10</sys_created_on>
<sys_domain>global</sys_domain>
<sys_domain_path>/</sys_domain_path>
<sys_id>0b4cfbbc50977250f8776d5de5c0693f</sys_id>
<sys_mod_count>0</sys_mod_count>
<sys_name>All supplier managers</sys_name>
<sys_package display_value="Global" 
 source="global">global</sys_package>
<sys_policy/>
<sys_scope 
 display_value="Global">global</sys_scope>
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Field Description

<sys_update_name>user_criteria_0b4cfbbc50977250f877
6d5de5c0693f</sys_update_name>
<sys_updated_by>maint</sys_updated_by>
<sys_updated_on>2026-02-24 
 08:43:10</sys_updated_on>
<user/>
</user_criteria>
</unload>

Active Option to activate or deactivate the user criteria.

Companies Companies that the user record must match.

Locations Locations that the user record must match.

Departments Departments that the user record must match.

Match All Option to determine whether all elements from each populated user criteria 
field must match. If selected, only users who match all user criteria are given 
access. If cleared, the user must meet one or more of the set user criteria to be 
given access.

By default, this check box is cleared so that any condition met provides a 
match.

For example, consider a user criteria record for the following:

◦ Locations A or B

◦ Company C or D
With Match All  selected, only users that meet all of these conditions are 
matched. For example, a user with a location A and a company C.

If Match All  isn’t selected, users meeting any of these conditions are 
matched. For example, a user with a location B.

Note:  If you select Match All, verify that you don't create contradictory 
conditions that can never be met. For example, if all users in location A 
work for company G, the conditions in this example can never be met.

4. Select Submit.

Map assessment template with segmentation rule

You can map assessment templates with segmentation rules in the Source-to-Pay workspace. A 
rule defines which suppliers receive assessments based on the configured criteria.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Create a segmentation rule.
For more information, see Create segmentation rule.

3. Select Assessment templates  and New  to map an assessment template with this 
segmentation rule.
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4. Fill in the details in the new segmentation rule assessment template form.

Field Description

Assessment template Assessment template used for mapping with 
the segmentation rule.

Audience type Type of recipients of the assessment.

Segmentation rule Segmentation rule for which assessment is 
getting created (auto-filled).

Due date Date of expiry of the assessment.

5. Select Save.

What to do next
Trigger assessments from the segmentation rule assessment mapping templates.

Create assessments from assessment templates

After mapping the assessment templates with segmentation rules, supplier managers manually 
trigger batch creation of assessments.

Before you begin
Role required: sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Open the segmentation rule for which assessment templates have been created.

3. In the Assessment templates  tab, select the assessment template mapping record for which 
assessments have to be triggered.
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4. Select Create assessments  to trigger assessments to the users.

Result
The assessment is created and runs in the background. The status of the assessment changes 
as it progresses.

State When it occurs

New When the Assessment Template Relationship 
record is created.

In Progress When Create Assessment  is clicked, all UI 
validations are completed, the selected record 
is validated as eligible, and the assessment 
instance creation process begins.

Complete When the assessment creation process is 
successfully completed for all valid assignees.

Cancelled When cancelled using the Cancel  related list 
action. The Assessment Template Relationship 
record and all related assessment instances 
move to the Cancelled state.

Error When an error occurs during assessment 
creation, or when assessment instance 
creation fails for one or more assignees. The 
Assessment Template Relationship record 
moves to the Error state.

Integrating Supplier Lifecycle Operations  with other applications
Extend the capabilities of Supplier Lifecycle Operations  by integrating with other applications.

Related topics

Supplier Lifecycle Operations integration framework

Craft.co Integration for Supplier Lifecycle Operations
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News Integration for Supplier Lifecycle Operations

Relish Integration for Supplier Lifecycle Operations

Supplier Lifecycle Operations  integration framework

The Supplier Lifecycle Operations  (SLO) integration framework enables you to exchange supplier 
data with any third-party ERP system.

The SLO integration framework facilitates inbound and outbound integration with third-party 
applications and ERP systems.

SLO integration framework flow

For inbound flow:

Import supplier data from a third-party ERP system by populating the SLO inbound staging 
tables, and then run transform maps to update the supplier data into SLO primary tables.

For outbound flow:

• As soon as the SLO primary tables are updated, the SLO outbound tables are automatically 
updated using subflows.

• An ERP integrator can refer to the outbound tables and export the required data into any third-
party ERP system.

SLO inbound staging tables

The following table lists the SLO inbound staging tables and the application they belong to.

Application SLO inbound table

ERP Integration Framework​
 (com.sn_fcms_integrations)

sn_fcms_intg_imp_supplier​

sn_fcms_intg_supplier_location_inbound

sn_fcms_intg_supplier_contact_inbound​

sn_fcms_intg_supplier_payment_inbound_stage

sn_fcms_intg_supplier_legal_entity_inbound

SLO outbound staging tables

The following table lists the SLO outbound staging tables and the application they belong to.

Application SLO outbound table

Source-to-Pay Integration Framework​
 (com.sn_spend_intg)

sn_spend_intg_outbound_supplier​

sn_spend_intg_supplier_location_outbound​

sn_spend_intg_supplier_contact_outbound​

sn_spend_intg_supplier_payment_outbound_stage​
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The same set of fields exist in both the SLO inbound and SLO outbound staging tables. For more 
information about the mandatory fields in the staging tables and their descriptions, see Inbound 
staging tables for Supplier Lifecycle Operations.

Add supplier inbound data in an Excel file

You can import supplier inbound table data in an Excel file.

Before you begin
Role required: admin

Procedure

1. Select All.

2. In the navigation filter, do one of the following:

◦ To see the list of columns in the supplier location inbound table, enter 
sn_fcms_intg_supplier_location_inbound_list.do.

◦ To see the list of columns in the supplier contact inbound table, enter 
sn_fcms_intg_supplier_contact_inbound_list.do.

◦ To see the list of columns in the supplier payment inbound table, enter 
sn_fcms_intg_supplier_payment_inbound_stage_list.do.

◦ To see the list of columns in the supplier payment inbound table, enter 
sn_fcms_intg_supplier_legal_entity_list.do.

3. Right-click any column heading and select Export  > .xlsx.

4. Select Download  to save the spreadsheet on your local system.

Result
Depending on the supplier inbound table you selected, an Excel template is created with the 
mandatory columns for supplier location, supplier contacts, or supplier payment information. Use 
this Excel spreadsheet to enter the supplier data that you want to import and store into the SLO 
inbound staging tables.

What to do next
Load the supplier data from the excel template into the supplier inbound staging tables. For more 
information, see Load supplier data.

Load supplier data

Load the supplier data from the excel template into the supplier inbound staging tables.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Load Data.
The Load Data page appears.

2. In Import set table, select Existing table.

3. From the Import set table  list, select one of the following inbound tables depending on the 
type of supplier data you want to import:

◦ Supplier location inbound [sn_fcms_intg_supplier_location_inbound]

◦ Supplier contact inbound [sn_fcms_intg_supplier_contact_inbound]

◦ Supplier payment inbound [sn_fcms_intg_supplier_payment_inbound_stage]
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4. In Source of the Import, choose File.

5. Browse to the excel template that was created in Add supplier inbound data in an Excel file.

6. Enter the Sheet number  of the excel template that needs to be loaded into the staging table.

7. Enter the Header row  of the excel template that needs to be loaded into the staging table.

8. Click Submit.

Result
The supplier data from the Excel file is processed successfully. That is, the relevant supplier data 
is extracted from the Excel file and stored in the SLO inbound staging tables.

What to do next
Run the transform map to import supplier data from the SLO inbound staging tables into the SLO 
primary tables.

Run transform to update supplier primary data

Use transform map and run transform to map the supplier fields from the import set into primary 
data target tables in Supplier Lifecycle Operations.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Load Data  > Run Transform.
The Specify Import set and Transform map  screen appears.

In the Import set, the staging table you selected from Load supplier data  is auto populated.

In Selected maps, run in order  area, the target supplier table to be mapped in Supplier 
Lifecycle Operations  is auto-populated and selected by default.

2. Select Transform.

Result
The relevant supplier fields from the import set staging table are mapped to the SLO primary 
table.

For example, if you uploaded an Excel file with supplier location information, the relevant fields 
are updated from the Supplier location inbound [sn_fcms_intg_supplier_location_inbound] 
staging table into the Supplier Location [sn_slm_m2m_location] primary table. As soon as 
the Supplier Location [sn_slm_m2m_location] primary table is updated, the Supplier location 
outbound [sn_spend_intg_supplier_location_outbound] table is also updated. An ERP integrator 
can extract this information from the outbound table and export it into the ERP system.

Monitor the integration status of the SLO inbound data import

Monitor the status of the integration after a transform runs and completes successfully.

Before you begin
Role required: admin
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Procedure

1. After you run a transform and it completes successfully, do one of the following under the Next 
steps section:

◦ Import set number: Select the import set number link to view the import sets for this data 
load.

Transform History: Select this option to view the transform history, related errors, and log.

◦ Import log: Select this option to view the import log.

2. Select All.

3. In the navigation filter, enter the name of the SLO inbound table for which you want to check 
the integration status.
For example, to check the integration status of the Supplier location inbound table, enter 
sn_fcms_intg_supplier_location_inbound_list.do.

The Supplier location inbounds page appears.

4. Verify the following:

◦ If the primary tables were successfully updated, the Integration status column displays New 
for the import set.

◦ If the update to the primary tables was unsuccessful, the following occurs:

▪ The Integration status column displays Failed  for the import set.

▪ The Processing message column displays the issue that occurred during the 
transformation. You must fix the error and run the transform again. For example, if any of 
the mandatory fields are missing, the integration fails and displays the missing data to aid 
you in fixing the error.

Craft.co Integration for Supplier Lifecycle Operations

The Craft.co Integration for Supplier Lifecycle Operations  plugin (com.snc.sn_supplier_craft) 
provides an integration between Craft  and Supplier Case Management plugin.
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Important:  Check your entitlements to determine whether you have access to Craft.co 
Integration for Supplier Lifecycle Operations.

Craft  is a third-party supplier intelligence platform that offers most up-to-date, validated, and 
comprehensive information about any supplier you are working with.

Ensure that you have configured the sn_supplier_craft.craft.api.key  system 
property, which enables you to import supplier information automatically from Craft. For more 
information, see Configure properties for Supplier Lifecycle Operations.

The integration with Craft  provides the following advantages:

• Import suppliers automatically without manually entering supplier details.

• Synchronize supplier information stored in your system with that in Craft, thus ensuring that 
you always view the most up-to-date supplier data.

Related topics

Synchronize supplier data using external third-party application

Synchronize supplier data using external third-party application

Synchronize supplier data with any external third-party application to ensure that you are working 
with the latest data in the Source-to-Pay Workspace.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can synchronize data only for the suppliers they own.

About this task
Because the supplier data may have changed from the time that you last imported it, ensure 
that you are working with the latest supplier data by synchronizing with an external third-party 
application.

Note:  Supplier Lifecycle Operations  provides you with the flexibility to integrate with Craft 
to import and view the most up-to-date supplier data. For more information, see Craft.co 
Integration for Supplier Lifecycle Operations.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under My suppliers, select the legal name of the supplier you want to synchronize with 
external data.
The supplier Details page opens.

3. Do one of the following.

To Do this

Synchronize with external thid-party appli­
cation for the first time

Do the following:

a. Select Connect to external data.

b. In the Connect to external data dialog box, 
select Import.
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To Do this

The latest supplier data is imported and 
any changes that you made to the existing 
supplier data and the supplier locations are 
overwritten.

Synchronize with external third-party ap­
plication subsequently after initial synchro­
nization

Do the following:

a. Select Sync with external data.

b. In the Sync with external data? dialog box, 
select Sync.

The latest supplier data is imported and 
any changes that you made to the existing 
supplier data and the supplier locations are 
overwritten.

News Integration for Supplier Lifecycle Operations

The News Integration for Supplier Lifecycle Operations  plugin (com.snc.sn_supplier_news) 
retrieves supplier news and activities using the Microsoft  Bing News Search API and displays 
this information in the Supplier News and Activity section on the About  tab of the Source-to-Pay 
Workspace.

The News Integration for Supplier Lifecycle Operations  plugin is installed along with the Supplier 
Lifecycle Operations  application.

The Microsoft  Bing News Search API uses the default Supplier News REST message to fetch 
supplier news, so ensure that you have configured the Supplier News REST message. For more 
information, see Configure the Supplier News REST message.

Configure the Supplier News REST message

Configure the Supplier News REST message using the Microsoft  Bing News Search API 
subscription key.

Before you begin
Role required: admin

Get the Bing News Search API subscription key.

Procedure

1. Navigate to All  > System Web Services  > Outbound  > REST Message.

2. From the REST Messages list, select Supplier News.

3. In the HTTP Request related list, select Get Supplier News.

4. In the HTTP Request related list, under HTTP Headers, double-click the Value  column and 
enter the Bing News Search API subscription key.

5. Select the green check mark icon ( ) to save your changes.

6. Select Update.

Configuring a custom API to dynamically fetch supplier news

By default, News Integration for Supplier Lifecycle Operations  retrieves the supplier news and 
activities using the Microsoft  Bing News Search API.
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However, you have the flexibility to use any API of your choice to dynamically retrieve the 
supplier news and activities.

The process for configuring a custom news API includes the following tasks:

1. Create a REST message for a custom API.

2. Add and configure the Get News data resource in UI Builder.

3. Update the field names in the UX client script.

Related topics

Create a REST message for a custom API

Add and configure the Get News data resource in UI Builder

Update the field names in the UX client script

Create a REST message for a custom API

Create a REST message request and send it to a custom API endpoint to fetch the latest supplier 
news.

Before you begin

• Install the News Integration for Supplier Lifecycle Operations  plugin 
(com.snc.sn_supplier_news).

• Set the application scope to News Integration for Supplier Lifecycle Operations  using the 
application picker.

Role required: admin

Procedure

1. Navigate to All  > System Web Services  > Outbound  > REST Message.

2. Select New.

3. On the form, fill in the fields.

REST Message form

Field Description

Name Name for this message.

Endpoint Endpoint that this REST message is sent to.

Authentication 
type

Authentication to use, if any, and the profile record that contains the user 
credentials.

4. Right-click the form header and select Save.
After creating the REST message, a GET HTTP method is created automatically using the 
values from the REST message record.

5. In the HTTP Methods related list, select Default GET.

6. In the Name  field, specify a name for the GET HTTP method.

7. Select the HTTP Request  tab.

8. In the HTTP Headers embedded list, select Insert a new row.

9. In the Name  field, enter the name of the header.
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Supported headers depend on the REST web service provider that you want to connect to.

10. Double-click the Value  field for the new row and enter the value that you want to assign to this 
header.
You can use a variable in the format ${variable} instead of a static value. You can assign a value 
to the variable when sending a REST request.

11. In the HTTP Query Parameters embedded list, select Insert a new row.

12. In the Name  field, enter the name of the query parameter.

13. Double-click the Value  field for the new row and enter the value that you want to assign to this 
query parameter.
You can use a variable in the format ${variable} instead of a static value. You can assign a value 
to the variable when sending a REST request.

14. Select Update.

What to do next
Add and configure the Get News data resource in UI Builder.

Add and configure the Get News data resource in UI Builder

Add and configure the Get News - Composite data resource in UI Builder to dynamically retrieve 
supplier news in the News and Activity section of the Source-to-Pay Workspace.

Before you begin
Create a REST message for a custom API. For more information, see Create a REST message for 
a custom API.

Role required: admin

About this task
A data resource is the data that a page fetches to display the content in the components. For 
more information, see Data resources in UI Builder  .

Procedure

1. Navigate to All  > Now Experience Framework  > UI Builder.

2. On the Page Collections  tab, do one of the following:

◦ For Supplier Manager Workspace, select SLM Record page tabs.

◦ For Source-to-Pay Workspace, select S2P SLM Record page tabs.

3. In the About section, select About default.

4. From the lower-left pane, select the +  icon next to the Data and scripts section.

5. In the Select data or script to add panel, select Data resource.

6. In the Select a data resource dialog box, in the search field, enter Get News – Composite.

In the Select a data resource section, you can add and configure data resource instances for 
your page. If you have any inherited data resources, you see them listed in the Inherited data 
resource pane but they are read-only. You do not configure inherited data in UI Builder.

7. Select the Get News – Composite  tile and then select Add  to add it to your page.

8. Select the Configure  tab and then do the following:

a. In the When to evaluate this data resource  list, select when you want to evoke the data 
resource.

b. In the News Api  list, select the name of the REST message record.
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c. In the News Api Method  list, select the name of the GET HTTP request method.

d. In the Query Params  field, select Edit.

The Query Params dialog box is displayed.

e. On the Edit JSON  tab, enter the query parameters, and then select Apply.

f. In the Response Base Path  field, enter the top-level object to retrieve information from.

You can also specify nested objects.

g. In the Response Field List  field, select Edit.

The Response Field List dialog box is displayed.

h. On the Edit JSON  tab, enter the fields that you want to display in the response, and then 
select Apply.

Note:  Specifying specific fields enables you to retrieve filtered responses for REST 
endpoints. The response includes only the requested fields and objects.

9. Select Save.

Update the field names in the UX client script

Update the field names in the UX client script to match the custom field names in the custom API 
response.

Before you begin
Role required: admin

Procedure

1. In the navigation filter, enter sys_ux_client_script.list.

2. In the UX Client Scripts form, in the Name  search field, search for the Set 'news' activity state.

3. Select the Set 'news activity' section state  client script.

4. Edit the Script  field to update the field names so that they match the field names in the custom 
API response.

For example, in your custom API response, if the name  field entry is title, and the description 
field entry is summary, then you must update the field names accordingly in the script.
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5. Select Update.

Relish Integration for Supplier Lifecycle Operations

The SLO Connector for Relish Data Assure plugin (x_reliq_slo_connec) provides an integration 
between Relish and Supplier Case Management plugin.

Important:  Check your entitlements to determine whether you have access to Relish 
Integration for Supplier Lifecycle Operations.

Relish is a third-party supplier intelligence platform that helps in validating supplier data while 
working on supplier cases (for banking information change requests, supplier location change 
requests, and conducting sanction screening). For more information, see Review supplier 
information using Relish.

To install SLO Connector for Relish Data Assure, the following plugins have to be installed:

• Required plugins:

◦ SLO Connector for Relish Data Assure plugin (x_reliq_slo_connec)

◦ Relish Data Assure (x_reliq_relish_dat)

• Dependent plugin: Source-to-Pay integration framework (sn_spend_intg)

After SLO Connector for Relish Data Assure is installed, Relish shares the client ID and password. 
A basic authentication profile must be created using the client ID and password. For more 
information, see Set up authentication profile using Relish credentials.

Related topics

Set up authentication profile using Relish credentials

Set up authentication profile using Relish credentials

Create a basic authentication profile that can be used for web service integration with Relish. 
Register the Relish user name and password to create the authentication profile.

Before you begin
Role required: admin
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Procedure

1. Navigate to Connections & Credentials  > Connection & Credential Aliases.

2. Click New.

3. Enter a unique name for the alias and set the Type  value to Credential.

4. Click Submit.
A new credential alias with a unique ID is created.

5. In the Credentials related list, click New  and then select Basic Auth Credentials.

6. On the form, fill in the fields.

Basic Auth Configuration form

Field Description

Name Name of the authentication configuration.

Username User name as provided by Relish.

Password Password as provided by Relish. This 
username and password is used to 
authenticate the HTTP request when this 
basic authentication profile is enabled.

Credential alias Credential alias created for the Relish 
configuration. This alias is auto-populated 
when you create an authentication profile 
from a credential alias.

7. Click Submit.

Related topics

Relish Integration for Supplier Lifecycle Operations

Using Supplier Lifecycle Operations
Supplier managers and supplier contacts can use Supplier Lifecycle Operations  to accelerate 
supplier onboarding, minimize supplier risk, and maximize productivity.

Related topics

Using Source-to-Pay Workspace

Using Supplier Collaboration Portal

Using Supplier Relationship and Performance Management

Using Supplier Payment Optimization

Using Source-to-Pay Workspace

As a supplier manager, use the Source-to-Pay Workspace  to import or create suppliers, add key 
contacts, add supplier locations, and manage the supplier cases assigned to you.

Important:  Starting with the Washington D.C. release, Supplier Manager Workspace  is 
being prepared for future deprecation. It will be hidden from the navigation and no longer 
be activated on new instances. Source-to-Pay Workspace  provides the latest experience 
for this functionality.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1009



Create a supplier from the Source-to-Pay Workspace

Create a supplier to quickly onboard the supplier using playbooks and start purchasing goods 
and services.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Create new supplier.

3. On the form, fill in the fields.

Request new supplier form

Field Description

Supplier Name Name of the supplier.

This supplier is owned 
by another company

Indicates if the new supplier is a subsidiary company.

Note:  This check box is added after Xanadu  December 2024 
release.

Parent company name Name of the parent company. This field comes up if the This 
supplier is owned by another company  check box is selected.

Note:  This field is added after Xanadu  December 2024 
release.

This supplier owns 
other companies

Indicates if the new supplier is a parent company.

Note:  This check box is added after Xanadu  December 2024 
release.

Subsidiary list List of the subsidiary companies. This field comes up if the This 
supplier owns other companies  check box is selected.

Note:  This field is added after Xanadu  December 2024 
release.

Supplier DUNS Unique numeric identifier for every supplier.

Contact first name First name of the supplier contact.

Contact last name Last name of the supplier contact.

Contact email Email of the supplier contact.

Contact title Title of the supplier contact.

Priority Priority of the supplier. The available options are:

◦ Critical

◦ High

◦ Moderate
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Field Description

◦ Low

◦ Planning

4. Select Create.

5. On the Request new supplier window, select View onboarding request.
The application creates a case of type Onboard a Supplier and its state moves to Work in 
progress.

The supplier manager can continue to onboard the supplier using the Playbook  tab on 
the Case Details page. For more information, see Use the supplier onboarding playbook to 
onboard suppliers.

Use the supplier onboarding playbook to onboard suppliers

Supplier owners and supplier managers can use the supplier onboarding playbook to complete 
the tasks and activities that are needed to onboard new suppliers.

Playbooks overview

Playbooks provide step-by-step guidance for onboarding suppliers. A playbook visualizes a 
workflow in a simple, task-oriented view. The workflow for a playbook is typically created using 
Process Automation Designer .

A playbook takes a workflow and breaks it into multiple stages. Each stage in a playbook includes 
one or more activities or steps for a supplier owner or supplier manager to complete. Stages can 
also include automated activities, such as sending an email to a supplier contact when a stage or 
activity is complete. For more information, see Interact with Playbook .

When using a playbook, a supplier owner or supplier manager can:

• View the playbook stages and activities.

• View status indicators that display the current state of each activity or step.

• View check boxes that indicate the stage you are currently at in the workflow.

• Select an activity and perform the work necessary to complete that activity.

• Mark an activity as complete and move to the next activity or stage.

• Complete the stages and activities necessary to complete the case.

Supplier onboarding playbook

You can use the Supplier onboarding playbook to onboard a new supplier. The Supplier 
onboarding playbook provides the activities and tasks that a supplier owner or supplier manager 
can perform during the onboarding process.

You can use the Supplier onboarding playbook with cases that are created using the Onboard a 
Supplier case type.

The Supplier onboarding playbook appears in the Playbook  tab on the Case Details page in the 
Source-to-Pay Workspace.

After you submit a supplier onboarding request, the application creates a new case of type 
Onboard a Supplier and opens the Case Details page. You can select the Playbook  tab and start 
the supplier onboarding process using playbook. For more information on creating a supplier, 
see Add a supplier.
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Important:  Supplier Lifecycle Operations  creates an approval record if the "Ask For 
Approval" action is a part of any SLO flow. This approval record can be approved by the 
user who belongs to the Supplier Administrators group (sys_user_group table). For more 
information, see Add a user to a group .

Playbook tab on the Case Details page

The Supplier onboarding playbook includes the following stages:

• Registration: Includes activities to register the supplier.

• Qualification: Includes activities to verify the eligibility of the supplier.

• Activation: Includes activities to activate the supplier.

• Rejection: Includes activities to reject the supplier.

Related topics

Add a subsidiary for a supplier from the Source-to-Pay Workspace

Perform risk assessment playbook

Registration stage

The following table lists the activities in the Registration stage of the Supplier onboarding 
playbook.

Activity Activity Details

Collecting onboarding details Processes the supplier details collected in the onboarding 
request form.

This activity completes automatically.

Process onboarding variables Uses the information provided to start the onboarding activities.

This activity completes automatically.

Update the supplier case 
record

Sets the supplier case record to Work in progress.

This activity completes automatically.
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Activity Activity Details

Show possible duplicate 
suppliers

Displays duplicate supplier records to ensure you are not 
onboarding an existing supplier.

If there are no duplicate supplier records, this activity auto-
completes.

If duplicate supplier records exist, then select Open List  to see 
the duplicate record and resolve the issue.

Show possible duplicate 
onboarding requests

Displays duplicate supplier onboarding request cases to 
ensure you are not duplicating an existing case.

If there are no duplicate supplier onboarding request cases, 
this activity auto-completes.

If duplicate supplier cases exist, then select Open List  to see 
the duplicate cases and resolve the issue.

Check for supplier 
intelligence source

Checks if a supplier intelligence platform is installed to import 
supplier data.

Import supplier details from 
intelligent/external source

Imports supplier details from the supplier intelligence platform.

Available actions:

• Import data

• Skip

Create new company record Creates a new record for the supplier in the Company 
[core_company] table.

This activity completes automatically.

Create new supplier record Creates a new supplier record in the Supplier [sn_fin_supplier] 
table.

This activity completes automatically.

Associate the onboarding 
case with the newly created 
supplier.

Associates the onboarding case with the supplier. The Supplier 
field shows the newly created supplier on the Details  tab of the 
case.

This activity completes automatically.

Sync supplier profile with the 
third party source

Synchronizes the supplier and company records with data from 
a third-party supplier intelligence.

This activity completes automatically.

Invite supplier contact Sends an email to the primary contact to register to the Supplier 
Collaboration Portal.

Verify that the supplier 
information is correct

Ensure that the supplier information is accurate and up to date.

Available actions:
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Activity Activity Details

• Mark complete

• Skip

• Update

Waiting for supplier contact 
invitation to be sent out

Waits for the primary contact to be given access to the Supplier 
Collaboration Portal.

Set the case status to On 
Hold.

Sets the case status to On Hold.

After this activity is completed, the playbook moves to the 
Qualification stage.

Qualification stage

The following table lists the activities in the Qualification stage of the Supplier onboarding 
playbook.

Activity Activity Details

Check 
if Risk 
assessment 
for supplier 
plugin is 
installed

Checks whether the risk assessment for supplier plugin is installed.

Risk 
assessment 
decision

Lets you choose whether you need to perform risk assessment for the supplier 
being onboarded.

Available actions:

• Continue without assessment

• Perform risk assessment

Perform risk 
assessment

The playbook starts the risk assessment process.

Waiting 
for risk 
assessment 
to be 
completed

The playbook waits for the risk assessment to be completed. A new due diligence 
case is created. You can see this case on the Related Cases  tab of the Onboard 
a supplier case. Select the link for the due diligence case, which opens the 
Perform risk assessment playbook.

One of the following occurs:

• If you have installed only the Risk Assessments Integration for Supplier 
Lifecycle Operations [com.snc.sn_supplier_tprm] plugin, the Perform risk 
assessment playbook triggers the flow that includes activities to verify the 
eligibility of the supplier by creating risk assessments. For more information, 
see Playbook stages and activities when only Vendor Risk Management is 
installed.

• If you have installed both the Risk Assessments Integration for Supplier 
Lifecycle Operations [com.snc.sn_supplier_tprm] and GRC: Third-party Risk 
Due Diligence [com.sn_tprm_onboarding] plugins, the Perform risk assessment 
playbook triggers the flow that includes activities to create a due diligence 
request, complete Inherent Risk Questionnaire (IRQ) assessments, and 
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Activity Activity Details

conduct risk assessments for a third-party and an engagement. For more 
information, see Playbook stages and activities when Third-party Risk Due 
Diligence is installed.

Update the 
supplier 
case record

Updates the state of the case to Work in progress.

Confirm 
supplier 
is not 
restricted

Verify that this supplier is not on any corporate or governmental restricted list. If 
they are, you must reject this case.

Available actions:

• Confirm not restricted

• Reject

If you select Reject, the playbook opens the Rejection stage.

Confirm 
qualification 
status

Confirm if you would like to continue onboarding or reject the supplier.

Available actions:

• Continue Onboarding

• Reject

If you select Reject, the playbook opens the Rejection stage.

After this activity is completed, the playbook moves to the Activation stage.

Activation stage

The following table lists the activities in the Activation stage of the Supplier onboarding 
playbook.

Activities in the Supplier onboarding playbook

Activity Activity Details

Create a task to collect 
banking details

Creates and assigns a task to the primary supplier contact to update 
the supplier banking details.

Create a task to review 
the supplier profile 
details

Creates and assigns a task to the primary supplier contact to review 
the supplier profile details.

Waiting for supplier 
to complete banking 
details

This activity is completed after the primary supplier contact 
completes the Update banking details task from the Supplier 
Collaboration Portal.

Waiting for supplier to 
validate their profile 
details

This activity is completed after the primary supplier contact validates 
the Update supplier profile task from the Supplier Collaboration 
Portal.

Confirm supplier 
activation

Confirm if you would like to continue onboarding or reject the 
supplier.

Available actions:
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Activities in the Supplier onboarding playbook  (continued)

Activity Activity Details

• Continue Onboarding

• Reject

If you select Reject, the playbook opens the Rejection stage.

Activate supplier record Sets the supplier record to onboarded=true.

Update supplier 
company status

Sets the status for the company record to active.

Send welcome email to 
supplier

Sends an email to the supplier with a welcome message.

Notify requestor of 
onboard completion

Sends an email to the requestor, informing them about the supplier 
onboarding completion status.

Set onboarding case to 
complete.

Updates the onboarding case to Closed completed.

Related topics

Registration stage

Qualification stage

Rejection stage

Rejection stage

The following table lists the activities in the Rejection stage of the Supplier onboarding playbook.

Activity Activity Details

Provide reason for 
rejection

Provide a reason for rejecting the supplier onboarding request.

In the Close notes  field, enter the reason for rejection and select 
Reject Supplier.

Available actions:

• Reject Supplier

• Skip

Send rejection email to 
supplier

Sends an email to the supplier informing them that their 
onboarding request has been rejected.

Notify requestor of 
onboard rejection

Sends an email to the requestor, informing them about the supplier 
onboarding rejection.

Set onboarding case to 
rejected

Updates the onboarding case to Closed rejected.

Perform risk assessment playbook

The Perform risk assessment playbook includes activities that enable you to conduct risk 
assessments for the supplier that you are onboarding.

The type of flow that is triggered in the Perform risk assessment playbook depends on the 
plugins that you have installed.
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Perform risk assessment playbook

Plugins for risk assessment

Plugins Installed Playbook flow

Risk Assessments Integration 
for Supplier Lifecycle 
Operations

[com.snc.sn_supplier_tprm]

The Perform risk assessment playbook flow creates risk and 
tiering assessments to verify the eligibility of the supplier. For 
more information, see Risk assessment flow when only Vendor 
Risk Management is installed.

• Risk Assessments 
Integration for Supplier 
Lifecycle Operations

[com.snc.sn_supplier_tprm]

• GRC: Third-party Risk Due 
Diligence

[com.sn_tprm_onboarding]

The Perform risk assessment playbook flow create a due 
diligence request to verify the eligibility of the supplier. For 
more information, see Risk assessment flow when Third-party 
Risk Due Diligence is installed.

Related topics

Use the supplier onboarding playbook to onboard suppliers

Add a subsidiary for a supplier from the Source-to-Pay Workspace

Risk assessment flow when only Vendor Risk Management  is installed

If you have installed only the Risk Assessments Integration for Supplier Lifecycle Operations 
[com.snc.sn_supplier_tprm] plugin, the Perform risk assessment playbook triggers the flow that 
includes activities to verify the eligibility of the supplier by creating risk assessments.

The Risk Assessments Integration for Supplier Lifecycle Operations [com.snc.sn_supplier_tprm] 
plugin automatically installs the Vendor Risk Management  [sn_vdr_risk_asmt] plugin.
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Risk assessment flow when only VRM is installed

In this flow, the following occurs:

1. The supplier manager receives a supplier onboarding request.

2. The supplier manager uses the onboarding playbook, which provides a streamlined and 
guided process to onboard suppliers. For more information, see Use the supplier onboarding 
playbook to onboard suppliers.

3. During the onboarding process, the playbook automatically creates the risk and tiering 
assessments. The assessment records are listed in the Risk Assessments  and Tiering 
Assessments  tabs.

4. The supplier manager assigns the risk and tiering assessments to the third-party risk assessor.

5. The TPR assessor assigns the assessments to the supplier contact.

6. The supplier contact logs in to the Supplier Collaboration Portal  and completes the risk and 
tiering assessments. For more information, see Complete a risk assessment from the Supplier 
Collaboration Portal.

7. After the risk assessment has been completed, the supplier manager evaluates the risk 
information in combination with any other data and determines whether to continue or cancel 
the onboarding process.

After the assessments are completed, you can continue with completing the activities in the 
Activation stage.

Playbook stages and activities when only Vendor Risk Management  is installed

The following table lists the Perform risk assessment playbook stages and activities when only 
Vendor Risk Management  (VRM) is installed.
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Perform risk assessment playbook stages and activities

Stage Activity Activity Details

Assign case As a supplier manager or fulfiller, you can use this activity to 
assign the case to a different person or keep the case assigned 
to you.

You can do the following:

• In the Assigned to  search field, search for and select the 
person that you want to assign the case to.

• In the Short description  field, update the description for the 
case.

• Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Review 
case

Update case to 
work in progress Updates the state of the due diligence case to work in progress.

Waiting on the risk 
assessment to be 
completed

Waits for the risk assessment questionnaires to be completed by 
the supplier contact.

Select View Record  to see the risk assessment record.

Assess 
tiering 
and 
risk

Mark risk 
assessment as 
completed

Select Mark Complete  to mark this activity as completed 
after the supplier contact completes the risk assessment 
questionnaires from the Supplier Collaboration Portal.

Notify the 
requestor the 
request has been 
approved

Sends an email to the requestor informing them that the due 
diligence request has been approved.

A draft email appears with pre-populated data in the To  and 
Subject  fields. The email body is pre-populated with the relevant 
text.

Available actions:

• Send email

• Skip

Close 
case

Close case Add closing comments to complete the case.

In the Close notes  field, add your comments and select Close 
case.

The state of the due diligence case is updated to Closed 
completed.

Risk assessment flow when Third-party Risk Due Diligence is installed

If you have installed both the Risk Assessments Integration for Supplier Lifecycle Operations 
[com.snc.sn_supplier_tprm] and GRC: Third-party Risk Due Diligence [com.sn_tprm_onboarding] 
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plugins, the Perform risk assessment playbook triggers the flow that includes activities to create 
a due diligence request, complete Inherent Risk Questionnaire (IRQ) assessments, and conduct 
risk assessments for a third-party and an engagement.

Risk assessment flow when Third-party Risk Due Diligence is installed

In this flow, the following occurs:

1. The supplier manager receives a supplier onboarding request.

2. The supplier manager uses the onboarding playbook, which provides a streamlined and 
guided process to onboard suppliers. For more information, see Use the supplier onboarding 
playbook to onboard suppliers.

3. The supplier manager submits a due diligence request. For more information about the fields 
in this activity, see Request due diligence for a third-party engagement .

The supplier manager must fill in the details and assign the due diligence request to the TPR 
manager.

Note:  For each due diligence request, the system auto-assigns a unique ID number that 
starts with the prefix DDR.

4. If the due diligence request is approved by the TPR manager, the inherent risk questionnaire 
(IRQ) is sent to the TPR assessor (internal stakeholder).

5. After the TPR assessor submits the completed IRQ, the due diligence process begins.

6. The due diligence process creates two risk assessments, each containing an external due 
diligence questionnaire, one for the third-party and another for engagement.

7. After the supplier contacts complete and submit the external questionnaires from the Supplier 
Collaboration Portal, the TPR manager goes through the questionnaires and approves the due 
diligence request.

8. A contract record is created with an approval. After the contract record is approved, the risk 
record is updated with the final rating.
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9. After the supplier manager accepts the risk rating, an email is sent to the requester informing 
that the due diligence request has been successfully processed and approved.

10. The supplier manager closes the due diligence request (case).

After the case is closed, you can continue with completing the activities in the Activation stage.

For more information about the due diligence workflow, see Due diligence workflow .

Playbook stages and activities when Third-party Risk Due Diligence is installed

The following table lists the Perform risk assessment playbook stages and activities when Third-
party risk Due Diligence is installed.

Perform risk assessment playbook stages and activities

Stage Activity Activity Details

Assign case As a supplier manager or fulfiller, you can use this activity 
to assign the case to a different person or keep the case 
assigned to you.

You can do the following:

• In the Assigned to  search field, search for and select 
the person that you want to assign the case to.

• In the Short description  field, update the description for 
the case.

• Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Review 
case

Update case to work in 
progress Updates the state of the due diligence case to work in 

progress.

Check if TPRM is 
installed

Checks if the TPRM plugin is installed.

Check for duplicate 
due diligence (risk 
assessment) requests

Reviews existing due diligence requests for this supplier.

You can do the following:

• Cancel:  If there's an existing due diligence request, you 
can select this option to cancel this due diligence case.

• Create new request:  Creates a new due diligence 
request.

Create 
request

Create due diligence 
request

Do the following:

• Under Options, select Onboard a new engagement.

• In the Third party  field, select the supplier.

• Fill in the required fields in the following sections:

◦ Third-party information

◦ Third-party address
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Perform risk assessment playbook stages and activities  (continued)

Stage Activity Activity Details

◦ Engagement information

◦ Engagement address

◦ Engagement primary contact

• Select Submit.

Check the status of the 
due diligence request

Waits for initial approval on the due diligence request and 
the risk process to start. Select View record  to view the 
due diligence request.

Waiting on IRQs to be 
completed

Waits for the approval of the IRQs and the due diligence to 
start.

Waiting on the due 
diligence to be 
completed

Waits for the due diligence to be completed and the 
formal review process to start.

Assess 
risk

Waiting on the due 
diligence to be reviewed 
and approved

Waits for the due diligence request to be reviewed and 
approved.

Review 
risk 
rating

Accept or reject risk 
ratings

Review the risk rating of the supplier and choose to accept 
or reject the risk rating.

Available actions:

• Accept

• Reject

If you select Reject, the playbook opens the Rejection 
stage.

Notify the requester that 
the request has been 
approve

Available actions:

• Send email:  Sends an email to the requester, informing 
them that the case has been approved.

• Skip:  Skips this activity.

Close 
case

Close case Add closing comments to complete the case.

In the Close notes  field, add your comments and select 
Close case.

The state of the due diligence case is updated to Closed 
completed.

Add a subsidiary for a supplier from the Source-to-Pay Workspace

If a supplier has subsidiaries, you can add them to that supplier from the Source-to-Pay 
Workspace.

Before you begin
Role required: sn_slm.owner or sn_slm.admin
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier that you want to add a supplier 
location for.

4. Select the Subsidiaries  tab and then select Add.

5. In the Select subsidiary  field of the Add subsidiary dialog box, search for and select a 
subsidiary.

6. Select Add.
The subsidiary is added and displayed on the Subsidiaries  tab.

When you add a subsidiary, the supplier you added it under becomes the parent entity of that 
subsidiary.

Source-to-Pay Workspace  Supplier page

As a supplier manager, view all the information about a supplier, view supplier locations, manage 
cases, and view procurement information.

Open the Source-to-Pay Workspace  Details page by navigating to All  > Supplier Lifecycle 
Operations  > Source-to-Pay Workspace.

Under Quick Actions, select Manage my suppliers, and then in the Legal name column of the 
My suppliers form, select the link to the legal name of the supplier to view more details about the 
supplier.

The Details page contains the following tabs that display relevant information related to the 
supplier.

• About

• Details

• Related work

• Spend

• Risk

• Performance

• KPI management

• Subsidiaries

• Documents

About tab

The About  tab displays information about the supplier, supplier relationship, similar suppliers, 
and supplier locations.

Sections on the About tab

Title Description

Sections
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Sections on the About tab  (continued)

Title Description

Supplier 
details

Displays supplier details, such as legal name, DUNS number, country of 
registration, stock symbol, number of employees. You can edit the supplier 
details, if needed.

Relationship 
summary

Displays details about whether the supplier has been onboarded, who 
onboarded the supplier and on which date, and who is the supplier relationship 
manager.

Relationship 
manager

Person responsible for managing the relationship with this supplier. Select the 

email icon ( ) to send an email to the relationship manager.

Similar 
suppliers

Displays suppliers that provide products and services similar to the one that 
you’re currently viewing.

Supplier 
news

Displays news and significant events related to the suppliers that you manage, 
so that you can take action to reduce the impact to the business. For example, 
news related to mergers and acquisitions, cybersecurity events, fines and 
sanctions, bankruptcy, negative news, and so on.

By default, Supplier Lifecycle Operations  retrieves supplier news and activities 
using the Bing News Search API.

The News Integration for Supplier Lifecycle Operations  plugin 
(com.snc.sn_supplier_news) provides you with the flexibility to dynamically fetch 
news and activities related to a supplier by using any API of your choice. For 
more information, see Configuring a custom API to dynamically fetch supplier 
news.

Related 
Links

Displays links that enable you to view additional information pertaining to 
suppliers:

• Banking information

• Product codes

• Email domains

• Contracts

• Supplier products

Supplier 
locations Displays the geographical location of the suppliers on a map.

Note:  The Map UI component for threat and alert data feeds 
(com.sn_fam_map) plugin enables you to view and manage this section. 
Verify that you have configured the FAM map properties. For more 
information, see Configure properties for Supplier Lifecycle Operations.

You can do the following:
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Sections on the About tab  (continued)

Title Description

• Select the add supplier location icon ( ) to add a supplier location. For more 
information, see Add a supplier location from the Source-to-Pay Workspace.

• Select the toggle list view icon ( ) to open the list view, which displays a list 

of all the supplier locations. Select the toggle map view icon ( ) to return to 
the map view.

• Select the toggle full screen view icon ( ) to view the map in full screen. 

Select the toggle full screen view icon ( ) to exit the full screen mode.

Stakeholders Displays internal stakeholders and supplier contacts associated with a supplier. 
Internal stakeholders are internal users with a unique relationship type such 
as Procurement manager or Category manager. To view a list of all the internal 
stakeholders, select the View stakeholders  option. For more information on 
adding and managing internal stakeholders, see Manage internal stakeholders

Supplier contacts are associated external users. Primary supplier contact 
is indicated with a Primary tag. To view a list of all the internal stakeholders, 
select the View supplier contacts  option. For more information on adding and 
managing supplier contacts, see Manage supplier contacts from the Source-to-
Pay Workspace.

Note:  The View stakeholders  and View supplier contacts  options are 
displayed only if the supplier has more than five internal stakeholders or 
supplier contacts respectively.

Option

Contextual 
side panel

This panel appears below the UI actions.

Select the supplier overview icon ( ) to open the following panels:

• Supplier overview: Displays information about the supplier.

• Supplier contacts: Displays information about the supplier contacts. An 
Admin label next to the contact's name indicates that the contact is a primary 
contact. If a supplier has more than 5 supplier contacts, the View all  option is 
displayed. Select View all  to view a list of all the contacts for the supplier.

Select the attachments icon ( ) to open the Attachments panel, which enables 
you to attach documents to the case.

Select the agent assist icon ( ) to open the Agent Assist panel, which enables 
you to search for information across multiple sources such as catalog items, 
knowledge articles, supplier cases, problems, and open incidents.

Options 
to sync 
supplier 
data with 
an external 
third-party 
application

Select Connect to external data: Enables you to synchronize the supplier data 
from an external third-party application so that you can view the latest supplier 
details in the Source-to-Pay Workspace

Select Sync with external data  to synchronize with an external third-party 
application to update the supplier details in the Source-to-Pay Workspace
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Sections on the About tab  (continued)

Title Description

Note:  The Sync with external data  option replaces the Connect to 
external data  option after you import supplier details for the first time using 
the Connect to external data  option.

For more information, see Synchronize supplier data using external third-party 
application.

Options 
to create 
supplier 
cases and 
supplier 
tasks

Select the Create  drop-down list to view these options:

• Create supplier case: Enables you to create a supplier case. For more 
information, see Create a supplier case.

• Create supplier task: Enables you to create a task for a supplier case. For 
more information, see Create a task for a supplier case from the Source-to-Pay 
Workspace

Option 
to save 
supplier 
details

If you update the supplier details, select Save  to save the data to the supplier 
record.

Option to 
delete a 
supplier

Select the see actions icon ( ) and select Delete  to delete a supplier.

Details tab

The Details  tab displays information about the supplier.

Note:  The fields on this tab are editable. You can update the supplier details and select 
Save  to save the data.

Fields on the Details tab

Field Description

Supplier

Number An auto-generated number that uniquely identifies a supplier.

Legal name Name of the supplier.

ERP supplier 
code

Company code of the supplier in the ERP system.

Parent entity Name of the parent company of the supplier.

Global 
company

Name of the global company of the supplier.

Relationship 
manager

Person responsible for managing the relationship with this supplier.

Relationship 
status

Business relationship that is designated to the supplier. The options are 
Strategic, Valued, Tactical, or Excluded.

Onboarded Whether the supplier is onboarded. The options are Yes or No.
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Fields on the Details tab  (continued)

Field Description

Preferred Whether the supplier is preferred. The options are Yes or No.

General

Street address Street where the supplier is located.

City City where the supplier is located.

State / 
Province

State or province where the supplier is located.

Country Country where the supplier is located.

Industry The type of industry the supplier belongs to.

Website Website of the supplier.

Image Option to attach an image of the supplier logo. Select Attach image  and select 
the image you want to attach.

Related work tab

The Related work  tab displays information about cases, tasks, sourcing requests, risk 
assessments, purchase requisitions, and shipments.

The Related work  tab contains the Lists section on the left, which contains the modules 
that display information about cases, tasks, sourcing requests, risk assessments, purchase 
requisitions, and shipments. The Lists section displays the count of records in each module. You 
can select a module to view a list of records in that module.

In the Number column, select the record number link to view more details pertaining to that 
record.

Modules on the Related work tab

Module Description

Cases Displays a list of cases for the supplier.

Tasks Displays a list of tasks for the supplier.

Risk 
assessments

Displays a list of risk assessments for the supplier.

Note:  This module is displayed only if you have installed the Vendor Risk 
Management (com.sn_vdr_risk_asmt) plugin.

Purchase 
requisitions

Displays a list of purchase requisitions for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) plugin.

Purchase 
orders

Displays a list of purchase orders for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) and Source-to-Pay Common 
Architecture (com.snc.sn_shop) plugins.
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Modules on the Related work tab  (continued)

Module Description

Shipments
Note:  This module is displayed only if you have installed the Supply 
Chain Exception Management (com.snc.sn_scm_core) plugin.

Invoices Displays a list of invoices for the supplier.

Note:  This module is displayed only if you have installed the Sourcing 
and Purchasing Automation (com.snc.sn_pr) and Source-to-Pay Common 
Architecture (com.snc.sn_shop) plugins.

Spend tab

The Spend  tab displays information about open purchase orders, open invoices, your total 
spend, total savings, and the trend of your spend and savings over time.

Note: 

The Spend  tab becomes available in the Source-to-Pay Workspace  only if you install the 
Source-to-Pay Common Architecture  (com.snc.sn_shop) plugin. The Spend  tab displays 
information about open purchase orders, open invoices, your total spend, total savings, and 
a graphical representation of the trend of your spend and savings over time.

For detailed information about each component, select an individual widget or chart.
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Spend tab

Sections on the Spend tab

Title Type Description

Summary - Total Spend

All Time Widget View the total spend till date.

This Year Widget View the total spend for the 
year.

This Quarter Widget View the total spend for the 
quarter.

This Month Widget View the total spend for the 
quarter.
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Sections on the Spend tab  (continued)

Title Type Description

Summary - Total Savings

All Time Widget View the total savings till date.

This Year Widget View the total savings for the 
year.

This Quarter Widget View the total savings for the 
quarter.

This Month Widget View the total savings for the 
quarter.

Summary

Spend vs. Savings over time Graph Displays a graphical 
presentation of spend versus 
savings over a given period of 
time.

Purchase orders

Number Column An auto-generated number 
that uniquely identifies the 
purchase order.

In the Number column, select 
the link to the record number 
to view more details.

Display name Column Name of the purchase order 
for a supplier product.

Total amount Column The total cost of purchase 
requisition calculated as the 
sum from all related purchase 
lines.

Status Column State of the purchase order.

Created Column Date on which this purchase 
order is created.

Created by Column Person who created the 
purchase order.

Invoices

Number Column An auto-generated number 
that uniquely identifies the 
invoice.

In the Number column, select 
the link to the record number 
to view more details.

Purchase order Column Purchase order with which this 
invoice is associated.
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Sections on the Spend tab  (continued)

Title Type Description

State Column Status of the invoice.

Invoice date Column Date on which this invoice is 
created.

Created by Column Person who created the 
invoice.

Contracts

Number Column An auto-generated number 
that uniquely identifies the 
contract record.

In the Number column, select 
the link to the record number 
to view more details.

Name Column Short description of the 
contract.

Total cost Column Final cost of the contract.

State Column Current state of the contract.

Substate Column Current substate of the 
contract.

Start date Column Date on which the contract 
takes effect.

End date Column Date on which the contract 
expires

Risk tab

The Risk  tab displays third-party name and process information, summary reports, risk 
intelligence scores, and tracking data for issues and tasks. On most reports, you can select an 
item to view the underlying data.

The Risk  tab is displayed only if you have installed the Third-party Risk Management 
[com.sn_vdr_risk_asmt] and GRC: Vendor Risk Management Workspace 
(com.sn_vdr_risk_asmt_workspace) plugins.

To know more about the information displayed on the Risk  tab, see Viewing summarized risk 
information for a third party .

Performance

The Performance  tab displays the Dashboard which enables monitoring and managing supplier 
performance effectively and making data-driven decisions. You can view the overall supplier 
score, risk score, individual KPI scores, and domain-specific scores.

The Performance  tab is displayed only if you have installed the KPI Framework (com.snc.sn_kpi) 
and Supplier Relationship and Performance Management (com.snc.sn_slm_perf) plugins.
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To know more about the information displayed on the Performance  tab, see View supplier 
performance dashboard.

KPI Management

The KPI Management  tab provides comprehensive visibility into the performance scores of all 
KPIs. KPIs are grouped by domains (such as Inventory and Quality) and include critical details 
such as weight, frequency, and status.

The KPI Management  tab is displayed only if you have installed the KPI Framework 
(com.snc.sn_kpi) and Supplier Relationship and Performance Management 
(com.snc.sn_slm_perf) plugins.
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To know more about the information displayed on the KPI Management  tab, see Manage 
supplier KPIs from the supplier record page of the Source-to-Pay Workspace.

Subsidiaries tab

The Subsidiaries  tab displays all the subsidiaries of the supplier.

The Subsidiaries  tab contains the Add  option, which enables you to quickly add a subsidiary of 
the supplier. For more information, see Add a subsidiary for a supplier from the Source-to-Pay 
Workspace.

Stakeholders

The Stakeholders  tab helps you manage internal stakeholders and supplier contacts associated 
with a supplier. You can complete the following operations from this tab:

• View a list of internal stakeholders and supplier contacts

• Add internal stakeholders with a unique relationship type to the supplier

• Remove or update internal stakeholder details

• Add, remove, or update supplier contacts

• Manage access for primary contact role

For more information on the stakeholders tab, see Manage internal stakeholders  and Manage 
supplier contacts from the Source-to-Pay Workspace.
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Documents tab

The Documents  tab displays information about the required documents that the suppliers 
upload by either using this tab or from the Supplier Collaboration Portal.

The Documents  tab contains the Link Documents  option, which enables you to quickly add an 
already uploaded document without creating a new one. Access to the Link Documents  option 
is controlled by the user criteria you set on the Manage access  tab when creating the supplier 
document configuration. For more information, see Create a supplier document configuration.

Add a supplier location from the Source-to-Pay Workspace

Add a supplier location to visualize the geographical location that suppliers run their operations 
from.

Before you begin
Ensure that you have configured the FAM map properties. For more information, see Configure 
properties for Supplier Lifecycle Operations.

Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can add locations only for the suppliers they own.

About this task

• If a supplier has multiple locations, at least one location should be set as headquarters.

• If a new supplier location is set as headquarters (HQ) or if any updates are made to the existing 
HQ supplier location, the location details of the HQ supplier location is updated in the supplier 
record.

• When you update the supplier location details in a supplier record, the location details are 
updated in the supplier location record as well.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier that you want to add a supplier 
location for.

4. On the About  tab, under Supplier Locations, select the add supplier location icon ( ).

5. On the Add New Location form, fill in the fields.
For more information about the form fields and descriptions, see Add New Location form.

6. Select Save.

Edit supplier details from the Source-to-Pay Workspace

Add or modify the details of an existing supplier.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can edit details only for the suppliers they own.
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Manage my Suppliers, select the legal name of the supplier to be edited.
The supplier Details panel opens.

3. Select the Details  tab and update the fields in the Supplier and General sections as needed.
For descriptions of the fields on the Details  tab, see Source-to-Pay Workspace Supplier page.

4. Select Save.

Result
The edited supplier details are updated in the system.

Manage documents from the Source-to-Pay Workspace

Manage documents by uploading, updating and downloading the required documents from the 
Source-to-Pay Workspace.

Before you begin
Ensure that you have created a supplier document configuration. For more information, see 
Supplier Document Management.

Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

About this task
The Documents  tab contains the Link Documents  option, which enables you to quickly add an 
already uploaded document without creating a new one. Access to the Link Documents  option 
is controlled by the user criteria you set on the Manage access  tab when creating the supplier 
document configuration. For more information, see Create a supplier document configuration.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under My suppliers, select the legal name of the supplier.
The supplier details page is displayed.

3. Select the Documents  tab and do one of the following.

To Do this

Upload a document

a. Select New.

b. On the Create New Documents form, fill in 
the fields. For a description of the field val­
ues, see Create New Documents form.

c. Select Submit.

Download a document
a. In the Name column, select the link to a doc­

ument to open it.

b. Select Download Document.

Remove a document
a. Select the check box next to the document 

name.

b. Select Remove.
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To Do this

Upload a new version of a document

a. In the Name column, select the link to a doc­
ument to open it.

b. Do one of the following:

▪ Select Upload Version.

▪ Select the Versions  tab and then select 
New.

c. On the Create New Versions form, under 
Attachments, select Browse  to upload the 
new version of the document.

d. Select Save.

A new version of the document is created 
and displayed in the Versions  tab.

Playbook for updating the supplier primary data

Source-to-Pay Workspace  includes a playbook that you use for updating the supplier primary 
data.

Review supplier primary data request playbook

This playbook provides step-by-step guidance for cases related to updating supplier primary 
data. The playbook includes a supplier case flow containing various stages and activities that 
you must complete to close the supplier case. For more information, see Interact with Playbook .

This playbook is used for updating the supplier primary data when:

• A supplier contact submits a request for updating the supplier primary data using the supplier 
catalog item from the Supplier Collaboration Portal

• A supplier manager or fulfiller creates a case for updating the supplier primary data from the 
Source-to-Pay Workspace

The application opens the case on the Playbook  tab on the Details page.

This playbook is displayed only for these case types:

• Banking information change request

• Supplier information change request

• Supplier location change request

• Conduct sanction screening
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Review supplier primary data request playbook on the Playbook tab

Review supplier primary data request playbook flow

The following diagram illustrates the flow of the activities in each stage of the Review supplier 
primary data request playbook.
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Review supplier primary data request playbook flow

Review supplier primary data request playbook stages and activities

The playbook contains the following stages and activities.

Flow of activities in each stage of the Case playbook

Stage Activity Activity Details

Review 
case

Assign case As a supplier manager or fulfiller, you can use this activity to assign 
the case to a different person or keep the case assigned to you.
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Flow of activities in each stage of the Case playbook  (continued)

Stage Activity Activity Details

You can do the following:

• In the Assigned to  search field, search for and select the person 
that you want to assign the case to.

• In the Short description  field, update the description for the case.

• Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Approve 
changes As a supplier manager or fulfiller, you can use this activity to decide 

whether to approve or reject the case.

This activity has the options:

• Approve changes: Approves your changes.

• Reject changes: Rejects your changes and opens the Reject 
changes stage.

For more information, see Non-Interactive activities .

Verify 
changes are 
made in other 
systems

This activity informs you that changes to this request have been 
processed in ServiceNow. If applicable, please verify that the details 
of this case have also been processed in all other systems.

You can do the following:

• Skip: Skips this activity and moves to the next activity.

• Continue: Marks this activity as complete and moves to the next 
activity.

Notify the 
supplier A draft email appears with pre-populated data in the To  and Subject 

fields. The email body is pre-populated with the relevant text.

You can do the following:

• Send Email: Send an email to the supplier informing that the 
request has been completed.

• Skip: Skips this activity and moves to the next activity.

Process 
change 
request

Complete 
case As a supplier manager or fulfiller, you can update the state of the 

case and complete the case.

You can do the following:
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Flow of activities in each stage of the Case playbook  (continued)

Stage Activity Activity Details

• From the State drop-down list, select Closed completed.

• In the Work notes  field, provide any additional information about 
the case.

• In the Close notes  field, enter the details when closing the case.

• Select Complete case.

Updates the case to Closed Completed.

Notify the 
supplier A draft email appears with pre-populated data in the To  and Subject 

fields. The email body is pre-populated with the relevant text.

You can do the following:

• Send Email: Send an email to the supplier informing that the 
request has been rejected.

• Skip: Skips this activity and moves to the next activity.

Reject 
Changes

Complete 
case As a supplier manager or fulfiller, you can update the state of the 

case and reject the case.

You can do the following:

• From the State drop-down list, select Closed rejected.

• In the Work notes  field, provide any additional information about 
the case.

• In the Close notes  field, enter the details when closing the case.

• Select Complete case.

Updates the case to Closed Rejected.

Related topics

Manage supplier cases from the Source-to-Pay Workspace

Configure due dates for supplier cases

Case playbook for specific supplier case types

Create a case on behalf of a supplier from the Source-to-Pay Workspace

Review supplier information using Relish

Using Relish integration, checking supplier's banking details, physical addresses, and sanction 
screening can be done efficiently.

Important:  Check your entitlements to determine whether you have access to Relish 
integration.

The details of the following case types in the Review supplier primary data request  playbook 
can be verified using Relish integration:
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• Banking information change request

• Supplier location change request

• Conduct sanction screening

For more information on required and dependent plugins for Relish, see Relish Integration for 
Supplier Lifecycle Operations.

Example: Verifying Supplier location change request

When a location change request is assigned to a supplier manager and they start working on it, 
they can verify the new location by clicking Validate.

Verify supplier information

Clicking the Validate  button invokes the Relish verification process.

Verify supplier information using Relish

It takes few minutes for Relish to complete the verification process. Depending on the result, the 
supplier manager can approve or reject the request.
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Approve or reject changes

Also, a notification can be sent to the requester.

Notify the supplier

Related topics

Playbook for updating the supplier primary data

Manage internal stakeholders

Internal stakeholders represent key relationship types associated with a supplier such as 
Business owner, Category manager, or Procurement manager. Mapping internal stakeholders 
to a unique relationship type enhances governance data visibility and facilitates effective 
relationship management with a supplier.

Important:  This functionality is available from the Yokohama December 2025 release 
onwards.

You can add internal stakeholders with unique relationship types and remove non-essential 
internal stakeholders from the Source-to-Pay Workspace.

Each internal stakeholder can be assigned only one of the following relationship types:
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• Primary Relationship Manager

• Secondary Relationship Manager

• Procurement Manager

• Category Manager

• Contract Manager

• Business Owner

Note:  You can configure all relationship types, except the Primary Relationship Manager 
type, to align with your business requirements.

Internal stakeholders with Primary Relationship Manager relationship type must be assigned the 
[sn_slm.owner] role manually, which enables them to view, create, and update stakeholders for 
the associated supplier. All relationship types, other than Primary Relationship Manager, are for 
reference only. For more information on roles and their description, see Components installed 
with Supplier Lifecycle Operations.

Related topics

Add internal stakeholders from the Source-to-Pay Workspace

Remove internal stakeholders from the Source-to-Pay Workspace

Add internal stakeholders from the Source-to-Pay Workspace

Assign relationship types such as Primary relationship manager and Category manager to 
internal users associated with a supplier.

Before you begin
Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note:  Users with the sn_slm.owner role can add stakeholders only for the suppliers that 
they manage. Users with sn_slm.manager and sn_slm.admin roles can add stakeholders for 
any supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick Actions, select Manage my suppliers.

3. Select the legal name of the supplier for which you want to add a supplier contact.
The supplier details page is displayed.

4. Navigate to the Stakeholders  tab, and then select Internal.

5. Select Add.

6. In the Internal stakeholders  field, enter the name of the user that you want to add as an 
internal stakeholder.
You can add more than one user by entering multiple email addresses separated by a comma.

7. From the Relationship type drop-down, select the user's relationship type with the supplier.
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8. From the Importance  drop-down, select how critical the stakeholder is to the supplier 
relationship.

9. Select Add.

Result
The user is added to the list of internal stakeholders on the Stakeholders  tab.

Remove internal stakeholders from the Source-to-Pay Workspace

Remove non-essential internal stakeholders from the Source-to-Pay Workspace.

Before you begin
Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note:  Users with the sn_slm.owner role can remove stakeholders only for the suppliers 
that they manage. Users with sn_slm.manager and sn_slm.admin roles can remove 
stakeholders for any supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick Actions, select Manage my suppliers.

3. Select the legal name of the supplier for which you want to add a supplier contact.
The supplier details page is displayed.

4. Navigate to the Stakeholders  tab, and then select Internal.

5. Select the required stakeholders.

6. Select Remove.
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7. In the Remove internal stakeholders dialog box, select Remove.

Result
Selected stakeholders are removed from the list of internal stakeholders.

Manage supplier contacts from the Source-to-Pay Workspace

Add or remove contacts, elevate access or remove elevated access to contacts from the Source-
to-Pay Workspace.

Related topics

Add a supplier contact from the Source-to-Pay Workspace

Remove a supplier contact from the Source-to-Pay Workspace

Elevate a contact to the primary contact role from the Source-to-Pay Workspace

Restrict the primary contact role for a contact from the Source-to-Pay Workspace

Add a supplier contact from the Source-to-Pay Workspace

Add supplier contacts so that they can access the Supplier Collaboration Portal  and start 
working on the most important tasks.

Before you begin
Before performing this task, ensure that you do the following:

• Configure self-registration for external users. For more information, see Configure self-
registration for external users.

• Configure the sn_supplier.external_registration_profile_id system property to ensure that 
registration emails are sent to external users. For more information, see Configure system 
property to send registration emails to external users.

Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note:  Users with the sn_slm.owner role can add contacts only for the suppliers that they 
manage. Users with sn_slm.manager and sn_slm.admin roles can add supplier contacts for 
any supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick Actions, select Manage my suppliers.

3. Select the legal name of the supplier for which you want to add a supplier contact.
The supplier details page is displayed.

4. Navigate to the Stakeholders  tab, and then select Supplier contacts.
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5. Select Add.

Note:  The Add  button is visible only after the external user configuration is completed.

6. In the Contact emails  field, enter the email address of the contact that you want to invite.
You can invite more than one contact by entering multiple email addresses separated by a 
comma.

7. Select Add.

8. From the Role  drop down list, select one of the following options:

◦ Contact: Supplier contact role is assigned to the selected user.

◦ Primary: Primary contact role is assigned to the selected user.

9. Select Send 

invites.
A confirmation message stating that an email containing the registration link is sent to the 
email address is displayed.

What to do next
Register to the Supplier Collaboration Portal as an invited member.

Related topics

Remove a supplier contact from the Source-to-Pay Workspace

Elevate a contact to the primary contact role from the Source-to-Pay Workspace

Restrict the primary contact role for a contact from the Source-to-Pay Workspace

Remove a supplier contact from the Source-to-Pay Workspace

Remove non-essential supplier contacts for a supplier from the Source-to-Pay Workspace.

Before you begin
Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note:  Users with the sn_slm.owner role can remove contacts only for the suppliers that 
they manage. Users with sn_slm.manager and sn_slm.admin roles can remove supplier 
contact for any supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.
The My suppliers page is displayed.
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3. Select the legal name of the supplier.

4. Navigate to the Stakeholders  tab and the select Supplier contacts.

5. Select the supplier.

6. Select Remove Contact.

Note:  A contact can be removed only when at least two contacts exist in the supplier 
contact list.

7. From the Reassign tasks to  drop-down, select a contact to whom you want to reassign the 

tasks.

8. From the Reassignment reason  drop-down, select the reason for reassignment.

9. Select Remove.

Result
The contact is removed and all the tasks that were assigned to that contact are reassigned to the 
alternate contact.

Related topics

Add a supplier contact from the Source-to-Pay Workspace

Elevate a contact to the primary contact role from the Source-to-Pay Workspace

Restrict the primary contact role for a contact from the Source-to-Pay Workspace

Elevate a contact to the primary contact role from the Source-to-Pay Workspace

Elevate a contact to the primary contact role to enable them to access and manage all the 
contacts and tasks in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note: 

• Users with the sn_slm.owner role can elevate access only for the contacts of the 
suppliers that they manage. Users with sn_slm.manager and sn_slm.admin roles can 
elevate access for any supplier.

• This functionality isn’t available in Xanadu  December 2024 release.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick Actions, select Manage my suppliers.
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3. Select the legal name of the supplier.

4. On the supplier details page, select the Stakeholders  tab.

5. Select Supplier contacts.

6. Select the supplier contact.

7. On the Supplier contact details page, select Elevate 

access.

Result
The Primary contact column is set to true  for this contact on the Supplier contacts page, and the 
contact is elevated to the primary contact role.

Related topics

Add a supplier contact from the Source-to-Pay Workspace

Remove a supplier contact from the Source-to-Pay Workspace

Restrict the primary contact role for a contact from the Source-to-Pay Workspace

Restrict the primary contact role for a contact from the Source-to-Pay Workspace

Remove the primary contact role for a contact to prevent them from accessing all the contacts 
and tasks in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.owner, sn_slm.manager, sn_slm.admin

Note:  Users with the sn_slm.owner role can restrict access only for the contacts of the 
suppliers they own. Users with sn_slm.manager and sn_slm.admin roles can restrict access 
for any supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick Actions, select Manage my suppliers.

3. Select the legal name of the supplier.

4. On the supplier details page, select the Stakeholders  tab.

5. Select Supplier contacts.
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6. Select the supplier contact that you want to restrict.

7. Select Restrict 

access.

Result
The Primary contact column is set to false  for this contact on the new table page, and the contact 
no longer has the primary contact role.

Related topics

Add a supplier contact from the Source-to-Pay Workspace

Remove a supplier contact from the Source-to-Pay Workspace

Elevate a contact to the primary contact role from the Source-to-Pay Workspace

Manage supplier cases from the Source-to-Pay Workspace

You can create and manage supplier cases for suppliers in the Source-to-Pay Workspace.

On the Source-to-Pay Workspace  List page, navigate to Lists  > Cases  and select any of the sub-
modules to view a list of cases. Select the link to the case in the Number  column to open the 
Case Details page.

For more information about viewing cases in the Source-to-Pay Workspace, see View a supplier 
case from the Source-to-Pay Workspace.

The Case Details page contains the following options.

Case Details page options

Option Description

Multi-tab 
interface

When you select a link for a case, each case opens in a separate tab in the top-left 
corner, which enables you to easily navigate between multiple open cases.

Each case displays information in the following tabs:

• Playbook  tab: Displays either the playbook to onboard a supplier or the generic 
playbook depending on the case type. For more information, see Use the 
supplier onboarding playbook to onboard suppliers  and Case playbook for 
specific supplier case types.

• Details  tab: Contains the Supplier Case, Summary Details, and Resolution 
Information sections.
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Case Details page options  (continued)

Option Description

◦ Supplier Case: Displays information about the supplier case.

◦ Summary Details: Displays the parent case, related location, start and end 
dates for the case.

◦ Resolution Information: Displays the resolution information and close notes for 
the case.

• Supplier Information  tab: Displays information about the supplier. For more 
information about this tab, see Supplier Information tab.

• Supplier Tasks  tab: Lists the supplier tasks for the supplier case.

• Related Cases  tab: Lists the child supplier cases related to the parent supplier 
case.

If you've not installed Third-party Risk Management, the playbook creates 
supplier cases of types Risk assessment  and Tiering assessment. The Supplier 
Risk Assessment and Supplier Tiering Assessment cases are child cases of the 
parent Onboard a Supplier  case and are displayed on the Related Cases  tab. 
The supplier owner or supplier manager assigns these assessment cases to the 
TPR assessor.

• Approvals  tab: Lists the approval records, their approval status, and the persons 
who need to approve this case.

Important:  Supplier Lifecycle Operations  creates an approval record if 
the "Ask For Approval" action is a part of any SLO flow. This approval record 
can be approved by the user who belongs to the Supplier Administrators 
group (sys_user_group table). For more information, see Add a user to a 
group .

• Risk Assessments  tab: Displays the risk assessments for a supplier.

If you have installed Third-party Risk Management, the playbook creates the risk 
assessment records and displays them in this tab.

• Tiering Assessments  tab: Displays the tiering assessments for a supplier.

If you have installed Third-party Risk Management, the playbook creates the 
tiering assessment records and displays them in this tab.

Note:  The Risk Assessments  and Tiering Assessments  tabs are shown 
only for a supplier case of type Supplier onboarding.

• Draft Emails  tab: Displays a list of emails you saved as draft.

• Documents  tab: Enables you to manage supplier documents by uploading, 
updating and downloading the required documents

Compose 
section

Contains the Comments and Work notes (Private) widgets. The text that you enter 
in the Comments section are visible to everyone. However, the text that you enter 
in the Work notes (Private section) are visible only to internal users; customers 
cannot view them.
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Case Details page options  (continued)

Option Description

Activity 
stream

Displays all the processing activities, conversations, and changes that have 
happened since the case was opened. You can filter activities by post types, field 
changes, and flagged activities.

Contextual 
side panel

This panel appears below the UI actions.

Select the supplier overview icon ( ) to open the following panels:

• Supplier overview: Displays the following information about the supplier.

◦ Supplier: Name of the supplier.

◦ Short description: Brief description about the supplier.

◦ Risk rating: The risk rating of the supplier.

The risk rating scale helps business users better understand risk assessment 
results. For example, in the default settings, risk scores in the 20 through 39 
range indicate high risk, while scores in the 60 through 79 range indicate low 
risk.

Depending on the risk score of the supplier, the following risk ratings are 
displayed:

▪ 1 - Very High

▪ 2 - High

▪ 3 - Moderate

▪ 4 - Low

▪ 5 - Very Low

For more information about risk ratings and risk scores, see Set up risk rating 
scales for scoring .

◦ Onboarded: Status of whether the supplier is onboarded into the ERP system. 
The options are Yes or No.

◦ DUNS number: Unique, 9-digit identifier for a supplier.

◦ Website: Website of the supplier.

◦ Industry: Industry to which the supplier belongs.

◦ Country of Registration: The country in which the supplier is registered.

• Supplier contacts: Displays information about the supplier contacts. An Admin 
label next to the contact's name indicates that the contact is a primary contact. If 
a supplier has more than five supplier contacts, the View all  option is displayed. 
Select View all  to view a list of all the contacts for the supplier.

Select the attachments icon ( ) to open the Attachments panel, which enables 
you to attach documents to the case.

Select the agent assist icon ( ) to open the Agent Assist panel, which enables 
you to search for information across multiple sources such as catalog items, 
knowledge articles, supplier cases, problems, and open incidents.
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Related topics

Configure due dates for supplier cases

Case playbook for specific supplier case types

Playbook for updating the supplier primary data

Create a case on behalf of a supplier from the Source-to-Pay Workspace

Supplier Information tab

The Supplier Information  tab shows details about the supplier and the supplier contact, a 
summary of all the open and overdue cases, and a list of all the cases by their priority.

Supplier Information tab

Sections

The Supplier Information  tab includes the following sections.
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Sections on the Supplier Information tab

Section Description

Supplier Displays the following information about the supplier:

• Primary Contact

• Phone

• Website

• Street Address

• City/State

• Country

Contact Displays the following information about the contact:

• Office Phone

• Mobile Phone

• Email

• Street Address

• City/State

• Country

Reports

The Supplier Information  tab includes the following reports.

Reports on the Supplier Information tab

Title Type Description

Supplier case summary

Open Single 
score

Total number of open cases for the supplier. Click the number to 
view the list of open cases.

Overdue Single 
score

Total number of overdue cases for the supplier. Click the number to 
view the list of overdue cases.

Cases Donut 
chart

Total number of supplier cases by case or type.

By Type Choice 
list

Enables you to filter and view cases by type or state in the Cases 
donut chart.

Contact case summary

Open Single 
score

Total number of open cases requested by the contact. Click the 
number to view the list of open cases.

Overdue Single 
score

Total number of overdue cases requested by the contact. Click the 
number to view the list of overdue cases.

Cases Donut 
chart

Total number of cases by type or state.
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Reports on the Supplier Information tab  (continued)

Title Type Description

By type Choice 
list

Enables you to filter and view cases by type or state in the Cases 
donut chart.

Cases by priority

Count of cases 
by priority

Donut 
chart

Total number of cases by priority.

List of cases and 
their details

List
Displays a list of cases by their priority, including case details, such 
as case number, short description, and priority.

In the Number column, select the link to the case to view more 
details.

Sidebar for supplier cases in the Source-to-Pay Workspace

Sidebar enables stakeholders to collaborate with others by getting into discussions when 
working on supplier cases.

You can start a Sidebar discussion by selecting Discuss  on a supplier case in the Source-to-Pay 
Workspace. Other stakeholders are notified when you add them to a discussion. They can join 

the discussion by selecting the Sidebar discussions icon ( ).

For more information on what Sidebar is, see Sidebar .

To learn more about how to use Sidebar, see Using Sidebar .

For information on activity stream in Sidebar is, see Activity stream in Sidebar .

Configure due dates for supplier cases

Configure due dates for different case types so that the Due date  field is auto-populated when 
you create supplier cases.

Before you begin
Role required: sn_slm.admin

About this task
Although the Due date  field is auto-populated for a supplier case type, you can always update 
this field as required.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Administration  > Default Due Dates for 
Cases.
The Decision Builder opens and displays the Decision table for configuring the default due 
dates.

Case type Default due date

Onboard new supplier 30

Supplier support request 3

General inquiry 3
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Case type Default due date

Banking information change request 3

Supplier information change request 3

Supplier location change request 3

Enroll new supplier user 3

Account access request 3

Supplier issue 3

Document change request 3

Conduct a risk assessment 3

Conduct a tiering risk assessment 3

Request supplier contact 3

Offboard supplier contact 3

Primary contact elevation 3

2. Under the Default due date column, select a row next to the case type row and enter a positive 
number.
The number that you enter for a case type is auto-populated in the Due date  field the next time 
you create a supplier case of that case type.

For example, let's say that you enter 3 as the due date for the case type General enquiry. If you 
create a General enquiry case on September 12, the due date will be in three days from this 
date; that is, September 15.

3. Select Save.

Case playbook for specific supplier case types

Source-to-Pay Workspace  includes a generic case playbook to complete supplier cases of 
specific case types.

Case playbook for supplier cases

The case playbook provides step-by-step guidance for completing specific types of supplier 
cases. The case playbook includes a generic supplier case flow containing various stages and 
activities that you must complete to close the supplier case. For more information, see Interact 
with Playbook .

When a supplier contact submits a request using the supplier catalog item from the Supplier 
Collaboration Portal  or when a supplier manager or fulfiller creates a case from the Source-to-Pay 
Workspace, the application opens the case on the Playbook  tab on the Details page.

The case playbook is displayed only for these case types:

• Supplier issue

• Supplier support request

• General inquiry

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1055

https://www.servicenow.com/docs/access?context=playbook-ui&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-ui&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-ui&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-ui&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US


Case playbook on the Playbook tab

Case playbook flow

The following diagram illustrates the flow of the activities in each stage of the Case playbook.

Case playbook flow

Case playbook stages and activities

The case playbook contains the following stages and activities.
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Stages in case playbook

Stage Activity Activity Details

Review 
case

Assign 
case

As a supplier manager or fulfiller, you can use this activity to assign the 
case to a different person or keep the case assigned to you.

You can do the following:

• In the Assigned to  search field, search for and select the person that 
you want to assign the case to.

• In the Short description  field, update the description for the case.

• Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Notify the 
supplier A draft email appears with pre-populated data in the To  and Subject 

fields. The email body is pre-populated with the relevant text.

Select one of the following actions:

• Send Email: Send an email to the supplier informing that the request 
has been completed.

• Skip: Skips this activity and moves to the next activity.

Close 
the case 
record

Complete 
case As a supplier manager or fulfiller, you can update the state of the case 

and close the case.

You can do the following:

• From the State drop-down list, select Closed completed.

• In the Work notes  field, provide any additional information about the 
case.

• In the Close notes  field, enter the details when closing the case.

• Select Complete case.

Updates the case to Closed Completed.

Related topics

Manage supplier cases from the Source-to-Pay Workspace

Configure due dates for supplier cases

Playbook for updating the supplier primary data

Create a case on behalf of a supplier from the Source-to-Pay Workspace

Create a case on behalf of a supplier from the Source-to-Pay Workspace

Create a supplier case to track the progress of supplier tasks, resolve issues related to supplier 
products or services, and request additional information from a supplier.
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h=6aae08cf02&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can create cases only for the suppliers they own.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following.

To Do this

To create a case from Quick actions

On the home page, do one of the following:

◦ Under Quick actions, select Create case.

◦ Under Quick actions, select Manage my 
suppliers  and do the following:

a. Select the link to the supplier name un­
der the Legal name column.

b. From the Create  drop-down list, select 
Supplier case.

To create a case from the List page

a. Select the list icon ( ) and do one of the 
following:

▪ Navigate to Lists  > My work  > Open cas­
es

▪ Navigate to Lists  > All work  > Cases

b. Select New.

c. On the Create new case dialog box, select 
a case type from the Case type  field, and 
then select Submit.

3. On the Create New Supplier Case form, fill in the fields.
For more information about the form fields and descriptions, see Create New Supplier Case 
form.

4. Select Save.
The case is created in Draft state.

5. Do the following steps only if you selected these case types: Banking information change 
request, Supplier information change request, Supplier location change request.

a. Select Add more details.

b. On the Add more details form, fill in the fields.

In the Case type  field, if you selected Banking information change request, see Update 
banking details form  for more information about the form fields and descriptions.

In the Case type  field, if you selected Supplier information change request, see Update 
profile details form  for more information about the form fields and descriptions.
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In the Case type  field, if you selected Supplier location change request, see Add New 
Location form  for more information about the form fields and descriptions.

c. Select Submit.

6. Select Submit case
The case moves to the Open state.

What to do next
After you submit the case, depending on the case type, the specific playbook for the supplier 
case opens.

For more information, see Case playbook for specific supplier case types  and Playbook for 
updating the supplier primary data.

Assign a supplier case to yourself from the Source-to-Pay Workspace

As a supplier manager, assign a case to yourself and start working on it.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, sn_slm.fulfiller, or sn_slm.admin

About this task

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ View all the open cases by navigating to Lists  > Cases  > Open Cases.

◦ View all the cases by navigating to Lists  > Cases  > All Cases.

4. To view the details of the case, select the link for the case in the Number column.

5. Select Assign to me.
The case is assigned to you.

Note:  The Assign to me  option is not available if a case is already assigned.

6. Select Save.

Submit a supplier case from the Source-to-Pay Workspace

Submit a supplier case in Draft state to indicate that it is ready to be worked on.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ View all the open cases by navigating to Lists  > My work  > Open cases.

◦ View all the cases by navigating to Lists  > All work  > Cases.
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4. Open a case that is in Draft state by selecting the link to the case in the Number column.

5. Select Submit case.
The state of the case updates to Open, indicating that the case is ready to be worked on.

What to do next
After you submit the case, depending on the case type, the specific playbook for the supplier 
case opens.

For more information, see Case playbook for specific supplier case types  and Playbook for 
updating the supplier primary data.

Complete a supplier case from the Source-to-Pay Workspace

You can mark a supplier case as complete when you finish all the tasks related to that case.

Before you begin
Role required: sn_slm.fulfiller, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ View all the open cases by navigating to Lists  > Cases  > Open cases.

◦ View all the cases by navigating to Lists  > Cases  > All cases.

4. Open a case that is in Open, Work in progress, or Awaiting task completion state by selecting 
the link to the case in the Number column.

5. Select Complete.
The state of the case updates to Closed completed.

Reopen a supplier case from the Source-to-Pay Workspace

Reopen a closed supplier case if you are not satisfied with the case resolution.

Before you begin
Role required: sn_slm.owner and sn_slm.agent

About this task
The Re-open  option is available for a supplier case that is in any of the following states:

• Closed completed

• Closed canceled

• Closed rejected

The Re-open  option is not available for the auto-closing supplier cases of the following case 
types:

• Onboard new supplier

• Enroll new supplier user

• Account access request

• Offboard supplier contact
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• Primary contact elevation

• Request supplier contact

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Cases.

4. Select one of the following:

◦ Open Cases

◦ All Cases

5. In the Number column, select the link to the case that you want to reopen.

6. Select Re-open.
The following occurs:

◦ The case is reopened and its state moves to Open.

◦ The Close notes  field is cleared in the Resolution Information section.

◦ The previous comments that were made on the case are retained and displayed in the 
Activity section.

◦ The Actual end  field becomes empty.

Add a related case to a supplier case from the Source-to-Pay Workspace

If a supplier case has related cases, you can add them to that supplier case from the Source-to-
Pay Workspace.

Before you begin
Role required: sn_slm.owner or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. On the List page, navigate to and select a case.

4. Select the Related Cases  tab and then select Add.

5. In the Select case  field of the Add related cases dialog box, search for and select a case.

6. Select Add.
The case is added and displayed on the Related Cases  tab.

When you add a related case, the supplier case you added it under becomes the parent case 
of that related case.

View a supplier case from the Source-to-Pay Workspace

As a supplier manager, view a supplier case that requires your input or approval.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, sn_slm.fulfiller, or sn_slm.admin
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About this task

Note:  You can view only those cases that are opened for a supplier that you manage.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ View all the open cases by navigating to Lists  > Cases  > Open cases.

◦ View all the cases by navigating to Lists  > Cases  > All cases.

4. To view the details of the case, select the link to the case in the Number column.

Result
The case details are displayed on the Details  tab. For more information, see Source-to-Pay 
Workspace Case Details page. You can modify the fields as needed. Select the Supplier Task 
tab to view details about the tasks for the case or to create a new task. For more information, see 
Create a task for a supplier case from the Source-to-Pay Workspace.

Manage supplier tasks from the Source-to-Pay Workspace

You can create and manage tasks for suppliers and internal users in the Source-to-Pay 
Workspace.

Related topics

Configure due dates for tasks

Create a task for a supplier case from the Source-to-Pay Workspace

Submit a task from the Source-to-Pay Workspace

Complete a supplier task from the Source-to-Pay Workspace

Configure due dates for tasks

Configure due dates for different task types so that the Due date  field is auto-populated when 
you create tasks for internal users and suppliers.

Before you begin
Role required: sn_slm.admin

About this task
Although the Due date  field is auto-populated for a task type, you can always update this field as 
required.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Administration  > Default Due Dates for 
Tasks.
The Decision Builder opens and displays the Decision table for configuring the default due 
dates.

Task type Default due date

Mark complete 3

View link 3
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Task type Default due date

Play video 3

Upload documents 3

Complete a form 3

Sign document 3

Complete checklist 3

Complete survey 3

2. Under the Default due date column, select a row next to the task type row and enter a positive 
number.
The number that you enter for a task type is auto-populated in the Due date  field the next time 
you create a task of that task type.

For example, let's say that you enter 3 as the due date for the task type Mark complete. If you 
create a Mark complete task on September 12, the due date will be in three days from this date; 
that is, September 15.

3. Select Save.

Create a task for a supplier case from the Source-to-Pay Workspace

You can create a task for a supplier case and assign it to a supplier contact.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, sn_slm.fulfiller, or sn_slm.admin

Note:  The sn_slm.owner role can create tasks only for the suppliers they own.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following.

To Do this

Create a supplier task from Quick actions

On the home page, do one of the following:

◦ Under Quick actions, select Create task.

◦ Under Quick actions, select Manage my 
suppliers  and do the following:

a. Select the link to the supplier name un­
der the Legal name column.

b. From the Create  drop-down list, select 
Supplier task.

Create a supplier task from the List page

a. Select the list icon ( ) and do one of the 
following:

▪ Navigate to Lists  > My work  > Open 
tasks

▪ Navigate to Lists  > All work  > Supplier 
tasks
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To Do this

▪ Navigate to Lists  > All work  > Employee 
tasks

▪ Navigate to Lists  > Review needed  > 
Unassigned tasks

b. Select New.

c. In the Create new task dialog box, in the 
Task type  field, select Supplier Task.

Create a supplier task from the Case details 
page

a. Select the list icon ( ) and do one of the 
following:

▪ Navigate to Lists  > My work  > Open cas­
es

▪ Navigate to Lists  > All work  > Cases

b. In the Number column, select the link to the 
case that you want to create a task for, and 
do one of the following:

▪ Select Create task.

▪ Select the Supplier Tasks  tab and then 
select New.

3. In the Create new task dialog box, do one of the following:

To Do this

Create a task for a supplier a. In the Who is this task for?  section, select 
Supplier.

b. In the Action type  field, select one of the following task 
types:

▪ Complete a form

▪ Complete checklist

▪ Complete survey

▪ Mark complete

▪ Play video

▪ Sign document

▪ Upload documents

▪ View link

Create a task for an internal 
employee

a. In the Who is this task for?  section, select An 
employee at my company.

b. In the Action type  field, select one of the following task 
types:

▪ Mark complete

▪ Play video
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To Do this

▪ Upload documents

▪ View link

For more information about the form fields and descriptions on the Create a new task form, see 
Create new task form.

4. Select Submit.

5. On the Task form, fill in the fields.

For more information about the form fields and descriptions, see Task form.

6. Select Save.
The task is created in Draft state.

7. Select Submit task.

The task moves to the Awaiting completion state.

What to do next
The supplier contact to whom this task is assigned can view it on the My To-dos page. For more 
information, see Viewing supplier contact tasks from the Supplier Collaboration Portal.

Submit a task from the Source-to-Pay Workspace

Submit a task in Draft state to indicate that it is ready to be worked on.

Before you begin
Role required: sn_slm.manager, sn_slm.fulfiller, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ View all the supplier tasks by navigating to Lists  > All work  > Supplier tasks.

◦ View all the employee tasks by navigating to Lists  > All work  > Employee tasks.

4. Open a task that is in Draft state by selecting the link to the task in the Number column.

5. Select Submit task.
The state of the task updates to Awaiting completion, indicating that the task is ready to be 
worked on.

Complete a supplier task from the Source-to-Pay Workspace

You can mark a supplier task as complete when you finish all the activities related to that task.

Before you begin
Role required: sn_slm.fulfiller, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:
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◦ View all the supplier tasks by navigating to Lists  > All work  > Supplier tasks.

◦ View all the employee tasks by navigating to Lists  > All work  > Employee tasks.

4. Open a task that is in Awaiting completion or Work in progress state by selecting the link to the 
task in the Number column.

5. Select Complete task.
The state of the task updates to Closed complete.

Offboard a supplier from the Source-to-Pay Workspace

Offboard a supplier due to performance issues or when you learn that the supplier follows 
practices that are inconsistent or unethical.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can offboard only the suppliers they own.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Create case.

3. On the Create New Supplier Case form, fill in the fields.
For more information about the form fields and descriptions, see Create New Supplier Case 
form.

4. From the Case type  field, Offboard a supplier.

5. Select Save.
The application creates a case of type Offboard a supplier.

6. Select Submit Case.

What to do next
The supplier manager or supplier owner can continue to offboard the supplier using the 
Playbook tab on the Case Details page. For more information, see Offboard suppliers using the 
supplier offboarding playbook.

Offboard suppliers using the supplier offboarding playbook

Supplier owners and supplier managers can use the supplier offboarding playbook to complete 
the tasks and activities that are needed to offboard suppliers.

Offboard a Supplier playbook

The Offboard a Supplier playbook provides step-by-step guidance for completing various stages 
and activities to offboard a supplier.

When a supplier manager or supplier owner submits the Offboard a supplier case from the 
Source-to-Pay Workspace, the application opens the case on the Playbook tab on the Details 
page.

The Offboard a Supplier playbook is displayed only for the cases of type Offboard a supplier.
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Offboard a Supplier playbook flow

The following diagram illustrates the flow of the activities in each stage of the Offboard a Supplier 
playbook.
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Offboard a Supplier playbook
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Offboard a Supplier playbook stages and activities

The following table lists the stages and activities that supplier managers and owners can use to 
offboard suppliers.

Playbook stages and activities

Stage Activity Activity Details

Review case Assign case
When a supplier manager or owner creates 
an supplier offboarding case, the workspace 
opens the Create New Onboarding Case 
form, and then opens the supplier offboarding 
playbook.

As a supplier manager or fulfiller, you can use 
this activity to assign the case to a different 
person or keep the case assigned to you.

You can do the following:

• In the Assigned to  search field, search 
for and select the person that you want to 
assign the case to.

• In the Short description  field, update the 
description for the case.

• Select Save.

Select Start work  to start working on the case.

Notification Emails Review incomplete 
cases

This activity shows the list of all pending or 
outstanding cases that you can review before 
offboarding the supplier.

Available actions:

Select Continue  to move to the next activity.

Review incomplete 
tasks

This activity shows the list of all pending or 
outstanding tasks that you can review before 
offboarding the supplier.

Select Continue  to move to the next activity.

Notify internal 
stakeholders This activity enables you to send an email to 

notify internal stakeholders about the decision 
to offboard the supplier.

A draft email appears with pre-populated data 
in the Subject  field. The email body is pre-
populated with the relevant text.

Add the relevant internal stakeholders in the 
To  field.

Select one of the following actions:
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Playbook stages and activities  (continued)

Stage Activity Activity Details

• Send Email: Sends an email to the internal 
stakeholders.

• Skip: Skips this activity and moves to the 
next activity.

Notify supplier This activity enables you to send an email to 
the supplier informing about their termination.

A draft email appears with pre-populated data 
in the To  and Subject  fields. The email body is 
pre-populated with the relevant text.

Select one of the following actions:

• Send Email: Sends an email to the supplier.

• Skip: Skips this activity and moves to the 
next activity.

Termination plan Decide if a due 
diligence request is 
needed

This activity enables you to request for due 
diligence for the supplier being offboarded. 
This helps you in assessing the impact of 
offboarding the supplier.

Note:  This activity is displayed 
only if you have installed both the 
com.snc.sn_supplier_tprm and 
com.sn_tprm_onboarding plugins.

• Select one of the following options:

◦ Offboard an engagement with due 
diligence: Select this option if you want 
to create a due diligence request for the 
supplier.

◦ Offboard an engagement with NO due 
diligence: Select this option if you do not 
want to create a due diligence request for 
the supplier.

• If you selected Offboard an engagement 
with due diligence, then do the following:

◦ In the Third party  field, enter the name of 
the supplier.

◦ In the User who will respond to the initial 
IRA questionnaire  field, specify the name 
of the TPRM assessor.
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Playbook stages and activities  (continued)

Stage Activity Activity Details

◦ In the Engagement  field, select the 
engagement for the supplier.

◦ Select Submit.

Wait for risk process 
to start

As soon as the Due Diligence Request moves 
to the IRQ in progress state, this activity auto-
completes and moves to the next activity.

Review contract for 
compliance

This activity lists all the open contracts for the 
supplier. Ensure that all the terms and clauses 
are being followed.

Select Continue  to move to the next activity.

Settle outstanding 
invoices

Check all outstanding invoices to confirm that 
all payments or balances have been settled.

Select Continue  to move to the next activity.

Final Notices Review incomplete 
cases

This activity shows the list of all pending or 
outstanding cases that you can review before 
offboarding the supplier.

Available actions:

Select Continue  to move to the next activity.

Review incomplete 
tasks

This activity shows the list of all pending or 
outstanding tasks that you can review before 
offboarding the supplier.

Select Continue  to move to the next activity.

Notify internal 
stakeholders This activity enables you to send an email to 

notify internal stakeholders about the decision 
to offboard the supplier.

A draft email appears with pre-populated data 
in the Subject  field. The email body is pre-
populated with the relevant text.

Add the relevant internal stakeholders in the 
To  field.

Select one of the following actions:

• Send Email: Sends an email to the internal 
stakeholders.

• Skip: Skips this activity and moves to the 
next activity.
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Playbook stages and activities  (continued)

Stage Activity Activity Details

Notify supplier This activity enables you to send an email to 
the supplier informing about their termination.

A draft email appears with pre-populated data 
in the To  and Subject  fields. The email body is 
pre-populated with the relevant text.

Select one of the following actions:

• Send Email: Sends an email to the supplier.

• Skip: Skips this activity and moves to the 
next activity.

Close case

Manages the case 
close activities.

Deactivate user 
accounts

This activity enables you to raise a ticket to 
the appropriate teams to deactivate user 
accounts.

Select one of the following actions:

• Accept: Deactivates the supplier user 
accounts.

• Skip: Skipping this activity deactivates the 
supplier user accounts and moves to the 
next activity.

Close case This activity enables you to close the case.

Do the following:

• In the Close notes  field, enter the details 
when closing the case.

• Select Complete case.

Updates the case to Closed Completed.

Update primary 
contacts active to 
false

This activity deactivates all the contacts of the 
offboarded supplier. That is, the Active  check 
box is deselected and the Locked out  check 
box is selected for the contacts in the Vendor 
Contact [vm_vdr_contact] table.

Related topics

Offboard a supplier from the Source-to-Pay Workspace

Accept an incoming chat request from the Source-to-Pay Workspace

As a supplier fulfiller, accept an incoming chat request from the Supplier Manager Workspace 
Inbox to start a chat session with a supplier contact.

Before you begin
Role required: sn_slm.owner
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the Inbox icon ( ).

3. Select Available  from Status  to indicate that you are available to accept the incoming chat 
request.

4. When a chat comes through the chat queue, select Accept.

You are automatically connected to the supplier contact in the chat queue. The Active Chat 
panel displays a pre-chat message acknowledging the chat request. You can review the 
information before you enter a response in the Active Chat panel.

A new interaction record is created and chat details are displayed on the Details  tab of the 
interaction. For more information, see Virtual Agent interaction records .

Interaction tabs

Tab Description

Details Displays details about the interaction.

Supplier 
Information

Displays information about the supplier.

For more information, see Supplier Information tab.

User's 
Tasks

When a supplier contact communicates with an agent through chat, phone call, 
or SMS, the User’s Task related list shows the agent all of the other tasks that 
have been created for the supplier contact.

Supplier 
cases

Shows all the supplier cases associated with the interaction record.

5. From the Active Chat panel, interact with the contact who initiated the chat through the Public 
Chat  tab or chat with another user for any information related to the current chat queries 
through the Private Chat  tab.
From the Agent Chat panel, do the following:

◦ To chat, enter a message and select the send icon ( ).

◦ To send an attachment, select the send attachment to chat icon ( ), select the file to 
attach, and select Open.

◦ To transfer the chat to another available agent, select the transfer to agent icon ( ) and 
select the agent name.

6. Perform additional tasks by selecting the following UI actions:

UI action Description

Create Supplier 
Case

Creates a new supplier case. For more information, see Create New 
Supplier Case form.

End Chat Ends the current chat session.
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UI action Description

Save Saves any updates you made to the chat information.

More actions icon 

( )

Select Associate Record  to associate an interaction to a supplier case.

Interaction Management in Supplier Lifecycle Operations

Interactions are a centralized location for all communication channels available in Source-to-Pay 
Workspace. Interaction Management involves managing supplier-related queries from different 
sources, such as an email, chat, message, or SMS.

Related topics

View or create an interaction for a supplier

Associate an interaction record to a supplier case

View or create an interaction for a supplier

Typically, an interaction record is automatically created when you accept a chat through the chat 
queue in the Source-to-Pay Workspace. However, you can also manually created an interaction 
from the list page of the Source-to-Pay Workspace. You can link an interaction record to an 
existing supplier case or can assign a task, which needs a supplier manager involvement for 
investigation.

Before you begin
Role required: sn_slm.owner

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) to open the List page.

3. Navigate to All work  > Interactions

4. Select New.

5. On the form, fill in the fields.

Create New Interaction form

Field Description

Number System-generated, unique interaction number.

Type
Type of channel used for communication.

◦ Chat

◦ Messaging

◦ Phone

◦ Video

Assigned to The agent to whom the interaction record is assigned.

Supplier Name of the supplier company the supplier contact belongs to.

Supplier contact Name of the supplier contact who initiated the interaction.

Short description Brief description of the interaction.
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Field Description

Work notes Additional information or comments added to the interaction.

6. Select Save.

Associate an interaction record to a supplier case

Associate an interaction record to a supplier case if your interaction is related to an existing 
supplier case in Source-to-Pay Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Source-to-Pay Workspace..

2. Select the List icon ( ).

3. Navigate to All work  > Interactions

4. In the Number column, select the link to an interaction that you want to associate with a 
supplier case.

5. Select More Actions  and then select Associate record.
The Create New Interaction Related Record form appears in a new tab.

6. In the Supplier case  field, search for and select a supplier case that you want to associate with 
the interaction.

7. Select Save.

Composing emails with predefined content from the Source-to-Pay Workspace

Insert predefined content into the message body of emails that you send from the email client in 
the Source-to-Pay Workspace.

You can use this feature to compose and send emails directly from a supplier case or a supplier 

task. To open the email client, select Compose Email  from the more actions icon ( ) from a 
supplier case or a supplier task. A draft email appears with pre-populated data in the Cc  and 
Subject  fields. The Cc  field is auto-populated with the email address of the contact who opened 
the case. The Subject  field is auto-populated with the case number and issue description.

Using quick messages

In the email client, you can select a quick message to fill the email body with the content that 
is specified in the quick message. After you define one or more quick messages, the Quick 
Messages contextual pane appears in the email client so that you can draft an email with a quick 
message of your choice.

By default, the following quick messages are provided for the following supplier records:

• Supplier case: Standard closure response, case progress, primary contact information, 
Knowledge Base  article information, and additional information.

• Supplier task: Standard closure response, case progress, primary contact information, 
Knowledge Base  article information, and additional information.

Note:  The quick message templates contain placeholder text that you must replace with 
the appropriate text.
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For more information on how to create a quick message, see Define a quick message .

Using response templates

Resolve cases faster and more efficiently with response templates. Response templates are 
reusable messages that can be copied to draft emails to provide quick and consistent messages 
to users.

Open the response template that you want to use for your email and select Copy to clipboard. 
You can now paste the contents of this template at the location of the cursor. It doesn't replace 
the content that you created before selecting the response template. To replace existing content 
with a response template content, highlight the text to replace and then select a response 
template.

For more information on how to work with response templates, see Create or modify a response 
template .

Viewing draft emails

After you save the emails as draft, you can view the draft emails by selecting the Draft Emails  tab 
on the supplier case or supplier task. Alternatively, you can view the draft emails by selecting the 

list icon ( ) and selecting the Case Draft Emails  or Task Draft Emails  sub-modules under the 
Draft Emails  module.

Emailed message in activity log

After your email is composed, sent, and received by the intended recipient, you can see the 
email message in the Activity  section of the supplier case or task. You can continue to work with 
this email from the activity log.

Email composer configuration

To view the Compose Email  option in the More Actions menu, and to view your emailed message 
in the activity log of a supplier case or supplier task in Source-to-Pay Workspace, ensure that 
you add the role required to access this feature in the User Interface Properties page. For more 
information, see Configure access to the compose email feature.

Related topics

Configure access to the compose email feature

Communicate using emails from the Source-to-Pay Workspace

Configure access to the compose email feature

Configure the role required to access the compose email feature that enables you to send emails 
directly from a supplier case or supplier task in the Source-to-Pay Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > UI Properties.

2. In the Roles that can view email in the Activity formatter when including "Sent/Received 
Emails"  property field, enter itil, sn_slm.fulfiller.
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This property contains the itil  role by default. Add the sn_slm.fulfiller  role name 
after the itil  role, separated by a comma.

3. Select Save.

Communicate using emails from the Source-to-Pay Workspace

Compose and send emails directly from a supplier case or a supplier task in the Source-to-Pay 
Workspace.

Before you begin
Ensure that you have configured access to the compose email feature. For more information, see 
Configure access to the compose email feature.

Role required: admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. On the Lists  tab, under the Cases or Tasks module, open a supplier case or a supplier task, 
respectively.

4. Click the more actions icon ( ) and select Compose Email.

5. Do one of the following:

◦ To insert templated content into the email body using quick messages:

a. Click the quick messages icon ( ) and select an appropriate quick message that you 
want to use.

b. Select Insert.

◦ To insert templated content into the email body using response templates:

a. Click the response templates icon ( ) and select an appropriate response template that 
you want to use.

b. Select Copy to clipboard.

c. Paste the content in the email body.

6. Do one of the following:

◦ To send the email instantly, select Send Email.

◦ To save the email as draft to send later, select Save as draft.

Note:  You can view the draft emails by doing one of the following:

◦ Selecting the Draft Emails  tab on the supplier case or supplier task.

◦ Clicking the list icon ( ), selecting the Case Draft Emails list or Task Draft Emails sub-
modules under the Draft Emails module, and opening a draft email.

Overall supplier dashboard

The Overall supplier dashboard provides a comprehensive view of the entire supplier base's 
performance in one centralized location, aggregating data across all suppliers to give you 
enterprise-wide insights.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1077



Important:  Check your entitlements to determine whether you have access to the 
Overall supplier dashboard. This feature is available from the Yokohama December 2025 
release onwards.

The Overall supplier dashboard offers the following key benefits:

• Holistic view: View how the entire supplier base is performing at a glance rather than checking 
individual supplier dashboards.

• Strategic filtering: Filter by relationship status (Strategic, Tactical, Valued, Excluded), supplier, 
or industry to focus on specific supplier segments.

• Actionable insights: Identify top and bottom performers, track KPI trends, and monitor action 
plans across your supplier network.

• Performance tracking: Monitor overall supplier scores, risk levels, and spending patterns.

Using the dashboard for decision-making

To improve supplier performance:

• Identify patterns in failing KPIs and create targeted improvement initiatives.

• Focus resources on industries or relationship tiers that show consistent struggles.

• Compare top performers against bottom performers to understand success factors.

To manage risk:

• Monitor overall supplier risk ratings when applying different filters.

• Check if strategic suppliers have higher or lower risk profiles than tactical ones.

• Review action plans for suppliers with elevated risk levels.

Related topics

View Overall supplier dashboard

View Overall supplier dashboard

You can view the Overall supplier dashboard to get the enterprise-wide insights for the entire 
suppliers base.

Before you begin
Role required: admin, sn_slm.supplier_manager

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the Overall supplier dashboard ( ) icon.
The Overall supplier dashboard with the Overview and Action plan sections is displayed.
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Overall supplier dashboard - Overview

Overview - Performance metrics  (displays information based on filters)

◦ Overall supplier score: Average of the scores of all the suppliers

◦ Number of active suppliers: Count of all active suppliers

◦ All time spend: Total amount spent from the purchase order table for active orders

◦ Overall supplier risk: Average of the risk ratings of all the suppliers

Overview - Supplier insights

◦ Supplier turnover year-to-date: Count of on-boarded and off-boarded suppliers in the current 
year

◦ KPI performance by status: Pie chart based on the choice of performance from the KPI table

◦ Five most common supplier KPIs: List of the most used KPIs by the suppliers

◦ Top five performing suppliers: List of the suppliers with the highest KPIs scores

◦ Top five industries by number of suppliers: Chart of the industries with the highest number of 
suppliers
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Overall supplier dashboard - Action plans

Action plans

◦ Active action plans: Chart showing active action plans grouped by plan type

◦ Five most common KPIs in action plans: Chart showing most common KPIs with active action 
plans

◦ Lowest five performing suppliers: List of the suppliers with the lowest KPIs scores

◦ Top five industries with suppliers in action plans: Chart showing industries with the 
maximum number of suppliers having active action plans

Related topics

Overall supplier dashboard

Create supplier case from Universal Request

Routing agents can create a supplier case from the Source-to-Pay Workspace  to resolve a 
Universal Request.

Before you begin
Role required: sn_uni_req.routing_agent, and sn_slm.agent

You must have the following plugin installed: Universal Request for Source-to-Pay Operations 
Plugin [sn_fsc_ur_common].

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay workspace.

2. Select the list icon.
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3. Navigate to Universal request  All.

4. Select the Universal Request.

5. Select Create supplier case.

6. In the Create New Supplier Case form, fill in the details.

The universal request number from which the supplier case is created appears in the 
Universal Request  field on the supplier case form.

7. Select Save.

8. Optional:  To request assistance from other departments in resolving the Universal Request 
simultaneously, select Create Associated Ticket.
For more information on creating associated tickets, see Create associated ticket for primary 
ticket of UR .

Result
The supplier case number appears in the Primary Ticket  field of the Universal Request  record. It 
also appears in the Associated Tickets  list of the Universal Request  record.

Emails view for supplier managers

Supplier managers can access all emails including system-triggered emails, inbound replies, and 
error emails from the Source-to-Pay Workspace  at case, task, and supplier levels.

Important:  This feature is available from the March 26 Yokohama  release onwards.

Supplier managers can access all emails linked with a case, task, or supplier from the Emails  tab 
in the case, task, and supplier details pages respectively. Email actions are reflected, incomplete 
email errors are handled, and email-related activities can be summarized from the workspace.

Email sources

• System-triggered outbound notification emails (for task creation)

• Inbound replies from supplier contacts (for example, task completion email)

• Inbound replies from internal stakeholders (for example, task completion email)

• Error handling emails

Email notification to supplier stakeholders for tasks

When a task is created and assigned, the system automatically triggers an notification email to 
the assigned stakeholder.

• When the task is assigned to a supplier contact, the email provides the receiver with 
two options: complete the task directly from the email, or view the task in the Supplier 
Collaboration Portal.

• When the task is assigned to an internal stakeholder, the email provides the receiver with 
two options: complete the task directly from the email, or view the task in the Source-to-Pay 
Workspace.

Note:  If the email subject or reference ID is modified while marking the task as complete 
via email, the system detects the mismatch and sends an automated error notification 
emails.
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Email summarization for tasks and cases

An AI summary of all emails linked to a task or case can be generated using the Summarize 
button on the Emails  page.

The following sections are displayed:

• Summary: Includes number of emails, key theme, tone, and actions required.

• Next steps: Includes list of tasks, outstanding questions or escalations, and further updates.

To enable email summarization, set the default model for the One Extend capabilities.

1. Navigate to Sys_One_Extend_Capability.

2. Open the Summarize  record.

3. In the OneExtend Definition Configs  related list, verify that at least one model is marked as 
Default  to True.

Note:  Email summarization is not available for supplier records.

Using Supplier Collaboration Portal

As a supplier contact, you can self-register to the Supplier Collaboration Portal, complete your 
assigned tasks, and raise requests using the supplier catalog.

Important: 

• The list of suppliers under My Company  is available from the Xanadu  December 2024 
release onwards.

• If M2M mapping between supplier contact and suppliers is enabled, you can select the 
supplier from the My Company  drop-down list of suppliers.

Related topics

Invite a member to access the Supplier Collaboration Portal

Supplier contact self-registration

Managing supplier contacts from the Supplier Collaboration Portal

Raising requests from the Supplier Collaboration Portal

Viewing supplier contact tasks from the Supplier Collaboration Portal

Invite a member to access the Supplier Collaboration Portal

Invite supplier contacts to access the Supplier Collaboration Portal  so that they can raise 
requests and start working on their assigned tasks.

Before you begin
Before performing this task, ensure that you do the following:

• Configure self-registration for external users. For more information, see Configure self-
registration for external users.

• Map the external user registration configuration to the Supplier Collaboration Portal. For more 
information, see Map the self-registration configuration to Supplier Collaboration Portal.

• Configure the sn_supplier.external_registration_profile_id  system property to ensure that 
registration emails are sent to external users. For more information, see Configure system 
property to send registration emails to external users.

Role required: sn_slm.contact
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About this task
The Invite  option in the Contacts widget is available only to the primary supplier contact and 
the supplier administrator. Only the primary supplier contact and the supplier administrator can 
invite new members to access the Supplier Collaboration Portal.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the My contacts widget, select Invite.
The Invite contacts dialog box is displayed.

3. In the Contact emails  field, enter the email address of the contact that you want to invite.

You can invite more than one contact by entering multiple email addresses separated by a 
comma.

4. Select Add.

5. From the Role  list next to each email address, select one of the following options:

◦ Contact: Manages assigned files

◦ Primary: Manages all contacts and files

6. Select Send invites.
A registration email is sent to the email addresses.

What to do next
The invited member receives an email with the registration link to the Supplier Collaboration 
Portal. For more information, see Register to the Supplier Collaboration Portal as an invited 
member.

Note: 

After Xanadu  December 2024 release, you can also invite contacts from other email 
domains, provided they are part of the hierarchy.

Register to the Supplier Collaboration Portal  as an invited member

As an invited member, you can register and get access to the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact

About this task
After a supplier contact invites you as a member, you receive an email with the registration link to 
the Supplier Collaboration Portal.

Procedure

1. Select the registration link in the email.

2. On the Supplier Self Registration form, fill in the fields.

Note: 

◦ First name, Last name, Email, and Supplier name are the required fields.

◦ The Supplier name  and Relationship contact email  fields have been added after the 
Xanadu  December 2024 upgrade.
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3. Select the option to agree to the privacy policy and terms and conditions.

4. Select Sign Up.

A verification email is sent to the email address that you provided.

5. Select the link in the email to verify your email address.

After you verify your email address, you see this message: Our team is verifying 
your details. You should receive a confirmation within a few 
days.

After your details have been verified, the supplier manager approves the self-registration 
request and you receive a welcome email.

Note:  If the supplier manager invites a contact, then no approval is required for the new 
user registration case.

6. In the welcome email, select Re-set Password  to reset your password.

Result
Your registration is complete. You can now log in to the Supplier Collaboration Portal.

Supplier contact self-registration

Supplier contacts can self-register to the Supplier Collaboration Portal  and start working on the 
assigned tasks.

Supplier contact self-registration process

The process of self-registering to the Supplier Collaboration Portal  involves a series of tasks that 
the supplier contact must complete.

Workflow of the self-registration process

The following figure shows the workflow of the supplier contact self-registration process.
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In this workflow:

1. The supplier contact starts the self-registration process by selecting Register  on the Supplier 
Collaboration Portal home page. For more information, see Self-register to the Supplier 
Collaboration Portal.

2. A verification email is sent to the email address provided when registering.

3. The supplier contact verifies the email address.

4. An approval request is created for the self-registration supplier case.

5. The supplier manager approves the self-registration request. For more information, see 
Approve a request associated with the Enroll a new supplier user case type from the Source-
to-Pay Workspace.

6. The supplier contact receives an email to reset the password.

7. The supplier contact resets the password and logs in to the Supplier Collaboration Portal.

Related topics

Approve a request associated with the Enroll a new supplier user case type from the Source-
to-Pay Workspace

Approve a request associated with the Enroll a new supplier user case type from the Source-
to-Pay Workspace

As a supplier manager, you can approve or reject the assigned approve requests.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, sn_slm.fulfiller, or sn_slm.admin

Note:  The sn_slm.owner role can approve requests only for the suppliers they own.
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Open a supplier case.

3. Select the Approvals  tab.

4. In the State column, select the link to the state of the request for the supplier case.
Typically, the request requiring an approval is in the Requested  state.

5. From the State drop-down list, select Approved.

The following states are available:

◦ Not Yet Requested

◦ Requested

◦ Approved

◦ Rejected

◦ Cancelled

◦ No Longer Required

6. Select Save.

Self-register to the Supplier Collaboration Portal

Supplier contacts can self-register themselves to the Supplier Collaboration Portal  without the 
help of an administrator.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select Register.

3. On the Account sign up form, fill in the fields.

First name, Last name, Email, and Supplier name are required fields.

Note:  The Supplier name  field has been added in the Xanadu  December 2024 
upgrade. This field is available only after M2M mapping between supplier contact and 
suppliers  is enabled.

4. Select the option to agree to the privacy policy and terms and conditions.

5. Select Sign Up.

A verification email is sent to the email address that you provided.

6. To verify your email address, select the Verify Account  link in the email.

After you verify your email address, you see this message: Our team is verifying 
your details. You should receive a confirmation within a few 
days.
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After your details have been verified, the supplier manager must approve the self-registration 
request.

After the supplier manager approves the self-registration request, you receive a welcome 
email.

Note:  If the supplier manager invites a contact, then no approval is required for the new 
user registration case.

7. In the welcome email, select Set a new password  to set a new password for your account.

Result
Your self-registration is complete. You can now log in to the Supplier Collaboration Portal.

Managing supplier contacts from the Supplier Collaboration Portal

Manage and remove contacts, update the contact's email address, elevate access or remove 
elevated access to contacts from the portal.

Related topics

Elevate a contact to the primary contact role from the Supplier Collaboration Portal

Restrict the primary contact role for a contact from the Supplier Collaboration Portal

Reassign tasks to a different contact from the Supplier Collaboration Portal

Update the supplier contact email from the Supplier Collaboration Portal

Remove a supplier contact from the Supplier Collaboration Portal

Elevate a contact to the primary contact role from the Supplier Collaboration Portal

Elevate a contact to the primary contact role to enable them to access and manage all the 
contacts and tasks in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

About this task
The Elevate access  option is available only to the primary supplier contact and the supplier 
administrator.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the Contacts widget, select a contact to open the contact's profile page.

3. Select Elevate access.
The Elevate access dialog box is displayed.

4. In the Comments  field, enter the reason why you want to make this contact the primary 
contact.

5. Select Submit.
The Primary contact column is set to true  for this contact on the Vendor Contacts page, and 
the contact is elevated to the primary contact role.
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Restrict the primary contact role for a contact from the Supplier Collaboration Portal

Restrict the primary contact role for a contact to prevent them from accessing all the contacts 
and tasks in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

About this task
The Restrict access  option is available only to the primary supplier contact and the supplier 
administrator.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the Contacts widget, select a contact to open the contact's profile page.

3. Select Restrict access.
The Restrict access dialog box is displayed.

4. In the Comments  field, enter the reason why you want to restrict the primary contact role for 
this contact.

5. Select Submit.
The Primary contact column is set to false  for this contact on the Vendor Contacts page, and 
the contact no longer has the primary contact role.

Reassign tasks to a different contact from the Supplier Collaboration Portal

Reassign a task to a different contact in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

About this task
The Reassign  option is available only to the primary supplier contact and the supplier 
administrator.

The Reassign  option is displayed only for the following task types:

• View Link

• Play Video

• Catalog Item

• Checklist

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Do one of the following.
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To Do this

Open a task from the portal header

a. Select one of the following:

▪ My Tasks

The My To-dos page is displayed.

▪ All Tasks

The Supplier Task List is displayed.

b. Select the task that you want to reassign to 
a different contact.

Open a task from the My active items wid­
get

Select the Tasks tile, which opens the The My 
To-dos page.

Open a task from the My tasks widget
Select the task that you want to reassign to a 
different contact.

3. Select Reassign.

4. In the Assign to  field, search for and select the contact that you want to reassign this task to.

5. Select Submit.
The task is reassigned to the selected contact.

Update the supplier contact email from the Supplier Collaboration Portal

Update the email address of the contacts to ensure that they don't miss any email notifications.

Before you begin
Role required: sn_slm.contact

About this task
The Update email  option is available only to the primary supplier contact and the supplier 
administrator.

Note:  Ensure that the email domain of the supplier already exists in the 
sn_supplier_email_domain table.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the Contacts widget, select a contact to open the contact's profile page.

3. Select Update email.

4. In the Email  field, enter or update the email address of the contact.

5. Select Submit.

Remove a supplier contact from the Supplier Collaboration Portal

Remove a supplier contact that you no longer require from the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact or sn_slm.admin
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Procedure

To remove a supplier contact from the Supplier Collaboration Portal, do one of the following:

To Do this

Remove a supplier from the My 
contacts widget.

Perform the steps described in Remove a supplier contact 
from the My contacts widget.

Remove a supplier contact using 
the supplier catalog.

Perform the steps described in Remove a supplier contact 
using the supplier catalog.

Remove a supplier contact from the My contacts widget

Remove a supplier contact that you no longer require.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

About this task
The Remove Contact  option is available only to the primary supplier contact and the supplier 
administrator.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

Note:  If many-to-many (M2M) mapping between supplier contact and suppliers is 
enabled, you can see the list of all contacts associated with companies where you’re 
designated as the primary contact.

2. In the My contacts widget, do one of the following:

◦ Select a contact to open the contact's profile page, and then select Remove Contact.

◦ Select the cross icon ( ) next to the name of the contact that you want to remove.
The Remove Contact dialog box is displayed.

3. Select the supplier from the Supplier  drop-down list.

Note:  The Supplier  drop-down list is available after the Xanadu  December 2024 
release.

4. In the Delegate tasks to  field, search for and select a contact to whom you want to reassign the 
tasks that are currently assigned to the contact being removed.

5. In the Comments  field, enter the reason for removing the contact.

6. Select Remove.
The contact is removed and all the tasks that were assigned to that contact are reassigned to 
the alternate contact.

Raising requests from the Supplier Collaboration Portal

You can raise requests using the supplier catalog by selecting Raise a request  in the Supplier 
Collaboration Portal  header.

https://player.vimeo.com/video/1073916598?
h=7b4717fbe3&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Important: 

• The list of suppliers under My Company  is available from the Xanadu  December 2024 
release onwards.

• If M2M mapping between supplier contact and suppliers is enabled, you can select the 
supplier from the My Company  drop-down list of suppliers.

The following catalog items are available in the supplier catalog:

• Add or remove location

• Enroll a supplier contact

• Remove a supplier contact

• Ask a question

• Submit an idea

• Submit an issue

• Update banking details

• Update profile details

• Update default supplier (from Xanadu  December 2024 release onwards)

• Something else

Add or remove a supplier location using the supplier catalog

Submit a request to add a new supplier location or remove an existing one to keep the supplier 
information up to date.

Before you begin
Role required: sn_slm.contact

About this task

• If a supplier has multiple locations, at least one location should be set as headquarters.

• If a new supplier location is set as headquarters (HQ) or if any updates are made to the existing 
HQ supplier location, the location details of the HQ supplier location are updated in the 
supplier record.

• When you update the supplier location details in a supplier record, the location details are 
updated in the supplier location record as well.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Under the General category, select the Update location details  catalog item.
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The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. In the Add new or remove drop-down list, select one of the following:

◦ Add location

◦ Remove location

6. In the Select a location  search field, search for and select a supplier location.

Note:  You cannot remove a location whose category is set to Headquarters.

7. From the Category  drop-down list, select a category for the supplier location.

◦ Contracting address

◦ Delivery address

◦ Facility (default)

◦ Headquarters

◦ Invoice address

◦ Service center

You can select multiple values from the drop-down list.

8. If you do not find the required supplier location in the Search a location  search field, select the 
Add new  check box.

9. On the Supplier Location form, fill in the fields.
For a description of the field values, see Add New Location form.

10. Select Submit.
The application creates a case and assigns it to the supplier manager for review and approval.

After the supplier manager approves the case, the supplier record is updated accordingly.

Add a supplier contact using the supplier catalog

Add the supplier contacts so that they can access the Supplier Collaboration Portal  and start 
working on the assigned tasks.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

Only primary contacts can enroll a new user from the supplier catalog.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.
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4. Under the General category, select the Enroll a new user  catalog item.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. Select Add.
The Add Row dialog box is displayed.

6. In the Email  field, enter the email address of the contact.

7. From the Primary contact list, select one of the following:

◦ Yes: Select this option to specify that the contact you’re adding is a primary contact.

◦ No: Select this option to specify that the contact you’re adding is not a primary contact.

8. Select Add.

9. Repeat steps 4 through 8 to add additional contacts in multiple rows.

10. Optional:  To remove all the added rows for contacts, select Remove All.
A confirmation message is displayed.

11. Optional:  Select Remove.
All the supplier contact rows are removed.

12. Select Submit.
The application creates a case of type Enroll new supplier user and assigns it to the supplier 
manager to take the appropriate action.

Remove a supplier contact using the supplier catalog

Remove a supplier contact that you no longer require.

Before you begin
Role required: sn_slm.contact or sn_slm.admin

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Under the General category, select the Deactivate user account  catalog item.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. In the Contact  field, search for and select the contact you want to remove.

6. In the Delegate tasks to  field, search for and select a contact to whom you want to reassign the 
tasks that are currently assigned to the contact being removed.

7. In the Reason for offboarding  field, enter the reason for removing the contact.

8. Select Submit.
The application creates a case of type Offboard supplier contact and assigns it to the supplier 
manager to take the appropriate action.
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Ask a question using the supplier catalog

Submit a question that you need an answer for.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Under the General category, select the Ask a question  catalog item.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. In the Question  field, enter the question that you need an answer for.

6. To add attachments, such as documents and image files, to the request, select the add 

attachments icon ( ).

7. Select Submit.
The application creates a case of type General inquiry and assigns it to the supplier manager 
to take the appropriate action.

Submit an idea using the supplier catalog

Submit an idea you would like to share.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Select the Submit an idea  catalog item under the General category.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. In the Description  field, describe the idea you want to share.
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6. Select the Add attachments icon ( ) to add attachments, such as documents and image files, 
to the request.

7. Select Submit.
The application creates a case and assigns it to the supplier manager to take appropriate 
action.

Submit an issue using the supplier catalog

Submit an issue that you need help with.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Under the General category, select the Submit or report an issue  catalog item.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. In the Urgency drop-down list, select one of the following:

◦ High

◦ Medium

◦ Low

6. In the Description  field, describe the issue that you need help with.

7. To add attachments, such as documents and image files, to the request, select the add 

attachments icon ( ).

8. Select Submit.
The application creates a case and assigns it to the supplier manager to take the appropriate 
action.

Update banking details using the supplier catalog

Keep the banking information up to date to ensure timely payments without any delays.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.
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2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Select the Update banking details  catalog item under the General category.
The Supplier  field is auto-populated with the supplier you have currently selected. This field is 
available from the Xanadu  December 2024 release onwards.

5. On the Update banking details form, fill in the fields.
For more information about the form fields and descriptions, see Update banking details form.

6. Select Submit.
The application creates a case and assigns it to the supplier manager for review and approval.

After the supplier manager approves the case, the banking details are updated in the supplier 
record.

Update company profile using the supplier catalog

Update the company profile when the details about your company change.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. Do one of the following:

◦ In the portal header, select Raise a request, and then select the Update profile details 
catalog item under the General category.

◦ In the portal header, select My Company, and then select Request Change  on the Company 
Profile page.

4. On the Update profile details form, fill in the fields.
For more information about the form fields and descriptions, see Update profile details form.

5. Select Submit.
The application creates a case and assigns it to the supplier manager for review and approval.

After the Supplier Manager approves the case, the company profile details are updated in the 
supplier record.
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Request elevated access

Submit a request to gain access to the privileges of the primary contact role.

Before you begin
Role required: sn_slm.contact

About this task
The Request elevated access catalog item is available only to the secondary contact role. A 
secondary contact is a user that has the Primary contact column set to false  on the Vendor 
Contacts page.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Select the Request an access change request  catalog item under the General category.

5. In the Supplier  field, search for and select the supplier.

The Supplier  field is auto-populated with the supplier name, but you can change its value, if 
required.

6. From the Urgency drop-down list, specify how soon you want the request to completed.

◦ High

◦ Medium

◦ Low

7. In the Reason for requesting elevation  field, enter the reason for making this request.

8. Select the add attachments icon ( ) to add attachments, such as documents and image files, 
to the request.

9. Select Submit.

If more than one primary contact exists for a supplier, then approval tasks are created and 
assigned to all the primary contacts. When any one of the primary contacts approves or rejects 
the approval task from the My To-dos page, the approval tasks assigned to the other primary 
contacts are automatically canceled.

The secondary contact receives an email notification, regardless of whether the request is 
approved or rejected.

After the primary contact approves the request, the secondary contact role is elevated to that 
of the primary contact.

Update default supplier

Update the default supplier when multiple suppliers are linked with your profile.
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Before you begin
Role required: sn_slm.contact

Important:  This catalog request item is available from the Xanadu  December 2024 
release onwards, only after M2M mapping between supplier contact and suppliers  is 
enabled and more than one suppliers are linked with your profile.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select Raise a request.

3. Select the Update default supplier  catalog item under the General 

category.

4. Select the supplier from the Default supplier  drop-down list.

5. Select Submit.

Request something else using the supplier catalog

Request something else if the available catalog items in the supplier catalog do not meet your 
needs.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the supplier from the My Company  drop-down list of suppliers associated with your 
profile.

Important:  The list of suppliers under My Company  is available from the Xanadu 
December 2024 release onwards, only if M2M mapping between supplier contact and 
suppliers  is enabled.

3. In the portal header, select Raise a request.

4. Under the General category, select the General inquiry  catalog item.

The Supplier  field is auto-populated with the supplier name, but you can change its value, if 
required.
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5. From the Urgency  drop-down list, select one of the following:

◦ High

◦ Medium

◦ Low

6. In the Requested for  field, enter the name of the person or organization that this request is for.

7. In the What can we help you with?  field, enter the details explaining what you need help with.

8. Select Add Attachments  to upload any relevant images or documents.

9. Select Submit.
The application creates a case and assigns it to the supplier manager for review and approval.

After the supplier manager approves the case, the supplier record is updated accordingly.

Viewing supplier contact tasks from the Supplier Collaboration Portal

View the tasks that are assigned to you and other supplier contacts.

Tasks are of the following types:

• Mark Complete: Mark the task as complete.

• View Link: Open a link to complete the task.

• Play Video: Play a video to complete the task.

• E-Signature: Sign documents electronically to complete to task.

• Catalog Item: Submit a catalog item to complete the task.

• Survey: Take a survey to complete this task.

• Checklist: Complete a checklist to complete the task.

• Upload Document: Upload a document to complete the task.

Viewing your tasks

The My To-dos page lists all the tasks that are assigned to the logged-in user.

To open the My To-dos page, do one of the following on the Supplier Collaboration Portal  home 
page:

• In the Supplier Collaboration Portal  header, select My Tasks.

• (If you are a primary contact) In the Supplier Collaboration Portal  header, select Tasks  and 
then select My Tasks.

• In the My active items widget, select Tasks.
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My To-dos page

The My To-dos page has the following tabs:

• Open:  Lists all the to-dos that are open.

• Completed:  Lists all the to-dos that have been completed.

Selecting a to-do displays the following tabs in the To-dos summary section:

• Details:  Displays details of the selected task.

Note:  The information displayed on this tab varies depending on the task type.

• Activity:  Displays a chronological record of the updates made to the to-do since it was 
created. To add your comments to the activity stream, select Post. Click the Add attachments 

icon ( ) to add attachments, such as documents and image files, to the to-do.

Viewing all the tasks

The Supplier Task List page displays both the tasks assigned to you and the tasks assigned to 
other contacts.

To open the Supplier Task List page, in the Supplier Collaboration Portal  header, select Tasks 
and then select All Tasks.

Note:  The All Tasks  option is available only to the primary supplier contact and the 
supplier administrator.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1100



Supplier Task List page

On the Supplier Task List page, you can do one of the following:

• In the View  drop-down list, select one of the following:

◦ Open tasks: Displays the tasks that are open.

◦ Closed tasks: Displays the tasks that have been closed.

• Search for a task in the search field.

On the Supplier Task List page, select the link to a task to view details about that task.

Related topics

Approve or reject a task

Raising requests from the Supplier Collaboration Portal

Approve or reject a task

Review the tasks that are assigned to you and approve or reject them.

Before you begin
Role required: sn_slm.contact or admin

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1101



2. In the portal header, select My Tasks.

The My To-dos page is displayed.

3. On the Open  tab, select a task.

4. In the Do you want to approve the following:  field, enter your comments and select Approve 
or Reject.

View or update your user profile from the Supplier Collaboration Portal

Update your personal profile in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact

About this task
Keep your personal information accurate and up to date so that a supplier manager can 
communicate with you via phone or email.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select your user name, and then select Profile.

3. To add a picture to your profile, select Upload Picture  and select an image.

4. To update the personal information in your profile, including company, location, email address, 
and contact information:

a. Select the field that you want to update.

b. Enter the information in the pop-up window.

c. Select Save.

5. Turn on the Accessibility enabled  toggle switch to enable accessibility.

6. From the Time zone drop-down list, select a time zone.

7. Select Refresh to see changes.

View all your requests from the Supplier Collaboration Portal

View all the requests that you've raised, to whom they are assigned, and their status.

Before you begin
Role required: sn_slm.contact

About this task
The My Requests page displays all the requests that you've raised. For more information about 
raising requests, see Raising requests from the Supplier Collaboration Portal.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Do one of the following:
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◦ In the portal header, select My Requests.

◦ In the My active items widget, select Requests.
The My Requests page is displayed.

Note:  You can see all requests from all the suppliers linked with your profile if M2M 
mapping between supplier contact and suppliers is enabled (available from Xanadu 
December 2024 release onwards).

3. Do one of the following:

◦ In the View drop-down list, select one of the following:

▪ Open requests: Displays the requests that are open.

▪ Closed requests: Displays the requests that have been closed.

◦ Search for a request in the search field.

4. To view details about that request, select the link to a request under the Request column.
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The Supplier Ticker page shows details about the request, such as request title, name of the 
person who opened the request, name of the person to whom the request is assigned, and a 
case progress bar.

Note:  Any request that you raise automatically creates a case.

The Case progress bar shows any of the following stages depending on the status of the case.

◦ Open: The case is open.

◦ Work in Progress: The case is in progress.

◦ Resolved: The case has been resolved.

5. To work on the request, select any of the following tabs:

◦ Case details: View the details about the case.

◦ Activity: Enter your comment in the text field and select Post.

You can add comments to communicate with the supplier manager to request clarifications 
or ask questions related to the request.

◦ Attachments: Select the add attachments icon ( ) to attach documents or images to the 
case.

◦ Task: Do one of the following:

▪ In the Assigned to drop-down list, select one of the following:

▪ All: Displays all the requests.

▪ Assigned to me: Displays only the requests that are assigned to you.

▪ In the State drop-down list, select one of the following:
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▪ Open: Displays the requests that are open.

▪ Closed: Displays the requests that have been closed.

View supplier locations from the Supplier Collaboration Portal

As a supplier contact, view the locations of a supplier in the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select the supplier from the My Company  drop-down list of suppliers 
associated with your profile.

Important: 

◦ The list of suppliers under My Company  is available from the Xanadu  December 2024 
release onwards.

◦ If M2M mapping between supplier contact and suppliers is enabled, you can select the 
supplier from the My Company  drop-down list of suppliers.

3. Navigate to the Locations  section on the Company Profile page.
The Locations section displays the details about your locations.

4. Do one of the following:

◦ Select the link to a supplier to view the location details of that supplier.

◦ To view a list of all of your supplier location details on the Supplier Locations page, select 
View all.

Note: 

You can also see location details from company page through My Company  widget.

View supplier payment information from the Supplier Collaboration Portal

As a supplier contact, view the payment information of a supplier in the Supplier Collaboration 
Portal.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select the supplier from the My Company  drop-down list of suppliers 
associated with your profile.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1105



Important: 

◦ The list of suppliers under My Company  is available from the Xanadu  December 2024 
release onwards.

◦ If M2M mapping between supplier contact and suppliers is enabled, you can select the 
supplier from the My Company  drop-down list of suppliers.

3. Navigate to the Payment Information  section on the Company Profile page.
The Payment Information section displays the details about your banks.

4. Do one of the following:

◦ Select the link to a bank name to view its details.

◦ To view a list of all of your payment information on the Payment Information page, select 
View all.

Start a chat session from the Supplier Collaboration Portal

As a supplier contact, you can start a chat session from the Supplier Collaboration Portal  and 
interact with supplier fulfillers.

Before you begin
Role required: sn_slm.contact

About this task
By starting a chat session, supplier contacts can interact directly with supplier fulfillers and get 
immediate responses to their queries or issues.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Select the Open chat window icon ( ) to start a chat session.

3. Select Show me everything, and then select Live Agent Support.
The "Routing you to a live agent…" message is displayed.

The maximum wait time to connect with a live agent is 2 minutes.

After a live agent accepts your chat request, the "Agent has joined" message is displayed in 
the chat window.

4. To chat with the live agent, enter a message and select the send icon ( ).

5. To end the chat session, select the end chat icon ( ).

Manage documents from the Supplier Collaboration Portal

Manage documents by uploading, updating and downloading the required documents from the 
Supplier Collaboration Portal.

Before you begin
Ensure that you have created a supplier document configuration. For more information, see 
Supplier Document Management.

Role required: sn_slm.contact or sn_slm.admin
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Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. You can upload, and download documents using one of the following methods.

Action Description

Upload or download a document from the 
My Company page

Upload documents from the My Company 
page. For more information, see Manage doc­
uments from My Company page.

Upload documents from the My Tasks page

Upload documents from the My Tasks page to 
complete tasks assigned by the supplier rela­
tionship manager. For more information, see 
Upload document from My Tasks page.

Upload, download, manage permissions, 
from the Documents tab

This tab lets you manage documents without 
needing a supplier manager to initiate the 
process first.For more information, see Man­
age documents from Documents tab.

Related topics

Raising requests from the Supplier Collaboration Portal

View all your requests from the Supplier Collaboration Portal

Manage documents from Documents tab

The Documents tab lets supplier contacts upload and manage documents without needing a 
supplier manager to initiate the process first. Supplier contacts can also manage document 
permissions from the Documents tab.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select the Documents  tab.

3. You can upload, download, maintain versions, and manage permissions for documents as 
follows.

To do Do this

Create a new document
Use this option to upload documents without 
needing a supplier manager to initiate the 
process first.

a. Select Create Document.

b. Fill in the document details, such as the 
owner, document classification, and 
document type.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1107



To do Do this

c. Upload your document in the Attachments 
section.

d. Select Save.

Upload a new version Use this option when you want to upload a 
new version of an existing document:

a. Select a document from the list.

b. Go to the Version history  tab.

c. Select Add version.

d. Upload the new version.

e. Select Submit.

Manage document permissions
Use this option to manage read and write 
permissions for a document.

a. Select the document.

b. Go to the Permissions  tab.

c. Provide read or write access to supplier 
contacts, as required.

Note:  The document owner 
and primary supplier contact are 
automatically granted read and write 
access. Secondary contacts are 
granted read access by default.

Download a document
Download the latest or specific version of a 
document.

a. Select a document.

b. To download the latest version, select 
Download latest attachment.

c. To download a previous version, go to the 
Version history  tab.
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To do Do this

i. Select the document version from the 
version history.

ii. Select the download icon.

Upload document from My Tasks page

Complete the document upload tasks assigned to you from the My tasks page on the Supplier 
Collaboration Portal.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select My Tasks.

3. Go to the Open  tab.

4. Select a document upload task.

5. In the Attachments section, upload your document.
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6. Select Submit.

Manage documents from My Company page

You can upload, update, and download documents and document templates from the document 
widget on the My Company page.

Before you begin
Role required: sn_slm.contact

About this task
Access to the Documents widget on the My Company page is controlled by the user criteria 
admins set on the Manage access tab when creating the supplier document configuration. For 
more information, see Create a supplier document configuration.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the portal header, select My Company.

3. Select the supplier from the list of suppliers, if applicable.

4. Go to the Documents widget.
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You can now upload, download, maintain versions, and manage permissions for documents as 

follows.

To do Do this

Upload a document
To upload a document:

a. Select the document that you want to 
upload.

b. Select Upload.

c. Upload your document in the Attachments 
section.

d. Click Submit

Download the document template The document template specifies the 
expected format of the document that you 
must upload. To download the document 
template:

a. Select the document.

b. Select Get template.

Update an already uploaded document
To update an existing document:

a. Select the document.

b. Select the three vertical dots icon ( ) on 
the selected document tile and then select 
Update.

c. Upload the updated document in the 
Attachments section.

Download a document
To download a document:
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To do Do this

a. Select the document.

b. Select the three vertical dots icon ( ) on 
the selected document tile.

c. Select Download.

Complete a risk assessment from the Supplier Collaboration Portal

As a supplier contact, you can view and complete your assigned risk assessments to help the 
supplier manager in evaluating a supplier before onboarding them.

Before you begin
Role required: sn_slm.contact

About this task
View and complete risk assessment records that a supplier manager creates when onboarding a 
new supplier or reassessing an existing engagement with a supplier.

The Risk Assessments  tab shows assessments only if you've installed the Third-party Risk 
Management  [com.sn_vdr_risk_asmt] plugin.

Procedure

1. Go to the Supplier Collaboration Portal  portal page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. In the My active items widget, select Risk Assessments.
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3. The Assessment Summary page opens displaying a list of both Supplier (third-party) and 
Engagement risk assessments records.

Note:  Supplier Lifecycle Operations  integrates with Third-party Risk Management  to 
enable you to quickly view and work on all the assigned risk assessments.

The Assessment Summary page contains the Open  and Closed  tabs. Select each tab to view 
the open and closed assessments.

The Assessment Summary page has these columns.

◦ Primary Contacts: Primary contacts responsible for completing the assessments.

◦ Assessments: The count of assessments for a supplier or an engagement.

◦ Issues: The count of issues for a supplier or an engagement.

◦ Tasks: The count of tasks for a supplier or an engagement.

4. Under the Supplier column or the Engagement column, select the link to view more details.

For example, under Engagement, select Adobe Purchasing, and then under the Assessment 
column, select the link to an assessment to view more details. For example, select Purchasing 
risk evaluation.
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The assessment details page has these columns.

◦ Assessment: List of risk assessments.

◦ Entity: The assessed supplier.

◦ Status: Status of the assessment.

◦ Questionnaires: Number of questionnaires completed.

◦ Document requests: Number of document requests completed.

◦ Issues: Number of issues closed.

◦ Due by: The date by which the assessment should be completed.

5. Under the Request column, select the link to a request to view more details.

For example, select 

Business.

You can do the following:

◦ Navigate through the various sections and enter the required information.

◦ Under Import, you can import an already completed questionnaire in XML format by 
selecting Import.

◦ The questionnaire is displayed on the Questionnaire  tab. Select the Notes and Comments 
tab to enter any notes and comments.
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6. To exit the questionnaire, select Exit  or to save your responses, select Save as Draft.

After you exit or save the questionnaire, you return to the details page of the assessment that 
the request is associated with. In this example, you return to the Purchasing risk evaluation 
page.

7. Select Submit assessment.

Create a Universal Request from the Supplier Collaboration Portal

Create a Universal Request to raise issues that do not fit into predefined case types or involve 
multiple departments.

Before you begin
Role required: sn_slm.contact

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier  suffix.
For example, https://example.com/supplier.

2. In the search bar, enter your search query.

3. Navigate to the Contact us for help section.
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4. Select the Request help  option. 

5. In the Request Help form, fill in the request details.
The Supplier  field is populated automatically and is not editable.

6. Optional:  Select the Issue contains sensitive or confidential information  check box.

a. From the Select department for your issue drop-down, select a department related to your 
issue.

7. Select 

Submit.
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Result
A Universal Request is created based on the details provided in the Request Help form. For more 
information on the workflow, see Universal Request.

Using Supplier Relationship and Performance Management

Use Supplier Relationship and Performance Management for monitoring and managing supplier 
performance.

Run segmentation rule

Run a segmentation rule to create and activate KPIs corresponding to the KPI templates and 
suppliers in that segment. This action also creates new collection tasks and assigns them to 
suppliers to collect their KPI data.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > Segmentation 
rules.

3. In the Name column, select the link to the segmentation rule.

4. Select Execute.
Running the segmentation rule does the following:

◦ Generates KPIs and KPI collection tasks from the KPI templates in the segment if they were 
never generated before for the newly added suppliers.

◦ Sets the KPIs linked to this segment's KPI templates to active and creates new collection 
tasks for these KPIs.

◦ Assigns the new collection tasks to suppliers in this segment.

Note:  If the number of suppliers to be processed in the segmentation rule is too large, it 
may lead to a risk of a timeout.

Complete a KPI collection task from the Source-to-Pay Workspace

A KPI collection task is generated automatically each time a KPI is instantiated. A supplier 
manager can complete the assigned KPI collection task from the Source-to-Pay Workspace.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

A KPI is instantiated when:

• A segmentation rule is run.

• A supplier is added to the KPI template.

• An existing KPI template is added to the KPI management tab of a supplier.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ) and navigate to Lists  > Performance management  > KPIs.

3. In the Name column, select the link to a KPI.
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4. Select the Tasks  tab.

5. In the Name column, select the link to a task.

6. Do one of the following:

◦ If the requested KPI data is quantitative, in the Quantitative KPI value  field, enter a 
numerical value.

◦ If the requested KPI data is qualitative, from the Qualitative KPI value  drop-down list, select 
a value.

◦ If the KPI value isn't available, select the KPI Value is not available  check box.

7. Select Complete task.

Complete a KPI collection task from the Supplier Collaboration Portal

A KPI collection task is generated automatically each time a KPI is instantiated. A supplier 
contact can complete the assigned KPI collection task from the Supplier Collaboration Portal.

Before you begin
Role required: sn_slm.contact

A KPI is instantiated when:

• A segmentation rule is run.

• A supplier is added to the KPI template.

• An existing KPI template is added to the KPI management tab of a supplier.

Procedure

1. Navigate to the Supplier Collaboration Portal  home page by accessing your instance URL and 
adding a /supplier suffix.
For example, https://example.com/supplier.

2. Do one of the following:

◦ In the Supplier Collaboration Portal  header, select My Tasks.

◦ (If you’re a primary contact) In the Supplier Collaboration Portal  header, select Tasks  and 
then select My Tasks.

◦ In the My active items widget, select Tasks.

3. On the Open  tab, select the Provide KPI data task, and do one of the following:

◦ If the requested KPI data is quantitative, in the Quantitative KPI value  field, enter a 
numerical value.

◦ If the requested KPI data is qualitative, from the Qualitative KPI value  drop-down list, select 
a value.

4. Select Submit.

View KPI data from the List page of the Source-to-Pay Workspace

You can view the details of the existing KPIs from the List view page.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Do one of the following steps to view KPIs In the Source-to-Pay Workspace:

◦ Select the list icon ( ), navigate to Lists  > Performance management  > KPIs.

◦ Select the list icon ( ), navigate to Lists  > Performance management  > KPI Templates. In 
the Name column, select the link to a KPI template, and then select the KPIs  tab.

3. In the Name column, select the link to a KPI.

KPIs form

Tab Description

Details Displays information about basic details, KPI properties, and data collection that 
you specified in the in the KPI template. This tab also indicates whether the KPIs 
are qualitative or quantitative.

Thresholds Lists the KPI thresholds that you configured for the KPI template.

KPI Data Displays the KPI data that is collected based on the specified collection 
frequency in the KPI template.

Tasks Lists the tasks of Action type Provide input.

Each task is assigned to the user that you specified in the Collection source 
type  field for the KPI template.

The supplier manager completes the assigned task from the Source-to-Pay 
Workspace. For more information, see Complete a KPI collection task from the 
Source-to-Pay Workspace.

The supplier contact completes the assigned task from the Supplier 
Collaboration Portal. For more information, see Complete a KPI collection task 
from the Supplier Collaboration Portal.

Manage supplier KPIs from the supplier record page of the Source-to-Pay Workspace

You can view the latest KPI data that is collected for a particular supplier from the supplier page 
of the Source-to-Pay Workspace.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier.

4. Select the KPI management  tab.

The KPI management  tab contains columns that provide details, such as KPI, weight, 
collection frequency, last collected date, next run date, latest value, and status.

All the KPIs that are listed on this tab are grouped by the KPI performance domain set in the 
KPI template they were created from.
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KPI management tab

Note: 

◦ You can filter the KPIs by All KPIs, Supplier-level KPIs, or Contract-level KPIs.

◦ You can add new supplier-level and contract-level KPIs or remove existing KPIs for the 
selected supplier from the KPI management  view.

Create action plan for KPIs

Create action plans linked to under-performing KPIs, enabling visual tracking of milestones and 
tasks. The tasks triggered by the action plans are assigned to the suppliers and they can see and 
complete those tasks in the Supplier Collaboration Portal.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier.

4. Select the KPI management  tab.

5. Select Create action plan.

6. Select the KPIs to be tracked.
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Add action plan KPIs

7. Select Add.

8. On the form, fill in the fields.

Action Plan form

Field Description

Number Auto-generated action plan ID

State State of the action plan. By default it is in 
Draft state

Plan type Type of action plan to be created:

◦ Quality improvement plan

◦ Delivery improvement plan

◦ Cost reduction plan

◦ Sustainability and compliance plan
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Field Description

◦ Communication and collaboration plan

◦ Performance monitoring plan

Priority Priority of the action plan

Supplier Supplier related to the action plan

Opened by User who created the action plan

Assigned to User who is assigned the action plan

Note:  This field is not available for 
action plans created for automated 
KPIs.

Due date Due date for the completion of the action 
plan

Created Date of creation of the action plan

Watchlist List of users included in the watchlist

Short description Brief description of the action plan

Description Detailed description of the action plan

9. Navigate to Action plan items  and select Create.

10. Create milestones or supplier tasks for each KPI to track the action plan.
For more information on how to create milestones and supplier tasks, see Create milestones 
for the action plan  and Create supplier tasks for the action plan.

11. Select Submit  to activate the action plan.

The corresponding milestones and tasks are generated for the action plan.

Result
After the milestones are run, corresponding tasks are generated for the users assigned to those 
milestones. When they complete their tasks, performance metrics are recalculated to determine 
whether the KPIs are still on target or failing. If a KPI is linked to a milestone or an action plan, the 
dashboard highlights its status:

• On Target– if the KPI is meeting or exceeding the target

• Failing- if the KPI is not meeting its current target

• Failing in a plan- if the KPI is in an action plan and isn’t meeting its milestone targets

• Part of a Plan- if the KPI is in a plan and progressing but not failing

The action plan can be tracked continuously, with updates based on the subsequent KPI runs. 
Managers can monitor the progress of milestones and tasks using the Gantt chart.

Create milestones for the action plan

Create milestones for the affected KPIs in the action plan.

Before you begin
Role required: admin
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Procedure

1. Navigate to the Action plan items  tab of the action plan.

2. Select Create.
The Crate new action plan item  dialog box is 

displayed.

3. Select Milestone.

4. Select the affected KPI from the list of available KPIs.

5. Select Create.

6. In the form, fill in the required fields.

Create New Milestone form

Field Description

Assigned to User to whom the milestone tracking is 
assigned

Note:  This field is not available for 
action plans created for automated 
KPIs.

Due date Target date for the milestone

Note:  For action plans created for 
automated KPIs, the KPI is run 7 days 
before the due date.

Short description Brief description of the milestone

Milestone details

Milestone target value The expected target value of the KPI for the 
milestone

Milestone collection start date Start date for the milestone collection
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Field Description

Milestone collection end date End date for the milestone collection

7. Select Save  to create and save the new milestone.

Create supplier tasks for the action plan

Create supplier tasks for the affected KPIs in the action plan.

Before you begin
Role required: admin

Procedure

1. Navigate to the Action plan items  tab of the action plan.

2. Select Create.
The Crate new action plan item  dialog box is 

displayed.

3. Select Supplier task.

4. Select the user who will be assigned this task.

5. Select the action type required to close the task:

◦ Mark complete

◦ Play video

◦ Upload documents

◦ View link

6. Select Create.

7. In the form, fill in the required fields.

Create New Supplier Task form

Field Description

Supplier Name of the supplier
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Field Description

Priority Priority of the supplier task to complete the 
action plan

Assigned to User to whom the milestone tracking is 
assigned

Due date Target date for the milestone

Opened by User who created the supplier task

Short description Brief description of the milestone

Summary details

Supplier case The case to which the task is related

Expected start Expected start date of the supplier task

Actual start Actual start date of the supplier task

Actual end Actual end date of the supplier task

Related task Tasks related to this supplier task

Related KPIs KPIs related to this supplier task

Related location Location in which this supplier task is to be 
performed

8. Select Save  to create and save the new supplier task.

View supplier performance dashboard

You can view the overall supplier score, risk score, individual KPI scores, and performance 
domain-specific scores in the supplier performance dashboard.

Before you begin
Role required: sn_kpi.admin or sn_slm.manager or sn_slm.admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Under My suppliers, select the legal name of the supplier.

4. Select the Performance  tab.

The Performance  tab displays the overall score and risk profile of the supplier. You can also 
view the performance domain-wise KPI scores of the supplier.
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All the KPIs are grouped by the performance domain set in the KPI template that they were 
created from.

Performance tab

Result
The supplier performance dashboard is displayed with information on the latest scores of the 
supplier.

Using Supplier Payment Optimization

Use Supplier Payment Optimization for identifying, prioritizing, and tracking suppliers with high 
potential of accepting credit card payments. The saving estimation tool can be used to calculate 
potential savings from credit card payments.

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization. This feature is available from the Yokohama December 2025 release 
onwards.
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Related topics

View the Payment Optimization dashboard

Estimate savings using the saving estimator tool

Add propensity score for a supplier

The propensity score is used to identify the likelihood of a supplier to accept credit card 
payments. The supplier managers can manually update the propensity score for suppliers from 
the Source-to-Pay Workspace.

Before you begin
Role required: sn_slm.manager or admin

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Select the supplier for which you want to estimate the savings (by using credit card payments).

4. Select the Spend  tab.

5. Select Update score  under the Propensity score  section.

The Update propensity score  dialog box is displayed.

6. Add the propensity score value between 0-10 (by default, a score of 0–3 indicates low, 4–7 
indicates medium, and 8–10 indicates high likelihood).

7. Select Submit.
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The propensity score is saved.

Result
The propensity score graph is displayed.

Related topics

Using Supplier Payment Optimization

View the Payment Optimization dashboard

Create a case for supplier credit card enablement

Create a supplier case to request for the credit card information from a supplier.

Before you begin
Role required: sn_slm.manager, sn_slm.owner, or sn_slm.admin

Note:  The sn_slm.owner role can create cases only for the suppliers they own.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. On the home page, do one of the following:

◦ Under Quick actions, select Create case.

◦ Under Quick actions, select Manage my suppliers  and do the following:

a. Select the link to the supplier name under the Legal name column.

b. From the Create  drop-down list, select Supplier case.

3. On the Create New Supplier Case form, fill in the fields.

In the Case type  field, select Credit card enablement.
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For more information about the form fields and descriptions, see Create New Supplier Case 
form.

4. Select Save.
The case is created in Draft state.

5. Select Submit case.

Result
The case is created in the Open  state.

What to do next
After you submit the case, a playbook for this supplier case opens.

For more information, see Supplier credit card enablement playbook.

Related topics

Using Supplier Payment Optimization

View the Payment Optimization dashboard

Case playbook for specific supplier case types

Estimate savings using the saving estimator tool

Supplier credit card enablement playbook

Source-to-Pay Workspace  includes a playbook to complete the supplier cases for initiating credit 
card acceptance requests.

The Supplier credit card enablement playbook provides step-by-step guidance for completing 
the request. The playbook includes a customized supplier case flow including reviewing the 
case by checking the propensity score, creating the credit card acceptance task for the supplier 
contact, and notifying the supplier through email. Once the supplier contact accepts the credit 
card as the payment method, the case can be closed. For more information, see Interact with 
Playbook .
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Supplier credit card enablement playbook stages and activities

The playbook contains the following stages and activities.

Stages in the Supplier credit card enablement playbook

Stage Activity Activity Details

Assign 
case

As a supplier manager or fulfiller, you can assign the case to a 
different person or keep the case assigned to you.

You can do the following:

1. In the Assigned to  search field, search for and select the 
person that you want to assign the case to.

2. In the Short description  field, update the description for the 
case.

3. Select one of the following actions:

◦ Select Save  to save your changes.

◦ Select Start work  to start working on the case.

Review the 
case

Review 
supplier 
propensity 
score

As a supplier manager or fulfiller, you can approve or cancel 
the case after reviewing the propensity score available for this 
supplier.

Notify the 
supplier

Create 
credit card 
acceptance 
task

A draft email appears with pre-populated data in the To  and 
Subject  fields. The email body is pre-populated with the relevant 
text informing them about the benefits of accepting credit card 
payments. Ensure that the email template remains editable.
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Stages in the Supplier credit card enablement playbook  (continued)

Stage Activity Activity Details

Note:  Do not modify the task button, as any changes may 
cause the link to stop functioning.

Notify the 
supplier

Send an email to the supplier informing that the credit card 
acceptance request has been initiated.

Once the email is sent, a task is created for the supplier contact 
to review and approve the credit card acceptance request.

Waiting for 
the supplier 
to decide on 
credit card 
acceptance

Check the 
status

The supplier contact reviews and approves the credit card 
acceptance request from the Supplier Collaboration Portal after 
providing the terminal ID and uploading the bank account proof 
document.

Process 
change 
request

Close case You can select Mark complete  and Complete case  to close the 
request. Updates the case to Closed Completed.
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Stages in the Supplier credit card enablement playbook  (continued)

Stage Activity Activity Details

Related topics

Manage supplier cases from the Source-to-Pay Workspace

Configure due dates for supplier cases

Playbook for updating the supplier primary data

Create a case on behalf of a supplier from the Source-to-Pay Workspace

Estimate savings using the saving estimator tool

The saving estimator tool is used to calculate potential savings from credit card payments. The 
tool uses default values and allows users to modify billing cycles and other parameters to create 
new estimates.

Before you begin
Role required: sn_slm.manager or admin

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization.

Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Manage my suppliers.

3. Select the supplier for which you want to estimate the savings (by commercial credit card 
payments).

4. Select the Spend  tab.

5. Select Launch savings estimator  under the Credit card savings estimator  section.
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The Virtual card value estimator  is displayed.
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You can see the saving calculation formulas by selecting the Estimator formula  tab.

6. Fill in the form with the required values.

7. Select Create new estimate.
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The saving estimate is created and saved. You can select View saved estimates  to view the 
list of saved estimates.

Result
The potential savings from credit card payments are displayed.

Related topics

Using Supplier Payment Optimization

View the Payment Optimization dashboard

View the Payment Optimization dashboard

The Payment optimization dashboard provides an overview of the total spend and potential 
savings for all suppliers.

Before you begin
Role required: sn_slm.manager or admin

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization.
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Procedure

1. Navigate to All  > Supplier Lifecycle Operations  > Source-to-Pay Workspace.

2. Select the Payment optimization  icon .

Result
The Payment Optimization dashboard is displayed. It contains information on the following:

• All time spend and total spend for the current month, quarter, and year.

• Total potential savings and the top 10 supplier opportunities by potential savings.

• Average propensity score of the supplier-base for accepting credit card payments.

• Credit card insights including status of all the active credit card enablement cases and 
industry-wise potential credit card savings.

Related topics

Using Supplier Payment Optimization

Estimate savings using the saving estimator tool

Supplier Lifecycle Operations  reference
Reference topics provide additional information about Supplier Lifecycle Operations, including 
lists and forms.

Create New Supplier Case form

Use the Create New Supplier Case form to enter supplier case details and provide resolution 
information.
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Create New Supplier Case form

Field Description

Supplier Case

Number An auto-generated number that uniquely 
identifies the supplier case.

State The current state of the case. The choices are:

• Draft

• Open

• Work in progress

• Awaiting task completion

• Closed completed

• Closed rejected

• Closed canceled

Case type
The type of case. The choices are:

• Supplier support request

• General inquiry

• Banking information change request

• Supplier information change request

• Supplier location change request

• Supplier issue

• Due diligence

• Offboard a supplier

Priority Indicates how quickly you must complete the 
case based on its severity.

Supplier The name of the supplier the case is for.

Assigned to The name of the agent that the case is 
assigned to.

Requested by The person who requested the case.

Due date The date that the case must be completed.

Created The date that the case is created.

Assignment group Group to which the case is assigned to.

Channel source Channel that was used to request this case; 
for example, email.

Watch list Users who are notified when updates are 
made to the case.

Short description Short description of the case.

Description Detailed description of the case.
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Create New Supplier Case form  (continued)

Field Description

Summary Details

Parent case Parent case, if any, from which this case has 
been created, typically for reference purposes.

Related location Location of the supplier.

Expected start Expected start date of the case.

Actual start Actual start date of the case.

Actual end Actual end date of the case.

Duration Duration to complete the case.

Create new task form

Use the Create new task form to add a new task to a supplier case.

Create new task form

Field Description

Who is this task 
for?

Option to select who this task is intended for. The options are:

• Supplier

• An employee at my company

Action type Action type that defines the supplier task. The options for a supplier task 
are:

• Complete a form

• Complete checklist

• Complete survey

• Mark complete

• Play video

• Sign document

• Upload documents

• View link

Action type that defines the employee task. The options for an employee 
task are:

• Mark complete

• Play video

• Upload documents

• View link
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Task form

Use the Details  tab of the task form to provide details about the supplier or employee task.

Details tab of the task form

Field Description

General

Number An auto-generated number that uniquely identifies the task.

State The current state of the task. The choices are:

• Draft

• Work in progress

• Awaiting completion

• Closed complete

• Closed incomplete

• Closed canceled

Supplier The name of the supplier the task is for.

Priority Indicates how quickly you must complete the task based on its severity.

Task audience Identifies whether the task is assigned to an internal or external user.

Assigned to Person that you want to assign this task to.

Action type The type of the task.

Due date Date that this task must be completed by.

Opened by The person who opened the case.

Created The date that the task is created.

Watch list Users who are notified when updates are made to the task.

Short description Brief description about the task.

Description Detailed description about the task.

Summary details

Supplier case Supplier case to associate this task with.

Related task Task that is related to this task.

Related location Location of the supplier.

Expected start Expected start date of the case.

Actual start Actual start date of the case.

Actual end Actual end date of the case.

Duration Duration to complete the case.

Add New Location form

Use the Add New Location form to provide details about the location of a supplier.
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Add New Location form

Field Description

Name Name of the supplier location.

Street The street address of the supplier location.

City The city of the supplier location.

State/Province The state of the supplier location.

Zip/Postal Code The zip code of the supplier location.

Country The country of the supplier location.

Latitude The latitude coordinates of the supplier 
location.

Longitude The longitude coordinates of the supplier 
location.

Category The category that the supplier location 
belongs to. The choices are:

• Contracting address

• Delivery address

• Facility (default)

• Headquarters

• Invoice address

• Service center

You can select multiple values from the choice 
list.

Update banking details form

Use the Update banking details form to update the banking details of the supplier.

Update banking details form

Field Description

Bank Name Name of the bank.

Primary account Option that indicates whether this account is the primary account.

Note:  A supplier can have only one primary payment record at a 
given time.

Beneficiary name Name of the beneficiary.

Account number Account number of the beneficiary.

Country Country the bank is located in.

BSB code (For 
Australia)

Bank State Branch is a six-digit number that is used to identify a bank 
code and its associated branch in Australia.
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Update banking details form  (continued)

Field Description

This field becomes available only if you select Australia  in the Country 
field.

IFSC code (For India) Indian Financial System Code (IFSC) is a unique 11-digit alphanumeric 
code that is used for online fund transfer transactions in India.

This field becomes available only if you select India  in the Country  field.

Currency Currency of the country.

Routing information - 
Wire/ACH (For US)

A unique, nine-digit number used to identify banks and financial 
institutions.

IBAN International Bank Account Number used for international payments.

SWIFT code (BIC) Bank Identifier Code (also known as SWIFT code) of the bank.

Bank account proof Option to upload the bank account proof document. Select Required - 
Upload  to upload the document.

Update profile details form

Use the Update profile details form to update the details of the company profile.

Update profile details form

Field Description

Basic Profile

Supplier Name of the supplier whose profile details have to be 
updated.

Note:  The Supplier field is available from the 
Xanadu  December 2024 release onwards.

Legal name Legal name of the supplier.

Company description Detailed description of the supplier.

Website URL of the company website.

Country of registration Name of the country where the supplier is registered.

Tax ID Tax identification number of the supplier.

DUNS number A unique numeric identifier for every supplier.

Year founded Year that the company was founded.

Number of employees Number of employees that the supplier has.

Industry Industry type of the supplier.

Publicly traded Indicates whether the company is publicly traded. The 
choices are:
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Update profile details form  (continued)

Field Description

• Yes

• No

Stock symbol Stock symbol of the supplier.

Primary phone number Primary phone number of the supplier.

Any other attributes or details you 
wish to let us know?

Additional information about the company.

Onboard a Supplier form

Use the Onboard a Supplier form to provide details about the supplier that you want to onboard.

Onboard a Supplier form

Field Description

Supplier Name Name of the supplier.

Supplier DUNS Unique numeric identifier for every supplier.

Primary contact first name First name of the supplier primary contact.

Primary contact last name Last name of the supplier primary contact.

Primary contact email Email of the supplier primary contact.

Primary contact title Title of the supplier primary contact.

Create New Documents form

Use the Create New Documents form to provide details about the new document you want to 
create.

The Create New Documents form contains the Documents and Access Settings sections. For 
more information about document access settings, see Document security and access .

Create New Documents form

Field Description

Documents

Name Name of the document.

Owner Name of the document owner.

Reviewers Name of the document reviewers, if any.

Template Option to determine whether the document is a template.

Department Name of the department that created the document.

Type The type of document based on the content. The choices are:
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Create New Documents form  (continued)

Field Description

• Policy

• Guideline

• Procedure

• Contract

Classification Classification of the document. The choices are:

• Public

• Restricted

• Confidential

State The state of the document. The choices are:

• Draft

• Submit

• Review

• Complete

Description A brief description about the document.

Default Version
The document version that is used for document download.

By default, the latest version is the default version.

Primary data tables for Supplier Lifecycle Operations

The primary data tables for Supplier Lifecycle Operations  store important information about 
suppliers, supplier contacts, supplier email domains, product codes, supplier locations, and 
supplier payment information.

Supplier table

The Supplier [sn_fin_supplier] table stores important information about a supplier.

Supplier [sn_fin_supplier] table

The Supplier [sn_fin_supplier] table contains the following fields.

Supplier table

Field Data type Description

Legal Name String Legal name of the supplier that corresponds to its operating 
location.

DUNS 
number

Integer Unique, 9-digit identifier for a supplier.
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Supplier table  (continued)

Field Data type Description

ERP supplier 
code

Integer Company code of the supplier in the ERP system.

Parent entity Reference Parent organization of the supplier.

Global 
company

Reference Global company that the supplier is linked to.

Industry String Industry to which the supplier belongs.

Website URL Website of the supplier.

Image Image Image of the supplier’s logo.

Description String Detailed description of the supplier.

Relationship 
manager

String Person responsible for managing the relationship with this supplier.

Relationship 
status

List Business relationship that is designated to the supplier. The options 
are Strategic, Valued, Tactical, or Excluded.

Onboarded Boolean Status of whether the supplier is onboarded into the ERP system. 
The options are Yes or No.

Valid NDA Boolean Status of whether the supplier has a valid non-disclosure 
agreement. The options are Yes or No.

Valid risk 
assessment

Boolean Status of whether a valid risk assessment has been performed for 
the supplier. The options are Yes or No.

Customer 
number

String Unique identifier for the organization to the supplier.

On-boarded 
by

String The person responsible for onboarding the supplier.

On-boarded 
date

String Onboarding date of the supplier.

Off-boarded 
date

String Termination date of the supplier from the organization.

Preferred Boolean Whether the supplier is preferred. The options are Yes or No.

PO box 
number

String Post office box number where the supplier correspondence and 
payments are made.

ERP 
company 
code

String Company code of the supplier in the ERP system.

ERP source String ERP source used by the organization.

Parent entity String Parent organization of the supplier.

Street 
address

String Street where the supplier is located.

City String City where the supplier is located.
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Supplier table  (continued)

Field Data type Description

State/
Province

String State or province where the supplier is located.

County/
District

String County or district where the supplier is located.

ZIP/Postal 
code

String Zip code or postal code where the supplier is located.

Country String Country where the supplier is located.

Region String Region where the supplier is operating. Options are AMS, APAC, 
EMEA, or LATAM.

Primary 
phone 
number

String Phone number of the primary contact from the supplier side.

Fax number String Number to which documents can be faxed to the supplier.

For more information, see Supplier Lifecycle Operations data model.

Vendor Contact table

The Vendor Contact [vm_vdr_contact] table stores important information about a vendor contact.

Vendor Contact [vm_vdr_contact] table

The Vendor Contact [vm_vdr_contact] table contains the following fields.

Vendor Contact table

Field Data type Description

First name String First name of the vendor contact.

Last name String Last name of the vendor contact.

Vendor Reference The name of the vendor the vendor contact belongs to.

Email Email Email address of the vendor contact.

Primary contact Boolean Indicates whether the vendor contact is a primary contact.

For more information, see Supplier Lifecycle Operations data model.

Supplier Contact table

The Supplier Contact [sn_slm_contact_m2m_supplier] table stores information about supplier 
contacts and suppliers linked to them.
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Supplier Contact [sn_slm_contact_m2m_supplier] table

Important: 

The Supplier Contact table is available from the Xanadu  December 2024 release onwards.

Previously, the Organization  field from the Vendor Contact  table was used to fetch 
the mapping between the supplier contact and the supplier. From Xanadu  December 2024 
release onwards, the Supplier Contact  table is used to fetch this mapping.

The Supplier Contact [sn_slm_contact_m2m_supplier] table contains the following fields.

Supplier Contact table

Field Data type Description

Supplier contact Reference Name of the supplier contact.

Supplier Reference Name of the supplier.

Default supplier Boolean Indicates whether the supplier 
is the default supplier for the 
supplier contact.

Primary contact Boolean Indicates whether the supplier 
contact is the primary contact 
for the supplier.

For more information, see Supplier Lifecycle Operations data model.

Supplier Email Domain table

The Supplier Email Domain [sn_slm_email_domain] table stores important information about the 
email domain of a supplier.

Supplier Email Domain [sn_slm_email_domain] table

The Supplier Email Domain [sn_slm_email_domain] table contains the following fields.

Supplier Email Domain table

Field Data type Description

Email 
Domain

String Email domain name (which comes after the @ symbol) of the supplier.

Note:  By default, the length of the email domain can be 2–4 
characters.

Supplier Reference Vendor that provides goods and services.

Note:  Multiple supplier records can have the same email domain after removing 
the unique constraint from the Email Domain column of the Supplier Email Domain 
[sn_slm_email_domain] table.

For more information, see Supplier Lifecycle Operations data model.

Product Code table

The Product Code [sn_slm_product_code] table stores important information about a product's 
Universal Product Code (UPC).
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Product Code [sn_slm_product_code] table

The Product Code [sn_slm_product_code] table contains the following fields.

Product Code table

Field Data type Description

Name String Unique name for the product code.

Level List The level of the product. The choices are:

• Segment

• Family

• Class

• Commodity (default)

Code String The code of the product.

For more information, see Supplier Lifecycle Operations data model.

Supplier Location table

The Supplier Location [sn_slm_m2m_location] table stores important information about the 
geographical location of a supplier.

Supplier Location [sn_slm_m2m_location] table

The Supplier Location [sn_slm_m2m_location] table contains the following fields.

Supplier Location table

Field Data type Description

Supplier Reference Name of the supplier.

Name String Name of the supplier location.

Street String The street address of the supplier location.

City String The city of the supplier location.

State/Province String The state of the supplier location.

Zip/Postal 
Code

String The zip code of the supplier location.

Country String The country of the supplier location.

Latitude Integer The latitude coordinates of the supplier location.

Longitude Integer The longitude coordinates of the supplier location.

Category List The category that the supplier location belongs to. The choices 
are:

• Contracting address

• Delivery address

• Facility (default)

• Headquarters
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Supplier Location table  (continued)

Field Data type Description

• Invoice address

• Service center

For more information, see Supplier Lifecycle Operations data model.

Supplier Payment Information table

The Supplier Payment Information [sn_fin_supplier_payment] table stores important information 
about the payment information of a supplier.

Supplier Payment Information [sn_fin_supplier_payment] table

The Supplier Payment Information [sn_fin_supplier_payment] table contains the following fields.

Supplier Payment Information table

Field Data type Description

Supplier Reference The supplier that the payment information is for.

Active Boolean Indicates whether the supplier payment record is active.

Currency Reference The three-digit ISO currency code used for a given country.

Primary Boolean Option that indicates whether this account is the primary account.

Note:  A supplier can have only one primary payment record 
at a given time.

Bank name String Name of the bank.

ABA routing 
number

String Unique, nine-digit number used to identify banks and financial 
institutions.

BSB code String Bank State Branch is a six-digit number that is used to identify a 
bank code and its associated branch in Australia.

IFSC code String Indian Financial System Code (IFSC) is a unique 11-digit 
alphanumeric code that is used for online fund transfer 
transactions in India.

Country Reference Country the bank is located in.

SWIFT Code String Bank Identifier Code (also known as SWIFT code) of the bank.

IBAN String International Bank Account Number used for international 
payments.

Bank 
identification 
number

String Number that uniquely identifies the supplier payment record in an 
ERP system.

Beneficiary 
name on 
account

String Name of the beneficiary.
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Supplier Payment Information table  (continued)

Field Data type Description

Account 
number

Password2 Account number of the beneficiary.

For more information, see Supplier Lifecycle Operations data model.

Domain separation and  Supplier Lifecycle Operations

Domain separation is unsupported for  Supplier Lifecycle Operations  . Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Supplier Lifecycle Operations  data model

The following diagram shows the tables and their relationships that comprise the Supplier 
Lifecycle Operations  data model.
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Supplier Lifecycle Operations  data model

Note:  The table Supplier Contact [sn_slm_contact_m2m_supplier] is added after the 
Xanadu  December 2024 release.

Supplier Relationship and Performance Management reference

Reference topics provide additional information about Supplier Relationship and Performance 
Management, including its data model, lists, and forms.

Supplier Relationship and Performance Management data model

The following diagram shows the tables and their relationships that comprise the Supplier 
Relationship and Performance Management data model.
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Supplier Relationship and Performance Management data model

Primary data tables for Supplier Relationship and Performance Management (SRPM)

The primary data tables for Supplier Relationship and Performance Management store important 
information about KPI configurations, KPI data, and generated scores.

KPI Template table

The KPI Template [sn_kpi_template] table stores the configurations required to create KPIs.

KPI Template [sn_kpi_template] table

The KPI Template [sn_kpi_template] table contains the following fields.

KPI Template table

Field Data type Description

Name String Name of the KPI template.

Description String Brief description of the KPI template.

Active Boolean Status of the KPI template.

Threshold set Reference Set of thresholds created for this template.

Domain Reference Performance domain of the template.

Type Choice Indicates the type of the KPI template.

Nature Choice Indicates whether the KPI is leading (predicts future), lagging 
(measures past performance), or current (monitors ongoing 
activities).

Collected from 
user

Reference The person who provides the data.

Recommended 
weight

Integer Determines the importance of the KPI in the overall performance 
score when multiple KPIs are collected.
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KPI Template table  (continued)

Field Data type Description

Supplier count Integer Total number of suppliers added to the KPI template.

Direction Choice Indicates whether the KPI should be minimized or maximised to 
show the ideal trend of the values.

Precision Integer Specifies the number of decimal points to be used for data 
collection to ensure accuracy and consistency.

Template 
owner

Reference The person who owns the KPI template.

Collection 
source type

Choice The user persona that provides the data.

Unit Reference Measurement unit used to quantify the KPI.

Collection 
frequency

String The frequency for collecting the KPI data.

Instructions Translated 
html

Populated in KPI collection tasks to give more context to the user 
providing the KPI data.

Related topics

Create manual KPI templates

KPI table

The KPI [sn_kpi_kpi] table stores the important information about the KPIs created.

KPI [sn_kpi_kpi] table

The KPI [sn_kpi_kpi] table contains the following fields.

KPI table

Field Data type Description

Name String Name of the KPI.

Description String Brief description of the KPI.

Active Boolean Status of the KPI.

KPI 
Template

Reference KPI Template used to create the KPI.

Supplier Reference Supplier for which this KPI is created.

Threshold 
set

Reference Set of thresholds created for this KPI.

Domain Reference Performance domain of the KPI.

Type Choice Indicates the type of the KPI.

Nature Choice Indicates whether the KPI is leading (predicts future), lagging 
(measures past performance), or current (monitors ongoing activities).

Collected 
from user

Reference The person who provides the data.
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KPI table  (continued)

Field Data type Description

Weight Integer Determines the importance of the KPI in the overall performance 
score when multiple KPIs are collected.

Direction Choice Indicates whether the KPI should be minimized or maximised to show 
the ideal trend of the values.

Precision Integer Specifies the number of decimal points to be used for data collection 
to ensure accuracy and consistency.

Collection 
source type

Choice The user persona that provides the data.

Unit Reference Measurement unit used to quantify the KPI.

Collection 
frequency

String The frequency for collecting the KPI data.

Instructions Translated 
html

Populated in KPI collection tasks to give more context to the user 
providing the KPI data.

Next run 
date

Date Next scheduled run date of the KPI to collect the data.

Last 
collected 
date

Date Latest date on which KPI data is collected.

Last period 
data

Reference Latest KPI data.

Entity table Table 
name

Table in which the entity belongs.

Entity Sys 
ID

Document 
ID

Sys ID of the entity.

Related topics

Create KPIs without using KPI template

Create KPIs by adding suppliers to a KPI template

KPI Data table

The KPI [sn_kpi_data] table stores the collected data for all the KPIs.

KPI Data [sn_kpi_data] table

The KPI Data [sn_kpi_data] table contains the following fields.

KPI Data table

Field Data type Description

KPI Reference KPI to which this data belongs to.

Collection 
start date

Date Collection interval start date.
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KPI Data table  (continued)

Field Data type Description

Collection 
end date

Date Collection interval end date.

State Choice State of the data.

Last period 
data

Reference Previous data collected for the KPI.

Threshold 
set

Reference Set of thresholds created for this KPI.

Domain Reference Performance domain of the KPI.

Type Choice Indicates the type of the KPI.

Nature Choice Indicates whether the KPI is leading (predicts future), lagging 
(measures past performance), or current (monitors ongoing 
activities).

Collected 
from user

Reference The person who provides the data.

Weight Integer Determines the importance of the KPI in the overall performance 
score when multiple KPIs are collected.

Variance Decimal Variance between current data and previous data of the KPI.

Original 
value

String Original value collected through the collection task.

Latest value String Latest value of the data.

Kpi value 
unavailable

Boolean True if the value isn’t available for this interval.

Override 
value

Boolean Checked to override the submitted KPI data.

Is 
overridden

Boolean Indicates whether the data is overridden.

Justification String Reason for overriding the data.

Related topics

Create KPIs without using KPI template

Create KPIs by adding suppliers to a KPI template

Performance Domain table

The Performance Domain [sn_kpi_domain] table stores the information about the performance 
domains created for the KPIs.

Performance Domain [sn_kpi_domain] table

The Performance Domain [sn_kpi_domain] table contains the following fields.
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Performance Domain table

Field
Data 
type

Description

Domain String Name of the KPI performance domain.

Description String Brief description of the KPI performance domain.

Active Boolean Indicates whether the KPI performance domain record is active. This 
option is enabled by default.

Related topics

Create KPI performance domains

Unit table

The Unit [sn_kpi_unit] table stores the information about the units created for KPIs.

Unit [sn_kpi_unit] table

The Unit [sn_kpi_unit] table contains the following fields.

Unit table

Field Data type Description

Active Boolean Indicates whether the KPI unit 
record is active. This option is 
enabled by default.

Label String Symbol or label of the KPI unit.

Unit family Choice Category under which the unit 
is listed.

Description String Brief description of the KPI 
unit.

Name String Name of the KPI unit.

Format String Format in which the value is 
displayed.

Domain Choice Category under which the unit 
is listed.

Related topics

Create KPI units

KPI Threshold table

The KPI Threshold [sn_kpi_threshold] table stores the information about threshold values or 
value ranges configured for KPIs or KPI templates.

KPI Threshold [sn_kpi_threshold] table

The KPI Threshold [sn_kpi_threshold] table contains the following fields.
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KPI Threshold table

Field Data type Description

Name String Name of the KPI threshold.

Label String Label for the KPI threshold.

Description String Brief description of the KPI 
threshold.

Active Boolean Option that indicates the 
threshold is active for use.

Low Value Integer Represents the low value in 
the KPI threshold value range.

High Value Integer Represents the high value in 
the KPI threshold value range.

Normalized value Integer Indicates a value that has 
been calculated from its 
original figure to fit a specific 
scale for easy comparison 
with other values. For 
example, a scale of 1–5.

Color String Color for the threshold.

Related topics

Create KPI thresholds

Restructured Supplier Task table

The Supplier Task table architecture has been restructured in the Washington DC  and Yokohama 
releases.

In releases before the Washington DC  release, the Supplier Task [sn_slm_task] table extended 
the Task [task] table.

Starting with the Washington DC  release, the Supplier Task [sn_slm_task] table extends the 
Service Task [sn_spend_sdc_service_task] table.

Supplier Task table structure

After you upgrade to the Washington DC  release, the fix script 
glidefix_script_reparent_sn_slm_task.xml  runs to reparent the Supplier Task 
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table on instances with huge count of records (in millions). Therefore, it’s advisable to run the 
upgrade during a period of low interaction.

Note:  This is a mandatory one-time fix script run on instances upgrading directly to 
Washington DC  from Vancouver  or older versions.

Supplier Payment Optimization reference

Reference topics provide additional information about Supplier Payment Optimization, including 
its data model and primary table.

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization.

Supplier Payment Optimization data model

The diagram shows the tables and their relationships that comprise the Supplier Payment 
Optimization data model.

Important:  Check your entitlements to determine whether you have access to Supplier 
Payment Optimization.

Spend Savings Estimation table

The Spend Savings Estimation [sn_slm_opt_spend_savings_estimation] table stores the saving 
estimates generated by the saving estimator tool.
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Spend Savings Estimation [sn_slm_opt_spend_savings_estimation] table

The Spend Savings Estimation [sn_slm_opt_spend_savings_estimation] table contains the 
following fields.

Spend Savings Estimation table

Field Data type Description

Supplier Reference Name of the supplier.

System 
domain

Domain 
ID

Identifier for the system domain associated with the supplier.

System 
domain path

String Path that indicates the hierarchy or structure of the system domain.

Annual 
target 
spend

Currency Total amount expected to be spent in an year with the supplier.

Payment 
terms

Integer Number of days taken to pay the supplier using current method.

New 
payment 
terms

Integer Number of days it will take to pay the supplier using the new method 
(usually card).

Acceleration 
to supplier

Integer Number of days reduced by paying the supplier using the new 
method.

Grace 
period

Integer Number of days after the billing cycle closes before you must pay the 
card bill.

Billing terms Integer Internal setting or max deferral window — often used as a cap for 
payment timing (ex: billing cycle + grace period or a set maximum).

Working 
capital 
benefits

Currency Estimated financial benefit gained by extending the time between 
paying the supplier and paying the card issuer.

Billing cycle Integer Number of days in the card billing cycle (from transaction date to 
statement date).

Cost of 
funds

Decimal Organization’s internal cost (in percentage) for borrowing the funds 
needed to purchase goods or services from the supplier.

Total check 
transactions

Integer Total number of transactions currently processed through checks.

Cost per 
check 
payment

Currency Average processing cost per check payment (default value: 20).

Process 
savings 
benefits

Currency Total process cost savings from switching from traditional check 
payments to virtual card payments.

Regular 
rebate

Decimal Fixed rebate percentage offered by the card provider.

Iti rate Decimal Interchange Transfer Incentive rate: Additional rebate or incentive 
offered based on volume or card type.
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Spend Savings Estimation table  (continued)

Field Data type Description

Volume 
based 
rebates

Decimal Total rebates earned based on the payments made through the 
virtual card.

Total 
savings

Currency Total savings earned from process savings, working capital, and 
earned rebates.

For more information, see Supplier Payment Optimization data model.

Supplier Lifecycle Operations  glossary

Learn about the terms and concepts used in Supplier Lifecycle Operations  (SLO).

Glossary terms are grouped alphabetically.

A  | C  | I  | M  | N  | O  | P  | R  | S  |

A

Advanced Work Assignment for Supplier Lifecycle Operations

An application that automatically assigns supplier cases to agents based on availability 
and capacity, ensuring efficient case handling within Supplier Lifecycle Operations.

C

Craft.co integration for Supplier Lifecycle Operations

Provides integration with Craft.co, a supplier intelligence platform, to enhance supplier data 
management and decision-making within Supplier Lifecycle Operations.

child case

A case that is linked to and is a part of a parent case, inheriting its context and contributing 
to its resolution or management.

I

inbound staging tables

Tables that temporarily store the supplier data that is imported from external systems.

M

M2M mapping between supplier contact and suppliers

Many-to-many (M2M) mapping between supplier contact and suppliers enables one 
supplier contact to be the contact for multiple suppliers, provided the suppliers share a 
parent-subsidiary relationship.

N

News Integration for Supplier Lifecycle Operations

An integration that retrieves recent news and relevant articles related to suppliers from 
preferred news channels. Includes a pre-configured integration with Microsoft Bing News 
Search API.
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O

outbound staging tables

Tables that store the supplier data before it is exported to external systems. These tables 
are updated automatically when the corresponding primary tables are updated.

P

parent case

A case that contains multiple related child cases. This hierarchical case structure is useful 
for managing complex scenarios that involve multiple stages and processes.

R

Risk assessments integration for Supplier Lifecycle Operations

Provides an integration with Third-party Risk Management  to conduct risk assessments 
during supplier onboarding or reassessment of existing suppliers.

related case

A case that is associated with another case due to shared characteristics, dependencies, 
or interactions.

S

Source-to-Pay Workspace

A workspace that centralizes the management of suppliers, from sourcing to payment, 
enhancing productivity and collaboration.

supplier

A person, business, or an enterprise that provides raw materials, goods, or services to 
another organization.

supplier case

A case that is opened in the Source-to-Pay Workspace to address supplier-related issues 
that arise during different phases of the supplier lifecycle, from onboarding to offboarding.

Supplier Collaboration Portal

A web-based interface that provides a unified portal experience for supplier contacts. This 
interface enables self-service, direct collaboration, and management of supplier-related 
tasks and information.

supplier contact

The person who allows individuals from the supplier side to access the Supplier 
Collaboration Portal, manage tasks, and interact with the buying organization.

supplier document configuration

The supplier document configurations that detail when and how documents should be 
managed and notified.

supplier document management

The functionality that enables you to manage supplier-related documents, including 
creating and running a supplier document configuration that is required to upload the 
prerequisite documents.
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supplier fulfiller

The person who is responsible for fulfilling tasks and cases that are related to suppliers, 
ensuring compliance with service level agreements and operational standards.

supplier integration framework

A framework that enables Supplier Lifecycle Operations  to exchange supplier data with 
third-party ERP systems.

Supplier Lifecycle Operations

A framework that enables Supplier Lifecycle Operations  to exchange supplier data with 
third-party ERP systems.

supplier manager

The person who is responsible for managing supplier relationships, overseeing supplier 
onboarding, tracking cases and tasks, and conducting supplier risk assessments.

supplier offboarding

The process of discontinuing a business relationship with a supplier. Tasks include deleting 
the supplier primary data, settling accounts, and deactivating the access to your systems.

supplier onboarding

The process of registering, qualifying, and activating suppliers to do business with the 
organization.

supplier owner

The person who is responsible for the ownership and management of specific suppliers, 
including the ability to update supplier information and manage related cases and tasks.

Supplier Relationship and Performance Management

The Supplier Relationship and Performance Management (com.snc.sn_slm_perf) 
application enables you to establish clear expectations and criteria for measuring supplier 
performance, monitoring and assessing their performance against those criteria, providing 
feedback and recognition, and implementing corrective actions and improvement plans 
when needed.

Supplier Payment Optimization

The Supplier Payment Optimization (com.snc.sn_slm_opt) application enables suppliers 
managers to estimate potential savings from credit card payments, which can result in 
significant cost savings for the company. It provides a Supplier Payment Optimization 
dashboard that provides an overview of the total potential savings for all suppliers.

supplier task

A task that is created in the Source-to-Pay Workspace  and assigned to the contacts of the 
internal users or suppliers so that they can take action and complete that task.

Accounts Payable Operations
The ServiceNow®  Accounts Payable Operations  application enables you to efficiently manage 
invoices, invoice exceptions, invoice approvals, and supplier inquiries.

This video provides a visual overview of Accounts Payable Operations  and its key capabilities.
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https://url.us.m.mimecastprotect.com/s/m4JWCDkVqEiOXA3rlHWfAHjbv13?
domain=player.vimeo.com

Accounts Payable Operations  value proposition

Explore

Learn about how accounts 
payable specialists, 

employees, and 
suppliers use Accounts 

Payable Operations.

Configure

Plan and configure 
your implementation.

Integrate

Extend the capabilities 
of Accounts Payable 

Operations by integrating 
with other applications.

Use

Work on invoices, 
view invoice statuses, 

identify and resolve 
invoice exceptions.

Reference

Get details about 
components, such 

as fields, tables, 
and properties.
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Use Accounts 
Payable Operations

AI agent collection

Use agentic workflows 
in Now Assist for APO

Important: 

• Not all model providers are available for customers with in-country SKUs, and some Now 
Assist  products/features are currently unavailable for in-country customers. For more 
information, see the KB1584492  article in the Now Support Knowledge Base. Be sure to 
check for model provider availability updates in future releases.

• Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the 
KB0743854  article in the Now Support  Knowledge Base . Be sure to check for availability 
updates in future releases.

• Some Now Assist  products/features are currently available only for customers in some 
regions. Be sure to check for availability updates in future releases.

• Some AI products and skills are not available in Regulated Markets. For more information, 
see KB2593939: Regulated Markets AI Products/Skills Not Available . Be sure to check 
for availability updates in future releases.

Troubleshoot and get help

• Ask questions and explore other resource in the ServiceNow Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-

making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .
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Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to 
develop and improve ServiceNow  technologies including ServiceNow  models and AI products. 
Accounts Payable customers can opt out of future data collection at any time, as described in the 
Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Exploring Now Assist for Accounts Payable Operations (APO)

With the Now Assist for Accounts Payable Operations (APO)  application, an account payable 
(AP) fulfiller can use generative AI to summarize the details of a case.

Now Assist for APO  overview

Using the summarization capability of the Now Assist for APO  application, an AP fulfiller can auto-
map the invoice lines with purchase order lines, get a concise summary of a case quickly, extract 
invoice details from email and auto-create an invoice processing case.

Cases can be complex and a case summary may enable an AP fulfiller to provide a more concise 
summary.

Skills

The Now Assist for APO  application includes the following:

• The generative AI skills enable an AP fulfiller to extract the details of an invoice case or inquiry 
case and suggest resolutions.

• The generative AI skills perform the purchase order line-mapping and enable an AP fulfiller to 
review the mapping results.

Purchase order line mapping

Provides AP fulfiller to automatically map the invoice lines with the purchase order 
lines.

The purchase order line-mapping skill generates the invoice line mapping, changes 
the invoice line status to review mapping state and provokes the fulfiller to manually 
review the mapping results. After the fulfiller reviews the mapping results, the 
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invoice line status is changed to mapping complete. The purchase order lines 
mapped using the Now Assist skill are controlled using the APO properties. For 
more information on the use of purchase order mapping in workspace, see Set APO 
properties  and Using Playbook in Accounts Payable Operations.

Invoice case summarization

The summary skill reviews the issue, actions completed, status, and next steps. An 
AP fulfiller can refresh the summary as case updates happen and post the summary 
to work notes.

The invoice case summary displays above the activity stream.

For invoice processing cases, the summary skill also reviews the invoice status and 
invoice information located in the applicable document.

For inquiry cases, the invoice case summarization skill generates a case summary 
by checking the short description, description, and tasks that were created for the 
case.

Fulfiller can customize prompt configuration and prompt optimization using the pre-
processor in the Now Assist skill kit (NASK). The skill supports multiple models such 
as OpenAI, Claude, Gemini, Now LLM Service. The configured pre-processor is 
applied across all supported models in NASK. To customize the prompt instructions, 
the sn_skill_builder_admin role is mandatory.

Invoice data extraction

The Invoice data extraction skill helps in extracting invoice details from PDFs 
submitted through email or supplier portal. The digitized invoice is processed within 
Accounts Payable Operations  automatically. Invoices are extracted in languages 
(English, Dutch, French, German, Japanese, Italian, Portuguese, Spanish) supported 
by GPT-4o.

With the Invoice data extraction skill, customers can achieve higher invoice 
extraction accuracy by leveraging GPT-4o and significantly reducing manual 
effort. Customers are provided with the flexibility of turning on the manual 
review of extraction results or can let invoice be processed through the workflow 
automatically without manual review.

Invoice inquiry solution generator

The Invoice inquiry solution generator skill identifies, extracts the invoice inquiry 
details from the invoice data and related records. Automates the resolution for 
invoice inquiry cases.

The skill suggests appropriate resolutions for inquiry cases by analyzing case 
details such as description, short description, related tasks and knowledge articles.

Resolve supplier questions use case uses the field extractor skills, which extracts 
the invoice number and supplier (from the description and short description) and 
updates the case. The inquiry classifier categorizes the case by reading description, 
short description and updates the subcategory in the case. The Inquiry resolution 
provider agent automatically provides resolution for the inquiry submitted by 
suppliers or employees by analyzing the invoice, invoice lines, and other invoice-
related tables (tax, exceptions, approval history tables, purchase order tables, and 
knowledge base tables).

The skill is activated upon assignment of an inquiry case to an AP agent. The skill 
is used by the Inquiry resolution provider AI agent to generate invoice inquiry case 
resolution in the Now Assist panel (Now Assist panel) reviewed by an agent. The 
Agent is prompted with an input to close the case in the Now Assist panel. Upon 
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confirmation, the case is closed with the appropriate closure code and closure 
details. If the agent chooses to respond with a "No", then the Now Assist panel chat 
window is terminated for manual closure. The resolution is updated in the activity 
history (work notes) of the case. For more information on the AI agent, see Inquiry 
resolution provider AI agent.

Relevant invoice finder

The Relevant invoice finder skill identifies the historically processed invoices that 
are most relevant to a given invoice using semantic matching.

The skill compares the current invoice and its line descriptions with previously 
processed invoices along with its line descriptions, and generates a relevance 
score from 0 through 1 for each item. These invoices are then returned in a ranked 
list, ordered by relevance.

The Recommend invoice owner AI agent uses this match score to suggest a 
resolution plan  for Missing or invalid business owner exceptions.

Email response for invoice case

The Email response for invoice case skill generates responses for email by 
analyzing invoice case contexts, activity, work notes, invoice details, approvals, 
payments, fulfiller's response in the past and knowledge base articles. The skill 
enables AP specialists and agents to automatically draft and manage responses to 
invoice-related inquiries. It also leverages the templates in drafting email responses.

The skill reduces time spent by AP specialists and agents in manually drafting 
responses and improves productivity.

Email response for invoice task

The Email response for invoice task skill generates responses for email by analyzing 
invoice case contexts, activity, work notes, invoice details, approvals, payments, 
fulfiller's response in the past and knowledge base articles. The skill enables AP 
specialists and agents to automatically draft and manage responses to invoice-
related inquiries. It also leverages the templates in drafting email responses.

The skill reduces time spent by AP specialists and agents in manually drafting 
responses and improves productivity.

Sentiment analysis for invoice case

The Sentiment analysis for invoice inquiry case skill enables fulfiller to analyze 
and prioritize the invoice inquiry cases based on the response tone. The tone is 
categorized as positive, negative, or neutral. The sentiment score helps fulfiller to 
understand the urgency and emotional weight of the invoice inquiry case.

Accounts payable document classification

The Accounts payable document classification skill automatically identifies 
and categorizes supplier sent email attachments as invoice, credit memo, and 
supporting documents. The system supports configurable confidence thresholds 
and an AI solution with confidence score. Documents are auto-approved if the AI-
confidence score is greater than the configured threshold, and auto-approval is 
enabled in the APO properties page. AP specialist manually reviews the document 
if the AI confidence score is lesser than the configured threshold. After the 
documents are successfully categorized, the invoice data extraction skill triggers 
the extraction of invoices.

If the email contains more than one invoice or credit memo, the system handles 
them as follows:
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• The first invoice is processed using the parent case.

• For each additional invoice or credit memo, the system creates a separate invoice 
processing case. These cases are available under the Linked Cases  related list 
on the parent case.

• All supporting documents are automatically copied to both the parent case and 
each linked case, ensuring every case has the context it needs for processing.

• Supporting documents only: If no invoices or credit memos are found, you can 
either cancel the case or convert it into an inquiry case.

This skill accelerates invoice processing and manages substantial volumes of data 
across various formats, thereby reducing errors, enabling audit transparency, and 
eliminating manual intervention. The AI solution accurately classifies document 
types prior to invoice extraction, confirming that non-invoice documents such 
as contracts and receipts aren’t inadvertently processed as invoices. For more 
information on configuring the skill, see Configure Accounts payable document 
classification skill.

Related topics

Invoice Processing use case

Configuring the invoice ingestion flows using Accounts Payable Operations integration with 
Document Intelligence

Invoice Case Management

Supporting information for Now Assist for Accounts Payable Operations (APO)

Get a quick overview of the important information that is related to the Now Assist for Accounts 
Payable Operations (APO)  application.

Supported versions

The Now Assist for APO  application is supported starting with Yokohama.

Supported user interfaces

The Now Assist for APO  application includes the skills that are listed in the following table.

Now Assist for APO  supported interfaces

Interface Skill

Virtual Agent • Conversational interface in Now Assist  in 
Virtual Agent.

• Track request status
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Now Assist for APO  supported interfaces  (continued)

Interface Skill

Source-to-Pay Workspace • Purchase order line mapping enables the 
AP fulfillers to review the Now Assist  driven 
mapping results.

• Case summarization for AP fulfillers involves 
invoice case summarization and inquiry 
case summarization.

• Invoice data extraction for DocIntel  auto-
extracts the invoice details from email and 
processes the invoice.

Core UI Record summarization involves invoice 
case summarization and inquiry case 
summarization.

Application information

Activate the Now Assist for APO  store app (sn_ap_gen_ai) to use the Case summarization skills.

This store app has the following dependencies:

Now Assist for Platform (com.sn.now.platform)

Activate the applications in the following order:

1. Now Assist for Platform (sn_genai_platform)

2. Now Assist for APO  (sn_ap_gen_ai)

For more information, see Configure Now Assist for Accounts Payable Operations (APO).

Configure Now Assist for Accounts Payable Operations (APO)

If you have the admin role, you can configure the Now Assist for Accounts Payable Operations 
(APO)  application so that an accounts payable (AP) fulfiller can use the generative AI skills in 
Source-to-Pay Workspace  and in Core UI.

APO  configuration overview

• Now Assist

Use the Now Assist Admin  console to configure APO. This console contains everything that 
you need to install the plugin [sn_ap_gen_ai] and configure the generative AI skills.

• See the Configuring Now Assist settings and features  topic.

Use the Now Assist Admin  console to activate the various Now Assist  applications and skills 
that you’re entitled to.

The following table lists the features and skills that you can access from the Now Assist Admin 
console.
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APO  features and skills in the Now Assist Admin  console

APO  features Skills

Purchase order line mapping Purchase order line mapping with invoice line 
mapping

Case summarization Invoice case summarization

Invoice data extraction Invoice data extraction using DocIntel

Now Assist skills for APO

Skill inputs for Now Assist for Accounts Payable Operations (APO)

You can configure some of the inputs for a generative AI skill. Inputs permit you to determine how 
and when a skill is used.

Overview of skills

Inputs identify the data that is used for a skill. Inputs include the table and fields that are used to 
generate a record summary.

You can modify the inputs, but you can't modify a skill's data source. The data source contains 
the tables and fields that the skill relies on.

Skills for Now Assist for APO

The Now Assist for APO  application includes the invoice case summarization skill.
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Important:  These Now Assist  skills are now turned on by default. The skills will be 
automatically available to appropriate role users for the application. This change simply 
activates the skills and does not touch the roles that are needed to use them. The new 
default behavior works as follows:

New customers

When you install a Now Assist  product , designated skills are turned on 
automatically.

Existing customers who are upgrading (starting with Zurich Patch 4)

Any previously unconfigured skill is turned on automatically (the skill was 
never turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, remain inactive.

Invoice case summarization skill

The inputs for the invoice case summarization skill identify the table and fields that are used 
when the summary is generated for an invoice case.

The following table lists the inputs for the case summarization from the Choose input for 
procurement case page in the Now Assist Admin  console.

Invoice case summarization skill inputs

Input Description

Base input table Invoice case [sn_ap_cm_ap_case] table

Base input fields • Description

• Supplier

• Invoice due date

• Invoice supplier number

• Invoice date

• Short description

• Requested by

• Caller email

• Sub category

• State

• Closed at

• Closed by

• Closure code

• Closure details

Related topics

Using Invoice Case Management

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1171



Install Now Assist for Accounts Payable Operations (APO)

Install the APO  plugin [sn_ap_gen_ai] so that an accounts payable (AP) fulfiller can use the 
generative AI skills in Source-to-Pay Workspace  and in Core UI.

Before you begin
Role required: admin

Install the Document Intelligence for Accounts Payable Operations Content Pack from the 
ServiceNow®  Store  for the invoice data extraction skill.

Procedure

1. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

2. Expand the Finance and Supply Chain  workflow group and select Accounts Payable 
Operations.

The APO features are grouped under the Finance and Supply Chain  workflow group. Each 
feature has its associated skills.

3. Activate and configure the skills for the APO  application.

Skills Action

Purchase order line 
mapping

To activate the skill, on the Purchase order line mapping skill card, 
select Turn on.

Invoice case 
summarization

On the Purchase order line mapping skill card, select Activate skill.

Invoice data extraction On the Invoice data extraction mapping skill card, select Activate 
skill.

4. For Invoice case summarization skill:

a. Select General Details, review the details about the skill, and then select Save and continue 
to go to the next step.

b. Follow the steps to configure and activate a skill by using the Guided Setup.

c. Select View Case Input, review the base input table and input fields, and then select Save 
and continue  to go to the next step.
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d. Optional:  To test the prompt on a record, select Customize and test prompt.

e. Select Save and continue  to go to the next step.

f. Optional:  Select Define Availability  and choose one of the following options.

Option Description

Skill is always available The skill is always available to users.

Customize skill availability

The skill is available only when the certain 
conditions are met (default).

Use the condition builder to set your condi­
tions.

a. Select Save and continue  to go to the next step.

b. Choose Select display  to determine where you'd like to display the skill.

Option Description

In-product desktop
Now Assist  skills are displayed on forms and 
workspaces.

Now Assist  panel

Now Assist  skills are available in the Now As­
sist  panel. Turn on multi-language support for 
user-entered text with Dynamic Translation 
in Now Assist applications. For more informa­
tion, see Configure multilingual service for 

.

Note:  If you don't see this option, you 
must activate the Now Assist  panel. For 
more information, see Activate Now As­

.

5. Select Save and continue  to go to the next step.

6. Review your choices and select Activate  to complete the configuration for the skill.

7. Complete the setup by selecting Done.
The skill is displayed in the Active skills section.

8. In case of Invoice data extraction for the APO  specialists feature card, select Activate skill.
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a. In the Create Usecase  step, select the Invoice Processing - GenAI  use 

case.

b. Select Make a copy  to create a copy of the use case.
For more information on the fields, test outputs, and integrations in the use case, see Set up 
a use case for Now Assist in Document Intelligence .

Note:  When you create a copy of the generative AI use case in Now Assist console, 
then "DocIntel Extract Values Flow - copied GenAI use case name-Invoice processing-
GenAI integration" use case is created automatically in the flow designer. For more 
information on configuring the use case, see Configuring the invoice ingestion flows 
using Accounts Payable Operations integration with Document Intelligence.

c. Select Save and continue  to go to the next step.

d. In the Review and activate  step, select Activate.

The Invoice data extraction skill is activated.

9. On the Purchase order line mapping summarization for the APO  specialists feature card, select 
Turn on.
The generative AI skill auto-generates mappings between invoice lines and purchase order 
lines.

Configure Invoice case summarization

Enable fulfiller to use the generative AI based invoice case summarization to quickly analyze the 
case and take necessary action.

Before you begin
Role required: admin

Install the Document Intelligence for Accounts Payable Operations Content Pack from the 
ServiceNow®  Store  for the invoice data extraction skill.

Procedure

1. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

2. Expand the Finance and Supply Chain  workflow group and select Accounts Payable 
Operations.
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3. Activate and configure the skills for the APO  application.

Skills for Accounts Payable Operations

Skills Action

Invoice case 
summarization

On the Purchase order line mapping skill card, select Activate 
skill.

4. For Invoice case summarization skill:

a. Select General Details, review the details about the skill, and then select Save and continue 
to go to the next step.

b. Follow the steps to configure and activate a skill by using the Guided Setup.

c. Select View Case Input, review the base input table and input fields, and then select Save 
and continue  to go to the next step.

d. Optional:  To test the prompt on a record, select Customize and test prompt.

e. Select Save and continue  to go to the next step.

f. Optional:  Select Define Availability  and choose one of the following options.

Option Description

Skill is always available The skill is always available to users.

Customize skill availability

The skill is available only when the certain 
conditions are met (default).

Use the condition builder to set your condi­
tions.

a. Select Save and continue  to go to the next step.

b. Choose Select display  to determine where you'd like to display the skill.

Option Description

In-product desktop
Now Assist  skills are displayed on forms and 
workspaces.
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Option Description

Now Assist  panel

Now Assist  skills are available in the Now As­
sist  panel. Turn on multi-language support for 
user-entered text with Dynamic Translation 
in Now Assist applications. For more informa­
tion, see Configure multilingual service for 

.

Note:  If you don't see this option, you 
must activate the Now Assist  panel. For 
more information, see Activate Now As­

.

5. Select Save and continue  to go to the next step.

6. Review your choices and select Activate  to complete the configuration for the skill.

7. Complete the setup by selecting Done.
The skill is displayed in the Active skills section.

Configure Document Intelligence  using Now Assist for Accounts Payable Operations (APO)

Configure Document Intelligence  using Now Assist skill in Accounts Payable Operations.

Before you begin
Role required: admin

Scope: Accounts Payable Operations with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills for Common 
Finance & Supply Chain features  tab of the Now Assist Admin  console.

2. Select Finance and Supply Chain  > Accounts Payable Operations  > Invoice data extraction 
to view the skills for the APO  features.

3. Select Activate  the skill.
The Invoice processing - Gen AI  use case is provided as out of the box within the skill.
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4. Select Invoice processing - Gen AI  use 

case.

5. Select Save and Continue.

6. In the Review and activate  section, select Activate.
The Invoice data extraction  skill is activated successfully.

Copy and activate the Invoice attachment DI processing flow

Copy and activate the Invoice attachment DI processing flow.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the Invoice attachment DI processing  flow.

3. Select the more actions icon ) in the top right and select Copy flow.
The Create a copy of this flow dialog box is displayed.
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4. In the New flow name  field, enter a name for the copied 

flow.

5. Select Save.

6. Select Activate.
The Invoice attachment DI processing flow is copied and activated successfully.

Copy and activate the DI STP Failed flow

Copy and activate the DI STP Failed flow.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the DI STP Failed  flow.

3. Select the more actions icon ( ) in the top right and select Copy flow.
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A copy of the DI STP Failed  is 

created.

4. Select Save.

5. Select Activate.
The DI STP Failed flow is copied and activated.

Copy and activate the generative AI DocIntel  flow

Copy and activate the DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice 
Processing - Gen AI Integration  flow.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

About this task

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice 
Processing - Gen AI Integration  flow.

3. Select the  icon > Copy flow.
A copy of the DocIntel Extract Values Flow - Invoice 
Processing - Gen AI - Invoice Processing - Gen AI Integration  is 

created.
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4. Select Save  > Activate.
The DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice Processing - Gen AI 
Integration  is copied and activated successfully.

Configure data extraction modes

Configure the extraction modes for use cases to define how Document Intelligence  extracts 
fields from documents.

Before you begin
Role required: sn_docintel.manager

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills  tab of the Now 
Assist Admin  console.

2. Select > Finance and Supply Chain  > Accounts Payable Operations  > Invoice data extraction 
to view the skills for the APO  features.

3. Select the Invoice Processing - Gen AI  use case.

4. Select the settings  icon.

5. Select the extraction mode for the use case Accounts Payable 

Operations.

6. Adjust the DocIntel full automation mode.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1180



◦ When Full automation mode is turned on, DocIntel  automatically completes and submits 
the document task. The required values or fields in the invoice document are auto-filled 
or identified as missing in the document. If there are no fields defined as required for the 
document task, then DocIntel  automatically completes and submits the document task.

◦ When you turn on the Any required field is missing in the document, the agent will be 
prompted to review the fields.

7. Select Save.
The data extraction mode for use cases using Document Intelligence  is configured.

Configure Accounts payable document classification skill

Configure the Document classification skill to automatically identify and categorize incoming 
documents by type before the invoice extraction process begins.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills for Common 
Finance & Supply Chain features  tab of the Now Assist Admin  console.

2. Select Finance and Supply Chain  > Accounts Payable Operations  > Accounts payable 
document classification  to view the skills for the APO  features.

3. Select Activate  the skill.

4. Select Save and continue.

5. In the Review and activate  section, select Activate.
The Accounts payable document classification  use case is provided as out of the box within 
the skill. Make a copy of the following OOB flows in the flow designer and activate.

◦ Invoice processing case for invoice email

◦ Process classification attachment using DI

◦ Classification values on invoice staging
◦
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Note:  The Manual Classification on DI Error  scheduler runs every 30 minutes, 
checking for invoice cases where the DocIntel status is stuck in processing classification, 
and performs the following actions:

◦ Sets the DI status to Classification failed and the staging record status to Review 
required if all associated staging records are stuck in in-processing state

◦ Sets the DI status to Classification STP failed and the staging record status to Review 
required if some associated staging records are stuck in in-processing state

The Manual Classification on DI Error  scheduler is inactive by default. Activate the 
scheduler to pick invoice cases that are stuck in processing classification.

The Accounts payable document classification  is activated and the incoming email with 
attached documents are automatically categorized into invoices in the workspace.

Copy and configure Invoice Processing Case for Invoice email flow

Configure the invoice processing case invoice email flow to process invoices received through 
email.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Flow designer  > Workflow Studio  > Flows.

2. Search for Invoice Processing Case for Invoice email  flow.

3. Select the  icon > Copy flow.
A copy of the Invoice Processing Case for Invoice email  is created.

4. Open the TRIGGER > Inbound Email.

5. Update the email conditions according to your business requirements.
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Note:  If you're upgrading Accounts Payable Operations  from previous versions to 
version 12, then you must deactivate the existing Invoice Processing Case for Invoice 
email  flow and make a fresh copy of the Invoice Processing Case for Invoice email  flow 
to process invoices received through email.

6. Select Done.

7. Select Activate.
The Invoice Processing Case for Invoice email flow is activated.

Configure Process Classification Attachment using DI flow

Configure process classification attachment di flow using the flow designer to enable submitting 
of email attachments to the Document Intelligence classification use case (consisting of AI 
solution) for document type identification.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Flow designer  > Workflow Studio  > Flows.

2. Search for Process Classification Attachment using DI  flow.

3. Select the  icon > Copy flow.
A copy of the Process Classification Attachment using DI  is created. 

4. Select Done.

5. Select Activate.
The Process classification attachment using DI flow is activated.

Configure Set Classification Values on Invoice Stage flow

Configure the classification values within the invoice stage flow using the flow designer to write 
back the classification results into the invoice record for subsequent processing.
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Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

Procedure

1. Navigate to All  > Flow designer  > Workflow Studio  > Flows.

2. Search for Set Classification Values on Invoice Staging  flow.

3. Select the  icon > Copy flow.
A copy of the Set Classification Values on Invoice Staging  is 

created.

4. Select Done.

5. Select Activate.
The flow is activated and the classification results are inserted the invoice record for 
subsequent processing.

Configure Email response generation skill in Now Assist for Accounts Payable Operations 
(APO)

If you have the admin role, you can configure the Email response generation skill in Now Assist 
for Accounts Payable Operations (APO)  so that an accounts payable (AP) fulfiller can use the 
generative AI skills in Source-to-Pay Workspace  to draft professional responses automatically.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills  tab of the Now 
Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Accounts Payable Operations  to 
view the skills for the APO  features.

a. Select Email response for invoice case  if you want to activate the skill for invoice case.

b. Select Email response for invoice task  if you want to activate the skill for invoice task.
For more information on email generation, see Generate email response for invoice case  and 
Generate email response for invoice task.

3. Select Activate skill.
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A guided setup leads you through the configuration of the input, availability, access, display, 
review, and activation of the customized skill. If you complete the entire walk-through, the skill 
is activated.

4. Select Save and continue  to go to the next step.

5. Configure where to display the email response for invoice case or task.

a. Select In-product.
In-product: When selected, the Now Assist  skills are displayed on the forms and 
workspaces.

For the skills that appear in-product, select the down arrow to identify the roles that can use 
the skill.

b. Select Save and continue  to go to the next step.

6. Review and activate the skill.
For more information on drafting email responses in an invoice case or a task, see Composing 
emails with predefined content from the Source-to-Pay Workspace.

Result

The Email generation for invoice case is activated. You can now select  in the Email tab of an 
invoice case or a task to draft professional responses.

Configure Sentiment analysis for invoice case skill in Now Assist for Accounts Payable 
Operations (APO)

If you have the admin role, you can configure the Sentiment analysis skill in Now Assist for 
Accounts Payable Operations (APO)  so that an accounts payable (AP) fulfiller can use the 
generative AI skills in Source-to-Pay Workspace  to prioritize inquiry cases resulting in improved 
supplier collaboration.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills  tab of the Now 
Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Accounts Payable Operations  to 
view the skills for the APO  features.
A guided setup leads you through the configuration of the general details, input, frequency, 
availability, access, display, review, and activation of the customized skill. If you complete the 
entire walk-through, the skill is activated.

3. Select Save and continue  to go to the next step.

4. Configure where to display the sentiment analysis for invoice case.

a. Select In-product.
In-product: When selected, the Now Assist  skills are displayed on the forms and 
workspaces.
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For the skills that appear in-product, select the down arrow to identify the roles that can use 
the skill.

b. Select Save and continue  to go to the next step.

5. Review and activate the skill.
Review your choices and select Activate  the skill. For more information on sentiment analysis 
in an invoice case, see Analyze sentiments in invoice cases.

Result

You can now select  of an invoice case that displays a pop-up with a summary based on the 
sentiment.

Configure purchase order line mapping

The purchase order line-mapping skill generates the invoice line mapping, changes the invoice 
line status to review mapping state and provokes the fulfiller to manually review the mapping 
results.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Skills  to access the Now Assist skills  tab of the Now 
Assist Admin  console.

2. Select > Finance and Supply Chain  > Accounts Payable Operations  > Purchase order line 
mapping.

3. On the Purchase order line mapping summarization for the APO  specialists feature card, select 
Turn on.
The generative AI skill auto-generates mappings between invoice lines and purchase order 
lines.

Customize a Now Assist for Accounts Payable Operations (APO)  skill

If you have the admin role, you can customize a Now Assist for Accounts Payable Operations 
(APO)  skill so that an accounts payable (AP) fulfiller can use the generative AI skills in Source-to-
Pay Workspace  and in Core UI.

Before you begin
Role required: admin

About this task
From the Now Assist Admin  console, you can select the input table, related records, and fields 
for each input template of the Invoice case Summarization, Invoice data extraction skill and then 
configure the prompt headers to be included in the general summary.

Procedure

1. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

2. In the Finance and Supply Chain  workflow group, select Accounts Payable Operations  to 
view the skills for the APO  features.

3. Create a copy of a skill and customize the input fields.
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a. On the Invoice case summarization for the APO  specialists feature card, select View details.

b. In the Active skills section, locate the skill that you'd like to copy and select the More actions 

icon ( ).

c. Select Make a copy.

The copy that you make is listed in the Active skills section.

d. Select the copied skill from the Active skills section to open it.
A guided setup leads you through the configuration of the general details, input, prompt, 
availability, display, review, and activation of the customized skill. If you complete the entire 
walk-through, the skill is activated.

4. Enter a name and description for the skill.

5. Select Save and continue  to go to the next step.

6. View the input data for each skill, such as the base input fields and related lists for the different 
input templates.

Configure the base input table fields and related lists for the different input templates for the 
skill.

Each skill relies on a base input table and input fields with descriptions to provide context for 
the Now LLM Service  to generate a response.

Select only those related tables that are offered as the base system, as part of the input data.

a. For each input template state, select +New base input field  and configure the base input 
table fields.

Add multiple base input fields, as necessary.

The following table lists the base input table fields and descriptions, including a relevant 
example.

Base input fields

Field Description

Base input field
Field in the case table whose value this skill 
uses in its response.

For example, Short description.

Field description
Description of the base input field value.

For example, Short description 
of case, provides quick info 
about the case.

b. For each input template state, configure the rule conditions by using the condition builder to 
filter the data.
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The rule conditions determine when the input template is used. By default, the record state 
determines the input template that the Now LLM Service  uses.

You can build the condition out further by selecting +New condition set  and configuring 
additional parameters.

c. For each input template state, select +New data source  to configure the additional related 
table and activity stream data, as needed.

You can add input data sources like related tables, activity streams, and relationships to 
provide more context to the Now LLM Service. You can also add rule conditions to these 
additional data sources.

The selection of the related table fields may have a direct impact on the quality of the 
corresponding prompt header. For example, if a prompt header requires a specific field 
from the related table, but that field isn’t selected as input, the summary for that prompt 
header will contain missing information. For example, as a base case, you see one related 
table, such as Service level agreement (SLA), that includes all the required fields and 
filtering conditions for the prompt header. The SLA prompt header is preselected to help 
you understand how the related table, its fields, and the prompt header work together to 
produce a summary. You can use the SLA as a reference to configure the other related tables 
to determine which fields to select and which description adds the requirements of their 
respective prompt headers. Apply any additional conditions to filter the data further.

d. Select Save and continue  to go to the next step.

7. Customize the prompt.

Review and test the prompt for each input template configuration. You can edit the prompt by 
adding new predefined sections and reordering them, as needed.

a. For each input template state, select the prompt sections from the list of available sections 
to include in the generated summary.

To add a section, you must configure the relevant input data prior to this step.

The available prompt sections that you can select:

▪ Overview

▪ Actions completed

▪ Next steps

The following table lists the mandatory prompt headers.

Mandatory prompt headers

Input template state Mandatory prompt header

Open ▪ Overview

▪ Actions completed

▪ Next steps

Closed ▪ Overview

▪ Actions completed
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b. Select Save  to continue to the test response.

c. Select a record in the Test response section, and test the prompt response output format by 
selecting Run Test.

d. Select Save and continue  to go to the next step.

8. Define how the skill is available to your users.

a. Configure the skill to be always available to users, or select conditions that must be met 
before the skill is available.
Selecting Customize skill availability  displays a condition builder to filter the data further.

b. Select Save and continue  to go to the next step.

9. Configure where to display the Case summarization.

a. Select In-product.
In-product: When selected, the Now Assist  skills are displayed on the forms and 
workspaces.

For the skills that appear in-product, select the down arrow to identify the roles that can use 
the skill.

b. Select Save and continue  to go to the next step.

10. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
You can now select Summarize  in a record to generate the summary for the invoice cases.

11. For Invoice data extraction:

a. On the Invoice data extraction  for the APO  specialists feature card, select View details.

b. In the Active skills section, locate the skill that you'd like to copy and select the More actions 

icon ( ).

c. Select Make a copy.

The copy that you make is listed in the Active skills section.

d. Select the copied skill from the Active skills section to open it.
A guided setup leads you through the configuration of the general details, input, prompt, 
availability, display, review, and activation of the customized skill. If you complete the entire 
walk-through, the skill is activated.

12. To create and configure the use case for invoice extraction, follow the steps of Configuring Now 
Assist in Document Intelligence .

13. Review and activate the skill.
Review your choices and select Activate  to complete the skill customization.
You can now leverage the generative AI skill for matching invoice lines with purchase order.
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Customize Now Assist for Accounts Payable Operations (APO)  to use the Virtual Agent  chat

If you have the admin role, you can configure the Now Assist for Accounts Payable Operations 
(APO)  application so that the supplier contacts can use the generative AI skills in Source-to-Pay 
Workspace  and in Core UI.

Before you begin
Role required: admin

Install the Document Intelligence for Accounts Payable Operations Content Pack from the 
ServiceNow®  Store.

About this task
Use the Now Assist Admin  console to configure Now Assist for APO. This console contains 
everything that you need to install the plugins and configure the generative AI skills. For 
additional information, see Now Assist Admin console .

Procedure

1. Install the Now Assist for Accounts Payable Operations (APO)  plugin (com.snc.sn_ap_gen_ai).

◦ For information about the plugin dependencies and plugin activation order, see Supporting 
information for Now Assist for Supplier Lifecycle Operations (SLO).

◦ For information about the installation process, see Install Now Assist plugins .

2. Navigate to All  > Conversational Interfaces  > Assistants.

3. From the list of existing LLM Virtual Agents, select Now Assist in Virtual Agent - Supplier.

4. Review the details about Virtual Agent  by selecting Overview  and then selecting Save and 
continue  to go to the next step in Guided Setup.

5. Review the selected conversational skills by selecting Now Assist skills  and then selecting 
Save and continue  to go to the next step in Guided Setup.

6. Review the selected portal by selecting Display experience  and then selecting Save and 
continue  to go to the next step in Guided Setup.

7. Review the search sources by selecting Information Sources  and then selecting Save and 
continue  to go to the next step in Guided Setup.

8. Review the branding information by selecting Branding  and then selecting Save and continue 
to go to the next step in Guided Setup.

9. Review the structure of the chat experience by selecting Chat experience  and then selecting 
Save and continue  to go to the next step in Guided Setup.

10. Review all the details by selecting Review  and then selecting Turn on.

Using Now Assist for Accounts Payable Operations (APO)

If you've the sn_ap_apm.accounts_payable_specialist or sn_ap_cm.agent role, you can 
summarize the details of an invoice case, completed actions, or pending tasks with the Now 
Assist for Accounts Payable Operations (APO)  application.

Summarize a record by using Now Assist for Accounts Payable Operations (APO)

Summarize invoice and inquiry cases to learn about their status, progress, and action items by 
using the record summarization skill in the Now Assist for Accounts Payable Operations (APO) 
application.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_cm.agent
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About this task
You can use these record summarization skills in either Core UI  or Source-to-Pay Workspace.

• In Core UI, the summary appears in a banner in the record.

• In Source-to-Pay Workspace, the summary is generated on the Details  tab.

Procedure

1. Navigate to Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Generate a summary for either an invoice case record or an inquiry case record.

Option Procedure

Generate a summary for the invoice case 
record.

a. Navigate to Lists  >  > Invoices  > All invoic­
es.

b. Select any invoice and the link to the record 
under the Number column.

c. Open an invoice record and select Cases.

Generate a summary for the inquiry case 
record.

a. Navigate to Lists  >  > All work  > Cases.

b. Select any inquiry case and the link to the 
record under the Number column.

c. Open an invoice inquiry record.

4. On the Cases  tab, in the Record summary section, select Summarize.

When you opt to summarize an invoice case, you see the following message: "Now Assist is 
summarizing your invoice case."

Note:  Generating and displaying the summary may take several seconds.

5. Review the summary details.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1191



A concise summary of the record, including the overview, actions completed, and next steps 
are displayed. The information that is displayed is based on the type of the record.

◦ Overview: Provides information about the record.

◦ Actions Completed: Lists all the actions that have been taken so far.

◦ Next steps: Lists the actions that the AP fulfillers must take next.

6. Optional:  When you finish summarizing a record, you can add it to the work notes, expand or 
collapse it, provide feedback, copy it, or view information about it.

Option Procedure

Save the summary information by adding it 
to the recorded work notes

a. Select Share to work notes.

b. In the Share to work notes dialog box, edit 
the summary.

c. Select Save to work 

notes.

Expand or collapse the summary
Select the expanded card icon ( ) or the col­

lapse card icon ( ) to see more details or 
fewer summary details.

Provide feedback for the summary

If you think that the summary was helpful, se­

lect the helpful icon ( ). If you think that the 
summary wasn’t helpful, select the not helpful 

icon ( ).
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Option Procedure

This feedback improves the generative AI 
model and can help to improve the future ver­
sions of this skill.

Copy the record summary
Select the copy to clipboard icon ( ) to use 
the record summary information for another 
purpose, such as pasting into an email.

View the information about the record sum­
mary

If you want to check some details about the 
summary, select the more info icon ().

Use Now Assist for Accounts Payable Operations (APO)  in a Virtual Agent  chat

Use the conversational interface of Now Assist for Accounts Payable Operations (APO)  to 
request contextually relevant generative AI capabilities through a Virtual Agent  chat.

As a fulfiller, you can use the predefined topics (chatbot conversations) that are designed to help 
you complete self-service tasks. You can submit a request, track a request status, or connect to a 
live agent by using contextual generative AI capabilities.

To start a conversation, navigate to All  > Supplier Lifecycle Operations  > Supplier Collaboration 

Portal  and select the Virtual Agent chat icon ( ) as shown in the following example.

Starting screen for the Now Assist for APO  in a Virtual Agent  chat
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Then, see all your available options by selecting Show all my options  as shown in the following 
example.

All topics in a Now Assist for APO  in a Virtual Agent  chat

Using a predefined topic to submit a request

As a fulfiller, you can submit an invoice inquiry by selecting Show all my options  > Submit a 
request. You could also directly start entering the instructions.

Then, enter Invoice inquiry  in the chat, select an inquiry type, and create an invoice case 
by selecting Yes, submit  as shown in the following example.

Submit a request

Using a predefined topic to track a request status

As a fulfiller, you can track an invoice inquiry status by selecting Show all my options  > Track 
request status. You could also directly start entering the instructions.

For example, enter Invoice case number or invoice number  in the chat to view the 
status of the request as shown in the following example.
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Track a request status

Using a predefined topic to connect to a live agent

As a fulfiller, you can connect to a live agent by selecting Show all my options  > Connect to a live 
agent.

You can connect to a live agent by selecting Accounts payable team.

Additional Information

Now Assist  in Virtual Agent  provides your users with an interactive generative AI experience. 
A friendly, natural language conversation is easier to understand and makes fulfillers more 
comfortable with talking to a bot. To learn how a conversation that is powered by generative AI 
might look in Virtual Agent, see Using Now Assist in Virtual Agent .

As an administrator, you can use the Now Assist  in Virtual Agent  Analytics dashboard to monitor 
the performance of Now Assist  in Virtual Agent  as a self-service deflection tool. To learn more, 
see . Now Assist  in Virtual Agent  Analytics calculates the conversation deflection rate based on 
the resolution status associated with Now Assist  query responses. For more information, see .

For detailed information on Now Assist  in Virtual Agent  in general, and Now Assist for APO  in 
particular, see Exploring Now Assist for Accounts Payable Operations (APO).

For information on configuring Now Assist for APO, see Configure Now Assist for Accounts 
Payable Operations (APO).
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Use Invoice inquiry solution generator skill

Turn on the Invoice inquiry solution generator skill, which automates the resolution generation for 
inquiry cases.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Features  to access the Now Assist Features  tab of the 
Now Assist Admin  console.

2. Expand the Finance and Supply Chain  workflow group and select Accounts Payable 

Operations.

3. Select Invoice inquiry solution generator skill> Turn onto activate the skill.
Activate the skill in the Turn on skill  pop-up. The skill works in relation with the Inquiry 
resolution provider agent. For more information on the Inquiry resolution provider AI agent, see 
Inquiry resolution provider AI agent.

Result
The invoice and related inquiry data is analyzed by AI skills, AI agent, and case and auto-
recommends resolution, which will be reviewed by the AP agent resulting in automatic updating 
of case closure notes.

Use purchase order line mapping

AP fulfiller uses the purchase order line mapping skill to automatically map the invoice lines with 
the purchase order lines.

Before you begin
Role required: admin

Procedure

1. Activate the purchase order line mapping skill.

2. Navigate to All  > Accounts Payable Operations  > Properties.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1196



The Now Assist skill evaluates and executes rules on the invoice lines and performs the 
invoice line mapping with purchase order line mapping. For more information on setting APO 
properties, see Set APO properties. In the playbook, the match lines card allows you to review 
the mapping performed by Now Assist. For more information on the match lines card, see step 
7 of Using Playbook in Accounts Payable Operations.
The Now Assist skill maps the invoice lines with purchase order lines.

Analyze sentiments in invoice cases

Use the Sentiment Analysis skill in Now Assist for Accounts Payable Operations (APO)  to analyze 
requester's response and determine the sentiment associated with an invoice case.

Before you begin

Important:  This Now Assist  skill is turned on by default. The skill will be automatically 
available to appropriate role users for the application. For more information, see Now Assist 
skills, agents, and agentic workflows on by default .

Role required: sn_slm.fulfiller, sn_slm.owner, or sn_slm.admin

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.

4. Select an invoice case.
The case detailed view appears.

5. Select the information icon  to view the reasoning behind the generated 

sentiment.

You can view the updated Sentiment analysis by selecting the refresh icon .
Invoice cases display Sentiment analysis.

Generate email response for invoice case

Generate email response for invoice case.

Before you begin
Role required: ap_agent or ap_specialist

About this task
The Email response for invoice case skill uses invoice case details such as case type, short 
description, description, work notes, activity stream, additional comments, related records, and 
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relevant knowledge base articles to compose an email response. You can also use this skill to 
elaborate, shorten, or change the tone of your email draft.

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.

4. Select an invoice case.
The case detail view appears.

5. In the Email  tab, click anywhere within the email body text box.

6. Generate an email draft by selecting the Now Assist icon .

7. Select Insert.

8. Optional:  Select Refine  to elaborate, shorten, or change the tone of an email body.

9. Optional:  Apply templates by selecting the template 

icon .
The email response is generated for the invoice case.

Generate email response for invoice task

Generate email response for invoice task.

Before you begin
Role required: ap_agent or ap_specialist

About this task
The Email response for invoice task skill uses invoice task details such as short description, 
description, work notes, activity stream, additional comments, related records, and relevant 
knowledge base articles to compose an email response. You can also use this skill to elaborate, 
shorten, or change the tone of your email draft.

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.
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3. Select Invoices >All invoices.

4. Select an invoice case.
The case detail view appears.

5. Select Tasks.

6. In the Email  tab, click anywhere within the email body text box.

7. Generate an email draft by selecting the Now Assist icon .

8. Select Insert.

9. Optional:  Select Refine  to elaborate, shorten, or change the tone of an email body.

10. Optional:  Apply templates by selecting the template 

icon .
The email response is generated for the invoice task.

Using AI agents in Now Assist  for Accounts Payable Operations

Use the AI agents to resolve invoice inquiries autonomously; recommend business owners for 
invoices (Non-PO, Non-PO type credit memo).

Available AI agents for Accounts Payable Operations

Available AI agents Description

Inquiry resolution provider Automates responses to high-volume, 
repetitive invoice inquiries that were raised by 
suppliers. It also reduces the workload of the 
AP agents.

Recommend invoice owner When a Missing or invalid business owner 
exception occurs, the AI agent identifies the 
missing business owner through semantic 
matching or by creating tasks.

The AI agents run autonomously. For more information about the AI agents, see  Now Assist AI 
agents .

Important:  By default, all agentic workflows and AI agent records are read-only.

Looking for an AI agent?
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• There might be AI agents installed with the Now Assist application that are not used in agentic 
workflows. To learn how to see all agents that are available on your instance, see Find AI 
agents .

• To find agents that might not be installed on your instance, visit the AI Agent Marketplace  on 
the ServiceNow Store.

Related topics

Case resolution using Inquiry resolution provider

Inquiry resolution provider AI agent

Use the Inquiry resolution provider AI agent to process high volume repetitive invoice inquiries 
through various channels (web, email, virtual agent, mobile and manual entry) to significantly 
reduce the workload of human agents.

AI agents

The following table lists the agents that are used in the APO.

AI agents used

AI agent AI agent role

Inquiry 
resolution 
provider

Analyzes the inquiry case record that is based on the invoice details and related 
data. It suggests the resolution details to agents autonomously and updates the 
invoice case record with the suggested resolution.

Tools mapped to the Inquiry resolution provider AI agent

Tools used in the Inquiry resolution provider AI agent

Tool 
type

Execution 
mode

Name Description

Scripts Autonomous Invoice 
Inquiry 
resolution 
generator 
and case 
update

Collects the data related to invoice, invoice lines, invoice 
tax lines, exceptions, purchase order, purchase order line 
tables, knowledge base tables and generates resolution for 
an inquiry case and auto-updates the inquiry case record 
with the generated resolution. If invoice is not passed as 
input, the information is collected from the knowledge 
base article (with the knowledge base configured in system 
properties).

Scripts Autonomous Close the 
case

Closes the case if the user responds positively.

Related topics

Invoice inquiry cases

Work with the Inquiry resolution provider

Use the Inquiry resolution provider agent to generate resolutions to invoice inquiry cases that are 
raised by suppliers and employees.

Before you begin
Verify that the scope is set to Now Assist  for Accounts Payable Operations.
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Role required: now_assist_panel_user, admin

Procedure

1. Navigate to All  > AI Agent Studio  > Create and manage.
The Manage agentic workflows and AI agents  page appears.

2. Select AI agents.

3. Use the search icon  and select Inquiry resolution provider.

If you want to modify this AI agent, you can refer to Modify an AI agent . Adjust the 
settings for your specific needs, and activate the duplicated version of the agentic 

workflow.

4. Review the information in the Define the specialty  page, and then select Continue.
The Define the specialty  page is read-only.

5. Review the information in the Add tools and information  page, and then select Continue.
The Add tools and information  page is read-only.

6. Select Define trigger  >Resolution provider trigger  > Status  > Active.
The Define trigger page is shown 

below.

7. Select Continue.
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8. In the Toggle display  page, optionally you can enable the 
Display  option to display AI agent output in the Now Assist 

panel.

9. Select Save and test.

10. Navigate to Test AI reasoning  page to begin testing your agent.

The agent executes the testing in AI Agent Studio.

Example: Execute Invoice resolution provider agent

Example:
Enter the objective of the task as Help me resolve invoice inquiry INVC0001001 and start 
test. The AI agent starts to execute and provides the resolution plan as shown below. 

Related topics

Case resolution using Inquiry resolution provider

Case resolution using Inquiry resolution provider

The AI agent extracts invoice details and provide invoice inquiry case resolution. The AP agent 
is prompted to review the resolution. Upon confirmation from the AP agent, the case is updated 
with closure code and details.

Before you begin
Role required: now_assist_panel_user,sn_ap_cm.agent
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Procedure

1. Navigate to Source-to-Pay Workspace  > List view  > All work  > Cases  > New.
The Create new case  pop-up appears.

2. Select Invoice case.
For more information on creating an inquiry case, see Invoice inquiry cases. 
Assign the case to the AP agent and the inquiry resolution provider AI agent is 

triggered.

Result
Now Assist panel displays the resolution plan and enables agents to review the AI-generated 
resolution plan. The closure code and closure details are auto updated in the Assignment 
Closure Details  area if AP agent responds positively in the Now Assist panel.

Related topics

Case resolution using Inquiry resolution provider

Recommend invoice owner AI agent

For Non-purchase order (PO) invoices and Non-PO credit memos, the Recommend invoice 
owner AI agent is triggered when a Missing or invalid business owner exception occurs. The AI 
agent identifies the missing business owner through semantic matching or by creating tasks. The 
AI agent supports Amazon Claude,  Google Gemini, Now LLM, and GPT models.

Configuring invoice owner prediction settings

The Recommend invoice owner AI agent uses a set of configurable system properties. These 
properties define the logic to identify and assign business owners for Non-PO invoices and Non-
PO credit memos.

Navigate to All  > Accounts Payable Operations  > Administration  > Properties  to access the 
invoice owner prediction settings. These settings influence the number of historical invoices 
analyzed, the time considered, and the confidence threshold used to make recommendations. 
The AP admin can modify these settings. For more information on the settings, see Set APO 
properties.
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Invoice owner prediction settings and default values

Setting Description Default value

Number of recent invoices 
from the same supplier the 
system should review to 
predict the business owner

Defines the number of recent invoices 
from the same supplier that the AI agent 
analyzes when identifying a business 
owner.

5

The time window (in days) 
within which invoices from 
the supplier are considered

Indicates the time frame for analyzing 
historical invoices. By default, the AI agent 
evaluates invoices submitted in the past 90 
days.

90 days

The lowest confidence score 
allowed when suggesting a 
business owner based on 
supplier invoices

Specifies the minimum semantic match 
score required for the AI agent to 
recommend a business owner. When the 
match score falls below the default value, 
the AI agent prompts the AP specialist to 
create an exception task to review and 
confirm the business owner.

85

Automatically assign the 
predicted business owner if 
there’s only one match from 
the supplier and it meets the 
minimum score

Determines whether the AI agent 
automatically assigns the predicted 
business owner when there's a single, high-
confidence match. If this property is set 
to true, the system updates the business 
owner automatically.

No

Related topics

Set APO properties

Use Recommend invoice owner AI agent

Use the Recommend invoice owner AI agent to detect business owners for Non-PO invoices and 
Non-PO credit memos that lack an owner. The AI agent analyzes historically processed invoices 
to recommend the most likely business owner, which an accounts payable specialist can review, 
approve, or override.

Before you begin
Role required: Accounts Payable specialist (sn_ap_apm.accounts_payable_specialist)
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon .

3. Select My work  > Invoice exceptions.

4. From the Number  column, select the link for the 'Missing or invalid business owner' exception 
with the status Review needed.
The missing or invalid business owner exception opens. A message that Now Assist has a 
resolution plan to solve the exception displays.

5. Select View 

plan.
The AI agent summarizes the exception and provides a resolution plan. For more details on the 
resolution plan, see Resolution plan scenarios.
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6. Review and confirm the resolution 

plan.
In this scenario, a business owner is assigned. 

Result
When a business owner is found, the AI agent updates the Business owner  field on the invoice 
based on the closest matching invoice, updates the activity, and changes the exception status to 
Review complete.

If no business owner is found, the AI agent suggests creating a task.

Resolution plan scenarios

The Recommend invoice owner AI agent handles different scenarios when resolving Missing or 
invalid business owner exceptions. For each scenario, the AI agent recommends a resolution 
plan based on historically processed invoices and supplier information.

For information on using the Recommend invoice owner AI agent, see Use Recommend invoice 
owner AI agent.
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Scenarios handled by the Recommend invoice owner AI agent

No Scenario Resolution plan

1 No historically processed 
invoices exist in the system

The Recommend invoice owner AI agent 
suggests reaching out to the existing supplier 
contact. If the accounts payable specialist 
opts to reach out to supplier contact, a task is 
created and assigned to the supplier contact.

2 Single historical owner found 
in the system

The Recommend invoice owner AI agent 
prompts whether to assign the historical 
business owner.

On confirmation, the AI agent updates the 
business owner on the invoice and changes the 
exception status to Review complete.

However, if the automatic assignment property 
is set to true, the business owner is assigned 
and no confirmation is needed.

3 Multiple historical owners 
found in the system The Recommend invoice owner AI agent uses 

the score calculated by the Relevant invoice 
finder skill. If the scores of all business owners 
is less than the threshold, the agent suggests 
creating a task for the last known business 
owner.

On confirmation, the AI agent creates and 
assigns the exception task to the last known 
business owner.

If the scores of all business owners is above 
the threshold, the AI agent follows the single 
historical owner process  after selecting the 
business owner:

• If a business owner has the highest score, the 
AI agent selects that owner.

• If multiple business owners tie for the highest 
score, the AI agent selects the most recent 
owner.

Email parser agent for APO

The Email parser is an intelligent AI agent that automatically processes incoming emails (Level 
1 support cases and tasks) from suppliers and invoice owners, identifies actionable requests, 
classifies them, and routes them to the appropriate workflows to create invoice cases.s

The agent intelligently distinguishes between request types such as invoice inquiries, payment 
inquiries, payment acceleration requests, and payment term updates. This verifies that each 
query is categorized correctly and routed to the appropriate business process.
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Key benefits

• Reduced manual triage: Automated classification eliminates the need for manual email review 
and routing.

• Faster query resolution: Structured data extraction enables quicker case creation and 
response.

• Consistent categorization: All queries are classified using the same criteria, ensuring uniform 
handling across your organization.

• Improved supplier experience: Suppliers receive faster acknowledgment and status updates 
on their requests.

How it works

As a prerequisite, you must set:

• Inbound email action- Trigger Intent to Action to true

• Email properties-Inbound email configuration to true

When a supplier or invoice owner sends an email, the agent receives and processes the 
message. The agent identifies the sender's email address and validates that the sender is a 
registered, active supplier contact. It then analyzes the email content to determine whether 
it contains one or more of the following Accounts Payable Operations  request types: invoice 
inquiry, payment inquiry.

If the email matches one of the recognized request types, the agent extracts the relevant details, 
maps the request type to the appropriate case category and subcategory, and initiates a case 
creation workflow. Informational emails that don't contain actionable requests aren't processed.

Case creation behavior

The email parser agent follows these case creation rules:

• For emails with one or more recognized request types, a case is created with the appropriate 
category and subcategory.

• For emails with no recognized request types (non-actionable or informational emails), no case 
is created. The email is archived.

Explore Accounts Payable Operations
Learn about the key features and capabilities of Accounts Payable Operations.

Key features

Accounts Payable Operations  includes the following features:

• Automatically create cases for inquiries received via email from your employees or the 
suppliers

• Ingest invoices and perform end-to-end invoice processing using workflows from invoice 
ingestion to approval

Benefits

Accounts Payable Operations  offers the following benefits:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1208



• Resolve inquiries from employees and suppliers using self-service

• Automate invoice processing and therefore allocate your work resources to more important 
tasks

• Detect duplicate invoices to prevent the same invoice from being paid twice

• Verify, process, and reconcile invoices to expedite payment to suppliers

• Identify invoice exceptions to prevent fraudulent invoices from getting processed

Accounts Payable Operations  applications

Accounts Payable Operations  includes the following applications:

Accounts Payable Invoice Processing

The ServiceNow®  Accounts Payable Invoice Processing  application identifies 
invoice duplicates, matches invoices to purchase orders and goods receipts, 
enables invoice approval management, and provides invoice exception 
management.

Invoice Case Management

The ServiceNow®  Invoice Case Management  application enables you to resolve 
inquiries from suppliers or employees via invoice inquiry cases.

Source-to-Pay Workspace

The ServiceNow®  Source-to-Pay Workspace  application provides a single interface 
and an optimized layout that helps agents and Account Payable Specialists to 
efficiently manage invoice cases and invoice tasks.

Note:  Source-to-Pay Workspace  uses and customizes the existing 
capabilities of the Source-to-Pay Workspace  for its own specific requirements.

Accounts Payable Operations integration with Document Intelligence

The ServiceNow®  Accounts Payable Operations integration with Document 
Intelligence  application captures data from invoices received via email or through 
APIs and automatically creates invoices and invoice lines in Accounts Payable 
Operations.

Overview of invoice processing workflow

The following figure shows a high-level illustration of the various components 
that are involved in the processing of invoice in Accounts Payable 

Operations.
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Accounts Payable Invoice Processing

Accounts Payable Invoice Processing  (com.sn_ap_apm) enables Accounts Payable Specialists to 
ingest invoice documents and extract invoice data using ServiceNow®  Document Intelligence.

Accounts Payable Invoice Processing  enables purchase order matching, invoice  exception 
management, and invoice approval management. Thus, enabling Account Payable Specialists to 
manage the entire life cycle of an invoice, from its ingestion to approval.

For more information about installing Accounts Payable Invoice Processing, see Install Accounts 
Payable Invoice Processing.

Related topics

Source-to-Pay Workspace

Invoice Case Management

With Invoice Case Management, agents can manage and work on their assigned invoice cases, 
request more information from suppliers or employees, and create and assign tasks to users 
using the Accounts Payable workspace.

Invoice Case Management  (com.sn_ap_cm) is a dependent application and is automatically 
installed along with the Accounts Payable Operations  (com.sn_ap_apm) application. However, 
you can also install Invoice Case Management  independently. For more information, see Install 
Invoice Case Management.

The agent [sn_ap_cm.agent] and Invoice Case Management  administrator [sn_ap_cm.admin] 
roles can access the Invoice Case Management  application.

Open the Invoice Case Management  application by navigating to All  > Accounts Payable 
Operations  > Accounts Payable Workspace.

Related topics

Source-to-Pay Workspace

Source-to-Pay Workspace

The Source-to-Pay Workspace  enables you to manage and work on cases and tasks related to 
invoices and invoice exceptions.

The Source-to-Pay Workspace  provides a dashboard and tools that enable you to do the 
following:

• Manage all the invoice cases and complete your actionable tasks

• View and respond to inquiries and requests​

• View and work with all the invoices, including the invoices that have exceptions​

The Source-to-Pay Workspace  supports global search, which enables you to search for 
information using keywords. The search results include all the items that the keyword appears in, 
for example, cases, tasks, short description, content, or attached files. For more information, see 
Global search in Workspace .

Note:  The global search is available only for users with the Accounts Payable Specialist 
[sn_ap_apm.accounts_payable_specialist] role.

The Source-to-Pay Workspace  is automatically installed if any of the following applications are 
installed:
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• Accounts Payable Invoice Processing  (com.sn_ap_apm)

• Invoice Case Management  (com.sn_ap_cm)

End user and roles

End user and goal Required role

Accounts Payable Specialist: View and manage 
invoice processing cases and tasks.

sn_ap_apm.accounts_payable_specialist

Agent: View and manage invoice inquiry cases and 
tasks.

sn_ap_cm.agent

Related topics

Source-to-Pay Workspace

Accounts Payable Operations integration with Document Intelligence

Accounts Payable Operations integration with Document Intelligence  (com.sn_ap_ic) enables 
you to automatically capture data from incoming invoices, thus significantly reducing manual 
effort.

Accounts Payable Operations integration with Document Intelligence  uses the capabilities of the 
ServiceNow®  Document Intelligence  application to quickly and accurately extract information 
from invoice documents that are received as attachment via email, and creates invoice records 
in the Accounts Payable Operations  application.

Note:  Accounts Payable Operations integration with Document Intelligence  supports 
invoice documents that are in PDF, PNG, and JPEG format.

For more information, see Exploring Document Intelligence .

Related topics

Source-to-Pay Workspace

Configuring Accounts Payable Operations
Plan and configure your implementation for Accounts Payable Operations.

Install  Accounts Payable Invoice Processing

You can install the Accounts Payable Invoice Processing  (com.sn_ap_apm) application if you 
have the admin role. The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Accounts Payable Invoice Processing  application listing in the ServiceNow 
Store  for information on dependencies, licensing or subscription requirements, and release 
compatibility.

• The Accounts Payable Invoice Processing  (com.sn_ap_apm) application installs the following 
dependent plugins:
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◦ Invoice Case Management  (com.sn_ap_cm)

◦ Accounts Payable Operations integration with Document Intelligence  (com.sn_ap_ic)

Role required: admin

About this task
The following items are installed with  Accounts Payable Operations  :

• Plugins

• Roles

• Flows

• Tables

For more information, see Components installed with Accounts Payable Invoice Processing.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Accounts Payable Operations  application (com.sn_ap_apm) using the filter criteria 
and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Components installed with Accounts Payable Invoice Processing

Several types of components are installed with activation of the Accounts Payable Invoice 
Processing  plugin, including user roles, flows, and tables.
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Roles installed

Note:  The following roles are installed with Finance Common Architecture  (com.sn_fin), 
which is installed as a dependent plugin:

• sn_fin.supplier_payment_info_read: Provides read access to supplier details and 
supplier payment information tables

• sn_fin.supplier_payment_info_write: Provides write access to supplier details and 
supplier payment information tables

The sn_shop.invoice_owner role is installed with Source-to-Pay Common Architecture 
(com.snc.sn_shop), which is installed as a dependent plugin.

For information about the components installed with Invoice Case Management, see 
Components installed with Invoice Case Management.

Role title [name] Description Contains roles

Accounts Payable Invoice Processing 
Administrator

[sn_ap_apm.admin]

Can access 
all the 
features and 
capabilities 
of the 
Accounts 
Payable 
Operations 
application.

• sn_ap_cm.admin

• sla_admin

• sn__ap_apm.accounts_payable_specialist

Accounts Payable Specialist

[sn_ap_apm.accounts_payable_specialist]

• Can view 
and update 
all invoices 
and 
invoice 
exceptions.

• Can view 
purchase 
orders, 
supplier 
details, 
and 
supplier 
payments.

• sn_fin.supplier_payment_info_read

• sla_manager

• workspace_user

• canvas_user

• sn_ap_apm.reader

• sn_ap_cm.task.owner

• email_composer

Accounts Payable Invoice Processing 
Reader

[sn_ap_apm.reader]

Can view all 
the tables 
available in 
the Accounts 
Payable 
Operations 
application.

• vendor_reader

• sn_shop.procurement_common_reader
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Flows installed

Flow Description

Create 
Invoice 
Processing 
Case for 
Invoice

Creates an invoice processing case for an invoice that is received via email.

Note:  If you receive an email with N attachments, the application creates 
N invoice processing cases — a new invoice processing case for each 
attached invoice, where N is a positive number. If you receive an email with 
no attachment, then the application does not create an invoice processing 
case.

Start 
Invoice 
Processing 
for Orphan 
Invoices

Picks up all the invoice records in Draft state that do not have an invoice case 
associated to them and starts their processing.

You must activate the flow to use it. For information on how to activate the flow, see 
Activate the Start Invoice Processing for Orphan Invoices flow.

Scheduled job

Job Description

Exception Monitoring scheduler Runs on a regular schedule every five minutes 
to identify exceptions for the PO and Non-PO 
invoices that are in PO mapping completed/
Accepted  or Exceptions found  state.

Tables installed

Table Description

Invoice exception

[sn_ap_apm_exception]

Stores the exceptions found in the invoices.

Invoice exception line

[sn_ap_apm_line_exception]

Stores the line exceptions found in the invoices.

Invoice exception definition

[sn_ap_apm_exception_definition]

Extends the Application File table. Stores the exception 
definitions for an exception.

Invoice processing detail

sn_ap_apm_invoice_attribute

Stores invoice processing information

Application plugin installation sequence in Accounts Payable Operations

View the consolidated list of plugins, high-level description of each plugin, and the 
dependencies that are required before installing each plugin in Accounts Payable Operations.
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Application plugin list

Plugin name Description Dependencies

Source-to-Pay Common 
Architecture

[com.snc.sn_shop]

Maintains primary data such 
as Enterprise Resource 
Planning (ERP) sources, legal 
entities, accounting periods, 
and so on.

• Finance Common 
Architecture [com.sn_fin]

• Service Delivery Common 
[com.sn_spend_sdc]

Supplier Collaboration Portal

[com.snc.sn_supplier_sp]

Includes demo data and 
relatedServiceNow Store 
applications and plugins.

Supplier Common 
Architecture [com.snc.sn_slm]

Glide Virtual Agent Activate the virtual agent 
chatbot (chat channel) in the 
supplier portal for suppliers to 
complete Accounts Payable 
Operations related self-
service tasks.

Advanced Work Assignment 
for Source-to-Pay Operations

[com.snc.sn_spend_awa]

Provides configurations to 
support automatic routing, 
queuing, and assignment 
of procurement cases, 
emails, and live agent chat 
conversations.

• Advanced Work Assignment 
[com.glide.awa]

• Agent chat 
[com.glide.interaction.awa]

Invoice Case Management

[com.sn_ap_cm]

Includes demo data and 
relatedServiceNow Store 
applications and plugins.

• Source-to-Pay 
Common Architecture 
[com.snc.sn_shop]

• Source-to-Pay Workspace 
[com.sn_spend_workspace]

Accounts Payable Invoice 
Processing

[com.sn_ap_apm]

Enables Accounts Payable 
specialists to ingest invoice 
documents and extract 
invoice data using Document 
Intelligence

• Invoice Case Management 
[com.sn_ap_cm]

• Accounts Payable 
Operations integration with 
Document Intelligence 
[com.sn_ap_ic]

Document Intelligence

[com.snc.docintel]

Provide solutions that enables 
any organization to automate 
and accelerate the process 
of extracting data from 
documents.

sn-docintel-iframe

[com.sn_docintel_iframe]

Document Intelligent Admin

[com.snc.docintel_admin]

Provides full access to the 
Document Intelligence 
application, apart from 
modifying a subset of system 
properties, and the billing and 
internal tables.

sn-docintel-iframe

[com.sn_docintel_iframe]
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Application plugin list  (continued)

Plugin name Description Dependencies

Accounts Payable Operations 
integration with Document 
Intelligence

com.sn_ap_ic

Enables you to automatically 
capture data from incoming 
invoices, thus significantly 
reducing manual effort.

Document Intelligence

[com.snc.docintel]

Source-to-Pay Workspace

[com.sn_spend_workspace]

Provides a single environment 
for Procurement Specialists 
to work on purchase 
requisitions, sourcing 
requests, negotiations, 
procurement requests, and 
more.

Run the fix script for Accounts Payable Operations

Run the fix script for successful installation of Accounts Payable Operations.

Before you begin

• Install Accounts Payable Invoice Processing  plugin.

• Run fix script for Insufficient funds (header amount variance) exception to work.

• Set the Application scope  to Source-to-Pay Common Architecture.

• All the invoices associated with purchase order must be available in the system for Insufficient 
funds (header amount variance) exception to work.

• Ensure that invoices have same currency as that of associated with purchase order currency 
for exception to run successfully.

• You can run the fix script in batches by adding the command gr.setLimit(100000)  after 
the command line 
gr.addEncodedQuery("in_process_invoiced_amountISEMPTY". Run the script 
in batches of 100k or 200k.

• Ensure POs are updated with In process invoice amountand Invoice amount  fields.

Note:  If fix script is not executed for POs, then Insufficient funds (header amount 
variance) exception associated with a invoice will not work.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Fix scripts.

2. Click New.
A new Fix script record opens.

3. In the Name  field, enter name as Update PO Invoiced Amounts for APO.

4. In the Script  field, copy paste the below mentioned script.

updatePOInvoicedAmounts();
 
function updatePOInvoicedAmounts() {
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    var sessionCurrency = new 
 sn_currency.GlideCurrencyConfig().getSessionCurrency();
    var gr = new GlideRecord("sn_shop_purchase_order");
    gr.addEncodedQuery('in_process_invoiced_amountISEMPTY');
    gr.query();
    while (gr.next()) {
        var poSysID = gr.getValue('sys_id');
        var inProcessInvoiceAmt = 
 getInProcessInvoicedAmount(poSysID);
        var invoicedAmount = getInvoicedAmount(poSysID);
        var poCurrency = !gs.nil(gr.total_amount) ? 
 gr.total_amount.currency : sessionCurrency;
        var amtUpdated = false;
        if (!gs.nil(inProcessInvoiceAmt)) {
            inProcessInvoiceAmt = poCurrency + ';' + 
 inProcessInvoiceAmt;
           
 gr.getElement('in_process_invoiced_amount').setDisplayValue(inP
rocessInvoiceAmt);
            amtUpdated = true;
        }
        if (!gs.nil(invoicedAmount)) {
            invoicedAmount = poCurrency + ';' + invoicedAmount;
           
 gr.getElement('invoiced_amount').setDisplayValue(invoicedAmoun
t);
            amtUpdated = true;
        }
        if (amtUpdated)
            gr.update();
    }
}
 
function getInProcessInvoicedAmount(poSysId) {
    var query = 
 'invoice_amountISNOTEMPTY,^invoice_amount.amount!=0^stateINpo_m
atching_completed,exceptions_found,no_exceptions_found,pending_a
pproval,approval_recalled,approved';
    var gr = new GlideAggregate('sn_shop_invoice');
    gr.addNotNullQuery('purchase_order');
    gr.addQuery('purchase_order', poSysId);
    gr.addEncodedQuery(query);
    gr.addAggregate('SUM', 'invoice_amount.amount');
    gr.groupBy('purchase_order');
    gr.query();
    if (gr.next()) {
        var inProcessInvoicedAmt = gr.getAggregate('SUM', 
 'invoice_amount.amount');
        return inProcessInvoicedAmt;
    }
    return 0;
}
 
function getInvoicedAmount(poSysId) {
    var query = 
 'invoice_amountISNOTEMPTY,^invoice_amount.amount!=0^stateINpend
ing_payment,paid';
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    var gr = new GlideAggregate('sn_shop_invoice');
    gr.addNotNullQuery('purchase_order');
    gr.addQuery('purchase_order', poSysId);
    gr.addEncodedQuery(query);
    gr.addAggregate('SUM', 'invoice_amount.amount');
    gr.groupBy('purchase_order');
    gr.query();
    if (gr.next()) {
        var invoicedAmt = gr.getAggregate('SUM', 
 'invoice_amount.amount');
        return invoicedAmt;
    }
    return 0;
}

5. Click Submit.

6. In the fix script list view, search and select Update PO Invoiced Amounts for APO 
fix script.
The Update PO Invoiced Amounts for APO  fix script opens.

7. Select Run Fix Script.
A pop-up window appears with options to Cancel, Proceed  and Proceed in Background.

8. Click Proceed in Background.

Set APO  properties

Use the APO  properties form to set the parameters that control the invoice line mapping, invoice 
ingestion API and exception management.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Properties.
The Accounts Payable Operations properties page appears. You are prompted with a 
message, "This record is in the Accounts Payable Invoice Processing application, but Global is 
the current application. To edit this record, click here." On selecting, you are prompted with a 
message, "You are editing a record in the Accounts Payable Invoice Processing application."

2. If you aren’t able to edit the property in the current application scope, select the word here in 
the message at the top of the page.
You are prompted with a message, "You are editing a record in the Accounts Payable Invoice 
Processing application."

3. If you don’t want to proceed, select Cancel.

4. Select Save.
The changes to the application scope are saved. For more information on the form view 
options available for admin, AP admin and integrator roles, see Accounts Payable Operations 
properties.

Set system properties for invoice exception

Set the system property 
sn_ap_apm.exception.engine.max_parallel_thread_count  which defines 
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the number of parallel threads used by the exception engine scheduler to process invoice 
exceptions.

Before you begin
Role required: admin

Procedure

1. Navigate to All.

2. Search for All properties  under System properties.

3. Search for  sn_ap_apm.exception.engine.max_parallel_thread_count  and 
open the system property.
The system property 
sn_ap_apm.exception.engine.max_parallel_thread_count  opens as a 
record. The Value  field displays the default value as 4. This value indicates 4 worker threads of 
your instance will be used by the exception engine scheduler when it executes. You can edit 
the record in editing mode.

4. In the Value  field, you can enter the value as 6, or 8.
The exception engine scheduler makes use of 6 or 8 worker threads in your instance when 
it executes. This is recommended only when you have more than 2 nodes, i.e more than 16 
worker threads.

5. Select Update.

Set system properties for scheduler

Set the system property 
sn_ap_apm.exception.engine.scheduler_cool_off_period  which defines the 
time interval in minutes after which the invoice is picked for processing.

Before you begin
Role required: admin

Procedure

1. Navigate to All.

2. Search sys_properties_list.do  and open the system property.

3. Search for sn_ap_apm.exception.engine.scheduler_cool_off_period  and 
open the system property.
The system property 
sn_ap_apm.exception.engine.scheduler_cool_off_period  opens as a 
record. The Value  field displays the default value as 240. You can edit the record in editing 
mode.

4. In the Value  field, you can enter the value according to your choice.

5. Select Update.

Configure Antivirus Scanning

Configure Antivirus Scanning  across your instance and at the table level.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Dictionary.

2. Search for the table you want to exclude from the scan and select the table with Type set to 
collection.

3. In the Attributes  tab, select New.

4. Add Exclude_from_antivirus_scanin the Attributes field and enter True  in the Value 
field.

5. Select Submit.

Result
Antivirus Scanning  is enabled in your instance, and the List of Tables Excluded  on the Antivirus 
Configuration page is populated with all the tables that you excluded from the scan.

Upgrade Accounts Payable Operations

Upgrade Accounts Payable Operations  from any version to the latest version.

Before you begin
Role required: admin

Procedure

1. When you upgrade Accounts Payable Operations  from any version to the latest version, 
follow the steps mentioned in Configuring the invoice ingestion flows using Accounts Payable 
Operations integration with Document Intelligence  with the latest use case- DO NOT USE- 
Invoice Processing Vx  SYS DI Task Definition.
X refers to the latest version.

2. Create a copy of the default Invoice Processing use case.

3. Configure the newly created DocIntel Extract Values Flow.

4. Navigate to All  > Process Automation  > Flow Designer.

5. To copy and configure the invoice attachment DI processing flow, perform the following steps:

a. Search and use the existing flow that was copied from Copy and configure the Invoice 
attachment DI processing flow.

b. Open Flows.

c. Under ACTIONS, do the following:

▪ Select Process Attachment using DI  to expand it.

▪ In the SYS DI Task Definition [Use Case]  field, select the copy of the use case that was 

created using the Duplicate use case  icon ( ). For more information on copying use 
case, refer Create a copy of the default Invoice Processing use case.

d. Select Save.

e. Select Activate.

6. To copy and configure the DI STP failed flow, perform the following steps:
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a. Search and use the selected flow from DI STP failed flow.

b. Under TRIGGER, in the Condition  field, ensure that you select the copy of the use case that 
was created in Global scope.
For more information on copying use case, refer Create a copy of the default Invoice 
Processing use case.

c. Select Save.

d. Select Activate.

Upgrade Accounts Payable Operations  from version 2.0

Upgrade Accounts Payable Operations  with Document Intelligence  from lower to higher versions.

Before you begin

• Upgrade Accounts Payable Operations  version 2.0 and above to Accounts Payable Operations 
4.0 by installing Document Intelligence  version 4.0.

• As part of APO 2.0 or APO 3.0, in Use cases sys_di_task_definition  table, verify OOB 
Use case – “DO NOT USE- Invoice Processing v2”.

Role required: Admin

Procedure

1. Verify if the OOB pre-trained model Use case is available in the 
sys_di_task_definition  table.
Verify if the OOB pre-trained model is used for copying and creating Use cases. The upgrade 
applies only if the users use OOB Use case – “DO NOT USE- Invoice Processing v2” to create a 
new use case.

2. Verify the newly added pre-trained model Use case “DO NOT USE - Invoice Processing v3” 
exists.

3. Execute the following script from the background script in sn_ap_ic  Accounts Payable 
Operations integration with Document Intelligence  scope.

4. To execute the below script, perform the following steps.

functionalignParentUseCaseSysIds(oldReadOnlyUseCaseSysId,newRead
OnlyUseCaseSysId){varoldCopyUseCaseGr=newGlideRecord("sys_di_task_de
finition");oldCopyUseCaseGr.addQuery("parent_task_definition","CONTAINS","base
_trained_model");if(oldReadOnlyUseCaseSysId){oldCopyUseCaseGr.addQuer
y("parent_task_definition","CONTAINS",oldReadOnlyUseCaseSysId).addOrCondi
tion("parent_task_definition","CONTAINS","di_source");}else{oldCopyUseCaseGr.
addQuery("parent_task_definition","CONTAINS","di_source");}oldCopyUseCaseGr.
query();while(oldCopyUseCaseGr.next()){replaceCopyUseCaseSysId(ol
dCopyUseCaseGr,oldReadOnlyUseCaseSysId,newReadOnlyUseCaseSysId);
}}functionreplaceCopyUseCaseSysId(copyUseCaseGr,oldReadOnlyUseCa
seSysId,newReadOnlyUseCaseSysId){varoldParentUseCase=copyUseCase
Gr.getValue("parent_task_definition");varoldParentUseCaseObj={};varnewPa
rentUseCaseObj={};if(!
oldParentUseCase||!oldParentUseCase.includes("base_trained_model"))
{return;}oldParentUseCaseObj=JSON.parse(oldParentUseCase);newParen
tUseCaseObj=oldParentUseCaseObj;if(oldParentUseCaseObj["sys_di_parent
"]&&oldReadOnlyUseCaseSysId&&oldParentUseCaseObj["sys_di_parent"]===o
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ldReadOnlyUseCaseSysId){newParentUseCaseObj["sys_di_parent"]=newRead
OnlyUseCaseSysId;newParentUseCaseObj["base_trained_model"]=getNewRead
OnlyUseCaseTrainingSolutionName(newReadOnlyUseCaseSysId);}elseif
(oldParentUseCaseObj["di_parent"]&&!oldParentUseCaseObj["sys_di_parent
"])
{newParentUseCaseObj["sys_di_parent"]=newReadOnlyUseCaseSysId;newPar
entUseCaseObj["base_trained_model"]=getNewReadOnlyUseCaseTrainingSolu
tionName(newReadOnlyUseCaseSysId);}else{newParentUseCaseObj["base_t
rained_model"]=getNewReadOnlyUseCaseTrainingSolutionName(newReadOnl
yUseCaseSysId);}varnewParentUseCase=JSON.stringify(newParentUseC
aseObj);copyUseCaseGr.setValue("parent_task_definition",newParentUseCase
);copyUseCaseGr.update();}functiongetNewReadOnlyUseCaseTrainingS
olutionName(newReadOnlyUseCaseSysId){vargr=newGlideRecord("sys_di_t
ask_def_solution_def");gr.addQuery("task_definition",newReadOnlyUseCaseSysI
d);gr.addQuery("solution_type","be5131acb70a2110cbc68b91ee11a981");gr.query(
);if(gr.next()){returngr.getDisplayValue("ml_capability_definition_base.solu
tion_name").toString();}else{return"";}}alignParentUseCaseSysIds("54214
afa87c32110822cb887cebb35ff","d679b5744736f110d10671dc416d4390");

5. Navigate to All  > System Definition  > Scripts - Background.

6. Set the In scope  as sn_ap_ic.

7. Copy and paste the script in the Scripts  area.

8. Click Run Script.

◦ Use cases configured for Invoice processing flow in Accounts Payable Operations 
integration with Document Intelligence  scope [sn_ap_ic]  only will get upgraded.

◦ Use cases will be upgraded if there is at least one trained task that are manually trained by 
the user from Document Intelligence  Workspace.

Use cases are upgraded with latest model.

Post upgrade tasks for APO

After you upgrade to Washington DC, you must review all the post-upgrade tasks and complete 
them as needed.

Upgrade configuration for Accounts Payable Operations integration with Document 
Intelligence

After you upgrade Accounts Payable Operations to the latest version, you must review all the 
post-upgrade tasks and complete them as needed. Upgrade the copied use case to the latest 
Document Intelligence  model.

Before you begin
Role required: admin

Install the Document Intelligence for Accounts Payable Operations Content Pack from the 
ServiceNow®  Store.

Procedure

1. Select the DO NOT USE- Invoice processing V7 use case as source.

2. Navigate to All  > Document Data Extraction Administration  > Use Cases.

3. Search for DO NOT USE- Invoice processing V7 and create a duplicate copy using the  icon.

4. Save the copied use case.
Use the copied use case in flows and task definitions.
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5. To upgrade the copied use case to the latest Document Intelligence  model, perform the 
following steps:

a. Navigate to All  > Fix Scripts.

b. Search for Update DocIntel base_trained_model and select Run Fix Script.
The existing copied use case is updated to the latest DI base model.

Restructured Invoice table

The invoice and invoice line tables are restructured in the Xanadu  release.

Before Washington DC  release, invoice and invoice line tables were standalone tables. With 
Xanadu  release, the following changes are done:

• The invoice table [sn_shop_invoice] extends the base invoice table [sn_fin_base_invoice].

• The invoice line table [sn_shop_invoice_line] extends the base invoice line table 
[sn_fin_base_invoice_line].

Invoice Table structure

After you upgrade from Washington DC  to Yokohama  release, verify that your existing invoice 
and invoice line data has been migrated correctly. If you notice that your invoice and invoice line 
tables didn’t migrate properly, use the Now Support Portal  to raise a case with the Technical 
Support team.

Run a glide fix script to migrate existing data

When you update the instance from Washington DC  to Yokohama  release, you must manually 
run the glide fix to update the invoice and invoice line tables to their respective base tables.

Before you begin
Role required: maint
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Procedure

1. Navigate to All  > System Definition  > Fix Scripts.

2. Select New.
A new Fix script record opens.

3. Open the fix script record.

4. Enter Name  as re-parent invoice table.

5. Deselect the Record for rollback  check box.

6. In the Script  field, add the following code for the invoice line:

(function() {
            const invoiceLinetableToReparent = 
 "sn_shop_invoice_line";
            const invoiceLineNewExtends = 
 "sn_fin_base_invoice_line";
            const oldExtends = "";
var invoiceLineGr = new GlideRecord("sys_db_object");
        invoiceLineGr.get("name", invoiceLinetableToReparent);
        if(invoiceLineGr.super_class.name == 
 invoiceLineNewExtends) {
            gs.info("{0} table already reparented to {1}. 
 No reparenting required.", invoiceLinetableToReparent, 
 invoiceLineNewExtends);
            return;
        }
try {
 
            var invoiceLinetpc = new 
 GlideTableParentChange(invoiceLinetableToReparent);
            var reparentInvoiceLineResult = 
 invoiceLinetpc.change(oldExtends, invoiceLineNewExtends);
 
        } catch (e) {
            gs.warn("Table parent change for 
 sn_shop_invoice_line did not complete. Error: {0}", e);
        }
})();

7. In the Script  field, add the following code for invoice:

 (function() {
        const invoiceTableToReparent = "sn_shop_invoice";
        const oldExtends = "";
        const invoiceNewExtends = "sn_fin_base_invoice";
var invoiceGr = new GlideRecord("sys_db_object");
        invoiceGr.get("name", invoiceTableToReparent);
        if(invoiceGr.super_class.name == invoiceNewExtends){
            gs.info("{0} table already reparented to 
 {1}. No reparenting required.", invoiceTableToReparent, 
 invoiceNewExtends);
            return;
        }
 try {
            var tpc = new 
 GlideTableParentChange(invoiceTableToReparent);
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            var reparentResult = tpc.change(oldExtends, 
 invoiceNewExtends);
        } catch (e) {
            gs.warn("Table parent change for sn_shop_invoice 
 did not complete. Error: {0}", e);
        }
 })();

8. SelectSave.

9. Select Submit.
The Fix script is created.

10. Select Run Fix Script.
The parent invoice and invoice line tables are changed to respective base tables.

Run scheduled job for cost allocation

Run a scheduled job to copy cost allocations from invoice line to purchase order line when 
upgrading Accounts Payable Operations  from lower to higher version.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Scheduled Jobs  > Update Cost Allocation for the invoice.

2. Select the Active  check box.

3. In the script, add the following encodedQuery:

var encodedQuery = sn_shop.InvoiceLine.ORDER_LINE + 
 'ISNOTEMPTY^' + sn_shop.InvoiceLine.INVOICE + '.' + 
 sn_shop.Invoice.STATE + 'IN' + sn_shop.Invoice.STATE_DRAFT 
 + ',' + sn_shop.Invoice.STATE_PO_MAPPING_ERROR + "," + 
 sn_shop.Invoice.STATE_SUSPECTED_DUPLICATE;

4. Select Save  and Execute Now.s

Result
During the upgrade Accounts Payable Operations, cost allocation is auto-updated when 
purchase order lines are mapped to invoice lines.

Related topics

Create an invoice manually

Invoice cost allocation

Run fix script for exceptions

When you upgrade the instance from previous release to Yokohama  release, you must manually 
execute the fix script to re-calculate the amount and quantity of invoices (which are in-process 
state) with Insufficient goods receipt, Insufficient amount line and header variance logic.

Before you begin
Role required: AP admin
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Procedure

1. Navigate to Source-to-Pay Workspace  > All  > sysauto_script.LIST  table.
The Scheduled Script Executions  page appears.

2. Search for script "APM - Recalculate In-Process Invoice Amounts and Quantity".
The below image shows the Fix 

script.

3. Select Execute Now  to run the fix script.

Result
The script ensures invoices that are in-process state are re-calculated against amount and 
quantity as per the logic of Insufficient goods receipt, Insufficient line and header amount 
variance.

Related topics

Invoice exceptions

Install Invoice Case Management

You can install the Invoice Case Management  (com.sn_ap_cm) application if you have the admin 
role. The application includes demo data and installs related ServiceNow®  Store  applications 
and plugins if they are not already installed.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Invoice Case Management  application listing in the ServiceNow Store  for 
information on dependencies, licensing or subscription requirements, and release 
compatibility.

• The Invoice Case Management (com.sn_ap_cm) application installs the following dependent 
plugins:

◦ Source-to-Pay Common Architecture (snc.sn_shop)

◦ Supplier Collaboration Portal (sn_supplier_sp)

◦ Source-to-Pay Workspace (sn_spend_workspace)

Role required: admin
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About this task
The following items are installed with Invoice Case Management:

• Plugins

• Roles

• Scheduled jobs

• Tables

For more information, see Components installed with Invoice Case Management.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Invoice Case Management  application (com.sn_ap_cm) using the filter criteria and 
search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are sample records that describe application features for common use cases. Load 
the demo data when you first install the application on a development or test instance.

6. Select Install.

Components installed with Invoice Case Management

Several types of components are installed with activation of the Invoice Case Management 
plugin, including user roles, scheduled jobs, and tables.

Roles installed

Role title [name] Description Contains roles

Invoice Case 
Management 
Administrator

[sn_ap_cm.admin]

Can configure and make changes to record 
producers, invoice case assignment rules, 
invoice case SLA definitions, and email 
properties.

• sla_admin

• sn_ap_cm.agent

Invoice Case 
Management  Agent

[sn_ap_cm.agent]

Can view, create, and update invoice cases 
and tasks and manage the workflows for 
fulfilling requests.

• sn_ap_cm.requester

• sla_manager

• workspace_user

• vendor_reader
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Role title [name] Description Contains roles

• canvas_user

• sn_ap_cm.task_owner

• email_composer

Invoice Case 
Management 
Requester

[sn_ap_cm.requester]

Can create invoice inquiry cases. sn_shop.invoice_owner

Invoice Case 
Management  Task 
Owner

[sn_ap_cm.task_owner]

Can view and update the tasks that are 
assigned to them.

None

Scheduled jobs installed

Scheduled job Description

Create Inquiry 
Case on Invoice 
email

Creates an invoice inquiry case from the information in an inbound email.

You must activate the flow to use it. For information on how to activate the 
flow, see Activate the Create Inquiry Case on Invoice email flow.

Tables installed

Table Description

Invoice case

[sn_ap_cm_ap_case]

Extends the Service Case table. Stores the invoice case records.

Invoice task

[sn_ap_cm_ap_task]

Extends the Service Task table. Stores the invoice task records.

Activate the Create Inquiry Case on Invoice email flow

Activate the Create Inquiry Case on Invoice email  flow to automatically create an invoice inquiry 
case based on the information in an inbound email.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and select the Create Inquiry Case on Invoice email  flow to open it.

3. Select the more actions icon ( ) in the top right and select Copy flow.
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The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations.

6. Select Copy.
A copy of the flow opens.

7. Under TRIGGER, specify the conditions that trigger this flow.

8. Select Save.

9. Select Activate.

Install Accounts Payable Operations integration with Document Intelligence

Accounts Payable Operations integration with Document Intelligence  (com.sn_ap_ic) is installed 
automatically along with Accounts Payable Invoice Processing  (com.sn_ap_apm).

Required plugins

To use the flows for extracting data from the invoice document received as an email attachment, 
you must install ServiceNow®  Document Intelligence.

Note:  Accounts Payable Operations integration with Document Intelligence  supports 
Document Intelligence  version 2.4.

For more information, see Install Document Intelligence .

Components installed with Accounts Payable Operations integration with Document 
Intelligence

Several types of components are installed with activation of the Accounts Payable Operations 
integration with Document Intelligence  (com.sn_ap_ic) application plugin, including user roles, 
flows, and tables.

Roles required

You must have the Accounts Payable Specialist (sn_ap_apm.accounts_payable_specialist) role 
to review an invoice in Document Intelligence  and enter values in the invoice fields.

For more information about the roles that are installed with Document Intelligence, see 
Components installed with Document Intelligence .

Content pack

You must install the Document Intelligence for Accounts Payable Operations Content Pack from 
the ServiceNow®  Store.

Flows installed

Flow Description

Invoice processing case 
for Invoice email

Creates an invoice processing case after receiving an inbound 
email that contains at least one attachment, and then copies the 
email attachment to the invoice processing case.
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Flow Description

Note:  This flow is installed when you install the Accounts 
Payable Operations integration with Document Intelligence 
application.

Flows installed only when you install the Document Intelligence  application

Invoice attachment DI 
processing

Creates the DocIntel  task for processing the invoice attachment 
and creates the invoice stage record for storing the extracted data 
from the invoice attachment.

DocIntel Extract Values 
Flow - Invoice Processing 
v1.2 - Invoice Processing 
v1.2 v1.2 - Invoice 
Processing v1.2

Populates the extracted data from the DocIntel task to the invoice 
stage and invoice line stage records and updates Invoice stage 
status to Processing completed.

Invoice Stage to Invoice 
Transformation

This flow does the following:

• Runs the transformation logic for the invoice stage and the 
invoice line stage records

• Updates the invoice to Received  state and associates the invoice 
with the invoice processing case if all the prerequisite conditions 
for the transformation are met

• Updates the invoice processing case’s DocIntel Status to 
Processed (STP completed) if the DocIntel status is still in 
Processing

DI STP Failed Processes the DocIntel task that does not fail or that does not 
undergo straight through processing. This flow updates its 
associated invoice stage to Processing error and updates the 
invoice processing case’s DocIntel status to Processed (STP failed) 
or Failed, respectively.

Tables installed

Table Description

Invoice Stage

[sn_ap_ic_invoice_stage]

Stores the invoice data extracted from the invoice.

Invoice Line Stage

[sn_ap_ic_invoice_line_stage]

Stores the invoice line data extracted from the invoice.

Invoice Processing use case

Accounts Payable Operations integration with Document Intelligence  provides the DO NOT USE 
- Invoice Processing  use case.

The DO NOT USE - Invoice Processing  use case identifies the information to extract invoice 
documents received as email attachments and determines how a user with the Accounts 
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Payable Specialist role interacts with the extracted values in the Document Intelligence 
workspace.

Note:  The DO NOT USE - Invoice Processing  use case is read-only and cannot be edited.

The DO NOT USE - Invoice Processing  use case contains the list of invoice fields to extract data 
from invoice attachments and stores this data in the invoice stage record. It also contains an 
extraction flow that populates the extracted invoice data into the invoice stage and invoice line 
stage records and updates the Invoice stage status to Processing completed.

You can access this use case by navigating to All  > Document Intelligence  > Use Cases  > DO 
NOT USE - Invoice processing.

The DO NOT USE - Invoice Processing  use case includes the following information.

Invoice processing use case

Use case 
information

Description

Fields Contains the list of invoice and invoice line fields to extract information from an 
invoice document. A field is a single piece of information to extract from an invoice 
document. In the use case, invoice date is of data type "Date field". For example, 
in case of ambiguous date format such as 01-02-2024, the use case (the current 
use case) interprets the date as month followed by day or vice versa through the 
DI administration configuration menu. The platform admin [platform_ml_di.admin] 
manually configures the use case in the DI administration menu. For more 
information on the DocIntel  fields used to extract data, see .

For the list of invoice and invoice line fields included in the DO NOT USE - Invoice 
Processing  use case, see List of invoice and invoice line fields included in the use 
case for Accounts Payable Operations integration with Document Intelligence.

Field 
Groups

Includes the Invoice Lines  field group that maps to the Invoice Line Stage 
[sn_ap_ic_invoice_line_stage] target table where the extracted invoice line 
information from the invoice document is stored.

Document 
tasks

Includes a document task to train the Document Intelligence model to identify the 
correct information to extract from an invoice document.

Integration Maps to the DO NOT USE - Invoice processing  use case that contains the 
DocIntel Extract Values Flow - Invoice processing v1.2 - Invoice Processing 
v1.2  extraction flow, which populates the extracted invoice data into the invoice 
stage and invoice line stage records. It also updates the Invoice stage status to 
Processing completed.

List of invoice and invoice line fields included in the use case for Accounts Payable Operations 
integration with Document Intelligence

The DO NOT USE - Invoice Processing  use case includes the following set of invoice and invoice 
line fields from which to extract information from your invoice documents.

List of invoice and invoice line fields included in the use case

Field Description

Invoice Fields
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List of invoice and invoice line fields included in the use case  (continued)

Field Description

Supplier invoice 
number

The invoice number of the supplier invoice.

Supplier Supplier who delivers the product or service.

Supplier tax id The tax ID of the supplier.

Invoice date Date on which this invoice is created.

Purchase order Purchase order associated with this invoice.

Supplier bank name Bank name of the supplier.

Account number Bank account number of the supplier.

ACH routing number Unique, nine-digit number used to identify banks and financial 
institutions.

Swift code Standard format for the Bank Identifier Code (BIC) that is used to identify 
banks and financial institutions.

Wire routing number Unique, nine-digit number used to identify banks and financial 
institutions.

Tax rate Tax rate applied on the invoice amount.

Amount invoiced Total amount to be paid to the supplier including tax and shipping 
charges.

Subtotal The total amount from all the invoice lines without tax and shipping 
charges.

Shipping amount Shipping charges incurred for the invoice.

Other charges Other charges applied on the invoice amount.

Tax amount Tax applied on the invoice amount.

Invoice currency The currency mentioned in the invoice.

Bill to company 
name

The name of the company to which the invoice is billed.

Bill to city The city to which the invoice is sent.

Bill to country The country to which the invoice is sent.

Bill to state/province The state to which the invoice is sent.

Bill to street The street address to which the invoice is sent.

Bill to zip/postal 
code

The zip code to which the invoice is sent.

Remit to city The city to which the payment is made.

Remit to country The country to which the payment is made.

Remit to state/
province

The state to which the payment is made.

Remit to street The street address to which the payment is made.
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List of invoice and invoice line fields included in the use case  (continued)

Field Description

Remit to zip/postal 
code

The zip code to which this payment is made.

Invoice ship to city The city to which the items on the purchase order should be shipped.

Invoice ship to 
country

The country to which the items on the purchase order should be 
shipped.

Invoice ship to state/
province

The state to which the items on the purchase order should be shipped.

Invoice ship to street The street address to which the items on the purchase order should be 
shipped.

Invoice ship to zip/
postal code

The zip code to which the items on the purchase order should be 
shipped.

Invoice Line Fields

Line amount Total amount for the invoice line item.

Line tax amount Tax amount for the invoice line item.

Line unit price Unit price of the line item in the invoice.

Line quantity The number of items that have been invoiced.

Line description Description for the invoice line.

Configuring the invoice ingestion flows using Accounts Payable Operations integration with 
Document Intelligence

Configure Accounts Payable Operations integration with Document Intelligence  to automatically 
create an invoice processing case and extract the required data from an invoice attachment 
received via email.

The process for configuring Accounts Payable Operations integration with Document 
Intelligence  includes the following scenarios:

Configuration scenarios for invoice ingestion flows using Accounts Payable Operations 
integration with Document Intelligence

Scenario Do this

When Document Intelligence  is 
installed and you want to use the 
invoice ingestion flows

1. Create a copy of the default Invoice Processing use case.

2. Do the following to configure the invoice ingestion flows:

a. Configure the newly created DocIntel Extract Values 
Flow.

b. Copy and configure the Invoice processing case for 
Invoice email flow.
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Configuration scenarios for invoice ingestion flows using Accounts Payable Operations 
integration with Document Intelligence  (continued)

Scenario Do this

c. Copy and configure the Invoice attachment DI 
processing flow.

d. Copy and configure the DI STP Failed flow.

3. Perform the steps described in KB article KB1286265  to 
run the business rule to delete the duplicate ml_solution 
record from the ML Solution [ml_solution] table.

When Document Intelligence  is 
not installed Copy and configure the Invoice processing case for Invoice 

email flow when Document Intelligence is not installed.

When Document Intelligence  is 
installed but you want to disable 
the invoice ingestion flows

1. Configure the Invoice processing case for Invoice email 
flow for disabling the Document Intelligence capability.

2. Deactivate the Invoice attachment DI processing flow.

Create a copy of the default Invoice Processing use case

Create a copy of the default invoice processing use case to customize the invoice flow in your 
environment.

Before you begin
Ensure that the application scope is set to Accounts Payable Operations integration with 
Document Intelligence.

Role required: admin

About this task
Do this task to copy the default DO NOT USE- Invoice Processing V7  use case along with its 
fields, field groups, integrations, flows, and all the related machine learning (ML) models.

Procedure

1. Navigate to Workspaces  > All  > Document Intelligence  > Document Data Extraction 
Administration  > Use cases.

2. Open the DO NOT USE- Invoice Processing V7  use case.

3. Select Duplicate use case  icon ( ).
You will be prompted with a message "Choose the name for this use case".

4. Click Duplicate  button

◦ The copy is saved automatically into your environment.

◦ A copy of the DO NOT USE - Invoice Processing V7 use case is created with the name 
entered. You can see the copied use case by navigating to All  > Document Intelligence 
> Use Cases. For more information on configuring use case, see Configuring Document 
Intelligence .

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1235

https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1286265
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1286265
https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB1286265
https://www.servicenow.com/docs/access?context=doc-intel-administration&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=doc-intel-administration&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=doc-intel-administration&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=doc-intel-administration&version=yokohama&pubname=yokohama-intelligent-experiences&ft:locale=en-US


◦ A flow named DocIntel Extract Values Flow is created. This flow is suffixed with the name of 

the copied use case that was created after you clicked the copy ( ) icon. For example, 
DocIntel Extract Values Flow - name of the entered use case - Invoice Processing v7. You can 
see this flow by navigating to All  > Process Automation  > Flow Designer  and searching for 
the flow name.

You must add the missing information in the newly created flow by copying the existing 
information from the default DocIntel Extract Values Flow - Invoice Processing v7. For more 
information, see Configure the newly created DocIntel Extract Values Flow.

Configure the newly created DocIntel Extract Values Flow

Configure the newly created DocIntel Extract Values Flow - copied use case - Invoice 
Processing v7  flow to add the missing information by referring to the default DocIntel Extract 
Values Flow - Invoice Processing v7  flow.

https://player.vimeo.com/video/1097547868?
h=5748107e08&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: admin

About this task
In the DocIntel Extract Values Flow - copied use case - Invoice Processing v7  flow, perform the 
following steps.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the DocIntel Extract Values Flow - Invoice Processing v7  flow.

3. In the DocIntel Extract Values Flow - copied use case - Invoice Processing v7  flow, under 
TRIGGER, do the following:
Configure the condition by appending AND  condition with existing condition where the new 
condition is Use case  which is equal to copied use case. Example: Use case=<<copied use 

case>>.

4. In the DocIntel Extract Values Flow - copied use case - Invoice Processing v7  flow: under 
Actions, configure new actions similar to Look up Invoice Stage Record  (action 3), Look 
up Invoice Case Record  (action 4), Condition label : Check if invoice on invoice case is 
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not empty  (action 5, 6, 7) and Update stage record  (action 8) from flow mentioned in step 

2.

5. Select Save.

6. Select Activate.

Copy and configure the Invoice processing case for Invoice email flow

Copy and configure the Invoice processing case for Invoice email flow and add a trigger 
condition to specify when to create an invoice processing case.

https://player.vimeo.com/video/1092942669?
h=86d966de3d&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: admin

About this task

When act ivated, this flow automatically creates an invoice processing case for an inbound 
email.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the Invoice processing case for Invoice email  flow.

3. Select the more actions icon () in the top right and select Copy flow.
The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations integration with Document 
Intelligence.
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6. Select Copy.
A copy of the flow opens.

7. Under TRIGGER, select Inbound Email.

8. In the Trigger  field, leave the trigger as Inbound Email.

9. Update the email conditions according to your business requirements.

Note:  Don't activate this flow without configuring email conditions to specify when to 
create an invoice processing case. Otherwise, an invoice processing case is created for 
any email that you receive.

10. Select Save.

11. Select Activate.

Copy and configure the Invoice attachment DI processing flow

Copy and configure the Invoice attachment DI processing flow and activate this flow to use it.

Before you begin
Role required: admin

Scope: sn_ap_ic scope.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the Invoice attachment DI processing  flow.

3. Select the more actions icon ) in the top right and select Copy flow.
The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations integration with Document 
Intelligence.

6. Select Copy.
A copy of the flow Invoice Attachment DI Processing flow opens.

7. Under Trigger, select Use case  is copied Doc Intel use case  and Done.

8. Under ACTIONS, do the following:

◦ Select Process Attachment using DI  to reference the use case created by the customer.

◦ In the DI Task Definition [Use Case]  field, select the copy of the use case that was created 

using the Duplicate use case  icon ( ) in sn_ap_ic scope. For more information on 
copying use case, refer Create a copy of the default Invoice Processing use case.

9. Select Save.

10. Select Activate.

Copy and configure the DI STP Failed flow

Copy and configure the DI STP Failed flow and activate this flow to use it.

https://player.vimeo.com/video/1100004682?
h=8cae754d09&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Before you begin
Role required: admin

Scope: sn_ap_ic scope.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the DI STP Failed  flow.

3. Select the more actions icon ( ) in the top right and select Copy flow.
The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations integration with Document 
Intelligence.

6. Select Copy.
A copy of the flow opens. Under TRIGGER, in the Condition  field, copy "DI STP Failed" 
flow and update trigger condition to reference the use case created by the customer. 
Use the AND operator and select Use case  is copied Gen AI use case  and Done. 
Use the AND operator and, select Use case  is copied Gen AI use case  and Done. 

. 
For more information on copying use case, refer Create a copy of the default Invoice 
Processing use case  and Copy and activate the generative AI DocIntel flow.

7. Select Save.

8. Select Activate.

Copy and configure the Invoice processing case for Invoice email flow when Document 
Intelligence  is not installed

Copy and configure the Invoice processing case for Invoice email flow and add a trigger 
condition to specify when to create an invoice processing case when Document Intelligence  is 
not installed.

https://player.vimeo.com/video/1092942669?
h=86d966de3d&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin
Role required: admin
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About this task
The Invoice processing case for Invoice email is the only flow that is available if you don't install 
the Document Intelligence  application. When activated, this flow automatically creates an invoice 
processing case for an inbound email.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the Invoice processing case for Invoice email  flow.

3. Select the more actions icon ( ) in the top right and select Copy flow.
The Create a copy of this flow dialog box is displayed.

4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations integration with Document 
Intelligence.

6. Select Copy.
A copy of the flow opens.

7. Under TRIGGER, select Inbound Email.

8. In the Trigger  field, leave the trigger as Inbound Email.

9. Update the email conditions according to your business requirements.

Note:  Don't activate this flow without configuring email conditions to specify when to 
create an invoice processing case. Otherwise, an invoice processing case is created for 
any email that you receive.

10. Under ACTIONS, do the following:

a. Select Accounts payable case Record  to expand it.

b. Under Fields, in the DocIntel status  field, select Not applicable.

11. Select Save.

12. Select Activate.

Configure the Invoice processing case for Invoice email flow for disabling the Document 
Intelligence  capability

Configure the copied version of the Invoice processing case for Invoice email  flow for disabling 
the Document Intelligence  capability.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the copied version of the Invoice processing case for Invoice email  flow.

3. Under ACTIONS, do the following:

a. Select Accounts payable case Record  to expand it.

b. Under Fields, in the DocIntel status  field, select Not applicable.

4. Select Save.

5. Select Activate.
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Copy and activate the generative AI DocIntel  flow

Copy and activate the DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice 
Processing - Gen AI Integration  flow.

Before you begin
Role required: admin

Scope: Accounts Payable Operations integration with Document Intelligence.

Plugins required:

• Now assist in Document Intelligence

• Account Payable Invoice Processing

• Now assist for Account Payable Operations

• Document Intelligence for Accounts Payable Operations Content Pack

About this task

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice 
Processing - Gen AI Integration  flow.

3. Select the  icon > Copy flow.
A copy of the DocIntel Extract Values Flow - Invoice 
Processing - Gen AI - Invoice Processing - Gen AI Integration  is 

created.

4. Select Save  > Activate.
The DocIntel Extract Values Flow - Invoice Processing - Gen AI - Invoice Processing - Gen AI 
Integration  is copied and activated successfully.

Deactivate the Invoice attachment DI processing flow

Deactivate the Invoice attachment DI processing flow when you don't want to use the Document 
Intelligence  capability.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and open the copied version of the Invoice attachment DI processing  flow.

3. Select Deactivate.
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How Accounts Payable Operations integration with Document Intelligence  works

Accounts Payable Operations integration with Document Intelligence  uses automated workflows 
to extract the required information from the invoice document received as an email attachment, 
creates an invoice record in Accounts Payable Operations, and adds the extracted information 
into the newly created invoice record.

Invoice ingestion process flow when extraction confidence is high

When you receive an invoice as an attachment via email from a supplier or an employee, the 
following occurs:

1. An invoice case is created with category Invoice automation  and subcategory Invoice 
processing  in Accounts Payable Operations.

2. If Document Intelligence  determines that the extraction confidence is higher than the 
threshold value, it extracts the invoice data and stores the data in temporary staging tables.

3. The Document Intelligence  transformation process imports the invoice data from the staging 
tables, creates an invoice in the Draft state, and associates the invoice with the invoice 
processing case.

4. The application verifies the following:

◦ The required fields are populated on the invoice.

▪ If the required fields aren’t populated on the invoice, the Accounts Payable Specialist is 
required to open the invoice, manually enter the required values in the required fields, and 
submit the invoice.

▪ If the required fields are populated on the invoice, the invoice is auto-submitted.

◦ At least one invoice line record exists for the invoice. If not, the Accounts Payable Specialist 
must add an invoice line record and submit the invoice.

◦ If a unique currency code isn’t identified during currency transformation, the process uses 
the currency mentioned in the purchase order. If the currency is missing in the purchase 
order, the transformation process uses the session currency based on the user's locale. In 
this case, the Accounts Payable Specialist is required to open the invoice processing case, 
and enter the correct currency code in the invoice fields and submit the invoice. For more 
information, see Invoice data transformation logic.

For more information about the required fields for invoice and invoice lines, see Required fields 
for creating an invoice.

After the invoice is submitted, its state changes to Received. The invoice processing begins 
from this point. For more information, see Work on an invoice processing case.

Invoice ingestion process flow when extraction confidence is low

When you receive an invoice as an attachment via email from a supplier or an employee, the 
following occurs:

1. An invoice case is created with category Invoice automation  and subcategory Invoice 
processing  in Accounts Payable Operations.

2. If Document Intelligence  determines that the extraction confidence is lower than the threshold 
value, it doesn’t extract the invoice data and as a consequence an invoice isn’t created.

3. In this scenario, the Accounts Payable Specialist must do the following:

a. Open the invoice processing case created in step 1.

The case displays the following error message: Invoice has a data extraction error. Review 
invoice with automation to continue processing.
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b. Select Review invoice, which opens Document Intelligence  and displays the invoice fields.

c. Enter the required values into the invoice fields, and select Submit.

4. The Document Intelligence  transformation process imports the invoice data from the staging 
tables, creates an invoice in the Draft state, and associates the invoice with the invoice 
processing case.

5. The application verifies the following:

◦ The required fields are populated on the invoice.

▪ If the required fields aren’t populated on the invoice, the Accounts Payable Specialist is 
required to open the invoice, manually enter the required values in the required fields, and 
submit the invoice.

▪ If the required fields are populated on the invoice, the invoice is auto-submitted.

◦ At least one invoice line record exists for the invoice. If not, the Accounts Payable Specialist 
must add an invoice line record and submit the invoice.

◦ A unique currency code exists on the invoice. If a unique currency code isn’t identified 
during currency transformation, the process uses the currency mentioned in the purchase 
order. If the currency is missing in the purchase order, then the transformation process 
uses the session currency based on the user's locale. In this case, the Accounts Payable 
Specialist is required to open the invoice processing case and enter the correct currency 
code in the invoice fields and submit the invoice. For more information, see Invoice data 
transformation logic.

For more information about the required fields for invoice and invoice lines, see Required fields 
for creating an invoice.

After the invoice is submitted, its state changes to Received. The invoice processing begins 
from this point. For more information, see Work on an invoice processing case.

Invoice ingestion process flow when the entire transformation process fails

When the Document Intelligence  transformation process fails entirely, the following error 
message is displayed on the invoice processing case:

Invoice automation is experiencing issues. Please contact the administrator.

You must collaborate with the administrator to resolve this issue.

Localization information

Accounts Payable Operations  supports multiple languages. The current DocIntel  model is 
trained to extract invoices in the English language only. If you want to process the invoice in 
multi-lingual languages supported by DocIntel, you must train the DocIntel  model on your own.

For more information on Document Intelligence, see Document Intelligence .

Required fields for creating an invoice

The Accounts Payable Operations integration with Document Intelligence  application checks 
whether the required fields are populated on the invoice and invoice lines for creating the 
invoice.
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Required fields for invoice and invoice lines

Required field for invoice Required field for invoice line

Supplier invoice number Line description

Invoice date Line amount

Invoice amount Line unit price

Supplier Invoiced quantity

Invoice data transformation logic

Accounts Payable Operations integration with Document Intelligence  converts the invoice and 
invoice line field values from the invoice document to a format supported by the system that 
processes the invoice.

Type deriving logic

The application includes the following logic for deriving the type field on the invoice.

• Considers the purchase order value in the invoice stage record

• If the purchase order value isn’t empty, then the invoice type is set to PO type.

• If the purchase order value is empty, then the invoice type is set to Non- PO type.

Date conversion logic

The application includes the following logic for converting date formats mentioned in the invoice 
document:

• Considers YYY-MM-DD as the ISO format and the system format for date conversion.

• Considers dates only in MM-DD-YYYY format for conversion.

• Doesn’t consider dates in DD-MM-YYYY format if DD is less than 12.

Invoice date conversions

Date format in the incoming invoice Converted date format

2nd Sep, 2022 2022-09-02

3rd September, 2022 2022-09-02

02-Sep-2022 2022-09-02

02-Sept-2022 2022-09-02

Sept-02-2022 2022-09-02

Sep-02-2022 2022-09-02

09-02-2022 2022-09-02

02-09-2022 2022-02-09

09/02/2022 2022-09-02

02/09/2022 2022-02-09
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Currency conversion logic

The application supports different locale such as US, European and Indian number systems. For 
example, "X,XXX.XXX", "X.XXX,XX", "XX,XX.XXX" where X is a single-digit positive number.

Scenario
Currency format in the incoming 
invoice

Converted currency format

Amount followed by a space 
and the currency code

76 EUR 76 EUR

Amount followed by a space 
and the currency symbol

76 € 76 EUR

Currency code followed by 
multiple spaces and the 
amount

EUR 76 76 EUR

Currency symbol followed 
by multiple spaces and the 
amount

€ 76 76 EUR

Amount without a currency 
code or symbol

76 76 (followed by the purchase 
order currency or the session 
currency)

Amount separated by comma, 
dot or any other grouping or 
decimal separator followed 
by a space and the currency 
code

7.123.456,99 EUR 7123456.99 EUR

Amount followed by the 
currency code without any 
space

76EUR 76 EUR

Amount followed by the 
currency symbol without any 
space

76€ 76 EUR

Currency code followed by the 
amount without any space

EUR76 76 EUR

Currency symbol followed by 
the amount without any space

€76 76 EUR

The application first looks for the active unique currency code in the Currency [fx_currency] table 
when an incoming invoice amount has a currency symbol or code. If multiple currency matches 
are found or the incoming invoice amount has no currency code or symbol, then the application 
runs the defaulting currency logic depending on the invoice type as follows.

• PO invoice - Searches for purchase order and related currency, and sets the invoice currency 
to purchase order currency. In case of missing purchase order or related currency, the invoice 
currency is set to system currency.

• Non- PO invoice - Searches for legal entity and local currency, and sets the invoice currency 
to the legal entity's local currency. In the case of missing legal entity and local currency, the 
invoice currency is set to system currency.
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Unit Price conversion logic

The application supports different locale such as US, European and Indian number format locale. 
For example, "X,XXX.XXX", "X.XXX,XX", "XX,XX.XXX" where X is a single-digit positive number.

If the incoming invoice unit price consists of currency symbol or code present in Currency 
[fx_currency] table, then the unit price is converted. For example, $ XX,XXX,XXX.XX or USD 
XX,XX,XXX.X, where X is a single-digit positive number.

Unit price conversion

Unit price mentioned in the incoming invoice Converted unit price

1,000,25.10 100025.10

1,00,025.10 100025.10

$1,000,25.10 100025.10

1,000,25.10 $ 100025.10

USD1,00,025.10 100025.10

1,00,025.10 USD 100025.10

Decimal conversion logic

The application supports different locale such as US, European and Indian decimal format locale. 
For example, "X,XXX.XXX", "X.XXX,XX", "XX,XX.XXX" where X is a single-digit positive number.

Currency groupings on invoice and invoice lines are determined based on the user system 
locale settings. European currencies consider comma as a decimal separator and dot as 
a thousand separators. In some cases, various characters can also be used as grouping 
separator. The incoming invoice and invoice lines present in [sn_ap_ic_invoice_stage] and 
[sn_ap_ic_invoice_line_stage] tables are converted based on the positioning of decimal and 
thousand separators.

Note:  During conversion, for numbers such as 100,251 and 100.251, the system checks 
for other decimal separators mentioned in the invoice, and converts it to the appropriate 
decimal format. If the invoice contains fields with a single decimal separator, then 
conversion doesn’t apply for the invoice, and the value is set to empty as shown in the 
following table.

For more information on currency conversion, see Currency administration .

Decimal conversion

Decimal format mentioned in the incoming invoice Converted decimal format

1,000,25.10 100025.10

1,00,025.10 100025.10

100,251 100,251

10.102,510 10102.51

10.10.102,510 1010102.51

100,251

100.251
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Logic to fetch reference field values

Logic to fetch reference field values

Reference 
Field

Logic to fetch the field value

Legal 
Entity

The system fetches the value by checking the following values in the order listed:

1. Bill to company

2. Street, City, State, Country, Zip

3. City, State, Country, Zip

4. State, Country, Zip

5. Country, Zip

6. Country

7. Zip

Purchase 
Order

The system does the following:

• The system considers the purchase order value mentioned in the invoice stage

• If the purchase order value is prefixed with special characters, alphabets or 
zeroes, then the application ignores the prefixes and matches the remaining 
purchase order value with the ERP number from the purchase order table

• If a unique purchase order is found, then the application populates the purchase 
order in the invoice

Supplier The system does one of the following:

• The system considers the value mentioned in the invoice and does a complete 
match with supplier in Supplier table.

• If the invoice contains a purchase order associated with the supplier, the 
application matches with the supplier name mentioned in the invoice with the 
supplier name of purchase order and populates the supplier.

• If the invoice document contains supplier name with more than two words, the 
application performs partial name match against the supplier details in the 
supplier table along with street address or city. Example. If the invoice document 
contains supplier name as XX Corp, and the supplier name in the supplier table is 
XX Ltd, the application matches XX in supplier table along with the address and 
populates the invoice document with the corresponding supplier.

If a unique supplier record is found in any of the above, then the application 
populates the supplier in the invoice.

Country The system does one of the following:

• Considers the value mentioned in the invoice

• If this value isn’t mentioned in the invoice, it populates the International 
Organization for Standardization (ISO) short country name or the ISO long country 
name

Subtotal, 
Tax 

The system does the following:
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Logic to fetch reference field values  (continued)

Reference 
Field

Logic to fetch the field value

amount, 
Other 
charges

• If the invoice contains XX.XXX,XXX the application groups the numeric to four 
digits after decimal separator.

• If the invoice contains three numeric digits after the separator, the application 
sets the invoice fields to empty.

• If the invoice contains a combination of decimal and thousand separators in a 
form, the application defaults to the numeric value to the decimal separator.

• If the invoice contains negative amount or negative quantity, then the DocIntel 
transformation logic is updated to extract negative amounts where the negative 
sign is either:

◦ Present after the value (header or line level)

◦ Present within a bracket (header or line level)
In such cases, the invoice is considered as of type Credit memo.

Domain separation and Accounts Payable Operations

Domain separation is unsupported for Accounts Payable Operations. Domain separation 
enables you to separate data, processes, and administrative tasks into logical groupings called 
domains. You can control several aspects of this separation, including which users can see and 
access data.

Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Using Accounts Payable Operations
Accounts Payable Specialists and agents can use Accounts Payable Operations  to manage 
cases, invoices, route cases to agents, invoice exceptions and integrate with other applications.

Create a knowledge base article about invoice

Create a knowledge base article to share invoice information and policies with your employees 
and suppliers.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist

Procedure

1. Navigate to All  > Knowledge.

2. Select Create Article.

3. On the form, fill in the fields.
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Create new article form

Field Description

Number System-generated unique identifier for the 
request.

Knowledge base Knowledge base to which this article belongs.

Category Category of the article such as Accounts 
Payable. Use the category picker to select 
an existing category or subcategory. You can 
create a category or subcategory to suit your 
requirements.

Valid to Validity of the article.

Article type Type of article such as HTML.

Workflow Status of the article.

Scheduled publish date Date on which you want the article to be 
published.

Valid to Set the validity of the article.

Source Task Name of the article source.

Attachment link Link to attachments.

Display attachments Display of attachments in the article. When 
you do not select this option, the article does 
not display the attachments.

Short description Short description of the article.

Article body Detailed description of the article.

4. Optional:  To check if any duplicate articles are available with similar short descriptions, select 
Search for Duplicates.

5. Do one of these actions.

Action Description

Submit To submit an article for review, select Submit.

Save
To save an article, from the Additional actions 
menu, select Save.

Result
Knowledge base articles are created to share invoice information and policies with employees 
and suppliers.

What to do next

• View your submitted articles by navigating to Knowledge  > My Knowledge Articles

• Track the progress of your article from My Knowledge Articles.

• Manage the article workflows, such as reviewing, publishing, updating, or retiring the article.
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Invoice case categories and subcategories

An agent and Accounts Payable Specialist can access and work on the invoice cases in the 
Accounts Payable workspace.

The following table provides information about the invoice case categories and subcategories, 
when the cases are created, and which roles can access and work on these cases.

Account Payables cases

Category Subcategory Role Description

Inquiry • Payment 
inquiry

• Invoice 
inquiry

• Expedite 
payment 
request

• Payment 
terms 
issue

• Invoice 
entry 
assistance

Agent

[sn_ap_cm.agent]
You can view the 
invoice inquiry cases 
in the Source-to-Pay 
Workspace.

For more information, 
see Invoice inquiry 
cases.

Invoice 
automation

Invoice 
processing

Accounts Payable Specialist

[sn_ap_apm.accounts_payable_specialist]
You can view the 
manual invoice 
ingestion cases in 
the Source-to-Pay 
Workspace.

For more information, 
see Invoice processing 
cases.

To view the invoice cases, do the following:

1. Navigate to Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ As an Accounts Payable Specialist:

▪ Navigate to Lists  > My Work  > Open cases

▪ Navigate to Lists  > All Work  > Cases.

Open invoice cases under My work.
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All invoice cases under All 

work.

◦ As an agent, you can view inquiry cases:

▪ Navigate to Lists  > My Work  > Open cases

▪ Navigate to Lists  > All Work  > Cases
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With Invoice Case Management, agents can manage and work on their assigned invoice 
cases, request more information from suppliers or employees, and create and assign tasks 
to users using the Accounts Payable workspace.

Using Invoice Case Management

Agents can use Invoice Case Management  to manage and work on invoice inquiry cases raised 
by employees and suppliers to resolve issues related to invoices.

Invoice inquiry cases

Invoice inquiry cases help you resolve invoice-related issues raised by the suppliers or 
employees.

When you receive an email for an inquiry, the application automatically creates an invoice case 
with a category of Inquiry  and one of the following sub-categories:

• Payment inquiry

• Invoice inquiry

• Expedite payment request

• Payment terms issue

• Invoice entry assistance

• Other

Note:  An invoice case with a category of Inquiry  is referred to as an invoice inquiry case.

However, an agent [sn_ap_cm.agent] can manually create invoice inquiry cases and work on 
them or create Accounts Payable tasks for those cases and assign them to a user or group. For 
more information, see Create an invoice inquiry case manually.

Invoice inquiry case life cycle

The following figure illustrates the various states that the invoice inquiry case goes through 
during its life cycle, from its creation to closure.
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Invoice inquiry case life cycle

Invoice inquiry case states

State Description

New The case is created.

Assigned The case is assigned.

Work in 
progress

The case is being worked on.

Awaiting 
requester 
info

The agent needs more information from the requester to continue working on the 
case.

Awaiting 
internal info

The agent is waiting for the internal review on the case to complete.

Closed 
complete

The case is closed by entering the closure code.

Closed 
incomplete

The case is marked as incomplete by entering the closure code. Providing the 
closure details is required when you mark a case as Close incomplete.

Canceled The case is a duplicate, created in error, or no longer required.

Work on an invoice inquiry case

Work on an invoice inquiry case to resolve an issue raised by the suppliers or employees.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin

About this task
An invoice case with a category of Inquiry is referred to as an invoice inquiry case.

Typically, an invoice inquiry case is automatically created when you receive an inquiry email. 
However, the agent can also manually create an invoice inquiry case from the Source-to-Pay 
Workspace. For more information, see Create an invoice inquiry case manually.
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > Open cases.

◦ Navigate to Lists  > All Work  > Cases.

4. Open an invoice inquiry case to work on.

5. Do one of the following:

◦ To assign the case to yourself, select Assign to me.

◦ If the case is assigned to you by the Accounts Payable Specialist, you can start working on 
the case by selecting Accept.

The case moves to the Work in progress 

state.

6. Do one of the following:

◦ Request more information about the invoice inquiry case from the requester. For more 
information, see Request additional information from the requester for an invoice inquiry 
case.

The state of the case updates to Awaiting requester info.

◦ Submit the invoice inquiry case for an internal review. For more information, see Submit an 
invoice inquiry case for an internal review.

The state of the case updates to Awaiting internal info.

◦ Create an invoice task and assign it to a user or group to resolve the invoice inquiry case. For 
more information, see Create an invoice task.

◦ AP specialist closes the inquiry case and if the system property 
sn_ap_cm.awaiting_acceptance_enabled is enabled, then the invoice inquiry 
state changes to awaiting acceptance, and the supplier receives an inquiry task in the 
Supplier Collaboration portal. If the supplier confirms the state of the invoice inquiry 
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changes then the invoice is closed, otherwise the state of the invoice inquiry changes to 
Work in Progress.

◦ The state of an inquiry case changes fromAwaiting requester info  andAwaiting internal 
info  to Work in progress  in the following scenarios:

▪ An email reply from a requester triggers an action to move the inquiry case state to Work in 
progress.

▪ When all inquiry tasks are closed, the inquiry case state is automatically changed to Work 
in progress.

▪ An agent can manually change the inquiry state from Awaiting requester info to Work in 
progress.

7. Close an invoice inquiry case when all the activities and tasks for resolving the case are 
completed.
For more information, see Close an invoice inquiry case.
The inquiry case and related tasks are closed successfully.

Related topics

Using Supplier Collaboration Portal in APO

Create an invoice inquiry case manually

Create invoice inquiry cases to address and respond to questions related to invoices and 
payment.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin

About this task
Invoice inquiry cases are created automatically when you receive emails from suppliers or 
employees. However, you can also create invoice inquiry cases manually.

Note:  An invoice case with a category of Inquiry is referred to as an invoice inquiry case.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Under Quick actions, select Create New Inquiry.
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3. On the Create New Invoice case form, fill in the fields.
For a description of the field values, see Create New Invoice case form.

4. Select Save.

Result
The invoice inquiry cases are created manually to address and respond to questions related to 
invoices and payments.

Create an invoice task

Create an invoice task and assign it to a user or group to resolve an invoice inquiry case.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin

Procedure

1. Navigate to All  > All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Lists  > My Work  > Open cases

◦ Lists  > All Work  > Cases

4. Select the Tasks  tab and then select New.

5. On the Create New Invoice task form, fill in the fields.
For a description of the field values, see Create New Invoice task form.

6. Select Save.

Result
The invoice task is created successfully.

Request additional information from the requester for an invoice inquiry case

Request additional information from the requester to continue working on the case.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > My open invoice inquiry cases.

◦ Navigate to Lists  > All Work  > All open invoice inquiry cases.

4. In the Number column, select the link to the case to open it.

5. Select the down arrow icon ( ) and then select Wait for requester.

The 
Wait for requester dialog box is displayed.

6. In the Reason  field, enter the information that you need from the requester.

7. Select Wait for requester.
The state of the case updates to Awaiting requester info.

Result
The additional information is requested from the requester to continue working on the case.

Submit an invoice inquiry case for an internal review

Submit an invoice inquiry case for an internal review by creating a review task and assigning it to 
the reviewers.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:
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◦ Navigate to Lists  > My Work  > My open invoice inquiry cases.

◦ Navigate to Lists  > All Work  > All open invoice inquiry cases.

4. In the Number column, select the link to the case to open it.

5. Select the down arrow icon ( ) and then select Request internal review.
The application automatically creates a task in the New state and opens it. 

6. In the Assigned to  field, assign the task to the users who must complete the review.
Alternatively, in the Assignment group  field, assign the task to a group who must complete the 
review.

7. Select Save.
The state of the case updates to Awaiting internal info.

Result
The invoice inquiry case is submitted for internal review by creating a review task and assigning it 
to the reviewers.

Close an invoice inquiry case

Close an invoice inquiry case when all the activities and tasks for resolving the case are 
completed.

Before you begin
Role required: sn_ap_cm.agent or sn_ap_cm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).
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3. Do one of the following:

◦ Navigate to Lists  > My Work  > Open cases.

◦ Navigate to Lists  > All Work  > Cases.

4. In the Number column, select the link to the case to open it.

5. Do one of the following:

◦ Select Close inquiry.

The Close inquiry dialog box is displayed.

◦ Select the down arrow icon ( ) and then select Close 

incomplete.

The Closure details dialog box is displayed.

6. From the Closure code list, select one of the following options:

◦ Duplicate request

◦ Canceled/False inquiry

◦ Canceled by requester

◦ Information provided

◦ Exceptions resolved

7. In the Closure details  field, enter the reason why you're closing the case.

Note:  This field is required when you close an invoice inquiry case as Close 
incomplete.

8. Select OK.
Depending on the option that you selected in step 5, the state of the case updates to Close 
complete or Closed incomplete.
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Result
The invoice inquiry case is closed after completing all activities and tasks required for resolution.

Using Accounts Payable Invoice Processing

Accounts Payable Specialists can use the Accounts Payable Invoice Processing  application to 
manage and work on invoice processing cases to perform end-to-end invoice processing, from 
invoice ingestion to approval.

Invoice ingestion using Application programming interface (API)

The invoice ingestion API enables customers to ingest bulk AP invoices from external systems 
such as supplier billing systems, buyer network, and OCR solutions, supplier networks into APO. 
The supported payload formats are cXML, JSON and XML.

The system property [ap.invoice.create.api.record_limit] enables users to set the maximum 
number of invoices that can be processed in a batch using the AP invoice create API.

The Rate limit AP invoice xml defines the maximum number of API calls invoked by external 
systems according to hour.

The APO  application verifies that users have valid authorization to access the APIs.

Look up logic for reference fields is enhanced for invoices ingested via APIs and integration. The 
reference fields are:

• Purchase order

• Legal entity

• Currency field

• Country

• Line quantity

• Line unit price

For more information on the AP invoice API, see AP Invoice API Developer Guide .

Rules based engine

The rule based engine maps the invoice line with purchase order line using fields such as unit 
price, delivered unit price, exact description, exact amount and amount round off.

The digitized invoice in accepted state moves to suspected duplicate state where the AP 
specialist verifies if the invoice is duplicate or not. When the invoice is confirmed to be not 
duplicate, the state of the invoice changes to received. The rules-based engine maps the fields 
in invoice such as unit price, derived unit price, exact description, exact amount and amount 
round off with the purchase order lines. If the invoice fields doesn't match with any of the fields in 
the purchase order lines, then the invoice state changes to matching error.
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Work with invoices

Invoices are generated for a payment against a purchase order. The Accounts Payable Specialist 
[sn_ap_apm.accounts_payable_specialist] can access all the invoices and take required actions 
to process the invoices in Source-to-Pay Workspace.

Accounts Payable Operations integration with Document Intelligence  automatically extracts data 
from the invoices that are received as an attachment via email, and creates the invoice records 
and the invoice line records. When the invoice is in certain states during automated invoice 
processing, manual intervention is required by the Accounts Payable Specialist to move the 
invoice to the next stage of processing.

Note:  Accounts Payable Operations  supports invoices of type PO Invoice, Non-PO 
Invoice, Credit memo.

The Accounts Payable Specialist can view the invoices by doing the following:

1. Navigate to Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Invoices.

Invoice life cycle

The following figure illustrates the various statuses and sub-statuses that the invoice goes 
through during its life cycle, from its creation to approval.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1261



Invoice life cycle

Non-PO invoice life cycle

The following figure illustrates the various statuses and sub-statuses that the non-
PO invoice goes through during its life cycle, from its creation to approval.
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Credit memo invoice life cycle

The following figure illustrates the various statuses and sub-statuses that the credit 
memo invoice goes through during its life cycle, from its creation to approval.

Create an invoice manually

As an Accounts Payable Specialist, you can create an invoice manually from the Source-to-Pay 
Workspace  when the automated invoice creation process is encountering issues or not available.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
Invoices are created automatically by integration with Document Intelligence. However, you can 
also create invoices manually.

Procedure

1. Navigate to All  > All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Under Quick actions, select Create New 

Invoice.

3. On the Create New Invoice form, fill in the fields.
For a description of the field values, see Create New Invoice form.

4. Select Save.
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A new invoice is created in the Draft state, a new invoice case is created with a category of 
Invoice automation and sub-category of Invoice processing, and the new invoice is associated 
with the invoice case.

For more information about working with an invoice processing case, see Work on an invoice 
processing case.

Result
The invoice is created manually from the Source-to-Pay Workspace.

What to do next
Create invoice lines for the invoice. For more information, see Create an invoice line manually.

Create an invoice line manually

Create invoice lines manually for an invoice when the invoice automation process doesn't 
capture this information from an incoming invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Navigate to Lists  > Invoices  > All Open Invoices.

3. In the Number column, select the link to the invoice that you want to create an invoice line for.

4. Select the Invoice lines  tab and select New.
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5. On the Create New Invoice Line form, fill in the fields.
For a description of the field values, see Create New Invoice Line form.

6. Select Save.

Result
The invoice lines are created manually for an invoice when the invoice automation process does 
not capture the information from the incoming invoice.

Invoice rejection modes

Invoice rejection modes control how Accounts Payable Operations  handles exceptions that 
require an invoice to be rejected, either automatically by the system or through manual review by 
an AP specialist.

When the exception engine processes an invoice, it evaluates each exception associated with 
that invoice. The Rejection mode  field on each exception rule table determines whether the 
invoice is rejected without AP intervention or routed to an AP specialist for review.

When rejection mode is set to "None" in APO, the system disables the ability to manually reject 
invoices.

Manual rejection mode

When manual rejection is triggered, the invoice is routed to an AP specialist for review. The 
specialist reviews the flagged exceptions and confirms the rejection. The system supports this 
workflow by displaying the following on the invoice case:

• A notification that exceptions flagged for manual rejection mode require review.

• A Reject invoice  button that the AP specialist selects to initiate the rejection.

When the AP specialist selects Reject invoice, the system prompts them to enter a rejection 
reason. After confirmation, the system cancels the exception and invoice, populates the 
appropriate comments in the audit history and activity stream, and sends an email notification to 
the supplier with the rejection comments.

Condition builder

The exception rule allows AP admin to add conditions to any invoice exception definition by 
Legal entity, Supplier type and many more as shown in the following screen shot: For more 
information on the fields in the exception rule, see Invoice Exception Rule Form.

Related topics

Invoice Exception Rule Form

Reject an invoice manually

Review exceptions flagged for manual rejection and reject an invoice from the invoice case when 
AP specialist confirmation is required.

Before you begin
Role required: admin

The invoice must have at least one exception with Rejection mode  set to Manual, and no 
exception with Rejection mode  set to Auto.
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About this task
When exceptions flagged for manual rejection exist on an invoice, the system routes the invoice 
to an AP specialist for review. The invoice case displays a notification indicating that exceptions 
require manual rejection review. Use this procedure to review the exceptions and reject the 
invoice.

Important: 

Manual rejection review is only triggered when no exception has Rejection mode  set to 
Auto. If an auto rejection exception exists on the same invoice, the system rejects the 
invoice automatically and does not route it for manual review.

Procedure

1. Navigate to the invoice case that requires manual rejection review.

The invoice case displays a notification that exceptions are flagged for manual rejection and 
require review.

2. Review the exceptions listed on the invoice case.

The Rejection mode  field is visible on each exception record. Verify that the exceptions 
flagged for manual rejection are correct before proceeding.

3. Select Reject invoice.

A dialog prompts you to enter a rejection reason.

4. Enter a rejection reason in the field provided.

Result
After you confirm the rejection, the system performs the following actions:

• Cancels the exception.

• Cancels the invoice and closes the invoice processing case with the appropriate terminal 
state.

• Populates the rejection reason and comments in the invoice audit history and activity stream.

• Sends an email notification to the supplier with the rejection comments.

Credit memo

You can create Credit memo invoice. The credit memo invoice type can be of PO and Non-PO 
invoice.

When an invoice is ingested into the Accounts Payable Operations  application recognizes if the 
invoice received through various channels is of type credit memo. A credit memo is a document 
issued between a supplier and the buyer when there’s a reduction or any offset in the amount 
payable to the supplier. Credit memo is also applicable for any goods or services that the buyer 
owes to a seller. In some cases, if the buyer hasn’t paid the seller, the credit memo can be used 
as an offset for an invoice generated in the past or future. For an invoice to be recognized as a 
credit memo:

• The credit memo invoice must contain one of the following:

◦ Original invoice

◦ Original invoice number

◦ Purchase order
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• Credit memos issued for purchase order or invoice number must match with purchase order 
lines and invoice lines

• Invoice contains negative amount fields

For more information on creating invoice, see Create New Invoice form.

For more information on invoices ingested using document intelligence, see Invoice data 
transformation logic.

Invoice cost allocation

Cost allocation is a process of identifying and allocating the costs across different cost centers 
or ledger accounts. Accounts Payable specialists allocate invoice line cost across multiple cost 
centers or ledger accounts for accurate cost analysis and invoice processing.

Accounts Payable specialists can allocate invoice cost in the following ways:

• Cost allocated at purchase order level-

◦ When the invoice line is matched with the purchase order line and the invoice moves to PO 
matching completed status, then the cost allocation related to the purchase order line is 
copied to the invoice line. Any existing cost allocation record is overridden.

◦ When you change the invoice type from PO to non-PO invoice, you're prompted with a 
warning message to confirm that updating the invoice type restarts invoice processing, 
closes any open exceptions and deletes any cost allocations associated with the invoice. 
Upon confirmation, the cost allocation record is deleted.

• Manual cost allocation- add cost allocation at invoice line level. When cost is split across 
multiple cost centers, the cost center field on the invoice line becomes read-only and allows 
one type of allocation type in cost allocations For more information on manual cost allocation, 
see Create invoice cost allocation manually.

Accounts Payable specialists can allocate invoice line cost by:

• Quantity

• Quantity percentage

• Amount

• Amount percentage

For more information on cost allocation, see .

• You can create a new invoice line record and cost allocation record only when the invoice is in 
draft state and exception found state.

• During cost allocation, you must confirm that the total allocated quantity or amount across 
different cost centers or ledger accounts must be equal to the invoice line quantity or subtotal, 
or else invoice cost allocation exception occurs.

• Approval rules are configured by the approval engine that directs the invoices to cost center 
owners for approvals. For more information on approvals, see Invoice approvals.

• Distribution set is added for cost allocation type. For more information on how distribution set 
is added for cost type, see Distribution set in Accounts Payable Operations.

• Distribution sets automate the creation of cost allocations for invoice lines by applying pre-
defined rules or filters and distribution lines included during their setup.

• Manual Selection: AP specialists can manually select a distribution set while creating cost 
allocation records for an invoice line, enabling bulk automation as per defined distribution 
lines.
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• For PO invoices, cost allocations can be copied from the PO. If invoice attributes meet the 
default rule or filter criteria in distribution set, distribution lines will also apply.

• The template feature in a distribution set automatically creates cost allocation records for 
invoice lines without amounts. AP specialists can then manually allocate costs across cost 
centers or general ledger accounts.

• Any over or under-allocation will be flagged during the exception stage.

BEnefits of distribution set in cost allocation records are:

• Reduces risk of cost allocation errors.

• Speeds up invoice processing by minimizing manual work for AP specialists.

Related topics

Accounts Payable Invoice Processing

Invoice Case Management

Source-to-Pay Workspace

Accounts Payable Operations integration with Document Intelligence

Using Now Assist for Accounts Payable Operations (APO)

Using Supplier Collaboration Portal in APO

Invoice processing cases

Distribution set in Accounts Payable Operations

Create invoice cost allocation manually

Manually allocate invoice line cost across multiple cost centers.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist, admin

Procedure

1. Navigate to All  > All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Navigate to Lists  > Invoices  > All Open Invoices.

3. Select an invoice  > Invoice line  > .
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For more information on invoice line, see Create an invoice 

manually.

4. Select Cost allocations.

5. Select New.
The invoice cost allocation form displays. For more information on the cost allocation form, see 
Create invoice cost allocation form

Note: 

◦ During cost allocation, if the total allocated quantity or amount across different cost 
centers or ledger accounts isn’t equal to the invoice line quantity or subtotal, then 
the invoice cost allocation exception occurs. For more information on exceptions, see 
Invoice exceptions.

◦ When you delete an invoice line record, you’re prompted with a pop-up message to 
confirm the deletion of an invoice line record removes its associated cost allocation 
record.

◦ When you select allocation type as cost center for the first record and save the 
changes, the subsequent records also will inherit the same allocation type.

6. Select Save.
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Result
The cost allocation form is added to the invoice line.

Related topics

Accounts Payable Invoice Processing

Invoice Case Management

Source-to-Pay Workspace

Using Now Assist for Accounts Payable Operations (APO)

Invoice processing cases

Invoice exceptions

Distribution set in Accounts Payable Operations

Distribution set in Accounts Payable Operations  is a collection of predefined rules, including 
template, designed to automate the allocation of costs for invoice lines across cost centers and 
GL accounts.

By applying a distribution set, Accounts Payable teams can efficiently generate cost allocation 
records automatically, eliminating the need for manual cost splitting for each invoice line.

The key features of the distribution set are:

• AP Admin can define distribution sets and add distribution lines with varying percentages 
across cost centers or general ledger accounts.

• Distribution sets can be end-dated by specifying an effective-to-date. After expiration, they’ll 
no longer be automatically applied to invoice lines according to the invoice date.

• A distribution set can be marked as a template to automate creation of cost allocation records 
without amounts.

• The template feature in the distribution set automatically generates cost allocation records 
for invoice lines, and also enables AP specialists to divide costs by allocation type, such as 
cost center or general ledger account. Any over or under allocation will be flagged during the 
exception stage.

• For non-template-based distribution sets, the AP administrator must input allocation 
percentage so that the total sums to 100% and the distribution set becomes auto-active. If the 
total doesn't sum to 100%, then the distribution set remains inactive.

• An AP administrator is able to establish filters or rules that automatically assign distribution 
sets throughout the invoice processing workflow, thereby eliminating the requirement for 
manual selection.

• AP specialist can manually select a distribution set during the processing of an invoice.

• Reduces the risk of cost allocation errors.

• Distribution sets apply to both PO and Non-PO invoices.

• Speeds up the invoice processing by reducing manual work by AP specialists.

The workflow of the distribution set is shown below:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1270



© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1271



The key features of distribution lines are:

• Distribution lines can be associated with either cost centers or general ledger accounts; 
however, they can’t be linked to both at the same time.

• Duplicate distribution lines aren’t enabled.

• Allocation type is restricted to amount percentage for each distribution line.

• When the distribution set is set as a template, the percentage column is read-only, and AP 
specialists can manually allocate costs later.

Allocate costs using distribution set

Define a distribution set to split cost allocations automatically for invoice lines with allocation 
type as cost center or general ledger account.

Before you begin
Role required: sn_ap_apm.admin

Procedure

1. Navigate to Source-to-Pay workspace  > All  > Accounts Payable Operations  > Distribution 
Sets.

2. Select New.
The distribution set form view appears. For more information on the form, see Distribution set 
form

3. Select the Template  check box if you want the distribution set to be applied as a template to 
the cost allocation record.

4. Select Save.
The Convert Template  pop-up appears. You’ll be prompted with a message "Converting this 
distribution setup to a template removes all allocation percentage from the distribution line. 
This action can’t be undone".

5. Select Create template.
For distribution set with template, if there’s distribution lines created, by default, the 
distribution set is active. For non-template, if the allocation percentage doesn't sum upto 100%, 
then the distribution set remains inactive else it is saved as active.

6. Select Submit.
The distribution set is 

created.
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7. Select the distribution set for which you want to create distribution lines.

a. Select New.
A distribution line form appears. For more information on the distribution line form, see 
Distribution set 

form.

b. Allocate the cost and split the invoice line amount by cost center or general ledger account.

c. Select Submit.
After a distribution line is submitted, it’s applicable for new invoices only and unavailable for 
existing invoices.

8. To apply distribution set manually for an invoice line, select Invoice line> Cost allocation> 
New.
Create a New Invoice cost allocation form appears. You can choose Allocation type  as 
Distribution set. For more information on the form, see Create invoice cost allocation 

form.

If a distribution set is created for cost center, then for subsequent cost allocation, the 
allocation type is cost center by default.

If a distribution set is created for general ledger account, then for subsequent cost allocation, 
the allocation type is general ledger account by default.

9. Select Save.

Result
Distribution set automates cost allocations. Each cost allocation record displays the source 
whether it’s entered manually, derived from a purchase order, or associated with a specific 
distribution set number confirming complete traceability.

Related topics

Create invoice cost allocation form
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Tax calculations

Calculate the final tax for an invoice based on the tax type and the tax tolerance variance.

The Accounts Payable Operations  application enables the validation of supplier-provided taxes 
for enhanced tax compliance and improved operational effectiveness.

Tax specialists create tax types of either indirect tax or withholding tax. One or more tax lines 
are added to invoice lines. Based on the tax type, the supplier tax is calculated against the 
invoice line amount. If the supplier tax amount is greater than the system tax amount, an overtax 
amount variance is calculated. If the supplier tax is less than the system tax amount, an undertax 
variance is calculated. You can choose to accept the system tax or the supplier tax,which will 
determine the final tax that is calculated and displayed on the invoice tax line and invoice 
header.

For example, for an invoice line amount of $1000, add a tax line of the indirect tax type with a 
supplier tax of $100. The final tax amount would be calculated as the sum of $1000 and $100, 
for a total of $1100. If you select the withholding tax type, the final tax amount is calculated as the 
difference between the invoice line amount of $1000 and the supplier tax of $100, for a total of 
$900.

Related topics

Accounts Payable Invoice Processing

Invoice Case Management

Source-to-Pay Workspace

Invoice processing cases

Tolerance Rules and Variances for invoices

Invoice approvals

Create tax codes to be added in an invoice

Create tax codes to be added in an invoice.

Before you begin
Role required: Tax manager
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Procedure

1. Navigate to All  > Finance Common  > Tax codes.

2. Select New.

3. On the form, fill in the fields.

Tax Code form

Field Description

Invoice Case

Tax code ID Unique tax code generated from the ERP source.

Name Name of the tax code.

Description The details of the tax code used in transactions or financial activities.

Country The country for which the tax code is applied to.

State The state for which the tax code is applied to.

Active Option to make the tax code available.

ERP source The ERP source from which the tax code is generated.

4. Select Save.

Result
The tax code details are added.

Related topics

Accounts Payable Invoice Processing

Invoice Case Management
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Source-to-Pay Workspace

Invoice processing cases

Tolerance Rules and Variances for invoices

Invoice approvals

Create tax types to be used in an invoice

Create tax types to be added in the invoice.

Before you begin
Role required: Tax manager

Procedure

1. Navigate to All  > Finance Common  > Tax types.

2. Select New  on the tax type page.

3. On the form, fill in the fields.

Tax type form

Field Description

Invoice Case

Code Unique tax code generated from the ERP source.

Category Name of the tax category. The available values are:

◦ Sales tax

◦ Use tax

◦ Value-added tax
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Field Description

◦ Goods and service tax

◦ Withholding tax

Name The tax type used in transactions or financial activities.

Active State to make the tax type available.

4. Select Save.

Result
The tax type details are added.

Related topics

Accounts Payable Invoice Processing

Invoice Case Management

Source-to-Pay Workspace

Invoice processing cases

Tolerance Rules and Variances for invoices

Invoice approvals

Update the purchase order on an invoice

If you find that the purchase order that is currently associated with an invoice is incorrect, you 
can associate the correct purchase order to the invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Invoices  > All open invoices.

4. Open a PO Invoice.

5. Under Summary Details, in the Purchase order  field, search for and select a purchase order.
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The following confirmation message is displayed: Updating the Purchase 
order may require PO mapping again. Do you want to 

continue?

6. Select OK.

The confirmation message is not displayed if you update the purchase order on a PO invoice 
that is in the Draft, Received, or Accepted status.

The confirmation message is displayed if you update the purchase order on a PO invoice 
either before or after PO mapping is completed. If you select OK  after you change the 
purchase order in the Purchase order  field, the invoice lines are mapped with the purchase 
order lines of the newly associated purchase order. Subsequently, the automated PO mapping 
process is run and the invoice status moves to PO mapping error or PO mapping completed.

Result
The correct purchase order is associated with the invoice.

View your invoices on Employee Center

As a business owner, you can view all the invoices that you own on Employee Center.

Before you begin
Role required: sn_shop.invoice_owner
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Procedure

1. Navigate to All  > Employee Center.

2. In the My active items widget, select Invoices.
The Invoice List page is displayed, which lists all the invoices that you own.

In the Number column, select the link to an invoice to view its details.

Result
The business owner views all owned invoices on Employee Center.

Invoice processing cases

Typically, Accounts Payable Operations integration with Document Intelligence  automatically 
creates the invoice processing case by extracting data from the invoice that you receive as an 
attachment via email. However, the Accounts Payable Specialist may need to manually create 
a new invoice or update details of a partially created invoice in situations where the automated 
invoice creation process encounters issues or is not available.

By default, when an inbound email is received in Accounts Payable Operations integration 
with Document Intelligence, the invoice processing flow is triggered and an invoice case with a 
category of Invoice automation  and sub-category of Invoice processing  is created. For more 
information, see Install Accounts Payable Operations integration with Document Intelligence.

Invoice processing case life cycle

The following figure illustrates the various states that the Invoice processing case goes through 
during its life cycle, from its creation to closure.
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Manual invoice ingestion case life cycle

Invoice processing case states

State Description

New The case is created.

Assigned The case is assigned.

Work in 
progress

The case is being worked on.

Closed 
complete

The case moves to this state after the invoice approval request is approved by the 
approver or after the invoice is auto-approved by the approval engine.

Closed 
incomplete

The case moves to this state when the invoice is in the Suspected duplicate state 
and the Accounts Payable Specialist selects the Confirm duplicate  option.

Canceled The case is canceled because it was created in error or is no longer required.

Work on an invoice processing case

Perform different manual actions to process an invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
An invoice case with a category of Invoice automation and sub-category of Invoice processing is 
referred to as an invoice processing case.

By default, an invoice processing case is automatically created when you receive an invoice via 
email. Document Intelligence  captures the invoice data and subsequently creates the invoice 
and invoice line records in Accounts Payable Operations. However, the Accounts Payable 
Specialist can also manually create an invoice from the Source-to-Pay Workspace. For more 
information, see Create an invoice manually.

For a description of the field values and information about the available tabs on the invoice 
processing case form, see Invoice processing case form.
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > My open invoice processing cases.

◦ Navigate to Lists  > All Work  > All open invoice processing cases.

4. Open 
an invoice processing case.
Typically, the state of the newly created invoice processing case is New and the status of 
the invoice associated with this case is either Draft or Received, depending on how it was 
processed by the Accounts Payable Operations integration with Document Intelligence 
application.

For more information about invoice statuses, see Work with invoices.

5. In the Assigned to  field, specify a user that you want to assign the invoice processing case to.
The invoice processing case moves to the Assigned state.

6. Do one of the following:

◦ If you have the Accounts Payable Specialist role, assign the invoice processing case to 
yourself by selecting Assign to me.

◦ If the invoice processing case is assigned to you by the Accounts Payable Specialist, start 
working on the case by selecting Accept.

The invoice processing case moves to the Work in progress state.

7. Do one of the following:

Tasks in invoice processing case

To Do this

Review the invoice 
in Document 
Intelligence  to create 
the invoice

If a processing error occurs in Document Intelligence, the invoice 
processing case displays the following error:

Invoice has a data extraction error. Review 
invoice with automation to continue processing.
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To Do this

For more information, see Review an invoice in Document 
Intelligence.

Enter the missing 
required information 
in the invoice

If a transformation error occurs in Document Intelligence, the invoice 
processing case displays the following error:

Required information for invoice has one 
or more errors. Review required fields 
and currency in "Details" tab to continue 
processing.

For more information, see Enter the missing required invoice 
information and submit an invoice.

8. Submit the invoice.
After you submit the invoice, the status of the invoice updates to Received and the invoice 
processing case remains in the Work in progress state.

The automated duplicate check process is run and if the process suspects that the invoice is 
a duplicate, the invoice moves to the Suspected duplicate status, and the invoice processing 
case displays the following error.

Invoice is a potential duplicate. Review invoices in "Potential 
duplicate invoices" tab to confirm or reject duplicate.

The Accounts Payable Specialist must manually confirm whether the invoice is a duplicate.

9. Confirm whether the invoice is a duplicate.

For more information, see Confirm whether an invoice is a duplicate.

If you confirm that the invoice is a duplicate, the invoice moves to the Confirmed duplicate 
status and the invoice processing case moves to the Closed incomplete state.

Note:  When the invoice is in the Confirmed duplicate status, the Reset to Received 
option becomes available. If you've confirmed an invoice as duplicate by mistake, you 
can reset the status back to the Received status. For more information, see Reset an 
invoice to the Received status.

If you confirm that the invoice is not a duplicate, the invoice moves to the Accepted status, and 
the invoice processing case remains in the Work in progress state.

After the invoice moves to the Accepted status, the automated PO mapping process is run and 
one of the following occurs:

◦ If the invoice matches with the PO, then the invoice moves to the PO mapping completed 
status.

◦ If the invoice doesn't match with the PO, then the invoice moves to the PO mapping error 
status and the invoice processing case displays the following error:

Invoice needs to map Purchase order. Map "invoice lines" to 
"Purchase order lines" to continue processing.
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The Accounts Payable Specialist must manually match the invoice and invoice lines with the 
PO and the PO lines, respectively. The invoice moves to the PO mapping completed status 
only after all the invoice lines move to the PO mapping completed status.

The invoice processing case remains in the Work in progress state.

Note:  After the invoice moves to the PO mapping completed status, the exception 
engine is run via a scheduled job at a specific time on a recurring basis. The exception 
engine runs on all the invoices that are in the PO mapping completed status.

At this stage, however, you can also manually run the exception engine to identify invoice 
exceptions on the invoice.

Note:  The Check for exceptions  option enables you to instantly run the exception 
engine on a single, selected invoice that is in the PO mapping completed status, whereas 
the scheduled job periodically runs the exception engine on all the invoices that are in 
the PO mapping completed status.

10. Check for exceptions on the invoice.

For more information, see Check for invoice exceptions on a single invoice.

If no exceptions are found, the invoice moves to the No exceptions found status.

If exceptions are found on the invoice, the invoice moves to the Exceptions found status, and 
the invoice processing case displays the following error:

Invoice has one or more exceptions. Resolve all issues in 
"Invoice exceptions" to continue processing.

The Accounts Payable Specialist can work on the exceptions or create exception tasks and 
assign them to other users to resolve the exceptions. For more information, see Invoice 
exceptions.

After all the exception tasks are completed and the exceptions are resolved, the invoice 
moves to the No exceptions found status. The invoice processing case remains in the Work in 
progress state.

At this stage, the automated invoice approval process runs and submits the invoice for 
approval.

The invoice moves to the Pending approval status and the invoice processing case remains in 
the Work in progress state.

Typically, an invoice that is in the No exceptions found status is automatically picked by the 
approval engine and submitted for approval. However, in a few scenarios, you may have to 
manually submit an invoice for approval. For more information, see Invoice approvals.

After you submit the invoice, the invoice moves to the Pending approval status, and the invoice 
processing case remains in the Work in progress state.

At this stage, one of the following occurs:
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◦ If the invoice is rejected, the invoice moves to the Rejected status and the rejection 
comments are copied over to the invoice processing case.

To resubmit the invoice, you must cancel the rejected invoice using the Cancel invoice 
option and submit a new invoice.

◦ If the invoice is approved, the invoice moves to the Approved status and the invoice 
processing case moves to the Closed complete state.

Result
The different manual actions are performed to process an invoice.

Accounts Payable Specialist manual tasks

Accounts Payable Operations  performs invoice processing using automated workflows, with 
minimal manual intervention. In some situations, however, the Accounts Payable Specialist is 
required to perform a few manual tasks to move the invoice to the next stage of processing.

View the invoice processing case associated with an invoice

View the invoice processing case that is automatically created for an invoice and take any 
actions to process the invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Invoices.

4. Open an invoice.

5. Select View invoice processing case.

Result
The invoice processing case opens.
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Review an invoice in Document Intelligence

Review the invoice details, enter the required invoice field values, and submit the invoice if 
Document Intelligence  encounters an extraction error.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
If Document Intelligence  encounters an extraction error, the invoice processing case is 
created in Accounts Payable Operations integration with Document Intelligence. The invoice 
is not created or associated with that case. You must review the invoice details in Document 
Intelligence, enter the required values in the invoice fields, and submit the invoice to create the 
invoice.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open an invoice that is in the Draft status.

5. Select View invoice processing case.

The invoice processing case opens and displays the following notification at the top:

Invoice has a data extraction error. Review invoice with 
automation to continue processing.

6. Select Review invoice.

7. Refer to the invoice document and fill in the fields for the invoice.

8. Select Submit.
The invoice and invoice line records are created and the invoice is associated with this invoice 
processing case.

9. Open the invoice processing case and select Submit invoice.
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A message appears asking you for a confirmation.

10. Select Yes.

Result
The invoice is submitted for further processing and the status of the invoice changes to 
Received.

Enter the missing required invoice information and submit an invoice

If Document Intelligence  encounters a transformation error, the invoice is created and associated 
with an invoice processing case. However, not all required information is populated on the 
invoice. You must manually enter the required information and submit the invoice for further 
processing.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open an invoice in the Draft status.

5. Select View invoice processing case.

The invoice processing case opens and displays the following notification at the top:

Required information for invoice has one or more errors. Review 
required fields and currency in "Details" tab to continue 
processing.

6. On the Details  tab, under Summary details, enter the missing details in the fields.

7. Select the Invoice lines  tab, and ensure that you add at least one invoice line.

8. Select Submit invoice.
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A message appears asking you for a confirmation.

9. Select Yes.

Result
The invoice is submitted for further processing and the status of the invoice changes to 
Received.

Confirm whether an invoice is a duplicate

Confirm whether an invoice that is in the Suspected duplicate status is indeed a duplicate to 
determine if the invoice should be considered for processing.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open an invoice in the Suspected duplicate status.

5. Select View invoice processing case.
The invoice processing case opens and displays the following notification at the top:

Invoice is a potential duplicate. Review invoices in "Potential 
duplicate invoices" tab to confirm or reject duplicate.

6. Do one of the following:

Option Action

To mark an invoice 
as not a duplicate

a. Select Not a duplicate.

A message appears asking you for a confirmation.
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Option Action

b. Select Yes.

The status of the invoice changes to Accepted.

To mark an invoice 
as a duplicate

a. Select Confirm duplicate.

A message appears asking you for a confirmation.

b. Select Yes.

The status of the invoice changes to Confirmed duplicate and the 
state of the invoice processing case changes to Closed incomplete.

Result
The invoice in the Suspected Duplicate status is confirmed as duplicate or not.

Convert invoice type

You can convert invoice type from PO to Non-PO invoice and vice versa based on interaction 
between buyers and suppliers of business services.

Before you begin
Role required: Account Payable Specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > My work  > My open invoice processing cases  and open an invoice 
processing case.
An alternate way is by navigating to Lists  > Primary Data  > >Invoices  > Open invoice.

Note:  Type conversion is supported only for invoices from Draft  state to No exceptions 
found  state. You cannot convert invoice type once it is submitted for approval.

4. Choose the Type  drop-down to convert an invoice.
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◦ When you choose to convert an invoice from PO to Non-PO invoice, the Purchase order  field 
is hidden.

◦ When you choose to convert an invoice from Non-PO to PO invoice, the Purchase order  field 
is displayed and you must populate the purchase order field.

A message appears asking for your confirmation.

5. Select Continue.

6. Select Save.

Result
The status of the invoice changes to new invoice type. The invoice is reprocessed and re-
validated.

Reset an invoice to the Received status

If you confirm an invoice as a duplicate by mistake, you can reset that invoice from the Confirmed 
duplicate status back to the Received status.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open an invoice in the Confirmed duplicate  state.
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5. Select View invoice processing case.

6. On the invoice processing case form, select Reset to 

Received.
A message appears asking you for a confirmation.

7. Select Yes.

Result
The status of the invoice changes to Received.

Check for invoice exceptions on a single invoice

Manually check for invoice exceptions on a single invoice so that you can resolve them.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
The Check exceptions  option is available for all invoices that are in Exceptions found  state.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open an invoice that is in the Exceptions found  state.

5. Select View invoice processing case.

Note:  If you open an invoice processing case for an invoice that is in Exceptions found 
status, the invoice processing case form displays the following notification at the top:

Invoice has one or more exceptions. Resolve all issues in 
"Invoice exceptions" to continue processing.

6. On the invoice processing case form, select Check exceptions.
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7. Select Yes.

Result
While exceptions are being identified on the invoice, the status of the invoice changes to 
Checking exceptions  for a short period of time and the following occurs:

• If no exceptions are found on the invoice, the status of the invoice changes to No exceptions 
found.

• If exceptions are found on the invoice, the status of the invoice remains as Exceptions found.

Start the processing for an invoice imported via integration with third-party applications

Start the processing for an invoice that doesn't have an associated invoice processing case.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
In a few scenarios, the invoice can be imported via integration with third-party applications. If an 
invoice is ingested into Accounts Payable Operations  via integration, the invoice processing is 
not initiated. No invoice processing case is created for the invoice.

In such situations, the Accounts Payable Specialist must open the invoice and select the Start 
invoice processing  option, which creates an invoice processing case for the invoice and starts 
processing the invoice.

The Start invoice processing  option is displayed for invoices of type PO and Non-PO only.

The Start invoice processing  option is not displayed for invoices that are in the Canceled, 
Closed duplicate, Approved, Pending payment, or Paid status.

Note:  Accounts Payable Operations  includes the Start Invoice Processing for Orphan 
Invoices flow, which automatically picks up all the PO and Non-PO invoice type records that 
are in the Draft status that don't have an invoice processing case associated to them and 
starts their processing.

You don't need to perform this manual task if you've activated the Start Invoice Processing 
for Orphan Invoices flow. For more information, see Activate the Start Invoice Processing for 
Orphan Invoices flow.
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).

3. Navigate to Lists  > Primary Data  > Invoices.

4. Open the invoice that is imported into Accounts Payable Operations  via integration.

5. Select Start invoice processing.

Result
An invoice processing detailed record and an invoice processing case is created for the invoice 
and the invoice processing begins.

After an invoice processing case is created for the invoice, the Start invoice processing  option is 
replaced by the View invoice processing case  option on the Invoice form.

After an invoice processing case is created for the invoice, the Start invoice processing  option is 
replaced by the View invoice processing case  option on the Invoice form.

The invoices for which an invoice processing case is not created automatically, a scheduled job 
runs at regular intervals to pick up such invoices, creates an invoice case for each invoice, and 
starts the processing for the invoices. The scheduled job enables you to start the processing 
for all such invoices in bulk, without requiring you to start the processing for each invoice 
individually.

Activate the Start Invoice Processing for Orphan Invoices flow

Activate the Start Invoice Processing for Orphan Invoices  flow to start the processing of an 
invoice that doesn’t have an associated invoice case.

Before you begin
Role required: admin

About this task
This flow creates an invoice processing case, associates the invoice with that case, and then 
starts the invoice processing.

Procedure

1. Navigate to All  > Process Automation  > Flow Designer.

2. Search for and select the Start Invoice Processing for Orphan Invoices  flow to open it.

3. Select the more actions icon ( ) in the top right and select Copy 

flow.
The Create a copy of this flow dialog box is displayed.
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4. In the New flow name  field, enter a name for the copied flow.

5. In the Application  field, select Accounts Payable Operations.

6. Select 

Copy.
A copy of the flow opens.

7. Under TRIGGER, specify the conditions that trigger this flow.

8. Select Save.

9. Select Activate.

Result
The Start Invoice Processing for Orphan Invoices  flow starts processing invoices that don’t 
have an associated invoice case.

Invoice ingestion process when Document Intelligence  is unavailable

When Document Intelligence  goes down or when Document Intelligence  itself is not installed, 
and if you receive an invoice document via email, an invoice processing case is created but an 
invoice record is not created.

In this scenario, the invoice processing case displays the Create invoice  and Close case 
options. The Accounts Payable Specialist must open the invoice processing case and either 
create the invoice or close the invoice processing case.

Create an invoice manually when Document Intelligence  is unavailable

As an Account Payable Specialist, manually create an invoice if an invoice processing case 
automatically is created when the Document Intelligence  application is unavailable.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:
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◦ Navigate to Lists  > My Work  > My open invoice processing cases.

◦ Navigate to Lists  > All Work  > All open invoice processing cases.

4. Open the invoice processing case.

5. Select Create invoice.
The invoice is created and the invoice processing case displays the following message:

Invoice has been successfully created. Verify all the required 
fields are correct and add invoice lines before submitting.

Verify that the values in the invoice fields are correct and ensure that you add at least one 
invoice line for the invoice. For more information, see Create an invoice line manually.

6. Select Submit invoice.

Result
The invoice is manually created when the Document Intelligence application is unavailable.

Close the additional invoice processing case for an invoice

Close the auto-created invoice processing case if one already exists for an invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist

About this task
If you create an invoice manually, a new invoice processing case is created for that invoice. As a 
result, the auto-generated invoice processing case becomes redundant and therefore you can 
close it.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > My open invoice processing cases.

◦ Navigate to Lists  > All Work  > All open invoice processing cases.

4. Open the invoice processing case.

5. Select Close case.
The Close case dialog box is displayed.

6. From the Closure code list, select one of the following options:

◦ Duplicate invoice

◦ Invoice canceled

◦ Invoice approved

7. In the Reason  field, enter the reason why you're closing the case.

8. Select Close case.

Result
The invoice processing case is closed and its state updates to Closed complete.
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Invoice exceptions

Invoice exceptions are discrepancies identified during invoice processing that must be resolved 
before payment, such as missing information, tax variances, or supplier issues.

The Accounts Payable Operations  exception engine automatically identifies discrepancies in 
invoices and lists them as invoice exceptions in the Source-to-Pay Workspace  workspace. The 
Accounts Payable Specialist can analyze the identified invoice exceptions and take appropriate 
action to resolve them.

The Accounts Payable Operations  exception engine is run for the PO invoices that are in either 
the PO matching completed or Exceptions found state.

The Accounts Payable Operations  exception engine is run for Non-PO invoices that are in the 
Accepted or Exceptions found state.

The Accounts Payable Operations  exception engine identifies invoice exceptions of the following 
types.

Invoice exception type

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

Invalid or blocked 
supplier

This exception occurs 
in one of the following 
scenarios:

• The supplier 
information is 
missing on the 
invoice.

• The supplier 
information 
on the invoice 
doesn’t match the 
information on the 
purchase order if 
invoice is of type 
PO.

• The Supplier Legal 
Entity Mapping 
(sn_fin_supplier_detail) 
table doesn’t have 
a record with a 
combination of 
Invoice.supplier and 
Invoice.legal_entity 
fields

• In the Supplier 
Legal Entity 
Mapping 
(sn_fin_supplier_detail) 
table, the supplier 
has one of the 

To resolve this invoice 
exception, do the 
following:

• If the supplier 
information is 
missing on the 
invoice, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable 
Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Populate a valid 
supplier and legal 
entity.

• If the supplier 
information on the 
invoice doesn’t 
match with that on 
the purchase order, 
do the following:

1. Log in to the 
application with 
the Accounts 
Payable 
Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

PO invoice and Non-
PO invoice
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

following attributes 
set to true:

◦ Hold Payment: 
Indicates that the 
invoice payment 
is put on hold for 
the supplier

◦ Hold Posting: 
Indicates that the 
invoice posting 
is put on hold for 
the supplier

This exception 
is a header-level 
exception.

2. Update the 
supplier 
information on the 
invoice to match 
with that on the 
purchase order.

• If the Supplier Legal 
Entity Mapping 
(sn_fin_supplier_detail) 
table, doesn’t have 
a record with a 
combination of 
Invoice.supplier and 
Invoice.legal_entity, 
do the following:

1. Log in with 
the Supplier 
Enablement 
Manager 
(sn_fin.supplier_payment_info_write) 
role.

2. Add a record 
with the 
combination of 
Invoice.Supplier – 
Invoice.LegalEntity 
fields in the 
Supplier Legal 
Entity Mapping 
(sn_fin_supplier_detail) 
table.

• If the supplier's 
Hold Payment 
and Hold Posting 
attributes are 
set to true in the 
Supplier Legal Entity 
Mapping table, do 
the following:

1. Log in with 
the Supplier 
Enablement 
Manager 
(sn_fin.supplier_payment_info_write) 
role.
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

2. Take the 
necessary actions 
to remove holds 
from invoices to 
enable payment 
and posting of the 
invoices.

Insufficient Funds 
(Quantity variance)

This exception 
occurs when the total 
quantity of previously 
billed invoices and 
the current invoice, 
which is in-process 
becomes more 
than the respective 
purchase order line 
quantity.

This exception is a 
line-level exception.

To resolve this invoice 
exception, you must 
edit the purchase 
order. For more 
information, see Edit 
a purchase for an 
Insufficient Funds 
invoice exception.

To resolve this invoice 
exception, you must 
edit the purchase 
order. For more 
information, see Edit 
a purchase for an 
Insufficient Funds 
invoice exception.

PO invoice

Insufficient Funds 
(Line amount 
variance)

This exception occurs 
when purchase order 
lines don't have 
sufficient funds left to 
process the current 
invoice, which is in-
process.

This exception is a 
line-level exception.

To resolve this invoice 
exception, you must 
edit the purchase 
order. For more 
information, see Edit 
a purchase for an 
Insufficient Funds 
invoice exception.

PO invoice

Insufficient Goods 
Receipt

This exception occurs 
when one or more 
lines of an invoice 
don’t have sufficient 
receipts to process 
the invoice.

Resolving the 
Insufficient 
Goods Receipt 
exception when 
PSM is installed

If 
Sourcing 
and 

PO invoice
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

This exception is a 
line-level exception.

Procurement 
Operations 
(PSM) is 
installed, 
and if no 
receipt 
task 
exists 
for the 
purchase 
order 
line, 
Accounts 
Payable 
Invoice 
Processing 
creates 
a receipt 
task and 
displays 
the task 
in the 
Related 
tasks  tab 
of the 
exception 
form. For 
more 
information, 
see 
Invoice 
exception 
form.

The 
receipt 
task is 
assigned 
to the 
user 
specified 
in the 
Recipient 
field on 
the PO 
line. The 
recipient 
must 
have the 
sn_shop.acknowledgement_task_owner 
role to 
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

complete 
the 
receipt 
task from 
Employee 
Center.

For more 
information, 
see 
Confirm 
receipt 
of your 
order 
from 
Employee 
Center.

Resolving the 
Insufficient 
Goods Receipt 
exception 
when PSM isn’t 
installed

If 
Sourcing 
and 
Procurement 
Operations 
isn’t 
installed, 
then the 
Accounts 
Payable 
Specialist 
must 
manually 
create an 
exception 
task, 
which is 
assigned 
to the 
business 
owner. 
The 
business 
owner 
must 
mark this 
task as 
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

complete 
in 
Employee 
Center. 
For more 
information, 
see 
Mark an 
exception 
task as 
complete 
from 
Employee 
Center.

Valid coding required This exception occurs 
when one or more 
lines of an invoice 
cost is distributed 
across multiple cost 
centers or general 
ledger accounts. 
When the cost is 
split across multiple 
cost centers, the cost 
center field on the 
invoice line is read-
only and allows one 
type of allocation type 
in the cost.

This exception is a 
line-level exception 
and applies for 
general ledger 
account.

To resolve this invoice 
line exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Populate the ledger 
account, enter the 
information for 
invoice lines or 
cost allocations. 
For example: You 
can enter a ledger 
account in the 
invoice lines and 
add multiple cost 
allocations on the 
allocations page, or 
you can enter a cost 
center in the invoice 
lines and include 
several general 
ledger account 
allocations on the 
cost allocations 
page. You can also 
choose to enter 
general ledger and 
cost center both in 
the invoice line.

PO Invoice and Non-
PO invoice
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

Missing required 
information

This exception occurs 
when one or more 
fields of the following 
are missing on the 
invoice:

• Payment terms

• Invoice type

• Supplier

• Invoice amount

• Invoice date

• Legal entity

This exception 
is a header-level 
exception.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Populate the 
following fields on 
the invoice:

◦ Payment terms

◦ Invoice type

◦ Supplier

◦ Invoice amount

◦ Invoice date

◦ Legal entity

PO Invoice and Non-
PO invoice

Missing or Invalid 
Business Owner

This exception occurs 
when the business 
owner of the invoice 
is missing or inactive 
or is different from 
the business owner 
mentioned in the 
purchase order (if 
invoice is of type PO).

This exception 
is a header-level 
exception.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Update the valid 
business owner 
field in the invoice 
line.

PO Invoice and Non-
PO invoice

Over tax amount 
variance

This exception occurs 
when the supplier 
tax amount is greater 
than the system tax 
amount.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections to the 

PO Invoice, Non-PO 
invoice, and Credit 
memo
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

supplier tax, system 
tax on all the invoice 
lines.

3. You can choose 
to either accept 
system tax or 
supplier tax.

Under tax amount 
variance

This exception occurs 
when the supplier 
tax amount is lesser 
than the system tax 
amount.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections to the 
supplier tax, system 
tax on all the invoice 
lines.

3. You can choose 
to either accept 
system tax or 
supplier tax.

PO Invoice, Non-PO 
invoice, and Credit 
memo

Tax validation failed This exception occurs 
when the tax is not 
validated due to 
integration error

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
or Tax specialist 
role.

2. The system restarts 
the tax execution

Tax validation expired Tax information is 
changed after the 
invoice execution, 
then Tax validation 
expired failed 
exception is raised.

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

or Tax specialist 
role.

2. Make necessary 
corrections to the 
invoice and selects 
Validate tax  to re-
calculate the tax

Under tax amount 
variance (Invoice line)

Tax amount on an 
invoice line is lesser 
than the tax response 
received for the line 
item through tax 
engine

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
or Tax specialist 
role.

2. Make necessary 
corrections to the 
invoice line item 
and select either 
Accept Supplier tax 
or Accept System 
tax

Under tax amount 
variance (Invoice 
header)

Total tax amount on 
the invoice header is 
lesser than the total 
tax for the invoice 
received through tax 
engine

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
or Tax specialist 
role.

2. Make necessary 
corrections to the 
invoice header and 
select either Accept 
Supplier tax  or 
Accept System tax

Over tax amount 
variance (Invoice 
header)

Total tax amount on 
the invoice header 
is greater than the 
total tax of the invoice 
received through tax 
engine

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
or Tax specialist 
role.

2. Make necessary 
corrections to the 
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

invoice header and 
select either Accept 
Supplier tax  or 
Accept System tax

Over tax amount 
variance (Invoice line)

Tax amount on the 
invoice line is greater 
than the tax of the 
invoice line item of 
the invoice received 
through tax engine

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
or Tax specialist 
role.

2. Make necessary 
corrections to the 
invoice line item 
and select either 
Accept Supplier tax 
or Accept System 
tax

Invoice isn’t balanced This exception occurs 
when sum of the 
subtotals of the 
invoice lines must 
match the sub total 
amount in the header.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections to the 
sub total so that the 
sum of sub totals of 
invoice lines match 
with the invoice 
header amount.

PO Invoice, Non-PO 
invoice, and Credit 
memo

Insufficient Funds 
(Header amount 
variance)

This exception occurs 
when purchase 
order doesn’t have 
sufficient balance left 
to process the invoice.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

PO invoice
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

2. Make necessary 
corrections to 
invoice amount 
so that the sum 
of amount of all 
invoices related to 
PO (in progress or 
paid) amount must 
be less than the 
total PO amount.

Line unit price 
variance

This exception occurs 
due to difference in 
unit price of invoice 
line and PO.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections to unit 
price on invoice line 
so that it’s equal to 
unit price of PO line.

PO invoice, Credit 
memo

Incomplete credit 
memo

This exception occurs 
when any of the 
following are missing 
on a credit memo 
invoice:

• Original invoice 
number

• Original invoice

• Purchase order

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections on 
the invoice by 
populating the 
Original invoice 
number, Original 
invoice, and 
purchase order 
fields.

Credit memo
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

Insufficient billing 
amount on purchase 
order

This exception occurs 
when purchase order 
doesn't have sufficient 
billing quantity or 
amount to process the 
credit memo invoice.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Make necessary 
corrections to 
invoice line amount 
such that the line 
amount doesn’t 
exceed the sum 
of PO line amount 
and other credit 
memo (approved or 
pending approval) 
related to the PO 
line.

Credit memo

Missing tax 
information

This exception 
occurs when tax 
line information is 
missing in an invoice. 
This is a header level 
exception.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Add tax lines details 
to the invoice using 
the Add tax  button.

Note:  The 
under tax 
amount 
variance 
and over 
tax amount 
variance are 
dependent on 
the Missing 
tax information 
exception.

PO Invoice, Non-PO 
invoice, and Credit 
memo
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Invoice exception type  (continued)

Invoice exception Description
Do these steps to 
resolve the invoice 
exception

Applicable to

Missing tax code 
details

This exception occurs 
when tax code details 
are missing in one or 
more invoice lines. 
This exception applies 
to PO invoice, non-
PO invoice and credit 
memo. This is a line 
level exception.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Populate the tax 
code details.

PO Invoice, Non-PO 
invoice, and Credit 
memo

Currency mismatch This exception occurs 
when the currency on 
an invoice does not 
match the currency 
on the associated 
purchase order 
when purchase order 
mapping is disabled 
and the invoice is 
still in draft state. The 
cost allocation data is 
preserved even when 
the purchase order 
mapping is turned off.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Correct the 
currency details to 
match the invoice 
and purchase order.

PO invoice, Credit 
memo

Unverified sender 
source

This exception occurs 
when the sender's 
email address or 
domain cannot be 
recognized. The 
system adds an audit 
log entry each time 
the unverified sender 
source exception 
is evaluated. This 
is a header level 
exception.

To resolve this invoice 
exception, do the 
following:

1. Log in to the 
application with 
the Accounts 
Payable Specialist 
(sn_ap_apm.accounts_payable_specialist) 
role.

2. Verify the exception, 
and add the sender 
as a new supplier 
contact or reject the 
invoice.

By default, the exception engine is configured to run once every 5 minutes through the 
Exception Monitoring Job. This is a scheduled job, which is inactive in the state by default. 
For information on how to activate the scheduled job, see Activate the Exceptions Monitoring 
Scheduler.
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However, you can also run the exception engine manually. For more information, see Check for 
invoice exceptions on a single invoice.

When you run the exception engine manually on a single invoice, it checks for exceptions only 
on that invoice, whereas the automated exception engine checks for exceptions on all the 
invoices that are valid for exception check.

You can bypass an exception in situations where that exception is not applicable to an invoice. 
For more information, see Bypass an invoice exception.

The Accounts Payable Operations  exception engine finds exceptions and lists them in the list 
page of the Source-to-Pay Workspace. View the list of exceptions by navigating to All  > Accounts 
Payable Operations  > Accounts Payable Workspace.

In the workspace, select the list icon ( ) and do one of the following:

• Navigate to Lists  > My Work  > My open invoice exceptions.

• Navigate to Lists  > All Work  > All open invoice exceptions.

The Accounts Payable Specialist can analyze the invoice exceptions, create exception tasks, and 
assign these tasks to the relevant individuals to fix the exceptions and resolve the case. For more 
information, see Work on an invoice exception.

Activate the Exceptions Monitoring Scheduler

Activate the Exception Monitoring Scheduler  to run the exception engine on a regular schedule 
to identify invoice exceptions.

Before you begin
Role required: admin

About this task
The default automatically runs every 5 minutes after you activate it.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and select the Exception Monitoring Scheduler  to open it.

3. Select theActive  check box.
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You will notice theRepeat interval  set to five 

minutes.

4. Select Update.

Result
The Exception Monitoring Scheduler is activated.

Work on an invoice exception

As an Accounts Payable Specialist, analyze the invoice exceptions, create exception tasks, and 
assign them to the relevant individuals to resolve the invoice exceptions.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
For a description of the field values and information about the available tabs on the invoice 
exception form, see Invoice exception form. For details about the available tabs for an exception 
task, see Invoice task form tabs.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:
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To Do this

View exceptions 
from the List page

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open invoice exceptions.

▪ Navigate to Lists  > All Work  > All open invoice exceptions.

b. Select the link to the invoice exception under the Number column to 
open the exception and view its details.

View exceptions 
from an invoice 
processing case

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open invoice processing 
cases.

▪ Navigate to Lists  > All Work  > All open invoice processing cases.

b. Open an invoice processing case that contains exceptions.

Note:  If an invoice processing case contains exceptions, the 
following message is shown at the top of the case:

Invoice has one or more exceptions. 
Resolve all issues in "Invoice exceptions" 
to continue processing.

c. Select the Invoice Exceptions  tab.

d. Select the link to the invoice exception under the Number column to 
open the exception and view its details.

4. Either work on the invoice exception yourself or create an exception task to assign it to a user 
or an assignment group to resolve the invoice exception.
For more information, see Create an exception task for an invoice exception.
After all the invoice exception tasks are completed, the status of the invoice updates to No 
exceptions found. The invoice processing case remains in the Work in progress state.

5. To view all the invoice exceptions tasks and the exception tasks that are assigned to you, do 
the following:

a. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

b. Select the list icon ( ).

c. Do one of the following:

▪ Navigate to Lists  > My Work  > My open tasks.

▪ Navigate to Lists  > All Work  > All open tasks.

Result
The invoice exceptions are analyzed, exception tasks are created, and assigned to the relevant 
individuals to resolve them.

Create an exception task for an invoice exception

Create an exception task to assign it to a user or an assignment group to resolve the invoice 
exception.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

To Do this

Create an exception task 
from the List page

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open tasks.

▪ Navigate to Lists  > All Work  > All open tasks.

b. Select New.

The Create New Invoice task page is displayed. For a 
description of the field values, see Create New Invoice task 
form.

The Type  field is set to Case task  by default.

c. In the Parent case  field, select the parent case for the 
invoice.

d. In the Invoice exception  field, select the exception for 
which you want to create an exception task.

e. After you select an exception, the Type field changes from 
Case task  to Exception task.

Note:  The Type  field is read-only.

f. Enter the required information in the Assignment group, 
Assigned to, Short description, and Description  fields.

g. Select Save.

Create an exception task 
from an invoice exception

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open invoice 
exceptions.

▪ Navigate to Lists  > All Work  > All open invoice 
exceptions.

b. In the Number column, select the link to an invoice 
exception to open it.

c. Select the Exception tasks  tab and then select New.

The Create New Invoice task page is displayed. For a 
description of the field values, see Create New Invoice task 
form.

The Parent case, Invoice exception, and Type  fields are 
auto-populated.
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To Do this

d. Enter the required information in the Assignment group, 
Assigned to, Short description, and Description  fields.

e. Select Save.

Create an exception task 
from an invoice processing 
case

a. Navigate to Lists  > All Work  > All open invoice processing 
cases.

b. In the Number column, select the link to an invoice 
processing case to open it.

c. Select the Tasks  tab and then select New.

The Create New Invoice task page is displayed. For a 
description of the field values, see Create New Invoice task 
form.

The Parent case field is auto-populated. The Type  field is 
set to Case task  by default.

d. In the Invoice exception  field, select the exception for 
which you want to create an exception task.

e. After you select an exception, the Type  field changes from 
Case task  to Exception task.

Note:  The Type  field is read-only.

f. Enter the required information in the Assignment group, 
Assigned to, Short description, and Description  fields.

g. Select Save.

Result
The exception task gets assigned to the business owner specified on the invoice.

What to do next
Mark an exception task as complete from Employee Center.

Mark an exception task as complete from Employee Center

As a task owner, when you finish working on an assigned exception task, you can mark the task 
as complete from Employee Center.

Before you begin
Role required: sn_shop.invoice_owner or sn_ap_cm.task_owner

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Open  tab, select an exception task.

3. Select Mark Complete.
The Marking the task complete dialog box is displayed.
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4. Enter your comments and select Mark 

Complete.
The status of the exception task changes to Closed complete.

Result
The assigned exception task is marked as complete from the Employee Center.

Edit a purchase for an Insufficient Funds invoice exception

Edit a purchase to resolve invoice exceptions of type Insufficient Funds (Amount variance) and 
Insufficient Funds (Quantity variance).

Before you begin
Role required: sn_shop.shopper

About this task
For more information about editing a purchase order line, see Edit a purchase order line.

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Open  tab, select an Insufficient Funds exception task.

3. Select Edit Purchase.

4. On the Edit a purchase page, select Entire purchase.

5. In the Purchase  field, select the purchase order and do one of the following:

◦ To resolve the Insufficient Funds (Quantity variance) invoice exception, edit the purchase 
order and ensure that the purchase order quantity is greater than the invoiced quantity of all 
the invoices received for this purchase order.

◦ Insufficient Funds (Line amount variance) invoice exception, edit the purchase order and 
ensure that the purchase order amount is greater than the invoiced amount of all the 
invoices received for this purchase order.

6. Select Submit.
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Result
The purchase is edited to resolve invoice exceptions of type Insufficient Funds (Amount 
variance) and Insufficient Funds (Quantity variance).

What to do next
Mark the Insufficient Funds exception task as complete. For more information, see Mark an 
exception task as complete from Employee Center.

Resolve unverified sender source exception

Review an unverified sender source exception in APO  and resolve it by adding the sender as a 
supplier contact or rejecting the invoice.

Before you begin
Role required: admin

An invoice with an unverified sender source exception must be assigned to you or your queue in 
APO.

About this task
Use this procedure when an invoice is flagged with an unverified sender source exception. The 
exception indicates that the sender's email address or domain could not be verified against the 
supplier record or vendor contact list. You must review the exception details and take one of the 
available actions to resolve it.

The system evaluates the following conditions in order when an invoice email is received:

Condition A: Internal forwarding check.

The system first checks whether the email was forwarded by an internal employee.

• If the sender's email domain matches the internal email domain, no exception is created. The 
system adds an audit log entry: Success: Unverified Sender Source - Sender is found to be 
internal company employee.

• If the sender's email domain does not match the internal email domain, the system proceeds 
to evaluate Condition B.

Condition B: Known supplier, unknown contact.

The system evaluates this condition when the sender is not an internal employee. It applies 
when the supplier is successfully identified on the invoice (via OCR or purchase order match) but 
the sender's email address is not recognized.

• The system checks whether all of the following are true:

◦ The supplier is identified as valid.

◦ The sender is not found in the vendor contact list.

◦ The sender's email domain matches the supplier's website domain or registered email 
domains in the primary supplier data or supplier contacts, OR the sender's email domain 
matches the email domain of other contacts in the vendor contact list.

• If a domain match is found, the exception is created. The system adds an audit log entry: 
Failed: Unverified Sender Source - Supplier identified and sender is found to be un-registered 
contact.

• If no domain match is found, the exception is created. The system adds an audit log entry: 
Failed: Unverified Sender Source - Supplier identified but sender's email source is unknown.
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Procedure

1. Navigate to Source-to-Pay Workspace  > All  > List  > Invoices.
locate the invoice with the unverified sender source exception.

2. Select the invoice to open the exception record, then select the Exception details  tab.

3. Review the exception details and the audit log to understand why the exception was triggered.

The audit log records one of the following outcomes:

◦ Failed: Exception check - Supplier identified and sender is found to be un-registered contact 
— the supplier is recognized but the sender is not in the vendor contact list, though the 
domain matches a known supplier domain.

◦ Failed: Exception check - Supplier identified but sender's email source is unknown — the 
supplier is recognized but the sender's email domain does not match any known supplier 
domain or contact.

4. Select one of the following actions to resolve the exception:
To add the sender as a new supplier contact and reprocess the invoice, select Add contact to 
supplier. For the steps to complete this action, see Add a supplier contact from the Source-to-
Pay Workspace.

Note: 

This option is available only if the Supplier Lifecycle Operations  application is installed 
on your instance.

To reject the invoice, select Reject invoice. A rejection dialog appears. Continue to the next 
step.

Result
If you rejected the invoice, the system performs the following actions:

• Adds the rejection reason to the exception record and invoice.

• Cancels the invoice and the invoice processing (IP) case.

If you added the sender as a supplier contact, the invoice is reprocessed.

Related topics

Add a supplier contact from the Source-to-Pay Workspace

Confirm receipt of your order from Employee Center

Confirm the receipt of the items that you've ordered so that the payment is made to the supplier.

Before you begin
Role required: sn_shop.acknowledgement_task_owner

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Open  tab, select the receipt task.

3. Select Complete in ShoppingHub.
Shopping Hub  is opened in a new browser tab.

4. Follow the steps starting from step 2 in Confirm receipt of your order from Shopping Hub 
Home.
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Result
The receipt of the ordered items is confirmed.

Bypass an invoice exception

Bypass an invoice exception if you find that it is not applicable to the invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
The Bypass exception  option is available for an exception only if the Allow bypass  option is 
selected for that exception on the Invoice exception definition form. For more information, see 
Invoice exception definition form.

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

To Do this

View 
exceptions 
from the List 
page

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open invoice exceptions.

▪ Navigate to Lists  > All Work  > All open invoice exceptions.

b. Select the link to the invoice exception under the Number column to 
open the exception and view its details.

View 
exceptions 
from an invoice 
processing 
case

a. Do one of the following:

▪ Navigate to Lists  > My Work  > My open invoice processing cases.

▪ Navigate to Lists  > All Work  > All open invoice processing cases.

b. Open an invoice processing case that contains exceptions.

Note:  If an invoice processing case contains exceptions, the 
following message is shown at the top of the case:

One or more exceptions have been identified on 
this invoice. Review the identified invoice 
exceptions and take appropriate action to 
resolve them.

c. Select the Exceptions  tab.

d. Select the link to the invoice exception under the Number column to 
open the exception and view its details.

4. Select Bypass exception.

5. In the Bypass reason dialog box, enter a reason for bypassing the invoice exception and select 
OK.
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Result
The invoice exception is bypassed and its status changes to Closed-bypassed.

After you bypass an exception, the exception engine re-runs automatically.

View invoice line details for a line-level invoice exception

View details about invoice lines to understand why a line-level invoice exception has been 
created.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
The Invoice lines affected  tab is displayed only for exception tasks that are created for line-
level exceptions, such as Insufficient Goods Receipt, Insufficient Funds (Quantity variance), and 
Insufficient Funds (Amount variance).

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > My open invoice exceptions.

◦ Navigate to Lists  > All Work  > All open invoice exceptions.

4. In the Number column, select the link to a line-level invoice exception to open it.

5. Select the Exception tasks  tab and open an exception task that you created for the invoice 
exception.

6. Select the Invoice lines affected  tab to view details about each invoice line exception.

Result
The line-level invoice exception details are viewed.

View related tasks for an Insufficient Goods Receipt invoice exception

As an Accounts Payable specialist, view tasks related to Sourcing and Procurement Operations 
to understand why an Insufficient Goods Receipt invoice exception has been raised for an 
invoice.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ Navigate to Lists  > My Work  > My open invoice exceptions.

◦ Navigate to Lists  > All Work  > All open invoice exceptions.

4. In the Number column, select the link to an Insufficient Goods Receipt invoice exception to 
open it.
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5. Select the Related tasks 

tab.

If Sourcing and Procurement Operations  is installed, then this tab shows the following tasks:
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◦ Receipt. For more information, see Receipt tasks.

◦ Milestone. For more information, see Milestones.

◦ Invoice acknowledgment. For more information, see Invoice tasks.

If Sourcing and Procurement Operations  is not installed, then this tab shows only the 
Milestone task.

Result
The Accounts Payable Specialist understands the Insufficient Goods Receipt exception by 
viewing Sourcing and Procurement tasks.

Create an invoice exception definition

You can create invoice exception definition for invoices of types PO, Non-PO, credit memo.

Before you begin
Role required: sn_ap_apm.admin

This video shows you how to perform the following procedure.

https://player.vimeo.com/video/983170290?
h=5c81ae0349&badge=0&autopause=0&player_id=0&app_id=58479

Procedure

1. Navigate to All  > Accounts Payable Operations  > Administration  > Invoice exception 
definition.

2. On the Invoice exception definitions form, select New.

3. On the Invoice exception definition form, fill in the fields.
For description of the field values, see Invoice exception definition form. Example: Missing 
business owner or legal entity.

4. Select Active.

5. Select Applicable to  as PO invoice.

6. Enter the order number by which the exception must be executed.

7. Select and hold (or right-click) on the form and Save.

8. Configure the subflow that you want to choose from the drop-down list.

For more information on sub flows, see Create subflow in workflow studio.

9. Select Save.

10. Open an invoice record with all fields configured and click View invoice processing case.
For more information on creating an invoice record, see Create an invoice manually. The 
exception engine runs and displays exceptions in the Review exceptions  activity card of the 
playbook.

11. Click Resolve exceptions  activity card.
The exceptions are displayed. Navigate to the invoice details and populate the valid business 
owner details.

12. Navigate to the invoice details and populate the valid business owner details.

13. Click Save.
The form is saved.

14. Click Check exceptions.
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Result
The exception is raised and resolved successfully.

Create subflow in workflow studio

Use subflows to configure conditions that are applied on the invoice and raise an exception.

Before you begin
Role required: admin

This video shows you how to create subflow in workflow studio.

https://player.vimeo.com/video/1017692662?
h=de32932dcd&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to Workflow Studio  > New  > Subflows.
The subflow page appears.

2. Enter the Subflow name.

3. Enter the Description.

4. Choose the Application  as Accounts Payable Invoice Processing in the drop-down list.

5. Click Build subflow.

6. Configure Inputs and Outputs for Subflow.
Example: In Subflows, you must fetch the invoice record based on sys_id. Traverse through 
the invoice record and check if the condition business owner or legal entity is empty. If the 
condition matches, then the system raises an exception.

a. In the Inputs  area, enter Label  as invoice Sysids.

b. Enter Name  as invoice_sysids.

c. The Type  drop-down is auto-populated with String.

d. Select Done.

e. In the header area, click Flow variables.
The Flow variables pop-up appears.

f. Enter Label  as Condition result.

g. Enter Name  as Condition result.

h. Choose Type  as True/False.

i. Select Save.

7. In Actions  area, perform the following steps:

a. Select Action  as Look Up Records  from the drop-down list.

b. In the Table  field, search forinvoice [sn_shop_invoice].
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c. Configure the Conditions  as sys_id is one of invoice SysIDs.

d. In Actions  > Accounts Payable Invoice Processing > Look Up Records.

e. Select Table  as Invoice [sn_shop_invoice]

f. Set the Conditions  > SysID  > is one of  > Subflows- Inputs  > invoice Sysids.

g. Select Done.

h. Create Flow logic  > For Each item in  > Look Up Records  > Invoice Records > Done.

i. Select If  > Condition1  > For Each  > Invoice Record  > Business owner  > is empty.

j. Select If  > Condition2  > For Each  > Invoice Record  > Legal entity  > is empty.

k. Select then  >  icon.

l. Click Done.

m. Add a flow logic as Set Flow variable.

n. Choose Condition result  from the drop-down list.

o. Select the Data  check-box.

p. Select Done.

q. Add a Flow logic  as Set Flow variables.

r. Choose Condition result  from the drop-down list.

s. Select Done.

t. Select Save.

u. Choose Action  > Accounts Payable Invoice Processing  > Generate Exception and Line 
Exceptions  from the drop-down list.

v. Choose Condition result  as Flow Variable.

w. Choose Exception Definition Record  as Missing BO or LegalEntity.

x. Choose the Invoice  as For Each > Invoice record.

y. Enter the description.

z. Select Done.
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aa. Select Save.
Success message appears as the subflow is saved successfully.

8. Select Publish.
You are prompted with an alert message "Are you sure you want to publish this subflow? Your 
changes will be applied to all instances where this subflow is being used."

Result
The subflow is successfully created.

Tolerance Rules and Variances for invoices

Tolerance rules define the limits set on an invoice to determine the permissible amount of 
variance that can be applied to an invoice before the invoice total exceeds the tolerance limit.

The exception engine checks whether invoices with exceptions are configured with tolerance 
rules. You can customize tolerance rules of different types where the variance is compared with 
defined tolerance percentage and tolerance values. If the tolerance value exceeds the tolerance 
limit, exceptions are raised.

Tolerance types

Accounts Payable Operations  supports the following tolerance types:

• Line amount tolerance: Avoid payment delays by defining the acceptable difference between 
the expected and actual total amount for specific items or services of invoice. If the actual 
amount exceeds the expected amount but falls within this limit, the invoice is considered valid 
for payment.

• Line quantity tolerance: Ensure easy payment processing by defining the acceptable range 
between the expected and actual quantities of items or services listed on an invoice. If the 
actual quantity exceeds the purchased quantity but remains within this limit, the invoice is 
considered valid for payment. This is a line level tolerance.

• Line unit price tolerance: Prevent small discrepancies from impacting payment processing and 
supplier relations by establishing a tolerance range for the difference between the purchase 
order line unit price and the actual price of an invoice. When the actual unit price falls within 
this specified range, the invoice is ready to be processed for payment. This is a line level 
tolerance.

• Overbilling amount tolerance: Defines the maximum allowable amount of overbilling between 
an invoice and the corresponding purchase order. If the actual amount exceeds the expected 
amount but falls within this limit, the invoice is considered valid for payment. This is a header 
level tolerance.

• Over tax amount and under tax amount variances: Ensure smooth payment processing by 
defining an acceptable range between the supplier-provided tax and system-calculated tax 
amounts that allows minor differences within the defined tolerance range. If the supplier-
calculated tax exceeds the system-provided tax but remains within the Over tax tolerance limit 
or the system-calculated tax exceeds the supplier-provided tax but remains within the Under 
tax tolerance limit, the invoice is considered valid for payment.

Note:  If tax amount variance for a tax line is within the tolerance range, then supplier tax 
amount will be copied over to final tax amount field by default.

Define an invoice tolerance type

Define an invoice tolerance type that you can use in an exception definition.
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Before you begin
Role required: sn_ap_apm.invoice_tolerance_admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > All  > Tolerance types.
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2. On the Invoice Tolerance type  list, select New.

3. On the form, fill in the fields.

Field Description

Name Name of the tolerance type

Application
The application value is automatically set to 
Accounts Payable Invoice Processing.

Line level
Option to make the tolerance type applicable 
at the line level.

Description Brief description of the tolerance type

4. Select Submit.

Result
The invoice tolerance type is defined for use in an exception definition.

Map invoice tolerance type with invoice exception definition

Define a new tolerance type and map them with invoice exception definition of your choice to 
fulfill a goal.

Before you begin
Role required: sn_ap_apm.admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Administration  > Invoice exception 

definition.
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For more information on configuring invoice exception definition, see Invoice exception 
definition form.

2. Populate the tolerance type on the invoice exception definition form.
For more information on the tolerance type, see Define an invoice tolerance type.

3. You must update the Subflow  logic to include associated tolerance type logic as per the 
business requirement.

4. Select Submit.

Result
The new tolerance type is defined and mapped to an invoice exception definition.

Define an invoice tolerance rule

Configure invoice tolerance rule definition for a tolerance type to be applied to invoices matching 
the invoice filter's conditions.

Before you begin
Role required: sn_ap_apm.invoice_tolerance_admin

Enable sn_ap_apm.reader role to access invoice filters for tolerance rules.
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Procedure

1. Navigate to All  > Accounts Payable Operations  > All  > Tolerance rules.
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2. On the Invoice Tolerance rule  list, select New.

3. On the form, fill in the fields.

Field Description

Name Name of the tolerance rule.

Active
Option to make the tolerance rule available 
for invoice processing.

Type
The tolerance type that you would like to asso­
ciate with the tolerance rule.

Order

Defines the priority in which you would like to 
process the tolerance rule. The lowest order 
is applied on the invoice. Example: If there 
are two rules applicable with the orders set as 
10 and 20. Rule with order 10 is applied on the 
invoice.

Tolerance value
Set the permissible variance limit of type nu­
meric and positive numbers only. Example: 
200

Tolerance percentage The permissible variance percentage.

Condition type

Determine whether the value and percentage 
both need to be met or whether one of the 
other need to be met to skip an exception.

◦ AND- If both the Tolerance value  and Tol­
erance percentage  values should be met.

◦ OR-Iif either the Tolerance value  or Toler­
ance percentage  values should be met.

Invoice filters

Filter condition to determine the invoices for 
which the tolerance rule is applicable. For ex­
ample: [Type][is][PO invoice] AND [Suppli­
er]]is][X]. You can concatenate additional fil­
ters by using New Criteria.

4. Select Submit.

Result
The tolerance rule is configured for the selected tolerance type.

View tolerance form

Invoice processing cases with exceptions displays the associated Tolerance details  at header 
level and Variance details  at line level.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > All Work  > All open invoice processing 
cases.
List of All open invoice processing cases  is displayed.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1331



2. Open an invoice case.

3. Click Exceptions.

4. Open any invoice exception record with Status  as Open  and contains Tolerance type.

5. In the Details  tab.

a. For header level exception- View Tolerance  and Variance details.

b. For line level exception- View Tolerance  details.
You can view the variance details of each invoice line under Invoice line affected  tab in list 
view and form view.

Note:  If the variance value and variance percentage is exceeding the limit, the values 

are highlighted in yellow color with warning  icon suffixed with Exceeds  and Within 
labels. Grey color indicates that the variance value and variance percentage is within 

the limits or closed with check  icon.

Result
The Tolerance details at the header level and Variance details at the line level are displayed in 
the invoice processing case with exceptions.

Invoice approvals

Invoices with the No exceptions found status are eligible for approval.

The approval engine picks all the invoices with the No exception found status and based on the 
configured approval rules, creates the approval requests and assigns them to the approvers. At 
this stage, the status of the invoices changes to Pending approval. After the approver approves 
the approval request, the status of the invoice changes to Approved.

Create an approval rule

Create approval rules to ensure that the approval requests are reasonable and fit your 
organization's budget.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Administration  > Approval rules.
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2. Select New.

3. On the Approval Rule form, fill in the fields.
For a description of the field values, see Approval Rule form.

4. Select Submit.

Result
The approval rules are created.

What to do next
You can also associate approval rules with approval groups and define the sequence to 
determine when these rules should be triggered. For more information, see Approval rule 
grouping and sequencing.

Approval rule types

Approval rule types determine how approvals are created and routed during the invoice approval 
process.

The approval rule types determine the conditions under which approval plans are created and 
routed.

Approval rule types

Approval 
rule type

Description

Dynamic 
Users or 
Groups

Approvals are dynamically created and sent to the specified user or group. 
Approvals are triggered based on the purchasing user's attributes. The approval 
routing method is restricted to just sending approvals in parallel.

Managerial 
Job Code 
Hierarchy

Approvals are triggered based on the purchasing user's job code and manager's 
job code. The approval routing method can be parallel or sequential, and the 
approval decision method can be all approvers or any approver.

Managerial 
Hierarchy

Approvals are triggered based on the purchasing user's manager's hierarchy. The 
approval routing method can be parallel or sequential, and the approval decision 
method can be all approvers or any approver.

Specified 
Users or 
Groups

Approvals are triggered based on the specified users or groups. The approval 
routing method is restricted to just sending approvals in parallel.

Monitor an approval plan

Monitor approval plans to understand how the overall approval process is progressing.

Before you begin
To monitor an approval plan, you must have already defined an approval rule. For more 
information on how to create approval rules, see Create an approval rule. You can review and 
update the plans if required. Approval plans are not created manually.

Role required: admin

About this task
The approval engine converts each approval rule into one or multiple approval plans. You can 
monitor approval plans to understand how the overall approval process is progressing, the 
routing and decision methods used, the list of approvers involved, the status of the approvals, 
the list of invoice lines the approval is planned for, and so on.
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Procedure

1. Navigate to All  > Accounts Payable Operations  > Administration  > Approval plan.

2. Select a record.

3. On the Approval Plan form, review the 

fields.
For a description of the field values, see Approval Plan form.

Result
Approval plans are monitored to view the approval flow, approvers, routing methods, statuses, 
and related invoice lines, helping you track overall approval progress and actions.

What to do next
Use the related lists of the Approval Plan form to view the approval plan details and approvers 
associated with this approval plan.

Approve an invoice approval task from Employee Center

Review the invoice approval tasks that are assigned to you and approve or reject them.

Before you begin
Role required: sn_shop.invoice_owner

Procedure

1. Navigate to All  > Employee Center  > My Tasks.

2. On the Open  tab, select an invoice approval task.

3. Do one of the following:

Action Description

Approve Approves the request.

Reject Rejects the request.
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You can now view the approved and rejected approval tasks on the Completed  tab.

Note:  When rejecting a request, you must provide your justification for rejection on the 
Reject request window.

Result
The invoice approval tasks are reviewed and approved or rejected.

View invoice documents in the Source-to-Pay Workspace

View the invoice documents directly in the Source-to-Pay Workspace  using Document Viewer 
without having to download them.

Before you begin
Configure Antivirus Scanning

Role required: sn_ap_apm.accounts_payable_specialist or sn_ap_apm.admin

About this task
The invoice document is displayed for invoice, invoice lines, invoice processing case, invoice 
exceptions, and exception task records.

Procedure

1. Navigate to All  > All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Navigate to the list of invoice cases.

4. In the Number column, select the link to a case record that contains an invoice document.

The invoice document is displayed on the right contextual side panel. You can zoom in, zoom 
out, rotate left and right, adjust the document width both horizontally and vertically, and also 
download the document.

You can toggle the invoice document icon ( ) to show or hide the invoice document.

Result
The invoice documents are displayed in the Source-to-Pay workspace.

Advanced Work Assignment in Accounts Payable Operations

Advanced Work Assignment (AWA) automatically assigns work items to Accounts Payable 
Operations  agents based on their availability, capacity and skills. AWA pushes work to qualified 
agents using work item queues, routing conditions, and assignment criteria that you define. The 
work items are available in Agent workspaceinbox.

Customers use different channels to request service, for example, email, chats, cases, or 
incidents. Requests from customers create task or interaction records that store information 
about these objects, called work items. AWA  automatically routes work items to queues that 
focus on certain types of support, using criteria (such as priority or customer status) that you 
provide.

For more information about AWA, refer Advanced Work Assignment .

Setting up Advanced Work Assignment for Accounts Payable Operations

Set up the AWA and required plugins through the plugin page after selecting any Get 
[plugin]button on the Advanced Work Assignment home page.
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Set up the following components for AWA in Accounts Payable Operations

• Service channels- A means of assigning specific tasks to APO agents and specialists. You 
can configure base channels which define the means through which a query is answered by 
the agents. Base channels may include chats, invoice inquiry cases, messenger, and walk-
up centers. You can create service channel of your choice and set attributes such as agent 
capacity, agent skills for each service channel which will define the work handled by the agent 
or agent group.

• Work item- Work handled by the agent from start to completion.

• Work item queue- Queue that stores work items for a service channel.

• Assignment groups- Agents belonging to specific groups categorized by the type of work 
assigned to them.

• Agent capacity- Number of items on a service channel that an agent can work within defined 
time.

• Agent availability- States that indicate whether an agent is busy, available or offline. AWA uses 
agent availability to determine if an agent is able to receive work.

• Inbox layout- A configuration tied to a service channel that defines which fields of a record 
representing a work item are shown in agent inboxes. A layout defines what the agent sees in 
Account Payable Operations workspace.

For more information about AWA components, refer Exploring Advanced Work Assignment .

Configure Advanced Work Assignment for Accounts Payable Operations

Configure AWA for APO to ensure that requests or queries received via email, chat, messenger 
are routed to the respective APO agents belonging to defined groups.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > Advanced Work Assignment.

2. Create a service channel to automatically route incoming work to agents.
For more information about creating service channels, see .  Service channels specific to 
Accounts Payable Operations  are:

◦ Invoice Inquiry Cases

◦ Chat

Note:  You can customize the service channel of your choice for any work that would 
have come through by any mode other than email, chat, messenger.

After you've created the service channel, do the following.
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a. Configure the agent capacity to determine the number of work items that can be assigned to 
agents belonging to a defined group. For more information, see .

b. Create or change an inbox layout to determine the information shown on work item cards 
displayed in an agent's inbox. For more information, see .

c. Create a work item size override if you want to calculate an agent's workload using a work 
item size other than the default. For more information on work item, see .

Define or modify a work item queue, which determines the work items to be routed 
automatically to agents assigned to a service channel. For more information on queues, see .

3. To assign queues, work items to agents, follow steps 3–5 from Configure Advanced Work 
Assignment for Source-to-Pay Operations.

Result
AWA is configured for Accounts Payable Operations  to route requests or queries from email, 
chat, or messenger to the respective agents.

Configure the Accounts Payable Operations  queues

Configure AWA for Accounts Payable Operations  queues so that email, chat, and requests raised 
by suppliers are routed to respective agents belonging to the Accounts Payable supplier group.

Before you begin
Role required: admin

Procedure

1. Navigate to Source to Pay Workspace  > All  > Advanced Work Assignment  > >Queues.

2. Select one of the following mentioned queues for Account Payable Operations.

◦ Invoice Inquiry case

◦ Chat

3. In the Assignment Eligibility related  list, select New.

a. In the Agent assignment rule  field, select Chat - Most Capacity.

b. Select the lock icon ( ) next to the Groups  field.

c. Select the look-up icon ( ) to view the list of groups.

d. Select New.

e. In the Name  field, enter a name for the group.

f. Fill in the remaining fields, as appropriate.

g. Select Submit.

h. Select the lock icon ( ) to lock the Groups  field.

i. Right-select and select Save.

4. Next to the Groups  field, select the link to the group, which opens the group record.

a. In the Group Members related list, select Edit  to add members to the group.

b. Select one or more users in the Collection list and move them to the Group Members List.

c. Select Save.

Note:  The users that you add to this assignment group are automatically granted the 
awa_agent role.
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Result
The AWA queues are configured for Accounts Payable Operations  to route supplier emails, 
chats, and requests to the Accounts Payable supplier group agents.

Configure Agent chat for Accounts Payable Operations

Configure agent chat settings to interact with an Accounts Payable Operations  agent.

Before you begin
Role required: admin

Procedure

1. Navigate to Source-to-Pay workspace  > All  > Conversational Interfaces  > Settings  > Agent 
control.

2. In the User Experience section, swipe the Agent names and avatars  toggle switch to the right 
to enable this option.

3. In the Configurable Toolbar Controls section, select View All.
The Quick Action Toolbar Controls is displayed.

Add or update the quick action shortcuts for live agents in Agent Chat. For more information 
about configuring the toolbar controls, see Configuring Agent Chat .

4. Select Save.
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Result
The agent chat settings are configured to interact with an Accounts Payable Operations  agent.

Using Advanced Work Assignment for Accounts Payable Operations

AWA enables suppliers to interact with Accounts Payable Operations  agents inquire or resolve 
invoice-related queries.

Use AWA for the following benefits:

• Suppliers can initiate chat sessions using virtual agent assist by logging in to the Supplier 
Collaboration Portal to interact with Accounts Payable agents.

• Accounts Payable agents are notified of incoming requests on new work items. By default, no 
more than five requests are assigned to an agent at a time. Accounts Payable agents accept 
requests from the Source-to-Pay workspace inbox to interact with suppliers. Accounts Payable 
agents can also reject requests or transfer requests to other queues or agents if needed.

• Accounts Payable agents use various features such as response templates, knowledge-based 
articles, agent assist, and so on, to resolve invoice-related queries or cases.

• Accounts Payable agents can create an invoice inquiry case if the supplier query needs more 
investigation. For more information on creating a case, see Create New Invoice case form.

• Accounts Payable agents receive invoice email from suppliers. Invoice inquiry cases are 
created through the Create Inquiry Case on Invoice email  flows if email subject contains 
keywords such as invoice inquiry, inquiry.

Working with Advanced Work Assignment

Suppliers interact with APO agents for invoice inquiry cases using the live chat.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Supplier Collaboration portal.
Suppliers interact with APO live agent for invoice inquiry cases. The interactions between 
supplier and APO live agent is recorded in an auto-generated interaction record. For more 
information regarding interaction record, refer Interaction management in Accounts Payable 
Operations.

2. Click Create a case  through the interaction record to create an inquiry case.
For more information about invoice case, refer Create New Invoice case form.

Result
An invoice inquiry case is created through the interaction record, and the interaction is auto-
recorded.

Interaction management in Accounts Payable Operations

Any request for assistance made to an Accounts Payable specialist via email, chat, phone is 
logged in an auto-generated interaction record. Agents can choose to create a case from the 
interaction record, create a request, and associate an interaction record with an existing invoice 
case record.

The Details  tab in interaction record contains the following fields:
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Interaction record details

Field Description

Number Auto-generated unique interaction number

Type The means through which interaction was 
created. Example:Chat

State Status of the interaction

Application The type of application. Example: Invoice Case 
Management

Short description Brief description of the interaction

Work notes Additional notes about the interaction record

Opened for Name of the user

Assigned to Name of the assigned agent

For more information, see Create a new interaction.

.

Create a new interaction

An interaction record is automatically created when an agent accepts a supplier's chat request 
through the chat queue in the Supplier Collaboration Portal.

Before you begin
Role required: Account Payable Operations agent

Procedure

1. Navigate to All  > Source-to-Pay Workspace.
Based on the supplier interaction with the agent, an interaction record is auto-created. For 
more information about the fields in an interaction record, see Interaction management in 
Accounts Payable Operations.

2. ClickCreate a case.
If the supplier chat has a new inquiry, then use create a case. For more information about 
creating invoice inquiry case, see Invoice inquiry cases.

3. Click Save.

Result
An Interaction record is created.

Associate an interaction record in Accounts Payable Operations

Associate an interaction record to an invoice case if your interaction is related to an existing 
invoice case in Source-to-Pay workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Source-to-Pay Workspace..

2. Select the List icon >  > Interactions  > All.
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3. Search for an existing interaction record using the interaction ID from the list of records.

4. Associate a record with an existing invoice case.

a. Select More Actions  and then select Associate record.

The Create New Interaction Related Record  form appears in a new tab.

b. On the form, fill in the fields.

Create New Interaction Related Record form

Field Description

Interaction System-generated interaction number.

Record Type Type of record created for a case or 
knowledge topic. By default, this task is auto-
populated.

Document table Invoice case name that you want to associate 
with the interaction record.

ID of related record Auto-populates after the Document table 
field is filled.

Result
The interaction record is associated with an existing invoice case in the Source-to-Pay 
Workspace.

View interaction record in Accounts Payable Operations

View the details of an interaction record to analyze interactions and take immediate actions. 
Viewing an interaction record provides a comprehensive view of the customer journey. You 
can link an interaction record to an existing invoice case, which needs an Accounts Payable 
Operations  agent involvement for investigation.

Before you begin
Role required: Account Payable agent
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Procedure

1. Navigate to All  > Source-to-Pay Workspace.

2. Select the List icon ( ) and select Interactions  >All.

3. View interactions in the desired category to associate a record with an invoice case.

• Assigned to me- Interactions assigned to an agent

• Active- Interactions ready to be investigated

• All- All interactions

4. Select an interaction record to view its details.

Details form

Field Description

Number System-generated unique interaction number

Type Mode of interaction

State Status of the record

Opened for The virtual agent name

Assigned to The Account Payable agent assigned to the 
interaction record

Transcript Text record of the conversation between an 
agent and the supplier

Result
The interaction record details are displayed.

Composing emails with predefined content from the Source-to-Pay 
Workspace

Insert predefined content into the message body of emails that you send from the email client in 
the Source-to-Pay Workspace.

You can use this feature to compose and send emails directly from an invoice case. To open the 

email client, select Compose Email  from the more actions icon ( ) from an invoice case. A draft 
email appears with pre-populated data in the To  and Subject  fields.

The To  field is auto-populated with the following information:

• The email address of the user in the Requested by  field on the invoice case form.

• The email address of the user in the Assigned to  field on the invoice case form.

The Subject  field is auto-populated with the case number and the invoice case short description.

Using quick messages

In the email client, you can select a quick message to fill the email body with the content that 
is specified in the quick message. After you define one or more quick messages, the Quick 
Messages contextual pane appears in the email client so that you can draft an email with a quick 
message of your choice.
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For more information on how to create a quick message, see Define a quick message .

Using response templates

Resolve cases faster and more efficiently with response templates. Response templates are 
reusable messages that can be copied to draft emails to provide quick and consistent messages 
to users.

Open the response template that you want to use for your email and select Copy to clipboard. 
You can now paste the contents of this template at the location of the cursor. It doesn't replace 
the content that you created before selecting the response template. To replace existing content 
with a response template content, highlight the text to replace and then select a response 
template.

For more information on how to work with response templates, see Create or modify a response 
template .

Communicate using emails from the Source-to-Pay Workspace

Compose and send emails directly from an invoice inquiry case or an invoice processing case in 
the Source-to-Pay Workspace.

Before you begin
Role required: sn_ap_apm.accounts_payable_specialist, sn_ap_apm.admin, sn_ap_cm.agent, or 
sn_ap_cm.admin

Procedure

1. Navigate to All  > Accounts Payable Operations  > Accounts Payable Workspace.

2. Select the list icon ( ).

3. Do one of the following:

◦ As an Accounts Payable Specialist:

▪ Navigate to Lists  > My Work  > My open invoice processing cases

▪ Navigate to Lists  > All Work  > All open invoice processing cases

◦ As an agent:

▪ Navigate to Lists  > My Work  > My open invoice inquiry cases

▪ Navigate to Lists  > All Work  > All open invoice inquiry cases

4. In the Number column, select the link to the case to open it.

5. Select the more actions icon ( ) and select Compose Email.

6. Do one of the following:
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◦ To insert templated content into the email body using quick messages:

a. Select the quick messages icon ( ) and select an appropriate quick message that you 
want to use.

b. Select Insert.

◦ To insert templated content into the email body using response templates:

a. Select the response templates icon ( ) and select an appropriate response template 
that you want to use.

b. Select Copy to clipboard.

c. Paste the content in the email body.

7. Do one of the following:

◦ To send the email instantly, select Send Email.

◦ To save the email as draft to send later, select Save as draft.

Result
Emails are sent from the Source-to-Pay Workspace.

Universal Request in Accounts Payable Operations

The ServiceNow  Universal Request (UR) feature transforms fragmented service intake into a 
centralized, intelligent, and scalable experience for invoice case management.

The Universal Request (UR) is a key ServiceNow  capability that serves as a centralized entry 
point for both invoice owners and suppliers. The primary purpose of UR is to simplify the process 
of raising general case requests, thereby removing any uncertainty regarding the appropriate 
department to contact for assistance.

Persona based roles

UR can be created by:

• Invoice owners through Employee center. For more information on ServiceNow  Universal 
Request, see Exploring Universal Request

• Suppliers submit inquiry case request or issue (UR) using the Supplier Collaboration portal. 
For more information on UR from supplier portal, see Create Universal Request from Supplier 
portal.

How UR works in Accounts Payable Operations

UR seamlessly integrates with the APO system, enabling more efficient management of invoice 
cases. This integration not only streamlines the overall invoice handling process but also 
enhances cross-departmental service delivery, confirming that case requests are addressed 
promptly and accurately across the organization. UR works in APO in the following order:

1. Request submission- Invoice owners or suppliers initiate a UR via the Employee portal or the 
Supplier portal. The UR records essential information and uses predefined mappings.

2. Routing and case creation-Accounts Payable (AP) agents within the Accounts Payable 
Universal Request group are authorized to review Universal Requests (URs) and, based on 
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the provided details, can create an invoice case as the primary ticket. This process can be 
executed either within the Source-to-Pay workspace or directly from the platform.

3. Processing and automation- The updates are synchronized back to the UR. The invoice owner 
or supplier tracks progress and receives updates through the UR case in the employee portal 
or supplier portal.

Key features:

• Both invoice owners and suppliers can submit a single request, eliminating the need to 
navigate multiple portals and simplifying the initial process.

• Users part of Accounts Payable Universal Request group can check and create primary ticket 
for invoice case based on the details in the UR.

• Users benefit from consolidated case activity updates, which are accessible from their 
respective portals. This eliminates the need to switch between systems and provides a 
seamless tracking experience.

Related topics

Using Invoice Case Management

Create Universal Request from Supplier portal

Create invoice case from Universal Request

AP agents validate the incoming UR requests in the Source-to-Pay workspace and create an 
invoice case for further processing.

Before you begin
Role required: Users must be part of the Accounts Payable Universal Request group which 
contains the roles sn_uni_req.routing_agent, sn_ap_cm.agent, [sn_uni_req.sensitiveinfo_agent] 
optional.

Plugins required:
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• Universal Request for Source-to-Pay Operations Plugin [sn_fsc_ur_common] plugin (contains 
dependent plugin Universal Request Plugin [com.snc.universal_request])

• Invoice Case Management [com.sn_ap_cm].

Users can also create own groups. For more information on creating own service- specific-
assignment groups see, Universal Request is raised in the Employee Center or Supplier portal.

Procedure

1. Navigate to Source-to-Pay workspace  > List  > Universal request.
The AP agent validates the UR case details and creates an invoice case for further 

processing.

2. Select a specific UR case to view case details.

Note:  Users with [sn_uni_req.sensitiveinfo_agent] role can view and work on the tickets 
that are marked as restricted. Restricted tickets contain sensitive information and are 
secured from general viewing.

3. Select Create case  >Create invoice case.
The Create New Invoice case  form appears. The associated UR details appear as a 
banner in the case. For more information on creating invoice case, see Create an invoice 

manually.

4. Select Save  to save the changes.

5. Select Transfer  if the primary ticket belongs to a different team.
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If a ticket is transferred to another team and the user who submitted the UR doesn't have the 
necessary permissions to access that team's case, updates to the UR will not be visible to 
them.

For more information on transferring a UR, see Transfer a primary 

ticket .

6. Select Create Associated Ticket  to request other departments for assistance in resolving a 
universal request (UR).
For more information on associated ticket, see Create associated ticket for primary ticket of 
UR .

If the ticket is assigned to another team, and the original user who submitted the UR doesn’t 
possess the necessary privileges or access to view that team's case, they’ll be unable to 
monitor updates on the UR.

An associated ticket is created.

Result
Invoice case is created and processed. Once the case is resolved, the agent closes the case 
with appropriate reason. The UR is synced with invoice case details for invoice owners and 
suppliers to track the status of the UR.

Related topics

Using Invoice Case Management
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Playbook for updating the invoice primary data

Playbooks provide Accounts Payable admins or specialists to visualize invoice processing 
workflows in a simplified, task-oriented, actionable view.

The playbook provides a visual representation of the step-by-step process involved in 
processing an invoice processing case. The structured workflow helps Accounts Payable admins 
or specialists to visualize and understand the status of an invoice processing case and take 
necessary action when required. With playbooks, it’s easier to know what to do next, and also 
understand what happened in the past with the invoice processing case. With playbooks, 
the Accounts Payable admins or specialists quickly view and analyze the state of an invoice 
processing case leading to quicker turn-around with suppliers and resulting in enhanced 
business operations.

Playbooks in Accounts Payable Operations  provide step-by-step process involved in processing 
an invoice processing case such as validating the invoice, checking for duplicates, mapping 
invoice lines and purchase orders, validating exceptions, checking for approvals, and processing 
the payment of the invoice.

The generative AI skill is used to map purchase order lines with invoice lines. Mapping 

performed by a generative AI skill is displayed with an  icon.

You can perform the following actions using the playbook:

• View the different stages and activities of an invoice

• View status indicators that display the state of the current stage or action

For more information about the workflow of playbooks, see Process Automation Designer .

View the Playbook activities

Playbooks in Accounts Payable Operations  displays step by step process involved in processing 
an invoice processing case through activity views.

The playbook life cycle provides the context as to where an Accounts Payable specialist is within 
the playbook, including information for each stage and activity and any dependencies between 
stages. For stages with multiple activities, the playbook life cycle provides step-by-step guidance 
for completing the stage.

The figure below displays the playbook 

workflow.

The stages and activities in a playbook life cycle are configured using Process Automation 
Designer  (PAD). Refer to the table below for the Playbook activity cards.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1351

https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=yokohama&pubname=yokohama-build-workflows&ft:locale=en-US


Playbook activity cards

Stage Activity Description

Validate invoice • Review header details-
Review the invoice header 
details and make any 
required changes

• Review invoice lines- 
Review the invoice lines 
associated with the invoice 
processing case

• Review tax lines- Review the 
list of invoice tax lines.

Verify the invoice details. For 
more information on details 
of playbook stages, see Using 
Playbook in Accounts Payable 
Operations

Check duplicates Review duplicates Checks if the invoice 
processing case is a 
suspected duplicate

Map invoice lines • Verify purchase order- Verify 
the purchase order details 
associated with an invoice.

• Review PO line mapping- 
Review the PO lines 
associated with the 
purchase order to identify 
the lines that is mapped to 
the invoice line.

Allows you map invoice lines 
with purchase order lines.

Review exceptions • Resolve exceptions- Review 
and resolve the exceptions 
generated for the invoice.

• Review exception tasks-
Review and resolve 
exception tasks if any.

Allows you review list of 
exceptions raised for the 
invoice

Await approval • View approval plan- Review 
the approval plan

• Review approvals-Review 
the approvals generated for 
the invoice

Allows you to review approvals 
generated for the invoice
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Playbook activity cards  (continued)

Stage Activity Description

Pay invoice • Review integration errors- 
Review the integration 
errors generated for the 
invoice.

• Review payments- Review 
the payment details of the 
invoice.

Allows you to review the 
integration errors and the 
payment details

The playbook work area appears in the center part of the playbook section. It displays the action 
taken for the current activity, depending on the configured activity view.

Using Playbook in Accounts Payable Operations

Configure a playbook and visualize the step-by-step actions performed by an Accounts Payable 
specialist while processing an invoice.

Before you begin
Role required: Accounts Payable specialist

Procedure

1. Navigate to Source-to-Pay Workspace  > All  > Accounts Payable Operations.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.
You can create an invoice manually. For more information on invoices, see Work with invoices.

4. Select View Invoice processing case.
A playbook is available for the Invoice processing case. You can view the stages and activities 
of Invoice processing in the Playbook  tab.

5. Select Validate invoice.
The invoice opens and you must verify the invoice details. The Classify documents  swim 
lane appears and prompts you to verify the invoice classification. The Classify documents 
swim lane appears if the document classification skill is activated. For more information on 
document classification, see Configure Accounts payable document classification skill.

a. Select the Review header  details.
Review the invoice header details and make any required changes.

b. Select Save.

c. Select Continue  to move to the next activity in the playbook.

d. Select the Review invoice lines  activity.
Manually review the invoice lines associated with the invoice processing case.

e. When tax integration is disabled, you can create tax lines from related list of invoice lines or 
invoice case.
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f. Select Add new invoice lines  to create invoice lines.

g. Select Continue  to move to the next activity in the playbook.

h. Select Add tax.
The Add tax lines to the invoice  pop-up box displays. You can choose to add tax lines 
associated with invoice line. For more information on the fields of tax lines, see Invoice Tax 
lines fields.

i. Select an Invoice line  in which you would like to add the tax lines.

j. Select the Apply to all invoice lines  check box if you want to add the tax lines to all the 
invoice lines.

k. In the Enter tax details  area, perform the following steps.

l. Select the Tax type  to be associated with the invoice line.

m. Enter the Supplier tax rate  details.

n. Enter the Supplier tax  details.

o. Select Add tax.
The tax lines are added to the invoice line.

p. Select Submit invoice.
The invoice is submitted with tax lines.

6. Select Check Duplicates.

a. The Check Duplicates  activity enables you to check if the invoice processing case is a 
suspected duplicate.
The Review Duplicates  activity is auto-selected if the invoice is a suspected duplicate. If the 
invoice isn't a suspected duplicate, then the activity is set to auto-complete.

b. Select Confirm duplicate.
If the invoice is found to be duplicate, then select confirm duplicate. The invoice moves to a 
confirmed duplicate State and the playbook is set to Cancelled

c. Select Notify supplier.

d. Select Not a duplicate  if the invoice isn’t duplicate.
A pop-up box displays prompting the user to enter the reason for the non-duplicate invoice.

e. To reset the invoice to the received state after setting, it as confirmed duplicate follow the 
steps from Reset an invoice to the Received status.

7. Select the Map invoice lines  card.
If the invoice is a PO invoice or credit memo invoice of type PO and the invoice doesn't run 
into a matching error, then the Map invoice lines  card is set to auto-complete. However, if 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1354



the invoice is of type Non-PO invoice or a credit memo invoice of type Non-PO, the stage is 
skipped.

a. Verify the Map invoice lines  card.

b. Verify the Verify Purchase Order  card.
Verify the purchase order details associated with an invoice.

c. You can edit the changes to the purchase order form and select Update.

d. Select Continue  after you save the changes.

e. In the Review PO line mapping  card, review the PO lines associated with the purchase order 
to identify the lines that is mapped to the invoice line.

f. You can edit the invoice lines and match the invoice lines with the corresponding purchase 
order lines.

The swim lane moves to Review compliance. For more details on tax compliance, see Tax 
integration in playbook.

8. Select Review exceptions.
The list of exceptions raised for the invoice is listed. For more information on exceptions, 
see Invoice exceptions. This stage is set to auto-complete if the invoice doesn't run into 
exceptions.

a. Review the exceptions generated for the invoice using the Resolve exceptions  card, and 
resolve exceptions if any.

b. Select an Check exceptions  action to re-evaluate the exceptions.
For Valid coding required exception, the exception engine is trained to provide 
recommendations from Agentic AI. The status of the exception is set to Review needed.

c. The APS manually reviews and verifies the suggestion by selecting Accept suggestion  and 
Save.

d. After all the exceptions are resolved in an invoice line, the status of the exception changes to 
Complete.

e. Select Review exception tasks  to resolve exception tasks if any.

f. Select Create new task  to create an exception task.
For more information on exception tasks, Work on an invoice exception.

9. Select the Await approval  card.
This stage is set to auto-complete after the invoice is approved.

Note:  Use Review approvals  generated for the invoice. In the Notify supplier  activity, 
you can review the emails sent to the supplier when an invoice is rejected.

10. Select the Pay Invoice  card.
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a. In the Review Integration errors  activity, review the integration errors generated for the 
invoice.
For more information on integration errors, see Integration errors.

b. The playbook auto-selects a Review payments  activity.
You can view the payment details of the invoice. For more information on the payment form, 
see Payment terms

The invoice processing case is completed with status set to Paid.

Document Intelligence  processing with playbook

Invoices ingested through Document Intelligence  require Accounts Payable specialists or 
admins to perform manual actions depending on Document Intelligence  availability and invoice 
processing using Document Intelligence.

The following scenarios occur when Document Intelligence  process a document:

• When Document Intelligence  is processing the document, and if you select the Capture 
invoice details  card, you’re prompted with the message: Invoice is currently 
being processed by DocIntel. This process might take some time 
to complete. Check back for updates.

• When Document Intelligence  processing is completed and the data is extracted successfully, 
the Capture invoice details  card is auto-completed and displays the message as: Invoice 
extraction is successfully completed.

• Extract data with Document Intelligence

• Extract data when Document Intelligence fails

• Extract data when Document Intelligence is unavailable

Extract data with Document Intelligence

You can manually extract data from the document when Document Intelligence  completes the 
processing but fails to auto-extract data.

Before you begin
Role required: Accounts Payable admin, Accounts Payable specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.
You can create an invoice manually. For more information on invoices, see Work with invoices.

4. Select View invoice processing case.
A playbook is created for the invoice processing case.

5. Select Validate invoice  >Capture invoice details  activity card.
An alert message displays as: Review the invoice details captured by 
DocIntel and provide any missing information.

6. Select Review invoice.
The document extraction dashboard opens in a tab. The document extraction dashboard 
extracts the invoice fields.
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Note: 

◦ When the document extraction is completed either automatically or manually and all 
the required invoice details are populated, then the invoice is submitted automatically. 
The Review header details  and Review invoice lines  cards are set to auto-complete.

◦ When the document extraction is completed either automatically or manually, but 
the required fields are missing, then manually populate the invoice line fields or add 
invoice lines using Review invoice lines.

For more information on manual creation of invoice, see Using Invoice Case Management.

7. Select Submit.

Result
The data is manually extracted from the document.

Extract data when Document Intelligence  fails

You must manually create an invoice for processing when Document Intelligence  fails to process 
the task.

Before you begin
Role required: Accounts Payable admin, Accounts Payable specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.
You can create an invoice manually. For more information on invoices, see Work with invoices.

4. Select View invoice processing case.
A playbook is created for the invoice processing case.

5. Select Validate invoice>Capture invoice details  activity card.
An alert message displays as: Invoice extraction has run into some 
technical issues. Please contact your system administrator. To 
continue processing, manually create an invoice or close the 
case.

6. Select Create invoice  manually for creation of an invoice.

Note:  You can choose to close the case if you do not want to proceed.

For more information on manual creation of invoices, see Using Invoice Case Management

7. Select Review header details  to populate the header fields.

8. Select Review invoice lines  and add the invoice line fields or populate the required fields.

9. Select Submit.
If no further processing is required, then you can close the invoice case. A pop-up window 
prompts you to enter the reason for closing the invoice processing case. The playbook is 
canceled and the supplier is notified about the closure of the invoice processing case. The 
Notify supplier  card is activated by default and displays the email sent to the supplier.

Result
The invoice is manually created for processing when Document Intelligence fails.
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Extract data when Document Intelligence  is unavailable

You must manually create an invoice for processing when Document Intelligence  is unavailable.

Before you begin
Role required: Accounts Payable admin, Accounts Payable specialist

Procedure

1. Navigate to All  > Accounts Payable Operations  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.
You can create an invoice manually. For more information on invoices, see Work with invoices.

4. Select View invoice processing case.
A playbook is created for the invoice processing case.

5. Select Validate invoice>Capture invoice details  activity card.
An alert message displays as: DocIntel is unavailable to process the 
invoice. To continue processing, manually create an invoice or 
close the case.

6. Select Create invoice  manually.

Note:  You can select Create invoice  when Document Intelligence  is down or still 
processing in the background. If Document Intelligence  is extracting invoice details via 
email using generative AI skill, then the invoice processing case is created with Review 
invoice  option enabled. Thus, prompting the Accounts Payable specialist to manually 
review the invoice details.

For more information on manual creation of invoices, see Using Invoice Case Management

7. Select Review header details  to populate the header fields.

8. Select Review invoice lines  and add the invoice line fields or populate the required fields.

9. Select Submit.
If no further processing is required, then you can close the invoice case. A pop-up window 
prompts you to enter the reason for closing the invoice processing case. The playbook is 
canceled and the supplier is notified about the closure of the invoice processing case. The 
Notify supplier  card is activated by default and displays the email sent to the supplier.

Note:  Invoices ingested through integration or manually, the Capture invoice details 
activity card isn’t displayed under Validate invoice.

Result
The invoice is manually created for processing when Document Intelligence is unavailable.

Using Supplier Collaboration Portal in APO

The Supplier Collaboration portal application integrated with Accounts Payable Operations 
provides seamless interaction between Account Payable Specialist and supplier in creating 
invoice inquiry case, submit new invoice, resolving case tasks and exception tasks.

Supplier Portal Collaboration header

The portal header is located at the top-right corner of the home page contains the following 
options.
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Option Description

My Tasks Lists all the tasks that are assigned to the 
logged-in user. For more information on 
tasks, see Working with tasks in Supplier 
Collaboration Portal header.

My Requests Opens the My Requests page, which lists all 
the requests assigned to you.

Raise a request Supplier raises invoice requests.

For more information regarding the Supplier Portal Collaboration header options, see Working 
with tasks in Supplier Collaboration Portal header.

Supplier Collaboration Portal widgets

The Supplier Collaboration Portal integrated with Accounts Payable Operations  consists of the 
following widgets. For more information on Supplier Collaboration Portal widgets, see Supplier 
Collaboration Portal.
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My active items widget

As a supplier contact, you can view specific items from the following tiles in the My active items 
widget:

Item Description

Tasks Opens the My Tasks  list page, which lists all 
the tasks that are assigned to the supplier. For 
more information on tasks, see Working with 
tasks in Supplier Collaboration Portal header.

Requests Lists all the invoice inquiry cases for the 
supplier. For more information on inquiry 
requests, see Working with My Requests.

Invoices Lists the invoices for supplier to view the 
invoice details and raise invoice related 
inquiry case. For more information on invoice 
inquiry see Submit Invoice Inquiry.

Note:  From the invoice form, you can 
submit an inquiry case. For more details 
on inquiry case, see Submit Invoice 
Inquiry

.

My Requests widget

Displays a list of invoice inquiry cases that you have submitted. Selecting 
a case directly opens the My Requests  page so that you can work on that 
inquiry case. Select View All  to view the list of all inquiry cases that you have 
submitted. For more information on My Requests  widget, see Working with My 

Requests.

For more information on installing Supplier Collaboration Portal, see Configuring Supplier 
Lifecycle Operations.
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Explicit roles plugin

You can give both internal users and external users access to your instance. However, you might 
not want both types of users to have the same level of access. To provide added security, every 
user must have at least one role so that the instance can distinguish between internal and 
external users.

As of the Paris  release, no user can have both of the explicit roles (snc_internal and 
snc_external). Groups and role containment cannot include both roles, either, since that would 
cause any group member or user who is assigned to such a group or such a role to automatically 
have both roles. The ServiceNow AI Platform  aborts any operation that would create such a 
scenario.

You must install the Explicit Roles [com.glide.explicit_roles] plugin while installing Accounts 
Payable Operations. The Accounts Payable Operations plugin is dependent on the Explicit Roles 
[com.glide.explicit_roles] plugin.

Before you install the Accounts Payable Operations plugin, you must perform comprehensive 
analysis of the Explicit Roles [com.glide.explicit_roles] plugin configuration to avoid conflicts or 
adjustments; ensure seamless integration and operation of the plugins.

The installation of the Accounts Payable Operations plugin may cause access issues to the 
existing functionality that are controlled by the Explicit Roles [com.glide.explicit_roles] plugin. You 
may have to manage or reconfigure certain roles and permissions managed by the Explicit Roles 
[com.glide.explicit_roles] plugin for seamless integration and operation of existing functionalities. 
For more information on explicit roles, see Explicit Roles .

Working with tasks in Supplier Collaboration Portal header

Use the portal header located at the top-right corner of the Supplier Collaboration Portal home 
page to open exception tasks, invoice inquiry requests assigned to the logged-in supplier.

Before you begin
Role required: Supplier

Procedure

1. Navigate to the header on the Supplier Collaboration Portal home page >Tasks  > My Tasks.
Lists the Open  and Completed  exception tasks and invoice case tasks assigned for the 
logged in supplier. For more information on creating an exception task, see Work on an invoice 
exception.

Note:  You can also view My Tasks  by navigating to My active items  widget>Tasks  tile.

2. On the Exception task  form, you can view the following details.

Option Description

Number
An auto-generated number that uniquely iden­
tifies the task.

Due Date
The assigned date by which the task must be 
completed.

State

The current state of the task. The states are:

◦ New

◦ Assigned

◦ Work in progress
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Option Description

◦ Closed complete

◦ Closed incomplete

Supplier Name of the supplier

Supplier invoice number The invoice number of the supplier invoice.

Purchase order Purchase order number related to the invoice.

Amount invoiced (Transaction currency) Charges applied on the invoice.

Description Detailed description about the task.

Activity
Lists the activity postings between Accounts 
Payable Specialist and supplier.

Attachments
Supplier uses attachments in the form of PDF, 
JPEG, PNG formats.

3. On the Invoice case  task form, you can view the following.

Option Description

Number
Auto-generated number that uniquely identi­
fies the invoice case.

Due Date
The assigned date by which the task must to 
be completed.

State

The current state of the task. The states are:

◦ New

◦ Assigned

◦ Work in progress

◦ Closed complete

◦ Closed incomplete

Supplier invoice number The invoice number of the supplier invoice.

Purchase order Purchase order number related to the invoice.

Parent case Name of the parent case assigned to.

Description Detailed description about the task.

Activity
Lists the activity postings between Accounts 
Payable Specialist and supplier.

Attachments
Supplier uses attachments in the form of PDF, 
JPEG, PNG formats.

Supplier selects Mark complete. The status of the task changes to Closed complete. For more 
information on invoice case, see Using Invoice Case Management.
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Result
Exception tasks and invoice inquiry requests assigned to the logged-in supplier are displayed, 
and the supplier can mark them as complete.

Working with My Requests

View and respond to invoice inquiries.

Before you begin
Role required: Supplier

Procedure

1. Navigate to the header on the home page > My Requests.
Lists all the invoice inquiry cases assigned to supplier. For more information on invoice inquiry 
cases, see Invoice inquiry cases.

2. You can apply filter on View  option which will display the open and closed requests.

3. Use the Search open requests  option to search for a specific request using the inquiry 
number.

4. Open a Invoice inquiry  case.
The Invoice inquiry  form appears.

5. On the Invoice inquiry  form, perform the following.

Option Description

Number
Auto-populates the invoice number associat­
ed with the inquiry.

State
Displays the current state of the Invoice in­
quiry.

Updated Number of days the record was last updated.

Created Number of days the record was created on.

Requested by Auto-populated name of the requester.

Supplier invoice number
Supplier invoice number to which the inquiry 
is related to.

Due date
Last date to approve the request by the sup­
plier.

Description
Detailed description about the invoice in­
quiry.

Activity
Supplier posts comments related to the in­
voice inquiry.

Attachments Invoice attachments in the form of jpeg, png.

The Accounts Payable agent interacts with the supplier and updates the inquiry case using the 
Activity  option.

Result
The invoice inquiry case details are displayed, and the Accounts Payable agent can view and 
respond to invoice inquiries.
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Create Universal Request from Supplier portal

Suppliers submit their invoice inquiries through Request help, which transfers to a Universal 
Request (UR). Requests are sent directly to the Source-to-Pay Workspace for further processing.

Before you begin
Role required: sn_slm.contact

Plugins required:

• Universal Request for Source-to-Pay Operations Plugin [sn_fsc_ur_common] plugin (contains 
dependent plugin Universal Request Plugin [com.snc.universal_request])

• Supplier Common Architecture [com.snc.sn_slm]

• Invoice Case Management [com.sn_ap_cm].

Procedure

1. Navigate to Supplier Collaboration Portal  > Search for 
any detail in Search bar  > Contact us for help  > Request 

help.

2. Select Request Help  to create a UR.
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The Request Help form appears. For more information on the fields in the form, see Request 
Help 

form.

3. Select 

Submit.

Result
The Universal Request is created.

Related topics

Universal Request in Accounts Payable Operations

Working with Supplier Catalog

Supplier uses the Supplier Catalog to submit new invoice inquiry and invoice to the Accounts 
Payable Operations  team to evaluate and resolve the cases.

Supplier can perform the following actions in the Supplier Catalog  with category as Invoices. By 
default, the Invoices  tab is selected and displayed in the Card View. You can toggle between 
Card view  and Table view.

Many-to-many (M2M) mapping between supplier contact and suppliers enable one supplier 
contact to be the contact for multiple suppliers, provided the suppliers share a parent-subsidiary 
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relationship. To view the list of suppliers associated with supplier contact (M2M) in the Supplier 
Collaboration Portal, the admin must create and execute a fix script. For more information on 
creating fix scripts for M2M mapping, see Enable M2M mapping between supplier contact and 
suppliers.

Note:  You can also select an Raise a request  option in the Supplier Collaboration Portal 
header to perform the following actions.

• Submit Invoice Inquiry

• Submit new Invoice

Submit Invoice Inquiry

Supplier uses the Supplier Collaboration Portal to create an inquiry related to an invoice and 
submits it to the Accounts Payable Operations  team to evaluate and resolve the inquiry.

Before you begin
Role required: Supplier

Procedure

1. Navigate to Supplier Catalog  > Invoices  > Submit an invoice inquiry.

2. On the Submit an invoice inquiry  form, enter the following details.

Question Description

Which supplier?
Supplier- Displays the name of the supplier 
associated with the supplier contact based 
on your selection from the My Company  tab.

What invoice would you like to inquire 
about?

Invoice number- Choose the invoice number 
on which you need to inquire from the drop-
down list. The drop-down lists the invoice 
numbers of the supplier displayed in Which 
supplier?  field.

What kind of invoice inquiry would you like 
to make?

Inquiry type- Choose the type of inquiry that 
you would like to ask an Account Payable Spe­
cialist. The options are:

◦ Payment inquiry

◦ Invoice inquiry

◦ Expedite payment request

◦ Payment term issue

◦ Invoice entry assistance
For more information on invoice inquiry, see 
Invoice inquiry cases.

Please describe your inquiry below in de­
tail:

Description- Detailed description about the in­
voice inquiry.

3. Select Submit.
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A pop-up alert message appears as "  Your inquiry is submitted and we will respond soon. You 
can review details here: <<Invoice case number>>.

Note:  From the invoice form page, you can select Actions  > Create new inquiry  and 
submit an invoice inquiry.

Result
Invoice inquiry case is created.

Submit new Invoice

Supplier creates and submits an invoice requesting for payment from Accounts Payable 
Operations  team. The invoices are of type PO-invoice or Non-PO invoice.

Before you begin
Role required: Supplier

Procedure

1. Navigate to Supplier Catalog  > Invoices  > Submit new invoice.

2. On the Submit new invoice  form, enter the following details.

Question Description

What type of invoice are you submitting?

Invoice type- Choose the invoice type for pro­
cessing from the drop-down list. The options 
are:

◦ PO invoice- The Purchase order  drop-
down appears. Choose the purchase order 
from the drop-down that you would like to 
associate with the invoice.

◦ Non-PO invoice- Browse and attach the in­
voice for the Accounts Payable Operations 
team to create an invoice processing case.

Note: 

▪ If you select Invoice type as Non-
PO, and upload an invoice copy 
with purchase order, DocIntel 
processes the invoice as a valid PO 
invoice.

▪ If you select Invoice type as PO in­
voice and enter purchase order 
number but Doc Intel is unable to 
extract the purchase order details, 
then the purchase order that you 
selected from the Purchase order 
drop-down list will be considered 
and processed.

For more information on invoice case, see 
Create New Invoice form.

Supplier- Displays the name of the supplier 
associated with the supplier contact based 
on your selection from the My Companytab. 
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Question Description

The Purchase order  drop-down lists the de­
tails associated with the selected supplier.

3. Click Submit.
A pop-up alert message appears as "  Your invoice is submitted and we will send updates about 
any issues. You can review details here: <<Invoice case number>>.

Result
Invoice is created.

Virtual agent flows

Suppliers can check the invoice and inquiry statuses, create inquiry cases in the supplier portal 
using the chat channel. Suppliers can also use the virtual agent to view predefined chatbot 
topics.

Suppliers can switch between a virtual agent and a live agent to address their issues. The 
customer service virtual agent topics (chatbot conversations) help suppliers complete common 
self-service tasks. The supplier initiates a conversation topic that consists of dialogs with the 
virtual agent chatbot to accomplish a goal.

Natural Language understanding (NLU) is integrated with the virtual agent chatbot to help 
suppliers with invoice and inquiry-related queries. NLU also helps suppliers to analyze, 
understand, and navigate to the right topic.

For more information, see Connect  and Virtual Agent .

Accounts Payable Operations  Virtual agent flows

Supplier can choose to view the following Virtual agent flows.

Check invoice status

The supplier provides an invoice number and the virtual agent displays the status of the invoice. 
The invoice status is a clickable link, which navigates suppliers to view invoice case details. For 
more details about the invoice, see Work with invoices.

The chatbot prompts the supplier to perform the following.

1. Add new comment-comment on the inquiry or invoice case that the supplier requested for

2. Talk to a live agent- Accounts Payable Operations  agent interacts with a supplier for an invoice 
or inquiry-related query

3. Search for something else- Redirects suppliers to point 1

4. All good thanks- Ends the chat

Live Agent support

Suppliers are routed directly to a live Accounts Payable Operations  to initiate conversations 
and skip the virtual agent conversation greeting. Live agents can also create Interaction records 
and associate with an existing invoice case. For more information on interaction records, 
see Interaction management in Accounts Payable Operations. If an agent isn't available, the 
message No agent available  is displayed to the user.
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Check inquiry status

The supplier provides an invoice number and the virtual agent displays the status of the inquiry. 
The Accounts Payable Operations  agent can create a new inquiry on the invoice.

Create new inquiry

The supplier can choose to create an inquiry case related to the invoice using the Create inquiry 
link. The Create inquiry  link enables suppliers to choose the type of inquiry case. Suppliers use 
Add new comment  to add comments related to the inquiry.

For more information on creating inquiry case, see Submit Invoice Inquiry.

Prechat Survey

Pre-chat survey is available to supplier if the Accounts Payable admin installs the app-
supplier-awaplugin into the system. Depending on the response received from the supplier, 
the chatbot directs the supplier to choose between Talk to Live Agent  and Accounts Payable 
options. For more information on the options, see Configure the chat channel  and Advanced 
Work Assignment in Accounts Payable Operations.

.

Configure the chat channel

Activate the virtual agent chatbot (chat channel) in the supplier portal for suppliers to complete 
Accounts Payable Operations  related self-service tasks.

Before you begin
Activate the following plugins for the chat channel in the supplier portal to be available to access 
predefined conversation topics:

• The Virtual Agent (com.glide.cs.chatbot)

• Advanced Work Assignment with Supplier life cycle Operations (com.snc.sn_slm_awa)

Role required: Accounts payable specialist, Accounts payable agent, supplier.

Procedure

1. Navigate to Supplier Collaboration Portal  > Chat window.

2. Choose a flow, which you want to view.
For more information on flows, refer Virtual agent flows.

Result
The virtual agent chatbot is activated in the supplier portal.

Email resolution notifications for APO

When the AI worker agent provides a resolution to your invoice inquiry case and moves the case 
status to awaiting acceptance. An email notification is sent with resolution details and action 
buttons to accept or reject the resolution.

The Accounts Payable Operations  email resolution notification feature streamlines how suppliers 
and invoice owners receive updates about their Accounts Payable Operations  cases. When a 
case is resolved and requires your acceptance or confirmation, you receive an email with the 
complete resolution details. The email includes action buttons that enables you to respond 
directly from your inbox, without needing to log in to the portal or navigate to a separate website.
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Key benefits

• Faster resolution: Receive resolution updates immediately and respond from your email inbox.

• Clear communication: Resolution details are presented directly in the email, eliminating the 
need to check a portal.

• Streamlined response: Accept or reject resolutions with a single "click" using the action 
buttons.

• Consistent behavior: Email buttons work the same way as portal actions for a seamless 
experience.

• Reduced effort: No login required to respond to resolution notifications.

How it works

When your Accounts Payable Operations  case receives a resolution, the AI worker agent 
updates the case status to "Awaiting acceptance" to indicate that your confirmation or feedback 
is needed. The system automatically sends an email notification to your registered email 
address. The email contains the following:

• The case reference number and case summary

• Complete resolution details provided by the AI worker agent

• Two action buttons: "Yes, this is resolved" and "No, I need more help"

When you select one of the action buttons, your response is recorded and the case status is 
updated accordingly. If you accept the resolution, the case closes. If you reject the resolution 
and request more help, the case is assigned to AP supplier services with New status for further 
investigation and assistance.

When notifications are sent

Email resolution notifications are sent in the following circumstances:

• A resolution has been provided to your case by the AI worker agent.

• The case status has been changed to "Awaiting acceptance."

• Your email address is registered in the system as the case requester or supplier contact.

Respond to an email resolution notification

When you receive an email resolution notification for your Accounts Payable Operations  case, 
use the action buttons to accept or reject the resolution directly from your email inbox.

About this task
Use this procedure to respond to an email resolution notification from the Accounts Payable 
Operations  team. Your response confirms whether the provided resolution addresses your 
concern. The action buttons in the email allows you to respond without logging into the portal or 
visiting a website.

Before you begin
Role required: admin

Procedure

1. Open the email resolution notification from the Accounts Payable Operations  team.

The email is sent to the email address registered for your supplier account. Look for an email 
with the subject containing your case reference number.
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2. Review the resolution details provided in the email.

The email includes the following information:

◦ Case reference number and case summary

◦ Complete resolution details and explanation from the APO  team

◦ Any supporting documentation or details relevant to your case

3. Evaluate whether the resolution resolves your issue.

4. Select the appropriate action button:

◦ If the resolution resolves your issue: Select the Yes, this is resolved  button.

◦ If you need more help or the resolution does not address your concern: Select the No, I need 
more help  button.

Result
Your response is recorded immediately and the case status is updated:

• If you selected "Yes, this is resolved":  The case closes and is marked as resolved. You receive 
a confirmation email acknowledging your acceptance of the resolution.

• If you selected "No, I need more help":  The case status changes to New and the Assignment 
group is changed to AP supplier services. The Accounts Payable Operations  specialist 
investigates the case.

In either case, your response is processed automatically, and you don't take any additional 
action.

What to do next
Monitor your email for follow-up communications from the Accounts Payable Operations  team. If 
you selected "No, I need more help," the team will continue working on your case and send you 
updates as progress is made.

Related topics

Email resolution notifications for APO

Integrating APO  with other applications
Extend the capabilities of Accounts Payable Operations by integrating with other applications.

Accounts Payable Operations integration framework

Invoice integration facilitates inbound and outbound integration with third party applications or 
any external systems into the ServiceNow®  application.

The integration framework consists of inbound invoice and outbound invoice interface tables. 
Invoice integration involves the transfer of invoice and invoice line data by running transform 
maps through various sources or external systems. For more information on integration, see 
Integration Hub .

The integration framework enables the following use cases:

• Ingest invoices from external sources - The invoice data is extracted from ERP sources into 
ServiceNow®  inbound staging tables and is referred as inbound integration.

• Post invoices into ERP- The invoice and invoice line data with Approved  status is synchronized 
with ServiceNow®  outbound invoice and invoice line tables. The integration status is set to 
New  and is referred as outbound integration.
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• Ingest invoice payment details from ERP- The ERP number received from the third party 
application is updated in the invoice table with payment status as Pending Payment. The 
supplier selects the payment method, proceeds with the payment and sets the payment status 
as Paid.

For example, You’re receiving invoice data from various sources. The invoice data is transferred 
to inbound invoice and invoice lines if the required fields are set on the invoice. For more 
information on the required fields, see Inbound Invoice Fields  and Inbound invoice line fields. 
The invoice status changes to Approved  and the invoice data is transferred to outbound invoice 
tables. The outbound invoice displays the integration status as New. The ERP integrator fetches 
the outbound invoices with status as New, creates a record in the third party application and 
sets the integration status to In progress. After the outbound data is successfully processed by 
the third party application, the system auto updates the ERP number in the outbound invoice 
tables and sets the integration status to Processed. The ERP number is updated in the invoice 
table with payment status set to Pending Payment.The supplier verifies the invoice payment 
details, proceeds with the payment and the payment status is set to Paid. For more information 
on payment fields, see Inbound invoice payment fields.

The advantages of integration framework are:

• Expedites the integration of the Accounts Payable Operations  application with external 
systems and reduces the time to verify invoices. Integration framework enables bulk import 
of invoice and invoice line data through scheduled jobs. A scheduled job runs every 30 
minutes, verifies, and auto process the invoices. Scheduled jobs result in increased efficiency 
of creating invoices.

• Expedite the payment processing process and enhance the user experience by seamlessly 
exchanging data with external systems.

Integration errors

The ERP integration framework enables Accounts Payable Operations  specialists to work on 
system-generated integration error tasks that record integration issues associated with invoices 
posted to the ERP system.

When the invoice is posted to an outbound staging table in the Accounts Payable Operations 
application, sometimes due to poor data connection, or missing data, the ERP integration can 
fail. Such integration failures are tracked in the form of system-generated integration error 
tasks. The integration error tasks are created and auto-assigned to the Accounts Payable 
Operations  specialist involved in the processing of invoice case. With playbooks, Accounts 
Payable Operations  specialist uses the Review integration errors  activity card to review the 
error tasks associated with the invoice processing case, make required changes to the invoice 
header, invoice lines and resubmits the invoice to ERP by integration.

When invoices are ingested through DocIntel  or integration, you can determine the ERP source 
for certain fields like Purchase order, Legal entity, Original invoice, Supplier tax id and Supplier. 
You can populate the reference fields matching the ERP source.

Integration admins are notified about the integration errors through Integration Error Tasks 
caused due to issues such as system time outs. If there are system issues, the integration admin 
can execute jobs of type scheduled, on-demand or auto-schedule to handle integration error 
tasks. The scheduled job triggers the posting of erroneous invoices.

When invoice and invoice lines ingested by DocIntel  or integration can result in errors

Playbooks are designed to auto-create an error task and attach the error task to the respective 
invoice case.
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The Accounts Payable Operations  specialists can also view the ERP posting errors through the 
Accounts Payable Operations  home page too. For more information on the home page, see APO 
landing page.

When the Accounts Payable Operations  admin closes the integration error task and resubmits 
the invoice to ERP, the following actions occur in the Outbound Invoice record.

• A new outbound invoice record is created

• The ERP admin reviews the outbound invoice record with status New  updates the ERP number, 
ERP line number, and ERP posting date

• The ERP admin changes the Integration status  to processed

• The invoice processing case changes status to pending payment, and the review payments 
activity card is auto-selected

For manually created invoices, the selected ERP source reference field will serve as the primary 
ERP reference for any subsequent selections.

For example, if the user selects supplier as the primary attribute and this field references ERP1 as 
its source, then the corresponding ERP1 filter condition is applied to the invoice header and to all 
related reference fields in both the invoice table and invoice lines to be consistent with the ERP1 
source.

If the supplier does not have an associated ERP source, and the user selects a different field—
such as legal entity—that does not reference ERP2, the previously selected supplier field will be 
cleared. The legal entity will serve as the primary attribute, and because it references ERP2, the 
ERP2 filter condition will be applied to the invoice header and all related reference fields in both 
the invoice table and invoice lines to ensure alignment with the ERP2 source.

Invoices ingested through Document Intelligence and APIs include reference fields—such as 
purchase order, supplier, payment term, legal entity, default tax code are linked to a consistent 
ERP source to prevent integration errors.

For PO invoices, the ERP source is referenced in following order:

1. Purchase order number

2. Bill to legal entity

3. Supplier

For credit memo type, the ERP source is referenced in following order:

1. Bill to legal entity

2. Supplier

3. Original invoice

With Non-PO invoices, Bill to legal entity and supplier are referenced.
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Related topics

Work with invoices

Working with Integration error tasks

Integration admin works on system-related integration error tasks and reposts invoices to ERP. 
Integration admin can run schedule job, on-demand, or auto-schedule bulk invoices after closing 
the error tasks.

Before you begin
Role required: Integration admin

Procedure

1. Navigate to All  > Integration Error tasks.
List of integration error tasks are displayed.

2. Select Submit to ERP.
The invoice is resubmitted to the ERP.

3. You can manually select the error tasks to be closed or create a schedule job, on-demand, or 
auto-schedule to close the error tasks.
For more information on scheduled jobs, see Scheduled jobs .
System-related integration error tasks are closed and invoices are auto-synchronized to 
outbound tables.

Example of ERP posting error workflow

The ERP posting error example shows the different stages involved in closing integration issues 
using error task.

Before you begin
Role required: Accounts Payable admin
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Procedure

1. Navigate to All  > Source-to-Pay Workspace  > Accounts Payable Operations.
The Accounts Payable Operations  landing page appears.

2. Click ERP Posting error.
The ERP Posting error invoices  page lists the invoice cases with ERP integration status  as 
Failed.

3. Click an invoice case.
The Pay invoice  playbook card auto-opens Review integration errors  card. An error message 
displays the reason for integration failure. Example: There was an integration error for this 
invoice. Complete the tasks to ensure the invoice details are correct.

4. Click the error task in Review integration errors  page.
The Review integration error for XXXXX  form opens. Review the error description which 
explains the reason for integration failure. Example: Network failure. For more information 
about the ERP posting error task, see ERP Posting error form.

5. Open the Invoice header  form and edit the invoice fields with appropriate details.

6. Open the Invoice Lines  form and edit the invoice fields with appropriate details.

7. Click Save.
The changes to the forms are saved.

8. Click Send to ERP.
You can also open the playbook of invoice processing case and select send to ERP. ln the 
outbound table, an invoice with status New  is created. The integration status in the outbound 
invoice is updated to Processed.

9. In the invoice Details  tab, the Status  is auto-updated as Pending payment.

10. Click Review Payments.
For more information on payment fields, see Inbound invoice payment fields.
The ERP integration error tasks are closed and the invoice is successfully processed for 
payment.

Import data into invoice

You can import bulk data through transform map using excel file.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Accounts Payable Workspace.

2. View the inbound table sn_spend_intg_imp_invoice_list.do.

3. Right-click the column heading.

4. Select Import.
The Import external data into Invoice Import  page appears. For more information on importing 
data through transform map, see Run transform to update invoice data.

Note:  Follow the same steps for invoice lines and invoice payment.

5. Select if you want to Insert  or Update  data.
By default, Insert  is selected.

6. Check the Do you want to create an Excel template to enter data?  check box.
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a. In the Create an Excel template file to enter data dialog box, select the Include all fields in 
the template  check box.

b. Click Create Excel template.

c. In Upload the template file, browse for the excel file in XLS format.

d. Click Upload.

Result
Excel template is created and uploaded with mandatory invoice data.

Load invoice data

Load the invoice data from the excel template into the sn_spend_intg_imp_invoice 
staging table.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Load Data.
The Load Data page appears.

2. In Import set table, choose Existing table  option.

3. Choose the invoice table from the drop-down list.

4. In Source of the Import, choose File.

5. Browse the excel template that was created from Import data into invoice.

6. Enter the Sheet number  of the excel template that needs to be loaded into the staging table.

7. Enter the Header row  of the excel template that needs to be loaded into the staging table.

8. Click Submit.

Result
The invoice data from the excel template is processed successfully.

Run transform to update invoice data

Use transform map and run transform to map the invoice fields from the import set into target 
tables in Accounts Payable Operations.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Load Data  > Run Transform.
The Specify Import set and Transform map  screen appears. In the Import set, the staging 
table you selected from Load invoice data  is auto populated. In Selected maps, run in order 
area, the target invoice table to be mapped in Accounts Payable Operations  is auto-populated 
and selected by default.

2. Click Transform.

Result
The invoice fields from the import set is mapped to sn_shop_invoice  table.
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Working with inbound invoice

Create invoice and invoice lines originating from different ERP sources using an integration 
framework.

Before you begin

• Import data into invoice

• Load invoice data

• Run transform to update invoice data

Role required: sn_spend_intg_admin or sn_spend_intg_procurement_integrator

Procedure

1. Open sn_spend_intg_imp_invoice_list.do  staging table.
The Invoice Imports  lists the inbound invoice columns. For more information on the inbound 
fields, refer Inbound Invoice Fields.

Note:  If the required inbound fields are validated and entered, then the Status  is set to 
inserted.

2. Open any inbound record with Status  as Inserted.

3. Navigate to Import Set  > Target record.

4. Select Open Record.
Invoice record is created in the Draft  state and the scheduled job is run every thirty minutes. 
If the required fields on the invoice are filled, and no exceptions are found, then the invoice is 
auto set to Approved  status.

Working with outbound invoice

ERP integrator validates the invoice with ERP number, processes the integration, and the moves 
the invoice for payment extraction.

Before you begin
Role required: sn_spend_intg_admin or sn_spend_intg_procurement_integrator

Procedure

1. Open sn_spend_intg_outbound_invoice_list.do  staging table.
The Invoice record  is verified with ERP number.

2. Set the Integration status  to Processed.
The invoice Status  is automatically set to Pending payment. The invoice is extracted for 
payment, and the invoice status is set to Paid.

IT Asset Management  purchase order invoice processing

The integration of IT Asset Management (com.snc.sn_spend_asset) with Sourcing and 
Procurement Operation enhances exception handling for ITAM-driven purchase order invoices 
in Accounts Payable Operations  APO (app-spend-itam), enhancing accurate routing and faster 
resolution while improving overall operational efficiency.

In IT Asset Management (ITAM), assets are created when you acknowledge the receipt of the 
requested items. As part of the Better Together integration, all the received asset is handled 
within IT Asset Management (ITAM).
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After receiving of the goods is completed, receiving slips are generated in ITAM. You can view 
the created assets in the Assets  tab of the ITAM purchase order. For more information, see 
Receiving assets in IT Asset Management.

During the invoicing process, Accounts Payable Operations  checks if the purchase order 
originates from ITAM using the reference field. It validates the received quantity against the 
purchase order using the receiving slips and if discrepancies are found, then insufficient 
goods receipt exception is triggered. APO automatically triggers an email and notifies the ITAM 
'Assigned to' user mentioned in the ITAM PO about the exception. Once the exceptions are 
resolved, APO automatically re-validates the invoices. The invoice status changes from “Review 
Needed” to “Review Complete”.

The benefits of Better Together integration with ITAM are:

• Leverage APO functionalities and process invoices faster and efficiently

• Automated exception handling for ITAM-PO invoices becomes more accurate and timely

• Operational efficiency and reduced manual intervention

Plugin dependencies for the APO-ITAM better together feature

The following are the plugin dependencies that are required to use Asset Management 
Integration for Accounts Payable Operations:

• Invoice Case Management [sn_ap_cm]

• Accounts Payable Operations [sn_ap_apm]

• Accounts Payable Invoice Processing [sn_pr]

• Accounts Payable Operations with Document Intelligence [sn_ap_ic]

• Asset Management Integration for Sourcing and Procurement Operations plugin 
[sn_spend_asset]

• Source-to-Pay Common Architecture [sn_shop]

• Source-to-Pay Integration Framework [sn_spend_intg]

• Supplier Common Architecture [sn_slm]

• Common Service Delivery [sn_spend_sdc]

• Source-to-Pay Workspace [sn_spend_workspace]

• Supplier Collaboration Portal [sn_supplier_sp]

• ERP Integration Framework [sn_fcms_intg]

• Finance Common Architecture [sn_fin]

Invoice processing using IT Asset Management  purchase order

The ITAM-APO integration is designed to streamline invoice processing for ITAM-related 
purchase orders (POs), verifying better accuracy, exception handling, and operational efficiency.

Before you begin
Role required: Accounts_payable_specialist [sn_ap_apm.accounts_payable_specialist]

Procedure

1. Navigate to Source-to-Workspace  > Accounts Payable Operations.

2. Create a purchase order in ITAM.
For more information on creating purchase order in ITAM, see Create a purchase order .
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3. Create an invoice with the ITAM purchase order.
For more information on invoices, Create an invoice manually. The Accounts Payable 
Operations  checks whether the received quantity in the ITAM receiving slip matches the 
invoiced quantity. In case of mismatch, an insufficient goods receipt exception is triggered and 
automatically the ITAM user is notified through email. For more information on exceptions, see 
Invoice exceptions.

4. The Accounts Payable Operations  automatically verifies and revalidates the invoice.

Result
The invoice processing of ITAM purchase order is successfully performed.

Tax Engine Integration

Integrate an external tax engine to validate supplier-provided taxes against calculated from 
external tax engines resulting in accurate, conforming, straight through processing and 
improving efficiency.

The Accounts Payable invoice processing invokes the external tax engine to validate supplier 
tax (based on ship to, item, service, category, amounts, jurisdiction, exemptions, other tax 
configuration) against system tax and drive straight through processing for matching outcomes. 
During invoice data extraction, the tax rate and tax amount will be stored as supplier tax rate 
and supplier tax amount at both header and invoice line levels. Tax integration is applicable for 
invoices of type PO, Non-PO and credit memo; supporting automatic, manual, and scheduled tax 
validation ensuring taxes remain correct even when invoices change or temporary integration 
issues occur.

How system tax is calculated

How system tax is calculated-Accounts Payable Operations  captures supplier-declared tax 
amounts exactly as provided and validates them against independently calculated system 
tax. Internal tax line breakdowns roll up to system tax only, which is then compared against the 
supplier-declared amount. If the difference is not within the configured tolerance threshold or if 
the difference is lower or more than threshold, then tax exception is raised. Roll up logic applies 
only to system tax, not to supplier-declared tax.

Example: A supplier sends an invoice with a sales tax amount for each line item. When recording 
the corresponding liability, the buyer may internally calculate tax and split into State, County, 
and District tax components. These components are recorded as internal tax lines. The sum of 
these internal tax lines (roll up to invoice line or header as system tax) is then validated against 
the supplier tax declared at the invoice line level.

Tax integration is triggered for invoices:

• For Non- PO invoices, after the invoice state is changed to accepted state.

• For PO invoices, after the PO matching state is completed.

Key capabilities

• External tax engine integration- Connects to enterprise tax engines using integration 
framework.

• Intelligent tax calculation- System validates supplier tax against system tax using invoice 
fields (based on ship to, item, service, amounts, jurisdiction, exemptions, customer tax 
configuration).

• Granular comparison logic-
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◦ Line-level and Header-level validation- The extracted values are stored as it is and the 
system compares tax at the invoice line item and header level for maximum accuracy.

◦ Configurable  tolerance-Define acceptable variance thresholds. The system auto-approves 
tax when the variance is within the configurable tolerance.

◦ Scheduler based re-calculation- The scheduler will automatically reinitiate the tax integration 
process for invoices with tax status of integration error, or recalculate tax.

Benefits of Tax Engine integration

Customers using tax engine integration benefit from:

• Reduced manual effort – Automatic tax calculation and reconciliation removes the need for 
manual tax line entry.

• Improved accuracy – Taxes are calculated using authoritative third‑party  tax logic.

• Stronger conformance – Consistent validation across jurisdictions and invoice types.

• Faster invoice processing – Higher straight‑through  processing rates and fewer exceptions.

• Clear exception visibility – Over‑tax  and under‑tax  variances are surfaced at line and header 
levels.

Tax calculation framework
The tax calculation framework is structured as a modular, three-tier architecture to promote 
scalability, maintainability, and extensibility. The framework seamlessly integrates Accounts 
Payable Operations  and the external Tax engine, enabling automated and coordinated tax 
computation. The validation logic is applied at:

• Line‑level  and Header-level comparison (primary)- Supplier tax and system tax are compared 
at the invoice line level and header level for maximum accuracy.

• Configurable  tolerance-Customers can define acceptable variance thresholds. Invoices within 
tolerance are automatically approved.

Components involved in tax calculation framework

Components Key functions

The Accounts Payable Operations  serves 
as entry point for tax calculation. When an 
invoice is in PO matching or accepted state in 
the Accounts Payable Operations, the system 
determines if tax calculation is required or not.

• If tax calculation is required, then a 
record is created in the tax staging table 
[sn_spend_intg_tax_staging], and the 
tax status is set to in progress. For more 
information on tax status, see Tax status

• If tax calculation isn’t required, then the 
invoice processing continues through the 
regular exception flow and proceeds to 
payment.

The Source-to-Pay integration framework is a 
processing layer between Accounts Payable 
Operations  and the external tax engine.

• The vendor defines the data mapping 
required by the external tax engine.

• Mapping tables are used during request 
creation (outbound) and response 
processing (inbound) between APO 
attributes and Accounts Payable 
Operations.
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Components involved in tax calculation framework  (continued)

Components Key functions

• Responses from the tax engine are sent 
back to the staging table.

• Invoice tax status is updated based on the 
response.

• Failed records are processed manually. 
For more information on the tables, see 
Configuration tables and prerequisites for 
Tax integration.

The external tax engine computes the tax. Calculates the tax and returns the response. 
The response is processed, tax lines are 
created automatically for the applicable 
invoice in Accounts Payable Operations. The 
system triggers exception engine based on 
the response from tax engine. Tax exception 
is raised when supplier tax and system tax 
mismatch in the invoice. Invoice tax status is 
set to integration error and Accounts Payable 
specialist investigates the case manually. If 
the invoice is modified after last execution 
(change amounts, add lines or adjust tax 
codes), then the tax is recalculated. The 
tax processing is re-initiated. on successful 
validation, the invoice processing proceeds to 
payment.

Tax validation modes

Tax calculation and validation can be triggered in multiple ways:

• Automatic (synchronous)-Runs automatically at key invoice processing milestones

• Manual (on-demand)-AP specialists can trigger tax validation during invoice exception review. 
This is applicable or accessible from the tax exception

• Scheduler re-calculation-Background jobs automatically re‑initiate  tax validation for invoices 
that are in progress, or recalculate tax status and integration error status. This verifies taxes 
stay accurate even if invoice data is updated or external calls fail temporarily.

Tax integration workflow

A high level workflow of how tax integration works in Accounts Payable Operations  is shown 
previous.
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Note:  If you're upgrading from previous version of APO  to latest version, you must execute 
the scheduled job [APO  - close open exception for deactivated exception definition]. 
This scheduled job updates the status of invoice exceptions to inactive and closes the 
corresponding invoice exceptions.

Configuration tables and prerequisites for Tax integration

Use the configuration tables to enable tax integration with third-party tax engines.

Configure the following mentioned tables for tax integration with a third-party tax engine.

Configuration tables

Configuration table Description

S2P Custom Configurations 
[sn_fin_s2p_custom_config]

Set condition for tax integration for incoming 
invoices.

S2P Custom Configuration Type 
[sn_fin_s2p_custom_config_type]

Set condition for configuring type of 
responses from tax engine.

ERP sources [sn_fin_erp_source] Review ERP source for tax engine.

Tax type [sn_fin_tax_type] Match the tax type returned by the external 
tax engine and associate them with the 
appropriate ERP source.

Tax integration field mappings 
[sn_spend_intg_tax_field_map]

Review the mapping between APO field and 
external tax engine field

Tax attributes for recalculation Specify the invoice data attributes that must 
be present to create taxes in the Accounts 
Payable Operations properties.

Prerequisites for Third-party Tax integration

To enable third‑party  tax integration, customers must include the following:

The required plugins for third-party tax integration are:

• app-accounts-payable

• app-spend-workspace

• app-spend-catalog

• app-spend-integrations

• app-tax-integration-vertex (if vertex is used as the tax engine)

• Configure connection and credential details for the external tax engine.

• Configure tax management properties and mapping rules.

For configuring tax management properties, see Accounts Payable Operations properties.

Tax integration in playbook

The Accounts Payable Operations  playbook enables AP specialists and tax specialists to 
perform invoice tax validation using tax engine integration. Use the playbook for implementing 
and viewing the different stages of tax validation using the tax engine integration.
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Before you begin
Role required: AP specialist, tax specialist

Procedure

1. Navigate to Workspaces  > Source-to-Pay Workspace.

2. Select the list icon ( ).
A list of options within the workspace is displayed.

3. Select Invoices >All invoices.
You can create an invoice manually. For more information on invoices, see Work with invoices. 
Invoices can be entered manually or extracted using DocIntel. For more information on invoice 
extraction, see Configure data extraction modes.

4. Select View Invoice processing case.

5. Select Validate invoice.

a. Select the Review header  details.
Review the invoice header details and make any required changes. Tax mentioned in the 
invoice copy is entered or extracted as supplier tax (editable) at header level and the system 
tax is the sum total of system tax (read only, derived from external tax engine) for all the tax 
lines.

b. Select Save.

c. Select Continue  to move to the next activity in the playbook.

d. Select the Review invoice lines  activity and manually review the invoice lines associated 
with the invoice.

Note:  When tax integration is disabled, you can create tax lines from related list of 
invoice lines or invoice case. For more information on tax lines in related list see Using 
Playbook in Accounts Payable Operations. If tax integration is enabled, you can add 
tax lines using the related list but the tax lines are deleted and new tax lines are added 
as a response from external tax engine. Tax mentioned for each invoice line in the 
invoice copy is entered or extracted as supplier tax (editable) at invoice line level and 
the system tax (read only, derived from external tax engine) is the sum total of system 
tax (read only) for all the tax lines of that particular invoice line.

e. Select Add new invoice lines  to create invoice lines.

f. Select Continue  to move to the next activity in the playbook.

g. Select Submit invoice.
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Note:  During invoice processing (straight-through processing), when the invoice is 
sent to tax engine for validation, you can view the progress in the Review compliance 
swim lane. You will be prompted with a message "No action is needed. The system 
automatically runs a tax validation using a third-party tax engine. This verifies 
tax details from the invoice and ensures compliance by validating tax rates and 
jurisdictions. After tax validation is complete, the system moves to the next step 

automatically.

Tax Validation in progress.

Tax Validation successful.
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Tax Validation in failed.

Tax validation scenarios

Scenario Description

Tax validation successful If tax response is successful, the tax 
validation page will display the tax lines 
(Review compliance - tax validation lane) 
created automatically from the tax response.

Tax not validated due to integration error Tax validation fails, exception is raised.

Note:  The revalidate Timed‑Out Tax 
Validations scheduled job identifies 
invoices that have remained in the 
In Progress tax status beyond the 
configured threshold (as defined by 
the system property Maximum time to 
wait for tax validation from the external 
tax integration in minutes) and updates 
their tax status to Integration Error.

Tax validation failed Tax validation cannot be completed due 
to missing required invoice attributes for 
tax calculation or If tax response fails then 
Tax validation failed exception is raised. AP 
specialist manually verifies the invoice and 
selects Validate tax  to re-calculate the tax.

Tax validation expired Invoice header or line-level information is 
changed after the invoice execution (post 
tax integration response) then Tax validation 
expired exception is raised. AP specialist 
manually verifies the invoice and selects 
Validate tax  to re-calculate the tax.

System validates the supplier taxes by comparing the taxes calculated from the external tax 
engine and creates over or under tax exceptions.
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Scenario Description

Under tax amount variance (invoice line) Tax amount on an invoice line is lesser than 
the tax response (considering the variance) 
received for the line item through tax engine.

Under tax amount variance (invoice header) 
exception

Total tax amount on the invoice header is 
lesser than the total tax (considering the 
variance) for the invoice received through tax 
engine

Over tax amount variance (invoice header) Total tax amount on the invoice header is 
greater than the total tax (considering the 
variance) of the invoice received through tax 
engine

Over tax amount variance (invoice line) Tax amount on the invoice line is greater 
than the tax (considering the variance) of 
the invoice line item of the invoice received 
through tax engine

6. Select Review exceptions.
The list of exceptions raised for the invoice is listed. For more information on exceptions, see 
Invoice exceptions  and Using Playbook in Accounts Payable Operations.
The invoice tax validation is successful.

Accounts Payable Operations  reference
Reference topics provide additional information about the lists and forms that you use in 
Accounts Payable Operations.

Accounts Payable Operations  properties

On the Accounts Payable Operations  properties form, you can set the parameters that control 
the invoice line mapping, invoice ingestion for API and exception management.

Accounts Payable Operations  properties as an admin

Property Description Role

Invoice line-mapping properties

Enable rules-based 
engine for invoice line 
mapping? (Default:Yes) 
[sn_ap_apm.mapping.enable_rule_based_mapping]

Select the property if you want the 
rule-based engine to perform the 
mapping of invoice line with the 
purchase order lines. Deselect 
the property, if you don’t want the 
rules-based engine to perform the 
invoice line mapping. For more 
information on invoice line mapping 
with purchase order line, see Rules 
based engine.

Review invoice line 
mappings predicted 
by rules-based 
engine? (Default:No) 
[sn_ap_apm.mapping.review_rule_based_mapping_suggestions]

By default, the property is 
deselected, and does not allow 
the AP specialist to review the 
mapping results generated by rules 
based engine. Select the property 
if you want the AP specialist to 

Admin
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Accounts Payable Operations  properties as an admin  (continued)

Property Description Role

manually review the mapping results 
generated by rules based engine, 
confirm the mapping and change 
the state to mapping complete.

Review invoice line 
mappings predicted by 
Now Assist? (Default:Yes)

By default, the property is selected 
and allows the AP specialist 
to review the mapping results 
generated by Now Assist. After 
reviewing the mapping results, AP 
specialist confirms the mapping 
and changes the state to mapping 
complete. Deselect the property 
if you don't want the AP specialist 
to review the invoice line-mapping 
results generated by Now Assist.

Invoice ingestion API Properties

Maximum number of 
invoices according 
to batch in accounts 
payable invoice create API 
[sn_spend_intg.ap.invoice.create.api.record_limit]

Maximum number of invoices that 
can be processed in a batch using 
accounts payable invoice create 
API. Default value is 100.

Exception management 
properties

Number of parallel worker 
threads for exception 
engine scheduler? 
[sn_ap_apm.exception.engine.max_parallel_thread_count]

Defines the number of parallel 
threads used by the exception 
engine scheduler to process invoice 
exceptions. Default value is 4.

Wait time (minutes) 
before exception engine 
scheduler rechecks an 
invoice for exceptions 
[sn_ap_apm.exception.engine.scheduler_cool_off_period]

Defines the time interval in minutes 
after which the invoice is picked for 
processing. Default value is 240.

Formatter fields for 
invoice exception activity 
[glide.ui.sn_ap_apm_exception_activity.fields]

Filter that lets you select which of 
the available fields to show in the 
invoice exceptions.

Formatter fields for invoice 
exception line activity 
[glide.ui.sn_ap_apm_line_exception_activity.fields]

Filter that lets you select which of 
the available fields to show in the 
invoice line exceptions.

Formatter fields for invoice 
tolerance rule activity 
[glide.ui.sn_ap_apm_invoice_tolerance_rule_activity.fields]

Filter that lets you select which of 
the available fields to show in the 
tolerance rules.

Formatter fields for invoice 
tolerance type activity 
[glide.ui.sn_ap_apm_invoice_tolerance_type_activity.fields]

Filter that lets you select which of 
the available fields to show in the 
tolerance type.
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Accounts Payable Operations  properties as an AP admin

Property Description Role

Invoice line-mapping properties

Enable rules-based 
engine for invoice line 
mapping? (Default:Yes) 
[sn_ap_apm.mapping.enable_rule_based_mapping]

Select the property if you 
want the rule-based engine 
to perform the mapping of 
invoice line with the purchase 
order lines. Deselect the 
property, if you don’t want the 
rules-based engine to perform 
the invoice line mapping. For 
more information on invoice 
line mapping with purchase 
order line, see Rules based 
engine.

Review invoice line mappings 
predicted by rules-based 
engine? (Default:No) 
[sn_ap_apm.mapping.review_rule_based_mapping_suggestions]

By default, the property is 
deselected, and does not 
allow the AP specialist to 
review the mapping results 
generated by rules based 
engine. Select the property if 
you want the AP specialist to 
manually review the mapping 
results generated by rules 
based engine, confirm the 
mapping and change the state 
to mapping complete.

Review invoice line mappings 
predicted by Now Assist? 
(Default:Yes)

By default, the property is 
selected and allows the 
AP specialist to review the 
mapping results generated 
by Now Assist. After reviewing 
the mapping results, AP 
specialist confirms the 
mapping and changes the 
state to mapping complete. 
Deselect the property if you 
don't want the AP specialist 
to review the invoice line-
mapping results generated by 
Now Assist.

Exception management properties

Number of parallel worker 
threads for exception 
engine scheduler? 
[sn_ap_apm.exception.engine.max_parallel_thread_count]

Defines the number of parallel 
threads used by the exception 
engine scheduler to process 
invoice exceptions. Default 
value is 4.

Wait time (minutes) 
before exception engine 
scheduler rechecks an 

Defines the time interval 
in minutes after which 
the invoice is picked for 

AP admin
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Accounts Payable Operations  properties as an AP admin  (continued)

Property Description Role

invoice for exceptions 
[sn_ap_apm.exception.engine.scheduler_cool_off_period]

processing. Default value is 
240.

Accounts Payable Operations  properties as an integrator

Property Description Role

Invoice ingestion API Properties

Maximum number of 
invoices according 
to batch in accounts 
payable invoice create API 
[sn_spend_intg.ap.invoice.create.api.record_limit]

Maximum number of invoices 
that can be processed in a 
batch using accounts payable 
invoice create API. Default 
value is 100.

Integrator

Accounts Payable Operations  properties as an AP admin

Property Description

Tax management properties

List of Invoice fields that, when modified, 
are eligible for triggering tax recalculation. 
(Ensure all fields provided are comma-
separated and do not have spaces) 
[sn_ap_apm.invoice_attributes_for_tax_revalidation]

supplier_invoice_number,invoice_date,supplier,legal_entity,subtotal,amount_invoiced_without_tax_transaction_currency,ship_to_street,ship_to_city,ship_to_state_or_province,ship_to_country,ship_to_zip_or_postal_code,ship_from_street,ship_from_city,ship_from_state_or_province,ship_from_country,ship_from_zip_or_postal_code

The mandatory invoice fields needed for tax 
engine to automatically trigger re-calculation 
when invoice data is modified.

Maximum time to wait for tax validation 
from the external tax integration (minutes) 
[sn_ap_apm.maximum_wait_time_for_tax_validation]

The maximum time in seconds that Accounts 
Payable Operations  will wait for a response 
from tax engine while performing tax validation 
on an invoice.

Enable integration with external tax 
system[sn_ap_apm.enable_integration_with_external_tax_system]

Controls whether invoices are sent to external 
tax engine for automated tax validation. 
Default value is Yes.

List of Invoice line fields that, when modified, 
are eligible for triggering tax recalculation. 
(Ensure all fields provided are comma-
separated and do not have spaces) 
[sn_ap_apm.invoice_line_attributes-for-tax-
revalidation]

sub_total,line_description

Determines which line-level field changes are 
significant enough to require re-sending the 
invoice line data to tax engine for fresh tax 
calculation.

Number of invoices processed in parallel 
[sn_ap_apm.external_tax.scheduler.parallel_worker_threads]

Defines the number of parallel worker threads 
that the tax validation scheduler uses to 
process invoice tax validations concurrently 
when sending requests to the external tax 
engine.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1390



Accounts Payable Operations  properties as an AP admin  (continued)

Property Description

Time to wait before revalidating 
tax on an invoice (minutes) 
[sn_ap_apm.external_tax.scheduler_cool_off_period]

Defines the waiting period (in seconds) 
between consecutive executions of the tax 
validation scheduler job. Default value is 60.

Maximum number of invoices sent per batch 
[sn_ap_apm.external_tax_max_invoices_per_batch]

Maximum number of invoices that can be sent 
to the external tax engine in a single batch 
request during tax validation processing. 
Default value is 1000.

Create New Invoice Line form

Use the Create New Invoice Line form to provide details about an invoice line.

Create New Invoice Line form

Field Description

Invoice Line

Number An auto-generated number that uniquely identifies the invoice line.

Invoice Invoice for which you are creating the invoice line.

Status Status of the invoice line.

ERP line number Unique number generated within the ERP system for the invoice line.

Line description Description for the invoice line.

Summary Details

Purchase order 
line

Purchase order line item in the purchase order.

Invoice line 
quantity

The number of items that have been invoiced.

Line unit price Unit price of the line item in the invoice.

Subtotal The total amount for the invoice line without tax and shipping charges.

Tax amount Tax amount for the invoice line item.

Line amount 
invoiced

Total amount for the invoice line item.

Accounting Details

Ledger account The account used to generate the invoice.

Cost center The cost center for which the invoice is generated.

Tax code Tax code of the invoice.

Ship to street The street address to which the items on the purchase order should be 
shipped.

Ship to country The country to which the items on the purchase order should be shipped.

Ship to city The city to which the items on the purchase order should be shipped.
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Create New Invoice Line form  (continued)

Field Description

Ship to zip/postal 
code

The zip code to which the items on the purchase order should be shipped.

Ship to state/
province

The state to which the items on the purchase order should be shipped.

Tax Details

Supplier tax The total tax amount charged on the invoice line item by the supplier.

System tax The total tax amount for the invoice line item calculated by the third-party 
tax calculation engine.

Final tax The total tax amount paid for this invoice line item.

Unit The unit or rate in which this product is billed by the supplier.

Supplier part 
number

The part number of the supplier product.

Create New Invoice form

Use the Create New Invoice form to enter the details of the new invoice.

Create New Invoice form

Field Description

Invoice

Number An auto-generated number that uniquely identifies the invoice.

Supplier invoice 
number

The invoice number of the supplier invoice.

Type The type of invoice.

Note:  Accounts Payable Operations  supports invoices of type 
PO invoice  and Non-PO invoice.

Business owner An individual or group who owns the invoice.

Status The status of the invoice.

Channel The channel used to send the invoice. The choices are:

• Web

• Email

• integration

• Virtual agent

Supplier tax id The tax ID of the supplier.

Supplier tax The total tax amount charged by the supplier.

System tax The total tax amount calculated by the third party tax calculation 
engine.
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Create New Invoice form  (continued)

Field Description

ERP number Unique number generated within the ERP system for the invoice.

This field is applicable when there is an ERP integration. The value is 
populated after the invoice is posted in the ERP system through the 
integration.

Short description Brief description about the invoice.

Summary Details

Supplier Supplier who delivers the product or service.

Purchase order Purchase order associated with this invoice.

Note:  For Non-PO invoice  the purchase order is not made 
available.

Payment terms How and when to make a payment for the products and services.

Subtotal The total amount from all the invoice lines without tax and shipping 
charges.

Tax amount Tax applied on the invoice amount.

Shipping Shipping charges incurred for the invoice.

Other charges Other charges applied on the invoice amount.

Discounts The discount applied on the invoice amount.

Early payment discount 
amount

The discount applied on the total invoice amount on early payment.

Amount invoiced 
without tax 
(Transactional currency)

Total amount to be paid to the supplier excluding tax and shipping 
charges. This amount is displayed in transactional currency.

Amount invoiced 
(Transactional currency)

Total amount to be paid to the supplier including tax and shipping 
charges. This amount is displayed in transactional currency.

Dates

Invoice date Date on which this invoice is created.

Due date Date by when you must make the payment.

ERP posting date Date on which the invoice is posted in the ERP system.

Payment date The date by when you must make the payment.

Accounting Details

Legal entity The internal legal entity which incurs the cost of this invoice.

Default tax code The tax code levied on the total invoice amount.

Default tax jurisdiction 
code

The tax code jurisdiction to which you must pay the tax.

Addresses

Remit to street The street address to which the payment is made.
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Create New Invoice form  (continued)

Field Description

Remit to country The country to which the payment is made.

Remit to city The city to which the payment is made.

Remit to zip/postal code The zip code to which this payment is made.

Remit to state/province The state to which the payment is made.

Bill to street The street address to which the invoice is sent.

Bill to country The country to which the invoice is sent.

Bill to city The city to which the invoice is sent.

Bill to zip/postal code The zip code to which the invoice is sent.

Bill to state/province The state to which the invoice is sent.

Ship to street The street address to which the items on the purchase order should 
be shipped.

Ship to country The country to which the items on the purchase order should be 
shipped.

Ship to city The city to which the items on the purchase order should be shipped.

Ship to zip/postal code The zip code to which the items on the purchase order should be 
shipped.

Ship to state/province The state to which the items on the purchase order should be 
shipped.

Invoice form tabs

The Invoice form includes tabs that store invoice information that an Accounts Payable Specialist 
can use to perform related tasks.

Invoice case form tabs

Tab Description

Details Details about the invoice.

Invoice Lines Invoice lines of the invoice.

Exceptions Exceptions found on the invoice.

Payments Payments made to the supplier.

Cases A list of cases associated with the invoice.

Other invoices of 
same PO Other invoices associated with the same purchase order as that of the 

invoice that you are currently viewing.

Goods receipts
Displays the corresponding goods receipt information for the invoice.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1394



Inbound Invoice Fields

The Inbound invoice table is the source table from where you import the invoice required fields to 
successfully create an invoice through the integration framework.

Invoice Imports

Column Description Data type

Invoice Type 
(Mandatory)

Details about the invoice. Choice Examples: invoice/
non_ po_invoice, debit 
_memo, credit_memo

Supplier 
invoice 
number

The invoice number of the supplier and ERP 
source and ERP invoice number

String

Business 
owner

email of business the owner who owns the 
application from the business side

String

Supplier 
(Mandatory)

Name of the ERP supplier code String

Purchase 
order

Binding contract between a buyer and a supplier 
that authorizes a purchasing transaction. Derived 
from ERP source and supplier

String

Invoice date 
(Mandatory)

The date on which the invoice is created. String (yyyy-mm-dd)

Payment 
terms

Conditions applied on the payment term. String

Legal entity Stores Legal entity's ERP company code String

Tax amount Tax rate applied on the invoice amount Decimal number

Shipping 
amount

Shipping charges incurred for the invoice Decimal number

Subtotal 
(Mandatory)

Total amount of money to be paid to the supplier 
excluding tax and shipping charges.

Decimal number. Example 
12345.65

Other 
charges

Additional charges incurred on the invoice Decimal number

Discounts Reduction on the total amount incurred on the 
invoice

Decimal number

Currency Currency code standard of amount exchanged. 
ISO 4217 currency code (USD, GBP, INR, etc)

String

External 
invoice 
number 
(Mandatory)

Invoice number originated from a third party 
application.

String

ERP source 
(Mandatory) The available ERP

String

Status Current state of the invoice is Draft String

External 
invoice 

Name of the third party application associated 
with the invoice.

String
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Invoice Imports  (continued)

Column Description Data type

source 
(Mandatory)

Inbound invoice line fields

The Inbound invoice line table is the source table from where you import the invoice line required 
fields to successfully create an invoice through the integration framework.

Invoice Imports

Column Description Data type

External invoice 
source (required)

Name of the third party application associated with the 
invoice. Derive logic from external invoice number.

String

Line description 
(required)

Description of the invoice line. String

Purchase order 
line

Information of the individual lines under a purchase 
order and ERP PO line number.

String

Line quantity 
(required)

The number of items that have been invoiced Decimal number

Line unit price 
(required)

Unit price of the line item in the invoice. Decimal number

Payment terms Conditions applied on the payment term. String Example 
(Net 30)

Legal entity Stores legal entity's ERP company code. String

Tax amount Tax rate applied on the invoice amount. Decimal number

Subtotal 
(required)

Total amount of money to be paid to the supplier 
excluding tax and shipping charges.

Decimal number 
Example 
(12345.65)

Cost center Combination of cost center's account number and ERP 
source.

String

GL accounts Records the total number of transactions derived from 
GL account and ERP source.

String

Tax code Sales tax related to locations where business 
transactions occur.

String

Currency Standard Currency Code ISO 4217 (USD, GBP, INR, etc) String

External invoice 
source Invoice source number originated from a third party 

application.

String

ERP source 
(required) The available ERP source.

String

Status The current state of the invoice is draft. String

External invoice 
source (required)

Name of the third party application associated with the 
invoice.

String
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Inbound invoice payment fields

The Inbound invoice payment details needed for a supplier to complete the transaction.

Invoice Imports

Column Description Data type

Payment 
amount

Payment details about the invoice Decimal number

ERP 
invoice 
number

The ERP invoice number of the 
supplier invoice

String

Payment 
date

The date on which the invoice 
payment was completed

String (yyy-mm-dd)

Payment 
method

Mode of payment Choice Example: bank_transfer/ 
cash_payment/ cheque /credit_card /
debit_card /wire_transfer

Payment 
reference 
ID

A unique ID to track the payment 
details

Alpha numeric

Remit to 
city

The city to which the payment is 
made

String

Remit to 
country

The country to which the payment is 
made in ISO 3166 format. Example:US

String

Remit to 
state/
province

The state or province to which the 
payment is made

String

Remit to 
street

The street address to which the 
payment is made

String

Remit to 
zip/postal 
code

The zip or postal code address to 
which the payment is made

String

Scheduled 
payment 
date

The date at which the payment will be 
made

String (yyyy-mm-dd)

ERP 
supplier 
code

Integer ERP code of the supplier in 
the ERP system

Combination of ERP supplier code and 
ERP source

ERP 
Source

The available ERP String

Currency Standard of amount exchangedin 
Currency Code ISO 4217 format (USD, 
GBP, INR, etc)

String

Outbound invoice fields

The outbound invoice table transfers the invoice details from ServiceNow®  to third party 
applications through integration framework.
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Invoice Imports

Column Description Data type

Supplier invoice number The combination of supplier invoice number or 
supplier and ERP source and ERP invoice number

String

Business owner.Email Name of the owner who owns the application from the 
business side

String

Amount invoiced 
(Transaction 
currency).amount

Charges added to the invoice String

Amount invoiced 
(Transaction 
currency).currency

Charges added to the invoice String

Discounts.amount Reduction on the total amount incurred on the invoice String

Legal Entity.ERP 
Source.Source

Stores organizational entities defined in the 
application

String

Type Details about the invoice Choice

Supplier Name of the supplier Reference

Supplier invoice number Invoice number mentioned by the supplier String

Purchase order Binding contract between a buyer and a supplier that 
authorizes a purchasing transaction

Reference

Invoice date The date on which the invoice is created. String 
(yyy-mm-
dd)

Payment terms Conditions applied on the payment Reference

Tax amount.amount Tax rate applied on the invoice amount String

Shipping. amount Shipping charges incurred for the invoice String

Subtotal.amount Total amount of money to be paid to the supplier 
excluding tax and shipping charges.

String

Other charges.amount Additional charges incurred on the invoice String

Number Unique business identifier associated with the 
business partner

String

Status Current state of the invoice Choice

Invoice date Date on which the invoice was created String 
(yyyy-mm-
dd)

Outbound invoice line fields

The Outbound invoice line table is the transfers the invoice line details table from ServiceNow® 

to third party application through integration framework.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1398



Invoice Imports

Column Description Data type

Line description Description of the invoice line String

Purchase order 
line

Information of the individual lines under a purchase order line 
or a sourcing request for the referenced supplier

Reference

Invoice line 
quantity

The number of items that have been invoiced String

Line unit price Unit price of the line item in the invoice String

Ledger account Displays General Ledger Account Reference

Tax 
amount.amount

Tax rate applied on the invoice amount String

Subtotal.amount Total amount of money to be paid to the supplier excluding tax 
and shipping charges.

String

Cost center Represent business entity to which costs can be allocated Reference

Status Current state of the invoice String

Invoice.Legal 
entity. ERP 
source

Stores organizational entities defined in the application String

ERP line number Displays the ERP number at the line item level String

Invoice Transaction record used to track purchase between shopper 
and supplier

Reference

Number The number in the invoice String

Status Status of an invoice Choice

Line 
amount.invoiced 
amount

The total amount for the invoice line String

Invoice Line form tabs

The Invoice line form includes tabs that store invoice line information that an Accounts Payable 
Specialist can use to perform related tasks.

Invoice Line form tabs

Tab Description

Details Details about the invoice line.

Exceptions A list of exceptions on the invoice line.

Receipts Goods receipts for the purchase order line corresponding to the invoice line. This 
tab is shown only for the invoice of type PO Invoice.

Create invoice cost allocation form

Allocate invoice line cost across multiple cost centers.
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Create invoice cost allocation form

Field Description

Invoice cost allocation

Allocation type Type of cost distribution (cost center or ledger account).

Invoice line Cost allocated to the invoice line

Allocate by Determines if the cost allocation is made by the following:

• Quantity

• Quantity percentage

• Amount

• Amount percentage

Allocation details

Cost center Cost center that incurs the cost of the allocated transaction amount.

Allocation amount Amount of the cost allocated.

Allocation percentage Percentage of the cost allocated.

This field is visible only if the allocation by is set to Percentage

Allocation quantity The quantity of goods/services allocated.

Ledger account Ledger account that incurs the cost of the allocated transaction amount.

Outbound cost allocation staging table

The outbound cost allocation [sn_spend_intg_outbound_invoice_cost_allocation] staging table 
stores important data about cost allocation information so that an ERP integrator can export this 
data to a third-party ERP system.

Outbound cost allocation staging table

The following table lists fields for the outbound cost allocation 
[sn_spend_intg_outbound_invoice_cost_allocation] staging table.

Outbound cost allocation staging table

Field Data type Description

Number String An auto-generated number that uniquely identifies the invoice.

Allocation type Choice The cost allocation type that you would like to assign cost to.

Cost center Reference Cost center for which the invoice is generated.

Ledger account Reference A reference field for the account used to generate the  invoice.​

Allocate by String Determines whether the cost allocation is based on amount or 
percentage.

Allocation 
amount

String Amount that is allocated.

Invoice line Reference Line items on the invoice.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1400



Outbound cost allocation staging table  (continued)

Field Data type Description

Integration 
status

Choice Status of the integration process.

Distribution set form

Create a distribution set to split cost allocations automatically for invoice lines.

Distribution set form

Field Description

Distribution set for cost allocation and ledger account

Number Auto-populated number of the distribution set.

Name Unique name of the distribution set.

Template You can choose to select the template if you want the AP specialist to apply the 
distribution set without entering percentage value.

Description Short description of the distribution set that you want to apply.

Active The check box is enabled if the percentage is allocated in the distribution set 
sums to 100 percent. By default, this is grayed out.

Order Order in which the distribution set must be applied to the invoice line.

Effective 
from

Date from which the distribution set is active.

Effective to Date by when the distribution set must be deactivated.

Filters Conditions or rules that are configured. Example: Supplier tax is $ 100USD.

Distribution Lines

Distribution 
set

Auto-populated number of the distribution set.

Allocation 
type

Cost split across allocation type cost center or general ledger.

Cost center Cost center for which the distribution set is applied.

Allocation 
percentage

Percentage cost that is split across cost centers.

Create New Invoice case form

Use the Create New Invoice case form to provide details about the Invoice case.

Create New Invoice case form

Field Description

Invoice case

Requested by User who submitted the inquiry.
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Create New Invoice case form  (continued)

Field Description

Requester email Email ID of the user who submitted the inquiry.

Sub-category Sub-category of the invoice inquiry case. The choices are:

• Payment inquiry

• Invoice inquiry

• Expedite payment request

• Payment terms issue

• Invoice entry assistance

Duplicate case The case that is similar to the currently opened case.

Channel The channel used to send the inquiry.

State The state of the case.

Priority Indicates how quickly you must complete the task based on its priority.

Assignment group The assignment group that the case is assigned to.

Assigned to Person that the case is assigned to.

Watch list Users who are notified when updates are made to the case.

Short description Brief description about the invoice.

Description Description about the invoice.

Summary

Supplier Supplier who has made the inquiry.

Invoice Invoice associated with the case.

Closure Details

Closure code The closure code for the case. The options are:

• Duplicate request

• Canceled/False inquiry

• Canceled by requester

• Information provided

• Exceptions resolved

Closure details Details about the case closure.

Closed by Person who closed the case.

Closed Whether the case is closed or not.

Invoice case form tabs

The Invoice case form includes tabs that store invoice case information that an agent can use to 
perform related tasks.
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Invoice case form tabs

Tab Description

Details Details about the case.

Tasks Tasks that have been created for this case by the agent.

Task SLAs The service level agreements that are associated with this case.

Emails Emails that are sent or received as part of resolving this case.

Cases by same requester Cases that are opened by the same requester.

Invoice status messages

Invoice-related status messages are displayed in the Accounts Payable Operations application.

Invoice statuses

Invoice 
status

Description

No invoice When an invoice encounters data extraction issue, this status is updated. You 
must review the invoice details and line items using DocIntel to ingest the required 
data and submit.

Draft This status is updated in 2 scenarios:

• When an invoice can extract most of the data from DocIntel, the invoice is being 
updated with the missing required information and is yet to be submitted.

• When an invoice is created manually until it’s ready for submission.

Received The invoice created with options such as manual, digitized or through API is 
moved to Received state.

Suspected 
duplicate

After the invoice is updated with required details, Accounts Payable Specialist 
checks if the same invoice (supplier invoice number) is previously submitted by 
the same supplier. If the invoice is submitted by the supplier, then the invoice is 
updated with Suspected duplicate  State.

Accepted This status is updated in one of the following scenarios:

• As part of invoice processing, the invoice moves from Received  to Accepted 
State if no duplicate invoices are identified by the system

• Accounts Payable Specialist confirms the invoice is not duplicate.

• System recognizes the invoice as duplicate and Accounts Payable Specialist 
confirms it as non-duplicate.

PO 
matching 
error

This status is updated in one of the following scenarios:

• An invoice is updated with PO matching error when PO is missing on the 
invoice.

• PO line mapping is missing from invoice lines.

• The currency on the PO is different from the invoice currency.
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Invoice statuses  (continued)

Invoice 
status

Description

PO 
matching 
completed

When all the invoice lines are mapped to PO lines and if no discrepancies are 
found between PO and invoice currency, then the invoice is updated to PO 
matching completed.

Exceptions 
found

An invoice is updated with the status Exceptions found, when it finds any one or 
more of the exceptions that were defined in Accounts Payable Operations. For 
more information on exceptions, see Invoice exceptions.

No 
exceptions 
found

This status is updated in one of the following scenarios:

• When there are no exceptions with an invoice or invoice lines.

• When all the identified exceptions are fixed, then the invoice is moved to No 
exceptions found state.

Review 
mapping

Any invoice lines that is matched using GenAI will be set to new status and will 
be stopped for Accounts Payable specialist review. After the Accounts Payable 
specialist reviews the recommendation, the status of the invoice changes 
accordingly.

Mapping 
error

An invoice consisting of multiple invoice lines and any invoice line is in mapping 
error status, then the invoice status remains in Mapping error.

Mapping 
complete

If instead of approving the GenAI recommendation, Accounts Payable specialist 
wants to overwrite it (or if no recommendation was given and Accounts Payable 
specialist manually adds POLI), then the invoice is moved to Mapping completed 
status.

Pending 
approval

After all the invoice exceptions are resolved (no exceptions found), then the 
invoice is submitted for approval and the invoice changes to Pending approval 
State.

Rejected When an invoice is rejected through email, custom APIs, the invoice status is 
updated as rejected.

Approved After the invoice us submitted for approval (pending approval), if the user 
approves the invoice, then the invoice is moved to Approved  state.

Pending 
payment

After the invoice is approved, then the invoice is integrated with ERP system. If no 
integration errors are found, then the invoice status changes to Pending payment.

Confirmed 
duplicate

When the system identifies the invoice as suspected duplicate, and then 
Accounts Payable Specialist confirms the invoice as duplicate, the status changes 
to Confirm duplicate.

Canceled When Accounts Payable Specialist cancels the invoice, then State is auto set to 
Cancelled.

Paid After the invoice is posted to ERP and paid in the ERP, the payment is posted back 
to Accounts Payable Operations without integration error. Then, the invoice moves 
to Paid  State.

Create New Invoice task form

Use the Create New Invoice task form to provide details about the Invoice task.
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Create New Invoice task form

Field Description

Number An auto-generated number that uniquely identifies the task.

Parent Case Parent case to associate the inquiry task or the exception task with.

Invoice 
exception

Invoice exception for an invoice.

Note:  This field is displayed only when you create an exception task from 
within an invoice exception.

Type This field is set to Exception task by default. This field is read-only.

Note:  This field is displayed only when you create an exception task from 
within an invoice exception.

State The current state of the task. At task creation, the State defaults to New.

The available task states are:

• New

• Assigned

• Work In progress

• Closed complete

• Closed incomplete

Assignment 
group

Group that you want to assign this task to.

Assigned to Person that you want to assign this task to.

Short 
description

Brief description about the task.

Description Detailed description about the task.

Invoice task form tabs

The Invoice task form includes tabs that store invoice task information that an Accounts Payable 
Specialist can use to perform related tasks.

Invoice task form tabs

Tab Description

Details Details about the task.

Invoice 
exception 
lines

Details about exceptions on invoice lines for line-level invoice exceptions.

This tab is displayed only for exception tasks that are created for line-level 
exceptions, such as Insufficient Goods Receipt, Insufficient Funds (Quantity 
variance), and Insufficient Funds (Amount variance).
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Invoice processing case form

Use the Invoice processing case form to view the case details that store invoice information that 
an Accounts Payable Specialist can use to perform related tasks.

Invoice processing case form

Field Description

Invoice Case

Type The type of invoice.

Channel The channel used to send the invoice.

Supplier invoice 
number

The invoice number of the supplier invoice.

Supplier tax id The tax ID of the supplier.

Assignment group Group that you want to assign this case to.

Assigned to Person that you want to assign this case to.

Business owner An individual or group who owns the invoice.

Summary details

Supplier Supplier who delivers the product or service.

Purchase order Purchase order associated with this invoice. This field is shown only 
for invoices of type PO Invoice.

Payment terms How and when to make payment for the products and services.

Subtotal The total amount from all the invoice lines without tax and shipping 
charges.

Tax amount Tax applied on the invoice amount.

Shipping Shipping charges incurred for the invoice.

Other charges Other charges applied on the invoice amount.

Discounts The discount applied on the invoice amount.

Amount invoiced 
(Transactional 
currency)

Total amount to be paid to the supplier including tax and shipping 
charges. This amount is displayed in transactional currency.

Dates

Invoice date Date on which this invoice is created.

Due date Date by when you must make the payment.

Accounting

Legal entity The internal legal entity which incurs the cost of this invoice.

Default tax code The tax code levied on the total invoice amount.

Default tax jurisdiction 
code

The tax code jurisdiction to which you must pay the tax.

Addresses

Remit to street The street address to which the payment is made.
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Invoice processing case form  (continued)

Field Description

Remit to country The country to which the payment is made.

Remit to city The city to which the payment is made.

Remit to zip/postal 
code

The zip code to which this payment is made.

Remit to state/
province

The state to which the payment is made.

Bill to street The street address to which the invoice is sent.

Bill to country The country to which the invoice is sent.

Bill to city The city to which the invoice is sent.

Bill to zip/postal code The zip code to which the invoice is sent.

Bill to state/province The state to which the invoice is sent.

Ship to street The street address to which the items on the purchase order should 
be shipped.

Ship to country The country to which the items on the purchase order should be 
shipped.

Ship to city The city to which the items on the purchase order should be shipped.

Ship to zip/postal 
code

The zip code to which the items on the purchase order should be 
shipped.

Ship to state/province The state to which the items on the purchase order should be 
shipped.

Invoice processing details

Accounts Payable Specialists can use the Invoice processing detailed form to view the invoice 
details. Invoice processing detail is found in the the sn_apm_invoice_attributetable.

Invoice attributes form

Tab Description

Approval 
date

Approved invoice date in DD/MM/YYYY format.

Auto 
approved

A boolean value is set to either true if the invoice is auto approved, or else it is 
set to false.

Created Timestamp of the invoice created in DD/MM/YYYY and HH:MM:SS format.

Created by Name of the person who created the invoice.

Exceptions Exception engine evaluates the invoice. A boolean value is set to true if the 
invoice gets stuck with exceptions, or else it is set to false.

Extraction 
failed

A boolean value is set to true if any of the invoice fields fails during extraction, 
or else it is set to false.

Invoice Name of the invoice.
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Invoice attributes form  (continued)

Tab Description

Last 
exception 
check time

Timestamps of the last exception check performed on the invoice in DD/MM/
YYYY and HH:MM:SS format.

Manual 
review in 
ingestion

The boolean value is set to true if invoice is manually submitted by Accounts 
Payable specialist instead of automated process, or else it is set to false.

Matching 
error

A boolean value is set to true for invoices that run into PO matching errorstate, 
or else it is set to false.

Rejected A boolean value is set to true if the invoice is rejected by an approver, or else it 
is set to false.

Suspected 
duplicate

A boolean value is set to true for invoices that run into Suspected duplicate 
state, or else it is set to false.

Sys_id Unique ID of the invoice processing detail record.

Tags Invoice processing detail-related tags.

Tolerance 
applied

A boolean value is set to true if any tolerance rule is applied on the invoice that 
helps prevents it from creating an exception, or else it is set to false.

Updated Timestamp of the invoice processing detail updated in DD/MM/YYYY and 
HH:MM:SS format.

Updated by Name of the person who updates the invoice processing detail record.

Updates Integer value set if any updates are performed on the invoice processing detail 
record.

Invoice processing case form tabs

The Invoice form includes tabs that store invoice information that an Accounts Payable Specialist 
can use to perform related tasks.

Invoice processing case form tabs

Tab Description

Details Details about the case.

Invoice lines Invoice lines of the invoice.

Exceptions Exceptions that are identified on the invoice.

Purchase order lines Purchase order lines of the purchase order for which the invoice has 
been raised.

This tab is shown only for invoices of type PO Invoice.

Tasks Tasks that have been created for this case by the Accounts Payable 
Specialist.

Potential duplicate 
invoices

Invoices that may be a duplicate of the invoice currently associated 
with this case.

Approvals Approval requests for the invoice.
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Invoice processing case form tabs  (continued)

Tab Description

Related invoices Related invoices from the same supplier.

Emails Emails that are sent or received as part of resolving this case.

Task SLAs The service level agreements that are associated with this case.

ERP Posting error form

The ERP posting error form includes mandatory fields that must be updated by the Accounts 
Payable admin to close the ERP integration error task.

ERP Posting error form tabs

Tab Description

Details Details about the task.

• Number- Unique error identification task number

• Sub type- auto populates Invoice ERP Integration

• State- Displays the state of the error task. By default the task is Open. Once you fix 
the integration errors, change the state to Closed.

• Assignment group- The default assigned group is AP- Invoice operations

• Assigned to- Name of the Accounts Payable admin

• Short description- Brief description of the integration error

• Description- Detailed explaination of the integration failure

Invoice 
header

Details about the invoice header. This is typically used to compare the invoice 
header details along with the invoice attachment.

Invoice 
lines

Details about the invoice line fields

Emails Invoice related emails are created

Tax lines

The Tax lines tab lists the tax line associated with the invoice line.

Tax lines tab

The following table displays the fields in the tax lines tab.

Field Description

Invoice Case

Number A unique system-generated number, which identifies the tax line.

Tax type Type of the tax applicable on the invoice.

Supplier tax rate The tax rate charged by the supplier.

Supplier tax The amount charged by the supplier.
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Field Description

System tax rate The tax rate calculated by the third-party tax calculation engine.

Final tax The tax amount paid for this invoice

Invoice line Invoice line for which the tax is applicable.

Invoice Invoice for which this tax is applicable.

Invoice Tax lines fields

Use the tax lines tab to record tax lines on purchases that are invoiced.

Invoice Tax lines fields

The following table displays the fields in the invoice tax lines tab.

Field Description

Invoice Case

Number A unique system-generated number, which identifies the tax line.

Tax type Type of the tax applicable on the invoice.

Taxable amount The amount of tax applicable on an invoice.

Supplier tax rate The tax rate charged by the supplier.

Supplier tax The amount charged by the supplier.

System tax rate The tax rate calculated by the third-party tax calculation engine.

Final tax The tax amount paid for this invoice

Invoice line Invoice line for which the tax is applicable.

Invoice Invoice for which this tax is applicable.

Tax status

The tax status field in the invoice record is used to track the current status of tax validation 
processing throughout the tax integration workflow.

Invoice tax status fields

The following table displays the tax status [tax_status] fields in the invoice record 
[sn_shop_invoice]:

Invoice tax status fields

Field Description

Invoice table

In progress Tax calculation request sent to third party tax engine and awaiting response.

Failed Tax calculation failed due to tax engine integration failure.

Success Tax calculation completed and tax lines created successfully.

Integration 
error

Tax engine connectivity or communication failure occurred.
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Invoice tax status fields  (continued)

Field Description

Recalculate 
tax

Invoice header or invoice line needs field changes, invoice tax status changes 
to recalculate tax. The invoice is sent for tax revalidation manually or through 
scheduler.

For more information on using tax status, see Tax Engine Integration.

Invoice exception form

Use the invoice exception form to view the case details that store invoice exception information 
that an Accounts Payable Specialist can use to perform related tasks.

Invoice exception form

Field Description

Invoice Exception

Number An auto-generated number that uniquely identifies the invoice exception.

Status Status of the invoice exception.

Exception definition Type of invoice exception.

Invoice Invoice for which the exception is raised.

Bypass reason Reason for bypassing the invoice exception.

Short description Brief description of the invoice exception.

Description Detailed description of the invoice exception.

Summary

Invoice Invoice that contains this exception.

Purchase order Purchase order corresponding to this invoice.

Supplier Supplier who delivers the product or service.

Total amount Total amount to be paid to the supplier.

Invoice exception form tabs

The Invoice exception form includes tabs that store invoice exception information that an 
Accounts Payable Specialist can use to perform related tasks.

Invoice exception form tabs

Tab Description

Details Details about the invoice exception.

Invoice lines 
affected

Invoice lines that have exceptions.

Note:  This tab is shown only for line-level exceptions.

Purchase 
Order Lines

Purchase order lines corresponding to the invoice lines for which the invoice 
exception has been raised.
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Invoice exception form tabs  (continued)

Tab Description

This tab is shown only for invoice exceptions of type Insufficient Funds (Quantity 
variance) and Insufficient Funds (Amount variance).

Receipts Goods receipts for all the purchase order lines of a purchase order. For more 
information, see Receipts.

Related 
invoices

Related invoices from the same supplier.

This tab is shown only for invoice exceptions of type Insufficient Funds (Quantity 
variance) and Insufficient Funds (Amount variance).

Exception 
tasks

Exception tasks for the invoice exception.

Related 
tasks If Sourcing and Procurement Operations  is installed, the following tasks are 

shown:

• Receipt. For more information, see Receipt tasks.

• Milestone. For more information, see Milestones.

• Invoice acknowledgment. For more information, see Invoice tasks.

If Sourcing and Procurement Operations  is not installed, only the Milestone task 
is shown.

Note:  This tab is shown only for an Insufficient Goods Receipt (IGR) 
exception.

Invoice Exception Rule Form

Invoice exception rules in Accounts Payable Operations  define which invoices trigger exceptions 
and how they are handled. Use this reference to understand each form field and its configuration 
options.

Invoice exception rules define the conditions under which invoices are flagged as exceptions 
in Accounts Payable Operations. Each rule specifies the exception type, triggering conditions, 
handling behavior, and processing order. The form fields control rule activation, resolution 
workflow, and exception prioritization.

Form field definitions

The following table describes each field in the invoice exception rule for.

Invoice exception rule form fields

Field name Description

Active Controls whether the rule is enabled. When selected, 
the rule is active and exceptions are triggered. When 
cleared, the rule is inactive and invoices aren't flagged 
by this rule.
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Invoice exception rule form fields  (continued)

Field name Description

Allow bypass When selected, authorized users can bypass this 
exception and proceed with invoice processing without 
triggering the exception.

Rejection mode Controls how exceptions from this rule are resolved. 
Options: "Manual" or "None".

Base object This field determines which records are evaluated 
against the rule conditions. sn_shop_invoice is the 
table name shown in the condition builder. Header level 
exception will be set to [sn_shop_invoice] table and for 
line level it will be set to [sn_shop_invoice_line] table.

Condition Defines the logical criteria that trigger the exception.

Condition field selector A drop-down showing available invoice fields. Select a 
field to include in the condition criteria.

Condition operator Logical operators for field comparison.

Condition value The comparison value for the condition.

Condition logic (AND / OR) Logical operators joining multiple conditions.

New Criteria button Adds an additional condition row to the rule, allowing 
complex multi-field matching criteria.

Order A numeric value that controls the sequence in which 
rules are evaluated.

Request Help form

Suppliers use the Request Help  form to report an inquiry related issue or request.

Request Help form

Field Description

Invoice Exception

Supplier Auto-populated name of the logged in supplier.

How 
would you 
summarize 
your issue?

Summary of the issue or request.

Anything else 
we should 
know?

Additional information about the issue.

Note:  Select the Issue contains sensitive or confidential information 
check box. For more information on handling sensitive information, see 
Universal Request sensitive information security .

Add 
attachments

Attachments related to the request or issue.
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Data required for invoice processing

Reference information for the key tables and required data used to process invoices in Accounts 
Payable Operations.

Data required for invoice processing

Data in the following key tables should be populated for processing an invoice within Accounts 
Payable Operations.

• Purchase order

• Purchase order lines

• Supplier

• Supplier Legal Entity Mapping

• Supplier contact

• Legal entity

• Cost center

• Ledger account

• Payment terms

• Tax code fields

• Tax type fields

• Organization tax details

Purchase order

A purchase order is a binding contract between a buyer and a supplier that authorizes a 
purchasing transaction. It contains the descriptions, quantities, prices, applicable discounts, 
payment terms, delivery dates, and other associated terms and conditions with the supplier.

sn_shop_purchase_order table

An Account Payable Specialist fills the key fields in the purchase order for invoice processing.

Purchase order fields

Field Data type Description

ERP number String A unique identifier generated 
within an ERP system for the 
purchase order.

Business owner Reference The user who placed the 
order.

Summary details

Field Data type Description

Supplier Reference Supplier who provides the 
product of this order.
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Summary details  (continued)

Field Data type Description

Order type String Indicates if the purchase order 
is of the type Standard or 
Blanket.

Order placed date_time Date and time of the order 
placed in YYYY-MM-DD HH: 
MM: SS format.

Total amount currency The total cost of purchase 
order calculated as the 
sum from all related lines. 
Example:USD 100.

Accounting details

Field Data type Description

Cost center Reference The cost center incurring the 
expense of this order.

Legal entity Reference Internal legal entity making 
this purchase

Payment term Reference The agreed time and 
conditions of payment to the 
supplier.

Purchase order lines

Purchase order lines provide information of the individual lines under a purchase requisition or a 
sourcing request for the referenced supplier.

sn_shop_purchase_order_line table

You can add or associate a purchase order with a purchase order line.

Field Data type Description

Purchase order Reference ERP PO number as unique 
identifier of the purchase 
order.

Supplier Reference Supplier for which the 
shopper places the order.

Product name String Name of the product or 
service purchased from a 
supplier.

Product type Choice list Defines whether product 
purchased is classified as 
goods or services. The values 
are:
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Field Data type Description

• Good

• Service

• Handling fee

Goods receipt required Choice list Applicable only if product type 
is “Good”. The values are:

• Yes

• No

Acknowledgement type Choice list Applicable only if product type 
is “Service” or “Handling fee”. 
The values are:

• Milestones

• Service acknowledgement

• Two way match

Expected delivery date Date Applicable only if product type 
is “Good".

ERP line number String A unique identifier generated 
within an ERP system for the 
purchase order line.

Start date Date The date on which service is 
expected to be rendered. This 
is applicable only if Product 
type is “Service”.

End date Date The date on which service 
is expected to end. This is 
applicable only if Product type 
is “Service”.

Purchase quantity String The quantity of the goods or 
service purchased.

Unit Choice list The unit of rate at which 
product or service is sold by 
supplier. The values are:

• Fixed fee

• Individual unit

Unit price currency The price of each individual 
unit purchased.

Total line amount currency Total amount of purchased 
goods and services including 
estimated tax and shipping.

Recipient Reference The person to whom goods or 
services are being delivered.
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Field Data type Description

Address Street address where goods 
will be shipped or where 
services will be provided.

City City where goods will be 
shipped or where the services 
are provided.

State or Province State or Province where goods 
will be shipped or where the 
services are provided.

Country Country where goods will be 
shipped or where the services 
are provided.

Zip or Postal code Zip or Postal code where 
goods will be shipped or 
where the services are 
provided.

General Ledger Account The account to which capital 
or operational expenses will 
be posted.

Supplier

You can add a supplier to the primary data and add products related to that supplier. The 
supplier data is managed effortlessly and enhance productivity of the teams that engage with 
suppliers.

sn_fin_supplier table

You can add suppliers and their products to populate your primary data. For more information on 
supplier, see Source-to-Pay Workspace Supplier page.

Field Data type Description

Legal name String Legal name of the supplier 
that corresponds to its 
operating location.

Related topics

SLO landing page

Supplier Legal Entity Mapping

The linking of supplier registered legal entity to the customer's corresponding legal entity within 
APO  is referred as Supplier legal entity mapping. Mapping ensures that invoices, purchase 
orders, and payments are correctly routed, validated, and processed across systems.

Supplier Legal Entity Mapping table

Field Data type Description

Supplier Reference Name of the supplier.
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Field Data type Description

Legal entity Reference Legal entity of the customer.

Payment term Reference The name or code of the 
payment term. Example: Net 
60.

General ledger account Reference The account to which capital 
or operational expenses will 
be posted.

Supplier contact

You can add the supplier contacts allowing them to access the  Supplier Collaboration Portal
  and start working on the most important tasks. You can view information about the supplier 
contacts and also indicates which user is the primary contact.

For more information on cost centers and how it is referenced within financial systems, see Cost 
Management .

vm_vdr_contact table

You can view the supplier contact details.

Field Data type Description

First Name String Name of the supplier.

Vendor Reference Name of the assigned vendor.

Email email email address of the supplier

User ID String User ID to identify the supplier

Title String The designated title of the 
supplier.

Legal entity

View the legal entity corresponding to a purchase.

sn_fin_legal_entity table

The table refers to internal legal entity that requests for purchase.

Field Data type Description

Legal name String Legal name of the entity 
corresponding to the location 
in which it operates.

ERP company code String Company code of the entity in 
the ERP system.

Region Choice list Area of the entity. The values 
are:

• AMS

• APAC
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Field Data type Description

• LATAM

• EMEA

Local currency Reference Local currency of the entity.

Reporting currency Reference Reporting currency of the 
entity.

Cost center

Cost centers are a commonly used reference between financial systems and IT. Cost center 
records represent business entities and have a related list of CI Cost Center Relationships that 
measure the cost center's consumption of business services.

cmn_cost center table

Field Data type Description

Name String A unique name for the cost 
center.

Account Number String An account number 
associated with the cost 
center, if one exists.

Code String A code associated with the 
cost center, if one exists.

Location Reference A reference to the location of 
the cost center.

Valid from Date/Time The date that the cost center 
is valid from. The format is 
YYYY-MM-DD HH: MM: SS.

Valid to Date/Time The date that the cost center 
is valid to. The format is YYYY-
MM-DD HH: MM: SS.

Manager String A reference to the user who 
manages the cost center.

Parent String A reference to the parent 
cost center in the hierarchical 
structure of cost centers.

Ledger account

A reference field for the account used to generate the  invoice.​

sn_fin_gl_account table

You can view records in any of the general ledger tables and make changes if necessary.
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Field Data type Description

Account Name String Display name of the ledger 
account fetched from ERP.

Currency Reference Currency that the expense is 
valued in.

Ledger account String Ledger account code fetched 
from ERP. Example: 160020.

Payment terms

Specify the terms and conditions that apply to customers while paying for an invoice. These are 
usually imposed by suppliers during the purchase.

sn_shop_payment_term

You can view the payment terms referencing an invoice.

Field Data type Description

Name String The name or code of the 
payment term. Example: Net 
060.

Type Choice list The values are:

• Due upon receipt

• Fixed

• Net

Short description String A short explanation of the 
payment term. Example: 2%14, 
Net 60.

Net days to pay String Applicable only to type “Net”.

Discount percentage String Applicable only to type “Net”.

Discount days String Applicable only to type “Net”.

Tax code fields

As a Tax manager, you can create tax codes to be applied in an invoice.

Tax code fields

The following table displays the fields in the tax code form.

Field Description

Invoice Case

Tax code ID A unique tax code generated from the ERP source.

Name Name of the tax code specified by the user.

Description The details of the tax code used in transactions or financial activities.
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Field Description

Country The name of the country for which the tax code is applied to.

State The name of the state for which the tax code is applied to.

Active The status of the tax code.

ERP source The name of the ERP source for which the tax code is generated.

Tax type fields

As a Tax manager, you can create tax types to be applied to an invoice.

Tax type fields

The following table displays the fields in the tax code form.

Field Description

Invoice Case

Code A unique tax code generated from the ERP source.

Category Name of the tax category.

• Sales tax

• Use tax

• Value-added tax

• Goods and service tax

• Withholding tax

Name The name of the tax type used in transactions or financial activities.

Active The status of the tax type. By default the active check box is inactive.

Organization tax details

Accounts Payable specialist uses the organization tax table to view the supplier's tax registration 
details.

Organization tax table

The organization table sn_fin_org_tax_detail  stores supplier or organization tax details.

Field Data type Description

Organization Reference The supplier or organization 
name.

Country of registration Reference Name of the country where 
the supplier or organization 
details are registered.

State/Province String Name of the state or province 
where the supplier or 
organization details are 
registered.
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Field Data type Description

Tax ID String/Numeric Unique reference ID issued 
against an organization or 
supplier

Active Boolean The status of the tax 
registration of the organization 
or supplier.

Invoice exception definition form

Use the Invoice exception definition form to provide details about the new invoice exception 
definition.

Invoice exception definition form

Field Description

Name Name of the invoice exception definition.

Application Application scope to create the invoice exception definition in. For example, 
Accounts Payable Invoice Processing.

Active Option to activate the invoice exception definition for use.

Order The order in which you want the invoice exception to be identified. Specify a 
numeric value in multiples of 100.

Line level 
exception

Option to mark the invoice exception definition as a line-level exception.

View View that is used to display the fields in an exception record.

Allow 
bypass

Option to allow bypass of the invoice exception definition.

Dependent The Invoice exception definition on which the new invoice exception definition 
depends on.

For example, if an exception definition record A is dependent on an exception 
definition record B, then when an invoice has an exception of type exception 
definition B in open state, then the exception engine does not check the invoice 
for exception definition A. Instead, the exception engine identifies only the 
exception definition B.

The dependent invoice exception definition record must have a lower order value 
than the new invoice exception definition record that you are creating.

Applicable 
to

Type of invoice that the invoice exception definition is applicable to. For example, 
PO Invoice.

Subflow Subflow that is run to determine if the exception exists for a given invoice.

Approval Rule form

Use the Approval Rule form to provide details about the new approval rule.
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Approval Rule form fields

Field Description

Number System-generated unique identifier for the approval rule.

Name The name you assign to the approval rule.

Active Option to decide if this rule is used to generate invoice approvals.

Approving 
object

Object you’re seeking approval for. The following options are available:

• Invoice

• Purchase Order

To create an approval rule for an invoice, select Invoice.

Approving 
line

Approving object line that you're seeking approval for. For Invoice approving 
object, the approving line is defaulted to Invoice Line.

Approval rule 
type

The type of approval rule that determines how approval plans are generated 
and routed when conditions are met. The following options are available:

• Dynamic Users or Groups

• Managerial Job Code Hierarchy

• Managerial Hierarchy

• Specified Users or Groups

Depending on the rule type that you select, the associated fields appear. For 
more information, see Approval rule types.

Base 
approvals on

Invoice fields that you want to base your approvals on. Select the invoice field 
and move it from Available to Selected.

Allow 
automatic 
approval

Option to allow automatic approval of an invoice if the requester (invoice 
business owner) is the only approver.

Approval 
trigger 
conditions

Conditions based on the approving object that determine the conditions under 
which an approval plan is created.

Approval Plan form

Use the Approval Plan form to view details of the overall invoice approval process.

Approval Plan form

Field Description

Number System-generated unique identifier for the approval plan.

Approval 
Rule

The approval rule that you want to reference for this plan.

Approval 
group

Group containing the users responsible for approving the plan.
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Approval Plan form  (continued)

Field Description

Approving 
record

Invoice record that requires approval.

Detail 
records

Details about the invoice and invoice line records.

Approval 
routing 
method

Method of routing the approvals. The options are sequentially and in parallel.

Approval 
decision 
method

Method of approving the rule. You can select if all approvers must approve the 
rule or any approver can approve it.

Approval Status of the approval plan request. The options are Not Yet Requested, 
Requested, Approved, Rejected, and Self Approved.

State Work status on the requested approval plan. The options are Pending, Open, 
Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped.

Approver list User or users responsible for approving the plan.

Approver 
group list

List of groups containing the users responsible for approving the plan.

Short 
description

Short description of the approval plan in the following format: Invoice approval 
required for <supplier name>.

Accounts Payable Operations  glossary

Learn about the terms and concepts used in Accounts Payable Operations  (APO).

Glossary terms are grouped alphabetically.

A  | D  | E  I  | S  | T  | V  | W

A

Accounts Payable

The process of managing and paying invoices from suppliers.

Approval workflow

The sequence of steps required to approve an invoice.

Advanced work assignment for Accounts Payable Operations

An application that automatically assigns work items to agents based on their availability, 
capacity, and skills to resolve invoice cases within Accounts Payable Operations.

Agent Workspace

a suite of tools that provides agents, case managers, help desk professionals, and 
managers quick access to what they need to help answer customer questions and resolve 
customer problems.

Assignment rules

Guidelines that determine how work items are assigned.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1424



D

Data capture

The process of collecting and digitizing invoice data.

Document intelligence

ServiceNow®  AI-powered tool for extracting data from invoices.

Data security

Measures to protect sensitive information within the system.

E

Enterprise resource planning systems

Enterprise resource planning (ERP) systems used for managing business processes.

Exception management

Handling and resolving issues that arise during Accounts Payable Operations  invoice 
processing.

I

Invoice approval

The process of verifying and authorizing an invoice for payment.

Invoice exception

Issues identified during invoice processing that require resolution.

Invoice ingestion

The process of receiving and entering invoices into the system.

Invoice processing

The end-to-end handling of invoices from receipt to payment.

P

Purchase order

A document issued by a buyer to a seller, detailing the items or services to be purchased.

S

supplier management

The process of managing relationships and transactions with suppliers.

T

tolerance rules

A limit that is set on invoices to determine acceptable variances before they require further 
review.

V
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virtual agent

An AI-driven assistant for handling common requests and inquiries.

W

Work item queue

A storage area for work items waiting to be assigned to agents.
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